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Chapitre 1 : Bienvenue dans Pro Tools

Bienvenue dans Pro Tools®. Pro Tools intègre de 
puissantes fonctions d'enregistrement 
audionumérique multipiste et
de séquence MIDI, et fournit tous les outils pour 
l'enregistrement, l'arrangement, l'édition, le 
mixage et le mastering de données audio de 
grande qualité pour la musique, la vidéo, les 
films et le multimédia.

Guides Pro Tools
Les systèmes Pro Tools s'accompagnent des 
guides suivants :

Guide de démarrage : instructions d'installation 
du système Pro Tools et de connexion du
studio.

Guide Notions de base (Pro Tools LE et Pro Tools 
M-Powered uniquement) : conçus pour les 
nouveaux utilisateurs, ces guides décrivent les 
méthodes spécifiques pour effectuer certaines 
tâches telles que l'importation et l'exportation 
de son vers et depuis votre interface matérielle 
Pro Tools LE ou M-Audio agréée Digidesign, la 
connexion d'un micro ou d'un instrument et 
l'enregistrement d'une session.

Guide de référence Pro Tools : description 
détaillée de toutes les fonctions et possibilités 
offertes par Pro Tools (les systèmes Pro Tools LE 
et M-Powered ne comportent qu'une version 
électronique du Guide de référence au 
format PDF).

Guide des menus Pro Tools : guide PDF 
électronique des menus de Pro Tools.

Guide des plug-in DigiRack : instructions 
d'utilisation des plug-in DigiRack (fournis avec 
Pro Tools) pour le traitement audio, en temps 
réel ou hors temps réel, des fichiers dans 
Pro Tools (les systèmes Pro Tools LE et M-
Powered ne comportent qu'une version 
électronique de ce guide au format PDF).

Guide des plug-in Digidesign : guide PDF 
électronique contenant des instructions 
relatives à l'utilisation des plug-in Digidesign 
optionnels pour le traitement audio, en temps 
réel ou hors temps réel, des fichiers dans 
Pro Tools.

Guide DigiBase : description détaillée de 
l'utilisation des bases de données et des 
navigateurs Pro Tools DigiBase pour la gestion 
de vos données et supports (les systèmes 
Pro Tools LE et M-Powered ne comportent 
qu'une version électronique de ce guide au 
format PDF).

Guide des systèmes étendus (systèmes 
Pro Tools|HD uniquement) : instructions pour 
l'ajout de cartes Digidesign optionnelles ou d'un 
châssis d'extension sur un système 
Pro Tools|HD.
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Guide MachineControl™ (systèmes Pro Tools|HD 
uniquement) : guide PDF électronique relatif à 
l'option MachineControl. Ce guide contient des 
instructions d'installation et d'utilisation de 
l'option MachineControl pour Pro Tools 
permettant d'activer la communication série 
avec des transports audio et vidéo distants.

Raccourcis clavier Pro Tools : guides PDF 
électroniques pour Windows et Macintosh 
comportant une liste des raccourcis clavier 
n'apparaissant pas dans les menus de Pro Tools.

Conventions utilisées dans ces 
guides

Les guides de Pro Tools utilisent les conventions 
suivantes pour indiquer les choix de menu et les 
commandes principales :
:

Les symboles suivants sont utilisés pour mettre 
en évidence des informations importantes :

Informations sur la 
compatibilité
Digidesign ne peut assurer la compatibilité et 
fournir une assistance que pour les matériels et 
les logiciels testés et approuvés par ses soins. 

Pour connaître la liste des ordinateurs, systèmes 
d'exploitation, disques durs et périphériques 
tiers approuvés par Digidesign, reportez-vous 
aux informations de compatibilité sur le site 
Web de Digidesign à l'adresse 
www.digidesign.com/compato.

Digidesign fournit également des guides avec 
les interfaces audio, les surfaces de travail 
dédiées (comme D-Control) et les contrôleurs 
(comme Command|8) et avec diverses autres 
options Digidesign (MIDI I/O, PRE et 
SYNC I/O, par exemple). Consultez les 
documents fournis avec votre produit 
Digidesign spécifique.

Convention Action

File > Save Dans le menu File, 
sélectionnez Save.

Ctrl+N Maintenez la touche Ctrl 
enfoncée et appuyez sur 
la touche N.

Ctrl+clic Maintenez la touche Ctrl 
enfoncée et cliquez à 
l'aide du bouton de la 
souris.

Clic droit (Windows) Cliquez à l'aide du 
bouton droit de la souris.

Les conseils aux utilisateurs sont des 
astuces qui vous permettent d'optimiser 
l'utilisation de votre système Pro Tools.

Les avertissements importants contiennent 
des informations susceptibles de modifier 
les données d'une session ou les 
performances de votre système Pro Tools.

Les raccourcis indiquent des raccourcis 
clavier et souris utiles.

Les renvois dirigent l'utilisateur vers les 
sections correspondantes des divers guides 
de Digidesign.
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A propos de 
www.digidesign.com
Le site Web de Digidesign 
(www.digidesign.com) est la meilleure source 
d'informations en ligne pour optimiser votre 
logiciel Pro Tools. Vous trouverez ci-après 
quelques exemples des services et fonctions 
disponibles à cette adresse.

Enregistrement : dans cette section, vous pouvez 
enregistrer votre produit en ligne. Pour obtenir 
les instructions nécessaires, reportez-vous au 
formulaire d'enregistrement fourni avec votre 
système.

Support : contactez l'assistance technique ou le 
service clientèle de Digidesign, téléchargez des 
mises à jour logicielles et les dernières versions 
des manuels en ligne, consultez les documents 
sur la compatibilité avec les différents systèmes 
d'exploitation et la base de recherche en ligne 
(Answerbase) ou inscrivez-vous au forum de 
discussion pour les utilisateurs Pro Tools (en 
anglais) dans la section Digidesign User 
Conference. 

Formation : étudiez directement en ligne ou 
découvrez les méthodes de formation utilisées 
dans les centres de formation certifiés Pro Tools. 

Produits et Développeurs : découvrez les 
produits Digidesign, nos partenaires de 
développement ainsi que leurs plug-in, 
applications et matériels et téléchargez des 
logiciels démo. 

Actualité et Evénements : accédez aux 
informations de dernière minute publiées par 
l'équipe de Digidesign et inscrivez-vous pour 
obtenir une démo de Pro Tools.
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Chapitre 2 : Configurations des 
systèmes Pro Tools

Il existe trois types de systèmes Pro Tools :

Pro Tools|HD® : il s'agit du logiciel Pro Tools HD 
pour le matériel Pro Tools|HD.

Pro Tools LE™ : il s'agit du logiciel Pro Tools LE 
pour Digi 002®, Digi 002 Rack™, Mbox 2™ ou 
Mbox™.

Pro Tools M-Powered™ : il s'agit du logiciel 
Pro Tools M-Powered pour les interfaces M-
Audio® agréées Digidesign.

Systèmes Pro Tools|HD
Les systèmes Pro Tools|HD sont disponibles 
dans les configurations indiquées à la page 7. 
Chaque système requiert au moins une interface 
audio Digidesign (vendue séparément). Il est 
possible d'ajouter des cartes Pro Tools|HD aux 
systèmes Pro Tools|HD, afin d'augmenter le 
nombre de pistes, le nombre de plug-in pris en 
charge, la capacité de traitement de la console 
de mixage et de connecter des interfaces audio 
supplémentaires.

Systèmes Pro Tools|HD

Pro Tools|HD 1

Comprend les éléments suivants :

• Carte HD Core

• Logiciel Pro Tools HD

Pro Tools|HD 2 Accel

Comprend les éléments suivants :

• Carte HD Core

• Carte HD Accel

• Logiciel Pro Tools HD

Les performances des systèmes Pro Tools 
dépendent de facteurs tels que la fréquence 
du processeur de l'ordinateur, la quantité de 
mémoire du système et les performances du 
disque dur. Vous pouvez obtenir les 
informations de configuration minimale et 
de compatibilité les plus récentes auprès de 
votre revendeur Digidesign ou sur le site 
Web de Digidesign.
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Pro Tools|HD 3 Accel

Comprend les éléments suivants :

• Carte HD Core

• Deux cartes HD Accel

• Logiciel Pro Tools HD

Pro Tools|HD 2

Comprend les éléments suivants :

• Carte HD Core

• Carte HD Process

• Logiciel Pro Tools HD

Pro Tools|HD 3

Comprend les éléments suivants :

• Carte HD Core

• Deux cartes HD Process

• Logiciel Pro Tools HD

Interfaces audio prises en charge
(systèmes Pro Tools|HD uniquement)

Les interfaces audio suivantes sont compatibles 
avec les systèmes Pro Tools|HD :

• 192 I/O™

• 192 Digital I/O™

• 96 I/O™

• 96i I/O™

Les interfaces audio Digidesign Legacy suivantes 
sont prises en charge par les systèmes 
Pro Tools|HD :

• 888|24 I/O™ et 882|20 I/O™

• 1622 I/O™

• Interface ADAT Bridge I/O™ 24 bits

Les cartes HD Accel et HD Process peuvent 
être utilisées au sein du même système. 
Reportez-vous au Guide de démarrage 
Pro Tools|HD.

Les systèmes Pro Tools|HD requièrent 
l'utilisation d'au moins une interface 192 
I/O, 192 digital I/O, 96 I/O ou 96i I/O.
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Nombre maximal de voix en lecture ou en enregistrement sur les 
systèmes Pro Tools|HD

Le tableau suivant indique le nombre maximal de voix en lecture et en enregistrement pour chaque 
type de système Pro Tools|HD. Les voix en lecture et en enregistrement se réfèrent au nombre de 
pistes de lecture et d'enregistrement simultanées sur votre système. Le nombre total de « pistes 
pouvant héberger des voix » renvoie au nombre maximal de pistes audio pouvant se partager les voix 
disponibles de votre système. (Une piste mono utilise une seule voix. Les pistes stéréo et multicanaux 
utilisent une voix par canal.) Les limites des voix dépendent de la fréquence d'échantillonnage de la 
session et du nombre de puces DSP dédiées au moteur de lecture du système. Les systèmes 
Pro Tools|HD peuvent ouvrir des sessions contenant un maximum de 256 pistes audio, mais les pistes 
audio dépassant les limites des pistes pouvant héberger les voix seront définies automatiquement sur 
Voice Off. 

Les systèmes Pro Tools|HD offrent jusqu'à 160 pistes (entrées) auxiliaires et un total de 128 bus de 
mixage interne. Ces systèmes offrent également jusqu'à 5 inserts et 10 départs par piste (en fonction 
de leur capacité DSP). De plus, les systèmes Pro Tools|HD prennent en charge jusqu'à 128 pistes 
d'instrument et jusqu'à 256 pistes MIDI.

Tableau 1. Nombre maximal de voix en lecture ou en enregistrement simultanés sur les systèmes Pro ToolsTools|HD

Type de système de base

Fréquence 
d'échantillon-
nage
(kHz)

Voix en lecture
(pistes mono en 
lecture simultanée)

Voix en 
enregistrement 
(pistes mono en 
enregistrement 
simultané)

Pistes 
totales 
hébergeant
des voix

Pro Tools|HD 1 44,1/48 96 96 112

88,2/96 48 48 48

176,4/192 12 12 12

Pro Tools|HD Accel 2,
Pro Tools|HD Accel 3

44,1/48 192 192 224

88,2/96 96 96 120

176,4/192 36 36 36

Pro Tools|HD 1, 
Pro Tools|HD 2 étendus,
Pro Tools|HD 3

44,1/48 128 128 224

88,2/96 64 64 80

176,4/192 24 24 24
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Interfaces audio pour les systèmes Pro Tools|HD

Le Tableau 2 récapitule les capacités d'entrée et de sortie des différentes interfaces audio des systèmes 
Pro Tools|HD.

Vous pouvez ajouter à votre système Pro Tools|HD plusieurs cartes d'extension Pro Tools|HD, soit 
directement à l'intérieur de l'ordinateur, soit en utilisant un châssis d'extension. En procédant de la 
sorte, vous augmentez le nombre de pistes et de plug-in ainsi que la capacité de traitement de la 
console de mixage et pouvez connecter des interfaces audio supplémentaires. Pour plus 
d'informations, reportez-vous au Guide des systèmes étendus.

Tableau 2. Nombre de canaux des interfaces audio du système Pro Tools|HD

Type d'interface

Nombre de 
canaux
d'enregistrement/
de lecture (E/S)

Fréquences 
d'échantillon-
nage (kHz)

Conversion
A/N

Conversion
N/A

Digital 
I/O

192 I/O 16 entrées/
16 sorties

44,1, 48, 88,2, 
96, 176,4, 192

24 bits 24 bits 24 bits

192 Digital I/O 16 entrées/
16 sorties

44.1, 48, 88.2, 
96, 176.4, 192

Non Non 24 bits

96 I/O 16 entrées/
16 sorties

44,1, 48, 88,2, 
96

24 bits 24 bits 24 bits

96i I/O 16 entrées/
2 sorties

44,1, 48, 88,2, 
96

24 bits 24 bits 24 bits

888|24 I/O 8 entrées/
8 sorties

44,1, 48 24 bits 24 bits (ou 
20 bits, sur 
I/O 
anciennes)

24 bits

882|20 I/O 8 entrées/
8 sorties

44,1, 48 20 bits 20 bits 24 bits

1622 I/O 16 entrées/
2 sorties

44,1, 48 20 bits 24 bits 24 bits

Interface ADAT 
Bridge I/O 24 bits

16 entrées/
16 sorties

44,1, 48 Non 24 bits 24 bits
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Systèmes Pro Tools LE
Les systèmes Pro Tools LE sont disponibles dans 
les configurations suivantes :

Digi 002®

Un système Digi 002 se compose des éléments 
suivants :

• Interface et contrôleur audio combiné 
Digi 002

• Logiciel Pro Tools LE

Digi 002 Rack™

Un système Digi 002 Rack comprend les 
éléments suivants :

• Interface audio Digi 002

• Logiciel Pro Tools LE

Mbox 2™

Un système Mbox 2 se compose des éléments 
suivants :

• Interface audio Mbox 2

• Logiciel Pro Tools LE

Mbox™

Un système Mbox se compose des éléments 
suivants :

• Interface audio Mbox

• Logiciel Pro Tools LE

Capacité de traitement

La capacité totale de traitement d'un 
système Pro Tools LE dépend de la 
puissance du processeur de votre ordinateur. 
Vous pouvez obtenir les informations de 
configuration minimale et de compatibilité 
les plus récentes auprès de votre revendeur 
Digidesign ou sur le site Web de Digidesign 
(www.digidesign.com).
Chapitre 2 : Configurations des systèmes Pro Tools 11
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Fonctionnalités des systèmes 
Pro Tools LE

Le Tableau 3 indique les capacités en lecture, en enregistrement et en entrée/sortie de chaque système 
Pro Tools LE. Les pistes mono en lecture simultanée se réfèrent au nombre de pistes de lecture et 
d'enregistrement simultanées sur votre système. Le nombre total de « pistes pouvant héberger des 
voix » renvoie au nombre maximal de pistes audio pouvant se partager les voix disponibles de votre 
système. (Les pistes mono utilisent une seule piste audio, tandis que les pistes stéréo utilisent jusqu'à 
deux pistes.) Si vous ouvrez une session Pro Tools créée sur un système Pro Tools|HD avec plus de 
pistes que le système LE le permet, les pistes dépassant le nombre admis sont automatiquement 
réglées sur inactives.

Les systèmes Pro Tools LE offrent jusqu'à 128 pistes d'entrées auxiliaires, un total de 32 bus de mixage 
interne et jusqu'à 5 inserts et 10 départs par piste (suivant la capacité de traitement de votre 
ordinateur). De plus, les systèmes Pro Tools LE prennent en charge jusqu'à 32 pistes d'instrument et 
jusqu'à 256 pistes MIDI.

Pour plus d'informations sur le transfert de données de session entre systèmes Pro Tools|HD et 
Pro Tools LE, reportez-vous à la section Partage de sessions créées sur des systèmes Pro Tools 
différents, page 179.

Tableau 3. Nombre de canaux en lecture ou en enregistrement sur les systèmes Pro Tools LE

Type de 
système

Pistes mono 
en lecture 
simultanée

Pistes 
totales 
hébergeant 
des voix

Nombre de 
canaux I/O

Conver-
sion A/N

Conver-
sion N/A

Digital 
I/O

Digi 002
ou 
Digi 002 
Rack

32 128 jusqu'à 
18 entrées/ 
18 sorties (à 
48 kHz ou 
moins)

jusqu'à 
10 entrées/ 
10 sorties (à 
88,2 ou 
96 kHz)

24 bits 24 bits 24 bits

Mbox 2 
ou Mbox

32 128 jusqu'à 
2 entrées/ 
2 sorties

24 bits 24 bits 24 bits
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Pro Tools M-Powered
Un système Pro Tools M-Powered se compose des éléments suivants :

• Logiciel Pro Tools M-Powered

• Interface audio M-Audio agréée Digidesign (non fournie avec le logiciel M-Powered)

Les références à Pro Tools LE dans ce guide s'appliquent également à Pro Tools M-Powered, sauf 
indication contraire dans ce manuel et dans le Guide de démarrage Pro Tools M-Powered.

Vous trouverez la liste des interfaces M-Audio agréées Digidesign dans la page relative à la 
compatibilité sur le site Web de Digidesign, à l'adresse www.digidesign.com/compato.
Chapitre 2 : Configurations des systèmes Pro Tools 13
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Chapitre 3 : Concepts de Pro Tools

Ce chapitre explique les principes et les 
concepts de base du fonctionnement et des 
fonctionnalités de Pro Tools.

Enregistrement audio sur 
disque dur
L'enregistrement sur bande exploite un support 
linéaire : autrement dit, il faut rembobiner une 
bande, en retour arrière ou en avance rapide, 
pour pouvoir écouter l'endroit particulier d'un 
enregistrement. Pour modifier l'ordre ou répéter 
des éléments contenus sur un système linéaire, il 
faut les réenregistrer. 

L'enregistrement sur disque dur utilise un 
support non-linéaire (ou à accès aléatoire) : on 
peut se rendre instantanément à n'importe quel 
endroit d'un enregistrement sans devoir 
rembobiner, comme avec une bande.

Les systèmes non-linéaires présentent plusieurs 
avantages. Vous pouvez facilement modifier la 
disposition des parties d'un enregistrement ou 
les répéter en les faisant lire par le disque dur 
dans un ordre différent ou à plusieurs reprises. 
De plus, cette réorganisation est non-destructive, 
ce qui signifie que le matériel enregistré original 
reste intact.

Pro Tools est un système d'enregistrement non 
linéaire qui permet de réorganiser et de mixer 
des éléments enregistrés, de façon non 
destructive. 

Digidesign Audio Engine
DAE, abréviation de Digidesign Audio Engine 
(moteur audio Digidesign), est le système 
d'exploitation en temps réel de Digidesign pour 
le traitement, la lecture et l'enregistrement 
numériques. Lorsque vous installez Pro Tools, 
DAE s'installe automatiquement sur votre 
système.

Tout comme le système d'exploitation d'un 
ordinateur permet l'exécution des programmes 
sur celui-ci, DAE offre la plupart des 
fonctionnalités d'enregistrement sur disque dur, 
de traitement de signal numérique et 
d'automation de mixage nécessaires à Pro Tools 
et à d'autres produits de Digidesign et de ses 
partenaires de développement.

Le paramètre DAE Playback Buffer Size 
détermine la quantité de mémoire DAE allouée à 
la gestion des buffers de disque.

Pour plus d'informations, reportez-vous à la 
section Taille du buffer de lecture DAE, page 54. 
La taille du buffer de lecture DAE peut être 
modifiée dans la boîte de dialogue Playback 
Engine, présentée ci-dessous.
Chapitre 3 : Concepts de Pro Tools 15
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Boîte de dialogue Playback Engine

Pro Tools tire également parti du processeur 
hôte de votre ordinateur pour partager un 
certain nombre de tâches et de traitements DSP 
optionnels. 

Pro Tools LE utilise le processeur de l'ordinateur 
hôte (CPU) pour effectuer l'enregistrement, la 
lecture, le mixage et les calculs d'effets des pistes 
audio. Pro Tools HD utilise également le 
processeur de l'unité centrale pour le calcul des 
effets des plug-in RTAS. Les performances sont 
déterminées par les caractéristiques de votre 
système et les réglages de son moteur de lecture. 

La boîte de dialogue Playback Engine permet de 
définir la taille du buffer matériel et d'allouer un 
pourcentage des ressources du processeur à ces 
tâches. Pour plus d'informations, reportez-vous 
à la section Configuration des paramètres du 
système Pro Tools (dans le moteur de lecture), 
page 50.

Sur les systèmes Pro Tools|HD, vous pouvez 
sélectionner le nombre de voix (et de pistes 
pouvant héberger les voix) pour votre système et 
ses sessions. Le choix du nombre de voix dépend 
des ressources DSP que vous souhaitez allouer 
aux voix. Pour plus d'informations, reportez-
vous à la section Configuration des paramètres 
du système Pro Tools (dans le moteur de 
lecture), page 50.

Sur les systèmes Pro Tools|HD, la boîte de 
dialogue Playback Engine permet également 
d'affecter les ressources DSP pour la 
compensation de retard.

Sessions Pro Tools
Lorsque vous démarrez un projet dans Pro Tools, 
vous créez une session. Cette section explique un 
certain nombre d'éléments de base concernant 
les sessions.

Fichier de session

Un fichier de session est le document créé par 
Pro Tools lorsque vous choisissez File > New 
Session et configurez une nouvelle session. 
Pro Tools ne peut ouvrir qu'une seule session à 
la fois. Le fichier de session porte l'extension .ptf 
(propre aux fichiers Pro Tools). Les fichiers de 
session contiennent des tables de tous les 
éléments associés à un projet, ce qui inclut les 
fichiers audio, les données MIDI, ainsi que 
toutes vos informations d'édition et de mixage. 
Rappelez-vous cependant qu'un fichier de 
session Pro Tools ne contient pas de fichier 
média (audio ou vidéo) en tant que tel, mais 
qu'il fait plutôt référence aux fichiers 
audio, vidéo, MIDI et aux autres fichiers. 
Les modifications effectuées dans une session 
seront enregistrées dans le nouveau fichier de 
session. Vous pouvez ainsi créer plusieurs 
versions d'une session ou sauvegarder votre 
travail d'édition et de mixage. 

Boîte de dialogue Playback Engine pour Pro Tools HD

Voir également Ressources système, 
page 22.
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Ler icônes des fichiers de session sont différentes 
selon qu'il s'agit d'un système Pro Tools HD, 
Pro Tools LE ou Pro Tools M-Powered. 

Bien qu'il existe différentes icônes de fichiers de 
session, il est possible d'ouvrir ces fichiers à 
partir des trois applications (avec certaines 
restrictions). Pour plus d'informations, reportez-
vous à la section Ouverture d'une session, 
page 61. 

Pistes

Les pistes de Pro Tools permettent d'enregistrer 
et d'éditer les données audio, MIDI et 
d'automation. Les pistes Pro Tools fournissent 
également des canaux audio pour 
l'acheminement des bus internes, ainsi que des 
entrées et sorties physiques pour les données 
audio et MIDI.

Pro Tools propose cinq types de pistes : pistes 
audio, entrées auxiliaires, faders principaux, 
pistes d'instrument et pistes MIDI.

Les données des pistes audio, des pistes MIDI et 
des pistes d'instrument peuvent être éditées en 
régions ou répétées à des emplacements 
différents, ce qui permet de créer des boucles, de 
réarranger des sections ou des chansons 
entières, ou d'assembler des pistes en utilisant 
des éléments de plusieurs prises. 

Les pistes d'entrée auxiliaire permettent 
d'acheminer des bus audio internes ou des 
entrées physiques vers des bus internes ou des 
sorties physiques. Les entrées auxiliaires sont 
généralement utilisées pour les bus d'effets 
audio, le débit audio et le prémixage.

Les pistes de fader principal fournissent des 
commandes pour les canaux de sortie audio 
physiques, y compris des réglages du niveau de 
volume pour le mixage, le panoramique et les 
inserts de plug-in.

Les pistes audio, d'entrée auxiliaire, 
d'instrument et de master principal peut être 
mono, stéréo ou multicanaux (Pro Tools HD 
uniquement). Lors de la création d'une piste, 
vous sélectionnez son format dans la liste de 
formats pris en charge par votre système.

Icônes des fichiers de session

En cas de transfert d'une session dans un 
autre système Pro Tools, son icône de fichier 
adopte le type d'icône du système de 
destination.

Piste audio dans la fenêtre Edit (piste stéréo affichée)

Pro Tools HD Pro Tools LE Pro Tools M-Powered

Piste MIDI dans la fenêtre Edit
Chapitre 3 : Concepts de Pro Tools 17
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Fichier audio

Lorsque vous enregistrez du son dans une 
session Pro Tools, des fichiers audio sont créés. 

Les fichiers audio de chaque session sont stockés 
dans un dossier appelé « Audio Files » (fichiers 
audio). La liste des fichiers audio se trouve dans 
la liste des régions de Pro Tools et peut 
apparaître dans une piste ausio. Il est possible de 
définir une section d'un fichier audio comme 
région. Pour plus d'informations, reportez-vous 
à la section Régions, page 18.

Régions

Une région est un segment d'audio ou de 
données MIDI. Une région peut correspondre à 
une boucle de batterie, un riff de guitare, un 
couplet de chanson, une prise, un effet sonore, 
une partie de dialogue ou un fichier audio 
entier. Il est possible également d'associer des 
données d'automation à une région. Dans 
Pro Tools, les régions sont créées à partir de 
fichiers audio ou MIDI, et peuvent être 
organisées en playlists de pistes audio et MIDI. 
Vous pouvez également regrouper des régions 
ou les lire en boucle.

Playlist

Une playlist est une suite de régions organisées 
sur une piste audio ou MIDI. Les pistes 
possèdent des playlists d'édition et des playlists 
d'automation. 

Dans le cas des pistes audio, une playlist 
d'édition indique au disque dur quelles sont les 
régions audio à lire et dans quel ordre. Vous 
pouvez, par exemple, utiliser la même région 
audio pour accéder à la même partie de données 
audio à plusieurs reprises et en plusieurs 
emplacements sans utiliser d'espace disque 
supplémentaire. Plusieurs versions des mêmes 
données audio peuvent être utilisées à différents 
endroits et des effets variés peuvent leurs être 
appliqués. Dans le cas des pistes MIDI et des 
pistes d'instrument, les playlists d'édition 
permettent de stocker plusieurs séquences MIDI 
(ou performances) sur une piste. 

Une playlist peut être constituée d'une seule 
région ou de plusieurs régions séparées. Elle peut 
être constituée d'éléments de même origine, par 
exemple des régions provenant de plusieurs 
prises différentes d'un solo, ou d'éléments 
hétérogènes, plusieurs effets sonores différents 
par exemple. 

Icône de fichier audio

Région audio

Menu déroulant du sélecteur de playlist
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Vous pouvez créer autant de playlists d'édition 
que vous le souhaitez pour une piste. Vous 
pouvez ainsi assembler différentes versions 
d'interprétations ou d'éditions sur une même 
piste et choisir celles qui vous intéressent dans 
un menu déroulant apparaissant sur la piste.

Chaque piste possède, en outre, un seul 
ensemble de playlists d'automation, pour le 
volume, le panoramique, les coupures (mute) et 
pour chaque contrôle d'automation pour les 
affectations d'inserts et de départs de cette piste.

Canal

Le terme canal peut revêtir plusieurs sens 
différents, selon l'élément de système Pro Tools 
considéré. Dans son sens premier, le mot 
« canal » se réfère à une entrée ou à une sortie 
physique de votre système Pro Tools.

Une interface audio 96 I/O (Figure 1) offre, par 
exemple, 16 canaux d'entrée et de sortie 
maximum à un système Pro Tools|HD, alors 
qu'une interface audio Mbox 2 ne fournit pas 
plus de 4 entrée et 2 sorties.

Figure 1.  Vue arrière de l'interface 96 I/O, avec huit entrées analogiques, huit sorties analogiques et huit canaux 
numériques I/O (utilisant un guide de lumière)
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La seconde utilisation du terme canal se réfère à 
une voie dans la fenêtre Mix de Pro Tools. 
Chaque piste d'une session Pro Tools possède 
une voie correspondante dans la fenêtre Mix.

Les voies audio et MIDI présentent des contrôles 
semblables, mais ces derniers ont des effets 
légèrement différents. Par exemple, les faders de 
voies audio et d'entrée auxiliaire contrôlent le 
gain de sortie de la console de mixage pour ce 
canal, alors que les faders de voies MIDI 
envoient des données de volume MIDI (de type 
contrôleur MIDI 7) à l'instrument MIDI. 
Les voies d'une pistes d'instrument associent 
une piste MIDI et une entrée auxiliaire dans une 
seule voie.

Assignation du signal

Pro Tools offre des contrôles logiciels de mixage 
et d'assignation (Routing) du signal. 
Ces contrôles se trouvent dans la fenêtre Mix. 
(Certains de ces contrôles sont également 
accessibles à partir de la fenêtre Edit).

Une tâche courante d'assignation du signal 
consiste à prémixer plusieurs pistes en une seule 
voie (par exemple, entrée auxiliaire ou fader 
principal), afin de pouvoir partager le traitement 
et le contrôle de niveau. Dans l'exemple suivant, 
trois pistes audio sont prémixées dans une 
entrée stéréo auxiliaire.

Figure 2.  Voie de console de la fenêtre Mix (piste audio)

Le terme canal s'applique également à un 
aspect distinct du fonctionnement MIDI. 
Reportez-vous à la section Concepts MIDI, 
page 24.
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Options d'assignation du signal

Les options d'assignation du signal sont les 
suivantes : 

Sélecteurs d'entrées et de sorties (E/S) de 
pistes : l'assignation de signal la plus simple 
consiste à définir l'entrée et la sortie de la piste. 
Il est nécessaire d'affecter un chemin d'entrée à 
une piste pour qu'elle puisse enregistrer des 
données audio, ainsi qu'un chemin de sortie 
pour que ces données audio soient audibles via 

une sortie physique. Les signaux peuvent 
également être acheminés vers ou depuis 
d'autres pistes dans Pro Tools (ou entrées et 
sorties matérielles) à l'aide de bus internes.

Entrées auxiliaires et faders principaux : 
les entrées auxiliaires sont des pistes qui 
peuvent servir de retours machine ou effets, de 
prémixeurs et de bus principaux. Les faders 
principaux servent à contrôler les niveaux 
généraux de bus et de sortie. Les entrées 
auxiliaires et les faders principaux peuvent 
posséder des inserts plug-in et/ou matériels. 

Pistes d'instrument : les pistes d'instrument 
permettent d'envoyer du son d'un plug-in vers 
des sorties, des départs et des bus ou d'autres 
inserts.

Départs : les départs envoient les données audio 
des pistes vers des sorties matérielles ou vers des 
bus internes acheminés à leur tour vers d'autres 
pistes au sein de Pro Tools. Les faders principaux 
ne gèrent pas les départs.

Inserts plug-in et matériels : le traitement des 
plug-in s'effectue entièrement dans le système 
Pro Tools. Les inserts matériels utilisent, en 
revanche, les entrées et les sorties de l'interface 
audio pour constituer une boucle d'insertion 
traditionnelle à destination et en provenance 
d'effets externes ou autres périphériques.

Chemins : les chemins correspondent à toute 
option d'assignation dans Pro Tools, y compris 
les entrées, sorties, bus et inserts internes ou 
externes. Pro Tools vous permet d'identifier ces 
chemins. Les noms des chemins seront affichés 
dans les sélecteurs d'entrée audio et de chemin 
de sortie ainsi que dans d'autres menus. Pour 
plus d'informations, reportez-vous au 
Chapitre 7, Configuration des E/S.

Prémixage vers une entrée auxiliaire

Entrée 
provenant 
du chemin 
du bus 
stéréo

Plug-in
stéréo

Sortie vers
le chemin de
sortie stéréo

Sorties 
vers le 
chemin du 
bus stéréo

Inserts

Départs

Entrées
auxiliaires

Pistes audio
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Formats de mixage : les sessions peuvent 
combiner des pistes, bus, entrées, sorties et 
inserts mono, stéréo et multicanaux (les formats 
multicanaux sont pris en charge uniquement 
sur les systèmes Pro Tools|HD). 

Ressources système
Le nombre de pistes, le traitement des plug-in, 
les options de chemin et d'assignation du signal 
ainsi que la disponibilité des voies sont en fin de 
compte limités par les ressources associées de 
l'ordinateur hôte et de votre dispositif Pro Tools. 

Pro Tools offre plusieurs manières de gérer et de 
conserver des ressources pour optimiser les 
performances de votre système. Lorsque vous 
commencez à travailler avec des sessions et des 
pistes Pro Tools, les fonctions suivantes vous 
permettront d'augmenter le rendement du DSP 
et des autres ressources disponibles :

◆ Pro Tools vous permet d'ajuster le mode de 
fonctionnement de votre système en changeant 
des paramètres système concernant sa capacité 
de traitement, de lecture et d'enregistrement. 
Voir Configuration des paramètres du système 
Pro Tools (dans le moteur de lecture), page 50.

◆ Pro Tools permet de désactiver manuellement 
certains éléments de la session (tels que les pistes 
et les inserts), afin de libérer des ressources DSP. 
Les éléments inactives sont visibles, peuvent 
être édités et sont conservés dans la session. 
Pour plus d'informations, reportez-vous à la 
section Eléments actifs et inactifs, page 22.

◆ Tous les systèmes Pro Tools offrent des 
options souples de voix pour les pistes audio, 
afin d'optimiser l'utilisation des voix disponibles 
de votre système. Pour plus d'informations sur la 
gestion et les options de voix, reportez-vous à la 
section Emprunt des voix, page 130. 

Eléments actifs et inactifs

Pro Tools permet de définir certains éléments de 
la session (tels que les pistes et les inserts) 
comme inactive, afin de libérer des ressources 
DSP et des connexions à la console. 

Les éléments de Pro Tools qui prennent en 
charge les modes d'activation et de 
désactivation sont les suivants :

• Pistes audio, d'entrée auxiliaire, 
d'instrument et de fader principal

• Entrées et sorties de pistes

• Départs

• Entrées latérales (sidechain)

• Plug-in

• Inserts matériels

• Chemins (à l'échelle de la session)

Outre le réglage manuel des modes Active et 
Inactive, Pro Tools désactive automatiquement 
certains éléments en cas de ressources 
insuffisantes ou indisponibles. 

Lorsqu'ils sont actifs, les éléments sont 
entièrement engagés et opérationnels.

Lorsqu'ils sont inactifs, les éléments sont 
silencieux et hors service, bien que la plupart des 
contrôles qui leur sont associés demeurent 
réglables. Différents éléments inactifs ont une 
incidence particulière sur les ressources système 
disponibles.

Plug-in : lorsqu'un plug-in est inactif sur une 
piste, son DSP est disponible pour d'autres plug-
in ou traitements. Les affectations des plug-in 
peuvent être désactivées soit manuellement, soit 
automatiquement (voir Mode inactif 
automatique et manuel, page 23). 

Les pistes MIDI ne peuvent être désactivées. 
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Chemin et affectation des chemins : lorsqu'un 
chemin ou l'affectation d'un chemin est inactif, 
ses ressources sont libérées au niveau de la 
console de mixage pour d'autres besoins de 
routage de signal de la session. La désactivation 
des chemins et des affectations peut s'effectuer 
soit manuellement, soit automatiquement (voir 
Mode inactif automatique et manuel, page 23).

Pistes : lorsqu'une piste est rendue inactive, ses 
voix sont utilisables par une autre piste. Les 
pistes mono inactives libèrent jusqu'à une voix, 
tandis que les pistes stéréo et multicanaux 
libèrent jusqu'à une voix par canal. De plus, 
lorsqu'une piste audio, d'entrée auxiliaire, 
d'instrument ou de fader principal est inactive, 
les plug-in, inserts, départs et affectations d'E/S 
correspondants le sont aussi, et le DSP associé 
est libéré et devient utilisable ailleurs dans la 
session.

Affichage des éléments inactifs

Lorsque des éléments sont inactifs, leurs noms 
apparaissent en italiques, sur un fond gris foncé. 
Lorsqu'une piste est inactive, la voie de console 
entière s'assombrit.

Mode inactif automatique et manuel

Les modes actif et inactif constituent de 
puissantes options pour le transfert de session, 
et pour la gestion des ressources du système. 
Pro Tools permet de commuter 
automatiquement ou manuellement le mode 
inactif. Vous pouvez désactiver (ou activer) 
manuellement les éléments pour gérer de façon 
sélective les ressources du système au cours de 
l'édition et du mixage.

Eléments et pistes actifs et inactifs

Actif Plug-in inactif 

Piste inactive 
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Désactivation automatique des éléments

Lorsque vous ouvrez une session, il se peut que 
certains chemins de signaux, plug-in ou 
interfaces audio utilisés dans la session ne soient 
pas tous disponibles sous la forme définie sur le 
système. Lorsque vous ouvrez une session, il est 
possible qu'un nombre insuffisant de voix soit 
disponible si la session a été créée sur un type de 
système Pro Tools différent (par exemple, en 
créant une session sur un système Pro Tools HD, 
puis en l'ouvrant sur un système Pro Tools LE).

Lorsque ceci se produit, la session s'ouvre 
comme elle avait été enregistrée. Tous les 
éléments qui ne sont pas disponibles ou qui ne 
peuvent être chargés du fait de ressources 
insuffisantes, sont désactivés.

Commutation inactive manuelle

Vous pouvez faire appel manuellement aux 
modes Active ou Inactive pour gérer les 
ressources du système. Lorsque vous désactivez 
un élément, les ressources qui lui étaient 
associées sont à nouveau disponibles pour 
d'autres tâches de la session. 

Vous trouverez ci-après les instructions de base 
pour désactiver manuellement des éléments. 
Dans l'ensemble du Guide de référence Pro Tools, 
vous trouverez des instructions s'appliquant dès 
qu'un élément peut être désactivé. 

Pour activer ou désactiver un élément :

■ Cliquez sur l'élément en maintenant 
enfoncées les touches Pomme-Contrôle 
(Macintosh) ou Contrôle-Démarrer (Windows). 

Vous pouvez appliquer les modes Active ou 
Inactive à toutes les pistes ou à l'ensemble des 
pistes sélectionnées en utilisant les touches de 
modification standard de Pro Tools (Option et 
Option+Maj sur Macintosh, Alt et Alt+Maj sous 
Windows). Les entrées latérales prennent en 

charge la commutation active et inactive 
directe, mais ne suivent pas la commutation de 
toutes les pistes ou de l'ensemble des entrées 
latérales sélectionnées.

Concepts MIDI
MIDI (Musical Instrument Digital Interface) est 
un protocole de communication destiné aux 
instruments de musique. Cette norme définie 
par les constructeurs permet de relier entre eux 
deux périphériques, quels qu'en soient la 
marque ou le modèle. Parmi les appareils 
pourvus de fonctions MIDI, citons les 
synthétiseurs, les modules sonores, les boîtes à 
rythmes, les patchs, les processeurs d'effets, les 
interfaces MIDI, les surfaces de contrôle MIDI et 
les séquenceurs. 

Les périphériques MIDI sont dotés de 
connecteurs DIN à 5 broches, repérés IN, OUT, 
ou THRU. Le port MIDI OUT émet les messages. 
Le port MIDI IN reçoit les messages. MIDI THRU 
répercute ce qui est reçu à partir du port IN. Les 
périphériques MIDI se connectent à l'aide de 
câbles MIDI que l'on peut se procurer auprès de 
la plupart des revendeurs d'instruments de 
musique.

Flux de signaux MIDI

Tous les périphériques ne possèdent pas 
forcément les trois ports MIDI (IN, OUT et 
THRU).

répercuté à partir de IN
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Le protocole MIDI offre 16 canaux MIDI par 
port. Un même câble MIDI peut transmettre un 
ensemble de messages distincts concernant 
chacun des 16 canaux. Ces 16 canaux 
correspondent à différents périphériques MIDI 
ou à plusieurs canaux d'un même équipement 
(si celui-ci est multitimbral). Chaque canal peut 
contrôler un son d'instrument différent. 
Par exemple, la basse sur le canal 1, le piano sur 
le canal 2 et la batterie sur le canal 10. Tout 
comme un magnétophone multipiste, un 
séquenceur MIDI peut enregistrer des 
arrangements complexes, même en n'utilisant 
qu'un seul clavier multitimbral.

Termes MIDI

Vous trouverez ci-après un certain nombre de 
termes MIDI courants :

Instrument MIDI (ou instrument virtuel) : plug-in 
d'instrument. Dans ce guide, instrument 
désigne aussi bien les synthétiseurs logiciels que 
les inserts de plug-in.

Interface MIDI : dispositif permettant de relier 
des périphériques MIDI à un ordinateur. 

Périphérique MIDI : tout clavier, générateur 
sonore, périphérique d'effets ou autre 
équipement capable d'envoyer ou de recevoir 
des informations MIDI.

Contrôleur MIDI : tout périphérique MIDI 
pouvant transmettre des données MIDI 
correspondant à une action, au jeu d'un 
instrumentiste. Il s'agit des claviers, contrôleurs 
de guitare MIDI, instruments à vent MIDI, et 
autres. Les contrôleurs transmettent les 
informations MIDI depuis de leur port 
MIDI OUT.

Surface de contrôle MIDI : tout périphérique, tel 
que la MackieHUI (Human User Interface), 
utilisant une connexion MIDI pour envoyer des 
messages de contrôle vers un logiciel, mais qui 
n'est généralement pas utilisé pour enregistrer 
des informations MIDI. 

Générateur de signaux MIDI (Générateur sonore 
MIDI) : tout instrument MIDI pouvant lire un 
son MIDI. Les générateurs sonores reçoivent les 
informations MIDI sur leur port MIDI IN.

Multitimbralité : capacité d'un périphérique 
MIDI à produire plusieurs sons d'instruments 
(par exemple piano, basse, et batterie) 
simultanément sur des canaux séparés. 
Ceci permet à un même générateur sonore MIDI 
de jouer des arrangements entiers.

Canal MIDI : il est possible de transmettre 
jusqu'à 16 canaux de données de performances 
MIDI sur un même câble MIDI. Le numéro du 
canal sépare les différents messages afin que vos 
sources sonores puissent recevoir celui qui leur 
est adressé.

Evénement de changement de programme : 
commande MIDI indiquant à une source sonore 
quel son ou programme prédéterminé utiliser. 
Le protocole MIDI permet de choisir dans un 
ensemble de 128 sons.

Message de sélection de banque : la plupart des 
dispositifs comportent plus de 128 sons disposés 
en banques. Le message de sélection de banque 
est une commande MIDI indiquant la banque 
de sons dans laquelle effectuer la sélection.

Contrôle local : paramètre du contrôleur présent 
sur la plupart des claviers MIDI, qui leur permet 
d'exécuter leur propre générateur sonore. 
La désactivation du « contrôle local » garantit 
que le générateur sonore interne d'un clavier, 
par exemple, ne peut être joué que par les 
messages MIDI externes. Lorsque vous utilisez 
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Pro Tools, le « contrôle local » doit 
généralement être désactivé. Lorsque le 
« contrôle local » est désactivé, votre clavier 
continue de transmettre des données vers son 
port MIDI OUT.

Evénements de contrôleur continu : instructions 
MIDI permettent de modifier en temps réel les 
notes que l'on entend. Parmi elles : le Pitch Bend 
(variation de hauteur), la modulation, le 
volume, le panoramique, etc.

Données System Exclusive : données MIDI 
couramment utilisées pour l'envoi et la 
récupération des informations des paramètres 
de sons préprogrammés, afin de permettre leur 
archivage.

Erreurs courantes à propos 
du MIDI

L'appellation MIDI représente juste des 
informations de contrôle, et non des sons à 
proprement parler. C'est un peu comme le 
rouleau de piano pour un piano : il transmet des 
informations de contrôle sur la note à jouer, sur 
la durée d'émission et sur le niveau de volume. 
Lorsque vous appuyez sur une touche d'un 
clavier MIDI, par exemple, vous envoyez un 
message à un instrument MIDI ou à un 
générateur de signaux pour signaler qu'il faut 
jouer la note en question à la vitesse 
correspondante. Il peut s'agir de son générateur 
de signaux interne, d'un instrument MIDI 
externe ou d'un plug-in d'instrument, lequel 
peut être entièrement intégré à Pro Tools. Pour 
créer ou lire un enregistrement MIDI, vous 
devez disposer d'un instrument MIDI. L'audio 
provenant de votre instrument peut être envoyé 
vers une console de mixage externe ou contrôlé 
via l'interface audio Pro Tools.

Si vous utilisez un instrument MIDI externe, 
vous devez le connecter aux ports MIDI 
reconnus par votre ordinateur. Ces ports 
peuvent se trouver sur une interface Pro Tools 
dotée de ports MIDI (telle que E/S MIDI, Mbox 2 
ou une interface audio M-Audio agréée 
Digidesign) ou sur une autre interface MIDI.

Pour entendre un périphérique MIDI externe, 
vous devez connecter ses sorties audio à une 
console de mixage ou le relier à l'une des entrées 
audio de votre interface audio Pro Tools.

Comme pour tout système Pro Tools, chaque 
périphérique MIDI a ses propres limites quant 
au nombre de voix et d'instruments susceptibles 
d'être reproduits à la fois. Pour plus 
d'informations à ce sujet, consultez la 
documentation du périphérique.

Lorsque vous utilisez la fonctionnalité MIDI 
avec des plug-in d'instrument dans Pro Tools, 
des nœuds MIDI virtuels sont créés. Ces noeuds 
assurent des connexions MIDI logicielles entre 
Pro Tools et d'autres logiciels MIDI, comme les 
plug-in d'instrument. Si vous insérez, par 
exemple, Reason de Propellerhead comme client 
ReWire sur une piste, ses diverses entrées MIDI 
deviennent disponibles pour les sorties MIDI 
des pistes MIDI et d'instrument de Pro Tools. 

Chemins des signaux des instruments MIDI externes
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Chapitre 4 : Fenêtres Pro Tools

Pro Tools offre deux façons complémentaires de 
visualiser un projet : la fenêtre Mix et la fenêtre 
Edit. Il permet également de contrôler le 
transport et les fonctions qui y sont liées, depuis 
la fenêtre Transport.

Pro Tools inclut également des navigateurs 
DigiBase pour la recherche, le tri et 
l'importation de données.

Fenêtre Mix
Dans la fenêtre Mix, les pistes apparaissent 
comme voies, avec des commandes pour les 
inserts, les départs, les affectations d'entrée et de 
sortie, le volume, le panoramique, l'activation 
en enregistrement, le mode d'automation et les 
touches de solo/coupure.

Pour afficher la fenêtre Mix :

■ Choisissez Window > Mix.

Pour afficher toutes les options d'affichage de la 
fenêtre Mix :

■ Choisissez View > Mix Window > All.

Pour basculer de la fenêtre Edit à la fenêtre 
Mix, et inversement, appuyez sur la 
combinaison de touches Pomme + touche 
égal (=) (Macintosh) ou Ctrl + touche égal (=) 
(Windows).

Pour de plus amples informations sur les 
éléments principaux des fenêtres Mix et Edit, 
consultez les références de pages fournies 
dans la Figure 3, page 29 et dans la 
Figure 4, page 30.

Pour plus d'informations sur DigiBase, 
consultez le Guide DigiBase.

Pour plus d'informations sur la sélection 
d'options d'affichage individuelles, reportez-
vous à la section Vues dans les fenêtres 
Mix et Edit, page 578.
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Fenêtre Edit
La fenêtre Edit présente sur une graduation 
temporelle (timeline) des données audio et 
MIDI, ainsi que des données d'automation de la 
console de mixage, afin de faciliter 
l'enregistrement, l'édition et l'organisation des 
pistes. Tout comme dans la fenêtre Mix, chaque 
piste possède ses commandes de préparation à 
l'enregistrement, de mise en solo, de coupure du 
son (Mute) et d'automation. Pro Tools propose 
également une piste vidéo.

Pour afficher la fenêtre Edit :

■ Choisissez Window > Edit.

Pour afficher toutes les options d'affichage de la 
fenêtre Edit :

■ Choisissez View > Edit Window > All. 

Pour plus d'informations sur la sélection 
d'options d'affichage individuelles, reportez-
vous à la section Vues dans les fenêtres 
Mix et Edit, page 578.
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Figure 3.  Fenêtre Mix de Pro Tools
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Figure 4.  Fenêtre Edit de Pro Tools
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Commandes des pistes Outils d'édition

Indicateurs de sélection et 
compteurs de la fenêtre Edit

Compteurs principaux et secondaires

Les compteurs principaux et secondaires 
peuvent être définis pour différents formats 
d'échelle temporelle (tels que Samples, 
Bars:Beats ou Minutes:Seconds). Pour plus 
d'informations, reportez-vous à la section 
Echelle temporelle principale, page 285. 
Ces compteurs figurent également dans la 
fenêtre Transport.

Indicateurs de sélection d'édition

Commandes des pistes de la fenêtre Mix pour une piste 
audio mono (Vue large)

Commandes des pistes de la fenêtre Edit pour une piste 
audio stéréo (hauteur de piste moyenne)

Sélecteur du mode d'automation 
(page 638)

Bouton d'activation à 
l'enregistrement (page 187)

Bouton d'écoute TrackInput (page 191)

Bouton Solo (page 134)

Bouton de coupure (Mute) (page 137)

Sélecteur du mode 
d'automation (page 638)

Bouton de coupure de son 
(Mute) (page 137)

Sélecteur de voix 
(page 129)

Sélecteur de hauteur de piste 
(page 275)

Sélecteur de playlist (page 290)

Bouton du nom de la piste 
(Track Name) (page 120)

Sélecteur de vue de la piste 
(page 271)

Bouton d'activation à 
l'enregistrement (Record 
Enable) (page 187)

Bouton Solo (page 134)

Bouton d'écoute TrackInput 
(page 191)

Sélecteur de base de temps 
(page 288)

Outils d'édition de la fenêtre Edit

Compteurs affichés dans la fenêtre Edit

Indicateurs de sélection d'édition dans la fenêtre Edit

Zoom 
(page 304)

Outils de 
trimming 

(page 310) Sélecteur 
(page 323)

Outils 
d'accrochage 
(page 336)

Outil de 
scrubbing 
(page 318)

Outil Smart 
(page 316)

Bouton de durée
de note personnalisée 

(page 500)

Crayon 
(page 498)

Changement 
de zoom 

(page 304)

Compteurs principaux et secondaires (page 327)

Indicateurs de sélection d'édition (page 339)
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Les indicateurs de sélection d'édition de début 
(Start), de fin (End) et de durée (Length) peuvent 
être défini pour différents formats d'échelle 
temporelle (tels que Samples, Bars:Beats ou 
Minutes:Seconds). Pour plus d'informations, 
reportez-vous à la section Echelle temporelle 
principale, page 285.

Zone d'édition des événements

La zone d'édition des événements indique le 
temps, la hauteur et autres informations 
relatives aux données audio ou MIDI 
sélectionnées. Elle permet également de définir 
des sélections à l'aide du clavier.

Barre de la fenêtre Edit

La barre de la fenêtre Edit contient divers 
sélecteurs, commandes, indicateurs et menus 
déroulants pour travailler dans la fenêtre Edit de 
Pro Tools.

Sélecteurs de vue

Commandes

Indicateurs de valeurs et menus 
déroulants Grid/Nudge

Indicateurs d'emplacement du curseur

Zone d'édition des événements affichant les 
informations concernant la piste MIDI

Sélecteurs de vue dans la barre de la fenêtre Edit

Attributs de note (page 507)
Hauteur (pitch)

Vélocité 
d'attaque

Vélocité de relâchement

Sélecteur de vue de la règle (page 578)

Sélecteur de vue de la fenêtre Edit (page 578)

Commandes dans la barre de la fenêtre Edit

Indicateurs de valeurs et menus déroulants Grid/Nudge 
dans la barre de la fenêtre Edit

Indicateurs d'emplacement du curseur dans la barre de 
la fenêtre Edit

Mode d'affichage de 
linéarité (page 436)

Tabulation vers 
transitoires (page 343)

Focus clavier sur les 
commandes (page 42)

Edition MIDI en 
miroir 

(page 497)

Liaison des sélections 
d'édition et de timeline 

(page 332)

Liaison des sélections 
d'édition et de piste 

(page 333)

Indicateur de valeur de 
grille (Grid) (page 366)

Menu déroulant des valeurs 
de grille (Grid) (page 366)

Indicateur de valeur d'incrément 
(Nudge) (page 368)

Menu 
déroulant des 

valeurs 
d'incrément 

(Nudge) 
(page 368)

Indicateur d'emplacement du curseur (page 323)

Indicateur de valeur d'emplacement 
du curseur (page 323)
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Fenêtre Transport
La fenêtre Transport peut être paramétrée pour 
faire apparaître les commandes de transport, 
compteurs, contrôles MIDI et fonctions 
étendues de base. Les compteurs de la fenêtre 
Transport reflètent les commandes et compteurs 
situés en haut de la fenêtre Edit.

Pour afficher la fenêtre Transport :

■ Choisissez Window > Transport.

Commandes et compteurs de 
transport principaux

Online (En ligne) : met Pro Tools « en ligne » 
afin que la lecture et l'enregistrement soient 
déclenchés par une source de timecode externe.

Retour à zéro : permet de revenir au début de la 
session.

Retour rapide : permet d'effectuer un retour en 
arrière rapide par rapport à l'emplacement de 
lecture actuel. Vous pouvez également cliquer 
plusieurs fois de suite, afin d'effectuer un retour 
arrière par incrément (d'une valeur basée sur 
l'échelle temporelle principale).

Arrêt : arrête la lecture ou l'enregistrement.

Vous pouvez également arrêter le transport à 
l'aide des raccourcis suivants :

• Appuyez sur la barre d'espace.

• Lorsque le mode du pavé numérique est 
réglé sur Transport, appuyez sur la 
touche 0.

Lecture : lance la lecture ou, si vous avez 
préalablement cliqué sur le bouton d'activation 
à l'enregistrement, l'enregistrement à partir du 
point d'insertion sur la timeline.

Fenêtre Transport affichant les principaux compteurs et 
commandes de transport (compteurs principaux et 
secondaires et MIDI non représentés)

Appuyez sur la touche Entrée (Windows) ou 
Retour (Macintosh) pour revenir au début 
de la session.

Début (Start), Fin (End) et 
Durée (Length)

Indicateurs de sélection

En ligne 
(Online)

Retour 
rapide

Avance rapide

Arrêt

Lecture

Activation à
l'enregistre-

ment

Retour à zéro

Fin

Pré-roll

Transport maître

Post-roll

Indicateur d'activation à l'enregistrement de piste

Indicateur d'écoute 
TrackInput

Indicateur de pré-roll

Indicateur de post-roll

Incréments du retour rapide

Format de l'échelle 
temporelle principale

Valeur de l'incrément

Min:Sec 1 seconde

Time code

(Pro Tools HD ou 
Pro Tools LE avec 
DV Toolkit)

1 image

Bars:Beats 1 mesure

Feet+Frame 

(Pro Tools HD ou 
Pro Tools LE avec 
DV Toolkit)

1 pied

Sample 1 seconde

Lorsque le mode du pavé numérique est 
réglé sur Transport, le retour rapide 
s'obtient en appuyant sur 1.
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Lorsque le transport est arrêté, maintenez la 
touche Contrôle (Macintosh) enfoncée ou 
cliquez avec le bouton droit de la souris 
(Windows) pendant que vous cliquez sur 
Lecture pour passer en mode de lecture en 
boucle. Lorsque l'option est activée, un symbole 
de boucle s'inscrit dans le bouton Lecture et 
Pro Tools recommence la lecture du début à la 
fin de la sélection.

Vous pouvez également lancer la lecture à l'aide 
des raccourcis suivants :

• Appuyez sur la barre d'espace.

• Lorsque le mode du pavé numérique est 
réglé sur Transport, appuyez sur la 
touche 0.

Vous pouvez effectuer une lecture à demi-vitesse 
à l'aide des raccourcis suivants :

• Appuyez sur Maj + Barre d'espace.

• Maj (Macintosh) + clic sur le bouton 
Lecture.

Avance rapide : permet d'effectuer une avance 
rapide par rapport au point d'insertion de la 
timeline. Vous pouvez également cliquer 
plusieurs fois de suite, afin d'effectuer une 
avance rapide par incréments (d'une valeur 
basée sur l'échelle temporelle principale).

Fin : permet d'aller directement à la fin de la 
session

Bouton d'activation à l'enregistrement (Record 
Enable) : prépare Pro Tools pour 
l'enregistrement (le bouton clignote). Cliquez 
ensuite sur Lecture pour lancer l'enregistrement 
sur les pistes activées à l'enregistrement 
uniquement.

Incréments de l'avance rapide

Format de l'échelle 
temporelle principale

Valeur de l'incrément

Min:Sec 1 seconde

Time code

(Pro Tools HD ou 
Pro Tools LE avec 
DV Toolkit)

1 image

Bars:Beats 1 mesure

Feet+Frame 

(Pro Tools HD ou 
Pro Tools LE avec 
DV Toolkit)

1 pied

Sample 1 seconde

Lorsque le mode du pavé numérique est 
réglé sur Transport, l'avance rapide 
s'obtient en appuyant sur la touche 2.

Vous pouvez aussi appuyer sur 
Option + Retour (Macintosh) ou 
Ctrl + Entrée sur le clavier alpha-
numérique pour aller à la fin de la 
session.
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Lorsque le transport est arrêté, maintenez la 
touche Contrôle (Macintosh) ou le bouton droit 
de la souris (Windows) enfoncés pendant que 
vous cliquez sur le bouton Record Enable pour 
basculer entre les cinq modes d'enregistrement. 
L'aspect du bouton Record Enable change alors 
pour indiquer le mode sélectionné : vide pour 
non destructif, « D » pour destructif, le symbole 
d'une boucle pour l'enregistrement en boucle, 
« Q » pour QuickPunch et « T » pour 
TrackPunch.

Vous pouvez également lancer l'enregistrement 
à l'aide des raccourcis suivants :

• Appuyez sur la touche F12.

• Appuyez sur Pomme + Barre d'espace 
(Macintosh) ou sur Ctrl + Barre d'espace 
(Windows).

• Lorsque le mode du pavé numérique est 
réglé sur Transport, appuyez sur la 
touche 3.

Indicateur d'activation à l'enregistrement de 
piste : lorsqu'il est allumé (rouge), cela signifie 
qu'au moins une piste audio est actuellement 
activée pour l'enregistrement. Lorsqu'il est 
éteint (gris), cela signifie qu'aucune piste audio 
n'est actuellement activée pour 
l'enregistrement. 

Indicateur d'écoute TrackInput : lorsqu'il est 
allumé (vert), cela signifie qu'au moins une piste 
audio est actuellement réglée sur Input Only 
monitoring (quel que soit le statut d'activation 
de l'enregistrement). Lorsqu'il est éteint (gris), 
cela signifie que toutes les pistes sont réglées sur 
le mode d'écoute Auto Input.

Pré-roll : lors de la lecture ou de 
l'enregistrement, spécifie la durée lue avant la 
lecture de la position actuelle du curseur ou le 
début de la sélection de la timeline. Le pré-roll 
est particulièrement utile avec l'enregistrement 
de type correction (Punch), car il permet de 
« rentrer dans le rythme » avant d'atteindre le 
point d'entrée de l'enregistrement. Pour définir 
la durée de pré-roll désirée, entrez une nouvelle 
valeur dans ce champ, ou faites glisser le 
drapeau de pré-roll dans la règle de référence 
temporelle principale.

Pour activer le pré-roll, cliquez sur le bouton 
pré-roll à gauche du champ pré-roll, ce qui le fait 
passer en surbrillance. 

Post-roll : lors de la lecture ou de 
l'enregistrement, spécifie la durée lue après la fin 
de la sélection de la timeline. Le post-roll est 
utile pour l'enregistrement à la volée, car la 
lecture se poursuit après le point de sortie de 
l'enregistrement, ce qui permet de vérifier que la 
transition avec les sons déjà enregistrés 
s'effectue en douceur. Pour définir la durée de 
post-roll désirée, entrez une nouvelle valeur 
dans ce champ, ou faites glisser le drapeau de 
post-roll dans la règle de référence temporelle 
principale.

Sur des systèmes Macintosh, la touche F12 
est réservée initialement au raccourci clavier 
du menu Spotlight sous Mac OS X. Pour 
utiliser la touche F12 dans Pro Tools, 
réaffectez le raccourci clavier du menu 
Spotlight dans les Préférences Système 
Macintosh. Consultez votre Guide de 
démarrage.

Pour démarrer un enregistrement à demi-
vitesse, appuyez sur Ctrl + Maj + Barre 
d'espace (Windows) ou sur 
Pomme + Maj + Barre d'espace 
(Macintosh).
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Pour activer le post-roll, cliquez sur le bouton 
post-roll à gauche du champ post-roll, ce qui le 
fait passer en surbrillance. 

Start (Début) : spécifie le début d'une plage de 
lecture ou d'enregistrement. Vous pouvez 
définir le point de départ en entrant un 
emplacement dans ce champ ou en faisant 
glisser le marqueur de lecture correspondant 
dans la règle de référence temporelle principale. 
Pour plus d'informations, reportez-vous à la 
section Marqueurs de lecture, page 223.

End (Fin) : spécifie la fin d'une plage de lecture 
ou d'enregistrement. Vous pouvez définir le 
point final en entrant un emplacement dans ce 
champ ou en faisant glisser le marqueur de 
lecture correspondant dans la règle de référence 
temporelle principale. Pour plus d'informations, 
reportez-vous à la section Marqueurs de lecture, 
page 223.

Length (Durée) : spécifie la durée d'une plage de 
lecture ou d'enregistrement. Vous pouvez 
définir la durée en entrant un emplacement 
dans ce champ ou en sélectionnant une plage 
dans la règle de référence temporelle principale.

Sélecteur du transport maître : spécifie l'unité 
principale pour les fonctions de transport et 
donne le moyen de mettre hors ligne les 
périphériques activés.

Pour configurer un transport maître :

■ Cliquez sur le sélecteur du transport maître, 
cliquez sur le menu déroulant Transport et 
sélectionnez un transport maître : Pro Tools, 
Machine, MMC (MIDI Machine Control) ou 
Remote. 

Pour mettre un périphérique hors ligne :

■ Cliquez sur le sélecteur du transport maître, 
cliquez sur le menu déroulant Online et 
désélectionnez le périphérique (MIDI ou 
Machine). Les choix proposés varient en 
fonction du transport maître actuel et des 
périphériques configurés dans Pro Tools. 

Pour remettre un périphérique en ligne, il suffit 
de le resélectionner dans le menu déroulant 
Online.

Commandes MIDILorsque les sélections d'édition et de 
timeline sont liées, vous pouvez vous 
déplacer dans la liste de diffusion d'une 
piste pour définir la plage de lecture et 
d'enregistrement. Pour plus d'informations, 
reportez-vous à la section Activation ou 
désactivation de la liaison des sélections 
d'édition et de timeline, page 332.

Si vous utilisez un périphérique MMC, 
reportez-vous au Chapitre 34, Utilisation 
de la synchronisation.

Si vous utilisez l'option Digidesign 
MachineControl, consultez le Guide 
MachineControl.

Fenêtre Transport affichant les commandes MIDI

Activation de 
la règle de 

tempo 
(Tempo Ruler 

Enable)

Attente de 
note (Wait for 

Note)

Décompte

Métrique actuel

Métronome Fusion MIDI (MIDI Merge)

Tempo actuel

Menu déroulant Tempo 
Resolution (valeur de 

temps) Curseur de tempo
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Pour faire apparaître les commandes MIDI dans la 
fenêtre Transport, procédez comme suit :

■ Choisissez View > Transport > MIDI Controls.

– ou –

■ Pour afficher les commandes MIDI, 
maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Macintosh) pendant que vous 
cliquez sur le bouton Développer/réduire (+) 
dans la fenêtre Transport.

Attendre la note (Wait for Note) : lorsque cette 
option est sélectionnée, l'enregistrement ne 
commence que lorsqu'un événement MIDI est 
reçu. Ceci garantit que l'enregistrement ne 
commence que lorsque vous êtes prêt à jouer, et 
que la première note, ou autre donnée MIDI, est 
enregistrée précisément au début de la plage 
d'enregistrement.

Métronome : lorsque cette fonction est 
sélectionnée, Pro Tools produit une impulsion 
de métronome qu'il est possible de configurer 
dans le but de déclencher des sons intégrés ou 
des instruments MIDI lors de la lecture et de 
l'enregistrement.

Le métronome Pro Tools est configuré dans la 
boîte de dialogue Click/Countoff Options. 
Cliquez deux fois sur le bouton Métronome 
pour ouvrir la boîte de dialogue Click/Countoff 
Options.

Décompte : lorsque cette fonction est 
sélectionnée, Pro Tools décompte le nombre 
spécifié de mesures (indiqué dans le bouton) 
avant le démarrage de la lecture ou de 
l'enregistrement.

Cliquez deux fois sur le bouton de décompte 
pour ouvrir la boîte de dialogue Click/Count 
Options.

Fusion MIDI (MIDI Merge) : lorsque cette option 
est sélectionnée (mode Merge), les données 
MIDI enregistrées fusionnent avec celles qui se 
trouvaient sur la piste. Lorsque cette option est 
désélectionnée (mode Replace), les données 
MIDI enregistrées remplacent celles qui se 
trouvaient sur la piste.

Activation de la règle de tempo (Chef d'orchestre) 
(Tempo Ruler Enable) : lorsque cette fonction est 
sélectionnée, Pro Tools utilise la table de tempo 
définie dans la règle de tempo. Lorsqu'elle est 
désélectionnée, Pro Tools passe en mode tempo 
manuel et ignore la règle de tempo.

Fenêtre Transport affichant les contrôles MIDI

Appuyez sur la touche F11 pour activer la 
fonction Wait for Note. Celle-ci n'est pas 
disponible lorsque l'option Disable F11 for 
Wait for Note est sélectionnée.

Bouton Développer/réduire (+)

Lorsque le mode du pavé numérique est 
réglé sur Transport, il suffit d'appuyer sur la 
touche 7 pour activer le métronome.

Lorsque le mode du pavé numérique est 
réglé sur Transport, il suffit d'appuyer sur la 
touche 8 pour activer le décompte.

Lorsque le mode du pavé numérique est 
réglé sur Transport, il suffit d'appuyer sur la 
touche 9 pour activer la fusion MIDI.
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En mode tempo manuel, vous pouvez entrer 
une valeur BPM dans le champ du tempo, ou 
cliquer en rythme sur la touche T de votre 
clavier alphanumérique.

Curseur de tempo : lorsque la fonction Tempo 
Ruler Enable (Chef d'orchestre) est désactivée, 
Pro Tools ignore les événements de tempo dans 
la piste de tempo et joue un tempo manuel à la 
place. Vous définissez ce tempo au moyen du 
curseur de tempo.

Métrique en cours (Current Meter) : indique la 
métrique (type de mesure) utilisée à l'endroit de 
la session où on se trouve en lecture. Cliquez 
deux fois sur le bouton Current Meter pour 
ouvrir la fenêtre Change Meter.

Tempo actuel : affiche le tempo actuel de la 
session basé sur l'emplacement de lecture. 
En mode tempo manuel, vous pouvez entrer 
une valeur BPM dans ce champ. De plus, lorsque 
le champ du tempo est sélectionné, vous pouvez 
entrer le tempo en le battant en rythme sur un 
contrôleur MIDI.

Menus et fenêtres
Les menus Pro Tools proposent différentes 
commandes pour configurer et utiliser 
Pro Tools, les sessions et les données des 
sessions.

Pro Tools se compose des menus principaux 
suivants :

File : commandes permettant de lire et d'écrire 
des données de session depuis/vers les disques. 

Edit : actions s'appliquant à la sélection en cours 
et ayant un effet sur les données dans les pistes 
ou le Presse-papiers.

View : commandes permettant de personnaliser 
le contenu des diverses fenêtres. 

Track : actions ayant un effet sur toutes les 
pistes sélectionnées.

Region : actions ayant un effet sur toutes les 
régions sélectionnées.

Event : actions ayant un effet sur les événements 
sélectionnés, comme les données MIDI ou les 
données de tempo.

AudioSuite : ensemble de plug-in AudioSuite. 

Options : éléments déterminant le mode de 
réponse de Pro Tools.

Setup : commandes donnant accès à diverses 
boîtes de dialogue à partir desquelles vous 
pouvez configurer les paramètres de 
l'application et des périphériques.

Window : commandes permettant d'ouvrir des 
fenêtres Pro Tools spécifiques. 

Menus déroulants des listes de pistes, 
de régions et de groupes

Les listes de pistes, de régions et de groupes 
contiennent des menus déroulants permettant 
de gérer le contenu de chaque liste.

Menu déroulant de la liste des pistes : 
commandes permettant d'afficher et de masquer 
les pistes dans les fenêtres Mix et Edit. Le menu 
déroulant de la liste des pistes sert également à 
trier le contenu de la liste des pistes. Reportez-
vous à la section Liste de pistes, page 123.

Pour plus d'informations, consultez le 
Guide des menus Pro Tools.
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Menu déroulant de la liste des régions (fenêtre 
Edit uniquement) : commandes permettant de 
rechercher, sélectionner, trier, effacer, 
renommer, horodater, compacter, exporter et 
recalculer les présentations sous forme d'ondes 
d'éléments dans la liste des régions. Ce menu 
déroulant sert également à définir l'ordre dans 
lequel les régions que vous faites glisser à partir 
de la liste des régions sont déposées dans la 
timeline. Reportez-vous à la section Liste des 
régions, page 295.

Menu déroulant de la liste des groupes (groupes 
d'édition et groupes de mixage) : commandes 
permettant de créer, afficher, suspendre et 
supprimer des groupes d'édition et des groupes 
de mixage. Reportez-vous à la section Utilisation 
de la liste des groupes, page 143.

Info-bulles
Pro Tools affiche des info-bulles dans toutes les 
principales fenêtres. Il suffit de placer le curseur 
quelques secondes sur un nom abrégé ou une 
icône ou un outil sans nom pour connaître la 
fonction ou les détails de l'élément (en fonction 
des préférences choisies pour les info-bulles).

Pour configurer les info-bulles pour Pro Tools :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Display.

2  Dans la zone Tool Tips Display, cliquez sur les 
options d'info-bulles que vous souhaitez 
afficher. 

Function : affiche le nom fonctionnel des 
différents éléments Pro Tools (boutons, 
indicateurs, modes, sélecteurs et outils d'édition, 
par exemple).

Details : affiche les noms ou valeurs abrégés ou 
masqués dans Pro Tools pour différents 
éléments Pro Tools (noms d'insert, niveaux de 
gain, paramètres et affectations de routage, par 
exemple).

3  Cliquez sur Done. 

Pour désactiver les info-bulles, ne 
sélectionnez aucune de ces options.
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Chapitre 5 : Raccourcis clavier

Ce chapitre vous donne un aperçu des 
principaux raccourcis clavier utilisés dans 
Pro Tools. Pour avoir la liste complète des 
raccourcis, reportez-vous aux versions PDF 
électroniques des Guides des raccourcis clavier.

Touches de raccourci 
générales
Cette section décrit des raccourcis clavier qui 
s'appliquent à de nombreuses fonctions de 
Pro Tools.

Fonctions des pistes

• Changement de mode d'automation

• Activation des playlists

• Ajout de plug-in

• Préparation à l'enregistrement, la mise en 
solo et la coupure du son des pistes

• Protection des pistes en enregistrement et 
en mise en solo

• Affectation des entrées, des sorties et des 
départs

• Commutation volume/crête/retard de 
l'affichage

• Remise à zéro des afficheurs

• Modification de la hauteur des pistes

Sélection des listes et des paramètres

• Sélection des pistes dans la liste des pistes

• Activation de groupes dans une liste de 
groupes

• Paramètres de la fenêtre Automation 
Enable

• Définition des paramètres d'emplacement 
mémoire

Commande Windows Macintosh

Pour appliquer 
l'action à toutes 
les voies ou pistes

Alt + 
action

Option + 
action

Pour appliquer 
l'action 
uniquement aux 
voies ou aux 
pistes 
sélectionnées

Alt + Maj 
+ action

Option + 
Maj + 
action

Commande Windows Macintosh

Pour basculer 
l'élément et régler 
tous les autres sur 
un même état 
nouveau

Alt + clic sur 
l'élément

Option + cli
c sur 
l'élément

Pour basculer 
l'élément et régler 
tous les autres sur 
l'état inverse

Ctrl + clic 
sur 
l'élément

Pomme + c
lic sur 
l'élément
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Commandes et outils d'édition

◆ Ils servent à déplacer les commandes de plug-
in, les faders et les curseurs, l'outil de scrubbing 
et les données d'automation

Focus clavier
Le focus clavier de Pro Tools détermine le 
fonctionnement des touches alphanumériques. 
Selon le focus clavier activé, les touches de votre 
clavier alphanumérique peuvent servir à 
sélectionner des régions de la liste des régions, à 
activer ou désactiver des groupes, ou à appeler 
une commande d'édition ou de lecture.

Vous ne pouvez activer qu'un focus clavier à la 
fois. L'activation d'un focus clavier désactive le 
focus activé précédemment.

Pro Tools propose trois types de focus clavier :

Focus clavier sur les commandes : lorsque cette 
option est sélectionnée, elle donne accès à de 
nombreux raccourcis directs sur le clavier 
alphabétique pour l'édition et la lecture.

Lorsque le focus clavier sur les commandes est 
désactivé, vous avez toujours accès à n'importe 
lequel de ses raccourcis clavier en maintenant la 
touche Contrôle (Macintosh) ou Démarrer 
(Windows) enfoncée pendant que vous appuyez 
sur la touche appropriée.

Focus clavier sur la liste des régions : lorsque 
cette option est sélectionnée, vous pouvez 
rechercher et sélectionner les régions audio, les 
régions MIDI et les groupes de régions dans la 
liste des régions en tapant les premières lettres 
de leur nom.

Focus clavier sur la liste des groupes : lorsque 
cette option est sélectionnée, vous pouvez 
activer ou désactiver les groupes d'édition et de 
mixage en tapant leur lettre d'identification 
(dans la fenêtre Mix ou Edit).

Commande Windows Macintosh

Réglage précis 
des curseurs, 
boutons et 
points 
d'inflexion

Maintenir la 
touche Ctrl 
enfoncée et 
cliquer sur 
l'élément

Maintenir la 
touche Pomme 
enfoncée et 
cliquer sur 
l'élément

La liste des raccourcis clavier au format 
PDF est disponible dans Pro Tools. 
Sélectionnez Help > Keyboard Shortcuts.

Bouton de focus clavier

Focus clavier sur la 
liste des régions

Focus clavier sur la 
liste des groupes

Focus clavier sur les 
commandes
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Pour définir le focus clavier, effectuez l'une des 
opérations suivantes :

■ Cliquez sur le bouton a-z pour déterminer le 
focus que vous voulez activer.

– ou –

■ Maintenez les touches Pomme + Alt 
(Macintosh) ou Ctrl + Alt (Windows) enfoncées 
pendant que vous appuyez sur l'une des touches 
suivantes : 1 (Commandes), 2 (Liste des régions) 
ou 3 (Liste des groupes).

Modes du pavé numérique
Les préférences de fonctionnement du mode du 
pavé numérique en déterminent le 
comportement pour la fenêtre Transport.

Il y a deux modes Shuttle Lock (Shuttle 
verrouillé) « Classic » et « Transport » et un 
mode Shuttle.

Quel que soit le mode sélectionné, vous pouvez 
toujours utiliser le pavé numérique pour 
sélectionner et entrer des valeurs dans les 
champs de la zone d'édition des événements, 
des indicateurs de sélection d'édition, des 
compteurs principal et secondaire et du 
transport.

Pour définir le mode du pavé numérique :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation.

2  Sous l'option correspondant au mode du pavé 
numérique (Numeric Keypad), sélectionnez un 
mode de pavé numérique (Classic, Transport ou 
Shuttle), puis cliquez sur Done.

Modes Shuttle Lock

En mode Shuttle Lock (aussi bien Classic que 
Transport), vous pouvez utiliser le pavé 
numérique pour effectuer un shuttle avant ou 
arrière à la vitesse que vous désirez :

• La touche 5 correspond à la vitesse 
normale.

• Les touches de 6 à 9 permettent d'avancer à 
des vitesses progressivement plus rapides.

• Les touches de 4 à 1 permettent de reculer 
de plus en plus vite (4 correspond à la 
vitesse Shuttle Lock la plus lente et 1 à la 
plus rapide).

• Appuyez sur 0 pour arrêter le mode Shuttle 
Lock, puis appuyez sur le chiffre voulu pour 
rétablir la vitesse Shuttle Lock 
correspondante.

• Appuyez sur la touche Echap ou sur la barre 
espace pour quitter le mode Shuttle Lock.

Vitesse Shuttle Lock personnalisée

Il est possible de personnaliser la vitesse Shuttle 
Lock d'avance rapide la plus élevée (touche 9) 
(Pro Tools HD et Pro Tools LE avec DV Toolkit 
uniquement). Pour plus d'informations, 
reportez-vous à la section Vitesse de Shuttle 
Lock personnalisée, page 320.

Mode Classic

Ce mode reproduit le fonctionnement de 
Pro Tools dans ses versions antérieures à la 
version 5.0. Lorsque le mode du pavé 
numérique est défini sur Classic, vous pouvez :

• Lire jusqu'à deux pistes audio en mode 
Shuttle Lock. Appuyez sur la touche Ctrl 
(Macintosh) ou de démarrage (Windows), 
puis sur un chiffre de 1 à 9 pour 
sélectionner la vitesse de lecture. 

• Appuyer sur la touche Plus ou Moins pour 
inverser la direction.

Bien qu'il soit possible d'activer un focus 
clavier pour plusieurs fenêtres de plug-in, la 
saisie clavier s'applique uniquement à la 
fenêtre au premier plan.
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• Appuyer sur 0 pour arrêter le mode Shuttle 
Lock, puis appuyez sur le chiffre voulu pour 
rétablir la vitesse Shuttle Lock 
correspondante.

• Appuyer sur la touche Echap ou sur la barre 
espace pour quitter le mode Shuttle Lock.

• Rappeler un emplacement mémoire en 
tapant son numéro, suivi d'un point(.).

Mode Transport

Ce mode permet de définir un ensemble de 
fonctions d'enregistrement et de lecture et de 
piloter les transports depuis le pavé numérique.

Lorsque le mode du pavé numérique est réglé 
sur Transport, vous pouvez également :

• Lire jusqu'à deux pistes audio en mode 
Shuttle Lock. Appuyez sur la touche Ctrl 
(Macintosh) ou de démarrage (Windows), 
puis sur un chiffre de 1 à 9 pour 
sélectionner la vitesse de lecture. 

• Appuyer sur la touche Plus ou Moins pour 
inverser la direction.

• Appuyer sur 0 pour arrêter le mode Shuttle 
Lock, puis appuyez sur le chiffre voulu pour 
rétablir la vitesse Shuttle Lock 
correspondante.

• Appuyer sur la touche Echap ou sur la barre 
espace pour quitter le mode Shuttle Lock.

• Rappeler un emplacement mémoire en 
tapant un point (.), le numéro de 
l'emplacement mémoire, puis un autre 
point (.).

Mode Shuttle
(Pro Tools HD uniquement)

Pro Tools offre une autre forme de lecture en 
mode Shuttle, différente de celles des deux 
modes Shuttle Lock (shuttle vérrouillé). Lorsque 
le mode du pavé numérique est réglé sur Shuttle, 
la lecture de la sélection d'édition actuelle 
commence lorsque vous appuyez sur les touches 
du pavé numérique et dure tant que vous les 
maintenez enfoncées ; la lecture s'arrête dès 
relâchement des touches. Vous pouvez définir 
plusieurs vitesses de lecture, en avant ou en 
arrière. Dans ce mode, les pré/post-roll sont 
ignorés.
:

Fonction Touche

Activation/désactivation du clic 7

Activation/désactivation du 
décompte

8

Mode de fusion/remplacement 
MIDI

9

Activation/désactivation de la 
lecture en boucle

4

Activation/désactivation de 
l'enregistrement en boucle

5

Activation/désactivation du 
mode QuickPunch

6

Retour rapide 1

Avance rapide 2

Activation à l'enregistrement 3

Lecture/Arrêt 0

Vitesses de lecture Touche

1x Avance rapide 6

1x Retour arrière 4

4x Avance rapide 9

4x Retour arrière 7

1/4x Avance rapide 3

1/4x Retour arrière 1

1/2x Avance rapide 5+6

1/2x Retour arrière 5+4
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Lorsque le mode du pavé numérique est défini 
sur Shuttle, vous pouvez également :

• Rappeler un emplacement mémoire en tapant 
un point (.), le numéro de l'emplacement 
mémoire, puis un autre point (.).

2x Avance rapide 8+9

2x Retour arrière 8+7

1/16x Avance rapide 2+3

1/16x Retour arrière 2+1

Sélection de boucle (1x) 0

Les modes Shuttle Lock ne sont pas 
disponibles lorsque le mode du pavé 
numérique est réglé sur Shuttle.

Vitesses de lecture Touche
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Chapitre 6 : Sessions

Ce chapitre expose un certain nombre de 
notions de base concernant le démarrage d'un 
projet dans Pro Tools, notamment la 
configuration et la sauvegarde d'une session 
Pro Tools.

Démarrage et arrêt du 
système
Pour que les différents composants de votre 
système Pro Tools puissent communiquer 
correctement entre eux, vous devez les mettre 
sous tension dans un ordre précis.

Lancez le système Pro Tools selon l'ordre suivant :

1  Dans le cas des systèmes Pro Tools|HD dotés 
d'un châssis d'extension, mettez ce dernier sous 
tension.

2  Mettez tous les disques durs externes sous 
tension. Attendez environ 10 secondes qu'ils 
aient atteint leur vitesse nominale.

3  Mettez sous tension les interfaces et 
périphériques MIDI ou les périphériques de 
synchronisation.

4  Diminuez le volume de tous les périphériques 
de sortie du système. 

5  S'il s'agit d'un système Pro Tools|HD, mettez 
vos interfaces audio Pro Tools sous tension. 
Attendez au moins 15 secondes que le dispositif 
constituant le système soit initialisé.

6  Allumez l'ordinateur. 

7  Lancez Pro Tools ou toute autre application 
tierce audio ou MIDI. 

Arrêtez votre système Pro Tools dans l'ordre 
suivant :

1  Quittez Pro Tools et toute autre application 
utilisée. 

• Pour quitter Pro Tools, choisissez File > Exit 
(Windows) ou Pro Tools > Quit 
(Macintosh).

2  Réduisez le volume de tous les périphériques 
de sortie du système. 

3  Mettez votre ordinateur hors tension.

4  Pour les systèmes Pro Tools|HD, mettez hors 
tension les interfaces audio.

5  Dans le cas des systèmes Pro Tools|HD dotés 
d'un châssis d'extension, mettez ce dernier hors 
tension.

6  Mettez hors tension les interfaces et 
périphériques MIDI ou les périphériques de 
synchronisation.

7  Mettez hors tension les disques durs externes.
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Configuration des paramètres 
du système Pro Tools (dans le 
moteur de lecture)
Pro Tools  permet de modifier les performances 
de votre système en changeant les paramètres 
système qui affectent sa puissance lors des 
opérations de traitement, de lecture et 
d'enregistrement.

Pour modifier ces paramètres système, vous 
devez accéder à la boîte de dialogue Playback 
Engine (Setup > Playback Engine).

Dans la plupart des cas, les paramètres par 
défaut de votre système assurent des 
performances optimales, mais vous pouvez les 
régler afin que le système puisse prendre en 
charge de longues sessions et des sessions à 
traitement intensif de Pro Tools. 

Taille du buffer matériel

La taille du buffer matériel (H/W Buffer Size) 
contrôle la taille du cache matériel utilisé pour 
effectuer les tâches de traitement hôte, telles que 
le traitement des effets des plug-in temps réel 
(RTAS). 

◆ Des valeurs inférieures réduisent la latence 
d'écoute et sont particulièrement adaptées à 
l'enregistrement des entrées en direct. 

◆ Des valeurs plus élevées permettent 
d'effectuer un traitement audio plus avancé et 
d'appliquer un plus grand nombre d'effets. De 
plus, elles sont utiles lorsque vous mixez et que 
vous utilisez davantage de plug-in RTAS.

Pour modifier la taille du buffer matériel :

1  Sélectionnez Setup > Playback Engine. 

2  Dans le menu déroulant H/W Buffer Size, 
sélectionnez la taille du buffer audio, exprimée 
en nombre d'échantillons. 

3  Cliquez sur OK. 

Processeurs RTAS

Le paramètre RTAS Processors permet de 
déterminer le nombre de processeurs de votre 
ordinateur alloués au traitement des plug-in 
RTAS (plug-in en temps réel).

Dans le cas d'ordinateurs équipés de plusieurs 
processeurs ou de la fonction de traitement 
multicœur ou Hyper-Threading, ce paramètre 
vous permet d'activer la prise en charge 
multiprocesseur pour les traitements RTAS. 
Utilisé conjointement avec le paramètre CPU 
Usage Limit, il vous permet de contrôler le 
traitement RTAS et d'autres tâches Pro Tools 
réalisées par le système.

Par exemple : 

• Pour les sessions avec un nombre important 
de plug-in RTAS, vous pouvez allouer 
2 processeurs au moins aux plug-in RTAS et 
prévoir une limite d'utilisation élevée.

• Pour les sessions comptant un faible nombre 
de plug-in RTAS, limitez le nombre de 
processeurs alloués à ces plug-in et prévoyez 
une limite d'utilisation de processeur assez 
basse pour éviter de monopoliser les 
ressources et optimiser la précision de 
l'automation, la réponse de l'écran ou les 
performances vidéo. Un buffer de grande taille entraîne une 

réponse plus lente de l'écran et une certaine 
latence d'écoute et risque d'affecter la 
précision de l'automation des plug-in, les 
données de Mute et les pistes MIDI.
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• Augmentez ou réduisez ces paramètres pour 
assurer la conversion TDM/RTAS. 
La conversion TDM/RTAS peut être nécessaire 
au cours de l'enregistrement. Cela dépend des 
latences, des besoins en matière d'assignation 
des voix et des possibilités d'écoute en 
enregistrement des plug-in TDM et RTAS. 

• Selon l'importance accordée à la réponse 
générale de l'écran et aux performances vidéo 
et selon la densité des données d'automation 
utilisées, vous devrez parfois trouver le 
meilleur compromis possible (traitement 
RTAS et limite d'utilisation du processeur) 
pour obtenir les résultats escomptés. Ainsi, 
pour optimiser la réponse de l'écran au cours 
d'une session de taille moyenne avec un 
nombre modéré de plug-in RTAS, il peut-être 
préférable de réduire le nombre de processeurs 
RTAS alloués et de maintenir une limite 
d'utilisation maximale (99%) sur un système 
doté d'un seul processeur.

La fenêtre System Usage indique, au moyen d'un 
simple indicateur, le mode de traitement 
combiné RTAS appliqué sur tous les processeurs 
activés, quel que soit le nombre de processeurs 
dans le système. Si vous constatez que vous êtes 
à la limite des ressources disponibles, augmentez 
le nombre de processeurs RTAS et/ou le 
paramètre CPU Usage Limit. Pour en savoir plus, 
reportez-vous à la section Utilisation du 
système, page 70.

Pour définir le nombre de processeurs RTAS :

1  Sélectionnez Setup > Playback Engine.

2  Dans le menu déroulant RTAS Processors, 
sélectionnez le nombre de processeurs 
disponibles que vous souhaitez allouer. Cela 
varie en fonction du nombre de processeurs 
disponibles sur votre ordinateur :

• Choisissez 1 Processor pour limiter le 
traitement RTAS à un processeur dans le 
système. 

• Choisissez 2 Processors pour permettre 
l'équilibrage de charge entre deux 
processeurs disponibles.

• Sur les systèmes à base de quatre 
processeurs ou plus, sélectionnez le 
nombre de processeurs RTAS voulu.

3  Cliquez sur OK.

Playback Engine, boîte de dialogue
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Limite d'utilisation du processeur

La limite d'utilisation du processeur (CPU Usage 
Limit) contrôle le pourcentage de ressources du 
processeur alloué aux tâches de traitement hôte 
de Pro Tools. Utilisé conjointement avec le 
paramètre RTAS Processors, il vous permet de 
contrôler les tâches Pro Tools réalisées par le 
système.

◆ En attribuant une valeur peu élevée au 
paramètre CPU Usage Limit, vous limitez 
l'impact du traitement de Pro Tools sur d'autres 
tâches faisant un usage intensif du processeur, 
comme le rafraîchissement d'écran. Ceci est 
utile lorsque la réponse de système est très lente 
ou que d'autres applications sont en cours 
d'utilisation en même temps que Pro Tools.

◆ Un pourcentage élevé d'utilisation du 
processeur permet d'allouer davantage de 
puissance de traitement à Pro Tools et s'avère 
utile lorsque vous lisez de larges sessions ou que 
vous utilisez davantage de plug-in temps réel. 

La valeur maximale du pourcentage d'utilisation 
du processeur est de 85 % pour les ordinateurs à 
processeur unique (sauf pour Digi 002, pour 
lequel la limite est de 99 %) et de 99 % pour les 
ordinateurs à plusieurs processeurs (lorsque 
cette valeur est égale à 99, un processeur est 
entièrement dédié à Pro Tools).

Sur les ordinateurs à processeur multiple, la 
valeur maximale du pourcentage d'utilisation 
du processeur est réduite lorsque vous utilisez 
tous vos processeurs (comme indiqué dans le 
menu déroulant RTAS Processing). Ainsi, avec 
des ordinateurs à double processeur, la limite est 
de 90%. Sur des ordinateurs à quadruple 
processeur, cette limite atteint 95%.

Pour modifier la limite d'utilisation du processeur :

1  Sélectionnez Setup > Playback Engine. 

2  Dans le menu déroulant CPU Usage Limit, 
sélectionnez le pourcentage de puissance du 
processeur à allouer à Pro Tools. 

3  Cliquez sur OK.

Nombre de voix
(Pro Tools HD uniquement)

Sur les systèmes Pro Tools|HD, le paramètre 
Number of Voices vous permet de déterminer le 
nombre de voix disponibles et la façon dont ces 
voix sont affectées aux DSP dans votre système. 
Par exemple, le nombre de voix par défaut sur 
un système Pro Tools|HD 1 est de 48, avec un 
DSP (à des vitesses d'échantillonnage de 
44,1 kHz ou 48 kHz). 

Selon la fréquence d'échantillonnage actuelle et 
le nombre de cartes Pro Tools|HD de votre 
système, plusieurs choix sont possibles. Pour 
connaître les limites de voix des différents 
systèmes Pro Tools|HD, reportez-vous à la 
section Nombre maximal de voix en lecture ou 
en enregistrement sur les systèmes 
Pro Tools|HD, page 9.

l'augmentation du pourcentage 
d'utilisation du processeur peut entraîner 
un ralentissement de l'affichage des écrans 
sur des ordinateurs lents.

La modification du nombre de voix affecte 
l'utilisation des ressources DSP, le nombre 
total de pistes pouvant héberger des voix et 
les performances générales de votre système. 
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Pour modifier le nombre de voix et de ressources 
DSP à allouer :

1  Sélectionnez Setup > Playback Engine.

2  Sélectionnez le nombre de voix et de DSP à 
allouer pour l'assignation des voix en 
sélectionnant une valeur dans le menu 
déroulant Number of Voices. 

• Sélectionnez un nombre élevé de voix si les 
cartes Pro Tools|HD sont les seules cartes 
PCI installées sur votre ordinateur ou si 
vous utilisez un châssis d'extension pour 
augmenter le nombre de pistes prises en 
charge.

• Sélectionnez un nombre de voix 
intermédiaire, lorsque les cartes 
Pro Tools|HD sont installées dans un 
châssis d'extension, ou lorsque d'autres 
cartes PCI sont utilisées avec les cartes 
Pro Tools|HD.

• Sélectionnez un nombre de voix restreint, 
si vous utilisez des cartes PCI dotées de 
bandes passantes étendues (cartes de 
capture vidéo, par exemple) avec vos cartes 
Pro Tools|HD. De plus, pour libérer des DSP 
pour les plug-in temps réel et le traitement, 
sélectionnez le nombre minimal de voix et 
de DSP nécessaires pour lire la session 
actuelle.

3  Cliquez sur OK. 

Fréquence d'échantillonnage par 
défaut

Le paramètre Sample Rate (fréquence 
d'échantillonnage) s'affiche par défaut lorsque 
vous créez une session. La fréquence 
d'échantillonnage ne peut être modifiée que si 
aucune session n'est ouverte. 

Pour modifier la fréquence d'échantillonnage par 
défaut :

1  Sélectionnez Setup > Playback Engine. 

2  Dans le menu déroulant Sample Rate, 
sélectionnez une fréquence d'échantillonnage.

3  Cliquez sur OK.

Moteur de compensation de 
retard
(Pro Tools HD uniquement)

Le moteur de compensation de retard (Delay 
Compensation Engine) permet de gérer les 
retards DSP dans la console de mixage Pro Tools. 

Il existe trois paramètres dans la boîte de 
dialogue Playback Engine permettant d'attribuer 
des ressources DSP à la fonction de 
compensation de retard : 

None : n'attribue aucune ressource DSP pour la 
compensation de retard.

Playback Engine, boîte de dialogue

Avec Pro Tools HD, le paramètre Sample 
Rate peut avoir un impact sur le nombre de 
voix disponibles.

Vous pouvez modifier la fréquence 
d'échantillonnage lors de la création d'une 
session Pro Tools en sélectionnant une 
fréquence différente dans la boîte de 
dialogue New Session (Reportez-vous à la 
section Création d'une session, page 59.)
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Short : attribue un nombre minimum de 
ressources DSP pour la compensation de retard 
de chaque canal. Il s'agit du paramètre le plus 
efficace pour les systèmes Pro Tools|HD.

Long : attribue un nombre maximum de 
ressources DSP pour la compensation de retard 
de chaque canal. Ce paramètre fait appel à la 
mémoire SRAM contenue sur les DSP utilisées 
par les plug-in de plus haut-débit.

Pour configurer le moteur de compensation de 
retard, procédez comme suit :

1  Sélectionnez Setup > Playback Engine.

2  Dans le menu déroulant Delay Compensation 
Engine, sélectionnez un paramètre de 
compensation de retard.

3  Cliquez sur OK.

Le paramètre de compensation de retard choisi 
est enregistré en tant que préférence de session 
et préférence système.

Taille du buffer de lecture DAE

Le paramètre DAE Playback Buffer Size 
détermine la quantité de mémoire DAE allouée 
aux buffers de disque. La taille du buffer de 
lecture DAE maximale pour les opérations de 
disque correspond au niveau 2.

◆ Une taille de buffer de lecture DAE inférieure 
au niveau 2 peut améliorer la vitesse d'amorce 
de lecture et d'enregistrement. En revanche, la 
lecture et l'enregistrement des pistes peuvent 
être plus difficiles si vos sessions contiennent un 
nombre élevé de pistes ou de points d'édition ou 
s'exécutent sur des disques durs lents ou très 
fragmentés.

◆ Une taille supérieure au niveau 2 permet une 
densité d'édition plus élevée au cours d'une 
session ou un nombre de pistes plus important 
lors de l'utilisation de disques durs plus lents. 
Cependant, un niveau élevé peut également être 
à l'origine d'un retard lors du démarrage de la 
lecture ou de l'enregistrement et produire un 
retard audible plus long lors de l'édition en 
cours de lecture.

Pour modifier la taille du buffer de lecture DAE :

1  Sélectionnez Setup > Playback Engine.

2  Dans le menu déroulant DAE Playback 
Buffer, sélectionnez une taille de buffer. 
La configuration de mémoire requise pour 
chaque paramètre est indiquée dans la partie 
inférieure de la boîte de dialogue Playback 
Engine.

3  Cliquez sur OK. 

4  Si Pro Tools nécessite davantage de mémoire 
système pour le buffer de lecture DAE, vous êtes 
invité à redémarrer l'ordinateur.

Pour plus d'informations, reportez-vous à la 
section Compensation de retard, 
page 602. 

Une grande taille de buffer de lecture DAE 
réduit la mémoire système affectée aux 
autres tâches. Nous vous conseillons 
d'utiliser la valeur par défaut (niveau 2) 
à moins que vous ne rencontriez les 
erreurs -073 de disques trop lents ou trop 
fragmentés. 

Playback Engine, boîte de dialogue
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Affectation de mémoire système
(Pro Tools HD uniquement)

Lors du démarrage de l'ordinateur, Pro Tools 
attribue automatiquement une partie de la 
mémoire système au buffer de lecture DAE. 
Cette portion de mémoire n'est plus disponible 
pour les autres applications, même si Pro Tools 
n'est pas en cours d'exécution.

Vous pouvez définir Pro Tools de sorte à ne 
réserver qu'une quantité minimale de la 
mémoire requise afin de conserver un 
maximum de mémoire système pour d'autres 
applications. 

Pour limiter l'allocation de mémoire système :

1  Sélectionnez Setup > Playback Engine.

2  Sélectionnez l'option Minimize System 
Memory Allocation. 

3  Cliquez sur OK. 

4  Effectuez l'une des opérations suivantes :

• Si vous travaillez sur un système Windows, 
redémarrez votre ordinateur. 

– ou –

• Sur un système Macintosh, saisissez votre 
mot de passe lorsque vous y êtes invité, 
puis redémarrez votre ordinateur.

Configuration des paramètres 
matériels Pro Tools
Pro Tools vous permet de configurer 
l'acheminement des signaux, le format d'E/S 
numérique, la fréquence d'échantillonnage par 
défaut, ainsi que d'autres paramètres matériels 
variant selon votre système. 

La section suivante explique comment 
configurer un système Pro Tools|HD avec une 
ou plusieurs interfaces Pro Tools|HD (avec une 
connexion à une ou plusieurs interfaces Legacy).

Configuration du dispositif 
Pro Tools|HD

Sur les systèmes Pro Tools|HD, vous devez 
configurer les paramètres matériels de chaque 
interface audio connectée à votre système. Par 
exemple, les systèmes Pro Tools|HD prennent 
en charge des interfaces audio 192 I/O, 
192 Numérique I/O, 96 I/O ou 96i I/O 
branchées à des cartes HD Core et HD Accel ou 
HD Process dans le système. Les interfaces 
192 I/O, 192 Numérique I/O, and 96 I/O 
peuvent être associées à des interfaces 
supplémentaires (notamment les interfaces 
audio Digidesign plus anciennes ou les interfaces 
d'E/S Legacy, comme les interfaces 888|24 I/O, 
882|20 I/O or 1622 I/O). Pour plus 
d'informations, consultez le Chapitre 2, 
Configurations des systèmes Pro Tools.

Pour configurer un système Pro Tools LE, 
reportez-vous au Guide de démarrage fourni 
avec ce système.
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Configuration de la boîte de dialogue 
Hardware Setup

L'onglet Main de la boîte de dialogue Hardware 
Setup permet de définir les entrées et sorties 
physiques de votre interface audio affectées aux 
entrées et sorties Pro Tools.

Des pages supplémentaires sont disponibles afin 
de configurer d'autres paramètres pour chaque 
interface audio (tels que les niveaux de 
fonctionnement). Pour plus d'informations, 
reportez-vous au Guide de démarrage de votre 
système ou au guide de votre interface audio.

Pour configurer des interfaces audio sur un 
système Pro Tools|HD :

1  Sélectionnez Setup > Hardware.

2  Dans la liste Peripherals, sélectionnez 
l'interface audio Digidesign connectée à la 
première carte de votre système. Il s'agit de la 
première interface figurant dans la liste.

3  Cliquez sur l'onglet Main.

4  Dans le menu déroulant Clock Source, 
sélectionnez la source d'horloge appropriée pour 
le système. Vous utiliserez Internal dans de 
nombreux cas. Les autres choix permettent 
d'adapter Pro Tools à des sources d'horloge 
externes. Selon l'interface audio, vous avez le 
choix parmi les options Clock Source suivantes : 
AES/EBU [Encl], S/PDIF, Optical [Encl], AES/EBU 
1–8, TDIF, ADAT et Word Clock (des fréquences 
de signal Word Clock optionnelles sont 
disponibles si vous travaillez avec des 
fréquences d'échantillonnage plus élevées).

5  Dans le menu déroulant Ext. Clock Output, 
sélectionnez la sortie d'horloge appropriée à 
envoyer aux périphériques connectés à votre 
interface audio.

6  Sélectionnez le port I/O numérique actif sur le 
châssis de votre interface audio sous Digital 
Format. Vous avez le choix entre les options 
suivantes : AES/EBU, S/PDIF et Optical (S/PDIF). 
La sélection de l'option Optical (S/PDIF) 
redéfinit le port d'E/S optique (constitué, par 
défaut, de huit canaux d'E/S ADAT) sur deux 
canaux d'E/S S/PDIF optiques.

7  Pour la compatibilité S/PDIF avec les 
enregistreurs DAT Tascam DA30, sélectionnez 
Tascam sous S/PDIF Format.

8  Pour l'interface 96 I/O, cliquez sur le menu 
déroulant Meters et sélectionnez l'affichage des 
vumètres d'entrée ou de sortie.

9  Dans les menus déroulants Input et Output, 
sélectionnez les ports physiques (tels que 
Analog 1–2 ou Optical 1–2) qui seront affectés 
aux canaux d'entrée et de sortie Pro Tools 
(comme Ch 1–2 ou Ch 3–4), affichés dans la 
partie gauche de la page Main.

Boîte de dialogue Hardware Setup pour l'interface 96 
I/O (onglet Main)

Vous pouvez identifier les connexions de 
l'interface audio à tout moment en 
sélectionnant le nom de l'interface dans la 
liste des périphériques (Peripherals) puis en 
cliquant sur Identify. Tous les voyants 
situés sur le panneau avant de l'interface 
s'illuminent.
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Pour différencier les entrées et sorties d'un 
même format, celles-ci sont désignées 
différemment dans les menus déroulants des 
canaux d'entrée et de sortie. Par exemple, les 
entrées et sorties AES/EBU du châssis de 
l'interface d'E/S 192 sont répertoriées comme 
AES/EBU [Encl], tandis que les entrées et sorties 
AES/EBU de la carte d'E/S numérique installée en 
usine sont identifiées (par paires) comme 
AES/EBU 1–2, AES/EBU 3–4, AES/EBU 5–6 et 
AES/EBU 7–8. Pour les interfaces d'E/S 192 
dotées de la carte optionnelle numérique d'E/S, 
les ports supplémentaires AES/EBU I/O de la 
carte optionnelle sont identifiés comme 
AES/EBU 9–10, AES/EBU 11–12, AES/EBU 13–14 
et AES/EBU 15–16.

10  Cliquez sur d'autres onglets (tels que Analog 
In et Analog Out) pour accéder à d'autres 
options de configuration propres à l'interface 
audio, à savoir :

• Dans l'interface 96 I/O, la configuration des 
niveaux de fonctionnement des entrées et 
sorties analogiques (+4 dBu ou -10 dBV).

• Dans l'interface 96i I/O, la configuration 
des niveaux de fonctionnement des entrées 
et sorties analogiques (+4 dBu ou -10 dBV).

• Dans l'entrée analogique d'E/S 192, la 
définition du connecteur d'entrée et de 
l'option Soft Limit.

• Dans l'interface 192 I/O, la configuration 
de deux ensembles de réglages pour les 
entrées et les sorties analogiques.

• Dans l'interface d'E/S 192 et d'E/S 
numérique 192, la configuration de la 
conversion de fréquence d'échantillonnage 
en temps réel pour les entrées numériques.

• Dans l'interface d'E/S 192 et d'E/S 
numérique 192, la configuration des 
entrées et sorties de n'importe quelle carte 
optionnelle A/N, N/A ou I/O numérique 
installée dans l'appareil.

11  Répétez les étapes précédentes pour toute 
interface audio Pro Tools|HD supplémentaire.

12  Répétez les étapes précédentes pour toute 
interface d'E/SLegacy connectée aux interfaces 
audio Pro Tools|HD de votre système. Avant de 
pouvoir configurer une interface d'E/S Legacy, 
vous devez l'initialiser dans Hardware Setup 
(Reportez-vous à la section Initialisation des 
périphériques Legacy MIX (sur un système 
Pro Tools|HD), page 57.).

13  Cliquez sur OK.

Initialisation des périphériques Legacy 
MIX (sur un système Pro Tools|HD)

Avant de pouvoir configurer une interface d'E/S 
Legacy, vous devez l'initialiser dans Hardware 
Setup. 

Pour initialiser une interface d'E/S Legacy sur un 
système Pro Tools|HD :

1  Démarrez votre système Pro Tools. Reportez-
vous à la section Démarrage et arrêt du système, 
page 49.

2  Réduisez le volume de tous les composants de 
sortie du système. Un son numérique très 
puissant risque d'être émis avant l'initialisation 
de l'interface d'E/S Legacy.

3  Mettez l'interface d'E/S Legacy sous tension.

Pour plus d'informations sur les paramètres 
de configuration matérielle de chaque 
interface audio Pro Tools|HD, reportez-
vous au Guide de démarrage Pro Tools|HD 
ou au manuel de votre interface audio.

Utilisez les flèches haut/bas pour faire 
défiler les périphériques dans la liste 
Peripherals.
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4  Dans la liste Peripherals, sélectionnez 
l'interface audio principale (l'interface à laquelle 
votre interface d'E/S Legacy est connectée).

5  Dans la page Main de la boîte de dialogue 
Hardware Setup, sélectionnez l'option Legacy 
I/O dans Port Settings.

6  Dans la liste Peripherals, No Interface est 
indiqué deux fois, directement sous l'interface 
audio principale. Cliquez sur la première 
occurrence de No Interface. Un menu déroulant 
Interface s'affiche dans la boîte de dialogue 
Hardware Setup, répertoriant les options 
d'interfaces d'entrée/sortie prises en charge.

7  Dans le menu déroulant Interface, 
sélectionnez votre interface d'E/S Legacy. 

8  Réglez le paramètre External Clock Output de 
l'interface Pro Tools|HD sur 256x, ce qui 
correspond à la vitesse d'horloge requise pour les 
interfaces d'E/S Legacy. 

La page Main affiche les commandes pouvant 
être configurées.

9  Répétez les étapes précédentes pour chaque 
interface d'E/S Legacy.

Configuration de la boîte de dialogue 
I/O Setup

La boîte de dialogue I/O Setup offre une 
représentation graphique de l'acheminement 
des signaux pour chaque interface audio 
branchée, ainsi que des commandes 
d'affectation des ports physiques sur l'interface 
audio aux entrées et sorties Pro Tools. Les 
paramètres de ces commandes reflètent ceux des 
commandes d'acheminement de la boîte de 

dialogue Hardware Setup : les modifications 
apportées au routage dans une boîte de dialogue 
sont toujours reflétées dans l'autre boîte de 
dialogue. 

La boîte de dialogue I/O Setup permet 
d'identifier et d'affecter les chemins de signaux 
d'entrée, de départ, d'insert et de bus de 
Pro Tools. La boîte de dialogue I/O Setup 
comprend également des paramètres 
importants pour l'écoute, les vumètres et le son 
surround. Pour plus d'informations, consultez le 
Chapitre 7, Configuration des E/S.

Acheminement d'une paire de sorties 
Pro Tools vers des destinations 
multiples

Les paires de canaux Pro Tools peuvent être 
affectées à plusieurs sorties d'une interface audio 
à l'aide de la boîte de dialogue Hardware Setup. 
Si, par exemple, vous affectez les deux sorties 
d'interface Analog 1–2 et Analog 3–4 à la paire 
de sorties Pro Tools 1–2, un signal envoyé aux 
sorties Pro Tools 1–2 est acheminé 
simultanément aux deux paires de sorties de 
l'interface audio.

Ceci vous donne la possibilité d'envoyer le 
même signal (tel qu'une paire stéréo, un 
prémixage ou un mixage multicanal) vers de 
nombreuses destinations (telles que divers 
périphériques de mastering).

Pour sélectionner plusieurs ports de sortie pour 
une paire de canaux de sortie Pro Tools :

1  Sélectionnez Setup > Hardware.

2  Dans la liste des périphériques, sélectionnez 
l'interface souhaitée.

3  Cliquez sur l'onglet Main. 

4  Sélectionnez une paire de ports de sortie 
depuis un menu déroulant Output.

Pour de plus amples informations sur les 
paramètres Hardware Setup pour chaque 
interface audio Legacy, consultez le guide 
fourni avec l'interface.
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5  Appuyez sur la touche Windows (Windows) 
ou Contrôle (Macintosh), cliquez à nouveau sur 
ce même menu déroulant pour sélectionner une 
paire de ports de sortie supplémentaire.

Le nom de la sortie est précédé d'un signe plus 
(+) pour indiquer que plusieurs ports de sortie 
ont été sélectionnés. Dans le menu déroulant, 
chaque paire de ports physiques affectée à la 
paire de sorties Pro Tools est signalée par une 
coche.

6  Répétez les étapes précédentes pour 
sélectionner des destinations de sortie 
supplémentaires. Le nombre de sorties 
disponibles sur votre système est la seule limite 
au choix des sorties.

Les paires de sorties Pro Tools peuvent 
également être acheminées vers plusieurs sorties 
depuis la boîte de dialogue I/O Setup. Pour plus 
d'informations, reportez-vous à la section 
Affectation de l'I/O matérielle à l'I/O Pro Tools, 
page 93.

Création d'une session
Lorsque vous démarrez un projet dans 
Pro Tools, vous devez créer une session. 

Pour créer une session :

1  Choisissez File > New Session.

2  Sélectionnez le volume sur lequel vous voulez 
enregistrer la session. Il est préférable de 
sauvegarder la session sur un volume réservé 
aux données audio.

3  Sélectionnez le format de fichier audio de la 
session.

Pour une compatibilité optimale entre les 
environnements Windows et Macintosh, 
choisissez le type de fichier BWF (.WAV). 

Les fichiers Sound Designer II (SD II) files ne 
sont pas pris en charge sur les systèmes 
Windows ou à des fréquences d'échantillonnage 
supérieures à 48 kHz.

4  Sélectionnez la résolution (16 bits ou 24 bits) 
et la fréquence d'échantillonnage.

Boîte de dialogue Hardware Setup pour l'interface 96 
I/O (onglet Main)

Boîte de dialogue New Session
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5  Sélectionnez les paramètres d'E/S à utiliser 
pour la session. Votre système est livré avec 
plusieurs configurations d'E/S préétablies, mais 
vous pouvez sélectionner une configuration 
d'E/S personnalisée, que vous avez créée vous-
même. Pour plus d'informations, reportez-vous 
à la section Chapitre 7, Configuration des E/S.

6  Nommez la session.

7  Cliquez sur Save.

Sélection de la résolution et de la 
fréquence d'échantillonnage

Lorsque vous sélectionnez une résolution ou 
une fréquence d'échantillonnage pour votre 
session, prenez en compte les critères de fidélité, 
de compatibilité avec les autres systèmes et 
d'espace de stockage. 

La résolution et la fréquence d'échantillonnage 
affectent également la puissance de mixage 
disponible pour une session. Le travail en 24 bits 
ou avec des fréquences d'échantillonnage 
élevées réduit le nombre de canaux de console 
disponibles. Pour plus d'informations, reportez-
vous au Guide de démarrage Pro Tools|HD.

Il est impossible de combiner différentes 
résolutions au sein d'une session Pro Tools ; les 
fichiers de résolution différente doivent être 
convertis et importés dans la session. 

Fichiers et dossiers de 
session
Lorsque vous créez une session, Pro Tools 
génère automatiquement un dossier portant le 
nom de votre session. Ce dossier contient le 
fichier de session, un fichier WaveCache.wfm et 
plusieurs sous-dossiers (Audio Files, Fade Files, 
Region Group et Session File Backups).

Fichier de session

Le fichier de session est le document que crée 
Pro Tools lorsque vous démarrez un nouveau 
projet. Pro Tools ne peut ouvrir qu'une seule 
session à la fois. Le fichier de session porte 
l'extension .ptf (propre aux fichiers Pro Tools).

Dossier Audio Files

Le dossier Audio Files contient toutes les 
données audio enregistrées ou converties au 
cours de la session. 

Lorsque vous enregistrez une nouvelle piste 
audio, celle-ci est enregistrée dans un nouveau 
fichier audio dans le dossier Audio Files. Vous 
pouvez également importer d'autres fichiers 
audio dans la session et travailler avec. 

Pour plus de détails sur l'allocation des pistes 
audio à différents emplacements du disque dur, 
en particulier les volumes partagés, consultez la 
section Allocation de disque, page 195.

Contenu type d'un dossier de session
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Dossier Fade Files

Le dossier Fade Files contient toutes les données 
de fondu enchaîné (crossfade) audio générées au 
cours de la session. 

Dossier Region Groups

Le dossier Region Groups est le répertoire par 
défaut réservé aux groupes de régions que vous 
exportez à partir de votre session Pro Tools.

Fichier WaveCache

Le fichier WaveCache.wfm stocke toutes les 
données d'affichage des formes d'ondes pour la 
session. Si vous supprimez le fichier 
WaveCache.wfm, Pro Tools en génère un 
nouveau la prochaine fois que vous ouvrez la 
session.

Les sessions sont ouvertes plus rapidement grâce 
au fichier WaveCache. Le fichier de session 
WaveCache peut être inclus chaque fois que 
vous transférez une session vers un autre 
système Pro Tools 7.0. 

Pro Tools gère également un fichier WaveCache 
distinct dans le dossier local des bases de 
données Digidesign (C:\\Digidesign 
Databases). Ce fichier contient toutes les 
données de formes d'ondes pour l'ensemble des 
fichiers utilisés sur le système. D'autres fichiers 
WaveCache sont créés sur chacun des disques 
durs externes reliés à votre système et stockés 
dans le dossier Digidesign Databases de chaque 
disque. 

Le fait de supprimer ou de mettre à la Corbeille 
des fichiers WaveCache ne perturbe pas 
réellement la session ou votre système. Cela 
demandera simplement plus de temps pour 
ouvrir chaque session dans la mesure où il 
faudra recalculer les données des formes d'ondes 
pour les données audio associées (et stocker ces 
données dans un nouveau fichier WaveCache). 

Dossier Session File Backups

Le dossier Session File Backups contient les 
sauvegardes générées automatiquement de vos 
sessions Pro Tools. Ces fichiers sont créés à 
condition de travailler dans une session et 
d'activer l'option Enable Session File Auto 
Backup des préférences de fonctionnement. 
Reportez-vous à la section Enable Session File 
Auto Backup :, page 78.

Dossier Renamed Audio Files

Ce dossier contient les noms des fichiers 
renommés lors de l'ouverture d'une session 
faisant référence à des noms de fichiers audio 
avec des caractères incompatibles ou, dans 
certaines situations, lors de l'enregistrement de 
la copie d'une session d'une version Pro Tools 
qui ne gère pas les noms de fichier longs.

Ouverture d'une session
Lorsque vous ouvrez une session, Pro Tools 
recherche dans le dossier correspondant les 
fichiers audio et de fondu associés.

Pour plus d'informations, reportez-vous à la 
section Renamed Audio Files, page 175.

Pour plus d'informations sur le partage des 
sessions créées avec différentes versions de 
Pro Tools, reportez-vous à la section 
Partage de sessions créées sur des versions 
logicielles de Pro Tools différentes, 
page 181
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Pour ouvrir une session existante :

1  Choisissez File > Open Session.

2  Recherchez la session que vous voulez ouvrir, 
puis cliquez sur Open.

Ouverture d'une session 
contenant des fichiers non 
disponibles

La fonction DigiBase vous informe si certains 
fichiers trouvés résident sur un volume de 
transfert (par exemple, un CD-ROM) ou si 
certains fichiers sont manquants. Pour en savoir 
plus, voir Recherche des fichiers audio, 
page 173.

Ouverture d'une session à partir 
d'un volume de transfert

Lorsque vous ouvrez une session à partir d'un 
volume de transfert (tel qu'un CD-ROM), la 
fonction DigiBase vous invite à enregistrer la 
session sur un volume Performance, puis de 
copier et convertir les fichiers média référencés. 
Pour en savoir plus, voir Recherche des fichiers 
audio, page 173.

Ouverture d'une session 
contenant des ressources non 
disponibles

Un message vous avertit si la session que vous 
ouvrez comporte des voix, des chemins d'E/S, 
des ressources DSP ou des plug-in non 
disponibles. Ceci se produit fréquemment lors 
du transfert de sessions d'un système à un autre 
système constitué de dispositif Digidesign 
différent.

La boîte de dialogue Unavailable Resources 
permet d'obtenir un premier rapport sur les 
composants manquants de la session. Pour 
sauvegarder un fichier texte (.txt) contenant un 
rapport Notes plus détaillé, ainsi que l'action 
résultante, cliquez sur Yes. Ce portera le nom de 
la session, suivi de Notes.txt. Vous êtes libre 
d'enregistrer ce fichier dans votre dossier Session 
ou à tout autre emplacement.

La section suivante décrit ce qui se produit 
lorsque vous ouvrez une session comportant des 
éléments non disponibles.

Avec tous les systèmes Pro Tools :

◆ Les inserts affectés à des plug-in non 
disponibles sont désactivés.

◆ Les entrées, sorties et départs affectés à des 
chemins non disponibles sont désactivés.

Avec Pro Tools HD uniquement :

◆ Les pistes dont le nombre de voix est 
supérieur au maximum de voix disponibles sur 
le système actuel sont désactivées. 

Avec Pro Tools LE et M-Powered uniquement :

◆ Les pistes dépassant le nombre maximal de 
voix disponibles du système actuel sont réglées 
sur Voice Off.

Boîte de dialogue d'ouverture d'une session
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Ouverture d'une session 
contenant des noms de fichier 
audio avec des caractères 
interdits

Pro Tools 7.0 ne prend pas en charge les noms 
de fichier audio composés de certains caractères 
ASCII (tels que * et @). 

Lorsque les noms des fichiers audio utilisés dans 
les sessions ouvertes contiennent de tels 
caractères, Pro Tools crée automatiquement une 
copie renommée de chaque fichier concerné (en 
remplaçant les caractères interdits par un trait 
de soulignement « _ »). Les fichiers renommés 
sont placés dans le dossier Renamed Audio Files. 
Les fichiers originaux restent inchangés dans le 
dossier Audio Files.

Avant que la session ne s'ouvre, vous êtes invité 
à enregistrer un rapport détaillé des fichiers 
renommés et de leurs noms d'origine dans un 
fichier texte de notes. Suivez les instructions à 
l'écran. Par défaut, le fichier de notes est 
sauvegardé dans le dossier Session.

Ouverture d'une session 
enregistrée avec un gain de fader 
de +6 dB

Toutes les sessions Pro Tools 7.0 ont un niveau 
de gain de fader de +12 dB. Cependant, lorsque 
vous enregistrez une session Pro Tools 7.0 dans 
une version antérieure de Pro Tools autorisant 
des gains de fader de +6 dB et +12 dB, il est 
possible de sauvegarder la nouvelle session avec 
un gain de fader maximum de +6 dB ou de 
+12 dB.

Lors de l'enregistrement d'une session à +12 dB 
ou +6 dB, Pro Tools vous avertit que tout point 
d'inflexion d'automation au-dessus de +6 dB est 
réduit +6 dB. Pour plus d'informations, 
reportez-vous à la section Enregistrement d'une 
copie de la session, page 64.

Dans Pro Tools 7.0, si vous ouvrez une session 
enregistrée avec un niveau de gain maximum de 
+6 dB, la session applique une plage équivalent 
à +12 dB.

Enregistrement d'une session
Il est recommandé d'enregistrer régulièrement 
votre travail au fil d'une session, afin de le 
conserver sur votre disque dur.

Enregistrement du fichier de la 
session

La commande Save enregistre les changements 
effectués au cours de la session par rapport à la 
version précédente du fichier. Elle ne peut pas 
être annulée.

Pour enregistrer une session :

■ Choisissez File > Save.

Commande Revert to Saved

Si vous avez effectué des changements dans une 
session depuis la dernière sauvegarde, vous 
pouvez les annuler et revenir à l'état précédent.

Pour restaurer la dernière version enregistrée 
d'une session :

■ Choisissez File > Revert to Saved.
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Enregistrement du fichier de 
session sous un nouveau nom

La commande Save As permet d'enregistrer une 
copie de la session actuelle sous un nom 
différent ou vers un autre emplacement du 
disque. Comme la commande Save As ferme la 
session en cours et permet de continuer à 
travailler sur la copie renommée, elle est utile 
pour faire des essais et enregistrer des versions 
successives de la session.

En travaillant de cette manière, vous pouvez 
rapidement revenir en arrière si vous souhaitez 
restituer une version précédente de votre 
session. La commande Save As vous permet 
d'enregistrer une nouvelle version du fichier de 
session uniquement, sans dupliquer les versions 
des fichiers audio ou de fondus.

Pour enregistrer une session sous un nouveau 
nom :

1  Choisissez File > Save As. 

2  Attribuez un nouveau nom à la session.

Pro Tools 7.0 permet de choisir des noms de 
fichier contenant autant de caractères que votre 
système d'exploitation l'autorise. 

3  Cliquez sur Save.

Le fichier de session renommé est enregistré 
dans le dossier de la session avec la session 
d'origine (à moins que vous ayez spécifié une 
autre destination). Tout nouveau fichier audio 
que vous enregistrez dans votre session 
renommée sera placé dans le dossier Audio Files 
créé avec votre session d'origine. 

Enregistrement d'une copie de la 
session

La commande Save Session In permet 
d'enregistrer une copie de la session actuelle 
avec ou sans ses fichiers audio et de fondu. En 
outre, vous pouvez préciser un format de fichier 
de session, un format de fichier audio, une 
résolution et une fréquence d'échantillonnage 
pour la copie de la session.

Vous pouvez également ouvrir une copie de 
sauvegarde de votre session, si vous avez 
activé l'option AutoSave des préférences de 
fonctionnement. Cette fonction permet de 
spécifier le nombre total de sauvegardes 
incrémentielles conservées et la fréquence 
d'enregistrement de la session. Pour plus 
d'informations, reportez-vous à la section 
Autosave, page 78.

Pour plus d'informations sur le partage de 
sessions entre différentes plates-formes, 
différents systèmes Pro Tools ou diverses 
versions logicielles Pro Tools, reportez-vous 
au Chapitre 10, Gestion des fichiers et 
des sessions et compatibilité.

Boîte de dialogue Save Copy In
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Contrairement à la commande Save As, la 
commande Save Copy In ne referme pas la 
session d'origine. C'est la raison pour laquelle 
toute nouvelle modification sera effectuée sur la 
session d'origine. Les copies de sessions servent à 
archiver des sessions importantes ou à préparer 
des sessions à des transferts vers d'autres 
systèmes Pro Tools.

La commande Save Copy In n'enregistre que les 
données audio utilisées dans la session. Toute 
donnée audio enregistrée ou importée, puis 
ultérieurement supprimée de la session, ne sera 
pas incluse dans la nouvelle copie de la session.

L'utilisation de la commande Save Copy In est le 
seul moyen de modifier la fréquence 
d'échantillonnage d'une session. 

Lorsque vous enregistrez une copie de la session 
avec un débit inférieur, un effet de dithering 
(Dither) et de mise en forme du bruit (Noise 
Shaping) sont appliqués. Voir le tableau 
suivant :

Le paramètre Dither utilisé lors d'une 
conversion est le plug-in Dither de Digidesign 
(avec le paramètre Noise Shaping activé).

Format de la session

Vous pouvez enregistrer la copie d'une session 
aux formats suivants, selon le type de plate-
forme utilisé :

Windows :

• Session Pro Tools (*.ptf) ; prise en charge de 
Pro Tools 7.0

• Session Pro Tools 5.1 -> 6.9 (.pts)

• Session Pro Tools 5.0 (.pt5)

• Session Pro Tools 4, 24 bits (.p24)

• Session Pro Tools 4, 16 bits (.pt4)

Macintosh :

• Dernière version ; prise en charge de 
Pro Tools 7.0

• Session Pro Tools 5.1 -> 6.9

• Session Pro Tools 5.0

• Session Pro Tools 4, 24 bits

• Session Pro Tools 4, 16 bits

• Session Pro Tools 3.2

Lorsque vous enregistrez des sessions vers des 
versions antérieures à la version 5.1, les pistes 
comportant plusieurs canaux (y compris stéréo) 
et les plug-in multimono sont perdus. Le cas 
échéant, assurez-vous d'abord de séparer les 
pistes et les plug-in en pistes mono distinctes.

Options Dither et Noise Shaping avec la commande 
Save Copy In

Débit Dither
Noise 
Shaping

24 bits vers 24 bits Non Non

16 bits vers 24 bits Non Non

24 bits vers 16 bits Oui Oui

16 bits vers 16 bits Non Non

Pour en savoir plus sur le dithering, 
reportez-vous à la section Dithering, 
page 606.

Pour partager des sessions entre différentes 
plates-formes, différents systèmes Pro Tools 
ou diverses versions logicielles Pro Tools, 
reportez-vous au Chapitre 10, Gestion des 
fichiers et des sessions et compatibilité.
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Paramètres de session

Type de fichier audio

Vous pouvez enregistrer la session pour 
référencer des fichiers audio BWF (.WAV) ou 
AIFF. Sous Macintosh, vous pouvez également 
enregistrer la session pour référencer les fichiers 
audio SD II (avec des fréquences 
d'échantillonnage allant jusqu'à 48 kHz).

Utilisation de types de fichiers mixtes

Une même session peut utiliser des fichiers 
audio de types différents. Si votre session 
d'origine contient plusieurs types de fichiers 
audio, ils ne sont pas convertis vers un type 
différent, à moins que vous n'indiquiez qu'ils 
doivent l'être. Toutefois, lorsque vous mélangez 
différents types de fichiers, les performances 
audio sont dégradées (du fait des manipulations 
supplémentaires sur les fichiers, nécessaires avec 
certains formats).

Résolution

Vous pouvez enregistrer la nouvelle session avec 
une résolution de 16 ou 24 bits. Si la résolution 
de votre session est différente, les fichiers audio 
sont convertis à la résolution de la nouvelle 
session et copiés vers l'emplacement que vous 
indiquez.

fréquence d'échantillonnage

Vous pouvez enregistrer la nouvelle session à des 
fréquences d'échantillonnage de 44,1 kHz ou 
48 kHz (avec les systèmes Mbox 2 and Mbox) et 
à des fréquences d'échantillonnage allant 
jusqu'à 96 kHz (avec les systèmes Digi 002, 
Digi 002 Rack et Pro Tools|HD avec une 
interface E/S 96 ou E/S 96i) ou encore jusqu'à 
192 kHz (avec les systèmes Pro Tools|HD avec 
une interface E/S 192 ou E/S numérique 192). 
Si la fréquence d'échantillonnage de votre 
session est différente, les fichiers audio sont 
convertis à la fréquence d'échantillonnage de la 
nouvelle session et copiés vers l'emplacement 
que vous indiquez.

Plus la qualité de la conversion de la fréquence 
d'échantillonnage choisie est élevée, plus le 
traitement du fichier audio dans Pro Tools 
est lent. 

Gain de fader

Lorsque vous enregistrez une session 
Pro Tools 7.0 dans une version antérieure de 
Pro Tools autorisant des gains de fader de +6 dB 
et +12 dB, il est possible de sauvegarder la 
nouvelle session avec un gain de fader 
maximum de +6 dB ou de +12 dB. Lors de 
l'enregistrement d'une session à +12 dB ou 
+6 dB, Pro Tools vous avertit que tout point 
d'inflexion d'automation au-dessus de +6 dB est 
réduit +6 dB.

Les sessions SD II ne sont pas prises en 
charge dans Pro Tools pour Windows ni 
avec des fréquences d'échantillonnage 
supérieures à 48 kHz.

Pour plus d'informations sur le prémixage 
sur disque et sur le dithering, reportez-vous 
à la section Dithering et prémixage sur 
disque (Bounce), page 680.
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Option Enforce Mac/PC Compatibility

Lorsque vous enregistrez une session 
Pro Tools 7.0 dans une version antérieure de 
Pro Tools, ce paramètre force les versions 
Macintosh ou Windows de Pro Tools à créer des 
sessions et des fichiers audio utilisables sur les 
deux plates-formes. 

Eléments à copier

All Audio Files

lorsque cette option est sélectionnée, tous les 
fichiers audio sont copiés vers le nouvel 
emplacement.

Ce paramètre est automatiquement sélectionné 
si vous modifiez la résolution ou la fréquence 
d'échantillonnage de la session.

All (Non-Native) Audio Files

Le nom de cette option change en fonction du 
type de fichier audio sélectionné. Si vous 
modifiez le type de fichier audio de la session, 
cette option garantit que tous les fichiers de la 
session copiée sont convertis vers le type de 
fichier sélectionné. Lorsqu'elle est sélectionnée, 
cette option permet d'éviter un ralentissement 
des performances, qui survient souvent dans des 
sessions avec des types de fichiers mélangés.

Cette option est automatiquement sélectionnée 
si vous modifiez la résolution ou la fréquence 
d'échantillonnage ou si vous copiez une session 
sur Macintosh depuis le format SD II vers le 
format AIFF ou BWF (.WAV), et si l'option 
Enforce Mac/PC Compatibility est sélectionnée.

Don't Copy Fade Files

Lorsque cette option est sélectionnée, les 
fichiers de fondus ne sont pas copiés dans le 
dossier Fade Files de la nouvelle session. 

Pro Tools ouvre la session avec tous les médias 
disponibles, indique le nombre de fichiers 
manquants (le cas échéant) et vous demande 
comment continuer. Vous pouvez rechercher les 
fichiers de fondus existants à l'aide de l'option 
Manually Find Relink ou Automatically Find 
Relink ou choisir l'option Skip All pour laisser à 
Pro Tools le soin de recréer les fondus à partir du 
document de la session. Vous pouvez également 
sélectionner l'option Regenerate Missing Fades 
pour exclure les fichiers de fondus du processus 
de rétablissement de liens et les régénérer.

Session Plug-In Settings Folder

Lorsque cette option est sélectionnée, le dossier 
de paramètres de plug-in de la session (Plug-In 
Settings) est copié au nouvel emplacement. Les 
références à ces paramètres de plugin dans la 
session sont redirigées vers les fichiers de 
paramètres copiés.

Root Plug-In Settings Folder

Lorsque vous sélectionnez cette option, le 
contenu du dossier de référence des paramètres 
de plug-in est copié dans un dossier nommé 
Place in Root Settings Folder, indiquant que ces 
fichiers devront être déplacés vers le dossier de 
référence des paramètres de plug-in dans le 
système de destination avant que vous ne les 
utilisiez. Les références à ces fichiers de 
paramètres de la session ne sont pas redirigées 
pour pointer vers les fichiers copiés.

Pour plus d'informations, reportez-vous à la 
section Enregistrement de copies de 
sessions Macintosh compatibles avec 
Windows, page 178.
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Movie/Video Files

Lorsque vous sélectionnez cette option, les 
fichiers de films de la session (fichiers vidéo 
QuickTime ou Avid) sont copiés vers le nouvel 
emplacement et les références de la session sont 
mises à jour pour pointer vers les fichiers de 
films copiés.

Pour enregistrer une copie de la session vers un 
nouvel emplacement :

1  Choisissez File > Save Copy In.

2  Dans la boîte de dialogue Save Copy In, 
sélectionnez une destination et entrez le nom 
du fichier de la nouvelle session.

3  Définissez l'option Audio File Type sur AIFF, 
BWF (.WAV) ou SD II. Si les fichiers audio 
doivent être compatibles avec Windows ou 
Macintosh, sélectionnez AIFF ou BWF (.WAV).

4  Définissez la résolution et la fréquence 
d'échantillonnage de la session.

5  Sélectionnez l'option Enforce Mac/PC 
Compatibility pour créer une session et des 
fichiers audio utilisables sur les systèmes 
Pro Tools aussi bien sous Windows que sur 
Macintosh. Pour plus d'informations, reportez-
vous à la section Enregistrement de copies de 
sessions Macintosh compatibles avec Windows, 
page 178.

6  Sélectionnez les éléments à copier vers la 
nouvelle session.

7  Cliquez sur Save. 

Création de modèles de 
session personnalisés
Vous pouvez créer des documents de session 
personnalisés pré-configurés conformément aux 
paramètres de pistes, paramètres de console de 
mixage, dispositions des fenêtres et 
emplacements mémoire du niveau de zoom que 
vous utilisez le plus souvent. Ceci vous évite 
d'avoir à récréer toute la configuration de votre 
studio chaque fois que vous démarrez une 
nouvelle session.

Création de modèles Windows

Sous Windows, vous pouvez créer un modèle de 
session en faisant du fichier de session un 
document en lecture seule.

Pour créer un modèle de session personnalisé 
sous Windows :

1  Créez une session et organisez ses éléments 
selon vos préférences d'affichage dans le 
modèle. Vous pouvez également définir des 
éléments tels que des routages de signal, des 
configurations d'inserts et de départs, des 
affichages de pistes, des paramètres de la règle et 
des paramètres par défaut.

2  Choisissez File > Save As.

3  Attribuez un nom à votre session et cliquez sur 
Save.

4  Fermez la session.

5  Recherchez le fichier de session que vous 
venez d'enregistrer.

6  Cliquez avec le bouton droit de la souris sur le 
fichier et choisissez Propriétés.
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7  Dans la zone Attributs, sélectionnez Lecture 
seule.

8  Cliquez sur OK.

Pour utiliser ce modèle, cliquez deux fois dessus 
ou ouvrez-le à l'aide de la commande Open 
Session. Lorsque vous enregistrez une session 
pour la première fois, Pro Tools vous demande 
de lui attribuer un nom. Le modèle de votre 
session d'origine reste inchangé.

Pour modifier le modèle de la session, vous 
devez rouvrir ses propriétés, désactiver la case 
Lecture, procéder à vos modifications, puis 
modifier de nouveau ses propriétés pour lui 
redonner l'attribut Lecture seule.

Création de modèles Macintosh

Sous Macintosh, vous pouvez créer un modèle 
de session en enregistrant un fichier de session 
en tant que document Stationery Pad. Une fois la 
session enregistrée en tant que Stationery Pad, 
elle se comporte comme un modèle que vous 
pouvez ouvrir et enregistrer à nouveau en tant 
que session normale.

Pour créer un modèle de session personnalisé sur 
le Macintosh :

1  Créez une session et organisez ses éléments 
selon vos préférences d'affichage dans le 
modèle. Outre la configuration des pistes, vous 
pouvez définir des éléments tels que des 
routages de signal, des configurations d'inserts 
et de départs, l'affichage des fenêtres Mix et Edit, 
les paramètres de règle et les paramètres par 
défaut.

2  Choisissez File > Save As.

3  Attribuez un nom à votre session et cliquez sur 
Save.

4  Fermez la session.

5  Recherchez le fichier de session que vous 
venez d'enregistrer. 

6  Cliquez une fois sur le fichier pour le 
sélectionner.

7  Choisissez File > Get Info.

8  Si besoin est, cliquez sur le triangle général 
Développer/Réduire pour afficher les 
informations et les options générales.

Transformation d'une session en fichier en lecture seule 
(Windows)

Enregistrement d'une session au format Stationery Pad 
(Macintosh)
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9  Sélectionnez l'option Stationery Pad pour 
enregistrer le fichier en tant que modèle, puis 
fermez la fenêtre d'informations.

Pour utiliser ce modèle, cliquez deux fois dessus 
ou ouvrez-le à l'aide de la commande Open 
Session si Pro Tools est déjà lancé. Vous pouvez 
créer plusieurs modèles personnalisés 
correspondant aux configurations de studio que 
vous utilisez souvent. 

Lorsque vous ouvrez une session enregistrée au 
format Stationery Pad, Pro Tools permet de 
modifier le modèle ou de démarrer une nouvelle 
session qui en reprend les paramètres. Si vous 
choisissez New Session, Pro Tools crée un 
nouveau dossier contenant une copie de votre 
modèle de session et des dossiers audio et de 
fondus.

Fermeture d'une session
Du fait que Pro Tools ne permet de travailler que 
sur une seule session à la fois, vous devez fermer 
la session en cours si vous souhaitez travailler 
sur une autre. La commande Close Session 
ferme votre session actuelle de Pro Tools mais 
laisse l'application ouverte. Vous pouvez 
enregistrer votre travail à l'aide des commandes 
Save ou Save As avant de fermer la session en 
cours.

Pour fermer une session :

■ Choisissez File > Close Session.

Fermeture de Pro Tools
Bien que vous soyez averti par Pro Tools avant 
d'être autorisé à quitter un travail sans 
enregistrer vos modifications, il est préférable 
d'enregistrer systématiquement votre travail 
avant de le quitter.

Pour quitter Pro Tools sous Windows :

■ Choisissez File > Exit.

Pour quitter Pro Tools sur le Macintosh :

■ Choisissez Pro Tools > Quit Pro Tools.

Utilisation du système

A propos de la bande passante de 
traitement

Les indicateurs de la fenêtre System Usage 
indiquent la quantité de puissance du système 
utilisée dans le traitement des sons et lors de 
l'écriture et de la lecture des données 
d'automation. 

Pro Tools HD, LE et M-Powered ont trois 
indicateurs en commun affichant le trafic du 
bus PCI, la la capacité de traitement du 
processeur et la capacité de traitement du 
disque.

Fenêtre System Usage (correspondant ici à 
Pro Tools LE)

Indicateurs d'activité du 
système
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Pro Tools HD offre des indicateurs 
supplémentaires permettant de connaître 
l'utilisation du Time Slot TDM et l'utilisation des 
ressources DSP sur chaque carte système 
Pro Tools|HD.

Lorsque ces indicateurs approchent de leurs 
limites, l'enregistrement ou la lecture des 
données d'automation peuvent se voir altérés. 

Des erreurs système peuvent se produire en 
raison d'une activité intense du processeur ou de 
l'interface PCI. Si l'activité sur le disque est 
élevée, Pro Tools risque de manquer la lecture de 
certaines données d'automation au cours de 
périodes d'activité particulièrement denses, 
notamment en cas de recours à la commande 
Bounce to Disk. 

Pour contrôler l'utilisation des ressources au 
cours d'une session Pro Tools :

■ Sélectionnez Window > System Usage.

Pour réduire la charge de traitement, essayez 
l'une des actions suivantes :

■ Désélectionnez l'option Faders Move During 
Playback dans la page Automation Preferences.

■ Réduisez la densité de l'automation aux 
points où elle semble la plus active. Pour en 
savoir plus, reportez-vous à la section Réduction 
de l'automation, page 654. 

■ Désactivez les vumètres de la vue Sends, s'ils 
sont activés, depuis la page Display Preferences. 
Pour plus d'informations, reportez-vous à la 
section Vues Send individuelles et vumètres de 
niveau de départ, page 587.

Vues de la fenêtre System Usage

(Pro Tools HD uniquement)

Pro Tools HD propose cinq vues différentes de la 
fenêtre System Usage : Small, Large, Detailed, 
Gas Gauge et Activity Only. Les formats 
Detailed et Gas Gauge indiquent le pourcentage 
d'utilisation pour chaque puce DSP.

Pour changer la vue de la fenêtre System Usage :

■ Sélectionnez View > System Usage, puis l'un 
des formats d'affichage (Small, par exemple).

Fenêtre System Usage (correspondant ici à 
Pro Tools HD)

Utilisation des 
ressources DSP

Indicateurs d'activité du 
système

Utilisation du Time Slot 
TDM

Pour plus d'informations, reportez-vous à la 
section Bounce to Disk, page 683.

Pour plus d'informations sur les différentes 
vues permettant de contrôler l'utilisation 
des ressources DSP, reportez-vous au Guide 
de démarrage Pro Tools|HD.
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Préférences
La boîte de dialogue Preferences contient 
plusieurs pages d'onglets permettant de spécifier 
les préférences relatives à plusieurs paramètres 
de session. Chaque nouvelle session utilise 
ensuite ces paramètres.

Préférences d'affichage

Options Basics

Edit Window Follows Bank Selection : si vous 
utilisez une surface de contrôle prise en charge 
par Pro Tools, cette option entraîne le 
défilement de la fenêtre Edit, permettant ainsi 
d'afficher la banque de pistes sélectionnée 
lorsque vous changez de banque sur la surface 
de contrôle. La banque en cours d'utilisation est 
ainsi toujours visible à l'écran.

Mix Window Follows Bank Selection : si vous 
utilisez une surface de contrôle prise en charge 
par Pro Tools, cette option entraîne le 
défilement de la fenêtre Mix, permettant ainsi 
d'afficher la banque de pistes sélectionnée 
lorsque vous changez de banque sur la surface 
de contrôle. La banque en cours d'utilisation est 
ainsi toujours visible à l'écran.

« Scroll to Tracks » Banks Controllers : lorsque 
vous utilisez une surface de contrôle (D-Control 
ou Pro Control, par exemple), vous pouvez 
sélectionner cette option pour affecter les faders 
de la surface de contrôle à une piste numérotée 
lors de l'exécution de la commandeTrack > 
Scroll to Track.

Track Position Numbers Stay with Hidden
Tracks : lorsque cette option est activée, les 
pistes masquées conservent leur numéro. 
Lorsqu'elle est désactivée, des numéros sont 
affectés uniquement aux pistes affichées. Les 
pistes actives sont alors numérotées 
séquentiellement et les pistes masquées ne sont 
pas numérotées.

Show Meters in Sends View : lorsque la vue 
Sends affiche des contrôles de départs distincts, 
sélectionnez cette option pour afficher 
les indicateurs de volume de départs. 
La désactivation de cette option permet 
d'accélérer la vitesse d'affichage et de traitement 
de l'écran.

Draw Grids in Edit Window : ajoute des 
graduations dans la fenêtre Edit. La résolution 
des graduations dépend du niveau de zoom de la 
fenêtre Edit.

Draw Waveforms Rectified : affiche les formes 
d'ondes audio dans une vue rectifiée. En d'autres 
termes, les formes d'ondes audio apparaissent de 
telle sorte que leurs excursions positive et 
négative (c 'est-à-dire les parties situées au-
dessus et en dessous de la ligne centrale) sont 
additionnées et présentées sous forme d'un 
signal positif unique. Cette vue permet 
d'afficher des formes d'onde plus détaillées, que 
la hauteur de piste soit normale ou réduite. 
Elle sert notamment à modifier les données 
d'automation de volume, puisqu'elle représente 
le niveau des formes d'ondes à partir du bas de la 
piste.
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Recompute Invalid Overviews : conduit 
Pro Tools à rechercher, à l'ouverture de la 
session, des données d'aperçu (données utilisées 
pour l'affichage des formes d'ondes) 
manquantes ou altérées. Si Pro Tools découvre 
des données d'aperçu manquantes ou altérées, le 
système recrée un ou plusieurs aperçus de la 
session. Cette opération peut durer un certain 
temps si la session contient de nombreuses 
pistes. Si vous avez des raisons de penser que les 
données d'aperçu d'une session sont altérées ou 
si vous importez des fichiers audio sans aperçu 
dans une session, assurez-vous que cette 
préférence est activée pour la session, 
enregistrez et fermez cette dernière, puis 
rouvrez-la. Pro Tools recrée alors tout aperçu de 
la session à la réouverture.

Always Display Marker Colors : permet d'afficher 
les couleurs des marqueurs dans la règle des 
marqueurs, quels que soient les paramètres 
choisis pour Default Region Color Coding. 

Option Tool Tips Display

Function : configure les info-bulles de façon à 
afficher la fonction de base de l'élément.

Details : configure les info-bulles de façon à 
afficher le nom complet d'un nom ou élément 
abrégé. La vue Details permet également 
d'afficher la valeur masquée ou abrégée des 
paramètres, ainsi que les assignations d'entrées 
et de sorties. 

Options Other

Edit Window Default Length : permet de définir 
la longueur par défaut pour la fenêtre Edit en 
heures, minutes, secondes et images 
(Pro Tools HD ou Pro Tools LE avec DV Toolkit 
uniquement). Elle est notamment utile si vous 
souhaitez créer une session d'une durée 
spécifique ou conserver de l'espace en vue 
d'étendre l'espace de travail de la fenêtre Edit 

dans votre session. La longueur maximale est de 
13 heures à 48 kHz (elle diminue de façon 
proportionnelle à des fréquences 
d'échantillonnage plus élevées).

Delay Compensation Mode : cette option vous 
permet de déterminer l'unité d'affichage des 
données dans le gestionnaire de retard : 
millième de seconde ou échantillon. Elle est 
disponible à condition d'avoir activé la 
compensation de retard (Options > Delay 
Compensation).

Option Organize Plug-In Menus By

Cette option permet d'organiser librement les 
listes de plug-in (menus des plug-in) dans le 
sélecteur d'insert ou le sélecteur de plug-In.

Flat List : classe les plug-in par ordre 
alphabétique au sein d'une même liste.

Category : classe les plug-ins par catégorie de 
processus (EQ, Dynamics, Delay, etc.) en 
répartissant les différents plug-in dans des sous-
menus de catégories. Les plug-ins ne 
correspondant pas à une catégorie standard (par 
exemple, DigiRack Signal Generator) ou les 
plug-ins tiers dont la catégorie n'a pas été définie 
par leurs développeurs, figurent dans la 
catégorie Other. Les plug-in peuvent s'afficher 
dans plusieurs catégories. 

Manufacturer : classe les plug-in en fonction de 
leur fabricant (Digidesign, Eventide, Line 6 ou 
McDSP, par exemple), en répartissant les 
différents plug-in dans des sous-menus de 
fabricants. Ceux pour lesquels aucun 
concepteur n'est défini figurent dans le dossier 
de concepteur Other. 

La plupart des plug-in tiers distribués par 
Digidesign sont regroupés sous Digidesign 
lorsque vous choisissez un mode d'affichage par 
fabricant.
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Category and Manufacturer : organise les plug-in 
dans deux niveaux de menus. Les menus du 
haut présentent les plug-ins par catégorie de 
processus (EQ, Dynamics, Delay, etc.). 
Les différents plug-in sont répertoriés dans des 
sous-menus de catégories. Les menus du bas 
présentent les plug-in par fabricant (Digidesign, 
Eventide, Line 6 ou McDSP, par exemple). Les 
différents plug-in sont répertoriés dans des sous-
menus de fabricants.

Options Default Track Color Coding

Les options de codage couleur suivantes 
déterminent les codes de couleur utilisés par 
défaut pour les pistes dans les fenêtres Edit et 
Mix. Les choix possibles sont :

None : désactive l'affectation de couleurs pour 
les pistes.

Tracks and MIDI Channels : affecte une couleur à 
chaque piste de la fenêtre Edit ou Edit en 
fonction de l'assignation de sa voix ou de son 
canal MIDI.

Tracks and MIDI Devices : affecte une couleur à 
chaque piste de la fenêtre Edit ou Edit en 
fonction de l'assignation de sa voix ou de son 
périphérique MIDI.

Groups : affecte une couleur à chaque piste, 
conformément à son ID de groupe. En cas de 
suspension de groupes à l'aide de la commande 
Suspend Groups, les barres de couleurs des pistes 
ne sont pas affichées.

Track Type : affecte une couleur à chaque piste 
en fonction de leur type (audio, MIDI, 
Instrument, Auxiliaire ou Fader principal).

Zone Default Region Color Coding

Les options de codage couleur suivantes 
déterminent les codes de couleur utilisés par 
défaut pour les régions dans la playlist de la 
piste. Les choix possibles sont :

None : désactive l'affectation de couleurs pour 
les régions. Les régions sont représentées par des 
formes d'ondes ou des notes MIDI noires sur un 
fond gris clair.

Tracks and MIDI Channels : affecte une couleur à 
chaque région de la fenêtre Edit en fonction de 
l'assignation de sa voix ou de son canal MIDI.

Tracks and MIDI Devices : affecte une couleur à 
chaque région de la fenêtre Edit en fonction de 
l'assignation de sa voix ou de son périphérique 
MIDI.

Groups : affecte une couleur à chaque région, 
conformément à l'ID de groupe de sa piste. 
En cas de suspension de groupes à l'aide de la 
commande Suspend Groups, toutes les régions 
présentent des formes d'ondes ou des notes 
MIDI noires sur un fond gris clair.

Track Color : affecte une couleur de région basée 
sur la couleur attribuée à la piste.

Marker Locations : affecte une couleur aux 
données dans toutes les pistes en fonction du 
marqueur précédent le plus proche.

Region List Color : affecte une couleur à chaque 
région en fonction de sa couleur dans la liste des 
régions.
Guide de référence Pro Tools



Options Peak Hold

Ces options permettent de régler la durée 
d'allumage des indicateurs d'écrêtage des 
vumètres de piste lorsqu'une crête est détectée. 

3-Second Peak Hold : lorsque cette option est 
sélectionnée, le vumètre de la piste affiche le 
dernier niveau de crête pendant trois secondes.

Infinite Peak Hold : lorsque cette option est 
sélectionnée, le vumètre de la piste affiche le 
dernier niveau de crête jusqu'à ce que vous 
l'effaciez en cliquant dessus.

No Peak Hold : lorsque cette option est 
sélectionnée, le vumètre de la piste ne « gèle » 
pas le niveau de crête.

Options Clip Indication

Ces options permettent de régler la durée 
d'allumage des indicateurs d'écrêtage des 
vumètres de piste, de plug-in et de départ 
lorsqu'une crête est détectée.

3-Second Clip Hold : lorsque cette option est 
sélectionnée, le vumètre affiche le dernier 
niveau d'écrêtage durant trois secondes.

Infinite Clip Hold : lorsque cette option est 
sélectionnée, le vumètre affiche le dernier 
niveau de crête jusqu'à ce que vous l'effaciez en 
cliquant dessus.

No Clip Hold : lorsque cette option est 
sélectionnée, le vumètre ne « gèle » pas le 
niveau d'écrêtage.

Préférences de fonctionnement

Options Basics

Timeline Insertion Follows Playback : si vous 
sélectionnez cette option, la position du curseur 
de lecture à l'écran est actualisée pour indiquer 
le point d'arrêt de la lecture.

Edit Insertion Follows Scrub/Shuttle : lorsque 
cette option est sélectionnée, le curseur 
d'édition repère automatiquement le point 
d'arrêt du scrubbing.

Sends Default to -INF : lorsqu'elle est 
sélectionnée, cette option règle le niveau de 
fader initial des nouveaux départs sur –∞ (pas de 
signal audible). Dans le cas contraire, le niveau 
de fader initial des nouveaux départs est défini 
sur 0 dB.

Audio During Fast Forward/Rewind : lorsque 
cette option est sélectionnée, le son est audible 
pendant l'avance ou le retour rapide.

Convert Imported « WAV » Files To 
AES31/BroadcastWave : lorsque cette option 
est sélectionnée, elle conforme tous les 
nouveaux fichiers .WAV importés à la norme de 
radiodiffusion AES31/EBU.
Chapitre 6 : Sessions 75



76
Automatically Copy Files on Import : lorsque 
cette option est sélectionnée, Pro Tools copie 
tous les fichiers audio importés dans le dossier 
Audio Files de la session, qu'ils nécessitent ou 
non d'être convertis vers le type de fichier, la 
résolution ou la fréquence d'échantillonnage de 
la session actuelle.

Audio Track RecordLock : ce paramètre permet 
de configurer Pro Tools de façon à émuler un 
défileur numérique ou à conserver le 
comportement hérité pour l'état 
d'enregistrement des pistes. 

• Lorsque la préférence Audio RecordLock est 
activée, les pistes audio préparées à 
l'enregistrement restent activées même en 
cas d'arrêt de la lecture ou de 
l'enregistrement. 

• Lorsque la préférence Audio RecordLock 
n'est pas activée, les pistes audio quittent le 
mode de préparation à l'enregistrement en 
cas d'arrêt de Pro Tools. Ceci permet 
d'éviter que les pistes ne restent activées 
d'une passe à l'autre, émulant le 
comportement d'enregistrement de piste 
d'un défileur numérique. 

Transport RecordLock : ce paramètre permet de 
configurer l'option Transport Record (bouton 
Record Enable dans les commandes de 
transport) de façon à émuler un défileur 
numérique ou à conserver le comportement 
hérité pour l'enregistrement principal dans la 
fenêtre Transport. 

• Si ce paramètre n'est pas sélectionné, 
l'option Transport Record est désactivée 
lorsque Pro Tools est arrêté manuellement 
ou lorsqu'il s'interrompt en raison d'une 
perte de timecode. Cela reproduit le 
comportement d'enregistrement Pro Tools 
standard. 

• Si ce paramètre est sélectionné, l'option 
Transport Record reste activée même en cas 
d'arrêt de la lecture ou de l'enregistrement. 
Ceci évite de réactiver le transport entre 
chaque prise, ce qui émule le 
comportement d'un défileur numérique. 

Latch Record Enable Buttons : lorsque cette 
option est désactivée, les pistes audio multiples 
ne peuvent pas être enregistrées. La préparation 
d'une piste en enregistrement désactive alors la 
préparation de la piste audio précédente.

Link Mix and Edit Group Enables : lorsque cette 
option est sélectionnée, elle associe l'activation 
et la désactivation des groupes Mix et Edit. 
L'activation du groupe A dans la fenêtre Mix 
active automatiquement ce groupe dans la 
fenêtre Edit, par exemple.

Use F11 key for Wait for Note : lorsque cette 
option est sélectionnée, la pression de la touche 
de fonction F11 active le mode d'attente de note 
(Wait for Note) pour l'enregistrement MIDI. 

Disable « Input » When Disarming Track 
(In « Stop ») : Vous pouvez personnaliser 
l'écoute TrackInput pour maintenir sa sélection 
indépendamment de l'état d'enregistrement des 
pistes ou pour activer automatiquement le 
mode d'écoute Auto Input après une passe 
d'enregistrement. Ceci permet d'optimiser 
l'écoute lors d'une opération de doublage type 
(pour laquelle vous souhaitez conserver les 
pistes en mode Input Only jusqu'à l'activation 
explicite du mode Auto Input) ou lors d'une 
opération de contrôle musical type (pour 
laquelle le fait de laisser une piste en mode Input 
Only risquerait de provoquer une double écoute 
accidentelle après l'enregistrement).

Le paramètre Transport RecordLock est 
automatiquement désactivé et grisé lorsque 
le mode d'enregistrement Destructive est 
activé.
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• Si vous sélectionnez cette option, la 
désactivation de l'enregistrement pour une 
piste audio (tout mode) désactive le mode 
Input Only, quel que soit le mode d'écoute 
général, et lui applique uniquement une 
écoute audio à partir du disque. 

• Si vous ne la sélectionnez pas, les pistes 
audio restent en mode Input Only jusqu'à 
l'activation explicite de l'écoute Auto 
Input. 

Mute Record-Armed Tracks While Stopped : 
ce paramètre détermine l'état d'écoute des pistes 
préparées à l'enregistrement. 

• Si vous sélectionnez cette option, Pro Tools 
coupe les pistes en mode enregistrement 
avant l'arrêt du transport. L'écoute des 
entrées reste possible en cas d'arrêt au 
moyen du bouton TrackInput Monitor.

• Si vous ne la sélectionnez pas, Pro Tools 
contrôle l'écoute des entrées audio sur les 
pistes en mode enregistrement.

Avid Video Errors Stop Playback : lorsque cette 
option est sélectionnée, Pro Tools arrête 
automatiquement la lecture des données audio 
et vidéo si une seule image vidéo est omise.

Si cette option n'est pas sélectionnée, Pro Tools 
continue la lecture des données audio même en 
cas d'omission d'images. Dans la plupart des cas, 
la lecture video reprend après quelques images 
et les données audio et vidéo suivantes sont lues 
en synchronisation.

Mode pavé numérique

Le mode Numeric Keypad détermine le 
fonctionnement du clavier numérique. Il est 
toujours possible d'utiliser le pavé numérique 
pour sélectionner et saisir des valeurs dans la 
zone d'édition des événements, des indicateurs 
de sélection d'édition, des compteurs principaux 
et secondaires et de la zone Transport.

Classic : le mode Shuttle Lock reproduit le 
fonctionnement de Pro Tools dans ses versions 
antérieures à la version 5.0. Lorsque le mode 
Classic Numeric Keypad est activé, vous pouvez 
lire un maximum de deux pistes audio en mode 
Shuttle Lock. Appuyez sur la touche Contrôle 
(Macintosh) ou de démarrage (Windows), puis 
sur un chiffre de 0 à 9 pour sélectionner la 
vitesse de lecture. Appuyez sur la touche Plus (+) 
ou Moins (–) pour inverser la direction. Pour 
rappeler un emplacement mémoire, il suffit de 
saisir son numéro, suivi d'un point (.). Pour 
personnaliser la vitesse Shuttle Lock d'avance 
rapide la plus élevée, reportez-vous à la section 
Vitesse de Shuttle Lock personnalisée, page 320.

Transport : sélectionne un mode Shuttle Lock 
permettant de définir un ensemble de fonctions 
d'enregistrement et de lecture et de piloter les 
transports depuis le clavier numérique. Lorsque 
le mode Transport Numeric Keypad est activé, 
vous pouvez lire un maximum de deux pistes 
audio en mode Shuttle Lock. Appuyez sur la 
touche Contrôle (Macintosh) ou de démarrage 
(Windows), puis sur un chiffre de 0 à 9 pour 
sélectionner la vitesse de lecture. Appuyez sur la 
touche Plus (+) ou Moins (–) pour inverser la 
direction. Pour rappeler un emplacement 
mémoire, il suffit de saisir un point (.), son 
numéro, puis un autre point (.). Pour 
personnaliser la vitesse Shuttle Lock d'avance 
rapide la plus élevée, reportez-vous à la section 
Vitesse de Shuttle Lock personnalisée, page 320.

Shuttle (Pro Tools HD uniquement) : ce mode 
sélectionne un type de Shuttle différent du 
mode Shuttle Lock. En mode Shuttle, la lecture 
est déclenchée par une pression prolongée sur 
les touches du pavé numérique. Elle s'arrête 
lorsque vous relâchez les touches. Vous pouvez 
définir plusieurs vitesses de lecture, en avant ou 
en arrière. Vous pouvez également rappeler un 
emplacement mémoire en saisissant un point 
(.), son numéro, puis un autre point (.).
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Autosave

Cette préférence détermine le fonctionnement 
de l'option Autosave.

Enable Session File Auto Backup : lorsque cette 
option est sélectionnée, Pro Tools enregistre 
automatiquement des sauvegardes de votre 
fichier de session Pro Tools au cours de votre 
travail. Les sauvegardes sont placées dans le 
dossier Session Files Backup à l'intérieur de votre 
dossier de session. Les champs Keep et Backup 
Every permettent de spécifier le nombre total de 
sauvegardes incrémentielles conservées et la 
fréquence d'enregistrement de la session. 

Online Options

Record Online at Time Code (or ADAT)
Lock : lorsque cette option est sélectionnée, 
l'enregistrement en ligne débute dès que 
Pro Tools reçoit un timecode ou un signal de 
synchronisation ADAT, puis le verrouille. 

Record Online at Insertion/Selection : lorsque 
cette option est sélectionnée, l'enregistrement 
en ligne débute à l'emplacement du curseur 
d'édition. Il se poursuit jusqu'à ce que Pro Tools 
ne reçoive plus de timecode. Si vous définissez 
une sélection, Pro Tools enregistre en ligne 
uniquement pendant la durée de la sélection. 

Open Ended Record Allocation

Cette préférence détermine la quantité d'espace 
disque allouée à l'enregistrement.

Use All Available Space : lorsque cette option est 
sélectionnée, la totalité de l'espace disponible 
est allouée à l'enregistrement. Ce choix peut 
ralentir le processus d'enregistrement sur les 
disques durs utilisant certains systèmes de 
fichiers, tels HFS+ et NTFS.

Limit To : définit la durée d'enregistrement 
maximale autorisée. Cette option peut accélérer 
le lancement de l'enregistrement en attribuant 
uniquement une partie du disque dur au 
processus. Le nombre de minutes indiqué est 
alloué pour chaque piste préparée en 
enregistrement. Afin d'obtenir les performances 
d'enregistrement escomptées, il est conseillé de 
faire des essais avec ce paramètre. 

Options de priorité de lecture QuickTime

Normal : priorité de lecture par défaut d'une 
séquence QuickTime. Cette option n'attribue 
aucune priorité particulière à la lecture de la 
séquence par rapport à d'autres tâches de mise à 
jour d'écran telles que les vumètres, les 
déplacements de faders, etc. Dans la plupart des 
cas, vous pouvez utiliser ce paramètre. 
Toutefois, si vous exécutez des séquences 
QuickTime sans carte d'acquisition vidéo, vous 
devrez choisir le paramètre Higher ou Highest 
Playback Priority.

Higher : cette commande attribue une priorité 
supérieure à la lecture d'une séquence 
QuickTime par rapport aux autres tâches de 
mise à jour d'écran de Pro Tools. Il en résulte de 
meilleures performances en lecture de séquence 
si vous lisez des séquences QuickTime sans carte 
d'acquisition vidéo.

Highest : cette commande accorde une priorité 
maximale à la lecture des séquences QuickTime. 
Pro Tools désactive les tâches à l'écran, et 
notamment la mesure, durant la lecture de la 
séquence. Il en résulte des performance de 
lecture de séquence maximales si vous exécutez 
des séquences QuickTime sans carte 
d'acquisition vidéo.
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Options supplémentaires

Custom Shuttle Lock Speed : définit la vitesse 
Shuttle Lock d'avance rapide la plus élevée 
(touche 9) pour les modes Shuttle Lock (Classic 
ou Transport). La plage autorisée est comprise 
entre 50 et 800 %. Pour plus d'informations, 
reportez-vous à la section Vitesse de Shuttle 
Lock personnalisée, page 320.

Calibration Reference Level (Pro Tools HD 
uniquement) : cette option définit le niveau de 
calibration de référence par défaut en dB, 
lorsque Pro Tools fonctionne en mode 
Calibration. Pour les interfaces audio possédant 
des trims (tels que l'interface I/O 192), reportez-
vous au guide de l'interface pour obtenir des 
instructions de calibrage.

Auto Regions Fade In/Out Length : cette option 
définit une durée par défaut pour les 
atténuations d'entrée et de sortie appliquées 
automatiquement aux frontières des régions. 
L'utilisation d'atténuations d'entrée et de sortie 
automatiques évite le montage des régions aux 
points de passage à zéro ou la création 
d'innombrables rendus d'atténuation afin 
d'éliminer les clics et autres parasites survenant 
au cours de la lecture. Les atténuations 
automatiques ne sont pas écrites sur le disque. 
La plage de valeurs de l'option Auto Region Fade 
In/Out Length s'étend de 0 à -10 ms. La valeur 
zéro indique l'absence d'atténuation 
automatique. La valeur de l'option Auto Fade est 
enregistrée avec la session et appliquée 
automatiquement à toutes les frontières de 
région autonomes jusqu'à ce que vous la 
modifiiez.

Back/Forward Amount : définit la longueur par 
défaut des modes retour arrière, retour arrière et 
lecture, avance et avance et lecture. La base de 
temps des paramètres Back/Forward Amount est 
conforme à l'échelle temporelle principale par 
défaut. Il est possible de désélectionner l'option 
Follow Main Time Scale et de choisir un autre 
format de base de temps : Bars:Beats, Min:Sec, 
Time Code, Feet+Frames ou Samples.

Options Solo Latch

Cette préférence détermine si les solos sont 
verrouillés, déverrouillés ou ajoutés 
temporairement (Pro Tools HD uniquement).

Latch : lorsque cette option est sélectionnée, les 
boutons Solo sur lesquels vous appuyez par la 
suite s'ajoutent à l'ensemble de pistes en solo.

Momentary (Pro Tools HD avec une surface de 
contrôle agréée Digidesign uniquement) : 
lorsque cette option est sélectionnée, le bouton 
Solo ne reste pas bloqué. Il faut maintenir le 
bouton Solo enfoncé pour écouter la piste en 
solo. Pour mettre d'autres pistes en solo, il suffit 
de toucher leurs boutons Solo (à condition de 
maintenir au moins un bouton Solo enfoncé). Si 
aucun bouton Solo n'est maintenu enfoncé, 
toutes les pistes qui étaient en solo ne le sont 
plus.

X–OR (Cancels Previous Solos) : lorsque cette 
option est sélectionnée, le fait d'appuyer sur des 
boutons Solo annule les solos précédents.
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Préférences d'édition

Recall Memory Location Selection at Original 
Track : lorsque cette option est sélectionnée, les 
emplacements mémoire rappelant une sélection 
rappellent également la piste sur laquelle la 
sélection a été effectuée.

Auto-Name Memory Locations When
Playing : lorsque cette option est sélectionnée, 
Pro Tools attribue un nom par défaut aux 
nouveaux emplacements mémoire, en fonction 
de leur emplacement temporel dans la session. 
Les unités temporelles sélectionnées dans le 
menu View déterminent les unités utilisées pour 
ces noms. 

Auto-Name Separated Regions : lorsque cette 
option est sélectionnée, Pro Tools nomme 
automatiquement les régions qui viennent 
d'être séparées en ajoutant un numéro à leur 
nom. Il peut être intéressant de désactiver cette 
option lors de l'importation de groupes de 
régions, de fichiers REX ou de fichiers ACID. En 
effet, comme ces types de fichiers contiennent 
parfois un grand nombre de régions distinctes, 
la liste des régions risque d'être difficile à 
consulter.

Region List Selection Follows Edit
Selection : lorsque cette case est cochée, la 
sélection d'une région dans une piste est reflétée 
dans la liste des régions. 

Edit Selection Follows Region List 
Selection : lorsque cette case est cochée, la 
sélection d'une région dans la liste des régions 
affiche en surbrillance l'occurrence de cette 
région dans une piste.

Crossfade Preview Pre-Roll : cette option 
spécifie la quantité de pré-roll ajoutée lors de 
l'écoute des crossfades dans la boîte de dialogue 
Fades.

Crossfade Preview Post-Roll : cette option 
spécifie la quantité de post-roll ajoutée lors de 
l'écoute des crossfades dans la boîte de dialogue 
Fades.

Réglages de fondu par défaut

Fade In : ce paramètre sélectionne la forme 
d'enveloppe par défaut des fade-in. 

Crossfade : ce paramètre sélectionne la forme 
d'enveloppe par défaut des crossfades. 

Fade Out : ce paramètre sélectionne la forme 
d'enveloppe par défaut des fade-out. 

Conversion Quality : cette option sélectionne la 
qualité de la conversion de la fréquence 
d'échantillonnage. La conversion de la 
fréquence d'échantillonnage est utilisée dans un 
certain nombre de traitements dans Pro Tools, 
notamment lors de la conversion et de 
l'importation de fichiers audio de différents 
formats dans une session, pour le prémixage et 
l'enregistrement de pistes avec une fréquence 
d'échantillonnage ou une résolution différentes. 
Plus la qualité de la conversion de la fréquence 
d'échantillonnage choisie est élevée, plus le 
traitement du fichier audio dans Pro Tools est 
lent.
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Liste de prises « Matching Start Time »

Lorsque vous cliquez sur Ctrl (Windows) ou 
Pomme (Macintosh) et que vous cliquez sur la 
région d'une piste, Pro Tools affiche une liste des 
régions dont le marquage temporel correspond 
à l'emplacement actuel du curseur. 
Les préférences suivantes déterminent les 
régions ou prises qui apparaissent dans 
cette liste.

Take Region Names That Match Track
Names : lorsque cette option est sélectionnée, 
seules les régions dont le nom racine est 
identique à celui de la piste et de la playlist 
s'affichent dans le menu déroulant de la liste des 
prises. 

Take Regions Lengths That Match : lorsque cette 
option est sélectionnée, seules les régions dont 
la durée correspond à celle de la sélection en 
cours s'affichent dans le menu déroulant 
Takes List. 

« Separate Region » Operates On All Related
Takes : lorsque cette option est sélectionnée, 
l'édition d'une région avec la commande 
Separate Region concerne également toutes les 
prises associées (passes d'enregistrement) 
possédant le même marqueur temporel de 
l'utilisateur. Cette option aide à comparer 
différentes sections d'un groupe de prises 
associées.

QuickPunch/TrackPunch Crossfade Length : 
cette option spécifie la durée par défaut des 
crossfades créés par l'enregistrement en mode 
QuickPunch ou TrackPunch. Ces crossfades se 
produisent avant le point d'entrée et après le 
point de sortie d'enregistrement. 

Levels of Undo : cette option permet de définir le 
nombre maximal d'actions qu'il est possible 
d'annuler avec la fonction Multiple Undo. 
Lorsque la valeur définie est faible, les 
ordinateurs lents peuvent voir leurs 
performances améliorées. Pro Tools prend en 
charge jusqu'à 32 opérations d'annulation.

Préférences d'automation

Faders Move During Playback : lorsque cette 
option est sélectionnée, les faders à l'écran se 
déplacent si des données d'automation les 
concernant ont été écrites. Lorsque cette option 
est désactivée, l'automation fonctionne mais 
les faders à l'écran ne se déplacent pas. 
La désactivation de cette option permet 
d'accélérer la vitesse d'affichage et de traitement 
de l'écran. 

Smooth and Thin Data After Pass : lorsque cette 
option est sélectionnée, Pro Tools lisse 
automatiquement les données créées lors de la 
passe d'automation, puis les réduit selon la 
valeur spécifiée Reportez-vous à la section 
Réduction de l'automation, page 654.

Les faders sur les surfaces de contrôle ne 
sont pas concernés par cette option.
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Mutes Follow Groups : lorsque cette option est 
sélectionnée, la coupure (Mute) d'une piste 
appartenant à un groupe de mixage coupe le son 
de tous les membres de ce groupe. Lorsque cette 
option est désélectionnée, les pistes sont 
coupées séparément. Vous pouvez également 
couper le son des membres d'un groupe l'un 
après l'autre, en cliquant avec le bouton droit de 
la souris (Windows) sur les boutons Mute leur 
correspondant ou en cliquant sur Ctrl et sur les 
boutons Mute (Macintosh).

Solos Follow Groups : lorsque cette option est 
sélectionnée, l'écoute en Solo d'une piste 
appartenant à un groupe Mix fait passer en Solo 
tous les membres de ce groupe. Lorsque cette 
option est désélectionnée, les pistes sont mises 
en solo séparément. Vous pouvez également 
mettre en solo des membres d'un groupe l'un 
après l'autre, en cliquant avec le bouton droit de 
la souris (Windows) sur les boutons Solo leur 
correspondant ou en cliquant sur Ctrl et sur les 
boutons Solo (Macintosh).

Send Mutes Follow Groups : lorsque cette option 
est sélectionnée, la coupure du son d'un départ 
sur une piste appartenant à un groupe de 
mixage coupe le son du départ correspondant 
(de A à E) sur tous les membres du groupe. 
Lorsque cette option est désélectionnée, le son 
des départs est coupé de façon individuelle. 
Vous pouvez également couper le son des 
membres d'un groupe l'un après l'autre, en 
cliquant avec le bouton droit de la souris 
(Windows) sur les boutons Mute leur 
correspondant ou en cliquant sur Ctrl et sur les 
boutons Mute (Macintosh). 

Send Levels Follow Groups : lorsque cette option 
est sélectionnée, le réglage du niveau d'un 
départ sur une piste appartenant à un groupe de 
mixage règle le niveau du départ correspondant 
(de A à E) sur tous les membres du groupe. 
Lorsque cette option est désélectionnée, le 

niveau des départs est réglé séparément. Vous 
pouvez également ajuster des membres d'un 
groupe les uns après, en appuyant sur la touche 
de démarrage (Windows) ou sur Contrôle 
(Macintosh), puis en faisant glisser les faders de 
niveau de départ. 

LFEs Follow Groups : lorsque cette option est 
sélectionnée, le réglage d'une commande LFE 
(Low Frequency Effects) d'une piste ou d'un 
départ appartenant au groupe de mixage 
entraîne le réglage des contrôles LFE de tous les 
membres du groupe. Lorsqu'elle est 
désélectionnée, les contrôles LFE doivent être 
réglés individuellement. Vous pouvez 
également régler les membres d'un groupe les 
uns après les autres, en appuyant sur la touche 
de démarrage (Windows) ou sur Contrôle 
(Macintosh), puis par une opération de glisser-
déposer des contrôles LFE. Dans le cas d'un LFE 
réalisé par des départs, le groupage ne se 
répercute que sur ce seul départ (de A à E) sur les 
autres pistes. 

After Write Pass, Switch To (Pro Tools HD 
uniquement) : sélectionne le mode d'automation 
sur lequel les pistes Pro Tools basculent 
automatiquement après une passe d'automation 
en mode Write. Vous pouvez décider de passer 
en mode Touch ou Latch ou de rester en mode 
Write en sélectionnant No Change.

Ce paramètre a une incidence sur le mode 
Write/Trim. Après une passe d'automation 
en mode Write/Trim, les pistes basculent 
automatiquement sur la version Trim du 
paramètre spécifié (Latch/Trim, 
Touch/Trim ou Write/Trim).
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Degree of Thinning : cette option spécifie 
l'importance de la « réduction » appliquée aux 
données d'automation à l'aide de la commande 
Thin Automation ou lorsque vous avez 
sélectionné l'option Smooth and Thin Data 
After Pass. Reportez-vous à la section Affinage, 
page 644.

Touch Timeout : lors de l'écriture de données 
d'automation en mode Touch, si vous arrêtez de 
déplacer un contrôle non tactile, Pro Tools 
poursuit l'écriture des données d'automation 
pendant la durée spécifiée par le paramètre 
Touch Timeout.

A l'expiration de ce « délai de contact », 
l'écriture de données d'automation s 'arrête et 
ces données retrouvent leur valeur 
d'automation antérieure, à la vitesse spécifiée 
par le paramètre AutoMatch Time.

AutoMatch Time : lors de l'écriture de données 
d'automation en mode Touch, si vous relâchez 
un fader ou un contrôle, l'écriture s'arrête et les 
données retrouvent leur valeur antérieure. 
La vitesse de restauration de la valeur antérieure 
correspond à la durée AutoMatch. Reportez-
vous à la section AutoMatch Time, page 644.

AutoGlide Time : ce paramètre définit la vitesse à 
laquelle Pro Tools passe (glisse) d'une valeur 
d'automation à une autre, en cas d'utilisation de 
l'option Automation Glide.

Amount of memory to reserve for automation 
recording : attribue de la mémoire pour 
l'automation. Pour plus d'informations, 
consultez la section Configuration de la taille du 
tampon d'automation, page 645.

Préférences de traitement

Options AudioSuite Dither

Use AudioSuite Dither : lorsque cette option est 
sélectionnée, un plug-in Dither sélectionnable 
est appliqué aux tâches de traitement 
spécifiques d'AudioSuite, telles que Gain et 
Normalize.

Dither Plug-In : cette option spécifie le plug-in à 
utiliser pour le traitement de dithering lorsque 
l'option Use AudioSuite Dither est sélectionnée.

Edit Settings : lorsque vous utilisez le plug-in 
Dither de Digidesign, cette option permet 
d'appliquer un effet de dithering normal ou avec 
noise shaping (mise en forme du bruit).
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Résolution

16-, 18-, 20-, and 24-Bit : cette option permet de 
sélectionner une résolution pour les données 
audio après dithering.

Taille du buffer AudioSuite

L'option Audio Suite Buffer Size définit la 
capacité du buffer de mémoire utilisé pour le 
traitement audio et l'aperçu à l'aide des plug-in 
AudioSuite. Si l'aperçu AudioSuite n 'est pas fixe, 
définissez le buffer sur Mini ou Small. 
Le traitement est généralement plus rapide 
lorsque le buffer est défini sur Larger ou Jumbo.

TC/E

TC/E Plug-In : permet de sélectionner le plug-in 
utilisé par les fonctions de 
compression/extension temporelle (Time 
Compression et Expansion) lors de l'édition des 
données audio à l'aide de l'outil de trimming 
correspondant. L'outil de trimming utilise la 
fonction Time Compression/Expansion pour 
faire correspondre la durée d'une région audio à 
celle d'une autre région, à une grille de tempo, à 
une scène vidéo ou à tout autre point de 
référence. 

Default Settings : spécifie les paramètres par 
défaut du plugin Time Compression/Expansion.

Préférences MIDI

Default Note On Velocity : cette option définit la 
valeur de vélocité de Note On par défaut pour les 
notes MIDI insérées dans la fenêtre Edit et la 
liste MIDI Event.

Pencil Tool Resolution When Drawing Controller 
Data : cette option définit la résolution par 
défaut des données de contrôleur MIDI créées 
avec le crayon. Le choix d'une valeur de 
résolution modérée évite la création de données 
de contrôleur inutilement denses. Ce paramètre 
est réglable entre 1 et 100 millièmes de seconde.

Global MIDI Playback Offset : permet de définir 
une valeur de décalage en échantillons afin de 
compenser la latence MIDI. La saisie d'une 
valeur dans cette zone conduit au même résultat 
que la définition d'un décalage à l'aide de la 
commande MIDI Track Offsets (Event > MIDI 
Track Offsets). Les valeurs de décalage peuvent 
être positives (plus tard) ou négatives (plus tôt). 
Guide de référence Pro Tools



Default Thru Instrument : définit l'instrument 
MIDI Thru par défaut. Vous pouvez sélectionner 
un périphérique prédéfini à partir des 
instruments MIDI disponibles ou choisir 
« Follows First Selected MIDI Track » pour 
utiliser la sortie MIDI assignée de la première 
piste MIDI ou Instrument sélectionnée. En cas 
de sélection de plusieurs pistes MIDI ou 
Instrument, c'est l'instrument de la piste 
sélectionnée qui est le plus proche du sommet 
de la fenêtre Edit (ou du bord gauche de la 
fenêtre Mix) qui est utilisé.

Zone General

Play MIDI Notes When Editing : si cette option 
est sélectionnée, les notes MIDI sont audibles 
lors de leur insertion avec le crayon ou de leur 
déplacement à l'aide d'un outil Main.

Use MIDI to Tap Tempo : lorsque cette option est 
sélectionnée, vous pouvez battre le tempo sur 
un clavier MIDI afin d'entrer la nouvelle valeur 
de tempo dans le champ du tempo.

Display Events as Modified by Real-Time 
Properties : lorsque cette option est 
sélectionnée, Pro Tools affiche les effets des 
propriétés en temps réel à la fois dans la fenêtre 
Edit et dans la liste des événements MIDI.

Options MIDI Note Display

ces options définissent la référence du C moyen 
comme C3, C4 ou la note MIDI numéro 60.

Options Delay for External Devices 
(Pro Tools HD uniquement)

Ces options permettent d'appliquer une 
compensation de retard aux signaux MIDI Time 
Code ou MIDI Beat Clock générés par Pro Tools. 
En général, il est préférable d'appliquer ce retard 
en cas de mixage externe de l'instrument MIDI 
externe, mais pas lorsque l'instrument MIDI 
externe est mixé à l'aide de la console de mixage 
Pro Tools. 

Ces options sont disponibles à condition d'avoir 
choisi un moteur de compensation de retard 
dans la boîte de dialogue Playback Engine et 
d'avoir activé l'option Delay Compensation 
dans Pro Tools.

Préférences Machine Control

Ces préférences déterminent le mode de réponse 
du transport d'une machine connectée à 
Pro Tools.
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Machine Control

Machine Chases Memory Location : lorsque 
cette option est sélectionnée, le déplacement 
vers un emplacement donné dans une session à 
l'aide d'un emplacement mémoire fait « suivre » 
le transport connecté, qui se rend aussi à cet 
emplacement.

Machine Follows Edit Insertion/Scrub : lorsque 
cette option est sélectionnée, la recherche d'un 
emplacement spécifique dans une session par 
déplacement du point de sélection ou scrubbing 
d'une piste fait « suivre » le transport connecté, 
qui se rend aussi à cet emplacement.

Machine Cues Intelligently : lorsque cette option 
est sélectionnée, si vous désirez vous rendre en 
un point situé à plus de 10 secondes de la 
position actuelle, Pro Tools ordonne au 
transport connecté de se rendre à l'emplacement 
choisi à pleine vitesse jusqu'à 10 secondes avant 
le point demandé. L'avance rapide ralentit alors 
et la lecture se poursuit en vitesse normale 
jusqu'au point sélectionné. Ce processus 
accélère considérablement l'avance rapide sur 
les bandes avec certaines transports vidéo.

Stop at Shuttle Speed Zero : provoque l'envoi 
d'une commande Stop par Pro Tools, chaque 
fois que vous arrêtez le shuttle. Cette fonction 
s'avère utile si votre ordinateur requiert une 
commande d'arrêt explicite pour s 'arrêter 
correctement. 

Remote Mode (émulation d'un appareil 
9 broches)

(Pro Tools HD uniquement)

Punch In Frame Offset : cette option définit un 
décalage (exprimé en images) visant à 
compenser l'avance ou le retard du passage en 
mode enregistrement.

Punch Out Frame Offset : cette option définit un 
décalage (exprimé en images) visant à 
compenser l'avance ou le retard de l'arrêt du 
mode enregistrement.

Delay After Play Command : définit un décalage 
(exprimé en images) pour compenser le temps 
de verrouillage des ordinateurs externes. 

Ignore Track Arming : demande à Pro Tools 
d'ignorer les commandes d'activation de pistes 
(pour l'enregistrement) entrantes. Cette 
fonction est utile si vous utilisez un contrôleur 
principal pour préparer l'enregistrement des 
pistes sur d'autres ordinateurs, sans avoir à 
préparer de pistes dans Pro Tools.

Set Servo Lock Bit at Play (Tamura Support) : 
activez cette option lorsque vous utilisez un 
synchroniseur Tamura pour piloter Pro Tools en 
mode Remote afin de minimiser les temps de 
verrouillage lors de l'enregistrement.
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Chapitre 7 : Configuration des E/S

La boîte de dialogue I/O Setup contient des 
outils permettant d'identifier, de formater et 
d'affecter les chemins des signaux d'entrée, de 
sortie, d'insert et de bus de Pro Tools pour 
chaque session. 

Un chemin de signal est un regroupement 
logique de plusieurs entrées, sorties ou bus, qui 
possède un nom et un format (de canal) 
uniques. Dans Pro Tools, la notion de chemin 
est voisine de celle de prémixages ou stems, 
connus et pratiqués dans les milieux du cinéma 
et de la vidéo (voir Stems et prémixages, 
page 90). La boîte de dialogue I/O Setup permet 
de nommer et de définir ces chemins selon les 
besoins de chaque projet.

Dans Pro Tools HD, la boîte de dialogue I/O 
Setup offre une représentation graphique de 
l'acheminement des signaux pour chaque 
interface audio branchée ainsi que des 
commandes d'assignation des ports physiques 
sur les entrées et sorties Pro Tools. Les 
paramètres de ces commandes reflètent ceux des 
commandes d'acheminement de la boîte de 
dialogue Hardware Setup : les modifications 
apportées au routage dans une boîte de dialogue 
sont toujours reflétées dans l'autre boîte de 
dialogue.

Chaque système Pro Tools peut posséder une 
configuration  d'E/S différente, déterminée par 
les conditions suivantes :

• Le type de système utilisé (Pro Tools LE, 
Pro Tools M-Powered ou Pro Tools|HD)

• Sur les systèmes Pro Tools|HD, le nombre et le 
type d'interfaces audio

• Sur les systèmes Pro Tools|HD, le plug-in de 
console actuellement installé (Stéréo ou 
Surround)

Chaque session Pro Tools conserve sa 
configuration de chemins sous forme de 
paramètres  d'E/S. Les paramètres d'E/S 
enregistrés avec la session sont chargés 
automatiquement lors de l'ouverture de la 
session. Les éléments non disponibles (matériel, 
chemins ou ressources nécessaires) demeurent 
dans la session, mais sont inactifs (voir Chemins 
actifs et inactifs, page 100).

Lorsque vous créez des sessions, vous pouvez 
spécifier une configuration d'E/S par défaut, 
comportant des présélections pour les formats 
de mixage stéréo ou multicanal. Le mixage 
multicanal nécessite un système Pro Tools|HD.

La boîte de dialogue I/O Setup permet 
également de sauvegarder et d'importer les 
fichiers de paramètres d'E/S. 
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Navigation dans la boîte de dialogue I/O Setup

Pour redimensionner la boîte de dialogue 
I/O Setup :

■ Faites glisser l'angle inférieur droit de la 
fenêtre selon la procédure standard de votre 
système d'exploitation (Windows ou 
Macintosh).

Pour faire défiler la fenêtre Disk Allocation vers le 
haut ou le bas :

■ Appuyez sur Page Up ou Page Down.

Pour faire défiler le contenu de la boîte de dialogue 
I/O Setup vers la gauche ou vers la droite :

■ Maintez la touche Alt (Windows) ou Option 
(Macintosh) enfoncée et appuyez sur Page 
Up/Down.

Chemins dans les sessions

Au cours des sessions, le signal audio est envoyé 
vers plusieurs destinations à l'aide des sélecteurs 
d'entrée, de sortie, d'insert, de plug-in et de 
départ de la piste. Les sélecteurs permettent 
d'affecter les pistes à des entrées et des sorties 
matérielles, à des bus internes et à d'autres 
chemins de signaux dans Pro Tools.

Les chemins comportent les listes des 
acheminements de signaux disponibles via les 
sélecteurs d'entrée, de sortie, d'insert et de 
départ de la piste.

Chemins et configuration des E/S

Les choix d'affectation du signal disponibles 
dans les sessions sont définis dans la boîte de 
dialogue I/O Setup. 

Sélecteur de chemin d'entrée et chemins

Sélecteur de chemin de sortie et chemins

Chemins de sortie dans la boîte de dialogue I/O Setup 
(Pro Tools HD)
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Chemins principaux et sous-
chemins

La boîte de dialogue I/O Setup contient des 
chemins principaux et des sous-chemins.

Chemins principaux

Les chemins principaux sont des regroupements 
logiques d'entrées, d'inserts, de bus ou de sorties. 
Par exemple, un chemin de sortie stéréo 
générale pourrait porter le nom Main Out. 
Les noms de chemins stéréo se terminent 
souvent par les suffixes « .L » et « .R » (pour les 
canaux gauche et droit). 

Sous-chemins

Un sous-chemin représente le chemin d'un signal 
au sein d'un chemin principal. Un chemin de 
sortie stéréo par défaut, par exemple, est 
constitué de deux sous-chemins mono, gauche 
et droit. Des pistes ou départs mono peuvent 
être affectés vers l'un ou l'autre des sous-
chemins mono d'un chemin de sortie stéréo. 

Paramètres d'E/S par défaut

Etant donné que Pro Tools installe 
automatiquement un fichier de paramètres d'E/S 
par défaut, vous disposez dès le départ d'un 
ensemble de chemins par défaut et n'avez pas 
besoin d'effectuer de réglages dans la boîte de 
dialogue I/O Setup. Vous pouvez personnaliser 
vos paramètres d'E/S à tout moment, selon les 
besoins spécifiques de chaque projet (voir Boîte 
de dialogue I/O Setup, page 91). 

Fichiers des paramètres par défaut

Le fichier des paramètres par défaut stéréo est 
disponible sur tous les systèmes Pro Tools. 
Il propose des chemins principaux stéréo 
disposant chacun de leurs propres sous-chemins 
mono. 

Les fichiers de paramètres multicanaux sont 
disponibles pour les systèmes Pro Tools|HD. 
Ces paramètres correspondent à la définition de 
chemins spécifiques au mixage Surround. Pour 
plus d'informations, reportez-vous à la section 
Configuration de Pro Tools pour les sessions 
multicanaux, page 712.

Noms de chemins par défaut

L'attribution par défaut de noms de chemins 
d'entrées, de sorties et d'inserts est basée sur le 
type de système (pour les systèmes Pro Tools LE) 
ou le type et le nombre d'interfaces (pour les 
systèmes Pro Tools|HD) que vous utilisez.

Chemins principaux et sous-chemins dans la grille de 
configuration d'E/S du canal

Cette option est surtout pratique pour 
définir et nommer des sous-chemins au sein 
de configurations de mixage complexes, 
telles qu'un mixage Surround 5.1. 

Chemin stéréo principal

Sous-chemin mono

Sous-chemin mono
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Stems et prémixages

L'utilisation de stems et de prémixages provient 
du domaine de la post-production et permet 
d'organiser et de gérer les éléments d'un mixage 
par type ou par contenu. 

Par exemple, le mixage d'un film s'effectue le 
plus souvent après prémixage des effets sonores, 
des dialogues et de la musique. Le prémixage des 
dialogues, par exemple, contient tous les 
éléments du dialogue correctement équilibrés. 
Lors du mixage final de la scène ou de la bobine, 
ce prémixage des dialogues est mixé avec les 
autres prémixages. Cette procédure simplifie le 
mixage final : il suffit en effet de contrôler le 
niveau de chaque prémixage, plutôt que d'agir 
séparément sur le niveau des dizaines de pistes 
distinctes composant généralement la bande 
son d'un film.

Pro Tools permet de travailler avec des chemins 
principaux et des sous-chemins, comme avec 
des prémixages. Ceux-ci peuvent être affectés 
suivant les besoins et permettent notamment 
d'affecter plusieurs sorties à des pistes et des 
départs individuels. Pour plus d'informations, 
reportez-vous à la section Assignations de sorties 
multiples, page 582.
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Boîte de dialogue I/O Setup
La boîte de dialogue I/O Setup définit le chemin des signaux d'entrée, de sortie, d'insert et de bus de 
Pro Tools. L'assignation des ports d'E/S vers les entrées et sorties de Pro Tools peut également 
s'effectuer ici.

Pour ouvrir la boîte de dialogue I/O Setup :

1  Vérifiez que les interfaces audio sont actives et 
configurées correctement dans la boîte de 
dialogue Hardware Setup. Pour plus 
d'informations, reportez-vous à la section 
Configuration des paramètres matériels 
Pro Tools, page 55.

2  Choisissez Setup > I/O. 

Pour ouvrir la fenêtre Input, Output, Insert, Bus, 
Mic Preamps ou H/W Insert Delay à partir de la 
boîte de dialogue I/O Setup :

■ Cliquez sur l'onglet approprié en haut de la 
boîte de dialogue I/O Setup. 

Figure 5.  Boîte de dialogue I/O Setup sur un système Pro Tools|HD avec une interface 96 I/O

Grille des canaux

Onglets des 
types de chemin

Développer/Réduire 
les chemins

Etat actif/inactif

Options

Chemins principaux 
et sous-chemins

Sélecteur de format de cheminColonne de nom du chemin

Outils du chemin

Sélecteurs d'entrées 
et de sorties

Etiquette de 
l'interface
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Fermeture de la boîte de dialogue I/O Setup

Vous pouvez refermer la boîte de dialogue 
I/O Setup à tout moment en cliquant sur 
Cancel. Lorsque vous cliquez sur OK, Pro Tools 
vérifie la validité de plusieurs paramètres 
d'affectation (afin d'éviter les boucles de 
signaux). Si certains paramètres entrent en 
conflit ou ne sont pas valides, vous serez invité à 
les corriger avant que la boîte de dialogue 
I/O Setup ne se referme. Pour plus 
d'informations, reportez-vous à la section 
Initialisation de la configuration des I/O, 
page 99.

Commandes de la boîte de 
dialogue I/O Setup

Voici les différentes commandes de la boîte de 
dialogue I/O Setup.

Onglets des types de chemin : permettent de 
sélectionner le type de commande d'E/S à 
configurer (Input, Output, Insert, Bus, Mic 
Preamps ou H/W Insert Delay).

Sélecteurs d'entrées et de sorties :  permettent 
de sélectionner les ports physiques de votre 
interface audio à affecter aux entrées et sorties 
de Pro Tools. Les ports sont disponibles sous 
forme de paires de canaux. Les ports disponibles 
pour chaque interface affichée sont basés sur les 
paramètres de la configuration matérielle. Si, par 
exemple, les entrées et sorties AES/EBU d'une 
interface sont activées dans la fenêtre Hardware 
Setup, elles sont disponibles pour le routage 
dans la fenêtre I/O Setup. La fonctionnalité du 
sélecteur d'entrée et de sortie est identique à 
celle disponible dans la page Main de la boîte de 
dialogue Hardware Setup.

Colonne de nom du chemin : indique les 
chemins pouvant être sélectionnés, y compris le 
nom spécifié pour chaque chemin défini.

Développer/Réduire : permet d'afficher ou de 
masquer les sous-chemins associés à un chemin 
principal.

Etat actif/inactif : indique et permet de modifier 
l'état, actif ou inactif, de chaque chemin.

Sélecteur de format de chemin : affiche et 
permet de sélectionner le type/format (mono, 
stéréo, Quad, 5.1, etc.) de chaque chemin défini.

Grille des canaux : affecte les chemins à des 
interfaces et des canaux spécifiques. 

Compensation des retards d'entrée et de sortie : 
permet la compensation automatique des 
retards d'entrée et de sortie causés par le matériel 
Digidesign analogique-numérique et 
numérique-analogique.

Outils du chemin : personnalise la configuration 
de la boîte de dialogue I/O Setup. Les boutons 
comprennent : New Path, New Sub-Path, Delete 
Path et Default.

Bouton Show Original Setup : s'affiche dans la 
boîte de dialogue I/O Setup dans certains cas de 
transfert de session. Pour plus de détails sur cette 
fonction, voir Affichage de la configuration 
d'origine et de la configuration en cours, 
page 102 

Options : les options permettent d'afficher des 
menus déroulants de définition des chemins ou 
des ordres pour Controller Meter Path, Audition 
Paths (aperçu de la liste des régions), New Track 
Default Output et Default Path Order. Pour plus 
d'informations, reportez-vous à la section 
Options de configuration d'E/S, page 106.
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Affectation de l'I/O 
matérielle à l'I/O Pro Tools
La boîte de dialogue I/O Setup permet de définir 
les ports physiques du périphérique d'E/S 
affectés aux entrées et sorties disponibles dans 
Pro Tools. Les sélecteurs d'entrées et de sorties 
de la fenêtre I/O Setup servent de patch 
permettant d'affecter l'une des entrées ou des 
sorties physiques à la console de mixage 
Pro Tools.

Pour configurer le routage des entrées/sorties 
dans I/O Setup :

1  Sélectionnez Setup > I/O.

2  Cliquez sur l'onglet Input ou Output pour 
afficher le type de chemin correspondant. 

3  Cliquez sur le sélecteur d'entrée ou de sortie 
pour la première paire de canaux de l'interface, 
située sous l'icône de la première interface 
audio.

4  Dans le menu déroulant, sélectionnez une 
paire de ports physiques (tels que Analog 1–2), 
pour l'acheminer à une paire de canaux 
Pro Tools (tels que A 1–2) dans la colonne Path 
Name, située dans la partie gauche. 

5  Répétez les étapes précédentes pour toute 
paire de canaux supplémentaire.

6  Cliquez sur OK.

Affectation d'une paire de sorties 
Pro Tools à plusieurs destinations

Les paires de canaux Pro Tools peuvent être 
affectées à plusieurs sorties d'une interface audio 
à l'aide de la boîte de dialogue I/O Setup. Si, par 
exemple, vous affectez les deux sorties 
d'interface Analog 1–2 et Analog 3–4 à la paire 
de sorties Pro Tools 1–2, un signal envoyé aux 
sorties Pro Tools 1–2 est acheminé 
simultanément aux deux paires de sorties de 
l'interface audio.

Ceci vous donne la possibilité d'envoyer le 
même signal (tel qu'une paire stéréo, un 
prémixage ou un mixage multicanal) vers de 
nombreuses destinations (telles que divers 
périphériques de mastering).

Le nombre de sorties disponibles sur votre 
système est la seule limite au choix des sorties.

Les paires de sorties Pro Tools peuvent 
également être acheminées vers plusieurs sorties 
d'interface audio dans la boîte de dialogue 
Hardware Setup. Pour plus d'informations, 
reportez-vous à la section Acheminement d'une 
paire de sorties Pro Tools vers des destinations 
multiples, page 58.

Menu déroulant du sélecteur de canal d'E/S

Les affectations des chemins de sorties ne 
peuvent pas se chevaucher. Pour plus 
d'informations, consultez la section 
Chemins valides et conditions, page 99.
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Pour affecter une paire de canaux de sortie 
Pro Tools à plusieurs ports de sortie d'interface 
audio :

1  Sélectionnez Setup > I/O.

2  Cliquez sur l'onglet Output. 

3  Cliquez sur le sélecteur de sortie 
correspondant à une paire de canaux de 
l'interface, juste en dessous de l'icône de 
l'interface audio. 

4  Dans le menu déroulant, sélectionnez une 
paire de ports physiques (tels que Analog 1–2), 
pour l'acheminer à la paire de canaux Pro Tools 
correspondants (tels que A 1–2) dans la colonne 
Path Name, située dans la partie gauche.

5  Maintenez enfoncée la touche de démarrage 
(Windows) ou Contrôle (Macintosh), pendant 
que vous cliquez sur le même sélecteur de sortie 
et sélectionnez une paire de sorties 
supplémentaires depuis le même menu 
déroulant.

Le nom de la sortie est précédé d'un signe plus 
(+) pour indiquer que plusieurs ports de sortie 
ont été sélectionnés. Dans le menu déroulant, 
chaque paire de ports physiques affectée à la 
paire de sorties Pro Tools est signalée par une 
coche.

6  Répétez les étapes précédentes pour 
sélectionner des destinations de sortie 
supplémentaires. 

7  Cliquez sur OK.

Création et modification de 
chemins 
Vous pouvez créer et personnaliser les 
définitions des chemins des signaux en utilisant 
la boîte de dialogue I/O Setup. 

Les chemins peuvent être :

• Renommés, pour faciliter l'identification 
après changement ou attribution d'un 
nouveau nom à des interfaces audio

• Réaffectés, vers ou à partir de différentes 
sources ou destinations

• Désactivés (ou réactivés) pour gérer des 
ressources d'E/S non disponibles ou inutiles

• Supprimés

Vous pouvez en outre importer et exporter les 
configurations d'E/S sous forme de fichiers de 
paramètres d'E/S et définir des paramètres de 
chemin par défaut.

Le tableau suivant dresse la liste des attributs 
disponibles pour chaque type de chemin.

Options de chemin par type

Type de 
chemin

Options de chemin (attributs)

Entrée Noms, formats et canal/voie 
source (interface audio 
analogique ou numérique ou 
entrée CPU)

Sortie Noms, formats et destination 
(canal de sortie de l'interface 
audio ou bus de départ interne)

Insert Noms, formats et destination 
(canaux de l'interface audio)

Bus Noms et formats
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Création d'un chemin ou d'un sous-
chemin par défaut

Vous pouvez régler à tout moment le type de 
chemin de paramètres d'E/S sur sa configuration 
par défaut.

Pour restaurer les chemins et les noms de 
chemins par défaut :

1  Sélectionnez Setup > I/O.

2  Cliquez sur l'onglet Input, Output, Insert ou 
Bus pour afficher le type de chemin 
correspondant.

3  Cliquez sur Default. 

Pro Tools crée tous les chemins stéréo 
principaux possibles. Des sous-chemins mono 
sont également créés automatiquement pour 
chaque chemin stéréo principal. Ces noms de 
chemins par défaut s'affichent dans les 
sélecteurs de chemins d'entrées et de sorties 
audio de piste de la session. 

Création de chemins

Vous pouvez créer des chemins principaux et 
sous-chemins avec des noms, des affectations et 
de formats personnalisés. Les noms de chemins 
personnalisés apparaissent dans les sélecteurs 
d'entrées, de sorties, d'inserts et de bus de la 
piste de la session.

Pour créer un chemin :

1  Sélectionnez Setup > I/O.

2  Cliquez sur l'onglet Input, Output, Insert ou 
Bus pour afficher le type de chemin 
correspondant.

3  Cliquez sur New Path ou appuyez sur les 
touches Ctrl + N (Windows) ou sur Pomme + N 
(Macintosh). 

– ou –

Sélectionnez un chemin principal et cliquez sur 
New Sub-Path. 

4  Cliquez deux fois dans le champ Name et 
attribuez un nom au chemin. 

5  Appuyez sur la touche de tabulation pour 
valider le nouveau nom du chemin et passer au 
champ Name du chemin suivant ou appuyez sur 
la touche Entrée (Windows) ou Retour 
(Macintosh) pour valider le nom du nouveau 
chemin. 

6  Choisissez un format dans le sélecteur de 
format de chemin (mono, stéréo ou multicanal). 

Chemins de sorties stéréo par défaut

Pour optimiser les ressources du DSP du 
système Pro Tools, il est préférable de créer 
des sous-chemins mono pour les sorties et 
les bus, plutôt que de créer des chemins 
mono principaux.

Sélecteur de format de chemin
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7  Configurez les autres types de chemins (Input, 
Output, Insert ou Bus) en répétant les étapes 
précédentes.

8  Cliquez sur OK pour fermer la boîte de 
dialogue I/O Setup. Si certains chemins se 
superposent ou portent le même nom, vous 
serez invité à les corriger avant que la boîte de 
dialogue I/O Setup ne se referme. Pour plus 
d'informations, reportez-vous à la section 
Initialisation de la configuration des I/O, 
page 99.

Sélection et agencement des chemins

La colonne Path Name de la boîte de dialogue 
I/O Setup permet de sélectionner un ou 
plusieurs chemins. Une fois sélectionnés, les 
chemins et sous-chemins peuvent être déplacés 
vers le haut ou vers le bas pour changer leur 
ordre d'affichage dans les sélecteurs d'entrées, de 
sorties, d'inserts et de bus de la piste. Vous 
pouvez également les supprimer. Un sous-
chemin suit son chemin principal lors de leur 
déplacement dans la boîte de dialogue 
I/O Setup.

Pour sélectionner un chemin principal ou un sous-
chemin :

■ Cliquez sur le nom du chemin.

Pour sélectionner un ensemble continu de 
chemins :

1  Cliquez sur le nom du chemin.

2  Tout en maintenant la touche Maj enfoncée, 
cliquez sur un nom de chemin supplémentaire.

Tous les chemins compris entre le premier nom 
de chemin sélectionné et le nom de chemin 
supplémentaire sont automatiquement pris en 
compte.

Pour sélectionner ou désélectionner des chemins 
non consécutifs, procédez comme suit :

■ Maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Macintosh) et cliquez sur les noms 
de chemin qui ne sont pas en surbrillance pour 
les sélectionner.

– ou –

■ Maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Macintosh) et cliquez sur les noms 
de chemin qui sont en surbrillance pour les 
désélectionner.

Pour sélectionner tous les chemins et sous-
chemins :

■ Maintenez la touche Alt (Windows) ou 
Option (Macintosh) enfoncée pendant que vous 
cliquez sur un nom de chemin qui n'est pas en 
surbrillance.

Pour désélectionner tous les chemins et sous-
chemins :

■ Maintenez la touche Alt (Windows) ou 
Option (Macintosh) enfoncée pendant que vous 
cliquez sur un nom de chemin en surbrillance.

Pour réagencer les chemins :

■ Faites glisser un ou plusieurs noms de chemin 
vers le haut ou vers le bas. 

Les chemins multicanaux et le mixage sont 
expliqués au Chapitre 30, Configuration 
de Pro Tools pour le mixage en mode 
Surround (Pro Tools HD uniquement)..

Sélection des chemins dans la boîte de dialogue 
I/O Setup
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Réinitialisation des chemins

Le bouton Default de la boîte de dialogue 
I/O Setup possède deux fonctions principales :

• Création de chemins par défaut jusqu'à la 
limite de la capacité des interfaces audio et 
ressources disponibles de votre système. Pour 
plus d'informations, reportez-vous à la section 
Création d'un chemin ou d'un sous-chemin 
par défaut, page 95.

• Réinitialisation des noms des chemins 
sélectionnés conformément aux chemins 
correspondants de la configuration d'E/S en 
cours. Si vous remplacez, par exemple, une 
interface audio sur un système Pro Tools|HD, 
le bouton Default permet de mettre à jour vos 
définitions de paramètres d'E/S en fonction de 
la nouvelle configuration du matériel. 

Pour réinitialiser les noms des chemins :

■ Cliquez sur Default.

Si des chemins correspondants sont disponibles 
dans la nouvelle configuration du système, les 
chemins existants seront mis à jour afin 
d'inclure les nouvelles interfaces audio 
(systèmes Pro Tools|HD).

Réinitialisation des bus de mixage

(Pro Tools HD uniquement)

Pro Tools prend en charge jusqu'à 128 bus de 
mixage (Pro Tools HD 7.0 et 
Pro Tools TDM 6.9), 64 bus de mixage 
(Pro Tools TDM 6.7.x et versions antérieures) ou 
32 bus de mixage (Pro Tools 7.0 et 5.0.1 et 
versions antérieures). Lorsque vous ouvrez une 
session créée avec une version antérieure de 

Pro Tools, le nombre de bus initialement 
disponible correspond au nombre de bus pris en 
charge sur le système antérieur. Vous pouvez, 
cependant, réajuster ce nombre en fonction des 
capacités de votre système actuel.

Pour utiliser tous les bus disponibles dans des 
sessions créées avec une version antérieure de 
Pro Tools :

1  Ouvrez la boîte de dialogue I/O Setup.

2  Cliquez sur l'onglet Bus situé dans l'angle 
supérieur gauche.

3  Cliquez sur Default. 

Modification des noms des interfaces

Les noms des interfaces audio peuvent être 
personnalisés dans la boîte de dialogue 
I/O Setup. Par la suite et sur les systèmes 
Pro Tools HD uniquement, la boîte de dialogue 
I/O Setup base les noms de chemins par défaut 
sur ces noms personnalisés.

Pour renommer une interface audio dans la boîte 
de dialogue I/O Setup :

1  Cliquez deux fois sur l'étiquette située au-
dessus du nom d'une interface.

2  Attribuez un nouveau nom à l'interface.

Il est possible de personnaliser les noms des 
interfaces. Pour plus d'informations, 
reportez-vous à la section Modification 
des noms des interfaces, page 97.

Le rétablissement des paramètres de bus par 
défaut a pour effet de redéfinir le nom de 
tous les bus en fonction de leurs noms par 
défaut.
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3  Appuyez sur la touche Entrée (Windows) ou 
Retour (Macintosh). 

Suppression de chemins

Les définitions de chemins inutiles ou 
indésirables peuvent être supprimées de la 
session courante pour refléter les modifications 
de votre configuration matérielle ou pour 
nettoyer les menus du sélecteur de piste. Après 
avoir supprimé un chemin, les affectations de 
pistes ou de signaux d'envoi vers celui-ci sont 
réinitialisées à No Output (pas de sortie).

Pour supprimer un chemin principal ou un sous-
chemin :

1  Sélectionnez les chemins que vous voulez 
supprimer dans la boîte de dialogue I/O Setup. 

2  Cliquez sur Delete Path. 

Pour supprimer tous les chemins :

1  Maintenez la touche Alt (Windows) ou Option 
(Macintosh) enfoncée pendant que vous cliquez 
sur un nom de chemin.

2  Cliquez sur Delete Path.

Affectation des canaux

Lorsque vous avez créé et formaté un chemin, il 
peut être affecté à des canaux de la grille 
spécifiques d'une interface audio ou d'un bus.

Pour affecter des canaux :

1  Sélectionnez un chemin principal ou un sous-
chemin. 

2  Dans la rangée correspondant au chemin 
sélectionné, cliquez sur la colonne de la grille 
sous l'interface audio et le canal désirés. Les 
autres canaux pour ce type de chemin sont 
renseignés à droite, le cas échéant. 

Lorsque vous affectez, par exemple, un nouveau 
chemin stéréo et que vous cliquez sous le canal 
de sortie 1 dans la rangée correspondant au 
chemin, les canaux 1 et 2 se remplissent (à 
gauche sur 1, à droite sur 2). 

Pour réaffecter des canaux dans un chemin, 
reportez-vous à la section Réaffectation de 
canaux, page 99.

Affectation de canaux et console de mixage 
Surround

(Pro Tools HD uniquement)

Lors de l'affectation de chemins multicanaux, le 
canal de gauche (L) est affecté en premier sur la 
zone de grille sélectionnée et les canaux restants 
de droite sont renseignés immédiatement en 
respectant l'ordre des chemins par défaut. 
Du fait que certains formats de mixage 
multicanaux utilisent des dispositions de pistes 
propres, Pro Tools permet de définir le format 
par défaut dans la boîte de dialogue I/O Setup 
(voir Options de configuration d'E/S, page 106).

Noms des interfaces

Nom de l'interface

Affectation des canaux
Guide de référence Pro Tools



Réaffectation de canaux

Vous pouvez déplacer les affectations 
individuelles vers des canaux différents pour 
réorganiser la définition du chemin (en 
modifiant une affectation multicanal en L-R-C-
LF-LS-RS, par exemple). 

Pour réaffecter des canaux dans un chemin :

■ Faites glisser le canal vers le nouvel 
emplacement de la grille. Les autres affectations 
de canaux se décalent en conséquence.

Réorganisation des canaux

Le déplacement d'un signal de droite à gauche 
produit une réorganisation des autres signaux se 
retrouvant placés après le nouveau canal de 
destination. Le déplacement d'un signal de 
gauche à droite provoque une réorganisation 
(shuffling) de tous les signaux à la suite du 
nouveau canal de destination et laisse vide le 
canal précédemment utilisé. 

Les sous-chemins suivent les chemins 
principaux

Lorsqu'un chemin principal est réaffecté, ses 
sous-chemins (s'il en existe) sont réaffectés 
automatiquement pour conserver la cohérence 
des affectations. Par exemple, la réaffectation 
d'un chemin stéréo vers d'autres sorties 
matérielles s'accompagne d'un déplacement 
identique de ses sous-chemins. 

Initialisation de la configuration 
des I/O

Pour définir la configuration d'E/S en cours :

■ Cliquez sur OK dans la boîte de dialogue 
I/O Setup. 

Tous les chemins doivent être valides pour 
pouvoir appliquer la configuration d'E/S. 

Chemins valides et conditions

Lors de la configuration de la boîte de dialogue 
I/O Setup, un certain nombre de règles doivent 
être respectées pour définir les chemins et 
affecter les canaux. 

Bien qu'il soit possible de définir des affectations 
non valides dans la grille des canaux, Pro Tools 
n'acceptera une configuration d'E/S que si tous 
les chemins correspondent aux conditions de 
définition des chemins et d'affectation décrites 
ci-après.

Définitions minimales des chemins : tous les 
chemins doivent posséder un nom, un format 
spécifique et une affectation d'E/S valide. 

Chemins de sorties personnalisés pour un mixage 5.1

Le changement de format d'un chemin 
efface toutes les affectations de canaux en 
cours. 
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Canaux superposés et chemins valides : 
l'affectation des canaux respecte certaines règles 
concernant la superposition des chemins. 

• Il ne peut exister aucune superposition 
partielle ou complète entre deux chemins 
de sorties principaux, entre deux chemins 
d'inserts ni entre deux chemins de bus 
principaux. 

• Un chemin de type Output ou Bus créé doit 
être soit complètement indépendant des 
autres chemins (c'est-à-dire affecté à 
aucune autre interface d'E/S ou canal 
disponible) soit un sous-chemin 
totalement intégré à un chemin plus grand 
(par exemple un sous-chemin LCR dans un 
chemin 5.1).

• Les chemins de type Output et Insert 
peuvent se superposer dans la 
configuration d'E/S, mais un seul des deux 
peut être utilisé à un instant donné en 
cours de session. En revanche, les chemins 
de type Inputs peuvent être affectés à 
plusieurs pistes. 

Chemins actifs et inactifs

Les chemins de Pro Tools peuvent être actifs 
(on) ou inactifs (off, ou non disponibles). 
La commutation actif/inactif s'effectue 
manuellement, piste par piste ou session par 
session. En outre, Pro Tools définit attribue 
automatiquement le statut d'inactif aux 
chemins lorsque l'I/O n'est pas disponible. 

Affectation des chemins d'une piste : l'état 
inactif peut être attribué à l'affectation des 
chemins d'entrée, de sortie et de bus d'une piste 
à l'aide du sélecteur approprié. Les playlists des 
pistes restent ainsi intactes, mais la piste choisie 
est déconnectée du chemin de sortie ou de bus. 
Vous pouvez ainsi supprimer une piste d'un 
chemin de signal.

Affectation de chemins à l'échelle de la session : 
vous pouvez activer ou désactiver globalement 
les chemins dans la boîte de dialogue I/O Setup. 
Vous pouvez ainsi désactiver un chemin de 
signal sur toutes les pistes qui lui sont 
actuellement affectées. Pro Tools désactive 
également les chemins non disponibles. 
Les chemins peuvent être non disponibles 
lorsque des dispositifs ou d'autres ressources du 
système ne sont pas disponibles, par exemple 
lors de l'ouverture d'une session enregistrée sur 
un autre système. 

Affectations des chemins d'une piste

(fenêtres Mix et Edit)

Pour activer ou désactiver l'affectation du chemin 
d'une piste :

■ Dans la fenêtre Mix ou Edit, maintenez 
enfoncées les touches Ctrl + Démarrer 
(Windows) ou Pomme + Contrôle (Macintosh) 
pendant que vous cliquez sur le sélecteur 
d'entrée, de sortie, d'insert ou de départ de la 
piste. 

Les affectations de chemins de pistes inactives 
apparaissent en italique et sans surbrillance.

Inactivation ou activation de toutes les pistes 
ou de toutes les pistes sélectionnées

Les touches de modification Alt (Windows) ou 
Option (Macintosh) font basculer le chemin sur 
toutes les pistes. Les touches de modification 
Alt + Maj (Windows) ou Option + Maj 
(Macintosh) font basculer le chemin sur toutes 
les pistes sélectionnées. Cependant, Pro Tools 
n'appliquera la modification qu'à des 
affectations de chemins identiques, s'il en 
existe, dans la ou les pistes en cours. La bascule 
de plusieurs pistes n'affecte que celles qui 
possèdent la même affectation de chemin que 
celle que vous basculez de façon explicite. 
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Bascule de plusieurs chemins

Si une piste ne possède qu'une affectation de 
sortie principale, vous pouvez maintenir 
enfoncées les touches Ctrl + Démarrer 
(Windows) ou Pomme + Contrôle (Macintosh) 
tout en cliquant sur son sélecteur de chemin de 
sortie pour désactiver la sortie principale. En cas 
d'affectations multiples, le sélecteur de piste 
s'affiche afin de vous permettre de spécifier le 
chemin d'entrée, de sortie, d'insert, ou de bus. 

Si un signal de départ (A - J) possède plusieurs 
affectations de sortie et si l'une d'entre elles a été 
basculée, toutes les affectations de sortie de ce 
signal de départ (A - J) seront basculées.

Chemins inactifs à l'échelle de la 
session

(boîte de dialogue I/O Setup)

Vous pouvez configurer globalement les 
chemins sur actif ou inactif dans la boîte de 
dialogue I/O Setup. 

Affichage du statut actif ou inactif

Non en surbrillance (italique) : indique que le 
chemin est inactif.

En surbrillance (sans italique) : indique que le 
chemin est actif.

En surbrillance (italique) : indique que le 
chemin est actif, mais qu'il n'y a pas 
suffisamment de ressources système 
disponibles. 

Pour activer ou désactiver globalement un 
chemin :

1  Sélectionnez Setup > I/O.

2  Sélectionnez un type de chemin avec les 
onglets situés en haut de la fenêtre. 

3  Définissez le chemin comme actif ou inactif. 

Les chemins inactifs apparaissent en italique 
dans les sélecteurs de chemin de la piste.

Chemins actifs et inactifs dans la fenêtre I/O Setup

Inactif

Actif

Toute affectation du chemin peut 
également être désactivée piste par piste. 
Pour plus d'informations, reportez-vous à la 
section Affectations des chemins d'une 
piste, page 100.

Chemins actifs et inactifs dans un sélecteur de chemin 
de sortie de piste
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Configuration matérielle et 
transfert de session

Les sessions Pro Tools mémorisent le type et 
l'ordre des interfaces audio connectées et actives 
lors du dernier enregistrement de la session. 

E/S non disponibles

Lors de l'ouverture d'une session, Pro Tools 
vérifie si la configuration matérielle a changé 
depuis le dernier enregistrement de la session. 
Si la configuration matérielle est différente de 
celle de la dernière session enregistrée, les 
chemins associés aux I/O non disponibles sont 
rendus inactifs. 

Réaffectation

La réaffectation se produit lorsque la 
configuration d'origine d'une session ne 
correspond pas à celle du système courant et les 
chemins de la session sont réaffectés en fonction 
du matériel actuel. 

Les systèmes présentant des fonctions 
équivalentes en I/O sont réaffectés directement. 
Supposons, par exemple, qu'une session a été 
enregistrée sur un système Pro Tools|HD par 
l'intermédiaire de deux interfaces audio 
192 I/O : elle inclut 32 chemins d'entrée répartis 
sur les deux interfaces à 16 canaux. Cette session 
est chargée sur un système Pro Tools différent 
possédant une interface audio 96 I/O (16 
canaux d'E/S) et une interface 1622 I/O(16 
entrées analogiques) connecté à son port 
Legacy. Lors de l'ouverture initiale de la session 
dans le second système, Pro Tools affecte les 
32 chemins d'entrée vers les entrées des deux 
interfaces. 

Lorsque le matériel n'est pas disponible à 
l'ouverture d'une session, les affectations 
peuvent être soit remplacées avec l'option de 
réaffectation, soit ouvertes comme inactives. 
Toute piste restant affectée à un chemin non 
disponible ne sera pas audible. Ceci peut 
toutefois être utile lorsque vous souhaitez 
réaffecter une par une des pistes dans le mixage 
de votre système.

Affichage de la configuration d'origine et de la 
configuration en cours

Lorsqu'une session ouverte contient des 
définitions de chemins pour des interfaces d'E/S 
non disponibles, la boîte de dialogue I/O Setup 
affiche la liste de ces chemins en italique. 

Le bouton Show Original Setup affiche les 
interfaces audio utilisées dans la session 
d'origine. Cet affichage temporaire vous permet 
de consulter la configuration des I/O d'origine 
tandis que vous configurez la session de votre 
système. 

Lorsqu'une session a été ouverte en conservant 
des E/S non disponibles, vous pouvez réaffecter 
les pistes vers des chemins d'E/S disponibles. 

Pour plus d'informations, reportez-vous à la 
section Chemins actifs et inactifs, 
page 100.

Pour redéfinir les chemins, consultez 
Création et modification de chemins, 
page 94. 
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Fichiers des paramètres 
d'E/S
Vous aurez à gérer les paramètres d'E/S lors du 
transfert de sessions et lorsque vous développez 
des configurations d'E/S dans le cadre de 
sessions et de projets multiples. 

Paramètres par défaut, fichiers 
des paramètres et derniers 
paramètres utilisés pour les 
nouvelles sessions

Lorsque vous créez de nouvelles sessions, vous 
pouvez définir la configuration des E/S de la 
session en utilisant les options suivantes : 

Default I/O Setups : le programme d'installation 
de Pro Tools offre des présélections pour les 
configurations d'E/S stéréo et Surround (le 
mixage Surround n'est pris en charge que par les 
systèmes Pro Tools|HD). Pour plus 
d'informations, reportez-vous à la section 
Fichiers des paramètres d'E/S d'usine, page 105. 

Custom Presets : vous pouvez stocker et 
rappeler des présélections personnalisées à l'aide 
des fonctions d'exportation et d'importation de 
la boîte de dialogue I/O Setup. 

Last Used : la configuration d'E/S la plus récente 
(ou la dernière utilisée) est enregistrée dans un 
fichier de paramètres Last Used. Pour plus 
d'informations, reportez-vous à la section 
Paramètres d'E/S dernièrement utilisés, 
page 104. 

Paramètres d'E/S par défaut lors de la 
création d'une session

Lorsque vous créez une session, vous pouvez 
choisir les paramètres par défaut de mixage 
stéréo ou de mixage Surround, suivant votre 
système et votre configuration. Pour plus 
d'informations, reportez-vous à la section 
Fichiers des paramètres d'E/S d'usine, page 105. 

Importation et exportation des fichiers 
de paramètres d'E/S

Vous pouvez exporter et importer des 
configurations d'E/S sous forme de fichiers de 
paramètres d'E/S. Vous pouvez ainsi enregistrer 
les paramètres concernant différents projets, les 
importer pour une reconfiguration d'E/S, gérer 
des définitions de chemins et des paramètres de 
routage du signal. 

Exportation de paramètres d'I/O

Pour exporter et enregistrer une configuration 
d'E/S :

1  Cliquez sur Export Settings. 

2  Attribuez un nom au fichier des paramètres, 
puis enregistrez-le.

Pour démarrer des sessions avec une boîte de 
dialogue I/O Setup vierge ou vide, il est 
possible de créer et d'exporter un fichier de 
paramètres d'E/S dans lequel toutes les 
définitions ont été supprimées. 
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Importation des paramètres d'E/S

Vous pouvez importer les paramètres d'E/S avant 
d'ouvrir une session ou alors dans une session 
déjà ouverte (voir Paramètres d'E/S par défaut 
lors de la création d'une session, page 103). 

Lorsque vous importez des paramètres d'E/S 
dans une session existante, vous pouvez 
supprimer toute les définitions de chemins 
inutilisées avant d'importer les nouveaux 
chemins ou laisser les définitions de chemins 
inchangées et ajouter les nouveaux chemins à la 
configuration des paramètres d'E/S actuelle.

Pour importer des paramètres d'E/S :

1  Cliquez sur Import Settings dans la boîte de 
dialogue I/O Setup.

2  Sélectionnez un fichier de paramètres d'E/S 
dans la boîte de dialogue Import Settings et 
cliquez sur Import. 

3  Une boîte de dialogue s'affiche, vous 
demandant si vous souhaitez ou non supprimer 
les chemins existants. Effectuez l'une des 
opérations suivantes :

• Cliquez sur Yes pour supprimer les chemins 
inutilisés et ajouter les chemins importés 
dans la configuration d'E/S actuelle. Cette 
opération efface toutes les affectations 
d'E/S et données d'automation liées aux 
chemins inutilisés. 

• Cliquez sur No pour ajouter les chemins 
importés à votre configuration actuelle 
des I/O. 

Si l'importation produit des chevauchements 
des chemins, les nouveaux chemins 
apparaissent inactifs dans la boîte de dialogue 
I/O Setup Reportez-vous à la section Chemins 
actifs et inactifs, page 100.

Après avoir importé les paramètres d'E/S, vous 
pouvez réassigner les définitions d'affectation de 
chemin dans la boîte de dialogue I/O Setup en 
modifiant l'affectation des chemins, en les 
renommant et en les supprimant. (Reportez-
vous à la section Création et modification de 
chemins, page 94.)

Paramètres d'E/S dernièrement 
utilisés

Si vous effectuez des modifications dans la boîte 
de dialogue I/O Setup au cours d'une session, 
elles seront enregistrées dans le fichier de 
paramètres Last Used lorsque vous refermez la 
boîte de dialogue (en cliquant sur OK). 

Les modifications de configuration des I/O sont 
enregistrées lors de la sauvegarde de la session 
en cours. Les fichiers de présélections utilisateur 
ne contiendront pas les récentes modifications, 
sauf si vous exportez un fichier de paramètres 
mis à jour. 

Les derniers paramètres utilisés sont disponibles 
en tant que choix lors de la création ou de 
l'ouverture des sessions, en plus des 
présélections d'usine décrites ci-dessous.
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Fichiers des paramètres d'E/S d'usine

Pro Tools contient des fichiers de paramètres 
d'E/S d'usine pour le mixage stéréo et Surround. 
Ces fichiers contiennent des définitions 
génériques de chemins principaux et de sous-
chemins pour les deux formats de mixage. 

Fichier de paramètres pour le mixage stéréo

La présélection Stereo Mix (mixage stéréo) est 
constituée de tous les chemins stéréo et mono 
possibles dans votre session. 

La présélection Stereo Mix crée le nombre 
maximal de chemins de chaque type, déterminé 
par la configuration des I/O disponibles du 
système et la configuration matérielle.

Fichiers de paramètres pour le mixage Surround 
(Pro Tools uniquement)

Le fichier Surround Mix offre d'autres 
présélections de sortie et de bus, spécifiques au 
Surround. Pour plus d'informations, reportez-
vous à la section Fichiers de paramètres de 
mixage surround, page 713.

A propos du mode Direct Outputs

Le mode Direct Outputs (sorties directes), qui 
existait dans les versions précédentes de 
Pro Tools, a été remplacé par les sous-chemins 
mono par défaut, disponibles par l'intermédiaire 
de toutes les E/S valides dans la boîte de dialogue 
I/O Setup. 

Le bouton Default crée les chemins de sortie 
principaux avec les sous-chemins mono 
appropriés. Ces sous-chemins permettent 
l'affectation monophonique cas par cas. 

A l'ouverture d'une session enregistrée en mode 
Direct Outputs, Pro Tools affecte toutes les 
sorties vers des sous-chemins mono équivalents 
(en fonction des disponibilités). Consultez la 
section Configuration matérielle et transfert de 
session, page 102 pour plus d'informations sur 
la réaffectation. 

Pour convertir une session afin qu'elle émule le 
mode Direct Outputs, utilisez la fonction Auto 
Assign Ascending Outputs, comme expliqué 
ci-après.

Pour affecter automatiquement des sorties de 
piste en mode Direct Out :

1  Vérifiez que toutes les pistes que vous 
souhaitez assigner sont visibles (les pistes 
masquées n'étant pas assignées).

2  Choisissez les pistes à affecter.

3  Maintenez enfoncées les touches Ctrl + Alt 
(Windows) ou Pomme + Option (Macintosh), 
pendant que vous cliquez sur le sélecteur de 
sortie de la piste la plus à gauche et affectez-la au 
sous-chemin pour Output #1. Toutes les pistes 
visibles seront alors automatiquement affectées, 
une par une, à des sorties de sous-chemin mono, 
par ordre croissant.

Le choix de la présélection « Stereo Mix » 
équivaut à cliquer sur le bouton Default de 
chaque onglet de la boîte de dialogue 
I/O Setup. Pour plus d'informations, 
consultez la section Création et 
modification de chemins, page 94. 
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Options de configuration 
d'E/S
Les systèmes Pro Tools sont dotés de fonctions 
de paramétrage d' E/S supplémentaires. Il s'agit 
du routage des signaux par défaut pour 
l'affichage et l'écoute, et de la disposition des 
pistes par défaut pour les formats de mixage 
multicanaux.

Vumètre de chemin du contrôleur
(D-Control, D-Command et ProControl 
uniquement)

Le sélecteur de vumètre de chemin du 
contrôleur détermine le chemin affiché sur les 
vumètres de sortie des surfaces de contrôle D-
Control, D-Command ou ProControl. Pour plus 
de détails, reportez-vous à la documentation de 
votre surface de contrôle.

Chemins d'écoute

Vous pouvez spécifier le chemin de sortie par 
lequel les fichiers et les régions sont écoutés 
dans la liste des régions ou dans les navigateurs 
DigiBase.

Utilisation du chemin d'écoute par 
défaut

Lorsque vous écoutez un fichier ou une région 
de la liste des régions, Pro Tools assure la sortie 
audio par envoi sur le chemin d'écoute. 
Pro Tools affecte un chemin d'écoute par défaut 
au premier chemin de sortie principal du format 
donné disponible. Vous pouvez également 
sélectionner un chemin d'écoute différent dans 
la boîte de dialogue I/O Setup.

Configuration des chemins d'audition

Vous pouvez spécifier les sorties de contrôle 
souhaitées pour la liste des régions en utilisant le 
menu Audition paths. 

Menu principal Audition Paths : le menu 
principal est constitué de tous les choix de 
formats de chemin disponibles dans le système 
actuel (formats mono et stéréo sur tous les 
systèmes, formats LCR et au-delà sur les 
systèmes Pro Tools|HD). 

Sous-menus Audition Paths : chaque choix de 
format du chemin dispose d'un sous-menu 
dressant la liste des chemins de sortie de ce 
format donné. Le sous-menu mono dresse la 
liste des chemins de sorties de n'importe quel 
format.

Pour configurer un chemin d'écoute :

■ Sélectionnez le chemin désiré dans le menu 
ou les sous-menus Audition Paths.

Pour écouter les régions dans la liste des régions :

■ Maintenez enfoncée la touche Alt (Windows) 
ou Option (Macintosh) pendant que vous 
cliquez sur la région de la liste.

Dans les systèmes Pro Tools|HD dotés de 
plusieurs interfaces audio, vous ne pouvez 
sélectionner que la première comme chemin 
d'écoute.
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Ecoute canal par canal de signaux multicanaux

Dans la liste des régions, les régions 
multicanaux sont écoutées via le chemin 
d'écoute en cours. Les signaux peuvent être 
écoutés tels quels (« in-place ») ou via toutes les 
sorties, comme décrit ci-dessous. 

Ecoute « sur place »

Lorsque vous écoutez un canal mono d'une 
région multicanal, vous l'écoutez par défaut sur 
place. Cela signifie qu'il sera lu depuis le canal de 
haut-parleur correspondant de sa région parente 
multicanal. 

Pour écouter « sur place » :

1  Dans la liste des régions, vérifiez que la région 
stéréo ou multicanal se trouve en vue 
développée (elle affiche .L, .R et les autres 
canaux la composant). 

2  Maintenez enfoncée la touche Option 
(Macintosh) ou Alt (Windows) pendant que 
vous cliquez sur la région du canal que vous 
souhaitez écouter. 

Ecoute sur toutes les sorties

Les régions mono peuvent aussi être envoyées à 
niveau égal vers toutes les sorties du chemin 
d'écoute de la région parente. 

Pour écouter sur tous les canaux du chemin 
d'écoute principal :

■ Maintenez enfoncée la touche Alt (Windows) 
ou Option (Macintosh) pendant que vous 
cliquez sur le signal dans la liste des régions. 

Chemin de sortie par défaut de la 
nouvelle piste

Vous pouvez définir l'affectation de chemin de 
sortie par défaut pour les nouvelles pistes, dans 
chaque format disponible. 

Pour spécifier une sortie par défaut pour les 
nouvelles pistes dans la boîte de dialogue I/O 
Setup :

■ Cliquez sur le sélecteur de sortie par défaut de 
la nouvelle piste et sélectionnez un format et 
une sortie.

Chemin AFL/PFL
(Pro Tools HD uniquement)

Les pistes mises en solo en mode Solo AFL (After 
Fader Listen) ou PFL (Pre Fader Listen) sont 
acheminées vers le chemin AFL/PFL actuel, tel 
qu'il est défini par le sélecteur de chemin 
AFL/PFL.

Pour sélectionner la sortie AFL/PFL :

1  Choisissez Setup > I/O.

2  Cliquez sur l'onglet Output afin d'afficher la 
page Output.

Le paramètre New Track Default Output 
peut être défini aussi bien pour des chemins 
de bus que pour des chemins de sortie.

Pour plus d'informations sur l'utilisation 
des modes Solo AFL ou PFL, reportez-vous à 
la section Modes Solo, page 134.

Si le sélecteur de chemin AFL/PFL n'est pas 
visible, assurez-vous d'avoir installé le 
plug-in Surround Mixer.
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3  Sélectionnez un chemin à l'aide du sélecteur 
de chemin AFL/PFL.

4  Cliquez sur OK pour fermer la boîte de 
dialogue I/O Setup.

Définition des niveaux de chemin AFL ou PFL

Vous pouvez définir un niveau de chemin 
maître AFL/PFL indépendant pour tous les solos 
AFL et tous les solos PFL.

Pour configurer le niveau de chemin AFL/PFL pour 
tous les solos AFL ou PFL :

1  Choisissez Options > Solo Mode et 
sélectionnez un mode Solo en procédant de la 
façon suivante :

• Pour définir le niveau pour l'ensemble des 
solos AFL, sélectionnez AFL.

– ou –

• Pour définir le niveau pour les solos PFL, 
sélectionnez PFL.

2  Dans la fenêtre Mix ou Edit, maintenez 
enfoncée la touche Ctrl (Windows) ou Pomme 
(Macintosh) tout en cliquant sur un bouton Solo 
d'une piste.

3  Réglez le fader du chemin AFL/PFL.

4  Cliquez sur la nouvelle position du fader (ou 
appuyez sur Echap) pour fermer l'écran du fader.

Sélecteur de coupure AFL/PFL (chemin 
de sortie)

(Systèmes sans surface de contrôle D-Control 
ou D-Command)

Si vous n'utilisez pas une surface de contrôle D-
Control ou D-Command, votre chemin de sortie 
Pro Tools normal peut être coupé lorsque vous 
envoyez un signal vers le chemin AFL/PFL. Pour 
ce faire, vous utiliserez le sélecteur de coupure 
AFL/PFL (chemin de sortie).

Pour désigner le chemin de sortie qui est coupé 
lors de l'écoute en solo des pistes en mode AFL ou 
PFL :

1  Choisissez Setup > I/O.

2  Cliquez sur l'onglet Output afin d'afficher la 
page Output.

3  Sélectionnez un chemin à l'aide du sélecteur 
de coupure AFL/PFL (chemin de sortie).

4  Cliquez sur OK pour fermer la boîte de 
dialogue I/O Setup.

Ordre des chemins par défaut
(Pro Tools HD uniquement)

Le sélecteur d'ordre des chemins par défaut 
permet de sélectionner la disposition de pistes 
par défaut qui sera suivie par Pro Tools lorsque 
vous créez et affectez des chemins principaux ou 
des sous-chemins au format 5.1 dans la boîte de 
dialogue I/O Setup. 

Ce paramètre n'affecte ni les définitions de 
chemin existantes, ni l'affichage des niveaux. 
Il ne fait que spécifier l'affectation des canaux 
dans le nouveau format 5.1. 

L'option None a pour effet de désactiver les 
modes Solo AFL et PFL. Dans ce cas, les 
modes AFL et PFL ne sont pas utilisables.

Il n'est pas nécessaire de mettre les pistes en 
solo pour que le niveau de chemin AFL/PFL 
maître soit réglé. 

Pour régler le niveau du chemin AFL/PFL 
sur 0 dB, maintenez enfoncées les touches 
Ctrl+Démarrer (Windows) ou 
Contrôle+Pomme (Macintosh) tout en 
cliquant sur un bouton Solo.

Pour plus d'informations sur la sélection et 
l'utilisation des modes Solo AFL ou PFL, 
reportez-vous à la section Modes Solo, 
page 134.
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Pour choisir un ordre de chemin par défaut :

■ Sélectionnez l'affectation de canal dans le 
menu Default Path Order. 

Pour plus d'informations sur le mixage 
multicanal, consultez le Chapitre 30, 
Configuration de Pro Tools pour le mixage en 
mode Surround (Pro Tools HD uniquement).

Compensation H/W Insert 
Delay
(Pro Tools HD uniquement)

Vous pouvez indiquer la latence du matériel 
externe (comme les périphériques d'effets) à la 
page H/W Insert Delay de la boîte de dialogue 
I/O Setup. Vous pouvez entrer la latence des 
inserts matériels en millisecondes, dans un 
champ correspondant à chaque paire 
d'entrées/de sorties. Les valeurs entrées seront 
utilisées par le moteur de retardement pour 
synchroniser les chemins d'entrées lorsqu'un 
insert matériel est utilisé.

Pour régler le décalage de retard d'un insert :

■ Entrez une valeur en millisecondes dans le 
champ correspondant à l'entrée à laquelle 
l'insert matériel est connecté.

Sélecteur d'ordre des chemins par défaut

Les décalages de retard au niveau des 
inserts n'ont un effet que lorsque l'I/O est 
utilisée pour les inserts matériels.
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Chapitre 8 : Pistes

Ce chapitre aborde les tâches principales de 
gestion des pistes telles que la création et la 
suppression de pistes, l'assignation de voix et de 
canaux de sortie, et le regroupement de pistes. 

Types de pistes
Une session Pro Tools peut contenir différents 
types de pistes. Il s'agit des pistes audio, des 
pistes d'entrée auxiliaire, des pistes de fader 
principal, des pistes MIDI, des pistes 
d'instrument, des pistes Avid et des pistes de 
film QuickTime. 

Pistes audio, pistes d'entrées 
auxiliaires, pistes de fader général

Les pistes audio, d'entrées auxiliaires et de fader 
principal de Pro Tools peuvent être aux formats 
mono, stéréo et multicanal.

Pistes audio

Les pistes audio contiennent des arrangements 
des fichiers audio enregistrés (ou importés).

Pistes d'entrée auxiliaire

Les pistes d'entrée auxiliaire (ou entrées 
auxiliaires) peuvent servir de signaux de départs 
d'effets, accueillir une autre version de mixage, 
de destination de prémixage, d'entrées pour le 
contrôle ou le traitement de l'audio (tel que 
l'audio des sources MIDI), ainsi que pour un 
grand nombre d'autres tâches d'assignation 
audio.

Pistes de fader principal

Les pistes de fader principal (ou faders 
principaux) contrôlent le niveau global des 
pistes audio envoyées vers les sorties principales 
de la session. Vous pouvez avoir, par exemple, 
24 pistes dans une session avec les canaux 
ProTools 1 à 8 assignés à Analog Output 1–2, les 
canaux 9 à 16 assignés à Analog Output 3–4 et 
les canaux 17 à 24 assignés à Analog Output 5–6. 
Vous pouvez ensuite créer trois faders 
principaux afin de contrôler chaque paire de 
canaux.

Les pistes de fader principal permettent de 
réaliser encore davantage d'opérations (telles 
que le contrôle des niveaux de prémixage). Pour 
plus d'informations, reportez-vous à la section 
Pistes de fader principal, page 574.

Les fonctions des pistes de film QuickTime 
sont décrites au Chapitre 35, Utilisation 
de séquences QuickTime.
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Pistes MIDI

Les pistes MIDI stockent les données des notes, 
des instruments et des contrôleurs MIDI. Vous 
ne pouvez pas sélectionner le format de piste 
lorsque vous créez une piste MIDI, car elle ne 
gère pas de données audio.

Pistes d'instrument

Les pistes d'instrument sont un type particulier 
de piste qui associe les fonctionnalités MIDI et 
audio dans une seule voie de console. Les pistes 
d'instrument simplifient l'utilisation des 
instruments logiciels et matériels pour 
enregistrer des données MIDI et écouter les 
sources audio.

Format des pistes

Pistes mono

Une piste audio mono, d'entrée auxiliaire, de 
fader principal ou d'instrument contrôle le 
volume et, dans certains cas le panoramique 
d'un canal audio unique. Une piste mono utilise 
une seule voix.

Pistes stéréo

Une piste audio mono, d'entrée auxiliaire, de 
fader principal ou d'instrument correspond à 
une voie de console unique, mais lit deux 
canaux audio sous forme d'une paire stéréo. 
Les pistes stéréo utilisent deux voix. 

Pistes multicanaux (Pro Tools HD uniquement)

Une piste multicanal correspond à une voie de 
console unique, lisant plusieurs canaux audio 
(3 à 8 canaux simultanément). Ceci permet à 
Pro Tools de prendre en charge les formats de 
mixage multicanaux, tels que LCRS, 5.1, 6.1, etc. 
Les pistes audio, d'entrée auxiliaire, de fader 
principal ou d'instrument sont compatibles avec 
tout format multicanal pris en charge.

Pour plus d'informations concernant le mixage 
Surround avec Pro Tools, reportez-vous aux 
chapitres suivants :

• Chapitre 30, Configuration de Pro Tools pour 
le mixage en mode Surround (Pro Tools HD 
uniquement)

• Chapitre 31, Pistes multicanaux et 
assignation des signaux (Pro Tools HD 
uniquement)

• Chapitre 32, Panoramique et mixage en mode 
Surround (Pro Tools HD uniquement)

Voies de piste

Voies de piste audio

Chaque piste audio possède ses propres 
commandes de volume, de fenêtre de sortie, 
d'activation en enregistrement, de mode 
d'automation, de Solo/Mute, de commentaires 
et d'affectation de voix. Les pistes audio 
possèdent également une vue Comments dans 
laquelle s'affichent les commentaires saisies.
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Voies de piste d'entrée auxiliaire

Chaque piste d'entrée auxiliaire possède son 
propre jeu de commandes pour le volume, le 
panoramique, la fenêtre de sortie, le mode 
d'automation, la mise en solo et la coupure de 
son. Les pistes d'entrée auxiliaire possèdent 
également une vue Comments dans laquelle 
s'affichent les commentaires saisis.

Voies de pistes de fader principal

Chaque piste de fader principal possède son jeu 
personnel de commandes pour le volume, la 
fenêtre de sortie et le mode d'automation. 
Les pistes de fader principal possèdent 
également une vue Comments dans laquelle 
s'affichent les commentaires saisis.

Voies de piste audio de format mono

Inserts

Départs

Sélecteur de chemin d'entrée/de 
sortie audio

Boutons Solo et Mute

Sélecteur de mode d'automation

Nom de la piste

Curseur de panoramique

Vumètre de niveau

Fader de volume

Identification du groupe

Bouton de la fenêtre Output

Commentaires sur la piste

Indicateur du type de piste

Sélecteur de voix

Bouton d'enregistrement de piste

Indicateur de volume/crête/retard

Indicateur de panoramique

Affichage de la compensation de retard

Numérotation de la position des pistes

Bouton d'écoute TrackInput

Codage couleur de la piste

Voie de piste d'entrée auxiliaire stéréo

Inserts

Départs

Sélecteur de chemin 
d'entrée/de sortie audio

Boutons Solo et Mute

Sélecteur de mode d'automation

Nom de la piste

Curseurs de panoramique

Vumètres de niveau

Fader de volume

Identification du groupe

Commentaires sur la piste

Indicateur du type de piste

Indicateur de volume/crête/retard

Indicateurs de panoramique

Affichage de la compensation de retard

Numérotation de la position des pistes

Codage couleur de la piste

Bouton de la fenêtre Output
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Voie de piste MIDI

Chaque piste MIDI dispose de ses propres 
réglages de volume, de panoramique, 
d'activation en enregistrement, de mode 
d'automation, de solo/mute, d'affectation de 
patch MIDI, et d'affectation de canal MIDI. 
Les pistes audio possèdent également une vue 
Comments dans laquelle s'affichent les 
commentaires saisis.

Voies de piste d'instrument

Chaque piste d'instrument possède son propre 
jeu de commandes pour le volume, le 
panoramique, la fenêtre de sortie, le mode 
d'automation, la mise en solo, la coupure de 
son. Les pistes d'instrument dispose d'une vue 
supplémentaire, la vue Instruments, qui 
contient les commandes MIDI d'entrée et de 
sortie, de coupure de son, de volume et de 
panoramique. Les pistes d'instrument possèdent 
également une vue Comments dans laquelle 
s'affichent les commentaires saisis. 

Voie de piste de fader principal

Inserts

Sélecteurs de chemin de sortie audio

Sélecteur de mode d'automation

Nom de la piste

Vumètres de niveau

Fader de volume

Identification du groupe

Commentaires sur la piste

Indicateur du type de piste

Indicateur de volume/crête/retard

Affichage de la compensation de retard

Numérotation de la position des pistes

Codage couleur de la piste

Bouton de la fenêtre Output

Voie MIDI

Sélecteur d'entrée MIDI

Fader de volume MIDI

Curseur de panoramique MIDI

Bouton du nom de piste

Vumètre de vitesse MIDI

Sélecteur de mode d'automation

Sélecteur de sortie MIDI

Touche d'enregistrement

Sélection de patch

Indicateur de panoramique MIDI

Indicateur de volume MIDI

Indicateur du type de piste

Identification du groupe

Commentaires sur la piste

Boutons Solo et Mute

Numérotation de la position des pistes

Codage couleur de la piste

Numérotation de la position des pistes
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Commandes et indicateurs 
des pistes

Sélecteurs d'entrée/sortie

La vue I/O affiche les sélecteurs d'entrée et de 
sortie sur les pistes audio, d'entrée auxiliaire, de 
fader principal (sortie seulement), MIDI et 
d'instrument.

Pour afficher la vue I/O dans la fenêtre Edit :

■ Choisissez View > Edit Window > I/O.

Pour plus d'informations sur les sélecteurs 
d'entrées et de sorties, consultez la section 
Assignation d'entrées et de sorties à des pistes, 
page 126.

Voie de la piste d'instrument stéréo

Inserts

Départs

Sélecteur de chemin 
d'entrée/de sortie audio

Boutons Solo et Mute

Sélecteur de mode d'automation

Nom de la piste

Curseurs de panoramique

Vumètres de niveau

Fader de volume

Identification du groupe

Bouton de la fenêtre Output

Commentaires sur la piste

Indicateur du type de piste

Indicateur de volume/crête/retard

Indicateurs de panoramique

Affichage de la compensation de retard

Numérotation de la position des pistes

Touched'enregistrement

Sélection de patch

Sélecteur d'entrée MIDI

Sélecteur de sortie MIDI

Vumètre de vitesse MIDI

Volume MIDI

Curseur de panoramique MIDI

Bouton de coupure de son MIDI

Codage couleur de la piste

Fenêtre Edit – affichage I/O (piste audio)

Pour plus d'informations sur les autres vues 
de pistes, consultez la section Vues dans 
les fenêtres Mix et Edit, page 578.

Les voies de la fenêtre Mix affichent 
toujours les sélecteurs d'entrée et de sortie, 
ainsi que les valeurs de volumes et de 
panoramiques ; la fenêtre Mix ne contient 
par conséquent pas d'option d'affichage de 
la vue I/O.

Sélecteur de chemin 
d'entrée

Sélecteur de chemin 
de sortie

Indicateur de volume

Indicateur de 
panoramique

Bouton de la fenêtre 
Output
Chapitre 8 : Pistes 115



116
Indicateur de 
volume/crête/retard du canal

L'indicateur de volume d'une piste audio 
possède trois modes : volume, crête et retard du 
canal.

Pour changer le mode d'affichage de l'indicateur 
de volume :

■ Pour basculer d'un mode à l'autre, maintenez 
la touche Pomme (Macintosh) ou Ctrl 
(Windows) enfoncée pendant que vous cliquez 
sur ce bouton.

Indicateur de volume (et glissière déroulante) : 
affiche le niveau du volume actuel ou d'entrée 
d'une piste, défini par le fader de volume de la 
piste. Dans la vue I/O (fenêtre Edit), cliquez sur 
l'indicateur de volume pour afficher la glissière 
déroulante correspondante qui permet de régler 
le volume.

Indicateur de crête : fonctionne comme 
indicateur de la marge de sécurité, référencé au 
dernier niveau crête rencontré en cours de 
lecture. Pour réinitialiser le compteur de crête, 
cliquez n'importe où sur l'afficheur. Les valeurs 
sont comprises entre –∞ (aucun signal) et 0 dB. 

Indicateur de retard du canal : affiche le retard 
total, en échantillons, subi sur la piste, dû à 
l'utilisation de plug-in TDM sur ce canal. 

Indicateur de panoramique

L'indicateur de panoramique affiche le 
paramètre actuel de panoramique d'une piste. 
Les valeurs de panoramique s'étendent de <100 
(à l'extrême gauche) à 100> (à l'extrême droite). 
Les contrôles de panoramique ne sont 
disponibles que pour les pistes stéréo ou les 
pistes mono assignées à une sortie stéréo.

Dans la vue I/O (fenêtre Edit), cliquez sur 
l'indicateur de panoramique pour afficher la 
glissière déroulante correspondante qui permet 
de régler le panoramique.

Curseur de panoramique

Le curseur de panoramique contrôle la balance 
d'une piste sur la paire de sortie qui lui est 
affectée. Il n'apparaît que si vous utilisez des 
pistes stéréo ou des pistes mono envoyées vers 
une sortie stéréo.

Le curseur de panoramique d'une piste MIDI ne 
fonctionne que si vous contrôlez un générateur 
de sons qui prend en charge le panoramique 
MIDI.

Fader de volume

Le fader de volume de la piste contrôle le 
volume d'une piste lorsqu'elle est en lecture, et 
son niveau d'enregistrement lorsqu'elle est en 
enregistrement. Vous pouvez relier les niveaux 
de retour et de lecture en activant la préférence 
de fonctionnement « Link Record and Play 
Faders ».

Le gain de fader maximum pour un fader de 
volume est de +12 dB.

Fader de volume MIDI

Si votre générateur de sons MIDI prend en 
charge le volume, le fader de volume sur une 
piste MIDI ou une piste d'instrument peut 
transmettre une valeur comprise entre 0 et 127 
au contrôleur de volume MIDI.
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Vumètre de piste

Sur les pistes audio, les afficheurs de niveau 
(vumètres) indiquent le niveau du signal en 
cours d'enregistrement ou de lecture sur le 
disque dur. Sur les pistes d'entrée auxiliaire, de 
fader principal et d'instrument, les afficheurs de 
niveau (vumètres) indiquent le niveau du signal 
en cours de lecture sur la sortie du canal. Le vert 
indique les niveaux nominaux ; le jaune 
indique le pré-écrêtage (–6  dB en dessous du 
signal pleine échelle) ; le rouge indique le signal 
pleine échelle/écrêtage. Lorsqu'une piste audio 
est préparée en enregistrement, son vumètre 
indique les niveaux d'enregistrement.

Sur les pistes MIDI, le vumètre indique la 
vélocité MIDI de l'événement MIDI le plus 
récent.

Visualisation des niveaux pré ou post-fader

Vous pouvez définir globalement les vumètres 
des pistes audio pour qu'ils indiquent les 
niveaux pré- ou post-fader. Lorsque Pre-Fader 
Metering est sélectionné, les afficheurs de 
niveau indiquent les niveaux avant fader, 
autrement dit indépendamment de la position 
du fader. Avec l'option Post-Fader Metering, les 
niveaux des vumètres suivent les évolutions du 
fader.

Pour basculer entre les modes pré et post-fader 
des vumètres :

■ Choisissez Options > Pre-Fader Metering.

Gel de crêtes

Les vumètres de Pro Tools disposent d'une 
fonction de gel de crêtes, dotée de trois options : 
3 Second, Infinite ou None.

Pour choisir un réglage de gel de crête :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Display.

2  Sélectionnez une option de Peak Hold.

3  Cliquez sur Done (Terminé).

Pour réinitialiser un vumètre :

■ Cliquez n'importe où sur le vumètre. 

Pour réinitialiser tous les vumètres, effectuez 
l'une des opérations suivantes :

■ Maintenez la touche Option (Macintosh) ou 
Alt (Windows) enfoncée pendant que vous 
cliquez sur un vumètre.

■ Choisissez Track > Clear All Clip Indicators.

■ Appuyez sur Option + C (Macintosh) ou sur 
Alt + C (Windows).

Indication d'écrêtage

Les vumètres de Pro Tools disposent d'une 
indication d'écrêtage dotée de trois options. 
3 Second, Infinite ou None. Si un écrêtage 
survient, la LED supérieure du vumètre reste 
allumée (en rouge).

Pour choisir un paramètre d'indication 
d'écrêtage :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Display.

2  Choisissez une option d'indication d'écrêtage.

3  Cliquez sur Done (Terminé).

Pour supprimer un indicateur d'écrêtage :

■ Cliquez n'importe où sur le vumètre. 

Des indicateurs d'écrêtage apparaissent 
dans les fenêtres de plug-in, de départ et de 
piste.
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Pour supprimer toutes les indicateurs d'écrêtage, 
effectuez l'une des opérations suivantes :

■ Maintenez la touche Option (Macintosh) ou 
Alt (Windows) enfoncée pendant que vous 
cliquez sur un vumètre.

■ Choisissez Track > Clear All Clip Indicators.

■ Appuyez sur Option + C (Macintosh) ou sur 
Alt + C (Windows).

Vue large des vumètres

L'option Wide Meters View permet de 
sélectionner un affichage plus large des 
vumètres de pistes dans les fenêtres Mix et Edit, 
les niveaux indiqués par les vumètres étant ainsi 
plus facilement décelables. La vue large des 
vumètres prend également en charge la vue 
« étroite » de la fenêtre Mix.

Pour activer la vue large des vumètres :

■ Maintenez enfoncées les touches 
Pomme+Option+Control (Macintosh) ou 
Ctrl+Démarrer+Alt (Windows) pendant que 
vous cliquez sur les vumètres de la piste dans la 
fenêtre Edit ou Mix.

Pour désactiver la vue large des vumètres :

■ Maintenez enfoncées les touches 
Pomme+Option+Control (Macintosh) ou 
Ctrl+Démarrer+Alt (Windows) pendant que 
vous cliquez de nouveau sur les vumètres de la 
piste dans la fenêtre Edit ou Mix.

Réglage de la largeur des 
pistes
Fenêtre Mix

La commande Narrow Mix permet de voir 
toutes les pistes ou les canaux de la fenêtre Mix 
en largeur réduite afin de conserver de l'espace à 
l'écran dans une session de grande taille. 
Consultez la section Hauteur de la piste, 
page 275, pour régler la hauteur des pistes dans 
la fenêtre Edit.

Pour réduire la largeur des pistes dans la 
fenêtre Mix :

■ Choisissez View > Narrow Mix.

Pour afficher les pistes à leur largeur normale :

■ Désélectionnez View > Narrow Mix.

Vue large des vumètres dans les fenêtres Mix et Edit

Vous pouvez changer la largeur des pistes en 
appuyant sur la touche Ctrl + Alt + M 
(Windows) ou Pomme + Option + M 
(Macintosh).
Guide de référence Pro Tools



Création de pistes
Sur tous les systèmes, vous pouvez créer des 
pistes mono et stéréo. De plus, dans Pro Tools 
HD, vous pouvez créez des pistes multi-canaux.

Lorsque de nouvelles pistes sont créées, elles 
reçoivent un nom par défaut qui peut 
cependant être modifié à tout moment.

◆ Pour insérer de nouvelles pistes à côté d'une 
piste donnée dans une session, sélectionnez 
cette piste en cliquant sur son nom dans la 
fenêtre Mix ou Edit avant d'ouvrir la boîte de 
dialogue New Tracks. Les nouvelles pistes 
viennent s'ajouter immédiatement après la piste 
sélectionnée. 

◆ Pour insérer de nouvelles pistes après la 
dernière piste d'une session, assurez-vous 
qu'aucun nom de piste n'est sélectionné à 
l'écran avant d'ouvrir la boîte de dialogue New 
Tracks

Pour créer des pistes :

1  Choisissez Track > New.

2  Dans le menu déroulant Track Type, 
sélectionnez le type de piste que vous souhaitez 
ajouter. 

3  Sélectionnez le format de piste (mono ou 
stéréo ou l'un des formats Surround 
multicanaux) dans le menu déroulant Track 
Format. Les formats Surround ne sont 
disponibles que pour les systèmes Pro Tools|HD.

4  Sélectionnez la règle temporelle (échantillons 
ou tics) dans le menu déroulant Track Timebase.

5  Entrez le nombre de nouvelles pistes.

6  Si vous le souhaitez, procédez de la manière 
suivante :

• Si vous voulez ajouter plusieurs pistes, 
cliquez sur le bouton Add Row.

– ou –

• Pour supprimer la piste précédente, il suffit 
de cliquer sur le bouton Remove Row.

Boîte de dialogue New Tracks

Pour faire défiler automatiquement le menu 
déroulant Track Type de la boîte de 
dialogue New Tracks, appuyez sur Pomme 
(Macintosh) ou sur Ctrl (Windows), puis 
utilisez les touches fléchées Haut et Bas.

Nombre de nouvelles 
pistes

Format des 
pistes

Type de piste

Règle temporelle 
de la piste

Ajouter/supprimer 
une ligne

Pour faire défiler automatiquement le menu 
déroulant Track Format, appuyez sur la 
touche Pomme (Macintosh) ou Ctrl 
(Windows) et utilisez les touches fléchées 
Gauche/Droite.

Pour faire défiler automatiquement le menu 
déroulant Track Timebase, appuyez sur les 
touches Pomme-Option (Macintosh) ou 
Ctrl-Alt (Windows) et utilisez les touches 
fléchées Gauche/Droite.

Pour ajouter ou supprimer une nouvelle 
piste, appuyez sur Pomme-Maj (Macintosh) 
ou Ctrl-Maj (Windows), puis utilisez les 
touches fléchées Haut et Bas.
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7  Pour réorganiser les pistes, cliquez sur l'icône 
Move Row et faites la glisser vers le haut ou vers 
le bas.

8  Cliquez sur Create.

Attribution de noms aux pistes

Les noms des pistes servent aussi à nommer 
automatiquement des fichiers audio et des 
régions (voir Nom des pistes par défaut, 
page 194).

Pour renommer une piste :

1  Dans les fenêtres Mix ou Edit, cliquez deux 
fois sur le bouton Track Name de la piste que 
vous voulez renommer.

2  Dans la boîte de dialogue Track 
Name/Comments, tapez un nouveau nom.

3  Cliquez sur Previous ou sur Next pour 
renommer d'autres pistes affichées.

4  Cliquez sur OK.

Ajout de commentaires à des pistes

Pour saisir des commentaires sur une piste :

■ Depuis la voie de piste, cliquez directement 
sur la zone Comments, entrez le commentaire et 
appuyez sur Entrée (Windows) ou Retour 
(Macintosh). 

– ou –

■ Dans les fenêtres Edit ou Mix, cliquez deux 
fois sur le bouton Track Name de la piste 
souhaitée. Cliquez ensuite directement dans la 
zone Comments, entrez le commentaire pour la 
piste et appuyez sur Entrée (Windows) ou Retour 
(Macintosh). 

Numérotation des pistes

Avec l'option Track Number View activée, 
chaque piste reçoit un numéro correspondant à 
sa position dans les fenêtres Mix et Edit. Lorsque 
l'ordre des pistes change, celles-ci sont 
renumérotées pour que le nouvel ordre puisse 
être conservé.

Pour utiliser l'option Track Number View :

■ Choisissez View > Track Number.

Boîte de dialogue New Tracks

Boîte de dialogue Track Name/Comments

Icône Move Row

Pour passer à la piste précédente ou 
suivante dans la boîte de dialogue du nom 
de la piste/commentaires, appuyez sur la 
touche Pomme (Macintosh) ou Ctrl 
(Windows) et utilisez les touches fléchées 
Haut et Bas ou Gauche et Droite.

Pour entrer un retour chariot dans la zone 
Comments, appuyez sur les touches 
Maj + Retour (Macintosh) ou Maj + Entrée 
(Windows) du clavier AZERTY.
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Pour accéder directement à la piste de votre 
choix :

1  Choisissez Track > Scroll to Track.

– ou –

Appuyez sur Pomme + Option + G (Macintosh) 
ou sur Ctrl + Alt + G (Windows).

2  Dans la boîte de dialogue Scroll To Track, 
entrez le numéro de position de la piste

3  Cliquez sur OK.

La piste est sélectionnée et les fenêtres défilent 
comme suit :

• Les pistes de la fenêtre Mix défilent pour 
afficher la piste sélectionnée le plus 
possible à gauche. 

• Les pistes de la fenêtre Edit défilent pour 
afficher la piste sélectionnée le plus près 
possible du haut. 

Sélection des pistes

Pour réaliser certaines opérations, comme la 
duplication de pistes ou l'ajout de pistes à un 
groupe, il est indispensable de sélectionner des 
pistes. Il est possible de sélectionner une ou 
plusieurs pistes à la fois.

Pour sélectionner une piste :

■ Cliquez sur le nom d'une piste qui n'est pas en 
surbrillance dans la voie de la piste.

Pour sélectionner un ensemble de pistes :

1  Cliquez sur le nom d'une piste qui n'est pas en 
surbrillance dans la voie de la piste.

2  Tout en maintenant la touche Maj enfoncée, 
cliquez sur un bouton Track Name 
supplémentaire.

Toutes les pistes comprises entre la première 
piste et la piste supplémentaire seront 
également sélectionnées.

Pour sélectionner ou désélectionner des pistes 
non consécutives, procédez comme suit :

■ Maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Macintosh) et cliquez sur les 
boutons Track Name qui ne sont pas en 
surbrillance pour les sélectionner.

– ou –

■ Maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Macintosh) et cliquez sur les 
boutons Track Name qui sont en surbrillance 
pour les désélectionner.

Pour sélectionner toutes les pistes :

■ Maintenez la touche Alt (Windows) ou 
Option (Macintosh) enfoncée pendant que vous 
cliquez sur un bouton Track Name qui n'est pas 
en surbrillance.

Pour désélectionner toutes les pistes :

■ Maintenez la touche Alt (Windows) ou 
Option (Macintosh) enfoncée pendant que vous 
cliquez sur un bouton Track Name qui est en 
surbrillance.

Boîte de dialogue Scroll To Track
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Suppression de pistes

Lorsque vous supprimez des pistes, les données 
de vos régions audio ou MIDI restent dans la 
liste des régions, mais la disposition des régions 
de la piste supprimée (autrement dit, la playlist 
de la piste) est perdue. 

Si la piste contient des playlists qui ne sont 
affectées à aucune piste, vous serez invité à les 
supprimer ou à les conserver.

Pour supprimer une piste :

1  Cliquez sur le nom de la piste souhaitée (dans 
sa voie de console de piste) pour la sélectionner. 

2  Sélectionnez Track > Delete.

3  Cliquez sur OK pour supprimer les pistes 
sélectionnées de la session.

Duplication de pistes

La commande Duplicate Track permet de 
dupliquer une ou plusieurs pistes, y compris 
leurs données audio ou MIDI, les playlists, les 
automations et autres attributs.

Lors de la duplication de plusieurs pistes, vous 
pouvez également décider que les nouvelles 
pistes soient conformes à la dernière piste 
sélectionnée (ou que toute nouvelle piste soit 
conforme à la piste source).

Pour dupliquer une ou plusieurs pistes :

1  Cliquez sur le nom de la piste souhaitée (dans 
sa voie de console de piste) pour la sélectionner. 

2  Choisissez Track > Duplicate. 

– ou –

Appuyez sur les touches Alt+Maj+D (Windows) 
ou Option+Maj+D (Macintosh). 

3  Dans la boîte de dialogue Duplicate Tracks, 
configurez les options suivantes, au besoin :

• Indiquez le nombre de copies que vous 
voulez créer dans le champ Number of 
Duplicates. 

• Pour copier la playlist d'édition 
actuellement active (visible) à partir de la 
piste source, activez Active Playlist. 

La commande Delete Track ne peut être 
annulée.

Pour sélectionner plusieurs pistes, 
maintenez la touche Pomme (Macintosh) 
ou Ctrl (Windows) enfoncée tout en 
cliquant dessus.

Pour sélectionner un ensemble de pistes, 
cliquez sur les noms des pistes en appuyant 
sur Maj.

Pour sélectionner plusieurs pistes, 
maintenez la touche Pomme (Macintosh) 
ou Ctrl (Windows) enfoncée tout en 
cliquant dessus.

Pour sélectionner un ensemble de pistes, 
cliquez sur les noms des pistes en appuyant 
sur Maj.

Boîte de dialogue Duplicate Tracks
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• Pour copier toutes les playlists d'édition de 
la piste source, activez Alternate Playlists.

• Pour copier toutes les données 
d'automation de la piste source, activez 
Automation. 

• Pour copier tous les plug-in et toutes les 
affectations d'insert, activez Inserts. 

• Pour copier tous les départs et toutes les 
affectations de départ, activez Sends.

• Pour conserver les affectations de groupe 
Mix et Edit, activez Group Assignments. 

4  Pour dupliquer plusieurs pistes, procédez 
comme suit :

• Si vous voulez que toutes les pistes 
récemment créées suivent la dernière piste 
source (à l'extrême droite de la fenêtre Mix 
et en bas de la fenêtre Edit), activez l'option 
Insert after Last Selected Track.

– ou –

• Si vous souhaitez que chaque piste 
récemment créée soit insérée directement 
après sa piste source, désactivez l'option.

5  Cliquez sur OK pour dupliquer les pistes 
conformément aux paramètres de la boîte de 
dialogue Duplicate Tracks. Cliquez sur Cancel 
pour fermer la boîte de dialogue et et éviter de 
créer des doubles des pistes. 

Dans la fenêtre Mix, chaque piste dupliquée est 
créée à droite de la piste d'origine. Dans la 
fenêtre Edit, chaque piste dupliquée est créée 
sous la piste d'origine. 

Liste de pistes
La liste des pistes, dans la partie gauche des 
fenêtres Mix et Edit, affiche toutes les pistes de la 
session. Elle permet d'afficher ou de masquer 
une piste en sélectionnant ou désélectionnant 
son nom dans les fenêtres Mix et Edit. Même 
lorsqu'une piste est masquée, les données qu'elle 
contient sont lues dans le cadre de la session. Les 
pistes inactives apparaissent en italiques dans la 
liste des pistes.

Le menu déroulant situé en haut de la liste des 
pistes contient des commandes permettant 
d'afficher ou de masquer toutes les pistes, les 
pistes actuellement sélectionnées à l'écran ou 
des types de pistes particuliers (audio, MIDI, 
d'entrée auxiliaire, de fader principal ou 
d'instrument).

La liste des pistes peut également servir à 
créer de nouvelles pistes lors de 
l'importation de médias à partir de 
DigiBase. Pour plus d'informations, 
reportez-vous au guide DigiBase.

Liste des pistes

Menu déroulant de la liste des pistes

Nom de la 
piste

Icône du 
type de 
piste

Code 
couleur 
de la 
piste

Numéro de la piste
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La commande Sort Tracks By (Tri des pistes par) 
permet de définir l'ordre des pistes en fonction 
de leur nom, type, groupe d'édition, groupe de 
mixage ou voix. L'ordre de tri est répercuté dans 
la liste des pistes de la fenêtre Mix ou Edit.

Lorsqu'une piste appartenant à un groupe actif 
est masquée, elle n'est pas affectée par les 
opérations d'édition effectuées sur les autres 
membres du groupe. Dans la fenêtre Mix en 
revanche, une piste masquée appartenant à un 
groupe actif est quand même concernée par 
toutes les opérations autres que l'activation en 
enregistrement.

Pour masquer une piste :

■ Cliquez sur le nom d'une piste en surbrillance 
dans la liste des pistes.

Pour afficher une piste actuellement masquée :

■ Cliquez sur le nom d'une piste sans 
surbrillance dans la liste des pistes.

Pour afficher toutes les pistes :

■ Cliquez sur le menu déroulant de la liste des 
pistes et choisissez Show All Tracks.

Pour masquer toutes les pistes :

■ Cliquez sur le menu déroulant de la liste des 
pistes et choisissez Hide All Tracks.

Pour afficher un ensemble de pistes :

1  Cliquez sur le nom d'une piste sans 
surbrillance dans la liste des pistes.

2  Tout en maintenant la touche Maj enfoncée, 
cliquez sur un autre nom de piste.

Option Show Only

Option Sort Tracks By

Sur les systèmes Pro Tools HD, même si une 
piste est masquée, sa position relative aux 
autres pistes affecte la priorité de sa lecture 
en tant que piste pouvant héberger des voix 
(voir Emprunt des voix, page 130 pour 
plus de détails).

Pour afficher toutes les pistes, maintenez la 
touche Alt (Windows) ou Option 
(Macintosh) enfoncée pendant que vous 
cliquez sur le nom d'une piste non mis en 
surbrillance.

Pour masquer toutes les pistes, maintenez 
la touche Alt (Windows) ou Option 
(Macintosh) enfoncée pendant que vous 
cliquez sur le nom d'une piste mis en 
surbrillance.

Pour réorganiser les pistes à l'écran, faites 
glisser les noms des pistes vers de nouvelles 
positions dans la liste des piste.
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Tous les noms compris entre le premier nom de 
piste sélectionné et le nom de piste 
supplémentaire sont automatiquement pris en 
compte.

Pour afficher ou masquer un groupe de pistes dans 
la liste des pistes à l'aide du rectangle de 
sélection :

1  Appuyez sur les touches Pomme (Macintosh) 
ou Ctrl (Windows).

2  Déplacez le curseur à gauche du nom d'une 
piste jusqu'à ce que le rectangle de sélection avec 
le symbole + s'affiche.

• Pour afficher les pistes, le rectangle de 
sélection doit se trouver à gauche d'un nom 
d'une piste sans surbrillance.

• Pour masquer les pistes, le rectangle de 
sélection doit se trouver à gauche du nom 
d'une piste mis en surbrillance.

3  Cliquez sur un nom de piste et faites-le glisser 
vers le haut ou vers le bas (pour masquer ou 
afficher la piste et les pistes placées 
imédiatement au-dessus ou au-dessous d'elle).

Pour afficher ou masquer des pistes non 
consécutives, procédez comme suit :

■ Maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Macintosh) et cliquez sur les noms 
de piste (qui ne sont pas en surbrillance) pour les 
sélectionner.

– ou –

■ Maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Macintosh) et cliquez sur les noms 
de piste qui sont en surbrillance pour les 
désélectionner.

A propos des groupes d'édition et de 
mixage et des pistes masquées

Si elles appartiennent à un groupe activé, les 
pistes, même masquées, seront concernées par 
toutes les opérations de la fenêtre Mix effectuées 
sur d'autres membres du groupe (à l'exception 
des opérations d'activation en enregistrement 
audio ou MIDI). Si vous appliquez des 
commandes de solo, de mute, ou d'activation en 
enregistrement de l'automation à une piste 
groupée, tous les membres masqués du groupe 
seront également concernés par ces 
commandes. 

Dans la fenêtre Edit, cependant, les opérations 
d'édition effectuées sur les membres d'un groupe 
activé n'affecteront pas les pistes masquées de ce 
groupe. 

A propos de l'écrêtage et de la liste des 
pistes

(Pro Tools HD uniquement)

En cas d'écrêtage de piste, plug-in ou départ, le 
nom de la piste figure en rouge dans la liste des 
pistes. Les pistes affichées et masquées affichent 
toutes des indications d'écrêtage. 

A propos des numéros de pistes et des 
pistes cachées

Les numéros de position des pistes peuvent être 
affichés de deux façons lorsque les pistes sont 
masquées.

• Les numéros sont assignés uniquement aux 
pistes affichées (lorsque l'option Track 
Position Numbers Stay With Hidden Tracks 
est désactivée dans la page Display 
Preferences). Dans ce cas, les pistes actives 
sont numérotées dans l'ordre croissant. 
Les pistes cachées restent sans numéro.

– ou –

Vous pouvez également sélectionner un 
ensemble de pistes en déplaçant le curseur à 
gauche des noms de pistes (le rectangle de 
sélection apparaît) et en entourant les 
régions que vous voulez sélectionner.
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• Le numéro de position des pistes masquées est 
conservé (lorsque l'option Track Position 
Numbers Stay With Hidden Tracks est activée 
dans la page Display Preferences).

Assignation d'entrées et de 
sorties à des pistes
Les entrées des pistes audio et des pistes d'entrée 
auxiliaire peuvent être assignées à des canaux de 
l'interface audio ou à des bus. Les sorties des 
pistes audio, des pistes d'entrée auxiliaire et du 
fader principal peuvent aussi être assignées à des 
canaux de l'interface audio ou à des bus.

Pour les pistes stéréo et Surround multicanaux, 
les entrées et les sorties apparaissent par paires 
stéréo et en tant que groupes multicanaux. 
Les entrées, sorties et bus disponibles sont 
définis comme des chemins dans la boîte de 
dialogue I/O Setup (voir Chapitre 7, 
Configuration des E/S). 

Assignation automatique des entrées 
et des sorties

Lorsque vous ajoutez des pistes à une nouvelle 
session, les entrées sont automatiquement 
assignées par ordre croissant. Si vous possédez, 
par exemple, une interface audio dotée de huit 
entrées, la création de quatre pistes audio mono 
ajoute automatiquement quatre pistes audio 
avec des entrées assignées aux quatre premiers 

chemins définis dans la boîte de dialogue I/O 
Setup. Lors de la création de pistes stéreo, les 
entrées sont automatiquement assignées aux 
paires d'entrées par ordre croissant.

Les sorties assignées automatiquement aux 
nouvelles pistes sont déterminées par la sortie 
par défaut de la nouvelle piste définie dans la 
boîte de dialogue I/O Setup.

Assignation des entrées vers les 
pistes audio
(pistes audio, entrées auxiliaires et pistes 
d'instrument)

Pour assigner une entrée à une piste audio :

1  Afin d'assigner des entrées de pistes audio 
dans la fenêtre Edit, sélectionnez View > Edit 
Window > I/O.

2  Dans les fenêtres Mix ou Edit, cliquez sur le 
sélecteur de chemin d'entrée de la piste et 
choisissez parmi les canaux de l'interface audio 
et les bus disponibles. Pour les pistes Surround 
stéréo et multicanaux, les entrées apparaissent 
par paires et dans des groupes multicanaux.

Le sélecteur de chemin d'entrée permet 
d'envoyer n'importe quelle entrée audio ou 
n'importe quel bus interne de Pro Tools vers une 
piste audio ou une piste d'entrée auxiliaire. 
Les choix disponibles dans ce menu déroulant 
sont déterminés par la configuration 
d'installation des I/O. Les entrées utilisées par 
une autre piste s'affichent en gras dans le 
sélecteur. 

Assignation des entrées/sorties de trois pistes audio 
mono

Piste envoyée sur 
l'entrée audio 2

Piste envoyée 
sur le bus 2

Piste envoyée sur 
aucune d'entrée

L'entrée des pistes d'instrument est 
automatiquement définie sur tout plug-in 
d'instrument inséré.
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Pour supprimer une assignation d'entrée :

■ Sélectionnez l'option No Input dans le 
sélecteur de chemin d'entrée.

Assignation des sorties des pistes 
audio
(pistes audio, entrées auxiliaires, faders 
principaux et pistes d'instrument)

Pour assigner la sortie d'une piste audio :

1  Afin d'assigner des sorties de pistes audio dans 
la fenêtre Edit, sélectionnez View > Edit 
Window > I/O.

2  Dans les fenêtres Mix ou Edit, cliquez sur le 
sélecteur de chemin de sortie de la piste et 
choisissez parmi les canaux de l'interface audio 
et les bus disponibles. Pour les pistes Surround 
stéréo et multicanaux, les sorties s'affichent par 
paires et dans des chemins multicanaux.

Le sélecteur de chemin de sortie permet 
d'envoyer une piste vers n'importe quelle sortie 
audio ou bus interne configuré(e). Les choix 
disponibles dans ce menu déroulant sont 
déterminés par la configuration d'installation 
des I/O. Les sorties utilisées par une autre piste 
s'affichent en gras dans le sélecteur.

Pour affecter automatiquement toutes les pistes 
visibles, une par une, à des sorties de sous-chemin 
mono, par ordre croissant :

1  Assurez-vous qu'un nombre suffisant de sous-
chemins mono est défini dans la boîte de 
dialogue I/O Setup (voir Chapitre 7, 
Configuration des E/S).

2  Maintenez enfoncées les touches Ctrl + Alt 
(Windows) ou Pomme + Option (Macintosh), 
pendant que vous cliquez sur le sélecteur de 
chemin de sortie de la piste la plus à gauche et 
affectez-la au sous-chemin pour Output #1. 
Toutes les pistes visibles seront alors 
automatiquement affectées, une par une, à des 
sorties de sous-chemin mono, par ordre 
croissant.

Pour supprimer une assignation de sortie :

■ Sélectionnez l'option No Input dans le 
sélecteur de chemin de sortie. Les playlists des 
pistes dépourvues d'assignation de sortie 
s'estompent.

‘

Sélecteur de chemin d'entrée

Sélecteur de chemin de sortie

Lorsque vous assignez une piste audio, une 
entrée auxiliaire, un fader principal ou une 
piste d'instrument sur « No Output », ses 
données d'automation de panoramique 
ainsi que ses contrôles de plug-in sont 
perdus. 
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Priorité des pistes et 
assignation de voix
En fonction de la configuration de votre 
système, les systèmes Pro Tools LE fournissent 
jusqu'à 32 voix pour la lecture et 
l'enregistrement audio. Reportez-vous au 
Tableau 3, page 12 pour obtenir des 
informations sur les fonctionnalités du 
système LE.

Le nombre de voix (canaux simultanés de 
lecture et d'enregistrement audio) des systèmes 
Pro Tools HD varie en fonction de la 
configuration du système. Le système 
Pro Tools|HD 1, par exemple, peut offrir jusqu'à 
96 voix de lecture et d'enregistrement audio, à 
44,1 ou 48 kHz. Reportez-vous au Tableau 1, 
page 9 pour obtenir des informations sur les 
fonctionnalités du système on Pro Tools.

Priorité des pistes

Bien que votre dispositif Pro Tools fixe le 
nombre de voix, le logiciel Pro Tools permet de 
travailler avec plus de pistes audio qu'il n'y a de 
voix. Toutes ces pistes peuvent être enregistrées 
ou importées, arrangées et transférées pour la 
lecture, mais elles ne peuvent pas toutes être 
lues simultanément. 

Lorsque les pistes de la session sont plus 
nombreuses que les voix disponibles, celles 
ayant la plus faible priorité risquent de ne pas 
être entendues. Dans de telles situations, 
Pro Tools affecte des priorités aux pistes qui 
recherchent des voix disponibles. Les pistes 
pouvant être plus nombreuses que les voix 
disponibles, Pro Tools permet de régler la 
priorité de lecture des pistes audio de plusieurs 
façons. Reportez-vous aux sections Changement 
de la priorité de lecture d'une piste, page 128 et 
Libération des voix sur une piste, page 129.

Les systèmes Pro Tools HD permettent 
également d'affecter des voix spécifiques à 
plusieurs pistes pour faire en sorte que ces voix 
soient partagées par plusieurs pistes. Cette 
fonction est désignée sous l'appellation 
d'emprunt des voix. La combinaison des pistes de 
lecture/enregistrement et des pistes de voix 
partagées constitue le nombre total de pistes 
pouvant héberger des voix sur un système 
Pro Tools|HD. 

Pour affecter plusieurs pistes à une même voix, 
reportez-vous à la section Définition de 
l'assignation des voix, page 129. Pour plus 
d'informations sur l'emprunt des voix, reportez-
vous à la section Emprunt des voix, page 130).

Changement de la priorité de lecture 
d'une piste

Les pistes avec des positions plus élevées (à 
gauche dans la fenêtre Mix, en haut de la fenêtre 
Edit) ont toujours priorité sur les pistes 
inférieures d'une session. 

Pour augmenter la priorité d'une piste, vous 
pouvez au choix :

■ Dans la fenêtre Mix, faire glisser le bouton 
Track Name à gauche des autres pistes de la 
session. Les pistes situées à gauche de la fenêtre 
Mix possèdent une priorité plus élevée que 
celles situées à droite.

■ Dans la fenêtre Edit, faire glisser le bouton 
Track Name au-dessus d'autres pistes de la 
session. Les pistes situées en haut de la fenêtre 
Edit ont une priorité plus élevée que celles 
situées au-dessous.

■ Dans la liste des pistes, faire glisser le bouton 
Track Name vers une position plus élevée. 
Les pistes situées en haut de cette liste possèdent 
une priorité plus élevée que celles situées vers 
le bas.
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Libération des voix sur une piste

Vous pouvez également modifier la priorité 
relative d'une piste en libérant sa voix, la 
rendant ainsi disponible pour d'autres pistes au 
sein de la session. 

Pour libérer la voix d'une piste, procédez comme 
suit :

■ Cliquez sur le sélecteur de voix de la piste et 
définissez-le sur Off. Pour plus d'informations, 
reportez-vous à la section Définition de 
l'assignation des voix, page 129.

■ Désactivez la piste en cliquant sur 
Ctrl + Démarrer (Windows) ou Pomme + Ctrl 
(Macintosh) et en cliquant sur l'icône du type de 
piste, dans la fenêtre Mix.

■ Assurez-vous que la piste ne comporte pas 
d'affectation de sortie ou de départ. 

■ Avec Pro Tools HD, vous pouvez libérer 
temporairement la voix d'une piste en la 
coupant au cours de la lecture (voir Option 
Mute Frees Assigned Voice, page 138).

Définition de l'assignation 
des voix

L'assignation de voix d'une piste peut être 
désactivée ou configurée en mode dynamique. 
Pro Tools HD permet en outre d'assigner un 
numéro de voix donné.

Sur tous les systèmes Pro Tools,, vous pouvez 
utiliser l'option d'assignation dynamique des 
voix pour la gestion des voix en tâche de fond, 
en affectant celles qui ne sont pas utilisées par 
d'autres pistes.

Avec Pro Tools HD, les pistes assignées à un 
numéro de voix donné ont la priorité sur les 
pistes en mode d'assignation dynamique de voix 
et prennent en charge l'emprunt de voix (voir 
Emprunt des voix, page 130). Pour garantir 
qu'une piste sera entendue ou qu'elle est 
disponible pour l'enregistrement QuickPunch 
ou TrackPunch (à la volée), assignez-lui un 
numéro de voix spécifique.

Les voix des pistes stéréo et multicanaux 
s'affichent par paires et dans des groupes 
multicanaux. Les voix déjà assignées à une autre 
piste apparaissent en gras dans le menu 
déroulant du sélecteur de voix.

Pour définir l'assignation d'une voix à une piste :

■ Cliquez sur le sélecteur de voix et définissez la 
piste sur Dyn, Off ou sélectionnez un numéro de 
voix (dans Pro Tools HD uniquement).

Le système Pro Tools LE ne prend en charge 
que l'assignation de voix automatique (et 
non pas l'assignation de voix individuelle).

Avec Pro Tools HD, l'insert initial d'un plug-
in RTAS utilise des voix supplémentaires 
dans certains cas. Voir Utilisation des voix 
et latence totale pour les plug-in RTAS, 
page 611.

Sélecteur de voix pour une piste audio stéréo 
(Pro Tools HD illustré)
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Assignation automatique des voix par ordre 
croissant

(Pro Tools HD uniquement)

Vous pouvez assigner automatiquement toutes 
les pistes (ou toutes les pistes sélectionnées) à 
des voix consécutives. Vous pourrez ainsi, par 
exemple, sélectionner huit pistes audio et les 
réassigner aux voix 9 à 16.

Pour assigner toutes les pistes audio à des voix 
consécutives :

■ Tout en appuyant sur Pomme + Option 
(Macintosh) ou sur Ctrl + Alt (Windows), 
sélectionnez le numéro de voix désiré pour la 
première piste dans le sélecteur de voix à 
l'extrême gauche de la fenêtre Mix ou en haut de 
la fenêtre Edit.

La voix est alors assignée à la première piste, les 
voix étant assignées consécutivement aux pistes 
(de même format) de priorité inférieure. 

Pour assigner toutes les pistes audio 
sélectionnées à des voix consécutives :

1  Sélectionnez les pistes audio en appuyant sur 
la touche Ctrl (Windows) ou Option 
(Macintosh) et en cliquant sur leur nom.

2  Maintenez les touches Ctrl + Alt + Maj 
(Windows) ou Pomme + Option + Maj 
(Windows) enfoncées pendant que vous 
sélectionnez le numéro de voix désiré pour la 
première piste sélectionnée dans le sélecteur de 
voix situé à gauche de la fenêtre Mix ou en haut 
de la fenêtre Edit.

La voix est assignée à la piste de départ, les 
suivantes étant assignées consécutivement aux 
pistes actuellement sélectionnées (de même 
format) de priorité inférieure. 

Emprunt des voix

(Pro Tools HD uniquement)

Pro Tools HD présente une fonction d'emprunt 
des voix qui vous permet d'affecter plusieurs 
pistes à une même voix. La piste de priorité la 
plus élevée adopte cette voix. Toutefois, lors 
d'un « trou » dans une piste de priorité élevée, la 
voix ainsi libérée redevient provisoirement 
disponible : elle est alors attribuée à la piste de 
priorité la plus proche, qui « s'intercale » et est 
donc lue. A la fin du « trou » dans la piste 
originale de priorité la plus élevée, la piste de 
priorité la plus voisine qui avait provisoirement 
pris sa place lui restitue sa voix. 

L'exemple qui suit démontre le concept 
d'emprunt des voix :Pour sélectionner plusieurs pistes, 

maintenez la touche Pomme (Macintosh) 
ou Ctrl (Windows) enfoncée tout en 
cliquant dessus.

Pour sélectionner un ensemble de pistes, 
cliquez sur les noms des pistes en appuyant 
sur Maj.

Les régions « Rhythm » sont reproduites en l'absence de 
régions « Lead »
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Dans l'illustration ci-dessus, les deux pistes 
visibles sont assignées à une même voix. La piste 
du haut contient une zone ouverte, un « trou » 
dans lequel aucune région n'apparaît. La voix 
inutilisée est alors disponible et la piste de 
priorité la plus voisine assignée à cette voix 
(celle du bas) s'intercale dans la zone ouverte 
pour être lue.

En permutant la priorité des pistes, l'assignation 
des voix et en disposant les régions de façon à 
bénéficier des transferts de priorité entre pistes 
lors des « trous », vous découvrirez de 
nombreuses applications utiles des pistes 
hébergeant des voix sur votre système 
Pro Tools HD.

Configuration de l'entrée et 
de la sortie MIDI
MIDI est pris en charge sur les pistes MIDI et les 
pistes d'instrument.

Assignation d'une entrée de piste 
MIDI

Pro Tools permet d'affecter des ports et des 
canaux MIDI donnés à une entrée de piste MIDI. 
La sélection par défaut All reçoit toutes les 
données MIDI entrantes de l'ensemble des ports 
sur l'intégralité des canaux. Servez-vous du 
sélecteur d'entrée MIDI pour spécifier le port et 
le canal MIDI d'entrée.

Pour assigner une entrée de piste MIDI :

■ Cliquez sur le sélecteur d'entrée MIDI de la 
piste et affectez un port et un canal à l'entrée 
MIDI. Les canaux déjà affectés à une autre piste 
s'affichent en caractères gras.

Assignation d'une sortie de piste 
MIDI

Pro Tools permet d'affecter des ports et des 
canaux MIDI donnés à une sortie de piste MIDI. 
Aucune sélection par défaut n'envoie de 
données MIDI à un port sur un canal donné. 
Servez-vous du sélecteur de sortie MIDI pour 
spécifier le port et le canal MIDI de sortie.Pour plus d'informations sur l'affectation 

d'entrées MIDI aux pistes d'instrument, 
reportez-vous à la section Affectation 
d'entrée et de sortie MIDI aux pistes 
d'instrument, page 132.

Dans la fenêtre Edit, choisissez View > Edit 
Window > I/O pour accéder au sélecteur 
d'entrée d'une piste.

Sélecteur d'entrée MIDI (piste MIDI illustrée)

Les pistes MIDI de Pro Tools ne peuvent 
contenir plusieurs canaux de données MIDI.
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Pour assigner une piste MIDI (et toutes ses 
régions) à un canal de périphérique MIDI donné :

■ Cliquez sur le sélecteur de sortie MIDI de la 
piste et affectez un port et un canal à la sortie 
MIDI. Les canaux déjà affectés à une autre piste 
s'affichent en caractères gras.

Pour assigner plusieurs destinations à une piste 
MIDI unique :

■ Maintenez la touche Pomme (Macintosh) 
enfoncée, puis cliquez sur le sélecteur de sortie 
MIDI (ou utilisez le bouton droit de la souris 
(Windows)) et sélectionnez d'autres canaux de 
périphériques.

Affectation d'entrée et de sortie 
MIDI aux pistes d'instrument

Les pistes d'instrument bénéficient d'une vue 
spécifique pour les commandes MIDI, 
notamment les sélecteurs d'entrée et de sortie 
MIDI.

Pour afficher les commandes MIDI de piste 
d'instrument, effectuez l'une des opérations 
suivantes :

■ Sélectionnez View > Mix Window > 
Instruments.

– ou –

■ Sélectionnez View > Edit Window > 
Instruments.

Pour plus d'informations sur l'affectation 
de sortie MIDI aux pistes d'instrument, 
voir Affectation d'entrée et de sortie MIDI 
aux pistes d'instrument, page 132.

Dans la fenêtre Edit, sélectionnez View > 
Edit Window > I/O pour accéder au 
sélecteur de sortie d'une piste.

Sélecteur de sortie MIDI (piste MIDI illustrée)

Pour plus de détails sur l'enregistrement et 
l'importation de données MIDI, reportez-
vous au Chapitre 13, Enregistrement 
MIDI.

Vue Instrument

Sélecteur d'entrée MIDI

Sélecteur de sortie MIDI
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Entrée MIDI de la piste d'instrument

Pro Tools permet d'affecter des ports et des 
canaux MIDI donnés à une entrée MIDI de piste 
d'instrument. La sélection par défaut All reçoit 
toutes les données MIDI entrantes de l'ensemble 
des ports sur l'intégralité des canaux. Servez-
vous du sélecteur d'entrée MIDI pour spécifier le 
port et le canal MIDI d'entrée.

Les canaux déjà utilisés par une autre entrée de 
la piste s'affichent en gras dans le menu 
déroulant du sélecteur d'entrée MIDI.

Pour affecter l'entrée MIDI d'une piste 
d'instrument :

■ Cliquez sur le sélecteur d'entrée MIDI de la 
piste et affectez un port et un canal à l'entrée 
MIDI. Les canaux déjà affectés à une autre piste 
s'affichent en caractères gras.

Sortie MIDI de la piste d'instrument

Pro Tools permet d'affecter des ports et des 
canaux MIDI donnés à une sortie MIDI de piste 
d'instrument. Aucune sélection par défaut 
n'envoie de données MIDI à un périphérique, 
un nœud sur un canal donné. Servez-vous du 
sélecteur de sortie MIDI pour spécifier le port et 
le canal MIDI de sortie.

Les canaux déjà utilisés par une autre entrée de 
la piste s'affichent en gras dans le menu 
déroulant du sélecteur d'entrée MIDI.

Pour affecter la sortie MIDI d'une piste 
d'instrument :

■ Cliquez sur le sélecteur de sortie MIDI de la 
piste et affectez un port et un canal à la sortie 
MIDI. Les canaux déjà affectés à une autre piste 
s'affichent en caractères gras.

Insertion de plug-in d'instrument 
sur les pistes d'instrument

Pour insérer un plug-in d'instrument sur une piste 
d'instrument :

■ Cliquez sur le sélecteur d'insert sur la piste 
d'instrument, puis sélectionnez le plug-in 
d'instrument. 

Un nœud MIDI (port MIDI virtuel) est 
automatiquement créé et attribué à la sortie 
MIDI de la piste.

Lecture en solo et coupure 
des pistes
Vous pouvez activer les boutons Solo et Mute à 
tout moment en cours de lecture. Les boutons 
Solo et Mute ont une incidence sur les pistes 
MIDI et audio. Vous pouvez écouter en solo ou 
couper plusieurs pistes en même temps dans 
une session.

Piste d'instrument avec plug-in d'instrument 
(Digidesign Synchronic illustré)

Les pistes d'instrument possèdent des jeux 
différents de boutons Solo et Mute pour 
l'écoute audio et le système MIDI.

Insert avec plug-in d'instrument
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Le regroupement par piste a également une 
incidence sur le solo et la coupure des pistes. 
Normalement, lorsque vous coupez ou écoutez 
en solo une piste appartenant à un groupe de 
mixage actif, toutes les autres pistes de ce groupe 
sont également coupées ou écoutées en solo. 
Vous pouvez toutefois modifier les paramètres 
Mute et Solo dans la boîte de dialogue 
Automation Preferences et désactiver ce 
comportement de groupe.

Pour désactiver la coupure groupée des pistes :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Automation.

2  Désactivez l'option Mutes Follow Groups et 
cliquez sur Done.

Lorsque cette option est désactivée et que vous 
coupez une piste appartenant à un groupe actif, 
les autres pistes de ce groupe ne sont pas 
concernées par la coupure.

Pour désactiver le solo groupé des pistes :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Automation.

2  Désactivez l'option Solos Follow Groups et 
cliquez sur Done. 

Lorsque cette option est désactivée et que vous 
écoutez en solo une piste appartenant à un 
groupe actif, les autres pistes de ce groupe ne 
sont pas concernées par le solo.

Bouton Solo

Le bouton Solo coupe généralement toutes les 
autres pistes et permet d'écouter uniquement la 
piste choisie.

Avec Pro Tools HD, ce comportement est 
sélectionné comme mode Solo désigné sous 
l'appellation Solo In Place. Des modes Solo 
supplémentaires sont fournis afin de modifier le 
fonctionnement du bouton Solo. Pour plus 
d'informations, reportez-vous à la section Modes 
Solo, page 134.

Pour lire des pistes en solo :

1  Cliquez sur le bouton Solo de la piste. 
Le bouton est en surbrillance et toutes les autres 
pistes sont coupées.

2  Cliquez sur le bouton Solo d'une autre piste. 
Les boutons de ces deux pistes sont mis en 
surbrillance et toutes les autres pistes sont 
coupées.

Pour désactiver la mise en solo des pistes :

■ Cliquez sur le bouton Solo de la piste lue en 
solo.

Modes Solo

(Pro Tools HD uniquement)

Avec Pro Tools HD, le bouton Solo permet de :

• Couper le son des autres pistes pour écouter 
seulement la piste choisie.

– ou –

• Envoyer une piste donnée vers une sortie 
différente.

Vous pouvez également écouter en solo ou 
couper les membres distincts d'un groupe, 
en maintenant la touche Ctrl (Macintosh) 
ou Démarrer (Windows) enfoncée pendant 
que vous sélectionnez le bouton Mute ou 
Solo de la piste.
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Le comportement du bouton Solo est défini par 
le mode Solo de la manière suivante :

SIP (Solo In Place) : le bouton Solo coupe les 
autres pistes. Lorsque ce mode est activé, les 
pistes peuvent être mises en solo (voir Mode 
Solo Safe, page 137).

AFL (After Fader Listen) : le bouton Solo envoie 
le signal post-fader/post-panoramique de la 
piste vers la sortie de chemin AFL/PFL. 
Le chemin AFL/PFL est configuré dans la page de 
l'onglet Output de la boîte de dialogue I/O Setup 
(voir Chemin AFL/PFL, page 107). 

Avec AFL, le niveau que vous entendez dépend 
du niveau du fader pour la piste considérée. 
De plus, un paramètre de niveau maître 
individuel pour AFL affecte la sortie d'une piste 
ou de toutes les pistes mises en solo en mode 
AFL (voir Chemin AFL/PFL, page 107). 
Ce paramètre de niveau est indépendant du 
paramètre de niveau PFL.

PFL (Pre Fader Listen) : le bouton Solo envoie le 
signal pré-fader/pré-panoramique de la piste 
vers la sortie de chemin AFL/PFL. Le chemin 
AFL/PFL est configuré dans la page de l'onglet 
Output de la boîte de dialogue I/O Setup (voir 
Chemin AFL/PFL, page 107). 

Avec PFL, le niveau de fader et de panoramique 
sont ignorés ; le niveau que vous entendez 
dépend du niveau d'enregistrement du signal. 
De plus, un paramètre de niveau maître 
individuel pour PFL affecte la sortie d'une piste 
ou de toutes les pistes mises en solo en mode PFL 
(voir Chemin AFL/PFL, page 107). Ce paramètre 
de niveau est indépendant du paramètre de 
niveau AFL.

Pour sélectionner un mode Solo :

1  Choisissez Options > Solo Mode et 
sélectionnez SIP, AFL ou PFL.

Utilisation de DSP avec le mode AFL ou PFL

Les modes AFL et PFL sont exécutés par 
Pro Tools qui crée un mixage en arrière-plan 
pour envoyer le signal vers le chemin AFL/PFL 
choisi. Selon la taille de votre mixage principal, 
Pro Tools consacre une partie importante de ses 
ressources DSP disponibles lors de l'utilisation 
du mode AFL/PFL.

L'annulation de la déclaration du chemin 
AFL/PFL libère toutes les ressources DSP 
précédemment utilisées pour le mode AFL/PFL.

Les modes Solo AFL et PFL requièrent le 
plug-in Surround Mixer (voir le guide de 
démarrage Pro Tools|HD).

Les modes Solo AFL et PFL requièrent le 
plug-in Surround Mixer. 

Si l'option Mutes Frees Assigned Voice est 
activée, toutes les pistes dont le son est 
coupé ne seront pas audibles en mode PFL.

Le mode Solo de toutes les pistes écoutées en 
Solo peut être librement modifié et ainsi 
passer en mode SIP ou AFL. Les pistes 
précédemment écoutées en solo adapteront 
leur mise en solo au nouveau mode.

Le fait de passer du mode Solo au mode PFL 
à la volée pour toutes les pistes écoutées en 
solo a pour effet d'effacer toutes les pistes 
précédemment en solo avant d'activer le 
mode PFL. Cette opération empêche une 
augmentation considérable du niveau.
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Utilisation du mode AFL/PFL sur les systèmes 
Pro Tools avec une surface de contrôle 
D-Control ou D-Command

AFL/PFL est optimisé pour les systèmes 
Pro Tools à l'aide de la surface de contrôle 
D-Command ou D-Control. XMON permute 
automatiquement la source d'écoute de la sortie 
principale à la sortie AFL/PFL de Pro Tools.

Utilisation du mode AFL/PFL sur les systèmes 
Pro Tools sans surface de contrôle D-Control ou 
D-Command

Si vous n'utilisez pas une surface de contrôle 
D-Control ou D-Command, votre chemin de 
sortie Pro Tools normal n'est pas nécessairement 
coupé lorsque vous envoyez un signal vers le 
chemin AFL/PFL. S'il s'avère nécessaire de 
couper automatiquement le signal principal 
lorsqu'un signal AFL/PFL est appelé, procédez 
comme suit : 

1  Configurez le chemin de sortie pour les pistes 
AFL ou PFL mises en solo.

2  Sélectionnez le chemin de sortie principale 
dont le son est coupé lorsque vous mettez en 
solo une piste en mode AFL ou PFL (voir 
Sélecteur de coupure AFL/PFL (chemin de 
sortie), page 108).

3  Configurez votre matériel pour écouter 
simultanément le chemin principal et les 
chemins AFL/PFL.

Lorsque le mode AFL ou PFL est sélectionné en 
tant que mode Solo et qu'une piste est mise en 
solo, le chemin de la sortie principale est coupé 
et le signal AFL/PFL apparaît au niveau du 
chemin AFL/PFL pour écoute.

Options Solo Latch

Les solos peuvent être verrouillés (les boutons 
Solo sur lesquels vous appuyez par la suite 
s'ajoutent à l'ensemble de pistes en solo), 
déverrouillés ou verrouillés temporairement 
(Pro Tools HD uniquement). Le verrouillage de 
la fonction Solo s'effectue à partir de la page 
Operation Preferences.

Pour sélectionner une option Solo Latch :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation.

2  Sélectionnez une option Solo Latch.

Latch : lorsque cette option est sélectionnée, les 
boutons Solo sur lesquels vous appuyez par la 
suite s'ajoutent à l'ensemble de pistes en solo.

X–OR (Cancels Previous Solos) : lorsque cette 
option est sélectionnée, le fait d'appuyer sur des 
boutons Solo annule les solos précédents.

Momentary (Pro Tools HD avec surfaces de 
contrôle prises en charge uniquement) : lorsque 
cette option est sélectionnée, le bouton Solo ne 
reste pas bloqué. Il faut maintenir le bouton 
Solo enfoncé pour mettre la piste en solo. Pour 
mettre d'autres pistes en solo, il suffit de toucher 
leurs boutons Solo (à condition de maintenir au 
moins un bouton Solo enfoncé). Si aucun 
bouton Solo n'est maintenu enfoncé, toutes les 
pistes qui étaient en solo ne le sont plus.

Pour plus d'informations sur l'utilisation de 
XMON et AFL/PFL, reportez-vous au Guide 
de votre surface de contrôle.

Pour remplacer le mode X–OR et le solo pour 
plusieurs pistes à la fois, maintenez le 
bouton Solo enfoncé sur la première piste. 
Les boutons Solo sur lesquels vous appuierez 
ensuite seront verrouillés.
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Utilisation de l'option Momentary Solo Latch

(Pro Tools HD uniquement)

Pour verrouiller provisoirement les solos :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation.

2  Dans la zone Solo Latch, sélectionnez 
Momentary, puis cliquez sur Done.

3  Maintenez enfoncé le bouton Solo de la 
première piste à mettre en solo.

4  Tout en continuant à maintenir enfoncé le 
premier bouton Solo, appuyez sur des boutons 
Solo supplémentaires. Les boutons Solo restent 
activés tant qu'un bouton Solo est maintenu 
enfoncé.

Mode Solo Safe

Pro Tools permet de protéger contre le solo une 
piste. Ceci évite qu'une piste ne soit coupée, 
même lorsque vous voulez écouter d'autres 
pistes en solo. Cette fonction est utile pour les 
pistes, telles que les entrées auxiliaires utilisées 
comme prémixage de pistes audio, ou de retours 
d'effets, car elle permet à la piste d'effets ou 
audio de rester dans un mix, même lorsque les 
autres pistes sont placées en solo. Il est 
également utile de protéger des pistes MIDI 
contre le solo pour que leur lecture ne soit pas 
affectée lorsque vous placez des pistes audio en 
solo.

Pour protéger une piste contre le solo :

■ Maintenez enfoncée la touche Pomme 
(Macintosh) ou Ctrl (Windows) pendant que 
vous cliquez sur le bouton Solo de la piste 
désirée. Ceci évite qu'une piste ne soit coupée, 
même lorsque vous voulez écouter d'autres 
pistes en solo. Le bouton Solo devient 
transparent en mode Solo Safe.

Pour déprotéger une piste contre le solo :

■ Maintenez enfoncée la touche Pomme 
(Macintosh) ou Ctrl (Windows) pendant que 
vous cliquez à nouveau sur le bouton Solo de la 
piste désirée.

Bouton Mute (Coupure du son)

Le bouton Mute coupe le son de la piste 
sélectionnée. Il est possible de couper le son de 
plusieurs pistes en même temps. Si l'option 
Options > Mute Frees Assigned Voice (systèmes 
Pro Tools HD uniquement) est active, la 
coupure d'une piste assigne sa voix à la piste 
virtuelle de priorité la plus élevée suivante 
(assignée à la même voix).

Pour couper une piste :

■ Cliquez sur le bouton Mute de la piste. 
La piste est inactive et coupée.

Pour désactiver la coupure d'une piste :

■ Cliquez de nouveau sur le bouton Mute.

Tant qu'au moins un bouton Solo est 
maintenu enfoncé, tous les solos restent 
verrouillés.

Les pistes AFL ou PFL écoutées en solo 
(Pro Tools HD uniquement) ne peuvent pas 
être protégées contre le solo.
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Option Mute Frees Assigned Voice

(Pro Tools HD uniquement)

Lorsque vous sélectionnez Options > Mute Frees 
Assigned Voice et que vous coupez une piste, la 
lecture de celle-ci est désactivée, et sa voix est 
« récupérée » par la piste de priorité la plus 
élevée suivante assignée à la même voix.

Lorsque cette option est active, un retard peut se 
produire (d'une à plusieurs secondes suivant la 
puissance du processeur) entre le moment ou 
vous coupez ou désactivez la coupure d'une 
piste et celui où vous en constatez l'effet sur la 
lecture. 

Inactivation des pistes
Les pistes audio, entrées auxiliaires, de faders 
principaux et d'instrument peuvent être 
désactivées. Les pistes inactives n'utilisent ni 
DSP ni voix. Sur les pistes inactives, les plug-in, 
départs, voix et automation sont tous 
désactivés. Il est également possible de 
désactiver automatiquement les pistes 
lorsqu'une session est ouverte sur un système 
possédant moins de puissance DSP que celui sur 
lequel elle a été créée.

Pour activer ou désactiver une piste :

■ Maintenez enfoncées les touches 
Pomme + Ctrl (Macintosh) ou Ctrl + Démarrer 
(Windows) pendant que vous cliquez sur 
l'indicateur du type de piste dans la fenêtre Mix.

Les playlists des pistes inactives sont estompées 
et les contrôles des pistes sont grisées.

Pour désactiver une ou plusieurs pistes :

1  Cliquez sur le nom de la piste souhaitée (dans 
sa voie de console de piste) pour la sélectionner. 

2  Choisissez Track > Make Inactive.

Lorsque vous coupez une piste en activant 
l'option Mute Frees Assigned Voice, la voix 
n'est pas libérée pour l'enregistrement 
QuickPunch ou TrackPunch (à la volée).

De grandes tailles de buffer de lecture DAE 
peuvent également augmenter le retard 
potentiel entre le moment où vous cliquez 
sur le bouton Mute et la coupure effective. 
Pour plus d'informations, reportez-vous à la 
section Taille du buffer de lecture DAE, 
page 54.

Les pistes MIDI ne peuvent être désactivées.

Activation/désactivation d'une piste

Pour sélectionner plusieurs pistes, 
maintenez la touche Pomme (Macintosh) 
ou Ctrl (Windows) enfoncée tout en 
cliquant dessus.

Pour sélectionner un ensemble de pistes, 
cliquez sur les noms des pistes en appuyant 
sur Maj.

Indicateur du type de piste
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Codage couleur des pistes, 
des régions, des marqueurs 
et des groupes
Des couleurs différentes peuvent être affectées à 
des régions, des pistes, des marqueurs et des 
groupes audio et MIDI. 

Les régions illustrées dans les vues Waveform et 
Block de la fenêtre Edit sont en couleurs. 
Les pistes présentées dans la liste des pistes, la 
liste de groupes et les fenêtres Mix et Edit sont 
associées à des barres de couleurs.

Barres de couleur

Le codage couleur au niveau de la piste est 
représenté par les barres de couleurs de la 
manière suivante :

Fenêtre Mix : les couleurs de la piste s'affichent 
sous formes de barres de couleur horizontales 
figurant au-dessus de chaque voie et en dessous 
du nom de la piste. 

Fenêtre Edit : les couleurs de la piste s'affichent 
sous formes de barres de couleur verticales à 
gauche de chaque piste.

Liste des pistes : les couleurs de la piste 
s'affichent sous formes de barres de couleur 
verticales à gauche de chaque nom de piste.

Liste de groupes : les couleurs de la piste 
s'affichent sous formes de barres de couleur 
verticales à gauche de chaque nom de groupe.

Les couleurs par défaut sont automatiquement 
affectées aux pistes, mais il est possible de 
remplacer ces couleurs par celles de la palette 
qui offre un choix de 96 couleurs. Pour plus 
d'informations, reportez-vous à la section 
Palette de couleurs, page 141.

Affichage des préférences de 
page pour le codage couleur

Les options de codage couleur déterminent la 
manière dont les couleurs sont affectées à 
l'affichage des pistes et des régions.

Pour modifier les options de codage couleur :

1  Choisissez Setup > Preferences.

2  Cliquez sur Display.

3  Sélectionnez une option de codage couleur de 
piste par défaut.

4  Sélectionnez une option de codage couleur de 
région par défaut.

5  Sélectionnez ou désélectionnez l'option 
Always Display Marker Colors.

6  Cliquez sur Done (Terminé).

Option Always Display Marker Colors

Cette option permet d'afficher les couleurs des 
marqueurs dans la règle des marqueurs, quels 
que soient les paramètres choisis pour Default 
Region Color Coding. 

Page des préférences d'affichage
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Options Default Track Color Coding

Ces options déterminent la façon dont les 
couleurs sont affectées à l'affichage des pistes. 

None : désactive l'affectation de couleurs par 
défaut pour les pistes.

Tracks and MIDI Channels : affecte une couleur à 
chaque piste de la fenêtre Edit ou Edit en 
fonction de l'assignation de sa voix ou de son 
canal MIDI.

Tracks and MIDI Devices : affecte une couleur à 
chaque piste de la fenêtre Edit ou Edit en 
fonction de l'assignation de sa voix ou de son 
périphérique MIDI.

Groups : affecte une couleur à chaque piste, 
conformément à son ID de groupe Mix ou Edit. 
En cas de suspension de groupes à l'aide de la 
commande Suspend Groups, les barres de 
couleurs des pistes ne sont pas affichées.

Track Type : affecte une couleur à chaque piste 
en fonction de leur type (audio, Entrée 
auxiliaire, Instrument, MIDI ou Fader 
principal).

Options Default Region Color Coding

Ces options déterminent la façon dont les 
couleurs sont affectées à l'affichage des régions. 

None : désactive l'affectation de couleurs par 
défaut pour les régions. Les régions sont 
représentées par des formes d'ondes ou des notes 
MIDI noires sur un fond gris clair.

Tracks and MIDI Channels : affecte une couleur à 
chaque région de la fenêtre Edit en fonction de 
l'assignation de sa voix ou de son canal MIDI.

Tracks and MIDI Devices : affecte une couleur à 
chaque région de la fenêtre Edit en fonction de 
l'assignation de sa voix ou de son périphérique 
MIDI.

Groups : affecte une couleur à chaque région, 
conformément à l'ID de groupe de sa piste. En 
cas de suspension de groupes à l'aide de la 
commande Suspend Groups, toutes les régions 
présentent des formes d'ondes ou des notes 
MIDI noires sur un fond gris clair.

Track Color : affecte une couleur de région basée 
sur la couleur attribuée à la piste. (Reportez-vous 
à la section Palette de couleurs, page 141.)

Marker Locations : affecte une couleur aux 
données dans toutes les pistes en fonction du 
marqueur précédent le plus proche.

Options des codes couleur par défaut des régions Options des codes couleur par défaut des régions
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Region List Color : affecte une couleur à chaque 
région en fonction de sa couleur dans la liste des 
régions. Lorsque cette option est activée, la 
couleur de région attribuée est conservée même 
si la région est placée dans un ensemble de pistes 
d'un code couleur différent. 

Palette de couleurs

La palette de couleurs vous permet de 
sélectionner des couleurs pour les pistes, les 
groupes et les marqueurs. 

La palette de couleurs prend en charge des 
codages couleurs de région distincts dans la liste 
des régions et dans les pistes.

Pour appliquer une couleur à partir de la palette :

1  Choisissez Window > Color Palette.

2  Effectuez l'une des opérations suivantes :

• Dans le menu déroulant Apply to Selected, 
sélectionnez la destination du codage 
couleur, à savoir : Tracks (pistes), Marker 
(marqueur), Group (Groupe), Regions in 
Tracks (Régions dans les pistes) ou Regions 
in Region List (Régions dans la listes de 
régions).

– ou –

• Sélectionnez une piste, un marqueur, un 
groupe, une région de piste ou une région 
de la liste de régions dans la fenêtre 
Pro Tools qui convient. Le menu Apply to 
Selected affiche le type d'élément que vous 
avez sélectionné.

3  Sélectionnez une couleur dans la palette ou 
sélectionnez une des options suivantes :

Default : supprime toute couleur personnalisée 
et rétablit la couleur selon l'orientation de la 
couleur par défaut. Pour plus d'informations, 
reportez-vous à la section Affichage des 
préférences de page pour le codage couleur, 
page 139.

None : désactive l'affectation de couleurs. 
Les régions affectées sont représentées par une 
forme d'onde noire ou des notes MIDI noires sur 
fond gris clair. Les barres de couleurs des pistes 
et des groupes concernés ne s'affichent plus.

L'activation d'une option de la liste Default 
Region Color Coding autre que l'option 
Region List Color annule la couleur de la 
liste de régions correspondante et réaffecte 
la couleur de la piste parente aux copies de 
la région placées dans les pistes. Les copies 
de la région dans la liste des régions 
conservent leur couleur unique, le cas 
échéant. 

Fenêtre de la palette de couleurs

Appliquer à la sélection Conserver
Valeur par 

Aucun

Dernière couleur affectée

défaut

Si la sélection d'un marqueur ne permet pas 
de présenter l'option Marker dans le menu 
déroulant Apply to Selected, cela signifie que 
l'option Always Display Marker Colors 
dans la page Display Preferences est 
désactivée. Pour plus d'informations, 
reportez-vous à la section Option Always 
Display Marker Colors, page 139.
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Utilisation du bouton Hold

La palette de couleurs présente un bouton Hold 
dont le but est de simplifier le processus 
d'affectation de mêmes couleurs à de nombreux 
éléments (comme les pistes et les régions).

Par défaut, ce bouton est désactivé. Dans ce cas, 
la palette de couleurs met automatiquement en 
surbrillance la couleur affectée (s'il y en a une) 
des éléments au fur et à mesure que vous les 
sélectionnez. 

Par défaut, ce bouton est désactivé. Dans ce cas, 
la palette de couleurs met automatiquement en 
surbrillance la couleur affectée (s'il y en a une) 
des éléments au fur et à mesure que vous les 
sélectionnez. 

Lorsque le bouton Hold est activé, la couleur 
affectée sélectionnée dans la palette de couleurs 
reste inchangée lorsqu'une piste ou une région 
différente est sélectionnée. 

Pour utiliser le bouton Hold afin d'affecter une 
même couleur à plusieurs éléments : 

1  Cliquez sur le bouton Hold pour l'activer. 
Le bouton Hold vire au blanc et la couleur 
actuellement sélectionnée est mise en 
surbrillance (elle est entourée d'une cadre 
blanc). 

2  Sélectionnez des pistes ou des régions 
supplémentaires auxquelles vous voulez affecter 
la couleur choisie. Etant donné que le bouton 
Hold est activé, la palette des couleurs ne se 
conforme pas à la sélection de l'élément ; elle 
conserve (ou « bloque ») la dernière couleur 
actuellement affectée. 

3  Cliquez à nouveau sur la couleur affectée pour 
l'appliquer à la nouvelle sélection de pistes ou de 
régions. Utilisez le menu déroulant Apply to 
Selected pour déterminer les éléments 
sélectionnés concernés. 

4  Pour désactiver le bouton Hold et rétablir le 
mode par défaut de la palette des couleurs, 
cliquez sur le bouton Hold jusqu'à ce qu'il soit 
désactivé. 

Regroupement des pistes
Pro Tools offre une fonction de regroupement 
relatif qui permet de relier des pistes et leurs 
commandes. Les groupes peuvent concerner la 
fenêtre Mix ou la fenêtre Edit, ou encore les 
deux.

Les groupes sont pratiques pour éditer plusieurs 
pistes exactement de la même manière ou pour 
mixer plusieurs pistes (par exemple une paire de 
pistes stéréo ou un prémixage) tout en 
préservant leurs niveaux relatifs. 

Pro Tools  offre les fonctions de regroupement 
suivantes :

• Jusqu'à 26 groupes différents

• Groupes emboîtés (sous-groupes à 
l'intérieur de groupes)

• Les faders ou contrôleurs regroupés 
préservent leurs niveaux relatifs.

Pour suspendre temporairement le 
comportement de groupe d'une piste, 
appuyez sur Contrôle (Macintosh) ou 
cliquez à l'aide du bouton droit de la souris 
(Windows) tout en cliquant sur la fonction 
de groupe souhaitée.

Pro Tools permet de regrouper des régions 
en groupes de régions. Pour plus 
d'informations, reportez-vous à la section 
Groupes de régions, page 386.
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Le regroupement peut s'appliquer aux 
paramètres de pistes suivants :

• Règle temporelle de la piste

• Niveaux de volume

• Solos

• Coupures

• Modes d'automation

• Niveaux de départ

• Coupures de départ

• Vue de piste

• Hauteur de la piste

• Fonctions d'édition

Le regroupement n'a pas d'effet sur les 
paramètres suivants :

• Préparation en enregistrement

• Panoramique

• Panoramique de départ

• Assignation des voix

• Assignation des sorties

• Insertion de plug-in

Utilisation de la liste des groupes

Les fonctions de regroupement de piste de 
Pro Tools se trouvent à gauche de la fenêtre Mix 
ou Edit dans la liste des groupes. La fenêtre 
déroulante contient les noms de tous les 
groupes de votre session, ainsi qu'un menu 
déroulant qui donne accès aux commandes de 
regroupement. Depuis ce menu, vous pouvez 
sélectionner et activer des groupes.

Par défaut, chaque session possède un groupe 
nommé All, qui inclut toutes les pistes de la 
session. Vous ne pouvez ni éditer ni supprimer 
le groupe All.

A gauche de chaque nom de la liste des groupes 
se trouve la lettre d'identification de chaque 
groupe (de « a » à « z »), et à gauche de cette 
lettre se trouve un symbole indiquant si ce 
groupe est sélectionné dans la fenêtre actuelle 
(la fenêtre Edit ou Mix).

Symboles de groupes

Ils existent trois types de symboles de groupes, 
tels qu'illustrés dans la figure suivante :

Les significations de ces symboles de groupes 
sont les suivantes :

Cercle plein : indique que tous les membres du 
groupe sont actuellement sélectionnés, et 
qu'aucun membre en dehors du groupe n'est 
sélectionné.

Cercle vide : indique que seuls certains membres 
du groupe sont actuellement sélectionnés.

Liste de groupes

Symboles de groupes

Menu déroulant de 

Cliquez ici pour 
sélectionner un 
groupe en 
tapant sa lettre

Cliquez ici 
pour activer 
un groupe 

Cliquez ici 
pour 
sélectionner 
les membres 
du groupe à 
l'écran

Cliquez pour masquer la 
liste des groupesID de groupe

Couleurs

la liste des groupes

Cercle vide

Cercle plein

Cercle contenant un point
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Cercle contenant un point : indique que tous les 
membres du groupe sont actuellement 
sélectionnés, ainsi que des membre en dehors du 
groupe.

Menu déroulant de la liste des groupes

Un menu déroulant de la liste des groupes de 
mixage et d'édition permet d'afficher ou de 
masquer les pistes d'un groupe ou d'afficher les 
pistes d'un seul groupe. Cliquez sur le sélecteur 
de liste de groupes et sélectionnez une option 
dans le menu déroulant.

Commandes de la liste de groupes

Le sélecteur de liste de groupes contient des 
commandes permettant de créer, de supprimer 
ou de suspendre des groupes de la façon 
suivante :

New Group : cette commande permet de créer 
un groupe. Vous devez au préalable sélectionner 
deux ou plusieurs pistes/voies à l'écran.

Display : cette commande vous permet de faire 
passer l'affichage de la liste des groupes des 
groupes de mixage aux groupes d'édition et vice 
versa. Si tous vos groupes s'appliquent à la fois à 
l'édition et au mixage, la liste des groupes sera 
identique pour les deux. 

Suspend All Groups : cette commande permet de 
désactiver provisoirement tous les groupes 
actifs.

Delete Group : cette commande permet de 
supprimer définitivement un groupe de la liste 
des groupes. Vous devez au préalable 
sélectionner le nom d'un groupe dans la liste.

Création de groupes

Pour créer un groupe :

1  Maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Macintosh) pendant que vous 
cliquez sur les noms des pistes que vous 
souhaitez inclure dans le groupe pour les 
sélectionner.

2  Choisissez New Group dans le menu 
déroulant de la liste des groupes ou choisissez 
Track > Group.

Sélecteur de la liste de groupes (groupe de mixage)

Sélecteur de liste de groupes et commandes

Sélection des pistes à regrouper
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3  Saisissez le nom d'un groupe.

4  Choisissez le type de groupe à créer : groupe 
Edit, groupe Mix ou groupe Edit and Mix.

5  Choisissez un ID de groupe (« a » à « z »).

6  Cliquez sur OK pour ajouter le nouveau 
groupe à la liste des groupes.

Edition de groupes

Modification des membres d'un groupe

Vous pouvez ajouter ou supprimer des membres 
d'un groupe à tout moment. 

Pour changer les membres d'un groupe :

1  Maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Macintosh) pendant que vous 
cliquez sur les noms des pistes que vous 
souhaitez inclure dans le groupe pour les 
sélectionner.

2  Choisissez New Group dans le menu 
déroulant de la liste des groupes ou choisissez 
Track > Group.

3  Dans la boîte de dialogue qui apparaît, 
sélectionnez l'identification du groupe que vous 
voulez mettre à jour.

4  Cliquez sur OK.

Changement du nom d'un groupe

Vous pouvez renommer un groupe à tout 
moment. 

Pour renommer un groupe :

1  Dans la liste des groupes, cliquez deux fois à 
gauche du nom du groupe (dans la zone des 
symboles circulaires).

2  Dans la boîte de dialogue qui s'affiche, entrez 
le nouveau nom du groupe. Vous pouvez 
également modifier le type d'un groupe.

3  Cliquez sur OK.

Suppression d'un groupe

Il est possible de supprimer un groupe à tout 
moment. Vous ne pourrez pas annuler cette 
action. 

Pour supprimer un groupe :

1  Dans la liste des groupes, sélectionnez le nom 
du ou des groupes que vous voulez supprimer.

2  Cliquez dans le menu déroulant de la liste des 
groupes et choisissez Delete Group.

Liaison de groupes de mixage et 
d'édition

L'option Link Mix and Edit Group Enables relie 
l'activation de groupe entre les fenêtres Mix et 
Edit. 

Pro Tools permet de créer des groupes qui sont à 
la fois de mixage et d'édition, même si vous 
préféreriez dans certains cas ne pas relier ces 
groupes. Par exemple, lorsque vous utilisez la 
fenêtre Mix pour le mixage, vous pouvez 
préférer travailler avec des groupes emboîtés 
plus grands. En revanche, dans la fenêtre Edit, 
vous préférerez peut-être effectuer vos tâches 

Boîte de dialogue New Group
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d'édition à l'intérieur d'un groupe plus petit. 
Dans ce cas, désactiver l'option Link Mix and 
Edit Group Enables permet de travailler avec des 
groupes différents dans les deux fenêtres.

Pour supprimer le lien entre les groupes Mix 
et Edit :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation. 

2  Désactivez l'option Link Mix and Edit Group 
Enables et cliquez sur Done.

Activation de groupes

Les opérations d'édition ne s'appliquent pas aux 
membres d'un groupe qui sont cachés dans la 
liste de pistes. Les opérations de mixage 
(exception faite de la préparation en 
enregistrement) s'appliquent aux pistes 
masquées.

Pro Tools permet de créer des groupes distincts 
pour l'édition et le mixage. Cette option est 
définie à l'aide de la commande New Group. Les 
groupes concernés à la fois par l'édition et le 
mixage peuvent être découplés.

Pour activer un groupe :

■ Dans la liste des groupes, sélectionnez le nom 
du groupe que vous voulez activer. Le nom du 
groupe s'affiche en surbrillance pour indiquer 
qu'il est activé.

Pour activer d'autres groupes, cliquez sur leurs 
noms dans la liste des groupes. 

Le déplacement du fader d'un membre du 
groupe provoque le déplacement des autres 
relativement à celui-ci. Si des groupes sont en 
conflit lorsque déplacez des faders et si un fader 
appartient à plusieurs groupes, il suivra le 
groupe le plus élevé ou « parent » auquel il 
appartient.

Pour désactiver un groupe :

■ Dans la liste des groupes, sélectionnez le nom 
du groupe que vous voulez désactiver. Le nom 
du groupe cesse de s'afficher en surbrillance 
pour indiquer qu'il est désactivé.

Sélection de groupes au clavier

Le focus sur le clavier de la liste des groupes 
permet de saisir une lettre identifiant un groupe 
de sorte à activer automatiquement le statut de 
ce groupe.

◆ Dans la fenêtre Mix, le focus sur le clavier de la 
liste des groupes est toujours actif. 

◆ Dans la fenêtre Edit, vous devez activer le 
focus pour pouvoir l'utiliser.

Pour activer le focus sur le clavier de la liste des 
groupes :

■ Cliquez sur le bouton de focus clavier en haut 
et à droite de la liste des groupes.

– ou –

■ Appuyez sur Pomme + Option + 3 
(Macintosh) ou sur Ctrl + Alt + 3 (Windows).

Pour activer ou désactiver des groupes en 
utilisant le focus sur le clavier de la liste des 
groupes Edit et Mix :

■ Lorsque le focus est activé, tapez la lettre 
d'identification du groupe (a–z) pour activer ou 
désactiver automatiquement le groupe en 
question.

Focus sur le clavier de la liste des groupes activé
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Chapitre 9 : Importation et exportation 
de données de session

Pro Tools permet d'importer un grand nombre 
de données dans une session, notamment des 
fichiers audio et MIDI, des groupes de régions, 
des fichiers vidéo, des playlists de pistes, des 
configurations d'E/S et des configurations 
d'assignations de signaux.

Vous pouvez importer des fichiers audio et MIDI 
dans une session, ou transférer l'intégralité de 
pistes audio ou MIDI, ainsi que leurs attributs, 
depuis une autre session. De plus, avec les 
systèmes Pro Tools HD, vous avez la possibilité 
d'importer toute combinaison d'attributs de 
pistes depuis une autre session, comme les 
playlists audio ou MIDI, l'assignation des 
signaux, les plug-in ou l'automation d'une piste. 
Reportez-vous aux sections Importation de 
données audio, page 147 et Importation de 
pistes et de leurs attributs, page 154. 

Importation de données audio
Les fichiers et les régions audio peuvent être 
importés vers de nouvelles pistes ou dans la liste 
des régions, d'où on peut les faire glisser sur des 
pistes existantes.

Les fichiers dont le type n'est pas pris en charge 
dans la session doivent être convertis lors de leur 
importation. Les fichiers dont les fréquences 
d'échantillonnage diffèrent de celui de la session 
actuelle doivent être convertis, afin que les 
fichiers soit lus à la hauteur et à la vitesse 
appropriées.

Vous pouvez écouter les fichiers et les régions 
pris en charge avant de les importer.

Si des définitions de régions sont présentes dans 
un fichier audio, vous pouvez convertir et 
importer l'audio pour une région sans importer 
l'ensemble du fichier audio parent.

Pro Tools 7.0 ne prend pas en charge les 
noms de fichier audio composés de certains 
caractères ASCII (voir Ouverture d'une 
session contenant des noms de fichier 
audio avec des caractères interdits, 
page 175).
Chapitre 9 : Importation et exportation de données de session 147



148
Les fichiers audio de type suivant peuvent être 
importés dans des sessions Pro Tools :

• AIFF

• WAV ou BWF (.WAV)

• SD II

• SD I

• MP3

• AAC audio (y compris les données audio 
avec les extensions de fichier AAC, Mp4 
et M4a)

• Sound Resource (AIFL — Macintosh 
seulement)

• WMA (Windows Media — Windows 
seulement)

• QuickTime (Macintosh uniquement)

• RealAudio :

• MXF audio

• Fichiers REX 1 et 2

• Fichiers ACID

Copie, ajout et conversion de données 
audio

Suivant les propriétés des fichiers audio que 
vous importez, vous pouvez ajouter, copier ou 
convertir ces fichiers. Les options suivantes 
s'affichent dans la boîte de dialogue Import 
Audio lorsqu'elles s'appliquent au fichier audio 
sélectionné.

Ajout

Les fichiers audio de même résolution et de 
même type qu'une session peuvent y être 
ajoutés directement. Lorsque vous ajoutez un 
fichier audio, la session référence le fichier audio 
d'origine dans son emplacement d'origine. 
Utilisez cette option si vous ne voulez pas 
consommer d'espace supplémentaire sur le 
disque dur pour des fichiers audio dont la 
résolution et le type correspondent déjà à votre 
session.

Pro Tools permet d'ajouter à une session des 
fichiers audio qui ne sont pas de son type natif. 
Les sessions Macintosh permettent d'ajouter des 
fichiers SD II, AIFF ou WAV à n'importe quelle 
session, et les sessions Windows permettent 
d'ajouter des fichiers AIFF ou WAV à n'importe 
quelle session. Toutefois, les performances des 
sessions mélangeant les types de fichiers seront 
réduites. 

Pro Tools n'est pas en mesure d'importer 
des fichiers AAC ou MP4 protégés avec 
l'extension .M4p. Ces fichiers sont protégés 
par des droits en matière de propriété 
numérique et ne peuvent pas être importés.

Les fichiers ACID sans données temporelles 
sont importées sous forme de régions audio.

Les fichiers ACID avec données temporelles 
et les fichiers REX 1 et 2 sont importés sous 
forme de groupes de régions. Pour plus 
d'informations sur les groupes de régions, 
reportez-vous à la section Importation et 
exportation de fichiers de groupe de 
régions, page 170.

Après avoir importé des fichiers ACID et des 
fichiers REX 1 et 2, il est possible de réduire 
la liste des régions en masquant les régions 
créées automatiquement (désélectionnez 
Show > Auto-Created dans le menu 
déroulant de la liste des régions).
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Les fichiers audio dont la résolution est 
différente de celle de la session doivent être 
convertis avant d'être importés. 

Copie

Dès que vous pouvez ajouter un fichier à votre 
session, vous avez également la possibilité de le 
copier. Cette option crée une copie du fichier 
audio et le place dans le dossier de votre choix. 
Lorsque vous copiez un fichier audio, la session 
référence le fichier copié dans son nouvel 
emplacement. 

L'option Copy peut en outre servir à déplacer 
des données audio d'un lecteur non pris en 
charge ou extractible vers un lecteur audio, ou 
pour archiver des fichiers audio d'une session 
vers un emplacement spécifique.

Conversion

Les fichiers audio dont la résolution et la 
fréquence d'échantillonnage sont différentes de 
celles de la session, ou les fichiers audio dont le 
type de fichier est incompatible (tels que les 
fichiers SD II dans Windows) doivent être 
convertis pour être utilisés dans la session. 
Lorsqu'un fichier audio est converti, un 
nouveau fichier avec la résolution, le type et la 
fréquence d'échantillonnage corrects est créé et 
placé dans le dossier de votre choix.

La qualité de conversion de la fréquence 
d'échantillonnage utilisée par Pro Tools est 
déterminée par l'option Conversion Quality 
dans les préférences. Pour en savoir plus, 
reportez-vous à la section Conversion Quality, 
page 150.

Importation de fichiers stéréo

Lorsque vous utilisez la commande Import 
Audio to Track, les fichiers stéréo (« entrelacés ») 
sont automatiquement importés dans des pistes 
stéréo.

Les fichiers audio stéréo non entrelacés (double 
mono) peuvent être importés automatiquement 
vers des pistes stéréo. Les fichiers de ce type 
doivent inclure dans leurs noms les 
identificateurs de canal « .L » et « .R » (par 
exemple, nomfichier.L et nomfichier.R) et les 
fichiers doivent être de même longueur. Sous 
Windows ou en mode de compatibilité Mac/PC, 
ces fichiers portent une extension de trois lettres 
ajoutée après l'identificateur de canal « .L » ou 
« .R ».

Pro Tools permet également d'importer des 
fichiers multicanaux entrelacés pour chaque 
type de fichier reconnu. 

Pro Tools permet d'ajouter à une session 
des fichiers de fréquence d'échantillonnage 
différente. Dans le champ des 
commentaires de la boîte de dialogue 
Import Audio, un avertissement indique que 
ces fichiers ne seront pas lus à la bonne 
vitesse et à la bonne hauteur si vous ne les 
convertissez pas.
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Conversion Quality
Ce paramètre détermine la qualité de la 
conversion de la fréquence d'échantillonnage 
utilisée lors de la conversion et de l'importation 
de données audio dans une session. Cinq 
qualités de conversion sont possibles, classées 
par ordre croissant : de Low à Tweak Head. Plus la 
qualité est élevée et la conversion importante, 
plus le temps nécessaire à la conversion sera 
important.

Pour définir la qualité de conversion de la 
fréquence d'échantillonnage :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Editing.

2  Dans le menu déroulant Conversion Quality, 
sélectionnez la qualité.

Dans la plupart des applications, les qualités 
Good (bon) ou Better (meilleur) donneront de 
très bons résultats.

3  Cliquez sur Done (Terminé).

Importation des fichiers audio 
et des régions
Pro Tools propose plusieurs méthodes pour 
importer des fichiers audio et des régions dans 
une session ouverte.

• Importation de fichiers et de régions audio 
à l'aide des commandes de menu Pro Tools, 
page 151

• Importation de fichiers audio à l'aide de 
l'icône de l'application Pro Tools ou de son 
alias, page 152

• Importation de fichiers et de régions audio 
en les faisant glisser, page 153

• Importation de données audio depuis des 
CD audio, page 153

Préférences de qualité de conversion
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Importation de fichiers et de 
régions audio à l'aide des 
commandes de menu Pro Tools

Pro Tools offre plusieurs commandes de menu 
pour importer des fichiers ou des régions audio.

Pour importer des fichiers ou des régions audio 
dans une session (depuis le menu File de 
Pro Tools) :

1  Effectuez l'une des opérations suivantes :

• Choisissez File > Import Audio to Track 
pour importer des fichiers audio et les 
placer automatiquement dans de nouvelles 
pistes.

– ou –

• Pour importer des données audio dans la 
liste des régions sans créer 
automatiquement de nouvelles pistes, 
choisissez File > Import > Audio to Region 
List.

Pour importer des pistes entières depuis d'autres 
sessions, reportez-vous à la section Importation 
de pistes et de leurs attributs, page 154.

2  En haut de la boîte de dialogue Import Audio, 
sélectionnez un fichier audio pour faire 
apparaître ses propriétés et ses régions associées. 

Vous pouvez choisir de ne faire apparaître qu'un 
seul type de fichier (AIFF, par exemple) en le 
sélectionnant dans le menu déroulant Show. 
Pour afficher tous les types de fichiers pris en 
charge, sélectionnez All Documents dans le 
menu déroulant Show.

3  Pour écouter un fichier ou une région 
sélectionnés avant de les importer, cliquez sur 
les boutons de lecture et d'arrêt.

Pour régler le volume de lecture, déplacez le 
curseur vertical. Pour aller à un endroit 
particulier du fichier, déplacez le curseur 
horizontal qui se trouve juste au-dessous des 
boutons de lecture et d'arrêt. 

Figure 6.  Boîte de dialogue Import Audio

Sur Macintosh, les fichiers de ressources son 
(Sound Resource) doivent porter l'extension 
.SFIL pour que Pro Tools puisse les 
importer. 
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Les canaux 1–2 sont par défaut la sortie d'écoute. 
Sur les systèmes Pro Tools HD, la sortie d'écoute 
peut être modifiée dans I/O Setup ou Hardware 
Setup.

4  Pour placer un fichier ou une région dans la 
liste d'importation (en bas et à droite de la boîte 
de dialogue sur un Macintosh, sur la droite dans 
Windows), sélectionnez le fichier (maintenez 
enfoncée la touche Maj pour sélectionner 
plusieurs fichiers) et cliquez sur Add ou sur 
Convert. Vous pouvez également cliquer sur 
Add All ou sur Convert All pour importer toutes 
les régions et les fichiers dans le répertoire 
courant. 

Dans la liste d'importation, les fichiers audio se 
distinguent des régions par leurs icônes.

5  Pour supprimer un fichier ou une région de la 
liste d'importation située à droite, sélectionnez-
les et cliquez sur Remove. Pour supprimer toutes 
les régions ou les fichiers, cliquez sur Remove 
All.

6  Après avoir ajouté les fichiers audio et les 
régions à la liste d'importation, cliquez sur 
Done. 

7  Si vous copiez ou convertissez des fichiers, 
vous êtes invité à choisir un emplacement pour 
les nouveaux fichiers audio. Sélectionnez un 
dossier dans un lecteur audio valide, tel que le 
dossier Audio Files pour votre session actuelle. 

Si vous choisissez File > Import Audio to Track, 
les fichiers et les régions sont importés dans de 
nouvelles pistes audio et apparaissent également 
comme des régions dans la liste des régions.

Si vous choisissez File > Import > Audio to 
Region List, les fichiers et les régions 
apparaissent comme des régions dans la liste des 
régions.

Importation de fichiers audio à 
l'aide de l'icône de l'application 
Pro Tools ou de son alias

Il est possible d'importer des fichiers audio dans 
une session en utilisant l'icône de l'application 
Pro Tools ou son alias.

Pour importer des fichiers audio dans une session, 
en utilisant l'icône de l'application Pro Tools ou 
son alias :

1  Ouvrez une session ou créez-en.

2  Depuis l'Explorateur Windows ou le Finder 
Macintosh, recherchez les fichiers audio que 
vous souhaitez importer.

Les fichiers audio doivent être au format WAV, 
SD II ou AIFF/AIFC pour pouvoir être déposés 
dans Pro Tools. 

Les fichiers audio seront convertis s'ils ne sont 
pas de résolution correcte ou s'ils n'ont pas le 
nombre correct de canaux. Ils seront convertis 
en fichiers mono en utilisant le format de fichier 
audio par défaut, avec la résolution et la 
fréquence d'échantillonnage de la session. 

3  Faites glisser les fichiers audio sur l'icône de 
l'application Pro Tools ou son alias.

Icônes des fichiers et des régions dans la boîte de 
dialogue Import Audio

Icône de fichier 
audio

Icône de région 
audio
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Importation de fichiers et de 
régions audio en les faisant 
glisser

Vous pouvez faire glisser des fichiers ou des 
régions audio à partir d'un navigateur 
DigiBase ou depuis l'Explorateur Windows ou le 
Finder Macintosh et les déposer dans la 
timeline, une piste, la liste des pistes ou la liste 
des régions.

Pour importer de l'audio dans la liste des régions :

1  Sélectionnez des fichiers dans un navigateur 
DigiBase, dans l'Explorateur Windows ou dans 
le Finder Macintosh.

2  Déposez les fichiers dans la liste des régions de 
la session actuelle. 

Pour importer de l'audio dans une piste existante :

1  Sélectionnez des fichiers audio dans un 
navigateur DigiBase ou sur le bureau. 

2  Déposez les fichiers dans une piste existante 
de la fenêtre Edit de la session actuelle. 

Pour importer de l'audio dans de nouvelles pistes :

1  Sélectionnez des fichiers audio dans un 
navigateur DigiBase, dans l'Explorateur 
Windows ou dans le Finder Macintosh. 

2  Effectuez l'une des opérations suivantes :

• Maintenant la touche Maj enfoncée tout 
en faisant glisser les fichiers et déposez-les 
dans une piste existante de la fenêtre Edit 
de la session actuelle. 

• Déposez les fichiers dans un emplacement 
vide de la fenêtre Edit de la session actuelle.

• Déposez les fichiers dans la liste des pistes.

Importation de données audio 
depuis des CD audio

Pro Tools permet d'importer des pistes depuis 
des CD audio en appliquant les mêmes 
méthodes que pour des fichiers audio :

• en faisant glisser les données audio du CD à 
partir du dossier du CD ;

• en faisant glisser des fichiers depuis le 
navigateur DigiBase ;

• en utilisant la commande Import Audio to 
Track ;

• en utilisant la commande Import Audio to 
Region List.

Le transfert s'effectuant dans le domaine 
numérique, il n'y a aucune dégradation de 
signal.

La fréquence d'échantillonnage des CD audio 
est de 44,1 kHz. C'est pourquoi, si la fréquence 
d'échantillonnage de la session est de 48 kHz ou 
plus, Pro Tools convertit celle des données 
audio importées. Avant d'importer des données 
audio d'un CD, réglez la qualité de conversion 
désirée. Pour plus d'informations, consultez la 
section Conversion Quality, page 150.

Pour obtenir des informations détaillées sur 
l'utilisation des navigateurs DigiBase, 
reportez-vous au Guide DigiBase.

En important des données audio provenant 
d'un CD à l'aide d'une méthode glisser-
déposer, vous pouvez continuer à travailler 
dans la session au premier-plan (dans la 
fenêtre Mix ou Edit, par exemple) pendant 
que le Gestionnaire de tâches (Window > 
Task Manager) se charge d'importer et de 
convertir les données audio en arrière-plan.

Pour plus d'informations sur le 
Gestionnaire de tâches, reportez-vous au 
Guide DigiBase.
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Avant d'importer des données audio d'un CD, 
assurez-vous que l'espace libre sur le disque dur 
est suffisant pour accueillir les fichiers audio 
convertis.

Pour importer des données audio d'un CD à l'aide 
du navigateur DigiBase :

1  Insérez le CD audio dans le lecteur de 
CD-ROM.

2  Choisissez Window > Workspace.

3  Dans le navigateur DigiBase, cliquez sur le CD 
et sélectionnez la piste audio. 

4  Effectuez l'une des opérations suivantes :

• Faites glisser le fichier et déposez-le dans la 
liste des régions pour l'ajouter à la session.

• Faites glisser le fichier et déposez-le sur une 
piste pour le placer dans la piste.

• Faites glisser le fichier et déposez-le dans la 
liste des pistes pour ajouter et créer une 
nouvelle piste.

Pro Tools convertit la piste audio du CD en 
fichier ayant un format, une résolution et une 
fréquence d'échantillonnage identiques à ceux 
de la session, et l'enregistre sur votre disque dur. 

Le fichier audio importé s'affiche dans la liste 
des régions. Vous pouvez ensuite faire glisser la 
région sur une piste de votre session.

Importation de pistes et de 
leurs attributs
Vous pouvez importer dans la session actuelle de 
Pro Tools des pistes entières provenant d'une 
autre session, à l'aide de la commande Import 
Session Data. Sur les systèmes Pro Tools HD, 
vous pouvez choisir les attributs pour les pistes 
que vous souhaitez importer. 

Par exemple, avec Pro Tools HD, vous pouvez 
décider d'importer uniquement les données 
audio de la piste dans votre session Pro Tools 
actuelle. Ceci revient à « modifier la bobine 
d'une cassette » dans une configuration de 
studio traditionnelle avec un lecteur à cassettes 
et une console de mixage. Vous pouvez 
également choisir d'importer tous les 
paramètres de mixage d'une piste sans en 
importer l'audio, ce qui importera une voie qui 
sera utilisée sur une piste dans la session 
actuelle. En important les paramètres de mixage 
pour toues les pistes d'une session ou d'un 
modèle de session, vous pouvez réutiliser une 
console Pro Tools sur toues les sessions d'un 
projet. 

Pour importer des pistes ou des attributs :

1  Ouvrez une session ou créez-en.

2  Choisissez File > Import > Session Data, puis 
sélectionnez la session dont vous souhaitez 
importer les données et cliquez sur Open. 

– ou –

Faites glisser le fichier de session dont vous 
souhaitez importer les pistes ou les attributs 
depuis un navigateur DigiBase et déposez-le 
dans la zone de playlist de pistes (dans la fenêtre 
Edit de la session actuelle) ou dans la liste des 
pistes.

Si la fonction de lecture automatique est 
activée, arrêtez la lecture et fermez 
l'application configurée à cet effet.
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3  Si le gain de fader (Fader Gain) des sessions 
sont fifférents, vous serez invité à garder ou 
changer le gain de fader avant que la boîte de 
dialogue Session Data ne s'ouvre.

4  Dans la section Source Tracks, sélectionnez les 
pistes à importer en cliquant sur le menu 
déroulant à droite de chaque nom de piste et en 
choisissant Import As New Track. 

5  Avec Pro Tools HD, pour chaque piste que 
vous sélectionnez, vous pouvez décider de 
l'importer en tant que nouvelle piste, ou choisir 
une piste de destination dans le menu déroulant 
correspondant. Cliquez sur Match Tracks pour 
faire correspondre automatiquement les pistes 
source aux pistes de destination ayant des noms 
identiques. 

6  Avec Pro Tools HD, sélectionnez l'une des 
options de Track Playlist pour choisir le mode 
d'importation des pistes source. 

7  Si cela est nécessaire, sélectionnez les options 
d'importation des fichiers médias depuis les 
menus déroulants Audio Media Options et 
Video Media Options. 

8  Choisissez l'option de correspondance du 
timecode à appliquer aux données importées. 

9  Si les fréquences d'échantillonnage des 
sessions sont différentes, choisissez celle de la 
session source à partir du menu déroulant 
Source Sample Rate. 

10  Sélectionnez l'option Import Tempo/Meter 
Map pour importer les pistes de métrique et de 
tempo à partir de la session source.

11  Pour importer des marqueurs et des 
emplacements mémoire à partir de la session 
source, sélectionnez l'option Import 
Marker/Memory Locations.

12  Avec Pro Tools HD, pour importer des 
groupes de mixage ou des groupes d'édition à 
partir de la session source, sélectionnez l'option 
Import Mix/Edit Groups.

13  Avec Pro Tools HD, sélectionnez l'option 
Import Mic Pre Settings pour importer tout 
paramètre de préamplificateur de micro depuis 
la session source.

14  Cliquez sur OK une fois terminé.

15  Si vous choisissez de copier ou de consolider 
un support, choisissez un emplacement pour 
placer ses fichiers.

Importation de playlists groupées 
depuis d'autres sessions

Vous pouvez importer des pistes qui utilisent 
des playlists groupées depuis une autre session 
Pro Tools ; la fonction de regroupement de 
playlist reste inchangée pour ces pistes 
importées. L'importation depuis des sessions 
antérieures à Pro Tools 6.1 est cependant 
soumise à une restriction : une fois qu'un 
ensemble partiel de playlists groupées a été 
importé (par exemple les pistes 1 à 7 d'un 
groupe de 10 pistes), vous ne pouvez pas ensuite 
importer les pistes 8 à 10 et les ajouter au groupe 
de playlists constitué des pistes 1 à 7.

Pour sélectionner plusieurs pistes, 
maintenez la touche Alt (Windows) ou 
Option (Macintosh) enfoncée et cliquez sur 
les menus déroulants des pistes, puis 
choisissez Import As New Track.

Si le système Pro Tools actuel ne prend pas 
en charge le mixage Surround, les pistes 
Surround n'apparaissent pas dans la liste 
Source Tracks.

Les pistes importées sont désactivées si leur 
support source n'est pas disponible ou si la 
session en cours ne contient pas de chemin 
de sortie équivalent.
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Boîte de dialogue Import 
Session Data

La boîte de dialogue Import Session Data permet 
d'afficher les propriétés de la session source, de 
sélectionner les pistes à importer et, avec 
Pro Tools HD, de choisir les attributs de ces 
pistes que vous souhaitez importer dans la 
session actuelle.

Propriétés de la session source

La boîte de dialogue Import Session Data affiche 
les propriétés de la session source. Ces propriétés 
comprennent le nom de la session source, le 
type de session, l'heure de début de la session, la 
résolution audio et la fréquence 
d'échantillonnage. Pour les sessions 
Pro Tools version 5.1 ou ultérieure, le 
programme dans lequel la session a été créée et 
le type de fichier audio s'affichent également.

Options Audio Media

Refer to Source Media (Where Possible) : cette 
option permet d'éviter de dupliquer les fichiers 
audio, en se référant aux fichiers d'origine 
quand cela est possible. Si les fichiers source ne 
résident pas sur un support directement pris en 
charge (tel qu'un CD-ROM) ou s'ils nécessitent 
une conversion de résolution ou de fréquence 
d'échantillonnage, ils sont quand même copiés. 
Lorsque cette option est activée, la session 
actuelle se réfère aux fichiers qui ne 
correspondent pas au format de fichier audio de 
la session actuelle. 

Copy from Source Media : cette option permet 
de copier tout les fichiers audio liés aux pistes 
importées depuis le support source vers un 
nouvel emplacement spécifique et de convertir 
les fichiers au format, à la résolution et à la 
fréquence d'échantillonnage des fichiers audio 
de la session actuelle si nécessaire. Elle est 
pratique si vous importez des pistes à partir 
d'une source telle qu'un CD-ROM ou d'un 
stockage partagé et que vous souhaitez placer les 
fichiers audio sur un disque dur différent.

Consolidate from Source Media : cette option 
permet de consolider l'audio lors de sa copie. 
Elle est pratique si vous souhaitez ne copier que 
les régions des fichiers audio utilisés dans les 
pistes source, sans copier l'audio non utilisé. 

Boîte de dialogue Import Session Data (Pro Tools HD)

Boîte de dialogue Import Session Data (Pro Tools LE)
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Cette option permet de copier et de convertir 
l'audio consolidé au format, à la résolution et à 
la fréquence d'échantillonnage des fichiers 
audio de la session actuelle si nécessaire. 

Lorsque cette option est sélectionnée, vous 
pouvez choisir la taille de la marge (en 
millisecondes) appliquée pour consolider 
l'audio. Le terme marge désigne la partie du 
fichier audio d'origine conservée avant et après 
chaque région, dans le cas où vous devriez 
modifier après coup les nouvelles régions.

Force to Target Session Format : cette option 
permet de copier et de convertir tout fichier 
dont le format, la résolution et la fréquence 
d'échantillonnage ne correspondent pas au 
fichier de la session actuelle. En revanche, les 
fichiers dont le type, la résolution et la 
fréquence d'échantillonnage correspondent au 
fichier de la session actuelle sont directement 
référencés et ne sont pas copiés.

Options Video Media

Vous pouvez choisir de laisser les fichiers médias 
vidéo dans leur emplacement d'origine ou de les 
copier vers un nouvel emplacement. Ceci est 
pratique si vous importez des pistes à partir 
d'une source telle qu'un CD-ROM ou d'un 
stockage partagé et que vous souhaitez placer les 
fichiers vidéo sur un disque différent.

Options Time Code Mapping

Vous pouvez spécifier l'emplacement des pistes 
importés dans la session actuelle. Il est exprimé 
en timecode pour Pro Tools|HD et Pro Tools LE 
avec DV Toolkit, et en minutes:secondes sur les 
autres systèmes Pro Tools LE.

Maintain Absolute Time Code Values : cette 
option place les pistes aux emplacements 
qu'elles occupaient dans la session source. Ainsi, 
si la session actuelle démarre à 00:01:00:00 et 
que la session à partir de laquelle vous importez 
démarre à 10:00:00:00, les premières pistes 
importées démarreront 9 heures et 59 minutes 
après le début de votre session.

Maintain Relative Time Code Values : cette 
option place les pistes en préservant leur 
décalage par rapport au début de la session dans 
la session source. Par exemple, si la session 
source démarre à 01:00:00:00 et contient une 
piste qui démarre à 01:01:00:00 et que la session 
actuelle démarre à 02:00:00:00, la piste est 
placée à 02:01:00:00 dans la session actuelle. 

Map Start Time Code To : cette option « force » 
les pistes à démarrer à un timecode précis, tout 
en respectant leurs positions originales. Sur les 
systèmes Pro Tools|HD ou Pro Tools LE avec DV 
Toolkit, ces informations sont exprimées en 
hh:mm:ss:ff, alors que sur les systèmes 
Pro Tools LE, elles sont exprimées en hh:mm:ss. 
En d'autres termes, si la session en cours démarre 
à 00:01:00:00 et si la session à partir de laquelle 
vous importez démarre à 10:00:00:00, vous 
pouvez réinitialiser le timecode de démarrage 
sur 00:01:00:00 pour éviter que les fichiers 
soient placés 9 heures et 59 minutes après le 
démarrage de la session.

Options Track Offset

Vous pouvez spécifier un décalage de piste en 
plus de tout décalage résultant des options Time 
Code Mapping. Tout matériel audio importé est 
décalé de la valeur spécifiée dans la graduation 
temporelle de la session actuelle. Les entrées 
peuvent être saisies en Minutes:Seconds, 
Bars|Beats, Samples, Time Code ou Feet/Frames. 
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Options Sample Rate Conversion (SRC)

Vous pouvez définir les options qui contrôlent 
la façon dont la fréquence d'échantillonnage est 
appliquée aux fichiers audio importés. Si la 
session source et la session actuelle ont la même 
fréquence d'échantillonnage, cette partie de la 
boîte de dialogue est désactivée.

Source Sample Rate : pour les fichiers audio 
créés dans n'importe quelle session, quelle que 
soit la fréquence d'échantillonnage, le processus 
de conversion de la fréquence d'échantillonnage 
peut traiter les fichiers de différentes manières 
pour compenser les modes pull-up et pull-down, 
ainsi que les fréquences d'images NTSC ou PAL. 
Ce paramètre permet également de choisir la 
fréquence d'échantillonnage à partir de laquelle 
lancer la procédure de conversion. 

Destination Sample Rate : la valeur de la 
fréquence d'échantillonnage de destination est 
toujours celle de la session actuelle.

Conversion Quality : cette option permet de 
déterminer la qualité de la procédure de 
conversion de la fréquence d'échantillonnage. 
Reportez-vous à la section Conversion Quality, 
page 150.

Zone Source Tracks

Cette zone de la boîte de dialogue répertorie les 
pistes de la session source qui peuvent être 
importées, chacune ayant un menu déroulant 
lui correspondant. 

Menus déroulants 
Operation/Destination Track

A chaque piste source correspond un menu 
déroulant qui répertorie les options 
d'importation des pistes et, sur les systèmes 
Pro Tools HD, les pistes de destination possibles 
dans la session actuelle. Les menus déroulants 
affichent les éléments suivants : 

Do Not Import : ni la piste source ni ses attributs 
ne sont importés. 

Import as New Track : la piste source et tous les 
attributs sélectionnés dans le menu Session Data 
to Import sont importés dans une nouvelle 
piste, au sein de la session actuelle. 

(Destination Track Names) (Pro Tools HD 
uniquement) : les noms des pistes de destination 
possibles dans la session actuelle sont 
répertoriés dans la partie inférieure du menu 
déroulant. Les playlists importées et tous les 
attributs sélectionnés dans Data to Import sont 
placés dans la piste de destination sélectionnée. 

Seules les pistes de destination qui 
correspondent au type de piste (audio, MIDI, 
entrée auxiliaire ou fader principal) et le format 
de canal (mono, stéréo ou tout format 
multicanal pris en charge) de la piste source 
s'affichent dans le menu déroulant. 

Option Find Matching Tracks

(Pro Tools HD uniquement)

Si vous importez des playlists depuis des pistes 
source ayant le même nom que certaines pistes 
de destination dans la session actuelle, cliquez 
sur l'option Find Matching Tracks pour faire 
correspondre automatiquement les noms de 
fichiers. Les pistes doivent avoir le même nom, 
le même format de canal et être du même type 
pour pouvoir être automatiquement mises en 
correspondance. 
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Menu Session Data to Import

(Pro Tools HD uniquement)

Le menu Session Data to Import vous permet de 
sélectionner les attributs des pistes sélectionnées 
que vous souhaitez importer dans la session 
actuelle. 

Les attributs sélectionnés sont appliqués à 
toutes les pistes que vous avez choisies 
d'importer dans la session actuelle.

Remplacement d'attributs de pistes

Lorsque vous importez un attribut de la piste 
source dans une piste existante de la session 
actuelle, celui-ci écrase l'attribut correspondant 
dans la piste de destination. Si vous choisissez de 
ne pas importer d'attribut de la piste source, 
l'attribut correspondant dans la piste de 
destination est conservé. 

Remplacement des noms des chemins de 
pistes

Lorsque vous importez une entrée, une sortie, 
une sortie de départ ou des affectations d'inserts 
matériels d'une piste, tout nom de chemin et 
configuration d'E/S personnalisé depuis la 
session source n'est pas importé. Vous pouvez 
importer des noms de chemins et des 
configurations d'E/S en important les 
paramètres I/O Setup. Pour plus d'informations, 
reportez-vous à la section Fichiers des 
paramètres d'E/S, page 103. 

Sélection d'attributs de pistes à importer

Vous pouvez sélectionnez les options All, None 
ou toute autre combinaison parmi les attributs 
répertoriés. Les attributs suivants sont 
disponibles pour l'importation :

All : importe toutes les playlists de la piste 
source, selon le paramètres Track Playlist Option 
et tous les attributs de la liste Session Data to 
Import.

None : importe uniquement la playlist 
principale de la piste source (selon le paramètre 
Track Playlist Option) et aucun autre attribut de 
la piste source. 

Alternate Playlists : importe toutes les playlists 
secondaires de la piste source. Les playlists 
secondaires s'affichent dans le menu déroulant 
de la playlist de la piste de destination. 

Regions and Media : importe tous les fichiers et 
les régions audio de la piste source et les place 
dans la liste des régions. 

Options du menu Session Data de la boîte de dialogue 
Import Session Data
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Volume Automation and Setting : importe le 
paramètre de fader du volume de la piste source 
et toute donnée d'automation dans la playlist 
Volume Automation de la piste. Le paramètre de 
fader du volume et toutes les données Volume 
automation de la piste de destination sont 
remplacées par les nouvelles données. 

Pan Automation and Setting : importe le 
paramètre Pan Slider de la piste source et toute 
donnée d'automation dans la playlist Pan 
Automation de la piste. Le paramètre Pan Slider 
et toutes les données Pan automation de la piste 
de destination sont remplacées avec les 
nouvelles données.

Mute Automation and Setting : importe le 
paramètre Mute de la piste source et toute 
donnée d'automation dans la playlist Mute 
Automation de la piste. Le paramètre Mute et 
toutes les données Mute automation de la piste 
de destination sont remplacées avec les 
nouvelles données.

Main Output Assignments : importe les 
affectations de sortie de la piste source, y 
compris les affectations de sorties multiples qui 
viennent remplacer les affectations de sorties de 
canal dans la piste de destination.

Send Output Assignments : importe les 
affectations de sorties de départs de la piste 
source, qui viennent remplacer les affectations 
de sorties de départs dans la piste de destination.

Plug-In Assignments : importe les affectations de 
plug-in de la piste source. Tout plug-in de la 
piste de destination est supprimé et les 
paramètres qui y sont associés ainsi que 
l'automation sont perdus. 

Si la piste source utilise un plug-in qui n'est pas 
disponible dans le système de destination, il 
apparaît dans la piste de destination et est 
désactivé. 

Plug-In Settings and Automation : lorsque les 
affectations de plug-in de la piste source sont 
importées, cette option importe les paramètres 
de plug-in de la piste et toute donnée 
d'automation associée aux plug-in. Si aucune 
affectation de plug-in n'est importée, cette 
option n'a aucun effet.

Hardware Insert Assignments : importe les 
affectations d'inserts matériels de la piste source. 
Ces affectations d'insert viennent remplacer les 
affectations d'inserts dans la piste de 
destination.

Voice Assignments : importe l'assignation des 
voix de la piste source depuis la session source, 
qui remplace les assignations de voix dans la 
piste de destination. 

Input Assignments : importe les affectations 
d'entrées de canal de la piste source, qui 
remplacent les assignations d'entrée dans la 
piste de destination. 

Side-Chain Assignments : lorsque les affectations 
de plug-in de la piste source sont importées, 
cette option importe toutes les affectations par 
déclenchement externe associées aux plug-in. Si 
aucune affectation de plug-in n'est importée, 
cette option n'a aucun effet.

I/O Labels (Path Names) : importe les noms de 
chemins de la piste source.

Track Active State : importe l'état actif/désactif 
de la piste source depuis la session source. 

Track Comments : importe les commentaires 
sur la piste associés à la piste source. 
Ces commentaires viennent remplacer ceux de 
la piste de destination. 
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Record Safe/solo Safe Settings : importe les 
paramètres de protection en enregistrement et 
de protection contre le solo de la piste source 
depuis la session source. Tous les paramètres de 
protection en enregistrement et de protection 
contre le solo dans la piste de destination sont 
remplacés. 

Track View Settings : importe la vue de hauteur 
d'une piste et d'une playlist de la piste source 
depuis la session source. 

Mix/Edit Groups : importe les groupes de pistes 
à partir de la piste source.

Options de playlist

(Pro Tools HD uniquement)

Vous pouvez sélectionner l'une des options 
suivantes pour contrôler la façon dont la playlist 
principale est importée sur la piste de 
destination dans la session actuelle. 

Import Main Playlists — Replacing Destination 
Main Playlists : importe la playlist principale 
depuis la piste source. Lorsque vous importez la 
playlist dans une piste existante, la playlist 
principale dans la piste de destination est 
supprimée et remplacée par la playlist importée. 

◆ Si vous sélectionnez cette option et importez 
tous les attributs de la piste source, cela revient à 
importer la piste entière. 

◆ Si vous sélectionnez cette option et que vous 
n'importez aucun attribut de la piste source, les 
playlists audio sont remplacées tant que vous 
conservez les paramètres de mixage actuels.

Import Main Playlists—Overlaying New with 
Existing, Trimming Existing Regions : importe la 
playlist principale depuis la piste source. 
Lorsque vous importez la playlist dans une piste 
existante, toutes les données de playlist 
existante qui recouvrent les données importées 
depuis la piste source sont rognées et remplacées 

par les données importées. Toutes les données 
de la playlist dans la piste de destination qui ne 
recouvrent pas d'autres données sont conservées 
dans la piste de destination. 

Do Not Import Main Playlists—Leaving 
Destination Playlists Intact : n'importe pas la 
playlist principale depuis la piste source. Aucune 
donnée audio n'est importée, seuls les attributs 
sélectionnés dans la liste Session Data to Import 
sont importés dans les pistes sélectionnées. 

◆ Sélectionner cette option et importer tous les 
attributs (entrée, sortie, départ, insert et plug-in) 
de la piste source revient à importer une voie. 

Import Tempo/Meter Map : importe les cartes de 
mesures et de tempos, tels qu'elles apparaissent 
dans les règles Chef d'Orchestre (Tempo, 
Métrique), depuis la session source. Tout 
événement de Tempo ou Métrique de la session 
de destination est remplacé. 

Importation d'emplacements mémoire et de 
marqueurs

importe les marqueurs et les emplacements 
mémoire tels qu'ils apparaissent dans la règle 
des marqueurs, à partir de la session source. 
Ceux qui figurent dans la session de destination 
sont conservés. Les numéros disponibles 
suivants sont attribués aux marqueurs et aux 
emplacements mémoire importés.

Paramètres PRE

(Pro Tools HD uniquement)

Importe tous les paramètres de préamplificateur 
de micro Pro Tools depuis la session source. 
Tous les paramètres de préamplificateur de 
micro dans la session de destination sont 
remplacés. 
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Exportation de données audio
Pro Tools prend en charge l'exportation des 
régions sous forme de fichiers audio, 
l'exportation des fichiers de données audio 
droite et gauche sous forme de fichier stéréo 
entrelacés et l'exportation des informations 
propres aux régions.

Vous pouvez également exporter des données 
audio à partir de Pro Tools en prémixant ou en 
consolidant des pistes audio. Pour plus 
d'informations, reportez-vous aux sections 
Commande de consolidation, page 419 et 
Bounce to Disk, page 683.

Exportation d'une région sous 
forme de nouveau fichier audio

Vous pouvez exporter des régions sous forme de 
fichiers audio, grâce à la commande Export 
Regions as Files. Cette commande est utile si 
vous envisagez d'utiliser une région dans 
d'autres sessions (ou dans d'autres applications 
audio) sans utiliser son fichier source parent. 

Cette commande permet également de 
convertir des régions dans un format audio, une 
fréquence d'échantillonnage ou une résolution 
différents.

Pour exporter des régions sous forme de nouveaux 
fichiers audio :

1  Dans la liste des régions, sélectionnez les 
régions que vous voulez exporter.

2  Dans le menu déroulant de la liste des régions, 
choisissez Export Regions as Files. La boîte de 
dialogue Export Selected s'affiche.

3  Dans la boîte de dialogue Export Selected, 
définissez le type de fichier, le format, la 
résolution numérique et la fréquence 
d'échantillonnage. Par ailleurs, indiquez la 
qualité de la conversion et choisissez le 
répertoire de destination.

Lorsque vous exportez des régions dans un débit 
inférieur, la fonction de dithering avec ou sans 
mise en forme du bruit (Noise Shaping) est 
appliquée comme indiqué dans le Tableau 10.

Boîte de dialogue Export Selected
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Le paramètre Dither utilisé lors d'une 
conversion est le plug-in Dither de Digidesign 
(avec ou sans le paramètre Noise Shaping 
activé), comme indiqué au Tableau 10.

4  Sélectionnez une option de résolution des 
noms de fichier en double par Pro Tools. 

Prompting for Each Duplicate : cette option vous 
invite à entrer un nom pour tout fichier portant 
le même nom qu'un fichier de votre répertoire 
de destination. 

Auto Renaming : cette option modifie 
automatiquement le nom de tout fichier 
dupliqué en lui ajoutant un nombre à la fin (tel 
que le fichier_01). 

Replacing with New Files : les fichiers ayant le 
même nom sont remplacés par les nouveaux 
fichiers.

5  Une fois la configuration des options 
d'exportation terminée, cliquez sur Export pour 
exporter les nouveaux fichiers audio.

Exportation de fichiers stéréo ou 
multicanaux entrelacés

La commande Export Regions as Files permet 
d'exporter des régions audio sous forme de 
fichiers stéréo ou multicanaux entrelacés, 
utilisables dans d'autres applications. Pro Tools 
n'est pas capable d'utiliser directement des 
fichiers entrelacés dans la timeline. Il faut 
d'abord les convertir en fichiers multimono. 
Par exemple, dans le cas d'un fichier stéréo, les 
régions sélectionnées doivent posséder des 
noms identiques, munis des suffixes « .L » et 
« .R » (par exemple voix_01.L et voix_01.R). 
Ces régions apparaissent sous forme d'une 
région stéréo dans la liste des régions.

Pro Tools HD permet également de prémixer des 
fichiers multicanaux entrelacés pour chaque 
type de fichier reconnu. 

Pour exporter des régions sous forme de fichier 
stéréo ou multicanal entrelacé :

1  Sélectionnez la région audio stéréo ou 
multicanal dans la liste des régions ou dans la 
playlist de la piste. Si les régions apparaissent sur 
des pistes mono de la session, sélectionnez les 
deux régions mono.

2  Dans le menu déroulant de la liste des régions, 
choisissez Export Regions as Files.

3  Dans la boîte de dialogue Export Selected, 
sélectionnez « Stereo Interleaved » dans le menu 
déroulant Format. Dans le cas de régions 
multicanaux, l'option Stereo Interleaved 
produit un fichier multicanal entrelacé.

4  Une fois la configuration de toutes les options 
d'exportation terminée, cliquez sur Export pour 
exporter le nouveau fichier stéréo entrelacé.

Tableau 10. Options Dither et Noise Shaping avec la 
boîte de dialogue Export Selected

Débit Dither
Noise 
Shaping

24 bits vers 
24 bits

Non Non

16 bits vers 
24 bits

Non Non

24 bits vers 
16 bits

Oui Oui

16 bits vers 
16 bits

Non Non

24 bits vers 8 bits Oui Non

16 bits vers 8 bits Oui Non

Pour en savoir plus sur le dithering, 
reportez-vous à la section Dithering, 
page 606.
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Exportation des définitions 
des régions

Pro Tools enregistre les définitions des régions 
des fichiers audio au sein de chaque session. 
Si vous souhaitez utiliser les régions d'un fichier 
audio dans une autre session, ou avec une autre 
application qui les prend en charge, vous 
pouvez exporter les informations des régions. 

La commande Export Region Definitions 
n'exporte pas les régions sous forme de fichiers 
audio (contrairement à la commande Export 
Regions as Files). En revanche, elle mémorise des 
pointeurs vers les régions au sein du fichier 
source parent.

Pour exporter les définitions des régions d'un 
fichier audio :

1  Dans la liste des régions, sélectionnez les 
régions ou les groupes de régions pour lesquels 
vous voulez exporter les définitions. Il n'est pas 
nécessaire de sélectionner la région audio du 
fichier parent.

2  Choisissez Export Region Definitions dans le 
menu déroulant de la liste des régions.

3  Cliquez sur Export.

Exportation de pistes 
Pro Tools en tant que 
séquences OMFI ou AAF
Lorsque l'option DigiTranslator Integrated 
(DigiTranslator 2.0 ou ultérieur) est 
sélectionnée, Pro Tools permet d'exporter des 
pistes individuelles au format OMFI ou AAF. 
Utilisez la commande Export Selected Tracks as 
OMF/AAF.

Exportation de sessions en 
tant que texte
(Pro Tools HD uniquement)

La commande Export Session Info as Text 
permet de créer un fichier texte contenant des 
informations complètes concernant votre 
session. 

Ce fichier texte contient la liste des fichiers 
audio, des régions audio, l'EDL de la piste audio, 
des informations détaillées de marquage 
temporel et des informations concernant les 
crossfades.

Les listes EDL des pistes sont exportées sous 
forme de texte délimité par des tabulations, 
c'est-à-dire contenant des tabulations entre 
chaque en-tête de colonne et des tabulations 
entre chaque paramètre d'événement. Vous 

Si vous avez l'intention de transférer des 
données de session Pro Tools vers une autre 
session, vous devez exporter les définitions 
des régions pour les sessions contenant 
plusieurs prises créées avec Loop Record.

Pro Tools avec DigiTranslator ne prend pas 
en charge les fichiers AAF avec des médias 
intégrés.

Pour plus d'informations sur l'installation, 
l'utilisation ou la désinstallation de 
DigiTranslator avec Pro Tools, reportez-
vous au guide DigiTranslator. 
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pouvez utiliser ces données dans un programme 
permettant de lire des listes EDL, ou formater ces 
données EDL sous forme de tableaux en 
utilisant un traitement de texte ou un tableur.

Options de la boîte de dialogue 
Export Session Text

Include File List/Region List

Cette option permet d'exporter une liste des 
fichiers audio et des régions de la session. La liste 
File répertorie tous les fichiers audio et les fades 
de la session, ainsi que leur emplacement sur le 
disque dur. La liste des régions affiche toutes les 
régions audio de la session, ainsi que le fichier 
audio source de chaque région.

Include Track EDLs (Playlists)

Cette option permet d'exporter les listes EDL des 
pistes (playlists). Ces listes peuvent servir à 
vérifier avec précision le placement des régions 
et des modifications, ou être utilisées par un 
programme de conformation pour des 
applications de post-production. Dans des 
circonstances extrêmes, l'EDL peut permettre de 
recréer une session entière.

Lors de l'exportation des listes EDL des pistes, les 
options suivantes sont disponibles.

Show Subframes : cette option d'affichage des 
sous-trames permet d'exporter des informations 
temporelles de subframes (subdivisions 
d'images) avec les listes EDL des pistes, si elles 
sont utilisées dans votre session.

Include User Timestamps : vous pouvez inclure 
des marquages temporels définis par l'utilisateur 
avec les listes EDL des pistes. Ces marquages 
temporels indiquent un emplacement défini par 
l'utilisateur de la session pour la région ou 
l'emplacement d'origine de la région lors de son 
enregistrement.

Fade Handling : pour les listes EDL des pistes, 
vous pouvez choisir d'afficher les crossfades 
(Show Crossfades), de ne pas les afficher (Don't 
Show Crossfades) ou de combiner les régions en 
crossfade (Combine Crossfaded Regions). 
Lorsque des régions sont combinées, leurs durée 
et emplacement sont calculés jusqu'au centre du 
crossfade (pour la première région) et à partir du 
centre du crossfade (pour la région qui suit).

Boîte de dialogue Export Session Text

Les listes EDL des pistes MIDI ne sont pas 
exportées.
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Time Format : vous pouvez sélectionner le 
format temporel approprié sur lequel sont 
basées les informations des listes EDL. 
En post-production, par exemple, vous choisirez 
un timecode SMPTE, mais en musique où la 
référence est généralement la grille rythmique, 
vous préférerez sans doute un format temporel 
en mesures et temps (Bars & Beats). 

Format de fichier

Vous pouvez choisir d'exporter dans l'un des 
formats de texte proposés. Ils incluent des 
formats de texte standard, ainsi que les formats 
Microsoft Word et Excel. 

Boîte de dialogue Export 
Session Text

Informations sur la session

Le fichier texte de la session débute avec des 
informations de base relatives à la session. 
Ces informations incluent le nom de la session, 
la fréquence d'échantillonnage, la résolution, le 
format temporel, le nombre de pistes audio, de 
régions audio et de fichiers audio de la session, 
comme dans l'exemple ci-dessous.

Liste des fichiers et liste des régions

Ensuite, si vous choisissez de les inclure, 
apparaissent les listes des fichiers audio et des 
régions.

Liste EDL de la piste

L'élément final, s'il est exporté, est la liste EDL 
de la piste. Une liste EDL indique le nom de la 
piste, et tous les points de montage, avec le 
numéro de l'événement, le nom de la région, les 
heures de début et de fin de la région, ainsi que 
la durée de la région. Le marquage temporel de 
la région est également exporté, si vous 
choisissez cette option. Les subframes sont 
affichées dans chaque champ de temps si vous 
sélectionnez cette option.

Pour exporter une session sous forme de texte :

1  Choisissez File > Export > Session Info as Text.

2  Choisissez d'inclure la liste File, Region et les 
listes EDL de la piste.

3  Si vous choisissez d'inclure les listes EDL de la 
piste, sélectionnez si vous voulez faire apparaître 
les subframes et s'il faut inclure des marquages 
temporels définis par l'utilisateur. Sélectionnez 
également une option de gestion de crossfade.

4  Si vous choisissez d'inclure les listes EDL de la 
piste, sélectionnez le format temporel du texte 
de la session exportée dans le menu déroulant.

5  Sélectionnez dans le menu déroulant le 
format de fichier du texte exporté.

6  Lorsque vous avez défini ces options, cliquez 
sur OK. 

7  Sélectionnez un emplacement et entrez un 
nom de fichier pour le fichier texte exporté. 
Dans Windows, Pro Tools ajoute la bonne 
extension de 3 lettres, tandis que sur le 
Macintosh, c'est l'extension « .txt » qui est 
ajoutée.

Exemple d'informations d'une session

NOM DE LA SESSION : Ripleys II-092700

FREQUENCE 
D'ECHANTILLONNAGE :

48000.000000

RESOLUTION : 24 bits

FORMAT TEMPOREL : 30 images/seconde

NOMBRE DE PISTES 
AUDIO :

19

NOMBRE DE REGIONS 
AUDIO :

203

NOMBRE DE FICHIERS 
AUDIO :

54
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Envoi de fichiers via 
DigiDelivery
DigiDelivery est le système conçu par Digidesign 
pour transférer en toute sécurité et de façon 
efficace les fichiers médias numériques via 
Internet. La commande Send via DigiDelivery 
vous permet d'envoyer une session Pro Tools et 
tous les fichiers associés au moyen de 
DigiDelivery, directement à partir de Pro Tools.

Toute personne est libre d'envoyer et de recevoir 
des fichiers à partir d'un système DigiDelivery, 
même si elle ne possède pas de serveur réseau 
DigiDelivery.

◆ Pour effectuer un transfert, l'expéditeur doit 
disposer d'une connexion Internet, d'un compte 
sur un serveur réseau DigiDelivery et de 
l'application client DigiDelivery. 

◆ Pour recevoir les fichiers, les destinataires ont 
besoin uniquement d'une connexion Internet et 
de l'application client DigiDelivery. Il n'est utile 
de disposer d'un compte sur le serveur réseau.

Pour envoyer une session à partir de Pro Tools à 
l'aide de DigiDelivery :

1  Choisissez File > Send via DigiDelivery.

2  Si le client DigiDelivery n'est pas installé sur 
votre système, Pro Tools lance votre navigateur 
Web et se connecte au site DigiDelivery pour 
que vous puissiez télécharger le client 
DigiDelivery actuel.

– ou –

Si le client DigiDelivery est installé sur votre 
système, la boîte de dialogue Send to 
DigiDelivery s'affiche.

3  Sélectionnez les fichiers à inclure dans la boîte 
de dialogue Send to DigiDelivery.

Voici les différents choix possibles :

• Fichiers audio

• Fichiers de fondu

• Fichiers vidéo

• Fichiers de paramètres de plug-in

• Fichier de timeline uniquement (fichiers 
référencés dans la timeline de session 
actuelle)

4  Cliquez sur OK. Cela a pour effet de lancer le 
client DigiDelivery et d'ouvrir l'assistant 
DigiDelivery Send (Page 1). C'est à partir de cette 
page que vous donnez un nom à votre livraison 
et ajoutez ou retirez des fichiers.

5  Complétez les autres pages de l'assistant 
DigiDelivery Send et envoyez le fichier, en 
suivant les instructions fournies avec le logiciel 
client DigiDelivery.

Importation de fichiers MIDI
Vous pouvez importer des fichiers MIDI 
standard (SMF) dans vos sessions Pro Tools. 
Utilisez la commande Import MIDI to Track 
pour placer les données MIDI importées dans de 
nouvelles pistes ou la commande Import MIDI 
to Region List pour placer les données dans la 
liste des régions, d'où vous pouvez les faire 
glisser sur des pistes existantes.

Pour plus d'informations, reportez-vous au 
Guide DigiDelivery ou au site Web de 
DigiDelivery 
(www.digidesign.com/digidelivery).

Boîte de dialogue Include in Delivery
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Pro Tools n'importe pas les fichiers de séquence 
externes. Pour utiliser des séquences provenant 
d'autres applications MIDI dans une session 
Pro Tools, vous devrez d'abord les enregistrer 
sous forme de fichiers MIDI standard (SMF). 
Consultez la documentation du logiciel de 
séquence pour plus de détails sur 
l'enregistrement de fichiers MIDI standard.

Il existe deux types de fichiers MIDI standard, 
tous deux pris en charge par Pro Tools :

◆ Les fichiers MIDI de type 0 enregistrent les 
données de tous les canaux MIDI sur une seule 
piste. Lors de l'importation de ces fichiers, 
Pro Tools trie et sépare les données par canal et 
place les informations de chaque piste dans des 
régions et des pistes distinctes.

◆ Les fichiers MIDI de type 1, parfois nommés 
fichiers MIDI multipistes, comportent plusieurs 
pistes de données MIDI. Lorsque vous importez 
ces fichiers, les données de chaque piste sont 
placées dans leur propre piste MIDI de la session 
Pro Tools.

Pour importer un fichier MIDI standard vers de 
nouvelles pistes :

1  Effectuez l'une des opérations suivantes :

• Choisissez File > Import > MIDI to Track et 
sélectionnez le fichier MIDI que vous 
souhaitez importer.

– ou –

• Faites glisser un fichier MIDI à partir d'un 
navigateur DigiBase ou depuis 
l'Explorateur Windows ou le Finder 
Macintosh et déposez-le dans la liste des 
pistes, dans la timeline ou sur une piste 
existante.

2  Dans la boîte de dialogue MIDI Input Settings, 
configurez les paramètres d'importation MIDI 
comme bon vous semble.

Import Location : sélectionnez Session Start ou 
Song Start. Cette option est disponible à 
condition que le marqueur de début de morceau 
ne se trouve pas en début de session 
(échantillon zéro). La séquence MIDI importée 
commencera à l'heure de début de la session ou 
de début du morceau, selon le cas.

Import Tempo Map From MIDI File : activez cette 
option pour remplacer toute table de tempos 
existante par les données de tempo lues à partir 
du fichier MIDI. 

Remove Existing Instrument Tracks : activez 
cette option pour supprimer les pistes 
Instrument existantes. Cela n'a aucun effet sur 
les pistes MIDI actuelles. Toutes les régions MIDI 
existantes seront conservées dans le chutier des 
régions.

Remove Existing MIDI Tracks : activez cette 
option pour supprimer les pistes MIDI 
existantes. Cela n'a aucun effet sur les pistes 
Instrument actuelles. Toutes les régions MIDI 
existantes seront conservées dans le chutier des 
régions.

Boîte de dialogue Import MIDI Settings
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Remove Existing MIDI Regions : activez cette 
option pour supprimer les régions MIDI 
existantes (c'est-à-dire toutes les données 
figurant sur l'ensemble des pistes MIDI et 
Instrument), mais laisser les pistes MIDI et 
Instrument en place. 

3  Cliquez sur OK.

Le fichier MIDI sera importé conformément aux 
paramètres choisis dans la boîte de dialogue 
Import MIDI Settings.

4  Dans la fenêtre Mix, cliquez sur le sélecteur de 
sortie MIDI pour chaque nouvelle piste et 
affectez un instrument MIDI et un canal.

Pour importer un fichier MIDI standard dans la 
liste des régions, effectuez l'une des opérations 
suivantes :

■ Choisissez File > Import > MIDI to Region List 
et sélectionnez le fichier MIDI que vous 
souhaitez importer.

– ou –

■ Faites glisser un fichier MIDI à partir d'un 
navigateur DigiBase ou depuis l'Explorateur 
Windows ou le Finder Macintosh et déposez-le 
dans la liste des régions.

Exportation de fichiers MIDI
Pour exporter les pistes MIDI d'une session afin 
de les utiliser dans une autre application MIDI, 
ou les lire avec un séquenceur MIDI externe 
(matériel), vous pouvez exporter les pistes 
Pro Tools MIDI et Instrument sous forme de 
fichier MIDI standard. 

Les données MIDI peuvent être exportées depuis 
Pro Tools sous forme d'une piste unique 
multicanal fusionnée (Type 0) ou de plusieurs 
pistes (Type 1).

Pour exporter toutes les pistes MIDI et Instrument 
de la session en cours :

1  Veillez à désactiver la coupure des pistes MIDI 
de la session que vous voulez inclure dans le 
fichier MIDI exporté. Ou inversement, coupez le 
son des pistes MIDI que vous ne désirez pas 
inclure dans le fichier MIDI exporté. Dans le cas 
des pistes Instrument, activez ou désactivez le 
bouton de coupure MIDI (vue Instruments).

2  Choisissez > Export > MIDI. La boîte de 
dialogue Export MIDI Settings s'affiche.

3  Dans le menu déroulant MIDI File Format, 
sélectionnez 1 (plusieurs pistes) ou 0 (une seule 
piste).

4  Si l'heure de début du morceau est différente 
de l'heure de début de la session, choisissez 
Session Start ou Song Start dans le menu 
déroulant Location Reference.

Si le fichier MIDI standard contient des 
marqueurs, ceux-ci ne sont importés que si 
la session en cours ne contient aucun 
marqueur.

Boîte de dialogue Export MIDI Settings
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5  Activez ou désactivez l'option Apply Real-
Time Properties, selon ce qui convient.

6  Cliquez sur OK. Cela a pour effet d'afficher 
une boîte de dialogue d'enregistrement.

7  Choisissez la destination du fichier MIDI et 
donnez-lui un nom.

8  Cliquez sur Save. 

Pro Tools exporte toutes les pistes MIDI et 
Instrument non coupées de la session en cours 
sous forme de fichier MIDI standard et l'écrit sur 
votre disque dur. Les informations MIDI 
exportées incluent les notes, les événements du 
contrôleur, les changements du programme, les 
données System Exclusive, ainsi que les 
événements concernant le tempo, la mesure et 
les marqueurs.

L'heure de début SMPTE pour la session ou le 
morceau (selon la sélection effectuée dans le 
menu déroulant Location Reference) est 
également exportée. Ainsi, les pistes exportées, 
lorsqu'elles sont lues à partir d'une autre 
application MIDI, démarrent au même code 
SMPTE, et sont donc synchrones avec les sons 
enregistrés sur bande ou les images provenant 
de magnétoscope externe, ou encore à 
Pro Tools.

Consultez la documentation de votre 
séquenceur MIDI pour savoir s'il prend en 
charge l'importation des points de début SMPTE 
à partir des fichiers MIDI.

Non exporté avec les fichiers MIDI

Les coupures (Mute) d'automation et de régions 
n'ont pas d'incidence sur les données MIDI 
exportées. Tant qu'une piste MIDI n'est pas 
coupée en cliquant sur son bouton Mute ou 

qu'une piste Instrument n'est pas coupée en 
cliquant sur son bouton MIDI Mute (vue 
Instruments), toutes ses données MIDI sont 
exportées.

Lors de l'exportation de fichiers MIDI à partir de 
Pro Tools, l'assignation des périphériques aux 
pistes n'est pas conservée (même si l'affectation 
des canaux est maintenue). Par conséquent, si 
vous exportez des pistes MIDI ou Instrument à 
partir de Pro Tools et que vous les réimportez 
plus tard, vous devrez réassigner les pistes aux 
périphériques de votre studio.

Toutes les informations de playlist des pistes 
MIDI et Instrument sont perdues lors de 
l'exportation. Par exemple, les pistes qui 
contenaient préalablement des douzaines de 
régions MIDI seront « mises à plat » et ne 
contiendront qu'une seule région après 
exportation et réimportation.

Importation et exportation de 
fichiers de groupe de régions
Pro Tools est capable d'exporter et d'importer le 
nouveau format de fichier de groupe de régions 
(.rgrp). Cela vous permet d'effectuer les 
opérations suivantes :

• séparer les métadonnées des groupes de 
régions des fichiers audio pour éviter les 
opérations de copie de fichiers inutiles lors 
de l'exportation de groupes de régions 
audio composés de plusieurs fichiers 
source ;

• exporter des données MID en tant que 
groupe de régions ;

• créer des boucles multipistes.
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Les fichiers de groupe de régions stockent les 
métadonnées suivantes :

• références à tous les fichiers audio au sein 
du groupe de régions ;

• noms des régions et emplacements relatifs 
dans les pistes ;

• fades et crossfades ;

• noms des groupes de régions et format 
(monopiste ou multipiste) ;

• toutes les données MIDI présentes dans le 
groupe de régions (notes, contrôleurs et 
Sysex, par exemple) ;

• noms des pistes.

Les fichiers de groupe de régions ne contiennent 
pas les données suivantes :

• audio ;

• automation ;

• plug-in ;

• assignation des pistes ;

• table des tempos et mesures ;

• informations sur la liste des régions.

Pour exporter un groupe de régions :

1  Sélectionnez un ou plusieurs groupes de 
régions dans la liste des régions.

2  Dans le menu déroulant de la liste des régions, 
choisissez Export Region Groups. La boîte de 
dialogue Export Region Groups s'affiche.

3  Le répertoire de destination correspond par 
défaut au dossier Region Groups créé 
automatiquement dans le dossier de la session. 
Vous pouvez en changer en cliquant sur le 
bouton Choose, en accédant à l'emplacement 
désiré, puis en cliquant sur Choose. Pour rétablir 
le répertoire de destination par défaut, cliquez 
sur Reset.

4  Activez l'une des options suivantes pour 
résoudre les noms de fichiers de groupe de 
régions en double :

• Prompting for Each Duplicate (option par 
défaut)

• Auto Renaming

• Replacing with New Files

5  Cliquez sur OK. 

Pour importer un groupe de régions :

1  Choisissez File > Import > Region Groups.

2  Accédez au groupe de régions que vous désirez 
importer et sélectionnez-le. 

3  Cliquez sur Import.

– ou –

Faites glisser le fichier de groupe de régions à 
partir d'un navigateur DigiBase ou depuis 
l'Explorateur Windows ou le Finder Macintosh 
et déposez-le dans la timeline, sur une piste, 
dans la liste des pistes ou dans la liste des 
régions.

Boîte de dialogue Export Region Groups
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Le fait de déposer un groupe de régions a des 
conséquences différentes selon la destination 
choisie :

• Lorsque vous déposez un groupe de régions 
sur une piste, Pro Tools recherche un format 
de piste correspondant, vérifie le nombre de 
canaux et (dans le cas de groupes de régions 
multipistes) s'assure qu'il y a suffisamment de 
pistes adjacentes correspondantes pour 
importer le fichier de groupe de régions. Si ces 
conditions sont remplies, le groupe de régions 
est importé et placé à l'endroit choisi dans la 
ou les pistes.

• Lorsque vous déposez un groupe de régions 
dans la timeline ou dans la liste des régions, le 
programme crée de nouvelles pistes pour le 
groupe de régions importé. 

• Lorsque vous déposez un groupe de régions 
dans la liste des régions, le programme y 
ajoute un nouveau groupe de régions. Toutes 
les régions audio et MIDI et même les autres 
groupes de régions contenus dans le groupe 
de régions déposé apparaissent également 
dans la liste des régions. 

Exportation de groupes de régions vers un 
autre disque dur

En règle générale, si vous exportez des groupes 
de régions vers un autre disque dur, il est 
recommandé de copier tous les fichiers audio 
éventuellement référencés. Vous pourrez ainsi 
transférer des groupes de régions non seulement 
d'une session à une autre, mais aussi d'un 
système à un autre.

Pour exporter un groupe de régions vers un autre 
disque dur en prenant en compte ses fichiers 
audio :

1  Exportez un ou plusieurs groupes de régions 
vers le disque dur de votre choix.

2  Créez une session sur le nouveau disque dur et 
activez l'option Automatically Copy Files on 
Import.

3  Importez tous les groupes de régions 
précédemment exportés. 

Le dossier des fichiers audio de la nouvelle 
session contient à présent tous les fichiers 
référencés par les groupes de régions.
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Chapitre 10 : Gestion des fichiers et 
des sessions et compatibilité

Lors de l'utilisation de Pro Tools, vous allez 
rencontrer plusieurs types de fichiers 
informatiques. Pour que les systèmes Pro Tools 
fonctionnent correctement, certains fichiers 
doivent être conservés dans des emplacements 
spécifiques du disque dur.

◆ Les fichiers logiciels Pro Tools doivent être 
placés dans votre lecteur de démarrage (celui qui 
contient le système d'exploitation et autres 
fichiers système).

◆ Sur les systèmes Pro Tools|HD, les fichiers de 
données (fichiers de session, fichiers audio et 
fichiers de fondus) peuvent se trouver sur tout 
disque compatible relié au bus SCSI interne ou 
externe de l'ordinateur, ou à une carte 
d'adaptateur de bus hôte SCSI de l'ordinateur. 
Pour optimiser les performances des systèmes 
Pro Tools|HD, il est recommandé d'utiliser des 
pilotes SCSI. Les pilotes FireWire et ATA/IDE 
sont également pris en charge. Consultez le site 
Web de Digidesign pour obtenir des 
informations supplémentaires 
(www.digidesign.com/compato).

◆ Sur les systèmes Pro Tools LE, les fichiers de 
données peuvent se trouver sur n'importe quel 
disque compatible connecté aux bus internes ou 
externes, ATA/IDE, FireWire ou SCSI, de votre 
ordinateur.

Gestion des fichiers audio

Identifications uniques de fichiers

Pro Tools  attribue un identificateur unique à 
chaque fichier audio d'une session, il peut ainsi 
retrouver un fichier dont le nom ou 
l'emplacement a été modifié.

Recherche des fichiers audio

Pro Tools travaille en fait avec des renvois à des 
fichiers audio et média via la fenêtre Relink. 
Par ailleurs, Pro Tools classe les volumes de 
stockage en fonction de leurs capacités en 
matière de performances (d'enregistrement ou de 
lecture) ou de transfert (stockage ou copie) des 
fichiers audio et autres fichiers médias. 

Bien que Pro Tools autorise 
l'enregistrement sur votre disque dur 
système, ceci est généralement déconseillé. 
Vous ne devez enregistrer sur des lecteurs 
système qu'en cas de besoin : par exemple, 
si votre ordinateur ne comporte qu'un seul 
disque dur ou si vos autres lecteurs sont déjà 
saturés.
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Les fichiers audio doivent être placés sur des 
volumes Performance appropriés et comprendre 
des renvois valides pouvant être lus dans une 
session Pro Tools.

Lors de l'ouverture d'une session, si Pro Tools 
signale que des fichiers audio sont absents d'un 
volume Performance, ou si le système ne 
parvient pas à localiser les fichiers audio 
contenus dans la session, vous pouvez localiser 
et copier les fichiers afin de lire la session. 
Ce processus est appelé rétablissement des liens. 

Fichiers de transfert :

Les fichiers de transfert résident sur des volumes 
non destinés à la lecture, tel qu'un CD-ROM et 
des lecteurs en réseau.

Pour ouvrir une session comprenant des fichiers 
de transfert :

1  Ouvrez la session de Pro Tools. Si certains 
fichiers se trouvent sur un volume non destiné à 
la lecture, Pro Tools envoie un avertissement.

2  Effectuez l'une des opérations suivantes :

• Cliquez sur Yes pour ouvrir la boîte de 
dialogue Copy and Relink

– ou –

• Cliquez sur No pour ouvrir la session en 
conservant les fichiers de transfert hors 
ligne. 

Pour que les fichiers de transfert puissent être 
joués dans la session actuelle :

1  Choisissez Window > Project.

2  Cliquez deux fois sur le dossier Audio Files 
pour afficher tous les fichiers audio.

3  Choisissez Select Transfer Files dans le menu 
du navigateur. 

4  Choisissez Copy and Relink dans le menu du 
navigateur. 

5  Choisissez une destination sur un volume 
Performance valide où copier les fichiers.

6  Cliquez sur OK. 

Fichiers manquants

Si un fichier ne se trouve plus à l'endroit où il 
résidait lors du dernier enregistrement de la 
session, ce fichier est considéré comme étant 
manquant. 

Pour ouvrir une session ProTools avec des fichiers 
manquants :

1  Ouvrez la session de Pro Tools. Si des fichiers 
sont manquants, Pro Tools envoie un 
avertissement pour vous en informer 
(avertissement Missing Files).

2  Choisissez l'une des options suivantes :

Skip All : ignore tous les fichiers manquants de 
fondus. Les fichiers manquants seront mis hors 
ligne dans la session.

Voyez le Guide DigiBase pour en savoir plus 
sur la gestion des volumes et des données. 

Voyez le Guide DigiBase pour en savoir plus 
sur l'établissement de liens avec des fichiers 
de transfert. 

Avertissement concernant les fichiers manquants à 
l'ouverture d'une session
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Manually Find and Relink : ouvre la fenêtre 
Relink, dans laquelle vous pouvez rechercher, 
comparer, vérifier et relier des fichiers 
manquants.

Automatically Find and Relink : lance une 
recherche dans tous les volumes Performance 
pour localiser tous les fichiers dont le nom, l'ID 
de fichier unique, le format et la longueur 
correspondent aux fichiers manquants et les 
associe aux fichiers manquants si possible. 

3  Pour exclure les fichiers de fondus du 
processus de rétablissement de liens, et les 
recalculer, sélectionnez l'option Regenerate 
Missing Fades.

4  Cliquez sur OK. 

Renamed Audio Files

Ce dossier inclut les fichiers qui ont été 
renommés. Vous pouvez renommer les fichiers 
lorsque vous ouvrez une session faisant 
référence à des noms de fichier audio contenant 
des caractères incompatibles. Il est possible de le 
faire également dans certaines situations, 
notamment lors de l'enregistrement de la copie 
d'une session d'une version Pro Tools qui ne 
gère pas les noms de fichier longs.

Ouverture d'une session contenant des noms 
de fichier audio avec des caractères interdits

Pro Tools 7.0 ne prend pas en charge les noms 
de fichier audio composés de certains caractères 
ASCII (tels que * et @).

Lorsque les noms des fichiers audio utilisés dans 
les sessions ouvertes contiennent de tels 
caractères, Pro Tools crée automatiquement une 
copie renommée de chaque fichier concerné (en 

remplaçant les caractères interdits par un trait 
de soulignement « _ »). Les fichiers renommés 
sont placés dans le dossier Renamed Audio Files. 
Les fichiers originaux restent inchangés dans le 
dossier Audio Files.

Avant que la session ne s'ouvre, vous êtes invité 
à enregistrer un rapport détaillé des fichiers 
renommés et de leurs noms d'origine dans un 
fichiet texte de notes. Suivez les instructions à 
l'écran. Par défaut, le fichier de notes est 
sauvegardé dans le dossier Session.

Enregistrement d'une copie d'une session 
contenant des noms de fichier audio longs

Lors de l'enregistrement de fichiers dans 
Pro Tools 6.9.x ou une version antérieure (à 
l'aide de la commande Save Copy In), les fichiers 
audio dont le nom dépasse la limite du format 
de destination sont tronqués et placés dans le 
dossier Session, conformément aux règles 
suivantes :

• Si la nouvelle session est enregistrée dans le 
même répertoire que le répertoire d'origine, 
un dossier Renamed Audio Files est créé dans 
le répertoire d'origine de la session pour les 
fichiers audio renommés.

Reportez-vous au Guide DigiBase pour en 
savoir plus sur l'établissement de liens avec 
des fichiers manquants.

Il est possible, cependant, de travailler dans 
une session Pro Tools 7.0 comprenant des 
fichiers audio avec des noms interdits. 
Dans ce cas, si vous utilisez la commande 
Save Session Copy In dans Pro Tools 6.9.x 
ou une version antérieure en laissant 
l'option Enforce Mac/PC Compatibility 
activée, les pistes seront renommées avec 
des caractères autorisés. En revanche, si 
vous choisissez la commande Save Session 
Copy In dans Pro Tools 6.9.x ou une 
version antérieure en désactivant l'option 
Enforce Mac/PC Compatibility, les 
caractères restent inchangés.
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• Si la nouvelle session est enregistrée dans un 
un répertoire différent du répertoire d'origine 
et que l'option All Audio Files n'est pas cochée, 
un nouveau dossier Session (composé d'un 
sous-dossier Audio Files et d'un sous-dossier 
Renamed Audio Files) est créé. Les fichiers 
audio renommés seront alors placés dans le 
sous-dossier Audio Files.

• Si la nouvelle session est enregistrée dans un 
un répertoire différent du répertoire d'origine 
et que l'option All Audio Files est cochée, un 
nouveau dossier Session (composé d'un sous-
dossier Audio Files) est créé. Les fichiers audio 
renommés seront alors placés dans le sous-
dossier Audio Files.

Compatibilité avec les 
fichiers WAV
Conversion de fichiers WAV importés au format 
AES31/BroadcastWave

Pro Tools crée toujours des fichiers BWF (WAV) 
compatibles AES31/Broadcast lorsqu'ils 
proviennent de Pro Tools. Cette option crée des 
fichiers WAV importés compatibles avec la 
norme AES31/EBU Broadcast.

AES31/Broadcast Wave est une variante du type 
de fichier audio standard WAV. Le format AES31 
contient des marquages temporels SMPTE et 
d'autres informations complémentaires aux 
données PCM audio brutes. 

Cette variante est conforme aux normes définies 
par l'EBU (European Broadcasters Union), et 
l'AES (Audio Engineering Society). Choisissez 
cette option pour garantir la compatibilité avec 
d'autres stations de travail reconnaissant ce type 
de fichier. 

Cette option crée des fichiers WAV importés 
compatibles avec la norme AES31/EBU 
Broadcast :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation.

2  Sélectionnez l'option Convert imported 
« wav » files to AES31/BroadcastWave, puis 
cliquez sur Done.

Partage des sessions créées 
sur différentes plates-formes

Transfert des sessions de type 
Windows vers des systèmes 
Macintosh

Plusieurs étapes sont nécessaires pour transférer 
des fichiers de session à partir de disques NTFS 
de type Windows vers des disques HFS+ de type 
Macintosh.

Pour transférer des sessions Pro Tools Windows 
depuis des disques NTFS vers des disques HFS+ :

1  Configurez les options MacDrive 6 en mode 
de sauvegarde/transfert de fichiers (Backup/File 
Transfer).

2  Effectuez l'une des opérations suivantes :

• Faites glisser le dossier de session du disque 
NTFS vers le disque HFS+.

– ou –

• Ouvrez la session Windows sur le disque 
NTFS, choisissez Save Copy In, puis 
enregistrez une copie de la session sur le 
disque HFS+.

Les systèmes Macintosh sont capables de 
lire (mais pas d'écrire) des sessions situées 
sur des disques durs Windows formatés 
FAT32.
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Transfert des sessions de type 
Macintosh vers des systèmes 
Windows

Plusieurs étapes sont nécessaires pour transférer 
des fichiers à partir de disques HFS+ de type 
Macintosh vers des disques NTFS de type 
Windows.

Vous avez besoin de l'utilitaire MacDrive 6 pour 
monter des disques HFS+ sur un système NTFS.

Pour transférer des sessions Pro Tools Macintosh 
depuis des disques HFS+ vers des disques NTFS :

1  Configurez les options MacDrive 6 en mode 
d'utilisation normal (Normal Use).

2  Effectuez l'une des opérations suivantes :

• Faites glisser le dossier de session du disque 
HFS+ vers le disque NTFS.

– ou –

• Ouvrez la session Macintosh sur le disque 
HFS+ et, lorsque vous y êtes invité, 
choisissez Save Copy In et enregistrez une 
copie de la session sur le disque NTFS. 

Pour enregistrer (ou créer) des sessions 
Macintosh destinées à être utilisées sur des 
systèmes Windows, reportez-vous à la 
section Enregistrement de copies de 
sessions Macintosh compatibles avec 
Windows, page 178.

Boîte de dialogue Save Copy In

Lors du transfert de sessions Pro Tools 
depuis des disques HFS+ vers des disques 
NTFS, les sessions Pro Tools ne sont pas 
capables de rétablir les liens avec les fichiers 
audio et de fondu dont les noms sont 
composés de caractères Macintosh interdits 
dans Windows. Ces caractères seront 
automatiquement convertis en traits de 
soulignement (« _ »). Les fichiers en 
question seront placés dans le dossier 
Renamed Audio Files. Il vous faudra 
rétablir manuellement les liens de chaque 
fichier par ID de fichier (File ID). Voir 
Fichiers manquants, page 174.

Pour enregistrer une session ne comportant 
aucun caractère interdit, reportez-vous à la 
section Enregistrement de copies de 
sessions Macintosh compatibles avec 
Windows, page 178.
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Si la session utilisait précédemment des fichiers 
SD II, ceux-ci sont convertis au nouveau format 
de fichier audio.

Enregistrement de copies de sessions 
Macintosh compatibles avec Windows

(Commande Save Copy In dans Pro Tools 6.9.x 
et les versions antérieures uniquement)

Les sessions créées et enregistrées dans 
Pro Tools 7.0 sont toujours compatibles sur des 
systèmes Windows et Macintosh.

Si vous créez une session dans Pro Tools 6.9.x 
(ou une version antérieure) sur un système 
Macintosh, la session sera compatible sur les 
systèmes Windows à condition d'avoir activé 
l'option Enforce Mac/PC Compatibility lors de 
la sélection de la commande Save Copy In. Il 
faut également prendre en compte certaines 
limites multi plate-formes.

Limites des sessions multi plates-
formes

Lorsque vous enregistrez (ou créez) une copie 
d'une session Pro Tools destinée à être 
compatible à la fois sur Macintosh et sous 
Windows, tenez compte des limites suivantes et 
de la façon dont elles sont gérées dans 
Pro Tools :

Types de fichiers audio

Le format de fichier recommandé pour une 
parfaite interopérabilité entre les plate-formes 
est le format BWF (.WAV). Pour favoriser les 
échanges de sessions, Pro Tools adopte par 
défaut le format BWF pour les nouvelles 
sessions.

Pro Tools propose différents formats de fichier 
pour l'enregistrement, le prémixage et 
l'exportation. Si vous essayez de créer une 
session et d'utiliser le format SD II, une boîte de 
dialogue d'avertissement vous rappelle les 
limitations qui s'y appliquent :

• les sessions SD II ne sont pas prises en 
charge sous Windows XP ;

• la fréquence d'échantillonnage maximale 
autorisée pour des fichiers SD II est de 
48 kHz.

Extensions des noms de fichiers

Pour assurer la compatibilité multi plates-
formes, tous les fichiers d'une session doivent se 
terminer par une extension de trois lettres. Les 
fichiers de session Pro Tools version 5.1 à 6.9.x 
portent l'extension « .pts » et les fichiers de 
session Pro Tools 5 portent l'extension « .pt5 ». 
Les fichiers WAV portent l'extension « .wav » et 
les fichiers AIFF portent l'extension « .aif ».

Caractères ASCII incompatibles

Les noms des régions, des pistes et des fichiers et 
les paramètres de plug-in ne peuvent pas 
contenir de caractères ASCII incompatibles avec 
l'un ou l'autre des systèmes. 

Lorsque vous importez des fichiers dans une 
session, les caractères incompatibles sont 
convertis en traits de soulignement (« _ ») et les 
fichiers renommés sont placés dans le dossier 
Renamed Files.

Les caractères suivants sont interdits dans des 
sessions Windows :

/ (barre oblique)

\ (barre oblique inverse)

: (deux points)

* (astérisque)
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? (point d'interrogation)

« (guillemets)

< (symbole inférieur à)

> (symbole supérieur à)

| (ligne verticale)

Tout caractère tapé avec la touche Command

Enregistrement de sessions multi 
plates-formes

Pour sauvegarder une session existante dans 
Pro Tools 6.9.x ou une version antérieure et 
garantir la compatibilité Macintosh et Windows :

1  Choisissez File > Save Copy In.

2  Dans la boîte de dialogue Save Copy In, 
sélectionnez une destination et entrez le nom 
du fichier de la nouvelle session.

3  Sélectionnez AIFF, BWF (WAV) comme option 
Audio File Type. Ces formats de fichiers sont 
compatibles avec les deux plates-formes.

4  Définissez la résolution et la fréquence 
d'échantillonnage de la session.

5  Sélectionnez l'option Enforce Mac/PC 
Compatibility. Cette option doit être 
sélectionnée pour que votre session soit 
compatible sur les deux plates-formes.

6  Sélectionnez les éléments à copier vers la 
nouvelle session.

7  Cliquez sur Save. 

Si la session utilisait précédemment des fichiers 
SD II, ceux-ci sont convertis au nouveau format 
de fichier audio.

Partage de sessions créées 
sur des systèmes Pro Tools 
différents
(Pro Tools|HD, Pro Tools LE et 
Pro Tools M-Powered)

Pro Tools facilite le partage de sessions entre les 
systèmes Pro Tools|HD et les systèmes 
Pro Tools LE ou M-Powered. Il existe entre les 
trois types de systèmes des différences 
importantes qui peuvent avoir une incidence 
sur le transfert des informations d'une session.

Pro Tools permet de convertir un fichier créé 
sur Macintosh (et enregistré sans l'option 
« Enforce Mac/PC compatibility ») en 
fichier compatible Windows. Pour plus 
d'informations, reportez-vous à la section 
Partage des sessions créées sur différentes 
plates-formes, page 176.

Différences entre les systèmes Pro Tools

Fonction
Systèmes 
Pro Tools|HD

Systèmes 
Pro Tools LE ou 
M-Powered

Nombre 
maximal de 
pistes audio

jusqu'à 256 jusqu'à 128 
(32 pouvant 
héberger des 
voix)

Nombre 
maximal de 
pistes 
d'instrument

128 32
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Ouverture d'une session Pro Tools HD 
dans Pro Tools LE ou M-Powered

Lorsque vous ouvrez une session Pro Tools HD 
dans Pro Tools LE ou M-Powered, les règles 
suivantes s'appliquent :

Systèmes Pro Tools LE ou M-Powered 7.0 :

• Toutes les pistes au-delà des 32 premières 
pistes, ainsi que les pistes inactives, sont 
définies sur voice off.

• Toute affectation à des bus au-delà de 32 est 
inactive.

• Les pistes d'instrument au-delà de la 
piste 32 sont désactivées.

• Les plug-in TDM ayant des équivalents 
RTAS sont convertis ; les autres sont 
désactivés.

• Les pistes multicanaux surround sont 
supprimées de la session.

• Les départs au-delà des cinq premiers sont 
supprimés.

• Les chemins d'entrée et de sortie non 
disponibles deviennent inactifs.

• Systèmes Pro Tools LE 6.x et ultérieurs 
(Windows ou Macintosh) ou systèmes 
Pro Tools 5.3.1 et ultérieurs (Windows) :

• Toutes les pistes au-delà des 32 premières 
pistes, ainsi que les pistes inactives, sont 
définies sur voice off.

• Les pistes multicanaux surround sont 
supprimées de la session.

• Toute affectation à des bus au-delà de 16 est 
inactive, sauf pour Pro Tools 7.0 lequel gère 
jusqu'à 32 bus.

• Les départs au-delà des cinq premiers sont 
ignorés.

• Les chemins d'entrée et de sortie non 
disponibles deviennent inactifs.

• Les plug-in TDM ayant des équivalents 
RTAS sont conservés ; les autres sont 
désactivés. 

• Systèmes Pro Tools LE 5.3.x ou antérieurs 
(Macintosh) ou systèmes Pro Tools LE 5.1.x 
ou antérieurs (Windows) :

• Toutes les pistes au-delà des 24 premières 
pistes, ainsi que les pistes inactives, sont 
supprimées de la session.

• Les pistes multicanaux surround sont 
supprimées de la session.

• Toute affectation à des bus au-delà de 16 est 
inactive.

Nombre 
maximal de 
bus de 
mixage

128 bus 
(Pro Tools 6.9 
et versions 
ultérieures)

64 bus 
(Pro Tools 
6.7.x et 
versions 
antérieures)

32 bus 
(Pro Tools 7.0)

16 bus 
(Pro Tools 6.9.x 
et versions 
antérieures)

Inserts par 
piste

jusqu'à 5 jusqu'à 5

Départs par 
piste

jusqu'à 10
(Pro Tools 7.0)

jusqu'à 5 
(Pro Tools 
6.9.x et 
versions 
antérieures)

jusqu'à 10 
(Pro Tools 7.0)

jusqu'à 5 
(Pro Tools 6.9.x 
et versions 
antérieures)

Pour plus d'information sur le transfert de 
sessions entre Windows et Macintosh, 
consultez la section Partage des sessions 
créées sur différentes plates-formes, 
page 176.

Différences entre les systèmes Pro Tools

Fonction
Systèmes 
Pro Tools|HD

Systèmes 
Pro Tools LE ou 
M-Powered
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• Les chemins d'entrée et de sortie non 
disponibles deviennent inactifs.

• Les plug-in TDM ayant des équivalents 
RTAS sont conservés ; les autres sont 
désactivés. 

Partage de sessions créées 
sur des versions logicielles 
de Pro Tools différentes
Il est impossible de lire une session au format 
Pro Tools 7.0 dans des versions Pro Tools 6.9.x 
ou antérieures. Pour enregistrer une session 
Pro Tools 7.0 compatible avec des versions 
antérieures de Pro Tools, utilisez la commande 
File > Save Copy In pour sélectionner le format 
de session de destination. Enregistrement d'une 
copie de la session, page 64.

Voici ce qui se produit lors de l'enregistrement 
d'une session au format Pro Tools 5.1 > 6.9 :

• Les niveaux de gain de fader et les points 
d'inflexion d'automation supérieurs à +6 dB 
passent à +6 dB.

• Les noms longs sont abrégés à 31 caractères.

• Les pistes d'instrument sont divisées en pistes 
d'entrée auxiliaire et pistes MIDI distinctes.

• Les attributs suivants sont abandonnés.

• Groupes de régions

• Répétitions des régions

• Régions MIDI basées sur les échantillons

• Pistes MIDI basées sur les échantillons

• Départs F–J et toutes les données 
d'automation associées

• Emplacements marqueur/mémoire 201 
à 999

• Bus 17 à 32 (Pro Tools LE et Pro Tools 
M-Powered)

Voici ce qui se produit lors de l'enregistrement 
d'une session au format Pro Tools 5.0 :

• Les noms longs sont abrégés à 31 caractères.

• Les pistes d'instrument sont divisées en pistes 
d'entrée auxiliaire et pistes MIDI distinctes.

• Les attributs suivants sont abandonnés.

• Groupes de régions

• Répétitions des régions

• Régions MIDI basées sur les échantillons

• Pistes MIDI basées sur les échantillons

• Départs F–J et toutes les données 
d'automation associées

• Emplacements marqueur/mémoire 201 
à 999

• Bus 17 à 32 (Pro Tools LE et Pro Tools M-
Powered)

• Instances de plug-in multimono

• Pistes multicanaux (Pro Tools HD 
uniquement)

• Départs affectés à des chemins 
multicanaux ou à des sous-chemins de 
chemins multicanaux

• Les pistes affectées à aucune sortie (No 
Output) sont acheminées vers les bus 31 et 32.

• Les pistes/départs affectés aux bus 33 à 64 
sont acheminés vers les bus 31 et 32.

• Les pistes affectées à des chemins multicanaux 
ou à des sous-chemins de chemins 
multicanaux sont acheminées vers les bus 31 
et 32.

• Les pistes/départs affectés aux chemins stéréo 
faisant référence à des canaux pairs/impairs 
(2-3, par exemple) sont acheminés vers les 
bus 31 et 32.
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Prise en charge des 
applications multilingues 
pour les systèmes 
Pro Tools|HD
(SE localisé sur Mac OS X uniquement)

Il est possible à présent d'ouvrir une version 
anglaise et localisée de Pro Tools (Pro Tools 
Coréen, Chinois simplifié ou Japonais) sur un 
Macintosh agréé par Digidesign capable 
d'exécuter les versions anglaise et localisées de 
Mac OS X. Une seule version localisée de 
Pro Tools peut être ouverte à la fois.

Pour changer de version localisée Pro Tools :

1  Fermez d'abord Pro Tools.

2  Lancez Préférences Système (menu Pomme).

3  Cliquez deux fois sur International (icône 
représentant un drapeau).

4  Cliquez sur l'onglet Langue si la page Langue 
n'est pas la page actuelle.

5  Dans la colonne Langues, cliquez sur la langue 
que vous souhaitez afficher et faites glisser la 
langue vers le haut de la liste.

6  Fermez la fenêtre International.

7  Effectuez l'une des opérations suivantes :

• Si vous passez d'une version localisée à la 
version anglaise, lancez Pro Tools.

– ou –

• Si vous passez d'une version localisée à une 
autre (ou de l'anglais à une version 
localisée), fermez puis ouvrez la session à 
partir du menu Pomme, puis lancez 
Pro Tools.

Si vous souhaitez réafficher la langue 
précédemment sélectionnée au démarrage 
de l'ordinateur (après avoir travaillé dans 
une autre version localisée), suivez les 
étapes ci-dessus et rétablissez la langue 
précédente comme préférence 
internationale.
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Chapitre 11 : Configuration de 
l'enregistrement

Avant d'enregistrer, vérifiez que votre système 
Pro Tools est correctement connecté et 
configuré. Pour plus d'informations concernant 
la connexion de Pro Tools à votre studio, 
consultez le Guide de démarrage fourni avec votre 
système. 

Certaines informations de ce chapitre 
concernent l'enregistrement MIDI, mais vous 
trouverez davantage de précisions sur ce sujet 
dans le Chapitre 13, Enregistrement MIDI.

Connexions d'entrée et 
niveaux audio
La plupart des interfaces audio Pro Tools|HD 
fonctionnent comme des périphériques de 
niveau ligne et n'offrent pas de pré-
amplification. Les sources de faible niveau 
(micros, guitares électriques) doivent être pré-
amplifiées. Pour cela, il vous faut une console de 
mixage haut de gamme ou un préampli dédié, 
comme le Digidesign PRE.

Digi 002 et Digi 002 Rack sont dotés de quatre 
entrées pré-amplifiées auxquelles vous pouvez 
connecter des signaux de faible niveau et de 
quatre entrées supplémentaires avec gain 
commutable. 

Mbox 2 et Mbox sont dotés de deux entrées pré-
amplifiées auxquelles vous pouvez connecter 
des signaux de faible niveau.

Pour plus d'informations sur les unités M-Audio 
agréées Digidesign, reportez-vous à la 
documentation de l'interface M-Audio.

Le Digidesign PRE peut être utilisé comme 
pré-ampli autonome avec tous les systèmes 
Pro Tools ou contrôlé à distance lors d'une 
session Pro Tools sur un système 
Pro Tools|HD.
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Quel que soit le système, les commandes de 
volume et de panoramique des pistes dans 
Pro Tools modifient uniquement les niveaux 
d'écoute, sans affecter le gain d'entrée des 
niveaux d'enregistrement. Les vumètres à DEL 
des interfaces audio Digidesign indiquent aussi 
bien l'utilisation de la pleine échelle numérique 
(niveau le plus élevé avant écrêtage) que 
l'écrêtage réel des signaux de sortie de Pro Tools. 
Les vumètres à l'écran de l'application Pro Tools 
n'indiquent que l'écrêtage réel.

Ecrêtage numérique

L'écrêtage se produit lorsqu'un enregistreur ou 
une console de mixage reçoit un signal 
supérieur à la limite autorisée par l'appareil. 
Sur de nombreux magnétophones analogiques, 
un léger écrêtage ajoute une chaleur perceptible 
au son, du fait de la compression magnétique 
sur la bande. Dans le cas d'un enregistrement 
numérique, en revanche, l'écrêtage provoque 
une distorsion numérique indésirable qui doit 
être impérativement évitée. 

Réglage des niveaux d'entrée 
suffisamment haut tout en évitant 
l'écrêtage

Lorsque vous envoyez un signal vers n'importe 
quel système d'enregistrement audio, Pro Tools 
compris, vérifiez le niveau d'entrée afin 
d'optimiser la plage dynamique et le rapport 
signal-bruit du fichier enregistré. Si le niveau 
d'entrée est trop faible, vous ne bénéficierez pas 
pleinement de la plage dynamique de votre 
système Pro Tools. Si le niveau d'entrée est trop 
élevé, le signal sera écrêté et provoquera des 
distorsions dans l'enregistrement. 

Veillez à définir des niveaux légèrement 
supérieurs à 6 dB (cette valeur s'affiche dans le 
vumètre d'entrée) sans déclencher l'indicateur 
d'écrêtage de l'interface audio.

Mode Calibration

(Pro Tools HD uniquement)

Le mode Calibration de Pro Tools permet de 
régler les niveaux d'entrée et de sortie des 
interfaces audio de manière à ce qu'ils 
correspondent à ceux de votre console de 
mixage et des autres périphériques de votre 
studio.

L'interface d'E/S 192 est équipée de deux séries 
de potentiomètres de rognage en entrée et deux 
séries de potentiomètres de rognage en sortie. 
De plus, le niveau de référence de l'entrée peut 
être réglé sur +4 dBu ou sur -10 dBV. L'interface 
d'E/S 888|24 est équipée de potentiomètres de 
rognage en entrée et en sortie, contrairement

aux interfaces audio suivantes : 192 Digital I/O, 
96 I/O, 96i I/O, 882|20 I/O, 1622 I/O et ADAT 
Bridge I/O 24 bits. Certaines interfaces d'E/S de 
Digidesign non équipées de potentiomètres de 
rognage en sortie (par exemple, E/S 96i I/O) 
fournissent des commandes logicielles de 
réglage des niveaux d'entrée. Pour les modifier, 
sélectionnez Setup > Hardware (pour plus 
d'informations relatives à votre interface d'E/S, 
reportez-vous au guide correspondant).

Pour en savoir plus sur le calibrage de votre 
interface audio ou sur l'utilisation du mode 
Calibration, reportez-vous au Guide 
192 I/O (ou aux instructions d'utilisation 
du mode de calibrage incluses dans les 
livraisons antérieures de l'interface 
192 I/O) ou au Guide 888|24 I/O.
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Activation des pistes à 
l'enregistrement
Pour enregistrer une piste, vous devez d'abord la 
préparer à l'enregistrement à l'aide du bouton 
Record Enable. Pour enregistrer simultanément 
plusieurs pistes, vous pouvez préparer à 
l'enregistrement plusieurs pistes de type audio, 
instrument ou MIDI. 

Une fois que vous avez préparé une ou plusieurs 
pistes à l'enregistrement, il suffit de cliquer sur 
les boutons Record et Play dans la fenêtre 
Transport pour lancer l'enregistrement.

Pour préparer une piste audio, MIDI ou une piste 
d'instrument à l'enregistrement :

■ Depuis la fenêtre Mix ou Edit, cliquez sur le 
bouton Record Enable de la piste pour activer ou 
désactiver le mode de préparation à 
l'enregistrement de la piste. Le bouton est 
allumé lorsqu'il est activé et le fader de la piste 
apparaît en surbrillance dans la fenêtre Mix.

Pour préparer plusieurs pistes audio à 
l'enregistrement :

■ Depuis la fenêtre Mix ou Edit, cliquez sur le 
bouton Record Enable de la piste pour activer ou 
désactiver le mode de préparation à 
l'enregistrement de chaque piste.

Seules les pistes MIDI et les pistes 
d'instrument peuvent être préparées à 
l'enregistrement pendant la lecture ou 
l'enregistrement. Pour préparer les pistes 
audio à l'enregistrement, vous devez arrêter 
les commandes de transport ou encore 
activer le mode d'enregistrement 
TrackPunch ou QuickPunch. Pour plus 
d'informations sur le mode TrackPunch, 
consultez Enregistrement audio 
TrackPunch, page 255. Pour plus 
d'informations sur le mode QuickPunch, 
consultez Enregistrement audio 
QuickPunch, page 251.

Piste audio préparée à l'enregistrement dans les 
fenêtres Mix et Edit

Si le mode Latch Record n'est pas activé, 
appuyez sur la touche Maj tout en cliquant 
sur le bouton Record Enable de la piste pour 
activer ou désactiver le mode de préparation 
à l'enregistrement de chaque piste. Pour 
plus d'informations, reportez-vous à la 
section Préférence Latch Record Enable 
Buttons, page 189.

Fenêtre Edit

Fenêtre Mix
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Pour préparer plusieurs pistes MIDI ou pistes 
d'instrument à l'enregistrement :

■ Depuis la fenêtre Mix ou Edit, appuyez sur la 
touche Maj tout en cliquant sur le bouton 
Record Enable de la piste pour activer ou 
désactiver le mode de préparation à 
l'enregistrement de chaque piste.

Pour préparer les pistes MIDI ou les pistes 
d'instrument à l'enregistrement à l'aide des 
touches fléchées Haut/Bas :

■ Pour préparer la piste MIDI ou la piste 
d'instrument précédente ou suivante à 
l'enregistrement, maintenez enfoncée la touche 
Ctrl (Windows) ou Pomme (Macintosh), 
pendant que vous appuyez sur les flèches 
Haut/Bas. La piste précédente (ou suivante) 
quitte le mode de préparation à 
l'enregistrement.

Pour préparer toutes les pistes audio ou MIDI ou 
les pistes d'instrument à l'enregistrement :

■ Pour activer ou désactiver la préparation de 
toutes les pistes audio, MIDI ou les pistes 
d'instrument à l'enregistrement, maintenez 
enfoncée la touche Alt (Windows) ou Option 
(Macintosh) pendant que vous cliquez sur le 
bouton Record Enable. 

Pour l'activation de la préparation des pistes, 
Pro Tools traite de la même manière les pistes 
MIDI et les pistes d'instrument. Par conséquent, 
maintenir les touches Alt (Windows) ou Option 
(Macintosh) enfoncées tout en cliquant sur le 

bouton Record Enable d'une piste MIDI ou 
d'une piste d'instrument prépare l'ensemble des 
pistes MIDI et des pistes d'instrument à 
l'enregistrement.

Pour préparer toutes les pistes audio, MIDI ou les 
pistes d'instrument sélectionnées à 
l'enregistrement :

■ Pour activer ou désactiver la préparation de 
toutes les pistes audio, MIDI ou les pistes 
d'instrument sélectionnées à l'enregistrement, 
maintenez enfoncées les touches Alt + Maj 
(Windows) ou Option + Maj (Macintosh) 
pendant que vous cliquez sur le bouton Record 
Enable.

Pour conserver ce mode sur la piste 
précédente tout en préparant de nouvelles 
pistes, appuyez sur les touches 
Maj + Ctrl + flèche Haut/Bas (Windows) 
ou Maj + Pomme + flèche Haut/Bas 
(Macintosh).

La préparation à l'enregistrement n'a pas 
d'incidence sur des pistes audio groupées, 
mais vous pouvez sélectionner toutes les 
pistes d'un groupe ; il suffit de cliquer 
directement à gauche du nom de la piste 
dans la liste du groupe. Pour préparer 
ensuite toutes les pistes sélectionnées à 
l'enregistrement, maintenez enfoncées les 
touches Maj + Option (Macintosh) ou 
Maj + Alt (Windows) pendant que vous 
cliquez sur le bouton Record Enable d'une 
piste.
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Préférence Latch Record Enable 
Buttons

Lorsque la préférence Latch Record Enable 
Buttons est sélectionnée, vous pouvez préparer 
des pistes supplémentaires à l'enregistrement en 
cliquant sur les boutons Record Enable qui leur 
correspondent. Les pistes précédemment 
préparées le demeurent. La préférence Latch 
Record Enable Buttons ne concerne que les 
pistes audio.

Lorsque l'option Latch Record Enable Buttons 
n'est pas sélectionnée, la préparation d'une 
nouvelle piste à l'enregistrement désactive la 
préparation à l'enregistrement de la piste audio 
précédente.

Pour activer la préférence Latch Record Enable 
Buttons :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation.

2  Sélectionnez l'option Latch Record Enable 
Buttons.

Mode de protection contre 
l'enregistrement

Le mode Record Safe de Pro Tools permet 
d'interdire individuellement la préparation de 
plusieurs pistes à l'enregistrement. Utilisez le 
mode de protection contre l'enregistrement 
pour protéger les pistes importantes.

Pour protéger une piste audio ou MIDI contre 
l'enregistrement :

■ Maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Macintosh) pendant que vous 
cliquez sur le bouton Record Enable 
correspondant à la piste. Ce bouton apparaît 
alors en grisé.

Pour désactiver la protection contre 
l'enregistrement de la piste, maintenez enfoncée 
la touche Ctrl (Windows) ou Pomme 
(Macintosh) pendant que vous cliquez sur le 
bouton Record Enable.

Pour protéger toutes les pistes contre 
l'enregistrement :

■ Maintenez enfoncées les touches Ctrl + Alt 
(Windows) ou Pomme + Option (Macintosh) 
pendant que vous cliquez sur le bouton Record 
Enable des pistes.

Pour sortir toutes les pistes du mode de 
protection contre l'enregistrement, maintenez 
les touches Ctrl + Alt (Windows) enfoncées ou 
Pomme + Option (Macintosh) pendant que 
vous cliquez à nouveau sur ce bouton.

Pour protéger toutes les pistes sélectionnées 
contre l'enregistrement :

■ Pour activer/désactiver la protection contre 
l'enregistrement des pistes, maintenez 
enfoncées les touches Ctrl + Alt + Maj 
(Windows) ou Pomme + Option + Maj 
(Macintosh) pendant que vous cliquez sur le 
bouton Record Enable de n'importe quelle piste 
sélectionnée.
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Modes d'écoute en 
enregistrement
Pro Tools propose deux modes d'écoute des 
signaux d'entrée : Auto Input et Input Only. 
Ces modes déterminent de quelle manière les 
signaux d'entrée sont écoutés au cours de la 
lecture, de l'enregistrement ou lorsque le 
transport est arrêté.

Mode d'écoute Auto Input

En mode Auto Input, dès que la lecture de la 
session s'arrête, Pro Tools bascule sur l'écoute 
des signaux d'entrée audio. Lorsque la lecture est 
lancée en vue d'une entrée d'enregistrement à la 
volée (punch-in), Pro Tools lit les données déjà 
enregistrées sur la piste jusqu'au point d'entrée. 
En mode réenregistrement, vous écoutez le 
signal d'entrée. A la fin du réenregistrement, Pro 
Tools lit de nouveau les données enregistrées sur 
la piste. Cette fonction est semblable au mode 
Auto Input (commutation automatique 
lecture/entrées) des magnétophones multipistes 
numériques ou analogiques.

Mode d'écoute Input Only

En mode Input Only, dès qu'une piste est 
préparée à l'enregistrement, Pro Tools ne permet 
d'écouter que l'entrée audio, quelle que soit la 
sélection en enregistrement effectuée ou l'état.

Dans Pro Tools LE, l'indicateur d'état Input 
Monitor Enabled (dans la fenêtre Transport) de 
couleur verte indique que le mode Input Only 
est activé.

Dans Pro Tools HD, l'indicateur s'affiche en vert 
lorsque la fonction TrackInput est activée pour 
une ou plusieurs pistes.

Sélection du mode d'écoute de 
l'enregistrement dans 
Pro Tools LE

Pour que les pistes activées en enregistrement 
utilisent le mode d'écoute Auto Input :

■ Sélectionnez Track > Auto Input Monitoring.

Pour que les pistes activées en enregistrement 
utilisent le mode d'écoute Input Only :

■ Sélectionnez Tracks > Input Only Monitoring.

Lorsque vous utilisez le mode Auto Input, le 
retour à l'écoute des données de la piste à la 
fin du réenregistrement n'est pas 
instantané.

Avec Pro Tools HD, les pistes sont réglées 
sur Auto Input par défaut et un contrôle 
d'écoute (bouton TrackInput) est proposé 
pour chaque piste. Pour plus 
d'informations, reportez-vous à la section 
Sélection du mode d'écoute de 
l'enregistrement avec la fonction 
TrackInput, page 191.

Fenêtre Transport

Pour passer du mode d'écoute Auto Input 
au mode Input Only et inversement, 
appuyez sur les touches Alt+K (Windows) 
ou Option+K (Macintosh).

Indicateur d'état Input Monitor Enabled
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Sélection du mode d'écoute de 
l'enregistrement avec la fonction 
TrackInput
(Pro Tools HD uniquement)

La fonction TrackInput permet à tout moment 
d'activer et de désactiver les modes d'écoute 
Auto Input au mode Input Only pour chaque 
piste audio, y compris pendant la lecture, 
l'enregistrement ou l'arrêt et ce, même si une 
piste n'est pas préparée à l'enregistrement. 
La fonction TrackInput offre la souplesse 
d'écoute qu'exigent le doublage et 
l'enregistrement fractionné, et est similaire à la 
commutation d'entrée des enregistreurs 
multipistes numériques ou appareils de 
même type.

Lorsque le bouton TrackInput d'une piste est 
activé (vert), la piste gère les données audio en 
mode Input Only. 

Lorsque le bouton TrackInput d'une piste est 
désactivé, la piste est en mode Auto Input.

Pour définir le mode d'écoute de pistes audio, 
effectuez l'une des opérations suivantes :

■ Cliquez sur le bouton TrackInput Monitor de 
chaque piste concernée.

■ Tout en maintenant la touche Alt (Windows) 
ou Option (Macintosh) enfoncée, cliquez sur un 
bouton TrackInput Monitor.

■ Tout en maintenant les touches Alt-Maj 
(Windows) ou Option-Maj (Macintosh) 
enfoncées, cliquez sur le bouton TrackInput 
Monitor d'une piste sélectionnée.

Pour activer/désactiver le bouton TrackInput de 
toutes les pistes activées pour l'enregistrement, 
effectuez l'une des opérations suivantes :

■ Pour activer le mode d'écoute Auto Input, 
sélectionnez Track > Set Record Tracks to Auto 
Input.

■ Pour activer le mode d'écoute Input Only, 
sélectionnez Track > Set Record Tracks to Input 
Only.

Préférence Disable « Input » When 
Disarming Track

Lorsque cette préférence de fonctionnement est 
sélectionnée, le mode d'écoute TrackInput est 
désactivé dès que le bouton Enable d'une piste 
est désélectionné. Ceci s'avère particulièrement 
utile pour certaines procédures, telles que 
l'enregistrement d'une série de pistes, une par 
une.

La désactivation de cette option a pour effet de 
laisser les boutons TrackInput activés lorsque le 
bouton Record Enable de la piste est désactivé.

Boutons d'écoute TrackInput dans la fenêtre Edit

Bouton TrackInput

Bouton TrackInput

 Fonction désactivée (Auto Input)

Fonction activée (Input Only)

Pour permuter les pistes activées à 
l'enregistrement entre les modes Auto 
Input et Input Only, appuyez sur les 
touches Alt+K (Windows) ou Option+K 
(Macintosh).
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Niveaux d'écoute en 
enregistrement et en lecture
Pro Tools mémorise deux niveaux de fader 
différents pour l'écoute de chaque piste audio : 
l'un est utilisé lorsque la piste est préparée à 
l'enregistrement, l'autre lorsqu'elle ne l'est pas. 

Pro Tools mémorise automatiquement ces deux 
valeurs de niveaux de fader. Si vous réglez un 
fader lorsqu'une piste est préparée à 
l'enregistrement et que vous désactivez la 
préparation à l'enregistrement, le fader reprend 
son niveau de lecture.

Lorsque des pistes audio sont préparées à 
l'enregistrement, leurs faders de volume 
deviennent rouges dans la fenêtre Mix pour 
indiquer que le niveau d'écoute de 
l'enregistrement est actif.

Option Link Record and Play Faders

Lorsque l'option Link Record and Play Faders est 
sélectionnée dans les préférences de 
fonctionnement, Pro Tools ne mémorise pas les 
différents niveaux d'écoute en enregistrement et 
en lecture des pistes audio. Dans ce cas, le fait de 
préparer une piste audio à l'enregistrement n'a 
aucun effet sur le niveau du fader de la piste. 
Vous pouvez ainsi conserver un mixage 
cohérent, que ce soit pendant l'enregistrement 
ou la lecture.

Latence d'écoute
(Pro Tools LE)

Pro Tools LE utilisant le processeur hôte de votre 
ordinateur pour le traitement, la lecture et 
l'enregistrement des données audio, le signal 
audio subit un léger retard, ou latence, lors de 
son parcours dans le système. La valeur de cette 
latence est liée à la taille du buffer matériel : plus 
la capacité du buffer est volumineuse, plus la 
latence sera importante.

Sur les systèmes Pro Tools LE, vous pouvez 
réduire le temps de latence d'écoute en 
diminuant la taille du buffer de l'appareil. Il est 
toutefois impossible d'éliminer complètement 
la latence, même pour une taille de buffer 
réduite au minimum. De plus, le fait de réduire 
la taille du buffer limite le nombre de pistes 
audio que vous pouvez enregistrer 
simultanément sans risque d'erreur.

Dans certaines circonstances, une taille de 
buffer plus importante peut s'avérer nécessaire, 
par exemple pour obtenir un plus grand nombre 
de pistes avec davantage de plug-in ; mais en 
général une taille de buffer inférieure est 
souhaitable lors de l'enregistrement d'audio que 
vous écoutez via Pro Tools LE.

Si vous écoutez la source enregistrée via une 
console de mixage externe avant que les 
données soient acheminées vers Pro Tools, vous 
n'entendrez aucune latence.
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Pour régler la taille du buffer matériel :

1  Sélectionnez Setup > Playback Engine.

2  Dans la liste déroulante H/W Buffer Size, 
choisissez le nombre d'échantillons.

3  Cliquez sur OK.

Ecoute avec une latence zéro
(Mbox 2 et Mbox uniquement)

Mbox 2 et Mbox permettent de contrôler les 
signaux d'entrée analogique lors de 
l'enregistrement, en éliminant la latence. Cette 
écoute analogique à latence zéro est contrôlée 
par le bouton Mix du panneau avant du 
dispositif, que vous pouvez utiliser pour 
mélanger et régler l'entrée analogique entre 
l'interface et la lecture Pro Tools. Pour plus 
d'informations, reportez-vous au Guide Notions 
de base ou au Guide de démarrage.

Ecoute à faible latence
(Digi 002 et Digi 002 Rack uniquement)

Les systèmes Digi 002 et Digi 002 Rack peuvent 
utiliser l'option Low Latency Monitoring pour 
enregistrer avec une latence d'écoute 
extrêmement réduite, sur autant de pistes que 
chaque système peut gérer.

Pour activer l'écoute à faible latence :

1  Préparez les pistes audio à l'enregistrement en 
cliquant sur les boutons Record Enable. Seules 
les pistes dont les entrées sont assignées à une 
interface audio (et non à un bus) autorisent 
l'écoute à faible latence.

2  Dans le sélecteur de chemin de sortie, assignez 
chaque piste à Output 1 ou Output 2. Seules les 
pistes assignées à ces sorties bénéficient de 
l'écoute à faible latence.

3  Sélectionnez Options > Low Latency 
Monitoring. 

Lorsque le contrôle à faible latence est activé, les 
plug-in et les départs affectés aux pistes activées 
pour l'enregistrement (acheminés vers les sorties 
1–2) sont automatiquement désactivés et 
doivent le rester. De plus, ces pistes 
n'apparaissent pas sur les vumètres des faders 
principaux.

Ecoute à faible latence et 
prémixage sur disque

Lorsque l'option Low Latency Monitoring est 
activée, seules les pistes audio sont incluses via 
la commande Bounce To Disk (prémixage sur 
disque). Les pistes d'entrées et d'instrument 
auxiliaires sont ignorées. Pour inclure les pistes 
d'entrées et d'instrument auxiliaires, désactivez 
l'option Low Latency Monitoring avant de 
choisir la commande Bounce to Disk. 

Les ordinateurs dotés de processeurs plus 
lents ne pourront peut-être pas utiliser une 
taille de buffer de 128 sans entraîner des 
erreurs de fonctionnement.

L'entrée externe ne peut pas être enregistrée 
au cours du prémixage sur disque. Pour 
inclure l'entrée externe dans votre 
prémixage, elle doit être enregistrée au 
préalable sur de nouvelles pistes audio 
(voir Enregistrement sur des pistes, 
page 681).
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Ecoute à faible latence avec 
compensation de retard
(Pro Tools HD uniquement)

Si vous choisissez d'effectuer un enregistrement 
en activant la compensation de retard, Pro Tools 
interrompt automatiquement la compensation 
de retard pour les pistes dans lesquelles vous 
souhaitez insérer un point d'entrée ou en mode 
d'écoute des signaux d'entrée. En pareils cas, 
aucune compensation de retard n'est ajoutée à la 
piste et l'indicateur de compensation de retard 
affiche zéro. 

La compensation de retard doit être activée dès 
que possible au cours du mixage et de la lecture. 
Dans certains cas, il est parfois préférable de 
désactiver la fonction de compensation de 
retard lors de l'enregistrement.

L'interruption automatique de la compensation 
de retard ou des pistes préparées à 
l'enregistrement au cours de l'enregistrement 
peut être annulée pour la piste de votre choix, 
quel que soit le statut d'enregistrement ou le 
mode d'entrée.

Nom des pistes par défaut
Lorsque vous créez des pistes audio, des pistes 
d'entrée auxiliaire, de fader principal, MIDI et 
des pistes d'instrument, Pro Tools les nomme 
« Audio », « Aux », « Master », « MIDI » ou 
« Inst » et les numérote de façon séquentielle. 
Lorsque vous créez, par exemple, deux pistes 
audio, leur nom par défaut est « Audio 1 » et 
« Audio 2 ». Vous pouvez renommer les pistes et 
leur ajouter des commentaires.

Les noms de pistes définissent les noms des 
nouveaux fichiers et des nouvelles régions lors 
de l'enregistrement sur une piste. Voir 
Attribution de noms aux pistes, page 120.

Noms par défaut des fichiers et des 
régions audio

Lorsque vous enregistrez sur une piste audio, les 
noms de fichiers et de régions résultants sont 
basés sur le nom de la piste. Par exemple, après 
avoir enregistré pour la première fois sur une 
piste nommée « Guit électr », le fichier audio 
écrit sur le disque dur porte le nom « Guit 
électr_01 ». De plus, une région portant le nom 
« Guit électr_01 » apparaît dans la liste des 
régions. Cette région est une région de fichier 
complet.

Les prises suivantes sur la même piste portent le 
même nom, mais le numéro de la prise est 
incrémenté (par exemple, « Guit électr_02 »). 
La seconde série de chiffres (par exemple, « Guit 
électr_01-01 ») désigne une région créée 
automatiquement à partir d'une édition. 

Pour plus d'informations sur l'annulation 
de la suspension de la compensation de 
retard, reportez-vous à la section Ecoute à 
latence réduite lors de l'enregistrement, 
page 604.

Les modes TrackPunch et QuickPunch 
utilisent une méthode différente pour 
numéroter les régions. Pour en savoir plus, 
reportez-vous à la section Numérotation 
des régions et des prises avec QuickPunch, 
page 254.
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Lorsque vous enregistrez des pistes MIDI, un 
principe d'identification similaire est utilisé, à la 
seule différence qu'il ne comporte qu'une série 
de chiffres. Après avoir enregistré, par exemple, 
sur une piste nommée « Synth 1 », la région 
créée s'appelle « Synth 1-01 ». Les régions 
suivantes de cette piste, créées soit à partir de 
prises supplémentaires, soit à partir d'éditions 
de régions, sont numérotées de façon 
séquentielle (par exemple, « Synth 1-02 »).

Noms des pistes audio stéréo

Lors de l'enregistrement sur des pistes audio 
stéréo, les noms des fichiers audio et des régions 
des canaux gauche et droit sont respectivement 
accompagnés des suffixes « .L » et « .R ».

Noms des pistes multicanaux

(Pro Tools HD uniquement)

Lors de l'enregistrement sur des pistes Surround 
multicanaux, les noms des fichiers audio et des 
régions de chaque canal se voient 
respectivement accompagnés des suffixes 
suivants.

Allocation de disque
Par défaut, Pro Tools enregistre les fichiers audio 
dans le dossier Audio Files qui se trouve dans le 
dossier de la session. La fenêtre Disk Allocation 
permet d'indiquer d'autres emplacements pour 
les fichiers audio de chaque piste audio.

Les disques durs pleins n'apparaissent pas dans 
la fenêtre Disk Allocation.

Pour accroître les performances du système, 
Pro Tools peut enregistrer et lire chaque piste à 
partir d'un disque dur différent. Vous pouvez 
aussi distribuer automatiquement les pistes qui 
viennent d'être créées vers plusieurs disques 
audio grâce à l'option Round Robin Allocation.

Navigation dans la fenêtre Disk Allocation

Pour redimensionner la fenêtre Disk Allocation :

■ Faites glisser l'angle inférieur droit de la 
fenêtre selon la procédure standard de votre 
système d'exploitation (Windows ou 
Macintosh).

Pour faire défiler la fenêtre Disk Allocation vers le 
haut ou le bas :

■ Appuyez sur Page Up ou Page Down.

Format 
multicanal

Suffixes des fichiers et des 
régions

LCR L, C, R

Quad L, R, Ls, Rs

LCRS L, C, R, S

5.0 L, C, R, Ls, Rs

5.1 L, C, R, Ls, Rs, LFE

6.0 L, C, R, Ls, Cs, Rs, LFE

6.1 L, C, R, Ls, Cs, Rs

7.0 L, Lc, C, R, Rc, Ls, Rs

7.1 L, Lc, C, R, Rc, Ls, Rs, LFE
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Affectation de lecteurs audio dans 
votre système

Pour attribuer les pistes aux disques audio de 
votre système :

1  Choisissez Setup > Disk Allocation.

2  Dans la fenêtre Disk Allocation, allouez un 
disque dur à chaque piste en cliquant dans la 
colonne Root Media Folder, puis en 
sélectionnant un volume dans la liste 
déroulante Disk Allocation.

Seuls les disques portant le suffixe R (lecture et 
enregistrement) peuvent être sélectionnés dans 
la fenêtre Disk Allocation. Pour plus 
d'informations, reportez-vous au Guide DigiBase.

Un dossier portant le nom de la session est créé 
sur chaque disque dur ; il contient des sous-
dossiers pour les fichiers audio et les fichiers de 
fondu.

• Pour affecter une piste à un autre disque 
dur, cliquez sur la piste et sélectionnez le 
nom d'un disque.

• Pour allouer toutes les pistes à un même 
disque dur, maintenez enfoncée la touche 
Alt (Windows) ou Option (Macintosh) 
pendant que vous sélectionnez le nom d'un 
disque.

• Pour sélectionner plusieurs éléments, 
maintenez enfoncée la touche Maj 
pendant que vous cliquez sur le nom d'une 
piste (dans la colonne des pistes). Vous 
sélectionnez ainsi les pistes déjà 
sélectionnées et toutes les pistes 
intermédiaires.

• Pour sélectionner plusieurs éléments non 
consécutifs, maintenez enfoncée la touche 
Ctrl (Windows) ou Pomme (Macintosh) 
pendant que vous cliquez sur le nom d'une 
piste dans la colonne des pistes.

3  Pour sauvegarder les fichiers audio enregistrés 
dans un dossier existant (sans créer un autre 
dossier pour la session), cochez la case 
Customize Allocation Options, puis cliquez sur 
le bouton Change et choisissez un dossier. Pour 
créer des sous-dossiers, cochez la case Create 
Subfolders for audio, video, and fade files.

4  Pour répartir automatiquement toutes les 
pistes créées sur les différents disques connectés 
à votre système, cochez la case Use Round Robin 
Allocation for New Tracks.

Fenêtre Disk Allocation

Liste déroulante Disk Allocation
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Si vous utilisez l'allocation à distribution 
automatique (Round Robin Allocation) et 
souhaitez que l'enregistrement audio s'effectue 
sur le disque de démarrage du système :

• Lancez le navigateur de l'espace de travail 
(Window > Workspace) et réglez 
l'indicateur de volume de votre système sur 
R (Enregistrement et lecture) Pour plus 
d'informations, reportez-vous à la section 
Désignation du volume de l'espace de 
travail, page 197.

5  Lorsque vous avez terminé, cliquez sur OK.

Enregistrement des paramètres 
d'allocation de disque

Pour enregistrer les paramètres d'allocation de 
disque et les utiliser dans de futures sessions, 
enregistrez la session sous forme de modèle. 
Pour en savoir plus, reportez-vous à la section 
Création de modèles de session personnalisés, 
page 68.

Allocation de disque et sessions 
multiplateforme

Pour assurer un fonctionnement multi plates-
formes, il est nécessaire que les sessions 
Pro Tools sur Macintosh et leurs fichiers audio 
associés se trouvent sur des disques formatés 

Macintosh (HFS or HFS+). Les sessions Pro Tools 
sous Windows et leurs fichiers audio associés 
doivent se trouver sur des disques formatés 
Windows (NTFS ou FAT32). 

Réallocation des pistes

Lorsque vous ouvrez une session dans laquelle 
certains disques durs préalablement alloués ne 
sont plus disponibles (ou ne correspondent pas 
à la plate-forme de la session en cours), 
Pro Tools réalloue automatiquement les pistes 
au volume sur lequel le fichier de session est 
stocké. Le cas échéant, utilisez l'allocation de 
disques pour réallouer des pistes à d'autres 
disques.

Désignation du volume de l'espace de 
travail

La désignation du volume de l'espace de travail 
peut altérer la disponibilité du disque, ainsi que 
l'allocation de disque. Depuis le navigateur de 
l'espace de travail, sélectionnez Record 
(enregistrement), Playback (lecture) ou Transfer 
(transfert) pour les volumes. Si vous configurez 
un disque pour qu'il soit en lecture seule (lecture 
uniquement ou transfert), vous devez contrôler 
l'allocation de disque pour toute piste allouée à 
ce disque. Pour plus d'informations, reportez-
vous au Guide DigiBase.

L'allocation à distribution automatique 
(Round Robin Allocation) n'est pas possible 
si vous utilisez des disques durs 
partitionnés.

Si vous souhaitez exclure des volumes 
montés individuels valides des passages 
d'allocation à distribution automatique, 
ouvrez le navigateur de l'espace de travail et 
protégez le volume en sélectionnant P 
(lecture seulement) ou T (transfert).

Reportez-vous aux sections 
Enregistrement de copies de sessions 
Macintosh compatibles avec Windows, 
page 178 et Partage des sessions créées 
sur différentes plates-formes, page 176.

La réallocation de pistes n'affecte pas 
l'audio préalablement enregistré. Elle 
n'affecte que l'emplacement de sauvegarde 
des nouvelles données audio.
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Enregistrement sur le volume 
système

Bien que Pro Tools autorise l'enregistrement sur 
votre volume système, ceci est généralement 
déconseillé. Les performances d'enregistrement 
et de lecture audio sur les disques durs système 
sont moins bonnes que sur les disques durs non-
système.

Il est recommandé d'enregistrer sur vos disques 
système uniquement en cas d'absolue nécessité : 
si votre ordinateur ne comporte qu'un seul 
disque dur ou si les autres disques sont saturés.

Par défaut, le volume système n'est pas compris 
dans l'allocation à distribution automatique 
(quel que soit la désignation du volume dans le 
navigateur de l'espace de travail). Pour inclure le 
volume système dans les allocations à 
distribution automatique, voir Pour attribuer les 
pistes aux disques audio de votre système :, 
page 196.

Allocation de l'espace de 
disque dur pour 
l'enregistrement
La préférence de fonctionnement Open Ended 
Record Allocation détermine l'espace disque dur 
alloué à l'enregistrement sur une ou plusieurs 
pistes dans Pro Tools.

Lorsque cette préférence d'allocation est réglée 
sur Use All Available Space, la totalité de l'espace 
disponible du disque est allouée à 
l'enregistrement. En réglant ce paramètre, vous 
pouvez enregistrer des prises ou des sessions 
plus longues. 

Cependant, lors de l'allocation de tout l'espace 
disponible, Pro Tools ut avoir besoin de plus de 
temps pour commencer l'enregistrement. Dans 
ce cas, essayez de réduire ce retard en allouant 
une durée spécifique à l'enregistrement. 

En général, la préférence Use All Available Space 
sollicite plus les disques durs. En plus de pouvoir 
enregistrer et réduire les retards, de nombreux 
systèmes voient leurs performances 
d'enregistrement globales s'améliorer lorsque 
l'option Open Ended Record Allocation est 
limitée.

Pour allouer une durée spécifique à 
l'enregistrement :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation.

2  Sous l'option Open Ended Record Allocation, 
sélectionnez Limit To et entrez un nombre de 
minutes à allouer.

Le nombre de minutes indiqué est alloué pour 
chaque piste préparée en enregistrement. 

3  Lorsque vous avez terminé, cliquez sur Done.

Vous pouvez également éviter ce retard en 
configurant Pro Tools en mode Record 
Pause (enregistrement en attente) avant de 
commencer à enregistrer. Pour plus 
d'informations, reportez-vous à la section 
Mode Record Pause, page 214.

Préférence de fonctionnement Option Open Ended 
Record Allocation
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Contrôle de l'espace 
disponible

Pour gérer l'espace disponible de votre disque dur 
au cours d'une session Pro Tools :

■ Choisissez Window > Disk Space.

Pour afficher l'espace disque disponible sous 
différents formats d'affichage :

1  Choisissez View > Disk Space et sélectionnez 
un format (Text View ou Gas Gauge).

Modes d'enregistrement
Pro Tools dispose des quatre modes 
d'enregistrement audio suivants :

• Nondestructive Record (par défaut)

• Destructive Record

• Loop Record

• QuickPunch

• TrackPunch (Pro Tools HD uniquement)

Pour activer les modes d'enregistrement 
destructif, en boucle, QuickPunch ou 
TrackPunch, sélectionnez-les dans le menu 
Options. Si vous ne sélectionnez aucun de ces 
modes, Pro Tools fonctionne normalement en 
mode d'enregistrement non destructif.

Pour choisir le mode d'enregistrement, vous 
pouvez également procéder comme suit : 
cliquez à l'aide du bouton droit de la souris 
(Windows et Macintosh) sur le bouton Record 
Enable de la fenêtre Transport ou en cliquez sur 
ce bouton tout en maintenant enfoncée la 

touche Contrôle (Macintosh). Ceci permet de 
passer d'un mode à un autre, tandis que le 
bouton d'enregistrement change pour indiquer 
le mode sélectionné : vide pour non destructif, 
« D » pour destructif, le symbole d'une boucle 
pour l'enregistrement en boucle, « Q » pour 
QuickPunch et « T » pour TrackPunch.

Mode d'enregistrement non destructif

En mode d'enregistrement normal non 
destructif, Pro Tools effectue un enregistrement 
audio non destructif, ce qui signifie que si vous 
enregistrez sur des régions existantes d'une 
piste, les données ne sont pas effacées de votre 
disque dur. Le nouvel et l'ancien enregistrement 
audio sont conservés sur votre disque dur et 
figurent sous forme de régions dans la liste des 
régions.

En mode d'enregistrement non destructif, la 
plage d'enregistrement se définit en 
sélectionnant une plage dans la règle ou dans la 
playlist d'une piste, ou en indiquant les points 
de début et de fin dans la fenêtre Transport. 
En l'absence de sélection, l'enregistrement 
commence au point où se trouve le curseur et se 
poursuit jusqu'à ce que vous cliquiez sur le 
bouton Stop dans la fenêtre Transport.

Activation du mode d'enregistrement destructif

Pendant l'enregistrement, vous pouvez 
économiser l'espace disque en supprimant 
les prises inutiles (voir Suppression des 
régions inutiles, page 422) et en 
compactant les fichiers audio (voir 
Compactage d'un fichier audio, 
page 419).
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Les paramètres pré/post-roll permettent 
d'écouter les données audio jusque et au-delà 
des points de début et de fin, ce qui est utile 
pour le réenregistrement (voir Enregistrement 
audio fractionné, page 217).

Mode d'enregistrement destructif

En mode d'enregistrement destructif, les 
données enregistrées sur des régions existantes 
remplacent définitivement les données audio 
qui s'y trouvaient déjà, ce qui permet de gagner 
de l'espace sur le disque dur. Toutefois, si vous 
disposez d'un espace suffisant sur le disque dur, 
il est généralement préférable d'utiliser le mode 
d'enregistrement non destructif de Pro Tools 
pour éviter d'effacer des enregistrements 
précédents.

Lors de la définition de la plage 
d'enregistrement et du réglage des paramètres 
pré- et post-roll, le mode destructif fonctionne 
comme le mode non destructif.

Contrairement aux autres modes 
d'enregistrement, il n'est pas possible d'annuler 
des prises en mode d'enregistrement destructif 
(voir Annulation d'une prise d'enregistrement, 
page 213).

Mode d'enregistrement en boucle

Le mode d'enregistrement en boucle permet 
d'enregistrer prise par prise (de façon non 
destructive) tandis que la même section audio se 
répète. Cette technique est pratique pour 
enregistrer rapidement plusieurs prises d'une 
partie sans perdre la spontanéité.

La partie mise en boucle et enregistrée (qui doit 
durer au minimum une seconde) est 
sélectionnée dans la règle ou dans la liste de 
diffusion d'une piste, ou en indiquant les points 
de début et de fin dans la fenêtre Transport. Le 
paramètre de pré-roll, s'il est activé, est utilisé 
pendant la première passe d'enregistrement, 
mais ensuite, à chaque passage de la boucle, les 
temps de pré/post-roll sont ignorés.

Lorsque vous utilisez le mode d'enregistrement 
en boucle, chaque prise successive apparaît 
comme une région dans la liste des régions et sa 
numérotation s'effectue de façon séquentielle. 
Les différentes prises, identiques en longueur et 
en heure de début, s'auditionnent et se placent 
aisément dans la piste à l'emplacement correct à 
l'aide du menu déroulant de la liste des prises 
(voir Ecoute des prises enregistrées dans la 
timeline, page 220).

Pour définir une plage d'enregistrement en 
la sélectionnant dans la playlist d'une piste, 
les sélections Timeline et Edit doivent être 
liées. Pour plus d'informations, reportez-
vous à la section Activation ou 
désactivation de la liaison des sélections 
d'édition et de timeline, page 332.

En mode d'enregistrement destructif, la 
présentation sous forme d'ondes n'est 
redessinée qu'après avoir interrompu 
l'enregistrement.

Pour définir une plage d'enregistrement en 
la sélectionnant dans la playlist d'une piste, 
les sélections Timeline et Edit doivent être 
liées. Pour plus d'informations, reportez-
vous à la section Activation ou 
désactivation de la liaison des sélections 
d'édition et de timeline, page 332.

En mode d'enregistrement en boucle, la 
présentation sous forme d'ondes n'est 
redessinée qu'après avoir interrompu 
l'enregistrement.
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QuickPunch

QuickPunch permet l'enregistrement « à la 
volée », ce qui vous donne la possibilité, 
pendant la lecture, de passer instantanément et 
manuellement en mode enregistrement sur une 
piste audio déjà prête à l'enregistrement, puis de 
sortir du mode enregistrement en cliquant 
simplement sur le bouton Record Enable de la 
fenêtre Transport. L'enregistrement 
QuickPunch est non destructif.

En mode QuickPunch, Pro Tools commence 
l'enregistrement d'un nouveau fichier dès que la 
lecture commence et crée automatiquement des 
régions au sein de ce fichier à chaque point 
d'entrée et de sortie de l'enregistrement. 
Ces régions apparaissent dans la playlist de la 
piste. Le fichier audio complet apparaît dans la 
liste des régions avec les régions créées en mode 
QuickPunch. Vous pouvez ainsi, dans une 
même passe, effectuer jusqu'à 200 points 
d'entrée et de sortie d'enregistrement.

Bien qu'il soit possible d'enregistrer à la volée 
dans les autres modes en indiquant 
manuellement la plage d'enregistrement, seul le 
mode QuickPunch permet de sortir 
instantanément de l'enregistrement.

TrackPunch (Pro Tools HD uniquement)

TrackPunch permet d'appliquer un punch-in ou 
un punch-out aux pistes ou de les sortir du 
mode de préparation à l'enregistrement sans 
interrompre l'enregistrement et la lecture en 
ligne. 

TrackPunch est un mode d'enregistrement non 
destructif. Lorsqu'une piste est en mode 
TrackPunch, Pro Tools commence à enregistrer 
un nouveau fichier lorsque la lecture démarre. 
Pendant la lecture, certaines ou la totalité des 
pistes en mode TrackPunch peuvent être 
activées ou désactivées en vue de 
l'enregistrement ou subir un punch-in ou un 
punch-out. 

TrackPunch crée automatiquement des régions 
dans ce fichier qui correspondent à chaque 
point d'entrée ou de sortie d'enregistrement. 
Ces régions apparaissent dans la playlist de la 
piste. Le fichier audio complet apparaît dans la 
liste des régions avec les régions créées en mode 
QuickPunch. Vous pouvez ainsi, dans une 
même passe, effectuer jusqu'à 200 points 
d'entrée et de sortie d'enregistrement. 

Modes d'enregistrement et MIDI

Outre les différents modes d'enregistrement, il 
existe également un bouton MIDI Merge dans la 
fenêtre Transport, qui détermine comment sont 
enregistrées les données MIDI. Lorsque le mode 
fusion (Merge) est activé, les nouvelles données 
MIDI viennent s'ajouter aux anciennes. Lorsque 
le bouton MIDI Merge est désactivé (mode 
Replace), les nouvelles données MIDI 
remplacent les anciennes.

L'enregistrement MIDI fonctionne de la même 
manière, que vous utilisiez un mode non 
destructif ou destructif. De plus, il n'est pas 
nécessaire que le mode QuickPunch ou le mode 

En mode d'enregistrement QuickPunch, la 
présentation sous forme d'ondes n'est 
redessinée qu'après avoir interrompu 
l'enregistrement.

Fusion MIDI activée

Bouton MIDI Merge
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TrackPunch soit activé pour réaliser un 
enregistrement à la volée en MIDI ; cette 
possibilité existe dans les modes non destructif 
et destructif.

Contrairement au mode d'enregistrement en 
boucle, l'activation/désactivation du mode 
MIDI Merge détermine si les données existantes 
sont remplacées ou fusionnées.

A moins que le mode MIDI Merge ne soit activé, 
l'enregistrement MIDI est destructif (bien qu'il 
soit possible d'annuler une passe 
d'enregistrement MIDI), soit par remplacement, 
soit par ajout d'une région. Il existe une 
exception à cette règle : lorsque le mode 
d'enregistrement en boucle est actif, les régions 
existantes de la piste sont remplacées par de 
nouvelles lorsque vous enregistrez de nouvelles 
données. Les anciennes régions demeurent 
intactes et restent disponibles dans la liste des 
régions, ainsi que dans la liste déroulante des 
prises. Dans le mode d'enregistrement en 
boucle, la fusion MIDI n'a aucun effet ; c'est 
pourquoi le bouton de fusion MIDI est estompé.

Enregistrement avec le 
métronome
Si vous envisagez de travailler avec des pistes 
MIDI ou des pistes d'instrument dans votre 
session ou si vous travaillez sur des données 
audio référencées en mesures et en temps, vous 
pouvez enregistrer vos pistes tout en écoutant le 
métronome Ceci garantit que les données 
enregistrées, MIDI et audio, seront bien en 
mesure tout au long de la session.

Lorsque les données de votre piste tombent bien 
en face des temps, vous pouvez bénéficier de 
certaines fonctions d'édition pratiques de 
Pro Tools, telles que la quantification des 

régions MIDI et audio, la quantification de 
notes MIDI individuelles, et le copier-coller de 
mesures et de parties de morceaux en mode 
Grid.

Pro Tools fournit un générateur d'horloge 
intégré, le plug-in DigiRack Click qui offre des 
présélections avec plusieurs sons de 
métronomes. Il prend en charge les sons de 
métronomes accentués et non accentués et 
permet de régler le volume de chacun. Le 
métronome est intégré directement à Pro Tools, 
ce qui évite les retards MIDI. Pour en savoir plus, 
reportez-vous au Guide des plug-in DigiRack. 

Pro Tools propose également des options et des 
commandes permettant d'utilisation avec des 
données MIDI. Les étapes suivantes décrivent les 
procédures de configuration et d'activation d'un 
métronome lors de l'utilisation de données 
MIDI.

Les données enregistrées sans référence au 
métronome peuvent néanmoins être 
alignées sur une grille mesure/temps dans 
Pro Tools à l'aide de la commande Beat 
Detective (voir Chapitre 21, Beat 
Detective). Sinon, utilisez la commande 
Identify Beat pour spécifier le tempo (voir 
Commande Identify Beat, page 444).

Vous pouvez également enregistrer des 
données MIDI avec ou sans métronome et 
cliquer sur les marqueurs Bar|Beat ou encore 
générer une table des tempos et mesures à 
partir de celui-ci en utilisant la commande 
Beat Detective. Pour plus d'informations, 
reportez-vous au Chapitre 21, Beat 
Detective.
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Pour configurer les options du métronome :

1  Sélectionnez Setup > Click.

– ou –

Cliquez deux fois sur le bouton du métronome 
ou du décompte dans la fenêtre Transport.

2  Effectuez une des opérations suivantes dans la 
boîte de dialogue Click/Countoff Options :

• Si vous utilisez le pIug-in DigiRack Click, 
sélectionnez None dans la liste déroulante 
Output. Pour plus d'informations sur ce 
plug-in, consultez le Guide des plug-in 
DigiRack.

– ou –

• Si vous utilisez un métronome avec des 
données MIDI, choisissez dans la liste 
déroulante Output le numéro du port 
(périphérique) et le canal sur lequel jouera 
le métronome. 

3  Pour les notes accentuées et non accentuées, 
indiquez la note, la vélocité et la durée à l'aide 
des touches du clavier numérique. Vous pouvez 
également jouer les nouvelles notes sur votre 
contrôleur MIDI, s'il est connecté.

Lorsque vous entendez le métronome dans vos 
sessions Pro Tools, la note accentuée correspond 
au premier temps de chaque mesure ; aux autres 
temps correspondent des notes non accentuées.

4  Indiquez si le métronome doit être entendu 
pendant la lecture et l'enregistrement (During 
play and record), seulement pendant 
l'enregistrement (Only during record) ou 
seulement pendant le décompte (Only during 
countoff).

5  Si vous utilisez un décompte, indiquez le 
nombre de mesures devant être décomptées. 
Si vous souhaitez entendre le décompte 
seulement pendant l'enregistrement, cochez 
l'option Countoff only when recording.

6  Cliquez sur OK.

Pour activer le métronome à partir du menu MIDI :

■ Sélectionnez Options > Click.

Pour activer le métronome dans la fenêtre 
Transport :

1  Pour faire apparaître les commandes MIDI 
dans la fenêtre Transport, procédez comme suit :

• Choisissez View > Transport > MIDI 
Controls.

• Pour afficher les commandes MIDI, 
maintenez enfoncée la touche Ctrl 
(Windows) ou Pomme (Macintosh) 
pendant que vous cliquez sur le bouton 
Développer/réduire (+) dans la fenêtre 
Transport.Boîte de dialogue Click/Countoff
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• Pour afficher les commandes MIDI et les 
compteurs, maintenez enfoncée la touche 
Alt (Windows) ou Pomme (Macintosh) 
pendant que vous cliquez sur le bouton 
Développer/réduire (+) dans la fenêtre 
Transport.

2  Dans la fenêtre Transport, cliquez sur le 
bouton du métronome (il passe en surbrillance).

3  Pour utiliser le décompte pendant 
l'enregistrement ou la lecture, cliquez sur le 
bouton de décompte dans la fenêtre Transport 
(il passe en surbrillance).

Entendre le décompte avant l'enregistrement est 
très pratique pour se « mettre dans le tempo » 
avant de commencer à jouer. Le bouton de 
décompte de la fenêtre Transport indique le 
nombre de mesures devant être décomptées.

Boutons Wait for Note et Countoff

Ces boutons s'excluent mutuellement et ne 
peuvent être activés simultanément. Par 
exemple, si vous activez le décompte et cliquez 
sur le bouton Wait for Note, le décompte est 
désactivé.

Réglage du tempo et de la 
métrique par défaut

Réglage de la métrique par défaut

Lorsque vous ouvrez une nouvelle session 
Pro Tools, la métrique (type de mesure) par 
défaut est 4/4. Si vous envisagez d'enregistrer 
avec le métronome et travaillez avec une 
métrique différente, modifiez-la en 
conséquence.

Si la métrique d'une session ne correspond pas à 
celle de la musique que vous enregistrez, les 
notes accentuées du métronome ne seront pas 
en mesure avec ce que vous jouez ; par 
conséquent, les données enregistrées risquent 
de ne pas s'aligner en termes de mesures/temps 
dans la fenêtre Edit.

Fenêtre Transport affichant les contrôles MIDI

Bouton du métronome activé

Décompte activé

Bouton Développer/réduire (+)

Bouton du métronome

Bouton de décompte

Le décompte est ignoré lorsque Pro Tools est 
en ligne et synchronisé avec un timecode 
SMPTE.

Beat Detective requiert des métriques 
identiques pour travailler avec DigiGrooves. 
Si, par exemple, Beat Detective extrait le 
feeling d'un tempo de 3/4, il peut être 
appliqué à un autre tempo de 3/4.
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Les changements de métrique, qui peuvent 
intervenir à tout moment dans une session 
Pro Tools, sont mémorisés dans la piste de 
métrique et apparaissent dans la règle de 
métrique. Pour plus d'informations sur 
l'insertion et l'édition des événements de 
métrique, consultez la section Evénements de 
métrique, page 448.

Pour définir la métrique par défaut d'une session :

1  Cliquez deux fois sur le bouton Current Meter 
dans la fenêtre Transport.

2  Entrez la métrique utilisée dans la session et 
entrez 1|1|000 comme emplacement (Location), 
de façon à ce que l'événement de métrique ainsi 
inséré remplace la métrique par défaut.

3  Choisissez une valeur de note (ronde, 
blanche, noire, etc.), qui déterminera le nombre 
de métronomes entendus dans chaque mesure.

4  Cliquez sur OK pour insérer le nouvel 
événement de métrique.

Réglage du tempo par défaut

Lorsque vous ouvrez une session dans Pro Tools, 
le tempo par défaut est de 120 BPM. Si vous 
envisagez d'enregistrer avec le métronome et 
travaillez avec un tempo différent, réglez-le en 
conséquence. Si vous connaissez le tempo que 
vous utiliserez dans votre session, vous pouvez 
insérer un événement de tempo au début de la 
piste de tempo.

Les changements de tempo, qui peuvent 
intervenir à tout moment dans une session 
Pro Tools, sont mémorisés dans la piste de 
tempo et apparaissent dans la règle de tempo. 
Pour plus d'informations sur l'insertion et 
l'édition des événements de tempo, consultez la 
section Tempo, page 426.

Pour insérer un événement de tempo par défaut :

1  Cliquez deux fois sur le marqueur de début de 
morceau dans la fenêtre Edit.

2  Saisissez la valeur BPM de la session et tapez 
1|1|000 comme emplacement (Location), de 
façon à ce que la valeur de tempo ainsi insérée 
remplace celle par défaut.

3  Pour baser la valeur BPM sur autre chose que la 
noire par défaut, choisissez une autre valeur 
dans le menu déroulant Resolution.

4  Cliquez sur OK pour insérer le nouvel 
événement de tempo.

Fenêtre Meter Change

Bouton Current Meter

Fenêtre Tempo Change
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Consultez Marqueur de début de morceau, 
page 425 pour plus d'informations sur le tempo 
par défaut.

Utilisation du mode tempo manuel

En mode Manual Tempo, Pro Tools ignore les 
événements de tempo enregistrés sur la piste de 
tempo et joue un tempo manuel à la place. Vous 
pouvez définir le tempo avec le curseur de 
tempo ou, si vous n'êtes pas certain du tempo, 
en battant le tempo grâce au bouton Tap.

Vous pouvez régler le tempo manuel en cours de 
lecture, mais celle-ci sera alors momentanément 
interrompue.

Pour régler le tempo manuel à l'aide du curseur de 
tempo :

1  Pour faire apparaître les commandes MIDI 
dans la fenêtre Transport, sélectionnez View > 
Transport > MIDI Controls.

Dans la fenêtre Transport, cliquez sur le bouton 
Tempo Ruler Enable (chef d'orchestre) pour qu'il 
n'apparaisse plus en surbrillance. Pro Tools 
passe en mode de tempo manuel. Dans ce mode, 
tous les événements de tempo enregistrés sur la 
piste de tempo sont ignorés.

2  Pour baser la valeur BPM sur un élément autre 
que la noire par défaut, cliquez sur le sélecteur 
de résolution du tempo et sélectionnez une 
autre valeur.

3  Pour entrer un nouveau tempo, faites glisser le 
curseur horizontal de tempo dans la fenêtre 
Transport.

Pour affiner la résolution du curseur de tempo, 
appuyez sur la touche Ctrl (Windows) ou 
Pomme (Macintosh) pendant que vous le faites 
glisser.

Pour quitter le mode Manual Tempo et activer la 
piste tempo :

■ Dans la fenêtre Transport, cliquez sur le 
bouton Tempo Ruler Enable (chef d'orchestre) 
(il ne s'affiche plus en surbrillance).

Pour régler le tempo manuel à l'aide du 
battement :

1  Pour faire apparaître les commandes MIDI 
dans la fenêtre Transport, sélectionnez View > 
Transport Window > MIDI Controls.

2  Dans la fenêtre Transport, cliquez sur le 
bouton Tempo Ruler Enable (chef d'orchestre) 
pour qu'il n'apparaisse plus en surbrillance. 
Pro Tools passe en mode de tempo manuel. 
Dans ce mode, tous les événements de tempo 
enregistrés sur la piste de tempo sont ignorés.

3  Cliquez dans le champ du tempo pour le faire 
apparaître en surbrillance et appuyez 
successivement sur la touche T de votre clavier 
au rythme du nouveau tempo.

– ou –

Cliquez dans le champ du tempo pour le faire 
apparaître en surbrillance et battez le tempo en 
jouant une note de façon répétée sur le clavier 
de votre contrôleur MIDI.

Mode tempo manuel activé

Bouton 
d'activation
de la règle 
de tempo

Sélecteur de résolution

Curseur de tempo

Curseur de tempo
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Pour calculer le nouveau tempo, Pro Tools fait la 
moyenne des huit derniers battements (ou 
moins) afin de déterminer le tempo. La valeur 
BPM calculée apparaît dans le champ Tempo du 
Transport.

Pour verrouiller le nouveau tempo :

■ Désactivez le mode Manual Tempo de 
Pro Tools en cliquant sur le bouton Tempo Ruler 
Enable (chef d'orchestre), puis insérez le 
nouveau tempo comme tempo par défaut pour 
le marqueur de début de morceau.
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Chapitre 12 : Notions de base de 
l'enregistrement audio

Enregistrement d'une piste 
audio
Lorsque vous enregistrez à partir d'une source 
mono, faites-le sur une seule piste audio mono 
dans Pro Tools. Un seul fichier audio mono est 
écrit sur le disque ; la région apparaît dans la 
playlist et dans la liste des régions.

Lorsque vous enregistrez une source stéréo dans 
Pro Tools, faites-le vers une seule piste audio 
stéréo. Un seul fichier audio mono est écrit sur le 
disque pour chaque canal (un pour le gauche et 
un pour le droit) ; les régions apparaissent dans 
la playlist des deux canaux. De plus, une région 
multicanal (stéréo) apparaît également dans la 
liste des régions.

L'enregistrement de pistes multicanaux 
(Pro Tools HD uniquement) est très proche de 
l'enregistrement de pistes audio stéréo. Un seul 
fichier audio mono est écrit pour chaque canal 
de la piste et les régions apparaissent dans la 
playlist de chaque canal. De plus, une région 
multicanal apparaît également pour chaque 
piste dans la liste des régions.

Pour configurer une piste audio en 
enregistrement :

1  Connectez une source sonore mono ou stéréo 
à l'entrée appropriée de votre dispositif audio.

2  Spécifiez le format (analogique ou numérique) 
des entrées de l'interface audio que vous 
utiliserez. Choisissez Setup > Hardware, puis 
sélectionnez l'interface et le format de la paire de 
canaux.

Certaines unités d'E/S Digidesign, telles que la 
Mbox 2, ne disposent que de deux canaux 
pouvant être réglés en mode analogique ou 
numérique.

3  Si aucune piste n'existe, choisissez Track > 
New ; spécifiez qu'il s'agit d'une piste audio 
(Audio Track) et sélectionnez le mode mono ou 
stéréo. Cliquez ensuite sur Create.

Pour plus d'informations sur les pistes 
multicanaux, reportez-vous à la section 
Pistes audio multicanaux, page 720.

Boîte de dialogue New Tracks
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4  Renommez la piste. Les noms des pistes 
servent à nommer automatiquement des 
fichiers audio et des régions. Pour plus 
d'informations, reportez-vous à la section Nom 
des pistes par défaut, page 194.

5  Dans la fenêtre Mix, utilisez le sélecteur de 
chemin d'entrée de la piste pour lui affecter une 
entrée matérielle.

– ou –

Dans la fenêtre Edit, activez l'affichage I/O et 
utilisez le sélecteur de chemin d'entrée de la 
piste pour lui affecter une entrée matérielle.

6  Dans la fenêtre Mix, cliquez sur le sélecteur de 
chemin de sortie de la piste pour affecter une 
sortie matérielle.

– ou –

Dans la fenêtre Edit, activez l'affichage I/O et 
utilisez le sélecteur de chemin de sortie de la 
piste pour lui affecter une sortie matérielle.

Pour faire défiler automatiquement le menu 
déroulant Track Type de la boîte de 
dialogue New Tracks, appuyez sur Pomme 
(Macintosh) ou sur Ctrl (Windows), puis 
utilisez les touches fléchées Haut et Bas.

Pour faire défiler automatiquement le menu 
déroulant Track Formats de la boîte de 
dialogue New Tracks, appuyez sur Pomme 
(Macintosh) ou sur Ctrl (Windows), puis 
utilisez les touches fléchées Gauche et 
Droite.

Sélecteur de chemin d'entrée (fenêtre Mix)

Sélecteur de chemin d'entrée (fenêtre Edit)

Sélecteur de chemin de sortie (fenêtre Mix)

Sélecteur de chemin de sortie (fenêtre Edit)
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7  Dans la fenêtre Mix, cliquez sur le bouton 
Record Enable de la piste audio pour préparer 
cette piste en enregistrement. Le bouton Record 
Enable clignote en rouge lorsque le fader est 
allumé en rouge et que le bouton Record Enable 
de la fenêtre Transport vire au rouge (indiquant 
que le mode enregistrement est activé pour au 
moins une piste).

– ou –

Dans la fenêtre Edit, cliquez sur le bouton 
Record Enable de la piste pour préparer cette 
piste en enregistrement.

8  Réglez le niveau de sortie de votre source 
sonore (instrument, console de mixage ou 
préamplificateur). Surveillez les niveaux des 
afficheurs de la piste dans Pro Tools pour vérifier 
que vous obtenez le signal le plus élevé possible 
sans écrêtage.

9  Dans la fenêtre Mix, réglez le niveau et le 
panoramique de la piste comme souhaité. 
Ces paramètres n'affectent que l'écoute et non 
les données enregistrées.

– ou –

Dans la fenêtre Output de la piste, réglez le 
niveau et le panoramique de la piste. 
Ces paramètres n'affectent que l'écoute et non 
les données enregistrées. Reportez-vous à la 
section Fenêtres Output pour les pistes et les 
départs, page 590.)

Pour enregistrer sur une piste audio :

1  Avec Pro Tools HD, assurez-vous que l'option 
Delay Compensation est désactivée dans le 
menu Options.

2  Dans le menu Options, désélectionnez les 
options Destructive Record, Loop Record, 
QuickPunch et TrackPunch.

3  En cas de besoin, activez le métronome (Click) 
et le décompte (Countoff) dans la fenêtre 
Transport. Pour en savoir plus, reportez-vous à la 
section Enregistrement avec le métronome, 
page 202. 

Bouton d'activation en enregistrement de la piste 
(fenêtre Mix)

Bouton d'activation en enregistrement de la piste 
(fenêtre Edit)

Activation en
enregistrement

Activation en
enregistrement

Dans certains cas, Digidesign recommande 
l'enregistrement sans compensation de 
retard. Pour plus d'informations, reportez-
vous à la section Compensation de retard, 
page 602.
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4  Indiquez la métrique et le tempo par défaut de 
la session si vous utilisez ce type d'informations. 
Pour en savoir plus, reportez-vous à la section 
Réglage du tempo et de la métrique par défaut, 
page 204.

5  Dans la fenêtre Transport, cliquez sur Return 
to Zero pour effacer les temps de début et de fin. 
Cela garantit que l'enregistrement commencera 
au début de la piste.

6  Cliquez sur Record dans la fenêtre Transport 
pour activer le mode d'enregistrement. 
Le bouton Record Enable clignote.

7  Lorsque vous êtes prêt à commencer 
l'enregistrement, cliquez sur Play. Si vous 
utilisez le décompte, Pro Tools décompte le 
nombre de mesures spécifié avant de 
commencer l'enregistrement.

8  A la fin de l'enregistrement, cliquez sur le 
bouton Stop de la fenêtre Transport.

Les nouvelles données audio enregistrées sont 
écrites sur le disque et apparaissent sous forme 
d'une région audio dans la playlist de la piste. 
La nouvelle région audio apparaît également 
dans la liste des régions.

Pour lire la piste audio :

1  Cliquez sur le bouton Record Enable de la 
piste audio pour annuler la préparation en 
enregistrement. Le fader de volume de la piste 
fonctionne à présent comme contrôle du niveau 
de lecture.

2  Dans la fenêtre Transport, cliquez sur le 
bouton de retour à zéro pour avoir la garantie 
que la lecture commencera au début de la 
session.

3  Cliquez sur le bouton de lecture de la fenêtre 
Transport pour commencer la lecture. Réglez le 
volume de la piste et son panoramique.

Annulation ou arrêt de l'enregistrement 
audio

Après avoir enregistré une piste audio et lorsque 
le Transport est arrêté, vous pouvez annuler la 
dernière prise d'enregistrement.

Pour annuler un enregistrement audio :

■ Après avoir arrêté le Transport, choisissez 
Edit > Undo Record Audio. 

La playlist des pistes revient à son état précédent 
et les matériaux suivant sont annulés :

• En mode d'enregistrement normal, la prise 
précédente est annulée.

• En mode d'enregistrement en boucle, 
toutes les prises enregistrées passe après 
passe sont annulées.

Si une piste préparée à l'enregistrement est 
en mode d'écoute Auto Input, vous 
entendrez l'entrée si le transport est arrêté. 
La piste passe automatiquement en mode de 
lecture lorsque vous appuyez sur Play, puis 
retourne en mode Input à l'arrêt ou à 
l'enregistrement à la volée. Pour plus 
d'informations, reportez-vous à la section 
Mode d'écoute Auto Input, page 190.
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• En mode TrackPunch ou QuickPunch, tous 
les enregistrements fractionnés de la 
dernière passe d'enregistrement sont 
annulées.

Annulation d'une prise d'enregistrement

Il est possible d'annuler la prise en cours 
d'enregistrement. Les données audio 
enregistrées jusqu'à ce point sur votre disque dur 
sont alors supprimées, de même que les régions 
correspondantes dans la playlist de la piste. 
Cette fonction n'est pas possible en mode 
d'enregistrement destructif. 

Pour annuler une passe en cours 
d'enregistrement :

■ Appuyez sur Ctrl + point (.) (Windows) ou 
Pomme + point (.) (Macintosh) avant que le 
transport ne soit arrêté.

En mode d'enregistrement en boucle, toutes les 
prises enregistrées passe après passe sont 
annulées.

Enregistrement de plusieurs 
pistes audio

Pro Tools peut enregistrer simultanément 
plusieurs pistes audio, dans les limites du 
nombre de pistes imposées par votre système. 
Pour enregistrer sur plusieurs pistes, préparez en 
enregistrement les pistes, puis lancez 
l'enregistrement. Procédez comme décrit dans la 
section Enregistrement d'une piste audio, 
page 209.

Pour chaque piste préparée en enregistrement, 
un nouveau fichier audio est écrit sur le disque 
et une nouvelle région créée – elle apparaît 
dans la playlist. Les nouvelles régions 
correspondantes apparaissent dans la liste des 
régions.

Raccourcis pour 
l'enregistrement
Pour commencer l'enregistrement, vous pouvez 
soit cliquer sur le bouton Record Enable de la 
fenêtre Transport, soit utiliser les raccourcis 
clavier suivants :

• Appuyez sur F12 pour lancer immédiatement 
l'enregistrement.

• Appuyez sur Ctrl + Barre d'espace (Windows) 
ou sur Pomme + Barre d'espace (Macintosh).

• Appuyez sur la touche 3 du pavé numérique 
(lorsque le mode du pavé numérique est réglé 
sur Transport).

Si vous annulez une passe d'enregistrement 
lors d'un enregistrement, Pro Tools 
supprimera de le session toutes les passes 
d'enregistrement annulées précédemment et 
vous offre la possibilité de supprimer la passe 
d'enregistrement précédente de votre 
dispositif.

Pour utiliser la touche F12 afin d'enregistrer 
sur les systèmes Macintosh, la fonction 
Spotlight doit être réaffectée. Pour obtenir 
plus d'informations, reportez-vous au Guide 
de démarrage.

Pour démarrer un enregistrement à demi-
vitesse, appuyez sur Ctrl + Maj + Barre 
d'espace (Windows) ou sur 
Pomme + Maj + Barre d'espace 
(Macintosh). Pour en savoir plus, reportez-
vous à la section Enregistrement et lecture 
à demi-vitesse, page 229.
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Mode Record Pause
Lorsque vous enregistrez un grand nombre de 
pistes ou de canaux, ou lorsque vous lisez un 
grand nombre de pistes pendant 
l'enregistrement, Pro Tools peut prendre un peu 
plus de temps à commencer effectivement 
l'enregistrement. Pour éviter ce retard, placez 
Pro Tools en mode Record Pause (attente en 
enregistrement) avant de commencer à 
enregistrer.

Pour enregistrer à partir du mode Record Pause :

1  Cliquez sur le bouton d'enregistrement de la 
fenêtre Transport. Le bouton Record Enable 
clignote.

2  Pour placer Pro Tools en mode d'attente en 
enregistrement (Record Pause), maintenez 
enfoncée la touche Alt (Windows) ou Option 
(Macintosh) dans la fenêtre Transport pendant 
que vous cliquez sur Play. Les boutons Play et 
Record Enable clignotent.

3  Pour commencer l'enregistrement 
instantanément, cliquez sur Play. A la fin de 
l'enregistrement, cliquez sur le bouton Stop de 
la fenêtre Transport.

Enregistrement de prises 
supplémentaires
Après avoir enregistré sur une piste audio, vous 
pouvez enregistrer d'autres prises sur cette 
même piste. Cependant, si vous enregistrez ces 
prises supplémentaires en mode destructif, les 
données audio des prises précédentes 
enregistrées sur le disque dur seront 
définitivement détruites.

Pour conserver les données audio des prises 
précédentes, enregistrez en mode normal, non 
destructif.

Pour enregistrer de façon non-destructive une 
nouvelle prise sur la même piste :

1  Placez Pro Tools en mode non destructif. Dans 
le menu Options, désélectionnez les options 
Destructive Record, Loop Record, QuickPunch 
et TrackPunch si celles-ci sont sélectionnées.

2  Vérifiez que la piste contenant la prise 
précédente est toujours activée en 
enregistrement.

3  Pour enregistrer à partir du début de la piste, 
cliquez sur Return to Zero (Retour à zéro) dans la 
fenêtre Transport.

– ou –

Si Options > Link Timeline and Edit Selection 
est actif, cliquez n'importe où dans la playlist de 
la piste pour pouvoir enregistrer à partir de cet 
endroit.

Vous pouvez également faire appel à ce 
mode lorsque vous enregistrez ou lisez un 
grand nombre de pistes pour diminuer le 
temps de synchronisation à un timecode 
externe.

Pour plus de détails sur les noms attribués 
aux fichiers audio et aux régions dans le 
cadre de nouvelles prises, consultez la 
section Nom des pistes par défaut, 
page 194
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4  Cliquez sur le bouton d'enregistrement de la 
fenêtre Transport. Lorsque vous êtes prêt à 
commencer l'enregistrement, cliquez sur Play.

5  A la fin de l'enregistrement, cliquez sur le 
bouton Stop de la fenêtre Transport.

Le fichier audio correspondant à la nouvelle 
prise est écrit sur le disque et apparaît sous forme 
d'une région audio dans la playlist de la piste. La 
nouvelle région correspondante apparaît dans la 
liste des régions.

L'ancienne prise est conservée sur votre disque 
dur, et figure toujours sous forme de région dans 
la liste des régions.

Pour enregistrer de façon destructive sur une prise 
précédente :

1  Sélectionnez Options > Destructive Record. 
Lorsque vous travaillez en mode 
d'enregistrement destructif, un « D » s'inscrit 
dans le bouton Record Enable.

2  Vérifiez que la piste contenant la prise 
précédente est toujours activée en 
enregistrement.

Si Options > Link Timeline and Edit Selection 
est actif, cliquez n'importe où dans la playlist de 
la piste pour pouvoir enregistrer à partir de cet 
endroit.

3  Pour enregistrer à partir du début de la piste, 
cliquez sur Return to Zero (Retour à zéro) dans la 
fenêtre Transport.

– ou –

Si Options > Link Timeline and Edit Selection 
est actif, cliquez n'importe où dans la playlist de 
la piste pour pouvoir enregistrer à partir de cet 
endroit.

4  Cliquez sur le bouton d'enregistrement de la 
fenêtre Transport. Lorsque vous êtes prêt à 
commencer l'enregistrement, cliquez sur Play.

5  A la fin de l'enregistrement, cliquez sur le 
bouton Stop de la fenêtre Transport.

Les données audio de la nouvelle prise sont 
écrites sur le disque, remplaçant de façon 
définitive les données précédentes. 
Les nouvelles données viennent remplacer les 
données d'origine dans la région existante. 
La région n'est pas renommée.

Ajout de nouvelles données à la fin 
d'une piste

Vous pouvez également ajouter de nouvelles 
données à la fin d'une piste. Pour ce faire, 
placez-vous à la fin de la piste en vous servant du 
bouton Go to End de la fenêtre Transport (vous 
passerez ainsi à la fin de la session ) ou appuyez 
plusieurs fois sur la touche de tabulation pour 
vous rendre à la fin de la piste. Il suffit alors de 
commencer l'enregistrement à partir de ce 
point ; les données enregistrées par Pro Tools 
viendront s'ajouter en fin de piste. Si vous 
travaillez en mode d'enregistrement destructif, 
les nouvelles données audio s'ajoutent au fichier 

Pour enregistrer une partie spécifique de la 
piste, avec des points de début et de fin 
précis, consultez la section 
Enregistrement audio fractionné, 
page 217.

Le mode d'enregistrement destructif est activé

Destructive
Record

Pour enregistrer une partie spécifique de la 
piste, avec des points de début et de fin 
précis, consultez la section 
Enregistrement audio fractionné, 
page 217.
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audio et à la région à partir de la première prise. 
Si vous travaillez en mode d'enregistrement non 
destructif, un nouveau fichier et une nouvelle 
région sont créés.

Enregistrement vers une nouvelle 
playlist

Plutôt que d'écraser des régions audio existantes, 
il existe une autre manière d'enregistrer de 
nouvelles prises sur la même piste de façon non 
destructive. Pour ce faire, il suffit de créer une 
playlist pour la piste, puis d'effectuer 
l'enregistrement comme précédemment.

Les pistes peuvent posséder plusieurs playlists 
d'édition, chacune mémorisant une liste des 
régions et l'ordre dans lequel les lire. Comme les 
playlists suivent les groupes, le fait de dupliquer 
ou de sélectionner une autre playlist pour une 
piste du groupe activé portera sur toutes les 
pistes du groupe.

Pour enregistrer vers une nouvelle playlist de 
piste :

1  Cliquez sur le sélecteur de playlist de la piste et 
choisissez New.

2  Donnez un nom à la nouvelle playlist, puis 
cliquez sur OK.

Lorsqu'une playlist est créée, son nom remplace 
celui de la piste. Lorsque cette liste de diffusion 
est active, les noms des nouveaux fichiers audio 
et des nouvelles régions sont basés sur le sien.

3  Vérifiez que la piste est toujours activée en 
enregistrement.

4  Dans la fenêtre Transport, cliquez sur Return 
to Zero.

5  Cliquez sur le bouton d'enregistrement de la 
fenêtre Transport. Lorsque vous êtes prêt à 
commencer l'enregistrement, cliquez sur Play.

6  A la fin de l'enregistrement, cliquez sur le 
bouton Stop de la fenêtre Transport.

Le fichier audio correspondant à la nouvelle 
prise est écrit sur le disque et apparaît sous forme 
d'une région audio dans la playlist de la piste. La 
nouvelle région correspondante apparaît dans la 
liste des régions.

7  Pour écouter la nouvelle prise, cliquez sur Play 
dans la fenêtre Transport.

8  Pour revenir à une playlist précédente et la 
comparer avec la nouvelle prise, cliquez sur le 
sélecteur de playlist de la piste et sélectionnez la 
playlist précédente.

La sélection d'une playlist rappelle ses régions 
telles qu'elles apparaissaient auparavant dans la 
piste. A tout moment, toutes les régions de 
toutes les playlists sont disponibles dans la liste 
des régions et peuvent être 
mélangées/combinées entre playlists et pistes.

Sélecteur de playlist

Pour plus d'informations sur les playlists et 
leur édition, consultez la section Playlists, 
page 290.
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Enregistrement audio 
fractionné
Pour définir une région d'enregistrement sur 
une playlist ou remplacer une partie de piste 
enregistrée, vous pouvez définir un point d'entrée 
d'enregistrement en spécifiant la région à 
enregistrer avant de commencer 
l'enregistrement.

Bien qu'il existe plusieurs manières de définir les 
plages d'enregistrement et de lecture (voir 
Définition des points d'enregistrement 
fractionné et de boucle, page 222), la plus 
simple est peut-être de sélectionner au sein de la 
playlist la région à enregistrer.

Lors de l'enregistrement, la lecture commence 
dès le point déterminé par la durée de pré-roll (si 
la fonction correspondante est activée) et se 
poursuit jusqu'au point de début (point d'entrée 
de l'enregistrement), là où démarre 
effectivement l'enregistrement. Lorsque le point 
de fin est atteint (point de sortie de 
l'enregistrement), Pro Tools sort 
automatiquement du mode d'enregistrement et 
continue la lecture pendant la durée de post-roll 
définie. Cette fonction automatisée de point 

d'entrée et de sortie de l'enregistrement 
constitue un moyen puissant et précis 
d'enregistrer ou de réenregistrer une partie de 
piste.

Pour effectuer un enregistrement fractionné sur 
une piste audio :

1  Pour effectuer un enregistrement non 
destructif, assurez-vous de ne pas activer 
Options > Destructive Record.

– ou –

Si vous avez décidé de remplacer les données de 
la région spécifiée, activez Options > Destructive 
Record.

2  Vérifiez que la piste est toujours activée en 
enregistrement.

3  Sélectionnez Options > Link Timeline and 
Edit Selection.

4  A l'aide du sélecteur, faites glisser la playlist de 
la piste jusqu'à ce que la sélection englobe la 
plage souhaitée. Pour connaître d'autres 
méthodes permettant de définir la plage 
d'enregistrement, consultez la section 
Définition des points d'enregistrement 
fractionné et de boucle, page 222.

Pour entrer et sortir manuellement des 
pistes audio préparées pour l'enregistrement 
pendant la lecture, reportez-vous à la 
section Enregistrement audio 
QuickPunch, page 251, ou 
Enregistrement audio TrackPunch, 
page 255.

Pour définir une plage d'enregistrement par 
sélection dans une playlist, les sélections 
d'édition et de timeline doivent être liées 
(choisissez Options > Link Timeline and 
Edit Selection).

Si vous enregistrez en n'importe quel mode 
autre que le mode destructif, les 
enregistrements fractionnés ne remplacent 
pas définitivement les données enregistrées. 
Si vous avez décidé de remplacer les données 
de la région spécifiée (et de ne conserver que 
la prise la plus récente), activez Options > 
Destructive Record.
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5  Pour écouter ce qui se trouve déjà sur la piste 
jusqu'au point d'entrée, ou après le point de 
sortie de l'enregistrement, activez les pré et post-
roll et entrez leurs durées. Pour en savoir plus, 
reportez-vous à la section Définition des 
paramètres de pré et post-roll, page 225.

6  Cliquez sur le bouton d'enregistrement de la 
fenêtre Transport. Lorsque vous êtes prêt à 
commencer l'enregistrement, cliquez sur Play.

Lorsque le point de début est atteint, Pro Tools 
commence l'enregistrement. Celui-ci se poursuit 
jusqu'à ce que le point de sortie de 
l'enregistrement soit atteint, sauf si vous cliquez 
sur Stop dans la fenêtre Transport. Si le post-roll 
est activé, la lecture se poursuit pendant le 
temps spécifié.

Si vous travaillez en mode non destructif, un 
nouveau fichier audio est écrit sur le disque et 
une nouvelle région apparaît dans la piste 
d'enregistrement et la liste des régions.

Si vous travaillez en mode destructif, les 
nouvelles données audio remplacent les 
précédentes dans le fichier audio et la région 
existants.

Ecoute pendant les enregistrements 
fractionnés

Pro Tools propose deux modes d'écoute pour 
l'enregistrement : Auto Input Monitoring 
et Input Only Monitoring. Pour en savoir plus, 
reportez-vous à la section Mode d'écoute Auto 
Input, page 190.

Enregistrement audio en 
boucle
Pro Tools offre un mode d'enregistrement en 
boucle qui vous permet d'enregistrer prise après 
prise tandis que la même section audio se répète 
sans cesse. Cette technique est pratique pour 
enregistrer rapidement plusieurs prises d'une 
partie sans perdre la spontanéité.

Lorsque vous effectuez un enregistrement en 
boucle, il faut commencer par indiquer les 
points de début et de fin de la boucle. Bien qu'il 
existe plusieurs manières de définir les plages 
d'enregistrement et de lecture (voir Définition 
des points d'enregistrement fractionné et de 
boucle, page 222), la plus simple est peut-être de 
sélectionner au sein de la playlist le matériel à 
mettre en boucle.

Le paramètre de pré-roll, s'il est activé, est utilisé 
lors de la première passe d'enregistrement 
uniquement. Le paramètre de post-roll, s'il est 
activé, est utilisé uniquement pour la dernière 
passe. Les temps de pré- et post-roll sont ignorés 
lors de chaque boucle successive. Pour 
compenser cela, vous pouvez rallonger 
provisoirement la boucle, quitte à rétablir par la 
suite la durée appropriée en appliquant l'outil de 
trimming sur les prises enregistrées (voir Outil 
de trimming, page 310).

Pour définir une plage d'enregistrement par 
sélection dans une playlist, les sélections 
d'édition et de timeline doivent être liées 
(sélectionnez Options > Link Timeline and 
Edit Selection).
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Lorsque vous effectuez un enregistrement audio 
en boucle, Pro Tools crée un seul fichier audio 
regroupant toutes les prises. Les prises 
apparaissent sous forme de régions distinctes 
dans la liste des régions et sont numérotées de 
façon séquentielle. Après avoir arrêté 
l'enregistrement, vous pouvez écouter n'importe 
quelle prise d'enregistrement.

Pour effectuer un enregistrement en boucle sur 
une piste audio :

1  Sélectionnez Options > Loop Record. Lorsque 
le mode Loop Record est actif, le symbole d'une 
boucle apparaît dans le bouton Record Enable.

2  Préparez en enregistrement la piste audio en 
cliquant sur son bouton Record Enable.

3  Sélectionnez Options > Link Timeline and 
Edit Selection.

4  A l'aide du sélecteur, faites glisser la playlist de 
la piste jusqu'à ce que la sélection englobe la 
boucle désirée.

Pour connaître d'autres méthodes permettant de 
définir la plage d'enregistrement, consultez la 
section Définition des points d'enregistrement 
fractionné et de boucle, page 222.

5  Pour écouter les données se trouvant déjà sur 
la piste jusqu'au point de début de la boucle, 
activez le pré-roll et définissez sa durée. Pour en 
savoir plus, reportez-vous à la section Définition 
des paramètres de pré et post-roll, page 225.

6  Cliquez sur le bouton d'enregistrement de la 
fenêtre Transport. Lorsque vous êtes prêt à 
commencer l'enregistrement, cliquez sur Play.

Le bouton Record Enable clignote pendant le 
pré-roll. Lorsque le point de début est atteint, 
Pro Tools commence l'enregistrement. Une fois 
le point de fin atteint, Pro Tools retourne au 
début et poursuit la lecture et l'enregistrement.

7  Pour annuler toutes les prises enregistrées 
pendant un enregistrement en boucle, appuyez 
sur Ctrl + point (.) (Windows) ou sur 
Pomme + point (.) (Macintosh).

8  A la fin de l'enregistrement, cliquez sur le 
bouton Stop de la fenêtre Transport.

Si vous arrêtez l'enregistrement avant d'avoir 
atteint le milieu de la boucle, Pro Tools élimine 
cette prise. Si vous enregistrez sur plus de la 
moitié de la boucle, Pro Tools laisse la prise sur 
la piste lorsque vous arrêtez l'enregistrement.

Les prises enregistrées apparaissent sous forme 
de régions dans la liste des régions et sont 
numérotées de façon séquentielle. La prise la 
plus récente reste sur la piste d'enregistrement. 
Pour plus de détails sur l'écoute de plusieurs 
prises, reportez-vous à la section Ecoute des 
prises enregistrées dans la timeline, page 220.

Lecture en boucle et enregistrement 
audio

Pro Tools ignore la lecture en boucle lors de 
l'enregistrement. La seule manière de définir 
une boucle pendant l'enregistrement est 
d'activer le mode Loop Record.

Pour utiliser d'autres prises créées avec Loop 
Record au cours de sessions différentes (en 
utilisant, par exemple, la boîte de dialogue 
Import Session Data), exportez les 
définitions des régions (voir Exportation 
des définitions des régions, page 164). Si 
les définitions des régions ne sont pas 
exportées, les autres prises créées avec Loop 
Record ne seront pas accessibles lorsqu'elles 
seront importées dans une autre session. 

Mode d'enregistrement en boucle activé
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Ecoute des prises 
enregistrées dans la timeline
Après avoir enregistré plusieurs prises, en 
enregistrement en boucle ou fractionné, vous 
pouvez remplacer la prise se trouvant sur la piste 
par des prises précédentes pour les écouter dans 
la timeline, dans le contexte de la session. Les 
prises doivent avoir la même heure de début 
pour être disponibles. Elles peuvent également 
être écoutées seules, depuis la liste des régions 
ou depuis le menu déroulant de la liste des 
prises.

Toutes les prises sont numérotées de façon 
séquentielle.

Sélection d'une prise différente 
dans la liste des régions

Pour sélectionner une prise dans la liste des 
régions :

1  Dans la fenêtre Edit, sélectionnez la prise en 
cours avec l'outil d'accrochage de temps.

2  Faites glisser une autre prise en maintenant 
enfoncée la touche Ctrl (Windows) ou sur 
Pomme (Macintosh) dans la liste de régions.

La région remplace la prise précédente et se 
positionne précisément à l'endroit correct.

3  Répétez les étapes précédentes pour écouter 
d'autres prises.

Sélection d'une prise différente 
depuis le menu déroulant de la 
liste des prises

Chaque région résultant d'une passe 
d'enregistrement fractionné ou en boucle 
possède un temps de début identique (le 
marqueur de temps de l'utilisateur). Ceci permet de 
sélectionner et d'écouter facilement des prises à 
partir du menu déroulant de la liste des prises, 
même pendant que la session est en lecture ou 
en boucle.

Pour sélectionner une prise à partir du menu 
déroulant de la liste des prises :

1  Maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Macintosh) pendant que vous 
cliquez avec le sélecteur sur le début précis de la 
plage d'enregistrement en boucle ou fractionné.

– ou –

Si la prise se trouvant sur la piste est 
sélectionnée, maintenez enfoncée la touche Ctrl 
(Windows) ou Pomme (Macintosh) pendant 
que vous cliquez dessus avec le sélecteur.

Un menu déroulant apparaît ; il contient une 
liste des régions qui partagent le même 
marqueur de temps de l'utilisateur.

2  Sélectionnez une région dans le menu 
déroulant de la liste des prises. La région 
remplace la prise précédente et se positionne 
précisément à l'endroit correct.

3  Répétez les étapes précédentes pour écouter 
d'autres prises.

Menu déroulant de la liste des prises
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Une façon de vous assurer que les futures prises 
utilisent le même marqueur de temps utilisateur 
(et apparaissent dans le menu déroulant de la 
liste des prises) consiste à sauvegarder les 
sélections d'enregistrement en boucle ou 
fractionné sous forme de mémoire 
d'emplacement. Si, par la suite, vous devez 
enregistrer d'autres prises, il vous suffit de 
rappeler la mémoire d'emplacement. Pour plus 
d'informations, reportez-vous à la section 
Emplacements mémoire, page 224.

Pour changer le marqueur de temps utilisateur 
d'autres régions afin qu'elles apparaissent dans 
le menu déroulant de la liste des prises 
correspondant à un endroit précis, utilisez la 
commande du menu déroulant de la liste des 
régions. Pour plus d'informations, reportez-vous 
à la section Marquage temporel, page 792.

Liste des prises et pistes multiples

Si vous avez enregistré plusieurs pistes 
contenant chacune des prises dotées d'un 
marqueur de temps utilisateur identique, vous 
pouvez utiliser le menu déroulant de la liste des 
prises pour remplacer toutes les prises 
simultanément.

Pour remplacer les prises de plusieurs pistes :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Editing.

2  Activez les options suivantes:

• Take Region Name(s) That Match Track 
Names

– et –

• Take Regions Lengths That Match

3  Cliquez sur Done pour refermer la boîte de 
dialogue Preferences.

4  A l'aide du sélecteur, sélectionnez la région de 
la prise de chaque piste audio à remplacer.

5  Maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Macintosh) tout en cliquant avec le 
sélecteur sur n'importe quelle prise sélectionnée.

Un menu déroulant apparaît ; il contient une 
liste des régions partageant un même marqueur 
de temps utilisateur pour cette piste.

6  Sélectionnez une région dans le menu 
déroulant de la liste des prises. La région 
remplace la prise précédente et se positionne 
précisément à l'endroit correct. Les mêmes 
numéros de prises sont automatiquement 
sélectionnés pour les autres pistes sélectionnées.

Préférences d'édition des prises

En plus de partager un même marqueur de 
temps utilisateur, les régions apparaissant dans 
le menu déroulant de la liste des prises sont 
également restreintes au niveau des options 
définies dans la boîte de dialogue Preferences.

Pour définir les préférences d'édition des prises :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Editing.

2  Activez ou désactivez les options suivantes de 
la zone Matching Start Time de la liste des 
prises :

Take Region Name(s) That Match Track
Names : lorsque cette option est sélectionnée, 
seules les régions partageant le même nom 
racine avec la piste ou la playlist apparaissent 
dans le menu déroulant de la liste des prises. Par 
exemple, la liste des prises d'une piste nommée 
« Gtr.L » montrerait les régions « Gtr.L_01 » et 
« Gtr.L_02-01 », mais pas « Guit.L_01 ». 

Take Regions Lengths That Match : lorsque cette 
option est sélectionnée, seules les régions qui 
correspondent à la durée de la sélection en cours 
(même s'il ne s'agit pas d'une région entière) 
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apparaissent dans le menu déroulant de la liste 
des prises. S'il n'y a aucune sélection, toutes les 
prises ayant le même marqueur de temps 
utilisateur s'affichent.

« Separate Region » Operates On All Related
Takes : Lorsque l'option Separate Region 
Operates On All Related Takes est sélectionnée, 
l'édition d'une région avec la commande 
Separate Region concerne également toutes les 
prises associées possédant le même marqueur de 
temps de l'utilisateur.

Cette option aide à comparer différentes 
sections d'un groupe de prises associées. Par 
exemple, vous pouvez rapidement séparer en 
sections tout un groupe de prises de voix 
associées, puis écouter et sélectionner 
indépendamment les meilleurs moments de 
chaque section.

Lorsque cette option est sélectionnée, vérifiez 
que les options Take Region Names That Match 
Track Name(s) et Take Region Lengths that 
Match le sont également. Si ce n'est pas le cas, 
toutes les régions de la session possédant le 
même marqueur de temps utilisateur seront 
concernées.

Dans la plupart des cas, il sera préférable de 
désélectionner l'option Separate Region 
Operates On All Related Takes pour éviter de 
créer un grand nombre de régions lorsque vous 
utiliserez la commande Separate Region.

Définition des points 
d'enregistrement fractionné 
et de boucle
Les points de début et de fin d'une plage 
d'enregistrement fractionné et en boucle 
peuvent être définis à l'aide des méthodes 
suivantes :

• Sélectionnez une plage dans la playlist 
d'une piste.

• Sélectionnez une plage dans une règle 
temporelle.

• Faites glisser les marqueurs de lecture dans 
la règle.

• Entrez les temps de début et de fin dans la 
fenêtre Transport.

• Rappelez une mémoire d'emplacement.

Pour définir la région à enregistrer dans la playlist 
d'une piste :

1  Si vous le souhaitez, réglez le mode d'édition 
sur Grid pour restreindre la sélection en 
fonction du pas de grille actuel. 

2  Sélectionnez Options > Link Timeline and 
Edit Selection.

3  A l'aide du sélecteur, faites défiler la playlist 
d'une piste jusqu'à ce que la sélection recouvre 
la plage désirée.

– ou –

Si la plage d'enregistrement est définie par les 
points de début et de fin d'une région, cliquez 
sur la région avec l'outil d'accrochage de temps.

Sélection de la playlist
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Pour définir la région à enregistrer dans une règle 
temporelle :

1  Si vous le souhaitez, réglez le mode d'édition 
sur Grid pour restreindre la sélection en 
fonction du pas de grille actuel. 

2  A l'aide du sélecteur, faites défiler une règle de 
la base de temps jusqu'à ce que la sélection 
recouvre la plage d'enregistrement.

Marqueurs de lecture

Lorsque des pistes sont préparées en 
enregistrement, des marqueurs de lecture 
correspondant aux temps de début et de fin 
apparaissent sous forme de flèches rouges vers le 
haut et vers le bas dans la règle temporelle 
principale. Si aucune piste n'est activée en 
enregistrement, les marqueurs de lecture sont 
bleus.

Vous pouvez faire glisser les marqueurs de 
lecture, séparément ou ensemble, pour définir 
les plages de lecture et d'enregistrement.

Pour définir la plage d'enregistrement en 
déplaçant les marqueurs de lecture :

1  Si vous le souhaitez, réglez le mode d'édition 
sur Grid jusqu'à ce que les marqueurs de lecture 
s'alignent sur la valeur de grille en cours.

2  Faites glisser le premier marqueur de lecture 
(flèche vers le bas) sur le point de début de la 
plage.

3  Faites glisser le second marqueur de lecture 
(flèche en haut) sur le point de fin de la plage.

Champ de début, de fin et de durée

En affichage étendu, la fenêtre Transport peut 
afficher les temps de début (start), de fin (end) et 
de durée (length), ainsi que les valeurs des 
paramètres de pré et de post-roll. Lorsque vous 
définissez une plage d'enregistrement ou de 
lecture, ces champs en indiquent les paramètres.

Vous pouvez également entrer des points de 
départ et de fin au cours de la lecture. 
Appuyez sur la flèche vers le haut pour 
définir le point de début et sur la flèche vers 
le bas pour définir le point de fin. Si vous 
utilisez cette approche en mode Grid, 
l'alignement sur la grille n'est pas respecté.

Sélection dans la règle temporelle

Si le sélecteur est désactivé, vous n'avez pas 
besoin de le sélectionner manuellement. 
D'autres outils d'édition (tels que l'outil 
d'accrochage de temps) se transforment 
automatiquement en sélecteur dans la règle 
temporelle.

Marqueurs de lecture dans la règle temporelle 
principale

Déplacement d'un marqueur de lecture (temps de 
début) dans la règle temporelle principale

Si la plage d'enregistrement en cours est déjà 
de la bonne durée et qu'il suffise de la 
déplacer, faites glisser l'un des marqueurs 
de lecture en maintenant appuyée la touche 
Alt (Windows) ou Option (Macintosh) pour 
déplacer l'ensemble vers un nouvel 
emplacement (tout en conservant la même 
durée).
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Vous pouvez entrer des valeurs dans les champs 
de début et de fin pour définir la région à lire ou 
à enregistrer. Les marqueurs de lecture sont mis 
à jour en conséquence dans la règle temporelle 
principale.

Pour définir la plage d'enregistrement en entrant 
les temps de début et de fin dans la fenêtre 
Transport :

1  Pour consulter les temps de début, de fin ainsi 
que la durée, effectuez l'une des opérations 
suivantes :

• Choisissez View > Transport > Expanded.

– ou –

• Dans la fenêtre Transport, cliquez sur le 
bouton Développer/Réduire (icône +), en 
appuyant sur la touche Maj.

2  Dans la fenêtre Transport, cliquez sur le 
champ Start

– ou –

Appuyez sur Alt + barre oblique (/) (Windows) 
ou sur Option + barre oblique (/) (Macintosh) 
sur le pavé numérique pour sélectionner le 
champ Start de la fenêtre Transport.

3  Tapez l'emplacement de début, puis appuyez 
sur Alt + barre oblique (/) (Windows) ou sur 
Option + barre oblique (/) (Macintosh) du pavé 
numérique pour valider la valeur et passer 
automatiquement au champ de fin.

4  Tapez l'emplacement de fin, puis appuyez sur 
Entrée pour valider la valeur.

Emplacements mémoire

Vous pouvez stocker des sélections d'édition 
avec emplacements de mémoire, qui peuvent 
inclure les valeurs actuelles de pré- et post-roll.

Pour plus d'informations sur les mémoires 
d'emplacement, consultez la section 
Emplacements mémoire et marqueurs, 
page 457.

Pour sauvegarder une sélection d'édition à l'aide 
d'une mémoire d'emplacement :

1  Sélectionnez Options > Link Timeline and 
Edit Selection.

2  Définissez la plage d'enregistrement en 
effectuant une sélection dans la playlist ou dans 
la règle, ou en entrant les temps de début et de 
fin dans la fenêtre Transport.

3  Pour enregistrer les valeurs de pré- et de post-
roll, activez et définissez les durées de pré- et de 
post-roll en les saisissant dans la fenêtre 
Transport ou en faisant glisser les drapeaux leur 
correspondant dans la règle représentant 
l'échelle temporelle principale. Pour plus de 
détails, consultez la section Définition des 
paramètres de pré et post-roll, page 225

4  Appuyez sur la touche Entrée du pavé 
numérique ou cliquez sur le bouton Add 
Marker/Memory Location dans la fenêtre Edit.

5  Dans la boîte de dialogue New Memory 
Location, cochez l'option Selection de la zone 
Time Properties et, si vous le souhaitez, dans la 
zone General Properties, cochez l'option 
Pre/Post Roll Times.

Fenêtre Transport avec affichage des champs de début, 
de fin et de durée

Utilisez la touche point (.) ou les flèches 
droite et gauche pour vous déplacer dans les 
champs Start/End. Utilisez les flèches haut 
et bas pour augmenter ou réduire les valeurs 
numériques.
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6  Saisissez un nom pour le nouvel emplacement 
mémoire et cliquez sur OK pour l'enregistrer.

Pour rappeler une sélection d'édition à l'aide d'un 
emplacement de mémoire :

1  Sélectionnez Options > Link Timeline and 
Edit Selection.

2  Sélectionnez Windows> Memory Locations.

3  Effectuez l'une des opérations suivantes :

• Dans la fenêtre Memory Locations, cliquez 
sur le nom ou le numéro de l'emplacement 
de mémoire

– ou –

• Rappelez l'emplacement de mémoire en 
entrant un point (.), le numéro de la 
mémoire et un autre point (.) sur le pavé 
numérique. (Voir Modes du pavé 
numérique, page 43.)

Les temps de début et de fin, ainsi que les 
paramètres de pré et de post-roll stockés dans la 
mémoire d'emplacement, sont rappelés.

Définition des paramètres de pré 
et post-roll

Le début de pré-roll et la fin de post-roll 
apparaissent sous forme de drapeaux dans la 
règle qui représente l'échelle temporelle 
principale. Lorsque les pré et post-roll sont 
activés, les drapeaux sont verts, sinon ils sont 
gris.

Vous pouvez entrer les durées de pré et de 
postroll dans la fenêtre Transport, les définir à 
partir de la playlist d'une piste ou d'une règle 
temporelle, ou en rappelant une mémoire 
d'emplacement.

Réglage des paramètres de Pré- et de 
Post-Roll dans la fenêtre Transport

Vous pouvez activer et définir les paramètres de 
pré et de post-roll dans les champs de la fenêtre 
Transport.

Pour définir et activer les paramètres de pré- et de 
post-roll dans les champs de la fenêtre Transport :

1  Sélectionnez View > Transport > Expanded.

2  Dans la fenêtre Transport, cliquez sur le 
champ pre-roll.

3  Tapez la durée de pré-roll désirée, puis 
appuyez sur la barre oblique (/) du pavé 
numérique pour valider la valeur et passer 
automatiquement au champ Post-roll.

Boîte de dialogue New Memory Location

Fenêtre Memory Locations

Drapeaux de pré/post-roll verts (activés) dans la règle 
temporelle principale
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4  Tapez la durée de post-roll désirée puis 
appuyez sur Entrée pour valider la nouvelle 
valeur.

5  Pour activer le pré- ou le post-roll, cliquez sur 
le bouton correspondant pour le mettre en 
surbrillance.

Réglage des paramètres de Pré- et de 
Post-Roll dans une playlist

Le sélecteur permet d'activer et de désactiver le 
pré et le post-roll en cliquant dans la playlist 
d'une piste.

Pour définir et activer les paramètres de pré- et de 
post-roll en cliquant dans une playlist :

1  Sélectionnez Options > Link Timeline and 
Edit Selection.

2  A l'aide du sélecteur, faites défiler la playlist 
d'une piste jusqu'à ce que la sélection recouvre 
la plage désirée.

3  A l'aide du sélecteur, maintenez enfoncée la 
touche Alt (Windows) ou Option (Macintosh) 
avant la sélection pour activer le pré-roll à cet 
endroit pendant que vous cliquez sur la playlist 
de la piste.

4  A l'aide du sélecteur, maintenez enfoncée la 
touche Alt (Windows) ou Option (Macintosh) 
après la sélection pour activer le post-roll à cet 
endroit pendant que vous cliquez sur la liste de 
diffusion de la piste.

Pour désactiver les paramètres de pré et de post-
roll en cliquant dans une playlist :

1  A l'aide du sélecteur, maintenez enfoncée la 
touche Alt (Windows) ou Option (Macintosh) 
pour désactiver le pré-roll pendant que vous 
cliquez sur la sélection d'une piste près du début.

2  A l'aide du sélecteur, maintenez enfoncée la 
touche Alt (Windows) ou Option (Macintosh) 
pour désactiver le post-roll pendant que vous 
cliquez sur la sélection d'une piste près de la fin.

3  Faites glisser le drapeau de pré-roll jusqu'au 
marqueur de lecture sur le point de début de la 
gamme.

4  Faites glisser le drapeau de post-roll jusqu'au 
marqueur de lecture sur le point de fin de la 
gamme.

Activation des paramètres de pré et de 
post-roll dans le menu Options

Vous pouvez activer et désactiver les paramètres 
de pré et de post-roll (ensemble) dans le menu 
Options.

Pour activer à la fois le pré et le post-roll à partir 
du menu Options :

■ Sélectionnez Options > Pre/Post-Roll.

Utilisez la touche point (.) ou les flèches 
droite et gauche pour vous déplacer dans les 
champs Pre-roll et Post-roll. Utilisez les 
flèches haut et bas pour augmenter ou 
réduire les valeurs numériques. Dans la timeline, vous pouvez régler le pré- 

et le post-roll sur zéro. Tout d'abord, faites 
glisser le drapeau de pré-roll jusqu'au 
marqueur de lecture sur le point de début de 
la plage, puis faites glisser le drapeau de 
post-roll jusqu'au marqueur de lecture sur le 
point de fin de la gamme.
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Déplacement des drapeaux de pré- et 
post-roll dans la règle temporelle

Vous pouvez faire glisser les drapeaux de pré- et 
de post-roll dans la règle, soit séparément, soit 
ensemble, pour définir leur emplacement.

Pour définir les paramètres de pré et de post-roll 
en se déplaçant sur la règle :

1  Si vous le souhaitez, réglez le mode d'édition 
sur Grid jusqu'à ce que les drapeaux déplacés 
s'alignent sur la valeur de grille en cours.

2  Faites glisser le drapeau de pré-roll vers 
l'emplacement désiré dans la règle.

3  Faites glisser le drapeau de post-roll vers 
l'emplacement désiré dans la règle temporelle.

Enregistrement à partir d'une 
source numérique
Si vous envisagez d'utiliser un lecteur DAT ou un 
enregistreur de CD à sortie numérique ou tout 
autre dispositif d'entrée et de sortie numérique 
avec votre système Pro Tools, vérifiez qu'il est 
compatible avec son format numérique. 
Les entrées et les sorties AES/EBU de votre 
interface, par exemple, doivent uniquement 
être connectées à un appareil AES/EBU.

Options numériques Pro Tools|HD

Les interfaces 192 I/O, 192 Digital I/O et 96 I/O 
sont dotées d'options numériques AES/EBU, 
S/PDIF et ADAT. Les interfaces 192 I/O et 
192 Digital I/O incluent également des options 
d'I/O numériques TDIF. L'interface 96i I/O ne 
comprend que l'option numérique S/PDIF.

Sur les interfaces 192 I/O, 192 Digital I/O ou 
96 I/O, Pro Tools peut recevoir à tout moment 
des données audionumériques à partir de 
l'interface d'I/O Optical (ADAT) pré-installée 
(si le réglage est autre que S/PDIF). Toutefois, 
Pro Tools peut recevoir des données 
audionumériques uniquement à partir de l'une 
des sources [Encl] numériques situées sur son 
châssis (AES, Optical (S/PDIF) ou S/PDIF).

Toutes les interfaces Pro Tools|HD I/O 
comportent des sources numériques situées sur 
le châssis, et qui apparaissent à l'écran sous 
forme de versions [Encl] pour les différencier des 
entrées et sorties numériques disponibles sur la 
carte Digital I/O 192. Les entrées et sorties 
AES/EBU, par exemple, incluses dans toutes les 
interfaces 192 I/O, sont identifiées de la façon 
suivante : AES/EBU [Encl].

Déplacement d'un drapeau de pré-roll dans la règle 
temporelle

Pour définir des durées de pré et de post-roll 
identiques, faites glisser le drapeau de pré-
roll ou celui de post-roll dans la règle, tout 
en appuyant sur la touche Alt (Windows) 
ou Option (Macintosh). Le drapeau 
désélectionné reprendra immédiatement la 
même valeur et s'adaptera lorsque vous 
faites glisser le drapeau sélectionné.
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Les ports numériques supplémentaires de 
l'interface 192 I/O et 192 Digital I/O sont les 
suivants : AES/EBU et ADAT. Pro Tools ne peut 
recevoir des données audionumériques que de 
l'un de ces ports à la fois.

Toutefois, les entrées de la carte numérique et 
du châssis de l'interface audio 192 I/O peuvent 
être utilisées simultanément. Sur une interface 
192 I/O, par exemple, il est possible de 
désactiver une source provenant de l'une des 
entrées situées sur le châssis et de faire effectuer 
à une autre entrée au niveau des ports 
numériques une conversion de fréquence 
d'échantillonnage, pour bénéficier ainsi de deux 
sources numériques.

Options numériques Pro Tools LE

Les systèmes Digi 002 et Digi 002 Rack incluent 
les options numériques S/PDIF et ADAT I/O. 

Mbox 2 et Mbox ne comprennent que l'option 
numérique S/PDIF.

Toutes les sorties numériques sont actives en 
permanence. Vous pouvez ainsi envoyer 
simultanément des données audionumériques 
vers plusieurs périphériques numériques. 

Enregistrement à partir de 
sources numériques

Pour enregistrer à partir d'une source numérique 
avec Pro Tools (dans cet exemple, depuis un 
enregistreur DAT) :

1  Connectez la sortie numérique de votre 
enregistreur DAT à l'entrée appropriée de votre 
dispositif audio.

2  Si vous souhaitez commencer une nouvelle 
session avec une fréquence d'échantillonnage 
différente, choisissez File > New Session et 
sélectionnez la fréquence d'échantillonnage. 
Cliquez sur Save.

3  Assurez-vous de spécifier le format 
(numérique) des entrées de l'interface audio que 
vous utiliserez. Choisissez Setup > Hardware, 
puis sélectionnez l'interface et le format de la 
paire de canaux qui convient. 

Certaines unités d'I/O Digidesign ne disposent 
que de deux canaux pouvant être réglés en 
mode analogique ou numérique. Par exemple, 
Mbox 2 dispose des entrées numériques S/PDIF 
L–R (stéréo) et des entrées analogique In 1–2. 
Mbox 2 peut enregistrer simultanément à partir 
des entrées analogiques et numériques. 

De plus, si votre dispositif audio prend en 
charge différents formats numériques (tels que 
AES/EBU et S/PDIF), sélectionnez le format 
numérique que vous utiliserez.

4  Pour les systèmes Pro Tools|HD, sélectionnez 
Setup > Hardware, puis sélectionnez la source 
d'horloge appropriée connectée à l'interface 
audio d'I/O appropriée ; vous pouvez également 
sélectionner l'horloge appropriée à partir de la 
fenêtre Session Setup. 

5  Cliquez sur OK pour refermer la boîte de 
dialogue Hardware Setup.

6  Choisissez Track > New et indiquez 1 Stereo 
Audio Track, puis cliquez sur Create.

7  Assignez les sélecteurs de chemin d'entrée de 
la piste à l'entrée appropriée. Puisqu'il s'agit d'un 
transfert dans le domaine numérique, vous 
n'avez pas à vous soucier des niveaux d'entrée.
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8  Dans la fenêtre Mix, cliquez sur le sélecteur de 
chemin de sortie de la piste pour affecter une 
sortie matérielle stéréo.

– ou –

Dans la fenêtre Edit, activez l'affichage I/O et 
utilisez le sélecteur de chemin de sortie de la 
piste pour lui affecter une sortie matérielle.

9  Dans le menu Options, désélectionnez les 
options Destructive Record, Loop Record, 
QuickPunch et TrackPunch.

10  Dans la fenêtre Transport, cliquez sur Return 
to Zero pour effacer les temps de début et de fin. 
Cela garantit que l'enregistrement commencera 
au début de la piste.

11  Dans la fenêtre Mix ou Edit, préparez la 
nouvelle piste audio pour l'enregistrement en 
cliquant sur son bouton Record Enable.

12  Cliquez sur le bouton d'enregistrement de la 
fenêtre Transport. Lorsque vous êtes prêt à 
commencer l'enregistrement, cliquez sur Play.

13  Démarrez la lecture sur l'enregistreur DAT.

14  Lorsque la lecture des données du DAT est 
terminée, cliquez sur Stop dans la fenêtre 
Transport.

Après un transfert numérique

Lorsque vous avez terminé un enregistrement 
numérique, rétablissez sur Internal le menu 
déroulant Clock Source de la fenêtre de 
configuration de la session (Session Setup). Dans 
le cas contraire, Pro Tools ne repassera pas sur 
son horloge interne et ne pourra ni enregistrer 
ni lire correctement les données audio. Le non-

rétablissement de la synchronisation interne 
pose en général des problèmes de hauteur 
(lecture trop rapide ou trop lente)de clics et 
autres parasites, ou crée des erreurs DAE, car un 
enregistreur DAT ou de CD en veille peut revenir 
à une fréquence d'échantillonnage différente 
par défaut ou s'arrêter complètement de fournir 
un signal d'horloge.

Enregistrement et lecture à 
demi-vitesse
Pro Tools autorise la lecture et l'enregistrement à 
demi-vitesse. Cette fonction est semblable à 
celle d'un magnétophone, qui permet 
d'enregistrer des signaux à demi-vitesse, puis de 
les lire à vitesse normale (soit une octave au-
dessus) afin d'obtenir des effets spéciaux.

Pour enregistrer à demi-vitesse :

1  Appuyez Maj + Ctrl + Z (Windows) ou sur Maj 
+ Pomme + Z (Macintosh). L'enregistrement 
commence et la lecture de toutes les données 
existantes s'effectue à demi-vitesse.

2  A la fin de l'enregistrement, cliquez sur Stop.

En lecture à vitesse normale, les données 
enregistrées à demi-vitesse sont lues deux fois 
plus vite (une octave au-dessus).

Pour plus d'informations sur la 
configuration de votre système Pro Tools 
pour l'enregistrement depuis une source 
numérique, reportez-vous au guide de 
démarrage s'y rapportant.

Pour enregistrer des pistes MIDI dont la 
lecture est difficile ou des mouvements 
d'automation complexes, utilisez 
l'enregistrement à demi-vitesse. 
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Pour lire à demi-vitesse :

1  Appuyez sur Maj + Barre d'espace. La lecture 
commence et la lecture des données s'effectue à 
demi-vitesse. Toute piste audio enregistrée à 
vitesse normale sera lue à demi-vitesse (et une 
octave en dessous), tandis que la sonorité des 
pistes audio qui ont été enregistrées à demi-
vitesse sera normale.

2  Cliquez sur le bouton d'arrêt de la fenêtre 
Transport pour arrêter la lecture.

Vous pouvez également déclencher la 
lecture à demi-vitesse en cliquant sur le 
bouton de lecture tout en appuyant sur Maj.

Utilisez la lecture à demi-vitesse pour 
apprendre ou transcrire des passages 
difficiles des pistes enregistrées.
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Chapitre 13 : Enregistrement MIDI

Dans Pro Tools, l'enregistrement MIDI 
ressemble beaucoup à l'enregistrement audio. 
Il existe toutefois quelques différences 
importantes :

◆ Contrairement à l'enregistrement audio, 
l'enregistrement MIDI est presque toujours 
destructif. Pour plus d'informations, consultez 
la section Modes d'enregistrement et MIDI, 
page 201.

◆ Contrairement aux pistes audio, les pistes 
MIDI et les pistes d'instrument peuvent être 
activées en enregistrement à la volée, en cours 
de lecture ou d'enregistrement.

◆ Les pistes MIDI et les pistes d'instrument 
disposent d'un sélecteur d'entrée permettant de 
déterminer le port de votre interface 
(périphériques) et le canal qui sont envoyés et 
enregistrés sur la piste. Si le sélecteur d'entrée 
MIDI est réglé sur All, tous les canaux de tous les 
périphériques sont envoyés à la piste. 

◆ A l'instar des entrées auxiliaires, les pistes 
d'instrument possèdent un sélecteur d'entrée 
audio. Ce sélecteur n'est pas identique à celui de 
la piste d'instrument de l'entrée MIDI.

◆ Il n'est pas nécessaire d'activer les options 
QuickPunch ou TrackPunch pour effectuer des 
entrées d'enregistrement à la volée sur des pistes 
MIDI ou des pistes d'instrument. Cette 
possibilité existe dans le mode d'enregistrement 
normal non destructif et dans le mode 
d'enregistrement destructif.

Enregistrement à partir de 
périphériques MIDI
Les entrées MIDI des pistes MIDI et des pistes 
d'instrument préparées en enregistrement 
déterminent quelles données MIDI seront 
enregistrées dans Pro Tools. Les entrées MIDI 
peuvent être réglées sur un périphérique (port) 
ou un canal donné, ou sur « All » pour que les 
données provenant de tous les périphériques 
soient fusionnées vers la piste.

Les pistes MIDI et d'instrument de Pro Tools ne 
contiennent pas plusieurs canaux et effectuent 
toujours la lecture par l'intermédiaire des 
périphériques et des canaux affectés à la piste 
(sortie MIDI). Il est possible d'enregistrer 
simultanément plusieurs canaux MIDI sur 
plusieurs pistes.

Les options suivantes de Pro Tools déterminent 
si vous pouvez enregistrer à partir d'un 
périphérique de contrôle MIDI :

◆ Les périphériques affectés comme contrôleurs 
MIDI dans la boîte de dialogue Peripherals sont 
ignorés lors de l'enregistrement de pistes MIDI. 
Cela évite l'enregistrement de données 
provenant de surfaces de contrôle MIDI telles 
que la Digidesign Command|8.
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◆ Pour enregistrer et lire des pistes MIDI, le 
dispositif doit être activé dans la boîte de 
dialogue Input Devices (Macintosh 
uniquement). Pour plus d'informations, 
reportez-vous à la section Activation des 
périphériques d'entrée, page 232.

En outre, les options suivantes ont une 
incidence sur la façon dont les données MIDI 
sont enregistrées dans Pro Tools.

◆ Le filtre d'entrée MIDI peut filtrer les messages 
MIDI que vous ne désirez peut-être pas 
enregistrer, tels que des données Polyphonic 
Aftertouch ou System Exclusive. Pour plus 
d'informations, reportez-vous à la section Filtre 
d'entrée MIDI, page 234.

◆ Lorsqu'elle est active, l'option Input Quantize 
quantifie automatiquement toutes les notes 
MIDI enregistrées (corrige automatiquement le 
timing). Pour plus d'informations, reportez-
vous à la section Option Input Quantize, 
page 234.

Activation des périphériques 
d'entrée
Pour enregistrer à partir d'un contrôleur MIDI 
dans Pro Tools, celui-ci doit être activé dans la 
boîte de dialogue Input Devices. Cette boîte de 
dialogue permet de s'assurer que les notes 
indésirables provenant de certains 
périphériques, tels que les boîtes à rythmes ou 
les arpégiateurs, ne sont pas enregistrées.

Surfaces de contrôle MIDI : pour utiliser une 
quelconque surface de contrôle MIDI (telle que 
Digidesign Command|8), celle-ci doit être 
activée dans la boîte de dialogue Input Devices.

MMC : pour que Pro Tools puisse être 
commandé via MMC (MIDI Machine Control), 
le MMC doit être activé comme source dans la 
boîte de dialogue Input Devices.

Pour activer les périphériques d'entrée :

1  Choisissez Setup > MIDI > Input Devices.

2  Dans la boîte de dialogue Input Devices MIDI, 
sélectionnez les périphériques MIDI à partir 
desquels vous effectuerez l'enregistrement. Par 
ailleurs, vérifiez que tous les périphériques qui 
seront utilisés comme surface de contrôle sont 
également sélectionnés.

3  Désélectionnez tous les périphériques d'entrée 
que vous souhaitez ignorer pendant 
l'enregistrement MIDI.

4  Lorsque vous avez terminé, cliquez sur OK.

Boîte de dialogue MIDI Input Enable

Il n'est pas nécessaire de sélectionner les 
périphériques pour faire transiter des 
données MIDI par eux. Par exemple, il est 
inutile de sélectionner un périphérique 
utilisé exclusivement comme générateur de 
sons dans la boîte de dialogue MIDI Input 
Enable.
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MIDI Thru
Pour pouvoir écouter les pistes MIDI pendant 
l'enregistrement, activez MIDI Thru. Lorsque 
cette option est activée, Pro Tools renvoie les 
données MIDI provenant des contrôleurs vers 
les périphériques et canaux affectés à la piste 
MIDI actuellement préparée en enregistrement.

Pour activer MIDI Thru :

■ Sélectionnez Options > MIDI Thru.

Instrument Thru par défaut

En plus des pistes MIDI préparées en 
enregistrement, vous pouvez également 
envoyer les données MIDI vers l'instrument 
Thru par défaut. Cela vous évite de créer une 
piste MIDI et de la préparer en enregistrement 
pour écouter un périphérique et un canal MIDI 
particuliers.

Contrairement aux pistes MIDI, qui n'écoutent 
que le périphérique et le canal affecté à leur 
sélecteur d'entrée MIDI, toutes les données MIDI 
à l'entrée sont routées vers l'instrument Thru par 
défaut.

Si l'instrument Thru par défaut est affecté à une 
piste MIDI préparée en enregistrement, 
Pro Tools n'envoie les données MIDI que vers 
cette piste préparée en enregistrement.

Pour configurer un instrument Thru par défaut :

1  Choisissez Setup > Preferences. 

2  Cliquez sur l'icône MIDI. 

3  Effectuez l'une des opérations suivantes :

• Sélectionnez un périphérique spécifique 
dans le menu déroulant Default Thru 
Instrument pour définir un aperçu 
homogène de la source sonore. 

• Sélectionnez Follows First Selected MIDI 
Track pour que l'affectation d'aperçu MIDI 
suive la sélection de piste MIDI. Lorsque 
plusieurs pistes MIDI sont sélectionnées, 
l'aperçu utilise la piste du haut/de gauche 
dans les fenêtres Edit et Mix. 

L'option Global MIDI Playback Offset de la 
préférence MIDI et les décalages individuels 
de piste MIDI n'ont pas d'incidence sur les 
données MIDI envoyées via MIDI Thru.

Lorsque l'option MIDI Thru est activée, les 
données System Exclusive sont renvoyées 
vers le périphérique MIDI affecté à la piste 
préparée en enregistrement si la taille des 
événements Sysex est inférieure à 
256 octets.

Lorsque vous utilisez l'option MIDI Thru, il 
est préférable de désactiver le contrôle local 
sur vos périphériques MIDI. S'il reste activé, 
votre périphérique MIDI risque de recevoir 
les notes MIDI en double, ce qui peut causer 
divers problèmes. Si vous ne savez pas 
comment désactiver le contrôle local de 
votre instrument, consultez la 
documentation du fabricant.
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• Pour désactiver l'instrument Thru par 
défaut, sélectionnez None.

Filtre d'entrée MIDI
Le filtre d'entrée MIDI permet d'éliminer par 
filtrage certains types de messages MIDI de vos 
enregistrements. Le filtre d'entrée peut être réglé 
pour laisser passer (et donc enregistrer) tous les 
messages (All), seulement les messages spécifiés 
(Only), ou tous les messages sauf ceux spécifiés 
(All except).

Pour filtrer les données Polyphonic Aftertouch, par 
exemple :

1  Choisissez Setup > MIDI > Input Filter.

2  Dans la boîte de dialogue MIDI Input Filter, 
sélectionnez l'option All Except.

3  Sélectionnez l'option Polyphonic Aftertouch. 
Ne cochez pas les autres cases d'option.

4  Cliquez sur OK.

Lorsque vous utilisez l'option All Except, les 
messages MIDI sélectionnés ne sont pas 
enregistrés. Inversement, lorsque vous utilisez 
l'option Only, seuls les messages MIDI 
sélectionnés sont enregistrés.

Option Input Quantize
Lorsque l'option Input Quantize est activée, 
toutes les notes MIDI enregistrées sont 
automatiquement quantifiées. Pour préserver le 
feeling original de vos pistes MIDI enregistrées, 
désactivez cette option.

Pour activer la quantisation en entrée :

1  Choisissez Event > MIDI > Input Quantize.

2  Dans la page Input Quantize, sélectionnez 
Enable Input Quantize.

La sélection Thru par défaut (Follows First 
Selected MIDI Track) vous permet 
également d'écouter un instrument sans 
devoir créer et activer l'enregistrement de la 
piste MIDI ou la piste d'instrument.

Boîte de dialogue MIDI Input Filter

Fenêtre MIDI Operations (page Input Quantize)
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Configurez comme désiré les autres options de 
la page Input Quantize. Pour plus de détails sur 
les différentes options de quantisation, 
consultez la section Input Quantize, page 545. 
Lorsque vous avez terminé, fermez la fenêtre 
MIDI Operations.

Pour l'enregistrement en boucle de type boîte à 
rythme, utilisez la quantisation d'entrée lorsque 
vous enregistrez en boucle des données MIDI en 
mode Merge (Fusion – voir Enregistrement en 
boucle et mode fusion, page 243).

Attente de note
Le bouton Wait for Note de la fenêtre Transport 
détermine de quelle manière Pro Tools 
commence l'enregistrement. Lorsque cette 
option est sélectionnée, Pro Tools ne commence 
l'enregistrement que lorsqu'un événement MIDI 
est reçu. Cela garantit que l'enregistrement ne 
commence que lorsque vous êtes prêt à jouer et 
que la première note, ou autre donnée MIDI, est 
enregistrée précisément au début de la plage 
d'enregistrement (temps de début).

L'option Wait for Note s'utilise pour 
l'enregistrement normal, à la volée ou en 
boucle. Si le pré-roll est actif, il intervient après 
la réception de l'événement MIDI et avant le 
début de l'enregistrement.

Pour activer Wait for Note :

1  Pour faire apparaître les commandes MIDI 
dans la fenêtre Transport, sélectionnez View > 
Transport > MIDI Controls.

2  Dans la fenêtre Transport, cliquez sur le 
bouton Attendre la note pour qu'il passe en 
surbrillance.

Mode de fusion/
remplacement MIDI
Le bouton de fusion MIDI de la fenêtre 
Transport détermine de quelle manière les 
données MIDI sont enregistrées lors d'overdubs 
ou d'enregistrements en punch-in. Lorsque la 
fusion MIDI est activée (mode Merge), les 
données MIDI enregistrées viennent s'ajouter à 
celles se trouvant déjà sur la piste. Lorsque le 
bouton de fusion MIDI est désactivé (mode 
Replace), les données qui se trouvaient dans la 
région enregistrée sont remplacées par les 
nouvelles.

Le bouton de fusion MIDI peut être activé et 
désactivé en cours de lecture ou 
d'enregistrement. Dans le mode 
d'enregistrement en boucle, la fusion MIDI n'a 
aucun effet ; c'est pourquoi le bouton de fusion 
MIDI est estompé.

Fenêtre Transport affichant les commandes MIDI

Bouton Attendre la note activé

Lorsque l'option Use F11 for Wait for Note 
des préférences de fonctionnement est 
sélectionnée, vous pouvez appuyer sur F11 
pour activer le bouton Wait for Note.

Pour activer la fusion MIDI par un 
raccourci clavier, réglez le mode du pavé 
numérique sur Transport et appuyez sur la 
touche 9 du pavé numérique. 

Bouton Attendre la note
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Pour activer la fusion MIDI :

1  Pour faire apparaître les commandes MIDI 
dans la fenêtre Transport, sélectionnez View > 
Transport > MIDI Controls.

2  Dans la fenêtre Transport, cliquez sur le 
bouton de fusion MIDI pour qu'il soit mis en 
surbrillance.

Configuration de pistes MIDI 
ou de pistes d'instrument 
pour l'enregistrement

Pour configurer une ou plusieurs pistes MIDI ou de 
pistes d'instrument pour l'enregistrement :

1  Si vous ne disposez pas de piste MIDI ou 
d'instrument vers laquelle enregistrer, choisissez 
Track > New et spécifiez 1 MIDI Track or 1 
Instrument Track, puis cliquez sur Create.

2  Pour les pistes d'instrument, assurez-vous que 
la vue Instruments est sélectionnée (View > Mix 
Window > Instruments ou View > Edit 
Window > Instruments).

3  Dans la fenêtre Mix, cliquez sur le sélecteur 
d'entrée MIDI de la piste et affectez le 
périphérique et le canal qui seront enregistrés. 
Pour les pistes d'instrument, le sélecteur d'entrée 
MIDI est disponible dans la vue Instruments.

– ou –

Pour les pistes MIDI dans la fenêtre Edit, 
choisissez View > Edit Window > I/O, puis 
cliquez sur le sélecteur d'entrée MIDI de la piste 
et affectez le périphérique et le canal qui seront 
enregistrés. Pour les pistes d'instrument, l'entrée 
MIDI est disponible en choisissant View > Edit 
Window > Instrument.

Vous pouvez également copier et fusionner 
les notes MIDI à l'aide de la fonction de 
collage spécial. Pour plus d'informations, 
reportez-vous à la section Fonction de 
collage spécial pour les données 
d'automation, page 665.

Fusion MIDI activée

Boîte de dialogue New Tracks

Bouton MIDI Merge

Sélecteur d'entrée de la piste MIDI (fenêtre Edit)

Sélecteur d'entrée MIDI de la piste d'instrument 
(fenêtre Mix)

Sélecteur d'entrée MIDI

Sélecteur d'entrée MIDI
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4  Dans la fenêtre Mix, cliquez sur le sélecteur de 
sortie MIDI de la piste et affectez un 
périphérique et un canal à partir du menu 
déroulant. Pour les pistes d'instrument, le 
sélecteur de sortie MIDI est disponible dans la 
vue Instruments. Les canaux déjà affectés à 
d'autres pistes apparaissent en gras dans ce 
menu.

– ou –

Dans la fenêtre Edit, activez l'affichage des I/O, 
cliquez sur le sélecteur de sortie MIDI de la piste 
et affectez un périphérique et un canal à partir 
du menu déroulant. Pour les pistes 
d'instrument, le sélecteur de sortie MIDI est 
disponible dans la vue Instruments. Les canaux 
déjà affectés à d'autres pistes apparaissent en 
gras dans ce menu.

Sélecteur d'entrée MIDI de la piste MIDI (fenêtre Edit)

Sélecteur d'entrée MIDI de la piste d'instrument 
(fenêtre Edit)

Sélecteur de sortie MIDI de la piste MIDI (fenêtre Mix)

Sélecteur d'entrée MIDI

Sélecteur d'entrée MIDI

Sélecteur de sortie MIDI

Sélecteur de sortie MIDI de la piste d'instrument 
(fenêtre Mix)

Sélecteur de sortie MIDI de la piste MIDI (fenêtre Edit)

Sélecteur de sortie MIDI de la piste d'instrument 
(fenêtre Edit)

Sélecteur de sortie MIDI

Sélecteur de sortie MIDI

Sélecteur de sortie MIDI
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5  Pour affecter plusieurs destinations à une 
même piste MIDI ou d'instrument, cliquez sur le 
sélecteur de sortie MIDI, appuyez sur la touche 
Démarrer (Windows) ou Contrôle (Macintosh) 
et cliquez sur des canaux d'autres périphériques. 
Lorsque plusieurs destinations sont 
sélectionnées pour une seule piste MIDI, un 
astérisque (*) s'affiche à côté du nom de la 
première destination dans le sélecteur de sortie 
MIDI.

6  Si vous souhaitez affecter un programme par 
défaut à la piste, cliquez sur le bouton Patch 
Select, effectuez les sélections nécessaires pour le 
programme et la sélection de banque, puis 
cliquez sur Done.

Les messages de changement de programme 
(changement de son) par défaut sont transmis à 
chaque lecture de la piste. Pour plus 
d'informations, reportez-vous à la section 
Sélection de patch (changements de programme 
et de banque), page 513.

7  Si vous enregistrez vers plusieurs pistes MIDI 
ou d'instrument, répétez les étapes ci-dessus 
pour chaque piste, puis passez à l'étape suivante.

8  Si vous souhaitez utiliser un clic, activez et 
configurez le métronome, puis définissez un 
tempo et une mesure par défaut pour la session. 
Pour en savoir plus, reportez-vous à la section 
Enregistrement avec le métronome, page 202.

9  En cas de besoin, activez le bouton Attendre la 
note et Décompte dans la fenêtre Transport. 

10  Pour remplacer des données existant déjà sur 
la piste, désactivez la fusion MIDI dans la fenêtre 
Transport.

11  Pour quantifier automatiquement des 
données enregistrées, activez l'option Input 
Quantize (reportez-vous à la section Option 
Input Quantize, page 234).

12  Dans la fenêtre Transport, cliquez sur Return 
to Zero pour effacer les temps de début et de fin. 
Cela garantit que l'enregistrement commencera 
au début de la piste.

13  Dans la fenêtre Mix ou Edit, cliquez sur le 
bouton Record Enable de la piste MIDI ou de la 
piste d'instrument pour préparer cette piste en 
enregistrement.

14  Assurez-vous que Options > MIDI Thru est 
sélectionné, puis jouez quelques notes sur votre 
contrôleur MIDI. L'instrument MIDI affecté à la 
piste doit émettre un son et les vumètres de la 
piste doivent témoigner d'une activité MIDI.

Vous êtes maintenant prêt à enregistrer des 
données MIDI vers les pistes MIDI ou 
d'instruments préparées en enregistrement. 
Pour plus d'informations, reportez-vous à la 
section Enregistrement vers des pistes MIDI et 
des pistes d'instrument, page 238.

Enregistrement vers des 
pistes MIDI et des pistes 
d'instrument
Dans Pro Tools, vous pouvez enregistrer vers 
une ou plusieurs pistes MIDI ou d'instrument. 
L'enregistrement simultané vers plusieurs pistes 
permet :

• D'enregistrer simultanément à partir de 
plusieurs contrôleurs MIDI et de capturer ainsi 
ce que jouent plusieurs musiciens

• D'enregistrer plusieurs canaux provenant d'un 
même appareil et capturer ainsi les données 
d'un clavier splitté jouant plusieurs sons

• De transférer des pistes MIDI provenant d'un 
séquenceur MIDI externe
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Pour enregistrer vers une ou plusieurs pistes MIDI 
ou pistes d'instrument :

1  Avec Pro Tools HD, assurez-vous que l'option 
Delay Compensation est désactivée dans le 
menu Options.

2  Configurez une piste MIDI ou une piste 
d'instrument pour l'enregistrement. Reportez-
vous à la section Configuration de pistes MIDI 
ou de pistes d'instrument pour l'enregistrement, 
page 236.

3  Préparez en enregistrement la piste que vous 
souhaitez enregistrer en cliquant sur le bouton 
Record Enable correspondant.

4  Placez Pro Tools en mode normal non 
destructif. Dans le menu Options, 
désélectionnez les options Destructive Record, 
Loop Record et QuickPunch.

5  Cliquez sur Record dans la fenêtre Transport 
pour activer le mode d'enregistrement. 
L'indicateur d'état Record Enable devient rouge.

6  Lorsque vous êtes prêt à commencer 
l'enregistrement, cliquez sur Play. Si vous 
utilisez le décompte, Pro Tools décompte le 
nombre de mesures spécifié avant de 
commencer l'enregistrement.

– ou –

Si vous utilisez l'option d'attente de note, les 
boutons de lecture, d'enregistrement et d'attente 
de note clignotent L'enregistrement commence 
dès réception d'un événement MIDI.

7  A la fin de l'enregistrement, cliquez sur le 
bouton Stop de la fenêtre Transport.

Pour chaque piste activée en enregistrement, 
une région MIDI est créée et apparaît dans la 
playlist. Les nouvelles régions MIDI s'affichent 
également dans la liste des régions.

Pour tirer parti des fonctions d'édition de 
Pro Tools, effectuez les enregistrements en 
activant le métronome. Cela garantit que 
les données enregistrées s'aligneront 
correctement sur la grille de mesure/temps 
de la session. Vous pouvez également 
enregistrer les pistes MIDI sans métronome 
et déduire le tempo et la mesure à partir des 
notes.

Dans la plupart des cas, Digidesign 
recommande l'enregistrement sans 
compensation de retard. Pour plus 
d'informations, reportez-vous à la section 
Compensation de retard, page 602.

Pour préparer des pistes supplémentaires à 
l'enregistrement, cliquez sur le bouton 
Record Enable tout en appuyant sur la 
touche Maj.

Bouton d'enregistrement

Plusieurs raccourcis clavier sont à votre 
disposition pour lancer l'enregistrement. 
Pour plus d'informations, consultez la 
section Raccourcis pour l'enregistrement, 
page 213.

Pour enregistrer les données audio d'un 
instrument MIDI, acheminez la sortie audio 
de la piste d'instrument ou de la piste 
d'entrée auxiliaire qui écoute l'instrument 
MIDI, vers une piste audio. Préparez la piste 
audio à l'enregistrement et lancez 
l'enregistrement.
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Pour lire une piste MIDI ou une piste d'instrument 
enregistrée :

1  Dans la fenêtre Transport, cliquez sur Return 
to Zero.

2  Pour commencer la lecture, cliquez sur le 
bouton de lecture de la fenêtre Transport.

Les données MIDI enregistrées sont lues sur 
chaque périphérique (port) et canal affectés à la 
piste.

Annulation d'un enregistrement 
MIDI

Vous pouvez annuler des prises MIDI déjà 
enregistrées.

Pour annuler un enregistrement MIDI :

■ Après avoir arrêté le Transport, choisissez 
Edit > Undo MIDI Recording. 

La playlist de la piste revient à son état antérieur. 
Toutefois :

◆ Si vous avez effectué plusieurs entrées/sorties 
d'enregistrement avant d'arrêter le Transport, 
seule la dernière partie enregistrée est annulée.

◆ En mode d'enregistrement en boucle, toutes 
les prises enregistrées passe après passe sont 
annulées.

Annulation d'une prise 
d'enregistrement

Il est également possible d'annuler la prise en 
cours avant l'arrêt du Transport.

Pour annuler une passe en cours 
d'enregistrement :

■ Appuyez sur Ctrl + point (.) (Windows) ou 
Pomme + point (.) (Macintosh) avant que le 
transport ne soit arrêté.

En mode d'enregistrement en boucle, toutes les 
prises enregistrées passe après passe sont 
annulées.

Enregistrement MIDI 
fractionné
Pour remplacer une partie de la piste MIDI ou de 
la piste d'instrument, vous pouvez définir un 
point d'entrée en spécifiant la région à 
réenregistrer avant l'enregistrement 
proprement dit.

Pour définir des points d'entrée sur une piste MIDI 
ou une piste d'instrument :

1  Configurez une piste MIDI ou une piste 
d'instrument pour l'enregistrement. Reportez-
vous à la section Configuration de pistes MIDI 
ou de pistes d'instrument pour l'enregistrement, 
page 236.

2  Placez Pro Tools en mode normal non 
destructif. Dans le menu Options, 
désélectionnez les options Destructive Record, 
Loop Record et QuickPunch.

3  Dans la fenêtre Transport, désactivez Attendre 
la note et Décompte.

4  Choisissez Options > Link Timeline and Edit 
Selection.

5  A l'aide du sélecteur, faites glisser la playlist de 
la piste jusqu'à ce que la sélection englobe la 
plage souhaitée.

Pour connaître d'autres méthodes permettant de 
définir la plage d'enregistrement, consultez la 
section Définition des points d'enregistrement 
fractionné et de boucle, page 222.
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6  Pour écouter ce qui se trouve déjà sur la piste 
jusqu'au point d'entrée, ou après le point de 
sortie de l'enregistrement, activez les pré et post-
roll et entrez leurs durées. Pour en savoir plus, 
reportez-vous à la section Définition des 
paramètres de pré et post-roll, page 225.

7  Préparez en enregistrement la piste contenant 
la dernière prise en cliquant sur son bouton 
Record Enable.

8  Cliquez sur Record dans la fenêtre Transport 
pour activer le mode d'enregistrement. 
Le bouton Record Enable clignote.

9  Lorsque vous êtes prêt à commencer 
l'enregistrement, cliquez sur Play.

Si le pré-roll est activé, les données se trouvant 
sur la piste sont lues jusqu'au point d'entrée de 
l'enregistrement. Vous pouvez commencer à 
jouer pendant le pré-roll pour vous mettre dans 
l'ambiance. Rien n'est enregistré tant que le 
point d'entrée de l'enregistrement n'est pas 
atteint.

Lorsque le point de début est atteint, Pro Tools 
commence l'enregistrement. Celui-ci se poursuit 
jusqu'à ce que le point de sortie de 
l'enregistrement soit atteint, sauf si vous cliquez 
sur Stop dans la fenêtre Transport. Si le post-roll 
est activé, la lecture se poursuit pendant le 
temps spécifié.

10  A la fin de l'enregistrement, cliquez sur le 
bouton Stop de la fenêtre Transport.

Les données MIDI nouvellement enregistrées 
apparaissent dans la piste.

Enregistrement fractionné en cours de 
lecture en MIDI

Il n'est pas obligatoire de définir au préalable 
une région d'enregistrement pour définir un 
point d'entrée sur une piste MIDI ou une piste 
d'instrument. En fait, vous pouvez entrer/sortir 
d'enregistrement librement et à tout moment en 
cours de lecture. Contrairement aux pistes 
audio, il n'est pas nécessaire d'activer 
l'enregistrement QuickPunch pour réaliser un 
enregistrement à la volée.

Pour enregistrer à la volée en MIDI :

1  Configurez une piste MIDI ou une piste 
d'instrument pour l'enregistrement. Reportez-
vous à la section Configuration de pistes MIDI 
ou de pistes d'instrument pour l'enregistrement, 
page 236.

2  Placez Pro Tools en mode normal non 
destructif. Dans le menu Options, 
désélectionnez les options Destructive Record, 
Loop Record et QuickPunch.

3  Dans la fenêtre Transport, désactivez Attendre 
la note et Décompte.

4  Préparez en enregistrement la piste contenant 
la dernière prise en cliquant sur son bouton 
Record Enable.

5  Démarrez la lecture en cliquant sur Play dans 
la fenêtre Transport. 

6  A l'endroit du début de l'enregistrement, 
cliquez sur Record dans la fenêtre Transport.

– ou –

Avec les systèmes Digi 001 et Digi 002 Rack 
(ou les surfaces de contrôle Digidesign) 
disposant d'une pédale, appuyez sur celle-ci au 
point d'entrée d'enregistrement désiré.

Le bouton Record Enable cesse de clignoter et 
reste allumé pendant l'enregistrement.
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7  Pour arrêter l'enregistrement, cliquez de 
nouveau sur Record (ou appuyez sur la pédale).

Pro Tools quitte alors le mode d'enregistrement 
et continue la lecture. Vous pouvez réaliser 
d'autres entrées/sorties d'enregistrement au 
cours de la même passe.

Régions et enregistrement 
fractionné

Selon la plage d'enregistrement, de nouvelles 
régions peuvent être créées à l'issue de 
l'enregistrement fractionné. Par exemple, la 
Figure 7 montre les deux régions existant avant 
l'enregistrement. La région définie par l'entrée/
sortie d'enregistrement tombant dans un 
« vide » de données, une région est créée afin de 
combler le « trou » qui séparait les deux régions 
d'origine.

Cependant, lorsque vous sélectionnez avant 
l'enregistrement fractionné une région entière 
ou une partie de région, aucune région n'est 
créée. Dans ce cas, seules les données se trouvant 
dans la région existante sont modifiées, aucune 
donnée nouvelle n'étant enregistrée hors de la 
région.

Dans ce cas de figure, contrairement à 
l'enregistrement audio, l'enregistrement MIDI 
est destructif. Si une région est modifiée suite à 
une prise d'enregistrement, les données 
d'origine sont perdues (sauf si vous choisissez 
Edit > Undo MIDI Recording) ou associées aux 
nouvelles données (si l'option MIDI Merge était 
activée pendant l'enregistrement). Si une région 
existante contient des données importantes, 
utilisez l'option Duplicate pour copier la région 
(Commande Duplicate, page 382) ou la playlist 
de la piste (voir Utilisation des playlists, 
page 290).

Enregistrement MIDI en 
boucle
L'enregistrement MIDI en boucle peut 
s'effectuer selon deux méthodes : 

• En mode normal non destructif, activez le 
mode de lecture en boucle et la fusion MIDI 
pour l'enregistrement en boucle de type boîte 
à rythme.

– ou –

• Utilisez le mode d'enregistrement en boucle 
pour enregistrer plusieurs prises successives à 
chaque passe d'enregistrement. Cette 
méthode est semblable à l'enregistrement 
audio en boucle.

Figure 7.  Région ajoutée après l'enregistrement 
fractionné

avant l'enregistrement fractionné

après l'enregistrement fractionné

nouvelle région
données venant

d'être enregistrées
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Enregistrement en boucle et mode 
fusion

Pour l'enregistrement en boucle de type boîte à 
rythme, utilisez le mode normal non destructif 
en activant le mode de lecture en boucle et la 
fusion MIDI. Cette méthode permet 
d'enregistrer et de fusionner les données MIDI 
sur une même région passe après passe 
d'enregistrement, ce qui permet, par exemple, 
d'enregistrer une charley lors d'une première 
passe, la grosse caisse/caisse claire lors d'une 
seconde, etc.

Vérifiez que la fusion MIDI est active dans la 
fenêtre Transport. Dans le cas contraire (en 
mode Replace), chaque prise remplacera la 
précédente de façon destructive.

Pour enregistrer en boucle avec la fusion MIDI :

1  Configurez une piste MIDI ou une piste 
d'instrument pour l'enregistrement. Reportez-
vous à la section Configuration de pistes MIDI 
ou de pistes d'instrument pour l'enregistrement, 
page 236.

2  Placez Pro Tools en mode normal non 
destructif. Dans le menu Options, 
désélectionnez les options Destructive Record, 
Loop Record et QuickPunch.

3  Sélectionnez Options > Loop Playback. 
Lorsque l'option de lecture en boucle est active, 
le symbole d'une boucle s'affiche dans le bouton 
Play.

4  Préparez la piste MIDI ou la piste d'instrument 
en enregistrement en cliquant sur son bouton 
Record Enable. Vérifiez qu'aucune piste audio 
n'est préparée pour l'enregistrement.

5  Dans la fenêtre Transport, cliquez sur le 
bouton de fusion MIDI pour qu'il soit mis en 
surbrillance.

6  Désactivez Attendre la note et Décompte dans 
la fenêtre Transport.

7  Sélectionnez Options > Link Timeline and 
Edit Selection.

8  A l'aide du sélecteur, faites glisser la playlist de 
la piste jusqu'à ce que la sélection englobe la 
boucle désirée.

Pour connaître d'autres méthodes permettant de 
définir la plage d'enregistrement, consultez la 
section Définition des points d'enregistrement 
fractionné et de boucle, page 222.

9  Pour écouter les données se trouvant déjà sur 
la piste jusqu'au point de début de la boucle, 
activez le pré-roll et définissez sa durée. Pour en 
savoir plus, reportez-vous à la section Définition 
des paramètres de pré et post-roll, page 225.

10  Cliquez sur le bouton d'enregistrement de la 
fenêtre Transport. Lorsque vous êtes prêt à 
commencer l'enregistrement, cliquez sur Play.

Vous pouvez activer à la volée une autre 
piste MIDI ou d'instrument en 
enregistrement pendant un enregistrement 
en boucle. Tout en appuyant sur Pomme 
(Macintosh) ou sur Ctrl (Windows), 
appuyez sur les flèches haut/bas pour 
préparer la piste MIDI ou d'instrument 
précédente ou suivante en enregistrement.

Mode de lecture en boucle activé
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Le bouton Record Enable clignote pendant le 
pré-roll. Lorsque le point de début est atteint, 
Pro Tools commence l'enregistrement. Lorsque 
le point de fin est atteint, Pro Tools retourne au 
point de début et continue la lecture et 
l'enregistrement.

11  Jouez quelques notes sur votre contrôleur 
MIDI. Les nouvelles données MIDI enregistrées 
apparaissent sous forme de région dans la piste 
d'enregistrement. Prise après prise, les données 
enregistrées apparaissent dans la région sans 
remplacer les données des prises précédentes.

12  Si vous souhaitez passer à une nouvelle piste 
à enregistrer, appuyez sur la touche Ctrl 
(Windows) ou Pomme (Macintosh), puis sur les 
touches Haut/Bas pour activer l'enregistrement 
de la piste MIDI ou d'instrument suivante ou 
précédente.

13  A la fin de l'enregistrement, cliquez sur le 
bouton Stop de la fenêtre Transport.

Les nouvelles données MIDI enregistrées 
apparaissent sous la forme d'une région MIDI 
dans la playlist de la piste et dans la liste des 
régions.

Enregistrement en boucle de 
plusieurs prises

Lorsque vous enregistrez des données MIDI en 
mode d'enregistrement en boucle, des régions 
sont créées chaque fois que de nouvelles 
données sont reçues pendant une passe 
d'enregistrement. Cela est quelque peu différent 
de l'enregistrement audio en boucle, dans lequel 
un fichier audio unique comprenant toutes les 
prises est créé. Ces prises apparaissent en tant 
que régions individuelles dans la liste des 
régions.

Cette méthode d'enregistrement MIDI en 
boucle permet d'enregistrer prise après prise sans 
interrompre l'enregistrement, afin de préserver 
la spontanéité du processus de création. Autre 
avantage de cette méthode d'enregistrement 
MIDI : comme elle est non destructive, les 
régions existantes et les régions créées 
demeurent intactes (et s'affichent dans la liste 
des régions).

Pour enregistrer des données MIDI en mode 
d'enregistrement en boucle :

1  Configurez une piste MIDI ou une piste 
d'instrument pour l'enregistrement. Reportez-
vous à la section Configuration de pistes MIDI 
ou de pistes d'instrument pour l'enregistrement, 
page 236.

2  Sélectionnez Options > Loop Record. Lorsque 
le mode Loop Record est actif, le symbole d'une 
boucle apparaît dans le bouton Record Enable.

3  Si vous ne l'avez pas déjà fait, préparez en 
enregistrement la piste MIDI ou la piste 
d'instrument en cliquant sur le bouton Record 
Enable correspondant. Vérifiez qu'aucune piste 
audio n'est préparée pour l'enregistrement.

4  Désactivez Attendre la note et Décompte dans 
la fenêtre Transport.

5  Sélectionnez Options > Link Timeline and 
Edit Selection.

Mode d'enregistrement en boucle activé
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6  A l'aide du sélecteur, faites glisser la playlist de 
la piste jusqu'à ce que la sélection englobe la 
boucle désirée.

Pour connaître d'autres méthodes permettant de 
définir la plage d'enregistrement, consultez la 
section Définition des points d'enregistrement 
fractionné et de boucle, page 222.

7  Pour écouter les données se trouvant déjà sur 
la piste jusqu'au point de début de la boucle, 
activez le pré-roll et définissez sa durée. Pour en 
savoir plus, reportez-vous à la section Définition 
des paramètres de pré et post-roll, page 225.

8  Cliquez sur le bouton d'enregistrement de la 
fenêtre Transport. Lorsque vous êtes prêt à 
commencer l'enregistrement, cliquez sur Play.

Le bouton Record Enable clignote pendant le 
pré-roll. Lorsque le point de début est atteint, 
Pro Tools commence l'enregistrement. Lorsque 
le point de fin est atteint, Pro Tools retourne au 
point de début et continue la lecture et 
l'enregistrement.

9  Tapez sur les touches du contrôleur MIDI. Une 
région MIDI contenant les nouvelles données 
enregistrées est créée automatiquement et 
apparaît dans la playlist de la piste, remplaçant 
la région précédente.

Les régions sont remplacées (de façon non 
destructive) passe après passe d'enregistrement 
lorsque de nouvelles données MIDI sont reçues.

10  A la fin de l'enregistrement, cliquez sur le 
bouton Stop de la fenêtre Transport. La prise la 
plus récente reste sur la piste d'enregistrement.

Les prises enregistrées apparaissent sous forme 
de régions dans la liste des régions et sont 
numérotées de façon séquentielle. Vous pouvez 
ainsi écouter les prises, qui sont de même durée 
et facilement interchangeables, à partir du 
menu déroulant de la liste des prises, même 
lorsque la session est en lecture ou en boucle. 

Pour écouter les différentes prises 
d'enregistrement :

1  Maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Macintosh) pendant que vous 
cliquez avec le sélecteur sur le début précis de la 
plage d'enregistrement en boucle.

– ou –

Si la prise se trouvant sur la piste est 
sélectionnée, maintenez enfoncée la touche Ctrl 
(Windows) ou Pomme (Macintosh) pendant 
que vous cliquez dessus avec le sélecteur.

Un menu déroulant apparaît ; il contient une 
liste des régions qui partagent le même 
marqueur de temps de l'utilisateur.

2  Sélectionnez une région dans le menu 
déroulant de la liste des prises. La région 
remplace la prise précédente et se positionne 
précisément à l'endroit correct.

Pour plus d'informations sur l'audition et la 
gestion des prises, consultez Ecoute des prises 
enregistrées dans la timeline, page 220.

Ecoute des prises d'enregistrement en boucle
Chapitre 13 : Enregistrement MIDI 245



246
Option MIDI Step Input
L'option Step Input permet d'utiliser un 
contrôleur MIDI pour entrer séparément des 
notes, étape par étape. Vous bénéficiez ainsi du 
contrôle précis de la position, de la durée et de la 
vélocité de la note. Avec MIDI Step Input, vous 
pouvez également créer des passages musicaux 
qui s'avéreraient difficiles à jouer avec 
exactitude ou encore à un tempo rapide. 

Pour entrer des notes MIDI avec Step Input (à 
l'aide d'un instrument MIDI externe) :

1  Assurez-vous que votre clavier MIDI externe 
est correctement branché et fonctionne avec 
Pro Tools.

2  Choisissez Event > MIDI > Step Input.

3  Sélectionnez l'option Enable.

4  Choisissez la piste MIDI que vous voulez 
enregistrer dans le menu déroulant Destination.

5  Choisissez la valeur de la note à entrer dans la 
zone Step Increment.

6  Jouez une note ou un accord sur votre 
instrument MIDI. Ceci a pour effet d'entrer la 
note et de passer au point d'insertion suivant.

Pour augmenter la longueur d'une note pendant 
l'utilisation de Step Input :

1  Jouez une note en continu sur votre 
instrument MIDI.

2  Choisissez la valeur de la note que vous voulez 
ajouter et appuyez sur le bouton Increment.

Relâchez la note sur votre clavier MIDI pour 
passer au point d'insertion suivant.

Commandes Step Input

La page Step Input propose les paramètres 
suivants :

Enable : s'ils sont sélectionnés, les événements 
MIDI sont ajoutés à la piste de destination 
lorsque vous jouez sur votre clavier MIDI 
externe. De plus, la piste MIDI précédemment 
préparée à l'enregistrement est désactivée. Page Step Input

Lorsque l'option Step Input est activée, 
chaque piste MIDI précédemment préparée 
à l'enregistrement quitte le mode de 
préparation à l'enregistrement et si un 
instrument Thru par défaut est défini dans 
la page MIDI Preferences, il est désactivé.

Lorsqu'une note est ainsi jouée sur le clavier 
MIDI, l'option Next Step affiche Increment. 
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Si un instrument Thru par défaut est défini dans 
la page MIDI Preferences, il est désactivé si 
l'option Step Input est sélectionnée et réactivé si 
Step Input n'est plus désactivée.

Destination : permet de sélectionner la piste de 
destination de la phase Step Input à partir d'une 
liste déroulante de toutes les pistes MIDI dans 
votre session. 

Step Increment

les options de la zone Step Increment 
permettent de définir l'espacement et la durée 
des événements MIDI entrés à l'aide de 
l'opération Step Input. Vous pouvez 
sélectionner n'importe quelle valeur de note, de 
la ronde à la quadruple croche (valeurs pointées 
comprises). 

Tuplet : permet d'entrer des groupes de notes 
« inhabituels », tels que les triolets ou 
quintolets. La longueur du tuplet est calculée à 
partir de la sélection de l'espacement de note et 
de la valeur Tuplet. Si, par exemple, une croche 
équivaut à 480 tics, des croches en triolet 
(3 pour 2) donnent un espace de note de 320 tics 
(480 tics / 3 * 2).

Note Length : cette option permet de 
sélectionner la longueur de la note sous forme 
d'un pourcentage de la valeur d'espacement. 
Si, par exemple, une croche équivaut à 480 tics, 
une croche dont la durée atteint 80% 
correspond à une longueur de 384 tics.

Options

Use Input Velocity : lorsque cette option est 
sélectionnée, les notes MIDI sont enregistrées à 
la vitesse où vous les jouez sur votre clavier 
MIDI.

Set Velocity To : les notes MIDI sont enregistrées 
à la vitesse indiquée dans le champ Velocity. 
Vous définissez cette valeur au moyen du 
curseur.

Enable Numeric Keypad Shortcuts : cette option 
permet de sélectionner les options Step Input à 
partir du pavé numérique. Reportez-vous à la 
section Raccourcis du pavé numérique, 
page 248.

Undo Step, Next Step (ou Increment) et Redo 
Step

Servez-vous des boutons Undo Step et Next Step 
pour procéder aux opérations suivantes :

• Déplacer le point d'insertion suivant, soit 
en supprimant la note précédente, soit en 
avançant le point d'insertion à la valeur 
Step Increment.

• Allonger et raccourcir les notes qui sont 
jouées sur le contrôleur MIDI en ajoutant 
ou en supprimant des valeurs Step 
Increment. La valeur Step Increment peut 
être modifiée à mi-note pour créer une note 
avec une longueur de note hybride.

Utilisez le bouton Redo Step pour recommencer 
la séquence des opérations précédemment 
annulées.

Undo Step : lorsque la note précédente est émise 
du clavier MIDI et que le point d'insertion se 
déplace à la note suivante, Undo Step supprime 
intégralement la dernière note.

Pourcentages de longueur de note

100% 80% 120%
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Lorsqu'une note est jouée, Undo Step affiche 
alors Decrement et supprime la dernière valeur 
Step Increment ajoutée à la note actuellement 
jouée.

Next Step (ou Increment) : si aucune note n'est 
jouée au clavier MIDI, Next Step passe au point 
d'insertion correspondant à la valeur Step 
Increment et insére une pause musicale.

Lorsqu'une note est jouée au clavier MIDI, Next 
Step affiche alors Increment et ajoute la valeur 
Step Increment à la note jouée, ce qui l'allonge 
d'autant. 

Tandis que la note est jouée, la valeur Step 
Increment peut être modifiée, vous permettant 
de créer des notes de toute longueur.

Redo Step : réinsère la dernière note supprimée 
à l'aide de l'opération Undo Step. 

Les boutons Undo Step, Next Step et Redo Step 
peuvent être définis de manière à être 
déclenchés par un synthétiseur MIDI externe, 
une boîte à rythme ou tout autre contrôleur. 

Pour définir les événements déclencheurs MIDI 
Undo Step, Next Step et Redo Step :

1  Choisissez Event > MIDI > Step Input.

2  Recherchez le bouton que vous voulez affecter 
à un événement MIDI et cliquez dans le champ 
situé sous ce bouton.

3  Jouez l'événement MIDI à utiliser comme 
signal de déclenchement. 

4  Appuyez sur Entrée pour confirmer 
l'affectation du déclencheur MIDI.

Raccourcis du pavé numérique

Lorsque l'option Enable Numeric Keypad 
Shortcuts est activée, vous pouvez choisir de 
nombreuses commandes dans la page Step 
Input, ainsi que plusieurs commandes de 
sélection. 
:

Sélection du champ Next Step

Si un contrôleur continu tel que Pitch Bend 
fait office d'événement déclencheur, vous 
devez vous assurer que vous utilisez la 
valeur extrème de contrôleur afin d'éviter 
toute entrée de données incorrecte.

Champ Next Step déclenché par une variation de 
hauteur

Raccourcis Step Input Touche

Ronde 1

1/2 note 2

1/4 note 4

1/8 note 5

1/16 note 6

1/32 note 7

1/64 note 8

Note pointée . (point décimal)

Activer/désactiver les tuplets 3

Etape suivante Entrée
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Enregistrement de données 
System Exclusive
Pro Tools permet l'enregistrement et la lecture 
de données System Exclusive (Sysex) sur des 
pistes MIDI. Cela permet d'utiliser des pistes 
MIDI dans Pro Tools pour stocker des données 
de patches (programmes) et de configuration 
des appareils MIDI, ou d'enregistrer en temps 
réel des changements de valeurs Sysex 
correspondant à un paramètre particulier d'un 
périphérique MIDI qui ne peut pas être contrôlé 
par un contrôleur MIDI standard.

Pour enregistrer un « dump » (transfert de 
données) Sysex au début d'une piste MIDI :

1  Vérifiez que la prise MIDI OUT du 
périphérique émettant les données Sysex est 
connectée à la prise MIDI IN de votre interface 
MIDI.

2  Configurez une piste MIDI pour 
l'enregistrement. Reportez-vous à la section 
Configuration de pistes MIDI ou de pistes 
d'instrument pour l'enregistrement, page 236.

3  Placez Pro Tools en mode normal non 
destructif. Dans le menu Options, 
désélectionnez les options Destructive Record, 
Loop Record et QuickPunch.

4  Dans la boîte de dialogue MIDI Input Filter, 
autorisez l'enregistrement des données System 
Exclusive.

5  Si vous ne l'avez pas déjà fait, préparez en 
enregistrement la piste MIDI en cliquant sur le 
bouton Record Enable correspondant.

6  Activez l'option Wait for Note dans la fenêtre 
Transport.

7  Dans la fenêtre Transport, cliquez sur Return 
to Zero pour effacer les temps de début et de fin. 
Cela garantit que l'enregistrement commencera 
au début de la piste.

8  Lorsque vous êtes prêt à enregistrer, cliquez 
sur Record dans la fenêtre Transport. 

Les boutons Record, Play et Wait for Note 
clignotent pour indiquer que Pro Tools attend 
des données MIDI.

9  Lancez le transfert des données Sysex depuis le 
périphérique MIDI, selon les instructions du 
guide qui l'accompagne. Dès qu'il reçoit les 
données MIDI, Pro Tools lance 
automatiquement l'enregistrement.

10  Une fois le transfert terminé (tel que défini 
dans le guide de votre périphérique MIDI), 
cliquez sur Stop dans la fenêtre Transport.

Annuler l'étape 0

Avancer la sélection par 
incrément

+

Reculer par incrément la 
sélection

–

Sélectionner le compteur 
principal

=

Modifier les indicateurs de 
sélection

/

Raccourcis Step Input Touche
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Les nouvelles données MIDI enregistrées 
apparaissent sous la forme d'une région MIDI 
dans la playlist de la piste et dans la liste des 
régions. Les régions MIDI contenant des 
données System Exclusive apparaissent vides 
lorsque l'affichage de la piste MIDI est réglé sur 
Regions.

Pour faire apparaître les blocs d'événements 
Sysex, qui indiquent l'emplacement des 
données, réglez la piste MIDI en affichage Sysex 
(voir Vue Regions pour les pistes MIDI et les 
pistes d'instrument, page 281). Pour plus de 
détails sur le déplacement et la copie de données 
Sysex, consultez la section Evénements System 
Exclusive, page 518

Pour renvoyer les données Sysex depuis 
Pro Tools :

1  Vérifiez que la prise MIDI IN du périphérique 
recevant les données System Exclusive est 
connectée à la prise MIDI OUT de votre interface 
MIDI. Vérifiez également que le périphérique est 
configuré pour recevoir des données Sysex. 
Certains périphériques obligent à désactiver la 
protection de la mémoire.

2  Cliquez sur le bouton Record Enable de la 
piste précédemment enregistrée, afin de 
désactiver l'enregistrement.

3  Cliquez sur le sélecteur de sortie MIDI de la 
piste et assignez le périphérique à partir du 
menu déroulant.

4  Dans la fenêtre Transport, cliquez sur Return 
to Zero.

5  Pour commencer la lecture, cliquez sur le 
bouton de lecture de la fenêtre Transport. 
Pro Tools commence à lire et à transmettre les 
données Sysex précédemment enregistrées au 
périphérique MIDI désigné.
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Chapitre 14 : Techniques 
d'enregistrement avancées

Il existe deux méthodes d'enregistrement 
avancées : QuickPunch et TrackPunch. 

QuickPunch : mode d'enregistrement non 
destructif permettant d'appliquer des entrées et 
des sorties d'enregistrement dans les pistes 
préparées en enregistrement pendant la lecture, 
par le biais du bouton Record Enable de la 
fenêtre Transport.

TrackPunch (Pro Tools HD uniquement) : mode 
d'enregistrement non destructif permettant 
d'appliquer des entrées et des sorties 
d'enregistrement dans les pistes ou de les sortir 
du mode de préparation à l'enregistrement sans 
interrompre l'enregistrement et la lecture en 
ligne.

Enregistrement audio 
QuickPunch
Pro Tools offre une fonction d'enregistrement à 
la volée, intitulée QuickPunch. QuickPunch 
permet d'appliquer instantanément des entrées 
et des sorties d'enregistrement dans les pistes 
préparées en enregistrement pendant la lecture 
en cliquant sur le bouton Record Enable de la 
fenêtre Transport.

En mode QuickPunch, Pro Tools commence 
l'enregistrement d'un nouveau fichier dès que la 
lecture débute et crée automatiquement des 
régions au sein de ce fichier à chaque point 
d'entrée et de sortie de l'enregistrement. 
Ces régions apparaissent dans la playlist de la 
piste. Le fichier audio complet apparaît dans la 
liste des régions avec les régions créées en mode 
QuickPunch. Vous pouvez ainsi, dans une 
même passe, effectuer jusqu'à 200 points 
d'entrée et de sortie d'enregistrement. 
Contrairement à l'enregistrement fractionné 
normal (voir Enregistrement audio fractionné, 
page 217), QuickPunch gère la commutation 
d'écoute (passage des données enregistrées aux 
données antérieures au point de sortie de 
l'enregistrement). Tous les enregistrements 
QuickPunch sont non destructifs.

Avec les systèmes Digi 002 et Digi 002 
Rack, ainsi que les surfaces de contrôle, vous 
pouvez utiliser une pédale pour entrer et 
sortir à tout moment de l'enregistrement 
avec QuickPunch.

Il n'est pas nécessaire d'activer l'option 
QuickPunch pour effectuer des 
enregistrements à la volée avec les pistes 
MIDI. Cette possibilité existe dans le mode 
d'enregistrement normal non destructif et 
dans le mode d'enregistrement destructif.
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QuickPunch/TrackPunch Crossfade 
Length :

Pro Tools peut écrire automatiquement un 
crossfade à chaque point d'entrée ou de sortie 
d'enregistrement lorsque vous utilisez 
QuickPunch. La durée de ces crossfades se 
définit via l'option QuickPunch 
Crossfade/TrackPunch Length dans la page 
Editing Preferences.

Pour définir la durée des crossfades en mode 
QuickPunch :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Editing.

2  Entrez une valeur (en ms) pour la longueur de 
crossfade QuickPunch /TrackPunch.

Une durée de crossfade de 10 est une valeur 
assez commune. Si vous définissez cette 
préférence sur une valeur nulle, Pro Tools ne 
crée aucun crossfade aux points d'entrée et de 
sortie de l'enregistrement.

3  Cliquez sur Done (Terminé).

Si vous avez spécifié une valeur de crossfade 
QuickPunch/TrackPunch non nulle, Pro Tools 
crée un crossfade au point d'entrée (ce crossfade 
commence avant ce point et s'étend jusqu'à 
celui-ci) et un autre crossfade au point de sortie 
(qui s'étend après la région d'enregistrement).

Même si la durée du crossfade 
QuickPunch/TrackPunch est nulle, Pro Tools 
exécute toujours un crossfade d'écoute (qui ne 
s'écrit pas sur le disque) d'une durée de 
4 millisecondes pour éviter les clics parasites qui 
risquent de se produire lorsque vous entrez et 
sortez du mode d'enregistrement.

Par la suite, vous pouvez modifier les crossfades 
QuickPunch de la même façon que les 
crossfades standard. Pour en savoir plus, 
reportez-vous à la section Utilisation des 
Crossfades, page 401.

Instructions d'enregistrement 
pour Pro Tools HD

Lorsque vous utilisez l'enregistrement 
QuickPunch (à la volée) sur un système 
Pro Tools HD, deux voix sont nécessaires pour 
chaque piste mono préparée en enregistrement. 
Vous pouvez ainsi enregistrer jusqu'à la moitié 
du nombre total de voix disponibles sur votre 
système. Par exemple, un système Pro Tools|HD 
Accel avec 192 voix peut enregistrer en 
QuickPunch sur 96 pistes mono (ou 48 pistes 
stéréo) au maximum simultanément.

Si le nombre de voix nécessaire pour les pistes 
préparées en enregistrement n'est pas disponible 
lorsque vous passez en mode QuickPunch, vous 
serez invité à libérer des voix.

Pour libérer des voix sur des pistes qui ne sont pas 
activées en enregistrement et qu'il n'est pas 
nécessaire d'écouter pendant l'enregistrement, 
effectuez l'une des opérations suivantes :

• Définissez l'assignation des voix des pistes 
sur Off.

• Désactivez des pistes.

• Rassemblez tous les plug-in RTAS avant les 
plug-in TDM.
Guide de référence Pro Tools



En fonction des besoins, des voix utilisées par 
d'autres pistes, qui ne sont pas activées en 
enregistrement, peuvent être « volées » pendant 
l'enregistrement avec QuickPunch. L'ordre de 
priorité des pistes lors d'un enregistrement 
QuickPunch est le suivant :

• Les pistes dont les voix sont assignées, mais 
qui ne sont pas préparées en enregistrement

• Les pistes dont les voix sont assignées qui sont 
préparées en enregistrement

• Les pistes à assignation dynamique des voix 
qui ne sont pas préparées en enregistrement

• Les pistes à assignation dynamique des voix 
qui sont préparées en enregistrement

Si la session comprend un grand nombre de voix 
disponibles, vous pouvez ne pas rencontrer de 
problème en utilisant QuickPunch avec des 
pistes à assignation dynamique des voix. 
Toutefois, si les voix viennent à manquer et que 
vous voulez être sûr qu'une piste restera audible 
pendant l'enregistrement QuickPunch, 
assignez-lui une voix.

QuickPunch et assignation dynamique 
des voix

(Pro Tools HD uniquement)

Lorsque vous utilisez QuickPunch avec un 
système Pro Tools|HD configuré pour 
l'utilisation d'un maximum de voix, veillez à 
régler l'assignation des voix pour chaque piste 
audio sur Dyn (ce qui correspond à Dynamically 
Allocated Voicing). Ceci garantit que Pro Tools 
gérera automatiquement la distribution des voix 
entre les deux ensembles de voix. Ainsi, pour un 
système Pro Tools|HD Accel à 192 voix, l'option 
d'assignation dynamique des voix répartit les 
voix de façon égale entre les quatre ensembles 
de voix (1 à 48, 49 à 96, 97–144 et 145 à 192).

Si vous n'utilisez pas l'option d'assignation 
dynamique des voix, ces dernières doivent être 
réparties de façon égale entre tous les moteurs 
DSP. Pour utiliser, par exemple, QuickPunch sur 
32 pistes sans l'option d'assignation dynamique 
des voix, les pistes 1 à 16 doivent être affectées 
aux voix 1 à 16 et les pistes 17 à 32 aux voix 33 
à 48.

Instructions d'enregistrement 
pour Pro Tools LE

Avec les systèmes Pro Tools LE, il est possible 
d'enregistrer simultanément 16 pistes audio en 
mode QuickPunch dans la limite du nombre de 
pistes mono prises en charge par votre système 
Pro Tools LE (voir Fonctionnalités des systèmes 
Pro Tools LE, page 12).

Pour enregistrer simultanément plus de 8 pistes 
avec QuickPunch, il convient de réduire le 
nombre de pistes de la session.

Enregistrement avec QuickPunch

Pour enregistrer à la volée avec QuickPunch :

1  Avec Pro Tools HD, assurez-vous que l'option 
Delay Compensation est désactivée dans le 
menu Options.

2  Sélectionnez Options > QuickPunch. Lorsque 
l'option QuickPunch est activée, la lettre P 
apparaît dans le bouton Record Enable. 

Avec Pro Tools LE, QuickPunch utilise la 
puissance du processeur, ce qui risque de 
réduire le nombre de pistes et de plug-in que 
vous pouvez utiliser.

Digidesign recommande l'enregistrement 
sans compensation de retard. Pour plus 
d'informations, reportez-vous à la section 
Compensation de retard, page 602. 
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3  Pour modifier l'option de crossfade 
automatique utilisé par QuickPunch, configurez 
l'option QuickPunch Crossfade Length dans la 
page Editing Preferences (voir 
QuickPunch/TrackPunch Crossfade Length :, 
page 252).

4  Préparez en enregistrement les pistes que vous 
voulez enregistrer avec QuickPunch. Vérifiez 
que votre système dispose d'un nombre suffisant 
de voix.

5  Préparez-vous à enregistrer en positionnant 
Pro Tools à l'endroit désiré. Si vous le souhaitez, 
activez une valeur de pré-roll dans la fenêtre 
Transport.

6  Démarrez la lecture en cliquant sur Play dans 
la fenêtre Transport.

7  A l'endroit du début de l'enregistrement, 
cliquez sur Record dans la fenêtre Transport.

– ou –

Avec les systèmes Digi 001 et Digi 002 Rack 
disposant d'une pédale, appuyez sur celle-ci au 
point d'entrée d'enregistrement désiré.

Le bouton Record Enable cesse de clignoter et 
reste allumé pendant l'enregistrement.

8  Pour arrêter l'enregistrement, cliquez de 
nouveau sur Record (ou appuyez sur la pédale).

Tandis que Pro Tools continue la lecture, vous 
pouvez effectuer d'autres entrées/sorties 
d'enregistrement (jusqu'à 100). Dans ce cas de 
figure, un seul fichier audio est enregistré, à 
partir duquel Pro Tools crée les régions 
appropriées.

QuickPunch avec une sélection 
d'édition

Si vous effectuez une sélection d'édition et 
utilisez QuickPunch, les règles suivantes 
s'appliquent :

◆ Si le Transport n'est pas activé, 
l'enregistrement commence et s'arrête chaque 
fois que vous cliquez sur le bouton Record 
Enable, quels que soient les points de début et 
de fin de la sélection. 

◆ Si le Transport est activé, le comportement en 
entrée/sortie de l'enregistrement est contrôlé par 
le paramètre Online Options de la page 
Operation Preferences. Si vous sélectionnez 
Record Online at Insertion/Selection, 
QuickPunch ne permet d'entrer/sortir de 
l'enregistrement qu'au sein de la sélection (ou 
dans le cas d'un point d'insertion, seulement 
après celui-ci). Si vous sélectionnez Record 
Online at Time Code Lock, QuickPunch ne tient 
pas compte de la sélection et entre/sort de 
l'enregistrement quand vous le souhaitez (une 
fois Pro Tools synchronisé sur le timecode).

Numérotation des régions et des prises 
avec QuickPunch

Après un enregistrement avec QuickPunch, les 
nouvelles régions audio apparaissent dans la 
liste des régions. Ceci comprend la région audio 
correspondant au fichier englobant tous les 
points d'entrée/sortie effectués au cours de la 
passe d'enregistrement, ainsi que les régions 
« dérivées » de chaque point d'entrée et de 
sortie.

Les noms des régions QuickPunch sont 
numérotés de façon séquentielle, en 
commençant par 01. Par exemple, si vous entrez 
deux fois en enregistrement QuickPunch sur 
une piste nommée Lead Gtr, une région du 
fichier audio parent apparaît, nommée Lead 

QuickPunch activé

QuickPunch activé
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Gtr_01, ainsi que deux régions correspondant 
aux entrées d'enregistrement QuickPunch, 
intitulées Lead Gtr_01_01 et Lead Gtr_01_02. 

Si vous arrêtez la lecture puis effectuez d'autres 
enregistrements en QuickPunch, les régions 
suivantes seront nommées de manière 
incrémentielle, en augmentant à chaque fois 
d'une unité les deux premiers chiffres du nom. 
Par exemple, lors de la seconde passe, les régions 
QuickPunch sont nommées Lead Gtr_02_01, 
Lead Gtr_02_02, et ainsi de suite.

Enregistrement audio 
TrackPunch
(Pro Tools HD uniquement)

TrackPunch optimise la fonction de défileur 
numérique de Pro Tools pour le 
réenregistrement de films (doublage) et le 
mixage. Des raccourcis clavier et des paramètres 
par défaut pour l'enregistrement et l'écoute des 
signaux d'entrée offrent un certain niveau de 
flexibilité qui fait de TrackPunch un mode 
également utile pour les chargements d'épreuves 
et l'enregistrement de bruitages, ainsi que pour 
l'enregistrement fractionné et le suivi dans les 
sessions musicales. 

Instructions d'utilisation de la fonction 
TrackPunch

TrackPunch et assignation dynamique des voix

Si vous utilisez le mode TrackPunch sur un 
système Pro Tools|HD configuré pour 
l'utilisation d'un maximum de voix, veillez à 
régler l'assignation des voix pour chaque piste 
audio sur dyn (ce qui correspond à Dynamically 
Allocated Voicing, précédemment appelé Auto 
Voice). Pro Tools peut ainsi gérer 
automatiquement les voix plus efficacement. 

Fichiers audio et TrackPunch

Après une passe d'enregistrement TrackPunch, 
la playlist de la piste concernée dans la fenêtre 
Edit affiche les régions créées à la suite de 
l'insertion des points d'entrée d'enregistrement. 
Vous pouvez utiliser tout outil de trimming 
après l'enregistrement fractionné pour ouvrir le 
début ou la fin des régions enregistrées en mode 
TrackPunch (et QuickPunch) ou pour révéler le 
fichier audio parent qui a été enregistré à 
l'arrière-plan. Vous pouvez ainsi compenser 
pour tout point d'enregistrement manqué ou 
tardif. 

Nombre de voix nécessaires pour 
l'enregistrement TrackPunch

TrackPunch nécessite deux voix pour chaque 
piste mono préparée en enregistrement. Vous 
pouvez ainsi enregistrer jusqu'à la moitié du 
nombre total de voix disponibles sur votre 
système. 

Lorsque vous activez le mode TrackPunch, vous 
êtes invité à libérer des voix supplémentaires si 
le nombre de voix disponibles n'est pas 
suffisant. 

Pour libérer des voix sur des pistes qui ne sont pas 
activées en enregistrement et qu'il n'est pas 
nécessaire d'écouter pendant l'enregistrement, 
effectuez l'une des opérations suivantes :

• Définissez l'assignation des voix des pistes 
sur Off.

• Désactivez des pistes.

• Rassemblez tous les plug-in RTAS avant les 
plug-in TDM.

En fonction des besoins, des voix utilisées par 
d'autres pistes peuvent être « volées » pendant 
l'enregistrement avec TrackPunch (certaines 
pistes sont alors coupées).
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La priorité de lecture des voix en mode 
TrackPunch est la même qu'avec QuickPunch, 
c'est-à-dire la suivante, par ordre décroissant :

• Les pistes dont les voix sont assignées, mais 
qui ne sont pas préparées en enregistrement

• Les pistes dont les voix sont assignées qui sont 
préparées en enregistrement

• Les pistes à assignation dynamique des voix 
qui ne sont pas préparées en enregistrement

• Les pistes à assignation dynamique des voix 
qui sont préparées en enregistrement

Si la session comprend un grand nombre de voix 
disponibles, vous pouvez ne pas rencontrer de 
problème en utilisant TrackPunch avec des 
pistes à assignation dynamique des voix. 
Toutefois, si les voix viennent à manquer et si 
vous voulez être sûr qu'une piste restera audible 
pendant l'enregistrement TrackPunch, assignez-
lui une voix. 

Présentation de l'enregistrement 
avec TrackPunch

Avant d'utiliser TrackPunch, configurez 
Pro Tools et TrackPunch comme suit : 

Pour configurer Pro Tools et TrackPunch : 

1  Configurez les paramètres de préférence 
TrackPunch comme suggéré dans Préférences 
TrackPunch, page 257. 

2  Si nécessaire, configurez les paramètres de 
synchronisation Pro Tools pour l'enregistrement 
en ligne et la préparation des pistes (voir 
Configuration de la synchronisation et de 
l'activation des pistes, page 259).

Pour utiliser TrackPunch :

1  Vérifiez que Pro Tools n'est pas en mode 
d'enregistrement ni de lecture (le transport est 
arrêté). 

2  Assurez-vous que l'option Delay 
Compensation est désactivée dans le menu 
Options.

3  Activez le mode TrackPunch (voir Activation 
du mode TrackPunch, page 259). 

4  Activez en mode TrackPunch toutes les pistes 
audio que vous souhaiter enregistrer de manière 
fractionnée pendant la passe d'enregistrement 
(voir Activation des pistes en mode TrackPunch, 
page 260). 

5  Configurer l'écoute des pistes préparées en 
enregistrement en sélectionnant le mode 
correspondant dans le menu Track. Vous avez le 
choix entre les options suivantes :

• Set Record Tracks to Auto Input

• Set Rec Enabled Tracks to Input Only

Le choix d'un mode d'écoute affecte 
uniquement les pistes préparées en 
enregistrement. 

6  Lancez la lecture. 

Digidesign recommande l'enregistrement 
sans compensation de retard. Pour en savoir 
plus sur la compensation de retard, 
reportez-vous à la section Compensation 
de retard, page 602.

Vous pouvez également utiliser les boutons 
TrackInput pour changer la source d'écoute 
pour les pistes préparées en enregistrement, 
comme expliqué ci-dessous. 
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7  Si vous souhaitez comparer les niveaux de la 
source d'entrée avec l'audio sur disque, cliquez 
sur le bouton TrackInput. La couleur verte 
(illumination) indique que la piste effectue 
l'écoute de l'entrée. La couleur grise (sans 
illumination) indique que la piste effectue 
l'écoute à partir du disque (pour en savoir plus, 
reportez-vous à Sélection du mode d'écoute de 
l'enregistrement avec la fonction TrackInput, 
page 191). 

8  Pour enregistrer de manière fractionnée des 
pistes les unes après les autres, activez le 
Transport Record, puis utilisez les différents 
boutons Track Record Enable pour appliquer des 
entrées et des sorties d'enregistrement dans 
chaque piste à la volée. 

9  Pour enregistrer de manière fractionnée 
plusieurs pistes simultanément, effectuez l'une 
des actions suivantes : 

• Préparez 16 pistes audio en enregistrement 
TrackPunch, puis utilisez le bouton 
Transport Record Enable pour appliquer 
des entrées et sorties d'enregistrement dans 
chacune d'elles simultanément. 

– ou –

• Activez d'abord le bouton Transport 
Record, puis appuyez sur les touches Alt-
Maj (Windows) ou Option-Maj 
(Macintosh) pour appliquer une entrée ou 
sortie d'enregistrement simultanément sur 
toutes les pistes TrackPunch sélectionnées.

10  Tout en continuant la lecture locale ou 
distante, effectuez l'une des actions suivantes :

• Appliquez des entrées d'enregistrement 
dans d'autres pistes TrackPunch 
séparément :

• Après avoir appliqué une sortie 
d'enregistrement, désactivez les pistes en 
enregistrement et activez d'autres pistes en 
mode d'enregistrement TrackPunch. 

• Répétez cette action pour appliquer des 
sorties d'enregistrement à d'autres stems, 
pistes ou prises. 

Préférences TrackPunch

Les préférences suivantes permettent de 
personnaliser les performances de la fonction 
TrackPunch. 

Durée de crossfade avec 
QuickPunch/TrackPunch :

Pro Tools peut écrire automatiquement un 
crossfade à chaque point d'entrée ou de sortie 
d'enregistrement lorsque vous utilisez 
TrackPunch. La durée de ces crossfades se définit 
via l'option QuickPunch Crossfade/TrackPunch 
Length dans la page Editing Preferences.

Pour définir la durée des crossfades en mode 
TrackPunch :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Editing.

2  Entrez une valeur (en ms) pour la longueur de 
crossfade QuickPunch /TrackPunch.

Utilisez des groupes pour les sélections de 
plusieurs pistes en un seul clic (cliquez à 
gauche de Group Name dans Group List). 
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Paramètres de transport et 
d'enregistrement des pistes

Les préférences TrackPunch s'affichent dans la 
page Operation Preferences. Ces préférences 
permettent de spécifier la façon dont l'état 
d'enregistrement des pistes et du transport doit 
réagir lors de l'arrêt du transport (pendant la 
lecture et l'enregistrement) et d'optimiser 
Pro Tools dans le cadre d'opérations de 
production musicale, vidéo ou 
cinématographique.

Transport RecordLock

ce paramètre permet de configurer l'option 
Transport Record de façon à émuler un défileur 
numérique ou à conserver le comportement 
hérité pour l'enregistrement principal dans la 
fenêtre Transport. 

◆ Si ce paramètre n'est pas sélectionné, l'option 
Transport Record est désactivée lorsque 
Pro Tools est arrêté manuellement ou lorsqu'il 
s'interrompt en raison d'une perte de timecode. 
Ceci reproduit le comportement 
d'enregistrement Pro Tools hérité. 

◆ Si ce paramètre est sélectionné, l'option 
Transport Record reste activée même en cas 
d'arrêt de la lecture ou de l'enregistrement. Ceci 
évite de réactiver le transport entre chaque prise, 
ce qui émule le comportement d'un défileur 
numérique. 

Destructive Recording et Transport RecordLock

Afin d'empêcher tout enregistrement accidentel 
sur des données précédemment enregistrées, 
la préférence Transport RecordLock est 
automatiquement désactivée et grisée lorsque le 
mode d'enregistrement Destructive est activé. 

Audio Track RecordLock

ce paramètre permet de configurer Pro Tools de 
façon à émuler un défileur numérique ou à 
conserver le comportement hérité pour l'état 
d'enregistrement des pistes. 

◆ Lorsque la préférence Audio RecordLock est 
activée, les pistes audio préparées à 
l'enregistrement restent activées même en cas 
d'arrêt de la lecture ou de l'enregistrement. 

◆ Lorsque la préférence Audio RecordLock n'est 
pas activée, les pistes audio quittent le mode de 
préparation à l'enregistrement en cas d'arrêt de 
Pro Tools. Ceci permet d'éviter que les pistes ne 
restent activées d'une passe à l'autre, émulant le 
comportement d'enregistrement de piste d'un 
défileur numérique.

Préférences TrackPunch

Préférences TrackPunch

La sortie de l'enregistrement en cliquant sur 
Record dans le Transport a pour effet de 
sortir le transport du mode prêt à 
l'enregistrement.
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Destructive Recording et Transport 
RecordLock

Afin d'empêcher tout enregistrement accidentel 
sur des données précédemment enregistrées, la 
préférence Transport RecordLock est 
automatiquement désactivée et grisée lorsque le 
mode d'enregistrement Destructive est activé. 

Configuration de la 
synchronisation et de l'activation 
des pistes

Dans le cadre de l'enregistrement en ligne et de 
l'enregistrement fractionné, configurez les 
paramètres Peripheral et Session Setup en 
procédant comme suit : Pour obtenir des temps 
de verrouillage optimaux lors de la 
synchronisation, il est déconseillé d'appliquer le 
mode TrackPunch à plus de 16 pistes à la fois.

Pour procéder à un enregistrement en ligne à 
l'aide de la permutation TrackPunch :

1  Choisissez Setup > Peripherals et assurez-vous 
que SYNC I/O est le périphérique de 
synchronisation sélectionné et qu'il 
communique avec Pro Tools. 

2  Choisissez Setup > Session et procédez ainsi :

• Sélectionnez une référence de position et 
d'horloge. 

• Si vous voulez que Pro Tools serve de 
périphérique de timecode principal, activez 
l'option Using SYNC/USD. Cette option 
fait partie des commandes Generator 
situées dans la zone Time Code Settings de 
la fenêtre Session Setup. 

3  Si vous contrôlez Pro Tools à l'aide d'un 
protocole 9 broches, procédez comme suit :

• Cliquez sur l'onglet Machine Control pour 
afficher la page Machine Control dans la 
boîte de dialogue Peripherals. 

• Configurez les paramètres du mode Remote 
9-pin Deck Emulation (voir le guide 
MachineControl).

• Cliquez sur OK pour refermer la boîte de 
dialogue Peripherals.

Activation du mode TrackPunch

Avant de pouvoir activer des pistes audio 
individuelles pour effectuer un enregistrement 
en mode TrackPunch, ce dernier doit avoir été 
activé au niveau du transport Pro Tools.

Pour activer le mode TrackPunch :

1  Vérifiez que Pro Tools n'est pas en mode 
d'enregistrement ni de lecture (le transport est 
arrêté). 

2  Effectuez l'une des opérations suivantes :

• Sélectionnez Options > TrackPunch.

• Cliquez avec le bouton droit de la souris 
(Windows) ou cliquez en maintenant la 
touche Contrôle enfoncée (Macintosh) sur 
le bouton Transport Record Enable pour 
faire défiler les modes d'enregistrement 
disponibles jusqu'à ce que le mode 
TrackPunch soit sélectionné (un T 
majuscule indique le mode TrackPunch). 

• Appuyez sur les touches Contrôle-Maj-T 
(Macintosh) ou sur Ctrl-Maj-T (Windows).

Contactez le fabricant de votre contrôleur 
pour obtenir les profils les plus récents et les 
mises à jour disponibles pour la prise en 
charge de Pro Tools. 

Bouton Transport Record avec mode TrackPunch activé
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Affichage de l'état du mode 
TrackPunch dans la fenêtre 
Transport

Bouton Transport Record Enable

Le bouton Transport Record Enable indique 
l'état TrackPunch et Record comme suit :

Lorsque le mode TrackPunch est activé :

◆ Le bouton Transport Record Enable porte un T 
majuscule. 

◆ Si au moins une piste est en mode 
TrackPunch, le bouton Transport Record Enable 
reste allumé en bleu. 

Lorsque le mode TrackPunch est activé et que 
le transport est prêt à l'enregistrement :

◆ Si aucune piste n'est en mode TrackPunch, le 
bouton Transport Record Enable clignote en gris 
et rouge. 

◆ Si au moins une piste est en mode 
TrackPunch, le bouton Transport Record Enable 
clignote en bleu et rouge.

◆ Si au moins une piste est en mode TrackPunch 
et également en mode d'enregistrement, le 
bouton Transport Record Enable clignote en 
rouge et bleu et le voyant d'enregistrement 
s'allume.

◆ Dès qu'au moins une piste est en mode 
d'enregistrement, le bouton Transport Record 
Enable reste allumé en rouge.

Activation des pistes en mode 
TrackPunch

Vous pouvez activer des pistes en mode 
TrackPunch sans les activer en mode 
enregistrement, ce qui permet l'entrée sur 
certaines pistes après le lancement de la lecture. 

Pour activer ou désactiver une piste en mode 
TrackPunch :

■ Tout en maintenant la touche Démarrer 
(Windows) ou Contrôle (Macintosh) enfoncée, 
cliquez sur le bouton Record Enable de la piste 
pour l'allumer en bleu. 

Pour activer ou désactiver toutes les pistes audio 
en mode TrackPunch : 

■ Tout en maintenant les touches Alt et 
Démarrer (Windows) ou Option et Contrôle 
(Macintosh) enfoncées, cliquez sur les boutons 
Record Enable de toutes les pistes pour les 
allumer en bleu. 

Pour activer ou désactiver toutes les pistes audio 
sélectionnées en mode TrackPunch :

■ Tout en maintenant les touches Alt, Maj et 
Démarrer (Windows) ou Option, Contrôle et 
Maj (Macintosh) enfoncées, cliquez sur les 
boutons Record Enable des pistes sélectionnées 
pour les allumer en bleu.

Indicateurs d'état des modes TrackPunch et TrackInput 
dans la fenêtre Transport

Indicateur 

de l'entrée

TrackPunch activé
Indicateur d'état
d'activation à 
l'enregistrement

d'état

Créez des groupes de pistes pour chaque 
stem ou ensemble de pistes sur lesquelles 
vous prévoyez d'effectuer une entrée. La liste 
des groupes permet de sélectionner 
rapidement toutes les pistes du groupe. 
Il s'avère ainsi plus facile d'activer ou de 
désactiver simultanément plusieurs pistes 
en mode TrackPunch. 
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Affichage de l'état d'enregistrement 
des pistes

Le bouton Record Enable de chaque piste 
indique son état d'activation en mode 
TrackPunch et en mode enregistrement 
comme suit :

• Si les deux modes sont activés pour une piste, 
son bouton Record Enable clignote en bleu et 
rouge. 

• Si le mode TrackPunch est activé pour une 
piste mais pas le mode enregistrement, son 
bouton Record Enable reste allumé en bleu. 

• Si seul le mode enregistrement est activé pour 
une piste, son bouton Record Enable clignote 
en rouge. 

• Si une piste se trouve en cours 
d'enregistrement (quel que soit le mode), son 
bouton Record Enable reste allumé en rouge.

Enregistrement TrackPunch

Après avoir activé le mode TrackPunch de 
Pro Tools et activé ce type d'enregistrement 
pour des pistes, vous pouvez procéder à 
l'enregistrement de différentes manières.

Entrées d'enregistrement sur 
différentes pistes

Pour effectuer des entrées d'enregistrement sur 
des pistes :

1  Activez le mode TrackPunch de Pro Tools.

2  Tout en maintenant la touche Démarrer 
(Windows) ou Contrôle (Macintosh) enfoncée, 
cliquez sur le bouton Record Enable de chaque 
piste concernée afin de n'activer pour celle-ci 
que le mode TrackPunch. Le bouton Record 
Enable de la piste doit rester allumé en bleu. 

3  Cliquez sur Record dans la fenêtre Transport 
pour activer le mode d'enregistrement 
TrackPunch. Le bouton Record Enable clignote 
en bleu et rouge.

4  Pour commencer la lecture, cliquez sur le 
bouton de lecture de la fenêtre Transport.

5  Pendant la lecture, effectuez des entrées ou 
sorties d'enregistrement sur des pistes en mode 
TrackPunch en cliquant sur leurs boutons 
Record Enable.

6  Arrêtez la lecture. Une fois la passe 
d'enregistrement terminée, les états d'activation 
en mode enregistrement et de préparation de 
l'enregistrement correspondent à la 
configuration par défaut TrackPunch actuelle. 

Indication de l'état du mode TrackPunch d'une piste 
audio dans la fenêtre Mix

Etat d'enregistrement d'une piste dans la fenêtre Edit

Bouton d'enregistrement

Un allumage en rouge 

(tous les modes)
permanent indique l'enregistrement
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Entrées d'enregistrement sur plusieurs 
pistes simultanément

Pour effectuer simultanément des entrées 
d'enregistrement sur plusieurs pistes :

1  Activez le mode TrackPunch de Pro Tools.

2  Cliquez sur le bouton Record Enable de 
chaque piste concernée afin d'activer pour celle-
ci les modes TrackPunch et enregistrement. 
Le bouton Record Enable de la piste doit 
clignoter en bleu et rouge. 

3  Pour commencer la lecture, cliquez sur le 
bouton de lecture de la fenêtre Transport.

4  Pendant la lecture, cliquez sur le bouton 
Record de la fenêtre Transport pour effectuer 
simultanément des entrées ou sorties 
d'enregistrement sur toutes les pistes en mode 
TrackPunch. 

5  Arrêtez la lecture. Une fois la passe 
d'enregistrement terminée, les états d'activation 
en mode enregistrement et de préparation de 
l'enregistrement correspondent à la 
configuration par défaut TrackPunch actuelle. 

Lancement de l'enregistrement sur 
toutes les pistes

1  Activez le mode TrackPunch de Pro Tools.

2  Cliquez sur le bouton Record Enable de 
chaque piste concernée afin d'activer pour celle-
ci les modes TrackPunch et enregistrement. Le 
bouton Record Enable de la piste doit clignoter 
en bleu et rouge. 

3  Cliquez sur Record dans la fenêtre Transport 
pour activer le mode d'enregistrement 
TrackPunch. Le bouton Record Enable clignote 
en bleu et rouge.

4  Pour commencer la lecture, cliquez sur le 
bouton de lecture de la fenêtre Transport.

5  Pendant la lecture, effectuez des entrées ou 
sorties d'enregistrement sur des pistes en mode 
TrackPunch en cliquant sur leurs boutons 
Record Enable.

6  Arrêtez la lecture. Une fois la passe 
d'enregistrement terminée, les états d'activation 
en mode enregistrement et de préparation de 
l'enregistrement correspondent à la 
configuration par défaut TrackPunch actuelle. 

Procédures TrackPunch

Avec TrackPunch, Pro Tools émule et optimise 
les quatre activités cinématographiques, vidéo 
et musicales suivantes :

• Doublage et mixage de films (voir Doublage et 
mixage de films avec TrackPunch, page 263)

• Chargement d'épreuves (voir Chargement 
d'épreuves à l'aide de la préférence 
RecordLock, page 264)

• Enregistrement de bruitages (voir 
Enregistrement de bruitages avec TrackPunch, 
page 264)

• Suivi et enregistrement fractionné pour la 
production musicale et tout autre 
environnement d'enregistrement (voir Suivi 
et enregistrement fractionné de musique en 
mode TrackPunch, page 265)

Chacune de ces procédures tire parti des 
fonctionnalités et options du mode 
TrackPunch. 

Les exemples pratiques ci-dessous partent du 
principe que vous connaissez déjà les 
techniques d'acheminement, de sélection et de 
groupement des pistes Pro Tools. Si vous n'êtes 
pas familiarisé avec ces techniques, consultez la 
section appropriée du Guide de référence 
Pro Tools. 
Guide de référence Pro Tools



Doublage et mixage de films avec 
TrackPunch

En offrant toutes les capacités d'enregistrement 
fractionné en ligne et de permutation d'écoute 
d'un défileur numérique, TrackPunch optimise 
Pro Tools pour le réenregistrement et le mixage 
des films. 

Les fonctionnalités de doublage et de mixage de 
films de TrackPunch offrent les possibilités 
suivantes :

• Activation et enregistrement fractionné de 
pistes audio Pro Tools à distance, à partir d'un 
synchroniseur principal (comme les 
commandes SoundMaster through P2), à tout 
moment, sans interruption de la lecture et 
tout en maintenant la synchronisation avec le 
timecode (requiert Digidesign 
MachineControl)

• Bascule des pistes audio Pro Tools entre 
l'écoute d'entrée et de disque 

• Utilisation de TrackPunch lorsque Pro Tools 
sert de périphérique principal de timecode 
(génération) et lors de l'asservissement. 

• Comme Pro Tools peut être utilisé en réseau, 
les fichiers audio TrackPunch (et tous les 
autres) et les sessions entières peuvent être 
utilisés pour un transfert sécurisé vers d'autres 
systèmes à des fins de vérification, de 
modification et d'archivage. 

Les sessions de pré-doublage types utilisant 
TrackPunch impliquent les étapes suivantes :

1  Configurez la synchronisation entre Pro Tools 
et les autres dispositifs. 

2  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation.

3  Sélectionnez (activez) Transport RecordLock. 
Elle restera activée après la fin du transport.

4  Désactivez Audio Track RecordLock. 
L'enregistrement de la piste audio est désactivé à 
la fin du transport.

5  Choisissez Options > TrackPunch pour activer 
le mode TrackPunch. 

6  Créez 32 pistes, puis effectuez les actions 
suivantes : 

• Affectez leurs entrées.

• Groupez-les par huit. 

7  Cliquez sur les boutons d'activation de 
l'enregistrement dans les huit premières pistes 
pour les faire passer en mode TrackPunch (ou le 
groupe pour la première passe de pré-doublage).

8  Affectez les commandes de la console au 
premier groupe de huit pistes dans la session. 

9  Commencez la passe de pré-doublage. Utilisez 
les commandes de la console pour activer 
Pro Tools et pour appliquer des entrées et sorties 
d'enregistrement au premier groupe. 

10  Lorsque le premier pré-doublage est terminé 
et que toutes les pistes sont désactivées pour 
l'enregistrement, supprimez toutes les pistes en 
mode TrackPunch.

11  Sélectionnez le groupe de pistes suivant et 
activez-les pour le mode TrackPunch.

En mode Remote, Transport RecordLock n'a 
aucun effet. Le synchroniseur détermine le 
comportement.

En mode Remote, Audio Track RecordLock 
n'a aucun effet. Le synchroniseur détermine 
le comportement.

Utilisez la liste du groupe pour sélectionner 
rapidement toutes les pistes du groupe, puis 
appuyez sur les touches Alt-Maj (Windows) 
ou Option-Maj (Macintosh) pour activer en 
enregistrement toutes les pistes du groupe.
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12  Appliquez des entrées et sorties 
d'enregistrement au deuxième groupe de pistes. 

13  Répétez l'opération si nécessaire.

Chargement d'épreuves à l'aide 
de la préférence RecordLock

Outre le doublage et le mixage, Pro Tools facilite 
le chargement d'épreuves. Les épreuves et les 
types de transferts comparables sont composés 
de plusieurs prises ou scènes, chacune étant 
enregistrée tout en étant synchronisée avec un 
timecode horaire unique. Entre les prises, le 
timecode ne continue pas ; il s'arrête 
complètement. C'est pourquoi le timecode des 
épreuves et des données source comparables est 
qualifié de discontinu. 

Lorsqu'une session est mise hors ligne pendant 
l'enregistrement en raison de la discontinuité du 
timecode, Pro Tools reste activé et attend la 
reprise du timecode. Pro Tools recommence 
l'enregistrement lorsque la synchronisation est 
rétablie avec le timecode pour la prise suivante. 
Chaque piste est enregistrée dans son propre 
fichier audio. 

Pour configurer RecordLock pour le chargement :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation. 

2  Sélectionnez (activez) Transport RecordLock. 

3  Sélectionnez (activez) Audio Track 
RecordLock. 

4  Configurez la synchronisation et les autres 
paramètres. Mettez Pro Tools en ligne et 
démarrez le lecteur source externe. 

5  Chaque fois que le timecode s'interrompt ou 
s'arrête, Pro Tools reste en ligne et attend de 
recevoir un nouveau timecode. Les pistes 
activées pour le transport et l'enregistrement 
restent activées pour l'enregistrement (ou en 
mode TrackPunch). Lorsque le timecode 
reprend, Pro Tools commence l'enregistrement 
dans un nouveau fichier (avec un marquage 
temporel correct basé sur le code entrant). 

Enregistrement de bruitages avec 
TrackPunch

L'enregistrement des bruitages est un type 
d'enregistrement dont les conditions de 
contrôle sont spécifiques. Entre les entrées ou 
sorties d'enregistrement et les prises, les entrées 
doivent être coupées lorsque les artistes de 
bruitage se déplacent avec leur matériel pendant 
les scènes. 

L'écoute TrackInput peut être configurée pour la 
prise en charge de l'enregistrement TrackPunch 
des bruitages avec la préférence Mute Record-
Armed Tracks While Stopped.

Pour configurer Pro Tools pour le contrôle 
d'enregistrement TrackPunch des bruitages : 

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation.

2  Activez Mute Record-Armed Tracks While 
Stopped.

Comme Pro Tools dispose d'une limite de 
graduation temporelle de 13 heures, vous 
devrez utiliser plusieurs sessions pour 
charger les épreuves si l'écart est supérieur à 
13 heures.
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3  Configurez la synchronisation et les autres 
paramètres de Pro Tools et des différents 
périphériques, puis activez le mode TrackPunch 
et procédez à l'enregistrement TrackPunch (voir 
Présentation de l'enregistrement avec 
TrackPunch, page 256 pour connaître les 
différentes étapes impliquées).

Lorsque l'option Mute Record-Armed Tracks 
While Stopped est activée, les pistes activées en 
enregistrement sont coupées si le transport est 
arrêté. L'écoute des entrées reste possible, à tout 
moment, au moyen du commutateur 
TrackInput. 

Suivi et enregistrement 
fractionné de musique en mode 
TrackPunch

L'enregistrement multipiste moderne requiert la 
possibilité de « capturer l'instant » en 
permettant l'enregistrement à la volée et 
TrackPunch. Les fonctions de TrackPunch pour 
les situations de suivi et enregistrement 
fractionné sont notamment les suivantes :

• Activez les pistes pour l'enregistrement à la 
volée. 

• Appliquez des entrées et sorties 
d'enregistrement à l'aide des boutons Record 
Enable à l'écran, à distance à partir d'un 
synchroniseur, à l'aide d'une surface de 
contrôle ou au moyen d'une pédale. 

• Comparez les niveaux à l'aide du 
commutateur TrackInput. 
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Chapitre 15 : Notions de base d'édition

Edition dans Pro Tools
La fenêtre Edit de Pro Tools offre un puissant 
ensemble d'outils d'édition et d'assemblage de 
pistes audio et MIDI. Les données des pistes 
peuvent être éditées de façon non destructive et 
en temps réel pendant la lecture.

La fenêtre Edit vous permet également d'éditer 
graphiquement l'automation des pistes. Pour 
plus d'informations sur l'option Automation de 
la fenêtre Edit, consultez le 

Edition non destructive

La grande majorité des opérations d'édition 
audio dans Pro Tools est non destructive. Qu'il 
s'agisse de couper, de coller, de « rogner », de 
séparer ou de supprimer des régions, vous 
n'effectuez ces opérations que sur une carte des 
données audio réelles. Les fichiers audio sources 
demeurent intacts. Si un processus ou un outil 
particulier fonctionne de façon destructive (ce 
qui signifie qu'il modifie définitivement les 
fichiers audio de votre disque dur), ce guide 
vous en avertit.

Si l'édition de pistes MIDI peut être destructive 
dans certains cas, le respect de quelques 
précautions vous permettra de préserver vos 
pistes et vos régions MIDI importantes lorsque 
vous effectuerez des opérations d'édition (voir 
Edition MIDI non destructive, page 283).

Edition en cours de lecture

Pro Tools permet d'effectuer de nombreuses 
tâches d'édition pendant la lecture de la session. 
Cette particularité permet de modifier et d'éditer 
une session de façon interactive, puisque vous 
entendez immédiatement les modifications 
apportées. Il existe de nombreux cas dans 
lesquels vous pourrez utiliser cette fonction afin 
d'augmenter votre productivité lorsque vous 
travaillez dans une session. 

Vous trouverez ci-après quelques exemples 
d'édition que vous pouvez réaliser au cours 
d'une boucle ou pendant la lecture de vos 
pistes :

• Capture, séparation et rognage de régions

• Placement, repérage ou réorganisation de 
régions

• Ajout de fondus ou de crossfades à des 
régions audio

• Transposition, quantification (y compris 
Groove Quantize) et autres modifications 
des pistes MIDI

• Déplacement par décalage de régions audio 
ou MIDI

• Ecoute de différentes playlists

• Réglage ou mise à l'échelle de données 
d'automation

• Insertion d'un plug-in temps réel
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• Traitement de l'audio avec un plug-in 
AudioSuite

• Edition d'un point d'inflexion 
d'automation

Lorsque Pro Tools est en lecture, certains aspects 
ne peuvent être modifiés. Ce guide s'y rapporte 
au fur et à mesure de la présentation des 
fonctions. Le routage vers les départs et 
l'affectation des sorties en font partie.

Données de la piste
Chaque fois que vous enregistrez ou importez 
des données audio et MIDI, Pro Tools crée des 
régions pour les nouvelles données de la piste, 
qui n'indiquent pas seulement où elles 
commencent et où elles se terminent, mais qui 
offrent une bonne idée de leur forme d'onde 
générale et de leur contenu. Lorsque vous 
enregistrez des prises supplémentaires ou que 
vous entrez à un emplacement donné d'une 
piste, Pro Tools crée de nouvelles régions.

On peut également créer des régions en coupant 
et collant, en redimensionnant, en séparant et 
en re-capturant des régions existantes. Les 
régions d'une session s'affichent dans la liste des 
régions, d'où l'on peut les faire glisser vers des 
pistes existantes. Une piste peut contenir un 
nombre indifférent de régions, dans n'importe 
quelle disposition. La playlist d'une piste définit 
l'ordre de lecture et l'emplacement des régions 
composant une piste. 

Types de régions

Il existe différents types de régions audio et 
MIDI en fonction de leur mode de création :

Régions audio de fichiers complets : ces régions 
audio sont créées pendant l'enregistrement ou 
l'importation de données audio, le 
regroupement de régions existantes et le 
traitement non destructif par un plug-in 
AudioSuite. Les régions audio de fichiers 
complets font référence à un fichier audio 
complet qui se trouve sur votre disque dur. 
Les régions audio de fichiers complets 
s'affichent en gras dans la liste des régions 
(voir Liste des régions, page 295). Les régions 
normales ne font souvent référence qu'à une 
partie du fichier audio parent et sont créées en 
cours d'édition et, dans certains cas, en cours 
d'enregistrement fractionné.

Régions définies par l'utilisateur : il s'agit des 
régions définies de façon explicite par 
l'utilisateur, par exemple lors de 
l'enregistrement ou de l'importation de données 
audio ou MIDI ; quand vous capturez, séparez 
ou regroupez une sélection ; quand vous 
« rognez » une région audio d'un fichier 
complet ou encore quand vous renommez une 
région existante.

Régions créées automatiquement : ces régions 
sont créées automatiquement en cours d'édition 
et, dans certains cas, en cours d'enregistrement 
fractionné dans des régions existantes. Dans la 
mesure où ces régions peuvent rapidement 
s'accumuler au cours d'une session, vous pouvez 
les masquer pour qu'elles ne s'affichent pas dans 
la liste des régions (voir Attribution de noms et 
affichage des régions, page 420). les régions 
créées automatiquement peuvent être 
transformées en régions définies par l'utilisateur 
en les renommant.

En plus des régions audio et MIDI, les pistes 
offrent également des playlists 
d'automation. L'automation peut être 
enregistrée et éditée dans les fenêtres Edit 
ou Mix. Pour plus d'informations, 
consultez le Chapitre 27, L'automation.
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Régions Offline : les régions sont offline lorsque 
leurs fichiers audio parents sont introuvables ou 
non disponibles à l'ouverture d'une session ou 
lors de l'importation d'une piste. Les régions 
offline apparaissent estompées et en italiques 
dans la liste des régions ; elles apparaissent en 
bleu clair avec leur nom en italiques dans les 
playlists. Les régions offline peuvent être éditées 
au même titre que les autres régions, mais elles 
ne peuvent être traitées par des plug-in 
AudioSuite. 

Régions multicanaux : ces régions, qui 
s'affichent en tant que région unique dans la 
liste des régions, font référence à plusieurs 
régions et fichiers audio pour les pistes stéréo et 
Surround. Les régions multicanaux peuvent être 
agrandies (en cliquant sur le triangle qui se 
trouve à côté de leur nom) pour faire apparaître 
les différents canaux, que vous pouvez alors 
faire glisser sur les pistes indépendamment les 
unes des autres.

Groupes de régions : ensemble formé de 
plusieurs régions audio et MIDI, un groupe de 
régions s'affiche et agit comme une région 
unique. Les groupes de régions servent 
essentiellement de conteneur à une ou plusieurs 
régions. Ils peuvent être créés sur une ou 
plusieurs pistes adjacentes audio, MIDI et 
d'instrument. Ils permettent de rassembler 
plusieurs régions en une macrorégion, ce qui 
facilite la manipulation, l'édition et 
l'organisation des ambiances et du tempo.

Vue de piste

La vue de la piste détermine quelles données 
sont affichées et éditées dans la zone de la 
playlist de la piste. Les données de la vue de la 
piste peuvent être définies sur Blocks, 
Waveform, Volume, Pan, Mute, ou sur un 
paramètre automatisé ou un contrôleur 
continu, suivant le type de piste.

Pistes audio : les pistes audio peuvent être 
réglées sur Blocks, Waveform, Volume, Pan, Mute, 
ou sur n'importe quel paramètre de plug-in 
ayant été automatisé. Sauf lors de l'édition des 
données d'automation, les pistes audio sont 
définies par défaut sur la vue Waveform et leurs 
données sont donc représentées graphiquement 
sous la forme d'ondes d'amplitude 
(représentation temps-domaine du son). Cette 
vue de la piste présente suffisamment de détails 
pour permettre des éditions importantes de la 
région.

Pistes d'entrée auxiliaire : les pistes auxiliaires 
peuvent être définies sur Volume, Pan, Mute, ou 
sur n'importe quel paramètre de plug-in ayant 
été automatisé. 

Pistes de fader principal : ces pistes peuvent être 
réglées sur Volume, ou sur n'importe quel 
paramètre de plug-in ayant été automatisé.Pour plus d'informations sur les groupes de 

régions, voir Groupes de régions, 
page 386.

Visualisation d'une piste audio en mode Waveform
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Pistes MIDI : les pistes MIDI peuvent être réglées 
sur Blocks, Regions, Notes, Volume, Pan, Mute, 
Velocity, Pitch Bend, After Touch, Program, Sysex, 
et sur n'importe quel type de contrôleur 
continu. Sauf lors de l'édition des données de 
contrôleurs, de changements de programme ou 
d'événements Système Exclusif, les pistes MIDI 
sont généralement visualisées en vue Notes ou 
Regions, chacun affichant les notes sous forme 
de « rouleau de piano » (piano roll). Utilisez la 
vue Notes pour insérer, éditer, copier et coller 
des notes MIDI ; utilisez la vue Regions pour 
disposer, capturer ou regrouper des régions.

Pistes d'instrument : ces pistes peuvent être 
définies sur Blocks, Regions, Notes, Volume, Pan, 
Mute, Velocity, Pitch Bend, After Touch, Program, 
Sysex et sur tout type de contrôleur continu pour 
pistes MIDI, ainsi que sur Volume, Pan, Mute ou 
tout contrôle de plug-in automatisé pour de 
l'audio. Sauf lors de l'édition des données de 
contrôleurs, de changements de programme ou 
d'événements Sysex (système exclusif), les pistes 
d'instrument sont généralement définies sur la 
vue Notes ou Regions, affichant les notes sous 
forme de bande perforée pour piano mécanique. 
Utilisez la vue Notes pour insérer, éditer, copier 
et coller des notes MIDI ; utilisez la vue Regions 
pour disposer, capturer ou regrouper des 
régions.

Lorsque la vue de la piste est définie sur Blocks, 
les régions audio et MIDI s'affichent sous forme 
de blocs vides portant le nom de la région. 
Ce mode est particulièrement utile lorsque, 
après avoir capturé et édité des régions au 
niveau de la forme d'onde ou de l'événement 
MIDI, vous désirez les déplacer et les réorganiser. 
Les rafraîchissements d'écran sont plus rapides 
dans ce format d'affichage.

Lorsque l'affichage d'une piste audio ou 
d'instrument est défini sur Volume, Pan ou un 
autre contrôle automatisé, ou lorsqu'une piste 
MIDI ou d'instrument est paramétrée sur l'un 
des types de contrôleurs continus (Volume, 
Pitch Bend, After Touch), les données de cette 
piste s'affichent sous la forme de segments de 
droite reliés par des points d'inflexion 
modifiables. Pour modifier les données 
d'automation, déplacez ces points d'inflexion 
ou ajoutez-en à l'aide du crayon ou de la main.

Pour de plus amples informations sur les 
données d'automation des pistes audio, 
consultez le Chapitre 27, L'automation. Pour de 
plus amples informations sur l'insertion et 
l'édition des données du contrôleur des pistes 
MIDI, consultez la section Evénements de 
contrôleur continu, page 510.

Vue de la piste MIDI en mode Notes

Vue de la piste audio définie sur Pan
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Pour définir le mode de visualisation de la piste :

■ Cliquez sur le sélecteur de vue de piste et 
choisissez le format désiré dans le menu 
contextuel.

La piste est alors visualisée dans le nouveau 
format. Si elle fait partie d'un groupe d'édition 
actif, toutes les pistes du groupe passent aussi 
sur ce nouveau format de visualisation.

Changement de vue de piste

Avec les pistes audio, MIDI, d'entrée auxiliaire et 
d'instrument, vous pouvez passer d'une vue à la 
suivante ou à la précédente, ou basculer entre 
plusieurs vues courantes prédéfinies.

Navigation entre plusieurs vues

Lorsque vous passez à la vue suivante ou que 
vous revenez à la vue précédente, l'ordre de la 
liste n'est pas modifié dans le sélecteur de vue de 
piste.

Sélecteur de vue de piste audio

Sélecteur de vue de piste MIDI

Sélecteur de vue de piste auxiliaire

Cliquez pour afficher le menu 
déroulant Track View

Cliquez pour afficher le menu 
déroulant Track View

Cliquez pour afficher le menu 
déroulant Track View

Sélecteur de vue de piste d'instrument

Les vues en tête de liste (notamment, la vue 
Blocks pour les pistes audio ou MIDI) ne 
peuvent pas être remplacées par une vue 
précédente. De même, les vues en fin de liste 
(notamment, la vue des contrôleurs MIDI) 
ne peuvent pas être remplacées par la vue 
suivante.

Cliquez pour afficher le menu 
déroulant Track View
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Pour passer à la vue suivante ou précédente :

1  Cliquez sur la piste dont vous souhaitez 
modifier la vue. Pour changer la vue de plusieurs 
pistes, maintenez la touche Maj enfoncée et 
cliquez sur les pistes souhaitées ou faites glisser 
le sélecteur, ou bien sélectionnez un groupe.

2  Effectuez l'une des opérations suivantes :

• Pour passer à la vue précédente ou à la vue 
suivante des pistes sélectionnées, 
maintenez les touches Ctrl+Démarrer 
(Windows) ou Ctrl+Pomme (Macintosh) 
enfoncées et appuyez sur les flèches gauche 
ou droite, indiquant respectivement la vue 
précédente et la vue suivante.

– ou –

• Pour passer à la vue précédente ou à la vue 
suivante de toutes les pistes, maintenez les 
touches Ctrl+Alt+Démarrer (Windows) ou 
Ctrl+Option+Pomme (Macintosh) 
enfoncées et appuyez sur les flèches gauche 
ou droite, indiquant respectivement la vue 
précédente et la vue suivante.

Basculement d'une vue de piste courante à 
une autre

Les vues de piste les plus couramment utilisées 
pour l'édition de pistes audio sont les vues 
Waveform et Volume. Pour l'édition de pistes 
MIDI et d'instrument, il s'agit des vues Notes et 
Regions. Pro Tools offre la possibilité de basculer 
simplement d'une vue à l'autre.

Pour changer la vue de pistes sélectionnées :

1  Cliquez sur la piste pour laquelle vous voulez 
changer la visualisation. Pour changer la vue de 
plusieurs pistes, maintenez la touche Maj 
enfoncée et sélectionnez les pistes souhaitées ou 
faites glisser le sélecteur.

2  Effectuez l'une des opérations suivantes :

• Appuyez sur les touches Ctrl+moins (-) 
(Macintosh) ou sur Démarrer+moins (-) 
(Windows) du clavier alphanumérique.

– ou –

• Après avoir activé le focus clavier sur les 
commandes, appuyez sur la touche moins 
(-) du clavier alphanumérique.

Les pistes audio passent de la vue Waveform à la 
vue Volume et inversement. Les pistes MIDI et 
les pistes d'instrument passent de la vue Notes à 
la vue Regions, et inversement.

Vues principales des pistes

Les pistes audio, MIDI et d'instrument 
possèdent des vues dites principales. Lorsqu'une 
piste est affichée dans une vue principale, toutes 
les modifications effectuées s'appliquent à 
l'ensemble des données de la piste. Par exemple, 
lorsqu'une piste audio est définie sur Waveform, 
l'opération de copier/coller ne concerne pas 
seulement les informations de la forme d'onde, 
mais également toutes les données 
d'automation associées. 

Pour basculer la vue de toutes les pistes, 
appuyez sur les touches Ctrl+Option+moins 
(-) (Macintosh) ou sur 
Démarrer+Alt+moins (-) (Windows) du 
clavier alphanumérique.

Lorsque le focus clavier est activé, vous 
pouvez basculer la vue de toutes les pistes 
en appuyant simplement sur les touches 
Option+moins (-) (Macintosh) ou sur 
Alt+moins (-) (Windows) du clavier 
alphanumérique.
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La vue principale dépend du type de piste :

• Pistes audio : Waveform et Blocks

• Pistes MIDI et d'instrument : Regions, 
Blocks et Notes (avec le sélecteur)

La vue Volume est la vue principale des pistes 
d'entrée auxiliaire et des pistes de fader 
principal. Lorsqu'une piste d'entrée auxiliaire ou 
de fader principal est affichée dans une vue 
principale, toutes les modifications effectuées 
s'appliquent à l'ensemble des données 
d'automation de la piste.

Hauteur de la piste

Vous pouvez visualiser les pistes dans la fenêtre 
Edit selon six hauteurs : Mini, Small, Medium, 
Large, Jumbo, et Extreme. Plus les hauteurs de 
pistes sont grandes, plus l'édition est précise. 
Cette condition s'applique particulièrement aux 
pistes MIDI. Les hauteurs de pistes plus petites 
sont utiles pour économiser l'espace d'écran 
dans une session de grande taille.

Vous pouvez régler la hauteur des pistes 
individuellement ou définir la même hauteur 
pour toutes les pistes. La hauteur des pistes est 
réglable en cours de lecture.

Pour définir la hauteur de la piste :

■ Cliquez sur la petite flèche située à côté du 
sélecteur de vue de piste pour faire apparaître le 
menu déroulant de hauteur de piste.

– ou –

■ Cliquez sur la zone située à droite des 
commandes de la piste et choisissez la hauteur 
dans le menu déroulant.

La piste est redimensionnée à la nouvelle 
hauteur. Si la piste fait partie d'un groupe 
d'édition, toutes les pistes de ce groupe adoptent 
la nouvelle hauteur.

Affichage étendu de piste

Les pistes stéréo et multicanaux partagent la 
même playlist pour le volume et la coupure. 
Cette playlist partagée occupe normalement 
toute la hauteur de la piste, en s'étendant sur 
tous les canaux.

Avec l'affichage étendu de la piste, vous pouvez 
afficher séparément la playlist de chaque canal, 
ce qui permet une édition plus précise des 
points d'inflexion. Ceci est également pratique 
pour éditer des données de panoramique ou de 
plug-in multimono, ces deux types de données 
pouvant être différents sur chaque canal.

Menu déroulant de hauteur de la piste

Cliquez pour afficher le menu 
déroulant Track Height

Pour augmenter/réduire la hauteur d'une 
piste contenant une sélection ou dans 
laquelle le curseur d'édition se trouve 
actuellement, maintenez enfoncée la touche 
Démarrer (Windows) ou Contrôle 
(Macintosh) pendant que vous cliquez sur 
la touche fléchée Haut/Bas.

Playlist de volume pour une piste stéréo
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L'affichage étendu de la piste permet également 
d'obtenir une forme d'onde plus grande 
(équivalente à celle des pistes mono), ainsi 
qu'un sélecteur de vue de piste et un vumètre 
pour chaque voie.

Pour activer l'affichage étendu de la piste :

■ Dans le sélecteur de hauteur de piste, cliquez 
sur Expanded Track Display.

Commandes de piste et hauteur de 
piste

La hauteur de la piste influe sur l'affichage des 
différentes commandes dans la fenêtre Edit. 
Lorsqu'une hauteur de piste est réglée sur Small, 
par exemple, la plupart des boutons s'affichent 
en taille réduite.

Lorsque la hauteur d'une piste est réglée sur 
Mini, seules les commandes Record, Mute et 
Solo s'affichent et les menus de playlist, de règle 
temporelle, de hauteur de piste et de vue de piste 
sont accessibles à partir du même sélecteur.

Lorsque la hauteur d'une piste est définie sur 
Large, Jumbo ou Extreme, tous les contrôles de 
la piste s'affichent à leur taille maximale.

Affichage dans les playlists 
des noms et positions 
temporelles des régions et 
d'autres données
Les noms et positions temporelles des régions 
gênent parfois l'édition des formes d'onde audio 
ou des données MIDI. Lorsque cela se produit, 
vous pouvez en désactiver l'affichage. Dans 
d'autres cas, par exemple pour organiser ou 
positionner des effets sonores, il peut s'avérer 
utile d'afficher les noms et positions temporelles 
des régions. 

Pour activer ou désactiver l'affichage des noms 
des régions dans les playlists :

■ Sélectionnez ou désélectionnez View > 
Region > Name.

Piste stéréo en affichage étendu de la piste

Menu déroulant de hauteur de la piste

Hauteur de la piste définie sur Small

Hauteur de la piste définie sur Small

Hauteur de la piste définie sur Large
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Pour afficher les positions temporelles des 
régions :

■ Dans View > Region, sélectionnez l'une des 
options suivantes :

No Time : désactive l'affichage des positions 
temporelles des régions.

Current Time : affiche les positions temporelles 
de début et de fin des régions

Original Time Stamp : affiche le marqueur de 
temps d'origine de chaque région. Le marqueur 
de temps d'origine est le timecode d'origine de la 
région, lors de son premier enregistrement ou de 
sa création.

User Time Stamp : affiche le marqueur de temps 
utilisateur pour chaque région. Le marqueur de 
temps utilisateur, par défaut identique au 
marqueur de temps d'origine, peut être redéfini 
grâce à la commande Time Stamp.

Il est possible d'afficher les points de 
synchronisation des régions et des groupes de 
régions (voir Points de synchronisation, 
page 367). Cette fonctionnalité facilite le 
positionnement par rapport au timecode et 
l'organisation en mode Grid.

Les chevauchements de régions peuvent 
également s'afficher. Cette fonctionnalité 
s'avère utile pour l'organisation et l'utilisation 
des pistes audio basées sur une référence 
temporelle (voir Chevauchements de régions, 
page 354).

Régions audio et formes 
d'onde
Lorsque la vue des pistes audio est en mode 
Waveform, Pro Tools représente les données 
audio sous forme d'un diagramme appelé forme 
d'onde audio. Les formes d'onde audio donnent 
de nombreuses informations sur le son 
enregistré.

Dans la Figure 8, les « crêtes » représentent les 
emplacements de l'enregistrement où l'attaque 
du son provoque une augmentation 
momentanée du volume. Ils sont suivis de 
« vallées » où le volume diminue.

A chaque type de son correspond un type de 
forme d'onde différent. La batterie, par exemple, 
produit en général des formes d'onde avec des 
transitoires marqués (des crêtes de courte durée), 
clairement visibles. Un coup de grosse caisse ou 
de caisse claire, par exemple, possède une 
attaque puissante et franche suivie d'une 
décroissance rapide du son.

D'autres sons, tels que des voix ou des nappes de 
clavier, produisent des formes d'onde très 
différentes, aux crêtes et aux vallées moins 
prononcées. Ces sons possèdent en effet des 
attaques plus progressives et des déclins plus 
longs.

Affichage activé des noms et positions temporelles des 
régions et des chevauchements

Figure 8.  Forme d'onde audio d'une piste de batterie
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Préférence Draw Waveforms Rectified

Lorsque l'option Draw Waveforms Rectified des 
préférences d'affichage est sélectionnée (dans la 
page Display Preferences), les formes d'onde 
audio s'affichent sous forme d'un signal unique 
de valeur positive, obtenu en additionnant leurs 
excursions positives et négatives. Toutefois, 
même lorsque cette préférence est activée, le 
zoom avant allant au-delà d'un certain point 
provoquera l'affichage normal des formes 
d'onde.

Le mode rectifié affiche des formes d'onde plus 
détaillées avec les hauteurs Medium ou Small, et 
peut se révéler particulièrement efficace pour 
l'édition des données d'automation du volume, 
car il représente les « niveaux » de la forme 
d'onde en partant du bas de la piste.

Instructions d'édition des formes 
d'onde

A l'aide de l'outil sélecteur de la fenêtre Edit, 
vous pouvez sélectionner des parties de formes 
d'onde audio et les diviser en segments nommés 
régions, de manière à pouvoir les réorganiser et à 
les manipuler dans les pistes.

Pendant l'édition, essayez de créer des régions 
qui permettent de maintenir un tempo 
cohérent. Si vous définissez des régions qui 
contiennent toujours un nombre entier de 
temps, vous pourrez enchaîner les régions et 
conserver un rythme régulier et continu.

Une forme d'onde régulière et bien définie peut 
s'avérer utile. Par exemple, une piste de batterie 
peut servir de guide pour la sélection et la 
définition d'autres régions. Si vous avez bien 
joué dans le rythme, il devrait être plus facile de 
créer des régions rythmiquement précises en 
vous référant à la forme d'onde de la batterie.

Lorsque vous définissez des régions, respectez 
les règles suivantes :

◆ Chaque fois que c'est possible, faites 
commencer la région exactement avant une 
crête de niveau et terminez-la immédiatement 
avant un autre crête de niveau.

◆ Chaque fois que c'est possible, vérifiez qu'une 
région commence et se termine exactement au 
même endroit dans un temps.

◆ Les fonctions Pro Tools suivantes vous 
aideront à modifier les données rythmiques ou 
les sources audio avec des transitoires claires 
dans des régions précises :

• Tabulation vers transitoires (voir 
Tabulation vers transitoires, page 343.) ;

• Beat Detective (voir Chapitre 21, Beat 
Detective) ;

• édition sur grille (voir Grid, page 302).

Données audio affichées en mode rectifié

Données audio affichées en mode normal
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Eviter les clics et autres parasites

Si une région éditée commence ou se termine 
sur un point d'amplitude élevée, vous risquez 
d'entendre un clic déplaisant lorsque Pro Tools 
passe en lecture d'une région à l'autre. Pour 
éviter les clics :

◆ Vérifiez que les points de début et de fin de 
votre sélection se trouvent aussi près que 
possible du point où l'amplitude de la forme 
d'onde diminue et coupe la ligne de passage par 
zéro (l'axe horizontal central dans l'affichage de 
la forme d'onde de la piste). Si nécessaire, 
utilisez les outils de zoom de la fenêtre Edit (voir 
Zoomer, page 304) pour afficher les formes 
d'onde avec davantage de détails.

◆ Sur Pro Tools HD, utilisez la fonction 
AutoFade afin d'appliquer des fondus d'entrée 
ou de sortie en temps réel à toutes les limites des 
régions qui ne touchent, ni ne chevauchent 
d'autres régions. Pour plus d'informations, 
consultez la section Utilisation des fondus 
automatiques, page 411.

◆ Appliquez un crossfade entre des régions où se 
produit un clic. Consultez la section Création 
d'un crossfade, page 408 pour plus 
d'informations.

Edition audio non destructive

Lorsque vous éditez la playlist d'une piste audio 
dans Pro Tools, le son n'est pas réellement coupé 
ou déplacé comme avec une bande analogique. 
Au lieu de cela, Pro Tools crée une carte du 
fichier audio sur votre disque dur, qui décrit 
l'ordre dans lequel les différentes portions de la 
piste doivent être lues.

Lorsque vous rognez des régions audio à l'aide 
de l'un des outils de trimming ou lorsque vous 
modifiez le placement ou l'ordre des régions sur 
une piste, utilisez plusieurs playlists, afin de 
pouvoir rétablir facilement l'état précédent 
d'une piste. Pour plus d'informations, consultez 
la section Playlists, page 290.

Régions audio et données 
d'automation

Les données d'automation audio font partie des 
pistes et non de la liste des régions. Ainsi, lorsque 
vous déplacez une région audio de la liste des 
régions vers une nouvelle piste, aucune donnée 
d'automation n'est placée dans la piste. En 
revanche, si vous déplacez une région audio 
d'une piste existante (contenant des données 
d'automation) vers une autre piste, les données 
d'automation de la piste source sont placées 
dans la piste de destination.

Sélection qui commence et se termine sur un point de 
passage par zéro
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Régions MIDI et données MIDI
Les deux modes de visualisation les plus 
couramment utilisés pour les pistes MIDI et les 
pistes d'instrument sont les modes Notes et 
Regions.

Utilisez la vue Notes pour insérer et éditer des 
notes MIDI individuelles ou travailler avec des 
groupes de notes et les modifier.

Utilisez les vues Regions pour faire des essais de 
réorganisation de régions ou en définir de 
nouvelles.

Vue Notes pour les pistes MIDI et 
les pistes d'instrument

Lorsque la vue d'une piste MIDI ou d'une piste 
d'instrument est définie sur Notes, les notes 
MIDI s'affichent sous la forme d'une bande 
perforée pour piano mécanique. Chaque note 
apparaît sous forme de petit rectangle, sa 
position verticale indiquant sa hauteur et sa 
position horizontale indiquant son 
emplacement temporel (et sa durée).

A gauche de la playlist de la piste MIDI ou de la 
piste d'instrument se trouve, pour référence de 
hauteur, un mini-clavier vertical, avec le 
numéro de l'octave. Il peut servir pour écouter 
les hauteurs de notes : il suffit de cliquer dessus 
en maintenant enfoncée la touche Pomme 
(Macintosh) ou Ctrl (Windows). Les flèches 
situées en haut et en bas du mini-clavier (non 
disponibles dans les plus petites hauteurs de 
piste) permettent de faire défiler l'affichage des 
notes vers le haut ou vers le bas.

Dans la vue Notes, la plage de hauteurs de notes 
MIDI affichable dépend de la hauteur de la piste 
et de la valeur du zoom. Chaque fois que les 
notes d'une piste ne tiennent pas dans sa 
hauteur actuelle, les notes au-dessus ou au-
dessous de la zone affichée s'affichent sous la 
forme de lignes d'un pixel d'épaisseur tout en 
haut ou tout en bas de la région affichée (voir 
Figure 9, page 280).

Pour plus d'informations sur la définition 
de Track View, consultez la section Vue 
de piste, page 271.

Pour changer de vue de piste, cliquez sur la 
piste de votre choix et appuyez sur la 
combinaison de touches Démarrer+moins 
(-) sous Windows ou Contrôle+moins (-) 
sous Macintosh du clavier alphanumérique.

Figure 9.  Piste MIDI affichant les notes

Flèche vers le haut

Flèche vers le bas

Note au-dessus de 
l'affichage

Référence clavier
Note MIDI
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Pour faire défiler l'affichage des notes d'une piste 
MIDI ou d'une piste d'instrument vers le haut ou 
vers le bas :

■ Cliquez sur la flèche vers le haut ou vers le bas 
du mini-clavier.

– ou –

■ Sélectionnez l'un des outils de la fenêtre Edit 
(celui d'accrochage de temps, par exemple), 
appuyez sur Pomme+Option+Contrôle 
(Macintosh) ou sur Ctrl+Alt+Démarrer 
(Windows), puis cliquez et faites glisser la note 
vers le haut ou vers le bas sur la piste.

A l'aide des outils de la fenêtre Edit, vous pouvez 
insérer, transposer, rogner et déplacer des notes. 
Pour plus d'informations, reportez-vous à la 
section Edition manuelle des notes MIDI, 
page 502.

Vue Regions pour les pistes MIDI 
et les pistes d'instrument

Les pistes MIDI et les pistes d'instrument 
peuvent aussi être visualisées sous forme de 
régions. Cette vue est très similaire à la vue 
Waveform pour les pistes audio. Bien que les 
notes d'une piste soient visibles dans la vue 
Regions, l'édition de notes individuelles n'est 
pas possible dans cette vue. En revanche, toutes 
les opérations d'édition concernent une plage de 
temps englobant toutes les données de la piste, 
en particulier les événements de contrôleur 
continu, de changements de programme et de 
type Système Exclusif.

Utilisez la vue Regions pour définir des régions 
qui représentent des sections et des clips d'un 
morceau ou pour réorganiser ou regrouper des 
éléments d'une piste.

Dans la vue Regions, l'échelle de zoom vertical 
est définie automatiquement de manière à 
afficher toute la plage de hauteurs (tessiture) de 
notes MIDI sur la piste.

Défilement de notes avec la flèche vers le haut du mini-
clavier

Défilement de l'affichage des notes par glissement

Si votre souris possède une molette de 
défilement, vous pouvez l'utiliser pour faire 
défiler l'affichage des notes d'une piste 
MIDI ou d'une piste d'instrument. Placez le 
curseur de la souris sur une piste MIDI ou 
une piste d'instrument dans la fenêtre Edit 
et maintenez les touches 
Alt+Démarrer+Ctrl (Windows) ou 
Pomme+Contrôle+Option (Macintosh) 
enfoncées pendant que vous utilisez la 
molette pour faire défiler l'affichage des 
notes de la piste MIDI ou de la piste 
d'instrument.
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Toutefois, vous devez respecter un certain 
nombre de principes lorsque vous sélectionnez, 
coupez, copiez et rognez des régions MIDI :

◆ Lorsque vous coupez ou supprimez une 
sélection de région ou de groupe de régions 
incluant le point de début d'une note, toute la 
note est supprimée. C'est le cas même si vous 
n'avez sélectionné qu'une partie de la note (du 
moment qu'elle inclut son point de début).

◆ Lorsque vous copiez ou collez une sélection de 
région ou de groupe de régions contenant le 
point de fin d'une note (mais pas son point de 
début), la note est conservée et déborde de la 
région.

◆ Des règles similaires s'appliquent également 
lorsque les régions MIDI ou des groupes de 
régions contenant des régions MIDI sont 
rognées avec l'un des outils de rognage. Si le 
point de début de la région MIDI est déplacé au-
delà du point de début de la note, cette dernière 
est supprimée. Si le point de fin de la région est 
rogné de telle manière que le point de début de 
la note se trouve dans la région mais que son 
point de fin ne s'y trouve pas, la note est 
conservée et dépasse du bord de la région.

Lorsque vous déplacez et positionnez des 
régions MIDI comportant des notes qui 
dépassent, les notes se déplacent toujours avec 
les régions. Lorsque vous positionnez des 
régions MIDI comportant des notes qui 
dépassent à côté ou près d'une autre région, les 
notes superposées viennent se positionner à 
l'intérieur de la région adjacente.

Pour plus d'informations sur la définition 
de Track View, consultez la section Vue 
de piste, page 271.

Pour basculer la vue de la piste entre les 
notes et les régions, cliquez dans la piste de 
votre choix et appuyez sur la combinaison 
des touches du clavier alphanumérique 
Démarrer+moins (-) (sous Windows) ou 
Ctrl+moins (-) (sous Macintosh), ou 
appuyez sur Ctrl+Alt (Windows) ou 
Pomme+Option (Macintosh) et utilisez les 
flèches gauche et droite pour changer la vue 
de la piste. Section d'une région MIDI avec dépassement de note
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Edition MIDI non destructive

Si l'édition de régions audio est en général non 
destructive, ce n'est pas toujours le cas pour les 
régions MIDI. Par exemple, si une région MIDI 
se trouve à un seul endroit dans une seule piste, 
l'édition de cette région est destructive. Cela 
signifie que la modification de la hauteur, de la 
durée ou du positionnement de notes en vue 
Notes modifie définitivement la région.

Cependant, lorsque vous éditez une région 
MIDI qui apparaît ailleurs sur la même piste 
(à un autre emplacement ou dans une playlist 
différente) ou dans une autre piste, l'édition est 
non destructive et crée automatiquement une 
région. Pour retrouver les données précédentes, 
faites glisser la région d'origine depuis la liste des 
régions ou retournez dans une playlist 
préalablement sauvegardée.

Régions MIDI et événements de 
type Contrôleur Continu

Les événements de Contrôleur Continu font 
partie des régions MIDI et non des pistes. Ainsi, 
lorsque vous déplacez une région contenant des 
données de Contrôleur depuis une piste ou 
depuis la liste des régions, ces données sont 
écrites dans la piste de destination.

Contrairement aux événements de type 
Contrôleur Continu, qui représentent des 
nuances au sein d'une prestation MIDI, l'option 
Mute de Pro Tools est une playlist d'automation 
qui coupe effectivement le moteur MIDI. 
L'automation de Mute ne correspond pas aux 
événements MIDI réels et n'est donc pas 
exportée lors de la sauvegarde sous forme de 
fichier MIDI standard.

Règles temporelles et règles 
de chef d'orchestre

Vous pouvez afficher les règles temporelles 
suivantes en haut de la fenêtre Edit :

• Bars:Beats ;

• Minutes:Secondes ;

• Time Code (Pro Tools HD et Pro Tools LE 
avec DV Toolkit uniquement) ;

• Feet+Frames (Pro Tools HD and Pro Tools 
LE avec DV Toolkit uniquement) ;

• Samples.

Les playlists permettent de restaurer en 
toute sécurité l'état précédent d'une piste. 
Avant d'éditer des notes ou bien de rogner 
ou de réorganiser des régions, faites une 
copie de la playlist de la piste, puis 
travaillez sur cette copie (voir Playlists, 
page 290).

Pour appliquer les modifications à toutes les 
instances d'une région MIDI, activez le 
mode Mirrored MIDI Editing (voir Edition 
MIDI en miroir, page 497).

Affichage de toutes les règles
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Outre le fait qu'elles référencent 
temporellement les données de la piste, les 
règles temporelles servent à définir les sélections 
d'édition des données de la piste et les sélections 
de graduation des régions d'enregistrement et de 
lecture.

Vous pouvez afficher les règles de chef 
d'orchestre suivantes :

• Tempo (et Tempo Editor) ;

• Meter ;

• Markers.

Les règles Meter et Tempo indiquent les 
modifications apportées aux données de tempo 
et de mesure au cours de la session. La règle 
Markers affiche des marqueurs aux 
emplacements importants de la piste.

Pour afficher toutes les règles :

■ Sélectionnez View > Rulers > All.

Pour retirer une règle de l'affichage :

■ Cliquez sur le nom de la règle en appuyant sur 
Option (à gauche de la règle).

– ou –

■ Choisissez View > Rulers et sélectionnez une 
option de règle.

Pour afficher uniquement l'échelle temporelle 
principale dans la règle temporelle :

■ Sélectionnez View > Rulers > None. (Reportez-
vous à la section Echelle temporelle principale, 
page 285.)

Pour ajouter une règle particulière à l'affichage, la 
règle Markers, par exemple :

■ Sélectionnez View > Rulers > Marker.

Pour modifier l'ordre d'affichage des règles :

■ Cliquez sur le nom d'une règle et faites-le 
glisser vers le haut ou vers le bas.

Sélecteur de la vue des règles

Vous pouvez également configurer les règles 
temporelles et les règles de chef d'orchestre à 
l'aide du sélecteur de la vue des règles.

Faites glisser le sélecteur dans une règle 
temporelle pour sélectionner des données sur 
toutes les pistes affichées dans la fenêtre 
Edit. Pour inclure les pistes du chef 
d'orchestre dans la sélection, faites glisser 
ces pistes en maintenant enfoncée la touche 
Option (Macintosh) ou Alt (Windows).

Pour plus d'informations sur la règle 
Tempo, voir Tempo, page 426.

Pour plus d'informations sur la règle Meter, 
voir Evénements de métrique, page 448.

Pour plus d'informations sur les marqueurs, 
reportez-vous au Chapitre 20, Pistes du 
chef d'orchestre et emplacements 
mémoire.

Sélecteur de la vue des règles dans la fenêtre Edit

Sélecteur de la vue des règles 
sélectionné
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Echelle temporelle principale
Vous pouvez afficher simultanément toutes les 
règles temporelles dans la fenêtre Edit, mais une 
seule d'entre elles représente l'échelle temporelle 
principale, également appelée règle temporelle 
principale. 

L'échelle temporelle détermine le format utilisé 
pour :

• le compteur principal de la fenêtre 
Transport ;

• le compteur principal en haut de la fenêtre 
Edit ;

• les valeurs de début (start), de fin (end) et 
de durée (length) ;

• les valeurs de pré et de post-roll ;

• les valeurs de grille et d'incrément.

L'échelle temporelle principale peut être définie 
dans les formats suivants :

Bars:Beats : affiche l'échelle temporelle en 
nombre de mesures et de temps. Utilisez cette 
échelle si vous travaillez avec des éléments 
musicaux qu'il faut placer en fonction de 
mesures et de temps.

Minutes:Seconds : affiche l'échelle temporelle 
en minutes et secondes. A mesure que vous 
zoomez vers l'avant à l'aide du zoom, l'échelle 
temporelle est graduée en dixièmes, puis en 
centièmes et en millièmes de seconde.

Time Code (Pro Tools HD et Pro Tools LE avec DV 
Toolkit uniquement) : affiche l'échelle temporelle 
en timecodes SMPTE. La fréquence d'image et 
l'heure du début de la session sont définies dans 
la fenêtre Session Setup.

Pro Tools prend en charge les cadences d'image 
suivantes : 23.976, 24, 25, 29,97 et Non-Drop ; 
29,97 Drop ; 30 Non-Drop et 30 images par 
seconde Drop. 

Feet+Frames (Pro Tools HD et Pro Tools LE avec 
DV Toolkit uniquement) : affiche l'échelle 
temporelle en pieds et images afin de constituer 
une référence pour les projets audio destinés au 
cinéma. L'affichage horaire en Pieds.Images 
repose sur le format de film 35 mm. 

Samples : affiche l'échelle temporelle en 
échantillons. Ce format est très pratique pour 
l'édition d'échantillons avec une précision 
élevée. 

Pour que vos pistes s'alignent correctement 
sur les mesures et les temps de votre session, 
effectuez l'enregistrement avec le 
métronome (voir Enregistrement avec le 
métronome, page 202). Toutefois, dans 
Pro Tools, les données enregistrées sans 
métronome peuvent être alignées plus tard 
sur la grille de mesure/temps à l'aide de la 
commande Identify Beat (voir Commande 
Identify Beat, page 444) ou de Beat 
Detective (voir Chapitre 21, Beat 
Detective).
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Définition de l'échelle temporelle 
principale

Pour définir l'échelle temporelle principale, 
effectuez l'une des opérations suivantes :

■ Choisissez View > Rulers et sélectionnez une 
échelle temporelle.

■ Cliquez sur le sélecteur de compteur principal 
(situé en haut dans la fenêtre Edit, ainsi que 
dans la fenêtre Transport, lorsque l'affichage des 
compteurs est activé) et sélectionnez une échelle 
temporelle.

■ Si une règle temporelle est déjà affichée, 
cliquez sur son nom. Il s'affiche alors en 
surbrillance.

Navigation à l'aide des compteurs principaux

Les compteurs principaux (en haut de la fenêtre 
Edit et dans la fenêtre Transport) facilitent la 
navigation vers un emplacement temporel 
spécifique. 

Pour naviguer à l'aide d'un compteur principal :

1  Cliquez sur un compteur principal.

2  Entrez une position.

3  Appuyez sur la touche Entrée (Windows) ou 
Retour (Macintosh) pour rechercher 
automatiquement une nouvelle position.

Définition de l'échelle temporelle des 
compteurs secondaires

Sous chaque compteur principal, un compteur 
secondaire fournit une référence temporelle 
supplémentaire.

Pour définir l'échelle de temps du compteur 
secondaire :

■ Cliquez sur un sélecteur de compteur 
secondaire et sélectionnez une échelle 
temporelle.

Sélecteur de compteur principal (dans la fenêtre Edit)

Lorsque vous définissez l'échelle temporelle 
principale sur la base de temps affichée 
dans le compteur secondaire, les deux 
échelles temporelles sont modifiées. 
En d'autres termes, l'échelle temporelle 
secondaire prend l'ancienne valeur de base 
de temps de l'échelle temporelle principale.

Changement d'échelle temporelle principale

L'indicateur de compteur principal de la 
fenêtre Transport ne s'affiche que lorsque 
l'affichage des compteurs est activé pour 
cette fenêtre.

L'indicateur de compteur secondaire de la 
fenêtre Transport ne s'affiche que lorsque 
l'affichage des compteurs est activé pour 
cette fenêtre.

Sélecteur de compteur secondaire (dans la fenêtre Edit)
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Résolution temporelle
Pro Tools est un programme travaillant à 
l'échantillon près, doté d'une résolution MIDI 
interne de 960000 impulsions par noire (ppn). 
Toutefois, lorsque l'échelle temporelle est réglée 
sur Bars|Beats, la résolution d'affichage dans 
Pro Tools est de 960 ppn. 

Avec l'échelle de temps Bars|Beats, Pro Tools 
travaille selon une référence temporelle (1 tic = 
1/960e de noire). Ainsi, il peut se produire un 
léger arrondi à l'échantillon le plus proche selon 
l'emplacement des événements choisi (voir 
Arrondi de l'échantillon et opérations d'édition, 
page 289).

Lorsque vous travaillez en Bars|Beats, vous 
devrez souvent indiquer des valeurs de tic pour 
un certain nombre d'opérations, en particulier :

• le placement et le positionnement de 
régions ;

• la définition des durées des régions ou des 
notes MIDI ;

• la recherche et la définition des plages de 
lecture et d'enregistrement (avec pré/post-
roll) ;

• la spécification des paramètres dans les 
pages Grid/Groove Quantize et Change 
Duration de la fenêtre MIDI Operations ;

• la définition des valeurs de pas de grille et 
d'incrément.

Le tableau ci-dessous répertorie les nombres de 
tics pour chaque valeur de note :

Bases de temps définies par 
échantillons et par référence 
temporelle

Dans Pro Tools, vous pouvez définir les bases de 
temps des pistes par échantillons ou par 
référence temporelle.

Par défaut, les données audio de Pro Tools sont 
basées sur les échantillons. Ainsi, si une région 
audio se trouve à une position donnée, 
exprimée en échantillons, elle ne bougera pas si 
le tempo de la session est modifié. Par contre, 
l'expression de sa position en mesures et temps 
est modifiée.

Les données MIDI de Pro Tools sont basées sur 
une référence temporelle. Ainsi, si une région 
MIDI se trouve à une position précise, exprimée 
en mesures et temps, elle ne quittera pas cet 
emplacement si le tempo change au cours de la 
session. Par contre, l'expression de sa position 
en échantillons est modifiée.

Valeur de 
note

Normal Pointill
é

Triplet

1/2 note 1920 2880 1280

1/4 note 960 1440 640

1/8 note 480 720 320

1/16 note 240 360 160

1/32 note 120 180 80

1/64 note 60 90 40
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Piste audio et piste MIDI basées sur les 
échantillons

Si vous définissez une piste audio comme étant 
basée sur les échantillons, les emplacements des 
régions audio de la piste sont définis en valeur 
absolue sur la timeline. La source audio ne 
bouge pas par rapport à l'échantillon, que le 
tempo et la mesure soient modifiés ou non au 
cours de la session.

Si vous définissez une piste MIDI comme étant 
basée sur les échantillons, tous les événements 
MIDI de la piste ont un emplacement absolu sur 
la timeline. Les événements MIDI ne bougent 
pas par rapport à l'échantillon, que le tempo et 
la mesure soient modifiés ou non au cours de la 
session.

Piste audio et piste MIDI basées sur une 
référence temporelle

Une piste audio basée sur une référence 
temporelle est fixée sur Bars|Beats et se déplace 
relativement à la timeline de l'échantillon 
lorsque le tempo et la mesure sont modifiés. 
Cependant, les événements MIDI et la piste 
audio basée sur une référence temporelle se 
comportent différemment en cas de 
modification du tempo, en termes de durée. 
La longueur des événements de note est 
modifiée en fonction des changements de 
tempo ou de mesure, alors que ce n'est pas le cas 
des régions audio. Les changements de mesure 
et de tempo affectent uniquement le point de 
début (point de synchronisation) de chaque 
région d'une piste basée sur une référence 
temporelle.

Vous pouvez définir au moment de sa création si 
la piste est basée sur l'échantillon ou sur une 
référence temporelle, ou choisir de modifier les 
règles temporelles ultérieurement. 

Changement de règle temporelle

Il est possible d'intervertir les règles temporelles 
de toutes les pistes Pro Tools.

La hauteur de la piste influe sur l'affichage des 
différentes commandes dans la fenêtre Edit. 
Le sélecteur de règle temporelle n'est visible que 
pour les hauteurs de pistes supérieures ou égales 
à Small.

Pour appliquer une autre règle temporelle à une 
piste, procédez comme suit :

■ Si la hauteur de la piste est définie sur Small ou 
sur une valeur plus élevée, cliquez sur le 
sélecteur de règle temporelle et sélectionnez la 
règle souhaitée. L'icône du sélecteur de règle 
temporelle est modifiée afin de prendre votre 
modification en compte. 
.

– ou –

Sélecteur de règle temporelle sur une piste dont la 
hauteur est définie sur Medium

Sélecteur de règle temporelle sur une piste dont la 
hauteur est définie sur Small

Sélecteur de règle 
temporelle (tics)

Sélecteur de règle 
temporelle (échantillons)

Sélecteur de règle 
temporelle (tics)

Sélecteur de règle 
temporelle (échantillons)
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■ Si la hauteur de la piste est définie sur Mini, 
cliquez sur la petite flèche à droite du sélecteur 
de vue de piste pour faire apparaître la liste 
déroulante de sélection de hauteur de piste, puis 
choisissez la règle temporelle souhaitée dans le 
sous-menu correspondant.

Règles temporelles des playlists secondaires

Après avoir modifié la règle temporelle d'une 
piste, vous pouvez décider d'appliquer cette 
modification à la playlist active de la piste 
uniquement ou à la piste et à l'ensemble de ses 
playlists secondaires. 

Pour configurer un changement de règle 
temporelle s'appliquant à l'ensemble des playlists 
d'une piste :

■ Cliquez sur le sélecteur de règle temporelle et 
activez l'option Selection Changes Alternate 
Playlists. 

Groupes

Lorsque vous modifiez la règle temporelle d'une 
piste audio appartenant à un groupe actif, le 
changement de règle temporelle est appliqué à 
l'ensemble des pistes du groupe.

Emplacement d'une région audio

Dans les pistes audio basées sur une référence 
temporelle, l'emplacement d'une région audio 
est déterminé par le point de début de la région, 
à moins que celle-ci ne comporte un point de 
synchronisation.

Si tel est le cas, celui-ci détermine l'emplacement 
de fixation de la région sur la grille. 

Emplacement du marqueur

Lorsque vous créez des marqueurs et des 
emplacements mémoire de sélection, vous 
pouvez leur attribuer une référence absolue 
(basée sur les échantillons) ou relative, en 
mesures et temps (basée une référence 
temporelle). Pour plus d'informations, reportez-
vous à la section Références Bar|Beat et absolue, 
page 459.

Arrondi de l'échantillon et opérations 
d'édition

Lorsque les données audio de Pro Tools sont 
basées sur les échantillons, il peut se produire un 
léger arrondi au niveau des échantillons lorsque 
l'échelle temporelle principale est définie sur 
Bars|Beats. Ceci est particulièrement évident 
lorsque vos régions audio doivent tomber 
parfaitement sur le temps (cas d'une boucle par 
exemple) : vous constaterez parfois un léger 
décalage, d'un tic ou deux. Pour éviter ce 
phénomène, il suffit de prendre quelques 
précautions simples.

Menu déroulant de hauteur de la piste

Sélecteur de règle temporelle et menu contextuel
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Lorsque vous sélectionnez des régions audio 
pour les copier, les dupliquer ou les répéter, 
vérifiez que vous sélectionnez les données à 
l'aide du sélecteur (activez le mode Grid pour 
plus de précision), ou définissez la plage de 
sélection en entrant ses points de début et de fin 
dans la zone Event Edit. Ne sélectionnez pas les 
données avec la main (ou en cliquant deux fois 
avec le sélecteur). Ceci garantit que la sélection 
sera précise en termes de mesures et de 
battements (et qu'elle ne sera pas basée sur la 
longueur des données en échantillons).

Playlists
La possibilité de créer des playlists est l'une des 
fonctions les plus puissantes de Pro Tools, et 
c'est notamment ce qui en fait un outil 
infiniment plus polyvalent que les enregistreurs 
multipistes classiques. 

Chaque piste est associée à une playlist 
principale et à un certain nombre de playlists 
secondaires.

Les playlists d'édition prennent un « cliché » de la 
disposition actuelle des régions d'une piste, ce 
qui permet d'essayer librement d'autres 
dispositions, puisque vous pouvez toujours 
rétablir, si nécessaire, les playlists préalablement 
sauvegardées.

Une playlist, qui peut être constituée d'une seule 
ou de plusieurs régions, ne peut être affectée à 
une piste que si elle n'est pas déjà utilisée par 
une autre piste. Si vous pouvez créer un nombre 
pratiquement illimité de playlists d'édition, 
partagées entre toutes les pistes, chaque piste 
possède son propre ensemble de playlists 
d'automation dédiées.

Les playlists d'automation des pistes audio 
stockent les données correspondant au volume, 
au panoramique, aux coupures (Mute) et aux 
plug-in. Les playlists d'automation des pistes 
MIDI, en revanche, ne mémorisent que des 
informations de coupure ; les événements de 
contrôleur continu, de changements de 
programmes et Sysex sont stockés dans les 
régions MIDI et, à ce titre, font partie des 
playlists d'édition.

Utilisation des playlists

Lors de la création d'une piste, celle-ci ne 
contient qu'une seule et unique playlist, vide 
jusqu'à ce que vous y enregistriez, importiez ou 
y fassiez glisser des éléments.

De nouvelles playlists, vides ou dupliquées à 
partir de la playlist actuelle, peuvent être créées. 
Une fois une playlist créée, vous pouvez la 
rappeler, la renommer et la supprimer comme 
vous le souhaitez, à l'aide du sélecteur de 
playlists.

Vous pouvez faire glisser des données audio 
sur une piste à partir de la liste des 
régions, des navigateurs de DigiBase, de 
l'Explorateur Windows ou du Finder de 
Macintosh.

Sélecteur de playlist
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Duplication d'une playlist

Lorsque vous éditez une piste, vous pouvez 
travailler sur une copie de la playlist de la piste 
et conserver l'originale intacte.

Pour dupliquer la playlist actuelle d'une piste :

1  Cliquez sur le sélecteur de playlists de la piste 
et choisissez Duplicate dans le menu déroulant.

2  Donnez un nom à la nouvelle playlist, puis 
cliquez sur OK. 

La playlist dupliquée apparaît dans la piste, dont 
le nom change pour prendre celui de la nouvelle 
playlist.

Les playlists nouvelles ou dupliquées sont 
nommées automatiquement selon le modèle 
suivant : nom de la piste, suivi d'un point (.) et 
du numéro de playlist. Par exemple, la première 
playlist dupliquée d'une piste intitulée « Kick » 
est automatiquement nommée « Kick.01 », et 
les playlists dupliquées par la suite seront 
nommées « Kick.02 », « Kick.03 », etc.

Création d'une playlist

Vous pouvez créer de nouvelles playlists pour 
l'enregistrement ou l'importation de données 
audio et MIDI. Cela peut être utile notamment 
pour effectuer des prises supplémentaires de 
données audio ou MIDI ou pour essayer d'autres 
dispositions.

Pour créer une playlist (vide) :

1  Cliquez sur le sélecteur de playlist de la piste et 
sélectionnez New dans le menu contextuel.

2  Donnez un nom à la nouvelle playlist, puis 
cliquez sur OK. Une playlist vide, portant le 
nom spécifié, apparaît alors dans la piste.

Affectation d'une playlist à une autre 
piste

Par défaut, une playlist est disponible 
uniquement pour la piste sur laquelle elle a été 
créée. Vous pouvez toutefois utiliser l'option 
Other Playlists, pour assigner une playlist non 
assignée à la piste de votre choix. Lorsqu'une 
playlist a été réassignée à une autre piste (quelle 
que soit la piste), elle n'est plus disponible pour 
les autres pistes, y compris sa piste d'origine.

La règle temporelle d'une playlist audio est 
enregistrée avec la playlist. Lorsque vous 
assignez une playlist non assignée à une piste, la 
piste prend en considération la règle temporelle 
enregistrée pour la playlist.

Pour assigner une playlist de piste :

■ Cliquez sur le sélecteur de playlist et procédez 
comme suit :

• Sélectionnez l'une des playlists de la piste.

– ou –

• Sélectionnez une playlist à partir d'une 
autre piste en cliquant sur le menu Other 
Playlists, puis en sélectionnant la playlist 
de votre choix.

La playlist sélectionnée apparaît dans la piste, 
dont le nom est mis à jour et devient celui de la 
playlist sélectionnée.

Changement du nom d'une playlist

Vous pouvez renommer une playlist en 
renommant la piste à laquelle elle est affectée. 

Pour renommer la playlist affectée à une piste :

1  Cliquez deux fois sur le nom de la piste.

2  Entrez un nouveau nom et cliquez sur OK. Les 
noms de la piste et de la playlist sont tous deux 
mis à jour.
Chapitre 15 : Notions de base d'édition 291



292
Suppression d'une playlist

Vous pouvez supprimer complètement une 
playlist d'une session. Cependant, les playlists 
n'occupant que très peu d'espace sur le disque, il 
n'est pas nécessaire de les supprimer pour des 
raisons d'économie d'espace.

Pour supprimer une ou plusieurs playlists d'une 
piste :

1  Cliquez sur le sélecteur de playlist et 
sélectionnez Delete Unused.

2  Sélectionnez les playlists non assignées que 
vous souhaitez supprimer. Pour sélectionner 
plusieurs playlists, maintenez la touche Maj 
enfoncée tout en cliquant sur les playlists 
souhaitées.

3  Cliquez sur OK pour supprimer les playlists 
sélectionnées. Une fois effectuée, cette 
suppression ne peut être annulée.

Playlists et groupes

Lorsque vous créez de nouvelles playlists avec 
des pistes groupées, le suffixe ajouté au nom de 
playlist est automatiquement incrémenté pour 
chaque piste du groupe actif. Cela vous permet 
de revenir à une prise précédente en 
sélectionnant les prises de playlist par groupes. 

A l'aide de cette méthode, vous pouvez ajouter 
de nouvelles pistes au groupe existant. Ainsi, les 
suffixes des noms de playlist sont synchronisés 
avec les pistes d'origine. 

Des playlists vides sont automatiquement créées 
afin de conserver la synchronisation des prises 
de playlist lors d'un retour à des prises plus 
récentes du groupe.

Pour conserver les noms et les performances de 
playlists synchronisées (exemple de procédure) :

1  Créez de nouvelles pistes et regroupez-les.

2  Assurez-vous que le groupe est activé.

3  Créez une playlist (cliquez sur le sélecteur de 
playlist dans l'une des pistes du groupe, puis 
sélectionnez New). Le suffixe par défaut sera 
« .01 », ce qui signifie qu'il s'agit de la prise 1.

4  Enregistrez la piste 1, puis créez une playlist. 
Les playlists de toutes les pistes du groupe sont 
incrémentées et prennent la valeur « .02 ».

5  Créez de nouvelles pistes (par exemple, pour 
un musicien ou un micro supplémentaire), puis 
ajoutez ces pistes au groupe (ou créez un 
nouveau groupe avec toutes les pistes).

6  Incrémentez toutes les playlists en cliquant 
sur le sélecteur de playlist dans l'une des pistes 
du groupe, puis en choisissant New.

Le même suffixe est désormais ajouté à toutes les 
playlists. Si vous créez des playlists 
supplémentaires dans l'une des pistes du groupe, 
les playlists correspondantes sont incrémentées 
afin d'assurer leur synchronisation.

7  Si vous souhaitez écouter la prise .01 du 
premier groupe de pistes, vous pouvez revenir à 
la playlist .01 à partir de n'importe quelle 
playlist du groupe.

Lorsque vous supprimez une piste d'une 
session, vous avez la possibilité de 
supprimer ou de conserver ses playlists pour 
les utiliser sur d'autres pistes.
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Les playlists de toutes les pistes du groupe sont 
numérotées à l'aide de suffixes .01 (y compris les 
pistes ajoutées au groupe d'origine après les 
prises initiales). Des playlists vides sont 
automatiquement créées sur les membres 
nouvellement ajoutés, afin que les numéros de 
playlists correspondent sur l'ensemble des 
membres du groupe

Multiples niveaux 
d'annulation
Pro Tools peut conserver la trace des 32 
dernières opérations pouvant être annulées et 
permet ainsi de revenir à un état d'édition 
précédent. 

Les opérations d'annulation dans Pro Tools sont 
stockées à la file, dans l'ordre où elles ont été 
appelées. Lorsque vous choisissez Edit > Undo, 
c'est l'opération la plus récente qui est annulée. 
Si vous choisissez Undo de nouveau, l'opération 
suivante dans la file sera annulée. Vous pouvez 
également choisir Edit > Redo pour rétablir une 
opération annulée, ce qui permet de remonter 
une opération après l'autre dans la file 
d'annulation.

Lorsque le nombre d'opérations de la file 
d'annulation atteint cette limite, toute autre 
opération susceptible d'être annulée remplacera 
l'opération la plus ancienne dans la file 
d'annulation.

Pour annuler la dernière opération :

■ Choisissez Edit > Undo.

– ou –

■ Appuyez sur Ctrl+L (Windows) ou sur 
Pomme+L (Macintosh).

Pour rétablir la dernière opération annulée :

■ Choisissez Edit > Redo.

– ou –

■ Appuyez Maj+Ctrl+Z (Windows) ou sur 
Maj+Pomme+Z (Macintosh).

Fenêtre Undo History

La fenêtre Undo History permet de voir 
l'historique des opérations qu'il vous est possible 
d'annuler ou de rétablir, afin de revenir à une 
étape précédente. Cet historique affiche l'heure 
de chaque modification, ce qui vous permet de 
revenir à l'état dans lequel se trouvait la session 
à une heure précise. 

Pour afficher ou masquer la fenêtre Undo History  :

■ Choisissez Window > Undo History.

Fenêtre Undo History

Opérations
pouvant
être
annulées

Opérations
pouvant
être
rétablies

Heures de création

Sélecteur d'options
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Pour annuler des opérations dans la fenêtre Undo 
History  :

■ Cliquez sur l'opération à annuler (en gras) 
dans la liste. 

Toutes les opérations postérieures à celle que 
vous avez sélectionnée seront également 
annulées. Dans la fenêtre Undo History, les 
opérations qu'il est possible d'annuler 
s'affichent en gras et les opérations que vous 
pouvez rétablir (celles ayant déjà été annulées) 
s'affichent en italique.

Pour rétablir des opérations dans la fenêtre Undo 
History  :

■ Cliquez sur l'opération à rétablir (en italique) 
dans la liste.

L'opération que vous avez choisie sera rétablie, 
ainsi que toutes les opérations antérieures à 
celle-ci dans la liste.

Pour activer ou désactiver l'affichage des heures 
de création dans la fenêtre Undo History :

■ Cliquez dans le menu déroulant Options et 
choisissez Show Creation Times. 

Pour annuler toutes les opérations de la fenêtre 
Undo History  :

■ Cliquez dans le menu déroulant Options et 
choisissez Undo All.

Pour rétablir toutes les opérations de la fenêtre 
Undo History  :

■ Cliquez dans le menu déroulant Options et 
choisissez Redo All.

Pour effacer le contenu de la File d'annulation

■ Cliquez dans le menu déroulant Options et 
choisissez Clear Undo Queue.

Les opérations qui effacent le contenu de la file 
d'annulation sont les suivantes :

• Suppression d'une piste ou d'une région 
dans la liste des régions

• Choix de Select > Unused ou Select > 
Unused Audio Except Whole Files dans le 
menu déroulant de la liste des régions

• Importation de pistes ou de données de 
session

Lorsque le nombre d'opérations de la file 
d'annulation atteint cette limite, toute autre 
opération susceptible d'être annulée remplace 
l'opération la plus ancienne dans la file 
d'annulation. Lorsque l'opération la plus 
ancienne arrive en avant-dernière position et 
qu'elle est sur le point de disparaître de la file 
d'attente, elle s'affiche en rouge.

Niveaux d'annulation et RAM

Pro Tools devant conserver la trace des playlists 
de toutes les pistes éditées, l'utilisation de 
plusieurs niveaux d'annulation risque de 
solliciter la mémoire de façon intensive. Pour 
réduire la quantité de mémoire système (RAM) 
utilisée par la file d'annulation, il suffit de 
réduire le nombre de niveaux d'annulation dans 
Pro Tools. Si vous avez alloué une grande 
quantité de RAM à Pro Tools, vous pouvez 
utiliser un plus grand nombre de niveaux 
d'annulation.

La fenêtre Undo History vous permet 
d'afficher la liste des opérations pouvant 
être annulées et de revenir à un état 
précédent.
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Pour définir le nombre de niveaux d'annulation 
dans Pro Tools :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Editing.

2  Cliquez dans le champ Levels of Undo et 
entrez une valeur comprise entre 1 et 32.

3  Cliquez sur Done pour refermer la boîte de 
dialogue Preferences.

Liste des régions
La fenêtre Edit affiche dans une liste des régions 
complète la totalité des régions audio et MIDI, 
ainsi que les groupes de régions. 

Toutes les régions enregistrées, importées ou 
créées lors de l'édition apparaissent dans la liste 
des régions. Les éléments peuvent être déplacés 
d'une liste vers des pistes et disposés dans 
n'importe quel ordre. Les régions de tous types 
peuvent également être écoutées depuis la liste 
des régions en cliquant dessus tout en 
maintenant la touche Option (Macintosh) ou 
Alt (Windows) enfoncée.

Le menu déroulant Region List accessible à 
partir du haut de la fenêtre Region List propose 
des outils et des commandes permettant de 
gérer le contenu de la liste.

Menu déroulant Region List

Le menu déroulant Region List propose des 
outils permettant de rechercher, sélectionner, 
trier, exporter, supprimer et gérer les différents 
éléments de la liste des régions. 

Pour accéder au menu déroulant Region List :

■ Dans la fenêtre Edit, cliquez sur le menu 
déroulant Region List.

Niveaux d'annulation

Figure 10.  Liste des régions

Cliquez pour masquer la liste des régions.

Faites glisser la 
largeur de la liste des 
régions pour la 
redimensionner

Cliquez pour faire apparaître le 
menu contextuel

Focus clavier
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Affichage des régions dans la liste des 
régions

Dans la liste des régions, les régions audio de 
fichiers complets apparaissent en gras et les 
régions stéréo et multicanaux peuvent être 
agrandies pour afficher des canaux particuliers.

Les noms de régions pouvant être longs, vous 
pouvez faire défiler ou redimensionner la liste 
des régions si nécessaire (voir Figure 10, 
page 295). 

Si l'option Region List Selection Follows Track 
Selection des préférences d'édition est active, 
une région ou un groupe de régions sur lesquels 
vous cliquez dans la liste des régions passent en 
surbrillance dans la piste à laquelle ils 
appartiennent. De même, la sélection d'une 
région ou d'un groupe de régions dans une piste 
est reflétée dans la liste des régions.

Affichage des informations du fichier 
pour les régions audio

Outre les noms des régions, la liste des régions 
peut également afficher des informations 
concernant le codage couleur, le type (audio, 
MIDI et groupe de régions), la règle temporelle 
et le fichier audio parent de la région :

Color : affiche le codage couleur des régions.

Icon : affiche l'icône pour les régions audio et 
MIDI, ainsi que les groupes de régions.

Timebase : affiche la règle temporelle pour les 
régions audio et MIDI, ainsi que pour les 
groupes de régions.

Disk Name : affiche le nom du disque dur sur 
lequel sont situés les fichiers référencés.

File Name : affiche le nom du fichier parent.

Full Path : affiche le chemin de répertoire 
complet du fichier parent de la région.

Par défaut, Pro Tools n'affiche que le nom de 
région dans la liste des régions. 

Menu Region List

Utilisez la liste des régions comme un 
chutier permettant de stocker vos boucles 
audio et clips MIDI favoris. Si vous 
enregistrez une session sous forme de 
modèle (voir Création de modèles de 
session personnalisés, page 68), les 
régions seront directement disponibles 
pour de futures sessions.

Menu Region List

Régions avec informations du fichier

Vous trouverez des informations complètes 
concernant l'affichage des infos de fichiers 
audio dans le Guide DigiBase. 
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Tri et recherche dans la liste des 
régions

La plupart des sessions contiennent de 
nombreuses régions, ce qui peut rendre difficile 
la recherche d'une région particulière dans la 
liste des régions. Pro Tools vous permet de trier 
et de rechercher les régions dans la liste de 
régions afin de localiser rapidement les régions 
recherchées.

Pour trier les régions dans la liste des régions :

1  Cliquez dans le menu déroulant Region List 
(en haut de la liste des régions), puis choisissez 
Sort By. 

2  Sélectionnez une base de tri dans le sous-
menu :

• Region Type (régions audio, groupes de 
régions, régions midi)

• Name

• Length

• Original Time Stamp

• User Time Stamp

• Timebase

• Start in Parent

• End in Parent

• File Name

• File Length

• File Creation Date

• File Modification Date

• Disk Name (audio et groupes de régions 
uniquement)

• Track Format/Width

3  Cliquez sur le menu déroulant Region List, 
choisissez Sort By, puis sélectionnez l'une des 
options suivantes pour appliquer des critères de 
tri supplémentaires :

• Ascending

• Descending

Recherche des régions

Utilisez la commande Find pour afficher toutes 
les régions d'une liste dont les noms 
contiennent un mot ou une phrase donnés.

Pour rechercher et afficher les régions contenant 
un mot ou une expression donnés, procédez 
comme suit :

1  Dans le menu déroulant de la liste des régions, 
choisissez Find.

– ou –

Appuyez sur Pomme+Maj+F (Macintosh) ou sur 
Ctrl+Maj+F (Windows).

2  Tapez le nom ou une partie du nom des 
régions que vous recherchez. 

Lorsque vous effectuez des modifications, la 
liste des régions peut se remplir rapidement 
de régions créées automatiquement. Vous 
pouvez masquer les régions créées 
automatiquement en choisissant l'option 
Show dans le menu déroulant Region List, 
puis en désélectionnant l'option Auto-
Created.

Boîte de dialogue Find Regions
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Lorsque vous saisissez le texte de votre 
recherche, celui-ci apparaît en haut de la liste 
des régions. Au fur et à mesure de la recherche, 
les résultats correspondants s'affichent dans 
la liste. 

3  Cliquez sur OK. Tous les types de régions dont 
les noms correspondent au mot ou à 
l'expression que vous recherchez s'affichent 
dans la liste des régions. La chaîne de recherche 
s'affiche en haut de la liste des régions entre 
parenthèses. 

Le texte saisi dans la boîte de dialogue Find est 
enregistré dans un historique, ce qui vous 
permet de trouver rapidement des expressions 
déjà recherchées, sans avoir à en taper de 
nouveau la totalité. 

Pour effectuer de nouveau une recherche sur un 
élément déjà recherché :

1  Dans le menu déroulant de la liste des régions, 
choisissez Find.

2  Cliquez sur la petite flèche à droite du champ 
de texte de la boîte de dialogue Find, puis 
sélectionnez une chaîne de texte dans le menu 
déroulant Find History. 

L'historique est enregistré avec la session. 

L'historique permet non seulement d'enregistrer 
toute chaîne de texte recherchée préalablement, 
mais également d'insérer manuellement 
plusieurs entrées dans l'historique de recherche 
(sans qu'il soit nécessaire d'effectuer chaque 
recherche pour stocker des mots ou des 
expressions). 

Pour compiler un historique de recherche sans 
devoir effectuer chaque recherche :

1  Dans le menu déroulant de la liste des régions, 
choisissez Find. 

2  Tapez le nom ou une partie du nom des 
régions que vous recherchez. 

3  Cliquez sur la double flèche à droite du champ 
de texte de la boîte de dialogue Find et 
maintenez-la enfoncée, puis sélectionnez Insert 
Entry dans le menu déroulant. 

4  Saisissez une autre entrée, puis choisissez de 
nouveau Insert Entry pour ajouter des chaînes 
de recherche supplémentaires à l'historique. 

Pour supprimer une entrée de l'historique :

1  Sélectionnez-la dans le menu déroulant Find 
History de sorte qu'elle s'affiche dans le champ 
de texte. 

2  Dans le menu déroulant Find History, 
choisissez Remove Entry. 

Liste des régions au cours d'une recherche

Exemple d'historique de recherche

Affichage
du texte de 
recherche

Liste des régions au cours d'une recherche
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Pour effacer le contenu de l'historique de 
recherche :

■ Dans le menu déroulant Find History, 
choisissez Remove All Entries. 

Sélection des régions dans la liste 
des régions

Dans les listes des régions vous pouvez 
sélectionner plusieurs régions pour les faire 
glisser vers des pistes, les traiter avec des plug-in 
AudioSuite ou les exporter.

Pour sélectionner ou désélectionner une région 
dans une liste des régions :

■ Cliquez sur un nom de région qui n'est pas en 
surbrillance pour le sélectionner

– ou –

■ Cliquez sur un nom de région en surbrillance 
pour le désélectionner.

Pour sélectionner un ensemble de régions, 
effectuez l'une des opérations suivantes :

■ Placez le curseur sur la gauche des noms des 
régions pour faire apparaître le rectangle de 
sélection et entourez-en les régions que vous 
voulez sélectionner.

– ou –

■ Cliquez sur le nom de la région dans la liste 
des régions, puis cliquez en maintenant la 
touche Maj enfoncée sur un nom de région 
supplémentaire.

Toutes les régions comprises entre la première 
région sélectionnée et la région supplémentaire 
sont automatiquement prises en compte.

Pour sélectionner ou désélectionner un ensemble 
de régions à l'aide du rectangle de sélection :

1  Appuyez sur les touches Pomme (Macintosh) 
ou Ctrl (Windows).

2  Déplacez le curseur sur la gauche du nom de la 
région jusqu'à ce que l'icône du rectangle de 
sélection apparaisse avec un symbole +.

• Pour pouvoir sélectionner des régions, le 
rectangle de sélection doit être placé à 
gauche d'un nom de région qui n'est pas en 
surbrillance.

• Pour désélectionner des régions, le 
rectangle de sélection doit être placé à 
gauche d'un nom de région en surbrillance.

3  Cliquez sur le nom d'une région, puis faites-le 
glisser vers le haut ou vers le bas (pour 
sélectionner ou désélectionner les régions 
situées immédiatement au-dessus ou au-dessous 
du nom de région.

Pour sélectionner ou désélectionner des régions 
non consécutives, procédez comme suit :

■ Maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Macintosh) et cliquez sur les noms 
de régions (qui ne sont pas en surbrillance) pour 
les sélectionner.

– ou –

■ Maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Macintosh) et cliquez sur les noms 
de régions qui sont en surbrillance pour les 
désélectionner.Régions entourées par le rectangle de sélection
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Sélection de régions au clavier

Si le focus clavier de la liste des régions est 
activé, vous pouvez taper les premières lettres du 
nom d'une région pour que Pro Tools recherche 
et sélectionne automatiquement la région dans 
la liste correspondante.

Pour activer et utiliser le focus clavier sur la liste 
des régions :

1  Cliquez sur le bouton de focus clavier en haut 
et à droite de la liste des régions.

2  Tapez les premières lettres de la région pour 
que Pro Tools la recherche et la sélectionne 
automatiquement. Lorsqu'une région a été 
trouvée et sélectionnée, vous pouvez la faire 
glisser sur une piste.

La sélection au clavier de régions audio 
recherche les régions d'après leur nom et non 
d'après celui de leurs fichiers parents ou des 
volumes sur lesquels ils résident.

Ecoute des régions dans la liste des 
régions

Dans la liste des régions, vous pouvez écouter 
une région en cliquant deux fois sur son nom.

Pistes stéréo et multicanaux dans 
la liste des régions

Les régions stéréo et multicanaux, qu'elles 
soient importées ou enregistrées dans Pro Tools, 
s'affichent sous forme d'éléments uniques dans 
la liste des régions. Par exemple, deux régions 
sources mono nommées « Main Piano.L » et 
« Main Piano.R » apparaissent dans la liste sous 
la forme « Main Piano (Stereo) ». Un triangle de 
réduction et d'agrandissement indique les 
régions stéréo et multicanaux. 

Les régions stéréo et multicanaux apparaissent 
par défaut dans la liste des régions en vue 
réduite. Vous pouvez afficher leurs régions 
individuelles en cliquant sur la flèche située à 
gauche de la région pour la développer.

Pour agrandir ou réduire toutes les régions stéréo 
et multicanaux :

■ Appuyez sur Option (Macintosh) ou sur Alt 
(Windows) tout en cliquant sur le triangle.

Chaque élément d'une région stéréo et 
multicanal en vue agrandie peut être 
sélectionné indépendamment des autres régions 
associées dans la liste des régions.

Focus clavier de la liste des régions activé

Cliquez pour 
activer ou 
désactiver le 
focus sur le 
clavier

Régions stéréo réduites (haut) et développées (bas).

Développement/ 
Réduction
Triangles 
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Règles pour les régions stéréo et 
multicanaux

Pour afficher les régions stéréo et multicanaux 
sous forme de régions collectives, les régions du 
composant doivent être de même durée. Si une 
région stéréo ou multicanal existante a été 
déplacée sur plusieurs pistes mono, puis éditée 
de sorte qu'un ou plusieurs composants ne sont 
plus de la même longueur, l'affichage stéréo 
disparaît et les régions apparaissent sous forme 
de régions individuelles dans la liste des régions.

Modes d'édition
Pro Tools dispose de quatre modes d'édition : 
Slip, Shuffle, Spot et Grid. Le mode Grid offre 
également deux modes de fonctionnement : 
absolu et relatif. Pour sélectionner le mode 
d'édition, cliquez sur le bouton correspondant 
dans la partie supérieure gauche de la fenêtre 
Edit.

Le mode d'édition a une incidence sur le 
déplacement et le positionnement des régions 
audio et MIDI (et des notes MIDI individuelles), 
sur le fonctionnement des commandes Copier 
et Coller, ainsi que sur le fonctionnement des 
différents outils d'édition (outil de trimming, 
sélecteur, main et crayon).

Shuffle

Le mode Shuffle (le terme signifie « mélanger » 
en anglais) permet de déplacer, rogner, couper 
ou coller librement les régions dans une piste ou 
vers d'autres pistes, mais leur mouvement est 
restreint par les autres régions. Autrement dit, si 
vous placez plusieurs régions dans une piste, 
elles s'alignent automatiquement l'une avec 
l'autre. Vous pouvez ensuite « modifier » l'ordre 
dans lequel elles se succèdent, mais vous ne 
pouvez pas les séparer, ni les superposer comme 
en mode Slip. Cependant, s'il existe un silence 
entre des régions existantes et que ces régions 
sont « modifiées », le silence est maintenu et 
n'est pas supprimé.

En mode Shuffle, l'ajout d'une autre région au 
début d'une piste décale les régions suivantes 
vers la droite, de la durée de la région ajoutée. 

Lorsque vous utilisez l'outil de trimming en 
mode Shuffle, le fait de modifier le point de 
début ou de fin d'une région décale 
automatiquement les régions adjacentes en 
conséquence. Le mode Shuffle n'a pas 
d'incidence sur le placement et l'insertion de 
notes MIDI.

Slip

En mode Slip (le terme signifie glisser en 
anglais), vous pouvez déplacer les régions 
librement à l'intérieur d'une même piste ou vers 
d'autres pistes. Dans ce mode, il est possible de 
placer une région dans une piste en laissant un 
espace entre elle et les autres régions. Lors de la 
lecture de la piste, cet espace est silencieux. Vous 
pouvez également déplacer une région pour 
qu'elle recouvre partiellement ou complètement 
une autre région.

Boutons des modes d'édition

Pour définir le mode d'édition, vous pouvez 
également utiliser les touches F1 (Shuffle), 
F2 (Slip), F3 (Spot) et F4 (Grid). 
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Utilisez le mode Slip lorsque vous voulez que 
l'outil de trimming, le sélecteur, la main et le 
crayon fonctionnent sans aucune restriction de 
placement temporel.

Spot

Utilisez le mode Spot (le terme signifie « point 
précis » en anglais) pour placer des régions à des 
endroits précis. Ce mode permet de préciser un 
point précis (exprimé en timecode SMPTE ou 
tout autre format temporel), capturer une 
adresse de timecode entrant ou utiliser les 
marqueurs temporels d'une région comme 
points de référence pour le placement. Ceci peut 
être particulièrement utile lorsque vous 
effectuez des tâches de post-production d'après 
des timecodes SMPTE correspondant à une 
image précise. 

Lorsque le mode Spot est activé, Pro Tools vous 
demande d'indiquer un emplacement de 
destination lorsqu'une région est déplacée 
depuis l'une des listes de régions ou depuis un 
navigateur DigiBase pris en charge.

Grid

En mode Grid, les régions et les notes MIDI 
déplacées, rognées ou insérées s'alignent sur la 
valeur de grille sélectionnée ou sur les 
incréments précis d'une grille temporelle définie 
par l'utilisateur. 

Le mode Grid peut être appliqué en mode 
absolu ou relatif. 

◆ En mode Grid absolu, le déplacement d'une 
région entraîne le déplacement du début de la 
région sur le pas de la limite de la grille. Si le 
point de départ d'une région se trouve entre 

deux temps et que la grille est définie sur 1/4 de 
note, le déplacement de la région déplace l'heure 
de début lui correspondant sur le 1/4 de note le 
plus proche (la valeur actuelle de grille absolue). 

◆ En mode Grid relatif, les régions peuvent être 
déplacées par unités de pas (ou d'incréments). 
Si le point de départ d'une région se trouve entre 
deux temps et que la grille est définie sur des 1/4 
de note, le déplacement de la région est 
contraint à 1/4 de note et conserve la position 
relative de la région sur la mesure la plus proche.

Pour sélectionner le mode Grid absolu ou relatif :

■ Cliquez sur le sélecteur de mode Grid, puis 
choisissez Absolute ou Relative. 

Configuration de la grille

Le pas réel de la grille, défini dans le menu 
déroulant Grid Value, peut être basé sur une 
valeur temporelle en utilisant l'échelle 
principale de temps (option Main Time Scale) ; 
si cette option n'est pas sélectionnée, vous 
pouvez utiliser un autre format temporel pour le 
pas de la grille. 

Pour suspendre temporairement le mode 
Grid et basculer en mode Slip tout en 
déplaçant une région, appuyez sur Ctrl 
(Windows) ou Pomme (Macintosh).

Pour plus d'informations sur le mode Grid 
relatif, reportez-vous à la section 
Déplacement des régions en glissant en 
mode Grid, page 365. 
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L'indicateur de valeur de grille et le menu 
déroulant sont situés dans la fenêtre Edit.

Regions/Markers est une autre option 
disponible du menu déroulant Grid Value. 
Lorsque cette option est sélectionnée, les 
événements peuvent être placés librement 
(comme en mode Slip) mais ils viennent 
s'aligner sur les emplacements de la région 
(points de début, de fin et de synchronisation), 
sur les marqueurs et les sélections d'édition 
lorsque vous les placez à proximité.

Pour afficher les lignes de la grille dans la fenêtre 
Edit :

■ Choisissez Setup > Preferences, puis cliquez 
sur l'onglet Display et activez Draw Grids in Edit 
Window.

– ou –

■ Activez (et désactivez) les graduations en 
cliquant sur n'importe quel nom de la règle de 
base de temps.

Indicateur de valeur de grille et menu déroulant

La valeur de grille actuelle est également 
utilisée pour la commande de 
quantification de grille Quantize to Grid 
(voir Quantification des régions sur la 
grille, page 372) et la commande 
Separated Region At Grid (voir 
Commandes Separate Region, page 352).

Les notes MIDI insérées avec le crayon 
ignorent l'option Regions/Markers et 
s'alignent sur la valeur temporelle 
sélectionnée dans le menu déroulant Grid 
Value.

Lignes de la grille affichées dans la fenêtre Edit

Activation des lignes de la grille à partir de la règle 
temporelle

Cliquez pour activer ou désactiver les lignes de la grille
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Outils d'édition
Pro Tools propose plusieurs outils d'édition : 
Zoom, outil de trimming, sélecteur, Main, outil 
de scrubbing, crayon et outil multifonction 
Smart. Sélectionnez l'outil de votre choix en 
cliquant dessus dans la fenêtre Edit. Le Zoom, 
l'outil de trimming, la main et le crayon 
comportent des modes différents, qui peuvent 
être sélectionnés depuis un menu contextuel 
multiple lorsque vous cliquez sur l'outil.

Boutons de zoom : utilisez les boutons de zoom 
pour effectuer des zooms avant ou arrière, 
verticalement ou horizontalement sur les 
données MIDI et les données de piste audio. 
En outre, vous pouvez enregistrer et rappeler 
cinq présélections de zoom.

Zoom : l'outil Zoom permet de sélectionner une 
vue de zoom sur une piste.

Changement de zoom : le bouton de 
changement de zoom permet de passer de la 
valeur de zoom en cours à un facteur de zoom 
défini, et inversement.

Outils de trimming : l'outil de trimming permet 
d'appliquer un rognage aux régions et groupes 
de régions.

Sélecteur : le sélecteur permet d'effectuer des 
sélections sur les pistes.

Outils Main : utilisez les outils Main afin de 
sélectionner, séparer ou déplacer des régions sur 
des pistes.

Outil Smart : utilisez l'outil Smart afin de rogner, 
sélectionner ou saisir des régions sur des pistes.

Outil de scrubbing : utilisez l'outil de scrubbing 
pour lire en mode scrubbing les éléments d'une 
piste.

Crayon : utilisez l'outil Crayon pour dessiner 
une automation ou des données MIDI.

Zoomer
Les options de zoom de Pro Tools sont les 
suivantes : les boutons de zoom horizontal et 
vertical, le Zoom, les boutons de présélection de 
zoom et la commande de changement de zoom.

Boutons de zoom

Pro Tools propose différents boutons 
permettant d'effectuer un zoom sur les données 
de pistes.

Boutons de zoom avant/arrière horizontal

Les boutons de zoom avant/arrière horizontal 
permettent de zoomer horizontalement sur les 
données d'une piste.

Boutons de zoom et outils d'édition

Changement de zoom Outil Smart

Crayon

Zoom
Outils de 

Sélecteur

Outils Main
Outil de scrubbing

Boutons de zoom
trimming

Appuyez sur la touche Echap pour basculer 
d'un outil d'édition à l'autre.

Bouton de zoom avant horizontal

Bouton de zoom 
arrière horizontal

Bouton de zoom
avant horizontal
(sélectionné)
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Pour effectuer un zoom avant horizontal sur 
l'ensemble des pistes, procédez comme suit :

■ Cliquez sur la commande de zoom avant 
horizontal.

■ Appuyez sur les touches Pomme+] 
(Macintosh) ou Ctrl+] (Windows).

■ Cliquez sur la commande de zoom avant 
horizontal et faites-la glisser pour effectuer un 
zoom continu.

Pour effectuer un zoom arrière horizontal sur 
l'ensemble des pistes, procédez comme suit :

■ Cliquez sur la commande de zoom arrière 
horizontal.

■ Appuyez sur les touches Pomme+[ 
(Macintosh) ou Ctrl+[ (Windows).

■ Cliquez sur la commande de zoom arrière 
horizontal et faites-la glisser pour effectuer un 
zoom continu.

Boutons de zoom avant et arrière pour les 
éléments audio et MIDI

Les boutons de zoom audio et MIDI vous 
permettent respectivement d'effectuer un zoom 
avant ou arrière verticalement sur les éléments 
audio et MIDI.

Pour effectuer un zoom avant vertical sur 
l'ensemble des pistes audio, procédez comme 
suit :

■ Cliquez sur la commande de zoom avant 
audio. 

■ Appuyez sur Pomme+Option+] (Macintosh) 
ou sur Ctrl+Alt+] (Windows).

■ Cliquez sur la commande de zoom audio et 
faites-la glisser pour effectuer un zoom continu.

Pour effectuer un zoom arrière vertical sur 
l'ensemble des pistes audio, procédez comme 
suit :

■ Cliquez sur la commande de zoom arrière 
audio. 

■ Appuyez sur Pomme+Option+[ (Macintosh) 
ou sur Ctrl+Alt+[ (Windows).

■ Cliquez sur la commande de zoom arrière 
audio et faites-la glisser pour effectuer un zoom 
continu.

Pour effectuer un zoom avant vertical sur 
l'ensemble des pistes d'instruments et MIDI, 
procédez comme suit :

■ Cliquez sur la commande de zoom avant 
MIDI.

– ou –

■ Appuyez sur Pomme+Maj+] (Macintosh) ou 
sur Ctrl+Maj+] (Windows).

Pour effectuer un zoom arrière vertical sur 
l'ensemble des pistes d'instruments et MIDI, 
procédez comme suit :

■ Cliquez sur la commande de zoom arrière 
MIDI.

– ou –

■ Appuyez sur Pomme+Maj+[ (Macintosh) ou 
sur Ctrl+Maj+[ (Windows).

Pour effectuer un zoom vertical vers l'avant ou 
vers l'arrière sur une piste d'instrument ou MIDI :

1  Vérifiez que la vue de piste n'est pas définie sur 
Régions.

Boutons de zoom audio et MIDI
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2  Maintenez la touche Démarrer (Windows) ou 
Contrôle (Macintosh) enfoncée, puis cliquez et 
faites glisser la souris vers le haut pour effectuer 
un zoom avant ou vers le bas pour effectuer un 
zoom arrière.

Autres fonctions du bouton de zoom

Pour revenir au niveau de zoom précédent, 
procédez comme suit :

■ Maintenez la touche Option (Macintosh) ou 
Alt (Windows) enfoncée, pendant que vous 
cliquez sur l'un des boutons de zoom horizontal, 
audio ou MIDI.

■ Appuyez sur Pomme+Option+E (Macintosh) 
ou sur Ctrl+Alt+E (Windows).

Pour effectuer un zoom avant dans une sélection :

■ Appuyez sur Option+F (Macintosh) ou sur 
Alt+F (Windows).

Pour effectuer un zoom de manière à ce que toutes 
les régions soient visibles dans la fenêtre Edit :

■ Cliquez deux fois sur le Zoom dans la barre 
d'outils.

■ Appuyez sur Option+A (Macintosh) ou sur 
Alt+A (Windows).

Zoom

Le Zoom permet d'effectuer un zoom avant et 
arrière dans une zone particulière de la piste. Il 
comporte deux modes : le mode Normal et le 
mode Single Zoom. 

◆ En mode zoom normal, le Zoom reste 
sélectionné après l'action de zoom. 

◆ En mode Single Zoom, l'outil d'édition 
sélectionné précédemment est resélectionné 
automatiquement après le zoom.

Zoom normal

Pour effectuer un zoom autour d'un point 
particulier de la piste :

1  Cliquez dans le menu déroulant du Zoom et 
sélectionnez le mode Normal Zoom.

– ou –

Pour passer en mode Normal Zoom, appuyez sur 
la touche F5.

2  Cliquez une fois avec le Zoom sur le point de 
la piste. Toutes les pistes sont agrandies d'un 
niveau et la fenêtre Edit est centrée autour du 
point cible.

3  Pour revenir au niveau de zoom précédent, 
maintenez la touche Option (Macintosh) ou Alt 
(Windows) enfoncée et cliquez sur le Zoom.

Pour effectuer un zoom avant sur une zone 
particulière de la piste :

1  Cliquez dans le menu déroulant du Zoom et 
sélectionnez le mode Normal Zoom.

– ou –

Pour passer en mode Normal Zoom, appuyez sur 
la touche F5.

2  Pour effectuer un zoom horizontal, faites 
glisser le Zoom dans la playlist de la piste.

– ou –

Zoom
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Pour effectuer un zoom horizontal et vertical, 
appuyez sur Command (Macintosh) ou sur Ctrl 
(Windows) tout en vous déplaçant dans la 
playlist.

La zone agrandie remplit toute la fenêtre Edit.

Mode zoom simple

Le mode Single Zoom (zoom simple) qui vous 
ramène à l'outil précédent lorsqu'un zoom a été 
effectué.

Par exemple, lorsque vous utilisez l'outil Smart 
Tool, si vous cliquez sur le mode Single Zoom, 
chaque fois qu'un zoom aura été effectué 
Pro Tools reviendra automatiquement à l'outil 
Smart.

Pour activer le mode Single Zoom :

■ Cliquez sur le menu déroulant du Zoom et 
sélectionnez le mode Single Zoom.

– ou –

■ Appuyez sur la touche F5 pour basculer en 
mode Single Zoom.

Le mode Single Zoom est identifié par une flèche 
vers la droite dans l'icône du Zoom. 

Cette flèche est absente dans le mode de zoom 
normal.

Zoom dans une règle

Pour effectuer un zoom horizontal dans une règle :

1  Appuyez sur Pomme+Contrôle (Macintosh) 
ou sur Ctrl+Alt (Windows) et déplacez le curseur 
dans la zone de la règle pour afficher le Zoom.

2  Cliquez une fois pour effectuer un zoom avant 
d'un niveau autour d'un certain point.

– ou –

Déplacez le Zoom autour d'une zone particulière 
de la règle.

Zoom horizontal avec le Zoom

Mode zoom simple

Mode zoom normal

Zoom dans une règle
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Zoom en continu à l'aide du zoom

Utilisez l'outil Zoom pour effectuer un zoom 
avant ou arrière en continu. 

Pour effectuer un zoom en continu sur une piste ou 
un groupe de pistes donné :

1  Sélectionnez le zoom. 

2  Maintenez la touche Ctrl (Macintosh) ou 
Démarrer (Windows) enfoncée, puis faites 
glisser le zoom sur une piste, comme suit :

• Vers le haut, pour un zoom avant vertical

• Vers le bas, pour un zoom arrière vertical

• Vers la droite, pour un zoom avant 
horizontal

• Vers la gauche, pour un zoom arrière 
horizontal

Avec le zoom horizontal, le zoom est effectué 
simultanément sur toutes les pistes. Le 
déplacement du zoom sur les pistes s'effectue 
horizontalement vers l'avant ou vers l'arrière à 
partir de l'emplacement sur lequel vous avez 
cliqué. 

Zoom vertical vers l'avant ou vers l'arrière en 
continu sur l'ensemble des pistes audio

La fonction de zoom continu affecte 
normalement uniquement la piste ou le groupe 
de pistes dans lesquels vous cliquez. Vous 
pouvez toutefois choisir d'effectuer un zoom sur 
l'ensemble des pistes audio affichées 
simultanément. 

Pour effectuer un zoom vertical continu vers 
l'avant ou vers l'arrière sur l'ensemble des pistes 
audio :

1  Sélectionnez le zoom. 

2  Appuyez sur les touches Contrôle+Maj 
(Macintosh) ou Démarrer+Maj (Windows), puis 
faites glisser la souris vers le haut ou vers le bas. 
Lorsque vous relâchez la souris, le zoom 
s'effectue sur toutes les pistes audio affichées au 
même niveau de zoom. 

Boutons de présélection de zoom

Pro Tools permet de conserver 5 présélections de 
zoom horizontal dans la fenêtre Edit, que vous 
pouvez rappeler en tapant leur chiffre ou en 
cliquant sur le bouton de présélection 
correspondant. 

Pour enregistrer une vue comme présélection de 
zoom :

1  Utilisez le zoom pour configurer la vue de 
piste selon vos préférences. 

2  Cliquez sur un bouton de présélection de 
zoom (de 1 à 5) et maintenez le bouton de la 
souris enfoncé, puis sélectionnez Save Zoom 
Preset dans le menu contextuel de présélection 
de zoom. Le bouton de présélection clignote 
momentanément, puis la présélection de zoom 
existante enregistrée à ce numéro est remplacée. 

Menu contextuel de présélection de zoom
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Pour charger une présélection de zoom 
enregistrée :

■ Cliquez sur le bouton de présélection de zoom 
correspondant (de 1 à 5). 

– ou –

■ Cliquez sur le bouton Zoom Preset et 
maintenez le bouton de la souris enfoncé, puis 
sélectionnez Recall Zoom Preset dans le menu 
contextuel de présélection de zoom.

Changement de zoom

La commande Zoom Toggle vous permet de 
définir et de passer d'un zoom à un autre 
directement à partir de la fenêtre Edit. Elle offre 
beaucoup de souplesse et de contrôle et permet 
d'obtenir une vue de piste distincte pour chaque 
élément audio (pistes audio, entrées auxiliaires 
et faders principaux) et MIDI (pistes MIDI et 
pistes d'instrument).

Paramètres de changement de zoom

La commande de changement de zoom permet 
d'enregistrer et de rappeler les paramètres 
suivants :

• hauteur de la piste ;

• vue de la fenêtre Edit ;

• boutons de zoom avant ou arrière pour les 
éléments audio et MIDI ;

• paramètre Grid.

La commande de changement de zoom permet 
d'obtenir des hauteurs de pistes distinctes pour 
chaque vue de piste de type audio (pistes audio, 
entrée auxiliaire, faders principaux) et MIDI 
(pistes d'instrument et MIDI). 

Utilisation du changement de zoom

Le bouton de changement de zoom permet 
d'enregistrer l'état d'un zoom et de passer du 
zoom enregistré au zoom actuel, et inversement. 
Lorsque ce bouton est sélectionné, la fenêtre 
Edit affiche le zoom enregistré. En outre, toute 
modification apportée à la vue pendant que la 
commande de changement de zoom est activée 
sera enregistrée dans l'état du zoom.

Lorsque ce bouton est désactivé, la fenêtre Edit 
rétablit l'affichage en fonction du dernier zoom 
effectué.

Pour enregistrer un zoom à l'aide du bouton de 
changement de zoom :

1  Effectuez une sélection d'édition.

2  Cliquez sur le bouton de changement de 
zoom. Celui-ci s'allume pour indiquer que la 
commande est activée.

3  Définissez les valeurs de la hauteur de piste, du 
zoom vertical, de la vue de piste et de la grille.

4  Pour rétablir le zoom précédent, cliquez de 
nouveau sur le bouton de changement de zoom. 

5  Effectuez une autre sélection d'édition et 
cliquez sur le bouton de changement de zoom 
pour charger le zoom enregistré, puis poursuivez 
l'édition.

Bouton de changement de zoom dans la fenêtre Edit

Lorsque le mode de focus clavier sur les 
commandes est activé, appuyez sur la 
touche E pour activer ou désactiver la 
commande de changement de zoom.

Bouton de changement de zoom
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Pour modifier le zoom enregistré en mode de 
changement de zoom :

1  Vérifiez que le bouton de changement de 
zoom est allumé (activé). 

2  Définissez les valeurs de la hauteur de piste, du 
zoom vertical, de la vue de piste et de la grille. 
Les paramètres sont enregistrés dans le zoom au 
fur et à mesure que vous les modifiez.

Pour supprimer le zoom enregistré en mode de 
changement de zoom :

1  Vérifiez que le bouton de changement de 
zoom est allumé (activé). 

2  Maintenez la touche Option (Macintosh) ou 
Alt (Windows) enfoncée, pendant que vous 
cliquez sur le bouton de changement de zoom.

Pour utiliser le changement de zoom sans modifier 
les vues de playlists :

1  Effectuer une sélection de une ou plusieurs 
pistes

2  Appuyez sur Option+Contrôle+E (Macintosh) 
ou sur Alt+Démarrer+E (Windows).

– ou –

Lorsque le focus clavier sur les commandes est 
activé, appuyez sur Option+E (Macintosh) ou 
sur Alt+E (Windows).

Zoom avec la molette de 
défilement

Si votre souris possède une molette, vous pouvez 
l'utiliser pour effectuer un zoom avant et arrière 
sur les pistes, verticalement et horizontalement.

Pour effectuer un zoom avant ou arrière horizontal 
dans la fenêtre Edit :

1  Placez la souris sur les pistes de la fenêtre Edit.

2  Maintenez enfoncée la touche Alt (Windows) 
ou Option (Macintosh) pendant que vous faites 
rouler la molette de défilement vers le haut ou le 
bas pour effectuer un zoom avant ou arrière 
horizontal.

Pour effectuer un zoom avant ou arrière vertical 
dans la fenêtre Edit :

1  Placez la souris sur les pistes de la fenêtre Edit.

2  Maintenez enfoncée la touche Alt (Windows) 
ou Option (Macintosh) pendant que vous faites 
rouler la molette de défilement vers le haut ou le 
bas pour effectuer un zoom avant ou arrière 
vertical.

Outil de trimming
L'outil de trimming offre des fonctions de 
rognage des régions, des notes et des données. 
Les fonctions de trimming suivantes sont 
disponibles :

• Outil de trimming standard

• Outil de trimming de 
compression/extension temporelle, 
également appelé TC/E

• Outil Scrub Trim (Pro Tools HD 
uniquement)

Utilisation de la bascule de zoom
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Les outils de trimming sont contraints par des 
limites de régions, quel que soit le mode Edit, de 
la façon suivante : 

• Le rognage vers la gauche est contraint par 
la limite la plus à gauche de la région 
adjacente (début de la région).

• Le rognage vers la droite est contraint par la 
limite la plus à droite de la région adjacente 
(fin de la région).

• L'outil de trimming propose des fonctions 
spéciales lorsqu'il est utilisé sur des régions 
et des groupes de régions mis en boucle. 
Pour plus d'informations, reportez-vous 
aux sections Groupes de régions, page 386 
et Mise en boucle de régions, page 395.

Outil de trimming

L'outil de trimming permet de raccourcir ou 
d'allonger rapidement une région (jusqu'à 
rétablir la durée totale du fichier audio source). 
La première fois que vous rognez une région, 
Pro Tools l'ajoute automatiquement à la liste des 
régions, en tant que nouvelle région (en lui 
attribuant un nom dérivé du nom d'origine) 
pour la différencier de l'originale.

L'outil de trimming standard est non destructif 
et ne modifie pas les données audio ou MIDI 
d'origine (lorsque vous travaillez sur des 
régions). Pour rétablir la durée de la région 
d'origine, faites-la glisser depuis la liste des 
régions ou rétablissez la durée originale de la 
région éditée à l'aide de l'outil de trimming.

L'utilisation de l'outil de trimming dépend du 
mode d'édition : Shuffle, Slip, Spot ou Grid. 
Pour plus d'informations, reportez-vous à la 
section Modes d'édition, page 301.

Pour rogner une région avec l'outil de trimming 
standard :

1  Sélectionnez l'outil de trimming. Dans 
Pro Tools HD, cliquez sur le menu contextuel de 
l'outil de trimming, puis sélectionnez Standard.

2  Placez le curseur près du début ou de la fin 
d'une région, de façon à afficher le curseur de 
l'outil de trimming.

Pour inverser la direction de l'outil de trimming, 
appuyez sur Option (Macintosh) ou sur Alt 
(Windows).

3  Si vous « rognez » la fin, faites glisser le curseur 
vers la gauche pour raccourcir la région ou vers 
la droite pour la rallonger.

– ou –

Si vous « rognez » le début, faites glisser le 
curseur vers la droite pour raccourcir la région 
ou vers la gauche pour la rallonger.

L'outil de trimming standard sert également 
à rallonger ou raccourcir des notes MIDI 
(voir Rognage des temps de début et de fin 
d'une note, page 505), ainsi qu'à mettre à 
l'échelle des données d'automation et de 
contrôleur Dessin d'automation, 
page 655.

Outil de trimming

Outil de trimming

Lorsque vous travaillez avec des données 
audio, vous ne pouvez rogner les régions 
adjacentes.
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Lorsque vous rognez des régions sur une piste 
stéréo ou multicanal, tous les canaux sont 
rognés.

En mode Shuffle, les régions adjacentes se 
décalent autant que nécessaire pour laisser la 
place à la région éditée. En mode Grid, les temps 
de début et de fin déplacés s'alignent sur le point 
le plus proche de la grille. En mode Spot, la boîte 
de dialogue Spot s'ouvre et vous invite à entrer le 
nouvel emplacement des points de début et de 
fin de la région.

Outil de trimming 
compression/extension 
temporelle (Time 
Compression/Expansion)

Cet outil de trimming temporel est pratique 
pour ajuster une région audio à la durée d'une 
autre région, d'une grille de tempo, d'une scène 
vidéo ou à pratiquement tout autre point de 
référence désiré.

L'outil de trimming temporel fonctionne en 
utilisant le plug-in AudioSuite Time 
Compression/Expansion (ou un plug-in tiers) 
pour créer un fichier audio. L'outil de trimming 
temporel s'utilise en faisant glisser le point de 
début ou de fin de la région pour étendre ou 
compresser la région.

Préférences du plug-in de 
compression/expansion

Entrez les paramètres du plug-in Time 
Compression/Expansion AudioSuite en les 
sélectionnant dans la liste contextuelle Default 
Settings de la page des préférences de 
traitement, sous TC/E. Les paramètres 
disponibles sont des présélections de Pro Tools ; 
vous pouvez, en outre, sauvegarder vos propres 
sélections pour le plug-in Time 
Compression/Expansion, qui apparaîtront 
également ici.

Outil de trimming compression/extension temporelle 
sur une région

Pour faire correspondre une sélection 
d'édition à la longueur d'une sélection de 
graduation temporelle, vous pouvez 
également utiliser la commande > TCE Edit 
to Timeline Selection (voir Edition TCE 
(Time Compression and Expansion, 
compression/expansion temporelle) et 
sélection de timeline, page 348.

Pour plus d'informations sur les plug-in 
AudioSuite, consultez le Guide des plug-in 
DigiRack.
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Utilisation de l'outil de trimming Time 
Compression/Expansion en mode Grid

L'outil de trimming temporel peut être utilisé en 
mode Grid pour ajuster une région au tempo 
d'une session ou d'une section d'une session. 
Par exemple, vous pouvez importer une boucle 
de batterie d'une mesure au tempo de 90 BPM 
dans une session dont le tempo est de 120 BPM. 
En mode Grid, l'outil de trimming temporel 
permet de compresser facilement et rapidement 
la boucle de batterie à la longueur d'une mesure, 
avec une perte minime de la qualité audio. 

Pour utiliser l'outil de trimming Time 
Compression/Expansion en mode Grid :

1  Réglez le mode d'édition sur Grid.

2  Cliquez dans le menu déroulant de l'outil de 
trimming et sélectionnez TCE.

3  Avec l'outil de trimming TC/E, faites glisser le 
point de début ou de fin de la région audio pour 
étendre ou compresser la région à la taille de la 
grille (par exemple par noires). La région est 
traitée automatiquement par le plug-in 
AudioSuite de compression/expansion 
temporelle. La nouvelle région apparaît dans la 
playlist et dans la liste des régions.

Utilisation de l'outil de trimming Time 
Compression/Expansion en mode Slip

Pour utiliser l'outil de trimming Time 
Compression/Expansion en mode Slip :

1  Définissez le mode d'édition sur Slip.

2  Cliquez dans le menu déroulant de l'outil de 
trimming et sélectionnez TCE.

3  Avec l'outil de trimming 
Compression/Expansion, faites glisser le point 
de début ou de fin de la région pour étendre ou 
compresser la région. Une nouvelle région est 
traitée automatiquement par le plug-in 
AudioSuite de compression/expansion 
temporelle. La nouvelle région apparaît dans la 
playlist et dans la liste des régions.

Utilisation de l'outil de trimming Time 
Compression/Expansion en mode Spot

En mode Spot, lorsque vous cliquez sur l'outil de 
compression/expansion temporelle dans une 
région, la boîte de dialogue Spot s'ouvre. Vous 
pouvez préciser l'emplacement sur lequel vous 
voulez que la région débute ou se termine, ou la 
durée de la région pour que celle-ci s'ajuste 
automatiquement.

Pour utiliser l'outil de trimming Time 
Compression/Expansion en mode Spot :

1  Définissez le mode d'édition sur Spot.

2  Cliquez dans le menu déroulant de l'outil de 
trimming et sélectionnez TCE.

Le rognage des régions en mode Relative 
Grid s'effectue par incrément tout en 
conservant un décalage relatif (le cas 
échéant) par rapport à la grille.

Outil de trimming compression/extension temporelle 
(Time Compression/Expansion)
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3  Cliquez sur la région à côté de son point de 
début ou de fin. La boîte de dialogue Spot 
s'ouvre. A l'aide de n'importe quelle échelle de 
temps, entrez une nouvelle valeur de début ou 
de fin (ou une durée) de la région, et cliquez sur 
OK. Une nouvelle région est traitée 
automatiquement par le plug-in AudioSuite de 
compression/expansion temporelle. La nouvelle 
région apparaît dans la playlist et dans la liste 
des régions.

Outil de trimming Scrub Trim
(Pro Tools HD uniquement)

L'outil Scrub Trim est pratique pour écouter des 
données (sur deux pistes au maximum) afin de 
rechercher un point de Rognage. Vous pouvez 
vous déplacer dans une piste pour écouter les 
données audio, puis rogner à un endroit précis 
en relâchant le bouton de la souris.

Cette action crée une région. Remarquez que le 
curseur de l'outil Scrub Trim se transforme en un 
« rognage à droite » ou « rognage à gauche » 
selon qu'il se trouve du côté droit ou du côté 
gauche d'une région. Pour inverser la direction 
de l'outil Scrub Time, appuyez sur Option 
(Macintosh) ou sur Alt (Windows) avant de 
cliquer sur la région.

Le sens et la vitesse de lecture en Scrub varient 
selon le mouvement du contrôleur. Les données 
audio d'une piste lue en scrubbing empruntent 
le chemin du signal de la piste, y compris les 
éventuels effets qui y sont disposés.

Pour effectuer un Scrub Trim sur une piste :

1  Cliquez sur l'outil Scrub Trim. Le curseur se 
transforme en haut-parleur avec un crochet.

2  Faites glisser le curseur dans la piste, vers la 
gauche ou la droite. Les données audio de la 
piste lue en scrubbing empruntent le chemin du 
signal de la piste, y compris les effets TDM. 
Lorsque vous avez repéré le point de rognage 
désiré, relâchez le bouton de la souris pour 
« rogner » la région.

Pour effectuer un Scrub Trim sur deux pistes, 
cliquez avec l'outil Scrub Trim entre deux pistes 
adjacentes et déplacez le curseur.

Pour affiner la résolution (sans effectuer de 
zoom), appuyez sur la touche Pomme 
(Macintosh) ou Ctrl (Windows) pendant le 
scrubbing.

Utilisation du sélecteur
Utilisez le sélecteur pour placer le curseur 
d'édition sur une piste ou une règle temporelle 
ou pour effectuer des sélections d'édition sur des 
pistes. Pour plus d'informations sur la sélection, 
voir Sélection des données de la piste, page 334.

Positionnement du curseur d'édition

Pour positionner le curseur à l'aide du sélecteur :

1  Sélectionnez le sélecteur dans la fenêtre Edit.

2  Cliquez sur l'emplacement de votre choix sur 
une piste ou une règle temporelle.

Outil Scrub Trim sur une région
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Sélection d'édition à l'aide du 
sélecteur

Pour effectuer une sélection avec le sélecteur :

1  Sélectionnez le sélecteur dans la fenêtre Edit

2  Cliquez dessus, puis faites-le glisser sur une 
piste, sur plusieurs pistes ou sur une règle 
temporelle.

Pour sélectionner une région entière avec le 
sélecteur :

1  Sélectionnez le sélecteur dans la fenêtre Edit

2  Cliquez deux fois sur la région souhaitée de la 
piste.

Pour sélectionner une piste entière avec le 
sélecteur :

1  Sélectionnez le sélecteur dans la fenêtre Edit

2  Cliquez trois fois sur la piste souhaitée.

Main
Utilisez les outils Main afin de sélectionner, 
séparer ou déplacer des régions sur des pistes. 
Il existe trois modes différents pour l'outil 
Main : Accrochage de temps/Séparation/Saisie 
d'objet

Outil d'accrochage de temps : sélectionne une 
région entière sur une piste à l'aide d'un clic de 
souris. Pour plus d'informations sur la sélection, 
voir Sélection des données de la piste, page 334.

Outil de saisie de séparation : permet de copier 
et de coller une sélection d'édition d'un 
emplacement à un autre en cliquant dessus et en 
la faisant glisser. Pour plus d'informations, 
reportez-vous à la section Outil de séparation, 
page 353.

Outil de saisie d'objet : permet de sélectionner 
simultanément plusieurs régions non contiguës. 
Pour plus d'informations, reportez-vous à la 
section Sélection d'objets, page 336.

Positionnement du curseur à l'aide du sélecteur

Sélection à l'aide du sélecteur 

Outil d'accrochage de temps

Outil de séparation

Outil de saisie d'objet
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Pour sélectionner l'un des outils de saisie :

1  Cliquez sur le bouton de l'outil de saisie et 
maintenez le bouton de la souris enfoncé dans 
la fenêtre Edit.

2  Dans le menu contextuel de la main, 
sélectionnez l'outil de saisie de votre choix.

Utilisation de l'outil Smart
L'outil Smart permet d'utiliser instantanément 
le sélecteur, la main et l'outil de trimming, ainsi 
que de créer des fades et des crossfades. La 
position du curseur par rapport à une région, 
une note, ou au sein d'une playlist 
d'automation, détermine le fonctionnement de 
l'outil Smart.

Pour sélectionner l'outil Smart, cliquez sur son 
icône en haut à gauche de la fenêtre Edit, ou 
appuyez simultanément sur F6+F7 (ou F7+F8).

Outil Smart en vue Waveform (ou en 
vue Regions pour les pistes MIDI)

Les fonctions suivantes sont utilisables avec 
l'outil Smart lorsque vous travaillez avec des 
pistes audio en vue Waveform ou Blocks, ou 
avec des pistes MIDI en vue Regions :

◆ Pour le sélecteur, placez le curseur au milieu 
de la région, dans la moitié supérieure.

◆ Pour l'outil d'accrochage, placez le curseur au 
milieu de la région, dans la moitié inférieure.

◆ Pour l'outil de trimming, placez le curseur à 
proximité du point de début ou de fin de la 
région. 

◆ Pour un fondu d'entrée ou de sortie, placez le 
curseur à proximité du point de début ou de fin 
de la région, près du haut. Lorsque le curseur de 
fondu apparaît, faites glisser dans la région pour 
définir la durée du fondu. Le fondu est créé 
automatiquement selon les réglages par défaut 
(Default Fade Settings, dans les préférences 
d'édition).

◆ Pour créer un crossfade (fondu enchaîné), 
placez le curseur entre deux régions audio 
adjacentes, près du bas. Lorsque le curseur de 
Crossfade apparaît, faites glisser vers la gauche 
ou la droite pour définir la durée du crossfade. 
Le crossfade est créé automatiquement selon les 
réglages de fondu par défaut (Default Fade 
Settings dans les préférences d'édition).

Sélection d'un outil de saisie

Outil Smart dans la fenêtre Edit

Outil Smart dans la vue Waveform

Fondu d'entrée 
(Fade-in)

Fondu de sortie 
(Fade-out)Sélecteur

Main
Outil de trimming

(début)

Outil de 
trimming 
(fin) Fin

Crossfade 
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Outil Smart dans la vue Notes

L'outil Smart permet, lorsque vous travaillez 
avec des pistes MIDI et des pistes d'instrument 
en vue Notes, d'accéder aux fonctions 
suivantes :

◆ Pour le sélecteur, placez le curseur de sorte 
qu'il ne recouvre aucune note.

Pour obtenir le sélecteur tout en positionnant le 
curseur sur des notes, appuyez sur Pomme 
(Macintosh) ou sur Ctrl (Windows).

◆ Pour l'outil d'accrochage, placez le curseur sur 
la note, vers le milieu. 

Pour obtenir le rectangle de sélection 
permettant de sélectionner un groupe de notes, 
positionnez le curseur sans qu'il recouvre des 
notes, puis appuyez sur Pomme (Macintosh) ou 
sur Ctrl (Windows).

◆ Pour l'outil de trimming, placez le curseur à 
proximité du point de début ou de fin de la note.

Outil Smart dans les vues Automation 
et Controller

Les fonctions suivantes sont utilisables avec 
l'outil Smart lorsque vous travaillez dans les vues 
Automation et Contrôleur :

◆ Pour le sélecteur, placez le curseur n'importe 
où dans les trois quarts inférieurs de la liste de 
diffusion. Faites glisser le sélecteur pour 
sélectionner des points d'inflexion. 

◆ Pour l'outil de trimming, placez le curseur 
n'importe où dans le quart inférieur de la 
playlist. Pour rogner des points d'inflexion, 
déplacez l'outil de trimming. Pour plus de 
précision, appuyez sur Pomme (Macintosh) ou 
sur Ctrl (Windows) tout en effectuant le 
rognage.

◆ Pour la main, sélectionnez l'outil en 
maintenant la touche Contrôle (Windows) ou 
Pomme (Macintosh) enfoncée, puis cliquez sur 
la ligne d'automation pour créer des points 
d'inflexion.

Pour modifier des points d'inflexion existants, 
placez le curseur à proximité d'un point 
d'inflexion, ce qui fait apparaître l'outil 
d'accrochage.

Pour plus de précision avec l'outil Main, 
appuyez sur la touche Pomme (Macintosh) ou 
Ctrl (Windows), ou continuez d'appuyer sur la 
touche si vous créez un nouveau point 
d'inflexion. 

Pour passer provisoirement de l'outil Smart 
à l'outil de scrubbing, placez le curseur sur 
la région pour activer le sélecteur, et 
appuyez ensuite sur la touche Contrôle 
(Macintosh) ou Démarrer (Windows), ou 
cliquez avec le bouton droit de la souris.

Outil Smart dans la vue Notes

Sélecteur

MainRognage du point de 
début de la région

Rognage du point de 
fin de la région

Pour passer provisoirement de l'outil Smart 
à la gomme, placez le curseur sur la région 
pour activer le sélecteur, et appuyez sur la 
touche Contrôle+Option (Macintosh) ou 
Démarrer+Alt (Windows).
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Appuyez sur Maj pour restreindre le mouvement 
de l'outil Main dans le sens vertical.

Pour restreindre le mouvement de l'outil Main 
dans le sens vertical avec précision, appuyez sur 
Ctrl+Maj (Windows) ou sur Pomme+Maj 
(Macintosh). 

Outil Smart avec les pistes stéréo et 
multicanaux

Si vous utilisez l'outil Smart sur des pistes stéréo 
et multicanaux, il est impossible d'éditer 
indépendamment les canaux séparés. Toutes les 
modifications apportées affecteront l'ensemble 
des canaux. 

Le passage d'un outil à un autre via l'outil Smart 
dans les pistes stéréo et multicanaux est 
déterminé par la position au sein de la piste dans 
sa globalité, et non par rapport à chacun des 
canaux.

Outil de scrubbing
L'outil de scrubbing permet d'effectuer un 
scrubbing sur deux pistes audio maximum dans 
la fenêtre Edit. L'outil de scrubbing est une 
technique qui provient du montage sur bande 
magnétique et consiste à faire défiler la bande 
d'avant en arrière sur la tête de lecture, à une 
vitesse inférieure à la vitesse normale, afin de 
mieux repérer un endroit particulier 
(généralement pour réaliser un montage par 
coupe/assemblage).

Si la consultation d'une forme d'onde audio 
dans Pro Tools est utile pour rechercher 
visuellement un point d'édition, il peut arriver 
que cette forme d'onde ne permette pas de 
repérer le point de montage désiré dans les 

données audio. Le scrubbing, lecture d'avant en 
arrière sur un point d'édition dans Pro Tools, 
permet d'écouter et de vous positionner 
précisément sur le point d'édition recherché. 

Lorsque l'option Edit Insertion Follows 
Scrub/Shuttle des préférences de 
fonctionnement est activée, le curseur d'édition 
saute automatiquement à l'endroit où vous vous 
êtes arrêté en mode Scrubbing.

Lorsque l'option de défilement est réglée sur 
Continuous ou Center Playhead, un clic avec 
l'outil de scrubbing dans la playlist d'une piste 
centre la fenêtre Edit autour de ce point et y 
place la tête de lecture. Avec ces options de 
défilement, les données soumises au scrubbing 
se déplacent au-delà de la tête de lecture, qui ne 
bouge pas et reste au centre.

Pour effectuer un scrubbing sur une seule piste 
audio

■ Lorsque l'outil de scrubbing est sélectionné, 
faites-le glisser dans la piste, vers la gauche pour 
aller en arrière, vers la droite pour aller en avant.

La distance et la vitesse du déplacement (via la 
souris ou la molette d'un contrôleur externe) 
détermine la durée et la vitesse de lecture des 
données audio. Les données audio de la piste 
ainsi lue sont assignées vers sa sortie, avec tous 
les effets affectés à la piste.

Le scrubbing ne concerne que les pistes 
audio. Il ne concerne pas les pistes MIDI et 
les pistes d'instrument.

Scrubbing d'une piste audio avec l'outil de scrubbing
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La résolution de l'outil de scrubbing dépend du 
facteur de zoom sur la piste lue.

Pour appliquer le scrubbing à des pistes audio 
multiples :

■ Après avoir sélectionné l'outil de scrubbing, 
faites-le glisser entre deux pistes adjacentes.

– ou –

■ Effectuez un scrubbing dans une sélection 
contenant plusieurs pistes. Vous n'entendrez 
que les deux premières pistes.

Mode Scrub/Shuttle

En scrubbing normal, la lecture s'effectue à 
vitesse normale ou plus lente. Le mode 
Scrub/Shuttle, en revanche, vous permet 
d'effectuer un scrubbing à plusieurs fois la 
vitesse normale, ce qui peut être utile pour lire 
des plages étendues et repérer des données.

Pour effectuer un scrubbing en mode Shuttle 
(plusieurs fois la vitesse normale) :

1  Sélectionnez l'outil de scrubbing.

2  Tout en appuyant sur Option (Macintosh) ou 
sur Alt (Windows), déplacez l'outil de scrubbing 
vers la gauche pour aller en arrière, vers la droite 
pour aller en avant. Les boutons Avance rapide 
et Retour arrière de la fenêtre Transport 
s'activent. 

La distance et la vitesse du déplacement 
déterminent la vitesse des données audio lues en 
scrubbing.

Mode Shuttle Lock (shuttle verrouillé)

Le mode shuttle verrouillé vous permet d'utiliser 
le clavier numérique pour effectuer, à la vitesse 
que vous désirez, un shuttle avant ou arrière 
allant jusqu'à deux pistes : 5 correspond à la 
vitesse normale, les touches de 6 à 9 permettent 
d'avancer à des vitesses progressivement plus 
accélérées et les touches de 4 à 1 permettent de 
reculer de plus en plus vite (4 correspond à la 
vitesse de Shuttle Lock la plus lente et 1 à la plus 
rapide). Si plusieurs pistes sont sélectionnées, 
seules les deux premières passent en mode 
Shuttle Lock.

Pour basculer temporairement le sélecteur 
sur l'outil de scrubbing, maintenez la 
touche Contrôle (Macintosh) enfoncée et 
cliquez sur le sélecteur ou cliquez avec le 
bouton droit de la souris (Windows) sur le 
sélecteur. Pour affiner la résolution, 
maintenez enfoncées les touches 
Pomme+Contrôle (Macintosh) puis cliquez, 
ou maintenez enfoncée la touche Ctrl 
(Windows) pendant que vous cliquez avec le 
bouton droit de la souris.

Scrubbing entre deux pistes audio

Vous ne pouvez effectuer un scrubbing que 
sur huit canaux au maximum dans 
Pro Tools, ce qui permet de lire deux pistes 
stéréo (quatre canaux), mais pas deux 
pistes 5.1 Surround (12 canaux).
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Pour lire une ou deux pistes en mode 
Shuttle Lock : 

1  Dans Pro Tools HD, vérifiez que l'option 
Numeric Keypad Mode des préférences de 
fonctionnement n'est pas réglée sur Shuttle 
(voir Préférences de fonctionnement, page 75).

2  A l'aide du sélecteur, cliquez dans la piste à 
l'endroit où vous souhaitez que commence la 
lecture. Pour que le shuttle s'effectue sur deux 
pistes, cliquez sur une seconde piste en 
appuyant sur Maj.

3  Appuyez sur Control (Macintosh) ou sur 
Démarrer (Windows) et sur un chiffre du clavier 
numérique : 0–9 (9 est le plus rapide, 5 est la 
vitesse normale, 0 arrête le shuttle).

Dès que le mode shuttle verrouillé est actif, les 
boutons Avance rapide et Retour arrière passent 
en surbrillance dans la fenêtre Transport.

4  Appuyez sur d'autres touches pour changer la 
vitesse de lecture ou appuyez sur plus (+) ou 
moins (-) pour changer la direction de lecture 
(plus pour aller en avant, moins pour aller en 
arrière).

5  Pour arrêter la lecture, appuyez sur 
Contrôle+0 (Macintosh) ou sur Démarrer+0 
(Windows).

Pour quitter le mode Shuttle Lock :

■ Appuyez sur Stop dans la fenêtre Transport.

– ou –

■ Appuyez sur la barre d'espace.

Vitesse de Shuttle Lock personnalisée

Utilisez l'option Custom Shuttle Lock Speed 
preference pour personnaliser la vitesse 
maximum du Shuttle verrouillé (touche 9) afin 
accorder vos besoins d'édition et d'écoute.

Pour configurer la vitesse de Shuttle verrouillé 
personnalisée :

1  Dans Pro Tools, choisissez Setup > Preferences 
et cliquez sur l'onglet Operation. 

2  Assurez-vous que le mode du clavier 
numérique (Numeric Keypad) est réglé sur 
Transport ou Classic (voir Préférences de 
fonctionnement, page 75).

3  Entrez le pourcentage que vous désirez dans 
les paramètres de Custom Shuttle Lock Speed. 
La plage de cette commande s 'étend de 50 à 
800 %. Utilisez les flèches Haut et Bas pour 
augmenter ou réduire le paramètre. 

4  Cliquez sur OK. 

La vitesse que vous avez choisi dans le Custom 
Shuttle Lock Speed est enregistrée avec vos 
préférences Pro Tools (et non pas avec la 
session).

Pour activer la vitesse de Shuttle verrouillé 
personnalisée :

■ Appuyez sur Démarrer+9 (Windows) ou 
Ctrl+9 (Macintosh) sur le clavier numérique.

Clavier numérique réglé sur 
Shuttle
(Pro Tools HD uniquement)

Pro Tools offre une autre forme de lecture en 
mode Shuttle, différente de celle du mode 
Shuttle verrouillé. Lorsque le mode du clavier 
numérique est réglé sur Shuttle, la lecture de la 
sélection d'édition actuelle commence lorsque 
vous appuyez sur les touches du clavier 
numérique et dure tant que vous les maintenez 
enfoncées ; la lecture s'arrête dès relâchement 
des touches. Vous pouvez définir plusieurs 
vitesses de lecture, en avant ou en arrière. Dans 
ce mode, les pré/post-roll sont ignorés.
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Pour effectuer un shuttle lorsque le mode du 
clavier numérique est réglé sur Shuttle :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation.

2  Réglez le mode du clavier numérique sur 
Shuttle, puis cliquez sur Done.

3  A l'aide du sélecteur, cliquez dans la piste à 
l'endroit où vous souhaitez que commence la 
lecture. Pour que le shuttle s'effectue sur deux 
pistes, cliquez sur une seconde piste en 
appuyant sur Maj.

4  Appuyez et maintenez enfoncée l'une des 
touches suivantes (ou l'une des combinaisons de 
touches) sur le clavier numérique pour 
déclencher la lecture.

5  Appuyez sur une autre touche pour changer 
de direction ou de vitesse. Relâchez pour arrêter.

Utilisation du crayon
L'outil Crayon vous permet de dessiner une 
automation, des données MIDI, des 
modifications de tempo et des formes d'ondes 
audio (à l'échelle de l'échantillon). 

La fenêtre Universe
(Pro Tools HD uniquement)

La fenêtre Univers affiche une vue générale de la 
session, représentant les données audio et MIDI 
de toutes les pistes non masquées (y compris les 
pistes inactives ou contenant des régions hors 
ligne). L'ordre d'affichage des éléments dans la 
fenêtre Universe correspond à l'ordre de la piste 
dans la fenêtre Edit.

Pour ouvrir la fenêtre Universe :

■ Choisissez Window > Universe.

Les données audio se trouvant dans les pistes 
audio sont représentées par de simples lignes 
horizontales dans la fenêtre Universe. Chaque 
canal d'une piste stéréo ou multicanal est 
représenté individuellement.

Vitesse de 
Shuttle

Touche de 
retour 
arrière

Touche 
d'avance 

rapide

Vitesse 1 x 4 6

Vitesse 4 x 7 9

Vitesse 1/4 x 1 3

Vitesse 1/2 x 4+5 5+6

Vitesse 2 x 7+8 8+9

Pour plus d'informations, consultez la 
section Dessin d'automation, page 655.

Pour plus d'informations, consultez la 
section Crayon, page 498.

Pour plus d'informations, consultez la 
section Edition des événements de tempo 
dans l'éditeur de tempo, page 431.

Pour plus d'informations sur le dessin des 
formes d'onde audio, consultez la section 
Réparation de la forme d'onde avec le 
crayon, page 385.

Fenêtre Universe 

Données en surbrillance
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Les pistes d'entrée auxiliaire ou de fader 
principal (Master Fader) ne contenant pas de 
données audio, elles s'affichent sous forme de 
zone vides dans la fenêtre Univers.

Les pistes MIDI contenant des notes sont 
représentées par de simples lignes horizontales.

Changement de taille de la fenêtre 
Univers

Bien que vous puissiez la redimensionner 
horizontalement et verticalement, la fenêtre 
Universe affiche toujours la durée de la session 
entière. Si vous redimensionnez la fenêtre 
Universe et qu'une partie des pistes de la session 
n'est pas affichée, une barre de défilement 
verticale apparaît.

Eléments en surbrillance dans la 
fenêtre Univers

La zone en surbrillance, ombrée, de la fenêtre 
Univers représente les éléments affichés dans la 
fenêtre Edit. Si vous modifiez ce qui apparaît 
dans la fenêtre Edit (par un zoom, un défilement 
horizontal ou vertical, en masquant/affichant 
des pistes ou en changeant leur hauteur), la zone 
en surbrillance de la fenêtre Universe est mise à 
jour en conséquence.

Pendant la lecture, si vous faites défiler la fenêtre 
Edit, la zone en surbrillance de la fenêtre 
Univers défile également.

Défilement dans la fenêtre Univers

En cliquant dans la fenêtre Univers, vous 
pouvez faire défiler automatiquement, 
horizontalement ou verticalement, les éléments 
affichés dans la fenêtre Edit. Une méthode 
pratique pour aller n'importe où dans la session 
ou pour redéfinir les pistes visibles dans la 
fenêtre Edit.

Pour déplacer la zone en surbrillance dans la 
fenêtre Univers :

1  Choisissez Window > Universe.

2  Faites glisser la zone en surbrillance à un 
emplacement différent dans la fenêtre Universe 
pour changer les pistes affichées dans la fenêtre 
Edit.

Si toutes les pistes sont visibles dans la fenêtre 
Edit et que la session est en zoom arrière 
complet avec toutes les régions visibles, c'est 
toute la fenêtre Univers qui est ombrée.
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Chapitre 16 : Lecture et sélection des 
données des pistes

Lecture des pistes
Après avoir enregistré ou importé des données 
audio ou MIDI vers des pistes, vous les écouterez 
en vue de leur édition ou de leur mixage.

Pour définir le début de la lecture, vous pouvez 
cliquer n'importe où dans une piste avec le 
sélecteur (si les sélections d'édition et de 
timeline sont liées). Voir Activation ou 
désactivation de la liaison des sélections 
d'édition et de timeline, page 332.

Curseur de lecture

Le curseur de lecture prend la forme d'une ligne 
continue non clignotante qui se déplace dans la 
fenêtre Edit pour indiquer la position de lecture 
actuelle.

L'option de défilement sélectionnée détermine 
le défilement de la fenêtre Edit pendant la 
lecture et le fonctionnement du curseur de 
lecture. Pour plus d'informations, reportez-vous 
à la section Options de défilement, page 330.

Emplacement de la lecture

L'emplacement correspondant à la lecture 
apparaît dans les compteurs situés en haut de la 
fenêtre Edit et dans les fenêtres Transport et Big 
Counter.

Pour afficher les compteurs dans la fenêtre 
Transport :

■ Choisissez View > Transport > Counters

Pour afficher la fenêtre Big Counter :

■ Choisissez Window > Big Counter.

Définition d'un point de lecture à l'aide du sélecteur

Fenêtre Transport avec les compteurs affichés

Fenêtre Big Counter
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Curseur d'édition

Le curseur d'édition est une ligne clignotante qui 
apparaît lorsque vous cliquez avec le sélecteur 
dans la playlist d'une piste. Le curseur d'édition 
clignotant indique le point de début de 
n'importe quelle tâche d'édition effectuée. 
Si vous effectuez une sélection et réalisez une 
édition, c'est la sélection qui constitue la cible de 
l'édition.

Lecture de base à partir d'un point 
spécifique

Pour commencer la lecture depuis un point 
spécifique d'une piste :

1  Choisissez Options > Link Timeline and Edit 
Selection.

2  A l'aide du sélecteur, cliquez dans la piste à 
l'endroit où vous souhaitez que commence la 
lecture.

3  Pour commencer la lecture, cliquez sur le 
bouton de lecture de la fenêtre Transport.

4  Cliquez sur le bouton d'arrêt de la fenêtre 
Transport pour arrêter la lecture.

Pour positionner le curseur à un autre 
emplacement et lancer la lecture à partir de ce 
point :

■ A l'aide du sélecteur, cliquez sur ce point, puis 
sur Play dans la fenêtre Transport.

– ou –

■ Cliquez sur l'emplacement correspondant 
dans une règle temporelle au cours de la lecture.

Lorsque les sélections d'édition et de timeline 
sont liées, cliquer sur une région ou une note 
MIDI à l'aide de l'outil d'accrochage de temps 
met à jour automatiquement la timeline en 
fonction du début de la sélection, ce qui permet 
de lancer facilement la lecture depuis ce point.

Défilement de la page pendant la 
lecture

Vous pouvez paramétrer Pro Tools de façon à 
faire défiler l'affichage de la piste pendant la 
lecture et à ce que le curseur d'édition apparaisse 
là où la lecture s'arrête.

Si vous souhaitez que l'affichage de la piste et le 
curseur d'édition suivent la lecture :

1  Choisissez Options > Scrolling > Page.

2  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation.

3  Sélectionnez l'option Timeline Insertion 
Follows Playback, puis cliquez sur Done.

4  Choisissez Options > Link Timeline and Edit 
Selection.

5  A l'aide du sélecteur, cliquez dans la piste à 
l'endroit où vous souhaitez que commence la 
lecture.

6  Pour commencer la lecture, cliquez sur le 
bouton de lecture de la fenêtre Transport. Le 
curseur de lecture défile dans la fenêtre Edit et 
indique l'emplacement actuel de la lecture.

7  Cliquez sur le bouton d'arrêt de la fenêtre 
Transport pour arrêter la lecture. Le curseur 
d'édition apparaît à l'endroit où la lecture s'est 
arrêtée.

Pour activer ou désactiver l'option Timeline 
Insertion Follows Playback, appuyez sur 
Contrôle + N (Macintosh) ou sur 
Démarrer + N (Windows).
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Recherche et écoute avec Avance 
rapide/Retour arrière

Les boutons Avance rapide et Retour arrière de la 
fenêtre Transport permettent de rechercher des 
données dans les pistes. Si l'option Audio 
During Fast Forward/Rewind des préférences de 
fonctionnement est sélectionnée, vous 
entendez réellement les données audio balayées 
(comme avec un lecteur de CD) lorsque vous 
cliquez sur les boutons d'avance rapide et de 
retour arrière.

Vous pouvez également effectuer une avance 
rapide ou un retour arrière par incréments en 
cliquant plusieurs fois sur le bouton 
correspondant. La taille de ces incréments est 
déterminée par l'échelle temporelle principale :

Bars:Beats : déplacement jusqu'au début de la 
mesure précédente ou suivante.

Min:Sec : déplacement vers l'arrière ou l'avant 
par incrément d'une seconde.

Time code : déplacement vers l'arrière ou l'avant 
par incrément d'une seconde (avec ajustement 
au format SMPTE courant).

Feet+Frames : déplacement vers l'arrière ou 
l'avant par incrément d'un pied.

Echantillons : déplacement vers l'arrière ou 
l'avant par incrément d'une seconde.

Recherche à l'aide des 
commandes Back et Forward
(Pro Tools HD uniquement)

Pro Tools fournit quatre commandes de type 
Retour/Avance (appelées parfois « rollback ») 
destinées à déplacer l'emplacement 
correspondant à la lecture dans la fenêtre Edit. 
L'intervalle du déplacement est défini par le 
paramètre Back/Forward Amount défini dans la 
page Operation de la fenêtre Setup > 
Preferences.

Vous pouvez également déplacer l'emplacement 
de la lecture de plusieurs incréments en 
exécutant à plusieurs reprises la commande 
(voir la section Répétition des commandes 
Back/Forward, page 326).

Back : déplace l'emplacement de la lecture, vers 
l'arrière, de la valeur du paramètre Back/Forward 
Amount.

Back and Play : déplace l'emplacement actuel de 
la lecture vers l'arrière de la valeur Back/Forward 
Amount et lance automatiquement la lecture.

Forward : déplace l'emplacement de la lecture 
vers l'avant de la valeur Back/Forward Amount.

Forward and Play : déplace l'emplacement actuel 
de la lecture vers l'avant de la valeur 
Back/Forward Amount et lance 
automatiquement la lecture.

Les commandes Back/Forward 
fonctionnent également lorsque vous 
contrôlez un périphérique à 9 broches. 
Reportez-vous au Guide MachineControl 
pour plus d'informations.
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Définition de la valeur Back/Forward

L'intervalle du déplacement Back/Forward est 
déterminé par le paramètre Back/Forward 
Amount situé dans la page Operation de la 
fenêtre Setup > Preferences.

Pour configurer le paramètre Back/Forward 
Amount :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation.

La référence temporelle des paramètres 
Back/Forward Amount est conforme à l'échelle 
temporelle principale par défaut. Il est possible 
de désélectionner l'option Follow Main Time et 
de choisir un autre format temporel :

• Bars:Beats

• Min:Sec

• Time Code

• Feet+Frames

• Samples

2  Effectuez l'une des opérations suivantes :

• Sélectionnez un intervalle prédéfini dans le 
menu déroulant Back/Forward Amount.

– ou –

• Dans le champ Back/Forward Amount, 
entrez un intervalle personnalisé.

Utilisation des commandes Back ou Forward

Pour déplacer l'emplacement de la lecture, vers 
l'arrière, de la valeur Back/Forward Amount :

■ Appuyez sur Pomme (Macintosh) ou sur Ctrl 
(Windows) et cliquez sur Rewind dans la fenêtre 
Transport.

Pour déplacer l'emplacement de la lecture, vers 
l'avant, de la valeur Back/Forward Amount :

■ Appuyez sur Pomme (Macintosh) ou sur Ctrl 
(Windows) et cliquez sur Fast Forward dans la 
fenêtre Transport.

Pour déplacer l'emplacement de la lecture, vers 
l'arrière, de la valeur Back/Forward Amount et 
lancer automatiquement la lecture :

■ Appuyez sur Pomme + Option (Macintosh) 
ou sur Ctrl + Alt (Windows) et cliquez sur 
Rewind dans la fenêtre Transport.

Pour déplacer l'emplacement de la lecture, vers 
l'avant, de la valeur Back/Forward Amount et 
lancer automatiquement la lecture :

■ Appuyez sur Pomme + Option (Macintosh) 
ou sur Ctrl + Alt (Windows) et cliquez sur Fast 
Forward dans la fenêtre Transport.

Répétition des commandes Back/Forward

Toutes les commandes Back/Forward peuvent 
être répétées de manière à augmenter 
l'amplitude du déplacement total vers l'avant ou 
l'arrière.

Pour répéter les déplacements vers l'avant ou 
l'arrière :

1  Appuyez sur les touches Pomme (Macintosh) 
ou Ctrl (Windows).

2  Cliquez sur Rewind ou Fast Forward le nombre 
de fois nécessaire pour déplacer l'emplacement 
de lecture vers l'avant ou vers l'arrière. La valeur 
Back/Forward Amount spécifie l'intervalle du 
déplacement.
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Extension des sélections avec les commandes 
Back ou Back and Play

Les commandes Back ou Back and Play peuvent 
servir à étendre une sélection vers l'arrière et ce, 
de la valeur du paramètre Back/Forward 
Amount. 

Pour étendre une sélection avec les commandes 
Back ou Back and Play :

1  Définissez la valeur du paramètre 
Back/Forward Amount (reportez-vous à la 
section Définition de la valeur Back/Forward, 
page 326).

2  Faites glisser le sélecteur dans la piste pour 
faire une sélection.

3  Effectuez l'une des opérations suivantes :

• Pour étendre la sélection vers l'arrière de la 
valeur Back/Forward Amount, appuyez sur 
Maj + Control (Windows) ou 
Maj + Pomme (Macintosh) et cliquez sur 
Rewind dans la fenêtre Transport.

– ou –

• Pour étendre la sélection vers l'arrière de la 
valeur Back/Forward Amount, puis lancez 
la lecture, maintenez les touches 
Maj + Ctrl + Alt (Windows) ou 
Maj + Pomme + Option (Macintosh) et 
cliquez sur Rewind dans la fenêtre 
Transport.

Indicateurs et compteurs de la 
fenêtre Edit

Les compteurs et les indicateurs situés en haut 
de la fenêtre Edit présentent l'emplacement de 
lecture actuel et la sélection d'édition. 
Ils incluent les compteurs principaux et 
secondaires et les indicateurs de sélection 
d'édition de début (Start), de fin (End) et de 
durée (Length).

Tous les compteurs et indicateurs (excepté le 
compteur secondaire) de la fenêtre Edit vous 
permettent d'entrer un emplacement dans 
l'écran de leur compteur pour accéder à un 
emplacement temporel donné.

Le compteur principal indique l'emplacement 
de lecture, exprimé dans le format temporel de 
l'échelle temporelle principale. Le compteur 
secondaire peut être réglé sur n'importe quel 
autre format d'échelle temporelle, afin de 
fournir une autre référence temporelle.

Les indicateurs de sélection d'édition (à droite 
des compteurs principaux et secondaires) 
affichent les temps de début et de fin et la durée 
de la sélection d'édition actuelle selon l'échelle 
temporelle principale.

Les compteurs principaux et secondaires, ainsi 
que les indicateurs de sélection d'édition, 
apparaissent également dans la fenêtre 
Transport avec l'affichage des compteurs activé.

Bien que vous ne puissiez pas étendre une 
sélection vers l'avant à l'aide des 
commandes Forward ou Forward and Play, 
il est possible d'utiliser les procédures 
suivantes avec Forward ou Forward and 
Play pour déplacer le point de début de la 
sélection actuelle.

Compteurs principaux et secondaires, indicateurs de 
sélection d'édition
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Pour naviguer à l'aide du compteur principal de la 
fenêtre Edit (ou à l'aide d'un indicateur de 
sélection d'édition) :

1  Cliquez sur un des compteurs.

– ou –

Appuyez sur la touche représentant un 
astérisque (*) du pavé numérique pour mettre en 
surbrillance le compteur principal dans la 
fenêtre Edit (ou celui de la fenêtre Transport ou 
Big Counter, si l'une ou l'autre est à l'écran).

2  Entrez la nouvelle position. Appuyez sur le 
point (.) pour passer d'un champ de valeur à 
l'autre.

3  Appuyez sur Entrée pour valider la nouvelle 
valeur et vous y rendre automatiquement.

Défilement dans une règle 
temporelle

Vous pouvez faire défiler le contenu de la fenêtre 
Edit en cliquant sur la règle et en la faisant 
glisser. Ceci ne met pas réellement à jour la 
valeur de position de la session, mais permet de 
décaler facilement l'affichage vers la gauche ou 
la droite afin de mieux repérer des données pour 
les éditer.

Cette méthode est particulièrement utile avec 
l'option de défilement continu (Pro Tools HD 
seulement), qui n'effectue pas de mise à jour et 
ne suit pas les sélections de timeline.

Pour faire défiler le contenu complet de la fenêtre 
Edit à partir de la règle :

■ Tout en appuyant sur Pomme + Option 
+ Control (Macintosh) ou sur 
Ctrl + Alt + Démarrer (Windows), faites glisser 
l'une des règles temporelles vers la gauche ou la 
droite.

Défilement avec la molette

Si votre souris possède une molette, vous pouvez 
l'utiliser pour effectuer un défilement vertical ou 
horizontal dans n'importe quelle fenêtre 
Pro Tools dotée d'une barre de défilement (telle 
que la liste des événements MIDI).

Pour faire défiler une fenêtre Pro Tools 
verticalement :

1  Placez la souris sur la fenêtre que vous voulez 
faire défiler (par exemple vous pouvez faire 
défiler l'affichage des pistes ou la liste des 
régions dans la fenêtre Edit).

2  Faites rouler la molette vers le haut ou vers le 
bas pour faire défiler la fenêtre vers le haut ou le 
bas.

Pour faire défiler une fenêtre Pro Tools 
horizontalement :

1  Placez la souris sur la fenêtre que vous voulez 
faire défiler (par exemple vous pouvez faire 
défiler l'affichage des pistes ou la liste des 
régions dans la fenêtre Edit).

2  Faites rouler la molette vers le haut ou vers le 
bas tout en appuyant sur la touche Maj pour 
faire défiler la fenêtre vers la gauche ou la droite.

Défilement via une règle
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Recherche du curseur de lecture

Utilisez le localisateur de curseur de lecture pour 
rechercher le curseur de lecture lorsqu'il 
n'apparaît pas à l'écran. Le localisateur de 
curseur de lecture apparaît à droite dans la règle 
temporelle principale une fois que le curseur de 
lecture s'est déplacé au-delà de la partie visible 
de la fenêtre Edit. Si le curseur de lecture se 
trouve en amont de la partie visible de la fenêtre 
Edit, le localisateur de curseur de lecture 
apparaît à gauche dans la règle temporelle 
principale.

Le localisateur de curseur de lecture est rouge 
lorsqu'une piste est en cours d'enregistrement et 
bleue lorsqu'aucun enregistrement n'est activé.

Si par exemple l'option de défilement est définie 
sur None, le curseur de lecture se déplace hors de 
l'écran une fois que la région visible dans la 
fenêtre Edit a été lue. Le localisateur de curseur 
de lecture apparaît à droite dans la règle 
temporelle principale une fois que le curseur de 
lecture s'est déplacé au-delà de la partie visible 
de la fenêtre Edit.

Pour rechercher le curseur de lecture lorsqu'il se 
trouve en dehors de l'écran :

■ Cliquez sur la fonction de recherche du 
curseur de lecture dans la règle temporelle 
principale.

La fenêtre Edit change pour centrer le curseur de 
lecture à l'écran.

Défilement automatique des 
pistes dans les fenêtres Mix 
et Edit
(Pro Tools HD uniquement)

Si vous travaillez avec de nombreuses pistes et 
que les fenêtres Edit ou Mix ne peuvent pas 
toutes les afficher à la fois, vous pouvez 
sélectionner une piste dans une fenêtre et 
Pro Tools défilera automatiquement jusqu'à 
cette piste dans l'autre fenêtre.

Défilement automatique dans la fenêtre Mix pour 
afficher une piste sélectionée dans la fenêtre 
Edit :

■ Maintenez la touche Contrôle (Macintosh) ou 
Démarrer (Windows) enfoncée pendant que 
vous cliquez sur le nom d'une piste dans la 
fenêtre Edit.

La sélection de la piste entraîne le défilement de 
la fenêtre Mix où s'affiche la piste sélectionnée.

Défilement automatique dans la fenêtre Edit pour 
afficher une piste sélectionée dans la fenêtre 
Mix :

■ Maintenez la touche Contrôle (Macintosh) ou 
Démarrer (Windows) enfoncée pendant que 
vous cliquez sur le nom d'une piste dans la 
fenêtre Mix.

La sélection de la piste entraîne le défilement de 
la fenêtre Edit où s'affiche la piste sélectionnée.

Localisateur de curseur de lecture, enregistrement 
activé (curseur de lecture situé après les données audio 
visibles)

Localisateur de curseur de lecture
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Navigation dans les pistes à l'aide 
des numéros de position des 
pistes

Avec l'option Track Numbers View activée, 
chaque piste reçoit un numéro correspondant à 
sa position dans les fenêtres Mix et Edit. Vous 
pouvez défiler directement jusqu'à n'importe 
quelle piste à partir de son numéro de position.

Pour accéder directement à la piste de votre choix 
en utilisant son numéro de position :

1  Choisissez View > Track Number.

2  Choisissez Track > Scroll to Track.

– ou –

Appuyez sur Pomme + Option + F (Macintosh) 
ou sur Ctrl + Alt + F (Windows).

3  Dans la boîte de dialogue Scroll To Track, 
entrez le numéro de position de la piste

4  Cliquez sur OK.

La piste est sélectionnée et les fenêtres défilent 
comme suit :

• Les pistes de la fenêtre Edit défilent pour 
afficher la piste sélectionnée le plus près 
possible du haut. 

• Les pistes de la fenêtre Mix défilent pour 
afficher la piste sélectionnée le plus possible à 
gauche. 

Options de défilement
Il est possible de configurer le défilement du 
contenu de la fenêtre Edit en cours de lecture et 
d'enregistrement. 

Pour configurer les options de défilement :

■ Choisissez Options > Scrolling et sélectionnez 
l'une des options suivantes :

None : la fenêtre Edit ne défile ni pendant ni 
après la lecture. Le curseur de lecture se déplace 
dans la fenêtre Edit, indiquant la position du 
point de lecture.

After Playback : le curseur de lecture se déplace 
dans la fenêtre Edit, indiquant la position du 
point de lecture. La fenêtre Edit défile jusqu'au 
dernier point lu après l'arrêt de la lecture.

Page : le curseur de lecture se déplace dans la 
fenêtre Edit, indiquant la position du point de 
lecture. Lorsque le bord droit de la fenêtre Edit 
est atteint, son contenu tout entier défile et le 
curseur de lecture reprend son déplacement 
depuis le bord gauche de la fenêtre.

Continuous (Pro Tools HD uniquement) : pour 
plus d'informations, reportez-vous à la section 
Défilement continu pendant la lecture, 
page 331.

Lorsque l'ordre des pistes change, les 
numéros de position des pistes sont 
réattribués de manière à les conserver en 
séquences numériques.

Boîte de dialogue Scroll To Track
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Center Playhead (Pro Tools HD uniquement) : 
pour plus d'informations, reportez-vous à la 
section Défilement utilisant la tête de lecture, 
page 331.

Défilement continu pendant la lecture

(Pro Tools HD uniquement)

Cette option de défilement provoque le 
défilement continu de la fenêtre Edit au-delà du 
curseur de lecture, qui reste au centre de la 
fenêtre. Avec cette option, la lecture repose 
toujours sur la sélection de la timeline 
(contrairement à ce qui se produit avec l'option 
Center Playhead Scrolling).

Défilement utilisant la tête de lecture

(Pro Tools HD uniquement)

Cette option de défilement provoque le 
défilement continu du contenu de la fenêtre 
Edit au-delà de la tête de lecture, qui prend la 
forme d'une ligne bleue au centre de la fenêtre 
(rouge pendant l'enregistrement).

La tête de lecture indique où commence la 
lecture lorsque vous cliquez sur Play dans la 
fenêtre Transport.

Pour déplacer la tête de lecture jusqu'à un 
endroit déterminé, vous pouvez faire défiler la 
règle (voir Défilement dans une règle 
temporelle, page 328), utiliser la barre de 
défilement horizontale de la fenêtre Edit ou 
taper la position désirée dans l'un des 
indicateurs de sélection d'édition ou l'un des 
compteurs.

Le déplacement de la tête de lecture par ces 
méthodes ne met pas à jour la sélection de 
timeline. En revanche, la mise à jour de la 
sélection de timeline déplace automatiquement 
la tête de lecture vers le point d'insertion de la 
timeline.

Lorsque la tête de lecture est activée, vous 
pouvez atteindre la sélection d'édition ou de 
timeline et passer en lecture. Pour en savoir plus, 
reportez-vous à la section Lecture des sélections 
d'édition et de timeline avec la tête de lecture, 
page 349.

Demi-écran de la fenêtre Edit

Lorsque l'option de défilement Continuous ou 
Center Playhead est activée, un demi-écran 
apparaît à l'extrême gauche de la fenêtre Edit 
(avant le début de la session).

Si vous sélectionnez un élément dans la 
timeline ou une playlist ou si vous faites 
défiler la timeline à la main en mode Page 
Scroll ou Continuous Scroll, le défilement 
est suspendu. Pour reprendre le défilement 
de la page et se positionner sur 
l'emplacement de lecture, cliquez sur le 
localisateur de curseur de lecture dans la 
règle temporelle principale (voir 
Recherche du curseur de lecture, 
page 329).

Option de défilement utilisant la tête de lecture 

Demi-écran pour l'option de défilement Center 
Playhead
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Activation ou désactivation 
de la liaison des sélections 
d'édition et de timeline
Pro Tools vous permet d'activer ou de désactiver 
la liaison des sélections d'édition et de timeline. 

Lorsque les sélections d'édition et de timeline 
sont liées, la sélection dans une playlist de piste 
(une sélection d'édition) définit également la 
plage de lecture et d'enregistrement (la sélection 
de timeline).

Lorsque vous désolidarisez les sélections 
d'édition et de timeline, vous pouvez 
sélectionner une partie de piste à modifier, 
distincte de la sélection de timeline (qui définit 
la plage de lecture et d'enregistrement).

Pour activer ou de désactiver la liaison des 
sélections d'édition et de timeline :

■ Sélectionnez ou désélectionnez Options > 
Link Timeline and Edit Selection.

– ou –

■ En haut et à gauche de la fenêtre Edit, cliquez 
sur le bouton Link Timeline and Edit Selection 
de manière à le mettre en surbrillance (il est 
sélectionné) ou à supprimer la mise en 
surbrillance (il n'est pas sélectionné).

Si vous travaillez sur une scène de film ou en 
vidéo, vous pouvez avoir besoin de séparer les 
sélections d'édition et de timeline pour 
rechercher ou lire des données se trouvant à des 
emplacements différents de la sélection de 
timeline actuelle. Vous pouvez lire des 
sélections d'édition (choisissez Edit > Selection > 
Play Edit) sans interrompre la sélection de 
timeline actuelle. Lorsque vous avez repéré les 
données, vous pouvez revenir à la sélection de 
timeline et les placer dans le contexte de la 
scène.

La Figure 11 illustre une autre raison pour 
laquelle vous pouvez séparer les sélections 
d'édition et de timeline. Dans cet exemple, la 
sélection de timeline définit une plage à boucler 
en lecture, tandis qu'une région MIDI (se 
trouvant dans la boucle) est sélectionnée pour 
des besoins d'édition. Pendant la lecture, la 
sélection d'édition peut être déplacée, quantifiée 
ou transposée pendant que la boucle est lue de 
façon complètement indépendante et sans 
interruption.

Si vous pouvez théoriquement le faire alors que 
les sélections d'édition et de timeline sont liées, 
dès que la lecture est arrêtée, la plage de lecture 
sera mise à jour en fonction de la plage d'édition 
la plus récente ou selon une note lorsque vous 
éditez des données MIDI.

Liaison des sélections d'édition et timeline activée

Appuyez sur Maj + / (barre oblique) pour 
activer ou désactiver l'option Link Timeline 
and Edit Selection.

Figure 11.  Sélections d'édition et de timeline séparées
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Marqueurs de lecture/d'édition

Les sélections de timeline apparaissent dans la 
règle temporelle principale avec les marqueurs de 
lecture, qui prennent la forme de flèches bleues 
(rouges en cours d'enregistrement). De plus, des 
drapeaux de pré et de post-roll (verts lorsqu'ils sont 
actifs) indiquent l'emplacement du pré/post-
roll.

Lorsque les sélections d'édition et de timeline 
sont séparées, les sélections d'édition s'affichent 
dans la règle avec les marqueurs d'édition, qui 
apparaissent sous forme de crochets noirs.

Lorsque les sélections d'édition et de timeline 
sont liées, les sélections d'édition sont 
représentées par les marqueurs de lecture bleus.

Consultez les sections qui suivent pour d'autres 
informations sur l'utilisation des sélections 
d'édition et de timeline :

• Sélection des données de la piste, page 334

• Sélections de timeline, page 346

• Définition des points d'enregistrement 
fractionné et de boucle, page 222

• Définition des paramètres de pré et post-
roll, page 225

Activation ou désactivation 
de la liaison des sélections 
d'édition et de piste
Pro permet d'activer ou de désactiver la liaison 
des sélections d'édition et de pistes.

Lorsque les sélections d'édition et de piste ne 
sont pas liées, vous pouvez effectuer une 
sélection dans une ou plusieurs pistes à des fins 
d'édition ; chaque piste est sélectionnée (les 
noms des pistes s'affichent automatiquement en 
surbrillance). Cela vous permet d'exécuter des 
commandes à l'échelle de la piste (pour changer 
la vue de pistes ou les hauteurs de pistes, par 
exemple) et d'appliquer la commande à toutes 
les pistes avec lesquelles vous travaillez. 

Lorsque les sélections d'édition et de pistes sont 
dissociées, définir une sélection d'édition ne 
sélectionne pas automatiquement les pistes 
associées. 

Pour séparer les sélections de piste et de 
timeline :

■ Sélectionnez ou désélectionnez Options > 
Link Track and Edit Selection.

– ou –

■ En haut et à gauche de la fenêtre Edit, cliquez 
sur le bouton Link Track and Edit Selection de 
manière à le mettre en surbrillance (il est 
sélectionné) ou à supprimer la mise en 
surbrillance (il n'est pas sélectionné).

Marqueurs de lecture avec les drapeaux 
de pré/post-roll

Figure 12.  Marqueurs d'édition

Liaison des sélections d'édition et de piste activée
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Sélection des données de 
la piste
Avant de pouvoir éditer des données audio et 
MIDI, vous devez les sélectionner. La vue de la 
piste détermine la manière dont le matériel 
s'affiche et est sélectionné. 

Lorsque vous effectuez une sélection, elle 
apparaît en surbrillance sur la piste et elle est 
également repérée par des flèches bleues au 
début et à la fin (marqueurs de lecture) dans la 
règle temporelle principale. Si une piste 
quelconque (audio ou MIDI) de la session est 
préparée en enregistrement, même si elle est 
masquée, ces marqueurs s'affichent en rouge. 

Lorsque les sélections d'édition et de timeline 
sont séparées, la plage de sélection d'édition est 
indiquée par des marqueurs d'édition dans la 
règle temporelle principale. Pour plus 
d'informations, reportez-vous à la section 
Activation ou désactivation de la liaison des 
sélections d'édition et de timeline, page 332.

Sélections et groupes d'édition

Lorsque vous effectuez des sélections sur des 
pistes appartenant à un groupe d'édition, toutes 
les pistes de ce dernier sont sélectionnées.

Sélections et pistes masquées

Lorsque vous éditez des pistes appartenant à un 
groupe d'édition, aucune piste masquée de ce 
dernier n'est concernée par l'édition. Pour éditer 
tous les membres d'un groupe, vérifiez s'ils sont 
visibles en mettant en surbrillance leurs noms 
dans la liste des pistes. 

Sélection sur plusieurs pistes

Pour effectuer une sélection sur plusieurs pistes :

■ A l'aide du sélecteur, cliquez et faites glisser 
horizontalement pour inclure des pistes 
adjacentes d'une sélection (faites glisser 
verticalement pour définir la plage temporelle). 

Sélection de régions

Pour sélectionner une partie d'une région :

■ A l'aide du sélecteur, déplacez-vous dans un 
région, (à gauche ou à droite) pour sélectionner 
les données d'une seule piste. (Vous pouvez 
également utiliser le sélecteur sur plusieurs 
pistes adjacentes pour effectuer des sélections 
s'étendant sur plusieurs pistes).

Pour sélectionner une région entière :

■ Cliquez sur la région à l'aide de l'outil 
d'accrochage de temps.

– ou –

■ Cliquez deux fois sur la région avec le 
sélecteur.

Marqueurs de lecture indiquant une sélection d'édition

Sélection d'une partie d'une région
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Pour sélectionner deux régions et la plage de 
temps qui les sépare :

1  Avec l'outil d'accrochage de temps, cliquez sur 
la première région.

2  Cliquez sur la seconde région en appuyant sur 
la touche Maj. Les deux régions sont 
sélectionnées, ainsi que la plage de temps qui les 
sépare (y compris, éventuellement, d'autres 
régions).

Pour sélectionner une piste entière :

■ Cliquez dans la piste avec le sélecteur et 
choisissez Edit > Select All.

– ou –

■ Cliquez trois fois sur n'importe quelle piste 
avec le sélecteur.

Pour sélectionner toutes les régions de toutes les 
pistes :

1  Sélectionnez le groupe d'édition All dans le 
menu déroulant de la liste des groupes.

2  Cliquez sur n'importe quelle piste avec le 
sélecteur et choisissez Edit >Select All.

– ou –

Cliquez trois fois sur n'importe quelle piste avec 
le sélecteur.

Option Region List Selection Follows 
Edit Selection

Lorsque l'option « Region List Selection Follows 
Track Selection » des préférences d'édition est 
activée, la sélection d'une région dans une piste 
sélectionne également la région dans la liste des 
régions.

Inversement, lorsque l'option Edit Selection 
Follows Region List Selection des préférences 
d'édition est active, la sélection d'une région 
dans la liste des régions sélectionne la première 
occurrence de cette région dans la piste.

Tout sélectionner à partir des règles 
temporelles

Pour sélectionner toutes les données de toutes 
les pistes audio et MIDI affichées :

1  Vérifiez que les sélections d'édition et de 
timeline sont liées.

2  Cliquez deux fois sur n'importe quelle règle 
temporelle. Toutes les régions de toutes les pistes 
audio et MIDI affichées sont sélectionnées. 
Les pistes masquées ne sont pas sélectionnées.

Pour sélectionner toutes les données de toutes 
les pistes, ainsi que les événements du chef 
d'orchestre :

1  Vérifiez que les sélections d'édition et de 
timeline sont liées.

2  Cliquez deux fois sur n'importe quelle règle 
temporelle en maintenant enfoncée la touche 
Option (Macintosh) ou Ctrl (Windows). Toutes 
les régions de toutes les pistes audio et MIDI 
affichées sont sélectionnées, ainsi que tous les 
événements dans chaque piste du chef 
d'orchestre.

Une autre façon de sélectionner toutes les 
régions de toutes les pistes, sans 
sélectionner le groupe d'édition All, consiste 
à appuyer sur Entrée (Windows) ou sur 
Retour (Macintosh), puis à cliquer 
simultanément sur Ctrl + A (Windows) ou 
sur Pomme + A (Macintosh). L'option Link 
Timeline and Edit Selection doit être 
activée.
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Réalisation de sélections pendant la 
lecture

Pro Tools permet d'effectuer des sélections à la 
volée à l'aide des touches fléchées Haut et Bas.

Pour réaliser une sélection pendant la lecture :

1  Sélectionnez Options > Link Timeline and 
Edit Selection.

2  A l'aide du sélecteur, cliquez au début de la 
piste dans laquelle vous voulez effectuer la 
sélection.

3  Pour commencer la lecture, cliquez sur le 
bouton de lecture de la fenêtre Transport.

4  Lorsque la lecture atteint le point où vous 
souhaitez que la sélection commence, appuyez 
sur la touche flèche en bas.

5  Appuyez sur la flèche vers le haut au point où 
vous voulez définir la fin de la sélection. La plage 
sélectionnée s'affiche en surbrillance.

6  Pour arrêter la lecture, cliquez sur Stop dans la 
fenêtre Transport.

Pour remonter automatiquement au début de la 
sélection (ou à l'emplacement du curseur à 
l'écran), appuyez sur la touche flèche à gauche. 
Appuyez sur la flèche à droite pour aller à la fin 
de la sélection.

En mode de défilement par page ou continu, le 
défilement est suspendu en cas de sélection sur 
la timeline ou dans la playlist pendant la lecture 
lorsque le curseur de lecture sort de l'image. Pour 
reprendre le défilement de la page et se 
positionner sur l'emplacement de lecture, 
cliquez sur le localisateur de curseur de lecture 
dans la règle temporelle principale (voir 
Recherche du curseur de lecture, page 329).

Sélection d'objets

L'outil de saisie d'objet permet de sélectionner 
des régions non contiguës sur une ou plusieurs 
pistes. Les sélections non contiguës doivent 
recouvrir des régions entières. Si vous souhaitez 
que des sélections non contiguës incluent une 
partie de région, commencez par transformer 
cette portion en région à part entière, à l'aide de 
la commande Separate Region (voir 
Commandes Separate Region, page 352).

Pour sélectionner des régions non contiguës :

1  Vérifiez que le mode d'édition est défini sur 
Slip ou sur Grid.

2  Cliquez sur le menu déroulant Grabber et 
sélectionnez Objet.

3  Cliquez sur chaque région que vous voulez 
inclure dans la sélection en appuyant sur Maj. 
Les régions peuvent même se trouver sur des 
pistes différentes.

Chaque région sur laquelle vous cliquez est 
entourée d'une bordure foncée qui indique 
qu'elle est sélectionnée.

L'outil de saisie d'objet n'est pas disponible 
lorsque le mode d'édition est réglé sur 
Shuffle ou sur Spot.

Outil de saisie d'objet

Sélection non contiguë
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L'outil de saisie d'objet ignore les groupes 
d'édition lorsque vous réalisez des sélections. Par 
exemple, sélectionner une région sur une piste 
groupée ne sélectionne pas les régions des autres 
pistes du groupe.

Sélections de temps et d'objet

Vous pouvez convertir des sélections de temps et 
d'objet. Les sélections de temps s'effectuent avec 
le sélecteur et l'outil d'accrochage de temps. Les 
sélections d'objet s'effectuent avec l'outil de 
saisie d'objet.

La conversion en sélection d'objet est utile 
lorsque vous travaillez avec des sélections 
importantes, en particulier avec plusieurs pistes 
et que vous souhaitez supprimer certaines 
régions de la sélection.

La conversion en sélection de temps est utile 
lorsque vous souhaitez sélectionner toutes les 
régions entre deux sélections d'objet non 
contiguës.

Pour convertir une sélection de temps en 
sélection d'objet :

1  Faites glisser le sélecteur dans n'importe quelle 
piste pour définir une sélection ou sélectionnez 
une règle temporelle pour sélectionner dans 
toutes les pistes.

2  Une fois l'outil de saisie d'objet sélectionné, 
cliquez deux fois sur l'icône d'accrochage dans la 
barre d'outils. Les régions comprises dans la 
plage de sélection sont alors sélectionnées en 
tant qu'objets. Les régions partiellement 
sélectionnées sont désélectionnées.

Pour sélectionner des régions partiellement 
sélectionnées, appuyez sur la touche Ctrl tout en 
cliquant deux fois sur l'icône d'accrochage.

Pour convertir une sélection d'objet en sélection 
de temps :

1  Sélectionnez le nombre de régions désiré avec 
l'outil de saisie d'objet.

2  Cliquez deux fois sur le sélecteur dans la barre 
d'outils. La plage de temps qui sépare la 
première et la seconde région est sélectionnée.

Si vous utilisez l'outil de saisie d'objet pour des 
pistes appartenant à un groupe d'édition, les 
régions des autres pistes du groupe sont 
sélectionnées si elles se trouvent dans la plage de 
la région sélectionnée.

Modification de la durée d'une 
sélection

La plage de sélection peut être raccourcie ou 
prolongée ; ceci n'affecte pas les données de la 
sélection.

Pour changer la durée d'une sélection, effectuez 
l'une des opérations suivantes :

■ A l'aide du sélecteur, placez le curseur à l'une 
des extrémités de la sélection courante et cliquez 
en appuyant sur Maj ou déplacez-vous vers la 
gauche ou la droite en appuyant sur Maj.

Régions sélectionnées

Régions sélectionnées en tant qu'objets
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■ Dans la règle temporelle principale, faites 
glisser le marqueur de lecture vers le début ou la 
fin de la sélection.

■ Lorsque les sélections d'édition et de timeline 
ne sont pas liées, faites glisser les marqueurs 
d'édition (voir Figure 12, page 333) pour 
modifier la durée de la sélection.

Pour effectuer une sélection longue :

1  A l'aide du sélecteur, cliquez à l'endroit où 
vous souhaitez que commence la sélection.

2  Déplacez le curseur jusqu'au point de fin et 
cliquez à l'endroit où vous souhaitez que finisse 
la sélection. 

Pour vérifier les points de début et de fin d'une 
sélection longue, appuyez sur la touche flèche à 
gauche pour retourner au début de la sélection 
ou sur la touche flèche à droite pour aller à la fin 
de la sélection.

Déplacement par incrément d'une plage 
de sélection

La plage de sélection (mais pas les données de la 
sélection) peut être déplacée d'une valeur de 
déplacement par incréments.

Pour déplacer une plage de sélection par 
incrément :

1  Configurez la valeur de déplacement par 
incrément. Pour en savoir plus, reportez-vous à 
la section Définition de la valeur de 
déplacement par incrément, page 369.

2  Effectuez la sélection initiale avec le sélecteur.

3  Tout en appuyant sur Maj, appuyez sur Plus 
(+) ou Moins (–) sur le pavé numérique pour 
déplacer la plage de sélection de la valeur de 
l'incrément.

Déplacement par incréments des points 
de début et de fin de la sélection

Vous pouvez déplacer par incrément les points 
de début et de fin des sélections.

Pour déplacer le point de début ou de fin de la 
valeur de déplacement par incrément :

1  Configurez la valeur de déplacement par 
incrément. Pour en savoir plus, reportez-vous à 
la section Définition de la valeur de 
déplacement par incrément, page 369.

2  Effectuez la sélection initiale avec le sélecteur.

3  Tout en appuyant sur Option + Maj 
(Macintosh) ou sur Alt + Maj (Windows), 
appuyez sur Plus (+) ou Moins (–) sur le pavé 
numérique pour déplacer le début de la 
sélection de la valeur de l'incrément.

– ou –

Tout en appuyant sur Pomme + Maj 
(Macintosh) ou sur Ctrl + Maj (Windows), 
appuyez sur Plus (+) ou Moins (–) sur le pavé 
numérique pour déplacer la fin de la sélection de 
la valeur de l'incrément.

Déplacement d'un marqueur de lecture
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Extension des sélections

Vous pouvez étendre des sélections aux points 
de début et de fin de la région pour inclure une 
région adjacente ou aux marqueurs et aux 
emplacements mémoire.

Pour étendre une sélection jusqu'au point de 
début ou de fin d'une région :

1  A l'aide du sélecteur, sélectionnez une partie 
d'une région ou cliquez n'importe où dans la 
région.

2  Appuyez sur Maj + Tab pour étendre la 
sélection au point de fin de la région.

– ou –

Appuyez sur Maj + Option + Tab (Macintosh) ou 
sur Maj + Ctrl + Tab (Windows) pour étendre la 
sélection au point de début de la région.

Pour étendre une sélection et inclure une région 
adjacente :

1  Sélectionnez la première région à l'aide de 
l'outil d'accrochage de temps.

2  L'option Tab to Transients étant désactivée, 
appuyez sur Maj +Démarrer + Tab (Windows) 
ou Maj + Contrôle + Tab (Macintosh) pour 
étendre la sélection à la limite de la région 
suivante.

– ou –

Pour étendre la sélection et inclure la limite de la 
région précédente, appuyez sur Maj + Contrôle 
+Option + Tab (Macintosh) ou sur Maj + 
Démarrer + Ctrl + Tab (Windows).

Pour étendre une sélection à un marqueur ou à un 
emplacement mémoire :

1  Cliquez dans une piste avec le sélecteur sur le 
point de début ou de fin souhaité.

– ou –

Effectuez une sélection avec le sélecteur ou 
l'outil d'accrochage de temps.

2  Cliquez sur un marqueur dans la règle des 
marqueurs tout en appuyant sur Maj.

– ou –

Cliquez sur un emplacement mémoire dans la 
fenêtre Memory Locations tout en appuyant 
sur Maj.

La sélection est étendue depuis le point 
d'insertion d'origine jusqu'au marqueur ou à 
l'emplacement mémoire.

Utilisation des indicateurs de 
sélection (Start, End et Length)

Les indicateurs de sélection d'édition situés en 
haut de la fenêtre Edit peuvent définir des 
sélections d'édition précises. Les valeurs de 
temps des indicateurs de sélection d'édition 
utilisent le format temporel de l'échelle 
temporelle principale.

Pour effectuer une sélection avec les indicateurs 
de sélection d'édition :

1  Avec le sélecteur, cliquez sur la piste que vous 
voulez sélectionner.

2  Cliquez dans le champ Start en haut de la 
fenêtre Edit.

Indicateurs de sélection d'édition
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3  Saisissez le point de début de la sélection et 
appuyez sur la barre oblique (/) pour entrer la 
valeur et passer automatiquement au champ de 
fin.

4  Saisissez le point de fin de la sélection et 
appuyez sur Entrée pour accepter la valeur.

Raccourcis de saisie numérique pour les 
indicateurs de sélection

Les raccourcis suivants sont à votre disposition 
pour entrer les valeurs dans les indicateurs de 
sélection d'édition :

• Appuyez sur la touche / (barre oblique) pour 
naviguer dans les trois indicateurs de sélection 
d'édition.

• Utilisez la touche point (.) ou les flèches droite 
et gauche pour vous déplacer dans les champs 
temporels de chaque indicateur de sélection 
d'édition.

• Utilisez les flèches haut et bas pour augmenter 
ou réduire les valeurs numériques.

• Tirez sur un champ sélectionné en 
maintenant enfoncée la touche Pomme 
(Macintosh) ou Ctrl (Windows) pour faire 
défiler une nouvelle valeur.

• Appuyez sur Plus (+) ou Moins (–) avec un 
nombre à ajouter ou à soustraire de la valeur 
du champ.

Par exemple, pour ajouter 10 à la valeur 
courante d'un champ, naviguez dans le champ, 
appuyez sur la touche Plus (+), tapez 10 et 
appuyez sur Entrée.

■ Appuyez sur esc ou Echap pour quitter les 
indicateurs de sélection d'édition sans entrer de 
nouvelle valeur.

Mode calculatrice

Vous pouvez éditer les valeurs de style 
calculatrice dans les indicateurs de sélection 
d'édition.

Pour soustraire des valeurs temporelles :

1  Dans l'indicateur de sélection d'édition, placez 
en surbrillance le champ que vous voulez 
modifier.

2  Appuyez sur Moins (–) sur le pavé numérique.

3  Tapez la quantité à soustraire de la valeur de 
temps courante et appuyez sur Entrée.

4  Appuyez de nouveau sur Entrée pour 
appliquer la modification.

Pour ajouter des valeurs temporelles :

1  Dans l'indicateur de sélection d'édition, placez 
en surbrillance le champ que vous voulez 
modifier.

2  Appuyez sur Plus (+) sur le pavé numérique.

3  Tapez la quantité à ajouter à la valeur de temps 
courante et appuyez sur Entrée.

4  Appuyez de nouveau sur Entrée pour 
appliquer la modification.

Ces raccourcis servent également à entrer les 
valeurs de début et de fin dans la fenêtre 
Transport.
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Sélection sur plusieurs pistes

Pour effectuer des éditions sur plusieurs pistes 
ou sur toutes les pistes, vous devez d'abord les 
sélectionner. Pour ce faire, il suffit d'inclure 
d'autres pistes à la sélection ou d'effectuer une 
sélection dans une règle temporelle (pour toutes 
les pistes).

Pour effectuer une sélection sur plusieurs pistes :

A l'aide du sélecteur, cliquez et faites défiler 
verticalement pour inclure les pistes adjacentes 
d'une sélection (faites défiler horizontalement 
pour définir la plage temporelle). 

Pour étendre une sélection à une autre piste :

1  A l'aide du sélecteur ou de l'outil d'accrochage 
de temps, effectuez une sélection dans la 
première piste ou dans les pistes.

2  Cliquez sur d'autres pistes avec le sélecteur en 
appuyant sur Maj. Une plage identique est 
sélectionnée sur chaque piste supplémentaire.

Pour raccourcir ou allonger la sélection sur 
chacune des pistes, appuyez sur Maj tout en 
déplaçant le sélecteur pour modifier l'étendue 
de la sélection.

Pour effectuer une sélection sur toutes les pistes :

■ Activez All Edit Group et effectuez une 
sélection dans n'importe quelle piste.

– ou –

■ A l'aide du sélecteur, faites défiler une règle 
temporelle (vérifiez que les sélections d'édition 
et de timeline sont liées).

Ces sélections incluent toutes les pistes de la 
fenêtre Edit, mais n'incluent pas les pistes du 
chef d'orchestre (tempo, métrique et 
marqueurs).

Pour effectuer une sélection sur toutes les pistes, 
y compris les pistes du chef d'orchestre (pour 
tempo, métrique et marqueurs) :

■ Déplacez le sélecteur dans n'importe quelle 
règle temporelle en maintenant enfoncée la 
touche Option (Macintosh) ou Alt (Windows).

Déplacement et extension de 
sélections entre pistes

Lorsque le focus clavier sur les commandes est 
actif, les sélections d'édition peuvent être 
déplacées ou étendues vers les pistes adjacentes.

Pour déplacer une sélection vers une piste 
adjacente :

1  Activez le focus clavier sur les commandes en 
cliquant sur le bouton en haut et à gauche de la 
fenêtre Edit.

2  A l'aide du sélecteur ou de l'outil d'accrochage 
de temps, effectuez une sélection.

3  Appuyez sur P sur le clavier de votre 
ordinateur pour déplacer la sélection vers la 
piste précédente.

– ou –

Appuyez sur le point-virgule (;) pour déplacer la 
sélection vers la piste suivante.

Dans les deux cas, la sélection d'édition 
d'origine est désélectionnée.

Bouton de focus clavier sur les commandes activé
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Pour étendre une sélection à une piste adjacente :

1  Activez le focus clavier sur les commandes

2  A l'aide du sélecteur ou de l'outil d'accrochage 
de temps, effectuez une sélection.

3  Appuyez sur Maj + P pour étendre la sélection 
à la piste précédente.

– ou –

Appuyez sur Maj + point-virgule pour étendre la 
sélection à la piste suivante.

Dans les deux cas, la sélection d'édition 
d'origine reste sélectionnée.

Pour supprimer la piste du bas d'une sélection :

■ Appuyez sur Contrôle + Option + point-
virgule (Macintosh) ou sur Démarrer + Alt + 
point-virgule (Windows) pour supprimer la 
piste du bas.

Autres techniques de sélection 
utiles

La section suivante présente d'autres techniques 
de sélection.

Pour placer le curseur d'édition précisément au 
point de début, de fin ou de synchronisation d'une 
région :

1  Vérifiez que le bouton de tabulation vers 
transitoire n'est pas activé. Reportez-vous à la 
section Tabulation vers transitoires, page 343.

2  Cliquez avec le sélecteur dans la piste.

3  Appuyez sur la touche de tabulation (Tab) 
pour déplacer le curseur sur le point de début, de 
fin ou de synchronisation de la région suivante 
ou du groupe de régions suivant.

– ou –

Appuyez sur Option + Tab (Macintosh) ou sur 
Ctrl + Tab (Windows) pour déplacer le curseur 
sur le point de début, de fin ou de 
synchronisation de la région précédente ou du 
groupe de régions précédent. 

Pour effectuer une sélection avec l'outil de 
scrubbing :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation.

2  Sélectionnez l'option Edit Insertion Follows 
Scrub/Shuttle, puis cliquez sur Done.

3  Déplacez l'outil de scrubbing pour repérer un 
point de début approprié de la sélection, puis 
relâchez-le.

4  Tout en appuyant sur Maj, déplacez l'outil de 
scrubbing pour repérer un point de fin approprié 
de la sélection, puis relâchez-le. La plage qui 
sépare le scrub initial et final est sélectionnée.

Pour déplacer la sélection vers la piste 
précédente, appuyez sur Control + P 
(Macintosh) ou sur Démarrer + P 
(Windows) avec le focus clavier sur les 
commandes activé ; pour déplacer la 
sélection vers la piste suivante, appuyez sur 
Control + (;) (Macintosh) ou sur Démarrer + 
(;) (Windows).

Pour étendre la sélection à la piste 
précédente, appuyez sur Maj + Control + P 
(Macintosh) ou sur Maj + Démarrer + P 
(Windows) avec le focus clavier sur les 
commandes activé ; pour étendre la 
sélection à la piste suivante, appuyez sur 
Maj + Control + (;) (Macintosh) ou sur Maj 
+ Démarrer + (;) (Windows).
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Pour déplacer une sélection vers une région 
adjacente de la même piste :

1  Sélectionnez une région avec l'outil 
d'accrochage de temps

2  Pour déplacer la sélection vers la région 
suivante, appuyez sur Contrôle + Tab 
(Macintosh) ou sur Démarrer + Tab (Windows). 

– ou –

Pour déplacer la sélection vers la région 
précédente, appuyez sur Contrôle + Option + 
Tab (Macintosh) ou sur Démarrer + Ctrl + Tab 
(Windows).

Dans les deux cas, la région d'origine est 
désélectionnée.

Pour faire glisser une sélection d'édition dans la 
règle temporelle principale :

1  A l'aide du sélecteur ou de l'outil d'accrochage 
de temps, effectuez une sélection.

2  Tout en appuyant sur Option (Macintosh) ou 
sur Alt (Windows), déplacez le curseur sur l'un 
des marqueurs de lecture de la règle (l'outil 
d'accrochage de temps apparaît).

3  Faites glisser le curseur vers la gauche ou la 
droite pour avancer ou reculer temporellement 
la sélection d'édition, tout en conservant sa 
durée.

Lorsque les sélections d'édition et de timeline 
sont séparées, faites glisser les marqueurs 
d'édition en appuyant sur Option (Macintosh) 
ou sur Alt (Windows).

Tabulation vers transitoires

L'option Tab to Transients vous permet de 
naviguer automatiquement vers les transitoires 
dans les formes d'onde audio, en plaçant le 
curseur juste avant le pic de transitoire détecté. 
Vous pouvez ainsi définir facilement des 
sélections et des plages de lecture, ainsi que des 
points de début et de fin pour de nouvelles 
régions, sans devoir effectuer de zoom avant sur 
la forme d'onde.

Lorsque l'option de tabulation vers transitoires 
est active, la fonction de tabulation repère 
également les points de début, de fin mais pas de 
synchronisation de la région.

Pour définir les points de début et de fin d'une 
sélection avec l'option de tabulation vers 
transitoires :

1  En haut et à gauche de la fenêtre Edit, cliquez 
sur le bouton de tabulation vers transitoires 
pour le sélectionner.

2  Si vous comptez définir la plage de lecture 
avec cette sélection, sélectionnez Options > Link 
Timeline and Edit Selection.

3  Cliquez sur la piste audio juste avant le début 
des données que vous voulez sélectionner.

4  Appuyez plusieurs fois sur Tab jusqu'à ce que 
le curseur se positionne sur le transitoire de 
début de la sélection.

Si nécessaire, vous pouvez vous déplacer sur le 
transitoire précédent en appuyant sur Option + 
Tab (Macintosh) ou sur Ctrl + Tab (Windows).

Glissement d'une sélection d'édition dans la règle 
temporelle principale

Bouton de tabulation vers transitoires activé
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5  Appuyez sur Maj + Tab jusqu'à ce que le 
curseur se positionne à la fin des données à 
sélectionner.

Pour déplacer le point de fin de la sélection sur 
le transitoire précédent, appuyez sur Maj + 
Contrôle + Tab (Macintosh) ou sur Maj + Ctrl + 
Tab (Windows).

Une fois sélectionnées, les données peuvent être 
mises en boucle pour l'enregistrement ou la 
lecture, ou transformées en nouvelle région avec 
les commandes Separate ou Capture.

Lecture des sélections
Après avoir effectué une sélection d'édition, 
vous pouvez l'écouter en cliquant sur Play dans 
la fenêtre Transport. S'ils sont activés, les pré et 
post-roll sont lus également.

Pour lire une sélection :

1  Sélectionnez Options > Link Timeline and 
Edit Selection.

2  A l'aide du sélecteur ou de l'outil d'accrochage 
de temps, effectuez une sélection de piste.

3  Si vous souhaitez utiliser les pré/post-roll, 
activez-les et définissez leurs paramètres. Pour 
en savoir plus, reportez-vous à la section 
Définition des paramètres de pré et post-roll, 
page 225.

4  Cliquez sur le bouton de lecture dans la 
fenêtre Transport ou appuyez sur la barre 
d'espace.

La plage de sélection est lue sur toutes les pistes, 
y compris les pré- et post-roll s'ils sont actifs.

Pour lire une sélection d'édition, option Link 
Timeline and Edit Selection activée :

■ Avec Pro Tools HD, choisissez Edit > 
Selection > Play Edit.

– ou –

■ Avec Pro Tools LE ou Pro Tools M-Powered, 
choisissez Edit > Play Edit Selection.

Pour lire une sélection de timeline, option Link 
Timeline and Edit Selection désactivée (Pro Tools 
HD uniquement) :

■ Choisissez Edit > Selection > Play Timeline.

Ecoute des pré et post-roll

Vous pouvez écouter et lire uniquement les 
données correspondant au pré-roll ou au post-
roll d'une sélection.

Pour lire à partir du point de pré-roll jusqu'au début 
de la sélection ou jusqu'à l'emplacement actuel 
du curseur :

■ Appuyez sur Option + flèche à gauche 
(Macintosh) ou sur Alt + flèche à gauche 
(Windows).

Pour lire jusqu'au point de post-roll depuis la fin de 
la sélection ou depuis l'emplacement actuel du 
curseur :

■ Appuyez sur Pomme + flèche à droite 
(Macintosh) ou sur Ctrl + flèche à droite 
(Windows).

Les crêtes des transitoires sont généralement 
visibles dans la forme d'onde. Cependant, 
certains transitoires basse fréquence 
peuvent ne pas apparaître sous forme de 
crêtes visibles dans la forme d'onde.
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Ecoute des points de début et de fin des 
sélections

Il peut arriver que vous souhaitiez écouter le 
début ou la fin d'une sélection audio sans pour 
autant entendre la sélection complète. Par 
exemple, pour vérifier si le début ou la fin d'une 
sélection inclut des clics indésirables.

Pour écouter le point de début d'une sélection :

■ Appuyez sur Pomme + flèche à gauche 
(Macintosh) ou sur Ctrl + flèche à gauche 
(Windows).

Lors de l'écoute du début d'une sélection, celle-
ci est lue depuis le point de début pendant une 
durée égale à la quantité de post-roll.

Pour écouter le point de début d'une sélection 
avec le pré-roll :

■ Appuyez sur Pomme + Option + flèche à 
gauche (Macintosh) ou sur Ctrl + Alt + flèche à 
gauche (Windows).

Pour écouter le point de fin d'une sélection :

■ Appuyez sur Option + flèche à droite 
(Macintosh) ou sur Alt + flèche à droite 
(Windows).

Lorsque vous écoutez la fin d'une sélection, la 
lecture commence avant le point de fin, de la 
durée de pré-roll.

Pour écouter le point de fin d'une sélection avec le 
post-roll :

■ Appuyez sur Pomme + Option + flèche à 
droite (Macintosh) ou sur Ctrl + Alt + flèche à 
droite (Windows).

Lecture en boucle

Lorsque l'option Loop Playback est active, la 
région sélectionnée sur la piste est lue en boucle. 
S'il n'y a aucune sélection, la lecture se déroule 
normalement à partir de l'emplacement actuel 
du curseur. 

La lecture en boucle permet notamment de 
vérifier la continuité rythmique d'une sélection 
de données musicales. Si vous travaillez avec des 
sélections d'une mesure, une lecture en boucle 
permet de vérifier si le bouclage n'est pas 
perceptible. Si vous avez l'impression d'une 
discontinuité rythmique, ajustez la durée de la 
sélection jusqu'à obtenir la « musicalité » 
recherchée dans le contexte de la playlist et des 
autres pistes.

Pour lire une sélection en boucle :

1  Sélectionnez Options > Link Timeline and 
Edit Selection.

2  A l'aide du sélecteur, sélectionnez la plage de 
la piste à lire en boucle.

Plages de lecture pour l'audition des points de début et 
de fin

joue le début
(pendant la durée de post-roll)

lit le pré-roll + le début

joue la fin (pendant 
la durée de pré-roll)

lit la fin + le post-roll

Une sélection doit durer au moins 500 ms 
pour pouvoir être lue en boucle.
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3  Sélectionnez Options > Loop Playback. 
Lorsque l'option est activée, un symbole de 
boucle s'inscrit dans le bouton Lecture de la 
fenêtre Transport.

– ou –

Vous pouvez également activer la lecture en 
boucle en procédant comme suit :

• Cliquez sur le bouton Lecture en 
maintenant enfoncées les touches Pomme 
(Macintosh) ou Ctrl (Windows). 

• Lorsque le mode du pavé numérique est 
réglé sur Transport, appuyez sur 4 sur le 
pavé numérique.

4  Cliquez sur le bouton de lecture dans la 
fenêtre Transport.

La lecture commence à partir du point de pré-
roll (si le pré-roll est activé) et se poursuit 
jusqu'au point de fin de la sélection, où la 
lecture revient au point de départ.

5  Cliquez sur le bouton d'arrêt de la fenêtre 
Transport pour arrêter la lecture.

Lecture en boucle et enregistrement 
audio

Même si l'option Loop Playback est active, 
Pro Tools ne fonctionne pas en boucle lorsqu'on 
tente d'enregistrer des pistes audio en modes 
QuickPunch, Destructive Record ou 
Nondestructive Record.

Pour enregistrer en boucle des pistes audio dans 
Pro Tools, vous devez activer le mode Loop 
Record (voir Enregistrement audio en boucle, 
page 218).

Sélections de timeline
Lorsque l'option des sélections d'édition et de 
timeline est désactivée, vous pouvez effectuer 
dans la timeline des sélections distinctes des 
sélections d'édition.

Lorsque les sélections d'édition et de timeline 
sont liées, les sélections d'édition effectuées sont 
reflétées dans la timeline.

Que les sélections d'édition et de timeline soient 
liées ou non, la plage indiquée par les marqueurs 
de lecture détermine toujours la plage de lecture 
et d'enregistrement.

Avec Pro Tools HD, lorsque l'option de 
défilement est réglée sur Center Playhead, elle 
détermine où commence la lecture. Pour en 
savoir plus, reportez-vous à la section Lecture 
des sélections d'édition et de timeline avec la 
tête de lecture, page 349.

Pour effectuer une sélection de timeline avec le 
sélecteur :

1  Si vous le souhaitez, réglez le mode d'édition 
sur Grid pour restreindre la sélection en 
fonction du pas de grille actuel. 

2  Faites glisser le sélecteur dans n'importe quelle 
timeline.

Lecture en boucle activée

Réalisation d'une sélection de timeline avec le 
sélecteur
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La sélection de timeline est indiquée dans la 
règle temporelle principale par les marqueurs de 
lecture bleus (rouges si la piste est active en 
enregistrement). Le début, la fin et la durée 
correspondant à la sélection de timeline 
apparaissent dans les champs correspondants de 
la fenêtre Transport.

Pour définir la sélection de timeline en déplaçant 
les marqueurs de lecture :

1  Si vous le souhaitez, réglez le mode d'édition 
sur Grid pour restreindre le mouvement en 
fonction du pas de grille actuel. 

2  A l'aide de l'outil d'accrochage de temps, 
déplacez le premier marqueur de lecture (flèche 
en bas) sur le point de début.

3  Déplacez le second marqueur de lecture 
(flèche en haut) sur le point de fin.

Pour définir la sélection de timeline dans la fenêtre 
Transport :

1  Si nécessaire, redimensionnez la fenêtre 
Transport en cliquant en haut et à droite pour 
afficher les temps de début et de fin.

2  Dans la fenêtre Transport, cliquez sur le 
champ Start.

– ou –

Appuyez sur Alt + barre oblique (/) (Windows) 
ou sur Option + barre oblique (/) (Macintosh) 
sur le pavé numérique pour sélectionner le 
champ Start de la fenêtre Transport.

3  Tapez le nouvel emplacement de début et 
appuyez sur la barre oblique (/) pour entrer la 
valeur et passer automatiquement au champ 
End.

4  Tapez le nouvel emplacement de fin et 
appuyez sur Entrée pour accepter la valeur.

Déplacement d'une sélection de 
timeline

De même que les sélections d'édition, les 
sélections de timeline peuvent être déplacées 
dans la règle temporelle principale.

Pour déplacer une sélection de timeline dans la 
règle temporelle principale :

1  Tout en appuyant sur Option (Macintosh) ou 
sur Alt (Windows), déplacez le curseur sur l'un 
des marqueurs de lecture (l'outil d'accrochage de 
temps apparaît).

2  Faites glisser le curseur vers la gauche ou la 
droite pour avancer ou reculer dans le temps la 
sélection de timeline, tout en conservant sa 
durée.

Pour sélectionner toutes les pistes, y compris 
celles du chef d'orchestre, appuyez sur 
Option (Macintosh) ou sur Alt (Windows) 
tout en déplaçant le sélecteur dans la règle 
temporelle.

Déplacement d'un marqueur de lecture

Les raccourcis pour entrer les valeurs de 
début et de fin dans la fenêtre Transport 
sont rassemblés dans la section 
Raccourcis de saisie numérique pour les 
indicateurs de sélection, page 340.
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Copie des sélections de timeline vers 
ou à partir de sélections d'édition

(Pro Tools HD uniquement)

Lorsque les sélections d'édition et de timeline ne 
sont pas liées, vous pouvez copier des sélections 
entre elles.

Pour copier une sélection d'édition vers la 
timeline :

■ Choisissez Edit > Selection > Change Edit to 
Match Timeline.

Pour copier une sélection de timeline vers une 
sélection d'édition :

■ Choisissez Edit > Selection > Change Timeline 
to Match Edit.

Edition TCE (Time 
Compression and Expansion, 
compression/expansion 
temporelle) et sélection de 
timeline
(Pro Tools HD uniquement)

Lorsque les sélections d'édition et de timeline 
sont séparées, vous pouvez rétrécir ou étendre 
temporellement une sélection audio pour 
qu'elle corresponde à une sélection de timeline. 
Cette fonction est assurée par le plug-in Time 
Compression/Expansion, qui permet d'étendre 
ou de compresser les données audio 
sélectionnées.

Pour faire correspondre une sélection d'édition à 
la timeline :

1  Désélectionnez > Link Timeline and Edit 
Selection.

2  A l'aide du sélecteur, sélectionnez les données 
audio à compresser ou à étendre.

3  Dans n'importe quelle règle temporelle, 
sélectionnez la plage de temps dans laquelle 
vous voulez inscrire les données audio.

4  Choisissez Edit > TCE Edit to Timeline 
Selection. La sélection d'édition est compressée 
ou étendue à la durée de la sélection de timeline.

Compression ou extension de la 
sélection d'édition selon la sélection 
de timeline pour plusieurs pistes et 
canaux

La commande TCE Edit to Timeline est 
applicable à des sélections multicanaux et à des 
sélections sur plusieurs pistes.

Cependant, toutes les régions sont compressées 
ou étendues de façon égale avec la même valeur 
en pourcentage, basée sur la plage de sélection 
d'édition. Ceci garantit que la relation 
rythmique entre les différents canaux ou les 
différentes pistes est conservée.
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Correspondance d'une région 
audio avec une sélection d'édition

Les régions peuvent être déplacées de la liste des 
régions pour s'inscrire dans une sélection 
d'édition. La région déplacée est compressée ou 
étendue à la durée de la sélection. Cette fonction 
est mise en œuvre par le plug-in Time 
Compression/Expansion pour étendre ou 
compresser la région audio.

Pour faire correspondre une région audio à une 
sélection d'édition :

1  A l'aide du sélecteur, sélectionnez la plage de 
temps désirée dans une piste audio.

2  Faites glisser la région depuis la liste des 
régions vers la piste où vous avez effectué la 
sélection, en maintenant enfoncées les touches 
Pomme - Option (Macintosh) ou Ctrl - Alt 
(Windows). Le début de la région est placé au 
début de la sélection, et la région voit sa durée 
compressée ou étendue pour correspondre à 
celle de la sélection.

Correspondance à la sélection sur 
plusieurs pistes et canaux

La commande Fit to Selection permet de faire 
glisser plusieurs régions de la liste des régions 
vers plusieurs pistes ou vers des pistes 
multicanaux.

Cependant, toutes les régions déplacées sont 
alors compressées ou étendues de façon 
identique, du même pourcentage, basé sur la 
durée de la dernière région sur laquelle vous 
avez cliqué avant d'effectuer le déplacement.

Lecture des sélections 
d'édition et de timeline avec 
la tête de lecture
(Pro Tools HD uniquement)

Lorsque l'option de défilement est réglée sur 
Center Playhead, les sélections dans la timeline 
ne déterminent pas où commence la lecture. 
La tête de lecture, par elle-même, indique où 
commence la lecture lorsque vous cliquez sur 
Play dans la fenêtre Transport.

Les sélections de timeline et d'édition peuvent 
encore être lues lorsque la tête de lecture est 
activée.

Pour lire une sélection d'édition avec la tête de 
lecture

1  Désélectionnez Options > Link Timeline and 
Edit Selections.

2  Sélectionnez Options > Scrolling > Center 
Playhead.

3  A l'aide du sélecteur ou de l'outil d'accrochage 
de temps, effectuez une sélection de piste.

4  Choisissez Edit > Selection > Play Edit.

La tête de lecture saute jusqu'à la sélection 
d'édition et lit celle-ci du début à la fin, puis 
s'arrête.

Pour lire une sélection de timeline avec la tête de 
lecture

1  Désélectionnez Options > Linked Timeline 
and Edit Selections.

2  Sélectionnez Options > Scrolling > Center 
Playhead.

3  Faites glisser le sélecteur dans n'importe quelle 
règle temporelle pour définir la plage de lecture.
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4  Choisissez Edit > Selection > Play Timeline.

La tête de lecture saute jusqu'à la sélection de 
timeline et lit celle-ci du début à la fin, puis 
s'arrête.

Déplacement de la tête de lecture

Lorsque l'option de défilement Center Playhead 
est activée, la tête de lecture peut être déplacée 
en avant ou en arrière, vers la limite suivante de 
la région dans la piste sélectionnée.

Pour déplacer la tête de lecture vers les limites 
d'une région :

1  Vérifiez que le bouton de tabulation vers 
transitoire n'est pas activé (voir Tabulation vers 
transitoires, page 343).

2  Cliquez avec le sélecteur dans la piste.

3  Appuyez sur la touche de tabulation pour 
déplacer la tête de lecture en avant vers la limite 
de la région suivante.

– ou –

Pour déplacer la tête de lecture en arrière à la 
limite de la région précédente, appuyez sur 
Option + Tab (Macintosh) ou sur Ctrl + Tab 
(Windows).
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Chapitre 17 : Utilisation des régions et 
des sélections

Les régions constituent les composants 
élémentaires permettant d'organiser les sources 
audio et MIDI dans Pro Tools. Pour profiter 
pleinement des fonctions d'édition offertes par 
Pro Tools, il est essentiel de bien comprendre les 
processus de création, de modification et 
d'organisation des régions.

Ce chapitre aborde les fonctions d'édition 
fondamentales qui s'appliquent aux régions et 
groupes de régions, ainsi que les sélections qui 
concernent, dans la majorité des cas, les 
données audio et/ou MIDI.

Création de régions
Pro Tools offre plusieurs commandes pour créer 
des régions et des groupes de régions, chacune 
ayant un effet légèrement différent sur la 
sélection. Lorsque vous créez une région ou un 
groupe de régions, il ou elle s'affiche dans la liste 
des régions et dans la playlist de la piste. Pour 
plus de détails sur l'attribution automatique de 
nom de ces nouvelles régions, consultez la 
section Options de désignation automatique, 
page 421

Lors de la création d'une région à partir d'une 
région existante, la région d'origine reste dans la 
liste des régions.

Commande Capture Region

La commande Capture Region définit une 
sélection en tant que nouvelle région et l'ajoute 
à la liste des régions. A partir de là, vous pouvez 
faire glisser la nouvelle région vers des pistes 
existantes.

Pour capturer une nouvelle région :

1  A l'aide du sélecteur, cliquez dans une région 
existante et sélectionnez les données de la 
nouvelle région.

2  Choisissez Region > Capture.

3  Donnez un nom à la nouvelle région et 
cliquez sur OK.

La nouvelle région apparaît dans la liste des 
régions. La région d'origine n'est pas modifiée.

Pour plus d'informations sur les procédures 
d'édition spécifiques aux données MIDI, 
reportez-vous au Chapitre 22, Edition 
MIDI.

Sélection d'une partie de région
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Commandes Separate Region

Les commandes Separate Region définissent une 
sélection, à l'intérieur d'une région existante ou 
d'une région partiellement sélectionnée, en tant 
que nouvelle région et la séparent des données 
adjacentes. 

Il existe trois commandes Separate Region :

At Selection : crée de nouvelles limites de région 
aux points de début et de fin de la sélection.

On Grid : crée des régions en fonction de la 
résolution de grille actuelle.

At Transients : crée automatiquement des 
limites de région en fonction des transitoires 
détectés dans une sélection. Cette commande et 
l'option de tabulation vers transitoires utilisent 
le même algorithme.

S'il n'existe aucune sélection et que le curseur 
d'édition est placé dans la région, cette dernière 
est divisée en deux nouvelles régions au point 
d'insertion.

Pour séparer une ou plusieurs régions :

1  Faites glisser le sélecteur pour sélectionner les 
données de la ou des nouvelle(s) région(s). 
La sélection peut se trouver à l'intérieur d'une 
même région, sur des régions adjacentes de la 
même piste ou englober plusieurs pistes.

– ou –

Cliquez avec le sélecteur sur le point d'une 
région où vous souhaitez créer une séparation.

2  Choisissez Edit > Separate Region > At 
Selection.

– ou –

Appuyez sur Ctrl+E (Windows) ou sur Pomme+E 
(Macintosh).

3  Si l'option Auto-Name Separated Regions des 
préférences d'édition n'est pas active, entrez le 
nom de la nouvelle région à l'invite, puis cliquez 
sur OK.

Les nouvelles régions s'affichent dans les pistes 
dans lesquelles elles ont été créées, isolées des 
données qui les entourent. Elles apparaissent 
également dans la liste des régions. 

Pour séparer des régions en fonction de la 
résolution de grille actuelle.

1  Sélectionnez les régions à éditer.

2  Choisissez Edit > Separate Region > On Grid.

Pour séparer des régions aux transitoires :

1  Sélectionnez les régions à éditer.

2  Choisissez Edit > Separate Region > At 
Transients.

Option Auto-Name Separated Regions

Lorsque l'option Auto-Name Separated Regions 
de la page des préférences d'édition est 
sélectionnée, Pro Tools attribue 
automatiquement des noms aux régions 
séparées. Le nom est une variation chiffrée du 
nom de la région d'origine.

Lorsque vous séparez une région, d'autres 
régions sont créées automatiquement à partir 
des données situées de part et d'autre de la 
séparation ; les noms de ces régions reçoivent 
chacun un numéro. La région d'origine n'est pas 
modifiée dans la liste des régions.
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Séparation sur plusieurs pistes

La Figure 13 illustre une séparation sur trois 
pistes audio mono et une piste stéréo. Pour 
certaines pistes, la sélection se trouve dans une 
région, tandis que d'autres se trouvent au début 
ou à la fin d'une région.

Une fois séparées, ces données se déplacent ou 
se copient facilement vers un autre 
emplacement.

Outil de séparation

L'outil de séparation permet de séparer 
automatiquement une sélection d'édition et de 
la déplacer vers un autre emplacement ou une 
autre piste.

Pour séparer une sélection avec l'outil de 
séparation :

1  Faites glisser le sélecteur pour sélectionner les 
données de la ou des nouvelle(s) région(s). 
La sélection peut se trouver à l'intérieur d'une 
même région, sur des régions adjacentes de la 
même piste ou englober plusieurs pistes.

2  Dans le menu contextuel de la main, 
sélectionnez l'outil de séparation.

Si vous éditez une région faisant partie des 
prises associées utilisant le même marqueur 
de temps utilisateur (créée lors d'un 
enregistrement en boucle, par exemple) 
alors que l'option Separate Region Operates 
On All Related Takes des préférences 
d'édition est activée, la commande Separate 
Region a une incidence sur chaque prise. 
Pour plus de détails, consultez la section 
Préférences d'édition des prises, page 221

La liste des régions peut se remplir 
rapidement de régions créées 
automatiquement. Dans le menu contextuel 
Region List, désélectionnez Show > Auto-
Created pour masquer toutes les régions 
créées automatiquement dans la liste des 
régions.

Figure 13.  Séparation sur plusieurs pistes

Outil de séparation
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3  Faites glisser la sélection vers le nouvel 
emplacement ou vers une autre piste.

Une région (ou plusieurs) est créée, contenant la 
sélection précédente, séparément de la sélection 
d'origine. De nouvelles régions sont également 
créées à partir des données se trouvant hors de la 
sélection d'origine.

Pour séparer une sélection sans affecter les 
régions d'origine :

1  Faites glisser le sélecteur pour sélectionner les 
données de la ou des nouvelle(s) région(s). 
La sélection peut se trouver à l'intérieur d'une 
même région, sur des régions adjacentes de la 
même piste ou englober plusieurs pistes.

2  Dans le menu contextuel de la main, 
sélectionnez l'outil de séparation.

3  Tout en appuyant sur Option (Macintosh) ou 
sur Alt (Windows), faites glisser la sélection vers 
le nouvel emplacement ou vers une autre piste.

De nouvelles régions contenant la sélection 
précédente sont créées et placées au nouvel 
emplacement. La sélection et les régions 
d'origine demeurent intactes.

Chevauchements de régions

Lorsqu'une piste audio basée sur le métronome 
comporte plusieurs régions, l'accélération du 
tempo peut provoquer un chevauchement de 
régions adjacentes. Vous pouvez définir les 
régions audio de sorte à afficher un coin écorné 
à leurs limites en cas de chevauchement. 

Pour basculer entre l'affichage des limites des 
régions chevauchées et celui des régions 
chevauchantes :

■ Sélectionnez View > Region > Overlap.

Déplacement d'une sélection plus loin dans la piste 
avec l'outil de séparation

avant
après

Déplacement d'une sélection vers une autre piste avec 
l'outil de séparation

Chevauchements de régions

Région 

Région chevauchée
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Modifier le chevauchement des régions

Le chevauchement de régions provoqué par la 
modification de certains paramètres, comme le 
tempo, peut ne pas vous convenir. Le cas 
échéant, vous avez la possibilité de modifier le 
chevauchement en affichant la région de votre 
choix en premier plan ou en arrière-plan.

Pour modifier le chevauchement de régions :

1  Dans la fenêtre Edit, choisissez la ou les 
régions à réorganiser.

2  Choisissez Region > Bring to Front pour que la 
région sélectionnée chevauche les régions 
adjacentes. 

– ou –

Choisissez Region > Send to Back pour que la 
région sélectionnée soit chevauchée par les 
régions adjacentes. 

Si la sélection est constituée de plusieurs régions 
qui se chevauchent, Pro Tools applique la 
commande à toutes les régions ainsi qu'aux 
régions de droite adjacentes. 

Commandes de rognage
Pro Tools intègre plusieurs options d'édition de 
limites de région et de groupe de régions. 

Commande Trim Region to 
Selection

La commande Trim Region to Selection 
supprime les données situées avant et après une 
région ou une note MIDI sélectionnée, pour que 
seule la sélection ne s'affiche à l'écran. Vous 
pouvez ainsi supprimer rapidement toutes les 
données d'une région (et, dans certains cas, 
l'intégralité de la piste), à l'exception de celles 
contenues dans la sélection active.

Pour « rogner » les données indésirables d'une 
région ou d'une note :

1  A l'aide du sélecteur, sélectionnez une partie 
d'une région ou d'une note (ou d'une plage de 
notes).

2  Choisissez Edit > Trim Region > To Selection 
pour supprimer les données situées hors de la 
sélection.

Commandes Trim Region to 
Insertion 

Vous pouvez rogner une région ou une note 
MIDI en supprimant automatiquement les 
données qui se trouvent entre le point 
d'insertion d'édition et le point de début ou de 
fin de la région.

Pour rogner depuis un point de début jusqu'au 
point d'insertion :

1  A l'aide du sélecteur, cliquez dans la région ou 
dans la note, à l'endroit où vous souhaitez placer 
le nouveau point de début.

2  Choisissez Edit > Trim Region > Start To 
Insertion. Le point de début de la région est 
rogné automatiquement jusqu'au point 
d'insertion.

Pour rogner depuis un point de fin jusqu'au point 
d'insertion :

1  A l'aide du sélecteur, cliquez dans la région ou 
dans la note, à l'endroit où vous souhaitez placer 
le nouveau point de fin.

2  Choisissez Edit > Trim Region > End To 
Insertion. Le point de fin de la région est rogné 
automatiquement jusqu'au point d'insertion.
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Commandes Trim to Fill Selection

La commande Trim to Fill Selection permet 
d'insérer automatiquement des données sous-
jacentes dans les espaces entre régions.

Pour combler des espaces depuis un point de 
début de région :

1  Faites glisser le sélecteur pour sélectionner au 
moins un espace entre les régions.

2  Choisissez Edit > Trim Region > Start to Fill 
Selection. 

Le point de début de la région situé derrière 
l'espace est étendu à la région précédente, le plus 
loin possible en fonction de la quantité de 
données sous-jacentes pouvant combler 
l'espace.

Pour combler des espaces depuis un point de fin 
de région :

1  Faites glisser le sélecteur pour sélectionner au 
moins un espace entre les régions.

2  Choisissez Edit > Trim Region > End to Fill 
Selection. 

Le point de fin de la région situé devant l'espace 
est étendu automatiquement jusqu'à la région 
suivante, le plus loin possible en fonction de la 
quantité de données sous-jacentes pouvant 
combler l'espace.

Pour combler des espaces avec les points de 
début et de fin d'une région :

1  Faites glisser le sélecteur pour sélectionner au 
moins un espace entre les régions.

2  Choisissez Edit > Trim Region > To Fill 
Selection. 

Le point de début de la région se trouvant 
derrière l'espace est étendu automatiquement 
jusqu'à la région précédente, le plus loin 
possible en fonction de la quantité de données 
sous-jacentes pouvant combler l'espace. En 
parallèle, le point de fin de la région se trouvant 
devant l'espace est étendu automatiquement 
jusqu'à la région suivante, le plus loin possible 
en fonction de la quantité de données sous-
jacentes pouvant combler l'espace.

Fin de la région rognée jusqu'au point d'insertion

Remplissage d'un espace avec le début d'une région

Remplissage d'un espace avec la fin d'une région
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Rognage par incrément

Vous pouvez rogner les points de début et de fin 
d'une région en les déplaçant par incrément.

Pour rogner le point de début ou de fin d'une région 
de la valeur de déplacement par incréments :

1  Configurez la valeur de déplacement par 
incrément. Pour en savoir plus, reportez-vous à 
la section Définition de la valeur de 
déplacement par incrément, page 369.

2  A l'aide de l'outil d'accrochage de temps, 
sélectionnez la région à rogner.

3  Maintenez la touche Option (Macintosh) ou 
Alt (Windows) enfoncée et appuyez sur le signe 
plus (+) ou moins (-) du clavier numérique pour 
rogner le point de début de la région de la valeur 
de déplacement par incrément.

– ou –

Maintenez la touche Pomme (Macintosh) ou 
Ctrl (Windows) enfoncée et appuyez sur le signe 
plus (+) ou moins (-) du clavier numérique pour 
rogner le point de fin de la région de la valeur de 
déplacement par incrément.

Réunion de divisions de 
région
La commande Heal Separation ramène une 
région séparée à son état d'origine, à condition 
que les divisions de région soient encore 
juxtaposées et que leurs points de début et de fin 
n'aient pas été modifiés depuis la séparation.

Si vous avez « rogné » ou modifié d'une manière 
ou d'une autre les points de début et de fin des 
deux régions, ou si vous les avez éloignées l'une 
de l'autre, vous ne pourrez pas rétablir leur état 
d'origine à l'aide de la commande Heal 

Separation. Il n'est pas possible de réunir deux 
régions créées à partir de fichiers audio 
différents.

Pour réunir deux divisions de région :

1  Faites glisser le sélecteur pour sélectionner une 
partie de la première région et une partie de la 
seconde région ainsi que l'espace qui les sépare.

2  Choisissez Edit > Heal Separation.

Si la commande Heal Separation ne parvient pas à 
reconstituer une région divisée, effectuez l'une 
des opérations suivantes :

■ Supprimez l'une des deux régions (vérifiez que 
vous êtes en mode Slip pour que l'espace ainsi 
créé ne se referme pas), puis, à l'aide de l'outil de 
trimming, étendez la région restante de sa 
longueur originale. Pour plus d'informations sur 
l'utilisation de l'outil de trimming, consultez la 
section Outil de trimming, page 310.

– ou –

■ Supprimez les deux divisions de région et 
faites glisser la région d'origine de la liste des 
régions vers l'emplacement d'origine. Pour plus 
d'informations sur le placement des régions, 
consultez la section Placement des régions dans 
les pistes, page 357.

Placement des régions dans 
les pistes
Une fois créée, la région s'inscrit dans la liste des 
régions. Vous pouvez la faire glisser de la liste 
vers une piste pour l'ajouter à une disposition de 
régions existante ou bien l'ajouter à une piste 
créée de toute pièce. Le placement exact des 
régions dans une piste dépend du mode 
d'édition choisi (Shuffle, Slip, Spot ou Grid) 
(voir Modes d'édition, page 301 pour plus de 
détails).
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Pour plus d'informations sur la recherche par 
initiale dans la liste des régions, consultez la 
section Sélection de régions au clavier, 
page 300.

Pour placer une région dans une piste :

1  Dans la liste des régions, sélectionnez la ou les 
régions à placer.

2  Faites glisser les régions sélectionnées de la 
liste des régions vers le point souhaité sur la 
piste. 

Si vous faites glisser plusieurs régions, celles-ci 
seront déposées sur des pistes adjacentes, de 
gauche à droite, ou sur plusieurs pistes de haut 
en bas en fonction de l'ordre de placement sur la 
timeline (voir Ordre de placement sur la 
timeline, page 358). Si vous faites glisser une 
région stéréo, elle doit être placée dans une piste 
stéréo ou dans deux pistes mono.

Les régions sont placées en fonction du mode 
d'édition courant :

• En mode Shuffle, les régions existantes de la 
piste se décalent de façon à libérer assez de 
place pour la nouvelle région.

• En mode Spot, vous êtes invité par la boîte de 
dialogue Spot à entrer l'emplacement désiré 
pour la région déplacée (voir Placement de 
régions (Spot), page 363). 

• En mode Grid, la région déplacée s'aligne sur 
le pas le plus proche de la grille.

• En mode Slip, les régions se placent 
exactement à l'endroit où elles sont déposées 
sur la piste de destination.

Ordre de placement sur la timeline

La commande Timeline Drop Order du menu 
contextuel Region List permet de déterminer si 
les régions sélectionnées de la liste des régions 
sont déposées les unes derrière les autres sur une 
seule piste ou si elles sont réparties sur plusieurs 
pistes :

Top to Bottom : lorsque cette option est activée, 
les régions sont réparties sur plusieurs pistes de 
destination ou sur de nouvelles pistes (lorsque 
vous les faites glisser en dessous de la dernière 
piste ou vers la liste de pistes). 

Left to Right : lorsque cette option est activée, 
les régions sont placées les unes derrière les 
autres sur une seule piste de destination ou sur 
une nouvelle piste (lorsque vous les faites glisser 
en dessous de la dernière piste ou vers la liste de 
pistes).

Pour définir l'ordre de placement des régions :

■ Sélectionnez Region List > Timeline Drop 
Order, puis Top to Bottom ou Left to Right. 

Pour faire glisser, puis déposer plusieurs éléments 
de la liste des régions sur de nouvelles pistes :

1  Dans le menu contextuel Region List, 
sélectionnez Timeline Drop Order > Top to 
Bottom.

2  Triez la liste des régions pour configurer, au 
besoin, l'ordre de positionnement des éléments. 

3  Sélectionnez plusieurs régions, puis effectuez 
l'une des opérations suivantes :

• Pour placer les régions à l'endroit voulu sur 
de nouvelles pistes, déposez-les en dessous 
de la dernière piste. 

• Pour placer les régions en début de session 
sur de nouvelles pistes, déposez-les dans la 
liste de pistes. 

Pour suspendre temporairement le mode 
Grid lorsque vous déplacez une région, 
maintenez la touche Pomme (Macintosh) 
ou Ctrl (Windows) enfoncée.
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Pour placer plusieurs régions sur plusieurs pistes 
existantes :

1  Dans le menu contextuel Region List, 
choisissez Timeline Drop Order > Top to 
Bottom.

2  Sélectionnez plusieurs éléments de la liste des 
régions, puis déposez-les à l'endroit voulu dans 
la playlist d'une piste compatible. Lorsque le 
curseur détecte une destination compatible, les 
contours de la région s'y affichent. 

Pour faire glisser, puis déposer plusieurs éléments 
de la liste des régions sur une seule piste : 

1  Dans le menu contextuel Region List, 
choisissez Timeline Drop Order > Left to Right.

2  Triez la liste des régions pour configurer, au 
besoin, l'ordre de positionnement des éléments. 

3  Sélectionnez plusieurs régions, puis effectuez 
l'une des opérations suivantes :

• Pour placer le premier élément à l'endroit 
voulu sur une nouvelle piste, déposez-le 
dans la zone située en dessous de la 
dernière piste, indiquée dans la fenêtre 
Edit. 

• Pour placer le premier élément en début de 
session sur une nouvelle piste, déposez-le 
dans la liste de pistes. 

• Pour placer des éléments sur une piste 
existante, déposez-les dans la playlist 
d'édition de la piste souhaitée. 

Si la sélection contient des régions de types 
différents (audio et MIDI ou groupes de régions 
et MIDI, par exemple), les pistes adéquates sont 
créées et les régions intègrent celles qui leur 
correspondent. De même, si la sélection 
contient plusieurs formats (mono, stéréo ou 
autres), de nouvelles pistes sont créées pour 
chaque format et les régions intègrent les pistes 
qui leur correspondent. 

Placement des régions au point 
d'insertion d'édition

Vous pouvez faire glisser une piste de la liste des 
régions, d'une piste à l'autre ou à l'intérieur 
d'une piste, puis aligner son point de début, de 
fin ou de synchronisation sur le point 
d'insertion d'édition. Cette technique s'avère 
utile en post-production. En effet, elle permet de 
définir un point de sélection d'édition lors de la 
lecture ou à l'arrêt et de placer facilement des 
effets sonores au point d'insertion d'édition.

Nouvelles pistes après dépose de plusieurs régions, 
l'ordre de placement sur la timeline étant défini sur le 
mode Top to Bottom

Nouvelles pistes après dépose de plusieurs régions, 
l'ordre de placement sur la timeline étant défini sur le 
mode Left to Right

Avec Pro Tools HD, lorsque l'option 
Scrolling est définie sur Center Playhead, les 
régions s'alignent sur la tête de lecture et 
non sur le point d'insertion d'édition.
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Pour placer le début d'une région sur le point 
d'insertion d'édition :

1  Avec le sélecteur, cliquez dans la piste, sur 
l'emplacement temporel où vous souhaitez 
placer le début de la région. 

2  Maintenez la touche Contrôle (Macintosh) ou 
Démarrer (Windows) enfoncée et faites glisser la 
région de la liste des régions, ou d'une autre 
piste, vers la piste de destination.

– ou –

Si la piste contient déjà cette région, maintenez 
la touche Contrôle (Macintosh) ou Démarrer 
(Windows) enfoncée et cliquez sur la région 
avec l'outil d'accrochage de temps.

Pour placer la fin d'une région sur le d'insertion 
d'édition :

1  Avec le sélecteur, cliquez dans la piste, sur 
l'emplacement temporel où vous souhaitez 
placer la fin de la région. 

2  Maintenez les touches Pomme+Contrôle 
(Macintosh) ou Ctrl+Démarrer (Windows) 
enfoncées et faites glisser la région de la liste des 
régions, ou d'une autre piste, vers la piste de 
destination.

– ou –

Si la piste contient déjà cette région, maintenez 
enfoncées les touches Pomme+Contrôle 
(Macintosh) ou Ctrl+Démarrer (Windows) et 
cliquez sur la région avec l'outil d'accrochage de 
temps.

Pour placer le point de synchronisation d'une 
région sur le point d'insertion d'édition :

1  Avec le sélecteur, cliquez dans la piste, sur 
l'emplacement temporel où vous souhaitez 
placer le point de synchronisation de la région. 

2  Maintenez les touches Maj+Contrôle 
(Macintosh) ou Maj+Démarrer (Windows) 
enfoncées et faites glisser la région de la liste des 
régions, ou d'une autre piste, vers la piste de 
destination.

– ou –

Si la piste contient déjà cette région, maintenez 
les touches Maj+Contrôle (Macintosh) ou 
Maj+Démarrer (Windows) enfoncées et cliquez 
sur la région avec l'outil d'accrochage de temps.

Alignement sur les points de 
début de la région

Vous pouvez aligner le point de début, de fin et 
de synchronisation d'une région sur le début 
d'une autre région sur une autre piste.

Pour aligner les points de début des régions sur 
des pistes différentes :

1  A l'aide de l'outil d'accrochage de temps, 
sélectionnez la région sur laquelle vous voulez 
effectuer l'alignement en cliquant dessus.

2  Si l'option Scrolling est définie sur Center 
Playhead (Pro Tools HD uniquement), placez la 
tête de lecture sur le point de début de la région 
sélectionnée. Pour en savoir plus, reportez-vous 
à la section Déplacement de la tête de lecture, 
page 350.

Avec Pro Tools HD, lorsque l'option 
Scrolling est définie sur Center Playhead, les 
points de début, de fin et de synchronisation 
des régions s'alignent sur la tête de lecture.
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3  Maintenez enfoncée la touche Contrôle 
(Macintosh) ou Démarrer (Windows) et faites 
glisser une région de la liste des régions vers une 
autre piste.

– ou –

Si la piste contient déjà cette région, maintenez 
la touche Contrôle (Macintosh) ou Démarrer 
(Windows) enfoncée et cliquez sur la région à 
déplacer avec l'outil d'accrochage de temps.

Le point de début de la seconde région est aligné 
avec celui de début de la première région.

Pour aligner le point de fin d'une région avec le 
point de début d'une autre région (sur une piste 
différente) :

1  A l'aide de l'outil d'accrochage de temps, 
sélectionnez la région sur laquelle vous voulez 
effectuer l'alignement en cliquant dessus.

2  Si l'option Scrolling est définie sur Center 
Playhead (Pro Tools HD uniquement), placez la 
tête de lecture sur le point de début de la région 
sélectionnée. Pour en savoir plus, reportez-vous 
à la section Déplacement de la tête de lecture, 
page 350.

3  Maintenez enfoncées les touches 
Pomme+Contrôle (Macintosh) ou 
Ctrl+Démarrer (Windows) et faites glisser une 
région de la liste des régions vers une autre piste.

– ou –

Si la piste contient déjà cette région, maintenez 
enfoncées les touches Pomme+Contrôle 
(Macintosh) ou Ctrl+Démarrer (Windows) et 
cliquez sur la région à déplacer avec l'outil 
d'accrochage de temps.

Le point de fin de la seconde région est aligné 
sur celui de début de la première région.

Pour aligner le point de synchronisation d'une 
région sur le point de début d'une autre région (sur 
une piste différente) :

1  A l'aide de l'outil d'accrochage de temps, 
sélectionnez la région sur laquelle vous voulez 
effectuer l'alignement en cliquant dessus.

2  Si l'option Scrolling est définie sur Center 
Playhead (Pro Tools HD uniquement), placez la 
tête de lecture sur le point de début de la région 
sélectionnée. Pour en savoir plus, reportez-vous 
à la section Déplacement de la tête de lecture, 
page 350.

3  Maintenez enfoncées les touches 
Maj+Contrôle (Macintosh) ou Maj+Démarrer 
(Windows) et faites glisser une région de la liste 
des régions vers une autre piste.

– ou –

Si la piste contient déjà cette région, maintenez 
les touches Maj+Contrôle (Macintosh) ou 
Maj+Démarrer (Windows) enfoncées et cliquez 
sur la région à déplacer avec l'outil d'accrochage 
de temps.

Le point de synchronisation de la seconde 
région est aligné sur celui de début de la 
première région.

Déplacement des régions par 
glissement

L'outil d'accrochage de temps permet aussi de 
faire glisser une région ou un groupe de régions 
sélectionnées (sur la même piste ou sur plusieurs 
pistes) vers de nouveaux emplacements ou vers 
d'autres pistes. En post-production, cette 
fonction s'avère utile pour la synchronisation 
des événements audio, notamment pour repérer 
les effets sonores et les dialogues sur une 
musique, un film ou une vidéo.
Chapitre 17 : Utilisation des régions et des sélections 361



362
Le déplacement des régions en les faisant glisser 
dépend du mode d'édition (Shuffle, Slip, Spot ou 
Grid). Pour plus d'informations, reportez-vous à 
la section Modes d'édition, page 301.

Déplacement des régions 
(Shuffling)

En mode Shuffle, vous pouvez déplacer 
librement les régions dans une piste ou vers une 
autre piste, mais leur mouvement est contraint 
par les autres régions. Cela signifie que si vous 
placez plusieurs régions dans une piste, leurs 
points de début et de fin s'alignent 
automatiquement les uns sur les autres. Vous 
pouvez ensuite « modifier » l'ordre dans lequel 
elles se succèdent, mais vous ne pouvez pas les 
séparer, ni les superposer comme en mode Slip. 
En mode Shuffle, l'ajout d'une autre région au 
début d'une piste décale les régions suivantes 
vers la droite, de la durée de la région ajoutée.

Pour déplacer des régions en shuffling :

1  Réglez le mode d'édition sur Shuffle en 
cliquant sur le bouton en haut et à gauche de la 
fenêtre Edit.

2  Faites glisser une région mono de la liste des 
régions vers une piste vide. La région s'aligne sur 
le début de la piste

3  Vers cette même piste, faites glisser une 
seconde région de la liste des régions, aux 
environs du centre de la piste. Le point de début 
de la seconde région est aligné sur la fin de la 
première région.

4  Avec l'outil d'accrochage de temps, faites 
glisser la seconde région vers le début de la piste.

Pro Tools réorganise la position des deux 
régions. La seconde est devenue la première, 
mais les deux régions restent collées l'une à 
l'autre.

5  Faites d'autres essais en mode Shuffle en 
faisant glisser d'autres régions vers la piste et en 
les réorganisant.

Les régions verrouillées (voir Verrouillage de 
régions, page 372), ainsi que toutes les régions 
situées après elles, ne bougent pas lorsque 
d'autres régions voisines sont déplacées en 
mode Shuffle. S'il n'y a pas assez d'espace pour 
placer ou dupliquer une région devant une 
région verrouillée, la zone d'insertion est 
désactivée.

Si vous placez une région alors que vous vous 
trouvez en mode Slip, puis que vous passez en 
mode Shuffle, Pro Tools conserve le timing et la 
position relatifs de la région déplacée en 
glissant, ainsi que tout espace vide entre elle et 
les autres régions.

Vous pouvez faire glisser une copie d'une 
région vers un autre emplacement ou une 
autre piste en appuyant sur Option 
(Macintosh) ou sur Alt (Windows).

Pour conserver l'emplacement temporel 
d'une région lorsque la vous déplacez vers 
une autre piste, appuyez sur la touche 
Contrôle (Macintosh) ou Démarrer 
(Windows).
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Déplacement en mode Shuffle de 
plusieurs pistes et de régions 
multicanaux

Il est possible de déplacer en mode Shuffle des 
sélections sur plusieurs pistes ou sur des pistes 
multicanaux. Dans ce cas, toute région 
partiellement sélectionnée sera coupée et 
déplacée avec la région que l'on fait glisser. 
Ceci permet de ne conserver que les données qui 
correspondent à la région déplacée.

Déplacement de régions en 
mode Slip

En mode Slip, l'outil d'accrochage de temps 
permet de déplacer à volonté les régions à 
l'intérieur d'une piste ou vers d'autres pistes. 
Dans ce mode, il est possible de placer une 
région dans une piste en laissant un espace entre 
elle et les autres régions. Lors de la lecture de la 
piste, cet espace est silencieux. Vous pouvez 
également déplacer une région pour qu'elle 
recouvre partiellement ou complètement une 
autre région.

Pour déplacer des régions en mode Slip :

1  Réglez le mode d'édition sur Slip en cliquant 
sur le bouton situé en haut et à gauche de la 
fenêtre Edit.

2  Faites glisser une région de la liste des régions 
vers une piste vide.

3  Vers cette même piste, faites glisser une 
seconde région de la liste des régions, aux 
environs du centre de la piste. La seconde région 
se place à l'endroit où vous la relâchez. 
Contrairement au mode Shuffle, ce mode ne 
permet pas d'aligner la seconde région pas sur la 
première.

4  Faites glisser les régions vers différents 
endroits dans la piste pour « sentir » le 
déplacement en mode Slip. Essayez de placer la 
seconde région pour qu'elle recouvre 
légèrement la première. Lisez le résultat.

Placement de régions (Spot)

Le mode Spot est utile dans le cadre de sessions 
dans lesquelles vous souhaitez placer des régions 
sur des emplacements précis d'après n'importe 
quelle échelle de temps. Ceci peut être 
particulièrement utile lorsque vous effectuez des 
tâches de post production. Le mode Spot permet 
de placer une région en précisant un 
emplacement SMPTE (Pro Tools HD et 
Pro Tools LE avec DV Toolkit uniquement) ou 
un nombre de mesures et de temps, en 
capturant une adresse de timecode entrante, ou 
en utilisant les marqueurs temporels de la 
région.

Déplacement de régions multicanaux en mode Shuffle

Le déplacement de cette région par shuffling coupe ce canal
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Pour placer une région en mode Spot :

1  Réglez le mode d'édition sur Spot en cliquant 
sur le bouton correspondant, en haut et à 
gauche de la fenêtre Edit.

2  Faites glisser une région à partir de la liste des 
régions ou faites glisser des fichiers audio ou des 
sessions à partir d'un navigateur DigiBase vers 
une piste existante. 

– ou –

Cliquez avec l'outil d'accrochage de temps sur 
une région se trouvant déjà dans la piste.

3  Dans la boîte de dialogue Spot, sélectionnez le 
format temporel désiré dans le menu déroulant 
Time Scale.

Chaque champ de la boîte de dialogue Spot 
apparaît dans le format temporel choisi.

4  Dans les systèmes Pro Tools HD ou 
Pro Tools LE avec DV Toolkit, si vous avez défini 
le format temporel (Time Scale) sur Time Code, 
sélectionnez l'option Use Subframes pour 
afficher les subdivisions d'images dans les 
champs, afin d'améliorer la précision.

5  Cliquez dans le champ Start, Sync Point 
ou End et tapez un nouvel emplacement. 
La modification de l'un de ces points de repère 
met à jour automatiquement les autres points de 
repère.

– ou –

Cliquez sur la flèche verticale du champ 
Original Time Stamp ou sur celle du champ User 
Time Stamp pour entrer la valeur du marqueur 
de temps d'origine ou du marqueur de temps 
utilisateur. 

– ou –

Si vous utilisez une source de timecode SMPTE 
externe, cliquez sur la flèche du bas, située à côté 
du champ Current Time Code (ou appuyez sur 
la touche égal (=) du clavier numérique) pour 
capturer une adresse de timecode entrant.

6  Cliquez sur OK. La région est déplacée vers le 
nouvel emplacement indiqué par ses points de 
début, de fin ou de synchronisation.

Si une région ne possède pas de point de 
synchronisation défini, le champ Sync Point de 
la boîte de dialogue Spot fonctionne comme le 
champ Start.

Pour en savoir plus sur l'utilisation de SMPTE 
avec Pro Tools, reportez–vous au Chapitre 34, 
Utilisation de la synchronisation.

Pour un repérage encore plus rapide, si vous 
utilisez le VITC, utilisez la commande 
Auto-Spot Regions pour placer une région à 
l'emplacement SMPTE actuel avec l'outil 
d'accrochage de temps. Pour plus 
d'informations, reportez-vous à la section 
Placement automatique de régions, 
page 791.

Boîte de dialogue Spot
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Marqueurs de temps de la région

Lorsqu'une région est créée, elle subit un 
marquage temporel relatif au temps de début 
SMPTE spécifié pour la session. Ce marquage 
temporel d'origine est lié de façon permanente à 
la région et ne peut être modifié. Si jamais une 
région est déplacée, elle peut facilement être 
replacée à sa position d'origine depuis la boîte de 
dialogue Spot.

Lors de la définition initiale du marquage 
temporel original, c'est ce même emplacement 
qui sert également à définir le marqueur 
temporel utilisateur de la région.

Contrairement au marqueur temporel original, 
le marqueur temporel utilisateur peut être 
redéfini via la commande Time Stamp dans le 
menu contextuel de la liste des régions. Pour 
plus d'informations, reportez-vous à la section 
Marquage temporel, page 792. 

Time Stamps dans DigiBase

Les navigateurs DigiBase contiennent des 
colonnes pour le marquage temporel original et 
le marquage temporel utilisateur. 

Marquages temporels et liste des prises

Les régions possédant des marqueurs de temps 
utilisateur identiques apparaissent ensemble 
dans le menu déroulant de la liste des prises lors 
de l'écoute de ces dernières. Pour plus 
d'informations, reportez-vous à la section 
Sélection d'une prise différente depuis le menu 
déroulant de la liste des prises, page 220.

Déplacement des régions en 
glissant en mode Grid

Le mode Grid offre plusieurs fonctions utiles 
pour faire glisser et déplacer des régions dans les 
playlists de la piste. Ce mode est 
particulièrement utile pour disposer des régions 
à intervalles précis, lorsque vous travaillez avec 
une session basée sur les mesures et les temps. 
Les pas de la grille, en fonction de l'échelle de 
temps principale, peuvent être exprimés en 
trames, en nombre de mesures et de temps, en 
minutes/secondes ou en nombre d'échantillons. 

Le mode Grid offre également deux modes de 
fonctionnement : absolu et relatif. Ces modes 
régissent l'application de la grille. (Pour plus 
d'informations, voir Mode Grid absolu et relatif, 
page 366.)

Configuration de la grille

Lorsque l'option Draw Grid in Edit Window des 
préférences d'affichage est activée, des 
graduations verticales s'affichent dans la fenêtre 
Edit.

Vous pouvez également activer et désactiver ces 
graduations de la fenêtre Edit en cliquant sur le 
nom de la règle temporelle en surbrillance.

Pour suspendre temporairement le mode 
Grid et basculer en mode Slip tout en 
déplaçant une région, appuyez sur Ctrl 
(Windows) ou Pomme (Macintosh).
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Définition de la valeur de la grille

Outre son influence sur le placement des 
régions, la valeur de la grille restreint les 
sélections d'édition et de timeline, et détermine 
le fonctionnement de la commande Region > 
Quantize to Grid.

Pour définir la valeur de la grille

1  Dans le menu View > Main Counter, 
sélectionnez l'échelle temporelle que vous 
utiliserez pour spécifier la valeur de grille.

– ou –

Pour conserver l'échelle temporelle principale et 
utiliser un format temporel différent pour la 
grille, désélectionnez l'option Follow Main 
Timebase dans le menu déroulant de valeur de 
grille de la fenêtre Edit.

2  Dans le menu déroulant de la valeur de grille 
de la fenêtre Edit, sélectionnez la valeur 
temporelle qui définira les limites de la grille.

– ou –

Pour définir une grille d'après les marqueurs, 
sélections et limites des régions d'une session, 
sélectionnez Regions/Markers dans le menu 
déroulant de la valeur de grille.

Mode Grid absolu et relatif

Le mode Grid peut être absolu ou relatif. 

◆ En mode Grid absolu, le déplacement d'une 
région entraîne le déplacement du début de la 
région sur les limites de la grille. Si le point de 
départ d'une région se trouve entre deux temps 
et que la grille est définie sur 1/4 de note, le 
déplacement de la région déplace l'heure de 
début lui correspondant sur le 1/4 de note le 
plus proche (la valeur actuelle de grille absolue). 

◆ En mode Grid relatif, vous pouvez déplacer les 
régions par unités (ou incréments). Si le point de 
départ d'une région se trouve entre deux temps 
et que la grille est définie sur des 1/4 de note, le 
déplacement de la région est contraint à 1/4 de 
note et conserve la position relative de la région 
sur la mesure la plus proche.

Pour sélectionner le mode Grid absolu ou relatif :

■ Cliquez sur le sélecteur de mode Grid, puis 
choisissez Absolute ou Relative. 

Pour placer ou déplacer une région en mode Grid :

1  Configurez la valeur de la grille. Pour en savoir 
plus, reportez-vous à la section Définition de la 
valeur de la grille, page 366.

2  Faites glisser une région de la liste des régions 
vers une piste existante. 

– ou –

Menu déroulant de valeur de grille, indiquant les 
mesures et les temps (Bars:Beats)

Pour suspendre temporairement le mode 
Grid et basculer en mode Slip tout en 
déplaçant une région, appuyez sur Pomme 
(Macintosh) ou Ctrl (Windows).
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Avec l'outil d'accrochage de temps, faites glisser 
une région se trouvant déjà dans une piste vers 
un nouvel emplacement.

Le point de début de la région s'aligne sur le pas 
le plus proche de la grille. Si un point de 
synchronisation a été défini pour la région, il 
s'aligne sur le pas de la grille.

Points de synchronisation
Le placement des régions dans les modes Grid et 
Spot peut être basé sur la définition d'un point 
de synchronisation de la région. Les points de 
synchronisation sont utiles pour aligner un 
point donné d'une région sur la grille ou sur un 
emplacement particulier (exprimé en code 
SMPTE ou en mesures/temps). Cette fonction 
est importante pour placer des musiques et 
effets sonores sur des films et de la vidéo.

Supposons par exemple que la région audio 
d'une fermeture de porte contienne à la fois le 
grincement de la porte en train de se fermer, le 
claquement de la porte et la réverbération du 
claquement. L'utilisation d'un point de 
synchronisation pour le claquement permet de 
placer ce dernier à un endroit précis de la 
session.

Pour définir le point de synchronisation 
d'une région :

1  Réglez le mode d'édition sur Slip en cliquant 
sur le bouton situé en haut et à gauche de la 
fenêtre Edit.

2  Cliquez avec le sélecteur sur le point d'une 
région où vous souhaitez définir le point de 
synchronisation.

– ou –

Appuyez sur la touche fléchée vers le bas au 
cours de la lecture. 

3  Choisissez Region > Identify Sync Point. Une 
petite flèche orientée vers le bas s'affiche en bas 
de la région, avec une fine ligne grise verticale, 
pour indiquer l'emplacement du point de 
synchronisation.

Pour changer l'emplacement d'un point de 
synchronisation :

■ Cliquez avec le sélecteur sur un point de la 
région, puis choisissez Region > Identify Sync 
Point. Le nouvel emplacement est identifié 
comme le point de synchronisation de la région.

Suppression de points de 
synchronisation

Pour supprimer un point de synchronisation :

■ Sélectionnez toute la région et choisissez 
Region > Remove Sync Point.

– ou –

■ A l'aide de l'outil d'accrochage de temps ou de 
l'outil de scrubbing, cliquez sur le point de 
synchronisation à supprimer tout en 
maintenant la touche Alt (Windows) ou Option 
(Macintosh) enfoncée.

Points de synchronisation

Vous pouvez également faire glisser un 
point de synchronisation. Pour plus 
d'informations, reportez-vous à la section 
Déplacement des points de 
synchronisation, page 368.

Points de synchronisation
Chapitre 17 : Utilisation des régions et des sélections 367



368
Affichage des points de 
synchronisation

Vous avez la possibilité d'afficher ou de masquer 
les points de synchronisation dans les régions 
audio.

Pour désactiver l'affichage des points de 
synchronisation dans les régions audio :

■ Désélectionnez View > Region > Sync Point.

Pour activer l'affichage des points de 
synchronisation dans les régions audio :

■ Sélectionnez View > Region > Sync Point. 

Déplacement des points de 
synchronisation

Vous pouvez faire glisser un point de 
synchronisation dans la région audio. 

Pour définir un point de synchronisation par 
glisser-déposer :

1  Pour aligner le point de synchronisation sur la 
valeur de grille en cours, définissez le mode 
d'édition sur Grid.

2  Sélectionnez l'outil d'accrochage de temps.

3  Cliquez sur le point de synchronisation et 
faites-le glisser vers un nouvel emplacement.

Scrubbing des points de 
synchronisation

Si l'affichage d'une forme d'onde audio aide à 
définir un point de synchronisation, il ne 
permet pas toujours de repérer le point de 
montage souhaité dans les données audio. 
La technique de scrubbing permet justement de 
détecter précisément l'endroit où placer le point 
de synchronisation lorsque vous le déplacez sur 
une forme d'onde audio.

Pour effectuer un scrubbing lors du déplacement 
du point de synchronisation :

1  Pour aligner le point de synchronisation sur la 
valeur de grille actuelle une fois le scrubbing 
terminé, définissez le mode d'édition sur Grid.

2  Sélectionnez l'outil de scrubbing.

3  Faites glisser le point de synchronisation vers 
un nouvel emplacement. Lors de son 
déplacement, le point de synchronisation 
réalise un scrubbing de la source audio.

Déplacement par incrément 
(Nudging)
Pro Tools permet de déplacer des régions (ou des 
notes MIDI) par incrément précis à l'aide des 
touches plus (+) et moins (-) du clavier 
numérique. L'amplitude de ce déplacement est 
déterminée par la valeur spécifiée dans le menu 
déroulant Nudge Value. La fonction Nudge est 
utilisable dans n'importe quel mode d'édition.

Le déplacement par incréments peut être 
remarquablement efficace pour ajuster le 
« groove » d'une phrase musicale ou le 
placement d'un effet sonore par rapport aux 
autres éléments de la session. Pro Tools pouvant 
déplacer des données par incrément en cours de 
lecture, vous pouvez utiliser cette fonction de 
façon continue et en temps réel pour ajuster le 
timing entre les pistes.

Scrubbing d'un point de synchronisation

Curseur de scrubbing d'un point de synchronisation
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Le déplacement par incrément sert également à 
ajuster le placement des points d'inflexion des 
courbes d'automation. Pour plus 
d'informations, reportez-vous à la section 
Modification de l'automation, page 656.

Définition de la valeur de déplacement 
par incrément

La valeur de déplacement par incréments 
détermine l'amplitude du déplacement par 
incréments des régions et des sélections. 

Vous pouvez également déplacer par incréments 
les points de début et de fin des sélections (voir 
Déplacement par incréments des points de 
début et de fin de la sélection, page 338). De 
plus, vous pouvez rogner des régions de la valeur 
de déplacement par incréments (voir Rognage 
par incrément, page 357).

Pour définir la valeur de déplacement par 
incrément

1  Dans le menu View > Main Counter, 
sélectionnez l'échelle temporelle que vous 
utiliserez pour spécifier la valeur de 
déplacement par incrément.

– ou –

Pour conserver l'échelle temporelle principale et 
utiliser un format temporel différent pour la 
valeur de déplacement par incrément, 
désélectionnez l'option Follow Main Timebase 
dans le menu déroulant Nudge Value de la 
fenêtre Edit.

2  Dans le menu déroulant Nudge Value de la 
fenêtre Edit, sélectionnez la valeur de 
déplacement par incrément.

Pour spécifier une valeur de déplacement par 
incrément ne figurant pas dans le menu 
déroulant Nudge Value, cliquez sur l'indicateur 
correspondant, puis tapez la valeur.

Déplacement de régions par 
incrément (Nudging)

Pour déplacer une ou plusieurs régions par 
incréments :

1  Configurez la valeur de déplacement par 
incrément. Pour en savoir plus, reportez-vous à 
la section Définition de la valeur de 
déplacement par incrément, page 369.

2  A l'aide de l'outil d'accrochage de temps ou du 
sélecteur, sélectionnez la ou les régions, ou 
groupes de régions, que vous voulez déplacer 
par incrément. Les régions peuvent se trouver 
sur des pistes différentes. Seules les régions 
entièrement sélectionnées seront déplacées par 
incrément.

3  Appuyez sur Plus (+) sur le clavier numérique 
pour déplacer la sélection vers l'avant de la 
valeur de déplacement par incrément.

– ou –

Appuyez sur Moins (–) sur le clavier numérique 
pour reculer la sélection de la valeur de 
déplacement par incrément.

Menu déroulant Nudge Value affichant le timecode
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La commande Nudge fonctionne de la même 
manière, quel que soit le mode d'édition. Les 
régions adjacentes sont superposées en mode 
Shuffle, la boîte de dialogue Spot ne s'ouvre pas 
en mode Spot et les données décalées ne 
s'alignent pas sur la grille en mode Grid.

Déplacement de régions par incrément 
sur plusieurs pistes et dans des pistes 
multicanaux

Lorsque vous déplacez par incrément une 
sélection de plusieurs régions, dans une seule ou 
dans plusieurs pistes contenant également des 
silences, les données d'automation résidant 
dans les silences sont également déplacées par 
incrément.

Déplacement par incrément de la valeur 
plus grande suivante

Outre le déplacement par la valeur d'incrément 
courante, vous pouvez également sélectionner 
la valeur d'incrément suivante, plus grande, 
entrée dans le menu déroulant Nudge. 

Par exemple, si la valeur de déplacement par 
incrément est réglée sur 1 image et que vous 
souhaitez une valeur plus grande, vous pouvez 
choisir comme valeur d'incrément suivante, 
plus grande, 10 images.

Pour vous déplacer par incrément vers l'avant ou 
l'arrière de la valeur plus grande suivante :

1  Activez le focus clavier sur les commandes en 
cliquant sur le bouton de focus clavier situé en 
haut et à gauche de la fenêtre Edit.

2  A l'aide du sélecteur ou de l'outil d'accrochage 
de temps, sélectionnez les régions ou les notes à 
déplacer par incrément.

3  Appuyez sur la barre oblique (/) pour avancer 
les données sélectionnées de la valeur 
d'incrément suivante. Appuyez sur M pour 
reculer par incrément la sélection.

Déplacement par incrément du 
contenu d'une région

Il est fréquent que le point de début d'une 
région se trouve à l'emplacement correct (valeur 
précise de timecode ou nombre de mesures), 
mais que les données de la région commencent 
trop tard ou trop tôt. Vous pouvez, en fait, 
déplacer par incrément la forme d'onde audio 
ou les notes MIDI d'une région sans en déplacer 
les points de début et de fin.

Vous pouvez également déplacer les régions 
de la valeur d'incrément suivante, sans 
activer le focus clavier sur les commandes. 
Pour ce faire, maintenez la touche Contrôle 
(Macintosh) ou Démarrer (Windows) 
enfoncée et appuyez sur la barre oblique (/) 
ou sur M.

Déplacement par incrément du contenu d'une région

Le contenu de la région est déplacé, les 
données de la forme d'onde glissant à l'intérieur 
et hors des limites de la région active

avant

après
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Ce « glissement » du contenu de la région n'est 
possible que si des données se trouvent en 
dehors des points de début et de fin de la région, 
à partir de la région rognée ou éventuellement 
capturée depuis une région plus grande.

Pour déplacer par incrément le contenu d'une 
région sans en changer les points de début et 
de fin :

1  Configurez la valeur de déplacement par 
incrément. Pour en savoir plus, reportez-vous à 
la section Définition de la valeur de 
déplacement par incrément, page 369.

2  A l'aide de l'outil d'accrochage de temps, 
sélectionnez la région dont vous voulez déplacer 
le contenu par incrément.

3  Tout en appuyant sur Contrôle (Macintosh) 
ou sur Démarrer (Windows), appuyez sur Plus 
(+) ou Moins (–) sur le clavier numérique pour 
déplacer les données de la valeur de 
déplacement par incrément.

Commande Shift
La commande Shift vous permet d'avancer ou 
reculer temporellement les données de la piste, 
d'une quantité définie. La commande Shift est 
utilisable sur les sélections, les régions, les notes 
MIDI, les données de contrôleurs MIDI, et les 
points d'inflexion de l'automation.

Pour décaler une sélection ou une région :

1  A l'aide du sélecteur ou de l'outil d'accrochage 
de temps, sélectionnez les données de piste à 
décaler. Les données sélectionnées peuvent se 
trouver sur plusieurs pistes différentes.

2  Choisissez Edit > Shift. Dans la boîte de 
dialogue Shift, sélectionnez si les données 
doivent être avancées (Earlier) ou reculées 
(Later).

3  Cliquez dans l'un des champs de la base de 
temps pour spécifier la valeur de décalage 
désirée. Lorsque vous entrez une valeur dans 
l'un des champs de la base de temps, les autres 
sont mis à jour automatiquement.

4  Si vous voulez décaler des données avec une 
meilleure précision, vous pouvez sélectionner 
l'option Use Subframes.

5  Cliquez sur OK. Les données sont décalées, 
vers l'arrière ou l'avant, de la valeur indiquée. 

Si une partie d'une région était sélectionnée, de 
nouvelles régions sont créées à partir de la 
sélection et des données se trouvant hors de 
celle-ci. 

La commande Shift fonctionne de la même 
manière, quel que soit le mode d'édition. 
Les régions adjacentes sont superposées en 
mode Shuffle, la boîte de dialogue Spot ne 
s'ouvre pas en mode Spot et les données décalées 
ne s'alignent pas sur la grille en mode Grid.

Boîte de dialogue Shift
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Quantification des régions sur 
la grille
La commande Quantize to Grid permet de régler 
le positionnement des régions MIDI et audio 
sélectionnées de sorte à aligner avec précision 
leur point de début (ou de synchronisation, le 
cas échéant) sur le pas de grille le plus proche.

Pour quantifier une ou plusieurs régions :

1  Configurez la valeur de la grille. Pour en savoir 
plus, reportez-vous à la section Définition de la 
valeur de la grille, page 366.

2  A l'aide du sélecteur ou de l'outil d'accrochage 
de temps, sélectionnez la ou les régions à 
quantifier. Les régions peuvent se trouver sur des 
pistes différentes. Seules les régions entièrement 
sélectionnées seront quantifiées.

3  Choisissez Region > Quantize to Grid. 
Les temps de début (ou les points de 
synchronisation) des régions sont alignés sur les 
pas les plus proches de la grille définie. 

Pour les régions MIDI, toutes les données 
contenues dans les régions (telles que les notes) 
sont déplacées de façon égale, et conservent par 
conséquent leur relation rythmique. Pour 
quantifier des notes MIDI, utilisez la commande 
Quantize du sous-menu Event > MIDI (voir 
Input Quantize, page 545).

Verrouillage de régions
Si vous voulez associer de façon permanente une 
région ou un groupe de régions à un 
emplacement particulier d'une piste 
(mesure:temps, adresse SMPTE, ou position 
exprimée en échantillons), vous pouvez la 
verrouiller pour éviter qu'elle ne soit déplacée 
par accident. Vous ne pouvez ni déplacer, ni 
supprimer des régions verrouillées. 

Pour verrouiller une région :

1  A l'aide de l'outil d'accrochage de temps, 
sélectionnez la ou les régions à verrouiller. 
Les régions peuvent se trouver sur des pistes 
différentes.

2  Choisissez Region > Lock/Unlock.

Un petit cadenas apparaît dans la région pour 
indiquer qu'elle a été verrouillée et ne peut être 
déplacée. Si vous tentez d'effectuer des éditions 
qui déplaceraient une région verrouillée, 
Pro Tools vous en avertit.

En mode Shuffle, les régions verrouillées, ainsi 
que toutes les régions situées après la région 
verrouillée, ne sont pas déplacées lorsque 
d'autres régions voisines sont déplacées.

Région audio verrouillée
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Coupure/rétablissement 
des régions
Le choix de la commande Mute/Unmute Region 
coupe la lecture de la région sélectionnée. 
Si vous sélectionnez cette commande une 
deuxième fois, le son de la région est rétabli. 
Les régions coupées sont estompées pour 
indiquer leur statut.

Pour couper une ou plusieurs régions :

1  A l'aide de l'outil d'accrochage de temps, 
sélectionnez la ou les régions à couper. 
Les régions peuvent se trouver sur des pistes 
différentes.

2  Choisissez Region > Mute/Unmute. 
Les régions sélectionnées sont estompées pour 
indiquer qu'elles sont coupées.

Pour rétablir le son d'une région, sélectionnez-la 
et choisissez Region > Mute/Unmute.

Remplacement des régions 
audio
(Pro Tools HD uniquement)

La fonction Replace Region permet de remplacer 
plusieurs instances d'une région audio dans une 
playlist par une autre région que vous faites 
glisser depuis la liste des régions en maintenant 
les touches Pomme+Maj (Macintosh) ou 
Ctrl+Maj (Windows) enfoncées.

Cette fonction est utile en post-production si 
vous utilisez un effet sonore, un bruit 
d'ambiance ou une région d'atmosphère 
plusieurs fois au cours d'une session et que vous 
décidez ensuite de remplacer une ou toutes les 
régions d'origine par une région différente.

Région audio coupée (celle du milieu)

Boîte de dialogue Replace Region
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Elle est également utile dans la production 
musicale, lorsque vous voulez remplacer une 
boucle ou un échantillon donnés (par exemple 
un son de batterie) par un nouveau. Vous 
pouvez l'utiliser en composition, si vous 
connaissez le tempo d'une section ou d'une 
session, pour créer un morceau en partant de 
zéro avec des régions « brutes » de la bonne 
longueur et les remplacer plus tard par les 
régions « finales » de même longueur.

Les options suivantes sont disponibles dans la 
boîte de dialogue Replace Region :

Replace: Original Region Only : remplace la 
région sélectionnée par la région de 
remplacement que vous avez fait glisser depuis 
la liste des régions.

Replace: All Instances of the Original Region : 
remplace toutes les régions de la session 
correspondant à la région d'origine.

Replace: All Regions That Match Original 
Region's : remplace toutes les régions 
correspondant aux critères des zones Match et 
On par la région de remplacement que vous 
avez fait glisser depuis la liste des régions. 

• Start Position : remplace toutes les régions 
possédant le même temps de début que la 
région sélectionnée. Ceci inclut les régions 
ayant été créées automatiquement lors du 
rognage des points de fin.

• End Position : remplace toutes les régions 
possédant le même temps de fin que la 
région sélectionnée. Ceci inclut les régions 
ayant été créées automatiquement lors du 
rognage des points de début.

• Name : remplace toutes les régions 
provenant du même fichier audio et 
renommées de la même manière.

• On This Track : remplace les régions 
correspondant aux critères de la zone 
Match et se trouvant sur la même piste que 
la région d'origine.

• On All Tracks : remplace les régions 
correspondant aux critères de la zone 
Match pour toutes les pistes de la session.

• On Within the Selection : remplace les 
régions correspondant aux critères de la 
zone Match au sein de la sélection active.

La correspondance des régions utilise tous les 
critères de la zone Match spécifiés. Par exemple, 
si vous sélectionnez Start Position et End 
Position, toutes les régions issues du même 
fichier audio d'origine que votre sélection et 
possédant les mêmes temps de début et de fin 
seront remplacées.

Fit Region Using The: Original Region Length : 
si la région de remplacement est plus petite que 
la région d'origine, elle est placée dans la playlist 
et toute donnée audio restante de la région 
d'origine est supprimée. 

Si la région de remplacement est plus grande 
que la sélection, elle est placée dans la playlist et 
rognée pour correspondre à la longueur de la 
région d'origine.

Fit Region Using The: Original Selection 
Length : si la région de remplacement s'étend 
au-delà de la région d'origine, elle est rognée (si 
elle est plus grande que la région d'origine) pour 
correspondre à la sélection.
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Fit Region Using The: Replacement Region 
Length : la région de remplacement est placée 
dans son intégralité, quelle que soit la durée de 
la région ou de la sélection d'origine.

La fonction Replace Region ne fonctionne que 
sur une sélection qui n'inclut qu'une région sur 
une piste. Elle n'est pas disponible lorsque la 
sélection de la playlist inclut les points de début 
de deux régions ou plus. De plus, si la sélection 
s'étend sur plusieurs pistes, seule la sélection de 
la première piste (celle du haut) est utilisée.

Pour remplacer des régions :

1  Sélectionnez dans la playlist de la piste une 
région que vous voulez remplacer. La sélection 
peut s'étendre au-delà du point de fin de la 
région et inclure des données provenant d'une 
région de remplacement plus longue que la 
région d'origine.

2  Faites glisser la région de remplacement 
depuis la liste des régions vers la région 
sélectionnée en maintenant enfoncée la touche 
Pomme+Maj (Macintosh) ou Ctrl+Maj 
(Windows). La boîte de dialogue Replace Region 
s'ouvre.

3  Si vous ne souhaitez remplacer que la région 
d'origine, sélectionnez Replace Original Region.

– ou –

Si vous souhaitez remplacer plusieurs régions, 
sélectionnez Replace All Regions That Match 
Original, et choisissez les critères de 
correspondance dans la zone Match.

4  Sélectionnez si vous voulez appliquer le 
remplacement à toutes les pistes ou seulement à 
celle de la sélection courante.

5  Sélectionnez si vous voulez faire correspondre 
les régions de remplacement à la sélection 
courante, à la région entière ou à la région de 
remplacement entière, quelle que soit la 
longueur de destination. 

6  Une fois que vous avez défini toutes les 
options, cliquez sur OK.

Remplacement des régions par glisser-
déposer

Pour déplacer par glisser-déposer une région de 
la liste des régions vers une autre région d'une 
piste, utilisez les touches de modification 
Ctrl+Maj (Windows) ou Pomme+Maj 
(Macintosh) pour ouvrir la boîte de dialogue 
Replace Region sans sélection préalable.

Sélection de régions

La commande Replace Regions est également 
disponible dans le menu contextuel Region List. 
Avant de l'utiliser, assurez-vous d'avoir 
sélectionné une région sur une piste ainsi 
qu'une région de remplacement dans la liste des 
régions, comme indiqué ci-dessous : 

Par défaut, une région sélectionnée dans une 
piste l'est également dans la liste des 
régions. Les instructions suivantes ne 
s'appliquent que si cette préférence a été 
désactivée pour votre système.
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Pour accéder à la boîte de dialogue Replace 
Regions :

1  Sélectionnez une région dans une piste. Il doit 
s'agir de la région à remplacer. 

2  A l'aide de la souris, sélectionnez la région de 
remplacement souhaitée dans la liste des 
régions tout en maintenant la touche Pomme 
(Macintosh) ou Ctrl (Windows) enfoncée. 
Par défaut, le paramètre de préférence Region 
List Selection Follows Track Selection est activé. 
Si tel est le cas, la touche Ctrl est requise. 

3  Choisissez Replace Regions dans le menu 
déroulant de la liste des régions. 

Remplacement des régions et pistes 
multicanaux

La commande Replace Region permet de faire 
glisser des régions multicanaux à partir de la 
liste des régions vers des pistes multicanaux, à 
condition qu'elles soient du même format.

Par exemple, vous pouvez remplacer une région 
stéréo, sélectionnée dans une piste audio stéréo, 
par une autre région stéréo de la liste des 
régions. Toutefois, vous ne pouvez pas la 
remplacer par deux régions audio mono.

De plus, le remplacement de régions dans 
plusieurs pistes mono par des régions 
multicanaux n'est pas pris en charge.

Commandes d'édition
Pro Tools offre de nombreuses commandes 
d'édition standard (couper, copier, coller) ainsi 
que des commandes d'édition spécialisées, 
optimisées pour la production audio (Repeat 
Paste to Fill).

Couper, copier, coller et supprimer

Les commandes couper, copier, coller et 
supprimer permettent de réorganiser et d'éditer 
les données des pistes. Les éditions peuvent 
s'appliquer à des régions entières sélectionnées à 
l'aide de l'outil d'accrochage de temps ou sur des 
plages d'une piste sélectionnées à l'aide du 
sélecteur. Les éditions peuvent également 
s'appliquer à plusieurs pistes (voir Edition sur 
plusieurs pistes, page 381).

Vue de la piste et contenu d'édition

Lorsque vous coupez ou copiez les données 
d'une piste, la vue de la piste détermine le type 
de données placées dans le presse-papiers. 
Lorsque vous affichez des formes d'onde pour 
les pistes audio ou bien des pistes MIDI ou 
Instrument en vue Notes ou Regions, les 
sélections incluent toutes les données sous-
jacentes d'automation et de contrôleur. Ainsi, 
lorsque vous coupez une région audio, les 
données d'automation de niveau, de 
panoramique, de coupure, de signal de départ 
ou de plug-in de la piste sont également 
coupées. Ceci vous évite de couper 
individuellement dans chaque playlist 
d'automation de la piste.

Vous pouvez couper, copier et coller des 
régions non contiguës à l'aide de l'outil de 
saisie d'objet.
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Cependant, lorsque vous sélectionnez des 
groupes de notes MIDI avec la main 
(en dessinant un rectangle autour), seules les 
données correspondant aux notes sont placées 
dans le presse-papiers. Lorsque vous 
sélectionnez une plage temporelle de notes 
MIDI avec le sélecteur, toutes les données de 
contrôleur contenues dans la piste sont 
sélectionnées (comme pour la sélection de pistes 
audio avec le sélecteur dans la vue Waveform).

Lorsqu'une piste affiche des données 
d'automation ou de contrôleur, seules ces 
données sont placées dans le presse-papiers. 
De plus, chaque fois que vous coupez ou copiez 
des données d'automation, des points 
d'inflexion limites sont créés à chaque extrémité 
de la zone sélectionnée, afin de conserver la 
pente de l'automation à la fois à l'intérieur et 
hors de la sélection.

Si des pistes sont groupées, le copier-coller sur 
n'importe quelle piste a une incidence sur les 
autres pistes du groupe. Les pistes masquées, 
même si elles appartiennent à un groupe en 
cours d'édition, ne sont pas concernées par 
l'édition.

Le mode d'édition courant a une influence sur la 
sélection, la copie et le collage des données :

• En mode Slip, la commande Couper laisse un 
espace vide correspondant aux données 
supprimées de la piste. 

• En mode Slip, les données collées peuvent se 
superposer à une région adjacente.

• En mode Shuffle, la commande Couper ne 
laisse pas d'espace vide, les régions situées à 
droite de celle coupée se décalant pour 
remplir le trou. 

• En mode Shuffle, toutes les régions se décalent 
de la distance nécessaire pour laisser la place 
aux régions collées.

Les régions sont souvent créées 
automatiquement lors des éditions. Lorsque 
vous supprimez, par exemple, une sélection 
d'une région, de nouvelles régions sont créées 
automatiquement à partir des données résidant 
hors de la sélection.

Commandes Cut et Copy

La commande Cut place une sélection dans le 
presse-papiers tout en la retirant de la piste.

La commande Copy place une copie de la 
sélection dans le presse-papiers pour pouvoir la 
coller dans une autre piste ou dans la même 
piste à un emplacement différent, sans que la 
sélection d'origine ne soit modifiée ou déplacée.

Pour couper ou copier une sélection ou une 
région :

1  Pour restreindre la sélection en fonction du 
pas de grille actuel, réglez le mode d'édition sur 
Grid. 

2  Définissez la vue des pistes que vous voulez 
éditer.

Données d'une forme d'onde audio

Données d'automation (données de type point 
d'inflexion)
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Lorsque vous affichez des formes d'onde pour 
les pistes audio ou des notes ou des régions pour 
les pistes MIDI, les sélections incluent les 
données sous-jacentes d'automation et de 
contrôleur. Lorsqu'une piste affiche des données 
d'automation, seules ces données sont 
concernées par les éditions.

3  Déplacez le sélecteur dans la piste pour 
sélectionner les données que vous voulez couper 
ou copier.

– ou –

Utilisez l'outil d'accrochage de temps pour 
sélectionner une ou plusieurs régions (ou un 
groupe de notes MIDI).

4  Choisissez Edit > Cut pour supprimer la 
sélection et la placer dans le presse-papiers.

– ou –

Choisissez Edit > Copy pour placer la sélection 
dans le presse-papiers sans la supprimer.

Si une partie d'une région a été coupée ou 
copiée, les données du presse-papiers 
s'inscrivent dans la liste des régions, en tant que 
nouvelle région. Si une partie d'une région a été 
coupée, de nouvelles régions sont créées 
automatiquement à partir des données se 
trouvant hors de la sélection. 

En mode Shuffle, les régions adjacentes se 
décalent de la distance nécessaire pour remplir 
les espaces vides.

Suppression des données sous-jacentes de la 
région

Lorsque vous supprimez une région ou une 
sélection, vous pouvez également supprimer ou 
conserver les données sous-jacentes de la région.

Pour supprimer une région ou une sélection et les 
données sous-jacentes de la région :

■ Choisissez Edit > Cut.

Pour supprimer une région ou une sélection sans 
supprimer les données sous-jacentes de la région :

■ Choisissez Edit > Clear.

Commande Paste

La commande Paste place le contenu du presse-
papiers au point d'insertion de l'édition, en 
remplaçant les données déjà présentes.

Pour coller une sélection ou une région :

1  Pour restreindre le point d'insertion ou la 
sélection en fonction du pas de grille actuel, 
réglez le mode d'édition sur Grid. 

2  A l'aide du sélecteur, cliquez dans la piste, à 
l'endroit où vous souhaitez coller les données. 
Appuyez sur Tab pour déplacer le point 
d'insertion en avant vers les points de début et 
de fin ; pour le déplacer vers l'arrière, appuyez 
sur Option+Tab (Macintosh) ou sur Ctrl+Tab 
(Windows).

– ou –

A l'aide du sélecteur ou de l'outil d'accrochage de 
temps, effectuez une sélection à l'endroit où les 
données seront placées.

3  Choisissez Edit > Paste.
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Si vous effectuez le collage à un point d'insertion 
en mode Shuffle, les données situées à droite du 
point se décalent vers la droite. En mode Slip, les 
données collées remplacent les données 
existantes.

Si vous effectuez le collage dans une sélection en 
mode Shuffle, la sélection est remplacée par le 
contenu du presse-papiers et les données 
adjacentes se décalent à gauche ou à droite de la 
durée nécessaire. En mode Slip, la sélection est 
également remplacée mais les données 
adjacentes demeurent inchangées.

Commande Clear

La commande Clear permet de supprimer une 
sélection d'une piste sans la placer dans le 
presse-papiers.

Pour supprimer une sélection d'une région :

1  Pour restreindre la sélection en fonction du 
pas de grille actuel, réglez le mode d'édition sur 
Grid. 

2  Définissez la vue des pistes que vous voulez 
éditer.

Lorsque vous affichez des formes d'onde pour 
les pistes audio ou des notes ou des régions pour 
les pistes MIDI, les sélections incluent les 
données sous-jacentes d'automation et de 
contrôleur. Lorsqu'une piste affiche des données 
d'automation, seules ces données sont 
concernées par les éditions.

3  Déplacez le sélecteur dans la piste pour 
sélectionner les données à supprimer.

– ou –

Utilisez l'outil d'accrochage de temps pour 
sélectionner une ou plusieurs régions (ou un 
groupe de notes MIDI).

4  Choisissez Edit > Clear pour supprimer la 
sélection.

Si une partie d'une région a été supprimée, de 
nouvelles régions sont créées automatiquement 
à partir des données se trouvant hors de la 
sélection. En mode Shuffle, les régions 
adjacentes se décalent de la distance nécessaire 
pour remplir l'espace vide.

Commandes spéciales couper, 
copier, coller et supprimer

Les quatre commandes « spéciales » du menu 
Edit (Cut Special, Copy Special, Paste Special et 
Clear Special) vous permettent d'éditer des 
playlists d'automation (automation du volume, 
du panoramique, de la coupure de son et des 
plug-in) de pistes audio, d'entrée auxiliaire, 
d'instrument et de fader principal. Vous pouvez 
utiliser également ces commandes pour les 
données du contrôleur MIDI.

Lorsque vous travaillez avec des données 
MIDI, vous pouvez fusionner le contenu du 
presse-papiers avec les données de la piste 
de destination. Pour en savoir plus, 
reportez-vous à la section Merge :, 
page 380.

Sur les systèmes Pro Tools HD, la 
commande Fill Paste permet de remplir une 
sélection avec le contenu du presse-papiers. 
Pour en savoir plus, reportez-vous à la 
section Repeat to Fill Selection, page 380.

Vous ne pouvez pas coller des données du 
contrôleur MIDI sur des données 
d'automation, et inversement.
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Cut Special

All Automation : coupe toutes les données 
d'automation ou du contrôleur MIDI, affichées 
ou non. 

Pan Automation : coupe uniquement les 
données de panoramique MIDI ou 
d'automation de panoramique, affichées ou 
non.

Plug-In Automation : coupe uniquement les 
données d'automation de plug-in affichées.

Copy Special

All Automation : copie toutes les données 
d'automation ou du contrôleur MIDI, affichées 
ou non. 

Pan Automation : copie uniquement les données 
de panoramique MIDI ou d'automation de 
panoramique, affichées ou non.

Plug-In Automation : copie uniquement les 
données d'automation de plug-in affichées.

Paste Special

Merge : colle les données du contrôleur MIDI du 
presse-papiers dans la sélection et les fusionne 
avec les données du contrôleur MIDI actif.

Repeat to Fill Selection : colle plusieurs 
itérations de régions audio ou MIDI, de données 
du contrôleur MIDI ou d'automation placées 
dans le presse-papiers pour remplir la sélection. 
Pour plus d'informations, reportez-vous à la 
section Repeat to Fill Selection, page 380.

To Current Automation Type : colle les données 
d'automation ou du contrôleur MIDI du presse-
papiers dans la sélection, en tant que type 
d'automation ou de contrôleur MIDI en cours. 
Vous pouvez ainsi copier des données 
d'automation sans distinction de type. Vous 

pouvez, par exemple, copier des données 
d'automation de panoramique à des données 
d'automation de plug-in ou copier des données 
de volume MIDI et les coller à des données de 
panoramique MIDI.

Clear Special

All Automation : supprime toutes les données 
d'automation ou du contrôleur MIDI, affichées 
ou non. 

Pan Automation : supprime uniquement les 
données d'automation de panoramique ou de 
panoramique MIDI, affichées ou non.

Plug-In Automation : supprime uniquement les 
données d'automation de plug-in affichées.

Pour plus d'informations sur l'utilisation des 
données d'automation, consultez le 
Chapitre 27, L'automation.

Repeat to Fill Selection

La commande Repeat to Fill Selection permet de 
remplir automatiquement une sélection avec 
des régions ou des données audio ou MIDI sans 
vous obliger à dupliquer manuellement les 
régions. Pour cela, coupez ou copiez une région 
audio ou MIDI, puis, après avoir effectué une 
sélection, utilisez la commande pour remplir la 
sélection. Lorsque vous collez des régions audio, 
vous êtes invité à paramétrer le crossfade à 
utiliser. 

Si vous remplissez une zone dont la taille est un 
multiple exact de celle de la région copiée (si, 
par exemple, vous remplissez 16 mesures avec 
une boucle de 4 mesures), la sélection copiée est 
collée autant de fois qu'il est nécessaire pour 
remplir la sélection. Si vous remplissez une zone 
qui n'est pas un multiple exact de la taille de la 
région copiée (si, par exemple, vous remplissez 
15 secondes avec un fond d'air ou une ambiance 
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trafic de 2 secondes), la zone de sélection 
restante est remplie par une version 
automatiquement rognée de la sélection 
d'origine.

Pour remplir une sélection à l'aide de la 
commande Repeat to Fill Selection :

1  Sélectionnez la région audio ou MIDI que 
vous voulez copier et choisissez Edit > Copy.

2  Sélectionnez la zone à remplir à l'aide du 
sélecteur, puis choisissez Edit > Paste Special > 
Repeat to Fill Selection.

3  Si vous collez des régions audio dans des zones 
plus grandes, la boîte de dialogue Batch Fades 
s'ouvre. Configurez la boîte de dialogue pour 
insérer des crossfades entre chaque région 
collée, puis cliquez sur OK.

– ou –

Si vous ne voulez pas de crossfades pour les 
données audio collées, cliquez sur Cancel dans 
la boîte de dialogue Batch Fades.

Edition sur plusieurs pistes

Lorsque vous travaillez avec des données de 
plusieurs pistes, vous devez prendre en 
considération un certain nombre de points 
importants. Par exemple, si des pistes 
sélectionnées sont réglées sur leur vue principale 
(voir Vues principales des pistes, page 274), les 
éditions concernent non seulement les données 
MIDI et audio des pistes sélectionnées, mais 
également toutes les données d'automation et de 
contrôleur.

Si toutes les pistes sélectionnées s'affichent sous 
forme de données d'automation, les éditions ne 
concernent que le type de données 
d'automation affiché dans chaque piste. 
De plus, si la piste 1 affiche l'automation du 
panoramique, la piste 2 affiche l'automation du 

niveau et la piste 3 affiche l'automation de 
coupure, la commande Cut ne coupe que les 
données de panoramique de la piste 1, les 
données de volume de la piste 2 et les données 
de coupure de la piste 3.

Pour ne copier que les données d'automation ou 
de contrôleur des pistes sélectionnées, appuyez 
sur Contrôle (Macintosh) ou sur Démarrer 
(Windows) pour copier tous les types 
d'automation sur toutes les pistes sélectionnées.

Pour effectuer un collage vers plusieurs pistes, 
appuyez sur la touche Maj et cliquez sur chaque 
piste de destination pour y définir le point 
d'insertion. Vous pouvez également 
sélectionner toutes les pistes, en cliquant sur 
une piste et en maintenant les touches 
Option+Maj (Macintosh) ou Alt+Maj 
(Windows) enfoncées, ou encore effectuer une 
sélection dans l'une des règles temporelles.

Lorsque vous collez plusieurs types de données, 
toute donnée copiée est collée dans le type de 
playlist qui lui correspond. Les données 
d'automation sont collées dans la playlist 
d'automation correspondante. Les données 
audio ou MIDI sont collées dans la playlist audio 
ou MIDI. Il n'est pas nécessaire de définir les 
pistes de destination en fonction du type de 
données à coller.

Si toutes les pistes de destination d'un collage 
mutipiste sont affichées sous forme 
d'automation, le collage remplace les données 
précédentes de la piste cible sans shuffling, que 
vous soyez en mode Slip ou Shuffle.

Pour plus de détails sur la sélection de 
données sur plusieurs pistes, consultez la 
section Sélection sur plusieurs pistes, 
page 341
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Commande Duplicate
La commande Duplicate copie une sélection et 
la place immédiatement après la fin de la 
sélection. Bien qu'elle soit similaire aux 
commandes Copy et Paste, la commande 
Duplicate est plus pratique et plus rapide, en 
particulier lorsque vous travaillez avec des 
données réparties sur plusieurs pistes. 

Pour effectuer plusieurs copies d'une sélection, 
utilisez la commande Repeat (voir Commande 
Repeat, page 383).

Comme avec les commandes Copy et Paste, un 
certain nombre de règle s'appliquent lorsque 
vous dupliquez des données sur plusieurs pistes. 
Pour en savoir plus, reportez-vous à la section 
Edition sur plusieurs pistes, page 381.

Pour dupliquer une sélection ou une région :

1  Si vous travaillez avec des données basées sur 
les mesures:temps, telles que des boucles, 
définissez l'échelle temporelle principale sur 
Bars:Beats.

2  Pour restreindre la sélection en fonction du 
pas de grille actuel, réglez le mode d'édition sur 
Grid. 

3  Déplacez le sélecteur dans la piste pour 
sélectionner les données à dupliquer.

– ou –

Cliquez dans la piste et entrez les points de 
début et de fin de la sélection dans la zone Event 
Edit.

4  Choisissez Edit > Duplicate. Les données sont 
placées immédiatement après le point de fin de 
la sélection.

En mode Shuffle, les données dupliquées sont 
placées directement après la fin de la sélection. 
Les régions qui se trouvent après sont décalées 
pour laisser la place aux données dupliquées. 
En mode Slip, les données dupliquées se 
superposent aux données adjacentes.

Lorsque vous utilisez les commandes Duplicate 
ou Repeat avec des notes MIDI sélectionnées via 
l'outil d'accrochage de temps, les données sont 
toujours dupliquées une mesure plus tard et 
sont fusionnées avec les données existantes de la 
piste (au lieu de les remplacer).

Duplication de données audio

Lorsque vous utilisez les commandes Duplicate 
(ou Repeat) avec des données audio qui doivent 
tomber parfaitement sur le temps (comme les 
boucles rythmiques), il est important de 
sélectionner les données audio à l'aide du 
sélecteur ou en tapant les points de début et de 
fin dans la zone Event Edit. Si vous sélectionnez 
une région audio à l'aide de l'outil d'accrochage 
de temps (ou en cliquant deux fois sur la région 
avec le sélecteur), les données peuvent être 
décalées de plusieurs tics du fait de l'arrondi à 
l'échantillon le plus proche.

Par ailleurs, si vous souhaitez dupliquer (ou 
répéter) des données audio qui ne sont pas 
basées sur les mesures:temps, réglez l'échelle 
temporelle sur un autre format que Bars:Beats. 
De la sorte, les données audio dupliquées 
posséderont le nombre correct d'échantillons et 
seront placées correctement.
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Commande Repeat
La commande Repeat est semblable à la 
commande Duplicate, mais elle permet de 
préciser le nombre désiré de duplications des 
données.

Comme avec les commandes Copy et Paste, un 
certain nombre de règle s'appliquent lorsque 
vous répétez des données sur plusieurs pistes. 
Pour en savoir plus, reportez-vous à la section 
Edition sur plusieurs pistes, page 381.

Pour coller plusieurs fois des données afin de 
remplir toute une sélection, reportez-vous à la 
section Repeat to Fill Selection, page 380.

Pour répéter une sélection ou une région :

1  Si vous travaillez avec des données basées sur 
les mesures:temps, telles que des boucles, 
définissez l'échelle temporelle principale sur 
Bars:Beats.

2  Pour restreindre la sélection en fonction du 
pas de grille actuel, réglez le mode d'édition sur 
Grid. 

3  Déplacez le sélecteur dans la piste pour 
sélectionner les données à répéter.

– ou –

Cliquez dans la piste et entrez les points de 
début et de fin de la sélection dans la zone Event 
Edit.

4  Choisissez Edit > Repeat. Dans la boîte de 
dialogue Repeat, entrez le nombre de répétitions 
des données et cliquez sur OK.

Les données sont placées immédiatement après 
le point de fin de la sélection et sont dupliquées 
autant de fois que vous l'avez indiqué.

En mode Shuffle, les données répétées sont 
placées directement après la fin de la sélection. 
Les régions qui se trouvent après sont décalées 
pour laisser la place aux données répétées. 
En mode Slip, les données répétées se 
superposent aux données adjacentes.

Edition de pistes stéréo et 
multicanaux
Les régions se trouvant sur des canaux 
individuels au sein de pistes stéréo et 
multicanaux ne peuvent être sélectionnées de 
façon indépendante. Toutes les sélections sur ces 
pistes sont basées sur le temps, ce qui signifie 
que les régions sélectionnées avec le sélecteur ou 
l'outil d'accrochage de temps s'étendent à 
chaque canal de la piste.

Lorsque des régions de pistes multicanaux sont 
éditées avec l'outil de trimming ou déplacées 
avec l'outil d'accrochage de temps, les données 
de chaque canal sont affectées de la même 
manière.

Boîte de dialogue Repeat
Chapitre 17 : Utilisation des régions et des sélections 383



384
Division des pistes sélectionnées

Pour éditer un canal spécifique d'une piste 
stéréo ou multicanal sans intervenir sur les 
autres canaux, vous pouvez la diviser en pistes 
mono séparées. Lorsque vous avez effectué vos 
éditions sur les données séparées, vous pouvez 
les déplacer ou les copier vers la piste multicanal 
d'origine.

Pour diviser une piste stéréo ou multicanal :

1  Dans la fenêtre Mix ou Edit, sélectionnez la 
piste à diviser en cliquant sur son nom. Pour 
diviser plusieurs pistes, maintenez la touche Maj 
enfoncée, pendant que vous cliquez sur des 
pistes supplémentaires.

2  Choisissez Track > Split Into Mono. Les 
régions provenant des canaux sur les pistes 
sélectionnées sont placées sur de nouvelles 
pistes audio mono.

Les noms des nouvelles pistes sont basés sur 
celui de la piste source et sur le suffixe du canal. 
Par exemple, après division d'une piste stéréo 
nommée « Funkit », deux nouvelles pistes 
baptisées « Funkit.L » et « Funkit.R » sont créées.

Les affectations de sortie et des signaux de 
départs ainsi que les paramètres de volume et de 
panoramique sont conservés dans les nouvelles 
pistes. Des équivalents mono des affectations de 
plug-in stéréo et multimono sont affectés aux 
nouvelles pistes ; les plug-in multicanaux ne 
sont pas affectés aux nouvelles pistes.

Déplacement de régions vers et à partir 
des pistes stéréo et multicanaux

Lorsque vous déplacez des régions vers ou à 
partir des pistes stéréo ou multicanaux, les règles 
suivantes s'appliquent :

◆ Si le nombre de pistes et de canaux sont 
identiques pour la source et la destination, vous 
pouvez déplacer des régions entre des pistes 
multicanaux et des pistes mono.

◆ La source et la destination des régions 
déplacées peuvent être mélangées. Par exemple, 
vous pouvez déplacer des régions d'une piste 5.0 
(contenant cinq canaux) vers une piste stéréo et 
trois pistes audio mono.

◆ Lorsque vous déplacez des régions 
multicanaux vers des pistes mono, les pistes de 
destination doivent être adjacentes.

◆ Lorsque vous déplacez des régions depuis des 
pistes mono vers une piste multicanal, les pistes 
source peuvent ne pas être adjacentes.

Les régions multicanaux peuvent également être 
déplacées de la liste des régions vers des pistes 
multicanaux de même format, des groupes de 
pistes audio mono ou une combinaison des 
deux. 

Déplacement d'une région stéréo vers deux pistes 
audio mono
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Inversement, un ensemble de régions mono 
uniques peut être déplacé de la liste des régions 
vers des pistes multicanaux, à condition que le 
nombre de régions déplacées corresponde au 
nombre de canaux de la piste de destination.

Traitement audio avec les 
plug-in AudioSuite
Les plug-in AudioSuite qui accompagnent votre 
système Pro Tools permettent de traiter et de 
modifier une région audio ou un fichier audio 
complet. Vous pouvez le faire pour appliquer un 
traitement AudioSuite particulier, par exemple 
la normalisation ou la suppression de 
composante continue, dont vous savez que vous 
l'appliquerez toujours systématiquement aux 
données audio.

Réparation de la forme d'onde 
avec le crayon
Le crayon permet de redessiner de façon 
destructive les données de la forme d'onde. 
Cet outil est couramment utilisé pour réparer un 
bruit ou un clic dans un fichier audio. Un clic 
apparaît sous la forme d'une pointe soudaine et 
franche dans une forme d'onde. Cet outil n'est 
actif que lorsque la fenêtre Edit effectue un 
zoom au niveau de l'échantillon.

Bien que vous puissiez annuler la modification 
du crayon, il est conseillé de créer une copie de 
sauvegarde de l'audio cible avant d'utiliser le 
crayon. Vous pouvez le faire en utilisant le plug-
in AudioSuite Duplicate.

Pour faire une copie d'une région audio :

1  Sélectionnez la région source dans la playlist 
de la piste.

2  Choisissez AudioSuite > Duplicate.

3  Dans la boîte de dialogue AudioSuite, vérifiez 
que « Playlist » est la préférence de traitement 
active et que l'option Use In Playlist est 
sélectionnée.

4  Cliquez sur le bouton Process.

Le plug-in AudioSuite Duplicate crée un fichier 
audio qui est une copie de l'original. La copie 
remplace l'original sur la piste, et est 
automatiquement renommée par le nom de la 
région suivi du suffixe DUPL.

Pour éditer de façon destructive une forme d'onde 
audio avec le crayon :

1  Recherchez la zone que vous souhaitez éditer.

2  A l'aide du Zoom ou des boutons de zoom, 
faites un zoom à l'échelle de l'échantillon de 
façon à afficher la forme d'onde comme une 
ligne continue fine. Réglez la hauteur de la piste 
pour éditer la forme d'onde avec la précision 
voulue.

Pour plus d'informations sur les plug-in 
AudioSuite, consultez le Guide des plug-in 
DigiRack.

Le crayon est un outil d'édition destructif 
qui modifie définitivement le fichier audio 
sur le disque et doit être utilisé avec 
beaucoup de précautions.

Vous pouvez rappeler des niveaux de zoom 
à l'aide de boutons présélections de zoom 
(voir Zoomer, page 304) ou 
d'emplacements mémoire (voir 
Emplacements mémoire et marqueurs, 
page 457).
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3  Sélectionnez le crayon.

4  Dessinez avec précaution la zone désirée de la 
forme d'onde à l'aide du crayon.

Pour des résultats satisfaisants, prenez soin de ne 
pas déborder. La commande Undo permet 
d'annuler votre dernière édition.

Essayez de limiter l'édition à une toute petite 
zone, et veillez à ce que vos « corrections » 
soient adaptées à la forme de la forme d'onde 
environnante. 

Groupes de régions
Un groupe de régions est un ensemble formé de 
plusieurs régions audio et MIDI qui s'affiche et 
agit comme une région unique. Les groupes de 
régions peuvent être créés sur une ou plusieurs 
pistes adjacentes audio, MIDI et d'instrument. 
Ils permettent de rassembler plusieurs régions 
en une macrorégion et facilitent ainsi la 
manipulation, l'édition et l'organisation des 
ambiances et du tempo. 

Les groupes de régions servent essentiellement 
de conteneur à une ou plusieurs régions. Sur les 
pistes, vous pouvez les placer à côté de régions 
standard et les modifier à l'aide des mêmes 
techniques d'édition de Pro Tools. Certaines 
modifications, telles que la coupure ou la 
suppression, effectuées sur un groupe 
s'appliquent à toutes les régions qu'il englobe. 
D'autres, telles que le rognage, ne s'appliquent 
qu'aux limites du groupe et n'ont aucune 
incidence sur les régions sous-jacentes.

Les groupes de régions s'avèrent 
particulièrement utiles pour les opérations 
suivantes :

• groupement d'une région audio basée sur une 
référence temporelle, ayant été divisée en une 
multitude de petites régions à l'aide de 
percussions individuelles ou d'un modèle à 
percussions. Vous pouvez facilement créer ces 
petites régions avec la commande Beat 
Detective ou Separate Region At Transients, 
ou les exporter en tant que fichiers REX et 
ACID.

• groupement de parties ou de sections pour 
une composition ou une organisation plus 
aisée, comme la copie de régions d'une section 
de cuivres d'un chœur à l'autre.

Crayon

Réparation d'un « pop » avec le crayon

Si vous ne parvenez pas à réaliser un zoom 
avant plus important pour effectuer vos 
corrections au crayon, vérifiez la longueur 
de la fenêtre Edit (session). Réduisez la 
longueur globale de la fenêtre Edit (session), 
si possible, jusqu'à ce que le crayon soit 
utilisable. 
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Création de groupes de régions

Pour créer un groupe de régions :

1  Sélectionnez une ou plusieurs régions d'une 
ou plusieurs pistes. Pour plus d'informations sur 
les groupes de régions multipiste, reportez-vous 
à la section Groupes de régions multipiste, 
page 388.

La longueur de la sélection détermine la durée 
du groupe de régions. Vous pouvez définir le 
début et la fin d'une sélection sur les limites 
d'une région, sur un espace vide ou même sur la 
partie centrale d'une région. Lors de la création 
d'un groupe de régions, si votre sélection 
démarre ou s'achève à l'intérieur d'une région, 
celle-ci est scindée à la limite de la sélection. 
Les groupes de régions créés à partir de 
sélections d'objets incorporent toutes les 
régions, sélectionnées ou non, situées entre la 
première et la dernière région que vous avez 
sélectionnée sur la piste.

2  Choisissez Region > Group.

Le groupe de régions apparaît comme une seule 
région et une icône de groupe de régions 
s'affiche dans le coin inférieur gauche. 
Les groupes de régions s'inscrivent également 
dans la liste des régions.

Format temporel des groupes de régions

Les groupes de régions sont créés dans le format 
temporel (basé sur des références temporelles ou 
des échantillons) des pistes qui les hébergent. 
Les groupes de régions multipistes peuvent 
inclurent à la fois des pistes basées sur des 
échantillons et des pistes basées sur des 
références temporelles.

Les groupes de régions sont entièrement 
indépendants des groupes de mixage et 
d'édition.

Sélection de régions à grouper sur une seule piste audio

Groupe de région sur une piste audio et dans la liste des 
régions

Groupe de régions sur une piste audio

Groupe de régions sur une piste MIDI

Vous pouvez créer des groupes de régions à 
partir de sélections vides. Cela s'avère 
particulièrement utile en mode Shuffle pour 
conserver les espaces entre les régions.

Icône de groupe 
de régions

Icône de groupes de régions audio

Icône de groupe de régions MIDI
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Annulation du groupement de régions

Pour annuler le groupement de régions :

1  Sélectionnez un groupe de régions. 

2  Choisissez Region > Ungroup.

Le groupe de régions est supprimé et toutes les 
régions sous-jacentes et groupes de régions 
emboîtés s'affichent. S'il existe plusieurs groupes 
de régions emboîtés, la commande Ungroup 
annule le groupement de la région de la couche 
supérieure, sans toucher aux groupes de régions 
sous-jacents.

Pour annuler le groupement d'un groupe de 
régions (et inclure tous les groupes de régions 
emboîtés qui s'y rapportent) :

1  Sélectionnez un groupe de régions.

2  Choisissez Region > Ungroup All.

Reconstitution de groupes de régions

La commande de menu Regroup annule la 
dernière commande Ungroup et réattribue aux 
régions leur ancien état de groupe. Ainsi, vous 
pouvez annuler le regroupement de régions, 
modifier les régions sous-jacentes comme vous 
le souhaitez, puis les regrouper de nouveau pour 
poursuivre vos opérations globales de 
composition et d'organisation.

Pour reconstituer un groupe de régions :

1  Sélectionnez une région appartenant à 
l'ancien groupe de régions à reconstituer.

2  Choisissez Region > Regroup.

Si vous aviez utilisé la commande Ungroup All, 
la commande Regroup recrée tous les anciens 
groupes de régions emboîtés.

3  Pour reconstituer un groupe de régions utilisé 
plusieurs fois au cours de la session, effectuez 
l'une des opérations suivantes dans la boîte de 
dialogue Change All qui s'affiche.

• Choisissez Modify pour appliquer les 
modifications à toutes les autres instances 
du groupe de régions. 

– ou –

• Choisissez Copy pour créer une copie et 
appliquer uniquement les modifications au 
groupe de régions copié. 

Groupes de régions multipiste

Les groupes de régions multipistes (groupes 
créés sur plusieurs pistes) facilitent le 
groupement de parties (pistes de percussions 
enregistrées à partir de plusieurs micro, par 
exemple) ainsi que la composition et 
l'organisation. Pour créer des groupes de régions 
multipiste, vous pouvez utiliser une 
combinaison quelconque de pistes audio, MIDI 
et d'instrument, basées sur des échantillons 
et/ou des références temporelles.

Les groupes de régions multipistes et 
monopistes fonctionnement de manière 
similaire. Les groupes de régions multipistes 
s'affichent sur plusieurs pistes adjacentes sous la 
forme d'un seul objet.

Les commandes de menu Group et Ungroup 
Region s'appliquent à toute sélection 
d'édition ou de temps, quelle que soit la vue 
de piste active.
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Pour créer un groupe de régions multipiste :

1  Sélectionnez plusieurs régions de pistes 
adjacentes.

2  Choisissez Region > Group.

Division de groupes de régions 
multipistes

L'insertion, le déplacement, le masquage et la 
suppression au sein d'un groupe de régions 
multipiste, bien que possible, peut provoquer la 
division du groupe. Lorsqu'un groupe de régions 
est divisé, une rupture apparaît dans l'icône de 
groupe de régions. Le groupe de régions divisé 
fonctionne toujours en tant que groupe unique, 
mais l'icône rompue indique un groupe 
inachevé ou divisé sur plusieurs pistes séparées.

Sélection de régions à grouper sur plusieurs pistes

Groupe de régions multipiste

Icône de groupe de régions

Groupe de régions multipiste mixte (données audio 
basées sur des échantillons et des références 
temporelles, et données MIDI basées sur des 
références temporelles)

Les groupes de régions multipistes créent des 
groupes de régions emboîtés par piste avant 
de les grouper sur plusieurs pistes.

La commande Regroup prend en charge les 
groupes de régions multipistes.

Icône de groupe de régions mixte
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L'une des opérations suivantes peut être à 
l'origine d'une division d'un groupe de régions :

• insertion d'une piste dans un groupe de 
régions multipiste ;

• déplacement d'une piste d'un groupe de 
régions multipiste occasionnant sa séparation 
d'avec les autres pistes du groupe ;

• masquage d'une piste faisant partie d'un 
groupe de régions multipiste ;

• suppression d'une piste faisant partie d'un 
groupe de régions multipiste ;

• modification du tempo d'un groupe mixte de 
régions basées sur des références temporelles 
et des échantillons ;

• enregistrement dans un groupe de régions ;

• modification d'une playlist sur une piste 
faisant partie d'un groupe de régions 
multipiste.

La division de groupes de régions peut s'avérer 
utile dans certains cas. Par exemple, si vous 
appliquez un accompagnement aux deux 
premiers vers d'une chanson, vous pouvez 
grouper les parties constituantes du premier vers 
et les copier en tant que groupe de régions pour 
le deuxième vers, tout en conservant une piste 
vocale continue entre les deux groupes de 
régions.

Groupes de régions sur des pistes 
basées sur des références 
temporelles

Lorsque vous modifiez le tempo, les groupes de 
régions sur les pistes basées sur des références 
temporelles règlent leur longueur en ajustant en 
conséquence la position de toutes leurs régions. 
Ce réglage s'avère particulièrement utile dans le 
cadre de l'organisation de données rythmiques 
et de la lecture de fichiers REX et ACID. 

Modification de la base de temps d'un 
groupe de régions

Vous pouvez modifier le format temporel d'un 
groupe de régions en effectuant les opérations 
suivantes :

• modification de la base de temps de la 
piste ;

• glisser-déposer du groupe de régions sur 
une piste dont la base de temps est 
différente.

Groupe de régions divisé après la suppression d'une 
piste

Icône de groupe de régions divisé

Pour supprimer une piste et conserver intact 
un groupe de régions, annulez d'abord le 
groupe de régions, puis supprimez la piste en 
question, et enfin reconstituez le groupe de 
régions. Le groupe de régions est recréé sans 
altération, à l'exception de la suppression de 
la piste.

Groupe de région sur une piste basée sur une référence 
temporelle de 120 BPM et de 160 BPM
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La modification de la base de temps crée une 
copie du groupe de régions d'origine. L'original 
et la copie s'affichent dans la liste des régions 
avec une base de temps différente.

Conversion d'échantillons en références 
temporelles

Le déplacement d'un groupe de régions d'une 
piste basée sur des échantillons vers une piste 
basée sur une référence temporelle ne modifie 
en rien sa longueur. En effet, les échantillons 
sont convertis en références temporelles après le 
déplacement du groupe sur la piste basée sur 
une référence temporelle. La longueur du 
groupe varie uniquement si le tempo est modifié 
par la suite. Dans la mesure du possible, ajustez 
le tempo local de la piste basée sur une référence 
temporelle sur le tempo du groupe de régions 
basé sur des échantillons avant le déplacement 
du groupe.

Conversion de références temporelles en 
échantillons

Le déplacement d'un groupe de régions d'une 
piste basée sur une référence temporelle vers 
une piste basée sur des échantillons ne modifie 
pas la longueur du groupe à moins qu'il ne soit 
déplacé vers un autre emplacement temporel 
pour lequel un tempo différent a été défini. En 
effet, les références temporelles sont converties 
en échantillons après le déplacement du groupe 
sur la piste basée sur des échantillons. 

Groupes de régions multipistes incluant des 
pistes basées sur des échantillons et des pistes 
basées sur des références temporelles

Les groupes de régions multipistes peuvent 
inclurent à la fois des pistes basées sur des 
échantillons et des pistes basées sur des 
références temporelles. La modification du 
tempo sépare les pistes basées sur des 
échantillons des pistes basées sur des références 
temporelles.

Edition des groupes de régions

L'édition des groupes de régions est similaire à 
celle des régions normales. Vous pouvez 
nommer, déplacer, couper, copier, coller, 
rogner, verrouiller les groupes de régions, en 
couper le son, etc. Il existe néanmoins quelques 
différences importantes. 

Edition des groupes de régions MIDI

Toute modification d'une région MIDI au sein 
d'un groupe de régions crée une copie de la 
région, qui est ensuite superposée au groupe de 
régions. Par exemple, une nouvelle région est 
créée sur le groupe de régions si vous effectuez 
un enregistrement, insérez une note, éditez les 
données du contrôleur MIDI ou quantifiez une 
sélection de timeline.

Groupe de régions multipiste dont les pistes basées sur 
des échantillons et les pistes basées sur des références 
temporelles ont été séparées après modification du 
tempo
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Edition des groupes de régions audio

Certaines commandes d'édition audio créent de 
nouvelles régions sur les groupes de régions. 
Pour les utiliser tout en conservant le groupe de 
régions, annulez le groupement des régions, 
effectuez les modifications, puis reconstituez le 
groupe.

Les commandes d'édition suivantes créent de 
nouvelles régions sur les groupes de régions :

• Le traitement AudioSuite d'une région 
groupée entraîne la création d'une région sur 
le groupe de régions.

• Le regroupement d'une sélection d'une région 
groupée crée un fichier audio et une région sur 
le groupe de régions.

• Un enregistrement dans un groupe de régions 
crée un fichier audio et une région sur un 
groupe de régions.

• Si vous redessinez une forme d'onde avec le 
crayon, une nouvelle région est créée sur le 
groupe de régions.

Tabulation vers transitoires et limites de 
régions

Si l'option Tab to Transients est activée, la 
touche Tab permet de déplacer le curseur vers les 
transitoires et les limites de région internes à un 
groupe de régions. 

Si l'option est désactivée, la touche Tab déplace 
le curseur vers les limites du groupe de régions 
uniquement (et le point de synchronisation, le 
cas échéant).

Rognage de groupes de régions

Le rognage de groupes de régions est identique à 
celui des régions normales, qu'il concerne un 
groupe de régions monopiste ou multipiste. 
L'outil de rognage TCE Trim fait figure 
d'exception. 

Le rognage d'un groupe de régions n'inclut pas 
les régions sous-jacentes. Celles-ci conservent 
leur longueur et leur emplacement. Cette règle 
s'applique à toutes les régions MIDI et audio 
sous-jacentes, ainsi qu'aux groupes de régions 
emboîtés. Ainsi, si vous écourtez un groupe de 
régions, ses régions sous-jacentes seront peut-
être inaudibles à la lecture si elles se retrouvent 
en dehors des limites du groupe. 

L'outil de rognage TCE Trim ne s'applique qu'à 
des régions audio et crée une nouvelle région sur 
les groupes de régions.

Après avoir rogné un groupe, si vous annulez le 
groupement, les régions audio se retrouvant en 
dehors des limites du groupe actif sont rognées 
et supprimées.

Enregistrement

Lors d'enregistrements audio ou MIDI, de 
nouvelles régions sont superposées, et non 
incluses, aux groupes de régions. Pour 
enregistrer dans un groupe de régions, annulez 
d'abord le groupement des régions, effectuez 
l'enregistrement, puis regroupez les régions. 
Le groupe de régions est recréé sans altération, à 
l'exception des nouvelles données de 
l'enregistrement.

Pour plus d'informations sur l'option Tab 
to Transients, reportez-vous à la section 
Tabulation vers transitoires, page 343.
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Fondus et crossfades sur les 
groupes de régions

Tout comme les régions normales, les groupes 
de régions peuvent comporter des fondus et des 
crossfades. Toutefois, les fondus s'appliquent 
uniquement aux régions audio. Vous pouvez 
effectuer un crossfade entre groupes de régions, 
mais aussi entre groupes de régions et régions 
audio normales.

Importation et exportation de 
fichiers de groupe de régions

Avec Pro Tools, vous pouvez exporter et 
importer les nouveaux fichiers de groupe de 
régions au format .rgrp. L'importation et 
l'exportation de fichiers de groupe de régions 
vous permet d'effectuer les opérations 
suivantes :

• séparer les métadonnées des groupes de 
régions des fichiers audio pour éviter les 
opérations de copie de fichiers inutiles lors 
de l'exportation de groupes de régions 
audio composés de plusieurs fichiers 
source ;

• exporter des données MIDI sous forme de 
groupe de régions ;

• créer des boucles multipistes.

Les fichiers de groupe de régions permettent de 
stocker les données suivantes :

• références à tous les fichiers audio du 
groupe de régions ;

• noms et emplacement relatif des régions 
sur les pistes ;

• fondus et crossfades ;

• noms et formats (monopiste ou multipiste) 
des régions ;

• toutes les données MIDI du groupe de 
régions (notes, contrôleurs, données Sysex, 
etc.) ;

• nom des pistes.

Les fichiers de groupe de régions ne permettent 
pas de stocker les données suivantes :

• automation ;

• plug-in ;

• assignation des pistes ;

• table de tempo et de mesure ;

• informations sur la liste des régions.

Deux groupes de régions multipistes avec crossfades 
sur les pistes audio et sans crossfades sur les pistes 
MIDI

L'annulation du groupement de régions 
supprime les fondus et crossfades au niveau 
du groupe. Ils sont restaurés dès que le 
groupe est reconstitué.
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Pour exporter un groupe de régions sans ses 
fichiers audio :

1  Sélectionnez un ou plusieurs groupes de 
régions dans la liste des régions.

2  Dans le menu déroulant de la liste des régions, 
choisissez Export Region Groups. La boîte de 
dialogue correspondante s'affiche.

3  Par défaut, le répertoire de destination 
correspond au dossier Region Groups créé 
automatiquement dans le dossier de la session. 
Pour en changer, cliquez sur le bouton Choose, 
recherchez l'emplacement souhaité, puis cliquez 
sur Choose. Cliquez sur Reset pour rétablir le 
répertoire de destination par défaut.

4  Pour résoudre les problèmes liés à la 
duplication de noms de fichiers de groupe de 
régions, activez l'une des options suivantes :

• Prompting for Each Duplicate (option par 
défaut)

• Auto Renaming

• Replacing with New Files

5  Cliquez sur OK. 

Exportation de groupes de régions avec fichiers 
audio

En règle générale, avant d'exporter un groupe de 
régions sur un autre disque dur, il est conseillé 
de copier ses fichiers audio référencés. Vous 
pourrez ainsi transférer des groupes de régions 
non seulement d'une session à une autre, mais 
aussi d'un système à un autre.

Pour exporter un groupe de régions avec ses 
fichiers audio :

1  Exportez un ou plusieurs groupes de régions 
vers le disque dur de votre choix.

2  Créez une session sur le nouveau disque dur et 
activez l'option Automatically Copy Files on 
Import.

3  Importez tous les groupes de régions 
précédemment exportés. 

Le dossier des fichiers audio de la nouvelle 
session contient à présent tous les fichiers 
référencés par les groupes de régions.

Importation d'un groupe de régions

Pour importer un groupe de régions :

■ Faites glisser le fichier de groupe de régions à 
partir d'un navigateur DigiBase ou depuis 
l'Explorateur Windows ou le Finder Macintosh 
et déposez-le dans la timeline, sur une piste, 
dans la liste des pistes ou dans la liste des 
régions.

Selon l'emplacement choisi, les conséquences 
sont les suivantes :

• Lorsque vous déposez un groupe de régions 
sur une piste, Pro Tools recherche un format 
de piste correspondant, vérifie le nombre de 
canaux et (dans le cas de groupes de régions 
multipistes) s'assure qu'il y a suffisamment de 
pistes adjacentes correspondantes pour 

Boîte de dialogue Export Region Groups
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importer le fichier de groupe de régions. S'il 
répond à ces critères, le groupe de régions est 
importé et placé à l'endroit choisi sur la ou les 
pistes.

• Lorsque vous déposez un groupe de régions 
sur la timeline ou la liste des pistes, le 
programme crée de nouvelles pistes pour le 
groupe de régions importé. 

• Lorsque vous déposez un groupe de régions 
dans la liste des régions, le programme y 
ajoute un nouveau groupe de régions. Toutes 
les régions audio et MIDI et même les autres 
groupes de régions contenus dans le groupe 
de régions déposé apparaissent également 
dans la liste des régions. 

Mise en boucle de régions
Les régions audio et MIDI ainsi que les groupes 
de régions peuvent être mis en boucle à l'aide 
des commandes de menu Region > Loop et 
Unloop. Dans le cadre de la composition et de 
l'organisation des données audio, la mise en 
boucle de régions est un moyen simple et 
efficace de répéter une région sur une piste ou 
plusieurs régions sur plusieurs pistes. La mise en 
boucle des régions offre plus de souplesse que les 
commandes de menu classiques Repeat et 
Duplicate de Pro Tools.

La mise en boucle de régions consiste à répéter la 
région source autant de fois que le spécifie la 
boîte de dialogue Region Looping ou de manière 
à combler la longueur de boucle indiquée 
(30 secondes ou jusqu'à la région suivante sur la 
piste, par exemple). La région source correspond à 
la région d'origine sélectionnée pour la mise en 
boucle. Les itérations de boucle correspondent 
aux régions mises en boucle qui suivent la 
région source. Si vous n'avez pas défini le 

nombre de répétitions, la dernière itération de 
boucle est tronquée de sorte à combler la 
sélection jusqu'au point de fin ou jusqu'à la 
longueur de boucle spécifiée.

Une fois mise en boucle, une région s'édite de la 
même manière qu'un groupe de régions. 
Par exemple, lorsque vous déplacez une région 
mise en boucle, vous déplacez la région source 
en même temps que toutes ses itérations de 
boucle.

Les régions mises en boucle (toutes les 
itérations) sont signalées par une icône de 
boucle située dans l'angle inférieur droit. 

Région mise en boucle

La mise en boucle d'une région ne 
s'applique pas à l'automation associée à la 
région source.

Pour copier l'automation définie pour la 
boucle source sur les itérations de boucle, 
utilisez les commandes Copy Special et 
Paste Special Repeat To Fill Selection (voir 
la section Automation et régions mises en 
boucle, page 399).

Icônes de boucle

Région source Itérations de boucle

Région mise en boucle
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Création de boucles de régions

Pour mettre en boucle une région :

1  Sélectionnez une région audio ou MIDI, ou un 
groupe de régions. 

2  Choisissez Region > Loop. La boîte de dialogue 
Region Looping s'affiche.

3  Effectuez l'une des opérations suivantes :

• Sélectionnez l'option Number of Loops et 
entrez le nombre de fois que vous souhaitez 
répéter la région.

• Sélectionnez l'option Loop Length et 
entrez la durée selon la base de temps 
principale. S'il ne s'agit pas d'un multiple 
exact de la durée de la boucle source, la 
dernière itération de boucle est tronquée.

• Sélectionnez l'option Loop Until End of 
Session or Next Region. La région mise en 
boucle est répétée jusqu'à la région 
suivante sur la piste ou jusqu'à la fin de la 
session. La dernière itération de boucle est 
ajustée par troncation.

4  Si vous le souhaitez, vous pouvez sélectionner 
l'option Enable Crossfade pour créer un 
crossfade au point de boucle. Pour modifier le 
crossfade de boucle :

• Cliquez sur le bouton Settings.

• Configurez les crossfades de boucle.

• Cliquez sur OK.

5  Dans la boîte de dialogue Region Looping, 
cliquez sur OK.

Pour renommer la région mise en boucle 
uniquement (ou la région et le fichier de disque) :

■ Cliquez deux fois sur l'icône de boucle à l'aide 
de la main.

Vous pouvez aussi sélectionner des régions 
sur plusieurs pistes.

Si vous sélectionnez plusieurs régions sur 
une même piste, seule la première région de 
votre sélection sera mise en boucle.

Boîte de dialogue Region Looping

Boîte de dialogue Loop Crossfade
Guide de référence Pro Tools



Pour annuler la mise en boucle une région :

1  Sélectionnez la région mise en boucle.

2  Choisissez Region > Unloop. La boîte de 
dialogue Unloop Regions s'affiche.

3  Effectuez l'une des opérations suivantes :

• Cliquez sur Remove pour annuler la mise 
en boucle et supprimer toutes les itérations, 
exception faite de la première boucle 
complète.

– ou –

• Cliquez sur Flatten pour annuler la mise en 
boucle et créer une région pour chaque 
itération de boucle.

Pour annuler la mise en boucle et le groupement 
d'une sélection de régions :

1  Sélectionnez une région mise en boucle 
contenant un ou plusieurs groupes de régions.

2  Choisissez Region > Ungroup All.

Annulation de boucle et mise à plat de régions 
à l'aide des commandes de menu Separate 
Regions

Les commandes Separate Regions (At Selection, 
On Grid et At Transients) annulent 
automatiquement la mise en boucle de régions 
et les aplanit avant la séparation.

Modification de régions mises en 
boucle

Les régions mises en boucle peuvent être 
modifiées en tant que régions individuelles ou 
groupes de régions. Par exemple, lorsque vous 
utilisez la main pour sélectionner une région 
mise en boucle, vous sélectionnez la boucle dans 
son intégralité (région source et itérations de 
boucle). En revanche, un clic sur l'icône de 
boucle d'une itération sélectionne uniquement 
l'itération correspondante.

Le déplacement d'une région en boucle déplace 
à la fois la région source et tous les alias mis en 
boucle qui s'y rapportent. Les itérations de 
boucle ne peuvent pas être déplacées sans leur 
région source. Si vous déplacez ou collez une 
région plus courte sur une région mise en 
boucle, la boucle ne s'arrête pas après la nouvelle 
région. Les parties constituantes d'une région 
mise en boucle ne peuvent pas être ajustées 
séparément.

Pour sélectionner une région mise en boucle dans 
son ensemble, effectuez l'une des opérations 
suivantes :

■ Cliquez une fois sur la région mise en boucle à 
l'aide de la main ou de l'outil Smart. 

– ou –

■ Cliquez deux fois sur la région mise en boucle 
à l'aide du sélecteur.

La région source et toutes ses itérations de 
boucle sont sélectionnées.

Boîte de dialogue Unloop Regions

La commande Region Ungroup a le même 
effet sur les boucles que le bouton Flatten de 
la commande Unloop.
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Pour sélectionner une région source ou une 
itération de boucle individuellement, effectuez 
l'une des opérations suivantes :

■ Cliquez une fois sur l'icône de boucle de la 
région source ou d'une itération de boucle à 
l'aide de la main ou de l'outil Smart.

– ou –

■ A l'aide du sélecteur, cliquez une fois sur 
l'icône de région en boucle et sélectionnez la 
région en déplaçant le curseur vers la gauche.

Tabulation vers transitoires et limites de 
régions

L'option Tab to Transients déplace le curseur 
vers les transitoires et les limites internes d'une 
région mise en boucle. La tabulation normale 
(option Tab to Transients désactivée) déplace le 
curseur vers les limites de début et de fin de la 
région mise en boucle.

Rognage de régions mises en boucle

Pour rogner les régions en boucle, vous disposez 
de l'outil de trimming, de l'outil de trimming de 
boucle et des commandes Trim Region. L'outil 
de trimming rogne la région mise en boucle 
dans son ensemble. L'outil de trimming de 
boucle est l'outil d'édition de boucle le plus 
complet. Il permet de rogner la durée de chaque 
itération de boucle, tout en comblant la durée 
totale de la région mise en boucle.

Pour rogner une région mise en boucle dans son 
ensemble :

1  Sélectionnez l'outil Scrub Trim ou l'outil de 
trimming standard.

2  Effectuez le rognage voulu du début ou de la 
fin de la région en boucle.

Pour rogner une région mise en boucle à l'aide de 
l'outil de trimming de boucle :

1  Sélectionnez l'outil Scrub Trim ou l'outil de 
trimming standard.

2  Déplacez le curseur sur une icône de boucle 
dans la région mise en boucle. Le curseur est 
remplacé par l'icône de l'outil de trimming de 
boucle.

Rognage d'une région en boucle à l'aide de l'outil de 
trimming standard

Pour un rognage d'itérations de boucle par 
incrément, maintenez la touche Démarrer 
(Windows) ou Contrôle (Macintosh) 
enfoncée.

Le rognage d'une boucle n'affecte pas les 
fondus sous-jacents.

L'outil de trimming TCE annule la mise en 
boucle et consolide la région.

Rognage d'une boucle à l'aide de l'outil de trimming de 
boucle

Outil de trimming de boucle
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3  Effectuez le rognage voulu du début ou de la 
fin de l'itération de boucle.

Le nombre de répétitions de la boucle rognée 
varie de sorte à combler la longueur de 
l'ensemble de la région mise en boucle.

Pour rogner une sélection au sein d'une région 
mise en boucle :

1  A l'aide du sélecteur, effectuez une sélection 
d'édition portant sur la totalité ou une partie 
d'une région mise en boucle.

2  Choisissez Edit > Trim Region, puis l'une des 
commandes de rognage de région (To Selection, 
To Fill Selection, Start to Fill Selection, End to 
Fill Selection).

Si vous étendez vers la gauche la région source 
avec l'outil de trimming pour englober 
l'ensemble de la boucle, la région source se 
déplace en amont de la timeline et des itérations 
de boucle comblent l'espace jusqu'au point de 
fin de la dernière itération de boucle originale. 
Si le rognage vers la gauche ne concerne qu'une 
partie de la durée de la région source, celle-ci 
n'est pas déplacée et une itération de boucle 
partielle est créée sur sa gauche. Cette fonction 
vous permet d'effectuer de rapides changements 
de vos compositions. En effet, vous pouvez 
utiliser des boucles partielles en tant que levés 
ou étendre des effets sonores mis en boucle et 
une ambiance en amont d'une musique de film.

Automation et régions mises en 
boucle

La mise en boucle d'une région audio ne 
s'applique pas à l'automation associée à la région 
source. L'automation peut donc être appliquée 
sur toute une région mise en boucle. 
Par exemple, vous pouvez insérer un fondu sur 
une partie ou la totalité d'une région mise en 
boucle. 

Vous pouvez aussi répéter l'automation sur 
chaque boucle. En ce qui concerne les régions 
audio mises en boucle, utilisez les commandes 
Copy Special et Paste Special Repeat to Fill 
Selection afin de copier et coller tout ou partie 
des données d'automation de la région source 
vers tout ou partie des itérations de boucle qui 
lui sont associées. 

Pour copier et coller les données d'automation 
depuis une région source vers des itérations de 
boucle :

1  Sélectionnez la région source.

2  Choisissez Edit > Copy Special, puis l'une des 
commandes Copy Special (All Automation, Pan 
Automation, Plug-In Automation) en fonction 
du type des données d'automation à copier.

3  Sélectionnez la région mise en boucle.

4  Choisissez Edit > Paste Special > Repeat to Fill 
Selection.

Rognage d'une région mise en boucle à l'aide de l'outil 
de trimming de boucle

Option Pan automation de la commande Special Copy

Option Pan automation de la commande Special Paste 
to Fill Selection
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Chapitre 18 : Fondus et Crossfades

Utilisation des Crossfades
Vous pouvez réaliser rapidement et facilement 
un crossfade entre deux régions audio 
adjacentes. Le crossfading (fondu enchaîné) 
consiste à fondre deux régions audio pour éviter 
les clics ou les changements de niveau soudains. 
Les crossfades trouvent de nombreuses 
applications, du « lissage » des transitions entre 
régions à la création d'effets spéciaux. Vous 
pouvez définir la durée, la position et la forme 
des crossfades.

Les crossfades sont calculés puis écrits sur le 
disque. Les crossfades écrits sur le disque sont 
stockés dans un dossier nommé Fade Files, 
contenu dans le dossier de la session. Lorsque 
vous lisez votre piste, Pro Tools lit et joue le 
fichier de crossfade à partir du disque.

Pro Tools ne permet pas de remplacer des 
fondus d'entrée et des fondus de sortie par des 
crossfades. Pour ajouter un crossfade entre des 
régions, tous les fondus d'entrée et fondus de 
sortie existants entre les régions doivent 
préalablement être supprimés. 

A propos des crossfades et des 
courbes

Pour créer un crossfade (fondu enchaîné) entre 
deux régions, utilisez le sélecteur pour 
sélectionner à la fois le point de fin de la 
première région et le point de début de la 
seconde. C'est la longueur de cette sélection qui 
détermine la longueur du crossfade. Bien que les 
fondus puissent apparaître comme des régions à 
part entière, ils ne peuvent en fait être séparés 
des régions dans lesquels ils ont été créés. 
Vous pouvez toutefois créer des fondus d'entrée 
(fade-in) et de sortie (fade-out) pour des régions 
individuelles (voir Création de fondus aux 
débuts et aux fins des régions, page 410).

Utilisez la boîte de dialogue Fades pour 
sélectionner, visualiser et manipuler les courbes 
servant à réaliser les crossfades. Vous pouvez 
affecter différentes courbes de niveau aux 
portions de fondu d'entrée et de sortie d'un 
crossfade. La boîte de dialogue Fades offre 
également un aperçu du fondu.

L'exemple qui suit illustre des types de crossfade 
courants et explique comment le type de 
sélection que vous réalisez détermine le 
caractère du crossfade.

Pro Tools HD inclut une fonction Auto 
Fade qui permet de réaliser des fondus en 
temps réel, sans devoir les enregistrer au 
préalable sur le disque. Reportez-vous à la 
section Utilisation des fondus 
automatiques, page 411. 

 Les crossfades étant créés par fondu 
enchaîné entre des données audio 
superposées, il n'est pas possible de les 
réaliser sur des régions ne contenant pas de 
données au-delà de leurs limites.
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Crossfade standard (centré)

Ce type de sélection crée un crossfade des deux 
côtés du point de jonction, qui a une incidence 
sur le niveau de la région 1 et de la région 2. 
C'est le type de crossfade le plus courant.

Ce type de crossfade implique que la région 1 
contienne des données audio au-delà de son 
point de fin et que la région  2 contienne des 
données audio avant son point de début.

Pré crossfade

Ce type de sélection crée un crossfade avant le 
point de jonction. Ceci permet de conserver le 
niveau nominal du tout début de la région 2 au 
lieu de lui faire subir un fondu, ce qui est utile 
lorsque vous souhaitez conserver une attaque 
forte au début de cette région. Lorsque vous 
effectuez des sélections de crossfades 
intervenant sur le bord de deux régions, vous 
pouvez utiliser la touche de tabulation pour 
déplacer le curseur exactement au début ou à la 
fin d'une région.

Ce type de crossfade implique que la région 2 
contienne des données audio avant son point de 
début.

Post crossfade

Ce type de sélection crée un crossfade après le 
point de jonction. Il est utile lorsque vous 
souhaitez conserver l'amplitude de la région 1 
jusqu'au bout. Lorsque vous effectuez des 
sélections de crossfades intervenant sur le bord 
de deux régions, vous pouvez utiliser la touche 
de tabulation pour déplacer le curseur 
exactement au début ou à la fin d'une région.

Ce type de crossfade nécessite que la région 1 
contienne des données audio au-delà de son 
point de fin.

Crossfade centré

Pré crossfade

region 1

fade out�
curve

fade in�
curve

region 2

splice point

crossfade selection

region 1 region 2

border of region 1 and 2

selection range extends just up to beginning of region 2

Post crossfade

region 1 region 2

border of region 1 and 2

selection range begins just after end of region 1
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Boîte de dialogue Fades

Lorsque vous choisissez la commande Edit > 
Fades, utilisez la boîte de dialogue Fades pour 
sélectionner, visualiser et manipuler le crossfade 
et pour éditer les courbes permettant d'obtenir 
ce crossfade.

Les contrôles de la boîte de dialogue Fades sont 
les suivants :

Audition : 

cliquez sur ce bouton pour écouter votre 
crossfade. Pro Tools prend en charge l'écoute de 
crossfades directement depuis les sorties de 
l'interface audio.

Vue de la première piste : 

si vous réalisez un fondu entre plusieurs pistes, 
ce bouton permet de voir et d'obtenir un aperçu 
des données audio de la première paire de pistes 
adjacentes.

Vue de la seconde piste : 

si vous réalisez un fondu entre plusieurs pistes, 
ce bouton permet de voir et d'obtenir un aperçu 
des données audio de la seconde paire de pistes 
adjacentes.

Vue des deux pistes : 

cliquez sur ce bouton pour afficher les formes 
d'onde des deux premières pistes adjacentes 
dans un fondu entre plusieurs pistes. 

Fondu des courbes seulement : 

cliquez sur ce bouton pour afficher les courbes 
de fondu spécifiées sans visualisation des formes 
d'onde audio. C'est l'option par défaut lorsque 
vous ouvrez la boîte de dialogue Fades.

Courbes de fondus et formes d'onde séparées : 

cliquez sur ce bouton pour afficher les courbes 
de fondu spécifiées ainsi que des vues séparées 
des formes d'onde du fondu d'entrée (fade-in) et 
de sortie (fade-out).

Courbes de fondus et formes d'onde 
superposées : 

cliquez sur ce bouton pour afficher les courbes 
de fondu spécifiées ainsi que des vues 
superposées des formes d'onde en entrée et en 
sortie de fondu. 

Boîte de dialogue Fades
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Courbes fondues et somme des formes d'onde : 

cliquez sur ce bouton pour afficher les courbes 
de fondu spécifiées ainsi qu'une seule forme 
d'onde représentant la somme des données 
audio du crossfade.

Zoom avant : 

cliquez sur ce bouton pour agrandir l'échelle de 
la vue de l'amplitude de la forme d'onde. 
Cliquez sur l'échelle de la vue par défaut en 
maintenant enfoncée la touche Pomme 
(Macintosh) ou Ctrl (Windows).

Zoom arrière : 

cliquez sur ce bouton pour réduire l'échelle de la 
vue de l'amplitude de la forme d'onde. Cliquez 
sur l'échelle de la vue par défaut en maintenant 
enfoncée la touche Pomme (Macintosh) ou Ctrl 
(Windows).

Réglage de la forme du fondu en sortie

Le paramètre Out Shape permet de définir la 
forme du fondu de sortie à partir de la région 1. 

Standard : sélectionne une courbe de fondu 
unique et continue. Ceci crée un fondu 
universel, susceptible d'être édité en déplaçant 
la courbe elle-même.

Courbe en S : sélectionne une courbe en S, dont 
les caractéristiques s'inversent au début et à la 
fin. Ceci permet, par exemple, d'obtenir un 
fondu de sortie plus rapide au début de la courbe 
et plus lent en sortie. Les courbes en S sont utiles 
avec les données sur lesquelles les crossfades 
sont difficiles à réaliser. Les courbes en S 
peuvent être éditées en faisant glisser la courbe 
dans l'éditeur de courbes.

Courbes présélectionnées : sept courbes 
présélectionnées sont à votre disposition pour 
faciliter la création rapide de crossfades. Ces 
présélections peuvent être éditées en faisant 
glisser le point de fin de la courbe dans l'éditeur 
de courbe de cette boîte de dialogue. Ces sept 
présélections sont les suivantes :

◆ La présélection de courbe 1 maintient le 
niveau nominal de la région 1 pendant tout le 
crossfade, puis fait chuter immédiatement le 
volume à la fin du crossfade.

◆ La présélection de courbe 2 effectue le fondu 
de sortie de la région 1 relativement lentement, 
en conservant un niveau assez élevé pendant 
toute la durée du fondu.

◆ La présélection de courbe 3 effectue le fondu 
de sortie de la région 1 relativement 
rapidement, en conservant un niveau un peu 
moins élevé pendant le fondu.

Forme du fondu en sortie

Présélection de courbe 1

Présélection de courbe 2

Présélection de courbe 3
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◆ La présélection de courbe 4 effectue le fondu 
de sortie de la région 1 de façon linéaire. C'est la 
courbe par défaut.

◆ La présélection de courbe 5 effectue le fondu 
de sortie de la région 1 rapidement au début du 
crossfade.

◆ La présélection de courbe 6 fait chuter le 
niveau de la région 1 encore plus rapidement au 
début du crossfade.

◆ La présélection de courbe 7 coupe le son de la 
région 1 au début du crossfade.

Réglage des liens

Le paramètre de liaison (Link) relie les courbes 
sélectionnées de fondu en entrée et en sortie. 
Si vous modifiez une des courbes, l'autre est 
également modifiée. Ceci garantit que le 

crossfade résultant est un crossfade maintenant 
une puissance constante ou un gain constant, 
suivant celui que vous sélectionnez.

Equal Power : l'option Equal Power est 
recommandée pour les données dont la phase 
n'est pas cohérente, comme dans le cas d'un 
crossfade entre deux types d'éléments 
complètement différents. Utilisez cette option 
pour éviter la chute de niveau qui peut se 
produire avec un crossfade de gain égal. Avec ce 
type de fondu, cliquer sur la courbe tout en 
appuyant sur la touche Option (Macintosh) ou 
Alt (Windows) la réinitialise à sa forme par 
défaut.

Equal Gain : cette option est recommandée pour 
les données qui sont cohérentes en phase ou 
presque, comme dans le cas d'un crossfade entre 
deux régions ou instruments identiques (une 
boucle de batterie répétée, par exemple). Utilisez 
cette option pour éviter l'écrêtage qui peut se 
produire avec un crossfade de puissance égale. 
Avec ce type de fondu, cliquer sur la courbe tout 
en appuyant sur la touche Option (Macintosh) 
ou Alt (Windows) la réinitialise à sa forme par 
défaut.

None : désactive la liaison entre les courbes de 
fondu d'entrée et de sortie, ce qui permet de les 
régler séparément, notamment leurs points de 
début et de fin. Cette commande permet de 
créer des formes de crossfade personnalisées. 
Pour n'éditer que le fondu d'entrée de la courbe, 
appuyez sur Option (Macintosh) ou sur Alt 
(Windows) tout en vous déplaçant. Pour n'éditer 
que le fondu de sortie de la courbe, appuyez sur 
Pomme (Macintosh) ou sur Ctrl (Windows) tout 
en vous déplaçant.

Présélection de courbe 4

Présélection de courbe 5

Présélection de courbe 6

Présélection de courbe 7

Liaison de fondu
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Option Use Dither

L'option Use Dither active une fonction 
présélectionnée de dithering avec mise en forme 
du bruit (noise shaping) qui améliore les 
performances audio lors du fondu au silence 
entrée ou en sortie, ou du crossfade entre deux 
régions de faible niveau. Le dithering n'est 
généralement pas utile lorsque vous réalisez le 
fondu entre deux régions d'amplitude élevée. 
Vous pouvez désactiver le dithering lorsque 
vous éditez vos crossfades dans la boîte de 
dialogue Fades pour accélérer les aperçus et le 
recalcul du fondu, puis réactiver le dithering 
pour créer le crossfade final.

Réglage de la forme du fondu d'entrée

Le paramètre de forme du fondu d'entrée permet 
de définir la forme du fondu d'entrée de la 
région 2.

Standard : sélectionne une courbe de fondu 
unique et continue. Ceci crée un fondu 
universel, susceptible d'être édité en déplaçant 
la courbe elle-même.

Courbe en S : sélectionne une courbe en S, dont 
les caractéristiques s'inversent au début et à la 
fin. On peut ainsi avoir un fondu d'entrée rapide 
en début de courbe et plus lent en fin. Les 
courbes en S sont utiles avec les données sur 
lesquelles les crossfades sont difficiles à réaliser. 
Les courbes en S peuvent être éditées en faisant 
glisser la courbe dans l'éditeur de courbes.

Courbes présélectionnées : sept courbes 
présélectionnées sont à votre disposition pour 
faciliter la création rapide de crossfades. Ces 
présélections peuvent être éditées en faisant 
glisser le point de fin de la courbe dans l'éditeur 
de courbe de cette boîte de dialogue. Ces sept 
présélections sont les suivantes :

◆ La présélection de courbe 1 effectue un fondu 
d'entrée au niveau nominal de la région 2 
immédiatement en début du crossfade, puis 
maintient ce niveau pendant toute la durée du 
crossfade.

◆ La présélection de courbe 2 effectue un fondu 
d'entrée rapide sur la région 2, pour atteindre le 
niveau nominal assez tôt dans la courbe de 
crossfade.

Réglage du point de fin d'une courbe de fondu

Option de dithering pour le fondu

Forme du fondu d'entrée

Présélection de courbe 1

Présélection de courbe 2
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◆ La présélection de courbe 3 effectue le fondu 
d'entrée sur la région 2 de façon modérément 
rapide.

◆ La présélection de courbe 4 effectue le fondu 
d'entrée sur la région 2 de façon linéaire. C'est la 
courbe par défaut.

◆ La présélection de courbe 5 effectue le fondu 
d'entrée sur la région 2 plus lentement en début 
du crossfade.

◆ La présélection de courbe 6 effectue le fondu 
d'entrée sur la région 2 encore plus lentement 
que la courbe précédente.

◆ La présélection de courbe 7 coupe le son de la 
région 2 jusqu'à la fin du crossfade.

Combinaisons classiques de courbes

Vous trouverez ci-après les combinaisons 
possibles de courbes de fondu d'entrée et de 
sortie.

Crossfade linéaire : il s'agit d'un crossfade 
(fondu enchaîné) polyvalent, créant une 
transition douce et progressive entre la région 1 
et la région 2.

Crossfade à puissance constante : il s'agit d'un 
crossfade polyvalent qui est utile lorsqu'un 
crossfade linéaire semble créer un chute notable 
de niveau au point de jonction.

Fondu avec recouvrement : cette combinaison 
de courbes maintient les deux régions à niveau 
nominal pendant toute la durée du crossfade : 
la région 2 « monte en marche » au début, et la 
région 1 « descend en marche » à la fin.

Présélection de courbe 3

Présélection de courbe 4

Présélection de courbe 5

Présélection de courbe 6

Présélection de courbe 7

Crossfade linéaire

Crossfade à puissance constante

Crossfade avec recouvrement

1-out 2-in

1-out 2-in

1-out

2-in
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Préférences de fondus et de 
crossfades

(Pro Tools HD uniquement)

Vous pouvez définir des paramètres de fondu et 
de crossfade par défaut. Ces paramètres se 
chargent comme paramètres « de base » lorsque 
vous utilisez la commande Create Fades, ainsi 
que les commandes Fade to Start et Fade to End.

Pour définir les préférences de crossfade :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Editing.

2  Définissez les durées de pré-roll et de post-roll 
pour les aperçus de fondu.

3  Cliquez sur Fade In et définissez la forme par 
défaut des fondus d'entrée, puis cliquez sur OK.

4  Cliquez sur Fade Out et définissez la forme par 
défaut des fondus de sortie, puis cliquez sur OK.

5  Cliquez sur Crossfade et définissez la forme 
par défaut des crossfades, puis cliquez sur OK.

6  Cliquez sur Done (Terminé).

Création d'un crossfade

Pour créer un crossfade entre deux régions :

1  Cliquez avec le sélecteur sur le point où vous 
souhaitez faire commencer le crossfade dans la 
première région et faites-le glisser jusqu'au point 
de la seconde région où vous souhaitez qu'il se 
termine. Les sélections de crossfade peuvent 
commencer et se terminer n'importe où dans 
leurs régions respectives.

2  Choisissez Edit > Fades > Create.

– ou –

Appuyez sur Ctrl + F (Windows) ou sur Pomme + 
F (Macintosh).

3  Utilisez les boutons de vue pour régler la vue 
du crossfade. Le calcul de l'affichage de la forme 
d'onde peut demander quelques instants 
lorsque les sélections sont longues.

4  Sélectionnez une forme de sortie et une forme 
d'entrée.

5  Choisissez une option de liaison.

6  Cliquez sur le bouton d'écoute ou lisez la 
session pour entendre le crossfade. Pour les 
longs crossfades, Pro Tools peut prendre 
quelques instants pour calculer et charger les 
données audio dans la RAM de lecture. 

7  Réglez les courbes en choisissant des formes 
présélectionnées différentes dans les menus Out 
Shape et In Shape.

– ou –

Déplacez les courbes de fondu d'entrée et de 
sortie sur une forme personnalisée. Si vous 
choisissez None comme option de liaison, vous 
pouvez déplacer et régler les points de début ou 
de fin d'une courbe de fondu.

8  Cliquez sur le bouton d'écoute ou lisez la 
session pour entendre de nouveau le crossfade.

Préférences de fondus et de crossfades
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9  Lorsque le crossfade vous convient, cliquez sur 
OK. Le fondu est calculé et écrit sur le disque, 
mais les fichiers audio et les régions demeurent 
inchangés. Les crossfades sont stockés dans le 
dossier Fades, à l'intérieur du dossier de la 
session.

Pour supprimer un crossfade :

■ Sélectionnez la partie de la piste contenant les 
crossfades que vous voulez supprimer, puis 
choisissez Edit > Fades > Delete. 

– ou –

■ Sélectionnez le crossfade avec l'outil 
d'accrochage de temps, puis appuyez sur Suppr 
(Macintosh) ou sur la touche de retour arrière 
(Windows). 

Pour rogner un crossfade :

1  Sélectionnez le crossfade avec l'outil 
d'accrochage de temps ou en cliquant deux fois 
dessus avec le sélecteur.

2  A l'aide d'un des outils de trimming, agissez 
sur l'une ou l'autre extrémité du crossfade. Le 
crossfade est recalculé pour refléter la nouvelle 
durée après Rognage.

Crossfades sur des pistes audio basées 
sur des tics

Un nouveau rendu des crossfades est effectué en 
cas de modification du tempo dans une piste 
audio basée sur des tics. La longueur du nouveau 
crossfade est la même qu'auparavant. 

S'il n'y pas suffisamment de données audio pour 
réaliser le crossfade, ou si la partie du nouveau 
crossfade sort des limites de régions valides, le 
crossfade est supprimé.

Sélections de pré/post crossfade

En effectuant une sélection qui commence ou se 
termine précisément au bord séparant deux 
régions, vous pouvez créer des « pré » ou des 
« post » crossfades. Utilisez la touche de 
tabulation pour placer le point d'insertion 
exactement au début ou à la fin d'une région.

Pour créer un pré- ou post-crossfade :

1  A l'aide du sélecteur, cliquez sur la piste 
contenant les régions entre lesquelles vous 
désirez créer le crossfade.

2  Appuyez sur la touche de tabulation pour 
avancer à la limite de région suivante. 

– ou –

Pour revenir à la limite de la région précédente, 
appuyez sur Pomme + Tab (Macintosh) ou sur 
Ctrl + Tab (Windows).

3  Pour ajuster votre sélection, déplacez-vous en 
appuyant sur Maj ou appuyez sur Maj + Tab 
pour avancer la sélection vers la limite de la 
région suivante. 

– ou –

Pour faire reculer la sélection vers la limite de la 
région précédente, appuyez sur Option + Maj + 
Tab (Macintosh) ou sur Ctrl + Maj + Tab 
(Windows).

4  Choisissez Edit > Fades > Create.

– ou –

Appuyez sur Ctrl + F (Windows) ou sur 
Pomme + F (Macintosh).

5  Choisissez un type de fondu et cliquez sur OK.

Par la suite, vous pouvez redimensionner la 
longueur des crossfades à l'aide d'un outil 
de trimming.
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Création de fondus aux 
débuts et aux fins des régions
Outre les crossfades entre régions, Pro Tools 
permet de créer des fondus d'entrée et de sortie 
en début et fin de régions. 

Avec Pro Tools HD, vous pouvez également 
utiliser une option de fondu automatique 
d'entrée et de sortie, qui permet d'appliquer des 
fondus d'entrée ou de sortie en temps réel à toutes 
les régions pendant la lecture. Ces fondus ne 
sont pas écrits sur le disque mais ils sont 
appliqués automatiquement lors de la lecture. 
Reportez-vous à la section Utilisation des fondus 
automatiques, page 411.

Création de fondus d'entrée et de 
sortie

Suivant la manière dont vous effectuez la 
sélection, vous pouvez placer un fondu d'entrée 
ou de sortie exactement au début ou à la fin 
d'une région, ou le placer de façon à ce qu'il 
déborde dans une zone vierge de la piste. La 
longueur de la sélection dans la région 
détermine la durée du fondu d'entrée ou de 
sortie.

Vous pouvez également effectuer un fondu vers 
le début ou la fin d'une région à partir d'un point 
d'insertion.

Bien que les fondus apparaissent comme des 
régions à part entière, ils ne peuvent en fait être 
séparés des régions dans lesquelles ils ont été 
créés. 

Lorsque vous changez le tempo dans une piste 
audio basée sur des tics, les fondus d'entrée et de 
sortie sont conservés dans leurs régions parentes 
et ne subissent aucune modification.

Pour créer un fondu d'entrée :

1  Sélectionnez le début de la région où vous 
voulez placer le fondu d'entrée. La sélection doit 
aller jusqu'au début exact de la région ou sur une 
zone vierge précédant la région sur la piste.

2  Choisissez Edit > Fades > Create. 

– ou –

Appuyez sur Ctrl + F (Windows) ou sur Pomme + 
F (Macintosh).

3  Choisissez votre courbe de fondu d'entrée 
ainsi que les autres paramètres.

4  Cliquez sur le bouton Audition pour entendre 
le fondu (ou appuyez sur la barre d'espace pour 
démarrer/arrêter la lecture).

5  Vous pouvez régler la courbe en la déplaçant 
ou en choisissant une forme différente dans le 
menu de formes de fondu en entrée (In Shape).

6  Lorsque vous avez terminé, cliquez sur OK. 
Pro Tools calcule alors le fondu puis l'écrit sur le 
disque. Votre courbe de fondu apparaît dans la 
région.

Région avec un fondu d'entrée

Sélection du début d'une région pour un fondu d'entrée
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Pour créer un fondu de sortie :

1  Sélectionnez la fin de la région sur laquelle 
vous voulez effectuer un fondu de sortie. La 
sélection doit aller jusqu'à la fin exacte de la 
région ou jusqu'à une zone vierge après la région 
dans la piste.

2  Choisissez Edit > Fades > Create. 

– ou –

Appuyez sur Ctrl + F (Windows) ou sur Pomme + 
F (Macintosh).

3  Choisissez votre courbe de fondu de sortie 
ainsi que les autres paramètres.

4  Cliquez sur le bouton Audition pour entendre 
le fondu (ou appuyez sur la barre d'espace pour 
démarrer/arrêter la lecture).

5  Vous pouvez régler la courbe en la déplaçant 
ou en choisissant une forme différente dans le 
menu de formes de fondu de sortie.

6  Lorsque vous avez terminé, cliquez sur OK. 
Pro Tools calcule alors le fondu puis l'écrit sur le 
disque. Votre courbe de fondu apparaît dans la 
région.

Pour réaliser un fondu depuis le point d'insertion 
jusqu'au point de début d'une région :

1  Placez le curseur à l'emplacement désiré dans 
la région.

2  Choisissez Edit > Fades > Fade To Start.

– ou –

Appuyez sur Alt + D (Windows) ou sur 
Contrôle + D (Macintosh).

Le fondu est alors appliqué conformément aux 
préférences de fondu en entrée.

Pour réaliser un fondu depuis le point d'insertion 
jusqu'au point de fin d'une région :

1  Placez le curseur à l'emplacement désiré dans 
la région.

2  Choisissez Edit > Fades > Fade To End.

– ou –

Appuyez sur Alt + G (Windows) ou sur 
Contrôle + G (Macintosh).

Le fondu est appliqué conformément aux 
préférences de fondu en sortie.

Utilisation des fondus 
automatiques
(Pro Tools HD uniquement)

Avec Pro Tools HD, vous pouvez faire appliquer 
par Pro Tools une option de fondu d'entrée et de 
sortie automatique, en temps réel, à toutes les 
limites des régions composant une session. 
Ces fondus d'entrée et de sortie sont réalisés 
pendant la lecture et n'apparaissent pas dans la 
fenêtre Edit ; de même, ils ne sont pas écrits sur 
le disque.

Cette option de fondu d'entrée et de sortie 
automatique a également un effet sur l'emprunt 
des voix d'une session. Chaque fois que, dans 
une même voix, une piste virtuelle de priorité 
inférieure se manifeste dans un moment de 
silence d'une piste virtuelle de priorité 
supérieure, un fondu d'entrée et un fondu de 
sortie sont appliqués à la transition.

Sélection de la fin d'une région pour un fondu de sortie

Par la suite, vous pouvez redimensionner la 
longueur des fondus à l'aide d'un outil de 
trimming.
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Cette fonction est particulièrement utile dans 
les situations de post production tels que le 
prémix de dialogues. Par exemple, vous pouvez 
affecter à une même voix de Pro Tools une piste 
de dialogue et une piste d'« ambiance ». Vous 
pouvez ensuite définir l'option AutoFade sur 
une longueur modérée (4 ms environ) de 
manière à ce que chaque fois qu'un silence se 
produit dans le dialogue, la lecture bascule 
doucement sur la piste d'ambiance, puis 
revienne doucement au dialogue sans clics.

L'utilisation des fondus automatiques en entrée 
et en sortie vous épargne les côtés fastidieux de 
l'édition aux points de passages à zéro ou les 
nombreuses écritures (rendus) de fondus pour 
éliminer les clics en lecture. Toutefois, comme 
ces fondus automatiques ne sont pas écrits sur le 
disque, ces clics existent toujours dans le fichier 
de son. Il en résulte que ces anomalies 
apparaîtront encore si vous utilisez les 
commandes Duplicate AudioSuite Plug-In ou 
Export Selected as Sound Files (à partir de la liste 
des régions) pour dupliquer plusieurs régions 
sous forme d'un fichier continu. Pour effectuer 
le rendu de ces fondus automatiques en temps 
réel, choisissez File > Bounce to > Disk.

Pour définir la durée des fondus automatiques 
d'entrée et de sortie :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation. 

2  Entrez une valeur entre 0 et 10 ms dans le 
champ Auto Region Fade In/Out Length. La 
valeur zéro (par défaut) indique l'absence 
d'atténuation automatique.

3  Cliquez sur Done (Terminé). La valeur de 
l'option AutoFade est enregistrée avec la session 
et appliquée automatiquement à toutes les 
limites de région autonomes jusqu'à ce que vous 
la modifiiez.

Création de fondus et de 
crossfades groupés
Le « mode Batch » permet de créer plusieurs 
fondus simultanément. Effectuez des sélections 
dans plusieurs régions puis utilisez la 
commande Create Fades pour créer des 
crossfades à chaque transition entre régions. 
Si votre sélection inclut des régions dans 
lesquelles se trouvent déjà des crossfades, cette 
fonction permet de les modifier.

Pour créer simultanément des crossfades entre 
plusieurs régions :

1  A l'aide du sélecteur, cliquez sur la première 
région dans laquelle vous voulez créer un 
crossfade.

2  Déplacez le sélecteur pour étendre la sélection 
vers la dernière la région dans laquelle vous 
voulez créer le crossfade. Vérifiez que la 
sélection inclut la région entière.

3  Choisissez Edit > Fades > Create.

– ou –

Appuyez sur Ctrl + F (Windows) ou sur Pomme + 
F (Macintosh).

4  Sélectionnez si vous souhaitez créer des 
fondus, créer des fondus en entrée et en sortie, 
ajuster des fondus existants ou une 
combinaison de ces options. 

Régions sélectionnées pour les fondus groupés
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Si vous choisissez de créer des fondus et des 
fondus d'entrée et de sortie, de nouveaux 
crossfades sont créés à chaque limite de région 
bordée par une autre région sélectionnée, un 
fondu d'entrée est créé au début de la première 
région et un fondu de sortie est créé à la fin de la 
dernière région.

5  Choisissez le placement de vos fondus. 
Vous vez le choix entre Pre-Splice (avant la 
jonction), Centered (centré) ou Post-Splice 
(après la jonction). 

6  Entrez une durée de crossfade en 
millisecondes.

7  Cliquez sur OK. Pro Tools crée alors les fondus 
dans les régions sélectionnées.

Boîte de dialogue Batch Fades

Par la suite, vous pouvez redimensionner la 
longueur des fondus à l'aide d'un outil de 
trimming.
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Chapitre 19 : Gestion des régions

La gestion des régions d'une session vous permet 
de limiter la configuration du système et du 
stockage au minimum, et simplifie les besoins 
d'archivage. Ce chapitre décrit plusieurs outils 
disponibles pour gérer les fichiers et les régions 
des sessions Pro Tools. 

Suppression du silence des 
régions
La commande Strip Silence analyse les 
sélections audio sur plusieurs régions ou 
plusieurs pistes et supprime toutes les zones de 
silence en divisant la sélection en régions plus 
petites.

La commande Strip Silence permet de diviser 
automatiquement une piste en régions, ce qui 
est pratique lorsque vous voulez quantiser des 
données audio à une valeur de note ou placer 
des effets sonores à des timecodes SMPTE précis. 
Elle est également utile si vous souhaitez 
éliminer des zones de silence pour préparer le 
compactage audio (voir Compactage d'un 
fichier audio, page 419).

Fenêtre Strip Silence

La fenêtre Strip Silence contient les commandes 
suivantes pour régler les paramètres pris en 
compte lors de la définition des zones de silence 
à l'aide de la commande Strip Silence. Le réglage 
de ces curseurs fait apparaître des rectangles 
dans la sélection (voir Figure 14, page 417), qui 
indiquent les zones de silence qui seront 
supprimées.

Strip Threshold : définit le seuil d'amplitude 
(de –48 dB à 0 dB) pris en compte pour la 
suppression du silence. Les données audio dont 
le niveau se situe au-dessous de ce seuil sont 
considérées comme du silence et sont 
supprimées. Les données audio se situant au-
dessus de ce seuil sont conservées et définies 
comme de nouvelles régions.

Min Strip Duration : définit la durée minimale 
(de 0 à 10000 ms) pendant laquelle le niveau des 
données doit rester au-dessous du seuil pour 
qu'elles soient considérées comme du silence. 
Utilisez ce paramètre pour éviter de créer une 
multitude de petites régions dans une même 
sélection.

Pour en savoir plus sur la gestion de 
fichiers, consultez le Guide DigiBase. 

Fenêtre Strip Silence
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Region Start Pad : indique une valeur de temps 
devant être ajoutée au début de chaque nouvelle 
région créée avec la commande Strip Silence. 
Ceci est pratique pour conserver des données 
musicales se situant au-dessous du seuil, telles 
qu'une inspiration avant une phrase vocale ou le 
glissement des doigts sur les cordes avant un 
accord de guitare.

Region End Pad : indique une valeur de temps 
devant être ajoutée à la fin de chaque nouvelle 
région créée avec la commande Strip Silence, 
afin de respecter la résonance des sons.

Extract : extrait les données audio et conserve 
les parties silencieuses de la piste (cela 
correspond en quelque sorte à une fonction de 
suppression inverse du silence idéale pour 
générer une ambiance acoustique de la pièce 
que vous utiliserez ailleurs).

Separate : sépare les régions en fonction des 
limites détectées par la commande Strip Silence. 

Désignation automatique des régions 
après suppression du silence

Le bouton Rename de la fenêtre Strip Silence 
ouvre la boîte de dialogue Rename Selected 
Regions, qui détermine la désignation des 
régions avec la commande Strip Silence. La boîte 
de dialogue mémorise vos paramètres 
précédents que vous pouvez effacer en cliquant 
sur le bouton Clear.

Name : spécifie le nom de base des régions créées 
avec la commande Strip Silence.

Number : spécifie le nombre de départ de la 
numérotation automatique séquentielle. 

Zeros : spécifie le nombre de zéros apparaissant 
avant la numéro attribué automatiquement.

Suffix : spécifie le texte ajouté à la fin du nom, 
après la numérotation automatique.

Par exemple, si vous définissez ces options 
d'attribution des noms sur :

• Name = SFX

• Number = 23

• Zeros = 1

• Suffix = .Reel1

Les noms des régions successivement créées avec 
la commande Strip Silence seront :

• SFX023.Reel1

• SFX024.Reel1

• SFX025.Reel1

• SFX026.Reel1

• SFX027.Reel1

• SFX028.Reel1

Utilisation de la suppression du 
silence

Pour supprimer le silence d'une sélection audio :

1  Sélectionnez une ou plusieurs régions audio. 

2  Choisissez Edit > Strip Silence.

3  Pour définir la méthode de désignation des 
régions crées avec la commande Strip Silence, 
cliquez sur Rename pour ouvrir la boîte de 
dialogue correspondante. Pour en savoir plus, 
reportez-vous à la section Désignation 
automatique des régions après suppression du 
silence, page 416.Boîte de dialogue Rename Regions Selected
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4  Dans la fenêtre Strip Silence, réglez les 
curseurs Strip Threshold et Min Strip Duration 
jusqu'à ce que des rectangles apparaissent dans 
la sélection.

Pour affiner la résolution de ces curseurs, 
appuyez sur la touche Pomme (Macintosh) ou 
Ctrl (Windows) pendant que vous les réglez.

5  Pour conserver des données avant et après les 
nouvelles régions, réglez les curseurs Region 
Start Pad et Region End Pad.

6  Lorsque les rectangles de suppression du 
silence délimitent les données audio que vous 
voulez conserver, appuyez sur le bouton Strip.

Les données définies comme du silence sont 
supprimées de la sélection et de nouvelles 
régions sont créées : elles apparaissent 
également dans la liste des régions.

La commande Strip Silence est non destructive 
et ne supprime pas les données audio des 
fichiers audio parents. Outre la commande 
Undo, la commande Heal Separation vous 
permet de restaurer les données supprimées.

Pour extraire des données audio d'une sélection 
audio à l'aide de la commande Strip Silence :

1  Effectuez une sélection de temps ou d'édition.

2  Choisissez Edit > Strip Silence.

3  Pour définir la méthode de désignation des 
régions crées avec la commande Strip Silence, 
cliquez sur Rename pour ouvrir la boîte de 
dialogue correspondante. Pour en savoir plus, 
reportez-vous à la section Désignation 
automatique des régions après suppression du 
silence, page 416.

4  Dans la fenêtre Strip Silence, réglez les 
curseurs Strip Threshold et Min Strip Duration 
jusqu'à ce que des rectangles apparaissent dans 
la sélection.

5  Cliquez sur le bouton Extract.

Toutes les données audio au-delà du seuil 
indiqué sont supprimées et les portions de 
silence de la piste sont conservées.

Pour séparer des régions à l'aide de la commande 
Strip Silence :

1  Effectuez une sélection de temps ou d'édition.

2  Choisissez Edit > Strip Silence.

3  Pour définir la méthode de désignation des 
régions crées avec la commande Strip Silence, 
cliquez sur Rename pour ouvrir la boîte de 
dialogue correspondante. Pour en savoir plus, 
reportez-vous à la section Désignation 
automatique des régions après suppression du 
silence, page 416.

Figure 14.  Rectangles de suppression du silence

Suppression du silence, temps devant être ajouté au 
début et à la fin de la région

Attaque à 
ajouter

Déclin à 
ajouter

La suppression du silence fonctionne avec 
les pistes stéréo et multicanaux et conserve 
la cohérence de phase de leurs régions audio.
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4  Dans la fenêtre Strip Silence, réglez les 
curseurs Strip Threshold et Min Strip Duration 
jusqu'à ce que des rectangles apparaissent dans 
la sélection.

5  Cliquez sur le bouton Separate.

De nouvelles régions sont générées en fonction 
des limites détectées par la commande Strip 
Silence. 

Insertion de silence
La commande Insert Silence constitue une 
méthode simple et pratique pour insérer du 
silence dans des sessions. Cette commande 
permet d'effectuer une sélection sur une piste 
(ou plusieurs) et d'insérer précisément cette 
durée de silence. En mode Shuffle, toutes les 
données de la piste sont décalées plus loin sur la 
piste d'une durée égale à la sélection.

En mode Grid, la commande Insert Silence 
fonctionne comme la commande Edit > Clear.

Mode Shuffle : lorsque vous insérez du silence 
sur plusieurs pistes en mode Shuffle, les 
conditions suivantes s'appliquent :

◆ Si des pistes sont affichées sous forme de 
données audio ou MIDI, la durée de silence 
sélectionnée est insérée dans les données audio 
ou MIDI et dans toutes les données 
d'automation sous-jacentes de toutes les pistes 
sélectionnées. Toutes les régions situées après 
sont déplacées de la quantité de silence insérée. 
Sur les pistes MIDI, seules les notes sélectionnées 
à partir de leur début sont concernées, ce qui 
signifie que si vous avez sélectionné la fin d'une 
note et que vous insérez du silence, cette note 
restera inchangée.

◆ Si toutes les pistes sélectionnées apparaissent 
sous forme de données d'automation, la plage 
sélectionnée n'est nettoyée que du type de 
données d'automation affiché dans chaque 
piste. Les régions ne sont pas déplacées. A la 
place, un espace vierge apparaît, d'une durée 
égale à celle de la sélection.

◆ Si toutes les pistes sélectionnées s'affichent 
sous forme de données d'automation, appuyez 
sur Control (Macintosh) ou sur Démarrer 
(Windows) tout en choisissant la commande 
Insert Silence pour insérer du silence sur toutes 
les playlists d'automation de toutes les pistes 
sélectionnées. Les régions ne sont pas déplacées.

Mode Slip : lorsque vous insérez du silence sur 
plusieurs pistes en mode Slip, les conditions 
suivantes s'appliquent :

◆ Si des pistes sont affichées sous forme de 
données audio ou MIDI, la plage sélectionnée 
est supprimée des données audio ou MIDI et de 
toutes les données d'automation sous-jacentes 
de toutes les pistes sélectionnées.

◆ Si toutes les pistes sélectionnées s'affichent 
sous forme de données d'automation, le silence 
n'est inséré que dans le type de données 
d'automation affiché dans chaque piste.

◆ Si toutes les pistes sélectionnées s'affichent 
sous forme de données d'automation, appuyez 
sur Control (Macintosh) ou sur Démarrer 
(Windows) tout en choisissant la commande 
Insert Silence pour insérer du silence sur toutes 
les listes d'automation de toutes les pistes 
sélectionnées.
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Pour insérer du silence dans une piste :

1  Effectuez une sélection sur une ou plusieurs 
pistes. La longueur de la sélection détermine la 
durée du silence inséré.

2  Choisissez Edit > Insert Silence.

En mode Shuffle, Pro Tools insère la durée de 
silence sélectionnée. En même temps, il divise 
les régions au début du point d'insertion et 
décale plus loin les nouvelles régions, d'une 
durée égale à celle de la sélection.

Commande de consolidation
Au fil d'une succession normale d'opérations 
d'édition, une piste peut finir par contenir de 
nombreuses régions. Cependant, lorsqu'une 
piste ou une de ses régions (un couplet ou un 
refrain) a atteint un état satisfaisant, vous 
souhaiterez peut-être regrouper ses multiples 
régions en une seule, ce qui permet par la suite 
de travailler plus facilement avec les données.

Lorsque vous consolidez une piste audio, un 
nouveau fichier audio est écrit, qui recouvre la 
plage de la sélection avec tous les espaces vierges 
qu'elle contient. 

Pour consolider des régions d'une piste :

1  A l'aide de l'outil d'accrochage de temps ou du 
sélecteur, sélectionnez les régions que vous 
voulez consolider. 

– ou –

Pour sélectionner toutes les régions d'une piste, 
cliquez trois fois dans sa playlist avec le 
sélecteur.

2  Choisissez Edit > Consolidate.

Une région unique est alors créée : elle remplace 
les régions préalablement sélectionnées, avec les 
espaces vierges qu'elles contenaient. Si vous 
travaillez sur une piste audio, un nouveau 
fichier audio est écrit (avec le plug-in AudioSuite 
Duplicate).

Lorsque vous consolidez des régions audio avec 
la commande Consolidate, si la sélection 
contient des régions coupées, celles-ci sont 
traitées comme du silence. Qu'une piste soit 
coupée ou non, ou qu'elle contienne une 
automation de coupure, n'a pas d'incidence sur 
la commande Consolidate.

Compactage d'un fichier 
audio
La commande Compact Selected supprime les 
parties inutilisées des fichiers audio, afin 
d'économiser l'espace sur le disque et de 
préparer des sauvegardes plus propres sur le 
disque dur. La commande Compact Selected 
supprime également les données audio si 
aucune région n'y fait référence.

Du fait qu'elle supprime définitivement les 
données audio, la commande Compact Selected 
ne doit être utilisée que lorsque vous avez 
terminé vos opérations d'édition et lorsque vous 
êtes certain de ne plus avoir besoin des données 
audio inutilisées.

La commande Compact Selected peut 
« encadrer » les régions du fichier compacté 
d'une durée définie par l'utilisateur. Cette 
opération peut être souhaitable, car Pro Tools 
exige la présence d'autres données audio avant 

La consolidation d'une piste audio ne 
consolide pas les données d'automation 
sous-jacentes. Pour créer un seul fichier avec 
des données d'automation appliquées aux 
données audio, utilisez la commande 
Bounce to Disk (voir Bounce to Disk, 
page 683).
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et après les régions audio pour créer des 
crossfades. Ainsi, si vos régions ont des 
crossfades ou si vous souhaitez « encadrer » les 
régions en prévision d'un futur Rognage, entrez 
la durée correspondante (en millisecondes).

Pour compacter un fichier audio :

1  Dans le menu déroulant de la liste des régions, 
choisissez Select > Unused. Toutes les régions 
qui n'ont pas été placées dans une piste de la 
session actuelle sont mises en surbrillance dans 
la liste des régions. 

2  Pour supprimer toutes les régions audio 
inutiles, choisissez Clear Selected dans le menu 
déroulant de la liste des régions. Lorsque la boîte 
de dialogue s'ouvre, choisissez Remove.

3  Dans la liste des régions, sélectionnez la ou les 
régions que vous voulez compacter.

4  Dans le menu déroulant de la liste des régions, 
choisissez Compact Selected.

5  Entrez la durée en millisecondes que vous 
voulez laisser autour de chaque région du 
fichier.

6  Cliquez sur Compact pour compacter le 
fichier ou sur Cancel pour annuler la 
commande. 

Lorsque l'opération de compactage est terminée, 
la session est sauvegardée automatiquement.

Attribution de noms et 
affichage des régions
Une session classique peut rapidement se 
retrouver encombrée de pistes et de dizaines de 
régions. Cependant, pour conserver la trace des 
régions d'une session et les gérer, vous pouvez :

• Renommer des régions existantes

• Préciser la méthode de désignation 
automatique des régions

• Masquer les régions créées 
automatiquement

• Supprimer les régions inutilisées

Changement de nom des régions

Au cours d'une session, vous pouvez renommer 
des régions pour leur donner des noms plus 
descriptifs, les raccourcir ou les simplifier. 
Lorsque vous renommez une région créée 
automatiquement à partir d'une édition, elle 
devient une région définie par l'utilisateur et 
apparaît dans la liste des régions, alors que les 
régions créées automatiquement sont masquées.

La façon la plus simple de renommer une 
région, si elle réside sur une piste, consiste à 
cliquer deux fois dessus avec un des outils 
d'accrochage. En revanche, lorsqu'elle ne réside 
pas sur une piste ou si vous souhaitez renommer 
plusieurs régions, utilisez la commande Rename 
dans la liste des régions.

Vous pouvez également renommer une région 
dans une piste à l'aide de la commande Rename 
du menu déroulant de la liste des régions.

La commande Compact Selected est 
destructive et ne peut être annulée. Elle 
modifie définitivement les fichiers audio 
d'origine. Il n'existe aucun moyen de 
restaurer les données supprimées par cette 
commande.
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Pour renommer une ou plusieurs régions :

1  Si vous voulez renommer une région créée 
automatiquement, sélectionnez Show > Auto-
Created dans la liste des régions.

2  Sélectionnez une ou plusieurs régions à 
renommer dans la liste des régions.

3  Choisissez Rename dans le menu déroulant de 
la liste des régions.

4  Lorsque vous y êtes invité, entrez le nouveau 
nom de la région. Si la région audio sélectionnée 
correspond à un fichier complet, précisez si vous 
souhaitez renommer uniquement la région ou la 
région et le fichier sur le disque.

5  Cliquez sur OK pour renommer la région. 
Si vous renommez plusieurs régions vous êtes 
invité à les renommer l'une après l'autre.

Options de désignation 
automatique

Vous pouvez indiquer les paramètres de 
désignation automatique d'une région lorsque 
des régions sont créées automatiquement à 
partir de la première en cours d'édition. 

La désignation automatique d'une région n'a pas 
d'incidence sur les noms des fichiers audio 
parents. En revanche, elle mémorise des 
pointeurs vers les régions au sein du fichier 
source parent.

Pour définir les options de désignation 
automatique d'une région :

1  Sélectionnez une région dans la liste des 
régions.

2  Choisissez Auto Rename dans le menu 
déroulant de la liste des régions.

3  Dans la boîte de dialogue Rename Regions, 
entrez le texte qui sera utilisé pour nommer les 
régions créées à partir de la région sélectionnée.

Name : détermine le nom racine des régions 
créées automatiquement.

Number : définit le nombre de départ de la 
numérotation automatique séquentielle.

Zeros : spécifie le nombre de zéros apparaissant 
avant le numéro attribué automatiquement.

Suffix : spécifie le texte ajouté à la fin du nom, 
après la numérotation automatique.

Si l'option Region List Selection Follows Edit 
Selection des préférences d'édition est active, 
lorsque vous cliquez sur une région dans la 
liste des régions, elle est mise en 
surbrillance.

Boîte de dialogue Rename Selected

Boîte de dialogue Rename Regions Selected
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4  Lorsque vous avez terminé, cliquez sur OK 
pour accepter les nouvelles options de 
désignation.

Masquage et suppression des 
régions inutiles

Au fil des éditions d'une session, la liste des 
régions peut se remplir rapidement de régions : 
celles que vous avez créées intentionnellement 
et celles qui ont été créées automatiquement en 
coupant, collant et séparant d'autres régions ou 
en important des fichiers REX, ACID ou des 
fichiers de groupes de régions. Pro Tools permet 
de masquer et de supprimer des régions de votre 
session pour vous éviter de parcourir une liste de 
régions démesurément longue.

Masquage des régions créées 
automatiquement

Vous pouvez masquer les régions créées 
automatiquement en cours d'édition.

Pour masquer les régions créées 
automatiquement :

■ Dans la liste des régions, désélectionnez 
Show > Auto-Created. Lorsque cette option n'est 
pas sélectionnée, seules les régions définies par 
l'utilisateur apparaissent dans la liste des 
régions.

Les régions définies par l'utilisateur incluent :

• Les régions correspondant à un fichier 
complet

• Les régions créées pendant l'enregistrement

• Les régions importées

• Les régions renommées

• Les régions créées à la suite d'un traitement 
AudioSuite

• Les nouvelles régions créées à l'aide de la 
commande Region > Capture ou des 
commandes Edit > Separate Region

• Les régions créées en rognant des régions 
audio de fichiers complets

Lorsque les régions créées automatiquement 
sont masquées, Pro Tools vous avertit dès que 
leur nombre excède un certain seuil et permet 
de les supprimer. Si vous choisissez de les 
supprimer, toutes les régions créées 
automatiquement sont supprimées en même 
temps. 

Pour être sûr de conserver une région 
particulière créée automatiquement, 
renommez-la : elle sera alors transformée en 
région créée par l'utilisateur. Pour en savoir plus, 
reportez-vous à la section Changement de nom 
des régions, page 420.

Suppression des régions inutiles

Dans la liste des régions, vous pouvez 
sélectionner les régions non désirées, puis 
utiliser la commande Clear pour les retirer de la 
session. Il est possible également de supprimer 
de façon permanente de votre disque dur des 
régions correspondant à un fichier complet.

Pour rechercher et supprimer les régions inutiles 
d'une session :

1  Effectuez l'une des opérations suivantes :

• Pour les régions MIDI, choisissez Select > 
Unused dans le menu déroulant de la liste des 
régions.

– ou –

La commande Clear ne peut pas être 
annulée.
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• Pour les régions audio, choisissez Select dans 
la liste des régions, puis sélectionnez l'une des 
sous-options suivantes :

• Unused (Régions inutiles)

• Unused Except Whole Files (Régions 
inutiles sauf fichiers complets)

• Offline (Régions hors ligne)

2  Après avoir sélectionné toutes les régions 
inutiles, choisissez Clear dans le menu 
déroulant de la liste des régions.

3  Cliquez sur Remove pour supprimer les pistes 
inutiles de la session.

– ou –

Si vous supprimez une région audio 
correspondant à un fichier complet, et que vous 
voulez supprimer définitivement le fichier 
audio de votre disque dur, cliquez sur Delete.

Lorsque vous supprimez des fichiers audio pour 
plusieurs régions, Pro Tools ouvre une boîte de 
dialogue d'avertissement pour chaque fichier 
audio. 

Pour ne plus afficher ces boîtes de dialogue 
d'avertissement :

■ Cliquez sur le bouton Delete de la boîte de 
dialogue Clear en maintenant enfoncée la 
touche Option (Macintosh) ou Alt (Windows). 
Ceci supprime définitivement chaque fichier 
audio de votre disque dur (pour chacune des 
régions inutiles), sans avertissement préalable. 

N'utilisez ce mode de suppression puissant 
qu'avec précaution, car la suppression des 
fichiers ne peut pas être annulée.

Boîte de dialogue Clear Selected (régions audio)
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Chapitre 20 : Pistes du chef 
d'orchestre et emplacements mémoire

Dans Pro Tools, les modifications apportées aux 
données de tempo et de mesure se trouvent dans 
les pistes du chef d'orchestre. Les événements de 
mesure et de tempo ont une incidence sur la 
résolution temporelle (les tics) des pistes et 
fournissent également une table de mesures et 
de tempos de la grille Bar|Beat. Vous pouvez 
modifier les événements de tempo dans la règle 
Tempo ou dans l'éditeur prévu à cet effet. 
De même, vous utilisez la règle de métrique 
pour modifier les événements de mesure. 
Les emplacements mémoire constituent une 
méthode de navigation dans votre session 
particulièrement utile lors de l'édition et 
l'organisation des pistes.

Marqueur de début de 
morceau
Le marqueur de début de morceau définit le 
tempo initial du matériel exprimé en 
mesures/temps (Bar|Beat). Les nouvelles sessions 
s'ouvrent avec un tempo par défaut de 120 BPM.

Le marqueur de début de morceau peut être 
déplacé, mais pas supprimé.

Pour déplacer le marqueur de début de morceau 
en le faisant glisser :

■ Dans la règle de tempo, faites glisser le 
marqueur vers la gauche ou la droite.

Si le mode d'édition est défini sur Grid, le 
marqueur de début de morceau se déplace par 
incréments du pas de grille actuel. 

Marqueur de début de morceau

La position du marqueur de début de 
morceau peut être modifiée dans la fenêtre 
Time Operations. Pour plus d'informations, 
reportez-vous à la section Déplacement du 
début d'un morceau, page 456.

Déplacement du marqueur

Pour ne déplacer que le marqueur de début 
de morceau, sans déplacer aucune donnée 
basée sur les tics, maintenez les touches 
Démarrer+Maj (Windows) ou 
Contrôle+Maj (Macintosh) enfoncées 
pendant que vous le faites glisser. Au cours 
de cette opération, le déplacement est limité 
à l'incrément de mesure uniquement. 
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Pour éditer le tempo initial dans le marqueur de 
début de morceau :

1  Dans la règle de tempo, cliquez deux fois sur le 
marqueur de début de morceau.

2  Dans la boîte de dialogue Change Tempo, 
entrez une nouvelle valeur BPM.

3  Cliquez sur OK.

Lorsqu'une session est créée, le marqueur de 
début de morceau n'est associé à aucun 
événement de métrique. Un événement de 
métrique est ajouté automatiquement au début 
du morceau si vous insérez un événement de 
métrique à un autre emplacement de la règle de 
métrique.

Tempo
La règle de tempo permet de modifier les 
événements de tempo, un par un. Vous pouvez 
modifier le tempo visuellement dans l'éditeur 
ou apporter des modifications précises dans la 
fenêtre Tempo Operations. 

Evénements de tempo

Les événements de tempo peuvent être attribués 
au marqueur de début de morceau pour 
remplacer le tempo par défaut (120 BPM) et 
peuvent être insérés n'importe où dans la 
session. 

Pour afficher la règle de tempo :

■ Sélectionnez View > Rulers > Tempo.

Tempo actuel

Conforme aux événements de tempo survenant 
en cours de lecture, le tempo actuel de la session 
s'affiche dans la fenêtre Transport.

Insertion d'événements de tempo

Pour insérer un événement de tempo :

1  Cliquez sur la règle de tempo à l'endroit où 
vous voulez insérer l'événement de tempo.

2  Cliquez sur le bouton Add Tempo Change 
situé à gauche de la règle de tempo.

Pour définir le tempo par défaut d'une 
session, reportez-vous à la section Réglage 
du tempo et de la métrique par défaut, 
page 204.

Il est possible d'utiliser Beat Detective pour 
générer les marqueurs Bar|Beat (table de 
tempos). Pour plus d'informations, 
reportez-vous à la section Création de 
marqueurs Bar|Beat avec le Beat 
Detective, page 481.

Le tempo ne peut pas être modifié en mode 
de tempo manuel.

En mode de tempo manuel, la piste de 
tempo est ignorée et la session est lue au 
tempo défini dans la fenêtre Transport. 
Pour en savoir plus, reportez-vous à la 
section Utilisation du mode tempo 
manuel, page 206.

Tempo actuel affiché dans la fenêtre Transport

Indicateur du tempo actuel
Guide de référence Pro Tools



3  Dans la fenêtre Tempo Change, entrez 
l'emplacement (Location) et la valeur BPM de 
changement du tempo. 

Cochez l'option Snap To Bar pour placer 
l'événement de tempo inséré précisément sur le 
premier temps de la mesure la plus proche.

4  Pour baser la valeur BPM sur un élément autre 
que la noire par défaut, sélectionnez une autre 
valeur.

5  Cliquez sur OK. Le nouvel événement de 
tempo est inséré et apparaît dans la règle de 
tempo.

A chaque événement de tempo est associé un 
petit triangle vert qui indique son 
emplacement. Vous pouvez faire glisser ce 
triangle pour déplacer l'événement de tempo ou 
cliquer deux fois dessus pour l'éditer.

Edition et déplacement des 
événements de tempo

Les événements de tempo existants peuvent être 
déplacés, édités, copiés et collés.

Pour déplacer un événement de tempo en le 
faisant glisser :

■ Dans la règle de tempo, faites glisser le 
triangle de l'événement de tempo vers la gauche 
ou la droite.

Lorsque le mode d'édition est réglé sur Grid, 
l'événement déplacé s'aligne sur le pas de grille 
courant. 

Pour éditer un événement de tempo :

1  Dans la règle de tempo, cliquez deux fois sur 
l'événement de tempo.

2  Dans la boîte de dialogue Tempo Change, 
entrez un nouvel emplacement (Location) ou 
une nouvelle valeur BPM pour l'événement de 
tempo.

3  Cliquez sur OK.

Pour supprimer un événement de tempo :

■ Tout en appuyant sur Option (Macintosh) ou 
sur Alt (Windows), déplacez le curseur sur 
l'événement de tempo (le curseur devient un 
outil d'accrochage muni d'un « – ») et cliquez 
dessus pour le supprimer.

Bouton d'ajout de changement de tempo

Boîte de dialogue Change Tempo

Evénement de tempo inséré

Déplacement d'un événement de tempo
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Pour copier et coller plusieurs événements de 
tempo :

1  A l'aide du sélecteur, cliquez sur la règle de 
tempo et faites glisser le curseur pour 
sélectionner la plage de mesures qui contient les 
événements de tempo.

2  Choisissez Edit > Copy.

3  Cliquez dans la règle de tempo à l'endroit où 
vous souhaitez coller les événements de tempo.

4  Choisissez Edit > Paste. Le contenu du presse-
papiers est collé à partir du point d'insertion et 
remplace les événements de tempo existants.

Pour étendre une sélection d'édition d'une piste à 
la règle de tempo :

1  A l'aide du sélecteur ou de l'outil d'accrochage 
de temps, sélectionnez une plage de temps.

2  Cliquez sur la règle de tempo tout en 
appuyant sur Maj. 

Pour sélectionner tous les événements de tempo :

■ Cliquez deux fois avec le sélecteur dans la 
règle de tempo.

Pour supprimer une plage sélectionnée 
d'événements de tempo :

1  Si vous le souhaitez, réglez le mode d'édition 
sur Grid pour restreindre la sélection en 
fonction du pas de grille actuel. 

2  Déplacez le sélecteur dans la règle de tempo 
pour sélectionner les événements de tempo que 
vous voulez supprimer.

3  Choisissez Edit > Clear pour supprimer les 
événements de tempo sélectionnés.

Battement du tempo

Vous pouvez définir manuellement le tempo 
dans une session Pro Tools à l'aide des touches 
de votre clavier. Vous pouvez également utiliser 
un clavier MIDI, relié à l'ordinateur, pour battre 
le tempo.

Pour régler le tempo manuel à l'aide du clavier :

1  Pour faire apparaître les commandes MIDI 
dans la fenêtre Transport, sélectionnez View > 
Transport > MIDI Controls.

2  Dans la fenêtre Transport, cliquez sur le 
bouton Tempo Ruler Enable (chef d'orchestre) 
pour qu'il n'apparaisse plus en surbrillance. 
Pro Tools passe en mode de tempo manuel. 
Dans ce mode, tous les événements de tempo 
enregistrés sur la piste de tempo sont ignorés.

Evénements de tempo sélectionnés

Appuyez sur Option (Macintosh) ou sur Alt 
(Windows) tout en déplaçant le curseur 
pour effectuer la sélection dans toutes les 
pistes du chef d'orchestre.

Mode de tempo manuel activé

Bouton d'activation 
de la règle de 
tempo

Champ du tempo
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3  Cliquez dans le champ du tempo pour le faire 
apparaître en surbrillance et appuyez sur la 
touche T de votre clavier de façon répétée au 
rythme du nouveau tempo.

Pour régler le tempo manuel en le battant en 
rythme sur un clavier MIDI externe :

1  Pour faire apparaître les commandes MIDI 
dans la fenêtre Transport, sélectionnez View > 
Transport > MIDI Controls.

2  Choisissez Setup > Preferences et cliquez sur 
l'onglet MIDI.

3  Sélectionnez Use MIDI To Tap Tempo.

4  Dans la fenêtre Transport, cliquez sur le 
bouton Tempo Ruler Enable (chef d'orchestre) 
pour qu'il n'apparaisse plus en surbrillance. 
Pro Tools passe en mode de tempo manuel. 
Dans ce mode, tous les événements de tempo 
enregistrés sur la piste de tempo sont ignorés.

5  Cliquez dans le champ du tempo pour le faire 
apparaître en surbrillance et battez le tempo en 
jouant une note de façon répétée sur le clavier 
de votre contrôleur MIDI.

Pour calculer le nouveau tempo, Pro Tools fait la 
moyenne des huit derniers battements (ou 
moins) afin de déterminer le tempo. La valeur 
BPM calculée apparaît dans le champ Tempo du 
Transport.

Changements du tempo et 
décalage d'automation

Lorsqu'une piste audio est basée sur les 
échantillons, la playlist d'automation de la piste 
n'est pas concernée par les modifications 
apportées au tempo.

En revanche, lorsqu'une piste audio est basée sur 
les tics, les points d'inflexion des courbes 
d'automation sont modifiés pour refléter les 
modifications du tempo.

Lorsque vous changez le tempo, la durée de 
chaque région audio d'une piste ne subit aucune 
modification. Aussi, les données d'automation 
des pistes basées sur les tics ne sont plus 
synchronisées avec les données audio. 

Pour appliquer le nouveau tempo à 
l'intégralité de la session, il suffit de 
modifier le tempo par défaut associé au 
marqueur de début de morceau. Pour plus 
d'informations, reportez-vous à la section 
Marqueur de début de morceau, page 425.

Changements de tempo appliqués à des régions plus 
grandes

Lorsque le tempo d'une piste basée 

...l'automation n'est plus synchronisée.

sur les tics change...
Chapitre 20 : Pistes du chef d'orchestre et emplacements mémoire 429



430
Limitation du décalage de l'automation

En général, plus les régions audio sont grandes, 
plus le décalage de l'automation est marqué. En 
créant, de nombreuses régions de petite taille, il 
est possible de minimiser les effets du décalage 
de l'automation, car le point de départ de 
chaque région suivante est lié au changement 
du tempo. Lorsque le tempo diminue, 
l'automation augmente ; lorsque le tempo 
augmente, l'automation se réduit.

Editeur graphique de tempo
L'éditeur de tempo, représenté par une fenêtre 
redimensionnable située sous la règle de tempo 
dans la fenêtre Edit, permet de visualiser et de 
modifier graphiquement les informations.

Editeur de tempo

L'éditeur de tempo est une extension de la règle 
de tempo et s'ouvre à partir de la zone des règles 
de la fenêtre Edit. 

Pour afficher l'éditeur de tempo, effectuez l'une 
des opérations suivantes :

■ Sélectionnez View > Rulers > Tempo, puis 
View > Rulers > Tempo > Tempo Editor.

■ Cliquez sur le triangle Développer/réduire de 
l'éditeur de tempo.

Changements de tempo appliqués à de petites régions

Pour diviser une région audio en régions 
plus petites, utilisez Beat Detective. Pour 
plus d'informations, reportez-vous au 
Chapitre 21, Beat Detective.

Vous pouvez également séparer les régions 
au niveau des transitoires ou en fonction de 
la résolution actuelle de la grille. Pour 
plus d'informations, reportez-vous à la 
section Commandes Separate Region, 
page 352.

L'utilisation d'un grand nombre de petites régions...

...permet de conserver la synchronisation 
audio en cas de changement de l'automation.

Editeur de tempo

Triangle Développer/Réduire de l'éditeur de tempo

Evénements 

Résolution du tempo

Densité d'édition du tempo
de tempo
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Edition des événements de tempo 
dans l'éditeur de tempo

Pour modifier les événements de tempo 
contenus dans l'éditeur de tempo, effectuez 
l'une des opérations suivantes :

◆ Vous pouvez déplacer des événements de 
tempo individuels à l'aide d'un outil 
d'accrochage afin d'ajuster leur emplacement ou 
leur valeur.

◆ Vous pouvez décaler vers le haut ou vers le bas 
un groupe de tempos sélectionné avec l'outil de 
trimming.

◆ Vous pouvez dessiner de nouveaux 
événements de tempo avec le crayon pour 
remplacer des événements.

◆ Vous pouvez copier et coller, déplacer et 
décaler des événements de tempo.

Dessin d'événements de tempo

Les événements de tempo peuvent être dessinés 
dans l'éditeur de tempo à l'aide du crayon.

Freehand : permet de dessiner librement en 
faisant glisser la souris. La forme est reproduite 
sous forme d'une série d'étapes, conformément 
au paramètre Tempo Edit Density. Pour en 
savoir plus, reportez-vous à la section Sélection 
de la densité d'édition du tempo, page 432.

Line : le crayon en forme de ligne trace une ligne 
droite lorsque vous cliquez puis relâchez la 
souris. Les valeurs de tempo se transforment en 
une série d'étapes selon les paramètres Tempo 
Edit Density et Resolution. Pour en savoir plus, 
reportez-vous à la section Sélection de la densité 
d'édition du tempo, page 432.

Parabolic : la forme parabolique dessine la 
meilleure courbe possible afin de s'ajuster à 
votre dessin à main levée. La forme est 
reproduite sous forme d'une série d'étapes, 
conformément au paramètre Tempo Edit 
Density.

S-Curve : le crayon en forme de courbe en S trace 
la meilleure courbe en S possible afin de s'ajuster 
à votre dessin à main levée. La forme est 
reproduite sous forme d'une série d'étapes, 
conformément au paramètre Tempo Edit 
Density.

Menu déroulant de la forme du crayon

Ces formes
ne sont pas
opérationnelles
dans l'éditeur
de tempo

Les autres formes du crayon (triangle, carré 
et forme aléatoire) ne concernent pas les 
événements de tempo.
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Sélection de la résolution du tempo 
(rapport BPM)

L'éditeur de tempo vous permet de spécifier la 
valeur de la note sur laquelle se base le rapport 
BPM pour tous les événements de tempo créés 
lorsque vous dessinez une courbe de tempo avec 
le crayon. La valeur de la note s'appelle la 
résolution du tempo (paramètre Tempo 
Resolution).

Pour sélectionner la résolution du tempo (rate 
BPM) pour l'édition au crayon, effectuez l'une des 
opérations suivantes :

■ Cliquez sur le sélecteur de résolution de 
tempo et sélectionnez une valeur de note dans le 
menu déroulant. La valeur BPM des événements 
de tempo créés à l'aide du crayon équivaut à la 
valeur de note que vous venez de définir.

■ Choisissez Follow Metronome Click. La valeur 
BPM des événements de tempo créés à l'aide du 
crayon est telle qu'elle reflète les valeurs du 
métronome définies par les événements de 
métrique dans la règle métrique. 

Une courbe de tempo peut inclure des valeurs 
BPM différentes en cas de modification du 
métronome dans la plage sélectionnée.

Sélection de la densité d'édition du tempo

L'éditeur de tempo permet de spécifier la densité 
des événements de tempo créés dans la règle de 
tempo lorsque vous dessinez une courbe de 
tempo à l'aide du crayon.

Sélecteur de résolution du tempo et menu déroulant

Digidesign recommande de choisir l'option 
Follow Metronome Click dans la majorité 
des cas. Il est en effet inutile et complexe de 
définir des événements de métrique 
différents pour chaque événement de tempo.

Courbe de tempo avec différentes valeurs du 
métronome

Sélecteur de densité d'édition du tempo et menu 
déroulant

Choix de la noire Choix de la noire pointée
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Pour sélectionner la densité d'édition du tempo 
pour l'édition au crayon :

■ Cliquez sur le sélecteur de densité d'édition du 
tempo et sélectionnez une valeur de temps dans 
le menu déroulant. Les événements de tempo 
créés à l'aide du crayon sont placés sur la règle de 
tempo en fonction du paramètre de densité 
choisi.

Mode d'ajustement de la courbe

Immédiatement après avoir tracé de nouveaux 
tempos à l'aide du crayon, une courbe s'affiche 
en bleu correspondant à la nouvelle 
représentation graphique du tempo. 
Des poignées d'ajustement de couleur bleue sur 
la courbe permettent de régler la forme et la 
taille du graphique.

Les poignées d'ajustement restent actives tant 
que vous n'avez pas sélectionné un nouvel outil 
ou exécuté une autre commande. 

Accrochage des événements de tempo

Les outils d'accrochage permettent de créer des 
paramètres de tempo en faisant glisser les 
événements de tempo dans l'éditeur de tempo. 
Pour supprimer un événement de tempo, 
cliquez sur l'événement à l'aide d'un outil 
d'accrochage tout en maintenant la touche Alt 
(Windows) ou Option (Macintosh) enfoncée.

Faites glisser un événement de tempo vers la 
gauche ou la droite pour ajuster l'emplacement 
du changement de tempo.

En appuyant sur la touche de démarrage 
(Windows) ou Contrôle (Macintosh) avant 
de tracer une ligne à l'aide du crayon, vous 
pouvez conformer les événements de tempo 
créés à la ligne au lieu de créer d'autres 
événements de tempo. 

Ajustement de la courbe de tempo

Poignées d'ajustement de la courbe de tempo

Tous les événements de tempo au-dessous 
de la courbe sont affectés par le déplacement 
des poignées d'ajustement de la courbe de 
tempo. Pour ajuster la forme de la courbe 
sans modifier immédiatement les données 
de piste, appuyez sur la touche de 
démarrage (Windows) ou Contrôle 
(Macintosh) pendant l'ajustement. 
Les événements de tempo sont modifiés 
pour correspondre à la nouvelle courbe 
lorsque vous relâchez le bouton de la souris.

Utilisation d'un outil d'accrochage pour modifier un 
événement de tempo
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Sélection des événements de tempo

Vous pouvez facilement sélectionner un 
événement de tempo ou la totalité de la courbe 
de tempo dans l'éditeur de tempo.

Pour sélectionner un événement de tempo dans 
l'éditeur de tempo :

A l'aide du sélecteur ou de l'outil d'accrochage, 
cliquez deux fois sur la ligne horizontale de 
tempo.

Pour sélectionner la courbe de tempo dans 
l'éditeur de tempo :

■ A l'aide du sélecteur ou de l'outil d'accrochage, 
cliquez trois fois sur la ligne horizontale de 
tempo dans la courbe à sélectionner.

Extension de sélections du tempo

Il est possible d'étendre la sélection à 
l'événement de tempo suivant ou précédent.

Pour étendre une sélection de tempo :

1  Sélectionnez une partie d'une région ou 
cliquez n'importe où dans la région.

2  Appuyez sur Maj + Tab pour étendre la 
sélection à l'événement de tempo suivant.

– ou –

Pour étendre la sélection et inclure l'événement 
de tempo précédent, appuyez sur Maj + Option 
+ Tab (Macintosh) ou sur Maj + Ctrl + Tab 
(Windows).

Utilisation de l'outil de trimming

L'outil de trimming permet de mettre à l'échelle 
l'ensemble des événements de tempo d'une 
session ou d'une sélection temporelle. Il permet 
également d'étirer (ou de contracter) une région 
d'événements de tempo pour couvrir une plus 
grande ou une plus petite zone de la timeline. 

Pour mettre à l'échelle l'ensemble des 
événements de tempo de la session à l'aide de 
l'outil de trimming :

1  Ouvrez l'éditeur de tempo.

2  Sélectionnez l'outil de trimming.

3  Cliquez au-dessus des événements de tempo 
et faites glisser le curseur vers le haut ou le bas. 
Les valeurs de tempo augmentent lorsque vous 
faites glisser l'outil de trimming vers le haut, 
elles diminuent lorsque vous le faites glisser vers 
le bas.

Sélection d'un événement de tempo

Sélection d'une courbe de tempo

Modification du tempo à l'aide de l'outil de trimming
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Pour mettre à l'échelle des événements de tempo 
sélectionnés à l'aide de l'outil de trimming :

1  Ouvrez l'éditeur de tempo.

2  A l'aide du sélecteur, sélectionnez la zone à 
éditer.

3  Sélectionnez l'outil de trimming.

4  Cliquez dans la zone sélectionnée et faites 
glisser le curseur vers le haut ou le bas. 
Les valeurs de tempo augmentent lorsque vous 
faites glisser l'outil de trimming vers le haut, 
elles diminuent lorsque vous le faites glisser vers 
le bas.

Pour modifier le degré de changement du tempo à 
l'aide de l'outil de trimming :

1  Ouvrez l'éditeur de tempo.

2  A l'aide du sélecteur, sélectionnez la zone à 
éditer.

3  Sélectionnez l'outil de trimming.

4  Cliquez sur la poignée de début ou de fin de la 
plage sélectionnée et faites-la glisser vers le haut 
ou vers le bas.

Pour allonger ou raccourcir la plage du 
changement de tempo à l'aide de l'outil de 
trimming :

1  Ouvrez l'éditeur de tempo.

2  A l'aide du sélecteur, sélectionnez la zone à 
éditer.

3  Sélectionnez l'outil de trimming.

4  Cliquez au début ou à la fin de la sélection et 
faites glisser le curseur horizontalement. 
Les événements de tempo conservent la 
distance relative qui les séparent mais sont 
répartis sur une zone plus grande ou plus petite.

Modification des tempos sélectionnés à l'aide de l'outil 
de trimming

Modification du degré de changement du tempo à l'aide 
de l'outil de trimming

Modification de la plage de changement du tempo à 
l'aide de l'outil de trimming :
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Déplacement, opération de couper-coller et 
déplacement par incrément dans l'éditeur de 
tempo

Pour déplacer un groupe sélectionné 
d'événements de tempo dans l'éditeur de tempo :

1  Ouvrez l'éditeur de tempo.

2  A l'aide du sélecteur, sélectionnez la zone à 
déplacer.

3  Cliquez sur un événement de tempo à l'aide 
d'un outil d'accrochage et faites-le glisser 
horizontalement pour déplacer les événements 
vers leur nouvel emplacement. 

Pour copier et coller des événements dans 
l'éditeur de tempo :

1  Ouvrez l'éditeur de tempo.

2  A l'aide du sélecteur, sélectionnez la zone à 
copier.

3  Choisissez Edit > Copy.

4  Cliquez dans l'éditeur de tempo à l'endroit où 
vous souhaitez coller les événements de tempo.

5  Choisissez Edit > Paste. Les éléments copiés 
sont collés à partir du point d'insertion et 
remplacent les événements de tempo existants.

Pour déplacer une sélection par incrément dans 
l'éditeur de tempo :

1  Ouvrez l'éditeur de tempo.

2  A l'aide du sélecteur, sélectionnez la zone à 
déplacer par incrément.

3  Appuyez sur la touche Plus (+) du pavé 
numérique pour déplacer les événements de 
tempo sélectionnés vers l'avant de la valeur de 
déplacement par incrément.

– ou –

Appuyez sur la touche Moins (–) du pavé 
numérique pour reculer la sélection de la valeur 
de déplacement par incrément.

Modification du mode 
d'affichage linéaire
Vous avez la possibilité d'afficher la fenêtre Edit 
à l'échelle temporelle au format linéaire Tick 
(Bars|Beats) ou Sample (absolu). Les pistes MIDI 
et d'instrument, les pistes audio et les courbes de 
tempo peuvent s'afficher et fonctionner très 
différemment selon les paramètres d'affichage 
temporels.

Le menu déroulant du mode d'affichage linéaire 
détermine si l'éditeur de tempo affiche les 
événements selon le format temporel absolu ou 
selon le format temporel Bars|Beats.

Lorsque l'option Linear Sample Display est 
définie, l'affichage des événements de tempo est 
exprimé en échantillons ; autrement dit, leur 
emplacement exprimé en mesures/temps 
change une fois la courbe de tempo tracée.

Appuyez sur Option (Macintosh) ou sur Alt 
(Windows) tout en faisant glisser une copie 
des événements de tempo.

Sélecteur du mode d'affichage de la linéarité et menu 
déroulant
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Lorsque l'option Linear Tick Display est définie, 
l'affichage des événements de tempo est 
exprimé en tics ; autrement dit, leur 
emplacement exprimé en mesures/temps n'est 
pas altéré une fois la courbe de tempo tracée.

Pour modifier l'affichage du format temporel :

■ Cliquez sur le sélecteur du mode d'affichage 
linéaire et sélectionnez un format dans le menu 
déroulant.

Densité d'édition du tempo et mode d'affichage 
linéaire

Si les deux paramètres Tempo Edit Density (dans 
l'éditeur de tempo) et Linearity Display Mode 
sont définis selon un format temporel Bars|Beats 
ou selon un format temporel absolue, les 
modifications du tempo sont réparties à 
intervalles réguliers. Lorsque les deux 
paramètres sont définis de telle manière que l'un 
est régi par une échelle temporelle absolue et 
l'autre par une échelle temporelle Bars|Beats, le 
nombre de modifications du tempo augmente 
ou diminue au fil du temps.

Fenêtre Tempo Operations
La fenêtre Tempo Operations permet de définir 
les événements de tempo sur une plage de temps 
(ou de mesures) donnée. Cette période est 
exprimée dans le format de l'échelle temporelle 
principale. De plus, la fenêtre Tempo 
Operations vous permet d'effectuer les 
opérations suivantes :

• insérer un nombre spécifique Bars|Beats à 
une plage de temps précise ;

• créer des tempos pour accélérer ou ralentir, 
de manière linéaire et sur différentes 
courbes ;

• mettre à l'échelle et étirer des tempos 
existants.

La fenêtre Tempo Operations comporte six 
pages d'onglets, chacun d'elles correspondant à 
un type d'opération liée au tempo.

Constant : permet de créer un tempo constant 
sur une plage de temps sélectionnée.

Linear : permet de créer des tempos qui 
changent à intervalle régulier sur une plage de 
temps sélectionnée.

Parabolic : permet de créer des tempos qui vont 
en accélérant ou en décélérant selon une courbe 
de tempo visant à changer le tempo plus 
rapidement ou plus lentement sur une période 
donnée.

S-Curve : permet de créer des tempos qui vont 
en accélérant ou en décélérant selon une courbe 
de tempo doté d'un point d'inflexion 
définissable déterminant les valeurs du temps et 
de la mesure à mi-parcours.

Scale : permet de mettre à l'échelle des tempos 
dans une sélection par un pourcentage. 

L'opération consistant à dessiner des 
événements de tempo à l'aide de l'option 
Linear Sample Display peut entraîner le 
déplacement non intuitif de matériel 
exprimé en mesures/temps. Digidesign 
recommande d'utiliser l'option Linear Tick 
Display lorsque vous dessinez des 
changements de tempo.

La fenêtre Tempo Operations n'est pas 
disponible en mode Manual Tempo.
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Stretch : permet de sélectionner des 
événements de tempo et de les appliquer à une 
zone plus grande ou plus petite de la sélection.

Pour ouvrir une page donnée de la fenêtre Tempo 
Operations :

■ Choisissez Event > Tempo, puis la commande 
correspondant à la page Tempo Operations 
souhaitée (Constant, par exemple).

Pour ouvrir la dernière page activée de la fenêtre 
Operations :

■ Choisissez Event > Tempo > Operations 
Window.

Pour définir les événements de tempo sur une 
plage de temps donnée :

1  Faites une sélection dans la règle temporelle 
ou dans une piste.

2  Choisissez Event > Tempo > Operations 
Window.

3  Choisissez une page dans le menu déroulant 
situé en haut de la fenêtre Tempo Operation.

4  Modifiez les paramètres de la page choisie, si 
nécessaire.

5  Cliquez sur Apply.

– ou –

Appuyez sur Entrée (Windows) ou Retour 
(Macintosh) pour appliquer automatiquement 
les valeurs et fermez la fenêtre.

Page Constant

La page Constant permet de créer un tempo 
constant sur une plage de temps sélectionnée.

Advanced : lorsque la case Advanced est cochée, 
la plage de la sélection adopte le format défini 
par l'échelle temporelle principale ; des options 
supplémentaires et modifiées sont disponibles.

Calculate (option avancée) : permet de calculer 
la valeur de fin du tempo ou de la sélection.

Selection Start and End : spécifie la valeur de 
début ou de fin du changement de tempo selon 
le format temporel Bars|Beats. Lorsqu'une 
sélection d'édition est effectuée, les champs 
Start et End affichent les limites de la sélection.

End Time (option avancée) : affiche la valeur de 
fin de la sélection. Si la valeur de l'échelle 
temporelle principale est Bars|Beats, la valeur de 
fin s'affiche dans l'échelle temporelle 
secondaire. Si l'échelle temporelle principale est 
au format temporel absolu, la valeur de fin est 
calculée et exprimée selon un format Bars|Beats. 
La modification de la valeur de fin entraîne un 
changement du tempo.

Si la fenêtre Tempo Operations est toujours 
ouverte, vous pouvez sélectionner une des 
pages à partir du menu déroulant situé en 
haut de la fenêtre.

Appuyez sur Alt + 2 (Windows) ou 
Option + 2 (Macintosh) pour ouvrir la 
fenêtre Tempo Operations et afficher la 
dernière page Tempo Operations active.

Page Constant (option avancée)
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Tempo : indique le tempo, exprimé en temps par 
minute (BPM) à appliquer à la plage 
sélectionnée.

Resolution (option avancée) : permet de 
sélectionner la valeur de note BPM pour votre 
paramètre de tempo.

Density (option avancée) : permet de spécifier le 
nombre d'événements de changement du 
tempo dans la règle de tempo.

Preserve Tempo after Selection : si cette option 
est sélectionnée, le paramètre de tempo 
précédent appliqué au point de fin de sélection 
est préservé après la sélection. Lorsque l'option 
n'est pas sélectionnée, le dernier paramètre de 
tempo créé par l'opération liée au tempo reste en 
vigueur à la fin de la session, ou jusqu'à 
l'événement de tempo suivant au-delà de la 
plage sélectionnée.

Page Linear

La page Linear permet de créer des tempos qui 
changent à intervalle régulier sur une plage de 
temps sélectionnée.

Advanced : lorsque la case Advanced est cochée, 
la plage de la sélection adopte le format défini 
par l'échelle temporelle principale ; des options 
supplémentaires et modifiées sont disponibles.

Calculate (option avancée) : permet de calculer 
la valeur de fin de la sélection, le tempo de début 
et celui de fin.

Selection Start and End : affiche les points de 
début et de fin du changement du tempo dans la 
référence temporelle principale actuellement 
sélectionnée. Lorsqu'une sélection d'édition est 
effectuée, les champs Start et End affichent les 
limites de la sélection. Le fait de modifier les 
valeurs de début et de fin a pour effet de 
modifier la plage de la sélection.

Le fait de sélectionner l'option Follow 
Metronome Click indique à la valeur de note 
BPM du tempo de reproduire la valeur du 
métronome définie dans les marqueurs de 
temps.

Page Linear (option avancée)
Chapitre 20 : Pistes du chef d'orchestre et emplacements mémoire 439



440
End Time (option avancée) : affiche la valeur 
absolue de la fin de la sélection. Si la valeur de 
l'échelle temporelle principale est Bars|Beats, la 
valeur de fin s'affiche dans l'échelle temporelle 
secondaire. Si l'échelle temporelle principale est 
au format temporel absolu, la valeur de fin est 
calculée et exprimée selon un format Bars|Beats. 
La modification de la valeur de fin entraîne un 
changement du tempo.

Tempo Start and End : affiche le tempo, en 
temps par minute (BPM), pour les points de 
début et de fin de la plage sélectionnée. 
Le changement de tempo entraîne la 
modification de la valeur de fin.

Resolution (option avancée) : permet de 
sélectionner la valeur de note BPM pour votre 
paramètre de tempo.

Density (option avancée) : permet de spécifier le 
nombre d'événements de changement du 
tempo dans la règle de tempo.

Preserve Tempo after Selection : si cette option 
est sélectionnée, le paramètre de tempo 
précédent appliqué au point de fin de sélection 
est préservé après la sélection. Lorsque l'option 
n'est pas sélectionnée, le dernier paramètre de 
tempo créé par l'opération liée au tempo reste en 
vigueur à la fin de la session, ou jusqu'à 
l'événement de tempo suivant au-delà de la 
plage sélectionnée.

Page Parabolic

La page Parabolic permet de créer des tempos 
qui vont en accélérant ou en décélérant selon 
une courbe de tempo visant à changer le tempo 
plus rapidement ou plus lentement sur une 
période donnée.

Advanced : lorsque la case Advanced est cochée, 
la plage de la sélection adopte le format défini 
par l'échelle temporelle principale ; des options 
supplémentaires et modifiées sont disponibles.

Calculate (option avancée) : permet de choisir 
de calculer la valeur de fin de la sélection, le 
tempo de début, le tempo de fin ou la courbe du 
changement de tempo. 

Selection Start and End : affiche les points de 
début et de fin du changement du tempo dans la 
référence temporelle principale actuellement 
sélectionnée. Lorsqu'une sélection d'édition est 
effectuée, les champs Start et End affichent les 
limites de la sélection. Le fait de modifier les 
valeurs de début et de fin a pour effet de 
modifier la plage de la sélection.

Le fait de sélectionner l'option Follow 
Metronome Click indique à la valeur de note 
BPM du tempo de reproduire la valeur du 
métronome définie dans les marqueurs de 
temps.

Page Parabolic (option avancée)
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End Time (option avancée) : affiche la valeur 
absolue de la fin de la sélection. Si la valeur de 
l'échelle temporelle principale est Bars|Beats, la 
valeur de fin s'affiche dans l'échelle temporelle 
secondaire. Si l'échelle temporelle principale est 
au format temporel absolu, la valeur de fin est 
calculée et exprimée selon un format Bars|Beats. 
La modification de la valeur de fin entraîne un 
changement du tempo.

Tempo Start and End : affiche le tempo, en 
temps par minute (BPM), pour les points de 
début et de fin de la plage sélectionnée. 
Le changement de tempo entraîne la 
modification de la valeur de fin.

Curvature : spécifie et affiche une représentation 
graphique et numérique de la courbe de tempo. 
Les nombres négatifs indiquent un changement 
de tempo plus rapide au début de la plage de 
temps et les nombres positifs indiquent un 
changement de tempo plus rapide à la fin de la 
plage. Vous définissez cette valeur au moyen de 
la glissière.

Resolution (option avancée) : permet de 
sélectionner la valeur de note BPM pour votre 
paramètre de tempo.

Density (option avancée) : permet de spécifier le 
nombre d'événements de changement du 
tempo dans la règle de tempo.

Preserve Tempo after Selection : si cette option 
est sélectionnée, le paramètre de tempo 
précédent appliqué au point de fin de sélection 
est préservé après la sélection. Lorsque l'option 
n'est pas sélectionnée, le dernier paramètre de 

tempo créé par l'opération liée au tempo reste en 
vigueur à la fin de la session, ou jusqu'à 
l'événement de tempo suivant au-delà de la 
plage sélectionnée.

Page S-Curve

La page S-Curve permet de créer des tempos qui 
vont en accélérant ou en décélérant selon une 
courbe de tempo doté d'un point d'inflexion 
définissable déterminant les valeurs du temps et 
de la mesure à mi-parcours.

Advanced : lorsque la case Advanced est cochée, 
la plage de la sélection adopte le format défini 
par l'échelle temporelle principale ; des options 
supplémentaires et modifiées sont disponibles. 

Calculate (option avancée) : permet de choisir 
de calculer la valeur de fin de la sélection, le 
tempo de début, le tempo de fin ou la courbe du 
changement de tempo. 

Le fait de sélectionner l'option Follow 
Metronome Click indique à la valeur de note 
BPM du tempo de reproduire la valeur du 
métronome définie dans les marqueurs de 
temps. Page S-Curve (option avancée)
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Selection Start and End : affiche les points de 
début et de fin du changement du tempo dans la 
référence temporelle principale actuellement 
sélectionnée. Lorsqu'une sélection d'édition est 
effectuée, les champs Start et End affichent les 
limites de la sélection. Le fait de modifier les 
valeurs de début et de fin a pour effet de 
modifier la plage de la sélection.

Start and End Time (option avancée) : affiche la 
valeur absolue de la fin de la sélection. Si la 
valeur de l'échelle temporelle principale est 
Bars|Beats, la valeur de fin s'affiche dans l'échelle 
temporelle secondaire. Si l'échelle temporelle 
principale est au format temporel absolu, la 
valeur de fin est calculée et exprimée selon un 
format Bars|Beats.

Tempo Start and End : affiche le tempo, en 
temps par minute (BPM), pour les points de 
début et de fin de la plage sélectionnée. Le 
changement de tempo entraîne la modification 
de la valeur de fin.

Curvature : spécifie et affiche une représentation 
graphique et numérique de la courbe de tempo. 
Les nombres négatifs indiquent un changement 
du tempo plus rapide au début et à la fin de la 
plage de temps alors que cette valeur est la plus 
faible à mi-parcours. Les nombres positifs 
indiquent une valeur de changement faible vers 
le début et la fin de la plage sélectionnée, la 
valeur la plus élevée se trouvant à mi-parcours. 
Vous définissez cette valeur au moyen de la 
glissière.

Mid Point : indique l'emplacement sur l'échelle 
temporelle principale du point central de la 
courbe. Vous définissez cette valeur au moyen 
de la glissière.

Mid Tempo : spécifie le tempo à mi-parcours. 
Vous définissez cette valeur au moyen de la 
glissière.

Resolution (option avancée) : permet de 
sélectionner la valeur de note BPM pour votre 
paramètre de tempo.

Density (option avancée) : permet de spécifier le 
nombre d'événements de changement du 
tempo dans la règle de tempo.

Preserve Tempo after Selection : si cette option 
est sélectionnée, le paramètre de tempo 
précédent appliqué au point de fin de sélection 
est préservé après la sélection. Lorsque l'option 
n'est pas sélectionnée, le dernier paramètre de 
tempo créé par l'opération liée au tempo reste en 
vigueur à la fin de la session, ou jusqu'à 
l'événement de tempo suivant au-delà de la 
plage sélectionnée.

Page Scale

La page Scale permet de mettre à l'échelle des 
tempos dans une sélection par un pourcentage.

Le fait de sélectionner l'option Follow 
Metronome Click indique à la valeur de note 
BPM du tempo de reproduire la valeur du 
métronome définie dans les marqueurs de 
temps.

Page Scale
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Advanced : lorsque la case Advanced est cochée, 
la plage de la sélection adopte le format défini 
par l'échelle temporelle principale ; des options 
supplémentaires et modifiées sont disponibles.

Calculate (option avancée) : combinés avec les 
paramètres choisis dans le menu déroulant 
Scale, le menu déroulant Calculate vous permet 
de choisir de calculer la valeur de fin de la 
sélection, le tempo moyen, le tempo de début 
ou encore le tempo de fin. 

Scale (option avancée) : combinés avec les 
paramètres choisis dans le menu déroulant 
Calculate, le menu déroulant Scale vous permet 
de choisir de mettre à l'échelle l'ensemble des 
tempos, le tempo de début ou encore le tempo 
de fin.

La mise à l'échelle de l'ensemble des tempos a 
pour effet d'attribuer le même coefficient à 
chaque tempo de la plage sélectionnée. 
En revanche, avec la mise à l'échelle du tempo 
de début, les tempos sont traités de manière 
différente : la mise à l'échelle du premier 
événement de tempo est plus importante alors 
que la mise à l'échelle des événements qui 
suivent diminue au fur et à mesure jusqu'au 

tempo de fin qui n'est pas mis à l'échelle. Avec la 
mise à l'échelle du tempo de fin, les tempos sont 
traités de manière différente : la mise à l'échelle 
du dernier événement de tempo est plus 
importante alors que la mise à l'échelle des 
événements qui précèdent diminue au fur et à 
mesure jusqu'au tempo de début qui n'est pas 
mis à l'échelle.

Selection Start and End : affiche les points de 
début et de fin de l'opération liée au tempo dans 
la référence temporelle principale actuellement 
sélectionnée. Lorsqu'une sélection d'édition est 
effectuée, les champs Start et End affichent les 
limites de la sélection. Le fait de modifier les 
valeurs de début et de fin a pour effet de 
modifier la plage de la sélection.

Start and End Time : affiche la référence 
temporelle absolue des points de début et de fin 
de la sélection. Si la valeur de l'échelle 
temporelle principale est Bars|Beats, les temps 
s'affichent dans l'échelle temporelle secondaire. 
Si l'échelle temporelle principale est au format 
temporel absolu, les temps sont calculés et 
exprimés selon un format Bars|Beats.

Average Tempo : affiche le tempo moyen, en 
temps par minute (BPM) sur la plage 
sélectionnée. Le fait de modifier le tempo 
moyen affecte le pourcentage de mise à l'échelle.

Scale : affiche le pourcentage de mise à l'échelle 
du tempo, en temps par minute (BPM) sur la 
plage sélectionnée. La modification de la mise à 
l'échelle affecte le tempo moyen.

Page Scale (option avancée)
Chapitre 20 : Pistes du chef d'orchestre et emplacements mémoire 443



444
Preserve Tempo after Selection : si cette option 
est sélectionnée, le paramètre de tempo 
précédent appliqué au point de fin de sélection 
est préservé après la sélection. Lorsque l'option 
n'est pas sélectionnée, le dernier paramètre de 
tempo créé par l'opération liée au tempo reste en 
vigueur à la fin de la session, ou jusqu'à 
l'événement de tempo suivant au-delà de la 
plage sélectionnée.

Page Stretch

La page Stretch permet de sélectionner des 
événements de tempo et de les appliquer à une 
zone plus grande ou plus petite de la sélection.

Advanced : lorsque la case Advanced est cochée, 
la plage de la sélection adopte le format défini 
par l'échelle temporelle principale ; des options 
supplémentaires et modifiées sont disponibles.

Selection Start and End : indique la plage des 
événements de tempo que vous voulez modifier. 
Lorsqu'une sélection d'édition est effectuée, les 
champs Start et End affichent les limites de la 
sélection. 

Stretch To End : spécifie un nouveau point de 
fin pour la région à laquelle vous voulez 
appliquer les événements de tempo 
sélectionnés. La modification du point de fin a 
un impact sur le pourcentage Stretch.

Stretch To Start (option avancée) : spécifie un 
nouveau point de début pour la région à 
laquelle vous voulez appliquer les événements 
de tempo sélectionnés. La modification du 
point de début a un impact sur le pourcentage 
Stretch.

Stretch : détermine le pourcentage de temps 
couvert par les événements de tempo 
sélectionnés.

Preserve Tempo after Selection : si cette option 
est sélectionnée, le paramètre de tempo 
précédent appliqué au point de fin de sélection 
est préservé après la sélection. Lorsque l'option 
n'est pas sélectionnée, le dernier paramètre de 
tempo créé par l'opération liée au tempo reste en 
vigueur à la fin de la session, ou jusqu'à 
l'événement de tempo suivant au-delà de la 
plage sélectionnée.

Commande Identify Beat
La commande Identify Beat vous permet 
d'établir une table de tempo/mesure pour des 
données audio enregistrées sans référence à un 
métronome ou pour des données audio 
importées dont les tempos sont inconnus.

La commande Identify Beat analyse une plage 
de sélection (généralement avec un nombre 
précis de temps ou de mesures) et calcule son 
tempo d'après la métrique spécifiée. Au cours du 
processus, les marqueurs Bar|Beat 
correspondant au tempo calculé sont insérés et 

Page Stretch
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apparaissent dans la règle de tempo au début et 
à la fin de la sélection ; de plus, les événements 
de métrique sont insérés dans la règle de 
métrique.

Marqueurs Bar|Beat

Les marqueurs Bar|Beat ressemblent aux 
événements de tempo, mais leur emplacement 
est indiqué par de petits triangles bleus.

Choix entre les marqueurs Bar|Beat et 
les événements de tempo

Les événements de tempo faisant référence aux 
tics et les marqueurs Bar|Beat aux échantillons, 
ils ne peuvent pas être mélangés. Si une session 
contient des événements de tempo et que vous 
tentez d'insérer des marqueurs Bar|Beat, les 
événements de tempo existants sont convertis 
en marqueurs Bar|Beat (et réciproquement).

Les événements de tempo peuvent également 
être convertis en marqueurs Bar|Beat 
(et réciproquement). 

Pour choisir d'utiliser les événements de tempo ou 
les marqueurs Bar|Beat :

1  Appuyez sur Pomme (Macintosh) ou sur Ctrl 
(Windows) et cliquez sur le bouton Add Tempo 
Change.

2  Choisissez Tempo Events ou Bar|Beat Markers 
dans le menu déroulant. 

Lors de la conversion d'événements de tempo en 
marqueurs Bar|Beat et inversement, il peut se 
produire un léger arrondi des échantillons.

Identification des temps

Pour ajouter des marqueurs Bar|Beat sur une 
boucle de batterie d'une mesure :

1  Placez une boucle de batterie d'une mesure au 
début d'une piste audio.

2  Sélectionnez View > Rulers > Samples. Ceci 
garantit que la sélection des données audio 
s'effectuera à l'échantillon près.

3  Sélectionnez la région audio avec l'outil 
d'accrochage de temps, puis choisissez Event > 
Identify Beat.

Utilisez Beat Detective pour générer des 
marqueurs Bar|Beat dans une sélection 
comportant des changements rythmiques 
sur chaque temps et subdivision de temps. 
Pour plus d'informations, reportez-vous 
au Chapitre 21, Beat Detective.

Marqueur Bar|Beat

Menu déroulant de la règle de tempo
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4  Dans la boîte de dialogue Bar|Beat Markers, 
indiquez les points de début et de fin 
correspondant aux marqueurs Bar|Beat insérés. 
Cet exemple utilisant une boucle d'une mesure, 
entrez 1|1|000 et 2|1|000.

5  Le cas échéant, indiquez la mesure (Time 
signature) correspondant aux plages de début et 
de fin.

6  Cliquez sur OK pour calculer 
automatiquement le nouveau tempo et insérer 
les marqueurs Bar|Beat et événements de 
métrique nécessaires. Tout événement de tempo 
et de métrique se trouvant dans la sélection est 
supprimé.

Après avoir déterminé le tempo des données 
audio, vous pouvez dupliquer la région audio 
d'origine à l'aide de la commande Repeat.

Lorsque vous travaillez avec une sélection, la 
commande Identify Beat ne calcule qu'un seul 
tempo pour la plage sélectionnée. Si le tempo 
varie d'une mesure à l'autre ou d'un temps à 
l'autre, vous devrez utiliser la commande 
Identify Beat pour chaque variation de tempo 
(en vous assurant que vous définissez une plage 
de sélection ou un emplacement de temps 
correspondant précisément au changement de 
tempo).

Pour définir avec précision les tempos 
correspondant à une plage de données audio au 
moyen de la commande Identify Beat, vous 
devez veiller à ce que la sélection initiale 
représente un nombre précis de temps ou de 
mesures. Une astuce utile consiste à lire la 
sélection en boucle (voir Lecture en boucle, 
page 345) pour vérifier qu'elle ne « saute » pas 
rythmiquement. Pour éviter tout décalage et 
garantir une précision à l'échantillon près, 
sélectionnez les données audio en ayant 
préalablement défini l'échelle temporelle sur 
Samples plutôt que sur Bars|Beats.

Boîte de dialogue Identify Beat

Marqueurs Bar|Beat insérés

Lors de l'identification des temps, 
sélectionnez une zone aussi large que 
possible. Si, par exemple vous voulez 
identifier un fichier audio s'étendant sur 
quatre mesures, sélectionnez les quatre 
mesures au lieu d'une seule pour réduire les 
erreurs d'arrondi.
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Déplacement des marqueurs Bar|Beat

Vous pouvez faire glisser les marqueurs Bar|Beat 
vers de nouveaux emplacements pour les aligner 
sur des régions audio qui ont été déplacées ou 
sur un point légèrement différent d'une région 
audio. Ceci a pour résultat d'aligner les données 
MIDI sur la nouvelle table de tempos.

Les marqueurs Bar|Beat font référence aux 
échantillons et les événements de tempo aux 
tics, c'est pourquoi il se comportent de façon 
différente lorsque vous les faites glisser dans la 
règle de tempo.

Lorsque vous faites glisser un événement de 
tempo :

• L'événement de tempo est placé à un nouvel 
emplacement en mesure/temps. Les 
expressions en échantillons et en adresse 
SMPTE des positions de l'événement sont 
également mises à jour.

• La valeur BPM correspondant à l'événement 
de tempo déplacé demeure constante, de 
même que les autres événements de tempo de 
la session.

• Les événements MIDI voisins, ainsi que la 
règle, raccourcissent ou s'allongent pour 
s'ajuster au nouvel emplacement de tempo.

Lorsque vous faites glisser un marqueur Bar|Beat :

• Sa valeur BPM est recalculée d'après le 
marqueur Bar|Beat qui se trouve 
immédiatement à sa gauche. Les marqueurs 
Bar|Beat situés à la droite du marqueur 
déplacé demeurent en place.

• Son emplacement, en mesure/temps, est 
déplacé avec le marqueur Bar|Beat. Si le 
marqueur Bar|Beat a été placé au départ à 
3|1|000, il y reste (sauf si vous l'éditez).

• Les expressions de son emplacement en 
échantillons et en adresse SMPTE changent en 
fonction du calcul du nouveau tempo pour le 
marqueur Bar|Beat.

• Les événements MIDI voisins, ainsi que la 
règle, raccourcissent ou s'allongent pour 
s'ajuster au nouveau tempo.

Edition des marqueurs Bar|Beat

Un marqueur Bar|Beat Marker peut être édité 
pour redéfinir son emplacement exprimé en 
mesure/temps, ce qui redéfinit également le 
point de début et de fin de la plage analysée 
pour le tempo. Ceci est différent du 
déplacement d'un marqueur Bar|Beat en le 
faisant glisser. 

Déplacement d'un marqueur Bar|Beat

Boîte de dialogue Edit Bar|Beat
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Pour éditer un marqueur Bar|Beat :

1  Dans la règle de tempo, cliquez deux fois sur le 
marqueur Bar|Beat.

2  Dans la boîte de dialogue Edit Bar|Beat, entrez 
le nouvel emplacement du marqueur Bar|Beat.

3  Le cas échéant, entrez une nouvelle mesure 
(Time Signature). 

4  Cliquez sur OK.

Pour supprimer un marqueur Bar|Beat :

Tout en appuyant sur Option (Macintosh) ou 
sur Alt (Windows), déplacez le curseur sur le 
marqueur Bar|Beat (le curseur devient un outil 
d'accrochage muni d'un « – ») et cliquez dessus 
pour le supprimer.

Insertion de marqueurs Bar|Beat 
individuels
Matériel exprimé en échantillons avec des 
tempos variables

Vous pouvez insérer les marqueurs Bar|Beat un 
par un, en définissant un point d'insertion 
d'édition (plutôt que d'effectuer une sélection) 
avant d'utiliser la commande Identify Beat. 
La possibilité d'identifier chaque temps, l'un 
après l'autre, est particulièrement utile avec du 
matériel dont les tempos varient.

Par exemple, si une mesure accélère légèrement, 
vous pouvez insérer un marqueur Bar|Beat sur 
chaque temps (voir Figure 15) afin de refléter 
précisément les variations du tempo.

Même après avoir inséré des marqueurs 
Bar|Beat, d'autres ajustements de la table de 
tempos restent possibles, en faisant glisser 
chaque marqueur, pour les aligner avec le temps 
associé dans les données audio.

Evénements de métrique
Vous pouvez modifier la métrique dans la règle 
de métrique ou apportez des modifications 
précises dans la fenêtre Time Operations.

Les événements de métrique peuvent être 
insérés au début d'une session pour remplacer la 
métrique par défaut (de 4/4), et n'importe où 
dans la session pour d'autres modifications de la 
métrique.

Pour afficher la règle de métrique :

■ Sélectionnez View > Rulers > Meter.

Métrique en cours

Conforme aux événements de métrique 
survenant en cours de lecture, la métrique en 
cours de la session apparaît dans la fenêtre 
Transport.

Figure 15.  Marqueurs Bar|Beat sur chaque temps

Métrique en cours affichée dans la fenêtre Transport

Métrique actuelle
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Insertion d'événements de 
métrique

Pour insérer un événement de métrique :

1  Effectuez l'une des opérations suivantes :

• Choisissez Event > Time > Change Meter.

• Cliquez sur le bouton Add Meter Change 
situé à gauche de la règle de métrique

• Tout en appuyant sur Contrôle 
(Macintosh) ou sur la touche de démarrage 
(Windows), déplacez le curseur dans la 
règle de métrique (le curseur devient un 
outil d'accrochage muni d'un « + ») et 
cliquez à l'emplacement où vous souhaitez 
insérer l'événement.

• Cliquez deux fois sur le vumètre dans la 
fenêtre Transport.

2  Dans la fenêtre Meter Change, entrez 
l'emplacement (Location) et la valeur (Meter) 
correspondant au changement de métrique 
désiré.

Cochez l'option Snap To Bar pour placer 
l'événement de métrique inséré précisément sur 
le premier temps de la mesure la plus proche.

3  Choisissez une valeur de note (ronde, 
blanche, noire, etc.) pour le nombre de clics 
entendus dans chaque mesure. Sélectionnez 
l'option point (.) si vous voulez une valeur 
pointée.

4  Cliquez sur Apply pour insérer le nouvel 
événement de métrique. Le nouvel événement 
de métrique est inséré et apparaît dans la règle 
de métrique.

Bouton d'ajout de mesure

Insertion manuelle d'un événement de métrique

Vumètre actuel dans la fenêtre Transport

Fenêtre de changement de métrique

Avec certaines métriques, il peut être 
souhaitable d'utiliser une valeur pointée. 
Par exemple, dans le cas d'une métrique de 
6/8, le choix d'une noire pointée (donnant 
deux clics par mesure) est généralement 
mieux adapté qu'une croche simple (six clics 
par mesure).

Evénement de métrique inséré
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A chaque événement de métrique est associé un 
petit triangle jaune qui indique son 
emplacement. Vous pouvez sélectionner ce 
triangle pour le copier et le coller ou cliquer 
deux fois dessus pour éditer l'événement de 
métrique.

Edition des événements de métrique

Les événements de métrique existants peuvent 
être édités, supprimés, copiés et collés.

Pour éditer un événement de métrique :

1  Dans la règle de métrique, cliquez deux fois 
sur l'événement de métrique.

2  Dans la boîte de dialogue Meter Change, 
entrez un nouvel emplacement (Location) ou 
une nouvelle valeur (Meter) pour l'événement.

3  Cliquez sur OK.

Pour supprimer un événement de métrique :

■ Tout en appuyant sur Option (Macintosh) ou 
sur Alt (Windows), déplacez le curseur sur 
l'événement de métrique (le curseur devient un 
outil d'accrochage muni d'un « – ») et cliquez 
dessus pour le supprimer.

Pour copier et coller plusieurs événements de 
métrique :

1  Si vous le souhaitez, réglez le mode d'édition 
sur Grid pour restreindre la sélection en 
fonction du pas de grille actuel. 

2  Déplacez-vous dans la règle de métrique pour 
sélectionner la région qui inclut les événements 
de métrique.

Si le début de la sélection inclut un événement 
de métrique, appuyez sur Pomme (Macintosh) 
ou sur Ctrl (Windows) pour faire apparaître le 
sélecteur.

3  Choisissez Edit > Copy.

4  Cliquez dans la règle de métrique à l'endroit 
où vous souhaitez coller les événements de 
métrique.

5  Choisissez Edit > Paste. Le contenu du presse-
papiers est collé à partir du point d'insertion et 
remplace les événements de métrique existants.

Pour étendre une sélection d'édition d'une piste à 
la règle de métrique :

1  A l'aide du sélecteur ou d'un outil 
d'accrochage, sélectionnez une plage de la piste.

2  Cliquez sur la règle de métrique tout en 
appuyant sur Maj.

Cliquez de nouveau sur la règle de métrique tout 
en appuyant sur Maj pour la retirer de la 
sélection.

Pour sélectionner tous les événements de 
métrique :

■ Cliquez deux fois avec le sélecteur dans la 
règle de métrique.

Evénements de métrique sélectionnés

Appuyez sur Option (Macintosh) ou sur Alt 
(Windows) tout en vous déplaçant pour 
effectuer la sélection dans toutes les pistes 
du chef d'orchestre.
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Pour supprimer une plage sélectionnée 
d'événements de métrique :

1  Si vous le souhaitez, réglez le mode d'édition 
sur Grid pour restreindre la sélection en 
fonction du pas de grille actuel. 

2  Déplacez le sélecteur dans la règle de métrique 
pour sélectionner les événements de métrique 
que vous voulez supprimer.

3  Choisissez Edit > Clear pour supprimer les 
événements de métrique sélectionnés.

Mesures partielles

Le cas échéant, Pro Tools créera une mesure 
partielle pour s'adapter à l'événement de 
métrique inséré. Lorsqu'un événement de 
métrique est précédé d'une mesure partielle, il 
apparaît en italiques dans la règle de métrique.

Les mesures partielles peuvent également 
apparaître lorsque vous collez des événements 
de mesure à d'autres emplacements que le 
premier temps d'une mesure.

Fenêtre Time Operations
La fenêtre Time Operations permet d'effectuer 
les opérations suivantes :

• changer la métrique ;

• insérer des temps ;

• supprimer des temps ;

• déplacer le début du morceau.

Pour ouvrir une fenêtre Time Operations 
spécifique :

■ Choisissez Event > Time, suivi de l'une des 
commandes Time Operations (Change Meter, 
par exemple).

Pour ouvrir la dernière fenêtre Time Operations 
active :

■ Choisissez Event > Time > Operations 
Window.

Mesure partielle 4/4

Pour insérer des événements de métrique en 
évitant les mesures partielles, utilisez la 
commande Change Meter de la fenêtre Time 
Operations. Reportez-vous à la section 
Changement de métrique, page 452.

Si la fenêtre Time Operations est toujours 
ouverte, vous pouvez sélectionner Time 
Operation à partir du menu déroulant situé 
en haut de la fenêtre.

Appuyez sur Alt + 1 (Windows) ou 
Option + 1 (Macintosh) pour ouvrir la 
fenêtre Time Operations et affichez la 
fenêtre Time Operations la plus 
récemment activée.
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Changement de métrique

Change Meter permet de spécifier des 
changements de métrique complexes pour le 
matériel exprimé en mesures/temps (Bar|Beat). 
Vous pouvez entrer des modifications de 
métrique dans une mesure donnée, modifier la 
métrique sur une période de temps sélectionnée 
ou ajouter des modifications de métrique de 
manière séquentielle, mesure après mesure.

Les options de la commande Change Meter sont 
les suivantes :

New Meter : permet de spécifier une nouvelle 
mesure. Le premier champ permet de saisir le 
nombre de temps (jusqu'à 99) compris dans une 
mesure et le deuxième champ la durée de la note 
correspondant à un temps.

Click : permet de spécifier la valeur de la note 
qui déclenche le clic du métronome. Si, par 
exemple, vous choisissez la croche, un clic se 
produit pour toutes les croches, et ce 
indépendamment du tempo.

Starting at Bar : définit la mesure où intervient 
le changement de métrique. Les changements 
de métrique indiqués à la page Change Meter 
peuvent seulement être réalisés au début d'une 
mesure.

Apply Change To : permet d'appliquer le 
changement de métrique à la plage 
sélectionnée, à la fin de la session ou jusqu'à la 
mesure suivante. 

Change : les champs Change permettent 
d'indiquer le nombre de mesures de la nouvelle 
métrique que vous voulez remplacer par la plage 
sélectionnée.

Pro Tools calcule automatiquement le nombre 
entier de mesures le plus proche ; vous pouvez 
également spécifier le nombre de mesures qui 
seront concernées. Du temps est inséré ou 
supprimé, sous forme d'incréments de mesures 
complets, à la fin de la sélection, sur toutes les 
pistes affectées lorsque vous remplacez la plage 
calculée.

Option Realign

Les commandes associées au paramètre Realign 
permettent de choisir les éléments à réaligner 
après les changements de métrique. Vous 
pouvez choisir de réaligner les événements de 
métrique ou les événements de métrique et de 
tempo, les marqueurs et les pistes faisant 
référence aux tics ou toutes les pistes (ou aucune 
des pistes) faisant référence aux échantillons.

Meter Ruler Only : applique les changements de 
métrique exclusivement à la règle de métrique. 
Les autres règles et pistes ne subissent aucune 
modification.

Meter and Tempo Rulers, Tick-Based Markers and 
Tracks, and Sample-based Markers and Tracks : 
applique les changements de métrique à 
l'ensemble des règles, aux pistes basées sur les 
tics et à votre choix de pistes basées sur des 
échantillons. Du temps est inséré ou supprimé, 
le cas échéant, à la fin de la sélection pour 
préserver l'alignement du matériel qui suit la 
sélection. 

Fenêtre de changement de métrique
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Exemples de changements de métrique

Pour modifier la métrique sur une plage de 
mesures :

1  Faites glisser le sélecteur pour sélectionner une 
plage de mesures à modifier.

– ou –

Pour que le changement de métrique soit 
appliqué jusqu'à l'événement de métrique 
suivant, cliquez à l'aide du sélecteur sur l'endroit 
où vous souhaitez que commence le 
changement. Le changement métrique se 
produit au début de la mesure la plus proche.

2  Choisissez Event > Time > Change Meter.

3  Spécifiez une nouvelle métrique et un 
paramètre Click. Pro Tools définit 
automatiquement les options de sélection de 
manière à ce que la nouvelle métrique concorde 
le mieux possible avec la plage sélectionnée, en 
ajoutant ou soustrayant éventuellement des 
temps.

4  Sélectionnez Selected Range dans le menu 
déroulant Apply Change To.

5  Choisissez les règles et les pistes à réaligner 
lorsque les changements de métrique effectués.

6  Cliquez sur Apply.

Pour ajouter une série de changements de 
métrique, une mesure après l'autre :

1  A l'aide du sélecteur, cliquez à l'endroit où 
vous souhaitez que commence le changement. 
Le changement métrique se produit au début de 
la mesure la plus proche.

– ou –

Entrez le numéro de la première mesure dans le 
champ Starting At Bar. 

2  Choisissez Event > Time > Change Meter.

3  Spécifiez une nouvelle métrique et cliquez sur 
Setting. 

4  Choisissez Until the Next Bar dans le menu 
déroulant Apply Change To.

5  Cliquez sur Apply pour valider la nouvelle 
métrique et placer le point d'insertion à la fin de 
la nouvelle mesure.

6  Spécifiez une nouvelle métrique et un 
paramètre Setting pour la mesure suivante.

7  Répétez les étapes 5 à 6 pour tout changement 
de métrique supplémentaire à insérer.

Insertion d'un temps

Le menu déroulant Insert Time permet d'insérer 
un silence dans les règles de chef d'orchestre, les 
pistes MIDI et audio.

Les options de la commande Insert Time sont les 
suivantes :

Start, End et Length : définit les points de début 
et de fin de la sélection ainsi que la durée de 
celle-ci. 

Fenêtre d'insertion de temps
Chapitre 20 : Pistes du chef d'orchestre et emplacements mémoire 453



454
Set Meter : si la valeur de l'échelle temporelle 
principale est Bars|Beats, Set Meter permet 
d'indiquer une nouvelle métrique pour le temps 
inséré. La sélection est quantifiée au nombre de 
mesures le plus proche ; la métrique précédente 
est insérée après la sélection. 

Si l'échelle temporelle principale fait référence 
aux échantillons, cette option n'est pas 
disponible.

Option Realign

Les commandes associées à l'option Realign 
permettent de choisir les éléments qui seront 
décalés (ultérieurement) lorsque le temps est 
inséré, de la manière suivante :

• Si l'échelle temporelle principale est au format 
temporel Bars|Beats, vous pouvez choisir de 
réaligner seulement les événements de 
métrique ou de réaligner une combinaison de 
règles de métrique et de tempo, les marqueurs 
et les pistes faisant référence aux tics et un 
choix de pistes basées sur des échantillons.

• Si l'échelle temporelle principale est au format 
temporel absolu (Min:Sec par exemple), vous 
pouvez décider d'aligner indépendamment les 
événements du chef d'orchestre, les 
marqueurs et les pistes faisant référence aux 
tics et un choix de pistes basées sur des 
échantillons. 

Meter Ruler Only : si l'échelle temporelle 
principale est au format temporel Bars|Beats, 
vous pouvez seulement insérer des temps dans 
la règle de métrique. Les événements de 
métrique postérieurs au point de début de la 
sélection sont décalés après le point de la fin de 
la durée de la sélection. 

Si l'échelle temporelle principale fait référence 
aux échantillons, l'option n'est pas disponible.

Meter and Tempo Rulers : permet d'insérer des 
temps dans les règles de métrique et de tempo. 
Les événements de métrique et de tempo 
postérieurs au point de début de la sélection 
sont décalés après le point de la fin de la durée 
insérée.

Tick-Based Markers and Tracks : permet de 
décaler les marqueurs de type Bar|Beat et 
d'insérer du temps dans les pistes basées sur des 
tics. Les événements associés aux marqueurs 
ainsi que les pistes basées sur des tics postérieurs 
au point de début de la sélection sont décalés, 
après le point de la fin, de la durée insérée.

Si la sélection de temps inclut des régions audio 
sur des pistes basées sur les tics, les régions audio 
sont séparées au point de début ; la nouvelle 
région contenant la sélection précédente est 
décalée vers le point de fin.

Sample-Based Markers and Tracks : permet de 
décaler les marqueurs de format temporel 
absolu et d'insérer du temps dans les pistes 
basées sur les échantillons. Les événements 
associés aux marqueurs ainsi que les pistes 
faisant référence aux échantillons postérieurs au 
point de début de la sélection sont décalés après 
le point de la fin de la durée insérée.

Si la sélection inclut des régions audio sur des 
pistes faisant référence aux échantillons, les 
parties sélectionnées des régions audio sont 
séparées au point de début ; la nouvelle région 
contenant la sélection précédente est décalée 
vers le point de fin.
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Exemple d'insertion de temps

Pour insérer quatre mesures vides 4/4 temps 
vides une session :

1  Définissez le format Bars|Beats pour l'échelle 
temporelle principale.

2  Choisissez Event > Time > Insert Time.

3  Spécifiez la mesure où vous voulez insérer les 
mesures dans le champ Start. 

4  Entrez quatre mesures dans le champ Length.

5  Sélectionnez Meter and Tempo Rulers, All 
Tick-Based Markers & Tracks et All Sample-Based 
Markers and Tracks pour l'option Realign.

6  Cliquez sur Apply.

Suppression de temps

Le paramètre Cut Time permet de supprimer un 
intervalle de temps défini (données de règles 
temporelles et de piste) des règles de chef 
d'orchestre, des pistes MIDI et audio.

Les options de la commande Cut Time sont les 
suivantes :

Start, End et Length : définit les points de début 
et de fin de la sélection ainsi que la durée de 
celle-ci. 

Option Realign

Les commandes associées à l'option Realign 
permettent de choisir les éléments qui seront 
décalés à l'issue de la suppression du temps, de la 
manière suivante :

• Si l'échelle temporelle principale est au format 
temporel Bars|Beats, vous pouvez choisir de 
réaligner seulement les événements de 
métrique ou de réaligner une combinaison de 
règles de métrique et de tempo, les marqueurs 
et les pistes faisant référence aux tics et un 
choix de pistes basées sur des échantillons.

• Si l'échelle temporelle principale est au format 
temporel absolu (Min:Sec par exemple), vous 
pouvez décider d'aligner indépendamment les 
événements du chef d'orchestre, les 
marqueurs et les pistes faisant référence aux 
tics et un choix de pistes basées sur des 
échantillons. 

Meter Ruler Only : si l'échelle temporelle 
principale est au format temporel Bars|Beats, 
vous pouvez seulement supprimer des temps 
dans la règle de métrique. Les événements de 
métrique dans la sélection sont supprimés et 
ceux qui se produisent après le point de fin de la 
sélection sont décalés vers le point de début de 
la sélection. 

Si l'échelle temporelle principale fait référence 
aux échantillons, l'option n'est pas disponible.

Meter and Tempo Rulers : permet de supprimer 
du temps dans les règles de métrique et de 
tempo. Les événements de métrique et de tempo 
dans la sélection sont supprimés et ceux qui se 
produisent après le point de fin de la sélection 
sont décalés vers le point de début de la 
sélection.

Fenêtre de suppression de temps
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Tick-Based Markers and Tracks : permet de 
décaler les marqueurs de type Bar|Beat et de 
supprimer le temps des pistes basées sur les tics. 
Les événements associés aux marqueurs ainsi 
que les pistes basées sur les tics dans la sélection 
sont supprimés et ceux postérieurs au point de 
fin de la sélection sont décalés vers l'avant.

Si la sélection de temps inclut des régions audio 
basées sur les tics, la zone sélectionnée de la 
région audio est supprimée ; la région qui suit la 
sélection est décalée vers l'avant.

Sample-Based Markers and Tracks : permet de 
décaler les marqueurs de format temporel 
absolu et de supprimer du temps des pistes 
basées sur les échantillons. Les événements 
associés aux marqueurs ainsi que les pistes 
basées sur les échantillons dans la sélection sont 
supprimés et ceux postérieurs au point de fin de 
la sélection sont décalés vers l'avant.

Si la sélection de temps inclut des régions audio 
faisant référence aux échantillons, la zone 
sélectionnée de la région audio est supprimée ; 
la région qui suit la sélection est décalée vers 
l'avant.

Exemple de suppression de temps

Pour couper trente secondes d'une session :

1  Définissez le format Minutes:Seconds pour 
l'échelle temporelle principale.

2  Choisissez Event > Time > Cut Time.

3  A l'aide du sélecteur, cliquez au début de la 
zone à couper. 

4  Entrez trente secondes (0:30.000) dans le 
champ Length.

5  Sélectionnez Meter and Tempo Rulers, All 
Tick-Based Markers & Tracks et All Sample-Based 
Markers and Tracks pour l'option Realign.

6  Cliquez sur Apply.

Déplacement du début d'un 
morceau

Le paramètre Move Song Start permet de 
redéfinir l'emplacement du début d'un morceau.

Les options de la commande Move Song Start 
sont les suivantes :

Timebase : permet de redéfinir avec précision la 
position du marqueur de début de morceau 
mesuré par une règle temporelle compatible.

Move Start To : définit l'emplacement du 
marqueur de début de morceau dans la règle 
temporelle choisie. 

Renumber Song Start To : lorsque cette option 
est activée, elle permet de définir le marqueur de 
début de morceau à n'importe quel numéro de 
mesure.

Fenêtre de déplacement du début d'un morceau
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Move

Les commandes associées à l'option Move 
permettent de déterminer les éléments à décaler 
lorsque le début du morceau est déplacé, de la 
manière suivante :

Song Start Only : déplace le marqueur de début 
de morceau uniquement.

Meter and Tempo Rulers, Tick-Based Markers and 
Tracks, and Sample-based Markers and Tracks : 

déplace le marqueur de début de morceau, règles 
de métrique et de tempo, les marqueurs et les 
pistes basées sur les tics et votre sélection de 
pistes faisant référence aux échantillons. 

Exemple de déplacement de début d'un 
morceau

Pour déplacer le marqueur de début d'un morceau 
de 15 secondes sur la timeline :

1  Choisissez Event > Time > Move Song Start.

2  Sélectionnez Minutes:Seconds dans le menu 
déroulant Timebase. 

3  Dans le champ Move Song Start To, entrez 
0:15:000 pour déplacer le début du morceau de 
15 secondes vers l'avant.

4  Si vous voulez renuméroter les mesures de 
manière à ce que le marqueur de début de 
morceau se trouve dans une autre mesure, 
sélectionnez l'option Renumber Song Start et 
entrez le numéro de la mesure dans le champ 
Renumber 1st Bar to.

5  Indiquez si vous voulez déplacer les pistes et 
les marqueurs basés sur des échantillons ou 
aucun d'eux en sélectionnant la case 
correspondante. 

6  Cliquez sur Apply.

Renumérotation des mesures
La commande Renumber Bars permet de 
renuméroter toutes les mesures d'une session, en 
changeant effectivement l'expression, en 
mesures/temps, des emplacements de toutes les 
régions, événements de métrique et de tempo, 
tout en laissant intacte leur position. A l'issue de 
cette manipulation, les expressions, en 
échantillons et en SMPTE, des emplacements 
des données audio de la session ne sont pas 
modifiés.

Pour renuméroter les mesures :

1  Choisissez Event > Renumber Bars.

2  Indiquez la mesure à renuméroter (bar) ainsi 
que le nouveau numéro de la mesure (becomes 
bar), puis cliquez sur Renumber.

Emplacements mémoire et 
marqueurs
Chaque session peut enregistrer jusqu'à 999 
emplacements mémoire, qui peuvent servir à 
rappeler :

• des marqueurs des emplacements 
importants de la session

• des sélections d'édition sur une ou 
plusieurs pistes

• des plages d'enregistrement et de lecture, 
avec les valeurs de pré et de post-roll

Boîte de dialogue Renumber Bars
Chapitre 20 : Pistes du chef d'orchestre et emplacements mémoire 457



458
• des paramètres des pistes, y compris le 
statut Masquer/Afficher, la hauteur de piste 
et les valeurs de zoom

• l'activation de groupes d'édition et de 
mixage

Les emplacements mémoire sont affichés et triés 
dans la fenêtre Memory Locations, dans laquelle 
vous pouvez les rappeler en cliquant dessus.

Propriétés des emplacements 
mémoire

Lorsque vous créez un emplacement mémoire 
(voir Création d'emplacements mémoire, 
page 460) vous êtes invité à définir ses propriétés 
temporelles (Time Properties) et ses propriétés 
générales (General Properties).

Propriétés temporelles

Sous Time Properties, vous pouvez régler un 
emplacement mémoire sur Marker, Selection ou 
None. Ce choix détermine le type 
d'emplacement mémoire créé. Chacun de ces 
trois types d'emplacement mémoire peut 
également enregistrer n'importe quelle 
combinaison de propriétés générales.

Marker : l'option Marker rappelle un 
emplacement de timeline, exprimée en 
mesures/temps (Bar|Beat, référence basée sur les 
tics) ou en nombre d'échantillons (Absolute). 
Lorsque vous rappelez un emplacement 
mémoire de type Marker, le curseur de lecture va 
se placer sur l'emplacement du marqueur, et les 
temps de début et de fin de la fenêtre Transport 
sont également mis à jour. Si les sélections 
d'édition et de timeline sont reliées, le curseur 
d'édition se déplace également sur 
l'emplacement du marqueur.

Les marqueurs apparaissent dans la règle des 
marqueurs avec une fine ligne jaune qui traverse 
toutes les pistes de la fenêtre Edit (pour vous 
aider à réorganiser et à aligner les données des 
pistes). Cliquer sur un marqueur dans la règle 
des marqueurs rappelle son emplacement et ses 
propriétés générales.

Selection : l'option Selection rappelle un 
emplacement de sélection d'édition ou de 
curseur d'édition, dont la référence peut être de 
type Bar|Beat (mesures/temps, basée sur les tics) 
ou absolue (basée sur l'échantillon). Un 
emplacement mémoire de type Selection permet 
de sauvegarder des sélections d'édition, pour 

Boîte de dialogue Memory Location
Marqueurs dans la règle des marqueurs
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une ou plusieurs pistes, auxquelles vous revenez 
souvent pendant une session. Si les sélections 
d'édition et de timeline sont liées, un 
emplacement mémoire de sélection peut aussi 
rappeler des plages d'enregistrement et de 
lecture.

None : ne rappelle aucune propriété temporelle 
et est donc appelé emplacement mémoire des 
propriétés générales.

Références Bar|Beat et absolue

Le menu déroulant Reference détermine si 
l'emplacement mémoire Marker ou Selection est 
de type Bar|Beat ou absolu. Si vous choisissez 
l'option Bar|Beat, l'emplacement mémoire est 
basé sur les tics ; autrement dit, l'expression de 
son emplacement en mesures/temps demeure 
constant, même si vous modifiez le tempo. 
En revanche, sa position relative aux données 
audio, dont la position est exprimée en 
échantillons, change.

Si vous choisissez l'option Absolute, 
l'emplacement mémoire est exprimé en 
échantillons ; autrement dit, son emplacement 
exprimé en mesures/temps change dès qu'on 
modifie le tempo. En revanche, la relation aux 
données audio, elles aussi référencés aux 
échantillons, n'est pas altérée.

Dans la règle des marqueurs, les marqueurs de 
type Bar|Beat apparaissent comme des écussons 
jaunes, tandis que les marqueurs absolus 
apparaissent sous forme de diamants jaunes.

Propriétés générales

Les trois types d'emplacements mémoire 
(Marker, Selection et None) peuvent stocker et 
rappeler n'importe quelle combinaison des 
propriétés générales suivantes :

Zoom Settings : rappelle les valeurs de zoom 
horizontal, audio et MIDI pour les pistes audio, 
MIDI et d'instrument.

Pre- and Post-Roll Times : rappelle les valeurs de 
pré et de post-roll (mais pas l'éventuelle 
activation des fonctions correspondantes). 
Cette propriété peut être stockée avec un 
emplacement mémoire de sélection pour 
rappeler des plages d'enregistrement et de 
lecture avec des valeurs de pré/post-roll.

Track Show/Hide : rappelle quelles pistes sont 
masquées. Cette propriété vous permet 
d'afficher des groupes de pistes pour l'édition et 
le mixage.

Track Heights : rappelle toutes les hauteurs de 
pistes. Utilisez cette option avec l'option Zoom 
Settings pour rappeler des environnements 
d'édition adaptés à des tâches particulières, 
comme l'édition jusqu'au niveau de 
l'échantillon ou le rognage de notes MIDI.

Group Enables : rappelle quels groupes d'édition 
et de mixage sont actifs. Cette option est utile 
pour rappeler des groupes pour des tâches 
particulières d'édition et de mixage, telles que la 
coupure de toutes les pistes de batterie ou 
l'atténuation d'une paire stéréo.

Seules des sélections contiguës peuvent être 
sauvegardées avec des emplacements 
mémoire. Les sélections non contiguës, 
effectuées avec l'outil de saisie d'objet, 
seront rappelées comme si la sélection avait 
été faite avec l'outil d'accrochage de temps.

Marqueur Bar|Beat (à gauche) et marqueur Absolu 
(à droite)
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Commentaires

Les trois types d'emplacements mémoire 
(Marker, Selection et None) peuvent stocker et 
rappeler les commentaires. Vous pouvez entrer 
un maximum de 255 caractères pour décrire un 
emplacement mémoire. Vous avez également la 
possibilité d'éditer les commentaires 
précédemment saisis.

Création d'emplacements 
mémoire

Il est possible de créer des emplacements 
mémoire de différentes manières, suivant 
leur type.

Lorsque vous créez un emplacement mémoire, 
le numéro disponible suivant lui est attribué 
(1–999). Ce numéro sert à rappeler 
l'emplacement mémoire depuis le pavé 
numérique.

Pour créer un emplacement mémoire de type 
marqueur :

1  Configurez les paramètres de la session que 
vous sauvegarderez avec l'emplacement 
mémoire de type marqueur, tels que les 
paramètres de zoom, le statut 
d'affichage/masquage des pistes, les hauteurs de 
pistes et l'activation des groupes d'édition et de 
mixage.

2  Sélectionnez Options > Link Timeline and 
Edit Selection.

3  Si la règle des marqueurs n'est pas affichée, 
sélectionnez View > Rulers > Markers.

4  Avec le sélecteur, cliquez sur une piste ou une 
règle à l'emplacement où vous souhaitez placer 
le marqueur. Pour placer un marqueur au début 
d'une région, sélectionnez-la à l'aide de l'outil 
d'accrochage de temps. Cliquez sur le bouton 
Add Marker/Memory Location (ou appuyez sur 
la touche Entr du pavé numérique).

– ou –

Tout en appuyant sur Contrôle (Macintosh) ou 
sur la touche de démarrage (Windows), déplacez 
le curseur dans la règle des marqueurs (le curseur 
devient un outil d'accrochage muni d'un « + ») 
et cliquez à l'emplacement où vous souhaitez 
placer le marqueur.

5  Dans la boîte de dialogue New Memory 
Location, sélectionnez l'option Marker et 
indiquez sa référence, Bar|Beat ou Absolute.

6  Entrez le nom du nouveau marqueur et 
sélectionnez les propriétés générales que vous 
voulez sauvegarder avec le marqueur.

7  Cliquez sur OK. Le marqueur est créé et 
apparaît dans la règle des marqueurs, ainsi que 
dans la fenêtre Memory Locations.

Pour en savoir plus, reportez-vous aux 
sections Création d'emplacements 
mémoire, page 460 et Edition des 
emplacements mémoire, page 463.

Bouton d'ajout d'emplacement mémoire/de marqueur

Insertion manuelle d'un marqueur
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Pour créer un emplacement mémoire de 
sélection :

1  Configurez les paramètres de la session que 
vous sauvegarderez avec l'emplacement 
mémoire de type Selection, tels que les 
paramètres de zoom, le statut 
d'affichage/masquage des pistes, les hauteurs de 
pistes et l'activation des groupes d'édition et de 
mixage.

2  Sélectionnez une plage de données sur une ou 
plusieurs pistes. 

3  Appuyez sur la touche Entr du pavé 
numérique.

– ou –

Dans le menu déroulant de la fenêtre Memory 
Locations (cliquez sur le bouton Name), 
choisissez Add Memory Location.

4  Dans la boîte de dialogue New Memory 
Location, sélectionnez l'option Selection et 
indiquez la référence, Bar|Beat ou Absolute.

5  Entrez le nom du nouvel emplacement 
mémoire et sélectionnez les propriétés générales 
que vous voulez sauvegarder.

6  Cliquez sur OK. L'emplacement mémoire de 
sélection est créé et apparaît dans la fenêtre 
Memory Locations.

Pour créer un emplacement mémoire des 
propriétés générales :

1  Configurez les paramètres de la session que 
vous sauvegarderez avec l'emplacement 
mémoire de type Selection, tels que les 
paramètres de zoom, le statut 
d'affichage/masquage des pistes, les hauteurs de 
pistes et l'activation des groupes d'édition et de 
mixage.

2  Appuyez sur la touche Entr du pavé 
numérique.

3  Dans la boîte de dialogue Memory Location, 
sélectionnez l'option None.

4  Entrez le nom du nouvel emplacement 
mémoire et sélectionnez les propriétés générales 
que vous voulez sauvegarder.

5  Cliquez sur OK. L'emplacement mémoire des 
propriétés générales est créé et apparaît dans la 
fenêtre Memory Locations.

Création d'emplacements mémoire à 
la volée

Lorsque l'option Auto-Name Memory Locations 
When Playing des préférences d'édition est 
activée, vous pouvez créer des emplacements 
mémoire en cours de lecture sans ouvrir la boîte 
de dialogue New Memory Location. Vous 
pouvez également sélectionner cette option 
dans le menu déroulant de la fenêtre Memory 
Locations.

Cette fonction est utile lorsque vous voulez 
marquer certains emplacements tout en 
écoutant une passe d'enregistrement, ou 
marquer certaines images lors du visionnage 
d'une scène vidéo.

Dans la boîte de dialogue New Memory 
Location, vous pouvez activer ou désactiver 
toutes les propriétés en cliquant sur 
n'importe quelle propriété générale tout en 
maintenant enfoncée la touche Option 
(Macintosh) ou Alt (Windows). Vous 
pouvez aussi cliquer sur n'importe quelle 
propriété en appuyant sur Pomme 
(Macintosh) ou sur Ctrl (Windows) pour 
changer son état et celui de toutes les autres 
propriétés générales.
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Pour créer un marqueur en cours de lecture :

1  Dans le menu déroulant de la fenêtre Memory 
Locations, sélectionnez Default To Marker. Ceci 
garantit que les nouveaux emplacements 
mémoire seront, par défaut, des marqueurs.

2  Dans le menu déroulant de la fenêtre Memory 
Locations, sélectionnez Auto-Name Memory 
Locations.

3  Pour les marqueurs insérés ayant une 
référence Bar|Beat, veillez à définir l'échelle de 
temps principale sur Bars:Beats.

4  Cliquez sur le bouton de lecture dans la 
fenêtre Transport.

5  Lorsque l'emplacement est atteint, appuyez 
sur la touche Entr du pavé numérique. Un 
marqueur est créé automatiquement et apparaît 
dans la règle des marqueurs.

Les marqueurs créés automatiquement sont 
nommés et numérotés sous la forme 
« Marker 1 », « Marker 2 », « Marker 3 », etc.

Lorsque l'option Default To Marker est 
désélectionnée, les nouveaux emplacements 
mémoire seront par défaut identiques au dernier 
type créé. Cela signifie que si le dernier 
emplacement mémoire créé était une sélection, 
c'est ce type qui sera créé à la volée. Dans ce cas, 
le nom de l'emplacement mémoire créé est basé 
sur le début de la sélection d'édition, en 
reprenant le format de l'échelle temporelle 
principale (tel que « 2|2|305 » ou « 0:02.658 »).

Rappel d'emplacements mémoire

Vous pouvez rappeler des emplacements 
mémoire à partir de la fenêtre Memory 
Locations et à partir du pavé numérique. De 
plus, vous pouvez rappeler des emplacements 
mémoire de type Marker en cliquant dessus 
dans la règle des marqueurs.

Pour rappeler un emplacement mémoire :

1  Si la fenêtre Memory Locations n'est pas 
ouverte, choisissez Window > Memory 
Locations pour l'ouvrir.

2  Si vous rappelez un emplacement mémoire de 
sélection qui définit une plage d'enregistrement 
ou de lecture, sélectionnez Options > Link 
Timeline and Edit Selection.

3  Effectuez l'une des opérations suivantes :

• Cliquez sur l'emplacement mémoire désiré 
dans la fenêtre Memory Locations pour le 
rappeler.

• Lorsque le mode du pavé numérique est 
réglé sur Classic, appuyez sur le numéro de 
l'emplacement mémoire suivi de la touche 
point. 

• Lorsque le mode du pavé numérique est 
réglé sur Transport ou Shuttle, appuyez sur 
la touche Point (.), sur le numéro de 
l'emplacement mémoire, suivi à nouveau 
de la touche Point (.).

Pour rappeler un marqueur depuis la règle des 
marqueurs :

1  Si la règle des marqueurs n'est pas affichée, 
sélectionnez View > Rulers > Markers.

2  Cliquez sur le marqueur. Le curseur de lecture 
se positionne sur le marqueur et les propriétés 
générales stockées avec le marqueur sont 
rappelées.

Si vous rappelez un emplacement mémoire à 
partir du pavé numérique, il n'est pas 
nécessaire que la fenêtre Memory Locations 
soit ouverte.

Même si la règle des marques n'est pas 
affichée, vous pouvez rappeler des marqueurs 
à partir de la fenêtre Memory Locations et à 
partir du pavé numérique.
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Edition des emplacements 
mémoire

Les emplacements mémoire peuvent être 
renommés, édités, supprimés, copiés et collés.

Pour renommer un emplacement mémoire :

1  Dans la fenêtre Memory Locations, cliquez 
deux fois sur l'emplacement mémoire que vous 
voulez renommer.

– ou –

Si vous renommez un emplacement mémoire de 
type marqueur, cliquez deux fois sur le 
marqueur dans la règle des marqueurs.

2  Entrez le nouveau nom de l'emplacement 
mémoire puis cliquez sur OK.

Pour redéfinir les propriétés générales d'un 
emplacement mémoire :

1  Configurez les paramètres de la session tels 
que les paramètres de zoom, les valeurs de pré et 
de post-roll, le statut d'affichage/masquage des 
pistes, les hauteurs de pistes et l'activation des 
groupes.

2  Dans la fenêtre Memory Locations, cliquez sur 
l'emplacement mémoire que vous voulez 
redéfinir en maintenant enfoncée la touche 
Control (Macintosh) ou cliquez avec le bouton 
droit de la souris (Windows).

– ou –

Si vous modifiez un emplacement mémoire de 
type marqueur, cliquez sur le marqueur dans la 
règle des marqueurs en maintenant enfoncée la 
touche Control (Macintosh) ou cliquez avec le 
bouton droit de la souris (Windows).

3  Dans la boîte de dialogue Memory Locations, 
sélectionnez les propriétés générales que vous 
voulez sauvegarder avec l'emplacement 
mémoire.

4  Entrez le nom de l'emplacement mémoire et 
cliquez sur OK. 

Pour changer le type d'un emplacement mémoire :

1  Dans la fenêtre Memory Locations, cliquez 
deux fois sur l'emplacement mémoire que vous 
voulez modifier.

– ou –

Si vous modifiez un emplacement mémoire de 
type marqueur, cliquez deux fois sur le 
marqueur dans la règle des marqueurs.

2  Dans la boîte de dialogue Memory Location, 
sélectionnez l'option Marker, Selection, ou 
None comme type d'emplacement mémoire. 

3  Entrez le nom de l'emplacement mémoire et 
cliquez sur OK.

Pour modifier la sélection stockée avec un 
emplacement mémoire :

1  Si la fenêtre Memory Locations n'est pas 
ouverte, choisissez Window > Memory 
Locations pour l'ouvrir.

2  Sélectionnez une plage de données sur une ou 
plusieurs pistes. 

3  Dans la fenêtre Memory Locations, cliquez sur 
l'emplacement mémoire que vous voulez 
redéfinir en maintenant la touche Control 
(Macintosh) ou cliquez avec le bouton droit de 
la souris (Windows).

4  Entrez le nom de l'emplacement mémoire et 
cliquez sur OK.
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Pour déplacer un marqueur en le faisant glisser :

1  Dans la règle des marqueurs, faites glisser le 
marqueur vers la gauche ou la droite.

Lorsque le mode d'édition est réglé sur Grid, 
l'événement déplacé s'aligne sur le pas de grille 
courante. En mode Spot, la boîte de dialogue 
Spot s'ouvre.

Pour aligner un marqueur sur un autre 
emplacement :

1  Sélectionnez Options > Link Timeline and 
Edit Selection.

2  Dans n'importe quelle règle de base de temps, 
cliquez avec le sélecteur sur le nouvel 
emplacement.

– ou –

Cliquez dans la liste de diffusion de n'importe 
quelle piste. Pour aligner le marqueur sur le 
début d'une région, sélectionnez-la à l'aide de 
l'outil d'accrochage de temps.

3  Dans la fenêtre Memory Locations ou la règle 
des marqueurs, cliquez sur l'emplacement 
mémoire de type marqueur que vous voulez 
redéfinir en maintenant enfoncée la touche 
Control (Macintosh) ou cliquez avec le bouton 
droit de la souris (Windows).

4  Entrez le nom du marqueur et cliquez sur OK.

Suppression des emplacements 
mémoire

Pour supprimer un emplacement mémoire :

■ Dans la fenêtre Memory Locations, 
sélectionnez l'emplacement mémoire et 
choisissez Delete Memory Location dans le 
menu déroulant.

– ou –

■ Dans la fenêtre Memory Locations, cliquez sur 
l'emplacement mémoire en maintenant 
enfoncée la touche Option (Macintosh) ou Alt 
(Windows).

Pour supprimer tous les emplacements mémoire :

■ Dans la fenêtre Memory Locations, choisissez 
Delete All dans le menu déroulant.

– ou –

■ Cliquez sur n'importe quel emplacement 
mémoire de la fenêtre Memory Locations en 
maintenant enfoncées les touches Option-Maj 
(Macintosh) ou Alt-Maj (Windows).

Pour supprimer un marqueur de la règle des 
marqueurs :

■ Tout en appuyant sur Option (Macintosh) ou 
sur Alt (Windows), déplacez le curseur sur le 
marqueur (le curseur se transforme alors en outil 
d'accrochage muni d'un « – ») et cliquez dessus 
pour le supprimer.

Déplacement d'un marqueur
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Copie d'emplacements mémoire de 
type marqueur

Pour copier et coller plusieurs marqueurs :

1  Si vous le souhaitez, réglez le mode d'édition 
sur Grid pour restreindre la sélection en 
fonction du pas de grille actuel. 

2  Déplacez-vous dans la règle de tempo pour 
sélectionner les mesures de façon à inclure les 
marqueurs.

Si le début de la sélection inclut un marqueur, 
appuyez sur Pomme (Macintosh) ou sur Ctrl 
(Windows) pour faire apparaître le sélecteur.

3  Choisissez Edit > Copy.

4  Cliquez dans la règle des marqueurs à l'endroit 
où vous souhaitez coller les événements de 
tempo.

5  Choisissez Edit > Paste. Le contenu du presse-
papiers est collé à partir du point d'insertion et 
remplace les marqueurs existants.

Pour étendre une sélection d'édition d'une piste à 
la règle des marqueurs :

1  A l'aide du sélecteur ou de l'outil d'accrochage 
de temps, sélectionnez une plage de piste.

2  Cliquez sur la règle des marqueurs tout en 
appuyant sur Maj. 

Cliquez de nouveau sur la règle de tempo tout 
en appuyant sur Maj pour la retirer de la 
sélection.

Pour sélectionner tous les marqueurs de la règle 
des marqueurs :

■ Cliquez deux fois avec le sélecteur dans la 
règle de tempo.

Fenêtre Memory Locations
La fenêtre Memory Locations affiche la liste des 
emplacements mémoire avec leur nom et leur 
numéro. Pour rappeler un emplacement 
mémoire à partir de cette fenêtre, il vous suffit 
de cliquer dessus.

Vous pouvez choisir, dans le menu déroulant de 
la fenêtre Memory Locations (qui s'affiche en 
cliquant sur le bouton Name en haut à gauche), 
des options d'affichage et de tri, ainsi que des 
commandes pour créer et supprimer des 
emplacements mémoire.

Appuyez sur Option (Macintosh) ou sur Alt 
(Windows) tout en vous déplaçant pour 
effectuer la sélection dans toutes les pistes 
du chef d'orchestre.

Fenêtre Memory Locations avec les icônes des filtres 
d'affichage

Menu déroulant de la fenêtre Memory Locations
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Commandes et options des 
emplacements mémoire

Show Markers Only : lorsque vous sélectionnez 
cette option, seuls les emplacements mémoire 
de type marqueur s'affichent dans la fenêtre 
Memory Locations. Cependant, même si les 
emplacements mémoire de sélection et les 
emplacements mémoire de propriétés générales 
sont masqués, vous pouvez les rappeler à partir 
du pavé numérique.

Show View Filter Icons : lorsque vous 
sélectionnez cette option, la fenêtre Memory 
Locations propose un filtre d'affichage, basé sur 
les icônes, permettant d'afficher ou de masquer 
les emplacements mémoire en fonction de leurs 
propriétés. Pour afficher/masquer les 
emplacements mémoire en fonction de leurs 
propriétés, cliquez sur l'icône appropriée.

Dès qu'une icône est désactivée, tous les 
emplacements mémoire associés à cette 
propriété sont masqués. Cependant, un 
emplacement mémoire qui contient d'autres 
propriétés correspondant à une icône encore 
active restera affiché. Lorsqu'une icône 
d'affichage est active, elle apparaît en couleurs. 
Lorsqu'elle est désactivée, elle apparaît en grisé.

De plus, le filtre d'affichage est pratique pour 
indiquer les propriétés stockées dans chaque 
emplacement mémoire (indiquées par une 
rangée d'icônes avec chaque emplacement 
mémoire).

Show Main/Sub Counter : lorsque vous 
sélectionnez cette option, une colonne apparaît 
dans la fenêtre Memory Locations afin d'afficher 
les emplacements des marqueurs, ainsi que les 
temps de début des emplacements mémoire de 
sélection. Les emplacements mémoire des 
propriétés générales n'affichent rien dans cette 
colonne.

Cliquer en haut de ces colonnes ouvre un menu 
déroulant permettant de modifier les échelles 
temporelles principale et secondaire.

Icônes des filtres d'affichage des emplacements 
mémoire

Marqueur

Emplacements
mémoire de sélection

Paramètres

Pré-roll et post-roll

Afficher/Masquer

Hauteur des pistesde zoom

Groupes
actifs

Fenêtre Memory Locations avec les icônes des filtres 
d'affichage

Compteurs principaux et secondaires dans la fenêtre 
Memory Locations

EchelleEchelle
temporelle principale temporelle secondaire
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Show Comments : lorsque vous sélectionnez 
cette option, une colonne apparaît dans la 
fenêtre Memory Locations afin d'afficher les 
commentaires de chacun des marqueurs.

Sort by Time lorsque cette option est 
sélectionnée, les marqueurs sont triés par ordre 
d'apparition dans la timeline, suivis des 
emplacements mémoire de sélection et des 
propriétés générales, classés par ordre de 
création.

Lorsque l'option Sort by Time est 
désélectionnée, tous les emplacements mémoire 
sont classés par numéro.

Add Memory Location : cette commande permet 
de créer un emplacement mémoire.

Remove Memory Location : supprime 
l'emplacement mémoire sélectionné dans la 
fenêtre Memory Locations.

Delete All : supprime tous les emplacements 
mémoire (marqueur, sélection et propriétés 
générales) de la session.

Default To Marker : lorsque cette option est 
sélectionnée, les nouveaux emplacements 
mémoire créés sont des marqueurs par défaut, 
même si vous pouvez définir un autre type dans 
la boîte de dialogue New Memory Location.

Désignation automatique des emplacements 
mémoire : lorsque cette option est sélectionnée, 
les emplacements mémoire sont créés 
automatiquement sans que la boîte de dialogue 
New Memory Location ne s'ouvre. Si l'option 
Default To Marker est sélectionnée, un 
emplacement mémoire de type marqueur est 
créé automatiquement. Sinon, le type 
d'emplacement mémoire est déterminé par le 
dernier type créé (Marker, Selection, ou None).

Commentaires dans la fenêtre Memory Locations
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Chapitre 21 : Beat Detective

Beat Detective est un puissant outil d'analyse, 
d'édition et de manipulation de données audio 
ou de pistes MIDI avec des données rythmiques 
inhérentes.

Beat Detective analyse une sélection audio ou 
MIDI, détecte ses crêtes des transitoires ou notes 
accentuées et crée des beat triggers basés sur les 
crêtes des transitoires ou les notes MIDI 
détectés. A partir de ces beat triggers, Beat 
Detective peut : 

• Extraire les informations de tempo et repérer 
les temps pour créer des marqueurs Bar|Beat 
utilisables pour définir la table de tempos de la 
session. Pour plus d'informations, reportez-
vous à la section Création de marqueurs 
Bar|Beat avec le Beat Detective, page 481.

• Extraire les informations de tempo et de 
groove sous forme de modèles groove, appelés 
DigiGrooves. Ces modèles peuvent être 
appliqués aux données audio ou MIDI à l'aide 
de Beat Detective ou de Groove Quantize 
(voir Modèles DigiGroove, page 482.

• Divisez la sélection audio en régions à part 
entière, puis conformez (ou « quantifiez ») les 
régions divisées à la table de tempos de la 
session ou aux modèles groove. Reportez-vous 
aux sections Séparation des régions avec 
Beat Detective (données audio uniquement), 
page 484 et Conformation de régions avec 
Beat Detective (données audio uniquement), 
page 486.

Beat Detective et les données source

Le Beat Detective est extrêmement efficace avec 
les données audio ou MIDI aux transitoires 
d'attaque ou aux accents marqués (c'est-à-dire 
avec la plupart des instruments utilisés dans la 
musique populaire, tels que la batterie, la guitare 
ou la basse). Le Beat Detective fonctionnera 
moins bien avec les données audio aux attaques 
moins franches ou au phrasé legato (telles que 
les cordes et les voix).

Applications du Beat Detective

Le Beat Detective peut servir dans de 
nombreuses situations :

Extraction du tempo à partir des données audio : 

Beat Detective peut générer des marqueurs 
Bar|Beat pour l'extraction du tempo, même si les 
données contiennent des tempos variés ou des 
éléments interprétés avec un certain swing. 
De plus, une fois les marqueurs Bar|Beat créés, 
ils peuvent être utilisés pour quantifier d'autres 
régions audio et pistes MIDI. 

Création de DigiGrooves : Beat Detective peut 
extraire des modèles groove, appelés 
DigiGrooves, à partir d'une sélection audio. 
Les DigiGrooves peuvent être utilisés pour 
appliquer le groove ou le feeling d'un passage 
capturé vers d'autres sélections audio (utilisant 
Groove Conform) ou vers des données MIDI 
(utilisant Groove Quantize). 
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Conformation des régions audio : Beat Detective 
peut conformer (« quantifier ») les données 
audio ayant un tempo différent ou des tempos 
variés, à la table de tempos actuelle de la session 
ou à un modèle groove. 

« Resserrer » les performances : Beat Detective 
peut améliorer le « timing » de certaines 
données audio en calculant et en extrayant son 
tempo moyen, puis en conformant ses 
composantes rythmiques (les régions séparées 
par le Beat Detective) à la table de tempos de la 
session.

Correspondance de boucles : comme Beat 
Detective peut extraire les informations de 
tempo et repérer les temps dans les données 
audio, puis conformer ces dernières à une table 
de tempos ou à un modèle groove existants, il 
peut servir à aligner des boucles sur différents 
tempos ou ambiances. Si une boucle présente un 
tempo différent de la session courante, le Beat 
Detective vous permet de séparer rapidement 
chaque temps de la boucle et de les conformer à 
la table de tempos (comme alternative à la 
compression ou à l'extension temporelle de la 
boucle, qui peut modifier la hauteur et 
l'ambiance des données audio). 

Remixes : Beat Detective peut servir pour les 
remixes ou pour créer de nouveaux rythmes. 
Il peut extraire le tempo des pistes de batterie 
d'origine et même, dans certains cas, du mix 
stéréo d'origine. Les nouvelles pistes, audio ou 
MIDI, peuvent être conformées aux données 
d'origine ou, à l'inverse, celles-ci peuvent être 
conformées à de nouvelles pistes de batterie, ce 
qui confère au remix un feeling rythmique 
radicalement nouveau.

Utilisation de la fonction Edit Smoothing en post-
production
(données audio uniquement) La fonction Edit 
Smoothing du Beat Detective permet de 
nettoyer automatiquement des pistes de 
bruitages contenant de nombreuses régions 
devant subir rognage et crossfades : elle 
supprime efficacement les silences ainsi créés 
entre les régions (ce qui conserve l'ambiance 
acoustique de la pièce sur toute la piste).

Configuration d'utilisation du 
Beat Detective
Beat Detective est disponible avec 
Pro Tools HD, LE et M-Powered.

Besoins en RAM du Beat Detective

Les opérations du Beat Detective peuvent 
demander une grande quantité de RAM, en 
particulier si vous travaillez avec plusieurs pistes 
et des sélections de longue durée.

Lorsque vous travaillez avec des données 
audio basées sur des tics, servez-vous de la 
commande Region Separation de Beat 
Detective pour séparer rapidement des 
régions audio en « sons » (ou sections). 
Il est possible également de regrouper les 
régions séparées pour faciliter l'édition et 
l'organisation.

Pro Tools LE et M-Powered ne permettent 
pas d'appliquer Beat Detective à plusieurs 
pistes. Lorsque cela est le cas, seule la piste 
du haut est éditée.
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Pour éviter les situations de mémoire 
insuffisante avec Beat Detective, procédez de la 
façon suivante :

• Si vous remarquez un ralentissement du 
fonctionnement du Beat Detective, ajoutez 
plus de RAM à votre ordinateur 

• Si votre ordinateur ne possède pas 
suffisamment de RAM, travaillez avec des 
sélections plus courtes ou sur des pistes 
individuelles.

• Réduisez le nombre de niveaux d'annulation 
dans les préférences d'édition (voir Niveaux 
d'annulation et RAM, page 294). 
Les opérations demandant beaucoup de 
mémoire, telles que l'Edit Smoothing 
(données audio uniquement) avec Beat 
Detective, peuvent immobiliser une grande 
quantité de RAM lorsqu'elles se trouvent dans 
la filed'annulation.

Fenêtre Beat Detective
La fenêtre du Beat Detective s'affiche, identique à celle illustrée à la Figure 16, ci-dessous. 

Pour ouvrir la fenêtre Beat Detective :

■ Choisissez Event > Beat Detective.

– ou –

■ Appuyez sur Ctrl + 8 (Windows) ou sur 
Pomme + 8 (Macintosh) sur le clavier 
numérique.

Le Beat Detective est une fenêtre flottante que 
vous pouvez laisser ouverte lorsque vous 
travaillez. Vous pouvez donc régler les 
paramètres en temps réel en cours de lecture, 
tout en regardant les beat triggers de votre 
sélection apparaître dans la fenêtre Edit.

Modes du Beat Detective
La fenêtre du Beat Detective se compose de trois 
zones : Operation, Selection et Detection. 
Les commandes proposées dans la zone Action 
varient en fonction du mode de 
fonctionnement (Operation) choisi. Les options 
de sélection (Selection) de Beat Detective restent 
disponibles dans tous les modes de 
fonctionnement.

Figure 16.  Beat Detective (Pro Tools HD illustré)
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Les modes du Beat Detective sont les suivants :

Operation : permet d'analyser, au choix, des 
données MIDI ou des données audio.

Bar|Beat Marker Generation : crée des 
marqueurs Bar|Beat (mesures/temps) 
correspondant aux transitoires détectés dans la 
sélection audio.

Groove Template Extraction : extrait les 
informations rythmiques et dynamiques des 
données audio, et enregistre ces informations 
dans le Presse-Papiers de Groove, ou sous forme 
de modèle DigiGroove.

Region Separation (données audio uniquement) : 
sépare et crée de nouvelles régions en fonction 
des transitoires détectés dans la sélection audio.

Region Conform (données audio uniquement) : 
conforme toutes les régions séparées de la 
sélection à la table de tempos en cours. Beat 
Detective peut conformer des régions audio à 
des modèles groove (tels que des modèles 
DigiGrooves) en plus de la quantification 
standard.

Edit Smoothing (données audio uniquement) : 
remplit les espaces entre les régions conformées 
en rognant automatiquement ces dernières, puis 
insère des crossfades si vous le souhaitez.

Définition d'une sélection 
pour le Beat Detective
Que vous procédiez à la génération des 
marqueurs Bar|Beat (mesures/temps), à 
l'extraction d'un modèle DigiGroove ou à la 
séparation des régions pour les conformer, vous 
devez toujours définir la sélection des données 
audio ou MIDI que vous voulez analyser. 
La fenêtre du Beat Detective offre des outils vous 
permettant de définir et de capturer la plage de 
sélection, la mesure (time signature) et le feeling 
« swing » (subdivision) des données audio 
sélectionnées.

Pour que le Beat Detective puisse créer des beat 
triggers précisément en mesure, la durée et la 
métrique de la sélection doivent être 
correctement définies. De plus, la sélection ne 
peut contenir aucun changement de métrique 
ou de tempo.

Pour définir une sélection de Beat Detective :

1  Dans la fenêtre Edit, sélectionnez une plage de 
données audio ou MIDI sur une ou plusieurs 
pistes.

Pour obtenir les meilleurs résultats possibles 
avec le Beat Detective, assurez-vous que le 
passage sélectionné démarre exactement sur 
l'attaque du premier temps. 

Utilisez la lecture en boucle pour vérifier la 
précision de votre sélection.

Pro Tools LE ne permet pas d'appliquer 
Beat Detective à plusieurs pistes. Lorsque 
cela est le cas, seule la piste du haut est 
éditée.
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Vérifiez que les points de début et de fin de la 
sélection tombent précisément sur le temps. 
Pour atteindre les points de début et de fin d'une 
région audio, faites un zoom au niveau de 
l'échantillon et utilisez l'option de tabulation 
vers transitoires (voir Tabulation vers 
transitoires, page 343).

2  Choisissez Event > Beat Detective.

3  Vous devez définir ou capture la sélection 
chaque fois que vous effectuez une nouvelle 
sélection ou changez la table de tempos. Pour 
définir la plage de sélection, effectuez l'une des 
opérations suivantes :

• Si le tempo et la métrique de la sélection 
audio ne correspondent pas à ceux par 
défaut de la session, entrez la mesure (time 
signature), ainsi que les emplacements de 
Start Bar|Beat et de End Bar|Beat. Pour une 
sélection s'étendant sur quatre mesures et 
commençant sur le premier temps, entrez 
1|1 et 5|1.

• Si le tempo et la métrique de la sélection 
audio ne correspondent pas à ceux par 
défaut de la session et si vous n'êtes pas 
certain de la durée des données 
enregistrées, entrez la mesure (time 
signature), ainsi que les emplacements de 
Start Bar|Beat et de End Bar|Beat, puis 
commencez la lecture et cliquez sur le 
bouton Tap plusieurs fois pour calculer 
automatiquement l'emplacement de End 
Bar|Beat. Lorsque vous utilisez le bouton 
Tap sur de longues sélections, continuez de 
battre la mesure jusqu'à stabilisation de la 
valeur de l'emplacement de End Bar|Beat. 
Une fois cette valeur stabilisée, vous 
pourrez si nécessaire ajuster manuellement 
le nombre sur la limite de la mesure la plus 
proche.

• Si le tempo et la métrique de la sélection 
correspondent à ceux de la session (voir 
Calcul du tempo avec Beat Detective, 
page 474), et si la sélection s'aligne 
correctement sur les mesures et les 
battements de la session, cliquez sur le 
bouton Capture Selection. Les valeurs 
correctes de mesure (time signature), ainsi 
que de Start Bar|Beat et de End Bar|Beat se 
remplissent automatiquement.

Pour conserver intacte la sélection d'édition 
lors de la lecture ou du bouclage à partir de 
n'importe quel emplacement, 
désélectionnez Options > Link Timeline et 
Edit Selection.

Sélection audio pour le Beat Detective

Pour éviter de perdre une sélection existante, 
sauvegardez et rappelez une sélection 
d'édition en l'enregistrant dans un 
emplacement mémoire. Pour plus 
d'informations, reportez-vous à la section 
Emplacements mémoire et marqueurs, 
page 457.

Beat Detective, options de sélection
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4  Pour améliorer la précision du Beat Detective 
dans l'analyse des notes « swinguées », 
sélectionnez l'option Contains qui indique la 
plus petite subdivision du temps contenue dans 
la sélection. L'option Contains peut inclure une 
noire, un huitième de note, un seizième de note 
(par défaut), une triple croche ou un triplet. 
L'option Contains sélectionnée détermine 
l'emplacement de la grille du modèle groove 
pour les modèles DigiGroove.

Calcul du tempo avec Beat 
Detective
Si vous connaissez la métrique, les points de 
début et de fin d'une sélection audio, vous 
pouvez utiliser le Beat Detective pour calculer 
son tempo.

Pour calculer le tempo d'une sélection avec le 
Beat Detective :

1  Effectuez une sélection dans la fenêtre Edit et 
définissez la sélection dans la fenêtre du Beat 
Detective comme indiqué dans Définition d'une 
sélection pour le Beat Detective, page 472.

2  Sélectionnez le mode Bar|Beat Marker 
Generation.

3  Dans la zone Detection (mode Normal), 
cliquez sur le bouton Analyze.

4  Réglez le curseur Sensitivity sur 0%.

5  Cliquez sur Generate.

Des marqueurs Bar|Beat (mesures/temps) sont 
créés automatiquement au début et à la fin de la 
sélection, représentant le tempo et la métrique 
des données.

Tant que les données audio sont 
correctement alignées sur la table de tempos 
de la session, utilisez l'option Capture 
Selection chaque fois que vous effectuez une 
nouvelle sélection ou effectuez les 
changements nécessaires à la table de 
tempos (par exemple, changement de tempo 
ou de métrique).

La définition de la sélection n'est pas 
conservée lorsqu'une session est fermée, 
puis réouverte.

Beat Detective, Mode Detection

Création de marqueurs Bar|Beat avec le Beat Detective 
pour identifier le tempo et la métrique
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Création de beat triggers
Une fois la plage de sélection définie avec 
précision, le Beat Detective peut créer les beat 
triggers d'après les crêtes des transitoires ou les 
notes MIDI détectées. L'étendue et le type de 
transitoires ainsi trouvés peuvent être réglés 
avec les paramètres de détection, ce qui permet 
de « viser » dans les données les mesures, les 
temps et les subdivisions des temps, tout en 
évitant les données non rythmiques.

Pour créer des beat triggers à partir d'une 
sélection audio :

1  Dans la fenêtre Edit, effectuez une sélection 
audio

2  Sélectionnez Audio dans le menu déroulant 
Operation.

3  Dans la fenêtre Beat Detective, sélectionnez 
l'un des modes suivants :

• Bar|Beat Marker Generation

• Groove Template Extraction

• Region Separation (données audio 
uniquement) :

4  Définissez ou capturez la sélection comme 
indiqué à la section Définition d'une sélection 
pour le Beat Detective, page 472.

5  Dans le menu déroulant Analysis, choisissez 
l'un des algorithmes de détection suivants :

• High Emphasis donne de bons résultats 
avec les sons riches en aigus, tels que les 
cymbales et les charleys, et ne prend pas en 
compte les sons graves.

• Low Emphasis donne de bons résultats 
avec les sons graves, tels que la guitare 
basse et la grosse caisse, ainsi qu'avec la 
plupart des données tonales, telles que le 
piano ou la guitare rythmique.

6  Cliquez sur le bouton Analyze. 

7  En fonction du contenu rythmique de la 
sélection, définissez la résolution sur Bars 
(mesures), Beats (temps), ou Sub-Beats 
(subdivisions de temps).

8  Réglez le curseur Sensitivity jusqu'à ce que des 
beat triggers apparaissent sur les temps et 
subdivisions de temps de la sélection.

Les beat triggers correspondant au premier 
temps d'une mesure sont indiqués par des lignes 
épaisses, les beat triggers correspondant aux 
autres temps par des lignes d'épaisseur 
moyenne, et les beat triggers de subdivisions de 
temps par des lignes fines. 

9  Vous pouvez zoomer au niveau échantillon et 
cliquer sur le bouton Scroll Next pour trouver le 
trigger suivant de la sélection. Pour revenir au 
trigger précédent, maintenez la touche Option 
(Macintosh) ou Alt (Windows) enfoncée et 
cliquez sur le bouton Scroll Next (voir 
Navigation dans les beat triggers consécutifs, 
page 480). Ceci permet de vérifier que les beat 
triggers apparaissent aux emplacements 
corrects. Si de « faux triggers » apparaissent entre 
les battements ou les sous-battements 
(représentant des données non rythmiques), 
supprimez-les (voir Suppression de beat triggers, 
page 478), ou réduisez la valeur de sensibilité 
(curseur Sensitivity).

10  Pour afficher les emplacements métriques 
des beat triggers, sélectionnez l'option Show 
Trigger Time.

Beat triggers

MesureBattement Sous-battement
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11  Si les beat triggers n'apparaissent pas aux 
emplacements corrects, répétez les étapes 5–10 
et essayez l'autre algorithme d'analyse (High 
Emphasis ou Low Emphasis).

Pour créer des beat triggers à partir d'une 
sélection MIDI :

1  Dans la fenêtre Edit, réglez la piste MIDI que 
vous avez l'intention d'utiliser sur la vue Notes.

2  Effectuez une sélection à partir d'une plage de 
données MIDI. Assurez-vous que les points de 
début et de fin de la sélection correspondent à 
des emplacement musicaux pertinents (barres 
de mesure, par exemple).

3  Choisissez Event > Beat Detective.

4  Sélectionnez MIDI dans le menu déroulant 
Operation.

5  Dans la fenêtre Beat Detective, sélectionnez 
l'un des modes suivants :

• Bar|Beat Marker Generation

• Groove Template Extraction

6  Définissez la plage de sélection. Si le tempo et 
la métrique de la sélection audio ne 
correspondent pas à ceux par défaut de la 
session, entrez la mesure (time signature), ainsi 
que les emplacements de Start Bar|Beat et de End 
Bar|Beat. Pour une sélection s'étendant sur 
quatre mesures et commençant sur le premier 
temps, entrez 1|1 et 5|1.

7  Si votre piste MIDI contient des accords, 
sélectionnez l'un des algorithmes de 
reconnaissance des accords MIDI suivants à 
partir du menu déroulant Analysis :

• Last Note (Dernière note)

• First Note (Première note)

• Loudest Note (Note la plus forte)

• Average Location (Position moyenne)

• Highest Note (Note la plus haute)

• Lowest Note (Note la plus basse)

8  Cliquez sur le bouton Analyze. 

Reconnaissance des accords MIDI

Etant donné que les notes MIDI d'un accord 
peuvent être jouées avec un léger intervalle, Beat 
Detective considère que les notes jouées à 
intervalle rapproché (équivalent à la moitié au 
moins de la valeur de temps définie dans le 
champ Selection Contains) constituent un 
accord. 

Beat Detective utilise les critères définis dans le 
menu déroulant Analysis pour interpréter la 
position du temps par rapport à l'accord.

Last Note : définit le beat trigger par rapport au 
début de la dernière note jouée dans l'accord.

First Note : définit le beat trigger par rapport au 
début de la première note jouée dans l'accord.

Loudest Note : définit le beat trigger par rapport 
au début de la note de l'accord jouée à la plus 
grande vélocité.

Average Location : définit le beat trigger par 
rapport à un point se trouvant à distance 
moyenne entre le début de la première note 
jouée dans l'accord et la dernière note jouée 
dans l'accord.

Highest Note : définit le beat trigger par rapport 
au début de la note la plus haute jouée dans 
l'accord.

Analyse des accords MIDI

Première
note Dernière

note

Note la plus haute

Note la plus basse
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Lowest Note : définit le beat trigger par rapport 
au début de la note la plus basse jouée dans 
l'accord.

Realignement de session

La fonction de réalignement de session de Beat 
Detective permet de créer des marqueurs 
Bar|Beat sans décalage des données basées sur 
des tics. Cela est pratique pour extrapoler les 
marqueurs Bar|Beat à partir de données basées 
sur des tics afin d'aligner la table de tempos et la 
grille Bar|Beat aux données en question. 

La création de marqueurs Bar|Beat dans des 
sessions constituées de données basées sur des 
tics (pistes MIDI et pistes audio basées sur des 
tics, par exemple),crisque de provoquer un 
décalage de ces données en valeur absolue. Cela 
peut être utile pour aligner les données basées 
sur des tics avec des marqueurs Bar|Beat générés 
à partir de données basées sur des échantillons.

Lorsque vous créez des marqueurs Bar|Beat 
Markers dans une session composée de données 
audio ou MIDI basées sur des tics, Beat Detective 
vous donne la possibilité de préserver la position 
des données en question ou d'autoriser un 
décalage.

Pour créer des marqueurs Bar|Beat Markers avec 
Beat Detective dans une session composée de 
pistes basées sur des tics :

1  Dans la fenêtre Edit, effectuez une sélection 
audio ou MIDI

2  Dans la fenêtre Beat Detective, sélectionnez le 
mode Bar|Beat Marker Generation.

3  Définissez ou capturez la sélection comme 
indiqué à la section Définition d'une sélection 
pour le Beat Detective, page 472.

4  Définissez la résolution de détection sur Bars 
ou Beats.

5  Cliquez sur le bouton Generate. 

6  Dans la boîte de dialogue Realign Session, 
choisissez Preserve Tick Position si vous avez 
l'intention d'autoriser le décalage absolu des 
données basées sur des tics. Cette option permet 
de préserver la fonctionnalité avant 
l'application de Beat Detective.

– ou –

Choisissez Preserve Sample Position si vous 
préférez maintenir la position absolue des 
données basées sur des tics. Cette option peut 
être pratique lors de l'ajout d'une table de 
mesures et de tempos à une performance jouée 
librement.

7  Cliquez sur OK.

Rien ne vous empêche également de passer 
de données basées sur des tics (telles que les 
performances MIDI) à des données basées 
sur des échantillons, puis d'insérer 
manuellement des marqueurs Bar|Beat.

Boîte de dialogue Realign Session
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Conseils pour obtenir des beat triggers 
utilisables

Les conseils suivants vous permettent de vérifier 
les beat triggers :

◆ Pour vous concentrer sur une zone 
particulière de la sélection, séparez les sélections 
d'édition et de timeline, puis définissez la plage 
de lecture en cliquant ou en vous déplaçant 
dans la règle temporelle.

◆ Vérifiez l'épaisseur des beat triggers vous 
vérifier s'ils s'alignent correctement avec les 
données audio. Les lignes épaisses tombent sur 
les barres de mesure, les lignes moyennes sur les 
temps et les lignes fines sur les subdivisions de 
temps. 

◆ Sélectionnez l'option Show Trigger Time et 
vérifiez si les emplacements métriques 
(supposés) des beat triggers s'alignent avec les 
données. Un « faux » beat trigger doit être 
déplacé ou supprimé car il peut provoquer le 
mauvais placement ultérieur des beat triggers 
(voir Edition des beat triggers, page 478).

◆ Evaluez si les sélections longues doivent être 
divisées en sélections plus petites, ce qui facilite 
leur gestion. Par exemple, l'utilisation de 
sections de 8 ou 4 mesures peut s'avérer plus 
rapide et produire de meilleurs résultats. 

◆ Les beat triggers sont préservé lorsque vous 
permutez les modes audio et MIDI. Cela permet 
d'utiliser les triggers MIDI pour éditer des 
données audio ou de collecter des triggers à 
partir de combinaisons de pistes MIDI et de 
pistes audio (Pro Tools HD uniquement).

◆ Pour les sélections englobant plusieurs pistes, 
évaluez s'il est plus simple de travailler 
séparément sur chacune d'elles 
individuellement ou s'il vaut mieux utiliser le 

mode Collection (Pro Tools HD uniquement). 
Pour plus d'informations, reportez-vous à la 
section Mode Detection (Normal) et Collection, 
page 490.

Edition des beat triggers

Bien que le Beat Detective offre une grande 
souplesse au niveau de la détection des 
transitoires, vous devrez à l'occasion supprimer, 
déplacer ou insérer manuellement des beat 
triggers. Vous pouvez également promouvoir 
des beat triggers afin de les conserver à des 
réglages de sensibilité moins élevés. 

Suppression de beat triggers

De « faux » beat triggers, ne représentant pas un 
vrai temps ou subdivision de temps dans les 
données source, peuvent apparaître lorsque 
vous élevez la valeur du curseur Sensitivity afin 
de détecter des données de faible niveau. Dans 
ce cas, vous pouvez repérer et supprimer 
manuellement les faux beat triggers.

Pour supprimer un beat trigger :

1  La fenêtre Beat Detective étant ouverte, 
choisissez un outil d'accrochage dans la fenêtre 
Edit.

2  Recherchez le faux beat trigger que vous 
voulez supprimer. Les transitoires 
correspondant à de faux beat triggers présentent 
généralement des crêtes plus petites que les 
autres beat triggers, et tombent souvent entre les 
subdivisions de temps.

Beat Detective LE ne peut pas être appliqué 
à plusieurs pistes. Lorsque cela est le cas, 
seule la piste du haut est éditée.
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3  Cliquez sur le beat trigger en maintenant 
enfoncée la touche Option (Macintosh) ou Alt 
(Windows) pour le supprimer.

Déplacement des beat triggers

Vous pouvez ajuster le positionnement des beat 
triggers, par exemple pour mieux respecter une 
attaque ou pour compenser une crête 
individuelle se trouvant légèrement devant ou 
derrière le temps.

Pour déplacer un beat trigger :

1  La fenêtre Beat Detective étant ouverte, 
choisissez un outil d'accrochage dans la fenêtre 
Edit.

2  Repérez le beat trigger que vous voulez 
déplacer puis faites-le glisser vers la gauche ou la 
droite.

Insertion de beat triggers

Si un temps (ou une subdivision de temps) 
important n'est pas détecté du fait d'un niveau 
trop faible, vous pouvez insérer un beat trigger 
manuellement.

Pour insérer un beat trigger :

1  La fenêtre Beat Detective étant ouverte, 
choisissez un outil d'accrochage dans la fenêtre 
Edit.

2  Cliquez dans la sélection à l'endroit où vous 
souhaitez insérer le nouveau beat trigger. Après 
avoir inséré un beat trigger, vous pouvez le faire 
glisser vers la gauche ou la droite pour ajuster sa 
position (voir Déplacement des beat triggers, 
page 479).

Si vous cliquez trop près d'un beat trigger 
existant, ce dernier sera déplacé vers le nouvel 
emplacement.

Promotion des beat triggers

Pour être sûr que des beat triggers importants ne 
disparaissent pas lorsque vous réduisez la 
sensibilité, vous pouvez les promouvoir. Ceci est 
utile si, au niveau de sensibilité limite 
d'apparition de beat triggers absolument 
nécessaires, une sélection contient de nombreux 
faux beat triggers (en nombre trop élevé pour se 
lancer dans leur suppression). Pour éviter que la 
réduction de sensibilité ne provoque la 
disparition des beat triggers nécessaires, il suffit 
de les promouvoir.

Suppression d'un beat trigger

Déplacement d'un beat trigger
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Pour promouvoir un beat trigger :

1  Augmentez la sensibilité via le curseur jusqu'à 
ce que le transitoire désiré soit détecté et qu'un 
beat trigger apparaisse.

2  Pour promouvoir ce beat trigger, cliquez 
dessus en maintenant enfoncée la touche 
Pomme (Macintosh) ou Ctrl (Windows). 

3  Si nécessaire, vous pouvez promouvoir 
d'autres beat triggers en répétant les étapes 1–2.

4  Abaissez la sensibilité via le curseur jusqu'à 
une valeur où les faux beat triggers 
disparaissent.

Une fois que vous avez promu des beat triggers, 
ils ne disparaissent que si vous réglez la 
sensibilité à 0%. Pour rétrograder tous les beat 
triggers de la sélection et rétablir leur état 
d'origine, vous pouvez cliquer sur le bouton 
Analyze.

Redéfinition de l'emplacement 
métrique d'un beat trigger

Il est indispensable que les beat triggers soient 
affectés précisément à l'emplacement métrique 
correct. Si un transitoire détecté se trouve 
légèrement décalées par rapport au temps, le 
Beat Detective risque de leur affecter, ainsi qu'à 
d'autres transitoires de la sélection, un mauvais 
emplacement métrique.

Par exemple, si vous avez une piste de basse dans 
laquelle une note normalement placée un temps 
fort a été jouée un peu trop tôt, le Beat Detective 
risque de définir son emplacement comme 
survenant un peu avant le temps fort. Si vous 
effectuez ensuite une séparation puis conformez 
la région contenant cette note, elle sera déplacée 
sur une position erronée. Les régions qui suivent 
peuvent elles aussi se retrouver à un 
emplacement erroné.

Si vous vous apercevez qu'un beat trigger n'est 
pas affecté à l'emplacement métrique correct, 
vous pouvez le redéfinir avec l'option Identify 
Trigger.

Pour modifier l'emplacement métrique d'un beat 
trigger :

1  Cliquez deux fois sur le beat trigger que vous 
voulez repositionner. La boîte de dialogue 
Identify Trigger s'ouvre.

2  Dans la boîte de dialogue Identify Trigger, 
entrez l'emplacement correct du beat trigger 
puis cliquez sur OK. 

Navigation dans les beat triggers 
consécutifs

Utilisez le bouton Scroll Next pour vous 
déplacer du beat trigger sélectionné au suivant. 
Pour revenir au beat trigger précédent, 
maintenez la touche Option (Macintosh) ou Alt 
(Windows) enfoncée et cliquez sur le bouton 
Scroll Next. Ceci est particulièrement utile pour 
l'édition de beat triggers consécutifs lors d'un 
zoom au niveau de l'échantillon.

Boîte de dialogue Identify Trigger
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Création de marqueurs 
Bar|Beat avec le Beat 
Detective
Une fois que le Beat Detective a détecté avec 
précision les crêtes des transitoires dans la 
sélection audio et a créé des beat triggers précis, 
vous pouvez convertir ces derniers en 
marqueurs Bar|Beat. Des marqueurs Bar|Beat 
créés par Beat Detective créent une table de 
tempos et peuvent être utilisés dans toute la 
session.

Une fois une table de tempos établie, d'autres 
régions audio et notes MIDI peuvent être 
conformées aux marqueurs Bar|Beat créés par 
Beat Detective.

Si vous voulez faire correspondre des données 
audio à la table des tempos existante de la 
session ou à modèle de groove, il est 
recommandé de ne pas créer de marqueurs 
Bar|Beat à partir des données. Il est préférable 
d'utiliser le Beat Detective pour séparer et 
conformer les données (voir Séparation des 
régions avec Beat Detective (données audio 
uniquement), page 484).

Pour créer des marqueurs Bar|Beat avec le Beat 
Detective :

1  Dans la fenêtre Edit, effectuez une sélection 
audio

2  Dans la fenêtre Beat Detective, sélectionnez le 
mode Bar|Beat Marker Generation.

3  Définissez ou capturez la sélection comme 
indiqué à la section Définition d'une sélection 
pour le Beat Detective, page 472.

4  Définissez la résolution de détection sur Bars 
ou Beats et configurez les options de détection 
de manière à détecter avec précision les crêtes 
des transitoires de la sélection (voir Création de 
beat triggers, page 475).

5  Cliquez sur le bouton Generate. 

Des marqueurs Bar|Beat sont alors créés, d'après 
les beat triggers, et apparaissent dans la règle 
temporelle.

Utilisation de subdivisions de 
temps

Le tempo est dérivé des marqueurs Bar|Beat. 
Le groove, ou feeling, est dérivé des subdivisions 
de temps—la déviation des subdivisions du 
temps par rapport à la grille stricte de tempo 
détermine le groove ou feeling. 

Pour extraire le groove d'une sélection, réglez la 
résolution de la détection sur Sub-Beats. 
Ceci garantit que les rythmes internes à chaque 
mesure (s'il en existe) sont pris en compte lors 
de la création des marqueurs Bar|Beat. 
Ces marqueurs Bar|Beat peuvent ensuite servir 
pour quantifier d'autres régions audio ou pistes 
MIDI, se conformant ainsi aux marqueurs 
Bar|Beat créés par Beat Detective.

Si vous souhaitez simplement aligner une 
partie grossière à d'autres pistes, il est 
probable que vous n'ayez pas besoin de créer 
des marqueurs Bar|Beat.

Marqueurs Bar|Beat créés avec la résolution Bar

Marqueurs Bar|Beat créés avec la résolution Beat
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Modèles DigiGroove
Le Beat Detective permet d'extraire des nuances 
très précises de synchronisation d'une 
performance rythmique et de les enregistrer 
sous forme de modèle « groove » appelé modèle 
DigiGroove. Les DigiGrooves peuvent être 
enregistrés localement dans le Presse-Papiers de 
Groove ou sur le disque en tant que 
DigiGrooves. 

Les modèles Groove peuvent être utilisés pour 
transférer le feeling d'une performance 
particulière vers :

• Régions audio sélectionnées en utilisant 
Groove Conform (voir Groove Conform, 
page 487).

• Données MIDI sélectionnées à l'aide de 
Groove Quantize (voir Groove Quantize, 
page 530).

Les modèles Groove sont des « tables de 
quantification » dérivées de performances 
musicales réelles. L'aspect rythmique de chaque 
interprétation est analysé et sauvegardé sous 
forme de modèle de groove. Beat Detective 
analyse une sélection audio à la recherche de 
pics de transitoire, en fonction d'un seuil défini 
et affecte les relations rythmiques à un modèle 
de 960 parties par quart de note (ppq).

Lors de la création de modèles DigiGroove, Beat 
Detective analyse également les dynamiques 
d'une performance. Les données de vélocité 
MIDI sont sauvegardées à partir des pistes MIDI 
et les accents et les niveaux de crête sont inclus 
dans le modèle « groove » comme données de 
vélocité, lesquelles peuvent être appliquées pour 
changer les dynamiques des pistes MIDI. 

Beat Detective convertit l'amplitude des signaux 
dans les pistes en vélocité MIDI en respectant 
une échelle linéaire. Par exemple, un signal à 
0 dBFS équivaut à une vélocité MIDI de 127, un 
signal à –6 dBFS équivaut à une vélocité MIDI de 
64, un signal à –12 dBFS équivaut à une vélocité 
MIDI de 32 et un signal à –48 dBFS équivaut à 
une vélocité MIDI de 1.

Il est très important de capturer ces 
informations afin de préserver le feeling d'une 
performance, et de pouvoir ajouter de la vie à 
des pistes MIDI manquant de dynamique. 

Pour extraire un modèle de Groove :

1  Dans la fenêtre Edit, effectuez une sélection 
audio ou MIDI La sélection doit être constituée 
d'une ou plusieurs mesures complètes, en 
commençant et en finissant sur des temps forts.

2  Dans la fenêtre Beat Detective, sélectionnez le 
mode Groove Template Extraction

3  Définissez ou capturez la sélection comme 
indiqué à la section Définition d'une sélection 
pour le Beat Detective, page 472.

Lorsque vous quantifiez des régions ou des 
notes MIDI en insérant des marqueurs 
Bar|Beat sur les subdivisions des temps, qui 
définissent le swing de l'interprétation, 
veillez à utiliser une valeur réduite de 
quantification (en désactivant l'option 
Swing de la fonction Quantize).

Beat Detective capture les données de durée 
uniquement à partir de pistes MIDI, et pas 
de pistes audio.

Lors de l'extraction de modèles Groove, la 
sélection capturée ne doit pas inclure de 
marqueurs Bar|Beat. La précision du 
modèle de groove s'en ressentirait.
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4  Configurez les options de détection de 
manière à détecter avec précision les crêtes des 
transitoires de la sélection (voir Création de beat 
triggers, page 475).

5  Cliquez sur le bouton Extract. 

6  Dans la boîte de dialogue Extract Groove 
Template, entrez les commentaires concernant 
le groove. Vous pouvez entrer un maximum de 
255 caractères pour décrire le groove. Vous 
pouvez consulter les commentaires en cliquant 
sur le bouton Show Info dans la fenêtre Beat 
Detective.

7  Effectuez l'une des opérations suivantes :

• Pour enregistrer le modèle extrait et 
l'utiliser dans la session en cours sans écrire 
le fichier de modèle sur le disque, cliquez 
sur Save To Groove Clipboard. (Ce modèle 
sera perdu lorsque vous fermerez la session 
courante.)

• Pour enregistrer le modèle extrait sur le 
disque afin de l'utiliser dans d'autres 
sessions ou de le partager avec d'autres 
utilisateurs de Pro Tools, cliquez sur Save 
To Disk. Donnez un nom au modèle et 
cliquez sur Save. (Ne changez pas 
l'emplacement des fichiers de modèles 
DigiGroove ni des dossiers ; ils ne seraient 
plus disponibles dans vos sessions.) 

• Cliquez sur Cancel pour annuler sans 
enregistrer le modèle. 

Contenu swing pour la création de modèles 
Groove

Lorsque vous définissez le contenu swing de la 
sélection, sélectionnez l'option Contains 
eighth-note si la sélection audio possède un fort 
groove swingué à la croche. Si la sélection audio 
possède des croches relativement régulières, 
utilisez l'option Contains sixteenth-note. Ceci 
permettra d'appliquer plus facilement ailleurs le 
modèle DigiGroove résultant. Bien qu'un 
groove puisse être basé sur des données de 
croches non swinguées, vous pouvez choisir 
d'appliquer le modèle aux données contenant 
des doubles croches. Si le modèle n'a qu'une 
résolution à la croche, mais que les données 
conformées contiennent des doubles croches, 
les doubles croches adjacentes auront le même 
emplacement de croche.

Extrapolation de groove

La capacité de Beat Detective à extraire des 
données de tempo d'un vaste ensemble de 
données est améliorée par sa puissante logique 
d'« extrapolation de groove ». L'extrapolation 
de groove crée automatiquement l'inclusion de 
beat triggers dans les modèles de groove même 
si aucune crête de transitoire n'est détectée. Par 
exemple, une boucle de batterie peut ne pas 

Boîte de dialogue Extract Groove Template

Utilisez des dossiers et des sous-
répertoires pour organiser les modèles 
DigiGroove. Assurez-vous toutefois qu'ils 
se trouvent toujours dans 
C:\Program Files\ Digidesign\ 
Pro Tools\Grooves (Windows) ou 
Applications/Digidesign/Pro Tools/ 
Grooves (Macintosh). Les fichiers de 
modèles Groove situés à d'autres 
emplacements ne seront pas disponibles 
dans Groove Quantize ou Beat Detective. 
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avoir de coup sur le temps 3, et de ce fait, aucune 
crête de transitoire n'est détectée et aucun beat 
trigger n'est créé. Le Beat Detective effectuera 
une extrapolation à partir des autres beat 
triggers de la sélection et créera un trigger pour 
le temps 3 dans le modèle de groove.

De plus, les triggers extrapolés conservent le 
feeling des triggers créés à partir des crêtes de 
transitoires. Par exemple, si une mesure de 
grosse caisse a détecté trois beat triggers qui se 
trouvent tous 20 tics avant le temps, tout beat 
trigger extrapolé sera également placé 20 tics 
avant le temps.

Séparation des régions avec 
Beat Detective (données 
audio uniquement)
Lorsque des beat triggers apparaissent dans 
votre sélection, ils peuvent être utilisés pour 
définir les points de début et de fin pour de 
nouvelles régions, qui peuvent être séparées 
automatiquement. Les nouvelles régions 
peuvent être conformées à la table de tempos 
existante de la session ou à un modèle de 
groove.

Si vous souhaitez plutôt nettoyer le timing de la 
sélection, sans modifier le tempo existant, 
commencez d'abord par calculer le tempo en 
créant des marqueurs Bar|Beat (voir Calcul du 
tempo avec Beat Detective, page 474).

Pour séparer des régions avec le Beat Detective :

1  Dans la fenêtre Edit, effectuez une sélection 
audio

2  Dans la fenêtre Beat Detective, Sélectionnez le 
mode Region Separation.

3  Définissez ou capturez la sélection comme 
indiqué à la section Définition d'une sélection 
pour le Beat Detective, page 472.

4  Configurez les options de détection de 
manière à détecter avec précision les crêtes des 
transitoires de la sélection (voir Création de beat 
triggers, page 475).

5  Cliquez sur le bouton Separate. 

Les régions sont séparées d'après les beat triggers 
détectés.

Trigger Pad

Lors de la séparation de régions, la fenêtre Beat 
Detective affiche une option nommée Trigger 
Pad.

Entrez une valeur dans ce champ (entre 0 et 
-50 ms) pour décaler les points de début de 
région lorsque le point de séparation est relié au 
beat trigger (transitoire). Ceci crée un espace 
entre le point de début de la région et le point de 
synchronisation de la région, ce qui assure que 
la portion d'attaque des données demeure 
intacte.

Paramètres de détection, mode Region Separation

Région séparée avec Trigger Pad de 20 ms

Début de la région Point de synchronisation 
(point de séparation)

20  ms

(beat trigger)
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Lors de la conformation de régions séparées, 
l'emplacement de la région est déterminé par le 
point de synchronisation de la région (et non 
par le point de début de la région).

 

Séparation sur plusieurs pistes

 

Vous pouvez utiliser les beat triggers d'une seule 
piste ou d'un sous-ensemble de pistes, pour 
séparer un groupe de pistes. 

Dans l'exemple qui suit, la sélection définie est 
une boucle de batterie constituée de deux 
mesures de 5/4. La grosse caisse, la caisse claire, 
les toms et les micros d'overhead sont 
enregistrés sur des pistes séparées.

En analysant la piste de grosse caisse de la 
boucle, avec la résolution de détection définie 
sur Beats, le Beat Detective place les beat triggers 
aux transitoires sur les temps beats 1 et 4 (voir 
Figure 17).

L'extension de la sélection aux pistes de caisse 
claire, de toms et de micro d'overhead, puis la 
séparation, se traduisent par des régions 
séparées dans chacune des pistes de batterie au 
même emplacement, d'après les beat triggers de 
la piste de grosse caisse (voir Figure 18). 

Les régions séparées peuvent alors être 
conformées en tant que groupe.

Vous pouvez également utiliser le mode 
Collection (Pro Tools HD uniquement) lorsque 
vous travaillez avec plusieurs pistes. Le mode 
Collection permet d'analyser et de détecter les 
triggers de chaque piste individuellement et, si 
vous le souhaitez, de n'ajouter que les triggers de 
la piste courante à la collection globale. Pour 
plus d'informations, reportez-vous à la section 
Mode Detection (Normal) et Collection, 
page 490. 

 

Pour plus d'informations sur les points de 
synchronisation des régions, reportez-vous 
à la section Points de synchronisation, 
page 367.

Beat Detective LE ne peut pas être appliqué 
à plusieurs pistes. Lorsque cela est le cas, 
seule la piste du haut est éditée.

 

Figure 17.  Piste de grosse caisse

 

Figure 18.  Pistes de batterie correspondant à la grosse 
caisse, à la caisse claire, aux toms et aux micros 
d'overhead
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Conformation de régions avec 
Beat Detective (données 
audio uniquement)

 

Après avoir séparé les régions avec le Beat 
Detective, vous pouvez les conformer à l'aide de 
l'un des deux modes suivants : 

 

Standard Conform : 

 

utilise la table (grille) de 
tempos courant de la session

 

Groove Conform : 

 

utilise les modèles de groove.

Le Beat Detective conformera toute région 
sélectionnée, qu'elle ait été ou non séparée avec 
lui. Toutefois, pour pouvoir conformer 
correctement des régions avec le Beat Detective, 
le point de début de la région doit correspondre 
au début des données à aligner sur les 
mesures/temps de la session. Ceci ne devrait 
généralement pas poser de problème si les 
régions ont été séparées avec le Beat Detective 
(et non séparées ou rognées manuellement).

 

Standard Conform

 

Ceci revient presque à utiliser la commande 
Region > Quantize to Grid, avec toutefois une 
différence importante : Beat Detective peut 
ajuster la position de toutes les régions en une 
seule opération, que leur feeling soit uniforme 
ou swing.

 

Pour conformer des régions avec l'option Standard 
Conform :

 

1  

 

Dans la fenêtre Beat Detective, sélectionnez le 
mode Region Conform.

 

2  

 

Assurez-vous d'avoir choisi Standard.

 

3  

 

Dans la fenêtre Edit, sélectionnez les régions 
séparées à conformer, si elles le ne sont pas déjà. 
Vérifiez que les points de début et de fin de la 
sélection tombent précisément sur le temps.

 

4  

 

Dans la fenêtre Beat Detective, définissez ou 
recapturez la sélection comme indiqué dans 
Définition d'une sélection pour le Beat 
Detective, page 472.

 

5  

 

Pour déterminer le degré de conformation des 
régions à la grille (table de tempos), sélectionnez 
l'option Strength et indiquez une valeur en 
pourcentage, soit à l'aide du curseur, soit en 
saisissant un nombre : 

• Un pourcentage faible préserve le feeling 
rythmique d'origine des régions.

• Un pourcentage élevé aligne les régions 
plus fortement sur la table de tempos, 
100% correspondant à un alignement 
parfait sur celle-ci.

 

6  

 

Pour définir quelles régions seront 
conformées, sélectionnez l'option Exclude 
Within et indiquez une valeur en pourcentage, 
soit à l'aide du curseur, soit en saisissant un 
nombre :

• Les pourcentages réduits garantissent que 
les régions plus éloignées des pas de la grille 
sont conformées et que les régions les plus 
proches ne le sont pas.

 Beat Detective, options Standard Conform  

Pour «  resserrer  » le feeling initial, tout en 
le préservant, réglez le paramètre Strength 
entre 85 et 88%.
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• Pour des pourcentages élevés, les régions 
les plus proches du pas de la grille sont 
conformées, ainsi que les régions les plus 
éloignées.

 

7  

 

Pour obtenir un feeling « swing » sur les 
régions conformées, sélectionnez l'option Swing 
et déterminez si le swing est basé sur les croches 
ou les doubles croches, puis indiquez une valeur 
en pourcentage, soit à l'aide du curseur, soit en 
saisissant un nombre :

• Les pourcentages plus faibles produisent 
moins de swing, la valeur 0% n'en 
produisant aucun.

• Les pourcentages plus élevés produisent 
davantage de swing, la valeur 100% 
produisant un feeling de swing ternaire.

• Les valeurs en pourcentage entre 100 et 150 
déplacent les régions au-delà du swing 
ternaire, tendant vers la double croche 
suivante (à condition que la valeur de note 
Swing soit définie sur les croches).

 

8  

 

Cliquez sur le bouton Conform pour 
conformer automatiquement toutes les régions 
de la sélection.

 

9  

 

Pour écouter les nouvelles régions 
conformées, cliquez sur Play dans la fenêtre 
Transport. 

 

10  

 

Le cas échéant, sélectionnez Edit > Undo et 
répétez les étapes 4–8 en essayant un autre 
ensemble de paramètres de conformation.

– ou –

Le cas échéant, appliquez la fonction Edit 
Smoothing (voir Edit Smoothing (données 
audio uniquement, page 489).

 

Groove Conform

 

Plutôt que d'utiliser une grille basée sur la table 
de tempos de la session, Groove Conform utilise 
une grille basée sur un modèle de groove, ou 
DigiGroove. Les DigiGrooves peuvent être 
utilisés pour appliquer le feeling d'un passage 
capturé aux régions audio sélectionnées. Pour 
plus d'informations sur la création de modèles 
DigiGroove, reportez-vous à la section Modèles 
DigiGroove, page 482.

 

Pour « resserrer » le feeling initial, tout en le 
préservant, réglez la valeur Exclude Within 
entre 10 et 15%.

Si le Beat Detective a capturé suffisamment 
de subdivisions de temps à partir d'une 
sélection avant la séparation, vous pouvez 
effectuer la conformation avec l'option 
Swing pour faire passer le groove d'un 
feeling « régulier » à un feeling « swing ». 
Vous pouvez également importe un 
modèle de groove contenant un feeling 
swing (voir Groove Conform, page 487).

 

Régions conformées avec Beat Detective
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Pour conformer des régions avec Groove 
Conform :

1  Dans la fenêtre Beat Detective, sélectionnez le 
mode Region Conform.

2  Sélectionnez Groove.

3  Dans la fenêtre Edit, sélectionnez les régions 
séparées à conformer, si elles le ne sont pas déjà. 
Vérifiez que les points de début et de fin de la 
sélection tombent précisément sur le temps.

4  Dans la fenêtre Beat Detective, définissez ou 
recapturez la sélection comme indiqué dans 
Définition d'une sélection pour le Beat 
Detective, page 472.

5  Dans le menu déroulant Groove Template, 
sélectionnez le Presse-Papiers de Groove ou 
enregistrez un modèle de groove (pour des 
informations sur la création de modèles de 
groove, consultez Modèles DigiGroove, 
page 482).

6  Pour voir les commentaires concernant le 
modèle sélectionné, cliquez sur Show Info. 

7  Pour déterminer le degré de conformation des 
régions au modèle de groove, sélectionnez 
l'option Timing et indiquez une valeur en 
pourcentage, soit à l'aide du curseur, soit en 
saisissant un nombre : 

• Un pourcentage faible préserve le feeling 
rythmique d'origine des régions.

• Un pourcentage élevé aligne les régions 
plus fortement sur la grille des modèles de 
groove, 100% correspondant à un 
alignement parfait sur celle-ci.

• Si le curseur est défini sur 200%, les régions 
se déplacent vers un emplacement ayant 
deux fois la différence entre l'emplacement 
de la région d'origine et celui de 
l'événement du modèle de référence. 

Par exemple, si une note a été jouée à la mesure 
1|1|060 (double croche), et si l'événement du 
modèle correspondant se trouve à 1|1|073, une 
valeur de curseur de 100% se traduit par le 
décalage de la note à 1|1|073 ; une valeur de 
curseur de 200% décale le note à 1|1|086.

8  Si vous le souhaitez, activez l'option Pre-
Process using Standard Conform. Lorsque cette 
option est activée, le Beat Detective conforme 
les régions aux paramètres Standard Conform 
courants avant d'appliquer le modèle de groove. 
Avec les données dans lesquelles les 
performances n'étaient pas précises, l'option 
Pre-Process using Standard Conform peut 
produire de meilleurs résultats en vérifiant la 
correspondance précise des performances aux 
mesures, temps et subdivisions de temps 
corrects avant d'appliquer le modèle de groove. 
L'expérimentation est le meilleur moyen de 
déterminer lorsque cette option doit être 
utilisée. 

Beat Detective, options Groove Conform

Lorsque vous utilisez Groove Conform, la 
sélection capturée ne doit pas inclure de 
marqueurs Bar|Beat. La précision du 
modèle de groove s'en ressentirait.

Lors de la conformation d'un passage audio 
à un modèle de groove fortement 
« swingué », l'utilisation de l'option Pre-
Process using Standard Conform produira 
souvent de meilleurs résultats.
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9  Cliquez sur le bouton Conform pour 
conformer automatiquement toutes les régions 
de la sélection.

10  Pour écouter les nouvelles régions 
conformées, cliquez sur Play dans la fenêtre 
Transport. 

11  Le cas échéant, sélectionnez Edit > Undo et 
répétez les étapes 4–9 en essayant un autre 
ensemble de paramètres de modèle de groove ou 
Groove Conform.

– ou –

Le cas échéant, appliquez la fonction Edit 
Smoothing (voir Edit Smoothing (données 
audio uniquement, page 489).

Edit Smoothing (données 
audio uniquement
Après que les régions ont été conformées, des 
espaces peuvent les séparer. Du fait de ces « trous 
de son », la lecture peut donner une impression 
de manque de naturel.

Le Beat Detective peut remplir 
automatiquement les espaces entre les régions et 
même ajouter des crossfades si vous le désirez. 
Cette option, appelée Edit Smoothing, peut être 
utilisée avec des régions qui ont été conformées 
ou avec une piste contenant de nombreuses 
régions (une piste d'effets sonores, par exemple) 

qui doivent être rognées et crossfadées. 
Ce processus automatisé de lissage des 
modifications des régions peut économiser des 
heures et des heures d'édition fastidieuse.

Pour utiliser l'option Edit Smoothing sur les 
régions conformées :

1  Dans la fenêtre Beat Detective, sélectionnez le 
mode Edit Smoothing.

2  Choisissez l'une des options de lissage 
(Smoothing) suivantes :

• Sélectionnez Fill Gaps pour rogner les 
points de fin des régions pour remplir les 
espaces entre régions.

• Sélectionnez Fill And Crossfade pour 
rogner les points de fin des régions et 
ajouter automatiquement un fondu 
d'entrée (en ms) directement avant le point 
de début de chaque région.

3  Dans la fenêtre Edit, sélectionnez la plage des 
régions audio conformer à lisser, si ce n'est déjà 
fait. Vérifiez que les points de début et de fin de 
la sélection tombent précisément sur le temps.

4  Cliquez sur le bouton Smooth pour « lisser » 
les éditions des régions sélectionnées.

5  Ecoutez les résultats en cliquant sur Play dans 
la fenêtre Transport. 

Beat Detective, options d'Edit Smoothing

Aspect de régions avant et après Edit Smoothing
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6  Le cas échéant, sélectionnez Edit > Undo et 
répétez les étapes 2–5 en essayant une durée de 
crossfade (Crossfade Length) différente.

Création de points de synchronisation 
avec l'option Edit Smoothing

Après Edit Smoothing avec Beat Detective, des 
points de synchronisation (correspondant au 
point de début des données) sont créées 
automatiquement pour les régions conformées. 
Ceci vous permet de conformer ultérieurement 
les régions à une table de tempos ou à un 
modèle de groove différents, ou d'utiliser des 
paramètres de conformation différents. En 
revanche, les points de synchronisation ne sont 
créés que s'ils sont nécessaires : Si des espaces 
sont créés entre les régions au cours de Region 
Conform, Fill Gaps en mode Edit Smoothing 
rognera les régions pour les remplir et un point 
de synchronisation sera créé au point de départ 
d'origine de chaque région. S'il n'existe aucun 
espace entre les régions, aucun point de 
synchronisation ne sera créé par Edit 
Smoothing.

Consolidation des régions après Edit 
Smoothing

Le processus de séparation, de conformation et 
de lissage avec Beat Detective peut déboucher 
sur des pistes comportant de nombreuses 
régions et d'innombrables crossfades. Si vous 
travaillez avec plusieurs pistes, la densité de ces 
éditions peut créer des problèmes de 
performances du système.

Une fois que vous êtes satisfait des résultats 
obtenus avec le Beat Detective, il est 
recommandé d'aplanir les pistes avec la 
commande Consolidate. Pour toutes les régions 
sélectionnées, Consolidate crée un seul fichier 
audio contigu afin de réduire la densité 
d'édition de la session. Reportez-vous à la 
section Commande de consolidation, page 419. 

Mode Detection (Normal) et 
Collection
(Pro Tools HD uniquement)

Dans certains cas, il peut être difficile pour le 
Beat Detective d'analyser correctement plusieurs 
pistes avec les mêmes paramètres de détection. 
Le mode Collection du Beat Detective permet de 
rassembler un ensemble de beat triggers issus de 
différentes pistes, chacune possédant des 
paramètres de détection différents, puis 
d'utiliser cet ensemble de beat triggers pour créer 
des marqueurs Bar|Beat ou des modèles 

Pour plus d'informations sur les points de 
synchronisation des régions, reportez-vous 
à la section Points de synchronisation, 
page 367.

Si les performances ne sont pas essentielles, 
servez-vous de la commande Region Group 
pour faciliter l'édition et la manipulation 
des régions. Cela peut être pratique pour 
organiser les temps sectionnés avec Beat 
Detective, notamment si vous prévoyez de 
changer les tempos avec des pistes audio 
basées sur des tics. Pour plus d'informations 
sur les groupes de régions, reportez-vous à la 
section Groupes de régions, page 386.

Avant de consolider une longue sélection 
sur plusieurs pistes, vérifiez que le 
système dispose de suffisamment de 
RAM. Reportez-vous à la section Besoins 
en RAM du Beat Detective, page 470.
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DigiGroove, ou séparer des nouvelles régions. Le 
mode Collection est le seul moyen d'analyser et 
de créer des beat triggers sur une piste et de les 
appliquer sur une autre.

Cette méthode consistant à ajouter des beat 
triggers de façon sélective à partir de plusieurs 
passes d'analyse sur des pistes différentes, 
jusqu'à obtenir uniquement les beat triggers 
dont vous avez besoin, est potentiellement 
beaucoup plus efficace que la suppression, 
l'insertion ou le réglage manuel de beat triggers 
incorrects ou faux.

Pistes de batterie et mode Collection

Supposons que vous ayez des pistes de batterie 
correspondant à la grosse caisse, à la caisse 
claire, aux toms et aux micros d'overhead. 
Si vous analysez une sélection s'étendant sur 
toutes les pistes, régler le curseur Sensitivity à 
une valeur suffisamment élevée pour capturer 
les données de la charley (qui proviennent en 
majorité des pistes des micros d'overhead) 
risque de créer de nombreux faux beat triggers. 

En revanche, si vous n'analysez que la piste des 
micros d'overhead, les beat triggers résultants 
apparaissent légèrement plus tard que les sons 
des autres pistes (car le son a davantage de 
chemin à parcourir pour arriver à ces micros). 
Si vous étendez ensuite la sélection aux autres 
pistes de batterie et que vous les séparez, les 
régions des pistes de la grosse caisse, de la caisse 
claire et des toms seront coupées un peu en 
retard (voir Figure 19 ci-dessous).

Le mode Collection permet d'analyser chaque 
piste de batterie séparément, une à la fois, et 
d'optimiser les paramètres de détection de 
chaque piste jusqu'à obtenir les beat triggers 
désirés. Les beat triggers de chaque piste 
peuvent s'ajouter successivement à la collection, 
ou vous pouvez choisir de ne récupérer que les 
seuls triggers d'une piste. La collection 
résultante de beat triggers peut ensuite servir à 
créer des marqueurs Bar|Beat ou un modèle 
DigiGroove, ou à séparer de nouvelles régions.

Utilisation du mode Collection

Le mode Collection est disponible en mode 
Bar|Beat Marker Generation, Groove Template 
Extraction ou Region Separation (données audio 
uniquement), et il est accessible en cliquant sur 
le bouton Collection Mode dans la zone 
Detection.

Beat Detective LE ne prend pas en charge le 
mode Collection.

Figure 19.  Les micros d'overhead créent des beat 
triggers en retard

Beat Detective, options du mode Collection
Chapitre 21 : Beat Detective 491



492
Pour utiliser le mode Collection :

1  Dans la fenêtre Edit, effectuez une sélection 
audio sur une seule piste. Vérifiez que les points 
de début et de fin de la sélection tombent 
précisément sur le temps.

2  Dans la fenêtre Beat Detective, sélectionnez 
l'un des modes suivants :

• Bar|Beat Marker Generation

• Groove Template Extraction

• Region Separation (données audio 
uniquement) :

3  Définissez ou capturez la sélection comme 
indiqué à la section Définition d'une sélection 
pour le Beat Detective, page 472.

4  Configurez les options de détection de 
manière à détecter avec précision les crêtes des 
transitoires de la sélection (voir Création de beat 
triggers, page 475).

5  Cliquez sur le bouton Collection Mode.

6  Dans la zone Detection (mode Collection), 
cliquez sur Add pour ajouter les beat triggers 
courants à la collection. 

7  Cliquez sur le bouton Normal Mode et 
déplacez la sélection vers la piste suivante à 
analyser. Vérifiez que vous maintenez constante 
la plage de sélection pour chaque piste. 

8  Configurez les options de détection de 
manière à détecter avec précision les crêtes des 
transitoires de la sélection (voir Création de beat 
triggers, page 475).

9  Cliquez de nouveau sur le bouton Collection 
Mode.

10  Effectuez l'une des opérations suivantes :

■ Dans la zone Detection (mode Collection), 
cliquez sur Add Unique Triggers pour n'ajouter 
que les beat triggers uniques de la piste à la 
collection. 

■ Cliquez sur Add All pour ajouter tousles 
triggers à la collection.

■ Cliquez sur Add All pour ajouter tousles 
triggers à la collection.

Chaque nouvel ensemble de beat triggers ajouté 
à la collection apparaît dans une couleur 
différente. Si des beat triggers de la collection se 
suivent de très près (du fait d'une diaphonie de 
micro, par exemple), le Beat Detective ne 
conserve que les beat triggers apparus le plus tôt 
(voir Figure 20, page 493).

1  Répétez les étapes 7 à n pour chaque piste 
supplémentaire que vous analysez.

Les beat triggers stockés dans le mode Collection 
sont sauvegardés avec les sessions. Cela signifie 
que lorsque vous rouvrez une session, les 
données de la collection précédente sont à votre 
disposition (jusqu'à ce que vous les supprimiez). 

Pour déplacer la sélection vers le haut, 
appuyez sur Control + Tab (Macintosh) ou 
sur Démarrer + Tab (Windows) ; Pour 
déplacer la sélection vers le bas, appuyez 
sur Control + (;) (Macintosh) ou sur 
Démarrer + (;) (Windows).

Après avoir activé le focus clavier sur les 
commandes, appuyez sur P sur le clavier de 
votre ordinateur pour déplacer la sélection 
vers le haut, ou sur (;) pour la déplacer vers 
le bas. Appuyez sur la touche Maj pour 
inclure la sélection courante au groupe.
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2  Une fois que les beat triggers désirés ont été 
ajoutés à la collection, vous pouvez les utiliser 
pour créer des marqueurs Bar|Beat ou un modèle 
de groove, ou séparer de nouvelles régions. 
Néanmoins, ceci peut être fait à partir de la sous-
page Collection Mode (lorsque les beat triggers 
s'affichent dans plusieurs couleurs).

Pour séparer des régions sur plusieurs pistes, 
veillez à étendre la sélection à toutes les 
pistes supplémentaires avant d'effectuer la 
séparation.

Figure 20.  La piste de micro d'overhead affichant une collection de beat triggers contenant les triggers uniques 
créés à partir des pistes de grosse caisse, caisse claire et toms

Beat triggers détectés
sur la piste de grosse caisse
ajoutés à la collection

Beat triggers uniques
détectés sur la piste de caisse 
claire ajoutés à la collection

Beat triggers uniques
détectés sur la piste de toms
ajoutés à la collection

Beat triggers collectés 
appliqués à la piste de
micro d'overhead
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Chapitre 22 : Edition MIDI

Pro Tools est livré avec des outils d'édition MIDI 
puissants. Vous pouvez créer et éditer dans la 
fenêtre Edit des notes MIDI individuelles et des 
événements de contrôleur à l'aide du crayon et 
des outils de trimming et d'accrochage. Vous 
pouvez transformer, de manière destructive, des 
groupes de notes MIDI et modifier la hauteur, le 
timing et le phrasé grâce aux différentes 
opérations MIDI (Quantize, Transpose, Change 
Velocity et Change Duration, etc.). Il est possible 
également d'utiliser les propriétés en temps réel 
pour intervenir, de façon non destructive, sur les 
données MIDI lors de la phase de lecture. 
Pro Tools offre, en outre, divers outils de zoom 
et d'affichage optimisés pour l'édition MIDI.

Pour plus d'informations sur l'édition de 
données audio et MIDI au niveau d'une région, 
reportez-vous au Chapitre 17, Utilisation des 
régions et des sélections.

Edition MIDI en miroir
Cette fonction permet d'éditer des régions MIDI 
et d'appliquer vos modifications à chaque 
région MIDI du même nom. Cela s'avère très 
utile lors de l'édition de régions MIDI en boucle.

Pour activer la fonction d'édition MIDI en miroir :

■ Choisissez Options > Mirror MIDI Editing.

– ou –

Activez le bouton Mirrored MIDI Editing dans la 
fenêtre Edit.

En mode Mirrored MIDI Editing, le bouton 
Mirrored MIDI Editing clignote une fois en 
rouge dès qu'une édition est effectuée pour vous 
signaler que celle-ci est appliquée à plus d'une 
région.

Bouton Mirrored MIDI Edit dans la fenêtre Edit

Bouton Mirrored MIDI Edit
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Pour désactiver la fonction d'édition MIDI en 
miroir :

■ Désélectionnez Options > Mirror MIDI 
Editing.

– ou –

Désactivez le bouton Mirrored MIDI Editing 
dans la fenêtre Edit.

Crayon
Le crayon sert à créer et éditer des données 
MIDI. Les cinq premières formes du crayon 
(à main levée, ligne, triangle, carré et aléatoire) 
permettent d'entrer une série de hauteurs 
identiques avec des durées et des vitesses 
différentes (les vélocités des notes varient en 
fonction de la forme du crayon). Les différentes 
formes du crayon peuvent s'avérer 
particulièrement utiles pour le dessin et l'édition 
de différents types de données de contrôle MIDI. 
Vous pouvez par exemple utiliser la forme ligne 
pour le volume, la forme triangle pour le 
panoramique, la forme carrée et aléatoire pour 
la vélocité et régler le crayon sur main levée 
pour le pitch bend.

Pour sélectionner la forme du crayon :

1  Dans la barre d'outils, cliquez sur l'icône du 
crayon pour afficher un menu déroulant.

2  Sélectionnez une forme de crayon.

Main levée (Freehand)

Lorsque vous êtes en vue Notes, le crayon à 
main levée (Freehand) insère une seule note 
MIDI dont la vélocité est déterminée par la 
préférence Default Note On Velocity MIDI. 
La hauteur, l'emplacement et la durée de la note 
sont fonction de l'endroit où vous cliquez sur la 
piste MIDI.

Lors de l'édition des valeurs de vélocité ou des 
données du contrôleur MIDI, le tracé du crayon 
réglé sur main levée suit le mouvement de la 
souris. La forme est reproduite sous forme d'une 
série d'étapes, conformément à la préférence 
Pencil Tool Resolution When Drawing 
Controller Data MIDI.

Lorsque le mode Mirrored MIDI Editing est 
désactivé et que vous éditez des notes de 
régions en boucle dans la vue Notes, 
l'édition a pour effet d'aplanir la boucle. 
De la même manière, l'édition de groupes 
de régions a pour effet de séparer les groupes 
de régions.

Les formes de crayon Parabolique et Courbe 
en S servent à définir des événements de 
tempo dans l'éditeur de tempo. Reportez-
vous à la section Dessin d'événements de 
tempo, page 431.

Menu déroulant de la forme du crayon

Formes du
crayon
disponibles 
pour MIDI
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Ligne (ligne)

Lorsque vous êtes en vue Notes, le crayon en 
forme de ligne (Line) insère une série de notes 
MIDI ayant toutes la même hauteur et dont la 
vélocité est déterminée par la préférence Default 
Note On Velocity MIDI. La durée de chaque 
note est déterminée par la valeur de la grille 
actuelle.

Lors de l'édition des valeurs de vélocité ou des 
données du contrôleur MIDI, le crayon en forme 
de ligne trace une ligne droite à main levée. Pour 
cela, cliquez à l'endroit où vous souhaitez que la 
ligne commence, puis relâchez la souris pour 
terminer la ligne. Les valeurs du contrôleur 
continu MIDI se transforment en une série 
d'étapes selon la préférence Pencil Tool 
Resolution When Drawing Controller Data 
MIDI.

Triangle (triangle)

Lorsque vous êtes en vue Notes, le crayon en 
forme de triangle insère une série de notes MIDI 
ayant toutes la même hauteur et dont la vélocité 
varie entre la préférence Default Note On 
Velocity MIDI et la valeur 127 formant ainsi des 
dents de scie. La durée de chaque note est 
déterminée par la valeur de la grille actuelle.

Lors de l'édition des valeurs de vélocité ou des 
données du contrôleur MIDI, le crayon en forme 
de triangle trace une ligne en dents de scie en 
fonction des valeurs de la grille actuelle. Les 
valeurs du contrôleur MIDI se transforment en 
une série d'étapes selon la préférence Pencil Tool 
Resolution When Drawing Controller Data 
MIDI.

Carré (Square)

Lorsque vous êtes en vue Notes, le crayon en 
forme de carré (Square) insère une série de notes 
MIDI ayant toutes la même hauteur et dont la 
vélocité passe de la valeur spécifiée dans Default 
Note On Velocity MIDI à la valeur 127. La durée 
de chaque note est déterminée par la valeur de la 
grille actuelle.

Lors de l'édition des valeurs de vélocité ou des 
données du contrôleur MIDI, le crayon en forme 
de carré trace une ligne constituée d'une série de 
carrés qui se répètent en fonction de la valeur de 
la grille actuelle.

Aléatoire (Random)

Lorsque vous êtes en vue Notes, le crayon de 
forme aléatoire (Random) insère une série de 
notes MIDI ayant toutes la même hauteur et 
dont la vélocité varie au hasard entre la valeur 
spécifiée dans Default Note On Velocity MIDI et 
la valeur 127. La durée de chaque note est 
déterminée par la valeur de la grille actuelle.

Lors de l'édition des valeurs de vélocité ou des 
données du contrôleur MIDI, le crayon en forme 
aléatoire trace une série de valeurs aléatoires qui 
varient en fonction de la valeur de la grille 
actuelle.
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Personnalisation de la durée 
des notes
La commande Custom Note Duration permet de 
définir la durée par défaut des notes insérées 
manuellement.

Pour sélectionner une durée de note 
personnalisée :

1  Dans la barre d'outils, cliquez sur l'icône du 
crayon pour afficher un menu déroulant.

2  Sélectionnez une durée de note personnalisée. 
Une icône en forme de note (bouton Custom 
Note Duration) apparaît sous l'icône du crayon 
dans la barre d'outils.

3  Cliquez sur la note pour afficher le menu 
déroulant Custom Note Duration et 
sélectionnez une durée.

L'icône de note change en fonction de la valeur 
sélectionnée.

Définition de la valeur de la 
grille
Lors de l'insertion de notes MIDI à l'aide du 
crayon, la valeur de la grille détermine entre 
autres la durée de chaque note en fonction de la 
forme du crayon (voir Crayon, page 498).

Pour définir la valeur de la grille pour 
l'édition MIDI :

1  Définissez l'échelle temporelle principale sur 
Bars:Beats (temps/mesures) (voir Définition de 
l'échelle temporelle principale, page 286).

2  Dans le menu déroulant de valeur de la grille, 
sélectionnez une valeur de note (par exemple 
1/4, 1/8 ou 1/16).

3  Vérifiez la mesure et le tempo par défaut de la 
session (voir Réglage de la métrique par défaut, 
page 204 et Réglage du tempo par défaut, 
page 205).

Insertion de notes MIDI
Outre l'enregistrement, l'enregistrement par 
étape et l'importation de données MIDI dans 
Pro Tools, vous pouvez insérer manuellement 
des notes MIDI à l'aide du crayon. 

Pour insérer une note MIDI :

1  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Notes.

2  Sélectionnez le crayon et vérifiez qu'il est réglé 
sur main levée (Freehand). Le curseur se 
transforme en crayon lorsque vous le placez sur 
la playlist d'une piste MIDI ou d'une piste 
d'instrument en vue Note.

Crayon avec l'icône de note

Menu déroulant Custom Note Duration

Pour plus d'informations sur le mode Grid, 
reportez-vous à la section Grid, page 302.
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3  Pour insérer une noire sur le tempo, définissez 
l'échelle temporelle principale sur Bars:Beats et 
réglez le mode d'édition sur Grid et la valeur de 
grille sur une noire (0|1|000). 

4  Déplacez le crayon dans la zone de la playlist 
de la piste MIDI ou d'instrument. Utilisez la 
règle de la fenêtre Edit et le mini clavier de la 
piste pour repérer la hauteur et l'emplacement 
de temps désirés.

Lorsque vous vous servez du crayon, la position 
et la valeur du curseur sont affichées dans la 
barre des options.

5  Lorsque vous avez atteint la hauteur et le 
temps désirés, cliquez pour insérer la note.

La vélocité des notes insérées est déterminée par 
la préférence Default Note On Velocity des 
préférences MIDI. En mode Grid, la durée de la 
note est déterminée par la valeur de la grille de la 
fenêtre Edit. Elle peut également être définie par 
la valeur Custom Note Duration (voir 
Personnalisation de la durée des notes, 
page 500).

Si la préférence Play MIDI Notes when Editing 
est activée, un son est émis à chaque insertion 
d'une note.

Vous pouvez faire glisser le crayon après avoir 
cliqué (ou avant d'avoir relâché le bouton de la 
souris), pour régler la hauteur et la durée de la 
note. Cliquez et faites glisser la souris vers la 
droite pour allonger la note sans en modifier le 
point de début et vers la gauche pour raccourcir 
la note sans en modifier le point de fin.

Crayon réglé sur main levée

Position et valeur du curseur

Note MIDI insérée avec le crayon

Après avoir activé l'outil Smart (voir 
Utilisation de l'outil Smart, page 316), 
maintenez la touche Démarrer 
(Windows) ou Pomme (Macintosh) 
enfoncée pendant que vous cliquez à l'aide 
de la souris pour transformer le curseur en 
crayon et insérer des notes MIDI. Pour 
supprimer des notes, maintenez les 
touches Option + Contrôle (Macintosh) ou 
Alt + Démarrer (Windows) enfoncées 
pendant que vous cliquez sur les notes.

Lorsque le mode Grid est activé, le point de 
début de la note MIDI passe par défaut 
directement au pas de grille le plus proche. 
Maintenez la touche Pomme (Macintosh) 
ou Ctrl (Windows) enfoncée pendant que 
vous cliquez avec le crayon pour désactiver 
momentanément l'alignement sur la grille.
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Les différentes formes du crayon (ligne, triangle, 
carré et aléatoire) permettent d'entrer une série 
de hauteurs identiques avec des vélocités 
différentes. La longueur des notes insérées et 
l'espace entre celles-ci sont déterminés par la 
valeur de la grille actuelle ou par la valeur 
Custom Note Duration. Les vélocités des notes 
sont déterminées par la forme du crayon.

Utilisez la forme carrée pour alterner vélocités 
fortes et faibles. Utilisez la forme triangulaire 
pour créer des rampes de vélocités vers le haut et 
vers le bas. La forme ligne entre les notes avec 
des vélocités identiques.

Pour insérer une série de notes avec des vélocités 
aléatoires :

1  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Notes.

2  Sélectionnez le crayon et vérifiez qu'il est réglé 
sur aléatoire.

3  Définissez l'échelle temporelle principale sur 
Bars:Beats (temps/mesures). De plus, réglez le 
mode d'édition sur Grid et la valeur de grille sur 
une noire (0|1|000).

Avec ces paramètres, les notes insérées seront 
espacées d'une noire.

4  Cliquez sur le point où sera insérée la première 
note, puis faites glisser la souris vers la droite 
jusqu'à atteindre le nombre de notes désiré.

Edition manuelle des notes 
MIDI
Vous pouvez éditer tous les aspects d'une note 
MIDI à partir de la fenêtre Edit : ses points de 
début et de fin, sa durée, sa hauteur et sa 
vélocité. Le sélecteur, l'outil d'accrochage et le 
crayon permettent de travailler sur des notes 
individuelles ou des groupes de notes.

Sélection des notes MIDI

Vous devez sélectionner les notes MIDI avant de 
pouvoir les éditer.

Pour sélectionner plusieurs notes MIDI, procédez 
comme suit :

■ Avec l'outil d'accrochage ou le crayon, cliquez 
sur chaque note en appuyant sur la touche Maj.

■ Avec un outil d'accrochage, placez le curseur 
là où il n'y a pas de notes (le rectangle de 
sélection apparaît) et cliquez en dessinant un 
rectangle autour du groupe de notes.

Réglage de la durée d'une note insérée

Lorsque le mode Grid est activé, le point de 
fin de la note MIDI passe par défaut 
directement au pas de grille le plus proche. 
Maintenez la touche Pomme (Macintosh) 
ou Ctrl (Windows) enfoncée pendant que 
vous faites glisser le crayon pour désactiver 
momentanément l'alignement sur la grille.

Crayon réglé sur aléatoire

Insertion d'une série de notes avec le crayon
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Lorsque vous utilisez un outil d'accrochage, si 
une partie du rectangle touche une note (que ce 
soit son point de début ou de fin), celle-ci est 
incluse à la sélection. Les sélections effectuées 
avec un outil d'accrochage n'incluent pas les 
données sous-jacentes de contrôleur et 
d'automation de la piste MIDI.

■ Faites glisser le sélecteur sur une plage de 
notes.

Lorsque vous utilisez le sélecteur, une note n'est 
sélectionnée que si son point de début est 
inclus. Lorsqu'une piste MIDI ou d'instrument 
est en vue Notes ou Regions, les sélections 
effectuées à l'aide du sélecteur incluent les 
données sous-jacentes de contrôleur et 
d'automation.

Pour sélectionner une hauteur unique sur toute la 
durée d'une piste :

■ Maintenez enfoncée la touche Démarrer 
(Windows) ou Pomme (Macintosh) et cliquez 
sur une touche du mini-clavier d'une piste MIDI 
ou d'une piste d'instrument. La note 
sélectionnée sera lue via la sortie assignée de la 
piste MIDI ou de la piste d'instrument.

Pour sélectionner une plage de notes sur une piste 
MIDI ou une piste d'instrument :

■ Maintenez enfoncées les touches Démarrer-
Maj (Windows) ou Pomme-Maj (Macintosh) et 
cliquez sur une touche inférieure et supérieure 
du mini-clavier d'une piste MIDI ou d'une piste 
d'instrument.

– ou –

■ Maintenez enfoncée la touche Démarrer 
(Windows) ou Contrôle (Macintosh) et faites 
glisser le curseur sur une plage de touches du 
mini-clavier d'une piste MIDI ou d'une piste 
d'instrument.

Sélection de notes à l'aide d'un outil d'accrochage

Sélection de notes avec le sélecteur

Sélection de toutes les instances d'une note à l'aide du 
mini-clavier

Sélection d'une plage de notes à l'aide du mini-clavier

Sous Windows, maintenez les touches Ctrl-
Maj enfoncées et cliquez pour jouer les notes 
lorsque vous effectuez une sélection sur le 
mini-clavier d'une piste.
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Pour désélectionner une ou plusieurs notes :

■ Avec le crayon ou un outil d'accrochage, 
cliquez sur les notes tout en appuyant sur la 
touche Maj.

Transposition des notes

Vous pouvez transposer les notes MIDI en 
faisant glisser un outil d'accrochage ou le crayon 
vers le haut ou vers le bas. Si plusieurs notes sont 
sélectionnées avant de faire glisser l'outil 
d'accrochage, elles sont toutes transposées.

Pour transposer une note MIDI :

1  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Notes.

2  Sélectionnez le crayon ou un outil 
d'accrochage.

3  Tout en appuyant sur Maj, faites glisser la note 
vers le haut ou vers le bas.

La touche Maj garantit que la note transposée 
conserve son point de début. A mesure que vous 
faites glisser, vous entendez chaque note et 
l'indicateur de valeur d'emplacement du curseur 
(dans la fenêtre Edit) indique le nombre de 
demi-tons et le sens (+/-) de la transposition.

Déplacement des notes

De même que les régions, vous pouvez déplacer 
les notes MIDI vers la gauche ou vers la droite 
avec un outil d'accrochage ou le crayon pour 
changer leur point de début. Si plusieurs notes 
sont sélectionnées avant de faire glisser l'outil 
d'accrochage, elles sont toutes déplacées.

Pour déplacer une note MIDI :

1  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Notes.

2  Avec un outil d'accrochage ou le crayon, faites 
glisser la note vers la gauche ou la droite 
(appuyez sur Maj pour conserver la hauteur de la 
note).

Au fur et à mesure que vous faites glisser la note, 
l'indicateur de valeur d'emplacement du curseur 
(dans la fenêtre Edit) affiche le nouveau point de 
début.

Lorsque le mode d'édition est réglé sur Grid, la 
note déplacée s'aligne sur le pas de grille le plus 
proche. Lorsque le mode d'édition est réglé sur 
Spot, la boîte de dialogue Spot s'ouvre.

Vous pouvez également sélectionner des 
notes dans la fenêtre Select/Split Notes. 
Pour plus d'informations, reportez-vous à la 
section Select/Split Notes, page 543.

Transposition à l'aide d'un outil d'accrochage

Pour transposer une copie de la note sans 
modifier la note originale, maintenez la 
touche Option (Macintosh) ou Alt 
(Windows) enfoncée pendant que vous 
faites glisser la note.

Pour copier les notes sélectionnées sans 
toucher aux notes originales, maintenez la 
touche Option (Macintosh) ou Alt 
(Windows) enfoncée pendant que vous 
faites glisser les notes.
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Rognage des temps de début et de fin 
d'une note

Tout comme les régions, vous pouvez ajuster les 
points de début et de fin des notes MIDI avec 
l'outil de trimming. Si plusieurs notes sont 
sélectionnées lorsque vous utilisez l'outil de 
trimming, elles sont toutes modifiées.

Pour changer les points de début ou de fin d'un 
groupe de notes MIDI :

1  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Notes.

2  Avec un outil d'accrochage ou le crayon, 
cliquez sur chaque note à rogner en appuyant 
sur la touche Maj.

3  Sélectionnez l'outil de trimming. Cliquez sur 
le menu déroulant de l'outil de trimming et 
sélectionnez « Standard », si besoin est.

– ou –

Utilisez le crayon.

4  Déplacez le curseur près du début de 
n'importe quelle note en surbrillance pour faire 
apparaître l'outil de trimming. Faites-le vers la 
droite pour raccourcir les notes, vers la gauche 
pour les rallonger.

– ou –

Déplacez le curseur près de la fin de n'importe 
quelle note en surbrillance pour faire apparaître 
l'outil de trimming. Faites glisser le curseur vers 
la gauche pour raccourcir les notes, vers la droite 
pour les rallonger.

En mode Grid, les points de début ou de fin 
déplacés s'alignent sur le pas de grille le plus 
proche de la grille. En mode Spot, la boîte de 
dialogue Spot s'ouvre et vous invite à entrer le 
nouvel emplacement des points de début et de 
fin de la note.

Vous pouvez également rogner les notes à l'aide 
de la commande Trim Region to Selection (voir 
Commande Trim Region to Selection, page 355) 
et de la commande Trim To Insertion (voir 
Rognage par incrément, page 357).

Le placement des notes MIDI peut 
également être ajusté à l'aide de la 
commande Shift (voir Commande Shift, 
page 371) ou de la commande Nudge (voir 
Déplacement par incrément (Nudging), 
page 368).

Il est possible également d'appliquer l'outil 
de rognage aux régions MIDI. Pour plus 
d'informations, reportez-vous à la section 
Fonction de compression/ extension 
temporelle pour les régions MIDI, 
page 508.

Outil de trimming

Changement de la position de fin des notes avec l'outil 
de trimming

En mode Grid, appuyez sur la touche Ctrl 
(Windows) ou Pomme (Macintosh) pour 
désactiver momentanément le mode Grid.
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Edition manuelle de la vélocité des 
notes

Lorsque le format d'affichage d'une piste MIDI 
ou d'une piste d'instrument est réglé sur 
Velocity, la vélocité d'attaque des notes est 
représentée par une barre verticale. Plus celle-ci 
est haute, plus la valeur de vélocité est élevée 
(0-127).

Pour modifier la vélocité MIDI :

1  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Velocity.

2  Sélectionnez l'outil d'accrochage de temps.

3  Effectuez l'une des opérations suivantes :

• Faites glisser l'extrémité supérieure 
(le « diamant ») de la barre de vélocité vers 
le haut ou vers le bas.

– ou –

• Si deux notes possèdent le même temps de 
début (avec des barres de vélocité se 
superposant), faites glisser la note vers le 
haut ou le bas en appuyant sur Pomme 
(Macintosh) ou Ctrl (Windows).

Faites glisser le diamant vers le haut pour 
augmenter la valeur de la vélocité ou vers le bas 
pour la réduire. Lorsque vous le faites glisser, il 
devient bleu et la note associée est sélectionnée. 

Les valeurs de vélocité correspondant au 
diamant déplacé apparaissent dans l'indicateur 
de valeur d'emplacement du curseur (dans la 
fenêtre Edit).

Les vélocités d'une plage de notes peuvent être 
éditées à l'aide du crayon, soit à main levée, soit 
avec une autre forme du crayon.

Pour dessiner des valeurs de vélocité créant un 
fondu d'entrée :

1  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Velocity.

2  Sélectionnez le crayon en forme de ligne.

3  Cliquez au début de la plage de notes, vers le 
bas de la plage de vélocité, puis faites glisser le 
crayon vers la droite tout en le faisant remonter, 
jusqu'à ce que la ligne englobe la plage de notes 
que vous souhaitez inclure dans le fondu.

Vous pouvez également utiliser l'outil de 
trimming pour décaler globalement les vélocités 
de toutes les notes sélectionnées. Cette fonction 
est pratique si vous êtes satisfait de la relation de 
vélocité entre les notes, mais que vous désirez 
qu'elles soient globalement plus ou moins 
fortes.

Déplacement d'une barre de vélocité

Edition de vélocités simultanées

Modification des vélocités avec la forme Ligne

En vue Velocity, l'outil de trimming peut 
servir à rogner la durée des notes en plus de 
modifier les vélocités.
Guide de référence Pro Tools



Pour décaler les vélocités avec l'outil de 
trimming :

1  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Velocity.

2  A l'aide du sélecteur ou d'un outil 
d'accrochage, sélectionnez la série de notes que 
vous voulez éditer.

3  A l'aide de l'outil de trimming, cliquez à 
proximité de la série de notes sélectionnée, puis 
faites glisser vers le haut ou le bas. La vélocité de 
toutes les notes augmente lorsque vous faites 
glisser l'outil de trimming vers le haut, elle 
diminue lorsque vous le faites glisser vers le bas.

Saisie des attributs des notes

Lorsque vous sélectionnez une note individuelle 
avec un outil d'accrochage ou le crayon, ses 
attributs s'affichent dans la zone d'édition des 
événements.

La hauteur est indiquée par le nom de la note et 
son numéro d'octave. Les vélocités d'attaque et 
de relâchement apparaissent sous forme de 
valeur MIDI (0-127). Les valeurs de sélection 
d'édition de début (Start), de fin (End) et de 
durée (Length) sont affichées dans l'échelle 
temporelle principale.

Pour changer un attribut sur une note MIDI :

1  Dans la zone de playlist d'une piste MIDI ou 
d'une piste d'instrument, sélectionnez la note 
avec un outil d'accrochage ou le crayon.

2  Cliquez dans la zone de texte Attributes et 
effectuez l'une des opérations ci-dessous.

• Entrez la nouvelle valeur sur le pavé 
numérique.

• Appuyez sur la flèche vers le haut ou vers le 
bas pour faire défiler les chiffres jusqu'à la 
nouvelle valeur.

• Appuyez sur la flèche vers le haut ou vers le 
bas pour atteindre la nouvelle valeur. 

• Jouez la nouvelle note choisie sur le clavier 
de votre contrôleur MIDI.

Appuyez sur la barre oblique (/) pour passer d'un 
champ à l'autre dans la zone d'édition des 
événements.

Notes multiples et zone d'édition des 
événements

Les valeurs que vous entrez dans la zone 
d'édition des événements s'appliquent à toutes 
les notes, lorsque vous en sélectionnez 
plusieurs. Un triangle apparaît à gauche de la 
note pour indiquer que plusieurs notes sont 
sélectionnées.

Entrer une nouvelle valeur dans le champ Start 
déplace la première note de la sélection jusqu'à 
cet endroit, et toutes les autres notes suivent le 
mouvement.

Modification des vélocités avec l'outil de trimming

Zone d'édition des événements affichant les 
informations concernant la piste MIDI

Hauteur

Vélocité d'attaque
Vélocité de 
relâchement

Vous pouvez également changer les 
attributs des notes MIDI dans la liste des 
événements MIDI (voir le Chapitre 24, 
Liste des événements MIDI).
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De même, les valeurs entrées dans les champs de 
hauteur et de vélocité s'ajoutent ou se 
soustraient à celles de toutes les notes 
sélectionnées. Par exemple, pour transposer 
d'une octave vers le bas toutes les notes 
sélectionnées, entrez une valeur de hauteur 
de -12.

Suppression de notes MIDI

Outre la suppression de notes sélectionnées via 
la commande Clear dans le menu Edit, vous 
pouvez supprimer des notes individuelles à 
l'aide du crayon.

Pour supprimer un groupe de notes MIDI à l'aide 
de la commande Clear :

1  A l'aide du sélecteur ou de l'outil main, 
sélectionnez les notes à supprimer. Pour en 
savoir plus, reportez-vous à la section Sélection 
des notes MIDI, page 502.

2  Choisissez Edit > Clear pour supprimer les 
notes sélectionnées. Les données de contrôleur 
sous-jacentes de la piste demeurent intactes.

– ou –

Appuyez sur la touche Retour arrière (Windows) 
ou Supprimer (Macintosh).

Pour supprimer une seule note MIDI avec le 
crayon :

■ En ayant sélectionné le crayon, appuyez sur 
Option (Macintosh) ou sur Alt (Windows) pour 
le transformer en gomme, puis cliquez sur la 
note à supprimer.

Fonction de compression/ 
extension temporelle pour les 
régions MIDI
L'outil de compression/extension temporelle est 
pratique pour faire correspondre une région 
MIDI à la longueur d'une autre région, à une 
grille de tempo ou à tout autre point de 
référence.

Notes multiples dans la zone d'édition des événements

Lorsque vous supprimez des notes MIDI 
dans une sélection de plage temporelle, 
toutes les données de contrôleur et 
d'automation sous-jacentes sont également 
supprimées.

Suppression d'une note avec le crayon

Vous pouvez également supprimer des 
événements de changement de programme 
et des événements Sysex en maintenant la 
touche Option (Macintosh) ou Alt 
(Windows) enfoncée pendant que vous 
cliquez dessus avec le crayon.

Outil de compression/extension temporelle
Guide de référence Pro Tools



A l'aide de l'outil de compression/extension 
temporelle, vous pouvez déplacer le point de 
début ou de fin de la région MIDI pour étendre 
ou compresser la région, en adaptant les 
données MIDI en conséquence, quelle que soit 
la base de temps de la piste (tics ou 
échantillons).

Utilisation de l'outil de compression/
extension temporelle en mode Grid

Cet outil peut être utilisé en mode Grid pour 
faire correspondre une région au tempo d'une 
session ou d'une section d'une session, ou pour 
créer des performances équivalant au double ou 
à la moitié de la durée.

Pour utiliser l'outil de compression/extension 
temporelle en mode Grid :

1  Réglez le mode d'édition sur Grid.

2  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Regions.

3  Cliquez sur le menu déroulant Trim et 
sélectionnez TCE.

4  Avec l'outil de compression/extension 
temporelle, faites glisser le point de début ou de 
fin de la région MIDI pour étendre ou 
compresser la région à la taille de la grille (par 
exemple, par noires). La nouvelle région, créée 
automatiquement, apparaît dans la playlist et 
dans la liste des régions.

Utilisation de l'outil de compression/
extension temporelle en mode Slip

Pour utiliser l'outil de compression/extension 
temporelle en mode Slip :

1  Définissez le mode d'édition sur Slip.

2  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Regions.

3  Cliquez sur le menu déroulant de l'outil de 
trimming et sélectionnez TCE.

4  Avec l'outil de compression/extension 
temporelle, faites glisser le point de début ou de 
fin de la région MIDI pour étendre ou 
compresser librement la région. La nouvelle 
région, créée automatiquement, apparaît dans la 
playlist et dans la liste des régions.

Mise à l'échelle d'une région MIDI à l'aide de l'outil de 
compression/extension temporelle

Avant rognage

Après rognage
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Utilisation de l'outil de compression/
extension temporelle en mode Spot

En mode Spot, lorsque vous cliquez sur l'outil de 
compression/extension temporelle dans une 
région, la boîte de dialogue Spot s'ouvre. Vous 
pouvez préciser l'emplacement sur lequel vous 
voulez que la région débute ou se termine, ou la 
durée de la région pour que celle-ci s'ajuste 
automatiquement.

Pour utiliser l'outil de compression/extension 
temporelle en mode Spot :

1  Définissez le mode d'édition sur Spot.

2  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Regions.

3  Sélectionnez l'option TCE dans le menu 
déroulant de l'outil de trimming.

4  Cliquez sur la région MIDI à proximité de son 
point de début ou de fin. La boîte de dialogue 
Spot s'ouvre. A l'aide de n'importe quelle échelle 
de temps, entrez une nouvelle valeur de début 
ou de fin (ou une durée) de la région, et cliquez 
sur OK. La nouvelle région, créée 
automatiquement, apparaît dans la playlist et 
dans la liste des régions.

Utilisation de l'outil de compression/
extension temporelle en mode Shuffle

En mode Shuffle, la région rognée commence 
systématiquement au niveau du point de départ 
de la région d'origine, quel que soit le sens de 
rognage (de l'avant vers l'arrière ou de l'arrière 
vers l'avant).

Pour utiliser l'outil de compression/extension 
temporelle en mode Shuffle :

1  Réglez le mode d'édition sur Shuffle.

2  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Regions.

3  Sélectionnez l'option TCE dans le menu 
déroulant de l'outil de trimming.

4  Avec l'outil de compression/extension 
temporelle, faites glisser le point de début ou de 
fin de la région MIDI pour étendre ou 
compresser librement la région. La nouvelle 
région, créée automatiquement, apparaît dans la 
playlist et dans la liste des régions.

Evénements de contrôleur 
continu
Les événements de contrôleur continu des pistes 
MIDI et des pistes d'instrument s'affichent sous 
la forme d'un graphique linéaire muni d'une 
série de points d'inflexion que vous pouvez 
éditer. Les événements de contrôleur des pistes 
MIDI et des pistes d'instrument diffèrent 
quelque peu des données d'automation des 
pistes audio dans la mesure où les points 
d'inflexion sont en escalier (et non basés sur des 
vecteurs), chaque point d'inflexion représentant 
un seul événement de contrôleur.

Vous pouvez insérer et éditer dans Pro Tools les 
événements de contrôleur continu suivants :

• Volume

• Panoramique

• Variation de hauteur

• Aftertouch (mono)

• Contrôleurs MIDI, numéros 0 à 127

Piste MIDI affichant des événements de volume
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Les contrôleurs MIDI numéro 7 (volume) et 
numéro 10 (panoramique) sont traités par 
Pro Tools comme des données d'automation. 
Cela signifie que ces événements de contrôleur 
(ainsi que les coupures du son) peuvent être 
enregistrés et automatisés à partir de la fenêtre 
Mix. Par ailleurs, chaque mode d'automation 
d'une piste MIDI ou d'une piste d'instrument a 
une incidence sur la lecture et l'enregistrement 
de ces événements. Il est possible d'interrompre 
les événements de volume et de panoramique 
(et de coupures du son) d'une piste MIDI, mais la 
lecture de tous les autres événements de 
contrôleur de la piste se poursuit. Les pistes 
d'instrument prennent en charge aussi bien le 
volume, la coupure de son et le panoramique de 
données MIDI que le volume, la coupure de son 
et le panoramique de données audio.

Enregistrez en mode MIDI Merge pour ne pas 
écraser les données d'automation de 
panoramique et de volume MIDI. Lors de 
l'enregistrement en mode MIDI Merge, les 
données de panoramique et de volume ne sont 
pas lues pendant l'enregistrement des nouvelles 
données MIDI. 

Les événements de contrôleur continu (volume 
et panoramique inclus) émis par un contrôleur 
MIDI externe (clavier ou surface de contrôle) 
peuvent être enregistrés, puis insérés dans la 
playlist d'une piste MIDI à l'aide d'un outil 
d'accrochage ou du crayon.

Insertion et édition d'événements 
de contrôleur

Les événements de contrôleur continu peuvent 
être édités par l'une des méthodes suivantes :

◆ Vous pouvez déplacer des points d'inflexion 
individuels à l'aide d'un outil d'accrochage afin 
d'ajuster leur emplacement ou leur valeur.

◆ Vous pouvez décaler vers le haut ou vers le bas 
un groupe de points d'inflexion sélectionné avec 
les outils de trimming.

◆ Vous pouvez dessiner de nouveaux 
événements du contrôleur avec le crayon pour 
remplacer des événements. Ceux-ci peuvent être 
dessinés avec le crayon à main levée ou avec 
l'une des autres formes de crayon (ligne, 
triangle, carré ou aléatoire).

◆ Vous pouvez copier et coller, déplacer et 
décaler des événements du contrôleur.

L'aftertouch polyphonique ne peut pas être 
visualisé dans la fenêtre Edit. Pour 
visualiser les données d'aftertouch 
polyphonique dans Pro Tools, utilisez la 
liste des événements MIDI (voir 
Chapitre 24, Liste des événements MIDI).

Pour copier des événements de contrôleur 
continu MIDI et les coller sur un autre 
contrôleur MIDI, utilisez la fonction de 
collage spécial (Edit > Paste Special > To 
Current Automation Type). En effet, vous 
pouvez souhaiter par exemple utiliser les 
mêmes données de contrôle pour le volume 
ou un filtre de coupure ou bien pour le 
panoramique et la hauteur. Pour plus 
d'informations, reportez-vous à la section 
Fonction de collage spécial pour les 
données d'automation, page 665.
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Résolution des événements de 
contrôleur insérés

Lorsque vous insérez des événements de 
contrôleur avec le crayon, la densité des 
événements est déterminée par l'option Pencil 
Tool Resolution When Drawing Controller Data 
des préférences MIDI.

Pour définir la résolution du crayon :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet MIDI.

2  Indiquez une valeur pour l'option Pencil Tool 
Resolution When Drawing Controller Data. Ce 
paramètre est réglable entre 1 et 100 millièmes 
de seconde.

3  Cliquez sur OK.

Pour modifier un événement de contrôleur 
continu à l'aide du crayon, il convient d'abord 
d'ajouter le contrôleur à la liste des contrôleurs 
MIDI automatisés.

Pour activer manuellement un contrôleur continu 
pour l'automation : 

1  Cliquez sur le sélecteur de vue de la piste MIDI 
ou d'instrument que vous voulez éditer et 
choisissez Add/Remove Controller dans le menu 
déroulant des contrôleurs.

2  Sélectionnez la plage de contrôleurs MIDI 
correspondant au contrôleur à automatiser. 

3  Choisissez les contrôleurs continus que vous 
souhaitez automatiser dans la liste de gauche, 
puis cliquez sur Add.

Les modifications apportées aux données de 
volume concernent toutes les pistes d'un 
groupe d'édition actif. Ce n'est toutefois pas 
le cas pour les autres playlists de contrôleur 
(panoramique, notamment). Pour insérer et 
éditer d'autres types de contrôleurs sur 
toutes les pistes d'un groupe d'édition, 
maintenez la touché Contrôle (Macintosh) 
ou Démarrer (Windows) enfoncée pendant 
que vous effectuez les éditions.

Le contrôleur est ajouté automatiquement à 
la liste des contrôleurs MIDI automatisés 
lorsque vous enregistrez des informations de 
contrôleur à partir d'un périphérique 
externe.

Menu déroulant des contrôleurs MIDI

Boîte de dialogue Automated MIDI Controllers
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4  Cliquez sur OK pour fermer la boîte de 
dialogue Automated MIDI Controller.

Sélection de patch 
(changements de programme 
et de banque)
Chaque piste MIDI et d'instrument peut 
posséder un changement de programme par 
défaut, qui est envoyé chaque fois que la piste 
est lue. D'autres changements de programme 
peuvent être insérés à n'importe quel point de la 
piste.

A propos des changements de 
programme et de banque

Le protocole MIDI permet de choisir dans un 
ensemble de 128 programmes (0-127). 
La plupart des instruments MIDI possèdent 
plusieurs banques de 128 programmes. Pour 
spécifier une banque, vous devez envoyer un 
message de sélection de banque. Certains 
instruments utilisent le contrôleur 0 et d'autres 
le contrôleur 32 (certains utilisent une 
combinaison des deux). La boîte de dialogue 
Patch Select de Pro Tools permet d'utiliser l'un 
ou l'autre de ces messages de sélection de 
banque lorsque vous insérez un événement de 
changement de programme. Vérifiez le 
contrôleur utilisé dans la documentation du 
fabricant de votre périphérique.

Lorsque vous enregistrez des informations 
de contrôleur continu à partir d'un 
périphérique MIDI externe, le contrôleur est 
ajouté automatiquement à la liste des 
contrôleurs MIDI.

Si vous ignorez la commande de sélection de 
banque utilisée par votre instrument, vous 
pouvez effectuer un enregistrement MIDI 
dans Pro Tools pendant que vous procédez à 
un changement de banque à partir de 
l'instrument. Il suffit ensuite d'examiner les 
informations de sélection de banque 
enregistrées par votre instrument dans 
Pro Tools dans la liste des événements 
MIDI.

Certains anciens périphériques MIDI (le 
Kurzweil K1000 par exemple) utilisent un 
message de changement de programme à la 
place d'un message de sélection de banque 
pour le changement de banque. Pour ces 
périphériques, vous devez donc envoyer deux 
messages de changement de programme 
pour accéder à un programme particulier, le 
premier définissant la banque et le second le 
programme.
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Changement de programme par 
défaut

Vous pouvez spécifier le changement de 
programme par défaut de chaque piste MIDI en 
cliquant sur le bouton Patch Select des fenêtres 
Edit ou Mix. Le message de changement de 
programme est alors envoyé à votre instrument 
lorsque vous lisez la piste.

Pour définir le changement de programme par 
défaut d'une piste MIDI ou d'une piste 
d'instrument :

1  Cliquez sur le bouton Patch Select dans la 
fenêtre Mix ou Edit.

2  Effectuez l'une des opérations suivantes :

• Dans la boîte de dialogue Patch Select, 
sélectionnez un numéro de programme.

• Si vous utilisez des fichiers de noms de 
patch, sélectionnez une banque dans le 
menu déroulant situé dans la partie 
supérieure gauche de la boîte de dialogue 
Patch Select, puis choisissez un nom de 
patch. Pour plus d'informations, reportez-
vous à la section Noms de patch, page 515.

3  Cliquez sur Done.

Une fois sélectionné, le numéro (ou le nom de 
patch) du programme apparaît sur le bouton 
Patch Select de la fenêtre Edit.

Contrairement aux événements de changement 
de programme enregistrés et insérés, le 
changement de programme par défaut 
n'apparaît pas dans la liste de diffusion de la 
piste.

Pour supprimer le changement de programme 
par défaut, sélectionnez None dans la boîte de 
dialogue Patch Select.

Bouton de sélection des patchs

 Boîte de dialogue Patch Select

Bouton de sélection des 
patchs (fenêtre Edit)

Bouton de sélection des 
patchs (fenêtre Mix)

Sélection d'une banque dans la boîte de dialogue Patch 
Select

Bouton de sélection des patchs, fenêtre Edit

Nom de patch
Guide de référence Pro Tools



Noms de patch

Pro Tools est compatible XML (Extensible 
Markup Language) pour l'archivage et 
l'importation des noms de patch des 
périphériques MIDI externes (tels que des 
instruments MIDI). Pro Tools installe les fichiers 
de noms MIDI (.midnam) pour les noms de 
patch d'usine par défaut de nombreux 
périphériques MIDI standard. Ces fichiers se 
trouvent dans des répertoires, triés par fabricant, 
dans Program Files\Common Files\Digidesign\ 
MIDI Patch Names\ Digidesign (Windows) et 
/Library/Audio/ MIDI Patch Names/Digidesign 
(Macintosh).

Pour importer des noms de patch MIDI dans 
Pro Tools :

1  Choisissez Setup > MIDI > MIDI Studio et 
vérifiez la définition du périphérique MIDI dans 
la fenêtre MIDI Studio Setup (Windows) ou 
Audio MIDI Setup (Macintosh).

2  Vérifiez si la sortie de la piste MIDI est 
correctement attribuée au périphérique MIDI.

3  Cliquez sur le bouton de sélection des patchs 
de la piste MIDI.

4  Dans la boîte de dialogue Patch Select, cliquez 
sur Change.

5  Dans la boîte de dialogue Open, accédez au 
dossier Program Files\Common Files\ 
Digidesign\MIDI Patch Names\ 
Digidesign\<nom du fabricant> (Windows) ou 
/Library/ Audio/MIDI Patch Names/ 
Digidesign/<nom du fabricant> (Macintosh) et 
sélectionnez le fichier .midnam pour le 
périphérique MIDI.

6  Cliquez sur Open.

7  La boîte de dialogue Patch Select contient une 
liste de noms de patch et le menu déroulant 
Patch Name Bank apparaît dans le coin 
supérieur gauche de la fenêtre.

Pour tout savoir sur la configuration des 
périphériques MIDI sur des systèmes 
Windows et Macintosh, reportez-vous au 
Guide de démarrage.

Boîte de dialogue Patch Select

Boîte de dialogue Patch Select contenant les noms de 
patch

Bouton Change
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Une fois les noms de patch importés dans 
Pro Tools, vous pouvez les utiliser pour ce 
périphérique MIDI dans toutes les sessions.

Pour effacer des noms de patch :

■ Dans la boîte de dialogue Patch Select, cliquez 
sur Clear, puis sur Done.

Insertion/édition des 
changements de programme

Vous pouvez insérer les changements de 
programme dans la liste de diffusion d'une piste 
à l'aide du crayon, puis les éditer, supprimer, 
copier et coller.

Pour insérer un changement de programme avec 
le crayon :

1  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Program Change.

2  Si vous le souhaitez, réglez le mode d'édition 
sur Grid jusqu'à ce que l'événement inséré 
s'aligne sur la valeur d'une grille. 

3  A l'aide du crayon, cliquez dans la playlist de 
la piste à l'endroit où vous souhaitez insérer les 
changements de programme.

4  Dans la boîte de dialogue Patch Select, 
sélectionnez un numéro (ou un nom) de 
programme et, le cas échéant, spécifiez une 
valeur de changement de banque.

5  Cliquez sur Done pour insérer l'événement de 
changement de programme dans la playlist de la 
piste.

Pour éditer un événement de changement de 
programme :

1  A l'aide d'un outil d'accrochage ou du crayon, 
cliquez deux fois sur le changement de 
programme à éditer.

2  Dans la boîte de dialogue Patch Select, 
sélectionnez le nouveau numéro (ou un nom) 
de programme et, le cas échéant, spécifiez une 
valeur de changement de banque.

3  Cliquez sur Done.

Pour déplacer un événement de changement de 
programme :

■ A l'aide d'un outil d'accrochage ou du crayon, 
faites glisser le changement de programme vers 
la gauche ou la droite.

Si le mode d'édition est défini sur Grid, 
l'événement déplacé s'aligne sur le pas de grille 
le plus proche. Lorsque le mode d'édition est 
réglé sur Spot, la boîte de dialogue Spot s'ouvre.

Pro Tools ne permet pas d'importer un 
fichier de noms de patch s'il ne correspond 
pas aux informations de modèle et de 
fabricant sélectionnées dans la fenêtre 
MIDI Studio Setup (Windows) ou dans 
AMS (Macintosh).

Vous pouvez modifier les fichiers .midnam 
dans un éditeur de texte. Vous pouvez 
également créer vos propres noms de patch à 
l'aide d'éditeurs ou de bibliothèques de 
noms de patch tiers.

Sur certains instruments, le changement de 
programmes en cours de lecture peut 
interrompre celle-ci. Pour éviter ce cas de 
figure, placez les événements de 
changement de programme sur la piste à un 
endroit exempt de note.

Evénement de changement de programme
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Pour supprimer un événement de changement de 
programme :

1  Lorsque le format d'affichage de la piste est 
réglé sur Program Change, cliquez sur 
l'événement de changement de programme à 
l'aide d'un outil d'accrochage pour le 
sélectionner.

– ou –

Si la région contient d'autres événements que 
vous souhaitez supprimer, sélectionnez la 
région entière à l'aide d'un outil d'accrochage 
(lorsque la piste affiche des régions).

2  Choisissez Edit > Clear pour supprimer les 
événements sélectionnés de la piste.

– ou –

Appuyez sur la touche Retour arrière (Windows) 
ou Supprimer (Macintosh).

Ecoute des programmes

Lorsque la boîte de dialogue Patch Select est 
ouverte, Pro Tools peut faire défiler 
automatiquement les différents patchs d'un 
periphérique MIDI affecté à une piste.

Pour écouter les patchs :

1  Si vous avez l'intention d'écouter des patchs 
pour une piste MIDI ou une piste d'instrument 
en cours de lecture, cliquez sur le bouton Play 
dans la fenêtre Transport.

2  Ouvrez la boîte de dialogue Patch Select en 
cliquant sur le bouton Patch Select ou en 
insérant ou éditant un changement de 
programme dans une piste MIDI ou une piste 
d'instrument.

3  Cliquez sur un numéro de programme, celui à 
partir duquel vous désirez faire défiler les patchs.

4  Entrez le nombre de secondes désiré entre 
chaque changement de programme.

5  Sélectionnez l'option Increment Patch.

Après le nombre de secondes indiqué, Pro Tools 
sélectionne le nouveau patch et transmet le 
changement de programme au périphérique 
MIDI affecté à la piste.

6  Lorsque vous avez terminé l'écoute de 
paramètres, cliquez sur Done pour arrêter 
l'incrémentation des patchs et fermer la boîte de 
dialogue Patch Select.

Le placement des changements de 
programme peut également être ajusté à 
l'aide de la commande Shift (voir 
Commande Shift, page 371) ou de la 
commande Nudge (voir Déplacement par 
incrément (Nudging), page 368).

Vous pouvez également supprimer des 
événements de changement de programme 
individuels en maintenant la touche Option 
(Macintosh) ou Alt (Windows) enfoncée 
pendant que vous cliquez dessus avec le 
crayon.
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Evénements System 
Exclusive
Vous pouvez enregistrer les événements System 
Exclusive (Sysex) sur des pistes MIDI ou des 
pistres d'instrument dans Pro Tools (voir Option 
MIDI Step Input, page 246). Lorsque des 
événements ont été enregistrés, ils apparaissent 
dans la playlist de la piste sous forme de blocs 
lorsque la vue de la piste est réglée sur Sysex.

Si vous ne pouvez pas éditer le contenu des 
événements System Exclusive enregistrés 
directement dans Pro Tools, vous pouvez 
néanmoins les déplacer, les déplacer par 
incréments, les copier/coller, ou les supprimer.

Pour déplacer un événement Sysex :

1  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Sysex.

2  A l'aide d'un outil d'accrochage, faites glisser 
l'événement Sysex vers la gauche ou la droite.

Si le mode d'édition est défini sur Grid, 
l'événement déplacé s'aligne sur le pas de grille 
le plus proche. Lorsque le mode d'édition est 
réglé sur Spot, la boîte de dialogue Spot s'ouvre.

Pour supprimer un ou plusieurs événements 
Sysex :

1  Lorsque le format d'affichage de la piste est 
réglé sur Sysex, cliquez sur l'événement Sysex à 
l'aide d'un outil d'accrochage pour le 
sélectionner.

– ou –

Si la région contient d'autres événements Sysex 
que vous souhaitez supprimer, sélectionnez la 
région entière à l'aide d'un outil d'accrochage 
(lorsque la piste affiche des régions).

2  Choisissez Edit > Clear pour supprimer les 
événements sélectionnés de la piste.

– ou –

Appuyez sur la touche Retour arrière (Windows) 
ou Supprimer (Macintosh).

Poursuite de note et de 
contrôleur

Note Chasing

La fonction Note Chasing permet d'entendre des 
notes MIDI longues et soutenues même 
lorsqu'elles sont lues à partir d'un point situé 
après leur début. Par exemple, si une note 
démarre à 1|1|000 et dure 8 mesures (jusqu'à 
9|1|000), la fonction Note Chasing permet, 
même si vous lancez la lecture depuis la 
mesure 5, d'entendre la note démarrée à 1|1|000, 
puisqu'elle est soutenue jusqu'à 9|1|000.

Bloc d'événements Sysex

Le placement des blocs d'événements Sysex 
peut également être ajusté à l'aide de la 
commande Shift (voir Commande Shift, 
page 371) ou de la commande Nudge (voir 
Déplacement par incrément (Nudging), 
page 368).

Vous pouvez également supprimer des blocs 
d'événements Sysex individuels en cliquant 
dessus avec le crayon tout en maintenant 
enfoncée la touche Option (Macintosh) ou 
Alt (Windows).
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La fonction Note Chasing peut être activée et 
désactivée séparément sur chaque piste MIDI ou 
d'instrument. Par défaut, l'option Note Chasing 
est activée sur les nouvelles pistes MIDI et 
d'instrument.

Pouractiver la fonction Note Chasing sur une piste 
MIDI :

■ Cliquez sur le sélecteur de playlist de la piste 
et sélectionnez l'option Note Chasing.

Veillez à désactiver la fonction Note Chasing 
lorsque vous travaillez avec des 
échantillonneurs qui jouent des boucles. Si une 
piste MIDI, par exemple, déclenche une boucle 
de batterie de 4 mesures et que vous commencez 
à jouer à la mesure 3, la boucle commencera sa 
lecture au mauvais moment et sera décalée par 
rapport aux autres pistes. 

Poursuite de données de contrôleur et 
de programmes

Pro Tools poursuit en permanence les 
événements de contrôleur continu et les 
changements de programme des pistes MIDI. 
Ceci garantit que les valeurs du contrôleur et les 
connexions de périphériques MIDI restent 
correctement configurées.

Supposons qu'une piste MIDI de 32 mesures 
commence à un volume de 127 et effectue un 
fondu de sortie à 0 dans la dernière mesure. Si 
après avoir lu toute la piste, vous tentez de lire à 
partir de la mesure 8, le volume initial de 127 est 
« poursuivi », retrouvé et envoyé au 
périphérique affecté à la piste. En l'absence de 
« poursuite », la piste ne serait pas entendue 
puisque l'événement de volume le plus récent 
aura été 0.

La poursuite se produit également pour un 
changement de programme par défaut d'une 
piste MIDI, ainsi qu'avec tout événement de 
changement de programme se trouvant sur la 
piste. Par conséquent, si vous avez choisi un 
changement de programme par défaut pour une 
piste, lorsque vous effectuez la lecture depuis 
n'importe quel point de la piste, cet événement 
de changement de programme est envoyé au 
périphérique affecté à la piste.

Valeurs de contrôleur par défaut et 
poursuite

Bien que les nouvelles pistes MIDI semblent 
avoir des valeurs par défaut pour les playlists de 
contrôleur continu, ce n'est en fait pas le cas. Par 
exemple, lorsque vous consultez la playlist de la 
molette de modulation d'une piste MIDI, vous 
observez que la ligne de point d'inflexion est 
définie sur zéro par défaut. Cependant, comme 
la molette de modulation de votre synthétiseur 
a pu être intentionnellement réglée sur une 
valeur différente, la valeur par défaut de la piste 
n'est pas transmise lors de la lecture.

Ceci peut provoquer une certaine confusion, 
toutefois, si vous insérez un fondu (par exemple 
de 0 à 90) dans la playlist de la molette de 
modulation vers la fin de la piste. Si vous lancez 
ensuite la lecture depuis le début de la piste, ou 
depuis n'importe où avant ce fondu, la valeur de 

Option Note Chasing activée dans le sélecteur de 
playlist
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la molette de modulation de votre synthétiseur 
restera à 90 jusqu'au début de vos données de 
fondu, ce que probablement vous ne souhaitez 
pas.

Pour vous assurer que la valeur par défaut du 
contrôleur d'une playlist est envoyée (et 
poursuivie), cliquez sur le point d'inflexion 
initial au début de la piste, déplacez-le 
légèrement puis redéfinissez-le à la valeur par 
défaut.

Décalage des pistes MIDI
Pro Tools peut décaler les pistes MIDI 
globalement ou individuellement.

Décalage de lecture MIDI global

Pro Tools offre une préférence de décalage MIDI 
(MIDI Offset) qui permet d'avancer ou retarder 
la lecture des pistes MIDI et d'instrument (par 
rapport aux pistes audio) d'un nombre 
d'échantillons donné. Le décalage ne concerne 
que la lecture et pas l'affichage des données 
MIDI dans la fenêtre Edit.

Cette fonction est offerte en grande partie pour 
compenser la latence de l'écoute audio dans 
Pro Tools LE. Si vous écoutez la sortie de vos 
instruments MIDI externes par l'intermédiaire 
d'une console de mixage ou d'un système de 
sonorisation externe (ou d'un casque), il ne se 
produit aucune latence. En revanche, si vous 
écoutez la sortie de vos périphériques MIDI à 

travers Digi 002, Digi 002 Rack, Mbox 2 ou 
Mbox, la lecture des pistes MIDI a l'air de 
s'effectuer légèrement après celle des pistes 
audio. Plus le paramètre de la taille du buffer 
matériel est élevé (128, 256, 512 ou 1024 
échantillons), plus la latence l'est également.

En configurant le décalage de lecture MIDI 
global (Global MIDI Playback Offset), vous 
pouvez avancer légèrement la lecture de vos 
pistes MIDI (d'un nombre spécifié 
d'échantillons), de manière à compenser la 
latence de l'écoute audio dans Pro Tools LE.

Pour configurer le décalage de lecture MIDI global

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet MIDI.

2  En face de l'option Global MIDI Playback 
Offset, entrez le nombre d'échantillons (-10 000 
à 10 000) désiré pour le décalage. Une valeur 
négative avance la lecture des pistes MIDI par 
rapport aux pistes audio, tandis qu'une valeur 
positive retarde la lecture des pistes MIDI.

Pour compenser la latence d'écoute dans 
Pro Tools LE, réglez le décalage sur une valeur 
approximativement équivalente à la taille du 
buffer matériel.

3  Cliquez sur Done.

Avec Pro Tools HD, lorsque la 
compensation de retard est active, les délais 
des pistes MIDI et d'instrument sont 
automatiquement compensés pour assurer 
une écoute à faible latence. Pour plus 
d'informations, reportez-vous à la section 
Compensation de retard pour un 
événement MIDI, page 605.

Vous pouvez également régler le décalage de 
lecture MIDI global dans la fenêtre MIDI 
Track Offsets. Vous pouvez également 
appliquer le retard des propriétés en temps 
réel MIDI pour décaler les données MIDI 
(voir Propriétés MIDI en temps réel, 
page 549).
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Décalages de pistes MIDI et de pistes 
d'instrument

Vous pouvez décaler des pistes MIDI et 
d'instrument individuelles dans Pro Tools pour 
compenser les temps de réaction de 
périphériques MIDI (le temps nécessaire au 
déclenchement d'événements sur un 
échantillonneur ou un synthétiseur).

Par exemple, si des grosses caisses sont lues par 
une piste audio dans Pro Tools et que vous 
voulez qu'elles soient parfaitement 
synchronisées avec les sons de grosses caisses 
générés par un périphérique MIDI, vous devrez 
peut-être utiliser un décalage MIDI. Dans cet 
exemple, 5 ms sont généralement nécessaires 
pour déclencher les notes MIDI, éventuellement 
davantage avec certains périphériques MIDI.

Pour mesurer la latence d'un périphérique MIDI 
affecté à une piste MIDI, il suffit de réenregistrer 
sa sortie audio dans Pro Tools. Comparer 
ensuite les emplacements des échantillons des 
événements audio enregistrés et ceux des notes 
MIDI d'origine pour obtenir la valeur de latence.

Pour configurer le décalage d'une piste MIDI ou 
d'instrument :

1  Choisissez Event > MIDI Track Offsets.

2  Cliquez dans la colonne Sample Offset de la 
piste MIDI et entrez le nombre d'échantillons 
(-10000 à 10000) pour le décalage. Une valeur 
négative avance la lecture des pistes MIDI ou 
d'instrument par rapport aux pistes audio, 
tandis qu'une valeur positive retarde la lecture 
des pistes MIDI ou d'instrument.

Le décalage équivalent apparaît en 
millisecondes dans la colonne msec Offset. 
Cette valeur ne peut être éditée mais elle est 
automatiquement mise à jours lorsque vous 
entrez une nouvelle valeur dans la colonne 
SMPTE Offset.

3  Appuyez sur Return (Macintosh) ou sur Entrée 
(Windows) pour valider la valeur de décalage.

Pour réinitialiser tous les décalages de toutes les 
pistes MIDI et d'instrument, cliquez sur le 
bouton Reset en haut et à gauche de la fenêtre.

Notes coincées
Si vous rencontrez des notes coincées dans vos 
périphériques MIDI, vous pouvez les faire taire 
par la commande All MIDI Notes Off.

Pour couper toutes les notes coincées :

■ Choisissez Event > All MIDI Notes Off. 

Fenêtre MIDI Track Offsets

Appuyez sur Pomme + Maj + point 
(Macintosh) ou sur Ctrl + Maj + point 
(Windows) pour activer la commande All 
MIDI Notes Off.
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Suppression des notes en 
double
La commande Remove Duplicate Notes est 
pratique pour supprimer des notes en double 
dans une performance MIDI. Lorsqu'une note 
commence dans les premiers instants (25% de la 
durée) d'une note de même hauteur qui retentit 
déjà (ou dans l'intervalle d'une croche, selon la 
durée la plus courte), elle est considérée comme 
un double et est combinée avec la note 
précédente. Si elle démarre après ce délai, la 
première note est raccourcie de façon à se 
terminer au tic précis où commence la nouvelle 
note.

Pour supprimer des notes en double :

1  Effectuez une sélection d'édition comprenant 
les notes en double à éliminer.

2  Choisissez Event > Remove Duplicate Notes.
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Chapitre 23 : Opérations MIDI

Fenêtre MIDI Operations
Les commandes proposées dans la fenêtre MIDI 
Operations permettent de transformer des 
groupes de notes MIDI et de modifier la hauteur, 
le timing et le phrasé. 

La fenêtre MIDI Operations se compose de neuf 
pages, une pour chaque commande MIDI 
Operations.

• Grid/Groove Quantize

• Restore Performance

• Flatten Performance

• Change Velocity

• Change Duration

• Transpose

• Select/Split Notes

• Input Quantize

• Step Input

La fenêtre MIDI Operations peut rester ouverte 
si vous souhaitez y revenir pour appliquer une 
commande ou essayer une option différente 
pour une commande donnée.

Pour ouvrir une page MIDI Operations spécifique :

■ Choisissez Event > MIDI, puis la commande 
MIDI Operations voulue (Grid/Groove 
Quantize, par exemple).

Il est possible également d'appliquer des 
valeurs de quantification, durée, retard et 
transposition, de façon non destructive, à 
l'aide des propriétés MIDI en temps réel. 
Pour plus d'informations, reportez-vous à la 
section Propriétés MIDI en temps réel, 
page 549.

Pour tout savoir sur la configuration des 
périphériques MIDI sur des systèmes 
Windows et Macintosh, reportez-vous au 
Guide de démarrage.

Fenêtre MIDI Operations (page Grid/Groove Quantize 
affichée)
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Pour ouvrir la dernière page MIDI Operations 
active :

■ Choisissez Event > MIDI > Operations 
Window.

Pour appliquer la commande dans la fenêtre MIDI 
Operations :

■ Cliquez sur Apply ou appuyez sur Entrée sur le 
pavé numérique. Ceci applique la commande et 
laisse la fenêtre ouverte au premier plan.

– ou –

■ Appuyez sur Retour (Macintosh) ou sur Entrée 
sur le clavier alphanumérique (Windows). Ceci 
applique la commande et ferme la fenêtre.

Pour annuler la commande dans la fenêtre MIDI 
Operations :

■ Choisissez Edit > Undo.

Utilisation de la fenêtre MIDI 
Operations

Les méthodes qui suivent vous permettent de 
configurer facilement les différentes options, 
variables d'une commande à l'autre, de la 
fenêtre MIDI Operations :

◆ Pour passer d'un champ au suivant ou revenir 
au champ précédent, utilisez la touche Tab ou 
Maj + Tab.

◆ Augmentez ou diminuez les valeurs des 
champs sélectionnés à l'aide des flèches vers le 
haut et vers le bas. Appuyez sur ces touches et 
maintenez-les enfoncées pour faire défiler 
rapidement les valeurs.

◆ Cliquez et tirez sur un champ sélectionné vers 
le haut ou le bas en pour faire défiler une 
nouvelle valeur.

◆ Appuyez sur Pomme (Macintosh) ou sur Ctrl 
(Windows) tout en réglant les curseurs pour 
obtenir une résolution plus fine.

◆ Dans le cas des champs de hauteur et de 
vélocité, jouez une note sur votre contrôleur 
MIDI pour entrer automatiquement les valeurs 
correspondantes.

◆ Le changement de valeur d'un paramètre 
particulier (par exemple le pourcentage de 
Swing dans la fenêtre Quantize), active 
automatiquement ce paramètre. 

Si la fenêtre MIDI Operations est déjà 
ouverte, vous pouvez sélectionner la page 
qui vous intéresse à partir du menu 
déroulant accessible en haut de la fenêtre.

Appuyez sur les touches Alt+3 
(Windows) ou Option+3 (Macintosh) 
pour ouvrir la fenêtre MIDI Operations et 
afficher la dernière page MIDI Operations 
active.

Lorsque vous utilisez en même temps la 
fenêtre MIDI Operations et les propriétés 
MIDI en temps réel, les opérations MIDI 
sont appliquées aux données MIDI réelles. 
Les propriétés MIDI en temps réel 
continuent d'être appliquées en plus des 
autres opérations MIDI.
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Grid/Groove Quantize
La commande Grid/Groove Quantize ajuste 
l'emplacement et la durée des notes MIDI pour 
améliorer leur temps ou créer une sensation 
rythmique particulière. 

La page Grid/Groove par défaut contient 
diverses options Grid Quantize. L'opération de 
quantification consiste à aligner les notes sur 
une grille de quantification, dont vous 
définissez le pas dans le menu déroulant 
Quantize Grid sous forme d'une durée de note 
standard. Il est possible également d'appliquer 
un modèle groove. La fenêtre Grid/Groove 
Quantize propose des options légèrement 
différentes selon l'opération choisie (Grid 
Quantize ou Groove Quantize).

La commande Quantize n'est pas identique à la 
commande Quantize to Grid (dans le menu de 
la liste des régions). Cette dernière ajuste en effet 
le point de début d'une région sélectionnée, 
dont le contenu se trouve déplacé (en préservant 
les relations rythmiques internes). 

En revanche, l'opération Grid/Groove Quantize 
MIDI modifie les notes MIDI de façon 
individuelle. Certaines notes peuvent être 
retardées, d'autres avancées, ou bien raccourcies 
ou au contraire allongées. Certaines notes 
subiront davantage de modifications que 
d'autres.

Pour ouvrir la fenêtre Grid/Groove Quantize :

■ Choisissez Event > MIDI > Grid/Groove 
Quantize. 

Fenêtre MIDI Operations, Grid/Groove Quantize

Les paramètres de la fenêtre Quantize sont 
sauvegardés avec chaque session. Pour 
enregistrer vos paramètres favoris comme 
ceux par défaut pour vos futures sessions, 
enregistrez la session en tant que modèle 
(voir Création de modèles de session 
personnalisés, page 68). 

Vous pouvez également quantifier les 
entrées MIDI (voir Input Quantize, 
page 545).

Appuyez sur Alt+0 (Windows) ou sur 
Option+0 (Macintosh) pour accéder à la 
fenêtre Grid/Groove Quantize.
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Pour sélectionner Grid Quantize :

■ Dans le menu déroulant Quantize Grid, 
sélectionnez la valeur de note désirée.

Pour sélectionner Groove Quantize :

■ Dans le menu déroulant Quantize Grid, 
sélectionnez le modèle groove désiré.

Options Grid Quantize

La fenêtre Grid/Groove Quantize permet 
d'appliquer une valeur de quantification de 
grille lorsqu'une valeur rhythmique particulière 
est sélectionnée dans le menu déroulant 
Quantize Grid. Si vous sélectionnez un modèle 
groove dans le menu déroulant Quantize, vous 
pouvez appliquer une quantification de groove. 
Pour plus d'informations à ce sujet, reportez-
vous à la section Groove Quantize, page 530.

Options What to Quantize

Les options de la zone What to Quantize 
déterminent les aspects des notes MIDI 
sélectionnées qui seront quantifiés : les phases 
d'attaque (Attacks), de relâchement (Releases) 
ou les deux.

Attacks : lorsque vous cochez cette option, les 
points de début des notes sont quantifiés.

Releases : lorsque vous cochez cette option, les 
points de fin des notes sont quantifiés.

Preserve Note Duration : lorsque vous cochez 
cette option, la durée des notes est conservée. 

Lorsqu'elle n'est pas cochée, mais que l'option 
Attacks l'est, les points de fin des notes ne sont 
pas déplacés. 

Lorsque cette option n'est pas cochée, mais que 
l'option Releases l'est, les points de début des 
notes ne sont pas déplacés.

Si vous avez coché les deux options Attacks et 
Releases, l'option Don't Change Durations n'est 
pas disponible.

La Figure 21, page 526 illustre le réglage des 
notes par les différentes options de la zone What 
To Quantize.

Grille de quantification

Menu déroulant Quantize Grid : détermine le pas 
de la grille sur lequel s'alignent les notes. Vous 
pouvez sélectionner comme pas de grille 
n'importe quelle valeur de note, de la ronde 
(1/1) à la quadruple croche (1/64), valeurs 
pointées ou triolets compris. 

Figure 21.  Exemples de quantification

Le mode Relative Grid n'affecte pas la grille 
de quantification.

Avant quantification
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Tuplet : cochez l'option Tuplet pour quantifier 
les groupes de notes « inhabituels », tels que les 
quintolets. Dans ce cas, le pas de grille de 
quantification est calculé à partir de la valeur de 
note sélectionnée et de la valeur de Tuplet. Par 
exemple, si une double croche équivaut à 
240 tics, des croches en quintolets (5 pour 4) 
donnent un pas de grille de 192 tics 
(240 tics /5)* 4.

Offset Grid By : permet de décaler 
temporellement la grille de quantification vers 
l'avant ou l'arrière, du nombre de tics spécifié. 
Utilisez cette option pour obtenir un effet de jeu 
« en avant » (en utilisant des valeurs positives) 
ou « en arrière » (en utilisant des valeurs 
négatives) du temps.

Randomize : lorsque cette option est cochée, les 
notes sont déplacées de façon aléatoire vers 
l'avant ou l'arrière dans le temps (à l'issue de la 
quantification). Par exemple, lorsque la grille de 
quantification est définie sur la croche et que 
l'option Randomize est définie sur 50 %, les 
notes sont déplacées jusqu'à une triple croche 
avant ou après la limite du tempo. Le paramètre 
Randomize a également une incidence sur la 
durée des notes (si vous avez coché l'option 
Releases).

Options

Les autres options de quantification incluent :

Swing : lorsque vous sélectionnez cette option, 
tous les pas de grille sont décalés du pourcentage 
spécifié (de 0 à 300) pour obtenir une ambiance 
swing. La valeur 0 % ne produit aucun swing et 
la valeur 100 % donne une ambiance swing 
ternaire. Les valeurs supérieures à 100% 

réduisent progressivement le swing jusqu'au 
maximum de 300%, seuil à partir duquel tous 
les pas de grille sont décalés vers le pas suivant 
de la grille.

Include Within : lorsque cette option est 
sélectionnée, les attaques et les relâchements ne 
sont quantifiés que s'ils se trouvent dans le 
pourcentage spécifié autour de la grille de 
quantification. Cette option permet de nettoyer 
les temps forts sans toucher aux notes swinguées 
ou très fortement décalées par rapport au tempo.

La Figure 22 illustre une grille de quantification 
définie sur la noire, l'option Include Within 
étant réglée sur 50 %. Seuls les attaques et les 
relâchements tombant dans la zone ombrée 
(équivalente à une croche de part et d'autre de 
chaque battement) sont quantifiés.

Pour ne quantifier que les backbeats (temps 
pairs de la mesure), réglez la valeur de grille 
de quantification sur une blanche avec un 
décalage de 960 tics.

Grille à la croche, swing à 100 %

Figure 22.  Option Include Within

Tous les autres points sont 
décalés par la fonction Swing

Swing à 0 %
(480 tics)

Swing à 100 %
(640 tics)
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Exclude Within : lorsque cette option est 
sélectionnée, les attaques et les relâchements ne 
sont pas quantifiés s'ils se trouvent dans le 
pourcentage spécifié autour de la grille de 
quantification. Cette option permet de 
préserver le feeling des notes proches du temps, 
tout en en corrigeant d'autres qui sont très 
éloignées du tempo.

La Figure 23 illustre une grille de quantification 
définie sur la noire, l'option Exclude Within 
étant réglée sur 25 %. Les attaques et les 
relâchements qui tombent sur la zone ombrée 
(équivalente à une double croche de part et 
d'autre de chaque tempo) ne sont pas quantifiés.

Strength : lorsque cette option est cochée, 
les notes sont déplacées sur la grille de 
quantification, du pourcentage indiqué. 
Les faibles pourcentages préservent le feeling 
d'origine des notes, les pourcentages élevés 
alignent les notes plus rigidement sur la grille.

Exemples de quantification par 
grille

Les exemples qui suivent illustrent certaines des 
utilisations les plus courantes de la commande 
Grid Quantize.

Si vous envisagez de lire en boucle pendant la 
quantification, vous pouvez désélectionner 
Options > Link Timeline and Edit Selection. 
Ceci garantit que la région de lecture ne change 
pas lorsque les notes sélectionnées sont 
déplacées en cours de quantification et 
d'annulation.

Quantification stricte

Pour quantifier à la double croche, de façon 
stricte :

1  Sélectionnez la région des notes MIDI à 
quantifier.

2  Choisissez Event > MIDI > Grid/Groove 
Quantize.

3  Dans la zone What to Quantize, cochez 
l'option Attacks. Pour quantifier également les 
durées de notes, cochez l'option Releases.

4  Dans le menu déroulant Quantize Grid, 
sélectionnez des doubles croches (1/16). 
Assurez-vous que les autres options : Tuplet, 
Offset Grid By et Swing ne sont pas cochées.

5  Laissez les autres options de quantification 
non cochées et cliquez sur Apply.

Figure 23.  Option Exclude Within

Après la quantification, vous pouvez 
utiliser l'option Restore Performance pour 
revenir à la version d'origine (voir Restore 
Performance, page 535).
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Quantification préservant le feeling 
d'origine

Vous pouvez effectuer une quantification moins 
stricte, préservant le feeling d'origine de vos 
pistes MIDI enregistrées.

Pour effectuer la quantification tout en préservant 
le feeling d'origine :

1  Sélectionnez la région des notes MIDI à 
quantifier.

2  Choisissez Event > MIDI > Grid/Groove 
Quantize.

3  Dans la zone What to Quantize, cochez 
l'option Attacks. Pour quantifier également les 
durées de notes, cochez l'option Releases.

4  Dans le menu déroulant Quantize Grid, 
sélectionnez la valeur de note à utiliser. Assurez-
vous que les autres options : Tuplet, Offset Grid 
By et Swing ne sont pas cochées.

5  Sélectionnez l'option Exclude Within et 
entrez une valeur entre 10 et 15 %.

6  Sélectionnez l'option Strength et entrez une 
valeur entre 70 et 80 %.

7  Laissez les autres options de quantification 
non cochées et cliquez sur Apply.

Ecoutez vos modifications, et si vous n'êtes pas 
satisfait, annulez-les et changez les valeurs des 
options Exclude Within et Strength.

Quantification avec Swing

Si vous travaillez avec des charleys ou des lignes 
de basse MIDI, vous pouvez appliquer 
davantage de swing à la piste.

Pour quantiser à la croche avec une ambiance 
swing :

1  Sélectionnez la région des notes MIDI à 
quantifier.

2  Choisissez Event > MIDI > Grid/Groove 
Quantize.

3  Dans la zone What to Quantize, cochez 
l'option Attacks. Pour quantifier également les 
durées de notes, cochez l'option Releases.

4  Dans le menu déroulant Quantize Grid, 
sélectionnez des croches (1/8). 

5  Cochez l'option Swing et entrez le 
pourcentage désiré :

• Pour un swing léger, utilisez 12 %.

• Pour un swing plus prononcé, utilisez 
24 %.

• Pour un swing ternaire, utilisez 50 à 75 %.

6  Vérifiez que les options Tuplet, Offset Grid By 
et Randomize ne sont pas cochées. Cliquez sur 
Apply.

Ecoutez vos modifications et si vous n'êtes pas 
satisfait, annulez-les puis changez le 
pourcentage de l'option Swing.
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Quantification avec Randomize

Si vous avez l'impression que les notes sonnent 
de façon trop mécanique ou trop sur le tempo, 
utilisez l'option Randomize de la fenêtre 
Quantize pour les rendre plus naturelles.

Pour « humaniser » le feeling rythmique des 
notes  :

1  Sélectionnez la région des notes MIDI à 
quantifier.

2  Choisissez Event > MIDI > Grid/Groove 
Quantize.

3  Dans la zone What to Quantize, cochez 
l'option Attacks. Pour quantifier également les 
durées de notes, cochez l'option Releases.

4  Dans le menu déroulant Quantize Grid, 
sélectionnez la valeur de note à utiliser. 

5  Sélectionnez l'option Randomize et entrez une 
valeur de 5 %.

6  Cliquez sur Apply.

Ecoutez vos modifications et si vous n'êtes pas 
satisfait, annulez-les puis modifiez le 
pourcentage de l'option Randomize.

Essais de quantification

Lors de l'utilisation de la commande Quantize, il 
est souvent nécessaire de faire des essais avec les 
différents paramètres. Vous devrez peut-être 
essayer différentes valeurs pour les options 
Include et Exclude Within, ainsi que l'option 
Strength ; ces paramètres déterminent quelles 
notes sont concernées et dans quelle mesure 
elles sont modifiées. De plus, le paramètre 
Randomize, qui ajoute un côté aléatoire à la 
quantification, peut servir à rendre le feeling des 
pistes moins mécanique.

Groove Quantize

La fenêtre Grid/Groove Quantize permet 
d'appliquer une quantification de groove si vous 
sélectionnez un modèle groove dans le menu 
déroulant Quantize Grid. La commande Groove 
Quantize permet de régler les emplacements des 
notes MIDI ainsi que leurs durées selon un 
modèle Groove plutôt qu'une grille de 
quantification stricte. Les modèles Groove 
extraient le feeling rythmique spécifique d'une 
performance enregistrée afin de l'appliquer à 
une séquence MIDI. Il est possible de créer des 
modèles DigiGroove à l'aide de Beat Detective.

Fenêtre MIDI Operations, Grid/Groove Quantize
(modèle groove sélectionné)
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Modèles Groove

Les modèles Groove (par exemple les modèles 
DigiGroove) sont des « tables de 
quantification » dérivées de performances 
musicales réelles. L'aspect rythmique de chaque 
interprétation est analysé et sauvegardé sous 
forme de modèle de groove. Ces modèles 
peuvent être utilisés pour transférer le feeling 
d'une performance particulière vers les données 
MIDI (Timing, Duration et Velocity).

Il est possible de créer des modèles DigiGroove à 
l'aide de Beat Detective. Ce dernier analyse un 
fichier audio à la recherche de pics de 
transitoire, en fonction d'un seuil défini et 
affecte les relations rythmiques à un modèle de 
960 parties par quart de note (ppq). Ce modèle 
peut être utilisé dans Groove Quantize et Beat 
Detective.

De plus, les modèles DigiGroove sont 
disponibles chez Digidesign et d'autres 
fabricants. 

Grille de quantification

Menu déroulant Quantize Grid : détermine le 
modèle groove à utiliser pour la quantification. 
Tous les fichiers de modèles Groove du dossier 
Grooves sont disponibles dans le menu 
déroulant Quantize Grid. Le chemin du 
répertoire Grooves est : C:\Program Files\ 
Digidesign\Pro Tools\ Grooves (Windows) ou 
Applications/Digi-design/Pro Tools/Grooves 
(Macintosh). Si vous organisez vos modèles 

Groove en sous-dossiers dans le dossier Groove, 
ceux-ci apparaissent sous forme de sous-menus 
dans le menu déroulant. Lorsque vous 
sélectionnez un modèle, des informations 
spécifiques à celui-ci relatives au temps et à la 
durée (en nombre de mesures) s'affichent en 
dessous du menu déroulant.

Show Comments : le champ Comments affiche 
les commentaires enregistrés avec le modèle 
Groove depuis Beat Detective. Vous ne pouvez 
pas modifier ce champ dans la fenêtre 
Grid/Groove Quantize. En revanche, cela est 
possible lorsque vous enregistrez un modèle 
Groove à partir de la page Groove Quantize.

Pre-Quantize : permet d'effectuer une 
quantification de type hard sur les notes MIDI 
sélectionnées en fonction d'une grille de 
doubles croches avant d'appliquer la commande 
Groove Quantize. 

Options

Timing : activez cette option pour appliquer un 
modèle Groove Quantize aux notes MIDI 
sélectionnées. Faites glisser le curseur pour faire 
varier le niveau de quantification appliqué à la 
sélection. S'il est réglé sur 0 %, il n'existe aucun 
effet sur le timing. En revanche, s'il est réglé sur 
100 %, les notes sont déplacées vers la position 
des modèles sous-jacents. Sur 200 %, les notes 
sont déplacées vers la position correspondant au 
tic, soit deux fois la différence entre la position 
de la note d'origine et celle de l'événement du 
modèle référencé. 

Ainsi, si vous lisez une note à la mesure 1|1|060 
(un seizième de note) et que l'événement du 
modèle correspondant a la mesure 1|1|073, un 
timing sur 100  % décale la note vers 1|1|073 
(sur 200 %, la note est décalée vers 1|1|086). 

Par défaut, le curseur Timing est réglé sur 100 %.

Pour des informations sur Beat Detective 
et la création de modèles Groove, 
consultez le Chapitre 21, Beat Detective.

Les modèles Feel Injector Templates de 
Numerical Sound (960 ppq) sont pris en 
charge par Pro Tools, mais pas les modèles 
DNA Groove Templates (192 ppq).
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Duration : activez cette option pour influencer la 
durée des notes MIDI sélectionnées. Sur 100 %, 
les durées changent pour être en accord avec le 
modèle Groove actuel. Sur 200 %, les durées 
varient en fonction du rapport entre la durée 
d'origine des notes sélectionnées et les durées 
dans le modèle. 

Par défaut, le curseur Duration est réglé sur 
100 %.

Velocity : activez cette option pour influencer la 
vélocité des notes MIDI sélectionnées. 
Un curseur réglé sur 0 % n'affecte aucunement 
les vélocités sélectionnées. En revanche, sur 
100 %, toutes les vélocités changent pour être 
en accord avec le modèle Groove actuel. 
Sur 200 %, les vélocités sont exagérées avec pour 
effet de monter le volume des notes fortes et de 
baisser celui des notes faibles. 

Ainsi, dans le cas de deux notes adjacentes avec 
des vélocités toutes les deux égales à 80 et pour 
lesquelles les vélocités du modèle sont égales 70 
et 90 respectivement, le réglage du curseur sur 
200 % permet d'obtenir des vélocités de 60 
et 100.

Par défaut, le curseur Velocity est réglé sur 
100 %.

Réglages du curseur

Pour enregistrer le modèle Groove en tenant 
compte des réglages du curseur dans la zone 
Options :

1  Dans la fenêtre Grid/Groove Quantize, cliquez 
sur Save.

2  Tapez ou modifiez les commentaires que vous 
souhaitez enregistrer avec le modèle.

3  Pour enregistrer le modèle Groove en tenant 
compte des réglages du curseur dans la zone 
Options, cliquez sur Save.

– ou –

Pour faire une copie du modèle Groove en 
tenant compte des réglages du curseur dans la 
zone Options, cliquez sur Save as. Lorsque la 
boîte de dialogue Save s'ouvre, attribuez un nom 
à la copie et cliquez sur Save.

Vous risquez de perdre les réglages du curseur si 
vous effectuez une des étapes ci-dessous sans 
enregistrer d'abord les réglages :

• Vous sélectionnez une autre fenêtre MIDI 
Operations.

• Vous avez fermé la fenêtre MIDI 
Operations.

• Vous sélectionnez un autre modèle Groove.

Recall With Template

Restaure les réglages des options Groove 
Quantize enregistrées avec le modèle actuel.

Beat Detective ne permet pas actuellement 
d'extraire des informations relatives aux 
durées provenant d'interprétations audio. 
Les modèles DigiGroove créés via Beat 
Detective contiennent une valeur de durée 
qui équivaut à 50 % de la résolution du 
modèle sélectionné (voir Définition d'une 
sélection pour le Beat Detective, 
page 472).

Enregistrement des réglages du modèle Groove de 
l'utilisateur
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Application de modèles Groove

Les modèles Groove peuvent être de toute 
longueur et peuvent être appliqués à un nombre 
illimité de mesures. En général, vous appliquez 
les modèles Groove aux sélections de même 
longueur et de même temps. Cependant, les 
modèles Groove peuvent être appliqués à 
différents temps ; un modèle Groove en 6/8 
peut par exemple être appliqué à une sélection 
en 4/4. De plus, il n'est pas nécessaire de 
démarrer sur le temps fort lors de la sélection 
afin d'appliquer un modèle Groove.

Pour appliquer un modèle Groove Quantize :

1  A l'aide du sélecteur ou d'un outil 
d'accrochage, sélectionnez les notes MIDI 
auxquelles vous souhaitez appliquer un modèle 
Groove Quantize.

2  Choisissez Event > MIDI > Grid/Groove 
Quantize.

3  Sélectionnez un modèle Groove dans le menu 
déroulant Grid Quantize.

4  Activez les options Timing, Duration et 
Velocity et réglez leurs valeurs en pourcentage à 
l'aide des curseurs.

5  Si nécessaire, activez l'option Pre-Process 
Using Quantize.

6  Cliquez sur Apply. 

Figure 24.  Modèle DigiGroove (dérivé de l'audio) appliqué à une série de quadruples croches et avec les options 
Timing et Velocity définies toutes les deux sur 100 %
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Affectation de modèles Groove

Pro Tools applique des modèles Groove en 
fonction du début du morceau. Ainsi, un 
modèle Groove à deux mesures est répété 
automatiquement lorsqu'il rencontre une 
mesure impaire dans la session (mesure 1, 3, 5, 
7, etc.).

Affectation du modèle pour les temps 
identiques et les mesures impaires

Si un modèle Groove à deux mesures est 
appliquée à une sélection d'une mesure ayant le 
même temps, seule la première mesure du 
modèle est utilisée. Par contre, si la sélection 
exclut les limites de la mesure, par exemple 
1|2|000 à 2|1|000, le modèle Groove ne modifie 
que les notes sélectionnées.

Affectation du modèle pour les temps 
identiques et les mesures paires

Si la sélection démarre sur une mesure paire, sur 
la partie adéquate du modèle Groove sera 
utilisée. Ainsi, si la sélection contient deux 
mesures et que la première est paire, le modèle 
est d'abord appliquée à la deuxième mesure puis 
à la première.

Affectation du modèle à des temps non 
identiques

Lorsque les modèles Groove et les sélections de 
piste se font sur des temps non identiques, le 
modèle est répété ou tronqué pour correspondre 
au nombre de battements de la sélection.

Ainsi, si le modèle Groove contient moins de 
battements que la sélection, le modèle est répété 
pour compenser la différence. C'est le cas, par 
exemple, lorsqu'un modèle à une mesure 6/8 est 
appliquée à une seule mesure 4/4 sélectionnée.

Exemple de répétition du modèle Groove à deux 
mesures

Application d'un modèle Groove à deux mesures à une 
seule mesure impaire

Modèle
Groove  :

à 2 mesures

Modèle
Groove  :

à 2 mesures

Modèle
Groove  :

à 2 mesures

Modèle
Groove  :

à 2 mesures

Mesure 1 à 4/4 Mesure 2 à 4/4 (non utilisée)

(modèle Groove)

1ère mesure 4/4 sélectionnée

 

Application d'un modèle Groove à deux mesures à une 
seule mesure paire

Application d'un modèle Groove à une mesure 6/8 à 
une mesure 4/4 sélectionnée

Mesure 1 à 4/4 (non utilisée) Mesure 2 à 4/4

(modèle Groove)

1ère mesure 4/4 sélectionnée

Mesure 1 à 6/8

1ère mesure 4/4 sélectionnée

Mesure 1 à 6/8 répétée

(modèle Groove)

(battements 3-6 non utilisés)
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Ainsi, si le modèle Groove contient moins de 
battements que la sélection, celui-ci est répété 
pour compenser la différence. C'est le cas, par 
exemple, lorsqu'un modèle à une mesure 6/4 est 
appliquée à une seule mesure 4/4 sélectionnée.

 

Affectation du modèle dans le cas de temps 
mixtes

 

Si la sélection contient des temps mixtes, le 
modèle Groove est toujours affecté de façon à 
aligner les temps forts. Ainsi, si le modèle 
Groove est composé d'une mesure 4/4 et qu'elle 
est appliquée à une mesure 4/4 sélectionnée 
suivie d'une mesure 3/8 et d'une mesure 3/4, le 
temps fort du modèle Groove est aligné sur les 
temps forts de la sélection. Seul le nombre 
approprié de battements du modèle Groove est 
appliqué.

 

Restore Performance

 

La commande Restore Performance restaure 
toutes les notes MIDI sélectionnées à leur état 
d'origine (c'est-à-dire les notes obtenues lors du 
premier enregistrement ou insérées 
manuellement) même après avoir enregistré la 
session ou supprimé la liste des dernières 
annulations. Les attributs des notes MIDI 
suivants peuvent être restaurés :

• Timing (Quantization)

• Duration 

• Velocity

• Pitch

 

Application d'un modèle Groove à une mesure 6/4 à 
une mesure 4/4 sélectionnée

 1ère mesure 6/4 (battements 5-6 non utilisés)

1ère mesure 4/4 sélectionnée

(modèle Groove)

 

Application d'un modèle Groove à une mesure 4/4 à 3 
mesures à des temps différents

 

Il est possible de réinitialiser la grille du 
modèle Groove en ajoutant un marqueur de 
temps (il peut s'agir du même temps). 
Le modèle Groove redémarre à l'endroit du 
marqueur quel que soit le nombre de 
mesures et sans tenir compte des 
changements de temps.

La commande Restore Performance ne peut 
pas être annulée.

3 mesures sélectionnées à des temps différents

(modèle Groove)

Mesure 1 à 4/4

(modèle Groove)

Mesure 1 à 4/4

(modèle Groove)

Mesure 1 à 4/4

(non utilisé)
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Pour restaurer le temps, la durée, la vélocité ou la 
hauteur d'origine d'une note :

 

1  

 

A l'aide d'un outil d'accrochage ou du 
sélecteur, sélectionnez les notes MIDI à 
restaurer.

 

2  

 

Choisissez Event > MIDI > Restore 
Performance pour ouvrir la page Restore 
Performance.

 

3  

 

Sélectionnez les attributs des notes à restaurer.

 

4  

 

Cliquez sur Apply.

Toute modification apportée aux commandes 
standard Quantize, Groove Quantize, Change 
Duration, Change Velocity ou Change Pitch est 
alors annulée et les réglages d'origine sont 
restaurés. Les notes enregistrées après avoir 
activé l'option Input Quantize sont également 
restaurées (voir Input Quantize, page 545).

 

Timing (Quantization) : 

 

activez cette option pour 
restaurer les temps de début d'origine des notes 
sélectionnées. La durée des notes sera modifiée 
si vous avez activé l'option Duration. 

 

Duration : 

 

activez cette option pour restaurer les 
durées d'origine des notes sélectionnées. 
Si l'option Timing (Quantization) n'est pas 
activée, le temps de début de la note n'est pas 
restauré et le temps de fin peut être modifié. 

 
Velocity : 

 
activez cette option pour restaurer les 

vélocités d'origine des notes sélectionnées. 

Pitch : 

 

activez cette option pour restaurer les 
hauteurs d'origine des notes sélectionnées.

 

Suppression d'Input Quantize

 

Restore Performance peut servir à supprimer une 
quantification en entrée. Ainsi, si vous effectuez 
un enregistrement avec l'option Input Quantize 
activée, il est possible de le restaurer tel qu'il 
était lors de l'interprétation.

 

Fenêtre MIDI Operations, page Restore Performance

 

Restore Performance n'annule pas les 
fonctions couper, copier et coller ou les notes 
MIDI déplacées manuellement.

Cette commande n'annule pas non plus les 
modifications apportées à la durée lors du 
rognage du début d'une note. Cette 
opération modifie essentiellement le temps 
de la note, ce qui équivaut, dans Pro Tools, 
à la déplacer manuellement.

 

Pour plus d'informations sur la commande 
Input Quantize, reportez-vous à la section 
Input Quantize, page 545.
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Flatten Performance

 

La commande Flatten Performance verrouille 
l'interprétation actuelle des notes sélectionnées, 
créant ainsi un état de restauration pour les 
attributs des notes spécifiées lors de l'utilisation 
de l'option Restore Performance.

 

Pour aplanir des notes :

 

1  

 

A l'aide d'un outil d'accrochage ou du 
sélecteur, sélectionnez les notes MIDI à aplanir.

 

2  

 
Choisissez Event > MIDI > Flatten 

Performance pour ouvrir la page Restore 
Performance.

 

3  

 

Sélectionnez les attributs des notes à aplanir.

 

4  

 

Cliquez sur Apply.

 

Change Velocity

 

La commande Change Velocity ajuste 
automatiquement les vélocités d'attaque et de 
relâchement des notes MIDI sélectionnées. 
Utilisez cette commande pour rendre des notes 
plus fortes ou moins fortes, ou pour créer des 
crescendos ou des diminuendos.

Vous pouvez également éditer manuellement 
les vélocités à l'aide du crayon et des outils 
d'accrochage (voir Edition manuelle des notes 
MIDI, page 502).

 

Fenêtre MIDI Operations, page Flatten Performance

 

La commande Flatten Performance ne peut 
pas être annulée.

 

Les valeurs de vélocité ont généralement une 
incidence sur le niveau sonore des notes 
MIDI. Elles peuvent également concerner 
d'autres aspects du son d'un instrument, 
tels que la fréquence de coupure d'un filtre, 
les enveloppes et les modulations.

Les paramètres de la fenêtre Change 
Velocity sont sauvegardés avec chaque 
session. Pour enregistrer vos paramètres 
favoris comme ceux par défaut pour vos 
futures sessions, enregistrez la session en 
tant que modèle (voir Création de modèles 
de session personnalisés, page 68).

Vous pouvez également changer la vélocité 
en temps réel, de manière non destructive, à 
l'aide des propriétés MIDI en temps réel. 
Pour plus d'informations, reportez-vous à la 
section Propriétés MIDI en temps réel, 
page 549.
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Pour ouvrir la page Change Velocity : 

 

■

 

Choisissez Event > MIDI > Change Velocity.

 

Set All To : 

 

règle toutes les vélocités à la valeur 
spécifiée (1–127).

 

Add : 

 

ajoute la quantité spécifiée (1 à 127) aux 
valeurs de vélocité existantes.

 

Subtract : 

 

soustrait la quantité spécifiée (1 à 
127) aux valeurs de vélocité existantes.

 

Scale By : 

 

multiplie toutes les valeurs de 
vélocités par un certain pourcentage (1 à 
400 %).

 

Change Smoothly : 

 

permet de passer 
progressivement d'une valeur de vélocité à une 
autre.

 

Change Smoothly by Percentage : 

 

permet de 
faire passer progressivement les valeurs de 
vélocité d'un pourcentage à un autre. 

La courbe régissant cette transformation peut 
être ajustée (+/-99) pour intervenir sur sa 
progressivité.

 

Limit To : 

 

lorsque cette option est cochée, elle 
restreint la commande Change Velocity à une 
valeur minimale et maximale.

 

Randomize : 

 

lorsque cette option est cochée, la 
commande Change Velocity crée des valeurs de 
vélocité aléatoires, en tenant compte du 
pourcentage spécifié. Par exemple, utiliser une 
valeur de 64 pour Set all to, et une valeur 
Randomize de 50 %, produit au hasard des 
valeurs de vélocité comprises entre 48 et 80 
(+/–25 % de la valeur de vélocité).

 

Plages de vélocité

 

Pour être valides, les valeurs de vélocité de notes 
MIDI doivent être comprises entre 1 et 127. 
La commande Change Velocity ne crée jamais 
de valeurs hors de cette fourchette ; 1 sera 
toujours la valeur la plus basse et 127, la plus 
élevée. Cela signifie que, dans certains cas, la 
commande Change Velocity peut n'avoir aucun 
effet sur une note donnée.

Par exemple, si une note d'une vélocité de 64 est 
multipliée par 200 %, la nouvelle valeur de 
vélocité sera de 127. Si vous tentez de multiplier 
ou d'augmenter encore la vélocité, vous 
n'obtiendrez aucune modification.

 

Fenêtre MIDI Operations, page Change Velocity

 

S'il existe des options permettant d'ajuster 
les vélocités d'attaque et de relâchement des 
notes, la plupart des périphériques MIDI 
ignorent les informations de vélocité de 
relâchement. Pour savoir si votre instrument 
prend en charge la vélocité de relâchement, 
veuillez consulter la documentation du 
fabricant.
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Vélocités de fondu

 

Pour faire varier les vélocités progressivement 
dans le temps :

 

1  

 

Sélectionnez la région de notes MIDI à éditer.

 

2  

 

Choisissez Event > MIDI > Change Velocity.

 

3  

 

Sélectionnez l'option Change Smoothly, la 
plage étant définie entre 127 et 0.

 

4  

 

Cliquez sur Apply.

Pour préserver (en partie) les valeurs relatives de 
vélocité existantes tout en réalisant des fondus 
de vélocité, utilisez l'option Change Smoothly 
by Percentage. La Figure 25 illustre la différence 
entre les deux options Change Smoothly.

 

Multiplication des vélocités

 

Il est fréquent que les valeurs de vélocité 
existantes présentent la relation souhaitée entre 
elles, mais qu'elles soient, dans leur ensemble 
soit trop faibles, soit trop élevées. Dans ce cas, 
vous pouvez utiliser l'option Scale By.

 

Par exemple, pour augmenter les valeurs de 
vélocité de 20 % :

1  Sélectionnez la région de notes MIDI à éditer.

2  Choisissez Event > MIDI > Change Velocity.

3  Sélectionnez l'option Scale By, en réglant la 
valeur de pourcentage sur 120.

4  Cliquez sur Apply.

Change Duration
La commande Change Duration modifie la 
durée des notes MIDI sélectionnées. Utilisez-la 
pour augmenter l'effet staccato ou legato de 
mélodies et de phrases.

Figure 25.  Option Change Smoothly by Percentage

Vélocités d'origine

Après l'option Change Smoothly by Percentage, 

Après l'option Change Smoothly, de 100 à 10

de 100  % à 20  % 

Les paramètres de la page Change Duration 
sont sauvegardés avec chaque session. Pour 
enregistrer vos paramètres favoris comme 
ceux par défaut pour vos futures sessions, 
enregistrez la session en tant que modèle 
(voir Création de modèles de session 
personnalisés, page 68).

Vous pouvez également changer la durée 
des notes en temps réel, de manière non 
destructive, à l'aide des propriétés MIDI en 
temps réel. Pour plus d'informations, 
reportez-vous à la section Propriétés MIDI 
en temps réel, page 549.
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Pour ouvrir la page Change Duration :

 

■

 

Choisissez Event > MIDI > Change Duration. 

 Set/Add/Subtract/Scale

Set All To : 

 

attribue une même durée, spécifiée 
en noires et en tics, à toutes les notes.

 

Add : 

 

ajoute à toutes les durées de notes une 
même valeur, spécifiée en noires et en tics.

 

Subtract : 

 

soustrait à toutes les durées de notes 
une même valeur, spécifiée en noires et en tics.

 

Scale By : 

 

multiplie les durées de notes d'un 
certain pourcentage (1 à 400 %).

 

Legato

 

Activez l'option Legato pour ajouter un effet de 
legato à la sélection MIDI. Sélectionnez Gap ou 
Overlap dans le menu déroulant Legato et 
entrez la valeur d'espacement ou de 
chevauchement désirée en temps et tics.

 

Remove Overlap

 

Cette option a pour effet de supprimer le 
chevauchement de note pour toutes les notes de 
la même hauteur. Elle diffère de l'option Legato 
dans la mesure où elle préserve les notes qui ne 
se chevauchent pas (qu'elles aient la même 
hauteur ou non). Pour créer un espace entre les 
notes qui se chevauchaient auparavant, entrez 
la valeur d'espacement désirée en temps et tics. 

 

Transform Sustain Pedal To Duration

 

Cette option prolonge les notes émises lorsque 
la pédale de tenue (contrôleur 64) est abaissée 
(0 à 63) jusqu'au moment où la pédale de tenue 
remonte (64 à 127). Activez l'option Delete 
Sustain Pedal Events pour convertir les 
événements de pédale de tenue en durées de 
note. Cette opération peut faciliter 
considérablement le travail d'édition tout en 
préservant l'effet de performance voulu. En cas 
de suppression en cours d'édition d'un 
événement d'activation de la pédale de tenue, 
par exemple, la performance MIDI suivante perd 
son effet de legato.

 

Change Continuously

 

Cette option permet de changer la durée des 
notes de façon continue en tics ou en 
pourcentage. Pour modifier la forme du 
changement, réglez le curseur de la courbe.

 

Change Continuously in Ticks : 

 

permet de faire 
passer progressivement les durées de notes d'une 
valeur à l'autre. Les valeurs de durée sont 
spécifiées en noires et en tics.

 

Appuyez sur Alt+P (Windows) ou sur 
Option+P (Macintosh) pour accéder à la 
page Change Duration.

 

Fenêtre MIDI Operations, page Change Duration
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Change Continuously by Percentage : 

 

permet de 
faire passer progressivement les longueurs de 
notes d'un pourcentage à l'autre. 

La courbe régissant cette transformation peut 
être ajustée (+/-99) pour intervenir sur sa 
progressivité.

 

Limit Range : 

 

lorsque cette option est cochée, 
elle restreint la commande Change Duration à 
une valeur minimale et maximale (exprimée en 
noires et en ticks).

 

Randomize : 

 

lorsque cette option est cochée, la 
commande Change Duration crée des valeurs 
aléatoires, en tenant compte du pourcentage 
spécifié. Par exemple, utiliser la fonction Set all 
to avec une valeur de 480 tics et une valeur 
Randomize de 50 %, produit des durées 
aléatoires, comprises entre 360 et 600 (+/-25 % 
de la valeur de durée).

 

Exemples d'application de 
changements de durée

 

Pour rendre les notes plus staccato :

 

1  

 

Sélectionnez la région de notes MIDI à éditer.

 2   Choisissez Event > MIDI > Change Duration. 

3  

 

Sélectionnez l'option Scale By avec la valeur 
en pourcentage de 50.

 

4  

 

Cliquez sur Apply. La durée des notes 
sélectionnées est réduite de 50 %.

Avec cette option, il se peut que vous deviez 
essayer plusieurs valeurs de pourcentage avant 
d'obtenir l'effet recherché.

 

Pour donner plus de legato aux notes :

 

1  

 

Sélectionnez la région de notes MIDI à éditer.

 

2  

 

Choisissez Event > MIDI > Change Duration.

 

3  

 

Sélectionnez l'option Legato.

 

4  

 

Dans le menu déroulant Legato, sélectionnez 
Overlap.

 

5  

 

Entrez 0|000 comme valeur de 
chevauchement.

 

6  

 

Cliquez sur Apply. 

Les points de fin des notes sélectionnées sont 
étendus jusqu'au point de début de la note 
suivante, ce qui élimine l'espace entre chaque 
note.

 

Transpose

 

Alors que les outils d'accrochage servent à 
transposer manuellement plutôt des notes MIDI 
individuelles ou de petits groupes de notes, la 
commande Transpose peut s'utiliser sur des 
pistes et des régions MIDI entières. L'une des 
utilisations les plus courantes de la commande 
Transpose est le changement de tonalité de vos 
pistes MIDI. Vous pouvez définir un groupe de 
pistes MIDI devant être transposées, en veillant 
à exclure les pistes de batterie du groupe (les 
transposer changerait les sons de batterie).

 
Vous pouvez également transposer des 
notes MIDI en temps réel, de manière non 
destructive, à l'aide des propriétés MIDI en 
temps réel. Pour plus d'informations, 
reportez-vous à la section Propriétés MIDI 
en temps réel, page 549.
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Pour ouvrir la page Transpose :

 

■

 

Choisissez Event > MIDI > Transpose. 

 

Transpose By (Octaves) : 

 

transpose les notes 
MIDI sélectionnées de +/– 10 octaves.

 

Transpose By (Semitones) : 

 

effectue une 
transposition chromatique vers le haut ou vers 
le bas, jusqu'à +/–127 demi-tons.

 Transpose (From et To) :  cette option de 
transposition, par demi-tons, se base sur la 
hauteur d'origine et la hauteur désirée. Ainsi, la 
transposition de C3 à F#3 transpose les notes 
vers le haut de six demi-tons (ou trois tons).

 

Transpose All Notes To : 

 

transpose toutes les 
notes sélectionnées à la même hauteur. Servez-
vous du curseur ou de la zone de saisie des 
chiffres pour spécifier la hauteur à laquelle vous 
souhaitez transposer toutes les notes 
sélectionnées.

 

Pour transposer des notes MIDI dans une autre 
tonalité :

 

1  

 

Si vous envisagez de transposer un groupe de 
pistes, veillez à activer le groupe d'édition.

 

2  

 

A l'aide du sélecteur ou d'un outil 
d'accrochage, sélectionnez la plage de notes 
MIDI que vous voulez transposer.

 

3  

 

Choisissez Event > MIDI > Transpose.

 

4  

 

Sélectionnez l'option Transpose (From et To).

 

5  

 

Entrez les valeurs From et To, par exemple C4 
et E4 pour transposer de do en mi.

Si l'un les champs de hauteur est sélectionné, 
jouer une note sur votre contrôleur MIDI l'entre 
automatiquement comme valeur de hauteur.

 

6  

 

Cliquez sur Apply.

Il est également courant de transposer des pistes 
MIDI vers le haut ou le bas d'une octave.

 

Pour transposer une piste MIDI vers le bas d'une 
octave :

 

1  

 

A l'aide du sélecteur, cliquez deux fois sur la 
piste pour sélectionner toutes les notes.

 
2  

 
Choisissez Event > MIDI > Transpose.

 

3  

 
Sélectionnez l'option Transpose By.

 

4  

 

Entrez la valeur –1 octave.

 

5  

 

Cliquez sur Apply.

 

Appuyez sur Alt+T (Windows) ou sur 
Option+T (Macintosh) pour accéder à la 
page Transpose.

 

Fenêtre MIDI Operations, page Transpose
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Select/Split Notes

 

La fenêtre Select/Split Notes offre un ensemble 
complet d'outils pour sélectionner et répartir des 
notes en fonction d'une multitude de critères. 
Vous disposez d'outils supplémentaires pour 
indiquer si les données sélectionnées sont 
copiées dans le Presse-papiers ou sur de 
nouvelles pistes, spécifier si les données sont 
réparties sur plusieurs nouvelles pistes ou sur 
une seule destination, et effectuer divers autres 
choix. 

 

Pour ouvrir la page Select/Split Notes : 

 

■

 

Choisissez Event > MIDI > Select/Split Notes.

 

Critères spécifiques à la hauteur de note

All Notes : 

 

sélectionne toutes les notes.

 

Notes Between : 

 

sélectionne les notes comprises 
entre les notes supérieure et inférieure 
spécifiées. Vous pouvez entrer les valeurs des 
notes sous forme de hauteur (C1–G8) ou de 
numéro de note MIDI (0–127).

 

Top : 

 

sélectionne la ou les notes les plus hautes 
de chaque accord.

 

Bottom : 

 

sélectionne la ou les notes les plus 
basses de chaque accord.

 

Autres critères

Velocity : 

 

activez l'option Velocity pour définir 
la plage de vélocités utilisée pour sélectionner 
ou répartir des notes. Définissez les valeurs de 
vélocité minimale et maximale souhaitées. 

 

Duration : 

 

activez l'option Duration pour définir 
la plage de durées (en temps et tics) utilisée pour 
sélectionner ou répartir des notes. Définissez les 
valeurs de durée minimale et maximale 
souhaitées.

 
Position : 

 
activez l'option Position pour 

sélectionner ou répartir toutes les notes figurant 
dans la plage de positions relatives (en temps et 
tics) au sein de chaque barre. La valeur minimale 
détermine le début de la plage et la valeur 
maximale la fin de la plage.

 

Action

Select Notes : 

 

sélectionne les notes MIDI en 
fonction des critères spécifiés.

 

Split Notes: The Clipboard : 

 

copie les données 
sélectionnées dans le Presse-papiers 
uniquement.

 

Fenêtre MIDI Operations, page Select/Split Notes
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Split Notes A New Track : copie toutes les 
données sélectionnées sur une seule nouvelle 
piste. Si la sélection inclut plusieurs pistes, le 
même nombre de pistes est créé. Les nouvelles 
pistes correspondent au type de la piste d'origine 
(Instrument ou MIDI). 

Split Notes A New Track per Pitch : copie toutes 
les données sélectionnées sur plusieurs 
nouvelles pistes (à raison d'une nouvelle piste 
pour chaque hauteur de note). Un zoom est 
appliqué aux nouvelles pistes pour permettre 
l'affichage d'une seule note. Si la sélection inclut 
plusieurs pistes, les données de chaque piste 
sont réparties séparément.

Include MIDI Controller Data : intègre toutes les 
données MIDI continues (y compris celles 
relatives au pitchbend et à l'aftertouch) sur la 
piste entière, sans restriction en matière de 
sélection temporelle.

Pour sélectionner et répartir des notes :

1  Choisissez Event > MIDI > Select/Split Notes. 

2  Définissez les critères relatifs à la hauteur de 
note.

3  Spécifiez les autres critères désirés (vélocité, 
durée et position).

4  Activez l'option Select ou Split, selon le cas. 

5  Dans le menu déroulant Split Notes, 
choisissez Copy ou Cut. 

6  Sélectionnez l'emplacement où vous 
souhaitez coller les données copiées ou coupées.

7  Si besoin est, activez l'option Include MIDI 
Controller Data. L'activation de cette option 
permet de prendre en compte toutes les données 
de contrôleur associées aux notes réparties sur 
les nouvelles pistes. Désélectionnez cette option 
si vous souhaitez uniquement répartir les 
données de note sur les nouvelles pistes. 

8  Cliquez sur Apply. 

Les propriétés en temps réel associées à la piste 
ou aux régions sont copiées sur les nouvelles 
pistes créées par la commande Select/Split 
Notes. 

Sélection d'une plage de hauteurs de 
notes

L'option Select/Split Notes est couramment 
utilisée pour sélectionner une seule note sur 
toute la longueur d'une région ou d'une piste. 
Ceci est particulièrement pratique si vous 
souhaitez sélectionner une note d'une piste de 
batterie MIDI (une charley, par exemple), et la 
modifier, sur la plage de temps sélectionnée, 
avec les commandes Quantize, Groove 
Quantize, Transpose ou Change Duration.

Pour ne sélectionner que la charley dans une piste 
de batterie Général MIDI :

1  A l'aide du sélecteur ou d'un outil 
d'accrochage, sélectionnez la plage de notes 
MIDI contenant la note.

2  Choisissez Event > MIDI > Select/Split Notes.

3  Sélectionnez l'option Notes Between, la plage 
de note étant définie entre F#1 et F#1 (si le 
paramètre MIDI Note Display est réglé sur 
Standard Pitch).

Pour les percussions Général MIDI, la charley 
fermée est affectée au numéro de note MIDI 42 
(F#1 sur Standard Pitch). Si la charley de votre 
kit de batterie est affectée à une autre note, 
veillez à l'indiquer.

4  Cliquez sur Apply.
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Sélection de notes dans un accord

L'opération Select/Split Notes sert également à 
ne sélectionner que les notes les plus hautes ou 
les plus basses d'un accord. Vous aurez souvent 
besoin de ne travailler que les notes les plus 
hautes ou les plus basses d'un accord, pour 
augmenter leur vélocité ou transposer leur 
hauteur.

Pour ne sélectionner que les notes les plus basses 
d'un accord :

1  A l'aide du sélecteur ou d'un outil 
d'accrochage, sélectionnez la plage de notes 
MIDI contenant les notes.

– ou –

Pour affecter toutes les notes MIDI d'une piste, 
cliquez sur celle-ci avec le sélecteur. Le curseur 
d'édition se met alors à clignoter.

2  Choisissez Event > MIDI > Select/Split Notes.

3  Sélectionnez l'option Bottom et laissez le 
nombre de notes défini sur 1.

4  Cliquez sur Apply.

Input Quantize
Lorsque l'option Input Quantize est activée, 
toutes les notes MIDI enregistrées sont 
automatiquement quantifiées. Pour préserver le 
feeling original de vos pistes MIDI enregistrées, 
désactivez cette option.

Pour activer la quantisation en entrée :

1  Choisissez Event > MIDI > Input Quantize.

2  Dans la page Input Quantize, sélectionnez 
Enable Input Quantize.

Pour que des notes soient considérées 
comme un accord, leurs temps de début 
doivent se trouver au maximum à trente-
deux tics les uns des autres.

Fenêtre MIDI Operations (page Input Quantize)
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Configurez comme désiré les autres options de 
la page Input Quantize. Pour plus de détails sur 
les différentes options de quantification, 
reportez-vous à la section Grid/Groove 
Quantize, page 525. Lorsque vous avez terminé, 
fermez la fenêtre MIDI Operations.

Pour l'enregistrement en boucle de type boîte à 
rythme, utilisez la quantification d'entrée 
lorsque vous enregistrez en boucle des données 
MIDI en mode Merge (Fusion – voir 
Enregistrement en boucle et mode fusion, 
page 243).

Step Input
L'option Step Input permet d'utiliser un 
contrôleur MIDI pour entrer séparément des 
notes, étape par étape. Vous bénéficiez ainsi du 
contrôle précis de la position, de la durée et de la 
vélocité de la note. Avec MIDI Step Input, vous 
pouvez également créer des passages musicaux 
qui s'avéreraient difficiles à jouer avec 
exactitude ou encore à un tempo rapide. 

Pour entrer des notes MIDI avec Step Input (à 
l'aide d'un périphérique MIDI externe) :

1  Assurez-vous que votre périphérique MIDI 
externe est correctement branché et fonctionne 
avec Pro Tools.

2  Choisissez Event > MIDI > Step Input.

3  Sélectionnez l'option Enable.

4  Sélectionnez la piste MIDI ou la piste 
d'instrument voulue dans la menu déroulant 
Destination.

5  Choisissez la valeur de la note à entrer dans la 
zone Step Increment.

6  Jouez une note ou un accord sur votre 
instrument MIDI. Ceci a pour effet d'entrer la 
note et de passer au point d'insertion suivant.

Fenêtre Step Input

Lorsque l'option Step Input est activée, 
chaque piste MIDI précédemment préparée 
à l'enregistrement quitte le mode de 
préparation à l'enregistrement et si la 
préférence Default Thru Instrument est 
définie, elle est désactivée.
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Pour augmenter la longueur d'une note pendant 
l'utilisation de Step Input :

1  Jouez une note en continu sur votre 
instrument MIDI.

2  Choisissez la valeur de la note que vous voulez 
ajouter et appuyez sur le bouton Increment.

Relâchez la note sur votre clavier MIDI pour 
passer au point d'insertion suivant.

Commandes Step Input

La page Step Input propose les paramètres 
suivants :

Enable : s'ils sont sélectionnés, les événements 
MIDI sont ajoutés à la piste de destination 
lorsque vous jouez sur votre clavier MIDI 
externe. De plus, la piste MIDI précédemment 
préparée à l'enregistrement est désactivée. 

Si un instrument Thru par défaut est défini dans 
la page MIDI Preferences, il est désactivé si 
l'option Step Input est sélectionnée et réactivé si 
Step Input n'est plus désactivée.

Destination : permet de sélectionner la piste de 
destination de la phase Step Input à partir d'une 
liste déroulante de toutes les pistes MIDI dans 
votre session. 

Step Increment

les options de la zone Step Increment 
permettent de définir l'espacement et la durée 
des événements MIDI entrés à l'aide de 
l'opération Step Input. Vous pouvez 
sélectionner n'importe quelle valeur de note, de 
la ronde à la quadruple croche (valeurs pointées 
comprises). 

Tuplet : permet d'entrer des groupes de notes 
« inhabituels », tels que les triolets ou 
quintolets. La longueur du tuplet est calculée à 
partir de la sélection de l'espacement de note et 
de la valeur Tuplet. Si, par exemple, une croche 
équivaut à 480 tics, des croches en triolet (3 
pour 2) donnent un espace de note de 320 tics 
(480 tics / 3 * 2).

Note Length : cette option permet de 
sélectionner la longueur de la note sous forme 
d'un pourcentage de la valeur d'espacement. Si, 
par exemple, une croche équivaut à 480 tics, 
une croche dont la durée atteint 80% 
correspond à une longueur de 384 tics.

Options

Use Input Velocity : lorsque cette option est 
sélectionnée, les notes MIDI sont enregistrées à 
la vitesse où vous les jouez sur votre clavier 
MIDI.

Set Velocity To : les notes MIDI sont enregistrées 
à la vitesse indiquée dans le champ Velocity. 
Vous définissez cette valeur au moyen du 
curseur.

Enable Numeric Keypad Shortcuts : cette option 
permet de sélectionner les options Step Input à 
partir du pavé numérique. Reportez-vous à la 
section Raccourcis du pavé numérique, 
page 549.

Lorsqu'une note est ainsi jouée sur le clavier 
MIDI, l'option Next Step affiche Increment. 

Pourcentages de longueur de note

100% 80% 120%
Chapitre 23 : Opérations MIDI 547



548
Undo Step, Next Step et Redo Step

Servez-vous des boutons Undo Step et Next Step 
pour procéder aux opérations suivantes :

• Déplacer le point d'insertion suivant, soit 
en supprimant la note précédente, soit en 
avançant le point d'insertion à la valeur 
Step Increment.

• Allonger et raccourcir les notes qui sont 
jouées sur le contrôleur MIDI en ajoutant 
ou en supprimant des valeurs Step 
Increment. La valeur Step Increment peut 
être modifiée à mi-note pour créer une note 
avec une longueur de note hybride.

Utilisez le bouton Redo Step pour recommencer 
la séquence des opérations précédemment 
annulées. 

Undo Step : lorsque la note précédente est émise 
du clavier MIDI et que le point d'insertion se 
déplace à la note suivante, Undo Step supprime 
intégralement la dernière note.

Lorsqu'une note est jouée, Undo Step affiche 
alors Decrement et supprime la dernière valeur 
Step Increment ajoutée à la note actuellement 
jouée.

Next Step (ou Increment) : si aucune note n'est 
jouée au clavier MIDI, Next Step passe au point 
d'insertion correspondant à la valeur Step 
Increment et insére une pause musicale.

Lorsqu'une note est jouée au clavier MIDI, Next 
Step affiche alors Increment et ajoute la valeur 
Step Increment à la note jouée, ce qui l'allonge 
d'autant. 

Tandis que la note est jouée, la valeur Step 
Increment peut être modifiée, vous permettant 
de créer des notes de toute longueur.

Redo Step : réinsère la dernière note supprimée 
à l'aide de l'opération Undo Step. 

Les boutons Undo Step, Next Step et Redo Step 
peuvent être définis de manière à être 
déclenchés par un synthétiseur MIDI externe, 
une boîte à rythme ou tout autre contrôleur. 

Pour définir les événements déclencheurs MIDI 
Undo Step, Next Step et Redo Step :

1  Choisissez Event > MIDI > Step Input.

2  Recherchez le bouton que vous voulez affecter 
à un événement MIDI et cliquez dans le champ 
situé sous ce bouton.

3  Jouez l'événement MIDI à utiliser comme 
signal de déclenchement. 

4  Appuyez sur Entrée pour confirmer 
l'affectation du déclencheur MIDI.

Sélection du champ Next Step

Si un contrôleur continu tel que Pitch Bend 
fait office d'événement déclencheur, vous 
devez vous assurer que vous utilisez la 
valeur extrème de contrôleur afin d'éviter 
toute entrée de données incorrecte.

Champ Next Step déclenché par une variation de 
hauteur
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Raccourcis du pavé numérique

Lorsque l'option Enable Numeric Keypad 
Shortcuts est activée, vous pouvez choisir de 
nombreuses commandes dans la page Step 
Input, ainsi que plusieurs commandes de 
sélection. 

Propriétés MIDI en temps réel
Les propriétés MIDI en temps réel permettent de 
changer certaines propriétés MIDI dans les 
pistes MIDI et d'instrument (ou les régions 
MIDI) au cours de la lecture. Il existe cinq types 
de propriétés MIDI en temps réel : Quantize 
(quantification), Duration (durée), Delay 
(retard), Velocity (vélocité) et Transpose 
(transposition). 

Il est possible d'ajuster les propriétés MIDI en 
temps réel en cours de lecture, lorsque vous 
vérifiez si vous obtenez le résultat escompté. 
Une fois les paramètres désirés identifiés, vous 
pouvez les enregistrer sur les pistes ou régions 
sélectionnées. Cela a pour effet de remplacer les 
propriétés MIDI correspondantes sur les pistes 
ou régions sélectionnées et de réinitialiser 
l'affichage des propriétés en temps réel.

Les propriétés en temps réel peuvent être 
redéfinies à partir de la vue des propriétés en 
temps réel dans la fenêtre Edit ou à partir de la 
fenêtre Real-Time Properties.

Vue des propriétés en temps réel

La vuedes propriétés en temps réel dans la 
fenêtre Edit concerne uniquement les pistes. 
Pour appliquer les propriétés en temps réel aux 
régions, utilisez la fenêtre Real-Time Properties 
(voir Fenêtre Real-Time Properties, page 550).

Raccourcis Step Input Touche

Ronde 1

1/2 note 2

1/4 note 4

1/8 note 5

1/16 note 6

1/32 note 7

1/64 note 8

Note pointée . (point décimal)

Activer/désactiver les tuplets 3

Etape suivante Entrée

Annuler l'étape 0

Avancer la sélection par 
incrément

+

Reculer par incrément la 
sélection

–

Sélectionner le compteur 
principal

=

Modifier les indicateurs de 
sélection

/
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Pour activer la vue des propriétés en temps réel 
dans la fenêtre Edit :

■ Choisissez View > Edit Window > Real-Time 
Properties. 

Pour les hauteurs des mini-pistes ou des petites 
pistes, la colonne des propriétés en temps réel 
contient une ou deux propriétés, 
respectivement. Par défaut, la première ou les 
deux propriétés activées sont affichées 
automatiquement.

Pour sélectionner une autre propriété en temps 
réel dans la vue d'une mini-piste ou d'une petite 
piste :

■ Maintenez enfoncées les touches Ctrl 
(Windows) ou Pomme (Macintosh) et cliquez 
sur une propriété en temps réel pour choisir un 
autre élément d'information dans le menu 
déroulant.

Fenêtre Real-Time Properties

Cette fenêtre permet d'appliquer des propriétés 
en temps réel aux pistes ou régions 
sélectionnées.

Pour ouvrir la fenêtre Real-Time Properties :

■ Choisissez Event > MIDI Real-Time Properties. 

La fenêtre Real-Time Properties peut servir à 
appliquer des propriétés en temps réel basées sur 
les pistes ou sur les régions. Il suffit, pour cela, 
d'effectuer une sélection de temps ou d'édition 
et de choisir les pistes ou les régions qui vous 
intéressent à partir du menu déroulant 
Apply To.

Colonne des propriétés en temps réel dans la 
fenêtre Edit

Fenêtre Real-Time Properties avec les propriétés 
activées
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Fenêtre Real-Time Properties avec une vue 
développée

Dans la fenêtre Real-Time Properties, les 
boutons Quantize, Duration et Velocity sont 
tous associés à un triangle Développer/Réduire 
prévu pour afficher ou masquer des paramètres 
supplémentaires. 

Activation des propriétés en temps réel

Pour activer les propriétés en temps réel :

1  Sélectionnez une piste ou effectuez une 
sélection de temps ou d'édition.

2  Dans la vue des propriétés en temps réel de la 
fenêtre Edit ou dans la fenêtre Real-Time 
Properties, sélectionnez les propriétés en temps 
réel voulues en cliquant sur le nom de la 
propriété (Quantize, Duration, Delay, Velocity 
ou Transpose). Les propriétés en temps réel 
activées sont mises en surbrillance et affichent 
leurs paramètres.

3  Si vous travaillez en mode Link Track and Edit 
Selection à partir de la fenêtre Real-Time 
Properties, sélectionnez la piste ou la région 
voulue dans le menu déroulant Apply To.

4  Définissez les paramètres qui conviennent.

Les propriétés en temps réel activées seront 
audibles lors de la lecture et seront appliquées 
aux pistes et régions sélectionnées.

Paramètres des propriétés en 
temps réel

Quantize

L'option de quantification peut être basée sur 
une grille ou un modèle groove. Dans le premier 
cas, vous disposez de paramètres 
supplémentaires de triolet et de décalage de 
grille, en plus des propriétés de quantification 
MIDI standard. Dans le deuxième cas, des 
commandes supplémentaires sont prévues pour 
définir les limites d'application de la durée et des 
vélocités du groove. Pour l'un comme pour 
l'autre, il est possible de définir trois valeurs 
importantes (Strength, Include et Randomize).

Fenêtre Real-Time Properties, vue développée

Lorsque vous utilisez les propriétés en temps 
réel, activez le mode Link Track and Edit 
Selection pour sélectionner une piste à partir 
d'une sélection d'édition. Pour plus 
d'informations, reportez-vous à la section 
Activation ou désactivation de la liaison 
des sélections d'édition et de piste, 
page 333.

Triangles
Développer/
Réduire
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Menu déroulant Quantize : sélectionnez la valeur 
de quantification désirée. Toutes les valeurs 
rythmiques de note standard de la ronde à la 
quadruple croche, valeurs pointées ou triolets 
compris, sont autorisées. Ce menu déroulant 
donne également accès à tous les grooves 
standard et personnalisés.

Swing : entrez le niveau de swing souhaité sous 
forme d'une valeur en pourcentage comprise 
entre 0 et 300%. 

Tuplet : activez l'option Tuplet et entrez le 
rapport voulu pour le triolet (1 à 99) : 3 pour 2 
ou 5 pour 4, par exemple. Cette option est 
accessible uniquement dans la vue développée 
de la fenêtre Real-Time Properties.

Offset : activez l'option Offset et entrez la valeur 
de décalage voulue en tics (de –2000 à 2000). 
Cette option est accessible uniquement dans la 
vue développée de la fenêtre Real-Time 
Properties.

Strength : activez l'option Strength et indiquez 
la quantité souhaitée sous forme d'une valeur en 
pourcentage comprise entre 0 et 100%. Cette 
option est accessible uniquement dans la vue 
développée de la fenêtre Real-Time Properties.

Include : activez l'option Include et définissez 
une plage de valeurs comprise entre 0 et 100%. 
Cette option est accessible uniquement dans la 
vue développée de la fenêtre Real-Time 
Properties.

Random : activez l'option Random et entrez une 
valeur en pourcentage comprise entre 0 
et 100%. Cette option est accessible 
uniquement dans la vue développée de la 
fenêtre Real-Time Properties.

Duration

Cette option peut servir à augmenter ou réduire 
la durée des notes MIDI en fonction d'une 
valeur fixe ou d'un pourcentage. Cela est parfois 
très utile pour créer des effets de legato ou de 
staccato.

Menu déroulant du mode Duration

Sélectionnez l'une des options suivantes à partir 
du menu déroulant du mode Duration : Set, 
Add, Subtract, Scale, Legato/Gap ou 
Legato/Overlap.

Set : sélectionnez cette option pour définir des 
notes de la durée spécifiée.

Add : sélectionnez cette option pour ajouter la 
durée spécifiée à la durée actuelle de chaque 
note.

Sélection d'une valeur de quantification par grille ou 
d'un modèle groove

Sélection d'un mode Duration
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Subtract : sélectionnez cette option pour 
soustraire la durée spécifiée de la durée actuelle 
de chaque note.

Scale : sélectionnez cette option pour multiplier 
la durée actuelle de chaque note par une valeur 
en pourcentage comprise entre 1 et 400%.

Legato/Gap : sélectionnez cette option pour 
prolonger chaque note jusqu'à la note suivante. 
La durée spécifiée est soustraite pour produire 
un espace cohérent entre les notes.

Legato/Overlap : sélectionnez cette option pour 
prolonger chaque note jusqu'à la note suivante. 
La durée spécifiée est ensuite ajoutée pour 
obtenir une valeur de chevauchement 
cohérente.

Duration Amount

Si l'option choisie pour le menu déroulant Ticks 
ou Notes est exprimée en tics, entrez une durée 
sous la forme d'une noire et d'un nombre de tics 
(4|000, par exemple). Si l'option choisie pour le 
menu déroulant Ticks ou Notes est exprimée 
sous forme d'une valeur de note, entrez le 
multiplicateur approprié (7/16 de notes, par 
exemple).

Menus déroulants Ticks ou Notes

Vous pouvez exprimer la durée des notes sous 
forme de tics ou d'une valeur de note. Vous 
disposez également d'un menu déroulant Ticks 
ou Notes pour les valeurs maximale et minimale 
de durée (Duration).

Valeurs Min et Max de durée

Activez au choix l'une ou les deux valeurs (durée 
minimale et durée maximale) et entrez une 
valeur sous la forme d'une noire et d'un nombre 
de tics ou d'un multiple d'une valeur de note. 
Ces options sont disponibles uniquement dans 
la vue développée de la fenêtre Real-Time 
Properties.

Delay

Cette option permet de retarder ou d'avancer 
toutes les données MIDI d »ans la région ou la 
piste sélectionnée. Choisissez « + » dans le menu 
déroulant Delay pour retarder les données MIDI 
ou « – » pour les avancer. Indiquez l'unité 
voulue (Ticks ou Milliseconds) dans le menu 
déroulant correspondant. Spécifiez la valeur du 
retard en tics ou en millisecondes. Cette valeur 
ne doit pas dépasser 2000 ms ou 999 tics.

Velocity

Cette option permet de changer la vélocité MIDI 
selon un pourcentage ou une valeur constante. 
Entrez une valeur en pourcentage dans le champ 
Dynamics pour multiplier la vélocité aux 
alentours de 64. Vous pouvez également 
spécifier un décalage en ajoutant (+) ou 
retranchant (–) des valeurs comprises 
entre 1 et 127. Il est possible, en outre, de fixer 
des limites minimum et maximum de vélocité. 
Ces options sont disponibles uniquement dans 
la vue développée de la fenêtre Real-Time 
Properties.

La vélocité peut être appliquée en tant que 
propriété en temps réel à MIDI Input et MIDI 
Thru.
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Transpose

Cette option permet de transposer des notes 
MIDI vers le haut ou vers le bas du nombre 
d'octaves et de demi-tons spécifié. Il est possible 
également d'effectuer une transposition en 
fonction d'une hauteur de note donnée. 
Sélectionnez By ou To dans le menu déroulant 
Transpose pour choisir un intervalle ou une 
hauteur de note. Dans le premier cas, entrez le 
nombre d'octaves et de demi-tons désiré sous 
forme de valeurs positives ou négatives. Dans le 
deuxième cas, entrez la note MIDI voulue.

La transposition peut être appliquée en tant que 
propriété en temps réel à MIDI Input et MIDI 
Thru.

Propriétés en temps réel sur les 
pistes et les régions

Les propriétés en temps réel peuvent être 
configurées en vue d'être appliquées à une piste 
entière (c'est-à-dire à toutes les régions de cette 
piste), ou région par région. Les propriétés au 
niveau des pistes permettent, en outre, un 
traitement des entrées MIDI en temps réel de la 
vélocité et de la transposition.

La présence de propriétés en temps réel basées 
sur des pistes est signalée par un T affiché dans 
le coin supérieur droit des pistes MIDI. Les 
propriétés en temps réel basées sur des régions 
sont désignées par un R affiché dans le coin 
supérieur droit de la région. Les limites d'une 
région sont indiquées dans la vue Notes.

Propriétés en temps réel basées sur 
des régions

Les propriétés en temps réel basées sur des 
régions peuvent être définies uniquement au 
moyen de la fenêtre Real-Time Properties 
(Event > MIDI Real-Time Properties). Il est 
possible de les appliquer à plusieurs régions. 
Après avoir attribué des propriétés en temps réel 
à une région, rien ne vous empêche de déplacer 
ou copier et coller la région. Celle-ci conservera 
ses propriétés.

Propriétés en temps réel basées sur 
des pistes

Ces propriétés s'appliquent aux séquences MIDI 
de la piste entière. Toutefois, les régions 
possédant leurs propres propriétés en temps réel 
ont priorité sur les propriétés en temps réel 
basées sur des pistes. Vous pouvez réinitialiser 
les propriétés en temps réel basées sur des 
régions en sélectionnant la région et en cliquant 
sur le bouton Clear Region Properties dans la 
fenêtre Real-Time Properties (voir Ecriture des 
propriétés en temps réel sur les pistes ou les 
régions, page 555).

Indicateurs des propriétés en temps réel basées sur 
des régions et sur des pistes

Signale des
propriétés en temps

réel basées sur des pistes

Signale des
propriétés en temps

réel basées sur des régions
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Pour utiliser les propriétés en temps réel avec un 
maximum de souplesse, chaque fois que des 
propriétés en temps réel sont attribuées par 
piste, elles sont regroupées dans une playlist de 
piste. Vous pouvez ainsi établir plusieurs 
playlists composées de différents paramètres de 
propriétés en temps réel.

Ecriture des propriétés en temps 
réel sur les pistes ou les régions

Lorsque vous êtes satisfait des paramètres, vous 
pouvez écrire les propriétés en temps réel sur les 
pistes ou régions sélectionnées au moyen de la 
fenêtre Real-Time Properties. Les propriétés en 
temps réel sont appliquées aux données MIDI 
actuelles de la piste ou d'une région.

Pour écrire des propriétés en temps réel sur des 
pistes :

1  Sélectionnez la ou les pistes auxquelles vous 
souhaitez appliquer des propriétés en temps 
réel.

2  Ouvrez la fenêtre Real-Time Properties 
(Event > MIDI Real-Time Properties).

3  Si le mode Link Track and Edit Selection est 
activé, sélectionnez Tracks dans le menu 
déroulant Real-Time Properties Apply To.

4  Définissez les paramètres qui conviennent.

5  Effectuez l'une des opérations suivantes :

• Cliquez sur le bouton Write to Track dans la 
fenêtre Real-Time Properties.

– ou –

• Choisissez Track > Write MIDI Real-Time 
Properties.

Pour écrire des propriétés en temps réel sur des 
régions :

1  Sélectionnez la ou les régions auxquelles vous 
souhaitez appliquer des propriétés en temps 
réel.

2  Ouvrez la fenêtre Real-Time Properties 
(Event > MIDI Real-Time Properties).

3  Si le mode Link Track and Edit Selection est 
activé, sélectionnez Regions dans le menu 
déroulant Real-Time Properties Apply To.

4  Définissez les paramètres qui conviennent.

5  Cliquez sur le bouton Write to Region.

Pour réinitialiser les propriétés en temps réel 
d'une région :

1  Sélectionnez la région pour laquelle vous 
souhaitez réinitialiser les propriétés en temps 
réel.

2  Ouvrez la fenêtre Real-Time Properties 
(Event > MIDI Real-Time Properties).

3  Choisissez Regions dans le menu déroulant 
Real-Time Properties Apply To.

4  Cliquez sur le bouton Clear Region Properties.
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Propriétés en temps réel dans la 
liste des événements MIDI

Dans la liste des événements MIDI, la présence 
de propriétés en temps réel basées sur des pistes 
est signalée par un T affiché à droite de chaque 
événement. Les propriétés en temps réel basées 
sur des régions sont signalées par un R.

Affichage des effets des 
propriétés en temps réel

L'option Display Events as Modified by Real-
Time Properties détermine si Pro Tools affiche 
les effets des propriétés en temps réel à la fois 
dans la fenêtre Edit et dans la liste des 
événements MIDI. Pour ce faire, vous devez 
activer cette option. Lorsque cette option est 
désactivée, les effets des propriétés en temps réel 
sont audibles, mais pas visibles. Vous ne pouvez 
pas voir les notes et les autres événements MIDI 
en fonction de leur emplacement, de leur 
hauteur, de leur durée ou de leur vélocité 
d'origine, mais vous avez la possibilité 
d'entendre le résultat obtenu après application 
des paramètres des propriétés en temps réel. 

Pour activer ou désactiver l'option Display Events 
as Modified by Real-Time Properties :

1  Choisissez Setup > Preferences.

2  Cliquez sur l'onglet MIDI.

3  Activez ou désactivez l'option Display Events 
as Modified by Real-Time Properties.

4  Cliquez sur Done.

Propriétés en temps réel basées sur des pistes et des 
régions signalées dans la liste des événements MIDI

Pour plus d'informations sur la liste des 
événements MIDI, reportez-vous au 
Chapitre 24, Liste des événements MIDI.

Colonne piste/région

Préférence Display Events as Modified by Real-Time 
Properties
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Effets des propriétés en temps réel 
affichés dans la liste des événements 
MIDI

La liste des événements MIDI prend en compte 
les effets des propriétés en temps réel à 
condition d'avoir activé l'option Display Events 
as Modified by Real-Time Properties. Lorsque 
vous modifiez ou insérez un événement dans 
une piste ou une région possédant des 
propriétés en temps réel actives, Pro Tools tient 
compte des propriétés et modifie ou insère 
l'événement à un autre endroit, si nécessaire, 
pour refléter les effets des propriétés en temps 
réel.

Effets des propriétés en temps réel 
affichés dans la fenêtre Edit

Si l'option Display Events as Modified by Real-
Time Properties est activée dans la fenêtre Edit, 
les événements MIDI apparaissent à l'endroit où 
ils sont émis. Ils ne seront, cependant, 
enregistrés aux nouveaux endroits choisis que 
lorsque vous écrirez les propriétés en temps réel 
sur la piste ou la région.

Lorsque vous faites glisser des événements 
MIDI, les emplacements réels (hauteur ou 
temps) sont décalés en fonction de la longueur 
du déplacement des événements, mais l'effet des 
propriétés en temps réel est affiché.

Lorsque vous insérez un événement dans une 
piste ou une région possédant des propriétés en 
temps réel actives, Pro Tools tient compte des 
propriétés et modifie ou insère l'événement à un 
autre endroit, si nécessaire, pour refléter les 
effets des propriétés en temps réel.
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Chapitre 24 : Liste des événements 
MIDI

Liste des événements MIDI
La liste des événements MIDI répertorie de 
façon détaillée tous les événements d'une piste 
MIDI ou d'une piste d'instrument. Ceux-ci 
apparaissent sous forme de texte et de nombres, 
ce qui permet d'éditer précisément leur 
emplacement, leur longueur et leurs valeurs.

Les événements de la liste des événements MIDI 
peuvent être copiés et collés, sélectionnés ou 
supprimés. Tout événement MIDI (exception 
faite des événements Sysex) peut être inséré et 
édité dans la liste. Certains types d'événements 
MIDI peuvent être masqués à l'aide du filtre 
d'affichage.

Ouverture de la liste des 
événements MIDI

Pour ouvrir la liste des événements MIDI, 
effectuez l'une des opérations suivantes :

■ Choisissez Event > MIDI Event List.

■ Maintenez la touche Contrôle (Macintosh) ou 
Démarrer (Windows) enfoncée pendant que 
vous cliquez deux fois sur le nom d'une piste 
MIDI ou d'instrument dans la fenêtre Edit 
ou Mix.

Liste des événements MIDI

Sélecteur de piste

Menu Options

Menu Insert

Contrairement aux playlists de la fenêtre 
Edit, vous pouvez insérer et afficher les 
données d'aftertouch polyphonique dans la 
liste des événements MIDI.

Les données de coupure du son des pistes 
MIDI et des pistes d'instrument 
n'apparaissent pas dans la liste des 
événements MIDI.
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■ Appuyez sur Option + signe égal (Macintosh) 
ou sur Alt + signe égal (Windows).

Menus de la liste des événements MIDI

Trois menus déroulants apparaissent en haut de 
la liste des événements MIDI :

Sélecteur de piste : indique la piste MIDI ou 
d'instrument affichée et permet d'en choisir une 
autre.

Menu Options : contient les commandes et 
options de la liste des événements MIDI (voir 
Options de la liste des événements MIDI, 
page 568).

Menu Insert : contient la liste des types 
d'événements que vous pouvez insérer.

A droite de ces menus déroulants se trouve le 
nombre des événements affichés.

Colonnes de la liste des événements 
MIDI

Les informations relatives aux événements de la 
liste des événements MIDI sont affichées dans 
les trois colonnes suivantes :

Colonne Start : affiche l'emplacement de début, 
selon l'échelle temporelle principale, de chaque 
événement. Les emplacements peuvent aussi 
être affichés dans l'échelle temporelle 
secondaire si l'option Show Sub Counter est 
sélectionnée dans le menu déroulant Options.

Le curseur de lecture apparaît sous forme de 
flèche bleue (rouge lorsque les pistes sont 
activées en enregistrement) dans la colonne 
Start.

Lorsque plusieurs événements se trouvent au 
même emplacement, celui-ci n'est indiqué que 
pour l'événement du haut, les autres étant 
estompés. Vous pouvez éditer ces derniers en 
cliquant deux fois dessus.

Colonne Event : affiche le type d'événement, 
indiqué par une icône, ainsi que les valeurs qui y 
sont associées.

Colonne Length/Info : affiche le point de fin ou 
la durée des notes en fonction de l'option 
sélectionnée dans le menu déroulant Options. 
Sont également affichés les noms des 
événements de contrôleur continu et les 
changements de programme.

La combinaison de touches Option + signe 
égal (Macintosh) ou Alt + signe égal 
(Windows) permet de passer de la liste des 
événements MIDI à la fenêtre Edit et 
réciproquement.

Colonnes de la liste des événements MIDI

Cliquer deux 
fois pour éditer

Evénements 
MIDI simultanés

Curseur de 
lecture
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Filtre d'affichage pour la liste des 
événements MIDI

Vous pouvez utiliser le filtre d'affichage pour 
spécifier les types d'événements à faire 
apparaître dans la liste des événements MIDI. 
Ceci vous aide à n'atteindre que les événements 
sur lesquels vous voulez intervenir et protège les 
autres événements MIDI des opérations 
d'édition et de suppression. Les événements 
n'apparaissant pas dans la liste des événements 
MIDI sont néanmoins lus.

Le filtre d'affichage peut être réglé pour afficher 
tous les messages (All), seulement les messages 
spécifiés (Only), ou tous les messages sauf ceux-
ci (All except).

Par exemple, pour filtrer les messages Aftertouch 
et System Exclusive dans la liste des événements 
MIDI :

1  Dans la liste des événements MIDI, allez dans 
le menu déroulant Options et sélectionnez View 
Filter.

2  Dans la boîte de dialogue MIDI Event List 
View Filter, sélectionnez l'option All Except.

3  Sélectionnez les options Mono Aftertouch, 
Polyphonic Aftertouch et System Exclusive. 
Ne cochez pas les autres cases d'option.

Lorsque vous utilisez l'option All Except, les 
événements sélectionnés ne sont pas affichés. 
Inversement, lorsque vous utilisez l'option 
Only, seuls les événements sélectionnés sont 
affichés.

4  Cliquez sur OK.

Lorsque vous insérez un type d'événement 
qui a été filtré à partir de la liste des 
événements MIDI, il ne peut plus être filtré.

Boîte de dialogue MIDI Event List View Filter
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Navigation dans la liste des 
événements MIDI

La touche de tabulation et les touches fléchées 
permettent de naviguer dans la liste des 
événements MIDI. Vous pouvez également 
repérer le point de début de l'édition ou tout 
autre emplacement spécifié.

Pour vous déplacer à l'intérieur de la liste des 
événements MIDI, effectuez l'une des opérations 
suivantes :

• Cliquez deux fois pour passer en mode 
édition.

• Appuyez sur la touche de tabulation ou la 
flèche vers le bas pour vous placer sur 
l'événement suivant (après avoir sélectionné 
ou pas le champ d'édition).

• Appuyez sur Option + Tab (Macintosh) ou sur 
Ctrl + Tab (Windows) pour déplacer le curseur 
vers l'événement précédent (après avoir 
sélectionné ou pas le champ d'édition) :

• Si vous avez sélectionné un champ d'édition, 
appuyez sur la flèche vers le droite pour vous 
placer sur le champ d'édition situé à droite.

• Appuyez sur la flèche vers le gauche pour vous 
placer sur le champ d'édition situé à gauche.

Pour conserver le dernier événement 
sélectionné, maintenez la Maj enfoncée 
pendant que vous vous placez sur l'événement 
suivant ou précédent.

Pour vous placer sur le point de début de l'édition :

■ Dans la liste des événements MIDI, choisissez 
Scroll To Edit Selection dans le menu déroulant 
Options.

Pour vous placer sur un emplacement spécifique 
de la liste des événements MIDI :

1  Dans la liste des événements MIDI, choisissez 
Go To dans le menu déroulant Options.

2  Dans la boîte de dialogue Go To, choisissez le 
format dans le menu déroulant Time Scale.

Si vous utilisez le timecode (Pro Tools HD et 
Pro Tools LE avec DV Toolkit uniquement), vous 
pouvez sélectionner l'option Use Subframes.

3  Entrez l'emplacement où vous voulez vous 
placer et cliquez sur OK.

Les éléments suivants du menu Options ont une 
incidence sur la navigation dans la liste des 
événements MIDI :

• Lorsque l'option Page Scroll During 
Playback est sélectionnée, la liste des 
événements MIDI défile pendant la lecture.

• Lorsque l'option Scroll During Edit 
Selection est sélectionnée, la liste des 
événements MIDI défile automatiquement 
lorsque la sélection d'édition change dans 
la fenêtre Edit.

Boîte de dialogue Go To
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Insertion d'événements dans 
la liste des événements MIDI

Vous pouvez insérer des événements dans la 
liste des événements MIDI en choisissant un 
type d'événement dans le menu Insert. Vous 
trouverez ci-après plusieurs exemples 
d'insertion d'événements dans la liste des 
événements MIDI.

Pour insérer une note dans la liste des 
événements MIDI :

1  Cliquez sur le bouton Insert et choisissez Note 
dans le menu déroulant.

– ou –

Appuyez sur Ctrl + N (Windows) ou sur 
Pomme + N (Macintosh).

2  Entrez l'emplacement, la hauteur, les vélocités 
d'attaque et de relâchement, ainsi que la durée 
de la nouvelle note. Pour naviguer d'un champ à 
l'autre, utilisez les flèches vers la gauche et vers 
la droite. 

Lorsqu'un champ est sélectionné, entrez une 
valeur en effectuant l'une des opérations 
suivantes :

• Entrez la valeur sur le pavé numérique.

• Appuyez sur la flèche vers le haut ou vers le 
bas pour faire défiler la valeur.

• Jouez la note sur votre contrôleur MIDI 
puis appuyez sur la touche Retour 
(Macintosh) ou Entrée (Windows) du 
clavier alphanumérique pour valider la 
valeur.

3  Pour insérer la note et rester en mode de saisie 
d'événement, appuyez sur la touche Entrée du 
pavé numérique.

– ou –

Pour insérer la note et quitter le mode de saisie 
d'événement, appuyez sur la touche Retour 
(Macintosh) ou Entrée (Windows) du clavier 
alphanumérique.

– ou –

Pour quitter le mode de saisie d'événement sans 
insérer l'événement de note, appuyez sur la 
touche Echap du clavier alphanumérique.

Menu Insert de la liste des événements MIDI

Champs de saisie des événements pour une note

Une fois le champ Start sélectionné, vous 
pouvez entrer automatiquement 
l'emplacement d'un autre événement 
présent sur la piste en cliquant dessus.

Pitch

Vélocité d'attaque

Vélocité de relâchement
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Pour insérer un événement de contrôleur dans la 
liste des événements  MIDI :

1  Cliquez sur le bouton Insert et choisissez 
Controller dans le menu déroulant.

– ou –

Appuyez sur Ctrl + L (Windows) ou sur 
Pomme + L (Macintosh).

2  Tapez l'emplacement, le numéro du type de 
contrôleur et la valeur de contrôleur du nouvel 
événement. Le nom du contrôleur est affiché 
dans la colonne length/info, à droite de la valeur 
du contrôleur. Pour naviguer d'un champ à 
l'autre, utilisez les flèches vers la gauche et vers 
la droite.

Lorsqu'un champ est sélectionné, entrez une 
valeur en effectuant l'une des opérations 
suivantes :

• Entrez la valeur sur le pavé numérique.

• Appuyez sur la flèche vers le haut ou vers le 
bas pour faire défiler la valeur.

• Maintenez la touche Pomme (Macintosh) 
ou Ctrl (Windows) enfoncée pendant que 
vous vous déplacez vers le haut ou le bas 
pour faire défiler la valeur.

• Jouez l'événement de contrôleur sur votre 
contrôleur MIDI et appuyez sur la touche 
Retour (Macintosh) ou Entrée (Windows) 
du clavier alphanumérique pour valider la 
valeur.

3  Effectuez l'une des opérations suivantes :

• Pour insérer l'événement de contrôleur et 
rester en mode de saisie d'événement, 
appuyez sur la touche Entrée du pavé 
numérique.

• Pour insérer l'événement de contrôleur et 
quitter le mode de saisie d'événement, 
appuyez sur la touche Retour du clavier 
alphanumérique.

• Pour quitter le mode de saisie d'événement 
sans insérer d'événement de contrôleur, 
appuyez sur la touche Echap du clavier 
alphanumérique.

Pour insérer un changement de programme dans 
la liste des événements  MIDI :

1  Cliquez sur le bouton Insert et choisissez 
Program Change dans le menu déroulant.

– ou –

Appuyez sur Ctrl + N (Windows) ou sur 
Pomme + N (Macintosh).

2  Entrez l'emplacement du nouvel événement.

3  Entrez un numéro de changement de 
programme et une valeur de sélection de banque 
(le cas échéant). Le nom du changement de 
programme apparaît dans la colonne 
length/info.

Champs de saisie des événements pour un événement 
de contrôleur

Numéro du contrôleur Nom du contrôleur

Valeur du contrôleur

Une fois le champ Start sélectionné, vous 
pouvez entrer automatiquement 
l'emplacement d'un autre événement 
présent sur la piste en cliquant dessus.
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Vous pouvez cliquer dans la colonne Info pour 
ouvrir la fenêtre Program Change (pour plus de 
détails, consultez Sélection de patch 
(changements de programme et de banque), 
page 513). 

4  Effectuez l'une des opérations suivantes :

• Pour insérer le changement de programme 
et rester en mode de saisie d'événement, 
appuyez sur la touche Entrée du pavé 
numérique.

• Pour insérer le changement de programme 
et quitter le mode de saisie d'événement, 
appuyez sur la touche Retour du clavier 
alphanumérique.

• Pour quitter le mode de saisie d'événement 
sans insérer de changement de programme, 
appuyez sur la touche Echap du clavier 
alphanumérique.

Insertion d'un autre événement

Après avoir inséré un événement, vous pouvez 
facilement en insérer un autre du même type. 
Le type d'événement à insérer est indiqué en bas 
du menu Insert.

Par exemple, après avoir inséré une note et pour 
en insérer une autre :

■ Cliquez sur le bouton Insert et choisissez 
Another Note dans le menu déroulant.

– ou –

■ Appuyez sur Ctrl + M (Windows) ou sur 
Pomme + M (Macintosh).

Edition dans la liste des 
événements MIDI
Les événements de la liste des événements MIDI 
peuvent être édités, sélectionnés, supprimés ou 
copiés et collés.

Pour éditer un événement dans la liste des 
événements MIDI :

1  Cliquez deux fois sur le champ de l'événement 
à éditer.

– ou –

appuyez sur Pomme + Enter (Macintosh) ou sur 
Ctrl + Entrée (Windows) pour éditer un 
événement sélectionné.

Champs de saisie des événements pour un 
changement de programme

Une fois le champ Start sélectionné, vous 
pouvez entrer automatiquement 
l'emplacement d'un autre événement 
présent sur la piste en cliquant dessus.

Numéro du programme Nom du programme

Valeur du contrôleur 0

Valeur du contrôleur 32

Lorsque l'option Insert At Playback 
Location est active (voir Options de la liste 
des événements MIDI, page 568), vous 
pouvez utiliser les raccourcis clavier afin 
d'insérer d'autres événements à la volée.
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2  Pour entrer une nouvelle valeur, effectuez 
l'une des opérations suivantes :

• Entrez la nouvelle valeur sur le pavé 
numérique.

• Maintenez la touche Option (Macintosh) 
ou Alt (Windows) enfoncée pendant que 
vous appuyez sur la flèche vers le haut ou 
vers le bas pour faire défiler l'affichage 
jusqu'à la nouvelle valeur désirée.

• Maintenez la touche Pomme (Macintosh) 
ou Ctrl (Windows) enfoncée tout en vous 
déplaçant vers le haut ou le bas pour faire 
défiler l'affichage jusqu'à la nouvelle valeur 
désirée.

• Jouez la nouvelle note (ou valeur de 
contrôleur) sur votre contrôleur MIDI puis 
appuyez sur la touche Retour (Macintosh) 
ou Entrée (Windows) du clavier 
alphanumérique pour valider la valeur.

3  Pour accepter la nouvelle valeur, effectuez 
l'une des opérations suivantes :

• Pour entrer la nouvelle valeur d'événement 
et vous déplacer vers un autre champ ou un 
autre événement, utilisez les touches 
fléchées.

• Pour entrer la nouvelle valeur et rester en 
mode édition, appuyez sur la touche Entrée 
du pavé numérique.

• Pour entrer la nouvelle valeur et quitter le 
mode édition, appuyez sur la touche 
Retour (Macintosh) ou sur Entrée 
(Windows) du clavier alphanumérique.

– ou –

Pour quitter le mode de saisie d'édition sans 
valider la nouvelle valeur, appuyez sur la touche 
Echap du clavier alphanumérique.

Sélection dans la liste des 
événements MIDI

Pour sélectionner une plage dans la liste des 
événements MIDI :

■ Cliquez sur l'événement au début de la 
sélection et faites glisser le curseur jusqu'à 
l'événement de fin.

– ou –

■ Tout en appuyant sur Maj, cliquez sur 
l'événement au début de la sélection puis sur 
l'événement de fin.

Pour sélectionner des événements non contigus 
dans la liste des événements MIDI :

■ Maintenez la touche Pomme (Macintosh) ou 
Ctrl (Windows) enfoncée pendant que vous 
cliquez sur chaque événement.

Pour supprimer un événement de la sélection dans 
la liste des événements MIDI :

■ Maintenez la touche Pomme (Macintosh) ou 
Ctrl (Windows) enfoncée pendant que vous 
cliquez sur l'événement sélectionné .

Les notes sélectionnées dans la liste des 
événements MIDI peuvent être modifiées à 
l'aide de n'importe quelle commande de la 
fenêtre MIDI Operations. Pour plus de 
détails, consultez le Chapitre 23, 
Opérations MIDI.
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Suppression dans la liste des 
événements MIDI

Pour supprimer un événement MIDI de la liste :

■ Maintenez la touche Option (Macintosh) ou 
Alt (Windows) enfoncée pendant que vous 
cliquez sur l'événement à supprimer.

Pour supprimer une sélection d'événements MIDI 
dans la liste :

1  Sélectionnez les événements que vous voulez 
supprimer en vous déplaçant dans la colonne 
Start ou en cliquant sur chaque événement tout 
en appuyant sur Maj.

2  Pour n'afficher que les événements que vous 
voulez supprimer, utilisez le filtre d'affichage 
(voir Filtre d'affichage pour la liste des 
événements MIDI, page 561). Les événements 
qui ne sont pas affichés ne peuvent être 
supprimés.

3  Choisissez Edit > Clear pour supprimer les 
événements sélectionnés.

– ou –

Appuyez sur la touche Supprimer (Macintosh) 
ou Retour arrière (Windows) du clavier 
alphanumérique.

Copier et coller dans la liste des 
événements MIDI

Pour copier et coller dans la liste des 
événements MIDI :

1  Sélectionnez la plage d'événements que vous 
voulez copier en vous déplaçant dans la liste des 
événements MIDI. Pour sélectionner des 
événements non contigus, maintenez la touche 
Ctrl (Windows) ou Pomme (Macintosh) 
enfoncée pendant que vous cliquez sur chaque 
événement que vous voulez copier.

2  Choisissez Edit > Copy.

3  Pour coller les données à l'emplacement d'un 
événement, cliquez dessus dans la liste des 
événements MIDI.

– ou –

Pour coller les données à n'importe quel 
emplacement, choisissez Go To dans le menu 
Options de la liste des événements MIDI, entrez 
l'emplacement auquel vous voulez effectuer le 
collage et cliquez sur OK.

Sélection dans la liste des événements MIDI
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4  Choisissez Edit > Paste. Les événements du 
Presse-papiers sont collés et remplacent les 
événements existants.

Options de la liste des 
événements MIDI

La liste des événéments MIDI propose les 
options suivantes :

Show Sub Counter : affiche le temps des 
événements dans l'échelle de temps secondaire.

Go To : ouvre la boîte de dialogue Go To, dans 
laquelle vous pouvez préciser un emplacement, 
exprimé dans n'importe quelle échelle 
temporelle, sur lequel le point d'insertion de 
l'édition se déplace.

Scroll To Edit Selection : fait défiler la liste des 
événements MIDI sur le point de début de 
l'édition ou le point d'insertion de l'édition.

Page Scroll During Playback : fait défiler la liste 
des événements MIDI lors de la lecture.

Scroll During Edit Selection : fait défiler la liste 
des événements MIDI automatiquement lorsque 
la sélection d'édition change dans la fenêtre 
Edit.

Show Note Length : affiche la durée au lieu des 
temps de fin des notes dans la colonne 
length/info de la liste des événements MIDI.

Show Note End Time : affiche les temps de fin 
des notes au lieu de la durée dans la colonne 
length/info de la liste des événements MIDI.

Insert At Edit Location : insère par défaut le 
point de début de l'édition ou le point 
d'insertion de l'édition comme emplacement 
des événements.

Insert At Playback Location : permet d'insérer 
des événements dans la liste des événements 
MIDI en temps réel, tout en écoutant la session. 

Insert At Playback Location With Grid : aligne 
l'emplacement des événements insérés en temps 
réel sur la grille.

View Filter : ouvre la boîte de dialogue View 
Filter dans laquelle vous pouvez spécifier les 
types d'événements devant s'afficher dans la 
liste des événements MIDI. Les événements qui 
ne sont pas affichés ne sont pas concernés par 
les opérations Couper, Copier et Coller dans la 
liste des événements MIDI, mais ils sont 
néanmoins lus. Pour plus d'informations, 
reportez-vous à la section Filtre d'affichage pour 
la liste des événements MIDI, page 561.

Pour coller des événements sans effacer les 
anciens, utilisez la commande Merge Paste 
Special.

Options de la liste des événements MIDI
Guide de référence Pro Tools



569

Partie VI : Mixage



570



Chapitre 25 : Mixage : les bases

En plus du mixage final, les tâches de mixage 
peuvent être réalisées à tout moment lors d'une 
session d'enregistrement. Ce chapitre explique 
les aspects du mixage sur un système Pro Tools, 
notamment les flux de signaux audio, les voies 
de sortie et de bus, les départs et l'assignation des 
signaux pour le prémixage et le mixage.

Lors du mixage, des plug-in en temps réel et des 
points d'inserts matériels assurent les effets et le 
traitement des signaux (voir Chapitre 26, Plug-
in et inserts matériels). 

Notions de mixage
Le mixage consiste à modifier certains éléments, 
tels que les niveaux de son, le panoramique et 
les effets. Les modifications apportées sont 
basées sur les données entendues en studio. Bien 
que vous puissiez contrôler de nombreuses 
variables en studio (par exemple les haut-
parleurs et l'acoustique de la salle), vous ne 
pouvez pas contrôler l'environnement d'écoute 
du mixage final. Les conseils suivants proposent 
plusieurs méthodes permettant de garantir la 
meilleure qualité de mixage possible au plus 
grand nombre d'auditeurs :

Alternez les enceintes et l'écoute : écoutez vos 
mixages sur différents types d'enceintes afin 
d'en évaluer la qualité. Cette opération permet 
d'anticiper ce qu'entendra effectivement le 
public visé.

Mixage de référence : l'enregistrement de 
cassettes ou de CD d'un état provisoire du mix 
permet de l'écouter hors studio, dans des 
environnements d'écoute différents.

Ecoute pour la compatibilité de formats : 
les mixages stéréo doivent généralement être 
compatibles avec le format mono. Lorsque vous 
effectuez un mixage en mode Surround 
multicanal, les mixages doivent généralement 
être compatibles avec des systèmes d'écoute 
stéréo ou mono (voir Chapitre 29, Notions 
relatives au format Surround (Pro Tools HD 
uniquement)).

Mesures et étalonnage
Les vumètres indiquent visuellement le niveau 
des signaux. Ils spécifient l'arrivée du signal sur 
un canal et sa valeur par rapport au repère 
« 0 dB » (supérieure ou inférieure). 

L'étalonnage de tous vos équipements avec des 
niveaux de référence standard permet de garder 
(et de mesurer) un niveau constant lors du 
passage d'un appareil d'enregistrement à un 
autre dans un studio, à l'échelle d'une structure 
de post-production ou tout au long de la chaîne 
de production d'un film long métrage. Un signal 
de niveau -18  dBFS sortant d'une machine DAT, 
par exemple, doit être lu et mesuré sur les 
vumètres à -18 dBFS dans Pro Tools.
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Flux de signaux
Pro Tools propose quatre types de pistes audio : 

• Audio (pistes)

• Entrée auxiliaire

• Fader principal

• Instrument

Les systèmes Pro Tools sont équipés de pistes 
audio mono et stéréo. 

Les pistes audio multicanaux et formats de 
mixage Surround sont pris en charge par 
Pro Tools HD uniquement.

Pro Tools propose également deux types de 
pistes MIDI :

• MIDI

• Instrument

Dans la fenêtre Mix, les pistes sont identifiées 
par leur icône de type :Utilisez l'option Calibration Reference 

Level de la page Operations Preferences 
pour définir le niveau de calibration de 
référence par défaut en dB, lorsque 
Pro Tools fonctionne en mode 
Calibration.

Pour les interfaces audio possédant des 
trims (tels que l'interface I/O 192), 
reportez-vous au guide de l'interface pour 
obtenir des instructions de calibrage.

Les pistes d'instruments sont répertoriées 
sous les pistes audio et les pistes MIDI 
parce qu'elles sont formées de pistes 
d'entrée auxiliaire et de pistes MIDI. 

Pistes audio, d'entrée auxiliaire, de fader principal 
et MIDI

Pour plus d'informations sur la création de 
pistes, consultez la section Création de 
pistes, page 119.

Icônes de type de piste
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Pistes audio

Les pistes audio lisent et enregistrent les 
données audio sur des disques ou permettent, 
lorsqu'elles sont préparées en enregistrement ou 
en mode d'écoute TrackInput, d'écouter les 
signaux d'entrée. Les inserts sur les pistes audio 
sont des inserts pré-fader. Les départs peuvent 
être pré-fader ou post-fader.

Pistes d'entrée auxiliaire

Les entrées auxiliaires offrent les mêmes options 
d'assignation des signaux que les pistes audio, à 
ceci près que leurs entrées doivent provenir d'un 
bus interne ou d'une entrée matérielle. Les 
inserts sur les entrées auxiliaires sont des inserts 
pré-fader.

Les entrées auxiliaires servent à accueillir des 
sorties d'instruments MIDI externes et autres 
sources sonores, ainsi qu'à prémixer des bus 
internes et des sorties. Elles peuvent être 
entièrement automatisées. Lorsque vous utilisez Chemin de signaux audio, pistes audio

Inserts

Départs,

Volume 

(inserts de 

Sortie principale

Pré-fader

Coupure 

Panoramique

Sorties supplémentaires

Départs,
Post-fader (après fader)

Sortie

+

Source : mono, stéréo ou 
fichier audio multicanaux, lecture
arrière du disque

 

externe
ou entrée

matériel)

Entrée : lors de l'écoute 

en mode d'écoute TrackInput
en enregistrement ou 

plug-in ou

de son 

Flux de signaux audio, pistes d'entrée audio

Inserts 

Départs,

Volume 

(inserts 

Sortie principale

Pré-fader 

Coupure 

Panoramique

Sorties supplémentaires

Départs,
Post-fader (après fader)

Sortie

+

Source : bus ou 

 

Entrée

matériel)

chemin d'entrée matérielle

de plug-in ou

de son
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des entrées auxiliaires pour accueillir des sources 
externes, c'est sur ces sources elles-mêmes qu'il 
convient de régler le volume de sortie afin 
d'obtenir un niveau d'enregistrement correct. 

Utilisations courantes des entrées auxiliaires

Le départ de pistes vers l'entrée auxiliaire, par 
l'intermédiaire de bus, permet :

• L'application de plug-in en temps réel ou d'un 
processeur externe à un prémixage en 
utilisant l'entrée auxiliaire comme retour 
d'effets (par exemple la réverbération ou la 
compression de ligne de bus).

• L'incorporation de sons à partir d'instruments 
MIDI externes et d'autres sources audio dans 
le mixage, pour l'écoute ou l'assignation de 
pistes audio à enregistrer sur disque (par 
exemple, à partir de sorties audio d'un 
synthétiseur MIDI)

• Le regroupement du contrôle du volume du 
niveau d'un prémixage sur un seul fader

• La lecture audio à partir du plug-in d'un 
instrument (bien que les pistes d'instruments 
soient la méthode recommandée 
d'intégration de plug-in d'instruments, par 
exemple Digidesign Synchronic)

Pour acheminer une entrée auxiliaire :

1  Pour choisir un chemin de bus ou d'entrée, 
cliquez sur le sélecteur de chemin d'entrée de 
l'entrée auxiliaire.

2  Pour choisir un chemin de bus ou de sortie, 
cliquez sur le sélecteur de chemin de sortie de 
l'entrée auxiliaire. 

3  Pour définir le volume de retour (par défaut : 
–∞ dB), réglez le fader de l'entrée auxiliaire. 

Pistes de fader principal

Les pistes de fader principal contrôlent les 
niveaux généraux des voies de sortie et des bus. 
Lorsqu'elles sont affectées à un chemin de sortie 
ou de bus actif, elles permettent de contrôler les 
traitements par effets post-fader et le niveau 
général d'un mixage principal, les mixages pour 
casque, des retours, des stems (prémixages), les 
départs d'effets et d'autres applications 
d'assignation de signaux. Les pistes de fader 
principal prennent en charge tous les formats de 
pistes reconnus par votre système Pro Tools.

Vous trouverez des exemples de prémixage à 
partir de la section Prémixage avant 
affectation des signaux et traitement par 
effets, page 595.

Flux de signaux audio, pistes de fader principal

Inserts,

Volume 

(plug-in ou

 

Sortie

Post-fader 

matériel)

Sortie principale

Sorties supplémentaires
+

Entrée (source) déterminée par 
assignation des sorties (d'autres
pistes)

(après fader)
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Contrairement aux inserts des pistes audio et 
des entrées auxiliaires, les inserts de fader 
principal sont placés après le fader. Il est ainsi 
possible d'insérer un plug-in de dithering ou un 
équivalent sur le mixage Master. Pour en savoir 
plus sur le dithering, reportez-vous à la section 
Dithering, page 606.

Les faders principaux fournissent jusqu'à cinq 
inserts post-fader, mais aucun départ. Les pistes 
de fader principal ne disposent pas non plus de 
curseurs de panoramique, ni de boutons Mute 
ou Solo.

Utilisations courantes des pistes de fader 
principal

Vous pouvez utiliser des pistes de fader principal 
pour :

• Contrôler le niveau et traiter des mixages 
de sortie.

• Ecouter et visualiser une sortie sur un 
vumètre (par exemple une sortie de bus ou 
une sortie matérielle) pour éviter l'écrêtage.

• Contrôler des niveaux de prémixage.

• Contrôler des niveaux de départs d'effets.

• Contrôler des niveaux de pistes submaster 
(envoyées sur un bus).

• Appliquer un traitement de dithering ou 
autres traitements d'insert à tout un 
mixage.

Utilisez les faders principaux pour contrôler les 
niveaux de prémixage, de généraux de départs 
d'effets et autres sorties. Les faders principaux 
peuvent contrôler des sorties d'interface audio 

ou des bus internes. Un fader principal stéréo 
contrôle le niveau d'une paire de sorties. 
Les faders principaux ne consomment aucune 
ressource de traitement audio de votre système.

Pour utiliser un fader principal comme commande 
de volume stéréo principal :

1  Créez une piste de fader principal stéréo.

2  Configurez les sorties de toutes les pistes audio 
de la session sur le chemin de sortie principal 
(par exemple sorties 1-2 de votre interface audio 
primaire), puis réglez le panoramique de chaque 
piste.

3  Configurez la sortie de la piste du fader 
principal sur le chemin de sortie principal. 

Vumètres de fader principal

Les niveaux visualisés par les vumètres associés 
aux pistes de fader principal sont toujours 
mesurés après fader, quel que soit le réglage de 
Pre-Fader Metering dans le menu Options. 

Pistes de fader principal et voies

Vous pouvez attribuer des pistes de fader 
principal à des chemins principaux ou à des 
sous-chemins, comme défini dans la boîte de 
dialogue I/O Setup. Il est impossible d'assigner 
plusieurs pistes de fader principal au même 
chemin.

Faders principaux actifs et inactifs

Lorsqu'une piste de fader principal est inactive, 
les plug-in associés, les assignations d'E/S et 
leurs ressources sont désactivés. 

Lorsqu'une affectation de sortie de piste de fader 
principal (assignation à un chemin) est 
désactivée, la piste de fader principal ne contrôle 
plus le gain principal du chemin concerné.

Si vous devez absolument avoir un insert 
pré-fader sur votre signal de fader principal, 
configurez une entrée auxiliaire avant le 
fader principal.
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La duplication d'une piste de fader principal 
désactive son assignation.

Pistes d'instrument

Les pistes d'instruments offrent les mêmes 
options d'assignation des signaux audio que les 
pistes d'entrée auxiliaire, à ceci près que leurs 
entrées doivent provenir du plug-in d'un 
instrument inséré sur la piste Instrument ou, 
d'un bus ou d'une entrée matérielle. Les pistes 
d'instruments fournissent jusqu'à dix inserts 
placés avant le fader.

Les pistes d'instruments sont utilisées en tant 
qu'entrées de plug-in d'instruments, et d'autres 
sources (y compris, de bus internes). Elles 
peuvent être entièrement automatisées. Lorsque 
vous utilisez des pistes d'instruments pour 
accueillir des sources externes, c'est sur ces 
sources elles-mêmes qu'il convient de régler le 
volume de sortie afin d'obtenir un niveau 
d'enregistrement correct. 

Utilisations courantes des pistes d'instruments

La lecture MIDI à partir ou via une piste 
d'instrument vous permet de contrôler l'audio :

• de plug-in d'instrument, tels que des 
synthétiseurs logiciels ou des 
échantillonneurs.

• d'instruments MIDI externes, tels que des 
synthétiseurs logiciels ou des 
échantillonneurs.

Pour transférer les données audio d'un instrument 
MIDI externe vers une piste d'instrument :

1  Cliquez sur le sélecteur de chemin d'entrée de 
la piste d'instrument et sélectionnez l'entrée 
matérielle correspondant à votre instrument 
MIDI externe.

2  Pour choisir un chemin de bus ou de sortie, 
cliquez sur le sélecteur de chemin de sortie de la 
piste d'instrument. 

3  Dans la vue Instruments, cliquez sur le 
sélecteur d'entrée MIDI et affectez un 
périphérique et un canal à partir du menu 
contextuel pour enregistrer et contrôler 
l'instrument MIDI externe.

4  Dans la vue Instruments, cliquez sur le 
sélecteur de sortie MIDI et affectez un port et un 
canal à l'instrument MIDI externe à partir du 
menu contextuel.

Flux de signaux audio, pistes d'instruments
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5  Pour définir le volume, réglez le curseur de 
l'instrument (par défaut –∞ dB).

Inserts
Pro Tools permet d'introduire jusqu'à cinq 
inserts sur chaque piste audio, entrée auxiliaire, 
fader principal ou piste d'instrument. Chaque 
insert peut être un insert de plug-in logiciel, un 
insert matériel ou un plug-in d'instrument.

Les inserts offrent les fonctionnalités suivantes : 

• Les plug-in et les inserts matériels acheminent 
les signaux à partir de la piste à travers l'effet 
de votre choix, puis les renvoient 
automatiquement vers la même piste. 

• Les inserts matériels envoient et revoient le 
signal vers les canaux d'entrée et de sortie 
correspondants d'une interface audio, 
laquelle peut être assignée à des effets 
externes.

• Certains plug-in d'instrument (notamment 
Virus Indigo) acceptent de l'audio à partir de 
l'entrée de piste, vous permettant ainsi de 
vous en servir comme des plug-in de 
traitement.

• Les inserts des pistes audio, des entrées 
auxiliaires et des pistes d'instrument sont 
disposés avant le fader. 

• Les inserts des pistes de fader principal sont 
placés après fader.

• Les inserts peuvent être désactivés.

• La plupart des commandes de plug-in sont 
entièrement automatisables.

Format des sorties de piste et plug-in

Pro Tools prend en charge les plug-in mono, 
multimono, stéréo et multicanaux (Pro Tools 
HD avec Surround Mixer uniquement). 

Les inserts fonctionnant en série, la 
modification du format d'un plug-in risque 
d'altérer le format du canal. L'insertion d'un 
plug-in mono-stéréo sur une entrée auxiliaire 
mono, par exemple, modifie le chemin du signal 
à partir de ce plug-in et sur tout le reste de la 
piste. Ce phénomène impose que les inserts 
matériels ou les plug-in insérés après un plug-in 
stéréo soient des plug-in stéréo en entrée 
comme en sortie (ou d'un format multicanal pris 
en charge). 

Formats des plug-in

Pro Tools prend en charge les plug-in mono et 
stéréo, notamment les chemins de plug-in des 
trois types suivants : 

• Entrée mono/sortie mono

• Entrée mono/sortie stéréo

• Entrée stéréo/sortie stéréo

Les sessions Pro Tools HD pourvus de la console 
Surround prennent aussi en charge les plug-in 
de 3 à 8 canaux, multimono et multicanaux.

Pour plus d'informations sur l'affectation 
d'une entrée et d'une sortie MIDI à des 
pistes d'instrument, reportez-vous à la 
rubrique Affectation d'entrée et de sortie 
MIDI aux pistes d'instrument, page 132

Pour plus d'informations sur l'insertion 
de plug-in d'instrument sur des pistes 
d'instrument, reportez-vous à la rubrique 
Insertion de plug-in d'instrument sur les 
pistes d'instrument, page 133

Pour en savoir plus sur l'utilisation des 
plug-in et des inserts, reportez-vous au 
Chapitre 26, Plug-in et inserts matériels.
Chapitre 25 : Mixage : les bases 577



578
Vues dans les fenêtres Mix 
et Edit
Vous pouvez configurer les fenêtres Mix et Edit 
pour afficher ou masquer un certain nombre de 
commandes de mixage à l'aide des commandes 
de menu ou des sélecteurs de vue. 

La plupart de ces vues sont disponibles dans les 
deux fenêtres, sauf indication contraire.

Sélecteurs de vue de fenêtre

La fenêtre Edit et la fenêtre Mix offrent 
disposent de sélecteurs de vue de fenêtre 
permettant de configurer leurs vues.

Affichage des vues

Pour afficher toutes les vues dans la fenêtre Mix 
ou Edit :

■ Sélectionnez View > Mix Window (ou Edit 
Window) > All.

– ou –

■ Cliquez sur le sélecteur de vue de la fenêtre 
Mix (ou le sélecteur de vue de la fenêtre Edit), 
puis sélectionnez All.

Pour n'afficher aucune vue dans la fenêtre Mix ou 
Edit :

■ Sélectionnez View > Mix Window (ou Edit 
Window) > None.

– ou –

■ Cliquez sur le sélecteur de vue de la fenêtre 
Mix (ou le sélecteur de vue de la fenêtre Edit), 
puis sélectionnez All.

Pour afficher (ou masquer) les vues disponibles 
dans les fenêtres Mix et Edit, effectuez une des 
opérations suivantes :

■ Sélectionnez View > Mix Window (ou Edit 
Window), puis un des types de vue (par 
exemple, Comments).

– ou –

■ Cliquez sur le sélecteur de vue de la fenêtre 
Mix (ou le sélecteur de vue de la fenêtre Edit), 
puis sélectionnez un des types de vue (par 
exemple, Comments).

Sélecteur de vue de la fenêtre Edit

Sélecteur de vue de la fenêtre Mix

Cliquez sur le sélecteur 
de vue de la fenêtre Edit

Cliquez sur le sélecteur 
de vue de la fenêtre Mix
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Vue Comments : affiche tout texte de 
commentaire saisi dans la boîte de dialogue 
Track Name/Comments. Pour plus 
d'informations, reportez-vous à la section 
Attribution de noms aux pistes, page 120.

Vue Mic Preamps : affiche les commandes de 
chaque piste pour Digidesign PRE. Pour masquer 
ces éléments, désélectionnez l'option. Pour des 
informations détaillées, consultez le Guide PRE.

Vue Instruments Affiche les commandes MIDI 
des pistes d'instrument (sélecteur d'entrée MIDI, 
sélecteur de sortie MIDI, volume MIDI, 
panoramique MIDI et coupure de son MIDI).

Vue Inserts : affiche les inserts (plug-in logiciels 
et inserts d'E/S matériels) pour chaque piste. 
Pour masquer ces éléments, désélectionnez 
l'option.

Vue Sends (Sends A–E et Sends F–J) affiche les 
affectations de départs pour chaque piste. Pour 
masquer ces éléments, désélectionnez l'option. 
Pour plus d'informations, reportez-vous à la 
section Configuration des vues Send dans les 
fenêtres Mix et Edit, page 585.

Vue I/O (fenêtre Edit uniquement) : affiche les 
sélecteurs d'entrée et de sortie, ainsi que les 
indicateurs de volume et de panoramique pour 
chaque piste. Pour masquer ces éléments, 
désélectionnez l'option.

Vue Comments dans les fenêtres Mix et Edit

Vue Mic Preamps

Vue Instruments

Vue Comments

Vues dans la fenêtre Mix

Vue I/O (fenêtre Edit)

Vue Inserts

Vue Sends (A–E)

Vue des I/O

Vue Sends (F–J)
Chapitre 25 : Mixage : les bases 579



580
Tout en maintenant la touche Maj (Windows) 
ou la touche Contrôle (Macintosh) enfoncée, 
cliquez sur les champs de volume ou de 
panoramique de la vue I/O dans la fenêtre Edit 
pour régler le volume ou les commandes de 
panoramique à l'aide d'un curseur contextuel.

Vue Real-Time Properties (fenêtre Edit 
uniquement) Affiche les commandes des 
propriétés en temps réel des pistes MIDI et 
d'instrument. Pour plus d'informations sur les 
propriétés en temps réel, voir Propriétés MIDI en 
temps réel, page 549.

Vue Delay Compensation (fenêtre Mix sur 
Pro Tools HD uniquement) La vue de 
compensation de retard indique la quantité 
totale de retard sur chaque piste. Elle permet 
d'appliquer un décalage défini par l'utilisateur 
pour le retard de piste et elle affiche la quantité 
totale de retard appliquée par Pro Tools à 
chaque piste. La vue de compensation de retard 
est affichée dans la fenêtre Mix. 

Les valeurs de retard peuvent être exprimées en 
échantillons ou en millisecondes, comme 
sélectionné sur la page Display Preferences. Pour 
en savoir plus sur la compensation de retard, 
reportez-vous à la section Compensation de 
retard, page 602.

Vue des couleurs de piste Affiche la couleur de 
piste de chaque piste. Pour masquer ces 
éléments, désélectionnez l'option. Pour plus 
d'informations, reportez-vous à la rubrique 
Codage couleur des pistes, des régions, des 
marqueurs et des groupes, page 139.

Vue Transport (fenêtre Edit uniquement) Affiche 
les commandes de transport fonctionnelles dans 
la partie supérieure de la fenêtre Edit. Ces 
commandes sont identiques à celles de la 
fenêtre Transport. Pour plus d'informations, 
consultez l'Fenêtre Transport, page 33

Curseur contextuel du volume de la vue I/O 
(fenêtre Edit)

Curseur contextuel du panoramique de la vue I/O 
(fenêtre Edit)

Vue Real-Time Properties (fenêtre Edit)

Affichage de la compensation de retard

Commandes de transport (fenêtre Edit)

Indicateur de retard

Décalage défini 

Indicateur de 

de piste

de plug-in

par l'utilisateur

compensation
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Masquage de vues dans la fenêtre Edit

Vous pouvez rapidement afficher des colonnes 
dans la fenêtre Edit à l'aide d'un simple raccourci 
clavier. 

Pour masquer une colonne dans la fenêtre Edit :

■ Tout en maintenant la touche Alt (Windows) 
ou la touche Option (Macintosh) enfoncée, 
cliquez au sommet de la colonne à masquer (Mic 
Pre, Comments, Instrument, Inserts, Sends A–E, 
Sends F–J, I/O, Real-Time Properties ou Track 
Color).

Chemins d'entrée et de sortie 
audio
Pro Tools vous permet de configurer les entrées 
et sorties physiques de vos interfaces audio, 
ainsi que les chemins et sous-chemins de bus 
internes dans la boîte de dialogue I/O Setup et la 
boîte de dialogue Hardware Setup. Ces entrées et 
sorties matérielles, ainsi que ces chemins de bus 
internes peuvent être affectés en tant qu'entrées 
et sorties de pistes audio, de pistes d'entrée 
auxiliaire, de pistes d'instrument et de faders 
principaux.

Chemin d'entrée audio

Les sélecteurs de chemin d'entrée déterminent 
l'entrée source des pistes audio, des pistes 
d'entrée auxiliaire et, de manière facultative, des 
pistes d'instrument. Les entrées de piste peuvent 
être configurées à partir de chemins ou sous-
chemins d'entrée matérielle ou de bus interne. 
Pour plus d'informations sur l'affectation 
d'entrées de piste, reportez-vous à la rubrique 
Assignation des entrées vers les pistes audio, 
page 126.

Les chemins d'entrée matérielle et de bus 
peuvent être configurés dans la boîte de 
dialogue I/O Setup. Pour plus d'informations, 
consultez le Chapitre 7, Configuration des E/S.

Vous pouvez également définir les ports 
physiques à acheminer vers les ports d'entrée de 
Pro Tools dans la page Main de la boîte de 
dialogue Hardware Setup. Pour plus 
d'informations, reportez-vous à la section 
Configuration des paramètres du système 
Pro Tools (dans le moteur de lecture), page 50.

Chemin de sortie audio

Les sélecteurs de chemin de sortie de piste 
envoient les signaux après fader aux sorties ou 
aux chemins de bus assignés. Le sélecteur de 
chemin de sortie envoie la sortie de piste 
principale au chemin principal ou secondaire 
choisi. Les pistes peuvent être envoyées 
directement vers des chemins et sous-chemins 
de sorties matérielles ou de bus internes en vue 
du prémixage (des chemins principal et 
secondaire). 

Le format de piste (mono, stéréo ou multicanal) 
détermine les choix de chemin principal et de 
sous-chemins disponibles pour la sortie de piste. 
Pour plus d'informations sur l'affectation de 
sorties de piste, reportez-vous à la rubrique 
Assignation des sorties des pistes audio, 
page 127.

Le format mono, stéréo ou multicanal stéréo ou 
supérieur des pistes audio, des pistes d'entrée 
auxiliaire, des pistes de fader principal et des 
pistes d'instrument, est défini lors de la création 
des pistes :

• Les pistes mono peuvent être affectées à tout 
chemin principal ou à tout sous-chemin 
mono, stéréo ou multicanal disponible.
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• Les pistes stéréo peuvent être affectées à tout 
chemin principal ou à tout sous-chemin 
mono, stéréo ou multicanal disponible.

• Les pistes multicanaux peuvent être affectées 
à tout chemin mono ou tout chemin offrant 
un même nombre de canaux (la piste LCRS 
peut, par exemple, être affectée à un chemin 
LCRS ou mono). 

Fenêtres Output

Les fenêtres Output contiennent les principales 
commandes de mixage de piste (telles que le 
panoramique de piste et le volume), comme 
alternative aux vues des fenêtres Mix et Edit. Les 
fenêtres Multichannel Output et Send 
fournissent également des vues panoramiques 
étendues et d'autres commandes spécifiques à 
l'effet Surround (consultez le Chapitre 32, 
Panoramique et mixage en mode Surround 
(Pro Tools HD uniquement)).

Au cours des grandes sessions, les fenêtres 
Output permettent de conserver les pistes 
importantes ancrées à un emplacement que les 
déplacements des fenêtres Mix et Edit (ou de la 
table de mixage) ne peuvent pas modifier. Pour 
plus d'informations, reportez-vous à la section 
Fenêtres Output pour les pistes et les départs, 
page 590.

Assignations de sorties multiples

Les pistes audio, les pistes d'entrée auxiliaire et 
les pistes d'instrument Pro Tools peuvent être 
assignées à plusieurs chemins de sortie. 
L'assignation d'un même mixage à plusieurs 
chemins constitue un moyen efficace de 
l'envoyer simultanément vers des sorties 
différentes, par exemple pour alimenter des 
moniteurs, fournir un mixage casque, ou toute 
autre situation où un mixage en parallèle est 
nécessaire.

Pour affecter une piste à plusieurs sorties :

1  Affectez un chemin de sortie principal en le 
choisissant dans le sélecteur de chemin de sortie 
de la piste. 

2  Cliquez en appuyant sur la touche de 
démarrage (Windows) ou Contrôle (Macintosh) 
pour sélectionner un autre chemin de sortie 
dans le sélecteur de chemin de sortie de la piste. 
La nouvelle destination de sortie est ajoutée en 
tant que sortie supplémentaire. 

Affichage des assignations de sorties multiples

Lorsqu'une piste est assignée à plusieurs 
chemins de sortie, le sélecteur de chemin de 
sortie signale son état (assignations, 
actif/inactif) à l'aide des indicateurs suivants :

• Le signe plus (+) indique que plusieurs sorties 
sont assignées à cette piste. 

• Dans le menu du sélecteur de chemin de 
sortie, toutes les sorties actuellement affectées 
à la piste sont cochées afin d'indiquer qu'elles 
sont actives. 

• Un astérisque (*) indique qu'une ou plusieurs 
sorties affectées sont inactives. 

Appuyez sur les touches Démarrer et Alt 
(Windows) ou sur les touches Option et 
Contrôle (Macintosh) tout en cliquant pour 
ajouter l'assignation à toutes les pistes ou 
appuyez sur les touches Alt, Démarrer et 
Maj (Windows) ou Option, Maj et Contrôle 
(Macintosh) pour ajouter l'assignation à 
toutes les pistes sélectionnées.

Indication de l'assignation à plusieurs sorties
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Sorties inactives

Vous pouvez désactiver un chemin de sortie en 
totalité dans la boîte de dialogue I/O Setup (ce 
qui affectera toutes les pistes assignées à ce 
chemin) ou par assignation (ce qui concernera 
uniquement une sortie spécifique de la piste 
audio ou de l'entrée auxiliaire). 

A l'ouverture d'une session, si le périphérique 
nécessaire ou les autres ressources ne sont pas 
disponibles, les sorties sont automatiquement 
désactivées. 

Les sorties inactives conservent toutes les 
playlists d'automation associées. Les 
modifications réalisées au cours de la session 
affectent également les playlists d'automation 
de sortie des pistes inactives.

Sorties inactives et ressources DSP

La désactivation d'une sortie de piste la coupe, 
tout en conservant toutes les données de playlist 
et d'automation. Les sorties inactives n'utilisent 
pas de ressources pour les connexions à la 
console TDM, toutefois les plug-in assignés à la 
piste continuent d'exploiter les ressources DSP 
requises. Les plug-in RTAS utilisent les 
ressources de l'unité centrale tandis que les plug-
in TDM utilisent les ressources DSP disponibles 
sur les cartes Pro Tools|HD. 

Pour libérer les ressources DSP des plug-in 
inutilisés, vous pouvez désactiver la piste 
associée ou désactiver uniquement le plug-in. 

A propos de l'option No Output

Les sorties de piste peuvent être réglées sur No 
Output. Le choix de cette option entraîne la 
perte de toute automation de panoramique 
associée à la piste.

Les pistes ainsi configurées ne sont pas audibles, 
mais ne libèrent pas pour autant les ressources 
DSP associées. 

Départs
Pro Tools permet d'introduire jusqu'à dix 
départs (A–E et F–J) sur chaque piste audio, piste 
d'entrée auxiliaire ou piste d'instrument.

Les départs offrent les fonctionnalités 
suivantes : 

• Les signaux de départ peuvent être prélevés 
avant ou après fader.

• Le niveau de départ et le Mute (coupure) 
peuvent être configurés pour suivre ou non les 
groupes.

• Le niveau, la coupure (Mute) et le 
panoramique du départ (dans le cas de départs 
stéréo ou multicanaux) peuvent être 
entièrement automatisés. Pour plus 
d'informations, reportez-vous à la section 
Automation des départs, page 648.

• Les commandes des départs peuvent être 
affichés et modifiés dans les fenêtres Mix ou 
Edit ou dans leurs propres fenêtres Output.

• Les départs peuvent être assignés à tout 
chemin de sortie et de bus disponible 
(chemins principaux ou sous-chemins), au 
format mono, stéréo ou dans tout format 
multicanal pris en charge pour le mixage 
Surround. 

Pour plus d'informations, reportez-vous à la 
section Inactivation des pistes, page 138.

Pour en savoir plus, reportez-vous aux 
sections Eléments actifs et inactifs, 
page 22 et Désactivation des inserts, 
page 613.
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• Chaque départ peut avoir plusieurs 
affectations (vers des chemins de sortie et de 
bus disponibles, par exemple).

Les signaux des départs peuvent être réinjectés 
dans le mixage via une entrée auxiliaire, une 
piste audio ou une piste d'instrument pour être 
audible dans Pro Tools. Ils peuvent être écoutés 
et traités à travers une entrée auxiliaire (ou une 
piste d'instrument), enregistrés sur des pistes 
audio et prémixés sur disque. Les notions de 
prémixage et de mixage final sont exposées au 
Chapitre 28, Mixage final.

Affectation de départs à des 
pistes

Pour ajouter un départ à une piste :

1  Assurez-vous que la vue Sends est activée dans 
la fenêtre Mix ou Edit (pour en savoir plus, 
reportez-vous à la section Vues dans les fenêtres 
Mix et Edit, page 578). 

2  Cliquez sur le bouton Sends de la piste, puis 
choisissez un chemin dans le menu déroulant.

Le départ peut être assigné à un chemin de sortie 
mono ou stéréo (ou dans tout format multicanal 
pris en charge pour le mixage Surround) ou de 
bus.

3  Réglez le niveau de sortie du départ dans la 
fenêtre Send :

• Réglez le fader du niveau de départ.

– ou –

• Pour régler le niveau d'un départ sur le gain 
unitaire (0 dB), maintenez enfoncée e la 
touche Option (Macintosh) ou Alt 
(Windows) pendant que vous cliquez sur le 
fader du niveau de départ lui 
correspondant.

Lorsque vous créez un départ pour la première 
fois, son niveau de sortie est automatiquement 
désactivé et affiche –INF (–∞) à l'écran.

Affectation d'un départ à un chemin de bus stéréo

Fenêtre Send (mono)
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Pour modifier la configuration par défaut des 
départs :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation.

2  Sélectionnez Sends Default to « –INF ».

– ou –

Désélectionnez Sends Default to « –INF ». Les 
nouveaux départs seront configurés par défaut 
sur le gain unitaire (0 dB).

Pour supprimer un départ d'une piste :

■ Cliquez sur le bouton Sends de la piste, puis 
choisissez No Send dans le menu déroulant. 

Formats de départs

Départs mono et stéréo : Si vous cliquez sur le 
bouton Sends d'une piste, la liste des sorties ou 
des chemins de bus mono ou stéréo s'affiche à 
l'écran. 

Départs multicanaux (Pro Tools HD uniquement) 

Si vous cliquez sur le bouton Sends d'une piste, 
la liste des sorties ou des chemins de bus 
multicanaux s'affiche à l'écran. 

Choix des chemins de départ

Les sélecteurs de départs permettent de choisir 
les chemins de bus et de sortie.

Bus de mixage internes : Les systèmes Pro Tools 
HD offrent 128 bus pour le routage interne des 
signaux et les systèmes Pro Tools LE, 32. 
Ces chemins de bus internes facilitent les 

prémixages et les traitements avec des plug-in. 
Les chemins de bus sont définis dans la boîte de 
dialogue I/O Setup et sont disponibles dans tous 
les formats de canaux pris en charge (mono, 
stéréo ou multicanaux, selon le système).

Sorties matérielles : les départs matériels sont 
souvent réservés aux mixages casques ou à 
l'envoi de signaux vers des processeurs d'effets 
externes. Contrairement aux inserts matériels, 
les départs ne renvoient pas automatiquement 
le son. 

Configuration des vues Send dans 
les fenêtres Mix et Edit

Les pistes audio, les entrées auxiliaires et les 
pistes d'instrument incluent deux groupes de 
vues de Sends : Sends A–E (départs 1–5) et Sends 
F–J (départs 6–10). Le menu View offre des 
options distinctes pour l'affichage de ces départs 
dans les fenêtres Mix et Edit.

Pour afficher les départs dans la fenêtre Mix 
ou Edit :

■ Sélectionnez View > Mix Window (ou Edit 
Window) > Sends A–E (ou Sends F–J).

Options Sends View

Les départs apparaissent dans les fenêtres Mix et 
Edit conformément aux options Sends A–E View 
et Sends F–J View. Chaque vue Send offre six 
options d'affichage : La vue Assignment et cinq 
vues Send individuelles (A–E ou F–J).

Vous pouvez personnaliser les noms, le 
format et la correspondance de chemins de 
bus et de sorties dans la boîte de dialogue 
I/O Setup. Pour plus d'informations, 
reportez-vous à la section Création et 
modification de chemins, page 94.
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Vue Assignment

Il s'agit de la vue Send par défaut, indiquant les 
cinq départs Sends A–E ou Sends F–J sur toutes 
les pistes affichées dans les fenêtres Mix et Edit.

Dans la vue Assignment, les commandes de 
départ sont réglées à partir des fenêtres Send. 
Pour plus d'informations, reportez-vous à la 
section Pour faire apparaître une autre fenêtre 
Output ou la fenêtre Send :, page 591.

Pour faire apparaître toutes les assignations des 
départs :

1  Si les départs ne sont pas visibles actuellement 
sur vos pistes, sélectionnez View > Mix Window 
(ou Edit Window) > Sends A–E (ou Sends F–J).

2  Effectuez l'une des opérations suivantes :

• Sélectionnez View > Sends A–E > 
Assignments ou View > Sends F–J > 
Assignments. 

– ou –

• Lorsque vous affichez des départs dans une 
vue Send individuelle (notamment une vue 
Send A), tout en maintenant la touche Ctrl 
(Windows) ou la touche Pomme 

(Macintosh) enfoncée, cliquez sur le 
sélecteur Send et sélectionnez 
Assignments.

Vues Send individuelles (A–J)

Les vues Send individuelles (notamment Send 
A) offrent des commandes de niveau de départ, 
de panoramique et de coupure de son pour un 
seul départ vers toutes les pistes. 

Vous pouvez régler les commandes de départs 
directement depuis ces vues Send. Les départs 
peuvent également être ouverts pour édition ou 
visualisation des niveaux dans les fenêtres Send. 
Pour plus d'informations, reportez-vous à la 
section Fenêtres Output pour les pistes et les 
départs, page 590.

Pour afficher les commandes associées à un 
départ spécifique sur toutes les pistes :

1  Si les départs ne sont pas visibles actuellement 
sur vos pistes, sélectionnez View > Mix Window 
(ou Edit Window) > Sends A–E (ou Sends F–J).

2  Effectuez l'une des opérations suivantes :

• Sélectionnez View > Sends A–E (ou Sends 
F-J) et sélectionnez une des vues 
individuelles Send (par exemple Send A).

– ou –

• Dans la vue Assignment, tout en 
maintenant la touche Ctrl (Windows) ou la 
touche Pomme (Macintosh) enfoncée, 
cliquez sur le sélecteur Send Assignment.

Vue des assignations, sans départ (à gauche) et avec un 
départ assigné (à droite)

Sélecteurs des 

Vue de l'assignation du départ A

départs

Vue du départ A, avec différents types d'assignation

Pré-fader

Multicanal
Post-fader (après fader) stéréo

Sans assignation
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Modification des départs dans les 
fenêtres Mix et Edit (vues Send 
individuelles)

Les vues Send individuelles (par exemple Send 
A) font apparaître, départ par départ, tous les 
paramètres disponibles dans la zone consacrée 
aux départs dans les fenêtres Mix et Edit. 
Ces vues permettent d'accéder à toutes les 
commandes associées au départ concerné, sur 
toutes les pistes. 

Le niveau et la coupure du départ peuvent suivre 
les groupes Mix, ce qui permet d'ajuster les 
différentes commandes de départ depuis un seul 
jeu de commandes Pour plus d'informations, 
reportez-vous à la section Départs et groupes, 
page 595.

Vues Send individuelles et vumètres de 
niveau de départ

Lors de l'affichage des commandes 
correspondant à un départ particulier, vous 
pouvez afficher les vumètres de niveau du 
départ.

Ces vumètres indiquent les valeurs crêtes ainsi 
que les écrêtages survenant lorsque ces vumètres 
sont affichés (si un départ est écrêté alors que 
son vumètre n'est pas affiché, cet écrêtage 
n'apparaît pas). Si vous utilisez un ordinateur 
plutôt lent, le masquage des vumètres des 
départs peut améliorer le rafraîchissement 
d'écran.

Pour afficher les vumètres lors de la visualisation 
de départs individuels :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Display.

2  Sélectionnez Show Meters dans la vue Sends, 
puis cliquez sur Done.

Pour remettre à zéro l'indicateur d'écrêtage d'un 
vumètre de départ :

■ Cliquez sur l'indicateur d'écrêtage. 

Pour réinitialiser tous les vumètres, effectuez 
l'une des opérations suivantes :

■ Appuyez sur la touche Option et cliquez sur 
l'indicateur Clip.

■ Sélectionnez Track > Clear All Clip Indicators.

■ Appuyez sur les touches Alt-C (Windows) ou 
Option-C (Macintosh).

Vues des départs

Vue du départ A, départ stéréo

Sélecteur Send Assignment

Bouton Send Mute
Curseurs Send Pan

Vumètre de niveau de départ

Départ

Bouton Pre/Post Fader

Niveau

Départ
Sélecteur

volume

Bouton Send Assignment

Dans la vue Assignment, vous pouvez 
modifier les départs en ouvrant la fenêtre 
Output correspondante. Pour plus 
d'informations, reportez-vous à la section 
Fenêtres Output pour les pistes et les 
départs, page 590.
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Affichage de l'état des départs

Lorsque vous affichez toutes les commandes 
d'une vue Send individuelle, l'indicateur d'état 
des départs est visible directement dans les 
fenêtres Mix et Edit.

Dans la vue Assignment, l'état des départs est 
affiché comme suit 

• Par défaut, le bouton Send est grisé, pour 
indiquer la non-coupure.

• Le texte du bouton Send est rouge lorsque le 
départ est écrêté.

• Le bouton Send est bleu lorsque le départ est 
coupé. 

• Le bouton Send est illuminé dès qu'une 
fenêtre de départ est ouverte. 

Si vous utilisez une surface de contrôle (telle que 
D-Control ou Digi 002) avec Pro Tools, le 
contrôleur actif est repéré par des contours 
colorés sur les départs, les inserts et les sorties.

Départs inactifs

Il est possible de désactiver les départs. Les 
départs inactifs libèrent leurs ressources de 
console et ressources DSP, mais conservent leur 
position dans la vue Sends de la piste. Les 
départs inactifs ne transmettent pas de données 
audio. Les départs inactifs conservent toutes les 

playlists d'automation associées. En outre, toute 
modification apportée à des régions de pistes 
comportant des départs inactifs peuvent encore 
affecter les playlists d'automation de départs.

A l'ouverture d'une session, les départs sont 
automatiquement désactivés en cas 
d'indisponibilité du matériel ou des autres 
ressources. 

Pour désactiver un départ :

■ Maintenez enfoncées les touches Ctrl-
Démarrer (Windows) ou Pomme-Contrôle 
pendant que vous cliquez sur l'assignation du 
départ.

– ou –

■ Désactivez la piste. Pour plus d'informations, 
reportez-vous à la section Inactivation des 
pistes, page 138.

Pour activer ou désactiver les départs dans la 
même position (A-E) attribués au même chemin 
sur toutes les pistes :

■ Maintenant enfoncées les touches Ctrl-
Démarrer (Windows) ou Pomme-Contrôle 
(Macintosh) pendant que vous cliquez sur un 
bouton Send pour l'activer ou le désactiver.

Indication de coupure de départ, d'écrêtage et de l'état 
de la fenêtre

Non coupé Fenêtre ouverte
 (bouton Send illuminé)

Coupé 
(bleu)  

Écrêté
(texte rouge) 

Affichage de départs inactifs

Départ inactifs Actif

Piste inactive

 

(en italique et
grisé)

Départ
(texte simple) 

(toute la piste est 
en italique et grisée)
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Pour activer ou désactiver les départs dans la 
même position (A-E) attribués au même chemin 
sur toutes les pistes sélectionnées :

■ Maintenant enfoncées les touches 
Ctrl+Démarrer+Alt+Maj (Windows) ou 
Pomme+Contrôle+Option+Maj (Macintosh) 
pendant que vous cliquez sur un bouton Send 
pour l'activer ou le désactiver.

Déplacement ou copie de départs 

Les départs peuvent être déplacés ou copiés sur 
d'autres pistes ou vers un autre emplacement 
d'une même piste par la méthode 
conventionnelle du glisser-déposer. Les départs 
peuvent être déposés de façon à créer de 
nouveaux départs au niveau de la destination, 
ou déposés sur des assignations de départs 
existantes afin de les remplacer. 

Les départs peuvent être déplacés ou copiés sur 
des pistes comportant des formats de départs 
compatibles (mono, stéréo ou autre). Pro Tools 
vous avertit lorsque vous tentez de déplacer ou 
de copier un départ vers une destination non 
compatible. (Pour en savoir plus, reportez-vous 
à la rubrique Format des départs et compatibilité 
des pistes, page 589.) 

Pour déplacer un départ :

1  Assurez-vous que le transport est arrêté. 

2  Cliquez sur le nom du départ et faites-le glisser 
à son nouvel emplacement sur la piste d'origine 
ou une autre piste. 

Pour copier un départ :

1  Assurez-vous que le transport est arrêté. 

2  Tout en maintenant la touche Alt (Windows) 
ou la touche Option (Macintosh) enfoncée, 
faites le glisser puis déposez-le à son nouvel 
emplacement. 

Le déplacement ou la copie d'un départ conserve 
toutes les assignations d'acheminement, 
l'automation (le cas échéant), les paramètres de 
niveau/panoramique/coupure de son, ainsi que 
le format de sortie. 

Format des départs et compatibilité des pistes

Les départs ne peuvent être copiés que sur des 
pistes comportant un format de sortie pour 
départs compatible (mono, stéréo ou autre). En 
outre, les conditions suivantes sont applicables 
lors du déplacement ou de la copie de départs 
d'une piste vers une autre :

• Lorsque vous copiez un départ stéréo d'une 
piste mono vers une piste stéréo, l'automation 
de panoramique du départ (le cas échéant) est 
déposée sans avertissement. 

• Lorsque vous copiez un départ stéréo d'une 
piste stéréo vers une piste mono, les données 
de gauche de l'automation de panoramique 
du départ sont conservées et celles de droite 
sont déposées. Une boîte de dialogue 
d'avertissement s'affiche pour vous permettre 
de confirmer ou d'annuler cette opération 
destructive. 

• Lorsque vous déplacez ou copiez un départ 
pour remplacer un départ existant, toute 
automation du départ existant est remplacé. 
Une boîte de dialogue d'avertissement 
s'affiche pour vous permettre de confirmer ou 
d'annuler cette opération destructive. 
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Copie des paramètres des pistes 
sur les départs
(Pro Tools HD uniquement)

Il est parfois nécessaire que les paramètres de 
départ soient identiques à ceux de la piste elle-
même ; par exemple, pour générer un mixage 
casque basé sur le mixage principal. 

Fenêtres Output pour les 
pistes et les départs
Les sorties de piste et les départs peuvent être 
ouverts pour affichage et édition dans des 
fenêtres prévues à cet effet. 

• Les fenêtres Output de pistes contiennent les 
commandes de fader de piste, de 
panoramique, d'automation, de Solo et de 
coupure (Mute). 

• Les fenêtres Send contiennent les réglages de 
niveau de départ, de coupure (Mute), de 
panoramique et d'automation. 

• Les commandes des fenêtres Standard Output 
et Send offrent des paramètres 
supplémentaires d'affectation, d'assignation 
et d'affichage.

Pour ouvrir la fenêtre Output d'une piste :

■ Cliquez sur le bouton de la fenêtre Output 
dans la voie de console. 

Pour ouvrir une fenêtre Send :

■ Cliquez sur le bouton Send Assignment dans 
la fenêtre Mix ou Edit. 

Pour plus d'informations, reportez-vous à la 
section Copie des données d'automation 
de piste sur les départs, page 649.

Ouverture d'une fenêtre Output de piste

Ouverture d'une fenêtre Send

Cliquez ici Ou ici
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Pour faire apparaître une autre fenêtre Output ou 
la fenêtre Send :

■ Cliquez sur un bouton de la fenêtre Output ou 
sur le bouton Send Assignment de la fenêtre Mix 
ou Edit. 

Si une fenêtre Output similaire, déjà ouverte, est 
signalée par l'illumination d'une icône Target 
(rouge, allumée), le nouveau départ sélectionné 
s'ouvre à sa place. 

Ouverture de plusieurs fenêtres Output

Il est possible de faire apparaître simultanément 
plusieurs fenêtres de piste et de départ à l'aide de 
l'une des méthodes ci-après : 

Pour ouvrir d'autres fenêtres Output :

■ Tout en maintenant la touche Maj enfoncée, 
cliquez sur le bouton d'une fenêtre Output ou 
sur le bouton Send Assignment.

Pour maintenir une fenêtre ouverte lors de 
l'ouverture d'autres fenêtres Ouptut :

■ Vérifiez que la cible est désactivée. 

Disposez les fenêtres à votre convenance. Pour 
plus d'informations, voir Fenêtres « ciblées », 
page 594.

Liaison de panoramique

Les sorties stéréo offrent deux commandes de 
panoramique, une pour chaque côté de la paire 
gauche/droite. Les sorties multicanaux offrent 
un panoramique multicanal.

Les commandes de la fenêtre Output permettent 
de découpler (ou de coupler) des canaux pour 
générer un panoramique précis des pistes stéréo 
et multicanaux.

Fenêtres Send multiples

Cible activée Cible désactivée
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En mode couplé (mode par défaut), chaque 
modification apportée au panoramique sur un 
côté est immédiatement répercutée à l'identique 
de l'autre côté. Il s'agit d'un mode de liaison 
absolu. Pour refléter les modifications du 
panoramique, voir Couplage de panoramiques 
en mode inversé, page 592.

Une fois le couplage supprimé, les commandes 
de panoramique redeviennent entièrement 
indépendantes.

Pour activer le couplage :

■ Activez l'icône de couplage.

Pour découpler une sortie afin de récupérer des 
panoramiques indépendants :

■ Désélectionnez l'icône de couplage. 

Couplage de panoramiques en mode 
inversé

Dans le cas de canaux couplés et réglés en mode 
inversé, les déplacements de panoramiques sont 
inversés d'un canal à un autre. 

Le mode de panoramique inversé répercute à 
l'inverse, dans une direction donnée, le 
mouvement d'un son d'un canal à l'autre. S'il est 
activé pour une inversion avant, par exemple, et 
si vous déplacez de droite à gauche le son d'un 
des canaux d'une sortie de piste stéréo, le son de 
l'autre canal subira le déplacement équivalent 
de gauche à droite. 

Le mode de couplage inversé à l'avant est 
disponible sur tous les systèmes. Les couplages 
inversés arrière et inversés avant/arrière sont 
disponibles sur les systèmes Pro Tools|HD. Ils ne 
s'affichent que sous forme d'options dans les 
fenêtres de plug-in multicanaux et de 
panoramiques/sortie.

Pour activer le mode de couplage inversé :

1  Activez l'icône de couplage.

2  Sélectionnez un mode d'inversion de 
panoramique. 

Commandes de sélecteur 
standard dans les fenêtres Output

Toutes les fenêtres Output contiennent des 
sélecteurs standard de chemins, d'automation et 
d'autres commandes, situés dans la zone 
supérieure (zone Output Editor).

Fenêtres Output avec couplage (gauche), sans couplage 
(milieu), avec couplage inversé à l'avant (droite)

Sélecteurs de couplage et de mode inversé (piste 
multicanal)

Commandes standard de la fenêtre Output, Windows 
(gauche) et Macintosh (droite)

Link 

Inversion avant/arrière

Inversion avant

Inversion arrière

Automation Safe, 

Cible

Vue du vumètre du chemin

Sélecteur de chemin

Sélecteur de vue 

Sélecteur de piste Fermeture

Couplage 

Link
inversé 

bouton

de sortie
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Fermeture : ferme la fenêtre.

Sélecteur de piste : permet d'accéder à toutes les 
pistes audio, les entrées auxiliaires et les pistes 
Master Fader au cours de la session.

Sélecteur de vue de sortie : permet d'accéder 
aux autres sorties (de piste et de départ) sur la 
piste, le cas échéant, et fait apparaître la sortie 
sélectionnée dans la fenêtre active.

Sélecteur de vue de départ (fenêtre Send 
uniquement) : permet d'accéder aux autres 
départs de la piste.

Sélecteur de chemin de sortie : permet d'affecter 
le chemin de sortie désiré à la piste ou au départ 
actuel. 

Bouton Pre/Post Fader (fenêtre Send 
uniquement) : détermine si le départ est pré-
fader ou post-fader.

Bouton Safe : le mode d'isolation d'automation 
(Safe) protège le niveau de piste et de départ, les 
panoramiques et autres commandes contre tout 
risque d'effacement. Pour plus d'informations, 
reportez-vous au Chapitre 27, L'automation. 

Couplage inversé : répercute à l'inverse, dans 
une direction donnée, le mouvement d'un son 
d'un canal à l'autre (par exemple commandes du 
panoramique des canaux gauche et droit). 

Couplage et suppression du couplage : permet 
de coupler/découpler les sorties gauche et droite 
(ou d'autres sorties) en stéréo (ou multicanaux). 
Le mode non couplé permet de régler 
indépendamment les côtés ou canaux séparés. 
Lorsqu'ils sont liés, les modifications se reflètent 
sur tous les canaux. Pour plus d'informations, 
reportez-vous à la section Liaison de 
panoramique, page 591. 

Cible : identifie la « cible » des commandes de 
configuration de plug-in. Sélectionne également 
la fenêtre active dans l'affichage des fenêtres 
Output. Reportez-vous à la section Fenêtres 
« ciblées », page 594. 

Vue du vumètre du chemin : o\uvre la vue du 
vumètre du chemin. Ce type de vumètre 
indique les niveaux du chemin sélectionné (et 
non les niveaux de la piste ou du départ). 

Commandes standard de la fenêtre Send, Windows 
(gauche) et Macintosh (droite)

Bouton Pre/Post Fader

Cible 

Vue du vumètre 

Sélecteur de chemin
Sélecteur de départ

Sélecteur de piste
Fermeture 

Couplage 

Link  

du chemin

inversé 

Automation Safe, bouton

 

Vue du vumètre du chemin dans une fenêtre Send

Chemin

Vumètre de 

Vumètre de 

Vumètre de 

Sélecteur

Vumètres

Bouton View
chemin

chemin

niveau 
de départ
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Fader de piste, commandes de 
panoramique, Solo, Mute et 
d'automation

 

Les fenêtres Output contiennent le fader de 
volume de la piste, les commandes de 
panoramique, les touches Solo et Mute et le 
sélecteur de mode d'automation. Ils permettent 
de régler ou d'automatiser les commandes de la 
fenêtre Output. 

 

Fenêtres « ciblées »

 

Lorsque la cible est allumée en rouge, cela 
signifie que sa fenêtre est « ciblée » et que la 
fenêtre de même type suivante remplace 
l'affichage actuel (à moins qu'elle n'ait été 
ouverte sous forme de fenêtre supplémentaire, 
en appuyant sur la touche Maj). Lorsque la cible 
n'est pas allumée, elle s'affiche en gris et la 
fenêtre active est ancrée à son contenu et à son 
emplacement à l'écran. L'ouverture de nouvelles 
fenêtres n'a aucun effet sur les fenêtres ancrées.

 

Pour définir une fenêtre Send ouverte en tant que 
fenêtre Target :

 

■

 

Cliquez sur le bouton Target afin qu'il s'allume 
en rouge.

 

Utilisation des fenêtres Output

 

Les fenêtres Output contiennent les commandes 
Pro Tools standard de piste, de départ, de 
cible, etc. 

 
Pour passer à une autre piste :

 

■

 

Cliquez sur le sélecteur de piste, puis 
choisissez une piste dans le menu déroulant.

 

Pour réassigner une sortie :

 

■

 

Cliquez sur le sélecteur de chemin de sortie, 
puis sélectionnez un chemin dans le menu 
contextuel. 

 

Les fenêtres Plug-in sont dotées de fonctions 
supplémentaires relatives à la cible (telles 
que le focus sur les commandes de 
configuration). Pour plus d'informations, 
reportez-vous à la section Fenêtre Plug-In, 
page 619.

 

Sélection d'une piste dans la fenêtre Output

Sélection d'un chemin dans la fenêtre Output
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Pour afficher les commandes correspondant à un 
autre départ sur la même piste :

 

■

 

Cliquez sur le sélecteur de vue Send, puis 
sélectionnez le départ souhaité.

 

Pour attribuer un autre départ à une piste :

 

■

 

Cliquez sur le sélecteur de départ, puis 
sélectionnez un chemin de sortie ou de bus dans 
le menu contextuel.

 

Pour ajouter une assignation de sortie au départ 
actif :

 

■

 

Cliquez sur un nouveau chemin de sortie en 
appuyant sur la touche Contrôle (Macintosh) ou 
Démarrer (Windows) dans le sélecteur de départ 
(ou le sélecteur de chemin de sortie).

 

Départs et groupes

 

Le niveau et la coupure de son des départs 
peuvent suivre les groupes Mix dans chacun des 
dix départs disponibles (de A à J). Pour régler 
plusieurs commandes de départ à partir d'un jeu 
de commandes unique, procédez comme suit : 

 

Pour configurer des départs et des groupes Mix :

 

1  

 

Choisissez Setup > Preferences et cliquez sur 
l'onglet Automation.

 

2  

 

Activez l'option Send Level Follows Groups, 
Send Mute Follows Groups ou LFE Follows 
Groups. 

 

3  

 

Cliquez sur Done pour valider ces nouvelles 
préférences.

 

Prémixage avant affectation 
des signaux et traitement par 
effets

 

Les fonctionnalités de bus et de mixage de 
Pro Tools permettent une infinité de 
configurations de prémixage et d'assignation de 
signaux. Elles permettent également :

• d'écouter et de mixer des pistes avec une 
entrée MIDI ;

• d'écouter et de mixer des pistes avec des 
entrées audio ;

• de créer des prémixages ;

• Prémixages de bus pour le traitement des 
effets

• Prémixages de bus pour l'écoute de studio

• Prémixages avec faders principaux

 

Écoute de pistes d'entrée audio 
avec des pistes d'entrée 
auxiliaire

 

Utilisez des pistes d'entrée auxiliaire pour 
écouter et mixer des signaux audio externes, tels 
que l'entrée d'instruments MIDI, de bandes, de 
micros et autres instruments, dans un mixage 
Pro Tools.

 

Pour écouter et mixer un signal audio externe en 
passant par des entrées auxiliaires :

 

1  

 

Reliez les sorties audio de votre source audio 
(telle qu'un synthétiseur MIDI ou une sortie de 
bande) aux entrées disponibles sur les interfaces 
audio de votre système Pro Tools. 

 

Accès à un autre départ dans la fenêtre Output

 

Pour plus d'informations sur les groupes, 
voir Regroupement des pistes, page 142.
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2  

 

Si nécessaire, configurez les chemins d'entrée 
que vous prévoyez d'utiliser dans la boîte de 
dialogue I/O Setup (consultez le Chapitre 7, 
Configuration des E/S.).

 
3   Utilisez une piste d'entrée auxiliaire (nouvelle 
ou existante) disposant du même nombre de 
canaux que votre source audio (mono, stéréo ou 
multicanaux).

 

4  

 

Réglez l'entrée de la piste d'entrée auxiliaire 
sur le chemin d'entrée correspondant.

 

5  

 

Affectez la sortie de piste au(x) chemin(s) 
approprié(s) pour l'écoute.

 

6  

 

Réglez le fader d'entrée auxiliaire pour mixer 
l'entrée audio. 

 

Écoute de pistes audio avec des 
pistes d'instrument

 

Utilisez les pistes d'instrument pour écouter et 
mixer de l'audio à partir de plug-in d'instrument 
ou d'instruments MIDI externes dans un mixage 
Pro Tools.

 

Pour utiliser des pistes d'instruments afin 
d'écouter et de mixer des plug-in d'instrument :

 

1  

 

Utilisez une piste d'instrument (nouvelle ou 
existante) disposant du nombre de canaux 
souhaité (mono, stéréo ou multicanaux).

 

2  

 

Sélectionnez le plug-in d'instrument désiré à 
partir du premier sélecteur d'insert de piste (tel 
que Digidesign Synchronic).

 

3  

 

Le nœud MIDI virtuel (port) du plug-in 
d'instrument doit être automatiquement 
sélectionné pour la sortie MIDI de la piste 
d'instrument. Si ce n'est pas le cas, sélectionnez 
le canal MIDI désiré ainsi que le port 
correspondant du plug-in d'instrument.

 

4  

 

Affectez la sortie de piste au(x) chemin(s) 
approprié(s) pour l'écoute.

 

5  

 

Réglez le fader de piste d'instrument pour 
mixer l'entrée audio. 

 

Piste d'instrument configurée pour contrôler et écouter 
le plug-in d'un instrument (Digidesign Synchronic)

 

Sélecteur de sortie MIDI

Commande de volume MIDI

Sélecteur d'entrée audio, 

Sélecteur de sortie audio

Commande de panoramique MIDI

Plug-in d'instrument

réglé sur aucune entrée
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6  

 

Si vous contrôlez le plug-in d'instrument à 
partir de la piste d'instrument, vous pouvez 
également réaliser un mixage à l'aide les 
commandes de volume MIDI et de panoramique 
de la vue Instrument.

 
Pour utiliser des pistes d'instruments afin 
d'écouter et de mixer de l'audio à partir 
d'instruments MIDI externes :

 

1  

 

Reliez les sorties audio de votre instrument 
MIDI externe (tel qu'un synthétiseur MIDI) aux 
entrées disponibles sur les interfaces audio de 
votre système Pro Tools. 

 

2  

 

Si nécessaire, configurez les chemins d'entrée 
que vous prévoyez d'utiliser dans la boîte de 
dialogue I/O Setup (consultez le Chapitre 7, 
Configuration des E/S.).

 

3  

 

Connectez l'entrée et la sortie MIDI de votre 
instrument MIDI externe aux ports d'entrée et 
de sortie disponibles de votre interface MIDI.

 

4  

 

Le cas échéant, configurez les paramètres 
MIDI Studio Setup (Setup > MIDI > MIDI 
Studio). 

 

5  

 

Utilisez une piste d'instrument (nouvelle ou 
existante) disposant du même nombre de 
canaux que votre source audio (mono, stéréo ou 
multicanaux).

 

6  

 

Réglez l'entrée audio de la piste d'instrument 
sur le chemin d'entrée correspondant.

 

7  

 

Dans la vue Instrument de la piste 
d'instrument, réglez la sortie MIDI sur le port 
MIDI correspondant connecté à l'entrée MIDI de 
votre instrument MIDI externe.

 

8  

 

Affectez la sortie de piste au(x) chemin(s) 
approprié(s) pour l'écoute.

9  Réglez le fader de piste d'instrument pour 
mixer l'entrée audio. 

10  Si vous contrôlez l'instrument MIDI externe 
à partir de la piste d'instrument, vous pouvez 
également réaliser un mixage à l'aide les 
commandes de volume MIDI et de panoramique 
de la vue Instrument.

Piste d'instrument configurée pour contrôler et écouter 
un instrument MIDI externe (K2600XS)

Sélecteur de sortie MIDI

Commande de volume MIDI

Sélecteur d'entrée audio

Sélecteur de sortie audio

Commande de panoramique MIDI
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Création d'un prémixage

Un prémixage est créé en acheminant plusieurs 
sources audio vers un même chemin de bus ou 
de sortie. Ceci « prémixe » les sources vers un 
seul chemin qui peut être renvoyé à une entrée 
auxiliaire, où le prémixage peut être traité à 
l'aide de plug-in ou de processeurs d'effets 
externes.

Pour créer un prémixage audio, il suffit 
d'assigner une combinaison de départs et de 
sorties de pistes vers des bus ou des chemins de 
sortie disponibles.

Prémixage via sorties de piste ou départs

Selon le type de prémixage souhaité, discret ou 
départ/retour, il convient de choisir entre 
l'utilisation de sorties de pistes ou celle de 
départs. 

Sortie de prémixage discret

Pro Tools permet de diriger discrètement la 
source audio vers un prémixage. Cette méthode 
est préférable pour le dithering ou autres 
traitements de mastering, lorsque l'on ne désire 
pas entendre de signaux audio non traités en 
plus des signaux traités. Pour un prémixage 
discret, on utilise les sorties de piste (et non les 
départs) pour assigner des pistes à un chemin de 
bus. Dans ce cas, l'équilibre entre les signaux 
traités et non traités est contrôlé par les 
paramètres Wet/Dry du plug-in.

Pour créer un prémixage discret, procédez 
comme suit :

1  Réglez la sortie des pistes à inclure dans le 
prémixage sur un chemin de bus stéréo. 

2  Effectuez la panoramisation de chaque piste.

3  Sélectionnez Track > New.

4  Indiquez le type de piste (sortie auxiliaire) et le 
format (stéréo), puis cliquez sur Create.

5  Réglez l'entrée de l'entrée auxiliaire sur le 
même chemin de bus que celui auquel sont 
affectées toutes les pistes à prémixer.

6  Réglez la sortie de la piste d'entrée auxiliaire 
sur les sorties de mixage stéréo principales (en 
général, les sorties 1-2). 

7  Définissez le niveau de la piste d'entrée 
auxiliaire.

8  Pour traiter le prémixage, affectez un plug-in 
ou un insert matériel à l'entrée auxiliaire. 

9  Réglez les commandes du plug-in. Les 
commandes Bypass et Wet/Dry du plug-in 
(lorsqu'elles sont disponibles) déterminent la 
quantité d'effet entendue.

Les niveaux relatifs du prémixage sont contrôlés 
par les faders de piste. La piste d'entrée auxiliaire 
contrôle les niveaux de sortie de toutes les pistes 
qui lui parviennent. 

Vous pouvez automatiser les niveaux, 
panoramiques, coupures (Mute) ainsi que les 
niveaux, panoramiques et coupures des départs 
de l'entrée auxiliaire.

Il est également possible d'enregistrer un 
prémixage sur disque, afin de libérer pour 
d'autres pistes les voix des pistes qui le 
composent. Pour en savoir plus, reportez-vous 
au Chapitre 28, Mixage final.
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Prémixage de type départ/retour en 
vue d'un traitement par effets

Lors d'un prémixage pour utilisation d'une 
réverbération, d'un retard ou de tout traitement 
d'effet similaire, utilisez les départs pour recréer 
le dispositif de routage de départ/retour 
classique. Vous pouvez alors « partager » un 
plug-in en temps réel ou un insert matériel entre 
toutes les pistes incluses dans le prémixage. La 
quantité d'effet (Wet/Dry) dans le mixage peut 
être modifiée à l'aide des faders de piste (niveau 
de son direct, Dry) et du fader d'entrée auxiliaire 
(niveau de signal d'effet, Wet).

Départ et retour avec un insert de plug-
in ou un insert matériel

Pour créer un prémixage de retour d'effets avec un 
plug-in ou un insert matériel :

1  Affectez la sortie principale de chaque piste 
aux sorties du mixage principal.

2  Sur les pistes sources, assignez un départ 
(mono ou stéréo) et sélectionnez un chemin de 
bus mono ou stéréo dans le sélecteur de départ. 
Configurez les départs avant ou après fader, 
selon vos besoins.

3  Sélectionnez Track > New.

4  Indiquez le type de piste (sortie auxiliaire) et le 
format (stéréo), puis cliquez sur Create.

5  Dans le sélecteur de chemin d'entrée de la 
piste d'entrée auxiliaire, sélectionnez le chemin 
de bus de départ.

6  Assignez un plug-in ou un insert matériel dans 
l'entrée auxiliaire.

7  Sélectionnez l'effet « 100% wet » et réglez 
toutes les commandes de votre choix.

8  Dans le sélecteur de chemin de sortie de la 
piste d'entrée auxiliaire, sélectionnez un chemin 
de sortie (sorties principales).

Réglez chaque fader de piste pour équilibrer les 
pistes Dry (non traitées). Lorsque le départ est 
disposé avant le fader, la quantité d'effet est 
contrôlée par le niveau du fader de niveau de 
départ ou du fader du volume d'entrée 
auxiliaire. Si le départ est disposé après le fader, 
le fader du niveau de départ suit le niveau du 
volume.

Pour plus d'informations, reportez-vous 
au Chapitre 26, Plug-in et inserts 
matériels.

Configuration de départ/retour pour un plug-in ou un 
insert matériel

Départ vers le bus d'effets

Configuration d'entrée 

Sortie réglée sur les sorties 

Contrôle le niveau des signaux 

Contrôle le niveau du retour 

Effet (plug-in ou hardware)
Insert

Contrôle le niveau de départ 
vers les bus d'effets

vers le chemin du bus de départs

de mixage principales

d'origine (Dry)

d'effets
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Prémixages de départs et de retours 
avec des périphériques externes

Pour créer un prémixage du retour d'effets avec un 
périphérique externe :

1  Affectez la sortie principale de chaque piste 
aux sorties du mixage principal.

2  Assignez un départ (mono ou stéréo) et 
définissez les destinations des départs sur les 
pistes source vers le chemin de sortie relié au 
périphérique externe. Configurez les départs 
avant ou après fader, selon vos besoins.

3  Sélectionnez Track > New.

4  Indiquez le type de piste (sortie auxiliaire) et le 
format (stéréo ou mono), puis cliquez sur 
Create.

5  Cliquez sur le sélecteur de chemin d'entrée de 
la piste d'entrée auxiliaire pour choisir un 
chemin d'entrée relié au périphérique externe.

6  Dans le sélecteur de chemin de sortie de la 
piste d'entrée auxiliaire, sélectionnez un chemin 
de sortie (sorties principales).

Réglez chaque fader de piste pour équilibrer les 
pistes Dry (non traitées). La quantité d'effet est 
contrôlée par le niveau du fader de niveau de 
départ ou du fader du volume d'entrée 
auxiliaire.

Création de prémixages d'écoute

La piste d'acheminement effectue un envoie 
vers une ou plusieurs pistes d'entrée auxiliaire 
pour écouter les prémixages dans un 
environnement de studio. Vous pouvez par 
exemple fournir à un bassiste un prémixage de 
batterie afin qu'il suive une nouvelle partie 
relative à la batterie.

Pour créer un prémixage d'écoute, procédez 
comme suit :

1  Affectez la sortie principale de chaque piste 
aux sorties du mixage principal.

2  Assignez un départ (mono ou stéréo) et 
définissez les destinations des départs sur les 
pistes source vers le chemin de sortie relié au 
périphérique externe. Configurez les départs 
avant ou après fader, selon vos besoins.

Configuration de départ/retour pour un périphérique 
externe

Départ vers un périphérique 

Entrée réglée pour assurer 

Sortie réglée sur les sorties 

Contrôle le niveau 

Contrôle le niveau d'effet

 

externe

le retour du périphérique

de mixage principales

des signaux d'origine (Dry)
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3  Sélectionnez Track > New.

4  Indiquez le type de piste (sortie auxiliaire) et le 
format (stéréo ou mono), puis cliquez sur 
Create.

5  Dans le sélecteur de chemin de sortie de la 
piste d'entrée auxiliaire, sélectionnez le chemin 
de sortie (et non pas les sorties principales) pour 
écouter le mixage. 

Réglez le fader de la piste d'entrée auxiliaire pour 
contrôler le volume du mixage d'écoute.

Création d'un contrôle maître de niveau 
de départ

Les pistes Master Fader contrôlent le niveau 
global de sortie des chemins de bus et de sortie. 

Pour créer un contrôle de volume maître de niveau 
de départ :

1  Sélectionnez Track > New.

2  Indiquez le type de pistes (fader principal) et 
les formats mono, stéréo ou tout autre format 
multicanal pris en charge pour le mixage 
Surround.

3  Cliquez sur Create.

4  Effectuez l'une des opérations suivantes :

• Réglez la sortie de la piste de fader principal 
sur le même chemin que celui utilisé pour 
les départs vers une piste d'entrée 
auxiliaire.

• Réglez la sortie de la piste de fader principal 
de façon à la faire correspondre au chemin 
choisi pour votre départ effets.

Dès lors, les niveaux de départs agissent sur 
l'équilibre des pistes source et les pistes de fader 
principal sur le niveau général de l'ensemble du 
prémixage.

Ecoute de pistes en Solo au sein d'un 
prémixage

Écoute de pistes en solo coupe implicitement le 
son de toutes les autres pistes, y compris des 
entrées auxiliaires. La protection contre la mise 
en solo d'une entrée auxiliaire évite cette 
coupure de son implicite et permet à l'entrée 
auxiliaire de continuer à transmettre les 
données audio lorsque ses pistes source sont en 
mode Solo.

Prémixage de batterie à écouter
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Pour isoler du solo une entrée auxiliaire :

■ Cliquez sur le bouton Solo de la piste d'entrée 
auxiliaire en appuyant sur la touche Pomme 
(Macintosh) ou Ctrl (Windows).

Pour mettre en solo une piste particulière 
appartenant à un groupe :

■ Maintenez enfoncée la touche Contrôle 
(Macintosh) ou Démarrer (Windows) pendant 
que vous cliquez sur le bouton Solo. 

Génération d'une sortie stéréo à partir 
d'un départ/retour mono

Pour générer une sortie stéréo à partir d'un 
départ mono, vous pouvez recourir à une entrée 
auxiliaire. Réglez la destination du départ vers 
une piste d'entrée auxiliaire sur laquelle vous 
placez un plug-in mono vers stéréo. La sortie de 
l'entrée auxiliaire devient dès lors une sortie 
stéréo. 

Pour créer un effet « stéréo » à partir d'une 
source mono, vous devez utiliser l'effet de 
réverbération, l'effet de retardement ou tout 
autre effet de découpage temporel.

Compensation de retard
(Pro Tools HD uniquement)

Pro Tools dispose d'une fonction de 
compensation de retard permettant de gérer les 
retards DSP qui se produisent sur les pistes 
audio, d'entrée auxiliaire, de fader principal ou 
d'instrument, en raison de l'utilisation des plug-
in et des acheminements vers la console. 
Lorsque la fonction est activée, Pro Tools 
préserve l'alignement temporel entre les pistes 
dont les plug-in présentent des différences au 
niveau du retard inhérent au DSP, les pistes 

comportant des chemins de mixage différents, 
les pistes interrompues et recombinées par 
l'intermédiaire de la console et les pistes 
comportant des inserts matériels. 

Pour conserver l'alignement temporel, Pro Tools 
rétablit le retard de chaque piste de façon à ce 
qu'il soit égal à celui de la piste possédant le 
retard le plus long.

La fonction de compensation de retard doit être 
activée pendant le mixage et la lecture pour que 
le son avec compensation de retard soit optimal. 
Dans certains cas, il est parfois préférable de 
désactiver la fonction de compensation de 
retard lors de l'enregistrement.

Pour activer cette fonction, procédez comme suit :

■ Choisissez Options > Delay Compensation.

Paramètres de compensation de 
retard

Il existe trois paramètres dans la boîte de 
dialogue Playback Engine permettant d'attribuer 
des ressources DSP à la fonction de 
compensation de retard :

None n'attribue aucune ressource DSP pour la 
compensation de retard.

Short : attribue un nombre réduit de ressources 
DSP pour la compensation de retard de chaque 
canal. Il s'agit du paramètre le plus efficace pour 
les systèmes Pro Tools|HD.

Long : attribue un nombre maximal de 
ressources DSP pour la compensation de retard 
de chaque canal de console. Ce paramètre utilise 
les mêmes ressources DSP que celles des plug-in 
DSP haut-débit.
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Pour configurer le moteur de compensation de 
retard, procédez comme suit :

1  Sélectionnez Setup > Playback Engine.

2  Dans le menu déroulant Delay Compensation 
Engine, sélectionnez un paramètre de 
compensation de retard.

3  Cliquez sur OK.

L'état de la compensation de retard est 
enregistré en tant que préférence de session et 
préférence système.

Affichage de la compensation de 
retard

La vue de compensation de retard indique la 
quantité totale de retard sur chaque piste. Elle 
permet d'appliquer un décalage défini par 
l'utilisateur pour le retard de piste et elle affiche 
la quantité totale de retard appliquée par 
Pro Tools à chaque piste. La vue de 
compensation de retard est affichée dans la 
fenêtre Mix. 

Pour afficher les informations de compensation de 
retard : 

■ Sélectionnez View > Mix Window > Delay 
Compensation.

Les valeurs de retard peuvent être exprimées en 
échantillons ou en millisecondes, comme 
sélectionné sur la page Display Preferences.

Indicateur de retard de plug-In (dly)

L'indicateur de retard de plug-in (dly) affiche le 
retard total au niveau des inserts de plug-in et 
des inserts matériels sur la piste. La valeur 
correspondant au retard total permet à 
Pro Tools de calculer le retard appliqué aux 
autres pistes pour qu'elles restent synchronisées. 
Les informations de retard correspondant à la 
piste dont le retard est le plus important sont 
affichées en orange.

L'omission du retard indiqué pour la piste peut 
s'avérer utile si le retard total de plug-in sur une 
piste dépasse la valeur spécifiée pour le 
paramètre Delay Compensation Engine. Vous 
devez dans ce cas avancer manuellement la piste 
en fonction de la quantité affichée pour obtenir 
la compensation de retard appropriée pour cette 
piste, tout en continuant à utiliser la fonction de 
compensation de retard (voir Champ du 
décalage défini par l'utilisateur (+/–), page 603).

Procédez comme suit :

■ Tout en maintenant enfoncées les touches 
Démarrer-Ctrl (Windows) ou Pomme-Contrôle 
(Macintosh), cliquez sur l'indicateur de retard de 
plug-in. Le retard de la piste apparaît grisé. 
Pro Tools n'utilisera plus le retard de plug-in de 
cette piste pour calculer la compensation de 
retard des autres pistes. 

Champ du décalage défini par l'utilisateur (+/–)

Ce champ permet de régler les retards de pistes 
manuellement. Outre le retard automatique, des 
valeurs de retard (positives ou négatives) 
peuvent être spécifiées dans le champ +/-. 

Ceci s'avère particulièrement utile si vous 
souhaitez modifier le feeling d'une piste ou 
synchroniser une piste dans le cas où un plug-in 
renvoie un retard incorrect.

Affichage de la compensation de retard

Indicateur de retard

Décalage défini 

Indicateur de 

de piste

de plug-in

par l'utilisateur

compensation
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Pour modifier le retard de piste à l'aide du 
champ +/- :

1  Dans la vue de compensation de retard, 
cliquez dans le champ du décalage défini par 
l'utilisateur (+/-).

2  Pour définir la valeur de retard (en 
échantillons ou en millisecondes selon vos 
préférences actuelles), procédez de l'une des 
manières suivantes :

• Entrez une valeur positive (avec ou sans le 
modification +) ou négative (avec le 
modificateur -). 

• Tirez sur un champ sélectionné en 
maintenant enfoncée la touche Pomme 
(Macintosh) ou Ctrl (Windows) dans le 
champ +/- pour faire défiler une nouvelle 
valeur.

• Utilisez les flèches Haut et Bas pour 
augmenter ou réduire les valeurs 
numériques. 

3  Appuyez sur la touche Entrée.

Pour désactiver le retard défini par l'utilisateur :

■ Cliquez dans le champ +/- tout en maintenant 
enfoncées les touches Pomme-Contrôle 
(Macintosh) ou Ctrl-Démarrer (Windows). 
Le champ apparaît alors grisé et la valeur qui lui 
correspond n'est plus appliquée à la piste.

Indicateur de compensation de retard (cmp)

Cet indicateur affiche la valeur de compensation 
que Pro Tools applique à chaque piste. 

Retard dépassant la limite de 
compensation

Lorsque le retard total d'une piste dépasse la 
quantité de compensation disponible, Pro Tools 
applique la compensation maximale disponible 
et affiche les informations de retard en rouge 
(dans la vue de compensation de retard) pour 
toutes les pistes n'ayant pu être compensées. 
L'indicateur de compensation de retard situé 
dans la fenêtre Edit devient également rouge 
pour indiquer que le retard de piste dépasse la 
limite de compensation de retard. Dans ce cas, 
vous devez ignorer le retard de piste signalé (voir 
Indicateur de retard de plug-In (dly), page 603), 
puis régler la piste manuellement pour 
conserver la compensation de retard correcte 
(voir Champ du décalage défini par l'utilisateur 
(+/–), page 603).

Ecoute à latence réduite lors de 
l'enregistrement

Pour l'enregistrement, Pro Tools interrompt 
automatiquement la compensation de retard 
pour fournir un chemin d'écoute à latence 
réduite via les sorties principales des pistes 
prêtes pour l'enregistrement. Lorsqu'une piste 
audio est dotée de la permutation d'écoute 
TrackInput, prête à l'enregistrement (à l'arrêt) ou 
possède un point d'entrée en enregistrement, la 
compensation de retard de la piste est 
automatiquement interrompue et l'indicateur 
de compensation de piste affiche la valeur 0. 
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Vous pouvez interrompre cette suppression 
automatique de compensation de retard à tout 
moment de la manière suivante :

Pour appliquer la compensation de retard aux 
pistes sur lesquelles elle a été interrompue:

■ Tout en maintenant enfoncées les touches 
Démarrer-Ctrl (Windows) ou Pomme-Contrôle 
(Macintosh), cliquez sur l'indicateur de 
compensation de piste. Le retard de piste sera 
appliqué à la piste et l'indicateur de 
compensation de piste apparaît en bleu. 

Compensation de piste au niveau des 
entrées auxiliaires

La compensation de retard au niveau des entrées 
auxiliaires peut être ignorée pour vous 
permettre d'écouter les sources externes (comme 
les pistes audio d'un appareil vidéo asservi) à 
latence réduite, tout en relevant le retard de la 
piste.

Pour désactiver la compensation de retard d'une 
entrée auxiliaire :

Tout en maintenant enfoncées les touches 
Démarrer-Ctrl (Windows) ou Pomme-Contrôle 
(Macintosh), cliquez sur l'indicateur de 
compensation de piste. Le retard de piste porte 
la valeur 0 et apparaît grisé.

Compensation de retard pour un 
événement MIDI

Lorsque la compensation de retard est active, un 
événement MIDI enregistré de façon à sembler 
synchronisé avec des données à compensation 
de retard est en fait enregistré avec un décalage 
du retard total en vigueur. 

Pour compenser, les événements MIDI sont 
reculés dans le temps d'un retard total de session 
suivant chaque passage d'enregistrement MIDI. 

Enregistrement à latence réduite avec 
des instruments MIDI virtuels

Lorsqu'une piste MIDI ou d'instrument qui 
achemine des données MIDI vers un plug-in 
d'instrument est activée pour l'enregistrement, 
Pro Tools interrompt automatiquement la 
compensation de retard via les sorties 
principales de la piste audio ou de l'entrée 
auxiliaire dans lequel le plug-in d'instrument 
plug-in est inséré. Ceci permet une écoute sans 
latence du plug-in d'instrument au cours de 
l'enregistrement.

Plug-in de traitement MIDI et Audio

Certains plug-in de traitement audio (tels que 
Bruno et Reso) et de nombreux plug-in 
d'instrument vous laissent traiter des données 
audio tout en permettant aux données MIDI de 
contrôler les paramètres de traitement. Lorsque 
vous activez pour l'enregistrement une piste 
MIDI ou d'instrument qui contrôle un plug-in 
de traitement audio, la piste sur laquelle le plug-
in est inséré passe en mode à latence réduite, 
entraînant la lecture anticipée des données 
audio traitées. 

La compensation de retard des instruments 
MIDI virtuels ne fonctionne que lorsque 
toutes les connexions MIDI et audio sont 
réalisées dans Pro Tools. Par exemple, 
Pro Tools n'interrompt pas la 
compensation de retard lorsque vous 
utilisez ReWire pour connecter des 
synthétiseurs et des échantillonneurs 
dans d'autres applications client ReWire 
(telles que Live et Reason). 
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Pour que l'audio reste synchronisé durant 
l'enregistrement avec un plug-in commandé via 
MIDI sur une piste audio :

■ Tout en maintenant enfoncées les touches 
Démarrer-Ctrl (Windows) ou Pomme-Contrôle 
(Macintosh), cliquez sur l'indicateur de 
compensation de piste de la piste audio pour 
appliquer la compensation de retard. 

Pour que l'audio reste synchronisé durant 
l'enregistrement avec un plug-in commandé via 
MIDI sur une entrée auxiliaire :

1  Tout en maintenant enfoncées les touches 
Démarrer-Ctrl (Windows) ou Pomme-Contrôle 
(Macintosh), cliquez sur l'indicateur de 
compensation de piste de l'entrée auxiliaire 
pour désactiver la compensation de retard.

2  Entrez le retard système total dans le champ 
User Offset.

Dithering
Le dithering est une forme spécifique de bruit 
aléatoire, utilisé pour masquer le bruit de 
quantification dans les systèmes 
audionumériques. Lors des passages de très bas 
niveau, à l'extrémité inférieure de la plage 
dynamique d'un système audionumérique, 
d'importantes distorsions de quantification se 
produisent, ce qui se traduit par des 
performances très médiocres dans ce domaine. 
Le processus de dithering réduit les erreurs de 
quantification en introduisant un bruit aléatoire 
de très faible niveau, limitant les artefacts de 
distorsion lorsque le niveau du signal audio est 
faible. Le dithering est donc un compromis 
entre les performances en termes de rapport 
signal/bruit et de taux de distorsion. Une 

utilisation appropriée du dithering permet de 
tirer des performance subjectives maximales 
d'un format de données 16 bits (par exemple les 
CD à la norme Red Book). 

Les systèmes Pro Tools|HD traitent tous les sons 
en interne en 24 bits ; Pro Tools LE traite le son 
en interne en 32 bits virgule flottante. Si le 
passage de données 24 bits au format 16 bits 
n'est pas assuré via un dithering, les 8 bits 
excédentaires sont tronqués (complètement 
supprimés) lors de l'enregistrement sur un 
support ou une machine au format 16 bits (par 
exemple un graveur de CD, la plupart des 
machines DAT, etc.). Par ailleurs, le dithering 
garantit une fidélité spectaculaire aux bas 
niveaux, en ajoutant une petite quantité de 
bruit aux signaux. 

Dithering dans Pro Tools

Pro Tools offre plusieurs options de dithering. 
Chacune est destinée à une application 
spécifique au sein des différentes opérations 
susceptibles de bénéficier du dithering. 

Outre les plug-in de dithering, disponibles en 
version TDM, RTAS et AudioSuite, Pro Tools 
offre une fonction de dithering intégrée.

Plug-in Dither Mixer (systèmes Pro Tools HD 
uniquement Deux plug-in de consoles 
incorporent la fonction de dithering avec mise 
en forme du bruit : Stéréo avec dithering et 
Surround avec dithering. Pour plus 
d'informations, reportez-vous au Guide de 
démarrage Pro Tools|HD. Les consoles de mixage 
Stereo et Surround standard n'intègrent pas de 
fonction de dithering et nécessitent l'utilisation 
de plug-in de dithering.
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Dithering sur la sortie finale pour le mixage 
terminal Vous pouvez insérer un plug-in de 
dithering en temps réel sur une piste Master 
Fader pour contrôler le mixage de sortie, en vue 
d'un traitement du mixage final sur CD ou autre 
support 16 bits. Les inserts des pistes de fader 
principal assurent un traitement après fader. 
Cette forme de dithering permet d'utiliser des 
plug-in de dithering de Digidesign ou d'autres 
fabricants. Avant d'utiliser la commande 
Bounce to Disk, consultez la rubrique Dithering 
et prémixage sur disque (Bounce), page 680.

Dither AudioSuite Pour le traitement de plug-in 
AudioSuite, le dithering est basé sur le plug-in 
Dither.

Pour la plupart des plug-in AudioSuite, le 
dithering peut être appliqué automatiquement 
dans la boîte de dialogue Processing Preferences. 
La case Use AudioSuite Dither permet d'activer 
un dithering prédéfini avec noise shaping.

Les plug-in AudioSuite suivants peuvent 
appliquer automatiquement un dithering au 
cours du traitement : 

• EQ III

• Compressor II

• Limiter II

• Gate II

• Expander/Gate II

• Normalize

• de high shelf

• DC Offset Removal

• Time Compression/Expansion

• Pitch Shift

Fades et Crossfades Dans la boîte de dialogue 
Fades (Edit > Fades > Create Fades), l'option Use 
Dither active une présélection de dithering 
utilisant le noise shaping. 

Noise Shaping

Le bruit fait partie intégrante du processus de 
dithering. La mise en forme du bruit peut encore 
améliorer les performances audio et réduire le 
bruit perceptible inhérent au dithering. La 
fonction de mise en forme du bruit (noise 
shaping) décale par filtrage numérique les 
fréquences du bruit d'environ 4 kHz à proximité 
de la fréquence Nyquist. Ainsi mis en forme, le 
bruit se trouve déplacé dans des régions du 
spectre où notre oreille le perçoit beaucoup 
moins que sous sa forme d'origine.

Paramètres de fonctionnement par défaut, pour le 
dithering AudioSuite

Pour en savoir plus sur le dithering 
AudioSuite, consultez le Guide des plug-in 
Digi-Rack. 

Boîte de dialogue Create Fades
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La fonction de noise shaping (mise en forme du 
bruit) est disponible dans le plug-in Dither.

Utilisation d'une surface de 
contrôle avec Pro Tools
Les surfaces de contrôle ajoutent un contrôle 
concret aux fonctions de Pro Tools. L'utilisation 
d'une surface de contrôle permet de régler des 
faders et des boutons à l'écran, d'activer des 
contrôles de transport ou d'utiliser des fonctions 
scrub et shuttle dans Pro Tools.

Il existe plusieurs surfaces de contrôle 
(optionnelles) de Digidesign pouvant être 
utilisées pour le mixage avec Pro Tools : 

D-Control et D-Command de Digidesign 
(Pro Tools HD uniquement) : Surfaces de travail 
novatrices et tactiles qui se présentent sous la 
forme d'une console familière et intuitive dont 
la partie centrale regroupe les voies.

Digidesign ProControl (Pro Tools HD uniquement) 
et Control|24 (Pro Tools HD et LE uniquement) : 
Contrôleurs dédiés permettant d'accéder à 
toutes les fonctions d'enregistrement, de 
mixage, d'édition, d'assignation des signaux, de 
contrôle des plug-in et d'automation de 
Pro Tools. 

Command|8 de Digidesign : Surface de contrôle 
pour Pro Tools, compatible USB et d'un prix 
abordable. Command|8 est une surface de 
contrôle compacte, pratique et souple d'emploi 
destinée aux systèmes Pro Tools approuvé par 
Digidesign.

Pour en savoir plus sur le dithering en 
cours du mixage final, reportez-vous au 
Chapitre 28, Mixage final.
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Chapitre 26 : Plug-in et inserts 
matériels

Pro Tools permet de disposer de cinq inserts de 
gain unitaire sur chaque piste audio, d'entrée 
auxiliaire, de fader principal et d'instrument. Les 
inserts de pistes audio, d'entrée auxiliaire et 
d'instrument sont placés avant le fader et, les 
inserts de faders principaux sont placés après le 
fader.

Il peut s'agir de plug-in DSP logiciels ou d'inserts 
matériels. Les inserts Pro Tools envoient les 
signaux de la piste vers le plug-in ou le 
périphérique externe de votre choix, puis les 
renvoient automatiquement vers la même piste. 
Les inserts ne modifient pas les fichiers source 
audio originaux, mais traitent les sons en temps 
réel au cours de la lecture. Il est possible de 
« figer » à tout moment des effets en temps réel 
appliqués aux pistes, en les enregistrant ou en 
les prémixant sur disque (pour en savoir plus, 
reportez-vous au Chapitre 28, Mixage final).

Inserts plug-in : Les inserts plug-in sont des 
inserts logiciels qui traitent les données audio 
d'une piste en temps réel. Par exemple, DigiRack 
EQ, le compresseur et les plug-in Delay fournis 
avec votre système Pro Tools peuvent être 
utilisés en tant qu'inserts de plug-in en 
temps réel.

Vous pouvez vous procurer d'autres plug-in 
temps réel auprès de Digidesign et de nombreux 
autres développeurs. 

Inserts d'I/O matériels : Les inserts d'I/O 
matériels font passer les sons à travers un 
périphérique externe connecté aux entrées et 
aux sorties parallèles de votre interface audio. 
Le traitement des sons sur une piste peut être 
effectué à l'aide d'un insert matériel en temps 
réel.

Les chemins d'insertion nécessitent des entrées 
et des sorties de l'interface audio : ils sont 
déterminés lors de la configuration des I/O sur 
votre système.

Pour plus d'informations sur les plug-in 
livrés avec Pro Tools, consultez le Guide des 
plug-in DigiRack.

Pour plus d'informations sur les plug-in 
optionnels Digidesign, consultez le Guide 
des plug-in Digidesign. Pour en savoir plus 
sur les plug-in tiers, visitez le site Web 
Digidesign à l'adresse 
www.digidesign.com.

Insert d'I/O matériels
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Généralités

Lorsqu'une piste comporte plusieurs inserts, 
ceux-ci sont traités en série. Chaque effet vient 
donc s'ajouter à celui du plug-in ou de l'insert 
précédent (de haut en bas dans la vue Inserts de 
la fenêtre Mix et de gauche à droite dans la vue 
Inserts de la fenêtre Edit).

Les inserts des pistes audio, d'entrées auxiliaire 
et d'instrument sont disposés avant le fader. 
Si vous réglez les paramètres du plug-in sur des 
valeurs extrêmes, de gain notamment, vous 
risquez de provoquer un écrêtage, plus 
particulièrement sur les pistes enregistrées avec 
une amplitude élevée. Les vumètres 
apparaissant à l'écran permettent de surveiller 
l'écrêtage. (Les inserts des pistes De fader 
principal sont disposés après le fader.)

Utilisation des inserts pour les effets

Les inserts peuvent être utilisés de deux façons : 

Sur pistes uniques : Vous pouvez appliquer un 
insert à une piste audio, d'entrée auxiliaire, de 
fader principal ou d'instrument individuelle.

Dans le cas des inserts en ligne, la quantité 
d'effet désirée est ajustée à l'aide du 
potentiomètre Balance (Wet/Dry) du plug-in ou 
du périphérique externe.

En tant que ressources partagées : pour utiliser 
un insert en tant que ressource partagée, dans 
une disposition départ-retour, assignez les 
signaux de plusieurs pistes sur un même bus 
envoyé vers une entrée auxiliaire, puis 
appliquez l'insert à la piste d'entrée auxiliaire. 
Vous pouvez alors contrôler le niveau de départ 
sur chaque piste, et le niveau global de l'effet 

depuis la piste d'entrée auxiliaire. L'utilisation 
de départs et d'autres fonctions d'assignation 
des signaux permet l'optimisation de la 
puissance de traitement d'un système. 

Formats d'inserts

Inserts Mono : s'utilisent sur des pistes mono. 
Les inserts ajoutés à une piste après un insert 
stéréo sont automatiquement utilisés en stéréo.

Inserts stéréo : s'utilisent sur des pistes stéréo. 
Il est également possible de créer un insert d'I/O 
matériel stéréo sur une piste stéréo.

Insert de plug-in d'entrée mono/sortie stéréo : 
conçus pour renvoyer un effet stéréo à partir 
d'une source mono. Certains plug-in (par 
exemple D-Verb) permettent de générer une 
sortie stéréo à partir d'une voie mono. Une piste 
ainsi convertie au format stéréo dispose de 
commandes de panoramique pour chaque canal 
du signal stéréo. Tout insert placé sur une piste 
après un insert stéréo est automatiquement 
utilisé en stéréo.

Inserts de plug-in multimono : s'utilisent pour 
des pistes stéréo ou comportant davantage de 
canaux, lorsque aucune version multicanal du 
plug-in n'est disponible. Les commandes de tous 
les canaux sont liées par défaut afin de 
permettre un réglage par paire. Pour régler les 
commandes indépendamment, dissociez-les à 
l'aide du bouton Master Link. Reportez-vous à la 
section Couplage et découplage des contrôles 
sur les plug-in multimono, page 627.

Vous trouverez des exemples de bus de type 
départ/retour ainsi que d'autres 
configurations de prémixage à la section 
Prémixage avant affectation des signaux 
et traitement par effets, page 595. 
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Inserts de plug-in multicanal : s'utilisent pour 
des pistes multicanal au format stéréo ou 
supérieur. Sur les pistes multicanal de format 
supérieur au format stéréo, les commandes de 
tous les canaux sont généralement liées.

Plug-in TDM et RTAS

Pro Tools prend en charge trois formats de 
plug-in : TDM, RTAS et AudioSuite. Deux d'entre 
eux peuvent être utilisés comme inserts temps 
réel :

Plug-in TDM : Utilisés avec les systèmes 
Pro Tools HD, ces plug-in s'appuient sur la 
capacité de traitement des cartes DSP installées 
sur les systèmes Pro Tools|HD.

Plug-in RTAS : Les plug-in RTAS sont similaires à 
leurs équivalents TDM, mais contrairement à 
ces derniers, ils s'appuient sur, et sont limités 
par, la puissance de traitement hôte de votre 
ordinateur.

Plug-in AudioSuite : Plug-in de traitement de 
fichiers ne fonctionnant pas en temps réel, 
conçus pour Pro Tools (reportez-vous au Guide 
DigiRack).

Les plug-in peuvent être utilisés des manières 
suivantes, selon le logiciel Pro  Tools dont vous 
vous servez :

Pro Tools HD

• Vous pouvez appliquer des plug-in TDM et 
RTAS sur des pistes audio, d'entrée auxiliaire, 
de fader principal et d'instrument.

Pro Tools LE et M-Powered

• Vous pouvez appliquer des plug-in RTAS sur 
des pistes audio, d'entrée auxiliaire, de fader 
principal et d'instrument. 

Utilisation des voix et latence 
totale pour les plug-in RTAS
(Pro Tools HD uniquement)

Dans Pro Tools HD, et dans certaines conditions 
énoncées ci-après, l'insertion initiale d'un plug-
in RTAS peut provoquer une latence 
supplémentaire et requérir l'ajout de deux voix 
par canal (une voix pour l'entrée et une voix 
pour la sortie).

• insertion sur une piste d'entrée auxiliaire 
ou de fader principal ;

• insertion sur une piste d'instrument sans 
plug-in d'instrument ;

• insertion à la suite d'un plug-in TDM sur 
toute autre piste.

Ainsi, l'insertion initiale d'un plug-in RTAS sur 
une piste mono d'entrée auxiliaire requiert deux 
voix (pour un seul canal). En revanche, sur une 
piste d'entrée auxiliaire stéréo l'insertion de ce 
même plug-in requiert quatre voix (deux voix 
pour chaque canal).

Une nouvelle liaison peut provoquer la perte 
de l'automation. Voir Couplage et 
découplage des contrôles sur les plug-in 
multimono, page 627.

Avec Pro Tools HD, les plug-in RTAS placés 
sur des pistes d'entrée auxiliaire, de fader 
principal et d'instrument utilisent des 
voix supplémentaires et peuvent 
introduire une latence plus longue basée 
sur la taille du buffer matériel. Pour plus 
d'informations, reportez-vous à la section 
Utilisation des voix et latence totale pour 
les plug-in RTAS, page 611. 

Le Guide des plug-in DigiRack contient des 
conseils d'optimisation des performances 
RTAS.
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Pour les plug-in RTAS suivants insérés sur la 
même piste, aucune autre voix supplémentaire 
ne sera requise, à moins qu'un plug-in TDM soit 
inséré entre deux plug-in RTAS. 

En outre, il faut ajouter une voix 
supplémentaire pour chacun des cas suivants 
dans le cadre de l'insertion de plug-in RTAS sur 
une piste :

• utilisation de la clé de déclenchement 
externe d'un plug-in RTAS sur cette piste ;

• sélection de plusieurs sorties de piste pour 
cette piste (une voix par sortie) ;

• sélection d'une sortie AFL/PFL dans l'onglet 
Output de la boîte de dialogue I/O Setup 
(une voix par canal).

Affichage des inserts

Vous pouvez configurer les fenêtres Mix et Edit 
pour afficher ou masquer les inserts. Les fenêtres 
Plug-In permettent de modifier les commandes 
des plug-in. 

Pour afficher ou masquer des inserts :

■ Dans la fenêtre Mix (ou la fenêtre Edit), 
sélectionnez View > Mix Window (ou Edit 
Window) > Inserts.

– ou –

■ Sélectionnez Inserts View à partir du sélecteur 
de vue de la fenêtre Edit ou de la fenêtre Mix.

En règle générale, pour éviter le recours 
inutile à des voix supplémentaires ou 
davantage de latence, n'insérez pas de 
plug-in TDM entre deux plug-in RTAS.

Lorsque vous utilisez Pro Tools 6.9.x ou 
une version plus antérieure, l'ouverture 
d'une session créée avec Pro Tools 7.0 
provoque la désactivation des plug-in RTAS 
insérés sur des pistes d'entrée auxiliaire ou 
de fader principal, ou insérés à la suite de 
plug-in TDM sur un autre type de piste.

Affichage des inserts dans la fenêtre Mix

Affichage des inserts à l'aide du sélecteur de vue

Inserts

Sends (A–F)

Sélecteur de vue
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Affichage du statut de la fenêtre des 
plug-in

Dans les fenêtres Mix et Edit, le bouton Plug-In 
et le sélecteur permettent d'afficher le statut de 
désactivation du plug-in actuellement inséré 
(voir la section Désactivation de plug-in, 
page 627), le statut de la cible et celui de la 
fenêtre.

Indication de la cible du contrôleur

Si vous utilisez une surface de contrôle avec 
Pro Tools, un seul plug-in peut être « ciblé » à un 
moment donné. La cible de contrôleur actuelle, 
le cas échéant, est signalée par un contour 
coloré :

Désactivation des inserts

Il est possible de désactiver les plug-in et les 
inserts matériels pour libérer leurs ressources et 
les affecter à un autre usage. Lorsqu'il est 
désactivé, l'insert de plug-in conserve les 
informations relatives à son affectation, sa 
position et aux playlists d'automation qui lui 
sont associées. Toutefois, il ne laisse plus passer 
les données audio, et n'utilise pas de ressources 
DSP ou TDM.

A l'ouverture d'une session, les plug-in sont 
automatiquement désactivés dans les cas 
suivants :

• Les ressources DSP du système sont 
insuffisantes.

• Aucun plug-in n'est installé.

• Le type du plug-in n'est pas disponible (RTAS 
ou TDM). 

• L'ouverture de la session entraîne des 
substitutions de type de plug-in. C'est le cas 
par exemple lorsque le type de plug-in est 
disponible mais sa substitution entraîne une 
condition non prise en charge, telle que 
l'ouverture d'une session contenant un plug-
in HTDM pour lequel une version RTAS n'est 
pas disponible.

Pour désactiver un insert :

■ Cliquez sur l'élément, en maintenant 
enfoncées les touches Pomme + Contrôle 
(Macintosh) ou Contrôle + Démarrer 
(Windows) et le bouton Insérer

– ou –

■ Désactivez la piste. Pour plus d'informations, 
reportez-vous à la section Inactivation des 
pistes, page 138.

Pour activer ou désactiver les inserts dans la 
même position sur toutes les pistes :

■ Cliquez sur un bouton Insert pour l'activer ou 
le désactiver, en maintenant enfoncées les 
touches Pomme + Contrôle (Macintosh) ou 
Contrôle + Démarrer (Windows).

Indication de fenêtre de plug-in ouverte

Cible du contrôleur

Le nom du plug-in est illuminé

Contour indiquant le statut de cible
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Pour activer ou désactiver les inserts dans la 
même position sur toutes les pistes 
sélectionnées :

■ Cliquez sur un bouton Insert pour l'activer ou 
le désactiver en maintenant enfoncées les 
touches Pomme + Contrôle + Option + Maj 
(Macintosh) ou Ctrl + Démarrer + Alt +Maj 
(Windows).

Inserts de plug-in inactifs

Les inserts de plug-in inactifs conservent toutes 
les playlists d'automation qui leur sont 
associées. De plus, toutes les modifications 
apportées au cours de la session se répercutent 
sur les playlists d'automation des plug-in. Vous 
ne pouvez pas enregistrer d'automation ni 
ajuster de commandes pour un plug-in inactif.

Inserts matériels inactifs

Un insert matériel inactif conserve son 
affectation, mais ne laisse passer aucune donnée 
audio ni n'utilise de ressource DSP.

Insertion de plug-in sur les 
pistes
Pour utiliser un plug-in temps réel, vous devez 
l'insérer sur une piste. 

Pour insérer un plug-in sur une piste :

1  Assurez-vous que la vue Inserts s'affiche dans 
la fenêtre Mix ou Edit.

2  Cliquez sur le sélecteur d'insert sur la piste, 
puis sélectionnez le plug-in à utiliser. (Pour en 
savoir plus, reportez-vous à la section Plug-in 
TDM et RTAS, page 611.)

Pour supprimer un insert d'une piste :

■ Cliquez sur le sélecteur d'insert, puis 
choisissez No Insert.

Affichage de plug-in inactifs

Fenêtre d'affichage de plug-in inactifs

Les inserts matériels n'offrent pas de 
commande de désactivation. Vous pouvez 
utiliser la fonction de désactivation pour 
couper le volume (Mute) d'un insert matériel 
ou le désactiver. 

(en italique)
Actif
(texte simple) 

Inactif

Insertion d'un plug-in TDM

Suppression d'un plug-in

Sélecteur d'insert
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Ordre d'insertion des plug-in RTAS 
et TDM sur les pistes audio
(Pro Tools HD uniquement)

Dans Pro Tools HD, il existe plusieurs manières 
d'ordonner les plug-in RTAS et TDM sur une 
piste audio, d'entrée auxiliaire ou de fader 
principal :

Insertion des plug-in RTAS avant les plug-in TDM 

Dans cet ordre, aucune voix supplémentaire 
n'est nécessaire et aucun phénomène de latence 
ne se fait sentir. Les plug-in RTAS sont ignorés 
lorsque la fonction d'activation de 
l'enregistrement ou d'écoute TrackInput est 
activée pour cette piste. 

Insertion des plug-in TDM avant les plug-in RTAS 

Dans cet ordre, chaque insertion de plug-in 
RTAS provoque une latence du processus et 
requiert l'utilisation de voix supplémentaires, 
comme indiqué à la section Utilisation des voix 
et latence totale pour les plug-in RTAS, 
page 611. Les plug-in RTAS restent actifs lorsque 
la fonction d'activation de l'enregistrement ou 
d'écoute TrackInput est activée pour cette piste. 

Recommandations relatives à l'ordre 
d'insertion

Pour insérer des plug-in RTAS et TDM sur une 
piste audio, appliquez l'une des stratégies 
suivantes, en fonction de vos besoins :

• Pour vous assurer que les plug-in RTAS restent 
actifs lorsque la fonction d'enregistrement ou 
d'écoute TrackInput est activée, regroupez 
tous les plug-in TDM avant les plug-in RTAS.

– ou –

• Pour éviter des voix supplémentaires et 
minimiser l'effet de latence, regroupez tous les 
plug-in RTAS avant les plug-in TDM.

Configuration de plug-in pendant 
la lecture et l'enregistrement

Avant de réaliser les opérations suivantes, 
arrêtez la lecture.

• Glisser-déposer d'un plug-in vers un autre 
emplacement

• Insertion ou suppression d'un plug-in 
pendant l'enregistrement

• Insertion ou suppression d'un plug-in qui 
modifie un format de piste

• Insertion ou suppression d'un plug-in RTAS 
dans une piste d'entrée auxiliaire ou de 
fader principal

• Insertion d'un plug-in RTAS à la suite d'un 
plug-in TDM dans une piste audio

• Suppression d'un plug-in RTAS consécutif à 
un plug-in TDM dans une piste audio

• Insertion d'un plug-in TDM avant un plug-
in RTAS dans une piste audio

• Suppression d'un plug-in TDM antérieur à 
un plug-in RTAS dans une piste audio

En règle générale, pour l'insertion de plug-in 
sur une piste, regroupez toujours les plug-in 
du même type, en particulier si vous insérez 
des plug-in RTS à la suite de plug-in TDM. 
Cette précaution vous permet d'éviter le 
recours inutile à des voix supplémentaires.
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• Suppression d'un plug-in qui contient des 
données d'automation

• Activation des commandes d'automation 
de plug-in

• Configuration d'un déclenchement 
externe

Organisation du menu Plug-In
Vous pouvez personnaliser l'organisation des 
listes de plug-in (menus de plug-in) du sélecteur 
d'insert et du sélecteur de plug-in. 

Utilisez le menu déroulant Organize Plug-In 
Menus By de la page Display Preferences de 
Pro Tools pour organiser les menus de plug-in 
en liste simple (Flat List, plug-in affichés par 
ordre alphabétique), par catégorie (Category), 
fabricant (Manufacturer) ou, catégorie et 
fabricant (Category and Manufacturer). 

Menu déroulant Organize Plug-In Menus By

Flat List Permet de présenter les plug-in dans 
une liste simple triée par ordre alphabétique.

Category Affiche les plug-in par catégorie de 
processus (par exemple, EQ, Dynamics, Delay), 
chaque plug-in étant répertorié dans les sous-
menus de catégorie. Les plug-in ne 
correspondant pas à une catégorie standard (par 
exemple, DigiRack Signal Generator) ou les 
plug-in- tiers n'appartenant pas à une catégorie 
définie par leurs développeurs, figurent dans la 
catégorie Other. Les plug-in peuvent s'afficher 
dans plusieurs catégories. 

Les catégories de plug-ins comprennent :

• Egaliseur

• Dynamique

• Pitch Shift

• Réverbération

• Retard

• Modulation

• Harmonic

• Noise Reduction

• Dither

• Sound Field

• Hardware

• Instrument

Plug-in organisés par catégorie (à partir du sélecteur 
d'insert)

Sélecteur d'insert

Plug-in organisés par fabricant (à partir du sélecteur de 
plug-in)
Guide de référence Pro Tools



• Other

• Wrapped Plug-Ins

• Effects

Le sous-dossier Effects regroupe les effets 
spéciaux, les processeurs d'effets multiples et 
autres plug-in. Tout plug-in dont la catégorie 
fait référence à un type d'effet s'affiche dans le 
sous-dossier Effects.

Manufacturer Permet de classer les plug-in par 
fabricant (tel que Digidesign, Eventide, Line 6 et 
McDSP), chaque plug-in étant répertorié dans 
les sous-menus de fabricant. Les plug-in 
n'appartenant à aucun fabricant en particulier 
s'affichent dans le dossier Other. 

La plupart des plug-in tiers distribués par 
Digidesign sont regroupés sous le nom 
Digidesign lorsque cette option est activée.

Category and Manufacturer permet de classer les 
plug-in selon deux menus. Les menus de la 
partie supérieure de la fenêtre affichent les plug-
in par catégorie de processus (par exemple, EQ, 
Dynamics, Delay), chaque plug-in étant 
répertorié dans les sous-menus de catégorie. Les 
menus de la partie inférieure de la fenêtre 
affichent les plug-in par fabricant (par exemple, 
Digidesign, Eventide, Line 6 et McDSP), chaque 
plug-in étant répertorié dans les sous-menus de 
fabricant.

Pour choisir le type de classement des plug-in :

1  Ouvrez une session ou créez-en. 

2  Choisissez Setup > Preferences et cliquez sur 
l'onglet Display.

3  Cliquez sur une option du menu contextuel 
Organize Plug-In Menus By.

4  Cliquez sur Done (Terminé).

Le paramètre Organize Plug-In Menus By est 
enregistré avec les préférences Pro Tools (et non 
avec le fichier de session Pro Tools).

Prise en charge des surfaces de 
contrôle

Les surfaces de contrôle Digidesign équipées de 
témoins lumineux de diverses couleurs (tels que 
D-Control) indiquent les plug-in comme suit :

• Les catégories de plug-in (par exemple, EQ) 
et les fabricants de plug-in (par exemple, 
Digidesign) sont indiqués en vert.

• Les plug-in spécifiques placés dans les sous-
dossiers (par exemple, le plug-in EQ III 
contenu dans le sous-dossier EQ) sont 
indiqués en jaune (ambre).

Si aucun plug-in d'une catégorie donnée 
n'est installé sur votre système, le nom 
correspondant à cette catégorie ne 
s'affiche pas dans le menu.

Si aucun plug-in d'un fabricant donné 
n'est installé sur votre système, le nom 
correspondant à ce fabricant ne s'affiche 
pas dans le menu.

Page Display de la fenêtre Setup > Preferences
Chapitre 26 : Plug-in et inserts matériels 617



618
Les surfaces de contrôle ne disposant que d'un 
affichage unicolore (tels que ProControl et 
Command|8) ne distinguent pas les divers types 
de plug-in. Elles affichent le contenu d'un 
dossier de plug-in sous forme de liste simple. 
(Bien que les surfaces de contrôle unicolores ne 
distinguent pas les divers types de plug-in, le 
logiciel Pro Tools affiche lui les plug-in en 
fonction de leur paramètre Organize Plug-Ins 
Menu By.)

Plug-ins favoris

Désignez un plug-in en tant que favori pour y 
accéder plus rapidement. Les plug-in favoris 
s'affichent en tête du menu des plug-in. 

Le nom du plug-in favori s'affiche en gras dans 
les sous-menus de plug-in classés par catégorie.

Pour désigner un plug-in en tant que favori :

■ Cliquez sur le bouton Insert d'un plug-in tout 
en maintenant la touche Ctrl (Windows) ou la 
touche Pomme (Macintosh) enfoncée, puis 
sélectionnez un plug-in dans une catégorie pour 
l'enregistrer en tant que Favori.

Pour modifier le statut d'un plug-in favori :

■ Maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Macintosh) et cliquez sur le bouton 
d'insertion de plug-in. Ensuite, sélectionnez 
dans le menu le plug-in que vous ne souhaitez 
plus désigner en tant que favori. 

Vous pouvez sélectionner ce plug-in favori dans 
la liste des favoris au-dessus du menu des plug-
in ou dans le sous-menu des plug-in classés par 
catégorie. Dans ce dernier, le plug-in concerné 
apparaît en gras.

Déplacement et duplication 
d'inserts plug-in et d'inserts 
matériels
Pour déplacer ou dupliquer un insert, faites-le 
glisser vers un autre emplacement de la piste ou 
vers une autre piste. Les inserts déplacés ou 
dupliqués conservent leurs paramètres et leurs 
playlists d'automation d'origine.

Pour déplacer un insert :

■ Faites glisser l'insert jusqu'à l'emplacement 
choisi.

Affichage de menu des plug-ins favoris

Plug-ins favoris

Catégories de 
plug-ins

Vous ne pouvez ni insérer ni supprimer de 
plug-in au cours de l'enregistrement.

Déplacement d'un plug-in

Pour remplacer un insert, ainsi que 
l'automation, faites glisser un autre insert 
sur celui-ci.
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Pour dupliquer un insert :

■ Faites-le glisser vers l'emplacement choisi en 
appuyant sur la touche Option (Macintosh) ou 
Alt (Windows). Les inserts de plug-in dupliqués 
conservent leurs paramètres d'origine et leur 
automation.

Fenêtre Plug-In
La fenêtre Plug-In s'affiche lorsque vous cliquez 
sur le bouton Insert du plug-in d'une piste. Cette 
fenêtre flottante permet de modifier et de 
définir les commandes de tout insert de plug-in 
en temps réel utilisé sur une piste.

Sélecteur de piste : cette fonction permet 
d'accéder à une piste non MIDI au cours d'une 
session.

Sélecteur d'emplacement de l'insert : permet 
d'accéder à un insert de la piste en cours.

Sélecteur de plug-in : permet de sélectionner 
l'un des plug-in temps réel installés dans le 
dossier Plug-Ins créé à l'installation de Pro Tools.

Bouton Effect Bypass : ce bouton désactive le 
plug-in affiché. Vous pouvez ainsi comparer le 
son de la piste avec et sans effet.

Sélecteur de conversion de plug-in : ce menu 
permet de convertir l'insert d'un plug-in TDM 
en insert de plug-in RTAS de type identique (et 
inversement). Cette fonction ne peut être 
utilisée qu'avec des plug-in disponibles dans les 
deux formats.

Témoin : s'allume en rouge pour indiquer 
l'écrêtage d'un vumètre dans un plug-in (non 
disponible sur tous les plug-in). Le témoin 
d'écrêtage du plug-in suit les paramètres 
d'indication d'écrêtage de Pro Tools. 

Menu ΩSettings : ce menu permet de copier, de 
coller, d'enregistrer et d'importer les paramètres 
des plug-in.

Menu Librarian : restaure les fichiers de 
paramètres enregistrés à la racine du dossier du 
plug-in ou dans le dossier Settings de la session 
en cours. Reportez-vous à la section Utilisation 
du menu Librarian, page 622.

Boutons Paramètre précédent (–) et Paramètre 
suivant (+) : permet de sélectionner le 
paramètre de plug-in précédent ou suivant dans 
le menu Librarian.

Vous pouvez également dupliquer les 
départs. Voir Déplacement ou copie de 
départs, page 589.

Bouton d'insertion et sélecteur sur piste

Fenêtre Plug-In (Mono Trim)

Bouton d'insertion

Sélecteur d'insert

Menu Settings

Sélecteur de 
piste

Menu Librarian

Sélecteur

Sélecteur de plug-in Compare

Bouton
Target

Paramètre
précédent

Paramètre
suivant

Settings,
menu
sélecteur

Effet
Bypass

Bouton Safe

Bouton
Auto

Conversion
du plug-in

Témoin
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Bouton de sélection du paramètre de plug-in : 
permet d'accéder à la boîte de dialogue Plug-In 
Settings, qui contient la liste des fichiers de 
paramètres du plug-in actuel, dans laquelle vous 
pouvez sélectionner de nouveaux paramètres ou 
écouter les paramètres définis.

Compare : ce bouton permet de basculer entre 
les paramètres d'origine du plug-in et leurs 
valeurs après modification afin de les comparer.

Auto, bouton : active en enregistrement 
d'automation les commandes individuelles des 
plug-in. Reportez-vous à la section Automation 
de plug-in, page 650.

Automation Safe : interdit l'effacement des 
playlists d'automation du plug-in existantes.

Bouton Target : lorsque plusieurs fenêtres Plug-
In sont ouvertes, cliquez sur ce bouton pour 
définir le plug-in cible de toutes les commandes 
clavier. Pour plus d'informations, reportez-vous 
à la section Fenêtres « ciblées », page 594.

Sélecteur de déclencheur : permet de 
sélectionner les données audio d'une entrée ou 
d'un bus spécifique et de les acheminer afin de 
déclencher le plug-in. Ce menu n'apparaît que 
sur les plug-in qui prennent en charge le 
traitement par déclenchement externe. 
Les entrées de déclenchement (Trigger) sont 
monophoniques.

MIDI Node Display : affiche les informations 
relatives au nœud MIDI des plug-in compatibles 
MIDI. Les nœuds MIDI sont des connexions 
virtuelles qui relient Pro Tools à des instruments 
logiciels et à d'autres plug-in compatibles MIDI. 
Ils sont particulièrement utiles pour 
l'acheminement de pistes MIDI vers plusieurs 
canaux appartenant à un même périphérique 
MIDI virtuel. Les numéros des nœuds MIDI 
s'affichent également dans le sélecteur de sortie 
MIDI d'une piste.

Bouton Master Link : activez ce bouton pour lier 
les commandes de tous les canaux d'un plug-in 
multimono, afin de pouvoir les régler par paire.

Boutons Link Enable : assure une activation ou 
désactivation de la liaison sélective des 
commandes sur des canaux spécifiques d'un 
plug-in multimono. Chaque carré représente un 
canal d'enceinte. Désactivez le bouton Master 

Cette opération supprime le paramétrage 
actuel si celui-ci n'a pas été sauvegardé. 
Enregistrez toujours votre configuration 
dans le menu Librarian.

Affichage du nœud Midi dans l'en-tête d'un plug-in 
(Bruno)

Fenêtre Plug-In (EQ à 1 bande multimono)

Nœud MIDI

Sélecteur de 
déclencheur

Sélecteur de canal

Boutons Link Enable

Bouton Master Link

Inversion
de phase
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Link avant d'utiliser les boutons Link Enable. 
Reportez-vous à la section Couplage et 
découplage des contrôles sur les plug-in 
multimono, page 627.

Channel selector : permet d'accéder au canal 
spécifique d'une piste multicanal afin de 
modifier les commandes du plug-in. Ce menu 
apparaît uniquement sur les plug-in multimono 
insérés sur des pistes dotées de plusieurs canaux. 
Cliquez dessus en appuyant sur la touche 
Majuscule pour ouvrir une fenêtre Plug-In 
distincte pour chaque canal de la piste 
multicanal sur laquelle le plug-in est inséré.

Bouton Phase Invert : inverse la phase (polarité) 
du signal d'entrée.

Bouton LFE Enable : ce bouton active le 
traitement par plug-in d'un canal LFE (low 
frequency effects ou subwoofer) sur une piste 
multicanal au format 5.1, 6.1 ou 7.1 ou au 
format surround sur certains plug-in. Pour 
désactiver le traitement du LFE, désélectionnez 
ce bouton.

Tempo Sync : permet aux plug-in compatibles 
de se synchroniser automatiquement avec le 
tempo de la session, pour les retards rythmiques, 
l'écho et d'autres effets semblables.

Ouverture des fenêtres Plug-In

Pour ouvrir une fenêtre Plug-In :

■ Dans la bande de canal de la fenêtre Mix ou 
Edit, cliquez sur le bouton Plug-In.

Par défaut, chaque plug-in ouvert apparaît à 
l'emplacement d'un plug-in déjà ouvert et le 
remplace dans la fenêtre, au même 
emplacement. 

Ouverture de plusieurs fenêtres 
Plug-In

Pro Tools affiche généralement une seule 
fenêtre Plug-In permettant de régler les 
commandes de n'importe quel plug-in d'une 
session. Vous pouvez également ouvrir d'autres 
fenêtres Plug-In de plug-in spécifiques. Lorsque 
vous travaillez avec plusieurs fenêtres Plug-In, 
cliquez sur le bouton de cible correspondant au 
plug-in dont vous souhaitez modifier les 
commandes à l'aide de celles du clavier.

Pour ouvrir d'autres fenêtres Plug-In :

■ Dans la fenêtre Mix, appuyez sur la touche 
Maj, puis cliquez sur le bouton Insert d'un 
plug-in.

Pour ouvrir une fenêtre Plug-In pour chaque canal 
d'un plug-in multimono :

■ Dans la fenêtre Plug-In d'un insert de plug-in, 
appuyez sur la touche Option (Macintosh) ou 
Alt (Windows) et cliquez sur le sélecteur de 
canal. 

Pour fermer toutes les fenêtres Plug-In ouvertes :

■ Appuyez sur la touche Option (Macintosh) ou 
Alt (Windows) et cliquez sur la case de fermeture 
de toutes les fenêtres Plug-In. 

Fenêtre Plug-In (compresseur multicanal)

Bouton LFE

Boutons d'inversion de phase
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Commandes de la fenêtre Plug-In

Outre les paramètres d'égaliseurs, de processeurs 
de dynamique et autres paramètres spécifiques 
au processeur d'effet, tous les plug-in utilisent 
les commandes Pro Tools standard pour la 
sélection des pistes et des inserts, la 
désactivation, etc. 

Pour sélectionner un autre plug-in sur la même 
piste :

■ Cliquez sur le sélecteur d'insert, puis 
sélectionnez un plug-in dans le menu déroulant.

Pour choisir une autre piste :

■ Cliquez sur le sélecteur de piste, puis 
choisissez une piste dans le menu déroulant.

Fenêtre Target et raccourcis de paramètres

Lorsque plusieurs fenêtres Plug-In sont ouvertes, 
la fenêtre cible (Target) est indiquée par une 
cible en surbrillance. Pro Tools conserve une 
seule fenêtre Plug-In cible. L'ouverture d'un 
nouveau plug-in entraîne celle d'une nouvelle 

fenêtre cible, au même emplacement que la 
précédente. De plus, la fenêtre Plug-In cible 
constitue également la cible des raccourcis 
clavier de configuration du plug-in. 

Utilisation du menu Librarian
Les paramètres du menu Librarian permettent 
de créer facilement une bibliothèque de 
paramètres de plug-in. A partir des menus 
Librarian et Settings, vous pouvez copier, coller, 
enregistrer et importer ces paramètres d'un plug-
in à l'autre ou d'une session à l'autre.

Une fois vos fichiers de paramètres créés et 
enregistrés sur le disque (et après avoir indiqué à 
Pro Tools l'emplacement de leur dossier racine), 
ils apparaissent dans le menu Librarian (et dans 
la boîte de dialogue Plug-In Settings).

Sélection d'un plug-in dans la fenêtre Plug-In

Sélection d'une piste dans la fenêtre Plug-In

Menu Librarian

Vous pouvez également utiliser la boîte de 
dialogue Plug-In Settings pour sélectionner 
des paramètres ou les écouter. Pour plus 
d'informations, reportez-vous à la section 
Boîte de dialogue Plug-In Settings, 
page 626.
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Menu des paramètres

Utilisez les commandes du menu Settings pour 
enregistrer, copier, coller et gérer les fichiers de 
paramètres des plug-in.

Les commandes du menu Settings 
comprennent :

Save Settings : enregistre les paramètres actuels. 
Cette commande remplace toute version 
précédente des paramètres. Ces derniers 
apparaissent ensuite dans le menu Librarian.

Save Settings As : enregistre les paramètres 
actuels sous un nouveau nom.

Copy Settings : copie les paramètres actuels. 
Vous pouvez ensuite appliquer ces paramètres 
au même type de plug-in sur une autre piste en 
choisissant la piste dans la fenêtre Plug-In et en 
collant les paramètres à l'aide de la commande 
Paste Settings.

Paste Settings : colle les paramètres copiés à 
l'aide de la commande Copy Settings.

Import Settings : importe un fichier de 
paramètres non contenu dans les dossiers Root 
Settings ou Session. 

Delete Current Settings File : supprime de façon 
permanente le fichier de paramètres actuel du 
disque.

Lock Settings File : interdit le remplacement des 
paramètres actuels via la commande Save. 
Si vous tentez d'enregistrer des paramètres 
modifiés, vous devrez utiliser un nom ou un 
emplacement différent.

Set As User Default : définit les paramètres 
actuels comme les paramètres utilisateur par 
défaut pour un plug-in spécifique.

Settings Preferences

Les sous-menus Settings Preferences permettent 
de définir plusieurs préférences concernant 
l'enregistrement et l'importation des paramètres 
de plug-in. Il s'agit des plug-in suivants :

Set Plug-In Default To : applique aux paramètres 
par défaut la configuration Factory Default 
(paramètres d'usine standard pour ce plug-in) ou 
User Default (vos paramètres).

Save Plug-In Settings To : sélectionne le dossier 
dans lequel les paramètres des plug-in sont 
enregistrés. Si vous choisissez Session Folder, les 
paramètres sont enregistrés dans un dossier 
nommé Plug-In Settings, à l'intérieur du dossier 
Session actif. Si vous choisissez Root Settings 
Folder, les paramètres sont enregistrés dans le 
dossier spécifié à l'aide de la commande Set Root 
Settings Folder.

Set Root Settings Folder : sélectionne un dossier 
source ou racine pour enregistrer et importer des 
paramètres. Le dossier des paramètres racine 
doit être nommé Plug-In Settings. N'utilisez 
cette commande que si vous souhaitez choisir 
un emplacement autre que le dossier Plug-In 
Settings.

Menu Settings
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L'emplacement par défaut du dossier Root Plug-
In Settings est le suivant :

Windows : Program Files\Common Files\
Digidesign\DAE\Plug-In Settings

Macintosh : Library/Application Support/
Digidesign/Plug-In Settings 

Choix d'une destination pour les 
paramètres

Avant d'enregistrer des paramètres de plug-in, 
choisissez leur dossier de destination.

Pour sélectionner un dossier de destination : 

■ Dans le menu contextuel Settings, 
sélectionnez Settings Preferences > Save Plug-In 
Settings To, et Session Folder ou Root Settings 
Folder.

Si vous choisissez Root Settings Folder, Pro Tools 
enregistre les données dans le dossier Plug-In 
Settings, à moins que vous n'ayez spécifié un 
emplacement différent pour le dossier Root 
Settings.

Pour sélectionner un autre dossier Root Settings :

1  Dans le menu contextuel Settings, choisissez 
Settings Preferences > Set Root Settings Folder.

2  Choisissez le dossier Root à utiliser et cliquez 
sur Select. 

Création de sous-dossiers de 
paramètres

Pour faciliter la recherche de paramètres 
spécifiques, vous pouvez diviser les fichiers de 
paramètres en créant des sous-dossiers.

Pour créer un sous-dossier de paramètres :

3  Dans le menu déroulant Settings, sélectionnez 
Save Settings.

4  Cliquez sur le bouton New Folder et attribuez 
un nom au sous-dossier.

5  Attribuez un nom à votre paramètre, puis 
cliquez sur Save. Le fichier est enregistré dans le 
sous-dossier. 

Gestion des paramètres

Le menu déroulant Settings permet de gérer vos 
paramètres.

Pour enregistrer un paramètre : 

1  Dans le menu contextuel Settings, 
sélectionnez Save Settings.

2  Saisissez un nom et cliquez sur OK. Ce fichier 
apparaît dans le menu Librarian.

Pour enregistrer les paramètres de plug-in 
dans un emplacement autre que le dossier 
Plug-In Settings, créez d'abord un dossier 
appelé Plug-In Settings dans son nouvel 
emplacement, puis enregistrez vos données 
dans ce dossier. Menu Librarian

Le paramétrage des plug-in multimono 
non liés répond à des règles spécifiques. 
Reportez-vous à la section Couplage et 
découplage des contrôles sur les plug-in 
multimono, page 627.
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Pour charger un fichier de paramètres 
préalablement enregistré :

■ Choisissez le paramètre dans le menu 
contextuel Librarian.

Pour importer un paramètre : 

1  Dans le menu contextuel Settings, choisissez 
Import Settings.

2  Recherchez le fichier de paramètres que vous 
souhaitez importer, puis cliquez sur Open. 
Pro Tools charge le paramètre et le copie dans le 
fichier de destination racine.

Pour copier un paramètre : 

■ Dans le menu contextuel Settings, 
sélectionnez Copy Settings.

Pour coller un paramètre : 

1  Ouvrez le plug-in de destination.

2  Sélectionnez Paste Settings dans le menu 
contextuel Settings.

Pour créer un ensemble de paramètres utilisateur 
par défaut : 

1  Créez un paramètre et enregistrez-le.

2  Sélectionnez la commande Set As User Default 
dans le menu contextuel Settings. 

Pour qu'un plug-in adopte par défaut vos valeurs 
personnalisées de paramètres : 

■ Dans le menu contextuel Settings, choisissez 
Settings Preferences > Set Plug-In Default To > 
User Setting.

Modification des paramètres à l'aide 
des boutons Paramètre précédent (–) 
et Paramètre suivant (+)

Ces boutons permettent de sélectionner le 
paramètre de plug-in précédent ou suivant dans 
le menu Librarian.

Pour modifier des paramètres d'un plug-in à l'aide 
des bouton +/– :

■ Cliquez sur le bouton (–) ou (+) pour 
sélectionner respectivement le fichier de 
paramètres du plug-in précédent ou suivant. 
Une fois le fichier de paramètres précédent ou 
suivant activé, le menu Librarian est mis à jour 
avec les changements.

Modification des paramètres de plug-in 
multimono non liés

Lorsqu'un plug-in multimono n'est pas lié, les 
paramètres importés, copiés, collés ou 
désactivés ne concernent que le canal 
sélectionné.

Pour appliquer des changements à tous les 
canaux d'un plug-in non lié :

■ Appuyez sur Option (Macintosh) ou Alt 
(Windows) tout en sélectionnant la commande.

Pour enregistrer les paramètres de plug-in, 
appuyez sur Pomme + Maj + S (Macintosh) 
ou sur Ctrl + Maj + S (Windows).

Pour copier les paramètres de plug-in, 
appuyez sur Pomme + Maj + C 
(Macintosh) ou sur Ctrl + Maj + C 
(Windows).

Appuyez sur Pomme + Maj + V 
(Macintosh) ou sur Ctrl + Maj + V 
(Windows) pour coller les paramètres de 
plug-in.

Cette opération supprime le paramétrage 
actuel si celui-ci n'a pas été sauvegardé. 
Enregistrez toujours votre configuration 
dans le menu Librarian.
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Boîte de dialogue Plug-In Settings

La boîte de dialogue Plug-In Settings contient la 
liste de tous les fichiers de paramètres pour le 
type de plug-in actuel. Dans cette liste, vous 
pouvez sélectionner de nouveaux paramètres ou 
écouter les paramètres définis. L'écoute des 
paramètres de plug-in sert particulièrement à la 
sélection de noms de patch pour les plug-in 
d'instruments MIDI virtuels ou aux essais 
d'effets appliqués à vos données audio. 

Utilisez le menu déroulant Folder situé en haut 
de la boîte de dialogue Settings pour passer d'un 
sous-dossier de paramètres de plug-in à un autre, 
ou d'un dossier racine à un dossier de 
paramètres de session.

La boîte de dialogue Plug-In Settings comporte 
les sections suivantes :

Folder : ce menu déroulant permet de passer 
d'un paramètre à un autre, dans les dossiers 
racine et de session (et sous-dossier éventuels).

Patch Field : ce champ indique le nom du 
paramètre actuel, en surbrillance dans la liste.

Increment Patch Every X Sec : cette option 
permet d'écouter les paramètres de plug-in à la 
volée par défilement de la liste pendant une 
durée déterminée (exprimée en secondes).

Pour modifier des paramètres d'un plug-in à l'aide 
de la boîte Plug-In Settings :

1  Cliquez sur le bouton de sélection de 
paramètres.

2  Dans la liste de la boîte de dialogue, 
sélectionnez un paramètre de plug-in.

– ou –

A l'aide des touches fléchées; parcourez la liste 
jusqu'au paramètre de votre choix. 

3  Cliquez sur Done (Terminé).

Boîte de dialogue Plug-in Settings

Pour basculer entre les sous-dossiers de 
paramètres, appuyez sur la touche Pomme 
(Macintosh) or Ctrl (Windows) et utilisez 
les touches fléchées Haut/Bas.
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Ecoute de paramètres de plug-in

Lorsque la boîte Plug-in Settings est ouverte, 
Pro Tools peut parcourir automatiquement la 
liste des paramètres et lancer l'écoute des fichiers 
de paramètres enregistrés dans le dossier racine 
des paramètres de plug-in ou dans le dossier des 
paramètres de la session en cours.

Pour écouter des paramètres de plug-in :

1  Cliquez sur le bouton de sélection de 
paramètres.

2  Dans la liste de la boîte de dialogue, cliquez 
sur le paramètre qui définira le début du 
défilement.

3  Entrez le nombre de secondes désiré entre 
chaque changement de programme.

4  Sélectionnez l'option Increment Patch.

Une fois la durée spécifiée écoulée, Pro Tools 
sélectionne le paramètre suivant. 

5  Après avoir écouté les paramètres souhaités, 
effectuez l'une des opérations suivantes :

• Cliquez sur Done pour arrêter 
l'incrémentation des patchs et fermer la 
boîte de dialogue Plug-in Settings.

– ou –

• Cliquez sur Increment Patch pour arrêter 
l'incrémentation des patchs et laisser la 
boîte de dialogue Plug-In Settings ouverte.

Désactivation de plug-in

Il est possible de désactiver (contourner) les 
plug-in depuis la fenêtre Plug-In correspondante 
ou depuis la vue Inserts des fenêtres Mix et Edit. 

Pour désactiver un plug-in :

■ Cliquez sur le bouton Effect Bypass de la 
fenêtre Plug-in.

– ou –

■ Cliquez sur le bouton Insert du plug-in dans la 
fenêtre Mix ou Edit en appuyant sur la touche 
Pomme (Macintosh) ou Ctrl (Windows). 

Couplage et découplage des 
contrôles sur les plug-in 
multimono

Lorsqu'un plug-in multimono est appliqué sur 
une piste stéréo ou une piste multicanal de 
format supérieur au format stéréo (Pro Tools HD 
uniquement), les commandes sont couplées par 
défaut. Le réglage du contrôle Gain sur un canal, 
par exemple, est étendu à tous les autres canaux.

Vous pouvez dissocier les commandes de plug-
in sur des canaux spécifiques d'une piste et les 
modifier indépendamment. Vous pouvez 
également lier les commandes de manière 
sélective sur certains canaux seulement.

Lorsqu'un insert de plug-in est ignoré, le 
sélecteur d'insert de la fenêtre Mix devient 
bleu pour faciliter le repérage visuel. Si 
certains canaux d'un plug-in multimono 
non lié sont ignorés, le sélecteur d'insert 
apparaît en violet.

Indication de l'état du plug-in désactivé

désactivé (bleu)

Certains canaux 
sont désactivés 
(magenta)

non
désactivé
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Pour dissocier les commandes d'un plug-in 
multimono :

■ Désélectionnez le bouton Master Link.

Pour accéder aux commandes d'un canal 
particulier :

■ Sélectionnez le canal dans le sélecteur 
correspondant.

Pour lier les commandes de canaux spécifiques :

1  Désélectionnez le bouton Master Link, si ce 
n'est déjà fait.

2  Cliquez sur les boutons Link Enable 
correspondant aux canaux dont vous souhaitez 
lier les commandes. Par exemple, sur les plug-in 
offrant des commandes LFE distinctes du 
bouton LFE Enable, vous pouvez lier tous les 
canaux à l'exception de celui de LFE en mettant 
en surbrillance les icônes représentant les cinq 
enceintes dans un plug-in multimono.

Réglage des commandes de 
plug-in
Pour régler une commande de plug-in, déplacez 
le curseur correspondant ou saisissez une valeur 
dans la zone de texte associée. Pour modifier 
certains plug-in spécifiques, consultez la 
documentation correspondante (par exemple le 
Guide des plug-in DigiRack et le Guide des plug-in 
Digidesign).

Pour régler une commande de plug-in :

1  Lancez la lecture audio afin d'entendre en 
temps réel les réglages apportés à la commande.

2  Réglez les commandes du plug-in pour obtenir 
l'effet souhaité.

3  Lorsque vous refermez la fenêtre Plug-In, les 
modifications les plus récentes sont enregistrées.

Raccourcis clavier

◆ Pour affiner les réglages, appuyez sur la touche 
Commande (Macintosh) ou Ctrl (Windows) et 
faites glisser la commande.

◆ Pour restaurer la valeur par défaut d'une 
commande, appuyez sur la touche Option 
(Macintosh) ou Alt (Windows) et cliquez sur 
celle de votre choix. 

Sélecteur de canal et commandes de liaison (liaison 
désactivée)

Tous les canaux sont liés, à l'exception du LFE.

Sélecteur de canal

Boutons Link Enable

Bouton Master Link
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Raccourcis clavier des 
commandes de plug-in

Vous pouvez modifier les commandes d'un 
plug-in à partir de votre clavier.

Si plusieurs fenêtres Plug-In sont ouvertes, la 
saisie au moyen de la touche Tab et du clavier 
concerne le plug-in ouvert dans la fenêtre cible.

Pour régler une commande à l'aide du clavier :

• Pour activer le champ, cliquez dans la zone de 
texte de la commande à régler ou utilisez la 
touche Tab. Saisissez la valeur requise.

• Dans les champs qui acceptent les valeurs 
exprimées en kilohertz, ajoutez la lettre k à la 
suite d'un nombre pour le multiplier par 
1 000. Pour indiquer 8 000, par exemple, 
saisissez 8k.

• Pour augmenter une valeur, appuyez sur la 
touche fléchée vers le haut du clavier. Pour 
diminuer une valeur, appuyez sur la touche 
fléchée vers le bas du clavier.

• Pour valider une valeur saisie (sans quitter le 
champ de la commande sélectionnée), 
appuyez sur la touche Entrée du pavé 
numérique.

• Pour valider la saisie et quitter le mode 
d'édition au clavier, appuyez sur la touche 
Retour (Macintosh) ou Entrée sur le clavier 
QWERTY (Windows).

• Pour vous déplacer d'un champ de commande 
au suivant, appuyez sur la touche Tab. Pour 
revenir au champ précédent, appuyez sur 
Maj + Tab. 

• Appuyez sur les touches Alt-C (Windows) ou 
Option-C (Macintosh) pour supprimer 
l'écrêtage de plug-in.

Automation de plug-in et Safe

Tous les plug-in en temps réel peuvent être 
entièrement automatisés, et prennent en charge 
tous les modes d'automation de Pro Tools 
(Write, Touch, Latch et Trim). 

Le bouton Auto ouvre la boîte de dialogue Plug-
in Automation qui permet d'activer des 
paramètres individuels de plug-in pour 
l'enregistrement d'automation. Pour en savoir 
plus, voir Automation de plug-in, page 650.

Le bouton Safe active le mode Automation Safe. 
Son activation interdit l'effacement des playlists 
d'automation du plug-in existant. Reportez-
vous à la section Protection contre 
l'enregistrement de l'automation de plug-in, 
page 651.)

Utilisation d'un déclenchement 
externe

Le déclenchement externe se fonde sur un signal 
utilisé par le détecteur d'un plug-in pour 
déclencher le traitement dynamique. Ce signal 
est généralement lancé en interne, à partir du 
signal d'entrée. Néanmoins, certains plug-in 
offrent la possibilité de basculer entre le 
traitement par déclenchement interne et par 
déclenchement externe.

La fenêtre Plug-In cible constitue également 
la cible des raccourcis clavier de 
configuration du plug-in. Pour définir un 
plug-in comme cible de n'importe quelle 
commande clavier (y compris des 
raccourcis), cliquez sur le bouton Target 
requis dans la fenêtre Plug-In.
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Dans le cas du traitement par déclenchement 
externe, le détecteur d'un plug-in est déclenché 
par un signal externe (une source audio ou une 
piste de référence distincte, par exemple) aussi 
appelé déclencheur.

Le traitement par déclenchement externe sert 
généralement à contrôler la dynamique d'un 
signal audio (celui qui entre dans le plug-in) à 
l'aide d'un autre signal (le déclencheur). Une 
piste de grosse caisse, par exemple, peut servir à 
déclencher un noise gate sur une piste de basse 
pour préserver l'impact rythmique ou une piste 
de guitare rythmique peut servir à filtrer un 
clavier.

Filtres de déclenchement externe

Certains plug-in comportent des filtres passe-
haut et passe-bas sur la clé de déclenchement 
externe. Ces commandes permettent de définir 
une gamme de fréquences du signal qui servira 
au déclenchement de l'effet du plug-in. Une 
astuce de production assez courante consiste à 
se servir de ces filtres pour, à partir d'une piste de 
batterie, activer le déclenchement uniquement 
à partir des sons riches en aigus (charley, par 
exemple) ou en graves (tom ou grosse caisse par 
exemple). 

Utilisation d'un déclencheur pour le 
traitement par déclenchement externe

Pour utiliser un déclencheur en vue du traitement 
par déclenchement externe :

1  Cliquez sur le sélecteur de déclencheur et 
choisissez l'entrée ou le bus audio à utiliser pour 
déclencher le plug-in.

2  Pour activer le traitement par déclenchement 
externe, cliquez sur External Key.

3  Appuyez sur la barre d'espace pour lancer la 
lecture. Le plug-in utilise l'entrée ou le bus que 
vous avez choisi(e) comme déclencheur d'effet.

4  Pendant la lecture, réglez le déclencheur d'une 
des manières suivantes :

• Pour entendre la source audio sélectionnée 
afin de contrôler le déclencheur, cliquez sur 
le bouton Side-Chain Listen ou Key Listen 
(selon le plug-in). Une fois le réglage 
effectué, désactivez les boutons Side-Chain 
Listen ou Key Listen pour revenir au 
contrôle normal de plug-in.

• Pour filtrer le déclencheur de sorte à ne 
déclencher le plug-in qu'à certaines 
fréquences, définissez la gamme de 
fréquences souhaitée à l'aide des 
commandes de filtrage, si elles existent.

5  Au besoin, réglez également le seuil de 
déclenchement à l'aide de la commande 
Threshold (seuil) du plug-in (si disponible) et 
d'autres commandes.

Sélection d'un déclencheur
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Utilisation d‘inserts matériels
Vous pouvez connecter des périphériques 
externes, tels que des processeurs de 
réverbération ou d'effets, à votre système 
Pro Tools, puis les utiliser en tant qu'inserts 
matériels sur des pistes individuelles ou sur des 
prémixages.

Les inserts Pro Tools envoient et récupèrent les 
sons par l'intermédiaire de canaux d'entrée et de 
sortie matériels correspondants. La boîte de 
dialogue I/O Setup permet de définir les inserts 
et de faire correspondre leurs canaux à ceux de 
l'interface audio. 

Pour utiliser un périphérique en insertion, 
connectez-le aux entrées et sorties 
correspondantes de votre système. Par exemple, 
un insert matériel fourni par les sorties 7–8 doit 
être renvoyé à des entrées matérielles 7–8. 

Pour définir des inserts matériels :

1  Choisissez Setup > I/O, puis cliquez sur 
l'onglet Inserts. 

2  Sélectionnez un chemin d'insertion ou cliquez 
sur New Path pour en créer un.

3  Cliquez deux fois sur le nom du chemin pour 
attribuer un nom de chemin personnalisé à 
l'insert.

4  Assurez-vous que le chemin de l'insert est 
correct (mono, stéréo ou autre).

5  Placez à votre convenance les inserts dans la 
grille de la voie. Les chemins d'inserts et de 
sortie sont régis par des règles particulières en ce 
qui concerne la correspondance aux voies (voir 
Canaux superposés et chemins valides :, 
page 100).

Assignation d'inserts matériels

Pour affecter un insert matériel externe à une 
piste :

■ Choisissez un insert dans le sélecteur d'insert 
de la piste. 

Désactivation d'inserts matériels

Les inserts matériels n'offrent pas de commande 
de désactivation. Pour écouter en lecture sans 
passer par l'insert matériel, vous pouvez soit 
désactiver l'insert, soit le supprimer en le 
réassignant sur No Insert, ou encore utiliser le 
commutateur Bypass situé sur le périphérique 
matériel lui-même. Pour en savoir plus, voir 
Désactivation des inserts, page 613.

La compensation de retard peut être 
appliquée aux inserts matériels. Pour plus 
d'informations, reportez-vous à la section 
Compensation H/W Insert Delay, 
page 109.

Sélection d'un insert d'I/O matériel
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Connexion et intégration de 
périphériques externes
Pro Tools peut créer des connexions dédiées vers 
des périphériques externes analogiques ou 
numériques. Le nombre et le type des 
connexions dépend du type de système utilisé.

Pour relier un périphérique externe à un système 
Pro Tools : 

1  Reliez une sortie inutilisée (ou une paire de 
sorties dans le cas d'un périphérique stéréo) du 
système Pro Tools à une entrée du processeur 
externe de signaux.

2  Reliez la sortie du processeur externe de 
signaux à une entrée inutilisée (ou une paire 
d'entrées dans le cas d'un périphérique stéréo) 
du système Pro Tools.

3  Dans les boîtes de dialogue Hardware Setup ou 
I/O Setup, définissez les ports physiques à 
acheminer vers les ports d'entrée et de sortie 
Pro Tools.

4  Définissez les chemins de sortie, d'entrée ou 
d'insertion appropriés dans la boîte de dialogue 
I/O Setup. 

Pour utiliser un périphérique en insertion, 
connectez-le aux entrées et sorties 
correspondantes de votre système. Pour utiliser 
les sorties 7–8, par exemple, l'insert doit utiliser 
également les entrées 7–8. 

Connexion numérique d'unités 
d'effets

Pour utiliser les entrées et les sorties numériques 
du système Pro Tools en tant que départs et 
retours d'effets vers un périphérique d'effets 
numérique, c'est Pro Tools qui fournit le signal 
d'horloge de référence dans la plupart des cas. 
Configurez l'effet numérique pour lui faire 
accepter une horloge numérique externe afin de 
le synchroniser avec Pro Tools.

Pour configurer un départ numérique vers un 
périphérique externe à partir d'un système 
Pro Tools|HD :

1  Effectuez l'une des opérations suivantes :

• Sur le canaux 192 I/O, 192 Digital I/O, 
96 I/O, 96i I/O ou 888|24 I/O, choisissez 
Setup > Hardware, sélectionnez le 
périphérique, le format et le format 
d'horloge, puis définissez la paire de 
canaux sur l'entrée numérique (Digital).

• Dans une interface d'E/S 882|20 ou 1622, 
choisissez Setup > Hardware, choisissez le 
périphérique, puis réglez l'entrée de canal 
1-2 sur l'entrée numérique.

2  Sélectionnez Internal dans le menu déroulant 
de la source d'horloge.

3  Cliquez sur OK. 

Pour en savoir plus sur la connexion des 
périphériques externes, reportez-vous au 
Guide de démarrage Pro Tools.
Guide de référence Pro Tools



Pour configurer un départ numérique vers un 
périphérique externe à partir d'un système 
Digi 002 ou Digi 002 Rack 

1  Choisissez Setup > Playback Engine et 
sélectionnez le périphérique.

2  Effectuez l'une des opérations suivantes :

• Si le périphérique externe est connecté aux 
prises cinch S/PDIF, désélectionnez l'option 
S/PDIF Mirroring. (Lorsque l'option S/PDIF 
Mirroring est activée, la sortie numérique 
des prises cinch S/PDIF reflète exactement 
la sortie des canaux analogiques 1-2.)

• Si le périphérique externe est relié aux ports 
optiques, choisissez un format 
(généralement S/PDIF pour un 
périphérique d'effets) dans le menu 
déroulant Optical Format.

3  Sélectionnez Internal dans le menu déroulant 
de la source d'horloge.

4  Cliquez sur OK.

5  Vous pouvez également entrer de nouveaux 
noms de voie dans la boîte de dialogue I/O 
Setup, correspondant à l'assignation des effets. 

Utilisation de sources d'horloge 
externes (pour l'enregistrement 
et l'écoute)

Lors de l'enregistrement ou de l'écoute, 
Pro Tools peut être synchronisé à une source 
d'horloge externe. Les options de la source 
d'horloge externe varient en fonction du type de 
système Pro Tools utilisé.

Systèmes Pro Tools|HD

Les systèmes Pro Tools|HD peut recevoir une 
horloge externe via n'importe quelle entrée 
numérique de n'importe quelle interface d'E/S 
Pro Tools|HD (dont AES/EBU, S/PDIF et 
Optical).

Si un système étendu Pro Tools|HD comprend 
des interfaces Legacy (telles que l'interface 
888|24 I/O), effectuez la connexion à l'entrée 
numérique des canaux 1-2 de l'interface audio 
Legacy, afin de les utiliser comme source 
d'horloge. Les interfaces de Legacy I/O prennent 
en charge les fréquences d'échantillonnage 
44,1 kHz et 48 kHz.

Pour sélectionner une source d'horloge externe 
pour un système Pro Tools|HD :

1  Sélectionnez Setup > Hardware.

2  Sélectionnez l'E/S Pro Tools|HD appropriée 
pour l'affichage des paramètres dans la page 
principale.

3  Si nécessaire, activez le format numérique 
approprié (si ce n'est déjà fait), en suivant les 
instructions du Guide de démarrage ou du Guide 
d'E/S.

Si vous réglez le format optique sur S/PDIF, 
Pro Tools surveillera le port optique, en 
attente de signaux audio et ignorera toute 
entrée audio arrivant sur les prises cinch 
S/PDIF.

Reportez-vous au Guide de démarrage de 
Pro Tools|HD pour déterminer l'ordre 
correct des cartes et connexions à 
l'interface audio.
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4  Sélectionnez la source d'horloge 
correspondant au type d'entrée.

5  Configurez l'acheminement d'entrée de la 
source numérique à l'aide des menus 
contextuels Input et Output, le cas échéant.

6  Cliquez sur OK pour refermer la boîte de 
dialogue Hardware Setup.

Systèmes Digi 002 ou Digi 002 Rack

Pro Tools peut recevoir un signal d'horloge 
externe provenant de l'entrée optique ou de 
l'entrée S/PDIF.

Pour sélectionner une source d'horloge externe 
pour un système Digi 002 ou Digi 002 Rack :

1  Sélectionnez Setup > Hardware.

2  Sélectionnez la source d'horloge 
correspondant au type d'entrée.

3  Si vous choisissez Optical, assurez-vous que ce 
format correspond au type d'entrée optique 
envoyé au système Pro Tools. 

Systèmes Mbox 2 et Mbox

Pro Tools peut recevoir un signal d'horloge 
externe provenant de l'entrée S/PDIF sur ces 
interfaces.

Pour sélectionner une source d'horloge externe 
pour un système Mbox 2 ou Mbox :

1  Sélectionnez Setup > Hardware.

2  Dans le menu déroulant Clock Source, 
sélectionnez SPDIF (Windows) or SPDIF/RCA 
(Macintosh). 

3  Cliquez sur OK.

Si vous réglez le format optique sur S/PDIF, 
Pro Tools surveillera le port optique pour 
repérer l'horloge externe et ignorer toute les 
entrées d'horloge sur les jacks RCA S/PDIF.

Pour que la synchronisation de Pro Tools 
avec le périphérique se réalise avec succès, 
votre périphérique d'entrée numérique doit 
être connecté et sous tension. S'il n'est pas 
sous tension, laissez la valeur Clock Source 
sur Internal.
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Chapitre 27 : L'automation

Pro Tools permet l'automation dynamique des 
commandes de volume, de panoramique et de 
coupure de son pour les pistes et départs audio, 
d'entrée auxiliaire et d'instrument, et les 
paramètres des plug-in en temps réel. Les pistes 
de fader principal prennent en charge 
l'automation. Les pistes MIDI et d'instrument 
prennent en charge l'automation du volume, du 
panoramique et de la coupure de son MIDI (les 
données MIDI sont différentes des données 
d'automation). 

Dans Pro Tools, vous pouvez écrire des actions 
d'automation en temps réel au cours de la 
lecture d'une session. Vous pouvez également 
modifier des données d'automation au moyen 
de la technique utilisée pour modifier les 
données audio et MIDI.

Précision de l'automation sur les tables 
de mixage

Surfaces de contrôle Digidesign Les surfaces de 
contrôle D-Control, D-Command, ProControl, 
Control|24 et Command|8 de Digidesign 
prennent en charge toutes les fonctionnalités 
d'automation de Pro Tools. Les surfaces de 
contrôle Digidesign offrent une résolution de 10 
bits ou 1 024 pas de résolution de fader. 
Pro Tools intercale en cours de lecture ces 
données à une résolution de 24 bits : il en résulte 
une précision et une progressivité accrues de 
l'automation du fader.

Surfaces de contrôle MIDI la majorité des 
surfaces de contrôle MIDI disposent d'une 
résolution de 7 bits ou 128 pas. Pro Tools 
intercale en cours de lecture ces données à une 
résolution de 24 bits : il en résulte une précision 
et une progressivité de l'automation du fader.

Prise en main de l'automation
Pro Tools propose de nombreuses options pour 
l'enregistrement, le remplacement et l'édition 
des données d'automation. 

Etapes élémentaires de l'enregistrement 
d'automation :

• Activez le type d'automation à enregistrer 
(volume, panoramique, coupure (Mute), 
niveau de départ, panoramique de départ, 
coupure de départ ou plug-in). 

• Configurez le mode d'écriture d'automation 
désiré (Write, Touch, Latch ou Trim) sur les 
pistes de votre choix. 

• Si vous désirez automatiser un plug-in, 
autorisez l'automation de ses commandes.

Pour plus d'informations sur l'utilisation 
des surfaces de contrôle Digidesign pour 
créer des automations de mixage, consultez 
le Guide des surfaces de contrôle Digidesign.
Chapitre 27 : L'automation 635



636
• Protégez l'automation des plug-in, sorties ou 
départs pour éviter l'effacement de leurs 
données d'automation existantes. 

• Lancez la lecture pour démarrer 
l'enregistrement de l'automation et réglez les 
commandes en conséquence. Pro Tools 
enregistre toutes les modifications apportées 
aux commandes activées. 

Pour modifier une automation enregistrée :

• Répétez les étapes précédentes pour écrire les 
données précédentes avec les nouvelles 
données d'automation.

• Modifiez graphiquement les données 
d'automation dans la fenêtre Edit.

• Coupez, copiez, collez ou supprimez les 
données d'automation (avec certaines 
restrictions).

Listes d'automation
Chaque piste de Pro Tools contient une liste 
d'automation unique par commande 
susceptible d'être automatisée.

Sur les pistes audio, ces paramètres sont les 
suivants :

• Volume 

• Pan

• Coupure de son

• Niveau, panoramique et Mute des départs

• Commandes de plug-in

Sur les pistes d'entrée auxiliaire, ces paramètres 
sont les suivants :

• Volume 

• Coupure de son

• Pan

Sur les faders principaux, ces paramètres sont les 
suivants :

• Volume 

Sur les pistes MIDI, ces paramètres sont les 
suivants :

• Volume (MIDI)

• Panoramique (MIDI)

• Coupure de son

Sur les pistes d'instrument, ces paramètres sont 
les suivants :

• Volume (audio)

• Coupure de son (audio)

• Panoramique (audio)

Vous pouvez afficher et modifier tous ces 
paramètres pouvant être automatisés 
individuellement dans Pro Tools, même durant 
la lecture.

De plus, vous pouvez afficher et modifier 
d'autres données de contrôleur continu MIDI 
sur des pistes MIDI ou d'instrument (par 
exemple, la molette de modulation, un breath 
controller, un contrôleur au pied ou une pédale 
de sustain) de manière similaire. Pour en savoir 
plus sur l'édition de données MIDI, reportez-
vous à la section Evénements de contrôleur 
continu, page 510.
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Listes d'automation avec régions 
audio et MIDI

Pro Tools gère les régions et les playlists 
d'automation audio différemment des régions et 
des listes d'automation MIDI.

Pistes audio

Sur les pistes audio, les données d'automation 
résident dans une autre liste que les données et 
les régions audio. Toutes les playlists d'édition 
d'une piste audio partagent les mêmes données 
d'automation. 

Pistes MIDI et d'instrument

Sur les pistes MIDI et d'instrument, toutes les 
données d'automation de contrôleur, à 
l'exception des données de coupure de son MIDI 
ou de coupure audio, sont enregistrées dans la 
région MIDI à laquelle elles appartiennent. Sur 
les pistes, les playlists d'édition sont séparées et 
représentent une version spécifique, avec son 
automation de contrôleur. 

Playlists d'édition multiples et 
automation de pistes audio

Toutes les playlists d'édition d'une même piste 
audio partagent les mêmes données 
d'automation. Lorsque vous enregistrez ou 
modifiez des données d'automation sur une 
piste audio, elles s'enregistrent dans la liste 
d'automation de la piste, ce qui permet de les 
modifier avec ou indépendamment des régions 
audio associées. 

◆ Lorsque vous copiez ou coupez des données 
audio sur une piste dans une vue Waveform, les 
données d'automation sous-jacentes sont 
également coupées ou copiées. 

◆ Si vous collez des données audio dans une 
playlist d'édition depuis d'autres emplacements 
ou pistes, il est possible de modifier les données 
d'automation sous-jacentes sur la piste. 

◆ En revanche, si vous recourez à la commande 
Trim du menu Edit, les données d'automation 
sous-jacentes restent inchangées. 

Duplication de pistes pour l'édition de playlists

La commande Duplicate Track permet de copier 
facilement une piste en vue d'expériences sur 
l'assignation, les plug-in et l'automation. 
La piste originale et ses données d'automation 
ne risquent donc pas d'être modifiées ni 
effacées. 

Dans une région MIDI, les données de 
coupure de sons MIDI sont indépendantes 
des données MIDI. Vous pouvez ainsi 
couper la lecture de pistes MIDI ou 
d'instrument individuelles dans 
Pro Tools sans altérer les données de 
contrôleur. 

Les données de contrôleur continu MIDI 
reflètent toujours les modifications de la 
région, à l'exception de la coupure du son. 
Pour plus d'informations, reportez-vous à la 
section Pistes MIDI et d'instrument, 
page 637.

Pour plus d'informations, reportez-vous à la 
section Modification de l'automation, 
page 656.
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Pour copier une piste pour l'automation :

1  Sélectionnez la piste, puis choisissez Track > 
Duplicate.

2  Dans la boîte de dialogue Duplicate Tracks, 
configurez les options suivantes selon les 
besoins :

• Entrez le nombre de copies à créer en 
tapant le nombre dans le champ 
Duplicates. 

• Pour copier la playlist d'édition active 
(visible) à partir de la piste source, activez 
Active Playlist. 

• Pour copier les playlists d'édition sur la 
piste source, activez Alternate Playlists.

• Pour copier toutes les automations à partir 
de la piste source, activez Automation. 

• Pour copier toutes les assignations de plug-
in et d'insert, activez Inserts. 

• Pour copier tous les départs et assignations 
de départ, activez Sends.

• Pour conserver toutes les assignations Mix 
et Edit Group, activez Group Assignments. 

3  Cliquez sur OK pour dupliquer la piste en 
fonction des paramètres de la boîte de dialogue 
Duplicate Tracks.

4  Pour désactiver temporairement la piste 
d'origine, effectuez une des opérations 
suivantes :

• Maintenez la touche Ctrl (Windows) ou la 
touche Pomme (Macintosh) enfoncée tout 
en cliquant sur l'icône Track Type.

– ou –

• Sélectionnez la piste puis cliquez sur Track 
> Make Inactive. 

5  Modifiez les données d'automation sur la piste 
dupliquée. 

Modes d'automation
Les modes d'automation contrôlent la méthode 
d'écriture et de lecture des données 
d'automation sur une piste. Chaque piste est 
dotée d'un sélecteur de mode d'automation 
permettant de sélectionner le mode 
d'automation de la piste.

Mode Off

Le mode Off désactive l'automation pour tous 
les paramètres concernés :

• Volume 

• Pan

• Coupure de son :

• Niveau, panoramique et Mute des départs

• Commandes de plug-in

• Volume, panoramique et Mute sur pistes 
MIDI

En mode Off, les données d'automation liées à 
ces paramètres sont ignorées lors de la lecture. 
Toutes les autres données de contrôleur MIDI 
sont envoyées. 

L'automation peut être basculée du mode Off 
vers un autre mode d'automation pendant la 
lecture ou l'enregistrement.

Mode Read

Le mode Read lit les données d'automation 
précédemment écrites pour une piste.
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Mode Write

Le mode Write écrit les données d'automation 
entre le démarrage et l'arrêt de la lecture, en 
effaçant sur la durée de cette passe toutes les 
données d'automation antérieures. Lorsqu'une 
passe d'automation Write est interrompue, elle 
se comporte de la manière suivante :

Pro Tools LE : Après une passe d'automation, 
Pro Tools passe automatiquement du mode 
Write au mode Touch. Cette précaution élimine 
tout risque d'effacement accidentel des données 
d'automation lors d'une lecture ultérieure.

Pro Tools HD : Vous pouvez configurer le mode 
Write afin qu'il bascule automatiquement vers 
le mode Touch ou le mode Latch, ou qu'il reste 
inchangé. Pour plus d'informations, consultez la 
section Préférence « After Write Pass, Switch 
To », page 639.

Sur les systèmes Pro Tools|HD dotés de surfaces 
de contrôle Digidesign prises en charge, la 
fonction AutoMatch peut être appliquée à une 
passe d'automation Write. Pour plus 
d'informations, reportez-vous à la section 
AutoMatch Time, page 644.

Préférence « After Write Pass, Switch To »

La préférence « After Write Pass, Switch To » 
sélectionne le mode d'automation vers lequel les 
pistes Pro Tools basculent automatiquement à la 
suite d'une passe d'automation en mode Write. 
Vous pouvez choisir de basculer vers le mode 
Touch ou le mode Latch, ou de rester en mode 
Write en sélectionnant No Change.

Pour configurer « After Write Pass, Switch To » :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Automation.

2  Sélectionnez une option « After Write Pass, 
Switch To » (Touch, Latch ou No Change).

3  Cliquez sur Done (Terminé).

Mode Touch

Le mode Touch écrit les données d'automation 
uniquement lorsqu'un fader ou un sélecteur est 
touché (en version « physique ») ou si vous 
cliquez dessus avec la souris (en version « à 
l'écran »). Au relâchement du fader, l'écriture 
des données d'automation s'arrête et le fader 
retrouve sa position d'automation précédente, à 
une vitesse définie par les paramètres 
AutoMatch et Touch Timeout. Pour plus 
d'informations, reportez-vous à la section 
Préférences d'automation, page 644.

En mode Touch, certaines surfaces de contrôle 
lancent l'écriture des données d'automation au 
moindre contact. Ceux-ci incluent des 
contrôleurs pourvus de faders tactiles, tels que 
D-Control, D-Command, ProControl, 
Control|24, Digi 002, Command|8 de 
Digidesign ou encore Mackie HUI.

Sur d'autres surfaces de contrôle en mode Auto 
Touch, l'écriture des données d'automation en 
mode Touch commence lorsque le fader atteint 
le point de passage, correspondant à sa position 
d'automation antérieure. L'écriture des données 
d'automation débute lorsque le fader atteint le 
point de passage ou un contrôle rotatif non 
tactile et se poursuit jusqu'à l'arrêt de son 
déplacement.
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Mode Latch

Le mode Latch fonctionne de manière analogue 
au mode Touch, c'est-à-dire qu'il écrit les 
données d'automation uniquement lorsque 
vous touchez ou déplacez une commande. 
Cependant, à la différence de Touch, l'écriture 
des données d'automation se poursuit jusqu'à ce 
que vous arrêtiez la lecture ou que vous mettiez 
fin à la passe d'automation en changeant le 
mode d'automation en Read (lire) ou Touch 
(toucher).

Sur les systèmes Pro Tools|HD dotés de surfaces 
de contrôle Digidesign prises en charge, la 
fonction AutoMatch Time peut être appliquée à 
une passe d'automation Latch. Pour plus 
d'informations, reportez-vous à la section 
AutoMatch Time, page 644.

Le mode Latch est particulièrement utile pour 
l'automation des contrôles panoramique et 
plug-in sur des contrôles rotatifs non tactiles car 
qu'il n'est pas soumis à un retard d'exécution et 
ne revient pas à sa position précédente lorsque 
vous relâchez le contrôle. 

Mode AutoJoin with Latch

(Mode Latch avec surfaces de contrôle 
Digidesign prises en charges uniquement)

Pro Tools offre deux méthodes différentes de 
reprise de l'automation de l'écriture sur les 
contrôles qui étaient actifs au moment de 
l'interruption du transport :

AutoJoin : vous permet de reprendre 
automatiquement l'automation de l'écriture en 
mode Latch. La fonction AutoJoin peut être 
activée à partir d'une surface de contrôle 
Ethernet prise en charge ou à partir de Pro Tools 
si une surface de contrôle prise en charge a été 
déclarée.

Join : vous permet de reprendre manuellement 
l'automation de l'écriture en mode Latch. 
La fonction Join n'est disponible qu'avec les 
surfaces de contrôle prises en charge par 
Digidesign.

Pour activer la fonction AutoJoin à partir d'une 
surface de contrôle ou pour reprendre l'écriture 
manuellement avec la fonction Join, reportez-
vous au guide de votre surface de contrôle.

Pour activer AutoJoin à partir de Pro Tools :

1  Ouvrez la fenêtre Automation Enable 
(Window > Automation Enable).

2  Cliquez sur AutoJoin dans la fenêtre 
Automation Enable.

Voir également Ecriture de données 
d'automation à l'ensemble, au début ou à 
la fin d'une sélection, page 668.

Bouton AutoJoin Enable de la fenêtre Automation 
Enable

Reportez-vous au guide de votre surface de 
contrôle pour plus d'informations sur 
l'utilisation des fonctions Join et AutoJoin 
avec une surface de contrôle.

Bouton AutoJoin Enable
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Indicateur AutoJoin

Après une passe d'automation Latch avec la 
fonction AutoJoin activée, l'indicateur AutoJoin 
apparaît dans la fenêtre Edit de Pro Tools.

L'indicateur AutoJoin est une ligne rouge 
signalant le point d'interruption de la dernière 
passe d'automation, ainsi que le point futur de 
« raccordement » automatique de toutes les 
pistes en cours d'écriture lors de la passe 
précédente. Lorsque l'écriture d'automation 
reprend à partir de ce point, la ligne disparaît.

Mode Trim
(Pro Tools HD uniquement)

Les systèmes  Tools HD permettent d'ajuster (ou 
rogner) en temps réel les données d'automation 
du niveau de piste et de départ. En revanche, il 
n'est pas possible de rogner de cette manière les 
données d'automation de panoramique et de 
plug-in. Le mode Trim fonctionne en 

association avec les autres modes d'automation 
(Read, Touch, Latch et Write). Il permet de 
conserver l'ensemble des modifications 
apportées aux données d'automation du volume 
tout en augmentant ou réduisant légèrement les 
niveaux afin d'équilibrer les mixages. 
Par exemple, utilisez le mode Trim pour créer 
des mixages secondaires avec « vocals up 1 dB » 
ou « bass down 1 dB » (souvent demandés par 
les labels et les studios).

Lorsque vous modifiez des données 
d'automation en mode Trim, les déplacements 
du fader écrivent des valeurs relatives plutôt 
qu'absolues. Les données d'automation 
existantes varient de la valeur d'augmentation 
ou de diminution (ou valeur delta) indiquée par 
les faders. Lors du rognage, un indicateur de 
volume de piste ou de niveau de départ affiche 
les valeurs delta en cours d'écriture plutôt que la 
valeur absolue.

En mode Trim, les commandes pour lesquelles le 
rognage est impossible se comportent comme 
dans les modes d'automation standard, à 
l'exception du mode Write/Trim dans lequel ils 
fonctionnent comme en mode Touch.

Trim/Off

Le mode Trim/Off désactive l'automation et le 
rognage sur une piste. Toutes les mouvements 
d'automation sont suspendus durant la lecture.

L'automation peut être basculée du mode 
Trim/Off vers un autre mode d'automation 
pendant la lecture ou l'enregistrement.

Indicateur AutoJoin de la fenêtre Edit

Pour utiliser Join ou AutoJoin afin de 
reprendre l'écriture sur des contrôles en 
cours d'écriture lors de l'interruption du 
transport, redémarrez le transport avant 
l'indicateur AutoJoin.

Indicateur AutoJoin
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Read/Trim

En mode Read/Trim, les faders de volume et de 
niveau de départ n'affichent et ne suivent pas les 
données d'automation existantes, aussi n'est-il 
pas nécessaire de les rechercher durant la 
lecture. Les faders se positionnent 
automatiquement à 0 dB, valeur à laquelle 
aucun rognage n'est effectué (ils partent d'une 
valeur delta de zéro).

En mode Read/Trim, dès que la lecture 
commence, les mouvements de rognage (valeurs 
delta) sont pris en compte, mais pas écrits dans 
les données d'automation. Vous pouvez ainsi 
écouter le résultat sans modifier les données 
d'automation existantes. Le rognage se poursuit 
jusqu'à l'arrêt de la lecture.

Lorsque ce mode est activé, les contrôles 
impossibles à rogner (toutes les commandes 
autres que le volume de piste et le niveau de 
départ) se comportent comme en mode Read 
normal : aucune donnée d'automation n'est 
écrite.

Touch/Trim

En mode Touch/Trim, lorsque la lecture 
commence, les faders de volume et de niveau de 
départ n'affichent et ne suivent pas les données 
d'automation existantes, aussi n'est-il pas 
nécessaire de les rechercher durant la lecture. 
Les faders se positionnent automatiquement à 
0 dB, valeur à laquelle aucun rognage n'est 
effectué (ils partent d'une valeur delta de zéro).

Le rognage en temps réel débute dès qu'un des 
faders est touché. Les déplacements du fader 
écrivent des valeurs delta (augmentation ou 
réduction des données d'automation existantes 
sous forme d'un décalage).

Au relâchement du fader, le rognage s'arrête, le 
fader retrouve une valeur delta de zéro ou une 
valeur de décalage et continue de suivre les 
données d'automation précédemment 
enregistrées. La vitesse de retour du fader à une 
valeur delta nulle dépend du paramètre 
AutoMatch Time défini dans la page 
Automation Preferences. Pour plus 
d'informations, consultez la section AutoMatch 
Time, page 644.

Si vous appliquez une valeur AutoMatch Time, 
le fader glisse mais l'emplacement du fader 
représente la valeur delta appliquée à 
l'automation sous-jacente se trouvant déjà sur la 
piste.

Lorsque ce mode est activé, les commandes 
impossibles à rogner (tous les contrôles autres 
que le niveau de piste et de départ) se 
comportent comme en mode Touch normal : ils 
suivent les données d'automation 
précédemment enregistrées jusqu'à ce qu'ils 
soient touchés. Lorsqu'ils sont touchés, leur 
position absolue est écrite jusqu'à relâchement 
ou arrêt de la lecture. 

Latch/Trim

En mode Latch/Trim, lorsque la lecture 
commence, les faders de volume et de niveau de 
départ n'affichent et ne suivent pas les données 
d'automation existantes, aussi n'est-il pas 
nécessaire de les rechercher durant la lecture. 
Les faders se positionnent automatiquement à 
0 dB, valeur à laquelle aucun rognage n'est 
effectué (ils partent d'une valeur delta de zéro).

Le rognage en temps réel débute dès qu'un des 
faders est touché. Tout mouvement du fader 
après le début du rognage augmente ou réduit 
les données d'automation existantes en 
conséquence. Le rognage du contrôle touché se 
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poursuit jusqu'à l'arrêt de la lecture ou jusqu'à ce 
que vous mettiez fin à la passe d'enregistrement 
en changeant le mode d'automation en Read 
(lire) ou Touch (toucher).

Si vous appliquez une valeur AutoMatch Time, 
le fader glisse mais l'emplacement du fader 
représente la valeur delta appliquée à 
l'automation sous-jacente se trouvant déjà sur la 
piste.

Lorsque ce mode est activé, les commandes 
impossibles à rogner (tous les contrôles autres 
que le niveau de piste et de départ) se 
comportent comme en mode Latch normal : 
ils suivent les données d'automation 
précédemment enregistrées jusqu'à ce qu'ils 
soient touchés. Dès qu'ils sont touchés, leur 
position absolue est écrite jusqu'à l'arrêt de la 
lecture. 

Write/Trim

En mode Write/Trim, les faders de volume et de 
niveau de départ n'affichent et ne suivent pas les 
données d'automation existantes, aussi n'est-il 
pas nécessaire de les rechercher durant la lecture 
ou l'enregistrement. Les faders se positionnent 
automatiquement à 0 dB, valeur à laquelle 
aucun rognage n'est effectué (ils partent d'une 
valeur delta de zéro).

Dans ce mode, dès le début de la lecture, les 
valeurs delta sont appliquées aux données 
d'automation existantes. Le rognage se poursuit 
jusqu'à l'arrêt de la lecture. 

Si vous appliquez une valeur AutoMatch Time, 
le fader glisse mais l'emplacement du fader 
représente la valeur delta appliquée à 
l'automation sous-jacente se trouvant déjà sur la 
piste.

Lorsque le mode Write/Trim est activé, les 
contrôles impossibles à rogner (tous les 
contrôles autres que le niveau de piste et de 
départ) ne sont pas en mode Write mais se 
comportent comme en mode Touch normal : 
aucune donnée d'automation n'est écrite jusqu'à 
ce qu'un contrôle soit touché. Ainsi, les 
commandes ne risquent pas d'effacer leurs 
données d'automation à chaque passe en mode 
Trim.

 Le paramètre « After Write Pass, Switch 
To » affecte le mode Write/Trim. Après une 
passe d'automation en mode Write/Trim, 
les pistes Pro Tools basculent 
automatiquement vers la version Trim du 
paramètre « After Write Pass, Switch To » 
(Latch/Trim, Touch/Trim ou Write/Trim).
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Préférences d'automation
Pro Tools offre plusieurs options de contrôle de 
l'écriture et de la lecture des données 
d'automation.

Pour afficher les préférences d'automation :

■ Choisissez Setup > Preferences et cliquez sur 
l'onglet Automation.

Lissage

Lorsque vous exécutez des mouvements 
d'automation avec un contrôle continu, 
Pro Tools enregistre chaque action en une série 
d'étapes très courtes, ce qui génère une courbe 
en « escalier » comportant de nombreux points 
d'inflexion. La fonction de lissage (smoothing) 
lisse intelligemment cet escalier en une rampe 
unique, reliant les points d'inflexion entre eux. 
(Le lissage ne s'applique pas aux contrôles 
commutés, tels que Mute ou Bypass des plug-in). 

Lorsque l'option de lissage est activée, 
l'automation qui en résulte représente 
généralement les mouvements réels avec une 
précision accrue. 

Affinage

La réduction réduit automatiquement le 
nombre total de points d'inflexion dans la liste 
d'automation en vue d'améliorer les 
performances du système. Le degré d'affinage 
appliqué est déterminé par le paramètre Degree 
of Thinning, dans la page Automation 
Preferences. Un affichage important entraîne 
une automation sensiblement différente des 
actions d'automation réelles. L'affinage 
s'applique uniquement aux pistes audio et ne 
modifie pas les pistes MIDI. Pour les 
instructions, consultez la section Réduction de 
l'automation, page 654.

AutoMatch Time

AutoMatch Time est le temps nécessaire à un 
fader pour revenir (en créant une rampe de 
niveau dirigée vers le haut ou vers le bas) au 
niveau d'automation se trouvant sur la piste, à la 
fin de la passe d'automation. Cette valeur est 
définie dans la page Automation Preferences 
(voir Préférences d'automation, page 644).

Une valeur AutoMatch Time est appliquée à 
toutes les passes en mode Touch.

La valeur AutoMatch Time détermine 
également le taux auquel les valeurs delta écrites 
en mode Trim renvoient à 0 dB (valeur delta de 
zéro).

Page Automation Preferences

Reportez-vous à la section Préférences 
d'automation, page 81 pour obtenir des 
informations détaillées sur les préférences 
d'automation de Pro Tools.
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La fonctionnalité AutoMatch agit sur des 
commandes continues (telles que le volume ou 
le panoramique), dont elle ramène la valeur à 
des niveaux automatisés antérieurs. La plage de 
fonctionnement de certaines commandes 
discontinues (par exemple, l'égaliseur dans le 
plug-in EQ à 1 bande) s'étend sur plus de deux 
pas. La fonction AutoMatch n'exerce aucune 
influence sur ces commandes.

Indicateurs AutoMatch

Des indicateurs AutoMatch triangulaires sont 
placés dans l'angle inférieur gauche de chaque 
voie de console de la fenêtre Mix. Lorsqu'ils sont 
allumés, ils indiquent la direction dans laquelle 
le fader se déplace automatiquement.

Configuration de la taille du 
tampon d'automation

Pro Tools permet de spécifier la taille de la 
mémoire tampon utilisée pour l'écriture des 
données d'automation. Pour les grandes sessions 
ou si vous écrivez un très grand nombre 
d'actions d'automation, vous pouvez augmenter 
cette valeur.

Pour configurer la taille du buffer d'automation :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Automation. 

2  Pour l'option « Amount of memory to reserve 
for automation recording », entrez une valeur 
comprise entre 200 et 20 000 K. La valeur par 
défaut pour une nouvelle session est 200 K.

3  Relancez Pro Tools pour valider cette 
modification.

Pour réduire la charge de traitement, essayez 
l'une des actions suivantes :

■ Désélectionnez l'option Faders Move During 
Playback dans la page Automation Preferences.

■ Réduisez la densité de l'automation aux 
points où elle semble la plus active. Pour en 
savoir plus, reportez-vous à la section Réduction 
de l'automation, page 654. 

■ Désactivez les vumètres de la vue Sends, s'ils 
sont activés, dans la page Display Preferences. 
Pour plus d'informations, reportez-vous à la 
section Vues Send individuelles et vumètres de 
niveau de départ, page 587.

Automation Safe

Il est possible de configurer les sorties, les 
départs et les plug-in en mode Automation Safe. 
En mode Automation Safe, les données 
d'automation associées à une fenêtre Output 
(niveau de piste ou de départ, panoramique, 
Mute, etc.) ou à un plug-in de cette piste sont 
protégées contre l'effacement, tout en 
enregistrant des données d'automation pour les 
autres éléments de la piste. 

Le mode Automation Safe suspend 
l'enregistrement des données d'automation de 
l'élément (sortie, départ ou plug-in) de la piste 
sélectionnée pour lequel il est activé. Vous 

Indicateurs AutoMatch triangulaires sur une voie de 
console

Indicateur AutoMatch

Fonction Automation Safe activée pour le départ

Automation Safe activé
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pouvez également suspendre l'enregistrement et 
la lecture des données d'automation pour toute 
la durée d'une session, dans la fenêtre 
Automation Enable. Pour plus d'informations, 
reportez-vous à la section Activation et 
suspension de l'automation, page 652. 

Visualisation des données 
d'automation
Pro Tools crée une playlist séparée pour chaque 
type d'automation écrit. Ces données peuvent 
être affichées et modifiées comme des données 
audio ou MIDI. 

Pour afficher les données d'automation :

■ Cliquez sur le sélecteur de vue de piste et 
choisissez le type d'automation à afficher dans le 
menu déroulant.

Ecriture de données 
d'automation
Pour écrire des données d'automation pour tous 
les contrôles qu'il est possible d'automatiser, 
déplacez-les au cours de la lecture. 

Pour écrire des données d'automation sur une 
piste :

1  Sélectionnez Window > Automation Enable. 

2  Assurez-vous que l'écriture est autorisée pour 
ce type d'automation.

3  Dans la fenêtre Mix ou Edit, cliquez sur le 
sélecteur de mode d'automation de la piste à 
automatiser, puis définissez le mode 
d'automation. Pour une première passe 
d'automation, optez pour le mode Write.

Affichage des données d'automation

Vous pouvez facilement basculer d'une 
vue de piste vers une autre. Pour plus 
d'informations, reportez-vous à la section 
Changement de vue de piste, page 273.

Automation Enable, fenêtre

Définition du mode d'automation d'une piste

Vous pouvez écrire des données 
d'automation sur plusieurs pistes 
simultanément. Pour cela, définissez un 
mode d'automation pour chaque piste à 
automatiser.
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4  Cliquez sur Play pour lancer l'écriture des 
données d'automation.

5  Déplacez les commandes à automatiser.

6  Une fois l'opération terminée, cliquez sur 
Stop.

Après la première passe d'automation, vous 
pouvez écrire d'autres données d'automation sur 
la piste sans effacer complètement le passage 
précédent, grâce au mode Touch ou Latch. 
Ces modes ajoutent des données d'automation 
uniquement lorsque vous déplacez la 
commande Reportez-vous à la section Modes 
d'automation, page 638.)

Pour ajouter des données d'automation à une 
passe antérieure :

1  Activez Options > Link Timeline and Edit 
Selection.

2  Dans la fenêtre Edit, effectuez une sélection 
ou placez le curseur au point où vous souhaitez 
écrire les données d'automation.

3  Dans la fenêtre Mix ou Edit, cliquez sur le 
sélecteur de mode d'automation de la piste à 
automatiser, puis sélectionnez le mode Touch 
ou Latch comme mode d'automation.

4  Cliquez sur Play pour lancer l'écriture des 
données d'automation. 

5  Déplacez les commandes à automatiser.

6  Une fois l'opération terminée, cliquez sur 
Stop.

Enregistrement de la position initiale 
d'un contrôleur

Lors de la création d'une piste audio, d'une piste 
d'entrée auxiliaire, d'une piste MIDI ou d'une 
piste d'instrument, le mode Read est 
automatiquement activé. Bien que la piste soit 
configurée en mode Read, vous pouvez définir la 
position initiale des commandes qu'il est 
possible d'automatiser. Cette position sera 
enregistrée avec la session.

Dans cet état initial, un seul point d'inflexion 
d'automation apparaît au début de chaque liste 
d'automation. Si vous déplacez la commande 
sans écrire de données d'automation, le point 
d'inflexion se déplace jusqu'à la nouvelle valeur.

Pour enregistrer de manière permanente la 
position initiale d'une commande susceptible 
d'automation, choisissez l'une des actions 
suivantes :

• Configurez la piste en mode Write, puis 
appuyez sur Play pour écrire quelques 
secondes de données d'automation sur la 
piste.

• Insérez manuellement un point d'inflexion 
sur la playlist d'automation après le point 
d'inflexion initial. Pour en savoir plus, voir 
Modification graphique de données 
d'automation, page 657.

Vous pouvez écrire des données 
d'automation supplémentaires sur 
plusieurs pistes simultanément. Pour cela, 
définissez un mode d'automation pour 
chaque piste à automatiser.

Si vous écrivez les données d'automation en 
mode Touch avec l'option Loop Playback 
activée, l'écriture s'arrête automatiquement 
à la fin de la sélection en boucle. Au début 
de chaque nouvelle boucle, vous pouvez 
alors toucher ou déplacer à nouveau la 
commande pour écrire de nouvelles données.
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Automation des commandes 
commutées

Dans Pro Tools, les contrôles commutés 
(coupures ou désactivations de plug-in, par 
exemple) sont considérés comme des contrôles 
tactiles. Les données d'automation sont écrites 
tant que la touche ou le bouton associés à la 
commande sont touchés.

Par exemple, si vous venez d'écrire plusieurs 
Mute on/off se succédant rapidement sur une 
piste, vous pouvez effacer ces données 
d'automation manuellement dans la fenêtre 
Edit, en choisissant la playlist d'automation de 
Mute, en sélectionnant les données 
d'automation correspondantes, puis en les 
supprimant. Dans Pro Tools, cette opération 
peut être effectuée automatiquement.

Pour automatiser un contrôle commuté (tel que le 
bouton Mute) :

1  Effectuez une autre passe d'automation sur la 
piste.

2  Lorsque vous atteignez l'emplacement de 
l'état Mute à supprimer, appuyez sur le bouton 
Mute tout en le maintenant enfoncé.

3  Tant que vous ne le relâchez pas, Pro Tools 
remplace les données de Mute sous-jacentes sur 
la piste par l'état actuel du commutateur (marche 
ou arrêt) jusqu'à l'arrêt de la lecture.

Automation des départs

Pro Tools permet d'automatiser 
dynamiquement le niveau, le Mute et le 
panoramique de départ (aux formats stéréo et 
multicanal uniquement pour ce dernier 
paramètre). Le niveau et le placement des effets 
sont ainsi plus faciles à contrôler avec précision 
lors du mixage final.

Il est également possible de configurer les 
niveaux et coupures de départs pour qu'ils 
suivent les groupes. 

Pour automatiser le niveau, Mute ou panoramique 
d'un départ :

1  Dans la fenêtre Automation Enable, assurez-
vous que l'écriture est autorisée pour ce type 
d'automation (niveau, coupure et panoramique 
de départ).

2  Dans la fenêtre Mix ou Edit, définissez le mode 
d'automation de chaque piste contenant des 
départs à automatiser. Pour chaque piste, cliquez 
sur le sélecteur de mode d'automation, puis 
définissez le mode d'automation. Pour une 
première passe d'automation, optez pour le 
mode Write.

3  Si les départs ne sont pas visibles actuellement 
sur vos pistes, sélectionnez View > Mix Window 
(ou Edit Window) > Sends A–E (ou Sends F–J).

Lorsque la lecture parvient à la première 
section coupée, le bouton Mute s'allume. 
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4  Pour afficher les commandes de départ, 
exécutez l'une des actions suivantes :

• Cliquez sur le départ à automatiser pour 
ouvrir la fenêtre Output correspondante.

• Sélectionnez View > Sends A–E (ou Sends 
F-J) et sélectionnez une des vues 
individuelles (par exemple Send A).

5  Cliquez sur Play pour lancer l'écriture des 
données d'automation. 

6  Déplacez les commandes à automatiser.

7  Une fois l'opération terminée, cliquez sur 
Stop. 

Copie des données d'automation de 
piste sur les départs

(Pro Tools HD uniquement)

Il est parfois souhaitable que l'automation d'un 
départ d'une piste reflète directement 
l'automation sur la piste, par exemple lorsqu'il 
est nécessaire que le niveau d'un effet suive les 
niveaux d'un mixage principal. Pour ce faire, 
vous pouvez copier toute la playlist 
d'automation de la commande sélectionnée 
dans la playlist correspondante du départ.

Pour copier les données d'automation d'une piste 
sur l'un de ses départs :

1  Sélectionnez les pistes à modifier en cliquant 
sur leur nom pour les mettre en surbrillance.

2  Choisissez Edit > Automation > Copy to Send.

3  Dans la boîte de dialogue Copy to Send, 
sélectionnez Automation pour copier la liste 
d'automation complète des commandes 
correspondantes.

4  Choisissez les commandes à copier. 

5  Choisissez les départs sur lesquels vous 
souhaitez copier les données d'automation, puis 
cliquez sur OK.

Pour annuler les effets de la commande Copy to 
Send, sélectionnez Edit > Undo.

Il est également possible de configurer les 
coupures et niveaux de départ de façon à 
suivre les groupes de mixage. Pour en savoir 
plus, reportez-vous au Préférences 
d'automation, page 644.

 Boîte de dialogue Copy To Send

Lors de l'effacement de données 
d'automation, Pro Tools affiche une boîte 
de dialogue de confirmation. Pour qu'elle 
n'apparaisse pas, appuyez sur Alt 
(Windows) ou sur Option (Macintosh), tout 
en cliquant sur OK.
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Automation de plug-in

Vous pouvez créer des données d'automation 
pour la quasi totalité des paramètres des plug-in 
fournis avec le système Pro Tools. L'automation 
d'un plug-in diffère légèrement d'autres 
procédures d'automation : il est en effet 
nécessaire d'activer les paramètres d'automation 
du plug-in. 

Pour activer les commandes d'un plug-in à 
automatiser : 

1  Ouvrez la fenêtre Plug-In du plug-in à 
automatiser.

2  Cliquez sur le bouton Automation Enable de 
la fenêtre Plug-In.

– ou –

Maintenez enfoncées les touches 
Ctrl+Alt+Démarrer (Windows) ou 
Pomme+Option+Ctrl (Macintosh) et cliquez sur 
le sélecteur de vue de piste dans la fenêtre Edit.

3  Sélectionnez les commandes à automatiser, 
puis cliquez sur Add. Si une piste comporte 
plusieurs plug-in, vous pouvez en sélectionner 
certains en cliquant sur le bouton 
correspondant dans la zone Inserts de la boîte de 
dialogue. 

4  Cliquez sur OK pour fermer la boîte de 
dialogue Plug-In Automation.

Pour automatiser un plug-in :

1  Dans la fenêtre Plug-In Automation Enable, 
assurez-vous que l'écriture de l'automation du 
plug-in est activée.

2  Dans la fenêtre Mix ou Edit, pour chaque piste 
contenant des plug-in à automatiser, cliquez sur 
le sélecteur de mode d'automation, puis 
définissez le mode d'automation. Pour une 
première passe d'automation, optez pour le 
mode Write.

3  Cliquez sur Play pour commencer l'écriture de 
l'automation, et déplacez les commandes à 
automatiser.

4  Une fois l'opération terminée, cliquez sur 
Stop.

Ouverture de la boîte de dialogue Plug-In Automation

Bouton Automation Enable

Boîte de dialogue Plug-In Automation
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Activation de l'automation pour un seul 
paramètre de plug-in

Vous pouvez également activer telle ou telle 
commande de plug-in directement dans la 
fenêtre Plug-In, en cliquant sur chaque 
commande tout en appuyant sur les touches 
Ctrl + Alt + Démarrer (Windows) ou 
Pomme + Option + Contrôle (Macintosh). Pour 
plus d'informations, consultez le Guide des plug-
in DigiRack ou le Guide des plug-in Digidesign.

Activation de l'automation pour tous les 
paramètres de plug-in

Pour activer tous les paramètres de plug-in :

1  Assurez-vous que la fenêtre du plug-in à 
automatiser est ouverte. 

2  Tout en maintenant les touches 
Ctrl+Alt+Démarrer (Windows) ou les touches 
Pomme+Option+Contrôle-(Macintosh) 
enfoncées, cliquez sur le bouton Auto situé au 
sommet de la fenêtre du plug-in. 

Protection contre l'enregistrement de 
l'automation de plug-in

Le mode Automation Safe protège les données 
d'automation du plug-in contre l'effacement.

Pour activer le mode Plug-In Safe :

1  Ouvrez un plug-in.

2  Cliquez sur le bouton Safe pour le mettre en 
surbrillance.

Activation de l'automation d'un plug-in pour un seul 
paramètre

Des raccourcis supplémentaires 
d'automation de plug-in sont disponibles 
à partir des surfaces de contrôle D-Control 
ou D-Command de Digidesign. Ces 
raccourcis vous permettent d'automatiser 
tous les paramètres d'un seul plug-in, tous 
les paramètres de tous les plug-in se 
trouvant au même emplacement de 
l'insert sur d'autres pistes ou, tous les 
paramètres de tous les plug-in de la 
session. 

Fonction Automation Safe activée sur un plug-in

Protection activée
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Activation et suspension de 
l'automation
Dans la fenêtre Automation Enable, vous 
pouvez activer ou suspendre l'écriture des types 
d'automation suivants sur toutes les pistes :

• Volume 

• Pan

• Coupure de son :

• Indicateur de retard

• Niveau de départ

• Panoramique de départ

• Coupure du départ

La lecture de l'automation peut être 
interrompue ou reprise à tout moment (sans 
avoir à arrêter le transport).

Pour suspendre l'écriture des données 
d'automation sur toutes les pistes :

1  Sélectionnez Window > Automation Enable. 

2  Effectuez l'une des opérations suivantes :

• Pour suspendre l'écriture de toutes les 
données d'automation sur toutes les pistes, 
cliquez sur le bouton Auto Suspend.

• Pour suspendre l'écriture d'un type de 
données d'automation particulier sur 
toutes les pistes, cliquez sur le bouton de ce 
type (niveau, Mute, panoramique, plug-in, 
niveau de départ, coupure de départ ou 
panoramique de départ).

Suspension de la lecture des données 
d'automation

Pour suspendre la lecture des paramètres 
d'automation des pistes, cliquez sur le sélecteur 
de vue de la piste.

Lorsqu'une commande est interrompue, son 
nom est mis en italique.

Pour suspendre la lecture (et l'écriture) des 
données d'automation sur des commandes 
spécifiques :

1  Dans la fenêtre Edit, configurez le sélecteur de 
vue de piste pour qu'il affiche la playlist 
d'automation de la commande à suspendre.

2  Effectuez l'une des opérations suivantes :

• Pour suspendre l'écriture et la lecture du 
seul paramètre d'automation affiché, 
cliquez sur son nom dans le sélecteur de 
vue de piste tout en appuyant sur la touche 
Ctrl (Windows) ou Pomme (Macintosh). 

• Pour suspendre l'écriture et la lecture de 
tous les paramètres d'automation, 
maintenez enfoncées les touches Ctrl + Maj 
(Windows) ou Pomme + Maj (Macintosh) 
pendant que vous cliquez sur leur nom 
dans le sélecteur de vue de piste.

Automation Enable, fenêtre
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• Pour suspendre l'écriture et la lecture d'un 
paramètre d'automation spécifique pour 
toutes les pistes, maintenez enfoncées les 
touches Ctrl + Alt (Windows) ou Pomme + 
Option (Macintosh) pendant que vous 
cliquez sur son nom dans le sélecteur de 
vue de piste.

Instructions d'activation de 
l'automation

Les règles ci-après déterminent si les données 
d'automation sont écrites ou lues sur une piste :

◆ Bien que Pro Tools n'affiche qu'un seul mode 
d'automation pour chaque piste, toutes les 
commandes associées à cette piste ne sont pas 
forcément configurées dans ce mode.

◆ Si l'automation est suspendue globalement 
dans la fenêtre Automation Enable, toutes les 
commandes pouvant être automatisées se 
comportent comme en mode Off et ce, quel que 
soit le mode d'automation de la piste.

◆ Lorsque vous suspendez une commande 
d'automation en cliquant dessus tout en 
appuyant sur la touche Ctrl (Windows) ou 
Pomme (Macintosh) dans le sélecteur de vue de 
piste, elle se comporte comme en mode Off, 
quel que soit le mode d'automation de la piste.

◆ Si une commande d'automation est 
suspendue dans la fenêtre Automation Enable, 
elle se comporte comme en mode Read lorsque 
la piste est configurée dans un mode 
d'automation enregistrable (mode Touch, Latch 
ou Write).

Suppression des données 
d'automation
Les données d'automation prennent la forme 
d'une ligne graphique comportant des points 
d'inflexion modifiables. Le moyen le plus facile 
de supprimer l'automation d'une piste ou d'une 
sélection consiste à supprimer manuellement les 
points d'inflexion de la liste d'automation.

Cette méthode de suppression des données 
diffère de la commande Cut qui crée des points 
d'inflexion ancrés à la périphérie des données 
restantes. Pour en savoir plus, reportez-vous à la 
section Couper/Copier/Coller de données 
d'automation, page 661. 

Pour supprimer les données d'automation, 
affichez la playlist d'automation à modifier en le 
sélectionnant dans le sélecteur de vue de piste, 
puis exécutez l'une des actions suivantes :

Pour supprimer un seul point d'inflexion :

■ A l'aide du crayon ou de la main, cliquez sur le 
point d'inflexion tout en appuyant sur la touche 
Alt (Windows) ou Option (Macintosh).

Pour supprimer plusieurs points d'inflexion en une 
seule opération :

■ Sélectionnez une plage contenant des points 
d'inflexion à l'aide du sélecteur, puis appuyez sur 
la touche de suppression (Windows) ou sur la 
touche d'effacement arrière (Macintosh).

Les opérations d'activation et de suspension 
des données d'automation dans la fenêtre 
Edit s'alignent sur les groupes Edit 
(à l'exception de l'automation de 
panoramique). Pour supprimer ce 
comportement en groupe, cliquez sur le nom 
de la commande en appuyant sur la touche 
Démarrer (Windows) ou Contrôle 
(Macintosh).
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Pour supprimer toutes les données d'automation 
du type affiché :

■ Cliquez sur la piste avec le sélecteur et 
choisissez Edit > Select All, puis appuyez sur la 
touche de suppression (Windows) ou sur la 
touche d'effacement arrière (Macintosh).

Pour supprimer toutes les données d'automation 
de toutes les listes d'automation d'une piste :

1  Sélectionnez une plage de données à 
supprimer à l'aide du sélecteur.

2  Appuyez sur Démarrer +Ret. Arr. (Windows) 
ou sur Contrôle + Arrière (Macintosh).

Toutes les données d'automation se trouvant 
dans la sélection sont supprimées de toutes les 
playlists d'automation de cette piste, que 
l'écriture d'automation soit autorisée ou non 
pour ces commandes.

Réduction de l'automation
Lors d'une passe d'automation, Pro Tools écrit 
des données d'automation avec une densité 
maximale, sous la forme de points d'inflexion. 
Pro Tools créant des rampes entre les points 
d'inflexion, tous les points acquis ne sont pas 
forcément indispensables à la création d'une 
représentation sonore précise des mouvements 
d'automation exécutés. Chaque point 
d'inflexion occupe de l'espace dans la mémoire 
affectée à l'automation ; la réduction des 
données peut donc optimiser l'efficacité et les 
performances de l'UC.

Pro Tools offre deux méthodes différentes pour 
réduire le volume les données d'automation en 
supprimant les points d'inflexion inutiles: 
l'option Smooth and Thin Data After Pass et la 
commande Thin Automation.

Utilisation de l'option Smooth and Thin 
Data After Pass

Lorsque cette option est sélectionnée dans la 
page Automation Preferences, Pro Tools réduit 
automatiquement les données de point 
d'inflexion après chaque passe d'automation.

A la création d'une nouvelle session, l'option 
Smooth and Thin Data After Pass est 
sélectionnée par défaut et le paramètre Some est 
sélectionné. Dans la plupart des cas, ce 
paramètre génère des performances optimales et 
reproduit précisément les mouvements 
d'automation.

Si vous choisissez None, Pro Tools écrit le plus 
grand nombre possible de points d'inflexion. 
Vous pouvez exécuter la réduction à tout 
moment, via la commande Thin. Pour en savoir 
plus sur la réduction de données d'automation, 
reportez-vous à la section Lissage, page 644.

Utilisation de la commande Thin 
Automation

La commande Thin Automation permet de 
réduire des zones sélectionnées d'une piste, sur 
lesquelles les données d'automation sont trop 
denses. Vous pouvez utiliser la commande Undo 
pour visualiser les résultats de la réduction 
(comparaison avec et sans réduction) avant de 
les appliquer définitivement.

Option Smooth and Thin Data After Pass
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Pour utiliser la commande Thin Automation :

1  Dans la fenêtre Edit, cliquez sur le sélecteur de 
vue de piste pour afficher le type d'automation à 
réduire.

2  A l'aide du sélecteur, mettez en surbrillance les 
données d'automation à affiner. Pour réduire 
toutes les données d'automation du type 
sélectionné sur la piste, cliquez sur la piste à 
l'aide du sélecteur et choisissez la commande 
Select All.

3  Choisissez Edit > Automation > Thin pour 
réduire les données d'automation sélectionnées 
de la valeur définie dans la page Automation 
Preferences.

Dessin d'automation
Vous pouvez utiliser le crayon pour créer des 
événements d'automation pour des pistes audio 
et MIDI, en les dessinant dans une liste 
d'automation ou de contrôleur MIDI 
quelconque.

Le crayon peut être configuré pour dessiner une 
série d'événements d'automation utilisant les 
formes suivantes :

Free Hand : permet de dessiner librement en 
faisant glisser la souris. Sur les pistes audio, la 
forme contient le nombre de points d'inflexion 
requis pour intercaler et reproduire sans 
accident la forme d'automation. Sur les pistes 
MIDI, la forme est reproduite sous forme d'une 
série de pas, conformément au paramètre de 
résolution défini dans la page MIDI Preferences.

Line : cet outil dessine une ligne droite. Sur les 
pistes audio, la ligne comporte un point 
d'inflexion à chaque extrémité. Sur les pistes 
MIDI, la valeur du contrôleur change par étapes 
selon la résolution définie dans la page MIDI 
Preferences.

Triangle : cet outil dessine un motif en dents de 
scie répété à une fréquence définie par la valeur 
de grille. Sur les pistes audio, le motif comporte 
un point d'inflexion à chaque extrémité. Sur les 
pistes MIDI, la valeur du contrôleur change par 
étapes selon la résolution définie dans la page 
MIDI Preferences. L'amplitude est contrôlée par 
le mouvement vertical du crayon. 

Square : cet outil dessine un motif carré répété à 
une fréquence définie par la valeur de grille. 
L'amplitude est contrôlée par le mouvement 
vertical du crayon. 

Random : cet outil dessine un motif aléatoire 
dont le niveau évolue à une fréquence définie 
par la valeur de grille fixée. L'amplitude est 
contrôlée par le mouvement vertical du crayon.

Choix de la forme crayon

Crayon
formes 
disponibles
pour Automation
Chapitre 27 : L'automation 655



656
Utilisation des formes du crayon

Vous pouvez dessiner une automation pour des 
pistes audio ou MIDI. Par exemple, utilisez le 
motif Triangle pour contrôler des fonctions 
continues ou le motif Square pour contrôler une 
fonction commutée, telle que Mute ou Bypass.

Le crayon dessinant ces formes à partir de la 
valeur de grille, vous pouvez l'utiliser pour 
générer un panoramique cadencé au tempo d'un 
morceau de musique, ou pour caler des effets de 
changement de plan à l'image près en post-
production.

Résolution des données de contrôleur 
MIDI

Si vous utilisez le crayon pour dessiner des 
données d'automation MIDI, elles prennent 
l'aspect de pas discontinus. Vous pouvez 
contrôler la résolution (ou densité) de ces pas 
afin de faciliter la gestion de la quantité de 
données MIDI envoyées pour un déplacement 
de contrôleur MIDI donné.

Pour configurer la résolution du crayon :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet MIDI.

2  Indiquez une valeur pour l'option Pencil Tool 
Resolution When Drawing Controller Data. 
Cette valeur peut aller de 1 à 100 millisecondes.

Les illustrations ci-après présentent les mêmes 
données d'automation de contrôleur MIDI 
dessinées avec différentes valeurs du paramètre 
de résolution du crayon.

Pour optimiser les performances, il est possible 
de définir une valeur inférieure pour les 
commandes MIDI nécessitant une résolution 
plus élevée (par exemple, le volume MIDI) et 
une valeur supérieure pour ceux qui ne 
nécessitent pas une résolution importante (par 
exemple, le panoramique).

Modification de l'automation
Pro Tools offre plusieurs méthodes pour 
modifier les données d'automation d'une piste 
quelconque de votre session. Vous pouvez 
modifier les données d'automation 
graphiquement, en ajustant les points 
d'inflexion sur la playlist d'automation d'une 
piste. Vous pouvez également couper, copier et 
coller les données d'automation comme s'il 
s'agissait de données audio ou MIDI.

Pour en savoir plus sur les données de 
contrôleur continu MIDI, reportez-vous à la 
section Evénements de contrôleur continu, 
page 510.

Données MIDI dessinées avec une résolution de 10 ms

Données MIDI dessinées avec une résolution de 
100 ms
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Modification graphique de 
données d'automation

Les données d'automation prennent la forme 
d'une ligne graphique comportant des points 
d'inflexion modifiables. Faites glisser ces points 
d'inflexion pour modifier les données 
d'automation directement dans la fenêtre Edit. 
Lorsque vous déplacez un point d'inflexion 
d'automation vers le haut ou vers le bas, le 
changement de valeur s'affiche en chiffres ou en 
lettres. Le déplacement d'un point d'inflexion 
d'automation vers la gauche ou vers la droite 
permet de régler la durée de l'événement 
d'automation.

Utilisation de l'outil Main

L'outil Main permet de créer de nouveaux 
points d'inflexion en cliquant sur la ligne 
graphique ou d'ajuster des points d'inflexion 
existants en les déplaçant. Cliquez sur les points 
d'inflexion avec l'outil Main tout en appuyant 
sur la touche Alt (Windows) ou Option 
(Macintosh) pour les supprimer.

Utilisation du crayon

Avec l'outil Crayon, créez des points d'inflexion 
en cliquant une fois sur la ligne graphique. 
Cliquez sur les points d'inflexion avec le crayon 
tout en appuyant sur la touche Alt (Windows) 
ou Option (Macintosh) pour les supprimer.

Utilisation des outils de trimming

Les outils de trimming vous permettent d'ajuster 
les points d'inflexion sélectionnés vers le haut 
ou vers le bas en les faisant glisser vers un point 
quelconque de la sélection.

Modification de types 
d'automation

Chaque commande qu'il est possible 
d'automatiser dispose d'une playlist 
d'automation particulière. Pour l'afficher, 
sélectionnez-la dans le sélecteur de vue de piste. 
Visualisation des données d'automation, 
page 646.

Création d'un point d'inflexion à l'aide de l'outil Main

Suppression d'un point d'inflexion à l'aide du crayon

Déplacement de points d'inflexion à l'aide de l'outil de 
trimming
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Modification de l'automation du volume

Faites glisser un point d'inflexion vers le haut ou 
vers le bas pour modifier le volume (valeur en 
dB). Déplacez un point d'inflexion vers la 
gauche ou vers la droite pour régler la durée du 
changement de volume.

Modification de l'automation du 
panoramique

Faites glisser un point d'inflexion vers le bas 
pour obtenir un panoramique droit, vers le haut 
pour un panoramique gauche. Déplacez un 
point d'inflexion vers la gauche ou vers la droite 
pour fixer la durée des mouvements de 
panoramique.

Modification de l'automation de Mute

Faites glisser le point d'inflexion vers le bas pour 
couper le son d'une section. Faites glisser un 
point d'inflexion vers le haut pour rétablir le son 
de la section. Déplacez un point d'inflexion vers 
la gauche ou vers la droite pour définir la durée 
de la coupure du son.

Modification de l'automation d'une 
commande discontinue

L'automation de certaines commandes, 
notamment les valeurs des contrôleurs MIDI ou 
les paramètres des plug-in, apparaît sous forme 
d'une succession de paliers sur la ligne de point 
d'inflexion. Faites glisser un point d'inflexion 
vers le haut ou vers le bas pour changer de palier 
et modifier la valeur de la commande. Déplacez 
un point d'inflexion vers la gauche ou vers la 
droite pour définir la durée du changement de 
commandes discontinues.

Modification de points d'inflexion 
d'automation

Pour modifier les points d'inflexion 
d'automation, affichez le paramètre 
d'automation à modifier en le sélectionnant 
dans le sélecteur de vue de piste, puis exécutez 
l'une des actions suivantes :

Pour créer un point d'inflexion :

■ Cliquez sur la ligne graphique avec l'outil 
Crayon ou Main.

Pour modifier un point d'inflexion :

■ Cliquez sur un point existant de la ligne 
graphique avec l'outil Main, puis déplacez-le.

Pour supprimer un point d'inflexion :

■ Cliquez sur les points d'inflexion avec l'outil 
Main tout en appuyant sur la touche Alt 
(Windows) ou Option (Macintosh).

Automation du volume de piste

Automation de panoramique de piste

Automation de coupure (Mute) de piste

Automation de commande discontinue
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Pour modifier plusieurs points d'inflexion en une 
seule opération :

■ A l'aide du sélecteur, sélectionnez une plage 
de la liste d'automation contenant les points 
d'inflexion, puis exécutez l'une des actions 
suivantes :

• Appuyez sur la touche Plus (+) pour placer 
les points d'inflexion plus tard sur la piste 
(vers la droite) ou sur la touche Moins (-) 
pour les placer plus tôt (vers la gauche). Les 
points d'inflexion se déplacent de la valeur 
d'incrément fixée.

• Pour régler la valeur des points d'inflexion, 
cliquez avec les outils de trimming sur la 
sélection, puis faites glisser les points 
d'inflexion vers le haut ou vers le bas.

Pour modifier toutes les valeurs de point 
d'inflexion dans une région :

■ Cliquez dans la région avec un des outils de 
trimming, puis faites glisser les points 
d'inflexion vers le haut ou vers le bas.

Restreindre les nouveaux points 
d'inflexion à la valeur d'automation 
suivante ou précédente

Les nouveaux points d'inflexion d'automation 
peuvent être restreints et écrits à la même valeur 
que le point d'inflexion suivant ou précédent.

Pour écrire un nouveau point d'inflexion à la valeur 
d'automation suivante :

■ Tout en maintenant les touches Alt+Maj 
(Windows) ou Option+Maj (Macintosh) 
enfoncées, écrivez un point d'inflexion (en 
cliquant à l'aide d'un des outils Main dans la 
playlist d'automation de la piste).

Lorsque vous modifiez une sélection 
contenant des points d'inflexion à l'aide de 
l'outil de trimming, de nouveaux points 
d'inflexion ancrés sont créés avant et après 
la zone sélectionnée. Pour éviter la création 
de ces points d'inflexion ancrés, appuyez sur 
Alt (Windows) ou Option (Macintosh) tout 
en appliquant l'outil de trimming.

Restriction et écriture de nouveaux points d'inflexion 
(au marqueur 1)

L'écriture d'un nouveau point d'inflexion 
à la valeur d'automation suivante ou 
précédente est réalisée à l'aide d'un des 
outils Main mais n'est pas prise en charge 
par l'outil Smart.

Automation d'origine

Après l'écriture au point d'inflexion précédent

Après l'écriture au point 
d'inflexion suivant
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Pour écrire un nouveau point d'inflexion à la valeur 
d'automation précédente :

■ Tout en maintenant les touches Ctrl+Alt 
(Windows) ou Pomme+Option (Macintosh) 
enfoncées, écrivez un point d'inflexion (en 
cliquant à l'aide d'un des outils Main dans la 
playlist d'automation de la piste).

Modification de l'automation sur 
les pistes stéréo et multicanaux

Les pistes stéréo et multicanaux affichent une 
seule playlist d'automation par piste. Une seule 
playlist de volume et de coupure est disponible 
pour la piste stéréo ou multicanal.

En ce qui concerne les plug-in multimono, il est 
possible d'afficher et de modifier les playlists 
d'automation par canal lorsque les plug-in sont 
désolidarisés et que la piste est affichée en mode 
développé. 

Vue de piste développée

Par défaut, une playlist unique s'affiche sur les 
pistes stéréo et multicanaux. La playlist occupe 
la hauteur totale de la piste (à l'instar des 
playlists d'automation en mono).

Si vous le souhaitez, vous pouvez afficher une 
vue développée de la piste présentant la playlist 
d'automation de chacun des canaux. 

Playlists d'automation de plug-in sur pistes 
stéréo et multicanaux

Certains plug-in multicanaux offrent un seul jeu 
de commandes, qu'il est possible d'automatiser 
pour tous les canaux d'une piste. Certains plug-
in multicanaux et tous les plug-in multimono 
fournissent également un jeu de commandes 

pour tous les canaux lorsqu'ils sont liés et des 
commandes séparées lorsqu'ils sont 
désolidarisés. Pour en savoir plus, reportez-vous 
au guide de votre plug-in.

Pour afficher et modifier les playlists individuelles 
d'un plug-in multimono :

1  Désolidarisez le plug-in.

2  Sélectionnez la playlist choisie dans le 
sélecteur de vue de piste.

Modification de l'automation sur 
des pistes groupées

Lorsque vous modifiez les données 
d'automation sur une piste audio appartenant à 
un groupe Edit actif, ce type d'automation (à 
l'exception des commandes de panoramique 
audio et MIDI) est modifié sur toutes les pistes 
du groupe. Ce phénomène se produit même 
lorsque le paramètre n'est pas affiché sur les 
autres pistes groupées.

Cependant, lorsque vous modifiez les données 
d'automation sur une piste MIDI appartenant à 
un groupe Edit actif, le regroupement est ignoré. 
Ce type d'automation (à l'exception des 
commandes de panoramique audio et MIDI) 

Sélectionner une liste d'automation pour un
plug-in multimono non lié

plug-in multimono non lié
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n'est pas modifié sur toutes les pistes du groupe. 
Pour modifier tous les membres du groupe 
MIDI, reportez-vous à la procédure décrite 
ci-dessous.

Exemples

◆ Si vous créez des points d'inflexion 
d'automation sur une piste appartenant à un 
groupe (à l'aide de l'outil Crayon ou de l'outil 
Main), les points d'inflexion des autres membres 
du groupe sont placés en fonction de cette piste.

◆ Si vous déplacez une automation de volume 
ou de départ sur une piste appartenant à un 
groupe (à l'aide de l'un des outils de trimming), 
les points d'inflexion de volume ou de départ 
des autres membres du groupe sont rognés en 
fonction de cette piste. Vous pouvez ainsi rogner 
des sections complètes d'un mixage.

Pour éditer individuellement un membre d'un 
groupe sans en affecter les autres membres :

■ Pour les pistes audio, d'entrée auxiliaire et 
d'instrument, appuyez sur Démarrer (Windows) 
ou sur Contrôle (Macintosh) pendant l'édition.

– ou –

■ Pour les pistes MIDI, n'appuyez pas sur 
Démarrer (Windows) ou sur Ctrl (Macintosh) 
pendant l'édition.

Pour éditer tous les membres d'un groupe :

■ Pour les pistes audio, d'entrée auxiliaire et 
d'instrument, n'appuyez passur Démarrer 
(Windows) ou sur Contrôle (Macintosh) 
pendant l'édition. 

– ou –

■ Pour les pistes MIDI, appuyez sur Démarrer 
(Windows) ou sur Ctrl (Macintosh) pendant 
l'édition.

Couper/Copier/Coller de données 
d'automation

Couper (cut) des données d'automation 
n'équivaut pas à les supprimer (delete) : les 
résultats obtenus sont différents (bien que dans 
les deux cas, les données d'automation 
existantes soient modifiées). La copie laisse 
intactes les données d'automation originales.

Rognage d'automation sur une piste active d'un groupe

Lors de l'édition de données d'automation, 
les commandes de panoramique audio et 
MIDI fonctionnent à l'inverse des autres 
commandes.

Pour les pistes audio, d'entrée auxiliaire 
et d'instrument, lorsque vous éditez ou 
rognez des points d'inflexion du 
panoramique, les groupes d'édition ne 
sont pas respectés. Pour activer le 
comportement de groupe, appuyez sur 
Démarrer (Windows) ou sur Contrôle 
(Macintosh) pendant le rognage.

Pour le panoramique MIDI sur des pistes 
MIDI ou d'instrument, lorsque vous éditez 
ou rognez des points d'inflexion du 
panoramique, les groupes d'édition sont 
respectés. Pour activer le comportement 
individuel, appuyez sur Démarrer 
(Windows) ou sur Control (Macintosh) 
pendant le rognage.
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Pour supprimer (Delete) des données 
d'automation, sélectionnez une plage de points 
d'inflexion, puis appuyez sur la touche de 
suppression (Windows) ou sur la touche 
d'effacement arrière (Macintosh). Pour plus 
d'informations, consultez la section Suppression 
des données d'automation, page 653.

Pour couper des données d'automation, 
sélectionnez une plage de points d'inflexion 
dans une liste d'automation et choisissez la 
commande Cut.

Lorsque vous coupez des données d'automation, 
puis les collez à un nouvel emplacement, des 
points d'inflexion ancrés s'ajoutent aux points 
d'extrémité des données. Ce phénomène 
préserve la pente d'atténuation réelle (pour les 
commandes continues telles que les faders de 
volume ou les panoramiques) ou l'état (pour les 
commandes commutées ou discontinues telles 
que les Mutes) des données d'automation, tant à 
l'intérieur qu'à l'extérieur de la sélection.

Les figures ci-après illustrent les différences 
entre couper et supprimer des données 
d'automation. Dans la Figure 26, une piste est 
configurée pour afficher l'automation du 
volume et une plage de données d'automation 
est sélectionnée.

Si vous choisissez la commande Cut, des points 
d'inflexion ancrés sont créés à chaque extrémité 
de la sélection et la pente d'atténuation de 
l'automation de chaque côté des données 
coupées est préservée, comme illustré dans la 
Figure 27. 

Si vous supprimez (Delete) les données en 
appuyant sur la touche de suppression 
(Windows) ou sur la touche d'effacement arrière 
(Macintosh), les valeurs d'automation 
s'étendent entre les points d'inflexion pré-
existants, comme l'illustre la Figure 28. 

De plus, si les données coupées ou copiées sont 
collées à un autre emplacement de la piste, des 
points d'inflexion sont créés aux extrémités des 
données collées afin d'en préserver la valeur et la 
pente, comme l'illustre la Figure 29.

Figure 26.  Sélection de données d'automation

Figure 27.  Après « Cut » des données d'automation

Figure 28.  Après suppression des données 
d'automation

Figure 29.  Après collage de données d'automation à un 
autre emplacement
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Modification et vues de piste

Les pistes audio et MIDI possèdent chacune une 
vue Track constituant le format principal pour 
tout ce qui est édition. Lorsque le format 
principal est affiché, toutes les modifications 
effectuées sur la piste s'appliquent à la totalité 
des données de cette piste.

Les formats de vue principaux sont les suivants :

• Pistes audio : Blocks et Waveform

• Pistes MIDI : Blocks, Regions et Notes

Par exemple, lorsqu'une piste audio est 
configurée au format Waveform (formes 
d'ondes) ou Blocks (blocs), les 
couper/copier/coller s'appliquent aux données 
audio et à tous les types de données 
d'automation de la piste. Si la piste est 
configurée pour afficher les données 
d'automation de panoramique, seules les 
données de panoramique sont modifiées.

Lorsqu'une sélection comprend plusieurs pistes 
dont l'une est configurée au format de vue 
principale, toutes les données des pistes 
sélectionnées sont modifiées.

Pour modifier tous les types d'automation sur une 
piste d'entrée auxiliaire ou de fader principal, 
effectuez l'une des actions suivantes :

■ Définissez une sélection de modification 
comprenant au moins une piste audio ou MIDI 
affichée au format principal.

– ou –

■ Appuyez sur la touche Contrôle en coupant 
ou en collant les données d'automation. 

Conseils pour couper, copier et coller

◆ Sur les pistes audio, si vous coupez ou copiez 
une section de forme d'ondes dans une vue 
Waveform, toutes les données d'automation 
associées à cette forme d'ondes sont également 
coupées ou copiées.

◆ Sur les pistes audio, si vous coupez dans une 
vue Waveform des données audio sur une piste 
contenant également des données 
d'automation, des points d'inflexion sont 
automatiquement créés aux limites des données 
d'automation restantes.

◆ Sur les pistes audio, le collage de données de 
formes d'ondes colle également toutes les 
données d'automation associées. 

◆ Sur les pistes d'entrée auxiliaire, de fader 
principal ou d'instrument, seules les données 
d'automation affichées sont coupées ou copiées. 
Pour couper ou copier toutes les données 
d'automation sur ces types de piste, appuyez sur 
la touche Contrôle tout en procédant au 
couper/copier.

◆ Sur les pistes contenant une playlist 
d'automation exempte de données (par 
exemple, s'il n'existe qu'un seul point 
d'inflexion au début de la piste), couper les 
données n'entraîne pas la création de nouveaux 
points d'inflexion.

◆ En cas de chevauchement de régions (par 
exemple, lors de déplacements de régions en 
mode Slip), la suppression d'une région ainsi 
superposée entraîne la perte de tous les points 
d'inflexion d'automation situés en dessous.

◆ Si des données coupées ou copiées 
contiennent un type d'automation non présent 
sur la piste cible, Pro Tools vous avertit avant de 
permettre le collage des données. 

◆ Les données d'automation coupées ou copiées 
concernant des plug-in ou des départs non 
présents sur la piste cible sont ignorées 
lorsqu'elles sont collées.

Pour plus de souplesse, vous pouvez utiliser 
des playlists ou la commande Duplicate 
Track pour travailler en toute sécurité sur 
une copie des données modifiées. 
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Commandes Cut Special, Copy Special, 
Clear Special et Paste Special

Les quatre commandes « spéciales » (Cut 
Special, Copy Special, Paste Special et Clear 
Special) simplifient les tâches de déplacement 
ou de suppression de différents types de 
données d'automation et de données de 
contrôleur MIDI entre des pistes, des départs et 
des plug-in. Ces commandes vous permettent :

• de modifier les données d'automation et de 
contrôleur MIDI uniquement (auxquelles 
aucune note audio ou MIDI n'est associée).

• de modifier les données d'automation et de 
contrôleur MIDI sans avoir à changer de 
vue de piste.

En outre, la commande Paste Special vous 
permet de copier un type de données sur un 
autre (par exemple, des données du 
panoramique gauche dans la playlist du 
panoramique de droite)

Cut Special

Les commandes Cut Special vous permettent de 
couper uniquement les données d'automation 
de la sélection actuelle (sans les notes audio ou 
MIDI associées) et de les placer en mémoire pour 
les coller à un autre emplacement de la manière 
suivante. Vous avez le choix entre les options 
suivantes :

All Automation : coupe toutes les données 
d'automation ou de contrôleur MIDI qu'elles 
soient ou non affichées. 

Pan Automation : ne coupe que les données 
d'automation de panoramique ou les données 
de panoramique MIDI qu'elles soient ou non 
affichées.

Plug-In Automation : ne coupe que les données 
d'automation de plug-in qui sont affichées.

Copy Special

Les commandes Copy Special vous permettent 
de copier uniquement les données 
d'automation de la sélection actuelle (sans les 
notes audio ou MIDI associées) et d'en placer 
une copie en mémoire pour les coller à un autre 
emplacement de la manière suivante.

All Automation : copie toutes les données 
d'automation ou de contrôleur MIDI qu'elles 
soient ou non affichées. 

Pan Automation : ne copie que les données 
d'automation de panoramique ou les données 
de panoramique MIDI qu'elles soient ou non 
affichées.

Plug-In Automation : ne copie que les données 
d'automation de plug-in qui sont affichées.

Paste Special

Les commandes Paste Special vous permettent 
de coller des données d'automation dans une 
autre région (sans que cela affecte les notes 
audio ou MIDI) d'une des manières suivantes : 

Merge : vous permet d'ajouter les données 
collées à des données d'automation existantes 
du même type dans la sélection de la 
destination. Cette fonction permet de regrouper 
dans une piste MIDI unique des données MIDI 
provenant de plusieurs pistes. Par exemple, vous 
aimez la variation de hauteur des trombones du 
synthétiseur et souhaitez l'appliquer à la guitare 
du synthétiseur.

Vous ne pouvez pas coller des données de 
contrôleur MIDI sur des données 
d'automation, ni inversement.
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Repeat to Fill Selection : colle plusieurs 
instances des données d'automation sur toute la 
plage de sélections. Si vous sélectionnez une 
zone dont la taille n'est pas un multiple exact de 
celle de la région copiée, la partie restante de la 
sélection est remplie par une version rognée de 
la sélection d'origine. Cette fonction permet de 
créer facilement des boucles de batterie et autres 
effets répétitifs. Avant de coller les données, 
Pro Tools vous invite à spécifier un crossfade 
pour lisser les transitions entre les régions. 

To Current Automation Type : colle les données 
d'automation ou de contrôleur MIDI contenues 
dans le Presse-papiers sur la sélection, en tant 
que type d'automation actuel ou contrôleur 
MIDI. Ceci vous permet de copier des données 
d'automation de toute type sur tout autre type. 
Par exemple, vous pouvez copier des données 
d'automation du panoramique gauche sur des 
données d'automation de plug-in. Ou vous 
pouvez copier des données de volume MIDI 
pour les coller sur un panoramique MIDI.

Clear Special

Les commandes Clear Special vous permettent 
d'effacer uniquement les données d'automation 
de la région actuelle, de la manière suivante :

All Automation : efface toutes les données 
d'automation ou de contrôleur MIDI qu'elles 
soient ou non affichées. 

Pan Automation : n'efface que les données 
d'automation de panoramique ou les données 
de panoramique MIDI qu'elles soient ou non 
affichées.

Plug-In Automation : n'efface que les données 
d'automation de plug-in qui sont affichées.

Fonction de collage spécial pour les 
données d'automation

En général, les données d'automation copiées se 
collent dans une playlist d'automation de type 
exactement identique (par exemple, les données 
de panoramique gauche sont collées dans la liste 
de panoramique gauche). 

Toutefois, il peut arriver de vouloir coller un 
type de données sur un autre (par exemple, des 
données du panoramique gauche dans la 
playlist du panoramique de droite)

La fonction Special Paste vous permet de copier 
un type de données sur un autre. 

Pour ne coller que des données d'automation ou 
de contrôleur MIDI (sans les notes audio ou 
MIDI associées), utilisez la commande Paste 
Special (voir Paste Special, page 664).

Pour que ce mode de « Coller » spécial (Special 
Paste) fonctionne, les conditions suivantes 
doivent être respectées :

• Chaque piste à coller doit être affichée en tant 
que données d'automation.

– et –

• Le Presse-papiers de chaque piste cible ne doit 
contenir qu'une seule liste d'automation. La 
fonction de collage spécial ne peut pas copier 
plusieurs listes d'automation par piste.

Il est impossible d'échanger des données 
d'automation entre des pistes audio et MIDI 
ou entre des commandes continues (faders 
ou panoramiques) et des commandes 
commutées ou discontinues (Mute ou 
contrôleurs MIDI).
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Pour coller des données dans une liste 
d'automation différente :

■ Maintenez enfoncée la touche Démarrer 
(Windows) ou Contrôle (Macintosh), pendant 
que vous sélectionnez Edit > Paste.

Glide Automation

Les commandes Glide Automation vous 
permettent de créer manuellement une 
transition d'automation (ou glisse) d'une valeur 
d'automation existante vers une nouvelle 
valeur, sur une zone sélectionnée.

Pour appliquer une commande Glide Automation 
au type de paramètre d'automation actuel :

1  Dans la fenêtre Automation Enable, assurez-
vous que l'écriture est autorisée pour ce type 
d'automation.

2  Cliquez sur le sélecteur de vue de piste pour 
sélectionner le type d'automation à automatiser. 

3  Faites glisser le sélecteur sur la piste pour 
sélectionner la zone sur laquelle écrire le 
paramètre Glide.

4  Remplacez le paramètre d'automation par 
la valeur désirée à la fin de la sélection. 
Par exemple, pour faire glisser le volume 
d'automation vers – l'infini, déplacez le curseur 
du volume vers – l'infini.

5  Choisissez Edit > Automation > Glide to 
Current.

Pour appliquer une commande Glide Automation à 
tous les paramètre activés :

1  Dans la fenêtre Automation Enable, assurez-
vous que l'écriture est autorisée pour ces types 
d'automation.

2  Dans chaque piste à automatiser, cliquez sur le 
sélecteur de vue de piste et choisissez le type 
d'automation à automatiser dans le menu 
contextuel.

3  A l'aide du sélecteur, cliquez et faites glisser 
horizontalement pour inclure toutes les pistes 
d'une sélection à automatiser (faites glisser 
verticalement pour définir la plage temporelle).

4  Dans chaque piste à automatiser, remplacez le 
paramètre d'automation par la valeur désirée à la 
fin de la sélection.

5  Choisissez Edit > Automation > Glide to All 
Enabled.

Considérations à propos des commandes Glide 
Automation

Lorsqu'une commande Glide Automation est 
appliquée, elle se comporte de la manière 
suivante :

• Lorsqu'une sélection est effectuée, la valeur 
d'automation au début de la sélection 
représente le point de départ de l'automation 
de la glisse et la fin de la sélection, son point 
final. L'automation de la glisse qui est créée 
entre les deux points est basée sur la longueur 
de la sélection ainsi que sur la valeur finale 
sélectionnée.

Lorsque vous faites glisser plusieurs 
paramètres simultanément, par exemple 
avec le panoramique Surround ou les plug-
in, utilisez Edit > Automation > option 
Glide to All Enabled.

Vous pouvez également appuyer sur les 
touches Alt + Barre oblique (/) (Windows) 
ou Option + Barre oblique (/) (Macintosh).

Vous pouvez également appuyer sur les 
touches Alt + Maj + Barre oblique (/) 
(Windows) ou Option + Maj + Barre 
oblique (/) (Macintosh).
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• Si une sélection est effectuée alors qu'il existe 
déjà des données d'automation, les points 
d'inflexion de l'automation sont écrits aux 
points de départ et de fin de l'automation de 
la glisse.

• Si les points d'inflexion de l'automation 
correspondent à la sélection, ils ne sont pas 
modifiés ; toutefois, la valeur sélectionnée 
pour la fin de la sélection est écrite à partir du 
point final, jusqu'au point d'inflexion suivant.

• Si aucun point d'inflexion de l'automation ne 
correspond à la sélection, la valeur 
sélectionnée pour la fin de la sélection est 
écrite à la fin de la piste.

• Si aucune sélection n'est effectuée, un point 
d'inflexion est écrit à l'emplacement actuel et 
la valeur sélectionnée pour l'automation de 
glisse est écrite au point d'inflexion suivant.

Rognage de l'automation
(Pro Tools HD uniquement)

Si vous avez déjà écrit des données 
d'automation, vous pouvez modifier celles qui 
se rapportent au volume de piste et de départ en 
temps réel, en mode Trim. Lorsque le rognage 
est autorisé sur une piste, vous n'enregistrez plus 
des positions de fader absolues mais des 
modifications relatives aux données 
d'automation existantes. Pour plus 
d'informations, reportez-vous à la section Mode 
Trim, page 641.

Pour activer le mode Trim :

■ Dans la fenêtre Mix ou Edit, cliquez sur le 
sélecteur de mode d'automation de la piste dont 
l'automation doit être rognée, puis sélectionnez 
Trim.

Lorsque le mode Trim est activé sur une piste, 
ses faders de volume et de niveau de départ 
deviennent jaunes ; le contour du sélecteur de 
mode d'automation correspondant passe 
également au jaune. Ce contour clignote pour 
indiquer que le rognage est autorisé sur cette 
piste ; il reste allumé au cours de l'opération de 
rognage du volume ou des niveaux de départ de 
la piste. 

Pour rogner le volume de piste ou les niveaux de 
départ en temps réel :

1  Dans la fenêtre Automation Enable, assurez-
vous que l'écriture est autorisée pour ce type 
d'automation (volume ou niveau de départ).

2  Dans la fenêtre Mix ou Edit, cliquez sur le 
sélecteur de mode d'automation de la piste dont 
l'automation doit être rognée, puis définissez le 
mode d'automation :

• Choisissez le mode Touch ou Latch pour 
que les faders suivent l'automation 
existante : vous pouvez ainsi les 
« surveiller » au cours de la passe 
d'automation. 

• Préférez le mode Write pour désolidariser 
les faders de l'automation existante.

Activation du mode Trim
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3  Dans la fenêtre Mix ou Edit, cliquez sur le 
sélecteur de mode d'automation de la piste dont 
l'automation doit être rognée, puis sélectionnez 
Trim.

4  Cliquez sur Play pour lancer le rognage de 
l'automation et déplacer les faders de volume ou 
de niveau de départ. 

5  Une fois l'opération terminée, cliquez sur 
Stop.

Ecriture de données 
d'automation à l'ensemble, au 
début ou à la fin d'une 
sélection
(Pro Tools HD uniquement)

Pro Tools permet d'écrire les valeurs 
d'automation en cours à partir de n'importe quel 
point d'insertion en avançant (ou en reculant) 
vers la fin (ou le début) d'une sélection ou d'une 
piste, ou sur la totalité de la sélection ou de la 
piste, au cours d'une passe d'automation. 

Les commandes standard Write Automation to 
Selection/Selection Start/Selection End ne 
fonctionnent pas lorsque le transport Pro Tools 
est arrêté. Elles influent uniquement sur les 
paramètres d'automation pour lesquels l'écriture 
est autorisée et actuellement en cours d'écriture. 

Il est possible de configurer les commandes 
Write Automation to Selection, Selection Start 
et Selection End de telle sorte qu'elles 
s'appliquent toujours automatiquement. Pour 
plus d'informations, reportez-vous à la section 
Ecriture de données d'automation à l'ensemble, 
au début ou à la fin d'une sélection A l'arrêt, 
page 669. 

Conditions d'utilisation des 
commandes Write Automation standard

Pour que des données d'automation soient 
écrites pour un paramètre spécifique, la piste 
associée doit être configurée dans l'un des 
modes d'automation suivants et respecter les 
conditions ci-après.

Mode Latch : la commande d'automation doit 
être modifiée (touchée) au cours de la passe 
d'automation. 

Mode Touch : le paramètre d'automation doit 
être modifié (touché). 

Mode Write : tous les paramètres d'automation 
de la piste doivent être configurés en mode 
Write. 

Pour annuler cette commande, choisissez Edit > 
Undo.

Pour écrire les valeurs actuelles d'automation au 
début, à la fin ou sur l'ensemble d'une piste ou 
d'une sélection :

1  Ouvrez la fenêtre Automation Enable 
(Window > Automation Enable).

2  Assurez-vous que l'écriture est autorisée pour 
ce type d'automation.

3  Cliquez sur une piste au niveau d'un point 
d'insertion.

– ou –

Commandes Write Automation to Selection, Selection 
Start et Selection End de la fenêtre Automation Enable

Commandes Write Automation standard
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Faites glisser avec le sélecteur pour sélectionner 
une partie de la piste.

4  Cliquez sur Play pour lancer la lecture.

5  Si vous êtes en mode Latch ou Touch, assurez-
vous que la lecture s'effectue sur la piste 
correcte.

6  Lorsque vous atteignez un point de la piste ou 
de la sélection contenant des données 
d'automation que vous souhaitez appliquer, 
cliquez sur Write Automation to Selection, 
Selection Start ou Selection End dans la fenêtre 
Automation Enable. 

Les valeurs actuelles de toutes les données 
d'automation pour lesquelles l'écriture est 
autorisée sur ce point sont écrites dans la zone 
correspondante de la piste ou de la sélection.

Mode Trim

En mode Trim, il est également possible d'écrire 
des valeurs delta (différentielles) de rognage 
pour le volume de la piste et les niveaux de 
départ, vers le début, la fin ou l'ensemble de la 
piste. 

Pour écrire les valeurs delta de rognage en cours 
au début, à la fin ou sur l'ensemble d'une piste ou 
d'une sélection :

1  Ouvrez la fenêtre Automation Enable 
(Window > Automation Enable).

2  Assurez-vous que l'écriture est autorisée pour 
ce type d'automation (volume de piste ou 
niveau de départ).

3  Dans la fenêtre Mix ou Edit, cliquez sur le 
sélecteur de mode d'automation de la piste dont 
l'automation doit être rognée, puis sélectionnez 
Trim. Les faders de volume de piste et de niveau 
de départ deviennent jaunes.

4  Cliquez sur une piste au niveau d'un point 
d'insertion.

– ou –

Faites glisser avec le sélecteur pour sélectionner 
une partie de la piste.

5  Cliquez sur Play pour lancer la lecture. 

6  Lorsque vous atteignez un point de la piste ou 
de la sélection contenant le paramètre de 
trimming (valeur delta) que vous souhaitez 
appliquer, cliquez sur le bouton Write 
Automation to Selection, Selection Start ou 
Selection End dans la fenêtre Automation 
Enable.

Les modifications relatives apportées au volume 
de piste et de départ à ce point sont écrits dans la 
zone correspondante de la piste ou de la 
sélection.

Ecriture de données d'automation 
à l'ensemble, au début ou à la fin 
d'une sélection A l'arrêt

La fenêtre Automation Enable contient des 
options permettant d'écrire des données 
d'automation après la réalisation d'une passe 
d'automation correcte. 

Il est possible de configurer les commandes 
Write Automation to Selection, Selection Start 
et Selection End On Stop de telle sorte qu'elles se 
désactivent ou restent actives après la réalisation 
d'une passe d'automation correcte.
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Pour plus d'informations, reportez-vous à la 
section Conditions d'utilisation des commandes 
Write Automation standard, page 668. 

Pour configurer les modes d'écriture à l'arrêt de 
façon à ce qu'ils se désactivent après une passe 
d'automation :

1  Ouvrez la fenêtre Automation Enable 
(Window > Automation Enable).

2  Cliquez pour activer l'un des modes d'écriture 
à l'arrêt (Selection, Selection Start, Selection 
End).

La flèche du mode d'écriture à l'arrêt activé 
s'affiche en bleu.

Pour configurer les modes d'écriture à l'arrêt de 
façon à ce qu'ils restent activés après une passe 
d'automation :

1  Ouvrez la fenêtre Automation Enable 
(Window > Automation Enable).

2  Appuyez sur la touche Alt (Windows) ou 
Option (Macintosh), puis cliquez sur l'un des 
modes d'écriture à l'arrêt (Selection, Selection 
Start, Selection End) pour l'activer.

La flèche du mode d'écriture à l'arrêt activé 
s'affiche en rouge.

Écriture de données 
d'automation au point 
d'inflexion suivant
(Pro Tools HD uniquement)

Lorsque vous effectuez une passe d'automation, 
Pro Tools vous permet d'écrire le valeurs 
d'automation actuelles, du point d'insertion 
actuel vers le point d'inflexion suivant 
(similaire).

Ceci vous permet de mettre à jour les données 
d'automation d'une piste sans écraser celles qui 
se trouvent précédemment ou plus loin sur la 
règle temporelle, et sans avoir à définir de 
sélection avant la modification des données 
d'automation.

Tout comme les commandes standard Write 
Automation to Selection, la commande 
standard Write Automation to Next Breakpoint 
ne fonctionne pas lorsque le transport Pro Tools 
est arrêté. Elles influent uniquement sur les 
paramètres d'automation pour lesquels l'écriture 
est autorisée et actuellement en cours d'écriture. 

Optionnellement, la commande Write 
Automation to Next Breakpoint peut être 
configurée de façon à être appliquée 
automatiquement après une passe d'automation 
valide. Voir Option Write Automation to Next 
Breakpoint On Stop, page 672.

Commandes Write On Stop dans la fenêtre Automation 
Enable

Écriture des données 
d'automation à l'arrêt

La commande Write Automation to Next 
Breakpoint a les mêmes conditions 
d'utilisation que les commandes Write 
Automation to Selection, Selection Start et 
Selection End. Pour plus d'informations, 
reportez-vous à la section Ecriture de 
données d'automation à l'ensemble, au 
début ou à la fin d'une sélection, 
page 668.
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La commande Write Automation to Next 
Breakpoint reste activée après une passe 
d'automation correcte. A l'inverse des 
commandes Write Automation standard, elle ne 
peut pas être configurée de façon à se désactiver 
après une passe d'automation.

Pour écrire les valeurs d'automation actuelles au 
point d'inflexion suivant :

1  Ouvrez la fenêtre Automation Enable 
(Window > Automation Enable).

2  Assurez-vous que l'écriture est autorisée pour 
ce type d'automation.

3  Cliquez sur une piste au niveau d'un point 
d'insertion.

4  Cliquez sur Play pour lancer la lecture.

5  Si vous êtes en mode Latch ou Touch, assurez-
vous que la lecture s'effectue sur la piste 
correcte.

6  Lorsque les données de contrôleur écrites vous 
conviennent et que vous souhaitez les 
appliquer, cliquez sur Write Automation to Next 
Breakpoint dans la fenêtre Automation Enable. 

Les valeurs actuelles de toutes les commandes 
écrites à ce stade sont écrites jusqu'au point 
d'inflexion suivant, arrêtant automatiquement 
le transport.

Mode Trim de la commande Write To 
Next Breakpoint

En mode Trim, il est également possible d'écrire 
des valeurs delta (différentielles) de rognage 
pour le volume de la piste et les niveaux de 
départ au point d'inflexion écrit suivant.

Pour écrire les valeurs delta de rognage actuelles 
au point d'inflexion suivant :

1  Ouvrez la fenêtre Automation Enable 
(Window > Automation Enable).

2  Assurez-vous que l'écriture est autorisée pour 
ce type d'automation (volume de piste ou 
niveau de départ).

3  Dans la fenêtre Mix ou Edit, cliquez sur le 
sélecteur de mode d'automation, puis 
sélectionnez Trim. Les faders de volume de piste 
et de niveau de départ deviennent jaunes.

4  Effectuez l'une des opérations suivantes :

• Cliquez sur une piste au niveau d'un point 
d'insertion.

– ou –

• Faites glisser avec le sélecteur pour 
sélectionner une partie de la piste.

5  Cliquez sur Play pour lancer la lecture. 

6  Lorsque les données de contrôleur écrites vous 
conviennent et que vous souhaitez les 
appliquer, cliquez sur le bouton Write 
Automation to Next Breakpoint dans la fenêtre 
Automation Enable.

Les modifications relatives apportées au volume 
de piste et de départ à ce point sont écrits dans la 
zone correspondante de la piste ou de la 
sélection.

Bouton Write Automation to Next Breakpoint on Stop de 
la fenêtre Automation Enable

Bouton Write Automation to Next Breakpoint
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Option Write Automation to Next 
Breakpoint On Stop

La fenêtre Automation Enable contient une 
option permettant l'écriture automatique des 
données d'automation au point d'inflexion 
suivant à l'arrêt.

La commande Write Automation to Next 
Breakpoint on Stop reste activée après une passe 
d'automation correcte. A l'inverse des modes 
d'écriture à l'arrêt (Write Automation to 
Selection, Selection Start et Selection End), elle 
ne peut pas être configurée de façon à se 
désactiver après une passe d'automation.

Pour configurer l'option Write Automation to Next 
Breakpoint on Stop :

1  Ouvrez la fenêtre Automation Enable 
(Window > Automation Enable).

2  Cliquez sur Write Automation to Next 
Breakpoint on Stop pour l'activer. 

Lorsque cette option est activée, l'écriture des 
données d'automation s'effectue 
automatiquement au point d'inflexion suivant 
après une passe d'automation correcte.

Commande Mute Automation 
Overwrite/Extend
(Pro Tools HD uniquement)

La commande Mute Overwrite/Extend vous 
permet d'écraser ou de rallonger un événement 
de coupure de son en temps réel, sans modifier 
l'état Mute actuel.

Un événement de coupure de son peut être 
écrasé lorsque la passe d'automation démarre 
avant le premier événement de coupure de son 
et se termine après le deuxième événement. 
Dans ce cas, l'état actuel activé/désactivé de la 
coupure de son est conservé.

Bouton Write Automation to Next Breakpoint on Stop de 
la fenêtre Automation Enable

Bouton Write Automation to 
Next Breakpoint On Stop

Ecrasement d'un événement d'automation de coupure 
de son

Coupure de son d'un événement écrasée

Automation de la coupure de son d'origine
(coupure de son désactivée,coupure de son activée, 
coupure de son désactivée)
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Un événement de coupure de son peut être 
rallongé lorsque la passe d'automation démarre 
avant un événement activé ou désactivé et se 
termine avant la fin du deuxième événement.

La commande Mute Overwrite/Extend est prise 
en charge par le mode Touch et le mode Latch, 
comme suit :

Mode Touch : écrit l'état actuel tant que le 
bouton Mute est maintenu enfoncé.

Mode Latch : écrit l'état actuel jusqu'à ce que 
vous arrêtiez l'opération ou utilisiez la 
commande AutoMatch (avec les surfaces de 
contrôle de Digidesign prises en charge 
uniquement).

Pour écraser un état de coupure de son de une ou 
plusieurs pistes :

1  Sélectionnez Window > Automation Enable. 

2  Vérifiez que la coupure de son est autorisée.

3  Dans la fenêtre Mix ou Edit, cliquez sur le 
sélecteur de mode d'automation de la piste dont 
l'état Mute doit être écrasé, puis sélectionnez le 
mode Touch ou Latch comme mode 
d'automation.

4  Dans chaque piste à automatiser, cliquez sur le 
sélecteur de vue de piste et sélectionnez Mute.

5  Placez le curseur avant le début de 
l'événement de coupure de son à écraser.

6  Lancez la lecture.

Rallongement d'un événement d'automation de 
coupure de son

Evénement de coupure de son désactivée rallongé 

Automation de la coupure de son d'origine
(coupure de son désactivée,coupure de son activée, 
coupure de son désactivée)

(jusqu'à la fin de la passe d'automation)

Commande Mute de la fenêtre Automation Enable

Pour écraser des états Mute sur plusieurs 
pistes, activez le même mode 
d'automation pour toutes ces pistes.

Placement du curseur avant le début de l'événement de 
coupure de son

Commande Mute activée

Exemple : Placez le curseur ici, 
avant le début de l'événement de coupure de son
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7  Appuyez sur la touche Ctrl (Windows) ou la 
touche Pomme (Macintosh) et sur le bouton 
Mute de la piste avant le début de l'événement 
de coupure de son à écraser.

8  Après la fin du deuxième événement de 
coupure de son, relâchez les touches et le 
bouton Mute.

9  A la fin de la passe d'automation, cliquez sur 
Stop.

Pour rallonger un état Mute sur une piste :

1  Sélectionnez Window > Automation Enable. 

2  Vérifiez que la coupure de son est autorisée.

3  Dans la fenêtre Mix ou Edit, cliquez sur le 
sélecteur de mode d'automation de la piste à 
automatiser, puis sélectionnez le mode Touch 
ou le mode Latch.

4  Dans chaque piste à automatiser, cliquez sur le 
sélecteur de vue de piste et sélectionnez Mute.

5  Placez le curseur avant le début de 
l'événement de coupure de son à rallonger.

6  Lancez la lecture.

7  Appuyez sur la touche Ctrl (Windows) ou la 
touche Pomme (Macintosh) et sur le bouton 
Mute de la piste avant le début de l'événement 
de coupure de son à rallonger.

8  Avant la fin du deuxième événement de 
coupure de son, relâchez les touches et le 
bouton Mute.

Pour écraser des états Mute sur plusieurs 
pistes, appuyez sur les touches Alt + Ctrl 
(Windows) ou les touches Option + Pomme 
(Macintosh) et le bouton Mute d'une des 
pistes à automatiser.

En mode Touch, vous devez maintenir le 
bouton Mute enfoncé tout au long de 
l'écriture.

Arrêt de l'automation après la fin d'un événement de 
coupure de son

Exemple d'un état Mute écrasé

Exemple : Arrêtez la passe d'automation ici, 
après la fin de l'événement de coupure de son

Etat Mute écrasé

Pour rallonger des états Mute sur 
plusieurs pistes, activez le même mode 
d'automation pour toutes ces pistes.

Placement du curseur avant le début de l'événement de 
coupure de son

Pour rallonger des états Mute sur plusieurs 
pistes, appuyez sur les touches Alt + Ctrl 
(Windows) ou les touches Option + Pomme 
(Macintosh) et le bouton Mute de la piste.

Si vous rallongez un événement au-delà de 
l'événement activé ou désactivé suivant, 
l'intégralité de l'événement est modifié.

Exemple : Placez le curseur ici, 
avant le début de l'événement de coupure de son
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9  A la fin de la passe d'automation, cliquez sur 
Stop.

Création d'automation par 
Snapshot
(Pro Tools HD uniquement)

Pro Tools permet d'écrire des valeurs de données 
d'automation pour plusieurs paramètres en une 
seule opération. Il existe deux méthodes 
d'écriture d'automation par snapshot :

Vers une sélection : les données d'automation 
sont écrites vers la sélection de Timeline (et vers 
la sélection Edit si elle est liée). Des points 
d'inflexion ancrés se placent immédiatement 
avant et après la sélection afin que les données 
qu'elle contient ne soient pas modifiées.

Vers l'emplacement du curseur : les données 
d'automation sont écrites au point d'insertion 
du curseur. Après le point d'insertion, les 
données d'automation s'étendent jusqu'à la 

valeur de point d'inflexion suivante ou, en 
l'absence de point d'inflexion, elles restent à 
l'emplacement de la nouvelle valeur écrite 
jusqu'à la fin de la session.

Pour en savoir plus sur les opérations de couper, 
copier, coller de données d'automation au cours 
d'une session, reportez-vous à la section Ecriture 
de données d'automation à l'ensemble, au début 
ou à la fin d'une sélection, page 668.

Pour écrire une automation par Snapshot :

1  Dans la fenêtre Edit, cliquez sur le sélecteur de 
vue de piste pour afficher les données 
d'automation à modifier.

2  Dans la fenêtre Automation Enable, assurez-
vous que l'écriture est autorisée sur les 
paramètres à modifier. Désélectionnez tous les 
paramètres d'automation que vous souhaitez 
conserver.

3  Sélectionnez une zone sur la playlist de la piste 
(ou sur plusieurs pistes) à laquelle vous 
souhaitez appliquer l'automation. 

– ou –

Placez le curseur en un point d'insertion de 
l'option Edit.

4  Réglez les commandes à automatiser. Vous 
pouvez également modifier une présélection de 
plug-in.

5  Choisissez Edit > Automation, puis effectuez 
l'une des opérations suivantes :

• Pour écrire la valeur actuelle uniquement 
vers le paramètre d'automation affiché, 
choisissez Write to Current.

– ou –

• Pour écrire les valeurs actuelles de tous les 
paramètres d'automation activés dans la 
fenêtre Automation Enable, choisissez 
Write to All Enabled.

Arrêt de l'automation avant la fin d'un événement de 
coupure de son

Exemple d'un état Mute rallongé

Exemple : Arrêtez la passe d'automation ici, 
avant la fin de l'événement de coupure de son

Etat Mute désactivé rallongé 
(jusqu'à la fin de la passe d'automation)
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Ajout de données d'automation par 
snapshot à des listes d'automation 
vides

Si vous exécutez une commande Write 
Automation sur une playlist d'automation ne 
contenant pas de données d'automation 
antérieures, la valeur choisie s'écrit dans la 
playlist entière et non uniquement dans la zone 
sélectionnée.

En effet, une liste vide de données d'automation 
ne contient qu'un seul point d'inflexion 
d'automation, correspondant à la position 
actuelle de la commande pour les paramètres. 
La position du point d'inflexion est mise à jour à 
chaque modification de la valeur du paramètre. 

Pour que la commande Write Automation 
n'écrive pas la valeur d'automation sélectionnée 
sur l'ensemble de la liste, vous pouvez :

• ancrer les données d'automation en plaçant le 
curseur à la fin de la session (ou sur tout autre 
point de terminaison) et en sélectionnant 
l'option Write to Current ;

– ou –

• cliquer avec un outil Main de chaque côté de 
la sélection.

Ainsi, la commande Write Automation n'écrit 
les données que dans la zone sélectionnée.

Ecriture d'automation par snapshot par 
dessus des données d'automation

Lorsque vous déplacez le curseur de lecture, les 
contrôles automatisés de Pro Tools sont mis à 
jour à l'écran, de façon à refléter les données 
d'automation présentes sur la piste. Pour 
conserver les paramètres définis pour un 
snapshot, vous pouvez suspendre les paramètres 
d'automation afin d'éviter la mise à jour de leurs 
valeurs.

Pour écrire une automation par snapshots par 
dessus des données existantes :

1  Dans la fenêtre Automation Enable, assurez-
vous que l'écriture est autorisée sur les 
paramètres d'automation à modifier. 
Désélectionnez tous les paramètres 
d'automation que vous souhaitez conserver.

2  Réglez les commandes des paramètres à 
automatiser.

3  Cliquez sur le sélecteur de mode d'automation 
puis sélectionnez le mode Off pour les pistes 
auxquelles vous souhaitez appliquer 
l'automation.

4  A l'aide du sélecteur, sélectionnez la partie de 
la piste sur laquelle vous souhaitez appliquer 
l'automation.

5  Choisissez Edit > Automation, puis 
sélectionnez l'une des options suivantes dans le 
sous-menu :

• Pour écrire la valeur actuelle uniquement 
vers le paramètre d'automation affiché 
dans la fenêtre Edit, choisissez Write to 
Current.

– ou –

• Pour écrire les valeurs actuelles de tous les 
paramètres d'automation activés dans la 
fenêtre Automation Enable, choisissez 
Write to All Enabled.

6  Cliquez sur le sélecteur de mode d'automation 
puis sélectionnez le mode Read pour les pistes 
que vous souhaitez lire avec l'automation.

Capture de données d'automation et 
application en un autre point

Les commandes Write Automation peuvent 
également permettre de capturer des états 
d'automation en des points spécifiques d'une 
session et de les appliquer à d'autres 
emplacements. 
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Pour acquérir et appliquer des données 
d'automation :

1  Dans la fenêtre Automation Enable, assurez-
vous que l'écriture est autorisée sur les 
paramètres d'automation à modifier. 
Désélectionnez tous les paramètres 
d'automation que vous souhaitez conserver.

2  Cliquez avec le sélecteur sur la piste contenant 
les données d'automation à acquérir. Toutes les 
commandes automatisées sont mises à jour pour 
refléter les données d'automation à cet 
emplacement. Si vous définissez une sélection, 
les commandes sont mises à jour pour refléter 
les données d'automation du début de la 
sélection.

3  Cliquez sur le sélecteur de mode d'automation 
de chaque piste à laquelle vous souhaitez 
appliquer l'automation, puis sélectionnez Off 
comme mode d'automation.

4  A l'aide du sélecteur, sélectionnez 
l'emplacement où vous souhaitez appliquer 
l'automation.

5  Activez les paramètres d'automation 
précédemment suspendus.

6  Choisissez Edit > Automation, puis 
sélectionnez l'une des options suivantes dans le 
sous-menu :

• Pour écrire la valeur actuelle uniquement 
vers le paramètre d'automation affiché 
dans la fenêtre Edit, choisissez To Current 
Parameter.

– ou –

• Pour écrire les valeurs actuelles de tous les 
paramètres d'automation activés dans la 
fenêtre Automation Enable, choisissez To 
All Enabled Parameters.

7  Cliquez sur le sélecteur de mode d'automation 
puis sélectionnez le mode Read pour les pistes 
que vous souhaitez lire avec l'automation.

Automation par snapshots et 
rognage de données d'automation

Pro Tools permet de rogner des valeurs telles que 
les snapshots et d'appliquer les changements 
relatifs (valeurs delta) aux données d'automation 
sélectionnées à l'aide de la commande Trim 
Automation. Cette procédure est comparable à 
l'action de la commande Write Automation 
mais elle écrit les valeurs delta (différentielles) et 
non les valeurs absolues des données 
d'automation. 

Vous pouvez utiliser des valeurs de rognage pour 
écrire une automation instantanée vers tout 
paramètre qu'il est possible d'automatiser.

Pour créer un snapshot des changements relatifs 
apportés aux données d'automation :

1  Dans la fenêtre Automation Enable, assurez-
vous que l'écriture est autorisée sur les 
paramètres d'automation à modifier. 
Désélectionnez tous les paramètres 
d'automation que vous souhaitez conserver.

2  Sélectionnez la zone de piste à modifier. 
Toutes les commandes automatisées sont mises 
à jour pour refléter les données d'automation au 
début de la sélection.

3  Déplacez les commandes du paramètre vers le 
haut ou vers le bas, de la valeur de modification 
que vous souhaitez appliquer aux données. 
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4  Choisissez Edit > Automation, puis effectuez 
l'une des opérations suivantes :

• Pour écrire la valeur delta actuelle 
uniquement vers le paramètre 
d'automation affiché, choisissez Trim to 
Current.

– ou –

• Pour écrire la valeur delta actuelle pour 
tous les paramètres d'automation activés 
dans la fenêtre Automation Enable, 
choisissez Trim to All Enabled.

Automation Follows Edit, 
commande

Lorsque cette commande est désactivée, les 
événements d'automation ne sont pas affectés 
par les modifications apportées aux notes audio 
ou MIDI. Lorsque cette commande est activée, 
les événements d'automation sont affectés par 
les modifications apportées aux notes audio ou 
MIDI.

Pour désactiver la commande Automation Follows 
Edit :

■ Sélectionnez Options > Automation Follows 
Edit.
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Chapitre 28 : Mixage final

Pro Tools vous permet d'enregistrer et de prémixer 
des pistes sur un disque. La commande Bounce 
to Disk permet d'enregistrer un mixage final sur 
un disque, de créer un nouvel enregistrement en 
boucle, de figer des effets ou de consolider tout 
type prémixage. Vous pouvez également 
prémixer, envoyer vers de nouvelles pistes audio 
et enregistrer des bus et des entrées. 

Bounce to Disk : cette commande écrit la 
session en cours (en l'absence de sélection) ou la 
sélection d'édition (Edit) ou de graduation 
temporelle (Timeline) sur le disque, sous forme 
de nouveaux fichiers audio. Toute sortie ou 
chemin de bus disponible peut faire office de 
source de prémixage. La commande Bounce to 
Disk sert aussi à écrire ou masteriser n'importe 
quelle sortie ou chemin de bus directement sur 
un disque. La fréquence d'échantillonnage, la 
résolution et les autres processus de conversion 
peuvent être appliqués en cours de prémixage 
(bounce) ou après. La commande Bounce to 
Disk permet de prémixer toutes les voix 
disponibles sur disque, sans devoir en garder 
une seule en réserve. Bien qu'il soit possible 
d'écouter en temps réel le prémixage en cours de 
création, vous ne pourrez pas agir sur la console 
ou autres commandes au cours de la procédure 
de Bounce to Disk. 

Enregistrement sur des pistes : ce processus de 
prémixage et d'enregistrement sur de nouvelles 
pistes audio est comparable au mixage et à 
l'enregistrement de n'importe quels signaux 
d'entrée. Cette méthode utilise des pistes, des 
voix et des chemins de bus disponibles, en 
nombre suffisant pour gérer le prémixage et les 
nouvelles pistes. Lors de l'enregistrement sur 
pistes, vous pouvez régler la console de mixage 
ou d'autres commandes.

Sélection de sons pour des boucles, 
des prémixages et des effets

Le prémixage sur disque (Bounce to Disk) et 
l'enregistrement sur pistes s'appliquent à la 
sélection Timeline ou Edit le cas échéant. Il est 
ainsi plus facile de convertir des sélections 
réalisées à partir de plusieurs pistes en boucles 
mono, stéréo ou multicanaux. Les prémixages, 
les stems et les autres types de mixage spécialisé 
peuvent également être enregistrés sur disque au 
moyen de l'une de ces méthodes, soit sur une 
machine DAT ou MDM, soit sur tout autre 
support d'enregistrement, de transfert ou 
d'archivage. 
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Enregistrer des effets sur un disque permet de les 
« figer », c'est-à-dire d'ajouter de façon définitive 
des effets en temps réel (par exemple une 
égalisation ou une réverbération) à une piste 
audio. Il suffit de la transférer et de l'enregistrer 
sur d'autres pistes en ajoutant les effets désirés. 
Les données audio originales sont préservées, ce 
qui permet de revenir à tout moment à la piste 
source. « Figer » ainsi les effets se révèlent 
notamment utile si vous disposez d'un nombre 
limité de pistes ou d'effets externes. 

Utilisez la commande Bounce to Disk si vous 
devez convertir les fichiers de prémixage ou si 
vous désirez éviter toute action accidentelle sur 
les commandes de la console au cours du 
prémixage. 

Procédez à l'enregistrement sur de nouvelles 
pistes si vous souhaitez être en mesure de régler 
les commandes en cours d'écriture des fichiers. 

Dithering et prémixage sur disque 
(Bounce)

Le processus de dithering peut améliorer 
considérablement la qualité du son. En général, 
cette procédure est nécessaire en cas de 
réduction de résolution des données 
audionumériques. 

Si vous utilisez la commande Bounce to Disk, 
sachez que ce processus ne permet pas 
d'appliquer de dithering. 

Pour appliquer du dithering à un fichier de 
prémixage, il faut insérer l'un des plug-in Dither 
de Digidesign ou tout autre plug-in de dithering, 
sur la piste du fader principal affectée au chemin 
source du prémixage. Les pistes de fader 

principal sont souvent préférables aux entrées 
auxiliaires, car les inserts de fader principal 
s'installent après le fader (ce qui convient 
davantage au dithering).

En l'absence de plug-in de dithering sur le 
chemin source du prémixage, si vous décidez 
d'opter pour une résolution inférieure en cours 
de prémixage sur disque ou après, le fichier 
résultant est converti par troncature. 

Dans quel cas utiliser un plug-in de dithering

Utilisez un plug-in de dithering dès lors que 
vous désirez réduire la résolution comme, par 
exemple, lors d'un mastering en 16 bits avec la 
commande Bounce to Disk, ou lors d'un 
mastering vers une machine externe 
enregistrant en 16 bits. 

Il est également nécessaire dans les sessions en 
16 bits. Bien que celles-ci utilisent des fichiers 
16 bits, elles sont traitées à une résolution 
numérique supérieure :

• Des chemins de signaux audio d'entrée et de 
sortie de 24 bits avec fonctions de mixage et 
de traitement interne de 48 bits pour les 
systèmes Pro Tools|HD.

• Des chemins de signaux audio d'entrée et de 
sortie de 24 bits avec traitement des virgules 
flottantes de 32 bits pour les systèmes 
Pro Tools LE.

Ainsi, que vous travailliez dans une session 
16 bits ou 24 bits, il est conseillé d'utiliser un 
plug-in Dither lorsque vous masterisez dans un 
format 16 bits.

Masteriser dans un format 24 bits, en revanche, 
ne nécessite pas d'utiliser de plug-in Dither.

Les plug-in AudioSuite offrent une autre 
option d'enregistrement des plug-in d'effets 
sur disque. Pour en savoir plus, reportez-
vous au Guide des plug-in DigiRack.
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Utilisation du plug-in Dither sur un mixage 
de sortie

Pro Tools est fourni avec des plug-in de 
dithering en temps réel qui améliorent les 
performances en 16, 18 et 20 bits et réduisent le 
bruit de quantification lors du mixage de 
signaux de faible niveau, ou lors de fondus.

Les seules commandes des plug-in de dithering 
que l'utilisateur peut choisir sont les 
commandes Bit Resolution et Noise Shaping.

Pour utiliser un plug-in de dithering dans un 
prémixage :

1  Choisissez Track > New, puis sélectionnez 
Master Fader (stereo) dans le menu contextuel.

2  Réglez la sortie de la piste Master Fader sur la 
sortie ou le chemin de bus emprunté(e) par le 
prémixage.

3  Affectez les sorties de toutes les pistes audio de 
la session au même chemin que celui choisi à 
l'étape 2. La piste de fader principal contrôle 
désormais les niveaux de sortie de toutes les 
pistes qui y parviennent.

4  Sur la piste du fader principal, cliquez sur un 
bouton Insert, puis sélectionnez l'un des plug-in 
de dithering de Digidesign.

5  Dans la fenêtre du plug-in de dithering, réglez 
les paramètres Bit Resolution et Noise Shaping.

Lors du prémixage sur disque, il est possible de 
convertir le fichier à une résolution plus 
adaptée. Avant d'être converti par la commande 
Bounce to Disk, le signal subit un dithering, 
conformément aux valeurs spécifiées pour les 
paramètres Bit Resolution et Noise Shaping du 
plug-in de dithering.

Enregistrement sur des pistes
Vous pouvez créer un prémixage dans une 
session Pro Tools et l'enregistrer vers des pistes 
disponibles dans cette même session. Cette 
technique permet d'ajouter au mixage des 
entrées « en direct » et de modifier les niveaux, 
les panoramiques, les Mute (coupures), etc. en 
cours d'enregistrement. Cette méthode peut 
également être utilisée à la place de la méthode 
Bounce to Disk, pour créer des pistes de mixage 
directement dans votre session Pro Tools.

Nombre de voix nécessaires

L'enregistrement d'un prémixage vers de 
nouvelles pistes impose de disposer d'une voix 
disponible pour chaque piste à enregistrer. 
Assurez-vous que vous disposez de 
suffisamment de voix disponibles pour lire 
toutes les pistes à enregistrer et pour enregistrer 
les pistes de destination. 

A l'inverse, la commande Bounce to Disk permet 
de prémixer toutes les voix disponibles sur un 
disque sans devoir en garder de réserve ; il est 
toutefois impossible d'intervenir manuellement 
sur les diverses commandes au cours du 
prémixage. Pour plus d'informations, reportez-
vous à la section Bounce to Disk, page 683.

Pour en savoir plus sur le dithering, 
reportez-vous à la section Dithering, 
page 606. 

 Pour en savoir plus sur les plug-in de 
dithering de Digidesign, reportez-vous au 
Guide des plug-in DigiRack.

Pour en savoir plus sur la gestion des voix, 
reportez-vous à la section Priorité des 
pistes et assignation de voix, page 128.
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Pour enregistrer un prémixage sur une piste :

1  Appliquez les plug-in ou les processeurs 
externes à ajouter aux pistes audio et aux entrées 
auxiliaires avant l'enregistrement.

2  Réglez sur un chemin de bus la sortie 
principale de canal des pistes que vous désirez 
inclure dans le prémixage. Réglez le 
panoramique de chaque piste si vous utilisez des 
pistes stéréo ou multicanaux.

3  Choisissez Track > New, puis créez une ou 
plusieurs pistes audio mono, stéréo ou 
multicanaux. 

4  Si l'enregistrement est réalisé en stéréo, réglez 
le panoramique de la nouvelle piste stéréo (ou 
de deux pistes mono) à fond à gauche et à fond 
à droite.

5  Réglez l'entrée de chaque piste de destination 
de telle sorte qu'elle corresponde au chemin de 
bus depuis lequel l'enregistrement s'effectue.

6  Réglez la sortie des nouvelles pistes sur la voie 
de sortie principale.

7  Sélectionnez Options > Link Timeline and 
Edit Selection.

8  Sélectionnez les données audio à enregistrer. 
Le début, la fin et la durée de l'enregistrement 
peuvent être définis par l'emplacement du 
curseur ou par les sélections Timeline et Edit. 

• Lorsque l'enregistrement est basé sur une 
sélection, l'entrée et la sortie de 
l'enregistrement s'effectuent 
automatiquement au début et à la fin de la 
sélection. N'oubliez pas d'ajouter du temps 
à la fin d'une sélection pour inclure les 
queues de réverbérations, les dernières 
répétitions des délais, etc.

• En l'absence de sélection définie, 
l'enregistrement débute au point 
d'insertion du curseur de lecture. Il se 
poursuit jusqu'à ce que vous appuyiez sur 
Stop. 

9  Préparez les nouvelles pistes en 
enregistrement, puis cliquez sur Record dans la 
fenêtre Transport. 

10  Cliquez sur Play dans la fenêtre Transport 
pour lancer l'enregistrement du prémixage.

11  Si vous enregistrez une sélection audio, 
l'enregistrement s'arrêtera automatiquement. 
Si vous procédez à un enregistrement « ouvert », 
cliquez sur Stop ou sortez d'enregistrement. 
Vérifiez que la lecture en boucle n'est pas 
activée.

Avec Pro Tools HD, les plug-in RTAS placés 
sur des pistes d'entrée auxiliaire, de fader 
principal et d'instrument utilisent des 
voix supplémentaires et peuvent 
introduire une latence plus longue basée 
sur la taille du buffer matériel. Pour plus 
d'informations, reportez-vous à la section 
Utilisation des voix et latence totale pour 
les plug-in RTAS, page 611. 
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Bounce to Disk
La commande Bounce to Disk permet de 
procéder à un mixage en utilisant toutes les voix 
disponibles sur votre système. L'enregistrement 
s'effectue dans des fichiers audio distincts, aussi 
n'est-il pas nécessaire de réserver des pistes pour 
le prémixage (bounce). 

Les prémixages (bounces) Pro Tools s'effectuent 
en temps réel, ce qui permet d'écouter la lecture 
audio du mixage au cours de l'opération (bien 
que vous ne puissiez pas intervenir dessus !). 

Vous pouvez utiliser la commande Bounce to 
Disk pour créer et importer automatiquement 
des boucles, des prémixages ou toutes autres 
données audio dans une session. Elle permet 
également de créer un master final mono, stéréo 
ou multicanal dans l'un des différents formats 
de fichier audio existants. Bounce to Disk offre 
des options de conversion de fréquence 
d'échantillonnage, de résolution et de format. 

Le prémixage (bounce) d'une piste sur un disque 
contient les éléments suivants :

Pistes audibles : toutes les pistes audibles qui 
parviennent à la sortie sélectionnée en tant que 
source de prémixage sont inclues dans le 
prémixage. Les pistes coupées (Mute) 
n'apparaissent pas dans le prémixage. En cas 
d'écoute en mode Solo d'une piste ou de 
plusieurs pistes, seuls les éléments écoutés en 
Solo apparaissent dans le prémixage.

Automation : toutes les données d'automation 
pour lesquelles la lecture est autorisée sont lues 
et prises en compte pour le prémixage. 

Inserts et départs : tous les inserts actifs, et 
notamment les plug-in temps réel et les inserts 
matériels, sont pris en compte pour le 
prémixage.

Durée de sélection ou de piste : si vous 
sélectionnez la partie d'une piste, la durée du 
prémixage correspond à celle de la sélection. 
En l'absence de sélection, la durée du prémixage 
correspond à celle de la piste audible la plus 
longue de la session.

Informations de marquage temporel : les 
éléments prémixés par Bounce subissent 
automatiquement un marquage temporel 
(« horodatage »), ce qui permet de les faire 
glisser dans une piste et de les disposer au même 
emplacement que les éléments originaux. 
Pour en savoir plus sur le marquage temporel, 
reportez-vous à la section Marquage temporel, 
page 792.

Les fichiers prémixés subissent une 
« compensation de retard »

Pro Tools compense tous les retards de bus et de 
plug-in dus à un prémixage. Ainsi, lorsqu'un 
fichier de prémixage est réimporté dans une 
session et placé directement en regard du 
mixage de la source, il est aligné avec le mixage 
original de la source.

Les pistes préparées en enregistrement ou 
dotées de la permutation d'écoute TrackInput 
ne peuvent être prémixées.

Les pistes préparées en enregistrement ou en 
mode d'écoute Input Only ne peuvent être 
prémixées à l'aide Pro Tools.

Pour exécuter la commande Bounce to Disk : 

1  Sélectionnez File > Bounce to > Disk.

2  Configurez les options de prémixage requises, 
puis procédez au prémixage (voir Options de 
prémixage, page 684). 
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Prémixage avec l'option Mute Frees 
Assigned Voice (Pro Tools HD 
uniquement)

Lorsque vous prémixez des sessions qui incluent 
des pistes Mute, l'activation de l'option Mute 
Frees Assigned Voice peut parfois augmenter le 
nombre de pistes pouvant être prémixées. Pour 
plus d'informations, reportez-vous à la section 
Option Mute Frees Assigned Voice, page 138.

Options de prémixage
La commande Bounce to Disk donne accès à un 
certain nombre d'options de fichier 
configurables.

Paramètres par défaut

Le tableau suivant présente les options 
disponibles et leur valeur par défaut. 

Boîte de dialogue Bounce to Disk (conversion et options 
activées)

Options et paramètres par défaut

Option de 
prémixage

Default

Bounce Source Chemin de sortie principal 
actuel

File Type Type de fichier par défaut de 
la session

format Stéréo

résolution Résolution par défaut de la 
session

fréquence 
d'échantillonnage

Fréquence d'échantillonnage 
par défaut de la session

Conversion Quality Good

Use Squeezer
(8 bits 
uniquement)

Désélectionnée

Convert During 
Bounce

Désélectionnée

Convert After 
Bounce

Sélectionnée

Import After 
Bounce

Désélectionnée
Guide de référence Pro Tools



Source de prémixage

Sélectionnez un chemin de sortie ou de bus 
mono, stéréo ou multicanal en tant que source 
de prémixage (bounce source). Tous les chemins 
de sortie ou de bus actifs définis dans la boîte de 
dialogue I/O Setup sont disponibles comme 
source de prémixage (Bounce Source). 

Pour régler la source de prémixage :

■ Sélectionnez une sortie ou un chemin de bus à 
l'aide du sélecteur de source de prémixage.

File Type

Cette option permet de sélectionner le type 
(créateur) des fichiers prémixés. 

Sound Designer II

(Macintosh uniquement)

Il s'agit du format de fichier natif des anciens 
systèmes Pro Tools reposant sur Macintosh. 
Sélectionnez-le pour utiliser les sons prémixés 
avec une application Digidesign pour 
Macintosh.

BWF (Broadcast .WAV Format)

WAV désigne le format de fichier natif des 
anciens systèmes Pro Tools reposant sur 
Windows ; ce format est désormais compatible 
avec Windows et Macintosh. Pour utiliser un 
fichier BWF (.WAV) dans Pro Tools, vous 
pouvez le faire glisser depuis le navigateur 
DigiBase, l'Explorateur Windows, le Finder 
Macintosh ou un dossier, ou utiliser la 
commande de menu Import Audio to Track ou 
Import Audio to Region List. Les fichiers de ce 
type de format n'ont pas besoin d'être convertis 
pour être utilisés dans Pro Tools.

AIFF(Audio Interchange File Format)

Pour utiliser un fichier AIFF dans Pro Tools, vous 
pouvez le faire glisser depuis le navigateur 
DigiBase, le bureau, l'Explorateur Windows ou le 
Finder Macintosh, ou utiliser la commande 
Import Audio to Track ou Import Audio to 
Region List. Les fichiers de ce type de format 
n'ont pas besoin d'être convertis pour être 
utilisés dans Pro Tools. Les données d'aperçu des 
formes d'ondes AIFF ne peuvent pas être 
calculées et conservées dans le fichier lui-même 
; aussi l'aperçu est-il recalculé à chaque 
ouverture de la session.

Sélectionnez une source de prémixage

Sélection d'un type de fichier
Chapitre 28 : Mixage final 685



686
QuickTime

Il s'agit du format de fichier audio Apple pour les 
applications multimédia reposant sur 
QuickTime. Ce type de fichier n'est pas pris en 
charge directement dans les sessions Pro Tools. 
Pour utiliser un fichier audio QuickTime dans 
Pro Tools, exécutez la commande Import Audio 
from QuickTime Movie (ou Import Audio from 
Current Movie). Le format QuickTime est 
largement utilisé pour joindre des fichiers aux 
messages électroniques en vue de simplifier 
l'analyse et l'approbation des projets à longue 
distance. De nombreuses applications 
multimédia répandues reconnaissent également 
le format QuickTime.

Sound Resource 

(Macintosh uniquement)

Type de fichier reconnu par quelques 
applications logicielles sur Macintosh et par les 
logiciels système Macintosh. Ce type de fichier 
n'est pas pris en charge directement dans les 
sessions Pro Tools. Pour utiliser un fichier SND 
sur un système Pro Tools, exécutez la 
commande de menu Import Audio to Track ou 
Import to Region List. Le format SND permet 
notamment d'utiliser vos propres données audio 
dans d'autres applications Macintosh ne 
prenant pas en charge les formats Sound 
Designer II et AIFF. Pour utiliser un fichier 
prémixé en tant que son d'alerte système, 
enregistrez-le dans ce format, puis faites-le 
glisser sur le dossier système Macintosh.

Windows Media

(Windows uniquement)

Les fichiers formatés Windows Media peuvent 
contenir des données audio, vidéo ou de script, 
stockées au format Windows Media. Les fichiers 
au format Windows Media peuvent porter 
l'extension .asf, .wma ou .wmv.

MXF (Material Exchange Format)

(Pro Tools avec DigiTranslator uniquement)

MXF est un format de fichier média qui inclut 
des fichiers vidéo et des fichiers audio, et qui est 
conçu pour l'échange de matériel audiovisuel et 
des données et métadonnées qui lui sont 
associées. Il a été conçu dans le but d'améliorer 
l'interopérabilité des fichiers entre les serveurs, 
stations de travail et autres périphériques de 
création de contenu.

Les fichiers de format de séquence AAF et OMF 
peuvent référer aux fichiers médias MXF ou 
intégrer des fichiers médias MXF. Pro Tools avec 
DigiTranslator prend en charge les séquences 
intégrées AAF.

MPEG-1 Layer 3 (MP3)

Le format de réduction de débit numérique de 
données MPEG-1 Layer 3 (MP3) permet de 
diffuser et de télécharger des données audio sur 
Internet, puis de les lire sur des périphériques 
portables. L'option MP3 est requise pour utiliser 
ce type de fichier. 

Pour plus d'informations, reportez-vous au 
Guide DigiTranslator.

Vous pouvez vous procurer l'option MP3 
via la boutique en ligne DigiStore 
exclusivement, sur le site Web de Digidesign 
(www.digidesign.com).
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Le codeur MP3 installé avec Pro Tools est une 
version de démonstration de 30 jours, 
entièrement fonctionnelle. Vous pouvez acheter 
la version complète de ce codeur MP3 sur le site 
de Digidesign (www.digidesign.com).

Lorsque ce format est sélectionné, le menu 
déroulant Resolution de la boîte de dialogue 
Pro Tools Output Options n'est pas disponible. 
La résolution est définie par le codeur.

La fréquence d'échantillonnage choisie est 
donnée au codec comme fréquence 
d'échantillonnage de base pour les opérations. 
La fréquence d'échantillonnage réelle du fichier 
obtenu est définie dans la boîte de dialogue MP3 
Encoder Options. Si vous choisissez, par 
exemple, une fréquence d'échantillonnage de 
base de 48 000 Hz, la boîte de dialogue MP3 
Encoder Options autorisera des données de 
sorties en 48, 24 ou 12 kHz, suivant la qualité du 
codage.

Pour exporter ou prémixer des données vers le 
format MP3, vous pouvez définir les options 
suivantes :

Paramètres de codeur

Encoding Quality : cette option détermine la 
qualité audio du fichier prémixé. Plus cette 
qualité est élevée, plus le traitement du son est 
long. Trois choix sont possibles, par ordre 
croissant de qualité : Fastest Encoding, Medium 
Encoding et Highest Quality. 

Le traitement du son peut durer cinq fois plus 
longtemps avec l'option Highest Quality 
qu'avec Fastest Encoding ; aussi est-il préférable 
de réserver la première option aux situations 
dans lesquelles une qualité optimale est 
indispensable et pour lesquelles vous disposez 
de suffisamment de temps à consacrer à ce 
traitement. Il est conseillé d'essayer également 
les autre options de qualité d'encodage, qui 
garantissent une qualité acceptable, pour une 
durée de traitement considérablement réduite. 

Encoding Method : deux méthodes d'encodage 
sont disponibles :

• Le débit constant (CBR, Constant Bit rate) 
code les fichiers avec un débit unique 
sélectionné dans le menu local CBR. Ce débit 
étant fixe, la qualité du son codé varie selon la 
nature des éléments « compressés ». Cette 
option est préconisée pour la diffusion sur 
Internet, car la bande passante requise est 
prévisible. 

• Le débit variable (VBR, Variable Bit rate) code 
les fichiers avec différents débits en vue de 
préserver la qualité de codage définie dans le 
menu local VBR. Le débit varie 
automatiquement selon la nature des 
éléments « compressés ». Cette option est 
préconisée pour les applications de jukebox 
personnelles.

Options de sortie MP3
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Paramètres ID3 Tag Info

ID3 Tag Type : l'étiquette ID3 stocke les données 
concernant le fichier audio codé que les lecteurs 
MP3 utilisent pour afficher des informations le 
concernant. Pro Tools prend en charge trois 
versions de cet identificateur afin d'assurer une 
compatibilité descendante avec des lecteurs 
MP3 moins récents : 

• ID3 v1.0 : apparaît à la fin d'un fichier MP3 
diffusé en continu ; aussi les informations 
d'identité s'affichent-elles uniquement après 
la diffusion logicielle.

• ID3 v1.1 : analogue à la version 1.0, cet 
identificateur affiche en outre un numéro de 
plage.

• ID3 v2.3 : apparaît dans l'en-tête d'un fichier 
MP3 pour streaming ; aussi les informations 
d'identité s'affichent-elles au début du 
streaming.

Title/Artist/Album/Comment : saisissez le titre, 
le nom de l'artiste et toute autre information 
concernant le fichier MP3. Un grand nombre de 
lecteurs MP3 affichent cette information.

Genre : choisissez un genre décrivant le contenu 
du fichier. Cette information est lue par de 
nombreux lecteurs MP3 et peut apparaître dans 
des catalogues et des bases de données de 
recherche.

Track Number : avec l'identificateur ID3 v1.1 ou 
v2.3, vous pouvez indiquer un numéro de la 
plage du CD pour le fichier. Un grand nombre 
de lecteurs MP3 affichent cette information.

Year : indiquez une année. Un grand nombre de 
lecteurs MP3 affichent cette information.

Paramètres avancés

Dans la plupart des cas, les options répertoriées 
dans la zone Advanced Settings peuvent 
conserver leur valeur par défaut. 

Pad To Match Bit Rate Exactly : cette option 
détermine le remplissage des « images » MP3 en 
vue de respecter un débit très précis. Cochez 
cette case uniquement si vous avez besoin d'un 
fichier au débit très précis pour des applications 
spécifiques (par exemple une transmission 
synchrone sur une ligne RNIS).

Allow Intensity Stereo Coding : cette option 
détermine si le dispositif de codage tient compte 
de la fréquence d'un signal pour coder ses 
caractéristiques de phase, ce qui permet 
d'appliquer une réduction de débit plus 
drastique si le débit disponible est faible. Dans la 
plupart des cas, vous pouvez laisser cette case 
cochée. Toutefois, si vous travaillez avec des 
données audio pour lesquelles le respect des 
phases est primordial, par exemple un mixage 
Dolby Surround, il est préférable de la 
désélectionner. 

Write CRC Checksums : cette option ajoute des 
données de détection d'erreur au fichier MP3. 
Ces données ne sont pas indispensables pour la 
plupart des applications de PC et Internet et 
occupent un espace qui pourrait être consacré 
aux données audio. Ne cochez cette case que si 
vous êtes certain que la correction des erreurs est 
essentielle pour votre mode de diffusion.

Bien que ID3 v2.3 s'impose en tant que 
format MP3 standard, il n'est pas encore 
reconnu par tous les lecteurs MP3. 
Contactez le développeur du logiciel de votre 
lecteur pour en savoir plus sur sa 
compatibilité.

Le remplissage des images MP3 peut causer 
des problèmes avec certaines versions de 
logiciels de streaming sur Internet. Si vos 
fichiers sont destinés à une diffusion sur PC 
ou sur Internet, ne cochez pas cette case.
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Copyrighted : cette option insère un bit dans le 
flux de données MP3 indiquant que les données 
audio sont protégées par un copyright. Tous les 
lecteurs MP3 n'utilisent pas cette information. 
Le fait de cocher cette case ne garantit pas que le 
fichier audio ne sera pas copié.

Original : cette option insère un bit dans le flux 
de données MP3 indiquant que ses données 
audio constituent l'original de la piste, et non 
une copie. Ce paramètre n'est pas largement 
répandu auprès des utilisateurs.

Private : cette option insère un bit dans le flux 
de données MP3, interprété différemment selon 
les applications. En général, elle n'est pas 
utilisée.

Paramètres de fichier Mac

Options Type et Creator : si votre fichier est 
destiné à un ordinateur Macintosh, vous pouvez 
indiquer le type de fichier Macintosh et le nom 
du créateur. Il suffira ainsi de cliquer deux fois 
sur le fichier pour ouvrir le lecteur MP3.

Bouton Defaults

Pour restaurer tous les paramètres de cette zone 
de dialogue, cliquez sur Defaults.

Format

Il s'agit du format du fichier de prémixage. Vous 
pouvez choisir le format Mono (summed), 
Multiple mono ou Interleaved. 

Pour configurer le format du fichier prémixé :

■ Choisissez un format de fichier dans le 
sélecteur de format.

Mono (summed) : un seul fichier de disque est 
créé, sommation mono des sources écoutées. 

Avant de procéder à un prémixage sur disque, 
vérifiez que vos niveaux sont inférieurs à –3 dB 
afin d'éviter l'écrêtage qui se produit lorsque les 
signaux droit et gauche dépassent –3 dB au-
dessous du maximum, repère « pleine échelle » 
(0 dB FS).

Multiple mono : plusieurs fichiers mono sont 
créés, leur nombre étant identique à celui des 
canaux du chemin source. 

• Si la sortie ou le chemin de bus source est 
stéréo, deux fichiers mono sont créés, dont les 
noms reçoivent le suffixe « .L » ou « .R » à 
l'issue du prémixage. 

• En cas d'utilisation d'un format multicanal 
(par exemple, six canaux, 5.1), des fichiers 
mono séparés sont créés pour chaque membre 
du chemin. Les fichiers reçoivent des suffixes 
de chemin conformément à la définition de 
chemin entrée dans la zone de dialogue I/O 
Setup.

• Si la sortie source ou le chemin de bus est 
mono, le menu déroulant passe de multiple 
mono à mono, et un fichier mono est créé 
(pas de sommation de sources multiples).

Boîte de dialogue Bounce (type de format de fichier)
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Stereo Interleaved : cette option crée un fichier 
entrelacé unique, contenant tous les flux 
prémixés depuis le chemin de sortie choisi. 
Dans un prémixage stéréo entrelacé, les pistes 
affectées à des sorties impaires sont envoyées au 
canal gauche tandis que les pistes affectées à des 
sorties paires sont envoyées au canal droit.

Pro Tools permet également de prémixer des 
fichiers multicanaux entrelacés dans chaque 
type de fichier reconnu. Cette option simplifie 
la gestion des fichiers de mixages et de projets 
dans le cadre de sauvegardes ou d'archivages. 

Pro Tools ne prend pas en charge en natif le 
format de fichier entrelacé. Ces fichiers doivent 
donc être divisés en fichiers multimono lors de 
l'importation (ce qui nécessite un espace disque 
supplémentaire). 

Resolution

Cette option permet de choisir parmi trois 
résolutions différentes pour la conversion de 
prémixage.

Le prémixage sur disque (Bounce to Disk) 
n'applique pas de dithering lors de la conversion 
à une résolution moins élevée, au cours d'un 
prémixage ou après (y compris en cas de 
prémixage sur 16 bits). Pour créer un fichier 
prémixé de résolution inférieure, insérez un 
plug-in Dither ou un équivalent sur une piste de 
fader principal affectée au chemin source du 
prémixage. Cette opération applique un 
dithering au fichier de prémixage avant que la 
conversion, dans le cadre du Bounce to Disk, ne 
tronque les données pour l'obtention de la 
résolution définitive du fichier Reportez-vous à 
la section Dithering et prémixage sur disque 
(Bounce), page 680.)

En matière de résolution, plusieurs options sont 
possibles :

8 bits : cette résolution est souvent utilisée pour 
les applications multimédia. Si les données 
audio sur lesquelles vous travaillez sont 
relativement simples, vous pouvez utiliser la 
fonction Squeezer de Pro Tools pour optimiser 
les résultats. Pour plus d'informations, consultez 
la section Qualité de conversion de la fréquence 
d'échantillonnage, page 692.

16 bits : il s'agit de la résolution standard 
des CD.

24 bits : ce paramètre fournit la plus haute 
résolution. Il est utile pour la création d'un 
mixage final sans perte de résolution (par 
exemple, lorsque vous produisez un mixage 
final prêt à être masterisé).

Si votre session est de 16 bits, vous devez 
appliquer un dithering car toutes les sessions 
Pro Tools effectuent des traitements internes à 
24 bits.

Pour définir la résolution du fichier prémixé :

■ Choisissez une valeur de résolution dans le 
sélecteur de résolution.
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fréquence d'échantillonnage

Cette option permet de choisir, pour 
l'enregistrement, une fréquence 
d'échantillonnage quelconque parmi plusieurs. 
Les choix possibles dépendent du système 
Pro Tools et des interfaces audio Digidesign 
utilisées.

Qualité de conversion de fréquence 
d'échantillonnage

Si vous optez pour une valeur de fréquence 
d'échantillonnage différente de la fréquence 
d'échantillonnage originale de la session, les 
options de conversion deviennent accessibles. 
Vous pouvez configurer la qualité de la 
conversion et planifier son exécution au cours 
du prémixage ou après. Pour plus 
d'informations, reportez-vous à la section 
Qualité de conversion de la fréquence 
d'échantillonnage, page 692.

Vous trouverez ci-après les fréquences 
d'échantillonnage les plus courantes et leurs 
applications. Des fréquences d'échantillonnage 
plus élevées fourniront une meilleure fidélité 
sonore pour l'enregistrement et la lecture, mais 
également pour le traitement avec les plug-in de 
dynamique, de dithering (avec mise en forme 
du bruit) et d'émulation analogique.

192000 : fréquence d'échantillonnage prise en 
charge pour certains DVD audio et permettant 
d'obtenir la meilleure fidélité sonore possible sur 
les interfaces audio compatibles (interface 
192 I/O, par exemple).

176400 : il est possible que vous souhaitiez 
travailler avec une fréquence d'échantillonnage 
de 176,4 kHz pour une fréquence du résultat 
final de 44,1 kHz (disques compacts, par 

exemple). Ceci permettra d'obtenir une 
conversion de fréquence d'échantillonnage de 
44,1  kHz un peu plus rapide qu'à partir de 
192 kHz.

96000 : fréquence d'échantillonnage prise en 
charge pour les DVD audio et permettant 
d'obtenir une fidélité sonore de haute qualité 
sur les interfaces audio compatibles (interfaces 
192 I/O, 96 I/O, 96i I/O et Digi 002 par 
exemple). 

88200 : il est possible que vous souhaitiez 
travailler avec une fréquence d'échantillonnage 
de 88,2 kHz pour une fréquence du résultat final 
de 44,1 kHz (disques compacts, par exemple). 
Ceci permettra d'obtenir une conversion de 
fréquence d'échantillonnage de 44,1 kHz un peu 
plus rapide qu'à partir de 96 kHz.

48000 : fréquence d'échantillonnage standard 
pour la vidéo professionnelle et les DVD, ainsi 
que pour certains archivages d'étiquettes 
d'enregistrement et de diffusion, et prise en 
charge par les appareils DA-88/98, DAT et 
ADAT.

44100 : fréquence d'échantillonnage standard 
pour les disques compacts (CD) et prise en 
charge par les machines DA-88/98, DAT et 
ADAT.

Custom : pour obtenir une fréquence 
d'échantillonnage personnalisée, cliquez dans la 
fenêtre de la fréquence d'échantillonnage et 
entrez une valeur manuellement.

Fréquences Pull Up et Pull Down : toutes les 
fréquences d'échantillonnage disponibles 
prennent en charge les modes Pull-up et Pull-
down, ou d'autres valeurs spécifiques. 
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Qualité de conversion de la 
fréquence d'échantillonnage

Dès que vous modifiez la fréquence 
d'échantillonnage d'un fichier prémixé 
(par exemple, lors du mixage en 44,1 kHz d'une 
session enregistrée en 96 kHz, en vue d'une 
sortie sur CD audio), Pro Tools utilise l'option 
Conversion Quality pour déterminer la qualité 
de la conversion de fréquence d'échantillonnage 
utilisée. 

Il existe cinq paramètres, classés par ordre 
croissant (de Low à Tweak-Head). Plus cette 
qualité est élevée, plus la conversion du fichier 
prémixé est longue.

Use Squeezer
(Résolution 8 bits uniquement)

L'option Use Squeezer repose sur un algorithme 
DSP exclusif spécialement conçu pour effectuer 
la conversion en 8 bits de fichiers source simples 
tels que des voix off de narrateurs. Elle optimise 
la dynamique sonore en retraitant les sons par 
compression, limitation et gating avant la 
conversion vers une résolution 8 bits. Il en 
résulte un signal apparemment plus fort, d'une 
intelligibilité améliorée. Si vous devez convertir 
un fichier audio 16 bits complexe vers une 
résolution 8 bits, commencez par tester cette 
option.

Conversion pendant ou après le 
prémixage

La zone de dialogue Bounce to Disk applique 
toutes les options de conversion, notamment la 
conversion de fréquence d'échantillonnage et 
de résolution, au cours du prémixage ou à la 
suite de l'opération. 

Les options suivantes sont disponibles 
uniquement lors de prémixages utilisant des 
résolution, fréquence d'échantillonnage, type et 
format de fichiers différents.

Convert During Bounce : la rapidité de cette 
option par rapport à la conversion après le 
prémixage est acquise au détriment de la 
précision de lecture de l'automation des plug-in.

Convert After Bounce : l'option Convert After 
Bounce, bien que plus lente, garantit un niveau 
inégalé de précision de l'automation des plug-in. 

Import Into Session After Bounce

L'option Import After Bounce importe 
automatiquement les nouveaux fichiers 
prémixés dans la liste des régions. Vous pouvez 
alors les placer dans des pistes. Si vos nouveaux 
fichiers prémixés sont des fichiers stéréos (mono 
multiples) divisés, ils apparaissent ensemble 
dans la liste des régions.

Help

Le bouton Help ouvre une boîte de dialogue non 
modifiable décrivant les fonctions Bounce to 
Disk.

L'option Import After Bounce n'est 
disponible que si le type de fichier cible et la 
fréquence d'échantillonnage du 
prémixage sont identiques au type de 
fichier et à la fréquence d'échantillonnage 
de la session en cours, et si la résolution 
cible (débit) est inférieure ou égale à la 
résolution de la session. En outre, les 
pistes prémixées en un fichier stéréo 
entrelacé (Stereo Interleaved) ne peuvent 
pas être automatiquement importées 
après un prémixage.
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Enregistrement d'un 
prémixage (avec la 
commande Bounce to Disk)
Vous pouvez créer un prémixage à l'aide de la 
commande Bounce to Disk, en coupant le son 
des pistes ou en désactivant les inserts 
n'appartenant pas au prémixage, puis en 
sélectionnant la partie de la session à prémixer. 
Vous ne pouvez mettre en solo que les données 
audio que vous souhaitez prémixer.

Il est également possible de créer un prémixage 
en réalisant un enregistrement vers de nouvelles 
pistes. Pour en savoir plus, reportez-vous à la 
section Enregistrement sur des pistes, page 681.

Pour procéder à un prémixage sur disque et en 
intégrer le résultat dans la session :

1  Configurez votre prémixage à l'aide de 
départs, d'entrées auxiliaires et de pistes de fader 
principal. Reportez-vous à la section Prémixage 
avant affectation des signaux et traitement par 
effets, page 595.)

2  Effectuez l'une des opérations suivantes :

• Pour prémixer la session tout entière, 
cliquez sur Return to Zero dans la fenêtre 
Transport pour atteindre le début de la 
session. 

– ou –

• Pour prémixer une partie de la session, 
activez l'option > Link Timeline and Edit 
Selection, puis sélectionnez un élément 
dans la fenêtre Edit.

3  Sélectionnez File > Bounce to > Disk.

4  Configurez les options et les paramètres de 
prémixage. 

5  Assurez-vous que la résolution du fichier 
prémixé correspond à celle de la session.

6  Vérifiez que la fréquence d'échantillonnage du 
fichier prémixé est prise en charge par la session 
et par l'interface audio.

7  Si nécessaire, vérifiez que le type et le format 
de fichier pour le fichier prémixé correspondent 
au type et au format de fichier de la session.

8  Sélectionnez l'option Import After Bounce.

9  Cliquez sur Bounce.

10  Choisissez une destination pour le nouveau 
fichier audio, indiquez un nom, puis cliquez sur 
Save.

Les prémixages Pro Tools s'effectuent en temps 
réel, ce qui permet d'entendre la lecture audio 
du mixage au cours de l'opération. Il est 
impossible d'agir sur les commandes au cours 
d'une opération Bounce to Disk. 

Pour ramener les fichiers prémixés dans des 
pistes :

1  Effectuez l'une des opérations suivantes :

• Si les données audio qui viennent d'être 
prémixées ont été importées 
automatiquement dans la session, faites 
glisser les nouveaux fichiers de la liste des 
régions vers des pistes existantes de votre 
session.

Si vous prémixez depuis un point de 
sélection, vous pouvez aligner le fichier sur 
le point de prémixage : Faites glisser la 
région de la liste des régions vers la piste de 
destination en maintenant enfoncée la 
touche Contrôle (Macintosh) ou Démarrer 
(Windows).
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• Si les fichiers prémixés ne sont pas 
disponibles dans la liste des régions, 
importez-les dans la session en 
sélectionnant File > Import > Audio to 
Track, ou en faisant glisser les fichiers 
prémixés et en les déposant depuis un 
navigateur DigiBase. 

• Si vous placez plusieurs fichiers, veillez à ce 
qu'ils soient alignés les uns sur les autres ; 
maintenez enfoncée la touche Maj 
pendant que vous les sélectionnez dans la 
liste des régions, puis faites-les glisser 
simultanément vers les pistes existantes du 
format qui convient. 

2  Si vous travaillez sur des pistes stéréo, réglez 
les panoramiques à l'extrême gauche et à 
l'extrême droite.

3  Mettez la piste contenant le prémixage en 
solo.

4  Cliquez sur Play dans la fenêtre Transport 
pour écouter le résultat du prémixage.

Mixage final
Au cours d'un mixage final, vous créez un 
mixage prenant en compte toutes les éditions, 
toutes les automations et tous les traitements 
d'effets spéciaux.

Pour enregistrer un mixage final sur un disque :

1  Réglez les volumes de sortie de piste, finalisez 
les automations de mixage éventuelles de 
chaque piste de la session.

2  Réglez tous les paramètres de plug-in en temps 
réel et d'effets ainsi que les données 
d'automation sur chacune des pistes de la 
session.

3  Assurez-vous que toutes les pistes à inclure 
dans le prémixage sont audibles (et non coupées 
(Mute) ou inactives).

4  Assignez la sortie de chaque piste à inclure 
dans le prémixage à un même chemin de sortie 
ou de bus.

5  Ajoutez du dithering. Pour plus 
d'informations, reportez-vous à la section 
Dithering et prémixage sur disque (Bounce), 
page 680.

6  Effectuez l'une des opérations suivantes :

• Pour prémixer la session tout entière, 
cliquez sur Return to Zero dans la fenêtre 
Transport pour atteindre le début de la 
session. 

– ou –

• Pour prémixer une partie de la session, 
activez l'option > Link Timeline and Edit 
Selection, puis sélectionnez un élément 
dans la fenêtre Edit.

7  Sélectionnez File > Bounce to > Disk.

8  Choisissez le chemin source à prémixer.

9  Configurez les autres paramètres de la boîte de 
dialogue Bounce to Disk. Pour plus 
d'informations, reportez-vous à la section 
Options de prémixage, page 684.

10  Cliquez sur Bounce.

11  Choisissez une destination pour le nouveau 
fichier audio, indiquez un nom, puis cliquez sur 
Save.

Par défaut, le prémixage s'arrête à la 
dernière forme d'onde audio ou à la 
dernière note MIDI. Pour arrêter le 
prémixage plus tôt, effectuez une sélection 
d'édition ou de temps pour définir la fin (et 
le début) du prémixage.
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Mastering
Le processus de mastering final consiste à 
enregistrer les données directement sur le 
disque, sur un enregistreur de DAT, de DVD ou 
de CD, une machine de mastering stéréo ou 
directement sur un enregistreur multipiste (dans 
le cas d'un mixage Surround).

Une fois le Master de votre session créé, vous 
pouvez le transférer sur un support portable en 
vue de le dupliquer. Il est également possible de 
transférer le fichier Master sur un CD ou une 
cassette DAT en vue de presser des CD.

Mastering vers un enregistreur 
numérique

Bien qu'il soit généralement préférable de 
« masteriser » les sessions directement sur le 
disque dur, Pro Tools permet de réaliser un 
mastering numérique vers tout enregistreur 
numérique équipé d'entrées AES/EBU ou S/PDIF, 
machine DAT par exemple.

entrées et sorties 24 bits

Les systèmes Pro Tools|HD prennent en charge 
les chemins d'entrée et de sortie audio 24 bits, 
avec traitement et mixage interne 48 bits, 
offrant 16 bits supplémentaires de marge de 
sécurité à l'extrémité supérieure de la plage 
dynamique d'un canal, et 8 bits à l'extrémité 
inférieure. Vous pouvez échanger des fichier 
avec d'autre systèmes d'enregistrement à 24 bits 
sans avoir à convertir leur résolution tant qu'ils 
sont de format compatibles.

Les systèmes Pro Tools LE prennent en charge 
les entrées et sorties audio à 24 bits et utilisent 
les fonctions internes de mixage et de 
traitement des virgules flottantes à 32 bits. Vous 
pouvez échanger des fichier avec d'autre 
systèmes d'enregistrement à 24 bits sans avoir à 
convertir leur résolution tant qu'ils sont de 
format compatibles.

Mastering et compression audio

Bien que la compression audio soit souvent un 
outil indispensable en enregistrement 
analogique, elle est parfois source de problèmes 
dans le domaine numérique. La compression 
d'un signal d'entrée à un taux très élevé résulte 
en un signal contenant une puissance totale 
extrêmement importante par rapport au niveau 
des transitoires. En enregistrant un certain 
nombre de ces signaux au niveau le plus élevé 
possible sur plusieurs pistes, vous vous trouvez 
dans une situation plus susceptible de 
provoquer des écrêtages dans le signal du 
mixage de sortie.

Le mixage de signaux très puissants après 
compression génère un niveau de sortie 
extrêmement élevé. Il est possible que ce signal 
de sortie s'élève au-dessus du niveau limite Full 
Scale, ce qui produit un écrêtage. 

Pour éviter ce problème, surveillez le niveau 
global de votre matériel : placez un vumètre sur 
une piste Master Fader ou utilisez le vumètre de 
l'enregistreur Master externe pour identifier 
l'écrêtage. Si le mastering s'effectue sur le disque 
dur, il est préférable de ne pas mixer ensemble, à 
gain unitaire (amplification de 0 dB) des signaux 
audio allant jusqu'au repère Full Scale, ce qui 
provoquerait systématiquement un écrêtage.
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Mastering et correction d'erreurs du 
support

Les supports à accès aléatoire (tels que les 
disques durs, les cartouches optiques, les 
cartouches de Bernouilli ou les lecteurs WORM) 
peuvent générer une copie numérique parfaite 
de vos données, car réalisée bit à bit, en 
respectant la valeur de chaque bit. Les supports 
séquentiels (par exemple, les bandes DAT) 
utilisent des algorithmes de correction d'erreurs 
afin de compenser les données erronées 
éventuellement reçues lors de transferts 
numériques. Ces corrections dévient légèrement 
par rapport aux données réelles ; aussi les 
générations successives de copie entraînent-elles 
une dégradation progressive.

Pour éviter ces dégradations, créez et conservez 
vos Masters sur des supports numériques à accès 
aléatoire (par exemple, un disque dur), et ne les 
transférez vers un support numérique séquentiel 
(cassette DAT par exemple) qu'en cas de besoin.

Pour configurer Pro Tools en vue d'un mastering 
numérique stéréo direct :

1  Connectez l'enregistreur numérique aux 
sorties numériques du système. Si votre système 
dispose de plusieurs sorties numériques, utilisez 
les canaux 1 et 2 de l'interface audio.

2  Dans Pro Tools, configurez le format et les 
sorties numériques appropriés depuis la boîte de 
dialogue Hardware Setup ou I/O Setup Reportez-
vous à la section Configuration des paramètres 
matériels Pro Tools, page 55.)

3  Définissez l'horloge du périphérique principal 
en tant qu'esclave de l'horloge numérique de 
Pro Tools, ou pour fournir une horloge 
principale à Pro Tools. Reportez-vous à la 
section Configuration des paramètres matériels 
Pro Tools, page 55.)

4  Sur l'enregistreur numérique, sélectionnez le 
format numérique correspondant aux 
connexions.

5  Dans Pro Tools, affectez toutes les pistes audio 
souhaitées au chemin de sorties Master 1-2.

6  Cliquez sur Return to Zero dans la fenêtre 
Transport pour retourner au début de la session.

7  Appuyez sur Record sur votre enregistreur 
numérique.

8  Lancez la lecture de la session.

9  A la fin de la lecture, arrêtez l'enregistreur.
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Chapitre 29 : Notions relatives au 
format Surround (Pro Tools HD 
uniquement)

Les systèmes Pro Tools|HD prennent en charge 
le mixage multicanal du son Surround. 

Utilisation de ces chapitres

Cette partie du guide décrit le mixage 
multicanal dans Pro Tools pour le son Surround. 
Ces sections complètent les informations 
élémentaires sur le Surround dans Pro Tools, 
fournies au fil du Guide de référence Pro Tools. 

Si vous ne connaissez pas encore le mixage 
surround, lisez les autres sections de ce chapitre 
pour vous familiariser avec la technologie et les 
concepts associés.

Si vous connaissez déjà le mixage, la gravure 
(mastering) et le monitoring en mode Surround, 
vous pouvez ignorer ces sections. Vous 
trouverez les instructions relatives aux fonctions 
Surround de Pro Tools dans le Chapitre 30, 
Configuration de Pro Tools pour le mixage en 
mode Surround (Pro Tools HD uniquement).

Formats de mixage et 
Surround
Lorsque vous exécutez Pro Tools avec le plug-in 
Surround Mixer, vous pouvez effectuer le 
mixage dans les formats comptant 3 à 8 canaux, 
en plus des formats mono et stéréo standard. 

Les formats de mixage pris en charge sont les 
suivants : Mono, Stéréo, LCR, Quad, LCRS, 5.0, 
5.1, 6.0, 6.1, 7.0 et 7.1.

Les formats Surround sont les Dolby Surround 
(Pro Logic) et Dolby Digital, le DTS et le SDDS. 
Pro Tools ne fournit pas son propre traitement 
de format surround et nécessite des plug-in (tels 
que Dolby Surround Tools™ ou un dispositif 
adéquat pour assurer le codage et de décodage 
du son Dolby surround). 
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Formats de mixage de Pro Tools

Disposition des haut-parleurs
Figure 30, page 701illustre la disposition des haut-parleurs pour chaque format Surround. 
Ces configurations sont approximatives pour chaque format. Pour connaître la disposition, 
l'alignement et l'étalonnage précis des systèmes de monitoring Surround, consultez la documentation 
de vos haut-parleurs et de vos équipements d'écoute. Le positionnement des haut-parleurs est crucial 
pour la précision d'écoute des mixages. Cette remarque s'applique en particulier au mixage multicanal 
pour le son Surround. 

Voir également Disposition des pistes, acheminement et mesures dans le format 5.1, page 717. 

Tableau 4. Formats de mixage et Surround multicanaux

Canaux de haut-
parleurs

Format de 
mixage 
multicanal

Format Surround Disposition des canaux et des 
pistes

1 Mono C

2 Stéréo L R

3 LCR Stéréo cinéma L C R

4 Quad Quadriphonique L R Lr Rr

4 LCRS Dolby Surround
((Pro Logic)

L C R S

6 5.1 Film (mode par 
défaut de Pro Tools) 
pour Dolby Digital

L C R Ls Rs LFE

6 5.1 SMPTE/ITU
(Control|24)

L R C LFE Ls Rs

6 5.1 DTS (ProControl) L R Ls Rs C LFE

7 6.1 Dolby Surround EX L C R Ls Cs Rs LFE

8 7.1 SDDS L Lc C Rc R Ls Rs LFE

Légende : L = gauche ; R = droite ; C = centre, S = Surround (mono) ; Ls = Surround gauche ; Rs = Surround droite ; 
Lc = centre gauche ; Rc = centre droite ; Cs = centre Surround ; Lr = gauche arrière ; Rr = droite arrière ; 
LFE = Low Frequency Effects (géré par un caisson de graves (sub-woofer) ou des systèmes de gestion des graves)
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Figure 30.  Disposition des haut-parleurs selon les formats Surround
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Ecoute en Surround
Pour écouter le mixage multicanal en cours dans 
un format Surround donné (DTS ou Dolby 
Digital), vous devez disposer de l'équipement de 
codage et de décodage requis par le format. 
Pro Tools n'assure pas directement la prise en 
charge du traitement du format Surround, mais 
Digidesign et d'autres constructeurs fournissent 
des dispositifs ou des logiciels de 
codage/décodage. Pour plus d'informations, 
contactez Digidesign ou votre revendeur.

Bien placer les haut-parleurs et calibrer le studio, 
disposer de processeurs Surround et de 
moniteurs supplémentaires et d'un système 
d'écoute bien calibré peut réduire l'effet des 
variables auxquelles votre mixage sera soumis 
lorsque le public l'entendra dans une salle de 
cinéma, à domicile ou ailleurs.

Importance de la disposition des 
haut-parleurs

Il est très important que votre système d'écoute 
Surround soit installé et configuré 
correctement. Bien placer les enceintes, les 
orienter correctement et bien calibrer le niveau 
d'écoute sont des conditions indispensables 
pour le mixage en mode Surround ; aussi est-il 
judicieux de consulter le constructeur de votre 
système d'écoute. Plusieurs formats Surround 
(notamment tous ceux de Dolby et de DTS) sont 
associés à des recommandations très 
particulières en ce qui concerne les haut-
parleurs et l'écoute. Aussi, prenez le temps de 
rechercher ces informations et de suivre les 
suggestions qui y sont émises. 

Pour voir un exemple d'un système d'écoute en 
mode 5.1, voir la Figure 31.

Figure 31.  Exemple de disposition des haut-parleurs pour le mixage et l'écoute en mode 5.1 (spécification SMPTE). 
La position du caisson de graves (subwoofer) est variable ; tous les autres haut-parleurs doivent être aussi proches 
que possible des angles suggérés. 

110°

30°

110°

30°

Position de mixage
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Ecoute Surround calibrée

L'une des choses les plus importantes à faire est 
de calibrer non seulement Pro Tools, mais 
également votre système d'écoute et vos autres 
appareils. 

De nombreux studios de post-production 
étalonnent, par exemple, leurs interfaces audio 
Pro Tools pour -20 dB = 0 VU. Ce n'est qu'une 
fois la partie hardware de Pro Tools calibrée à un 
gain unitaire qu'il est possible de régler le 
système d'écoute afin de prendre en compte les 
anomalies au niveau de l'acoustique de la salle, 
de la disposition des haut-parleurs et d'autres 
variables. 

Pour calibrer votre système Pro Tools, vous 
devez atténuer les étages d'entrée et de sortie de 
votre système. La configuration et le niveau de 
référence varient selon les normes applicables 
au projet en cours. 

Calibrage de votre studio : la première opération 
à effectuer en mixage Surround consiste à 
placer, à aligner et à calibrer correctement les 
niveaux des haut-parleurs afin de bénéficier de 
conditions d'écoute et de mixage exactes. 

La position et l'alignement des haut-parleurs 
varient d'une installation à l'autre, mais 
également selon les haut-parleurs, les 
constructeurs et les formats Surround. Les haut-
parleurs et systèmes d'écoute sont fournis avec 
les instructions nécessaires pour une disposition 
optimale ; veuillez consulter la documentation 
du fabricant. 

Le calibrage des haut-parleurs permet de 
s'assurer que le système offre un bon équilibre 
des niveaux de restitution. Elle permet de 
compenser d'éventuelles variations de position, 
d'alignement ou de performances des haut-
parleurs. 

Formats et terminologie
Certains formats de mixage multicanal sont 
désignés par des chiffres (tels que 5.1 et 7.1). 
Ces chiffres indiquent le nombre et le type des 
canaux de sortie (canaux de haut-parleurs) 
requis pour le format en question. D'autres 
formats sont désignés par la disposition des 
pistes (tels que LCRS et LCR). 

Les formats Surround sont désignés par le nom 
du créateur et du produit, tels que Dolby 
Surround (ou Pro Logic), Dolby Digital, DTS, 
Dolby Surround EX, etc. Chaque format 
Surround exige que le mixage soit effectué dans 
un format compatible. Par exemple, le Dolby 
Digital et le DTS sont tous deux des « formats 
Surround 5.1 ».

Les normes relatives à chaque format 
n'indiquent pas seulement le nombre de haut-
parleurs. Les formats peuvent également exiger 
une disposition spécifique et un filtrage des 
différents canaux. En Dolby Surround, par 
exemple, le canal Surround a une bande 
passante s'étendant de 100 Hz à 7 kHz. 

Les formats Surround accordent également une 
importance plus grande à la phase, à l'équilibre 
et au placement du son en raison des différentes 
méthodes de codage, décodage, compression, 
matriçage ou downmixing des mixages 
multicanaux. De nombreux ouvrages traitent de 
tous ces sujets. Pour obtenir une liste de sources 

Des instructions de calibrage d'une 
interface audio Pro Tools 192 I/O sont 
incluses dans la documentation de 
l'interface 192 I/O.
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d'informations relatives aux formats surround, 
reportez-vous à la section Autres sources 
d'information sur la technologie Surround, 
page 706 

LCRS pour Dolby Surround

Dolby Surround (Pro Logic) est l'un des formats 
quatre canaux les plus répandus dans le grand 
public. 

Ce format, qui nécessite de recourir à la 
technologie de codage et de décodage Dolby, 
utilise trois haut-parleurs « pleine bande 
passante » à l'avant – gauche, centre et droite –, 
plus un canal Surround mono (souvent réparti 
sur plusieurs haut-parleurs, des satellites 
branchés par paires, mais qui ne sont alimentés 
que par un seul signal « arrière »). 

Exemple de format Surround

Le codage Dolby Surround vise à faciliter le 
transport d'un mixage quatre canaux (LCRS), en 
le transformant en un mixage codé sur deux 
canaux, appelé Lt/Rt. Lt et Rt sont les 
abréviations de Left total et Right total, 
respectivement. La présence des lettres Lt/Rt fait 
référence aux enregistrements traités par un 
codeur Dolby Surround (tels que le Dolby SEU4 
ou le plug-in Dolby Surround Tools). 

Le mixage Lt/Rt peut ensuite être transporté, 
transmis ou lu sous forme de mixage stéréo, ce 
qui le rend compatible avec la plupart des 
systèmes home cinéma dépourvus de décodeur. 
Il existe une autre possibilité : décoder la paire 
Lt/Rt, afin de retrouver le mixage au format 
LCRS original. Pour ce faire, il faut disposer d'un 
décodeur, ce qui est le cas dans les systèmes 
home cinéma évolués. 

5.1 pour Dolby Digital et DTS

Le Dolby Digital et le DTS sont tous deux des 
formats 5.1, à six canaux. Ces deux formats 
mettent en œuvre cinq enceintes « pleine bande 
passante » et un caisson de graves (subwoofer). 
Les spécifications de ces deux formats Surround 
impliquent des dispositions de pistes, des 
filtrages et des procédés de réduction de débit de 
données différents. 

Formats .1

Le « .1 » des formats de mixage multicanal 
indique la présence d'une piste LFE (Low 
Frequency Effects) dans le mixage. La présence 
d'une décimale dans le nom d'un format 
Surround signifie que le système de lecture 
Surround intègre un canal Sub destiné à être lu 
par un caisson de graves. Par exemple, le Dolby 
Digital est un format 5.1, conçu pour être 
reproduit par des systèmes d'écoute dotés de 
cinq enceintes « pleine bande passante » et d'un 
caisson de graves. Le Dolby Surround EX est un 
format 6.1, destiné aux systèmes dotés de six 
haut-parleurs pleine bande passante et d'un 
caisson de graves. Le SDDS est un format 7.1, 
destiné aux systèmes dotés de sept haut-parleurs 
pleine bande passante et d'un caisson de graves. 

Pour obtenir des résultats professionnels, 
utilisez toujours des produits professionnels 
(tels que le décodeur Dolby Model SDU4, 
Model DP564 ou le plug-in Dolby Surround 
Tools) lors de l'écoute du mixage. 
Les produits de consommation équipés de 
Pro Logic disposent de fonctions 
d'équilibrage automatique qui, lorsqu'elles 
sont utilisées pour l'écoute du mixage, 
peuvent aboutir sur des décisions de mixage 
inappropriées.
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Le signal Sub envoyé au caisson de graves 
englobe le canal LFE d'un mixage au format 
« .1 », ainsi que le signal généré par le circuit de 
gestion des graves (« bass management ») du 
système de lecture. Pour plus d'informations, 
reportez-vous à la section LFE, page 705. 

Formats .0

Les formats « .0 » (5.0, 6.0 et 7.0), s'ils ne sont 
pas associés à des formats Surround particuliers, 
servent souvent de sous-chemin dans les 
mixages. Par exemple, toutes les pistes ne 
contiennent pas des sons à envoyer sur le canal 
LFE (le canal « .1 »). Assigner ces pistes à un 
chemin de type 5.0 fournit un panoramique sur 
360° sans les contrôles LFE. 

LFE

Lorsqu'une décimale, telle que « .1 » est présente 
dans le nom d'un format surround, elle signale 
la présence d'un canal LFE. Le canal LFE 
(abréviation de Low Frequency Enhancement, 
amélioration des basses fréquences) désigne 
généralement une piste particulière utilisée en 
production (et non pendant la lecture ou le 
décodage). LFE est le composant « .1 » des 
formats de mixage, tels que 5.1 et 7.1. 

La raison de cette dénomination est que, à la 
différence des cinq, six ou sept haut-parleurs 
affectés aux autres canaux du mixage, le canal 
LFE ne gère pas la totalité de la bande passante. 
Ce canal LFE constitue un chemin direct pour 
envoyer les fréquences graves au caisson de 
graves, indépendamment du circuit de gestion 
des graves (s'il existe). Les effets sonores riches 
en graves sont notamment le tonnerre, les 
explosions et autres sons synthétiques 
comportant des sons graves. 

Le canal LFE sert généralement à renforcer 
l'impact des effets sonores dans les films. 
Aucune règle établie ne détermine s'il est 
nécessaire ou non d'utiliser un canal LFE. 

Contenu du canal Sub

Lors de la reproduction de mixages Surround sur 
des systèmes d'écoute équipés d'un ou plusieurs 
caissons de basses, le signal reproduit par ces 
derniers provient de l'une ou l'autre de ces 
sources, ou des deux à la fois : 

• tous les graves de tous les canaux, dont la 
fréquence est inférieure à la fréquence de 
coupure du filtre de gestion des basses (s'il y 
en a un),

– et –

• les signaux envoyés sur le canal LFE lors du 
mixage (le cas échéant).

Un caisson de graves Surround reproduit toutes 
les fréquences graves issues de tous les autres 
canaux de haut-parleurs, dès que la valeur de 
leur fréquence descend en dessous d'un certain 
seuil. La valeur de cette fréquence-seuil varie 
selon les formats Surround. Pour consulter la 
liste des ressources relatives aux spécifications 
Surround, reportez-vous à la section Autres 
sources d'information sur la technologie 
Surround, page 706.

Outre les valeurs des fréquences de coupure et 
autres spécifications de chaque format 
surround, les variables du système de lecture 
peuvent aussi avoir des répercussions sur le 

Pro Tools n'applique aucun filtrage aux 
signaux LFE. Dans certaines cas, le format 
requiert un filtrage sur le piste LFE. Pour 
plus d'informations, reportez-vous à la 
section Formats de mixage et Surround, 
page 699.
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signal destiné au caisson de graves. Pour plus 
d'informations, reportez-vous à la section 
Variables du système de reproduction Surround, 
page 708.

Divergence

La divergence est un paramètre de mixage 
surround qui permet de contrôler la 
« progressivité » du panoramique. Une 
divergence complète se traduit par un 
panoramique « discret » (ou étroit). Des valeurs 
inférieures de divergence se traduisent par un 
panoramique de moins en moins « discret » 
(progressivement plus large). 

Lorsque la divergence est intégrale (100 %), il est 
possible d'effectuer un panoramique exclusif, ou 
discret, d'une piste sur un seule enceinte. Dans 
ce cas, les sons ne sont reproduits que sur cette 
enceinte. 

Lorsque la divergence est inférieure à 100 %, les 
signaux des pistes sont reproduits 
simultanément par des haut-parleurs voisins, 
même si le signal n'est panoramiqué que vers 
une seule enceinte du système. Des valeurs 
inférieures de divergence se traduisent par un 
signal source s'élargissant progressivement. 

Exemple de divergence

Pour comprendre la notion de divergence, il 
convient de se représenter l'intérieur d'une 
grande salle de cinéma. Il s'agit d'un très bon 
exemple puisque les variables de reproduction 
les plus difficiles à maîtriser dans le mixage 
multicanal concernent la taille de 
l'environnement d'écoute visé.

A la différence d'un salon ordinaire, une salle de 
cinéma est un local vaste où les haut-parleurs 
sont placés loin les uns des autres. A cause de la 
distance, les sons panoramiqués uniquement 
sur l'enceinte avant droite, par exemple, 
peuvent être inaudibles pour un spectateur assis 
dans l'angle opposé de la salle. Pour éviter ce 
problème, la divergence variable permet de 
contrôler la largeur du panoramique afin 
d'étendre la source sonore. De ce fait, le signal 
est réparti entre haut-parleurs adjacents, même 
s'il a été panoramiqué à 100% vers un haut-
parleur particulier. 

Autres sources d'information sur 
la technologie Surround

Le tableau ci-dessous répertorie différents sites 
constituant un bon point de départ pour vos 
recherches dans le monde en constante 
évolution de la production audio Surround.

Les options de divergence de Pro Tools sont 
expliquées dans la section Divergence, 
page 745.

Ressources sur les spécifications et d'information sur le 
format Surround

Spécifications Surround Site Web

Dolby Surround/Pro Logic www.dolby.com

Dolby Digital www.dolby.com

Dolby Surround EX www.dolby.com

DTS www.dtsonline.com

SDDS www.sony.com

THX www.thx.com
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Notions de mixage surround
A l'instar du mixage et du mastering en stéréo, le 
but en mixage Surround est de faire en sorte que 
le plus possible d'auditeurs puissent entendre le 
meilleur son possible. Parvenir à ce résultat dans 
le cadre d'un mixage Surround fait appel à bon 
nombre des techniques identiques à celles 
utilisées en production stéréo professionnelle, 
ainsi que certains facteurs spécifiques, exposés 
dans les sections suivantes. 

Compatibilité du format Surround

Pro Tools permet d'effectuer des mixages en 
mode Surround et de créer des masters 
multicanaux comportant quatre, six ou 
davantage de pistes, au format LCR, 5.1 ou 
autre. 

◆ Si nécessaire, il est possible de transférer les 
mixages multicanaux sous forme de master 
multipistes, non codés et discrets. La disposition 
des pistes varie selon le format (voir Importation 
de configurations d'I/O multicanaux, page 714 
pour plus de détails).

◆ Les systèmes de lecture grand public ne gèrent 
pas nécessairement tous les formats. On parle de 
Downmixing lorsqu'un mixage dans un format 
donné doit être créé à partir d'un autre format. 
Un exemple typique est l'écoute d'une piste son 
5.1 Dolby Digital de DVD ayant subi un 
« downmixing » au format stéréo.

Pour anticiper les effets du codage/décodage 
Surround et d'un downmixing éventuel, les 
mixages Surround professionnels sont écoutés 
via des processeurs de codage et de décodage 
appropriés. Les systèmes de contrôleur d'écoute 
permettent aux ingénieurs d'écouter leurs 
mixages reproduits via différents haut-parleurs 

et dans des configurations diverses pour 
référence, mais également de comparer des 
facteurs tels que les divers paramètres de gestion 
de graves et leurs effets.

Formats Surround et supports

Les types de mixages Surround sont choisis en 
fonction du support sur lequel ils seront 
commercialisés. La plupart du temps, un 
traitement de codage/décodage propre à chaque 
format est nécessaire. 

Codage et décodage

De nombreux formats surround font appel à 
une forme quelconque d'encodage et de 
décodage afin de faciliter la commercialisation, 
la diffusion et le transfert des différents canaux 
audio « pleine bande passante » qu'ils 
comportent. 

◆ Le codage est le processus permettant de 
faciliter le transport et la lecture des mixages 
multicanaux. Dans de nombreux cas, il est 
nécessaire de convertir les quatre, cinq ou six 
canaux discrets, voire davantage, composant le 
mixage multicanal, en un flux à deux canaux 
pour la diffusion (domaine où le support « deux 
canaux » est encore largement dominant). 

Certains formats de sortie sur lesquels sont 
répartis des formats surround peuvent 
contenir des restrictions audio 
supplémentaires qui risquent de modifier 
votre méthode de travail dans Pro Tools. 
Le format audio Dolby Digital sur un DVD-
vidéo par exemple requiert de fonctionner 
avec une fréquence d'échantillonnage de 
48 kHz. Si la fréquence d'échantillonnage 
de votre session Pro Tools n'est pas de 
48 kHz, vous devez convertir la fréquence 
d'échantillonnage avant de l'encoder avec 
Dolby Digital pourDVD.
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◆ Le décodage est le processus requis pour 
reconstituer les canaux Surround discrets à 
partir du support de livraison à deux canaux. 

Le codage et le décodage, quel que soit leur 
degré de raffinement, représentent des étapes 
supplémentaires du traitement appliqué à votre 
mixage avant qu'il ne parvienne à sa destination 
ultime, le public. 

Par exemple, comme l'algorithme Dolby 
Surround utilise largement les relations de phase 
entre canaux, il subsiste toujours un écart 
qualitatif notable entre la sortie LCRS « après 
décodage » et le mixage LCRS original. Pour 
prendre en compte ces imperfections, les 
mixeurs travaillant en Dolby Surround écoutent 
en permanence « à travers » les processeurs 
d'encodage/décodage. 

En procédant ainsi, ils se rendent précisément 
compte des effets parasites créés par le processus 
de codage/décodage, et peuvent modifier en 
connaissance de cause ce qu'ils font sur la 
console de mixage. 

Traitement Surround et Pro Tools

Pro Tools nécessite des composants logiciels ou 
matériels supplémentaires pour le codage, le 
décodage et le traitement en mode Surround. 
Par exemple, le plug-in Dolby SurroundTools™ 
permet d'effectuer le monitoring et le traitement 
entièrement dans l'environnement Pro Tools. 

Surround Tools et d'autres solutions de 
traitement en mode Surround sont disponibles 
chez Digidesign et d'autres fabricants. Pour plus 
d'informations, contactez votre revendeur 
Digidesign.

Variables du système de 
reproduction Surround

La diversité des systèmes de reproduction 
Surround a pour corollaire l'introduction de 
types et d'intensités de filtrage variables, de 
circuits de gestion des basses et de diverses 
autres variables. Celles-ci comportent les 
caractéristiques propres à certains formats 
Surround, ainsi que les options permettant 
d'affiner le réglage d'un système en fonction de 
son installation. 

Dans votre propre studio, vous connaissez les 
haut-parleurs sur lesquels vous écoutez, vous en 
reconnaissez les qualités, et vous savez 
comment votre cabine d'écoute sonne. Vous 
ignorez toutefois les caractéristiques des haut-
parleurs du salon, du cinéma ou de la salle de 
concert où votre mixage sera écouté par un 
public. 

Gestion des basses

La gestion des basses (Bass Management) est une 
fonction du système de reproduction. 
Elle englobe les divers traitements permettant 
au système de reproduction de « trier » ce qui 
sera reproduit d'une part par le caisson de graves 
et d'autre part par les haut-parleurs. Le but de la 
gestion des basses est d'optimiser la 
reproduction des graves, élargissant ainsi la 
bande passante de votre système d'écoute. La 
gestion des basses permet d'adapter la réponse 
des graves à des variables, telles que la taille et la 
forme de la salle, la présence (ou l'absence) d'un 
caisson de basses, ainsi que la bande passante de 
chaque haut-parleur. 
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Filtrage

Sous sa forme la plus simple, la gestion des 
basses applique un filtrage passe-haut à tous les 
haut-parleurs « pleine bande passante ». Les 
signaux dont la fréquence est inférieure à la 
fréquence de coupure sont « extraits », ajoutés 
aux signaux envoyés sur le canal LFE (le cas 
échéant), puis acheminés vers le caisson de 
graves. Selon les systèmes, les processus de 
gestion des basses varient et peuvent inclure :

Redirection des graves (Bass Redirection) : 
coupe ou laisse les signaux graves extraits par 
filtrage des canaux « pleine bande passante » 
(autrement dit, tous les signaux dont la 
fréquence est inférieure à la fréquence de 
coupure du filtre de gestion des basses). Cette 
fonction est utile lorsque les enceintes « pleine 
bande passante » sont vraiment « pleine bande 
passante », c'est-à-dire capables de reproduire les 
graves avec précision et sans distorsion. 

Extension des graves (Bass Extension) : permet 
au signal envoyé vers le caisson de graves (quelle 
que soit la manière dont il a été obtenu) de 
repartir vers les haut-parleurs « pleine bande 
passante ». Bien que cela puisse sembler 
contradictoire avec ce qui précède, le principal 
intérêt de cette fonction est de permettre au son 
destiné au caisson de graves d'être diffusé 
partout et pas seulement depuis le caisson de 
graves. 
Chapitre 29 : Notions relatives au format Surround (Pro Tools HD uniquement) 709



710
 Guide de référence Pro Tools



Chapitre 30 : Configuration de 
Pro Tools pour le mixage en mode 
Surround (Pro Tools HD uniquement)

Ce chapitre explique comment configurer des 
sessions Pro Tools pour le mixage multicanal. 

Le mixage multicanal n'est pris en charge que 
dans Pro Tools|HD. Dans ce chapitre, toute 
référence à Pro Tools désigne les systèmes 
Pro Tools|HD. 

Connexions audio de 
Pro Tools pour le mixage au 
format 5.1
Même si tous les formats de mixage 5.1 
prévoient une disposition des haut-parleurs 
identique, trois standards principaux régissent 
la disposition des différents canaux constituant 
le mixage multicanal au format 5.1 sur les pistes. 

Dans le tableau suivant, nous partons du 
principe que les canaux Surround sont affectés 
aux sorties 1 à 6 d'une interface audio Pro Tools. 
Utilisez les canaux 7 et 8 pour l'écoute des 
mixages stéréo destinés à une version stéréo ou 
pour les mixages de retours ou casques. 

Pour connecter vos interfaces audio en vue d'un 
mixage et d'une écoute au format 5.1 :

1  Déterminez le format 5.1 et la disposition des 
pistes à appliquer. 

2  Connectez les canaux de sortie de votre 
interface audio aux canaux d'entrée 
correspondants de votre système d'écoute, 
conformément aux affectations du Tableau 5, 
page 711.

Tableau 5. Disposition des pistes pour les formats 5.1

Formats Disposition des pistes

1 2 3 4 5 6

film
(Pro Tools par 

défaut)

G C D Ls Rs LFE

SMPTE/ITU
pour Dolby 

Digital (AC3) et 
Control|24

G D C LFE Ls Rs

DTS
avec 

ProControl

G D Ls Rs C LFE

Si vous utilisez une surface de contrôle 
Digidesign, consultez le guide qui 
l'accompagne pour plus d'informations.
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Configuration de Pro Tools 
pour les sessions 
multicanaux
Il existe plusieurs méthodes permettant de 
configurer Pro Tools et les sessions pour le 
mixage multicanal :

Nouvelles sessions

Vous pouvez créer une session et choisir un 
fichier de paramètres d'I/O de mixage Surround 
comme configuration d'I/O par défaut Reportez-
vous à la section Nouvelles sessions et nouveaux 
paramètres d'I/O, page 712.) 

Remixage de sessions en mode Surround

En créant ou important un fichier de paramètres 
d'I/O de mixage Surround dans la boîte de 
dialogue I/O Setup, il est possible de disposer de 
chemins multicanaux dans n'importe quelle 
session stéréo (ou d'un autre format). Vous 
pouvez ensuite réassigner les pistes des chemins 
stéréo originaux à ces chemins multicanaux. Les 
chemins actifs et inactifs simplifient la 
réassignation Reportez-vous à la section 
Importation de configurations d'I/O 
multicanaux, page 714.)

Chemins personnalisés

Vous pouvez personnaliser et redéfinir des 
chemins existants dans la boîte de dialogue 
I/O Setup. Pour plus d'informations, reportez-
vous à la section Chemins multicanaux 
personnalisés, page 714. 

Importation de données de session

La commande Import Session Data (File > 
Import > Session Data) permet d'importer non 
seulement les pistes et les médias, mais 
également les chemins et les affectations de 
piste associés. Après avoir importé les données 

de session, utilisez la boîte de dialogue I/O Setup 
pour configurer les chemins et les sous-chemins 
requis par la session. Pour plus d'informations, 
consultez le Chapitre 7, Configuration des E/S.

Nouvelles sessions et nouveaux 
paramètres d'I/O

Lors de la création d'une nouvelle session, vous 
pouvez choisir le format surround à utiliser 
comme configuration d'I/O par défaut. 
Des configurations de chemin par défaut sont 
fournies sous forme de fichiers de configuration 
d'I/O, pour des mixage stéréo et surround. 

Une fois que vous avez créé une session, vous 
pouvez créer et importer des pistes, des données 
audio, et gérer les assignations du signal afin de 
construire votre mixage. 

Pour créer une session pour un mixage 
multicanal :

1  Choisissez File > New Session.

2  Sélectionnez un des paramètres 5.1 
disponibles dans le menu I/O Settings. 

3  Si besoin est, modifiez d'autres paramètres 
dans la section Session Parameters.

4  Nommez la session.

5  Cliquez sur Save.

Configuration d'une nouvelle session pour un mix 5.1
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Les présélections surround préconfigurent la 
boîte de dialogue I/O Setup avec un chemin et 
des sous-chemins au format 5.1 par défaut pour 
les sorties et les bus.

Fichiers de paramètres de mixage 
surround

Les fichiers de paramètres d'I/O de mixage 
Surround fournissent les chemins de sortie et de 
bus pour trois standards de dispositions de pistes 
spécifiques. Pour obtenir des informations sur 
les entrées et les chemins d'insertion, reportez-
vous à la section Chemins d'entrée et d'insertion 
par défaut avec les paramètres de mixage 5.1, 
page 713.) 

Les trois fichiers de paramètres du format 5.1 
fournissent les chemins de sortie et de bus par 
défaut suivants :

Chemins de sortie 5.1 par défaut

• Un chemin de sortie 5.1 principal et des 
sous-chemins pour les sorties centrales, 
gauche/droite, LCR et 5.0 (pas de LFE) 

– et –

• Un chemin stéréo principal et deux sous-
chemins mono.

Chemins de bus 5.1 par défaut

• Un chemin de bus 5.1 principal et des sous-
chemins 5.0 (pas de LFE) pour les bus 
central, gauche/droit (stéréo), LCR et 
central (mono) 

– et –

• Un chemin stéréo principal et deux sous-
chemins mono.

Chemins d'entrée et d'insertion par défaut avec 
les paramètres de mixage 5.1

Les fichiers de paramètres de mixage 5.1 
proposent par défaut des chemins d'entrée 
principaux et des sous-chemins stéréo pour les 
entrées et les insertions. Si vous avez besoin de 
chemins multicanaux d'entrée ou d'insertion, 
créez-les dans la boîte de dialogue I/O Setup 
(voir Chemins multicanaux personnalisés, 
page 714) 

Chemins de sortie au format 5.1 (film) standard

Fichiers de paramètres et disposition des pistes

Paramètres 5.1
Disposition des 
pistes

Film (standard Pro Tools) L C R Ls Rs LFE

SMPTE/ITU
(Ecoute Control|24)

L R C LFE Ls Rs

DTS (Ecoute ProControl) L R Ls Rs C LFE
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Importation de 
configurations d'I/O multicanaux

La boîte de dialogue I/O Setup permet 
d'importer et d'exporter des fichiers de 
paramètres. Importer des fichiers de paramètres 
d'I/O est utile lorsque vous souhaitez remixer 
une session stéréo en mode surround. 
Vous pouvez également recourir à cette 
fonctionnalité pour préparer une session à un 
transfert sur un autre système Pro Tools, ou 
simplement pour sauvegarder et échanger les 
paramètres d'I/O 

Pour importer un fichier de paramètres d'I/O 
multicanaux :

1  Sélectionnez Setup > I/O.

2  Cliquez sur Import Settings.

3  Sélectionnez le fichier de paramètres à 
importer et cliquez sur Open.

Si des chemins ont déjà été définis pour la 
session en cours et qu'ils ne correspondent pas à 
ceux du fichier de paramètres importé, 
Pro Tools vous demande si vous souhaitez 
supprimer les chemins existants ou les conserver 
et ajouter les paramètres importés à votre 
session. 

• Cliquez sur No pour ajouter les nouveaux 
chemins à votre configuration actuelle 
des I/O.

• Cliquez sur Yes pour remplacer la 
configuration d'I/O actuelle par les 
paramètres importés. 

Exportation de paramètres d'I/O

L'exportation de fichiers de paramètres d'I/O 
permet de constituer une bibliothèque de 
configurations multicanaux pour différents 
projets. 

Pour exporter un fichier de paramètres d'I/O 
multicanaux :

1  Sélectionnez Setup > I/O.

2  Cliquez sur Export Settings.

3  Attribuez un nom au fichier de paramètres 
d'I/O actuel et enregistrez-le.

Chemins multicanaux 
personnalisés

La boîte de dialogue I/O Setup permet de créer et 
de personnaliser des chemins de signaux pour 
tout format de mixage multicanal pris en 
charge. 

Les chemins et les sous-chemins multicanaux 
sont affectés à des entrées, des sorties ou des bus 
internes par l'intermédiaire de la grille des 
canaux. Lorsque vous sélectionnez un fichier de 
paramètres d'I/O 5.1 prédéfini, la répartition par 
défaut des chemins multicanaux ainsi créés 
correspond à celle des pistes du format 
sélectionné. 

La boîte de dialogue I/O Setup, comme l'onglet 
Main de la boîte de dialogue Hardware Setup, 
contient des commandes de routage des ports 
d'entrée et de sortie physiques du périphérique 
d'I/O vers les ports d'entrée et de sortie 
Pro Tools.
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Réaffectation de canaux

La boîte de dialogue I/O Setup et sa grille de 
canaux permettent de réaffecter les canaux. 
Cette fonctionnalité est particulièrement utile 
pour modifier l'assignation des canaux à 
l'intérieur d'un chemin multicanal sans avoir à 
modifier les connexions au niveau des interfaces 
audio.

Vous pouvez réaffecter les chemins à n'importe 
quelle configuration selon les besoins. Les seules 
limites sont celles des ressources de votre 
système, ainsi que les conditions requises par la 
boîte de dialogue I/O Setup pour le 
chevauchement des canaux et l'attribution de 
noms (voir Chemins valides et conditions, 
page 99pour plus de détails).

Exemple de configuration LCRS

L'exemple ci-après montre une des méthodes de 
configuration de la boîte de dialogue I/O Setup 
pour un mixage au format LCRS 4 canaux, avec 
une interface 96 I/O.

Pour définir un chemin LCRS :

1  Sélectionnez Setup > I/O et cliquez sur l'onglet 
Output. 

2  Cliquez sur New Path.

3  Choisissez LCRS dans le sélecteur de format de 
chemin.

4  Nommez le chemin LCRS.

5  Dans la grille des canaux, cliquez sur la case en 
dessous du premier canal d'interface audio (à 
l'extrême gauche) du chemin. Pro Tools remplit 
automatiquement les cases adjacentes sur la 
droite. Si vous cliquez sur la ligne LCRS sous le 
canal 1, le chemin LCRS sera réparti sur les 
canaux 1 à 4.

6  Sélectionnez le nouveau chemin LCRS et 
cliquez sur New Sub-Path.

7  Nommez le nouveau sous-chemin LCR et 
sélectionnez LCR comme format de chemin. 
Cliquez sur le canal 1, sur la ligne LCR, pour 
affecter le chemin.

8  Sélectionnez le chemin LCRS, cliquez sur New 
Sub-Path et créez un sous-chemin stéréo (un 
pour l'avant gauche et un pour l'avant droite).

Lorsque vous créez des chemins au format 
5.1, vous pouvez spécifier la disposition par 
défaut des pistes. Pour plus d'informations, 
reportez-vous à la section Ordre 
d'acheminement par défaut des pistes 
dans le format 5.1, page 717. 

Voir également Exemples de chemins et 
d'acheminement du signal pour un 
mixage Surround, page 729. 

Exemple de chemins principal et de sous-chemins LCRS

Pour en savoir plus sur la configuration des 
E/S, reportez-vous à la section Création et 
modification de chemins, page 94. 
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9  Sélectionnez le chemin LCRS, cliquez sur New 
Sub-Path et créez un sous-chemin mono (pour le 
canal du milieu). 

10  Sélectionnez le chemin LCRS, cliquez sur 
New Sub-Path et créez un sous-chemin mono 
(pour le canal du milieu).

Pistes, format, affectation et mesures 
du format 5.1

Les définitions de chemin de la boîte de 
dialogue I/O Setup déterminent comment les 
données audio sont routées vers les interfaces 
audio, et leur niveau mesuré sur celles-ci.

Les fonctions internes de visualisation à l'écran 
des niveaux des chemins en format 5.1 dans 
Pro Tools adoptent toujours la disposition des 
pistes Film :

L C R Ls Rs LFE

La disposition des pistes audio au format 5.1 
dans la fenêtre Edit de Pro Tools adopte 
également la disposition Film (de haut en bas). 
Examinez l'illustration Disposition des pistes, 
acheminement et mesures dans le format 5.1, 
page 717.

Dans la boîte de dialogue I/O Setup, vous 
pouvez récupérer ces signaux en sortie des 
interfaces audio, en adoptant n'importe quelle 
disposition de pistes (DTS, SMPTE/ITU ou 
autre). 

Pour réaffecter des canaux dans un chemin :

■ Faites glisser un canal vers un nouvel 
emplacement valide de la grille. Les autres 
affectations de canaux se décalent en 
conséquence.

Sélecteurs par défaut dans la 
boîte de dialogue I/O Setup
L'onglet Output de la boîte de dialogue 
I/O Setup contient les paramètres par défaut 
suivants pour les sessions multicanaux :

Default Path Order : sélectionne la disposition 
(ou l'ordre d'acheminement) par défaut pour les 
nouveaux chemins (six voies) au format 5.1.

Controller Meter Path : sélectionne le chemin 
dont le niveau sera affiché dans les vumètres de 
sortie de la surface de contrôle Digidesign. Pour 
plus d'informations, reportez-vous à la section 
Pistes, format, affectation et mesures du format 
5.1, page 716.

Audition Paths : sélectionne le chemin d'écoute 
pour la pré-écoute audio dans les boîtes de 
dialogue Regions List, Import Audio et dans 
Digibase. Seules les sorties de l'interface 
principale peuvent être utilisées comme chemin 
d'écoute.

Sélecteurs par défaut de la boîte de dialogue I/O Setup

Ordre des chemins 
par défaut

Options de 
configuration d'E/S
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New Track Default Output : sélectionne le 
chemin de sortie par défaut pour toutes les 
nouvelles pistes, pour chaque format pris en 
charge. 

AFL/PFL Path (Pro Tools HD uniquement) : 

sélectionne l'emplacement auquel les pistes sont 
assignées lorsqu'elles sont écoutées en mode 
Solo AFL (After Fader Listen) ou PFL (Pre Fader 
Listen).

AFL/PFL Mutes (chemin de sortie) (Pro Tools HD 
uniquement) : sélectionne la sortie coupée en cas 
d'activation du mode Solo AFL (After Fader 
Listen) ou PFL (Pre Fader Listen) et de l'écoute 
d'une piste en solo.

Ordre d'acheminement par défaut 
des pistes dans le format 5.1

Il est possible de spécifier la disposition par 
défaut des pistes pour tous les nouveaux 
chemins de format 5.1 que vous créez. 

Pour choisir un nouvel ordre d'acheminement 
(disposition des pistes) dans Pro Tools 5.1 :

1  Choisissez Setup > I/O.

2  Choisissez la disposition des pistes dans les 
sous-menus du menu Default Path Order. 

Disposition des pistes, acheminement et mesures dans le 
format 5.1

Le paramètre New Track Default Output 
peut être défini aussi bien pour des chemins 
de bus que pour des chemins de sortie.

Sélecteur d'ordre d'acheminement par défaut dans la 
boîte de dialogue I/O Setup

Figure 32.  Disposition des pistes dans les différents formats 5.1

Affectation des canaux dans I/O  SFormat 5.1

Film

SMPTE/ITU

DTS

L C R Ls Rs LFE

(Ecoute Control|24)

L R Ls Rs C LFE

L C R Ls Rs LFE

Compteurs 
Pistes

L C R Ls Rs LFE
(haut en bas)

idem

L C R Ls Rs LFE
idem

idem

idem

L C R Ls Rs LFE
(gauche à droite)

L C R Ls Rs LFE

(standard Pro  Tools)

(Ecoute ProControl)

L C R Ls Rs LFE

L R C LFE Ls Rs

L R Ls Rs C LFE

L R C LFE Ls Rs

 

de pistes
Chapitre 30 : Configuration de Pro Tools pour le mixage en mode Surround (Pro Tools HD uniquement) 717



718
  
Guide de référence Pro Tools



   

Chapitre 31 : Pistes multicanaux et 
assignation des signaux (Pro Tools HD 
uniquement)

 

Les sessions Surround combinent généralement 
des pistes audio mono, stéréo et multicanaux, 
des entrées auxiliaires, des faders principaux, 
des pistes d'instrument, des bus et des inserts.

Une fois la configuration d'E/S adéquate 
importée ou définie, il est possible de mixer les 
pistes audio, d'entrée auxiliaire, de master 
principal et d'instrument en multicanal 
Surround grâce aux fonctions de mixage de 
Pro Tools. 

La configuration des I/O et l'affectation des 
signaux multicanaux sont déterminées par les 
chemins définis dans la boîte de dialogue 
I/O Setup.

Le mixage multicanal n'est pris en charge que 
dans Pro Tools|HD. Dans ce chapitre, toute 
référence à Pro Tools désigne les systèmes 
Pro Tools|HD. 

 

Démarrage rapide multicanal

 

La section suivante est une introduction au 
mixage multicanal Surround dans Pro Tools. 

 

Pour effectuer un mixage en multicanal :

 

1  

 

Ouvrez une session Pro Tools stéréo pour la 
remixer en mode Surround. (Vous pouvez 
également créer des sessions vides en mode 
Surround. (Voir Nouvelles sessions et nouveaux 
paramètres d'I/O, page 712.)

 

2  

 

Configurez les entrées, les sorties, les bus et les 
inserts multicanaux dans la boîte de dialogue 
I/O Setup, selon vos besoins (reportez-vous à la 
section Configuration de Pro Tools pour les 
sessions multicanaux, page 712).
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3  

 

Effectuez l'une des opérations suivantes :

• Créez des pistes et affectez des sorties de 
piste et des départs aux chemins 
multicanaux. Configurez l'assignation des 
signaux pour le prémixage, l'envoi sur les 
bus, le traitement et l'écoute. Si certaines 
pistes ne doivent pas être soumises à un 
panoramique sur 360°, placez-les dans le 
mixage en utilisant des sous-chemins et les 
assignations de signaux. Reportez-vous à la 
section Assignation du signal multicanal, 
page 723. 

• La commande Import Tracks permet 
d'importer des pistes multicanaux.

• Utilisez la commande Import Session Data 
pour importer des pistes 5.1, des bus et 
autres données existantes. Reportez-vous à 
la section Importation de pistes et de leurs 
attributs, page 154.

 

4  

 

Effectuez le panoramique Surround depuis les 
fenêtres des sorties de pistes et de départs 
multicanaux. Reportez-vous au Chapitre 32, 
Panoramique et mixage en mode Surround 
(Pro Tools HD uniquement)., pour obtenir des 
informations sur le mixage et l'application d'un 
panoramique pour le surround.

 

Pistes audio multicanaux

 

Les pistes audio multicanaux contiennent 
plusieurs signaux pour chaque canal de la piste ; 
ainsi, une piste au format 5.1 doit avoir six 
signaux : pour la gauche, un pour le centre, un 
pour la droite, un pour la gauche surround, un 
pour la droite surround et un pour le LFE. 

Les pistes audio multicanaux peuvent être :

• enregistrées directement dans Pro Tools, les 
signaux provenant de plusieurs microphones 
ou de dispositifs microphoniques étant 
acheminés vers les chemins d'entrée 
multicanaux appropriés de Pro Tools.

• importés d'autres sessions Pro Tools ;

• édités, traités et mixés en combinaison avec 
des pistes mono et stéréo.

Les fichiers audio et les pistes au format 5.1 
adoptent la disposition Film standard. Quelle 
que soit l'affectation des chemins dans la boîte 
de dialogue I/O Setup, toutes les pistes audio et 
tous les vumètres au format 5.1 se conforment à 
la disposition de pistes du standard Film :

L C R Ls Rs LFE

Les pistes audio multicanaux ne doivent pas 
nécessairement être mixées dans les formats 
multicanaux. Ces pistes peuvent être mono, 
stéréo ou de tout autre format reconnu, et leur 
mixage s'effectue en utilisant les sorties de pistes 
et les départs de Pro Tools. Pour plus 
d'informations, reportez-vous à la section 
Assignation du signal multicanal, page 723.

 

Piste audio multicanal au format 5.1
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Placement des données audio sur 
les pistes multicanaux

 

Pour placer des fichiers audio et des régions sur 
des pistes audio multicanaux, il suffit de les faire 
glisser depuis des navigateurs DigiBase, la liste 
des régions, l'Explorateur Windows, le Finder 
Macintosh ou d'autres pistes.

Pour ce faire, le nombre de canaux déplacés doit 
correspondre au format de la piste de 
destination. Vous ne pouvez faire glisser qu'une 
paire stéréo ou deux régions mono sur une piste 
audio stéréo, par exemple. De même, vous ne 
pouvez placer de données audio sur une piste 
LCR que lorsque vous avez sélectionné trois 
régions. Dans le cas de pistes au format 5.1, vous 
devez sélectionner six fichiers ou régions mono. 

 

Solo, Mute et Gain sur les pistes et les 
chemins multicanaux

 

Les pistes stéréo et multicanaux sont composées 
d'un « bloc » de plusieurs signaux audio reliés. 
Par défaut, les pistes multicanaux sont 
« monobloc », ce qui permet leur contrôle par 
un seul fader de voie et par les touches Solo et 
Mute. 

Si vous souhaitez contrôler séparément les 
signaux d'une piste multicanal, convertissez-la 
en pistes mono séparées (« discrètes »). Pour 
pouvoir régler séparément le niveau et la phase, 
il faut insérer, puis désolidariser, un plug-in 
Trim multimono. Ces deux étapes sont 
expliquées ci-après.

 

Pour convertir une piste multicanal en pistes 
mono séparées :

 

1  

 

Sélectionnez la piste multicanal.

 

2  

 

Choisissez Track > Split into Mono. 

 

Pour contrôler séparément le gain sur les canaux 
distincts d'une piste multicanal : 

 

1  

 

Insérez un plug-in Trim multimono dans la 
piste multicanal. 

2  

 

Désolidarisez le plug-in Trim en cliquant sur 
l'icône Link, qui doit alors s'éteindre. 

 

3  

 

Utilisez le sélecteur de voie pour afficher les 
contrôles pour un canal et pour régler le gain. 

 

Quand vous faites glisser des fichiers audio 
vers une piste multicanal, ils sont placés de 
haut en bas, selon l'ordre précis où ils 
apparaissent dans la liste de régions ou la 
playlist dont ils proviennent. Aussi, vous 
devez veiller à ce qu'ils soient agencés dans 
l'ordre voulu au sein de la liste des régions 
avant de les faire glisser. Renommez ces 
fichiers afin qu'ils soient triés dans l'ordre 
voulu lors d'un tri par nom de région dans 
la liste des régions. Pour une piste au format 
5.1 par exemple, arrangez les pistes de sorte 
qu'elles correspondent à L, C, R, Ls, Rs et 
LFE.

 

Une fois les pistes multicanaux converties 
en mono, leur format multicanal d'origine 
ne peut plus être rétabli. Cependant, vous 
pouvez « réassembler » une piste 
multicanal en faisant glisser le nombre de 
fichiers mono correspondants sur une piste 
multicanal ; des données d'automation 
risquent toutefois d'être perdues au cours de 
cette opération. Vous pouvez également 
enregistrer le prémixage des pistes mono sur 
une piste multicanal du disque.

Pour plus d'informations, reportez-vous à la 
section Couplage et découplage des 
contrôles sur les plug-in multimono, 
page 725. 
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Formats de piste et de sortie

 

Lorsque vous créez des pistes, spécifiez le format 
mono, stéréo ou tout autre format multicanal 
pris en charge. 

Dans les fenêtres Mix et Edit, le format d'une 
piste transparaît toujours, d'après le nombre de 
vumètres de pistes apparaissant dans sa voie de 
console (un seul pour les pistes mono, une paire 
pour les pistes stéréo, et six pour les pistes 5.1).

L'affectation de la sortie d'une piste détermine le 
format de cette sortie. Une piste mono, par 
exemple, comporte toujours un seul vumètre de 
piste, même lorsqu'elle est affectée à un chemin 
de sortie stéréo. Si cette même piste mono est 
affectée à un chemin de sortie au format 5.1, sa 
sortie sera répartie sur ces six canaux de sortie, 
en fonction de la position du panoramique. 

 

Changement de format

 

Changer de format de sortie pour une piste 
donnée a plusieurs effets :

• Le panoramique qui apparaît sur la piste 
s'adapte au nouveau format de sortie.

• Il peut être nécessaire de créer ou de 
supprimer une ou plusieurs playlists 
d'automation associées.

En raison des effets d'un changement de format 
de sortie, une boîte de dialogue d'avertissement 
apparaît à chaque fois que vous passez à un 
format de sortie comportant un moins grand 
nombre de canaux. Plus précisément, c'est ce 
qui se produit à chaque fois que des playlists 
d'automation doivent être supprimées.

 

Affectations de sorties multiples et format des 
pistes

 

Lorsqu'une piste est affectée à plus d'un chemin, 
avec des formats différents, sa sortie principale 
correspond au format du chemin affecté qui 
comporte le plus grand nombre de canaux.

 

Sorties multiples et playlists d'automation

 

Lorsqu'une piste comporte plusieurs 
affectations de sortie, Pro Tools trie les données 
de panoramique en fonction de chaque chemin 
affecté. Si vous affectez une piste mono 
simultanément à un chemin stéréo et à un 
chemin au format 5.1, par exemple, cette piste 
disposera d'un panoramique 5.1 dans la fenêtre 
Mix ou Edit. Lorsque vous effectuez un 
panoramique sur la piste, Pro Tools interprète 
les déplacements panoramiques 5.1 comme des 
déplacements panoramiques stéréo. 

Cela permet de disposer d'une forme de mixage 
en parallèle. Vous pouvez ainsi créer 
simultanément plusieurs mixages de formats 
différents en envoyant vos éléments vers 
plusieurs chemins. 

 

Maintenez les touches Ctrl + Démarrer 
(Windows) ou Pomme + Contrôle 
(Macintosh) enfoncées pendant que vous 
cliquez sur une commande d'une fenêtre 
Output pour afficher sa playlist 
d'automation et visualiser toute 
automation de panoramique. 
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Assignation du signal 
multicanal

 

Pour effectuer un mixage dans un format 
multicanal, les pistes sont affectées à des 
chemins multicanaux. 

Pour mixer les pistes en Surround, les deux 
méthodes suivantes sont applicables :

• L'affectation d'une sortie principale de piste à 
un chemin multicanal. 

• L'affectation d'un départ multicanal pour 
acheminer les données audio vers un chemin 
multicanal. 

 

Sorties de pistes multicanaux

 

Les pistes peuvent être acheminées vers des 
chemins de bus ou de sortie multicanaux via le 
sélecteur de chemin de sortie. Vous disposez 
ainsi d'un panoramique et d'un vumètre 
multicanaux dans la vue I/O des fenêtres Mix 
et Edit. 

Il est possible d'ajouter d'autres affectations de 
sortie en maintenant la touche Démarrer 
(Windows) ou Contrôle (Macintosh) enfoncée 
pendant que vous cliquez sur le sélecteur pour 
affecter un autre chemin. 

 

Départs multicanaux

 

Tous les formats, qu'ils soient mono ou stéréo, 
permettent d'affecter un ou plusieurs départs 
multicanaux. Vous disposez ainsi d'un 
panoramique multicanal dans la vue Sends. 
Les départs sont également utiles pour 
rassembler des signaux de pistes en vue du 
traitement par un plug-in multicanal. 

La Figure 33 ci-dessous représente une piste 
audio mono avec un départ (6 canaux) 5.1 
(Sends View Shows > Send A View).

 

Pour plus d'informations, reportez-vous à la 
section Départs multicanaux, page 723. 

 

Il existe deux méthodes de configuration des pistes 
pour le mixage multicanal.

Ce chemin de sortie du 
canal est multicanal. La 
piste est donc dotée d'un 
panoramique multicanal 

Le chemin de sortie 
principal de ce canal est 
mono (« Centermusic »). 
Il comporte un départ 
multicanal offrant un 
panoramique multicanal
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Les fonctions de routage par bus et de prémixage 
de Pro Tools sont disponibles pour tous les 
formats de voies, de mono/stéréo jusqu'au 
format 8 canaux. Des exemples d'écoute 
multicanal, de traitement par effets et de 
routage par bus sont donnés dans la section 
Mixage par l'intermédiaire de chemins et sous-
chemins, page 726. Des exemples de mixages 
mono et stéréo sont donnés au Chapitre 25, 
Mixage : les bases.

 

Entrées auxiliaires multicanaux et 
faders principaux

 

Le bus multicanal revient dans la console sur 
une entrée auxiliaire multicanal ou un fader 
principal.Les départs sont utiles lorsque vous 
devez créer simultanément un autre mixage 
indépendant (par exemple, dans un format 
distinct), ce qui nécessite des contrôles de fader, 
de Mute, de Solo et d'automation dédiés.

Vous pouvez attribuer des faders principaux aux 
chemins principaux et aux sous-chemins. Les 
chemins principaux doivent correspondre au 
format du fader principal, et un seul fader 
principal peut être actif et affecté à un chemin 
principal (actif) ou sous-chemin à la fois. Il n'est 
pas possible d'affecter un fader principal à un 
sous-chemin si son chemin principal associé est 
déjà assigné à un autre fader principal. Pour plus 
d'informations, reportez-vous à la section Pistes 
de fader principal, page 574. 

 

Pistes d'instrument multicanaux

 

Vous pouvez utiliser les pistes multicanaux pour 
l'écoute et l'assignation des plug-in d'instrument 
multicanaux ou des instruments MIDI externes 
multicanaux.

 
Plug-in mono, multimono et 
multicanaux

 

Vous pouvez utiliser les plug-in dans les formats 
mono, multimono ou multicanaux.

 

Figure 33.  Une piste mono, de format de sortie mono, 
avec un départ multicanal

Panoramique de départ multicanal

Vumètre mono

Format de sortie mono

 

Formats de plug-in
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Pour en savoir plus sur les plug-in mono, stéréo, 
et entrée mono/sortie stéréo, voir Chapitre 26, 
Plug-in et inserts matériels.

 

Plug-in multimono : 

 

ils sont conçus pour des 
pistes multicanaux au format stéréo ou 
supérieur. Les plug-in multimono sont utiles, 
voire obligatoires, dans les situations suivantes : 

• Lorsque le plug-in ne nécessite pas de 
corrélation des canaux (égalisation des 
canaux d'un signal multicanal, par exemple) ;

• lorsque vous devez intervenir séparément sur 
chaque signal formant une piste multicanal ;

• lorsqu'un plug-in ne prend pas en charge les 
formats multicanaux.

Lors de la première insertion d'un plug-in 
multimono dans une piste multicanal, ses 
commande sont couplées. Vous pouvez les 
désolidariser pour les régler individuellement. 
Pour plus d'informations, reportez-vous à la 
section Couplage et découplage des contrôles 
sur les plug-in multimono, page 725.

Les plug-in multimono peuvent également être 
insérés dans les pistes stéréo, afin d'appliquer 
des plug-in indépendants aux canaux droit et 
gauche.

 Plug-in multicanaux :  ils sont conçus pour être 
utilisés sur les pistes stéréo et multicanaux 
nécessitant un traitement corrélé, tel que la 
limitation stéréo et multicanal, la compression 
et autres effets similaires. 

 

Couplage et découplage des contrôles 
sur les plug-in multimono

 

Lorsqu'un plug-in multimono est appliqué à 
une piste multicanal comportant plus de deux 
canaux, les commandes sont généralement 
couplées. Le réglage du contrôle Gain sur un 
canal, par exemple, est étendu à tous les autres 
canaux.

Si nécessaire, vous pouvez dissocier les 
commandes de plug-in sur des canaux 
spécifiques d'une piste et les modifier 
indépendamment. Vous pouvez également lier 
les commandes de manière sélective sur certains 
canaux seulement. 

Par exemple, pour appliquer des fréquences de 
coupure identiques sur les canaux (surround) Ls 
et Rs d'un mixage au format 5.1, vous pouvez 
activer l'option Link Enable uniquement pour 
les canaux d'un plug-in EQ multimono 
désolidarisé. Le réglage des contrôles de la 
fenêtre Plug-In sur l'un des canaux (Ls ou Rs) 
s'applique simultanément à l'autre canal couplé. 

 

Sélecteur de canal : 

 

permet d'accéder au canal 
spécifique d'une piste multicanal afin de 
modifier les paramètres du plug-in. Ce menu 
apparaît uniquement sur les plug-in multimono 
insérés sur des pistes comportant plus de deux 
canaux.  

Bouton Master Link : 

 

activez ce bouton pour lier 
les commandes de tous les canaux d'un plug-in 
multimono, afin de pouvoir les régler par paire.

 

Boutons Link Enable : 

 

ces boutons assurent une 
liaison sélective des commandes sur des canaux 
spécifiques d'un plug-in multimono. Chaque 
carré représente un canal d'enceinte. Désactivez 
le bouton Master Link avant d'utiliser les 
boutons Link Enable. 

 

Sélecteur de canal et commandes de liaison

Sélecteur de canal

Boutons Link Enable

Bouton Master Link
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Pour dissocier les commandes d'un plug-in 
multimono :

 

■

 

Désélectionnez le bouton Master Link. Il est 
allumé lorsque le couplage est activé, éteint 
dans le cas contraire.

 

Pour accéder aux commandes d'un canal 
particulier :

 

■

 

Sélectionnez le canal dans le sélecteur de 
canal.

 

Pour ouvrir une fenêtre Plug-In pour tous les 
canaux d'un plug-in multimono :

 

■

 

Maintenez la touche Option (Macintosh) ou 
Alt (Windows) enfoncée pendant que vous 
cliquez sur un sélecteur de canal. 

 

Pour lier les commandes de canaux spécifiques :

 

1  

 

Désélectionnez le bouton Master Link, si ce 
n'est déjà fait.

 

2  

 

Cliquez sur les boutons Link Enable 
correspondant aux canaux dont vous souhaitez 
lier les commandes.

 

Chemins dans les mixages 
Surround

 

Pro Tools fournit un environnement de routage 
et de prémixage flexible. Vous pouvez ainsi tirer 
le meilleur parti des ressources de votre système 
en commençant par identifier les éléments sur 
lesquels vous souhaitez appliquer un 
panoramique dynamique et ceux qui peuvent 
être placés statiquement sur certains canaux 
(voir Mixage par l'intermédiaire de chemins et 
sous-chemins, page 726).

Une fois les éléments de votre session identifiés, 
vous pouvez combiner des affectations de 
chemins principaux et de sous-chemins au 
panoramique multicanal.

 

Mixage par l'intermédiaire de chemins 
et sous-chemins

 

Il est rare que toutes les pistes fassent l'objet d'un 
« panoramique étendu », c'est-à-dire sur 
plusieurs haut-parleurs et pas seulement deux. 
Dans la plupart des cas, certains éléments sont 
placés sur certains haut-parleurs et y restent, 
constituant ainsi la base du mixage.

La Figure 34, page 728 est un exemple de 
combinaison du panoramique et de 
l'acheminement du signal dans un mixage 
multicanal. Les sections suivantes indiquent 
comment organiser la session et l'assignation 
des signaux afin de tirer le meilleur parti des 
ressources disponibles. 

 

Pour plus d'informations sur les plug-in de 
retouche, consultez le Guide des plug-in 
DigiRack.

 

Pour en savoir plus, reportez-vous à la 
section Extension des conventions de 
mixage stéréo au mixage Surround, 
page 728. 
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Quand faut-il affecter des sorties multicanaux ?

 

■

 

Affectez des chemins 5.1 uniquement aux 
pistes sur lesquelles le panoramique doit être 
appliqué sur les six canaux. 

Par exemple, une piste d'effets spéciaux 
comportant le survol d'un avion à réaction se 
verra affecter un chemin 5.1 pour pouvoir 
« faire voler » le son de l'avant vers l'arrière. 
Dans un mixage musical, vous pouvez appliquer 
cet effet à un instrument en solo, ou faire 
tourner une nappe de synthé, comme effet 
spécial. 

Les éléments devant être entendus 
simultanément sur tous les haut-parleurs 
peuvent également être affectés à la sortie 
multicanal, qu'ils nécessitent ou non un 
panoramique actif dans le champ audio. 

 

Quand faut-il utiliser les sous-chemins ?

 

■

 

Pour simplifier les sessions d'une certaine 
importance, vous pouvez utiliser les sous-
chemins pour envoyer des éléments 

 

statiques

 

 
(ou stationnaires) directement vers le ou les 
canaux de sortie désirés. 

Par exemple, les dialogues d'un film sont 
souvent mixés sur le haut-parleur central 
uniquement, afin de « fixer à l'écran » cet 
élément sonore essentiel à l'image. Au lieu 
d'affecter un panoramique six canaux aux pistes 
de dialogue pour leur appliquer un 
panoramique uniquement vers le haut-parleur 
central, vous pouvez envoyer directement la 
sortie principale de la piste de dialogue vers un 
sous-chemin mono (centre).
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Extension des conventions de mixage stéréo au 
mixage Surround

Le mixage en stéréo a inauguré les 
panoramiques actifs et statiques, et le mixage en 
mode Surround peut bénéficier des mêmes 
principes de base. 

Panoramiser un son de l'enceinte gauche à 
l'enceinte droite est à considérer comme un effet 
spécial. Dans un mixage musical typique, les 
pistes de base sont placées une fois pour toutes 
dans l'image stéréo, et elles y restent. 

Figure 34.  Utilisation de l'assignation des signaux et des sous-chemins pour le mixage en mode Surround

Pistes envoyées vers 
des sous-chemins

Pistes avec 
panoramiques en 3D

Affectation
à des bus

Sortie 
principale 
vers les 
sous-
chemins

Sorties principales vers les chemins 5.1 pour panoramique en Surround

Entrée auxiliaire 
envoyée vers 
les chemins 
principaux
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Les mixages Surround multicanaux risquent de 
devenir complètement incohérents si trop 
d'éléments se déplacent en permanence. Pour 
créer des effets spéciaux, certaines pistes 
peuvent être panoramiquées 

 

dynamiquement, 
rebondissant ou passant progressivement d'une 
enceinte à l'autre.

Exemples de chemins et 
d'acheminement du signal 
pour un mixage Surround
Ces exemples montrent comment les entrées 
auxiliaires, les faders principaux et les autres 
fonctions d'acheminement du signal de 
Pro Tools peuvent être appliqués aux 
prémixages (stems), aux mixages secondaires et 
à des traitements similaires dans le cadre d'un 
projet. 

Dans ces exemples, la musique et les effets 
spéciaux sont mixés dans le cadre d'une bande-
annonce au format Surround 5.1. Les 
prémixages musicaux et effets doivent être 
enregistrés sur un magnétophone numérique 
8 pistes.

Exemple de chemins multicanaux

L'assignation des signaux est un élément-clef de 
toute session Surround Pro Tools. Elle se 
configure et se définit dans la boîte de dialogue 
I/O Setup.

Exemple de chemins de sortie

La Figure 35 illustre les chemins de sorties 
définis dans la boîte de dialogue I/O Setup d'un 
exemple de session créée sur un système 
Pro Tools|HD avec une interface audio 192 I/O.

Les sous-chemins ont été définis pour les 
chemins de sortie principaux Mix, Music et FX. 

D'autres chemins de sortie stéréo, comportant 
des sous-chemins mono, ont également été 
définis pour les canaux restants. 

Figure 35.  Paramètres d'I/O, exemple de chemins de 
sortie
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Exemple de chemins de bus

La Figure 36 affiche des exemples de chemins 
de bus.

Deux chemins principaux au format 5.1 ont été 
définis (Music et FX), chacun d'eux comportant 
plusieurs sous-chemins.

Exemple de sous-chemins

Les sous-chemins permettent d'effectuer 
l'assignation vers les canaux de votre choix dans 
la sortie Surround multicanal. Dans la Figure 37, 
le bus Mix 5.1 est doté de plusieurs sous-
chemins illustrant cette propriété. 

Sous-chemins au format 5.0 : le bus FX 5.0 est 
un sous-chemin à 5 canaux. Vous pouvez 
utiliser ce type d'assignation vers des sous-
chemins pour économiser les ressources de 
mixage avec les pistes que vous êtes certain de 
vouloir laisser hors du canal LFE. 

Chemin LFE : un sous-chemin LFE personnalisé 
a été ajouté pour fournir un chemin mono 
séparé au canal LFE. 

Exemples d'acheminement du 
signal

L'illustration ci-dessous montre plusieurs 
possibilités d'utilisation du chemin principal et 
des sous-chemins dans un exemple de session 
composée d'un mixage principal au format 5.1 
et de prémixages de la musique et des effets. 

Exemples de prémixages

La Figure 38 représente une configuration 
d'acheminement pour un prémixage d'effets. 

Figure 36.  Paramètres d'I/O, exemple de chemins de 
sortie

Figure 37.  Paramètres d'I/O, exemple de sous-chemins
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Certaines pistes sont envoyées vers des sous-chemins stéréo, tandis que d'autres sont affectées à des 
sous-chemins mono, LCR ou autres. Deux pistes (une stéréo, une mono) sont assignées à des bus 
multicanaux, pour bénéficier du panoramique Surround. Une entrée auxiliaire 5.1, affectée au 
chemin de bus FX principal, sert de prémixeur. 

Figure 38.  Prémixage d'effets (FX)
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La Figure 39 présente une configuration d'acheminement pour les pistes musicales.

Dans cet exemple, la plupart des pistes musicales sont envoyées vers les canaux avant gauche/droit au 
moyen d'un sous-chemin stéréo. Une entrée auxiliaire 5.1 contrôle la sortie du bus et celle du 
prémixage. 

Figure 39.  Prémixage musical
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Exemple de prémixages principaux

Dans la Figure 40, les deux canaux d'entrée auxiliaires peuvent faire l'objet d'affectations multiples 
vers d'autres chemins au format 5.1 pour un mixage principal. 

Les affectations de sorties multiples permettent 
de configurer un certain nombre de mixages 
multiformat. Par exemple, vous pouvez affecter 
une sortie stéréo supplémentaire aux pistes et 
créer un mixage stéréo en même temps qu'un 
mixage au format 5.1. Pour plus d'informations, 
reportez-vous à la section Assignations de sorties 
multiples, page 582.

Exemples LFE

Les pistes LFE et d'autres données audio peuvent 
être collectées à la sortie LFE de deux manières :

• Au moyen du curseur LFE dans les fenêtres de 
sortie. Ce signal LFE est prélevé après fader. 

– ou –

• Au moyen d'un sous-chemin personnalisé 
pour acheminer séparément les signaux des 
voies.

La Figure 41 suivante montre une fenêtre de 
sortie de canal, qui gère les envois et affiche le 
niveau sur le canal LFE. 

Figure 40.  Prémixages principaux

Figure 41.  Envoi vers le canal LFE depuis une sortie 
stéréo

Fader LFE Vumètre LFE auxiliaire
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Le fader LFE permet d'ajouter à la sortie LFE 
globale, à tout niveau, les signaux présents sur 
n'importe quel chemin multicanal. Dans 
l'exemple ci-dessus, le pourcentage alloué au 
centre de la piste a été désactivé, et le fader LFE 
a été levé pour acheminer le signal vers le 
canal LFE. 

La Figure 42 suivante montre comment 
acheminer une piste LFE « dédiée » uniquement 
vers le canal LFE. Cet exemple fait appel à un 
sous-chemin LFE personnalisé pour 
l'acheminement vers le chemin du bus FX 
principal. 

LFE et filtrage

Pro Tools n'applique aucun filtrage aux signaux 
LFE. Dans certaines cas, le format requiert un 
filtrage sur le piste LFE. Pour plus 
d'informations, reportez-vous à la section 
Formats de mixage et Surround, page 699. 

Figure 42.  Acheminement LFE séparé

Les faders LFE peuvent « suivre » les 
groupes de mixage et d'édition. Pour plus 
d'informations, reportez-vous à la section 
Préférences d'automation, page 644.

Pour obtenir des instructions sur la création 
d'un sous-chemin, voir Chemins 
multicanaux personnalisés, page 714. 
Guide de référence Pro Tools



Chapitre 32 : Panoramique et mixage 
en mode Surround (Pro Tools HD 
uniquement)

Ce chapitre explique comment effectuer des 
panoramiques et des mixages en mode 
Surround dans Pro  Tools.

Le mixage multicanal n'est pris en charge que 
dans Pro Tools|HD. Dans ce chapitre, toute 
référence à Pro Tools désigne les systèmes 
Pro Tools|HD. 

Avant de pouvoir régler un panoramique en 
Surround, vous devez affecter la piste en 
question à une sortie multicanal ou à un chemin 
de sortie adéquat. 

La boîte de dialogue I/O  Setup définit 
l'architecture de routage et de sortie de la 
console Surround multicanal de Pro Tools. 
Si vous ne l'avez pas encore fait, nous vous 
conseillons de vous familiariser avec les 
chemins principaux et les sous-chemins, ainsi 
qu'avec la boîte de dialogue I/O Setup avant de 
lancer des projets multicanaux dans Pro Tools. 

Introduction au panoramique 
Surround dans Pro Tools
Quatre méthodes différentes de panoramique 
sont disponibles : 

• dans la fenêtre Edit, à l'aide de la grille de 
panoramique de taille réduite, dans la vue 
des I/O ;

• dans la fenêtre Mix, à l'aide de la grille de 
panoramique de taille réduite ;

• dans la fenêtre Output, au moyen de la grille 
de panoramique plein écran ;

• par édition de l'automation de panoramique.

Pour plus d'informations sur les 
configurations multicanaux et les options 
de la boîte de dialogue I/O Setup, consultez 
le Chapitre 30, Configuration de 
Pro Tools pour le mixage en mode 
Surround (Pro Tools HD uniquement). En 
ce qui concerne l'assignation des signaux 
en multicanal, consultez le Chapitre 31, 
Pistes multicanaux et assignation des 
signaux (Pro Tools HD uniquement).
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Les surfaces de contrôle offrent d'autres options 
de panoramique. Pour plus d'informations sur 
les surfaces de contrôle, consultez la 
documentation de la vôtre. 

Grilles de panoramique des 
fenêtres Mix et Edit

Dans les fenêtres Mix et Edit, les grilles de 
panoramique multicanaux apparaissent sur les 
pistes comportant des affectations de sorties 
multicanaux pour les pistes ou les départs. 

Pour effectuer un panoramique depuis la fenêtre 
Mix ou Edit :

1  Depuis la fenêtre Edit, assurez-vous que la vue 
I/O est affichée (View > Edit Window > I/O). Les 
grilles de panoramique sont systématiquement 
affichées dans les pistes de la fenêtre Mix 
prenant en charge le panoramique.

2  Lancez la lecture. 

3  Cliquez sur la grille de panoramique de la piste 
multicanal appropriée dans la fenêtre Mix ou 
Edit, puis faites-la glisser. 

Le curseur de position du panoramique suit vos 
mouvements tant que vous maintenez le 
bouton de la souris enfoncé. La gestion des 
mouvements est telle qu'une fois que vous avez 
cliqué pour « saisir » le curseur de position du 
panoramique, les mouvements ne sont pas 
limités à la zone réduite allouée à la grille dans la 
piste. 

Couleur du curseur de position du panoramique 
lors de l'automation

Le curseur de position du panoramique est vert 
en mode Automation Read (lecture), rouge en 
mode Automation Write (écriture) et jaune en 
mode Automation Off (désactivation de 
l'automation) ou Automation Suspend 
(interruption de l'automation). 

En mode Trim, le fader de volume et le fader LFE 
sont en jaune.

Les fenêtres de sortie offrent d'autres fonctions 
et contrôles (ainsi qu'une grille beaucoup plus 
grande). Pour en savoir plus, reportez-vous à la 
section Fenêtre Output, page 736. 

Fenêtre Output
Les fenêtres de sortie (Output) offrent des 
commandes de panoramique (appelées 
panoramiques), ainsi que les commandes 
Pro Tools standard, dans tous les formats de 
mixage (du format LCR 3 canaux jusqu'au 
format 7.1 8 canaux). 

Reportez-vous à la section Commandes 
standard, page 737 pour obtenir davantage 
d'informations sur les commandes standard de 
la fenêtre Output. Reportez-vous à la section 
Commandes de panoramique Surround, 
page 738 pour obtenir davantage 
d'informations sur les commandes de 
panoramique de la fenêtre Output.Panoramique dans la grille des pistes

Cliquez et faites glisser 
pour faire un panoramique
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Les fenêtres Output fournissent notamment les 
fonctionnalités suivantes :

• Panoramique X/Y (mode joystick)

• Panoramique à trois boutons

• Contrôle de divergence intégrale et de 
pourcentage de centrage

• Envoi au LFE,

• Vumètres multicanaux

• Prise en charge de la fenêtre cible de 
Pro Tools

Il est possible d'ouvrir simultanément plusieurs 
panoramiques ou d'afficher le panoramique en 
cours dans une seule fenêtre.

Pour ouvrir une fenêtre Output :

■ Cliquez sur le bouton Output Window de la 
piste dans la fenêtre Mix ou Edit (vue I/O).

Commandes standard
Toutes les fenêtres Output offrent des 
commandes standard Pro  Tools pour 
l'acheminement, l'affectation des chemins et 
d'autres fonctions applicables aux pistes. Ces 
commandes se trouvent au-dessus de toutes les 
fenêtres Ouput, Send, Insert et Plug-in. 
Certaines commandes sont propres à certains 
types de fenêtre.

Fader de piste, Solo, Mute et Auto

Toutes les fenêtres Output sont dotées de 
commandes de volume et de coupure (Mute). 
Vous pouvez ainsi régler, automatiser ou couper 
directement le volume des pistes. Le grand fader 
et le bouton Mute sont équivalents à ceux de la 
fenêtre Mix de Pro Tools. 

Ouverture d'une fenêtre Output multicanal

Pour obtenir des instructions sur la gestion 
de fenêtres Output multiples, reportez-vous 
à la section Fenêtres Output pour les 
pistes et les départs, page 590.

Zone de contrôle du panoramique

Pour plus de détails ces fonctions standard, 
consultez la section Commandes de 
sélecteur standard dans les fenêtres 
Output, page 592

Sélecteur de 
piste

Sélecteur de 
sortie

Sélecteur de 
chemin Icône Target

Affichage des vumètres

Bouton Safe
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Commandes de panoramique Surround
Quand elle est affectée à des pistes ou à des chemins, la fenêtre Output offre une grille X/Y pour les 
panoramiques surround. Les haut-parleurs associés au format multicanal du panoramique sont 
représentés, dans leur position respective, à l'extérieur de la grille de panoramique. Ces haut-parleurs 
font également office de commandes Snap Pan to Speaker.

Cette section décrit toutes les commandes et fonctions des panoramiques multicanaux de Pro Tools. 

Figure 43.  Fenêtre Output avec un panoramique multicanal au format 5.1

Grille X/Y

Fader LFE

Fader et vumètre de 
la piste

Position 
(boutons de panoramique)

Divergence

Curseur de 
position du 
panoramique

Bouton du mode panoramique

Automation des 

pistes Solo et 

Mute

Pourcentage de centrage

Cliquez ici pour activer 
les vumètres

Icônes Snap Pan to Speaker
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Grille X/Y et curseur de position 
du panoramique

La grille X/Y permet de saisir et d'afficher les 
informations de panoramique multicanal. Vous 
pouvez également entrer des informations de 
panoramique en utilisant le mode X/Y, le mode 
trois boutons ou en saisissant des valeurs 
numériques dans les champs de données 
Position, comme décrit plus bas. Vous pouvez 
aussi modifier graphiquement l'automation de 
panoramique dans la fenêtre Edit.

Par défaut, les panoramiques multicanaux 
s'effectuent en mode X/Y. Dans ce mode, la 
position actuelle du panoramique de la piste est 
représentée par un point de couleur verte. Ce 
point est le curseur de position du 
panoramique ; il indique l'état de l'automation 
des pistes par les couleurs Pro Tools standard : 

Vert : la piste est en mode Automation Read.

Rouge : la piste fonctionne en mode 
Automation Write, Touch ou Latch.

Jaune : la piste est en mode Automation Off (ou 
Automation Suspend).

Bouton du mode panoramique

Ce bouton, permet d'accéder aux modes de 
panoramique Surround. Reportez-vous à la 
section Modes de panoramique, page 741. 

Commandes Position

Les commandes Position permettent de définir 
les positions des panoramiques.

Front : affiche et contrôle le panoramique sur 
l'axe horizontal avant (X) (gauche/droite). 

Rear : affiche et contrôle le panoramique sur 
l'axe horizontal arrière (X) (gauche/droite). 
En mode de panoramique X/Y par défaut, les 
positions avant et arrière sont solidaires et ne 
peuvent être contrôlées indépendamment. 

F/R (Front/Rear) : affiche et contrôle le 
panoramique sur l'axe Y. 

Commande Center %

Cette commande permet de contrôler le 
pourcentage du signal envoyé au haut-parleur 
central. Vous pouvez ainsi panoramiser une 
piste vers l'avant avec un centre fantôme (valeur 
Center de 0 %) ou en l'envoyant sur les trois 
canaux frontaux (LCR) lorsque vous êtes en 
mode panoramique. 

Grille X/Y et curseur de position du panoramique

Grille X/Y

Curseur de 
position du 
panoramique

Bouton du mode panoramique configuré en mode X/Y

Commandes Position et Center %

Icône du mode X/Y
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Commandes de divergence

La divergence détermine la largeur du signal 
panoramique au niveau des haut-parleurs 
adjacents (pour en savoir plus, reportez-vous à 
Divergence, page 706). Il existe trois 
commandes de divergence.

Divergence avant, arrière et AV/AR : permettent 
de contrôler la divergence séparément, 
automatiquement pour les haut-parleurs avant, 
arrière et entre l'avant et l'arrière, 
respectivement.

Icônes Snap Pan to Speaker

Ces icônes permettent de faire correspondre le 
panoramique à l'emplacement d'un haut-
parleur. Le fait de cliquer, par exemple, sur le 
haut-parleur supérieur gauche déplace le curseur 
de position du panoramique dans le coin 
supérieur gauche de la grille X/Y.

Fader LFE

Le fader LFE n'est disponible que dans les 
formats surround « .1 », à savoir 5.1, 6,1 et 7,1. 

Le fader LFE détermine, pour la piste active, le 
niveau de signal envoyé vers le canal LFE. Les 
faders LFE des fenêtres Track et Send peuvent 
suivre des groupes. Le canal LFE de Pro Tools 
fonctionne toujours à pleine bande passante. 
Pour plus d'informations sur l'utilisation du 
fader LFE, reportez-vous à la section Faders LFE 
dans les panoramiques multicanaux, page 747.

Commandes de divergence

Pour voir des exemples des répercussions des 
réglages de divergence sur les 
panoramiques en sortie, reportez-vous à 
la section Divergence et pourcentage de 
centrage, page 745.

Fader LFE
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Modes de panoramique
Le bouton du mode de panoramique donne 
accès à quatre modes de panoramique : X/Y, 
Edition de divergence, Panoramique à trois 
boutons et glissement automatique.

Modes de panoramique

Mode X/Y : pour effectuer un panoramique de 
style joystick, faites glisser le curseur de position 
du panoramique dans la grille de haut-parleur 
X/Y. Pour plus d'informations, reportez-vous à 
la section Panoramique X/Y, page 741. Il est 
possible d'automatiser le mode X/Y.

Panoramique à trois boutons : panoramique de 
point à point, entre paires de haut-parleurs. 
Pour plus d'informations, reportez-vous à la 
section Panoramique à trois boutons, page 742. 
Il est possible d'automatiser le mode de 
panoramique à trois boutons.

Edition de divergence : faites glisser les bords de 
la divergence dans la grille X/Y de divergence 
pour les redimensionner. Il est possible 
d'automatiser le mode d'édition de divergence.

Mode de glissement automatique : panoramique 
de point à point entre le curseur de position du 
panoramique et la nouvelle destination en 
fonction de la durée de glissement automatique 
spécifiée. Pour plus d'informations, reportez-
vous à la section Mode de glissement 
automatique, page 744.

Pour activer un mode de panoramique :

■ Cliquez sur le bouton du mode de 
panoramique dans le panoramique Surround 
autant de fois que nécessaire pour afficher 
l'icône du mode désiré.

Panoramique X/Y

Pour effectuer un panoramique en mode X/Y :

1  Cliquez sur le bouton du mode de 
panoramique afin d'afficher l'icône du 
mode X/Y.

2  Faites glisser le curseur de position du 
panoramique ou cliquez n'importe où dans la 
grille, puis faites glisser le curseur pour 
panoramiser le signal de la piste. L'emplacement 
du curseur de position du panoramique 
détermine la position du signal. Pour envoyer, 
par exemple, un son vers le haut-parleur arrière 
gauche, déplacez le curseur de position du 
panoramique vers l'angle inférieur gauche. 

Bouton du mode de panoramique (mode X/Y affiché)

Bouton du mode de panoramique

Bouton du mode de panoramique configuré en 
mode X/Y

Icône du mode X/Y
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Pour positionner le curseur de position du 
panoramique à un emplacement particulier de la 
grille :

■ Maintenez la touche Ctrl enfoncée pendant 
que vous cliquez sur un point quelconque de la 
grille X/Y. 

Options et raccourcis de la grille

Mode de réglage précis : maintenez la touche 
Ctrl (Windows) ou Pomme (Macintosh) 
enfoncée pour effectuer un réglage précis de 
toutes les commandes de panoramique. 

Restriction du déplacement à l'axe X ou Y : 

faites glisser le curseur de position du 
panoramique en maintenant enfoncée la touche 
Maj pour restreindre son mouvement sur l'axe X 
ou Y.

Remise au statut par défaut : maintenez la 
touche Alt (Windows) ou Option (Macintosh) 
enfoncée pendant que vous cliquez dans la grille 
de panoramique pour initialiser tous les 
paramètres à leur valeur par défaut. 

Snap Pan to Speaker : cliquez sur une des icônes 
Snap Pan to Speaker pour faire correspondre le 
panoramique à l'emplacement de cet haut-
parleur. 

Affichage des données d'automation dans la 
fenêtre Edit : maintenez les touches Démarrer 
(Windows) ou Pomme + Contrôle (Macintosh) 
enfoncées pendant que vous cliquez sur une 
commande pour afficher la playlist lui 
correspondant dans la fenêtre Edit.

Panoramique à trois boutons

Pro Tools offre aussi un mode trois boutons 
pour entrer des déplacements de panoramique. 

Le mode trois boutons permet d'effectuer :

• des panoramiques en ligne droite, en 
déplaçant le curseur de position du 
panoramique au moyen des boutons rotatifs 
Front, Rear et Front/Rear ; 

– et –

• des panoramiques séparés entre des paires de 
haut-parleurs.

Le mode trois boutons permet d'effectuer des 
panoramiques « discrets » entre enceintes. 
Par exemple, lorsque vous effectuez un 
panoramique de l'avant gauche vers l'arrière 

Il n'est pas nécessaire de cliquer exactement 
sur le curseur de position du panoramique. 
Si vous cliquez à un endroit quelconque de 
la grille, le curseur se déplace par rapport à 
cet emplacement ou un panoramique 
matériel est activé. Le panoramique ne vient 
pas se placer au niveau du point où vous 
avez cliqué. 

Panoramique X/Y

Il est possible d'automatiser tous les 
paramètres de panoramique, y compris la 
position et la divergence. Pour plus 
d'informations, reportez-vous au 
Chapitre 27, L'automation. 
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droite en mode trois boutons, le son ne sera 
audible que sur ces deux haut-parleurs (en 
partant du principe que la divergence intégrale 
est activée). 

En comparaison, si vous effectuez un 
panoramique en mode X/Y, le son peut être 
audible sur certains canaux ou sur tous pendant 
le déplacement du son. 

Le mode trois boutons effectue un panoramique 
« discret » « ponctuel » entre les positions avant 
et arrière de la trajectoire, tandis que le 
panoramique en mode X/Y s'effectue en 
couvrant les 360° de la grille de panoramique. 
Les options Divergence et Center Percentage 
(Center %) sont variables dans les deux modes. 

Pour activer le mode panoramique trois boutons :

■ Cliquez sur le bouton du mode de 
panoramique à trois boutons afin d'afficher 
l'icône du mode correspondant.

La ligne de la trajectoire s'affiche dans la grille, 
de l'avant (axe X) vers l'arrière (axe Y).

Pour effectuer un panoramique en mode trois 
boutons :

1  Réglez les boutons de position avant (Front) et 
arrière (Rear) pour définir la trajectoire. 

2  Faites tourner le bouton de position 
avant/arrière (Front/Rear) pour effectuer le 
panoramique le long de la trajectoire. Le curseur 
de position du panoramique est contraint à 
suivre la trajectoire correspondant à la ligne 
blanche. 

Pour modifier les angles de la trajectoire en mode 
trois boutons :

■ Faites glisser l'un des points d'extrémité 
(avant ou arrière) de la trajectoire. 

– ou –

■ Réglez les commandes de position avant 
(Front) ou arrière (Rear). 

Panoramique et vumètres en mode trois boutons

Panoramique et vumètre en mode X/Y

Trajectoire en 
mode trois 
boutons

Mode trois boutons

Vumètres

Position du 
panoramique X/Y

Vumètres

Mode X/Y

Bouton du mode de panoramique configuré en mode à 
trois boutons

Icône du mode de panoramique à trois boutons
Chapitre 32 : Panoramique et mixage en mode Surround (Pro Tools HD uniquement) 743



744
Pour modifier la trajectoire actuelle (de gauche à 
droite) en conservant les angles actuels :

■ Faites glisser la ligne de trajectoire (pas ses 
extrémités) sur une nouvelle position. 

Mode de glissement automatique

Le mode de glissement automatique permet 
d'écrire rapidement des données d'automation 
de panoramique Surround en cliquant aux 
emplacements voulus dans la fenêtre Surround 
Panner, au lieu de déplacer manuellement les 
commandes de panoramique Surround.

Le délai nécessaire pour passer d'un point à 
l'autre (du curseur de position du panoramique 
à la nouvelle destination) est appelé la durée de 
glissement automatique. Cette durée est définie 
dans la page Automation Preferences et peut 
être comprise entre 1 msec et 10 000 msec 
(10 secondes).

Pour définir la durée de glissement automatique

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Automation.

2  Définissez la durée de glissement automatique 
(AutoGlide Time).

Pour effectuer un passe d'automation AutoGlide :

1  Cliquez sur le bouton du mode de 
panoramique afin d'afficher l'icône du mode de 
glissement automatique.

Le bouton du mode de panoramique présente 
une ligne inclinée en pointillés se terminant par 
un point uni (représentant un curseur) dans 
l'angle supérieur droit.

2  Dans la fenêtre Mix ou Edit, cliquez sur le 
sélecteur du mode d'automation et sélectionnez 
un mode d'automation pour la piste que vous 
souhaitez automatiser.

3  Appuyez sur Play pour commencer la lecture.

4  Définissez une nouvelle destination pour le 
curseur en procédant de l'une des façons 
suivantes :

• Cliquez sur une icône Snap Pan to Speaker 
pour effectuer un glissement vers 
l'emplacement de son haut-parleur.

– ou –

• Cliquez à l'intérieur de la fenêtre de 
panoramique pour effectuer un glissement 
vers un emplacement spécifique dans la 
grille X/Y.

Lorsque vous écrivez des données 
d'automation en mode de glissement 
automatique, il n'est pas possible de faire 
glisser le curseur de position du 
panoramique.

Bouton du mode de panoramique configuré en mode de 
glissement automatique

Icône du mode de glissement automatique
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Le curseur de position du panoramique 
commencera à se déplacer vers la nouvelle 
destination à une vitesse correspondante à la 
durée de glissement automatique. Dès que le 
nouveau point de destination est atteint, le 
programme génère un nouveau point 
d'inflexion au nouvel emplacement.

5  Pour définir des déplacements panoramiques 
supplémentaires, recommencez l'étape 
précédente.

6  Arrêtez le transport lorsque vous avez terminé.

Divergence et pourcentage de 
centrage
La valeur des paramètres Divergence et Center 
Percentage (Center %), qu'il est possible 
d'automatiser, peut varier de 0 à 100. Ces 
commandes sont particulièrement utiles pour 
assurer une couverture sonore homogène, 
notamment dans les salles de grande taille et 
pour améliorer la clarté des voix. 

Divergence frontale : contrôle la divergence 
entre les haut-parleurs avant (axe X 
uniquement). 

Divergence arrière : contrôle la divergence entre 
les haut-parleurs arrière (axe X uniquement).

Divergence avant/arrière : contrôle la 
divergence entre l'avant et l'arrière (axe Y).

% de centrage (pourcentage) : détermine s'il 
existe une image centrale séparée, une image 
centrale entièrement fantôme ou une valeur 
variable comprise entre les deux. 

Divergence

Dans la grille de panoramique, les valeurs de 
divergence actuelles sont représentées par un 
contour violet. 

Bouton du mode panoramique (mode de glissement 
automatique affiché)

Mode de glissement automatique

Icônes Snap 
Pan to 
Speaker

Curseur de 
position du 
panoramique

Affichage et contrôles de divergence

Affichage de la divergence

Commandes de divergence
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Par défaut, les panoramiques Surround de Pro  
Tools sont divergents à 100 % ; autrement dit, 
un signal panoramiqué sur une seule enceinte 
ne sera audible que sur celle-ci. 

Une divergence inférieure se traduit par un 
signal source qui s'élargit progressivement. 
Lorsque la divergence est inférieure à 100 %, 
les pistes sont envoyées vers les haut-parleurs 
adjacents dans une certaine mesure, même 
lorsque le curseur de position du panoramique 
se trouve près d'une seule icône de haut-parleur. 

Pour régler la divergence :

■ Réglez les contrôles de divergence frontal, 
arrière et avant-arrière conformément à vos 
besoins. 

Pour régler la divergence en mode graphique :

1  Cliquez sur le bouton du mode de 
panoramique afin d'afficher l'icône du mode 
d'édition de divergence.

2  Faites glisser les bords de la divergence dans la 
grille pour les redimensionner. 

% de centrage (pourcentage)

Les commandes Center Percentage déterminent 
s'il existe un canal central séparé pour la piste, 
ou bien s'il s'agit d'un canal central fantôme. 

Exemple de pourcentage de centre

En production film et vidéo, le canal central 
contient souvent les dialogues. Pour améliorer 
la clarté et l'intelligibilité de la boîte de dialogue, 
il est souvent bénéfique de laisser les autres 
éléments (tels que la musique) hors du haut-
parleur central. En réduisant le pourcentage de 
centrage sur les pistes musicales (dans cet 
exemple), la musique sur laquelle est réglée un 
panoramique vers l'avant du champ peut être 
envoyée uniquement vers les haut-parleurs 
gauche et droit, créant ainsi une image centrale 
fantôme.

Divergence complète pour un panoramique discret vers 
l'avant gauche (les vumètres n'indiquent la présence 
d'un signal que sur le canal avant gauche).

La divergence frontale à 0 % offre le panoramique le 
plus large (notez les vumètres indiquant la présence 
d'un signal sur les trois haut-parleurs frontaux).

Vumètres

Curseur de 
position du 
panoramique

Vumètres

Divergence
frontale

Curseur de 
position du 
panoramique

Bouton du mode de panoramique configuré en mode 
d'édition de divergence

Icône du mode d'édition de divergence
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Pour régler le pourcentage de centrage :

■ Réglez le potentiomètre Center Percentage sur 
la position adéquate. 

Plus vous réduisez la valeur du bouton Center 
Percentage, plus l'icône centrale de haut-parleur 
située en haut de la grille s'estompe. Pour une 
valeur de 0, elle est complètement invisible, 
reflétant ainsi le réglage du centre entièrement 
fantôme.

Faders LFE dans les 
panoramiques multicanaux
Les commandes de fader LFE gèrent le niveau du 
signal prélevé sur la piste pour être envoyé au 
canal LFE. Les faders LFE ne sont disponibles 
que lorsqu'une piste est affectée à un chemin 
dont le format implique l'existence d'un LFE 
(5.1, 6.1 ou 7.1). 

Pour envoyer le signal sur le canal LFE :

■ Ajustez le fader LFE dans une fenêtre Output 
au format surround « .1 ». 

LFE et groupes

Les faders LFE de piste et de départ peuvent 
suivre les groupes Mix et Edit en activant cette 
fonctionnalité dans la page Automation 
Preferences. Pour plus d'informations, reportez-
vous à la section Préférences d'automation, 
page 644. 

Centre discret (Center % de valeur 100)

Centre fantôme (Center % de valeur 0)

Haut-parleur central moins visible

Curseur de position 
du panoramique

Vumètres

Pourcentage de 
centrage

Vumètres

Pourcentage de 
centrage

Curseur de position 
du panoramique

Pour plus d'informations sur le LFE, les 
canaux Sub et les sujets connexes, consultez 
le Chapitre 29, Notions relatives au 
format Surround (Pro Tools HD 
uniquement).

Paramètre par défaut LFEs Follow Groups

Paramètre par 
défaut LFE 
Follow Groups
Chapitre 32 : Panoramique et mixage en mode Surround (Pro Tools HD uniquement) 747



748
Bouton LFE Enable

Certains plug-in multicanaux, notamment le 
compresseur multicanal DigiRack, intègrent une 
fonction d'activation de fader LFE. Ceci permet 
d'activer ou de désactiver les traitement du canal 
LFE, s'il y en a un. 

Pour traiter le canal LFE dans un plug-in 
multicanal :

■ Activez la fonction LFE Enable, si le plug-in 
multicanal la prend en charge. LFE Enable 
apparaît en surbrillance lorsque vous l'activez, et 
en mode normal lorsque vous désactivez le LFE 
lors du traitement.

Playlists
Les panoramiques multicanaux comportent un 
playlist d'automation pour chaque commande 
de position et de divergence. 

Le panoramique ne suit pas les groupes.

A la différence de l'édition des points d'inflexion 
de coupure et de volume, l'automation de 
panoramique ne suit pas les groupes d'édition 
par défaut. Pour forcer l'édition de l'automation 
de panoramique à suivre les groupes, il faut 
maintenir la touche Démarrer (Windows) ou 

Ctrl (Macintosh) enfoncée pendant que vous 
éditez les points d'inflexion d'automation sur 
une piste membre d'un groupe. Cette 
fonctionnalité s'applique aux sept types de 
contrôle de panoramique (avant, arrière, avant-
arrière, divergence frontale, divergence arrière, 
divergence avant-arrière et pourcentage de 
centre). 

Plug-in SurroundScope 
Metering
Le plug-in SurroundScope Metering fournit un 
vumètre sur 360° pour l'affichage des chemins 
multicanaux au cours du mixage.

Disposition des pistes du format 5.1

Tous les vumètres au format 5.1 affichés (y 
compris ceux du vumètre SurroundScope, sur les 
pistes et dans les fenêtres Output et leurs vues du 
vumètre du chemin) apparaissent toujours dans 
l'ordre suivant :

L C R Ls Rs LFE

Pour utiliser le plug-in SurroundScope Metering :

■ Sur une piste de fader principal, cliquez sur un 
bouton Insert et sélectionnez le vumètre 
multicanal SurroundScope.

LFE Enable dans le compresseur multicanal

Si la fonction d'activation de fader LFE n'est 
pas disponible, essayez d'utiliser la version 
multimono du plug-in.

L'automation de panoramique peut être 
représentée, modifiée, coupée, copiée et 
collée à partir de la fenêtre Edit. Pour plus 
d'informations, consultez le Chapitre 27, 
L'automation.

Pour plus d'informations sur la 
visualisation dans Pro Tools, reportez-vous 
à la section Pistes, format, affectation et 
mesures du format 5.1, page 716. 
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SurroundScope ne comporte aucune commande 
réglable, mais il affiche les niveaux de sortie à la 
fois sur une grille couvrant 360° et à l'aide de 
points lumineux (voyants) classiques. 

Plug-in de vumètre SurroundScope

Reportez-vous au guide des plug-in 
Digidesign pour plus d'informations sur le 
SurroundScope.
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Chapitre 33 : Notions de 
synchronisation

Cette section présente les éléments de base de la 
synchronisation depuis Pro Tools.

Si vous utilisez un appareil qui reçoit ou émet un 
timecode (par exemple un magnétoscope ou 
une interface MIDI), reportez-vous à la 
documentation qui l'accompagne pour obtenir 
des informations sur la génération ou la 
réception de ce code et la configuration des 
options associées.

Configuration requise pour la 
synchronisation
La compatibilité et les conditions de 
synchronisation varient entre les divers 
systèmes matériels Pro Tools. C'est pourquoi 
nous avons signalé dans ce guide les fonctions 
qui requièrent un périphérique de 
synchronisation, tel que Digidesign SYNC I/O 
ou équivalent. Reportez-vous aux guides fournis 
avec ces périphériques pour obtenir des 
informations sur l'installation et la 
configuration. 

Il est vivement conseillé d'identifier la 
configuration requise pour la synchronisation 
dans votre environnement. Par exemple, si vous 
exécutez des travaux de post-production audio 
pour des documents vidéo sur Pro Tools, 
consultez l'ingénieur ou le monteur vidéo pour 

connaître le format de timecode qui sera utilisé. 
De plus, d'autres facteurs liés au timecode 
peuvent avoir une incidence sur la façon 
d'utiliser la synchronisation (et notamment le 
mode pull down). Votre revendeur Digidesign 
peut vous donner des conseils sur l'utilisation de 
la synchronisation dans votre studio.

Périphériques de synchronisation

Les périphériques de synchronisation sont des 
plus divers et vont des plus simples (interfaces 
MIDI compatibles MTC), aux plus complexes 
(dispositifs de synchronisation timecode de 
haute précision, capables de prendre en charge 
les nombreux formats timecode et d'horloges 
professionnels utilisés en musique, pour la 
télévision et le cinéma). 

Bien que de nombreux appareils soient capables 
d'assurer la synchronisation, seuls les 
périphériques SYNC I/O et USD de Digidesign 
offrent une précision à l'image près pour la 
synchronisation de systèmes Pro Tools HD avec 
des sources de timecode externes.
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Aspects de la synchronisation
La synchronisation sur station de travail 
audionumérique englobe deux concepts à 
traiter indépendamment :

◆ « Où sommes-nous ? » ; c'est ce qu'on appelle 
la référence de position. 

◆ « Quelle est notre vitesse ? » ; c'est ce qu'on 
appelle la référence d'horloge.

Pour synchroniser un système Pro Tools avec un 
autre appareil (magnétophone à bande, 
magnétoscope...), avec précision et pendant une 
longue durée, vous devez indiquer à Pro Tools 
l'emplacement du périphérique et la vitesse à 
laquelle il tourne. Certains appareils fournissent 
une seule de ces références : par exemple, un 
générateur de black burst fournit uniquement 
une référence d'horloge. D'autres, tels que le 
périphérique SYNC I/O de Digidesign, 
fournissent les deux. 

Synchronisation de Pro Tools
Outre le timecode, les systèmes Pro Tools|HD 
requièrent une référence d'horloge, pour 
conserver le niveau de synchronisation correct, 
une fois qu'il a été atteint. Par ailleurs, les 
transferts (enregistrements) entre appareils 
numériques doivent être effectués avec une 
source d'horloge référencée. 

Il est possible d'asservir le système Pro Tools à 
une référence d'horloge externe sans pour 
autant synchroniser le système à une référence 
de position. Vous pouvez, par exemple, utiliser 
n'importe quelle interface audio Pro Tools|HD 
pour référencer l'horloge d'échantillonnage 
Pro Tools à un signal numérique entrant (S/PDIF 
ou Word Clock, par exemple) sans synchroniser 
Pro Tools sur un timecode externe. 

Dans l'exemple suivant, Pro Tools utilise la 
valeur de timecode pour calculer les 
informations de position, et se sert de la 
référence d'horloge pour conserver la 
synchronisation. Pro Tools est asservi à un 
magnétoscope par l'intermédiaire de l'interface 
SYNC I/O ou USD, Pro Tools et le magnétoscope 
étant référencés à la même source de référence 
vidéo (signal de référence).

Exemple : Pro Tools est asservi à un 
magnétoscope, via un périphérique SYNC I/O 
ou USD

Dans cet exemple, le signal de référence est 
transmis au périphérique SYNC I/O, qui 
transmet le signal maître Loop Sync au système 
Pro Tools|HD via une interface audio 
Pro Tools|HD. Le signal de référence est 
également transmis au magnétoscope.

1  Au démarrage de la bande vidéo, le timecode 
(au format LTC ou VITC) est lu sur la bande, 
puis envoyé à l'interface SYNC I/O ou USD. 
Le périphérique SYNC I/O (ou USD) lit la 
position du timecode et transmet en continu les 
informations de référence de position par le biais 
de la connexion série SYNC I/O à la carte 
Pro Tools.

2  A partir de la première adresse de timecode 
reçue, Pro Tools calcule l'emplacement de 
l'échantillon correspondant à cette adresse dans 
la session. Il soit possible d'utiliser Pro Tools 
avec n'importe quel format de timecode 
standard, car le système calcule les numéros 
d'échantillon en interne.
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3  En supposant que l'adresse de timecode 
correspond effectivement à un numéro 
d'échantillon de la session Pro Tools, le système 
effectue la conversion et lance la lecture depuis 
ce point correspondant au numéro 
d'échantillon. Le point de départ de la lecture est 
appelé point de déclenchement. Pro Tools et le 
magnétoscope utilisent ensuite la référence 
d'horloge pour se maintenir à la même vitesse.

4  Si, par la suite, la bande vidéo est arrêtée, 
rembobinée, puis relancée, le processus est 
répété, en fonction du nouveau point de 
déclenchement calculé. 

A propos des références de 
position

Le timecode désigne des informations de 
position dans un signal analogique ou un signal 
de flux de données numériques qui peuvent être 
enregistrées sur une bande magnétique sous 
forme de signal audio ou vidéo. Il peut servir de 
référence de position pour synchroniser la 
lecture et l'enregistrement de votre système 
Pro Tools avec le signal de timecode d'une autre 
machine, par exemple un enregistreur 
multipiste analogique à bande ou un 
magnétoscope.

Timecode SMPTE et ISO/EBU

La question « Où sommes-nous ? » fait référence 
à la position relative. De nombreux appareils et 
logiciels professionnels audio, vidéo et 
multimédia décrivent les positions à l'aide d'un 
timecode SMPTE (Society of Motion Picture & 
Television Engineers). En Europe, c'est le 
timecode au standard ISO (International 
Standards Organization), précédemment appelé 
EBU (European Broadcasters Union), qui est le 
plus répandu. Ces types de timecode sont 
presque identiques en terme de représentation 
électronique. Toutefois, le timecode ISO/EBU 

utilise une fréquence d'image de 25 i/s (images 
par seconde) tandis que le code SMPTE possède 
plusieurs variantes, débouchant sur des 
fréquences d'image différentes. Pour une 
meilleure compréhension, ce chapitre fait 
généralement référence aux informations 
temporelles mesurées en 
heures:minutes:secondes:images sous le nom de 
« timecode SMPTE ». Ce terme générique réunit 
les codes temporels ISO/EBU et SMPTE.

Différentes formes du timecode SMPTE

Il existe deux méthodes permettant d'enregistrer 
un timecode SMPTE sur une bande 
magnétique : le LTC (Linear Time Code) et VITC 
(Vertical Interval Time Code). Le code LTC est 
enregistré ou généré sur une piste audio ou une 
piste spécifique de l'appareil audio ou vidéo. Le 
code VITC s'enregistre à l'intérieur du signal 
vidéo, dans les « blancs » de chaque image 
vidéo. Comme il est impossible d'enregistrer le 
code VITC sur des pistes audio, il n'est pas utilisé 
dans les travaux sur magnétophone. Toutefois, 
il offre de puissantes fonctionnalités de la post-
production (notamment la stabilité de l'image et 
la lecture lente de l'adresse de timecode).

Certains appareils transmettent les 
informations temporelles sous une forme 
différente du SMPTE : le MTC (MIDI Time 
Code).

Unités de timecode SMPTE

Le timecode décrit les emplacements en termes 
d'heures, de minutes, de secondes, d'images et 
de sous-images (1/100e d'image). Si l'image est 
utilisée en tant qu'unité de mesure temporelle, 
c'est que le code SMPTE tire son origine des 
applications film et vidéo (voir également 
Résolution et fréquence d'image, page 756.) 
Selon la fréquence d'image, une image 
correspond à 1/24e, 1/25e, 1/29,97e ou 1/30e de 
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seconde. Par exemple, une valeur de 
« 01:12:27:15 » lue sur le compteur d'une 
machine vidéo indique une position d'une 
heure, douze minutes, vingt-sept secondes et 
quinze images. Toutefois, cette adresse 
temporelle seule ne donne aucune information 
sur la fréquence d'image.

Le code SMPTE enregistrant sur la bande une 
référence temporelle absolue sous forme de 
timecode, tout point de cette bande peut être 
identifié précisément par les appareils qui lisent 
le code. Une fois le timecode enregistré ou 
couché sur une bande, il fournit une référence de 
position permanente, qui permet au système 
Pro Tools d'associer la lecture d'un événement à 
un emplacement précis sur cette bande. 
Par exemple, grâce à la synchronisation du 
timecode, il est possible de faire retentir un coup 
de feu à l'instant précis où la balle s'échappant 
de l'arme produit un éclair à l'écran.

Résolution et fréquence d'image

Nous souhaitons, ici, attirer votre attention sur 
la différence entre la résolution et la fréquence 
d'image. 

La résolution (Frame Count) correspond au 
nombre d'images comptées par le timecode 
avant de passer à la seconde suivante. 
Les résolutions standard sont les suivantes :

La fréquence d'image correspond à la vitesse à 
laquelle le timecode avance d'une image à 
l'autre. Ainsi, lorsqu'une personne parle d'un 
timecode de 29,97 images, elle se réfère 
d'ordinaire à une résolution de 30 images, avec 
une fréquence d'image de 29,97 images par 
seconde. 

LTC (Longitudinal ou Linear Time 
Code)

Le timecode LTC est enregistré et lu ou généré 
sous forme d'un signal audio analogique. De 
nombreux magnétophones et magnétoscopes 
prennent en charge le format LTC. 

LTC et vitesse de lecture

Le code LTC peut être lu à des vitesses de bande 
élevées, ce qui permet aux dispositifs de lecture 
de timecode d'une machine spécifique de 
communiquer avec les synchroniseurs à des 
vitesses de retour ou d'avance rapide plus de 
50 fois supérieures à la vitesse de lecture 
(à condition que le magnétophone soit 
effectivement capable de lire le timecode à cette 
vitesse). En revanche, il est impossible de lire le 
code LTC à des vitesses de bande très faibles (par 
exemple, lorsque vous faites défiler la bande 
image par image) ou en mode pause. Pour lire le 
code LTC, le magnétoscope doit défiler à une 
vitesse minimale (généralement à environ 1/10e 
de la vitesse de lecture nominale) afin d'être en 
mesure d'interpréter l'adresse temporelle 
SMPTE.

Résolutions par fréquence d'image

Résolution i/s

images 0-23 24

images 0-24 25

images 0-29 30
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VITC (Vertical Interval Time Code)

Le code VITC est un type de timecode enregistré 
et lu sous forme de partie invisible d'un signal 
vidéo. Il est généralement répandu dans les 
applications professionnelles audio pour le 
cinéma et la vidéo. Le code VITC étant 
enregistré avec chaque image vidéo, il est 
indispensable de l'enregistrer en même temps 
que le signal vidéo : contrairement au code LTC, 
le code VITC ne peut pas être ajouté 
ultérieurement. En outre, ce code ne pouvant 
pas être enregistré sur des pistes audio, il n'est 
jamais utilisé pour synchroniser les 
magnétophones. Le code LTC est choisi de 
préférence pour les applications uniquement 
audio. 

VITC et vitesse de lecture

Le code VITC peut être lu lors du défilement à 
vitesse réduite d'un magnétoscope, ou de sa 
mise en pause. Pour cette raison, il est plus 
utilisé que le code LTC dans ce type de situation. 
Le recours au code VITC permet à Pro Tools de 
récupérer la position temporelle SMPTE actuelle 
sur le magnétoscope en mode pause ou 
défilement « image par image ». Toutefois, si 
vous utilisez des synchroniseurs de transport 
externe supplémentaires, sachez que la plupart 
des synchroniseurs ne peuvent pas lire le code 
VITC à des vitesses supérieures à 10 fois la 
vitesse de lecture ; la synchronisation des 
machines asservies est donc impossible à 
maintenir au cours de l'avance ou du retour 
rapide. 

Commutation automatique LTC/VITC

Un grand nombre de synchroniseurs et 
d'appareils prennent en charge la commutation 
automatique entre les codes LTC et VITC en 
fonction de la vitesse, afin de tirer le meilleur 
parti de chaque option (les unités SYNC I/O et 
USD sont toutes les deux compatibles avec la 
commutation automatique). Par exemple, le 
synchroniseur utilise le code VITC sur un 
magnétoscope en mode pause ou défilement 
image par image, mais passe automatiquement 
au code LTC en mode avance rapide.

Bi-Phase/Tach

Ce flux d'impulsions électroniques est utilisé par 
les enregistreurs sur film magnétique perforé, les 
tables de montage et les projecteurs 
cinématographiques. Si vous possédez un 
périphérique SYNC I/O (ou USD), vous pouvez 
utiliser ce format pour synchroniser Pro Tools. 
Contrairement au timecode, le format Bi-
Phase/Tach ne contient aucune information de 
position absolue. Il indique la vitesse (par la 
fréquence des pulsations), ainsi que le sens de 
défilement et donc également la position 
relative. Le périphérique SYNC I/O ayant la 
capacité de détecter la vitesse et le sens de 
défilement du flux de pulsations, il peut utiliser 
une source Bi-phase/Tach pour déduire les 
informations de position d'un « point 
d'adresse » initial. La différence entre les formats 
Bi-phase et Tach réside dans le fait que le 
premier code la vitesse et le sens de défilement 
sur une paire de signaux à l'aide d'un format dit 
« quadrature de phase », tandis que le second 
code la vitesse sur un signal et le sens de 
défilement sur un autre. Pour en savoir plus sur 
les formats Bi-Phase et Tach, consultez le Guide 
SYNC I/O.
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Formats d'image SMPTE
Il existe plusieurs formats de timecode SMPTE. 
Pro Tools peut se synchroniser avec tous les 
formats courants si vous utilisez un 
périphérique de synchronisation compatible. 

Pro Tools prend en charge les fréquences 
d'image SMPTE suivantes :

30Format 24 i/s

Il s'agit du format SMPTE original, développé 
pour la vidéo noir et blanc. Il est couramment 
utilisé dans les applications uniquement audio. 
Ce format est souvent appelé « 30 images non-
drop ».

30 ips, format d'image drop

Certains enregistrements de trames de film 
s'effectuent au format 30 i/s Drop Frame ; ainsi 
quand elles sont ralenties après le transfert de 
télécinéma, la fréquence descend à 29,97 i/s 
Drop Frame.

Format 29,97 i/s Non-Drop

Format utilisé pour la vidéo couleur NTSC. 
Sa fréquence est de 29,97 i/s.

Format 29,97 i/s Drop

Le format vidéo couleur NTSC possède, 
intrinsèquement, une fréquence d'image de 
29,97 ips. La lecture d'une heure d'images (soit 
108 000 images) à 29,97 i/s non-drop dure 
légèrement plus longtemps qu'une heure en 
temps réel. Ce phénomène rend le calcul de la 
durée réelle d'un programme relativement 
complexe en cas d'utilisation d'un timecode 
29,97 images Non-Drop. Un programme qui 
s'étend sur une heure, selon les adresses de 
timecode au format 29,97 images Non-Drop 
(par exemple de 1:00:00:00 à 2:00:00:00) dure 
en réalité 60 minutes, 3 secondes et 18 images.

Pour faciliter l'utilisation du timecode 29,97 i/s 
par les diffuseurs, le comité SMPTE a créé le 
timecode 29,97 images Drop Frame (DF), qui 
fonctionne exactement à la même vitesse que le 
timecode 29,97 images Non-Drop (NDF), mais 
compense la réduction de fréquence en 
« laissant tomber » (en omettant) deux images 
au début de chaque minute, excepté toutes les 
10ème minutes dans une heure. Ainsi, l'adresse 
de timecode 1:01:00:00 n'existe pas dans un 
timecode Drop Frame, car elle est ignorée.

De la sorte, à la fin d'un programme d'une durée 
précise d'une heure, d'après lecture des positions 
exprimées en timecode Drop Frame (par 
exemple de 1:00:00;00 à 2:00:00;00), il s'est 
écoulé exactement une heure. 

Ce concept peut sembler complexe, mais le 
timecode Drop Frame permet aux diffuseurs de 
s'appuyer sur les valeurs de timecode pour 
calculer la durée des programmes, ce qui facilite 
la précision de programmation.

Pour travailler avec des bandes vidéo NTSC 
(standard nord-américain ou japonais), 
vous utiliserez généralement le standard 
vidéo couleur NTSC : 29,97 i/s Non-Drop 
ou 29,97 i/s Drop. Si vous travaillez avec 
un système PAL, votre fréquence d'image est 
de 25 i/s.

Notez que si le format d'image Drop Frame 
ignore certaines adresses de timecode, les 
images réelles des séquences vidéo ne sont 
jamais omises.
Guide de référence Pro Tools



25Format 24 i/s

Ce format est utilisé avec le standard vidéo 
européen PAL, qui adopte une fréquence 
d'image de 25 i/s. Il est également appelé format 
EBU (European Broadcast Union), car il est 
utilisé par la quasi-totalité des diffuseurs 
européens.

24Format 24 i/s

Ce format s'utilise pour les applications video et 
cinéma de haute définition. Les images d'un film 
sont généralement photographiées et projetées 
à une fréquence de 24 i/s, aussi ce format SMPTE 
est-il utile dans les cas où une image de 
timecode doit correspondre à une image 
cinématographique

23.976Format 24 i/s

Ce format s'utilise pour la production de vidéos 
numériques de haute définition utilisant 
l'équipement vidéo NTSC et pour les 
applications cinéma.

Travail sur des éléments 
d'origine film
Si vous effectuez des travaux de post-production 
avec Pro Tools, vous utiliserez probablement des 
séquences vidéo. Toutefois, il est possible que 
ces séquences soient tirées d'un film. 

L'image du film et le son capté sur le tournage 
sont soumis à des processus de transfert 
différents avant de se retrouver sur une vidéo et 
tout au long de la post-production audio. Le 
film est transféré sur vidéo au cours d'un 
processus appelé télécinéma, en utilisant une 
méthode dite 3:2 Pulldown. Le son peut aussi 

être ralenti au cours du transfert ; sinon, vous 
vous retrouverez à travailler sur des données 
audio (sons issus du tournage) qui ne seront pas 
« à la bonne vitesse ».

A l'issue du processus de télécinéma, une bande 
vidéo numérique Master est créée, ainsi qu'une 
copie de travail sur cassette vidéo analogique 
Betacam ou 3/4 de pouce, destinée au monteur 
image. Simultanément, il est possible de créer 
un master audio en ralentissant (par « pull-
down ») de 0,1 % le son issu du tournage afin de 
compenser la modification de vitesse introduite 
lors du télécinéma (transfert du film sur support 
vidéo NTSC) Reportez-vous à la section 
Figure 44, page 762.

Pistes témoin et conformation

A l'issue du montage vidéo, la piste audio 
produite par le monteur vidéo (la « piste de son 
témoin ») est restée brute, et doit donc être 
améliorée pour pouvoir être utilisée dans le 
mixage. Le monteur son devra donc retourner 
aux éléments son originaux issus du tournage, et 
les assembler conformément au montage image, 
au cours d'un processus appelé conformation.
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3:2 Pulldown

Une séquence cinéma durant 1000 secondes se 
compose physiquement de 24000 images de 
film. Pour transférer ce film sous forme de 
séquence vidéo couleur NTSC de 1000 secondes, 
vous devez « faire correspondre » les 
24 000 images du film à 29 970,02997 images 
vidéo. 

L'utilisation du standard vidéo NTSC noir et 
blanc (30 i/s) au lieu du format 29,97 i/s 
simplifie grandement la conversion des images 
cinématographiques en images vidéo. En effet, il 
n'est alors plus question de fractions d'images : 
les 24 000 images cinématographiques doivent 
correspondre à 30 000 images vidéo (soit 
60 000 trames). Au cours du processus de 
télécinéma (pour la vidéo couleur NTSC), on 
copie chaque image cinématographique paire 
sur deux trames vidéo et chaque image 
cinématographique impaire vers trois champs 
vidéo : d'où le nom du procédé, 3:2 Pulldown. 
La vitesse du film est également « ralentie » à 

23,976 i/s afin de s'adapter à la fréquence 
d'image réduite de la vidéo couleur NTSC par 
rapport à la vidéo noir et blanc NTSC (29,97 i/s 
contre 30 i/s).

La cadence d'image du film diffère 
de la vitesse de la vidéo NTSC

Lors du placement du son sur une séquence 
vidéo issue de la conversion d'un film au format 
vidéo NTSC, vous devrez tenir compte de deux 
facteurs essentiels : la fréquence d'image cinéma 
et d'image vidéo. 

Fréquence d'image cinéma : la fréquence 
d'image cinéma concerne les sons enregistrés et 
lus en synchronisation avec les séquences film 
originales. Lors du tournage, ces sons sont le 
plus souvent enregistrés sur un Nagra® ou un 
DAT portable. Le timecode couché sur le 
support d'enregistrement est généralement au 
format 30 i/s Non-Drop. Le film doit être ralenti 
de 0,1 % lors d'un transfert à 29,97 i/s NTSC. 
Le film doit être accéléré de 4,16667 % lors d'un 
transfert à PAL.

Etape télécinéma de la post-production vidéo

Le télécinéma
convertit les images film
en images vidéo en

Bande vidéo

en utilisant le procédé Transfert 3:2

Copie de travail
vidéo analogique

numérique Master

Son issu du tournage
30  i/s Non-Drop

48 kHz

DAT télécinéma

29,97  i/s
48 kHzConversion de la fréquence 

(passage en analogique)

29,97  i/s

29,97  i/s

«  miroir  »

Audio-
analogique

d'échantillonnage ou A-D-A 

 

Conversion d'images cinématographiques en trames et 
en images vidéo au moyen d'un transfert de 
télécinéma.

Images cinématographiques

Trames vidéo

1 1 2 2 2 3 3 4 4 4

Images vidéo

1 2 3 4 5
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Fréquence d'image vidéo : 

 

la fréquence d'image 
vidéo fait référence au son lu à la fréquence 
d'image standard en vidéo couleur NTSC, soit 
29,97 i/s. La fréquence d'image vidéo est 
inférieure de 0,1 % à la fréquence d'image 
cinéma : par conséquent, les sons issus du 
tournage lus à la fréquence d'image cinéma ne 
seront pas synchrones avec les images vidéo. 

Notez les points suivants dans la Figure 44 : 

• La flèche verticale à gauche (« plus rapide » 
« plus lent ») représente la vitesse ou 
résolution du programme. 

• Le télécinéma correspond à une conversion de 
la résolution (de 24 à 30 images, par exemple).

• La vitesse de lecture du résultat de cette 
conversion correspond à une conversion de la 
fréquence d'image (de 30 à 29,97 i/s par 
exemple).

Le tableau suivant répertorie les applications 
pour chaque fréquence d'image ou résolution 
affichée dans la Figure 44, page 762.

 

Fréquences d'image et leurs applications

 

Fréquences 
d'image

Applications

 

25 i/s PAL

24 i/s Film et 24P HD

23.976 i/s 24P ralenti (pull down) pour 
diffusion NTSC et vidéo digitale 
HD

30 i/s Production musicale de 30 i/s et 
enregistrement de 30 i/s pour 
film

29.97 i/s Diffusion vidéo NTSC
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Fréquences d'image et vitesses de lecture relatives

 

Le schéma suivant indique les vitesses de lecture relatives des formats SMPTE. 

 

Pull Up et Pull Down

 

Les termes 

 

Pull Up

 

 et 

 

Pull Down

 

 se réfèrent à la 
modification intentionnelle de la fréquence 
d'horloge utilisée pour la lecture des 
échantillons audio (ce qui modifie la hauteur du 
son), afin de compenser une variation de vitesse. 
Pro Tools permet de ralentir (pull down) ou 
d'accélérer (pull up) la cadence de lecture de 
données audio ou vidéo. Pro Tools version 5.3.1 
ou ultérieure propose des valeurs de majoration 
appelées « facteurs 4 % » (correspondant à un 
ralentissement précis de 4,0 % ou à une 
accélération précise de 4,167 %) et destinées à la 
lecture audio et vidéo, afin de répondre aux 
besoins de conversion PAL/film/NTSC. 

Le mode Pull Down (-0,1%) permet de lire les 
séquences d'origine cinématographique à la 
fréquence d'image vidéo : 29,97 est égal à 30 
moins 0,1 %. Le mode Pull Down (+0,1 %) 
permet de lire les séquences vidéo à la fréquence 
d'image cinématographique : 30 est égal à 29.97 
plus 0,1 %.

L'utilisation des modes Pull Up ou Pull Down de 
Pro Tools requiert une interface SYNC I/O ou 
USD, ou un synchroniseur externe.

 

Figure 44.  Fréquences d'image, transferts télécinéma et vitesses de lecture relatives
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Dans quel cas choisir le mode Pull 
Up ou Pull Down

 

De nombreuses méthodes permettent de 
transférer du son dans Pro Tools pour la post-
production. Le son source et le format de la 
destination finale jouent un rôle essentiel dans 
le choix de celle à adopter. Dans certains cas, le 
son aura déjà été ralenti pour vous. Dans 
d'autres situations, il sera nécessaire de ralentir 
les sons provisoirement. Vous pouvez aussi 
choisir de ralentir la source audio, par exemple 
une machine DAT, puis recourir au processus 
N-A-N (numérique-analogique-numérique), ou 
à l'option Sample Rate Conversion de l'interface 
192 I/O, pour enregistrer les sons dans Pro Tools 
à la fréquence d'échantillonnage appropriée. 
Il est également possible d'accélérer ou de 
ralentir Pro Tools lors de la lecture du son.

Etant donné que les erreurs commises avec les 
facteurs Pull peuvent coûter cher, il est d'une 
importance capitale que la communication soit 
fluide entre vous-mêmes et les autres personnes 
impliquées dans un projet. Définissez dès que 
possible le rapport entre vos tâches et le reste du 
projet. 

 

Destination audio finale : film

 

Si votre destination finale est un film, le son 
source est émis à la fréquence d'image 
cinématographique et votre objectif est d'éditer 
et de mixer les données audio dans Pro Tools, 
puis de les coucher sur un appareil tournant à la 
fréquence d'image cinématographique (par 
exemple, un défileur magnétique ou une 
machine DAT avec timecode). Dans ce cas, vous 
pouvez ralentir provisoirement le son dans 
Pro Tools pour travailler au format vidéo NTSC, 
puis le restaurer à la fréquence d'image 
cinématographique une fois le travail terminé 
(en désactivant le Pull down).

Le son, enregistré à la fréquence d'image 
cinématographique, sur un appareil 
d'enregistrement portable dont le timecode est 
de 30 i/s est enregistré sur votre système 
Pro Tools à une fréquence d'échantillonnage de 
44,1 ou 48 kHz. Sachant que la fréquence 
d'image cinématographique est supérieure à la 
fréquence d'image vidéo, sélectionnez 30 i/s 
dans la fenêtre Session Setup de Pro Tools, puis 
enregistrez les données audio en synchronisant 
Pro Tools sur le timecode de l'appareil 
d'enregistrement portable. 

Une fois toutes les données audio enregistrées, 
synchronisez Pro Tools sur la copie de travail 
vidéo (défilant, donc, à la fréquence d'image 
vidéo) et activez le mode Pull Down. Si vous 
utilisez un périphérique SYNC I/O de 
Digidesign, sélectionnez Pull Down dans la 
fenêtre Session Setup. Si votre synchroniseur n'a 
pas été développé par Digidesign, sélectionnez 
Pull Down sur la face avant de l'appareil, puis 
activez le mode Pull Down dans la fenêtre 
Session Setup de Pro Tools. A ce stade, il est 
vivement conseillé de vérifier si le timecode 
couché sur la bande vidéo sur laquelle vous 
travaillez est au format 29,97 images Drop (DF) 
ou Non-Drop (NDF). En mode Pull Down, vous 
pouvez travailler sur la vidéo de référence sans 
altérer la synchronisation ni la vitesse des 
éléments (à condition que votre système soit 
correctement référencé). 

 
L'audio a déjà été accéléré pour la plupart 
des DAT « miroirs » et ne doit pas l'être 
davantage.
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Lorsque vous êtes prêt à transférer votre projet 
achevé sur un appareil audio fonctionnant à la 
fréquence d'image cinématographique, 
désactivez le mode Pull Down dans la fenêtre 
Session Setup et sur votre synchroniseur s'il ne 
s'agit pas d'un modèle SYNC I/O. Restaurez alors 
la fréquence d'image du timecode dans la 
session Pro Tools à 30 i/s. Une fois le mode Pull 
Down désactivé, le son lu sur le système 
Pro Tools est parfaitement synchrone avec le 
film monté. 

Vous pouvez tout aussi bien ralentir la machine 
audio source lors de l'enregistrement du son 
dans Pro Tools, travailler à 29,97 i/s sans activer 
le mode Pull Down, puis repasser au format 
30 images Non-Drop et sélectionner le mode 
Pull Up au cours de la phase de transfert. Vous 
devrez convertir la fréquence d'échantillonnage 
des données audio, soit numériquement, soit 
par un passage en analogique (N-A-N).

Seules les entrées de la carte Digital I/O sur 
l'interface 192 I/O prennent en charge la 
conversion de fréquence d'échantillonnage en 
temps réel.

 

Destination audio finale : vidéo

 

Si vous travaillez sur une séquence vidéo issue 
d'un transfert film, les données audio source 
sont à la fréquence d'image cinéma, et la 
destination finale est le format vidéo NTSC (ou 
la télévision). Si vos clients vous demandent 
d'effectuer un transfert numérique, vous devrez 
modifier légèrement la procédure ci-avant. 
N'oubliez pas qu'en mode Pull Down, la 
fréquence d'échantillonnage active est de 
44,056 kHz (pour des données audio 
enregistrées à 44,1 kHz) ou 47,952 kHz (pour 
des données audio enregistrées à 48 kHz). 

 

Ralentissement (Pull Down) de la source audio

 

Certains appareils DAT professionnels 
permettent d'utiliser une fréquence 
d'échantillonnage de 44,056 kHz (ou 
47,952 kHz). Vous pouvez enregistrer ces 
données audio dans Pro Tools grâce à un 
passage en analogique, ou N-A-N (pour 
Numérique-Analogique-Numérique), ou à 
l'option Sample Rate Conversion de l'interface 
192 I/O. La vitesse de lecture des données audio 
restera correcte jusqu'à la fin du projet, puisque 
la destination finale est la vidéo, et aucun 
ralentissement (Pull Down) ni accélération (Pull 
Up) ne sera nécessaire par la suite. 

Accélération de Pro Tools au cours de 
l'enregistrement

 

S'il est impossible de ralentir la source, vous 
pouvez obtenir un résultat similaire en 
accélérant Pro Tools et en réglant la fréquence 
d'image SMPTE à 30 i/s avant d'enregistrer les 
sons issus du tournage. Commencez par 
sélectionner la fréquence d'image 30 i/s dans la 
fenêtre Session Setup. Activez ensuite le mode 
Audio Rate Pull Up dans la fenêtre Session Setup 
(ainsi que sur le synchroniseur s'il ne s'agit pas 
d'un périphérique SYNC I/O) avant d'enregistrer 
les sons issus du tournage. Dans ce cas, si les 
sons « tournage » sont lus à 44,1 ou 48 kHz, 
Pro Tools fonctionne (et enregistre) à une 
fréquence d'échantillonnage de 44,144 ou de 
48,048 kHz. Une fois tous les sons issus du 
tournage transférés dans Pro Tools, désactivez le 
mode Audio Rate Pull dans la fenêtre Session 
Setup et sur le synchroniseur matériel (s'il ne 
s'agit pas d'un périphérique SYNC I/O). Une fois 
le mode Pull Up désactivé, le son enregistré est 
lu à une vitesse plus lente de 0,1 % et est 
synchronisé avec les images, et vous obtenez 
une « vraie » fréquence d'échantillonnage de 
44,1 ou 48 kHz. Remarque : ce processus est 
destiné aux situations où la destination finale 

 

Vous devrez également sélectionner l'option 
Audio Rate Pull Up/Down dans la fenêtre 
Session Setup.
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est la vidéo. Pour restaurer ces données à la 
fréquence d'image cinéma, vous devrez accélérer 
Pro Tools et enregistrer sur une machine-
destination non accélérée. 

 

Remarque sur la conversion de la 
fréquence d'échantillonnage

 

Dans de nombreux cas, vous devrez convertir la 
fréquence d'échantillonnage à un stade 
quelconque, de façon numérique ou au cours de 
l'enregistrement du son en repassant en 
analogique (N-A-N). Il existe un seul cas où la 
conversion de fréquence d'échantillonnage n'est 
jamais nécessaire : lorsque vous travaillez avec 
des sons à la cadence d'image cinéma et que la 
destination finale est le format film. Il suffit 
alors de ralentir Pro Tools lorsque vous travaillez 
au format vidéo, puis de désactiver le mode Pull 
Down pour restaurer la fréquence d'image 
cinématographique. Sur les interfaces 192 I/O et 
192 Digital I/O, les entrées de la carte d'I/O 
numérique prennent en charge la conversion de 
la fréquence d'échantillonnage en temps réel.

 

Utilisation des entrées numériques

 

Si vous travaillez avec les options de Pull Up et 
Pull Down, ne référencez pas avec des entrées 
numériques utilisées comme sources audio dans 
Pro Tools. Ceci annulerait en effet l'utilisation 
de l'interface SYNC I/O comme référence 
d'horloge. L'ensemble du matériel fournissant 
des sources audionumériques à Pro Tools doit 
être synchronisé de manière externe.

 

Vous devrez également sélectionner l'option 
Audio Rate Pull Up/Down dans la fenêtre 
Session Setup. 
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Chapitre 34 : Utilisation de la 
synchronisation

 

La synchronisation permet à un système de 
générer un timecode en sortie et à un autre 
système de le suivre. Pro Tools peut être 
synchronisé avec d'autres appareils via un 
timecode SMPTE/EBU ou un signal de MIDI 
Time Code (MTC). Pour en savoir plus sur les 
différents formats de code SMPTE/EBU et sur les 
autres concepts relatifs au timecode, reportez-
vous au Chapitre 33, Notions de 
synchronisation.

 

Options de synchronisation 
de Pro Tools

 

Il existe plusieurs options pour la 
synchronisation de Pro Tools avec une source 
externe et son utilisation en tant qu'appareil 
maître. Certaines options ne sont pas 
disponibles sur tous les systèmes Pro Tools, 
comme expliqué ci-après. 

 

SMPTE Trigger Only

 

Cette solution est très utile pour les projets 
courts si la vitesse des deux systèmes est proche. 
Toutefois, même les meilleurs systèmes restent 
rarement parfaitement synchronisés plus de 
quelques minutes.

 

SMPTE Trigger Resolved with 
SYNC I/O

 (Pro Tools HD uniquement)  

Vous pouvez utiliser le périphérique d'I/O SYNC 
optionnel ou un appareil équivalent d'une autre 
marque pour référencer les vitesses 
d'enregistrement et de lecture de Pro Tools à 
l'une des sources de référence d'horloge ci-après, 
tout en asservissant Pro Tools à un timecode :

• LTC

• Source vidéo

• Référence vidéo house

• VITC

• Word Clock 1x

• Horloge AES/EBU « null »,

• Pilot Tone

• Biphase

En référençant tous les transports du système à 
un signal de synchronisation commun, ou à un 
signal tenant compte d'éventuelles fluctuations 
du timecode maître entrant, on obtient une 
synchronisation très précise à long terme.
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SMPTE Trigger while Locking to an Unresolved 
Source

(Pro Tools HD uniquement)

 

L'option SMPTE Trigger peut être utilisée avec le 
périphérique optionnel SYNC I/O ou tout 
périphérique équivalent pour référencer la 
vitesse d'enregistrement et de lecture d'un 
système Pro Tools asservi à un timecode LTC. 
En référençant le système à un signal tenant 
compte des fluctuations du timecode entrant, 
on obtient une synchronisation très précise, 
même à long terme. Le périphérique SYNC I/O 
prend également en charge VITC et les 
références de position Bi-phase/Tach.  

Option de synchronisation de SYNC I/O

 

L'ajout d'un périphérique SYNC I/O à un 
système Pro Tools|HD permet d'utiliser 
Pro Tools en tant qu'appareil maître dans la 
configuration. Tous les autres périphériques 
sont alors asservis à Pro Tools. 

Vous pouvez associer Pro Tools à l'interface 
SYNC I/O pour générer des signaux de LTC et 
des commandes de MIDI Time Code ou de MMC 
(MIDI Machine Control). Lorsque le 
périphérique SYNC I/O reçoit un timecode 
SMPTE sur son connecteur d'entrée SMPTE, il le 
régénère puis le renvoie sur le connecteur de 
sortie LTC ou MTC. Ce signal peut ensuite être 
transmis à d'autres périphériques esclaves.

 

MachineControl™

 

Le périphérique SYNC I/O prend également en 
charge le logiciel MachineControl de 
Digidesign, qui propose de nombreuses 
fonctions spécialisées pour les tâches de post-
production, notamment l'activation de pistes à 
distance, le timecode série etc. Reportez-vous au 

 

Guide MachineControl

 

 pour plus d'informations 
ou contactez votre revendeur Digidesign.

 

Sortie d'horloge externe

Pro Tools peut jouer le rôle du dispositif maître 
(sortie Word Clock) de la configuration de 
synchronisation. Dans ce cas, tous les autres 
dispositifs lui sont asservis. 

Avec les systèmes Pro Tools|HD, la sortie 
d'horloge peut être configurée sur 1x word clock 
ou 256x Slave Clock pour les interfaces Legacy 
I/O de Digidesign (telles que 888|24 I/O). 
Reportez-vous au Guide de démarrage 
Pro Tools|HD si vous souhaitez davantage 
d'informations sur la sortie d'horloge et les 
interfaces Legacy I/O. 

Pour régler la sortie d'horloge externe

1  Dans Pro Tools, sélectionnez Setup > 
Hardware.

2  Cliquez sur le menu déroulant Ext. Clock 
Output et sélectionnez un signal disponible. 

Pour en savoir plus sur la connexion d'un 
périphérique de synchronisation externe au 
système Pro Tools, reportez-vous au Guide 
de démarrage. Si vous utilisez le 
périphérique SYNC I/O, reportez-vous à la 
documentation correspondante.
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3  Lorsque vous avez terminé, cliquez sur OK 
pour refermer la boîte de dialogue Hardware 
Setup.

Fenêtre Session Setup
La fenêtre Session Setup permet de configurer 
sur votre système un certain nombre de 
paramètres relatifs au timecode. Cette fenêtre 
inclut également des zones d'affichage de la 
fréquence d'échantillonnage, du format de 
fichier et de la résolution de la session. 

Fenêtre Session Setup

La fenêtre Session Setup est organisée en trois 
zones d'affichage. La session ainsi que les 
paramètres lui correspondant s'affichent dans la 
partie supérieure de la fenêtre. Les icônes 
Développer/Réduire en forme de triangles 
permettent de masquer ou d'afficher les zones 
SYNC Setup & Session Offsets et Time Code 
Settings.

Pour afficher la fenêtre Session Setup :

■ Dans une session Pro Tools, choisissez Setup > 
Session.

Pour développer la zone SYNC Setup & Session 
Offsets :

■ Cliquez sur le triangle Développer/Réduire de 
la zone SYNC Setup & Session Offsets.

Dans cette zone, les commandes vous 
permettent de configurer les paramètres de 
Digidesign SYNC I/O. ces paramètres sont 
fournis pour les options Clock Reference et 
Positional Reference, Video Format et Variable 
Speed Override. 

Pour afficher la zone Time Code Settings :

■ Cliquez sur le triangle Développer/Réduire 
dans la zone Time Code Settings.

Les commandes de cette zone permettent de 
générer le timecode et fournissent des options 
d'inertie ainsi que des sélecteurs distincts pour 
les fréquences audio et vidéo.

Si le port Legacy est activé (et non le port 
Expansion), la sortie d'horloge externe passe 
automatiquement en mode Slave 256x. 
Pour réinitialiser la sortie Ext. d'horloge 
externe, le bouton Port Settings doit être 
réglé sur Expansion et l'interface Legacy I/O 
doit être réglée sur No Interface. Pour régler 
une interface Legacy I/O sur No Interface, 
sélectionnez son nom dans la liste des 
périphériques, puis cliquez sur No Interface 
dans le menu déroulant.

Les systèmes Pro Tools LE dotés de DV 
Toolkit prennent en charge plusieurs 
paramètres liés au timecode (tels que les 
règles temporelles de la Time Code et 
Pieds+Images). Pour obtenir une liste 
complète, reportez-vous au Guide DV 
Toolkit pour Pro Tools LE.
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Paramètres et affichage de la 
session

Sample Rate

Ce paramètre indique la fréquence 
d'échantillonnage de la session actuelle. 

Bit Depth

Ce paramètre indique la résolution de la session 
actuelle.

Audio Format

Ce paramètre indique le format de fichier pour 
les fichiers enregistrés dans la session.

Mac<->PC

Ce paramètre indique si Pro Tools est réglé pour 
créer des sessions et des fichiers audio utilisables 
sur à la fois Windows et Macintosh. 

Clock Source (mode de 
synchronisation)

Ce menu permet de configurer l'horloge source 
du système. Vous avez le choix entre SYNC I/O, 
une source d'horloge interne à partir d'une carte 
ou d'un périphérique Digidesign, et une source 
d'horloge externe connectée à une interface 
audio Pro Tools|HD.

Options de source d'horloge

SYNC I/O : au cours de l'utilisation d'un 
SYNC I/O Digidesign, Pro Tools reçoit sa source 
d'horloge à partir de SYNC I/O et ce dernier peut 
à son tour faire référence à une source externe 
indiquée dans le sélecteur de configuration 
SYNC. 

Figure 45.  Fenêtre Session Setup avec SYNC I/O

Source d'horloge

Paramètres et 
affichages de la 
session

Configuration de la 
synchronisation

Paramètres de 
timecode

Décalage de 
timecode externe

Triangle 
Développer/Réduire de la 
zone Synchronization & 
Session Offsets

Options de Pull 
Up/Pull Down

Décalage du lecteur de Timecode

Triangle Développer/Réduire 
de la zone Time Code Settings

Les modifications apportées au paramètre 
Clock Source dans la boîte de dialogue 
Hardware Setup se répercutent dans la 
fenêtre Session Setup, et vice versa.
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Internal Mode : en mode Internnal, votre 
système est référencé sur l'oscillateur à quartz de 
la carte Digidesign ou de l'interface externe, et 
lit les données audio à la fréquence 
d'échantillonnage de la session.

Sources d'horloge externes : selon votre 
interface audio Pro Tools|HD, les options de 
source d'horloge externe peuvent inclure 
AES/EBU [Encl], S/PDIF, Optical [Encl], 
AES/EBU 1-8, TDIF, ADAT et Word Clock (des 
fréquences de signal Word Clock optionnelles 
sont disponibles aux fréquences plus élevées). 
Les sources externes peuvent fonctionner à 1x la 
fréquence d'échantillonnage, ou à la fréquence 
de base. Les fréquences de base sont 44,1 kHz 
pour 88,2 et 176,4 kHz, et 48 kHz pour 96 et 
192 kHz. Si une source externe est sélectionnée 
et qu'aucune horloge de synchronisation valide 
n'est détectée au niveau de l'horloge externe 
d'entrée, le périphérique I/O repasse en mode 
Internal.

Pour plus d'informations sur les sources 
d'horloge externes, consultez le Guide SYNC I/O.

System Delay

Ce paramètre indique la quantité totale de 
retards de système (dans les échantillons) causés 
par la connexion de plug-in et de consoles de 
mixage.

Gain de fader

Ce paramètre indique le niveau maximum de 
gain de fader de la session. 

Session Start

Ce champ permet de spécifier une valeur SMPTE 
pour l'emplacement de l'image de départ de la 
session. Reportez-vous à la section Définition de 
l'image de départ d'une session SMPTE, 
page 775.

Incoming Time (Current Time)

Ce champ indique la valeur de timecode 
entrant. 

Time Code Rate

Ce menu déroulant permet de régler la 
fréquence de timecode SMPTE applicable à la 
session en cours. 

Cadence Pieds+Image

Vous pouvez définir les fréquences Pieds+Image 
des sessions à l'aide du sélecteur correspondant. 
Les fréquences d'échantillonnage prises en 
charge sont 23,976, 24 et 25 i/s.

Réglez cette fréquence en fonction de celle du 
projecteur cinématographique ou de la vidéo si 
la vitesse du projecteur est prise en compte. 
Ainsi, pour procéder au transfert de télécinéma 
depuis un projecteur cinématographique à 
24 i/s en vidéo NTSC, le projecteur devrait 
fonctionner à 23,976 i/s qu'un facteur de 
ralentissement soit ou non appliqué à la session.

Si un périphérique SYNC I/O est sélectionné 
dans la boîte de dialogue Peripherals et qu'il 
est correctement connecté dans la chaîne 
Loop Sync, ce périphérique peut être utilisé 
pour transmettre le signal maître Loop Sync, 
et toutes les autres interfaces audio 
Pro Tools|HD pour transmettre les signaux 
esclaves Loop Sync.
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Paramètres SYNC Setup
(Pro Tools HD uniquement)

Les contrôles de la zone SYNC Setup permettent 
de configurer les paramètres de SYNC  I/O tels 
que la référence d'horloge, la référence de 
position, le format vidéo et la fonction VSO. 

Ces commandes sont regroupées dans la zone 
Synchronization Settings. 

Clock Reference

Ce menu permet de définir la référence 
d'horloge de Pro Tools.

Lorsque vous utilisez un périphérique SYNC I/O 
de Digidesign, le sélecteur de référence 
d'horloge répertorie tous les types d'horloge pris 
en charge pour l'interface de synchronisation 
Digidesign.

Lorsque vous utilisez des systèmes Pro Tools|HD 
sans interface SYNC I/O, vous pouvez faire votre 
choix parmi tous les formats ou sources 
numériques activés depuis votre interface 
Pro Tools|HD I/O (tel que AES, S/PDIF ou 
1x Word vers le port d'entrée Word Clock de 
l'interface Pro Tools|HD).

Positional Reference

Ce menu permet de définir la source de 
timecode que Pro Tools utilise en tant que 
référence de position. 

Video Format

Ce menu permet de définir la session pour le 
format NTSC ou PAL. 

Variable Speed Override (VSO)

La fonction Variable Speed Override (VSO) 
nécessite un SYNC I/O. 

Si vous connectez un périphérique SYNC I/O au 
système Pro Tools|HD, les commandes VSO se 
trouvent dans la zone SYNC Settings de la 
fenêtre Session Setup. 

Pour en savoir plus sur l'utilisation de la 
fonction VSO pour modifier la vitesse de lecture 
de Pro Tools, reportez-vous au Guide SYNC I/O. 

Indicateur Locked

L'indicateur Locked reste allumé lorsque le 
SYNC I/O est verrouillé sur la référence 
d'horloge sélectionnée. L'indicateur Locked 
clignote si la source de référence d'horloge 
sélectionnée est absente ou si sa valeur se trouve 
hors de la fourchette de fréquences dans laquelle 
l'appareil peut se verrouiller.

Indicateur Speed Cal

Cet indicateur définit la précision de la référence 
d'horloge entrante. L'indicateur Speed Cal 
s'allume lorsque la fréquence de sortie est 
comprise dans les 200 ppm (0,02%) de la 
fréquence d'échantillonnage sélectionnée. 
L'indicateur Speed Cal s'éteint lorsque la 
fréquence d'échantillonnage de sortie diffère de 
la fréquence attendue (fréquence cible). 

Curseur VSO
Guide de référence Pro Tools



External Time Code Offsets

Dans la zone External Time Code Offsets, 
Pro Tools vous permet de compenser les 
périphériques qui enregistrent constamment un 
décalage fixe d'un nombre d'images (comme 
certains masters vidéo à émission corrigée) ou le 
matériel qui démarre à un autre moment que la 
session elle-même. 

Pro Tools fournit trois types de décalages de 
timecode de début de session. Il s'agit de :

• MMC (Machine à port MIDI)

• 9-Pin (Machine à port série)

• Des périphériques de synchronisation (tels 
que les interfaces SYNC I/O ou une 
interface MIDI qui fournit le timecode 
MIDI) 

Des valeurs de décalage positives et négatives 
peuvent être saisies pour décaler l'affichage du 
timecode Pro Tools en le retardant ou en 
l'avançant, respectivement. 

Il est possible de définir des valeurs uniques 
pour chacun de ces trois types de décalages ou 
de les lier pour les ajuster les uns par rapport aux 
autres. 

Si vous utilisez l'option MachineControl de 
Digidesign, des options supplémentaires de 
décalages de timecode externe sont disponibles. 
Pour en savoir plus, reportez-vous au Guide 
MachineControl.

Time Code Settings

La zone Time Code Settings contient des 
options de générateur, d'inertie (freewheel) et de 
pull up/pull down. 

Ces réglages se trouvent dans la zone Time Code 
Settings de la fenêtre Session Setup. Cliquez sur 
le triangle Développer/Réduire de la zone Time 
Code Settings pour afficher ou masquer ces 
commandes. 

Generator

Le générateur (Generator) vous permet d'activer 
la génération Pro Tools et la sortie de LTC et 
MTC via un périphérique SYNC I/O. Pour plus 
d'information, reportez-vous au Génération de 
timecode, page 783.

Using Synch : cette option génère un timecode 
en sortie à partir du type de périphérique 
sélectionné dans le champ Device de la page 
Synchronization, dans la boîte de dialogue 
Peripherals. 

MTC to Port : cette option émet des messages de 
MIDI Time Code vers la destination MIDI 
sélectionnée dans le menu déroulant. Dans 
Pro Tools pour Windows, les choix proposés 
sont les mêmes que dans votre profil MSS (MIDI 
Studio Setup). Dans Pro Tools pour Macintosh, 
les options disponibles dépendent de votre 
profil AMS (Audio MIDI Setup).

Freewheel

Les options disponibles dans la zone Freewheel 
vous permettent de configurer la façon 
Pro Tools passera en mode inertie ou poursuivra 
la lecture si le timecode est interrompu ou 
corrompu. Ces options permettent notamment 
d'éviter les erreurs dues à la présence de « trous » 
(drop-outs) dans le timecode source SMPTE mais 
également les pertes temporaires de signal.
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None : le mode inertie n'est pas activé. 

Frames : définit un nombre d'images en inertie 
(entre 1 et 120 images). La valeur par défaut est 
8 images, paramètre conseillé pour la plupart 
des applications.

Jam Sync : cette option permet à Pro Tools de se 
synchroniser avec un timecode entrant, puis de 
poursuivre la lecture même si ce timecode 
entrant disparaît complètement. Elle peut 
s'avérer utile si le timecode est altéré ou s'il a été 
effacé accidentellement de la bande source.

Pull Up/Down

Lorsque Pro Tools est associé à un périphérique 
SYNC I/O ou un autre périphérique ou 
synchroniseur d'une autre marque compatible 
avec les fréquences d'échantillonnage majorées, 
cette option permet d'accélérer (pull up) ou de 
ralentir (pull down) la fréquence 
d'échantillonnage actuelle.

Pour plus d'informations, consultez la section 
Travail sur des éléments d'origine film, 
page 759. Pour plus d'informations sur 
l'application des facteurs de majoration dans 
Pro Tools, reportez-vous à la section Pull Up et 
Pull Down, page 778. 

Time Code Reader Offset (Sync Offset)

Il permet de définir un décalage s'appliquant au 
MIDI Time Code entrant (de valeur comprise 
entre –100 000 et +100 000 échantillons). 
Le décalage permanent ainsi créé permet 
d'affiner le point à partir duquel Pro Tools se 
synchronise avec le timecode entrant. Par 
exemple, pour une valeur de -50, un événement 
dans Pro Tools se produit 50 échantillons avant 
son équivalent dans le MIDI Time Code entrant. 
Vous pourrez utiliser cette fonction pour 
compenser d'éventuelles latences lors d'une 
conversion SMPTE-Midi Time Code ou 
analogique/numérique – numérique/ 
analogique. 

Préparatifs pour travailler 
avec un code SMPTE
Pour travailler avec un code SMPTE, la première 
étape consiste à choisir la fréquence d'image 
appropriée. Pro Tools prend en charge toutes les 
cadences d'image SMPTE standard. Vous 
trouverez une description détaillée de ces 
fréquences d'image SMPTE dans la section 
Formats d'image SMPTE, page 758.

Détermination de la fréquence d'image 
SMPTE

Le choix de la fréquence d'image SMPTE se fait, 
en règle générale, en fonction d'indications 
écrites (étiquettes) ou orales.

N'oubliez pas, l'application des 
accélérations et ralentissements varie selon 
les différentes procédures. Il est donc 
important d'effectuer une vérification de la 
procédure spécifique employée pour chaque 
projet avant de commencer votre travail.
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Configuration de Pro Tools 
pour travailler avec un code 
SMPTE
Les paramètres système Synchronization et 
MachineControl™ sont définis dans la boîte 
de dialogue Peripherals de Pro Tools. 
Ces paramètres s'appliquent au système et sont 
conservés quel que soit le type de session sur 
lequel vous travaillez. Configurez ces 
paramètres avant d'ouvrir une session.

D'autres paramètres tels que la fréquence de 
timecode de la session, la fréquence pieds et 
images, l'image de départ et le format d'affichage 
de l'heure de la session peuvent être configurés 
dans la fenêtre Session Setup. Ces paramètres 
sont spécifiques à la session et ne peuvent être 
modifiés que lorsqu'une session est ouverte.

Sélection d'un format SMPTE

Pour choisir un format SMPTE :

1  Dans une session Pro Tools, choisissez Setup > 
Session.

2  Sélectionnez une fréquence d'image (format 
SMPTE) à partir du sélecteur de fréquence 
d'image. 

3  Entrez le nombre d'images désiré pour le mode 
Time Code Freewheel (le cas échéant) dans la 
boîte qui convient. Pour plus d'informations, 
reportez-vous à la section Freewheel, page 773.

Définition de l'image de départ 
d'une session SMPTE

Dans la fenêtre Session Setup, vous pouvez 
définir une image de départ SMPTE pour la 
session. Les bandes de travail vidéo 
commencent rarement à un timecode SMPTE de 
00:00:00:00. Vous pouvez indiquer rapidement 
le timecode de début de votre session en 
fonction de celui de la bande de travail du 
projet. Les fonctions de Pro Tools liées au 
timecode SMPTE (par exemple, le mode Spot) 
utiliseront dès lors cette nouvelle valeur comme 
point de départ de la session.

Timecode de début lors du couchage 
sur une bande

Si vous générez un timecode, il est conseillé de le 
coucher à partir de la valeur 01:00:00:00 (en 
réservant du temps pour les blancs d'amorce, les 
logos, la mesure, etc.). Ceci permet d'éviter les 
problèmes survenant sur certains 
synchroniseurs lors du passage de 23:59:59:29 à 
00:00:00:00 (communément appelé passage à 
zéro).

Pour définir une image de départ SMPTE pour 
votre session :

1  Choisissez Setup > Session. 

2  Entrez une valeur de code SMPTE dans le 
champ Session Start.

Pour saisir une adresse SMPTE entrante en tant 
qu'heure de départ de la session :

1  Cliquez dans le champ Session Start

2  Commencez la lecture de la source de 
timecode. 

3  A l'emplacement souhaité, appuyez sur la 
touche Egal (=) du pavé numérique. 

L'option MachineControl n'est prise en 
charge que sur les systèmes Pro Tools|HD.
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4  Appuyez sur Enter pour valider la valeur. Vous 
pouvez modifier par la suite une adresse ainsi 
saisie. Lorsqu'elle se déroule en ligne, la session 
considère l'adresse SMPTE ainsi entrée comme 
son image de début SMPTE.

Si les pistes contiennent des régions et si vous 
retardez l'image de début SMPTE originale (par 
exemple, de 00:00:00:00 à 01:00:00:00), toutes 
les régions existant sur les pistes conservent leur 
position relative, mais commencent plus tard, 
de la valeur du retard ajouté à l'image de début.

5  Si vous modifiez l'heure de début d'une 
session ouverte dans laquelle des pistes existent 
déjà, une boîte de dialogue s'affiche après la 
fenêtre Session Setup. Choisissez l'une des deux 
options suivantes :

Maintain Time Code : place le temps de session 
supplémentaire au début de la session en 
maintenant les régions existantes à leur 
timecode original.

Maintain Relative Position : place le temps 
supplémentaire de la session au début de la 
session tout en préservant la position relative 
des régions existantes par rapport à la nouvelle 
image de départ. Si vous modifiez par exemple 
l'image de début de la session de 01:00:00:00 à 
00:59:00:00, Pro Tools rallonge la session d'une 
minute afin de prendre en compte la nouvelle 
image de départ, puis avance toutes les régions 
existantes pour préserver leur position relative 
par rapport à cette image de départ. 

Redéfinition de la position du 
timecode

Utilisez cette commande pour redéfinir la 
position de time code actuelle ainsi que l'heure 
de début de la session. Lorsque vous créez un 
point d'insertion (ou une sélection) et que vous 
entrez la nouvelle position de time code 
souhaitée pour cet emplacement, l'heure de 
début de la session est recalculée en fonction de 
ce nouvel emplacement de time code relatif.

Pour redéfinir la position d'un timecode :

1  A l'aide du sélecteur, cliquez sur une piste (ou 
effectuez une sélection) à l'endroit ou vous 
souhaitez redéfinir la position.

2  Choisissez Setup > Redefine Current Time 
Code Position

3  Entrez un nouveau numéro d'image SMPTE 
qui corresponde au timecode indiqué dans la 
boîte de dialogue.

4  Cliquez sur OK.

Si votre point d'insertion ou votre sélection 
ne fait pas partie des limites d'une grille, 
l'alignement se fait par rapport au pas le 
plus proche de la grille.
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Redéfinir un emplacement pieds 
et images
(Pro Tools HD et Pro Tools LE avec DV Toolkit 
uniquement)

Utilisez cette commande pour redéfinir la 
position Feet+Frames actuelle. Lorsque vous 
créez un point d'insertion (ou une sélection) et 
que vous entrez la nouvelle position 
Feet+Frames souhaitée pour cet emplacement, 
l'heure de début de la session est recalculée en 
fonction de ce nouvel emplacement 
Feet+Frames relatif.

Habituellement, cette commande est utilisée 
pour intégrer à des sessions Pro Tools les 
signaux de tests, pré-roll, amorces normalisées 
et autres données pré-programmées.

Pour définir une position d'image relative pour une 
session (Feet+Frames) :

1  A l'aide du sélecteur, cliquez sur une piste 
(ou effectuez une sélection) à l'endroit ou vous 
souhaitez redéfinir la position.

2  Choisissez Setup > Redefine Current 
Feet+Frames Position

3  Entrez un emplacement pieds et images (Feet-
+Frames) qui corresponde au timecode indiqué 
dans la boîte de dialogue.

4  Cliquez sur OK.

Affichage de l'heure dans les 
images SMPTE
(Pro Tools HD et Pro Tools LE avec DV Toolkit 
uniquement)

Dans Pro Tools, vous pouvez faire correspondre 
au timecode la valeur affichée dans l'indicateur 
Main Time Scale (SMPTE). Cette valeur sera 
reflétée dans le compteur principal. Pro Tools se 
synchronisera toujours sur le timecode SMPTE 
entrant, mais si l'échelle temporelle est en 
mesures:temps, minutes:secondes ou 
feet.frames, il est généralement préférable 
d'utiliser le timecode SMPTE comme référence.

Pour régler l'indicateur Main Time Scale sur Time 
Code :

■ Choisissez View > Rulers > Time Code.

– ou –

■ Cliquez sur le sélecteur du compteur principal 
dans la fenêtre Edit, puis sélectionnez Time 
Code.

Pro Tools affichera les valeurs de timecode selon 
la fréquence d'image SMPTE sélectionnée.

Si votre point d'insertion ou votre sélection 
ne fait pas partie des limites d'une grille, 
l'alignement se fait par rapport au pas le 
plus proche de la grille.

Sélection de l'échelle temporelle principale à l'aide du 
sélecteur du compteur principal
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Affichage du compteur secondaire et 
de l'échelle temporelle secondaire

Vous pouvez afficher une échelle temporelle 
secondaire dans le compteur secondaire. Par 
exemple, si la valeur de l'échelle temporelle 
principale est réglée sur Time Code et que vous 
souhaitez, en utilisant la fréquence d'image 
29.97 Non-Drop, comparer l'heure SMPTE à 
l'heure d'horloge murale, cliquez sur le sélecteur 
du compteur secondaire et sélectionnez l'option 
Min:Secs dans la zone Sub Time Scale.

Pull Up et Pull Down
Pro Tools prend en charge jusqu'à 4 % 
d'accélération (pull up) et de ralentissement 
(pull down), avec une prise en charge 
supplémentaire de 0,1 %. Il est possible de 
définir des fréquences distinctes pour les 
sessions audio et vidéo (lorsque la vidéo a été 
importée ou saisie dans une session). 

Lorsque vous référencez des valeurs 
d'accélération et de ralentissement de 4 %, le 
pourcentage appliqué est exactement de 
4,167 %. Pour plus d'informations, reportez-
vous à la section Tableau 6, page 780.

Même s'il n'est pas requis pour utiliser les 
options d'accélération et de ralentissement 
étendues fournies dans Pro Tools, SYNC I/O est 
le seul périphérique qui peut être contrôlé 
depuis Pro Tools, et qui peut rappeler et 
restaurer automatiquement les facteurs de 
majoration lorsqu'une session est ouverte. 
Les autres périphériques de synchronisation 
doivent être configurés manuellement. 

Configuration des paramètres Pull Up 
et Pull Down

Pour accélérer ou ralentir des données audio ou 
vidéo :

1  Choisissez Setup > Session.

2  Sélectionnez une valeur de Pull Up/Down 
dans la zone Time Code Settings de la fenêtre 
Session Setup.

Audio Rate Pull Up/Down : contrôle la fréquence 
d'échantillonnage de l'audio. Pour plus 
d'informations, reportez-vous à la section 
Accélération et ralentissement de la fréquence 
d'échantillonnage audio, page 780.

Video Rate Pull Up/Down : contrôle le débit 
vidéo. Pour plus d'informations, reportez-vous à 
la section Pull Up and Down vidéo, page 781. 

Les options disponibles dans ces menus 
dépendent de la fréquence d'image de la session. 
Il est possible d'appliquer des combinaisons en 
sélectionnant des valeurs dans les deux menus. 

Les options disponibles dans ces menus 
dépendent également des paramètres par défaut 
et des paramètres Auto Match Pull Factors 
définis dans le menu Time Code Rate. Reportez-
vous aux sections Pull Up et Pull Down étendus, 
page 779 et Auto Match Pull Factors, page 779.

Les paramètres d'accélération et de 
ralentissement n'affectent pas le timecode 
généré par l'interface SYNC I/O.

Fenêtre Session Setup

Les facteurs de majoration de 4 % ne sont 
disponibles que dans les sessions à 176,4 et 
192 kHz.

Video Rate Pull 
Up/Down 

Audio Rate Pull 
Up/Down 
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Pull Up et Pull Down étendus

Préférences et commandes de la boîte de dialogue 
Session Setup : le menu Audio Rate Pull 
Up/Down propose toutes les combinaisons 
possibles de Pull Up et Pull Down pour la 
fréquence d'échantillonnage en question, quelle 
que soit la fréquence d'image de la session. 

De plus, si la graduation temporelle comporte 
un clip vidéo QuickTime, la fréquence vidéo 
peut être accélérée ou ralentie de 0,1%, quelle 
que soit la fréquence d'image de la session. Les 
versions antérieures de Pro Tools activent 
également le mode de ralentissement de la 
fréquence d'image des clips vidéo QuickTime 
lorsque l'audio a été ralenti, de sorte que cette 
option est incluse dans Pro Tools version 5.3.1 
ou ultérieure pour conserver la compatibilité 
avec des sessions antérieures. 

Auto Match Pull Factors

L'option Auto Match Pull Factors est située dans 
le menu Time Code Rate de la session dans la 
fenêtre Session Setup. Lorsqu'elle est activée, 
Pro Tools règle les cadences de lecture audio et 
vidéo pour qu'elles reflètent tous les 
changements de la fréquence du timecode de la 
session actuelle. 

L'option Auto Match Pull est appliquée en 
fonction du paramètre de majoration actuel. 
Lorsque cette option est activée, si la fréquence 
d'image de la session est modifiée de sorte que la 
vidéo doit être décalée d'une valeur non prise en 
charge, la vidéo reste inchangée. 

Ce paramètre peut être verrouillé, n'est pas 
disponible par défaut et son état est stocké avec 
la session.

Utilisation du paramètre Auto Match Pull 
Factors : exemple

Auto Match Pull Factors associe les facteurs de 
majoration audio et vidéo lorsque la fréquence 
d'image de la session est modifiée. 

Par exemple, si la fréquence d'image d'une 
session Pro Tools est définie sur 25 i/s, les 
données audio et vidéo sont joués sans 
accélération, et l'option Auto Match Pull Factors 
est activée. 

Lorsque vous définissez la fréquence d'image de 
la session sur 24 i/s, les valeurs des paramètres 
d'accélération audio et vidéo sont réduits de 
–4.0% (paramètre de majoration approprié 
requis par la modification apportée à la 
fréquence d'image). 

La mise en correspondance automatique des 
facteurs de majoration est appliquée à tout 
paramètre Audio Rate Pull Up/Down ou Video 
Rate Pull Up/Down défini. Par exemple, si les 
données audio ont été majorées de –0.1 % lors 
de la modification de la fréquence d'image de 
29,97 à 24 i/s, le paramètre Audio Rate Pull 
Up/Down est modifié et est défini sur None. 
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Accélération et ralentissement de 
la fréquence d'échantillonnage 
audio

Le menu Audio Rate Pull Up/Down applique des 
facteurs d'accélération et de ralentissement lors 
de lecture ou de l'enregistrement de données 
audio de la session. Toutes les valeurs de 
majoration sont disponibles, quelle que soit la 
fréquence d'image. 

Débits audio et options de Pull 
Up/Down

Le Tableau 6 répertorie les fréquences 
d'échantillonnage actuelles de chaque option et 
de chaque combinaison d'accélération (pull up) 
et de ralentissement (pull down) (arrondi à 
l'entier le plus proche en Hz) :

Menu Audio Rate Pull

Voir également Auto Match Pull Factors, 
page 779.

Tableau 6. Fréquences d'échantillonnage en fonction des paramètres de Pull Up et Pull Down

Pull Up/Down
Fréquence d'échantillonnage

44100 48000 88200 96000 176400 192000

+4,1667% et 
+0,1%

45983 50050 91967 100100 n/d n/d

+4.1667% 45938 50000 91875 100000 n/d n/d

+4,1667 % et 
-0,1 %

45892 49950 91783 99900 n/d n/d

+0.1% 44144 48048 88288 96096 176576 192192

–0.1% 44056 47952 88112 95904 176224 191808

–4,0 % et 
+0,1 %

42378 46126 84757 92252 n/d n/d

–4.0% 42336 46080 84672 92160 n/d n/d

–4,0 % et 
–0,1 %

42294 46034 84587 92068 n/d n/d
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Pull Up and Down vidéo

Le sélecteur du menu Video Pull Up/Down vous 
permet de modifier la fréquence 
d'échantillonnage de la lecture de la vidéo 
quelles que soient les valeurs d'accélération 
audio (le cas échéant). Il se situe en dessous du 
menu Audio Rate Pull Up/Down dans la fenêtre 
Session Setup. 

Les options disponibles dans le menu Video 
Rate Pull Up/Down dépendent du format de 
fichier du clip vidéo, ainsi que de sa fréquence 
d'échantillonnage. Le tableau suivant affiche les 
valeurs d'accélération disponibles pour les clips 
vidéo Avid, à balayage entrelacé et progressif. 

Les valeurs de majoration vidéo sont 
enregistrées avec la session. 

Pas d'enregistrement vidéo avec le 
mode Pull Up

(AVoption|XL requis)

Il est possible que des données vidéo ne puissent 
pas être enregistrées si le mode d'accélération 
vidéo est sélectionné. Si la piste vidéo est activée 
en enregistrement et que des valeurs 
d'accélération du débit vidéo sont définies, ou si 
vous essayez de définir une valeur d'accélération 
vidéo alors que la piste vidéo est activée en 
enregistrement, Pro Tools affiche une boîte de 
dialogue et désactive l'enregistrement vidéo. 
Pour poursuivre la numérisation, définissez à 
nouveau le menu Video Rate Pull Up sur None. 

Menu Video Rate Pull Up/Down de la fenêtre Session 
Setup

Voir également Auto Match Pull Factors, 
page 779.

Fréquences d'échantillonnage vidéo et options de 
majoration

Format et 
fréquence 
d'échantillon-
nage vidéo

Valeurs de 
majoration 
vidéo dis-
ponibles

A synchroniser avec

Vidéo Avid

24 i/s Aucune

–0,1% cassette vidéo 
29,97 NTSC

+4,167% cassette vidéo PAL 
25 i/s

25 i/s Aucune

–4,0% 24 i/s

+4,167% cassette vidéo 
29,97 NTSC

29,97 Aucune

Fréquences d'échantillonnage vidéo et options de 
majoration

Format et 
fréquence 
d'échantillon-
nage vidéo

Valeurs de 
majoration 
vidéo dis-
ponibles

A synchroniser avec
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Quels éléments sont affectés par le 
mode Pull Up ou Pull Down ?

Les sections suivantes décrivent quelles 
fonctions de Pro Tools sont affectées par les 
valeurs de pull up et de pull down. 

Règle de Time Code 

Les valeurs d'accélération et de ralentissement 
vidéo n'affectent pas la règle de Time Code. 
Assurez-vous que la fréquence 
d'échantillonnage de session est correctement 
définie pour votre projet. Si par exemple vous 
travaillez avec des données vidéo 24 i/s et que 
vous appliquez une valeur d'accélération de 
4 %, vous devez définir la fréquence 
d'échantillonnage de la session sur 25 i/s pour 
que la règle de Time Code reste alignée. De 
même, si vous travaillez avec de la vidéo 24 i/s à 
laquelle est appliquée une valeur d'accélération 
de 0,1 %, définissez la fréquence 
d'échantillonnage sur 29,97.

Lorsque vous travaillez avec un support Avid 
25i/s et qu'une valeur d'accélération de 4 % est 
appliquée à la vidéo, définissez la fréquence 
d'échantillonnage de la session sur 24 i/s.

Plug-in

Pour assurer le bon fonctionnement de sessions 
auxquelles des valeurs d'accélération de l'ordre 
de 4 % sont appliquées, les plug-in doivent 
utilisez l'horloge d'échantillonnage plutôt 
qu'une horloge temporelle absolue. Tous les 
plug-in Digidesign sont basés sur une horloge 
d'échantillonnage. 

Fréquences d'échantillonnage élevées 
et facteurs de majoration

Des facteurs de majoration audio de 4 % ne sont 
pas disponibles avec des sessions ayant des 
fréquences d'échantillonnage de 176,4 et 
192 kHz.

Mode Online (en ligne) de 
Pro Tools
Pour déclencher la lecture ou l'enregistrement 
depuis une source externe, le Transport 
Pro Tools doit être mis en ligne. Pro Tools sait 
alors qu'il doit repérer le timecode entrant. 

Pour mettre le Transport Pro Tools en ligne, 
effectuez l'une des opérations suivantes :

■ Choisissez Options > Transport Online. 

■ Cliquez sur le bouton Online, à l'extrême 
gauche de la fenêtre Transport. 

■ Appuyez sur Ctrl + L (Windows) ou sur 
Pomme + L (Macintosh). 

Le bouton Online clignote et Pro Tools attend 
une adresse SMPTE pour lancer la lecture. Dès 
réception d'un timecode, la lecture débute et le 
bouton Online s'illumine. Les indicateurs de 
sélection d'édition de la fenêtre Edit ainsi que le 
champ Incoming Time de la fenêtre Session 
Setup affichent le timecode entrant. 

Pour mettre Pro Tools hors ligne :

■ Désélectionnez Options > Transport Online.

– ou –

■ Désactivez le bouton Online dans la fenêtre 
Transport.
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Enregistrement Online

La page Operation Preferences contient deux 
options déterminant comment Pro Tools lance 
l'enregistrement en mode Online.

Record Online At Insertion/Selection : avec cette 
option, l'enregistrement en ligne commence là 
où vous avez placé le point d'insertion dans une 
piste. Il se poursuit alors jusqu'à ce que Pro Tools 
ne reçoive plus de timecode. Si vous effectuez 
une sélection dans une piste, Pro Tools 
enregistre en ligne uniquement sur la durée de 
la sélection. 

Record Online at Time Code (or ADAT)
Lock : l'enregistrement en ligne débute dès que 
Pro Tools reçoit un timecode ou un signal de 
synchronisation ADAT et se synchronise sur 
celui-ci. Dans ce cas, il n'est pas nécessaire de 
placer un point d'insertion, ni d'effectuer une 
sélection dans une piste pour définir le point 
d'entrée en enregistrement.

Génération de timecode
A l'aide d'une interface d'E/S SYNC, Pro Tools 
peut générer un timecode MIDI (MTC) et 
SMPTE. Il est possible de convertir Pro Tools en 
source de synchronisation maître, à laquelle 
asservir d'autres appareils.

L'interface SYNC I/O ne peut pas générer un 
timecode à 30 i/s, 24 i/s ou 23.976 i/s 
lorsqu'elle est verrouillée sur une entrée ou une 
référence vidéo

L'interface SYNC I/O ne peut pas générer de 
timecode à 30 i/s, 24 i/s ou 23.976 i/s lorsqu'elle 
est verrouillée sur un signal d'horloge vidéo. 
Si vous configurez Pro Tools pour générer un 
timecode de 30 i/s alors que l'interface SYNC I/O 
est verrouillée sur un signal d'horloge vidéo, 
cette dernière génère en réalité des images à la 
fréquence standard NTSC de 29,97 i/s. Pro Tools 
peut générer un timecode à des fréquences 
d'image non NTSC si vous utilisez l'horloge 
interne de l'interface SYNC I/O comme source 
de synchronisation.

Pour générer un timecode à l'aide d'une interface 
d'I/O SYNC :

1  Reliez le connecteur Out de l'interface SYNC 
I/O au connecteur SMPTE IN des appareils à 
asservir. Si l'appareil asservi reconnaît le code 
MTC, reliez le connecteur MTC OUT du 
périphérique SYNC I/O au connecteur MIDI IN 
de l'appareil asservi (interface MIDI ou autre). 

2  Assurez-vous que le périphérique SYNC I/O est 
sous tension.

3  Lancez Pro Tools et assurez-vous d'avoir activé 
l'interface SYNC I/O dans la page 
Synchronization de la boîte de dialogue 
Peripherals (pour en savoir plus, reportez-vous 
au Guide SYNC I/O).

Options d'enregistrement en ligne
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4  Choisissez Setup > Session et sélectionnez la 
fréquence d'image appropriée à partir du 
sélecteur de fréquence d'image.

5  Sélectionnez SYNC I/O dans le sélecteur de 
génération de la zone Time Code Settings de la 
fenêtre Session Setup. 

6  Choisissez une référence d'horloge avec le 
sélecteur de référence d'horloge. Notez que la 
disponibilité des références d'horloge dépend 
des fréquences d'échantillonnage. (Voir Sources 
d'horloge externes :, page 771.)

7  Cliquez sur le bouton Online dans la fenêtre 
Transport, puis cliquez sur Play. Pro Tools génère 
et émet en sortie un timecode depuis le 
périphérique SYNC I/O.

Utilisation de la fonction MIDI 
Machine Control
Pro Tools permet de transmettre des 
informations de position à des machines 
externes et de contrôler leurs transports à l'aide 
de messages MMC (MIDI Machine Control). 

Contrôle d'appareils externes 
via MMC

Tout appareil compatible MMC (par exemple, 
un Alesis ADAT ou un Tascam DA-88) peut être 
contrôlé directement depuis Pro Tools, le signal 
d'horloge maître pouvant être fourni par 
l'appareil externe ou par Pro Tools. 

Les machines externes prises en charge par 
Pro Tools mettent en œuvre uniquement des 
communications en « boucle ouverte ». De ce 
fait, bien que Pro Tools joue le rôle de transport 
maître, toute manipulation éventuelle des 
transports réalisée directement sur l'appareil 
externe lui-même n'est pas répercutée à 
Pro Tools. En revanche, vous pouvez 

sélectionner le périphérique externe (MMC) 
dans le menu local Transport et agir sur les 
commandes de transport apparaissant à l'écran 
de Pro Tools pour commander le périphérique. 

Pro Tools ne prend pas en charge la préparation 
en enregistrement des pistes des machines 
externes commandées via MMC. Pour procéder 
à un enregistrement sur la machine externe, 
vous devrez préparer les pistes manuellement. 

Windows

Sous Windows, Pro Tools utilise votre 
configuration Multimédia Setup pour 
déterminer quels sont les périphériques MIDI 
disponibles et leurs propriétés. Pour configurer 
le périphérique convenablement, reportez-vous 
à la documentation d'installation et d'utilisation 
qui l'accompagne.

Activation de MIDI Machine 
Control dans Pro Tools

Pour utiliser la fonction MIDI Machine Control :

1  Choisissez Setup > Peripherals, puis cliquez 
sur l'onglet Synchronization. 

2  Sélectionnez votre périphérique de 
synchronisation dans le menu déroulant 
Synchronization/Device. Dans une interface 
MIDI, sélectionnez « Generic MTC Reader ». 
Si vous utilisez un périphérique SYNC I/O, 
réglez le port sur DigiSerial.

L'option MachineControl de Digidesign 
prend en charge la préparation à distance 
des pistes en enregistrement sur les 
machines compatibles avec les protocoles 
Sony 9 broches et V-LAN. Reportez-vous à 
la section Activation de pistes à distance, 
page 788.
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3  Sélectionnez le port approprié pour les 
informations de synchronisation. Il s'agit du 
port auquel votre périphérique de 
synchronisation est relié.

4  Cliquez sur l'onglet Machine Control dans la 
fenêtre Peripherals.

5  Dans la zone MIDI Machine Control, activez 
l'option MMC. 

6  Sélectionnez votre périphérique externe dans 
le menu déroulant Send To. 

Le port sur lequel ces informations seront 
transmises est défini dans le champ ID. Les 
commandes MMC intègrent le numéro 
d'identification de la machine visée par ces 
commandes. Il existe 128 numéros ID MMC 
classés de 0 à 127. L'ID par défaut 127 est un 
paramètre spécial qui envoie les données vers les 
128 ID MMC. Ainsi, on est sûr que tout appareil 
relié au port spécifié répondra aux commandes 
MMC.

7  Définissez une durée de pré-roll pour la 
machine compatible MMC. La fonction de pré-
roll permet à Pro Tools de disposer de 
suffisamment de temps pour se synchroniser au 
timecode entrant. Cette durée est variable selon 

l'appareil externe. Si la durée de pré-roll est trop 
faible, Pro Tools n'aura peut-être pas le temps de 
se synchroniser avant d'arriver à la position 
temporelle désirée.

8  Cliquez sur OK pour refermer la boîte de 
dialogue Peripherals. Pro Tools peut désormais 
contrôler le transport sur la machine 
sélectionnée. 

Commande des transports de 
Pro Tools et MMC

La fenêtre Transport de Pro Tools permet de 
contrôler à distance tous les dispositifs activés 
(unités MMC, ADAT ou appareil vidéo non 
linéaire). Il suffit que vous activiez les dispositifs 
pour écouter l'adresse que vous avez entrée pour 
le MMC. La fenêtre Transport contrôle alors le 
transport de Pro Tools et tous les périphériques 
asservis. 

Vous pouvez également configurer un 
« maître » Pro Tools qui dirigera les autres 
dispositifs et sur lequel Pro Tools s'asservira. 

Pour contrôler des périphériques externes à partir 
du maître de transport de Pro Tools :

■ Sélectionnez Pro Tools ou MMC dans le menu 
local Transport de la fenêtre Pro Tools Transport. 
L'élément sélectionné jouera le rôle de transport 
maître.

Onglet Machine Control de la boîte de dialogue 
Peripherals

Sélection d'un transport maître
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Une fois le transport maître réglé sur Pro Tools, 
la position de lecture est régie par le curseur qui 
apparaît à l'écran de Pro Tools. 

Lorsque le transport maître est réglé sur MMC, la 
position de lecture est régie par celle de la 
machine externe. 

Pour plus d'informations, reportez-vous à la 
section Enregistrement à partir de périphériques 
MIDI, page 231.

Paramètres de transport MMC

Si vous avez choisi MMC, les options suivantes 
permettent de définir le comportement du 
transport machine dans la page Operation 
Preferences.

Machine Chases Memory Location : lorsque 
cette option est sélectionnée, si vous vous 
rendez en un endroit précis d'une session par 
rappel d'un emplacement mémoire (Memory 
Location), le transport de la machine connectée 
suit. 

Machine Follows Edit Insertion/Scrub : lorsque 
cette option est sélectionnée, si vous vous 
rendez en un emplacement précis d'une session 
en déplaçant le point de sélection ou par 
scrubbing d'une piste, le transport de la machine 
connectée suit.

Mise hors ligne d'un périphérique

Utilisez le menu contextuel Online à partir du 
sélecteur de transport maître pour mettre un 
périphérique MIDI (ou Machine) hors ligne.

Pour mettre un périphérique hors ligne :

1  Cliquez sur le sélecteur de transport maître.

2  Cliquez sur le menu contextuel Online et 
cliquez sur le périphérique (Machine ou MIDI) 
pour le désélectionner. Les choix proposés 
varient en fonction du transport maître actuel et 
des périphériques configurés dans Pro Tools.

Pour remettre un périphérique en ligne, il suffit 
de le resélectionner dans le menu contextuel 
Online.

Désélection d'un périphérique pour le mettre hors ligne

Le menu contextuel Online affiche 
uniquement les périphériques qui ont été 
configurés correctement dans Pro Tools.

Pour savoir comment configurer des 
périphériques MIDI, reportez-vous à la 
section Activation de MIDI Machine 
Control dans Pro Tools, page 784.

Pour savoir comment configurer des 
périphériques Machine, reportez-vous au 
Guide MachineControl.

Menu contextuel Online
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Synchronisation d'un 
séquenceur avec Pro Tools

(Macintosh uniquement)

Pour synchroniser Pro Tools sur un séquenceur, 
configurez AMS pour qu'il fournisse MTC et 
MMC (si nécessaire). Configurez AMS pour qu'il 
fournisse au moins deux nœuds pour la 
communication inter-application (dans la 
fenêtre Pro Tools MIDI Setup, ces nœuds sont 
fournis et intitulés Entrées Pro Tools 1 à 4).

Configuration d'un temps de 
synchro minimal
Le temps de synchronisation correspond à la 
durée nécessaire pour que les différentes 
machines composant votre système se 
synchronisent entre elles. Cette durée est 
différente pour chaque machine. Pour régler le 
temps de synchro dans Pro Tools, entrez la 
valeur dans la zone Minimum Sync Delay de la 
fenêtre Synchronization, dans la boîte de 
dialogue Peripherals. La valeur minimale 
disponible est 15 images. Déterminez la valeur 
minimale de temps de synchronisation pour 
votre système, puis entrez cette valeur dans la 
zone Minimum Sync Delay. Sur les systèmes 
utilisant MachineControl de Digidesign, activer 
le paramètre de timecode Use Serial accélérera 
considérablement la synchronisation. Pour que 
le timecode série soit utilisable, il faut que 
l'interface SYNC I/O et les périphériques 
externes soient synchronisés au signal vidéo 
interne.

Pour définir un temps de synchronisation minimal :

1  Choisissez Setup > Peripherals, puis cliquez 
sur l'onglet Synchronization. 

2  Saisissez un nombre d'images dans le champ 
Minimum Sync Delay. 

3  Cliquez sur OK pour refermer la boîte de 
dialogue Peripherals. 

Configuration de l'option Minimum Sync Delay 
pour les machines MMC externes référencées 
sur un signal de house sync

Si vous contrôlez via MMC, depuis Pro Tools, 
une machine référencée sur un signal de house 
sync, cette dernière commence par se rendre à 
l'emplacement MMC, puis se référence au signal 
d'image couleur. Dans le cas d'un signal de 
house sync, il faut 4 images pour se verrouiller 
sur la séquence d'images couleur. Si le temps de 
synchro minimal que vous avez entré est 
inférieur à la durée requise par la machine MMC 
pour se rendre à l'emplacement requis puis se 
verrouiller sur la séquence couleur, la lecture 
débutera avant que la machine ne soit 
synchronisée. Dans ce scénario, la valeur de 
l'option Minimum Sync Delay doit être 
supérieure à la durée requise pour le verrouillage 
sur la séquence d'image couleur. Le problème ne 
se pose pas avec l'interface SYNC I/O, qui refuse 
de se synchroniser tant qu'elle n'a pas pu se caler 
sur la séquence d'images couleur. 
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Activation de pistes à 
distance
L'option MachineControl™ de Digidesign pour 
Pro Tools permet de préparer à distance des 
pistes en enregistrement sur les machines 
compatibles avec le protocole 9 broches (ou V-
LAN pour le transport uniquement). Sans cette 
option, Pro Tools ne prend pas en charge la 
préparation à distance des pistes en 
enregistrement sur les machines externes. 
MachineControl, outre autoriser la préparation 
à distance des pistes en enregistrement, permet 
à Pro Tools de se comporter en tant que maître 
ou esclave vis-à-vis de machines externes 
compatibles avec le protocole Sony 9 broches 
(ou V-LAN pour le transport uniquement).

MIDI Beat Clock
Certains périphériques MIDI tels que les 
batteries, les séquenceurs matériels et les 
arpégiateurs ne peuvent se synchroniser qu'avec 
un signal d'horloge de type MIDI Beat Clock. 
Pour les synchroniser avec Pro Tools, il faut 
donc leur transmettre un signal d'horloge MIDI 
Beat Clock. De nombreux plug-in prennent 
également en charge les signaux d'horloge MIDI 
Beat Clock.

Pour transmettre l'horloge MIDI Beat Clock :

1  Choisissez Setup > MIDI > MIDI Beat Clock.

2  Dans la boîte de dialogue MIDI Beat Clock, 
sélectionnez l'option Enable MIDI Beat Clock.

3  Sélectionnez les périphériques chargés de la 
réception de l'horloge MIDI Beat Clock. Si votre 
interface MIDI ne prend pas en charge la 
transmission de MIDI Beat Clock vers des ports 
séparés, seule l'interface apparaît en tant que 
destination.

4  Cliquez sur OK.

Servez-vous de la commande Setup > 
Machine Track Arming Profiles pour 
configurer votre système, puis de la 
commande Window > Machine Track 
Arming pour afficher la fenêtre Machine 
Track Arming.

Pour plus d'informations sur la préparation 
à distance des pistes en enregistrement à 
l'aide de MachineControl et des 
commandes de menu Pro Tools prévues à 
cet effet, reportez-vous au Guide 
MachineControl.

Boîte de dialogue MIDI Beat Clock
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Placement de régions à des 
adresses SMPTE
(Pro Tools HD et Pro Tools LE avec DV Toolkit 
uniquement)

Le processus de spotting (placement) consiste à 
assigner des musiques ou des sons à des 
emplacements déterminés par une adresse 
SMPTE spécifiques, dans un film ou une vidéo. 
Cette fonction permet notamment de placer :

◆ Des régions entières sélectionnées avec l'outil 
d'accrochage de temps. Plusieurs régions, dans 
quel cas Pro Tools place la première région dans 
votre sélection.

◆ Un point spécifique à l'intérieur d'une région, 
en cliquant avec le sélecteur sur ce point, puis en 
sélectionnant Region > Identify Sync Point. 

◆ Des session ou des pistes, en les faisant glisser 
à partir d'un navigateur jusqu'à l'option 
Timeline (graduation temporelle) ou la liste des 
régions. 

mode Spot

En mode Spot, pour placer rapidement une 
région sur une piste, il suffit de cliquer dessus 
avec l'outil d'accrochage de temps. 

Le mode Spot permet également de faire glisser 
une région de la liste des régions vers une piste 
depuis un navigateur Digibase. 

Boîte de dialogue Spot

La boîte de dialogue Spot s'affiche lorsque vous 
déplacez une région vers une piste ou cliquez sur 
une région avec l'outil d'accrochage de temps en 
mode Spot. Les champs numériques jouent un 
rôle d'affichage de données et de contrôle 
d'édition pour les régions sélectionnées. 

Selon le format d'échelle de synchronisation 
choisi, les informations de ces champs sont 
exprimées sous forme d'un timecode SMPTE, en 
minutes:secondes, en pieds:images, en 
échantillons ou en mesures/temps.

Le champ actif pour la saisie de données 
numériques apparaît en surbrillance. Entrer une 
valeur dans un champ déplace un élément 
sélectionné vers l'emplacement temporel choisi. 
Les champs Start, Sync Point et End sont 
accessibles lorsque l'outil d'accrochage de temps 
est activé. Seuls les champs Start ou End (selon le 
point d'insertion de la souris) et Duration sont 
accessibles lorsque l'un des outils de trimming 
est activé (voir Utilisation des outils de 
trimming en mode Spot, page 792).

Boîte de dialogue Spot

Pour augmenter ou réduire les valeurs 
SMPTE d'un nombre d'images spécifique 
dans la boîte de dialogue Spot, appuyez sur 
la touche plus (+) ou moins (–) du pavé 
numérique, saisissez un nombre, puis 
appuyez sur Entrée.
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Option Use Subframes

Une sous-image (Subframe) représente 
1/100ème d'image. L'option Use Subframes 
permet d'utiliser ces unités plus petites, pour 
obtenir une plus grande précision. Cette 
commande ajoute un champ temporel 
supplémentaire à l'adresse SMPTE en 
heures:minutes:secondes:images, champ qui 
apparaît à l'extrême droite du champ horaire 
lorsqu'il est activé. Utilisez un point (.) comme 
séparateur entre les valeurs d'image et de sous-
image.

Capture d'un timecode

Pro Tools permet également de capturer 
facilement des valeurs de timecodes « à la 
volée » dans cette boîte de dialogue, en 
appuyant sur la touche Egal (=) ou en cliquant 
sur le bouton Current Time alors que Pro Tools 
reçoit un timecode valide. L'option VITC permet 
de capturer avec précision un emplacement 
SMPTE sur un magnétoscope en mode pause ou 
défilant au « ralenti ».

Lorsque Time Code est sélectionné dans la zone 
Time Scale, appuyez sur la touche Egal (=) pour 
capturer le timecode entrant. Lorsque Bars:Beats 
est sélectionné dans la zone Time Scale, appuyez 
sur la touche Egal (=) pour capturer la mesure la 
plus proche.

Bien que le bouton Capture Time Code 
fonctionne avec des timecodes LTC ou VITC 
« tournant » librement, seule la fonction VITC 
permet de capturer le timecode d'une image 
arrêtée. 

L'interface SYNC I/O prend en charge la lecture 
VITC. Avec MachineControl et une interface 
SYNC I/O, vous pouvez également lire le 
timecode série.

Pour placer une région sur une valeur SMPTE 
spécifique :

1  Choisissez Window > Edit.

2  Définissez l'échelle temporelle principale sur 
le time code. Reportez-vous à la section 
Définition de l'image de départ d'une session 
SMPTE, page 775.

3  Cliquez sur le bouton Spot dans l'angle 
supérieur gauche de la fenêtre Edit pour 
configurer Pro Tools en mode Spot.

4  Identifiez l'adresse SMPTE à partir de laquelle 
vous souhaitez déclencher la lecture de votre 
région en arrêtant la vidéo sur cette image. 

5  A l'aide de l'outil d'accrochage de temps, 
cliquez sur une région dans une piste ou dans la 
liste des régions et faites-la glisser vers une piste. 
La boîte de dialogue Spot apparaît.

Affichage d'un nouveau champ horaire lorsque la case 
Use Subframes est cochée

Les sous-images ne sont pas disponibles 
dans le champ Current Time.

Pour utiliser le mode Remote avec 
MachineControl, vous devez disposer d'un 
port série approuvé. Consultez le site Web 
www.Digidesign.com pour obtenir la liste 
complète des ports actuellement approuvés.

Mode Spot activé
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6  Indiquez l'adresse SMTE choisie. 

• Si vous utilisez le VITC, appuyez sur la 
touche Egal (=) du pavé numérique ou 
cliquez sur Current Time Code pour saisir 
la valeur de timecode SMPTE d'un 
magnétoscope en mode pause.

• Si vous utilisez un LTC, une fois l'option 
Time Code sélectionnée dans la zone Time 
Scale, appuyez sur la touche Egal (=) du 
pavé numérique pour capturer la valeur de 
timecode entrant. Lorsque Bars:Beats est 
sélectionné dans la zone Time Scale, 
appuyez sur la touche Egal (=) pour 
capturer la mesure la plus proche.

7  Si la région a été enregistrée alors que 
Pro Tools était « en ligne », vous pouvez utiliser 
le bouton Original Time Stamp pour rappeler et 
saisir la position d'image SMPTE à laquelle la 
région a été enregistrée à l'origine. Cette 
méthode permet également d'accéder à un 
marquage temporel défini par l'utilisateur. Pour 
plus d'informations, reportez-vous à la section 
Marquage temporel, page 792.

8  Cliquez sur OK pour refermer la boîte de 
dialogue. La région se déplace à l'adresse SMPTE 
choisie. Lorsque la session se déroule en ligne, 
lorsque le timecode arrive à cette adresse, la 
lecture de la région est déclenchée.

Placement automatique de 
régions

L'option Auto-Spot Regions de Pro Tools 
simplifie encore le placement des régions. 
Si vous utilisez le VITC avec cette option activée, 
ou le logiciel MachineControl, vous pouvez 
mettre en pause la bande vidéo à l'emplacement 
SMPTE de votre choix, puis cliquer sur une 
région avec l'outil d'accrochage de temps : 
la région se place alors automatiquement à cette 
adresse de timecode. 

Vous pouvez également utiliser la fonction de 
timecode série de MachineControl pour le 
placement automatique en activant 
MachineControl et le timecode série du 
périphérique. 

Pour placer une région automatiquement :

1  Choisissez Options > Auto-Spot Regions.

2  Si vous utilisez le VITC, repérez l'adresse 
SMPTE à laquelle vous souhaitez déclencher la 
lecture de votre région en arrêtant la vidéo sur 
l'image correspondante. 

3  Cliquez sur la région à l'aide de l'outil 
d'accrochage de temps. La région va alors se 
placer automatiquement à l'adresse de timecode 
désirée (celle où la vidéo est arrêtée).

Cliquer sur une région avec un outil de 
trimming permet de la « rogner » jusqu'à 
l'emplacement du timecode en cours.

Les régions sont placées automatiquement 
en fonction de leur temps de début, à moins 
que vous n'ayez défini préalablement un 
point de synchronisation (voir 
Identification d'un point de 
synchronisation, page 794). Si la région 
contient un point de synchronisation, son 
placement s'effectue par celui-ci. 
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Utilisation des outils de trimming 
en mode Spot

Vous pouvez utiliser la boîte de dialogue Spot 
pour « rogner » des régions, et notamment les 
heures de début/fin/durée et les adresses de 
timecode entrant de référence. Si vous cliquez 
sur une région en mode Spot avec un des outils 
de trimming, la boîte de dialogue Spot apparaît. 
Vous pouvez alors saisir une valeur dans les 
champs Start, End et Duration afin de spécifier 
le point exact de rognage du début ou de la fin 
de la région. Cette option permet également de 
modifier la durée d'une région, afin de la faire 
correspondre à un point de repère visuel 
particulier. 

Rogner une région contenant un point de 
synchronisation (voir Identification d'un point 
de synchronisation, page 794) ne modifie pas 
l'adresse SMPTE de ce point, à moins que le 
rognage ne s'effectue au-delà de ce point.

Marquage temporel
Pro Tools affecte un marquage temporel à 
chaque région enregistrée en ligne, utilisant le 
timecode SMPTE original d'enregistrement du 
son. Pour rappeler ce timecode SMPTE d'origine 
pour une région, cliquez sur le bouton Original 
Time Stamp dans la boîte de dialogue Spot.

Vous pouvez également placer une région en 
fonction d'un marquage temporel SMPTE 
utilisateur indépendant, en utilisant la 
commande Time Stamp du menu déroulant de 
la liste des régions. Une fois la région marquée 
temporellement au moyen de cette commande, 
cliquez sur le bouton User Time Stamp pour la 
replacer conformément à son emplacement 
SMPTE défini par l'utilisateur.

Show Original Time Code in 
Regions

Cette commande affiche le marquage temporel 
SMPTE original de toutes les régions 
appartenant à des pistes. Cette valeur SMPTE 
représente l'heure de l'enregistrement « en 
ligne » original de la région sur Pro Tools, et ne 
reflète pas nécessairement l'emplacement 
SMPTE actuel de la région sur une piste.

Pour afficher le marquage temporel original sur les 
régions :

■ Choisissez View > Region > Original Time 
Stamp.

Pour masquer le marquage temporel original :

■ Choisissez View > Region > No Time.

Création d'un marquage temporel 
utilisateur

Pour créer un marquage temporel utilisateur 
SMPTE indépendant, exécutez la commande 
Time Stamp du menu déroulant de la liste des 
régions. Cette commande permet de 
sélectionner une ou plusieurs régions pour 
redéfinir leur marquage temporel. Le marquage 
temporel original et le marquage temporel 
utilisateur sont alors enregistrés avec la session.

Lors du premier enregistrement des données 
audio, le marquage temporel utilisateur 
correspond au marquage temporel original. 
Vous pouvez toutefois modifier le premier à tout 
moment à l'aide de la commande Time Stamp. 
Cette fonctionnalité est particulièrement utile 
en post-production, lorsque le timecode SMPTE 
des bandes vidéo de travail subit de nombreuses 
modifications d'une version de montage à 
l'autre.
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Pour marquer temporellement une ou plusieurs 
régions avec une nouvelle valeur SMPTE :

1  Sur une piste, sélectionnez la région à 
marquer.

2  Dans le menu déroulant de la liste des régions, 
choisissez la commande Time Stamp.

3  Entrez une nouvelle valeur SMPTE en 
effectuant l'une des opérations suivantes : 

• Entrez les valeurs manuellement (via les 
flèches de direction). 

• Cliquez sur le bouton Current Time Code 
(ou appuyez sur la touche Egal (=)), si vous 
souhaitez saisir l'adresse du timecode 
entrant

• Cliquez sur le bouton Current Selection, si 
vous souhaitez entrer l'heure de début de la 
sélection actuelle à l'écran.

4  Cliquez sur OK pour refermer la boîte de 
dialogue.

Cette commande peut être utilisée en mode de 
traitement « par lots » pour configurer de 
nouveaux marquages temporels pour plusieurs 
régions simultanément. Pour ce faire, il suffit de 
sélectionner plusieurs régions et d'exécuter la 
commande Time Stamp Selected. Des zones de 
dialogue correspondant à chaque région 
s'ouvrent successivement. Utilisez-les pour saisir 
les nouvelles valeurs.

Une fois saisis, les marquages temporels 
utilisateur peuvent être affichés dans toutes les 
régions appartenant à des pistes. 

Pour afficher le marquage temporel utilisateur sur 
les régions :

■ Choisissez View > Region > User Time Stamp.

Pour masquer le marquage temporel utilisateur :

■ Choisissez View > Region > No Time.

Pro Tools 5.x et utilisation d'une région 
avec un marquage temporel utilisateur 
dans une autre session

Pro Tools 5.x enregistre les informations 
relatives au marquage temporel pour chaque 
région sous la forme de paramètres de session et 
non au niveau du fichier audio lui-même. 
L'exportation d'une région sous forme de fichier 
génère un fichier où figurent les informations 
relatives au marquage temporel.

Pour utiliser une région Pro Tools 5.x dotée d'un 
marquage temporel dans une autre session, tout 
en conservant les marquages temporels 
inchangés :

1  Ouvrez la session contenant la région dotée 
du marquage temporel original.

2  Dans la liste des régions, sélectionnez la 
région que vous voulez exporter.

3  Dans le menu déroulant de la liste des régions, 
choisissez Export Regions as Files.

4  Dans la boîte de dialogue Export Selected, 
configurez les options d'exportation.

5  Cliquez sur l'option Export pour exporter le 
nouveau fichier audio.

Boîte de dialogue Time Stamp

Pour plus d'informations sur les options 
Export Selected, reportez-vous à la section 
Exportation d'une région sous forme de 
nouveau fichier audio, page 162.
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La région peut désormais être utilisée dans 
d'autres sessions sans modification de son 
marquage temporel original.

Identification d'un point de 
synchronisation
La commande Identify Sync Point de Pro Tools 
permet d'identifier un point particulier d'une 
région en vue de son placement audio (en mode 
Spot). 

Scénario de placement d'effets sonores : Votre 
effet sonore (d'un seul tenant) consiste en un 
grincement de porte, suivi du claquement de sa 
fermeture, qui résonne quelques secondes dans 
la réverbération de la pièce. La partie 
« claquement » de l'effet, qui doit être 
synchronisée exactement avec l'image, ne se 
produit pas au tout début du fichier audio, ni à 
la fin. Elle se trouve vers le centre du fichier, ce 
qui complique son positionnement.

Dans ce scénario, utilisez la commande Identify 
Sync Point pour créer un point dans la région, 
puis synchroniser ce point avec un timecode 
SMPTE. 

Création de points de synchronisation

Pour créer un point de synchronisation dans une 
région :

1  Cliquez avec le sélecteur sur le point de la 
région à synchroniser à un emplacement SMPTE 
précis. 

– ou –

Appuyez sur la touche fléchée vers le bas au 
cours de la lecture. 

2  Choisissez Region > Identify Sync Point. 
L'heure SMPTE actuelle est automatiquement 
entrée en tant qu'emplacement SMPTE pour le 
point de synchronisation. Une petite flèche 
orientée vers le bas s'affiche en bas de la région, 
avec une fine ligne grise verticale, pour indiquer 
l'emplacement du point de synchronisation.

Suppression des points de 
synchronisation

Pour supprimer un point de synchronisation, 
effectuez l'une des opérations suivantes :

■ Sélectionnez toute la région et choisissez 
Region > Remove Sync Point.

– ou –

■ Cliquez sur le point de synchronisation en 
maintenant enfoncée la touche Option 
(Macintosh) ou Alt (Windows) pour le 
supprimer.

Affichage des points de 
synchronisation

Vous avez la possibilité d'afficher ou de masquer 
les points de synchronisation dans les régions 
audio.

Pour désactiver l'affichage des points de 
synchronisation dans les régions audio :

■ Désélectionnez View > Region > Sync Point.

Pour activer l'affichage des points de 
synchronisation dans les régions audio :

■ Choisissez View > Region > Sync Point.

Points de synchronisation

Points de synchronisation
Guide de référence Pro Tools



Déplacement des points de 
synchronisation à l'aide de la souris

Vous pouvez faire glisser un point de 
synchronisation à l'emplacement de votre choix 
dans la région audio. 

Pour redéfinir le point de synchronisation en le 
faisant glisser :

1  Si vous souhaitez aligner le point de 
synchronisation sur la valeur de grille en cours, 
réglez le mode d'édition sur Grid.

2  Sélectionnez l'outil d'accrochage de temps.

3  Faites glisser le point de synchronisation vers 
un nouvel emplacement dans la région.

Scrubbing des points de 
synchronisation

Si la consultation d'une forme d'onde audio est 
un moyen pratique pour définir un point de 
synchronisation, il peut arriver que cette forme 
d'onde ne permette pas de repérer le point de 
synchronisation désiré dans les données audio. 
La technique de scrubbing permet justement de 
se positionner précisément sur le point de 
synchronisation lorsque vous le déplacez sur 
une forme d'onde audio.

Pour procéder au scrubbing tout en faisant glisser 
le point de synchronisation :

1  Si vous souhaitez aligner le point de 
synchronisation sur la valeur de grille en cours à 
la fin du scrubbing, réglez le mode d'édition sur 
Grid.

2  Sélectionnez l'outil de scrubbing.

3  Faites glisser le point de synchronisation vers 
un nouvel emplacement. Cela permet de lire le 
point de synchronisation en mode Scrub à 
mesure que vous le déplacez.

Résolution des problèmes de 
synchronisation
Il est parfois difficile de parvenir à un résultat 
satisfaisant en matière de synchronisation 
SMPTE. Les suggestions suivantes vous aideront 
à résoudre les problèmes les plus courants. 

Utilisez le champ Incoming/Current Time de la 
fenêtre Session Setup en tant que référence.

Le champ Current Time de la fenêtre Session 
Setup indique si Pro Tools reçoit du timecode. Si 
ce champ semble inactif lorsque du timecode 
entre dans votre périphérique de lecture de 
timecode, vérifiez les paramètres du 
périphérique matériel, sa connexion à 
l'ordinateur et votre configuration Multimedia 
Setup (Windows) et AMS (Macintosh).

Scrubbing d'un point de synchronisation

Curseur de scrubbing des 
points de synchronisation

Lorsque vous utilisez MachineControl, le 
champ Current Time affiche un code de 
9pin, même si le périphérique LTC n'est pas 
connecté.
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Couchez le code SMPTE avant 
l'enregistrement.

Toutes les bandes (audio et vidéo) utilisées dans 
votre configuration doivent être couchées avec 
un timecode SMPTE avant d'y enregistrer des 
données audio, ou dans Pro Tools. Si les bandes 
ne sont pas couchées avec un timecode, votre 
système peut sembler fonctionner mais la 
synchronisation ne s'effectue pas correctement. 
Au contraire, les machines et Pro Tools 
dériveront de plus en plus l'une par rapport à 
l'autre au fil du temps.

Ce problème se manifeste également lorsque des 
données audio sont enregistrées dans Pro Tools 
sans synchronisation SMPTE (si elles ont été 
enregistrées avant la session en cours, par 
exemple). Il sera alors impossible de 
synchroniser précisément les données audio 
avec un magnétophone analogique ou un 
magnétoscope, puisque les données audio de 
Pro Tools n'ont pas été enregistrées 
synchronisées au timecode SMPTE issu du 
magnétophone analogique ou du 
magnétoscope.

Synchronisez tous les composants de votre 
système.

Lors du couchage du timecode, assurez-vous que 
le générateur de timecode et le magnétoscope 
sont référencés à un même signal de référence, 
issu d'un quartz. Par exemple, lors du couchage 
d'un timecode à 29,97 i/s Drop Frame sur un 
magnétoscope, le générateur SMPTE et le 
magnétoscope doivent être référencés à un 
même générateur de « black burst » ou de house 
sync. Au cours de la lecture, la platine maîtresse 
doit aussi être référencés à ce signal de « black 
burst » ou house sync. 

Cette convention assure la compatibilité de 
votre bande entre les phases d'enregistrement et 
de lecture et lors de la lecture sur des appareils 
différents, dans d'autres studios. Ainsi, lors de la 
lecture d'une bande couchée avec un timecode, 
la machine lectrice doit être référencée à la 
même fréquence d'image que la machine 
d'enregistrement lors du couchage du timecode. 
Lorsque vous couchez un timecode sur une 
machine audio, celle-ci peut être en « roue 
libre » et non référencée ; en revanche, lors de la 
lecture, elle doit être contrôlée par un 
synchroniseur référencé à un signal de house 
sync.

Quelle est la valeur réelle de fréquence d'image 
de votre bande de travail ?

Si vous recevez vos bandes vidéo d'une société 
de production au lieu de les enregistrer vous-
même, vérifiez impérativement que la fréquence 
d'image SMPTE utilisée est correctement 
spécifiée sur la bande. Plusieurs formats de 
timecode utilisent la même résolution (telles 
que 23.976 i/s et 24 i/s) bien qu'ils fonctionnent 
à des fréquences d'image par seconde 
légèrement différentes.

Le périphérique SYNC I/O de Digidesign (et 
certains produits d'autres marques) peuvent 
servir à déterminer la fréquence d'image. Pour 
plus d'informations, reportez-vous à la section 
Détermination de la fréquence d'image SMPTE, 
page 774.

Fréquence 29,97 i/s Non-Drop non reconnue

29.97 i/s Non-Drop constitue une version 
légèrement plus lente du timecode 30 i/s Non-
Drop. Lorsque cette fréquence est utilisée en 
vidéo couleur, chaque image vidéo correspond à 
une image SMPTE, sans devoir utiliser de format 
de timecode Drop. Aucune image n'étant omise, 
les calculs horaires et de position se trouvent 
grandement simplifiés.
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Malheureusement, certains périphériques 
matériels et logiciels ne reconnaissent pas la 
fréquence d'image 29,97 Non-Drop en tant que 
telle. Par exemple, un convertisseur standard 
SMPTE-MTC quelconque ne la reconnaît pas 
explicitement. L'utilisateur doit indiquer au 
convertisseur d'attendre une fréquence de 30 i/s 
Non-Drop. En réalité, un grand nombre de 
périphériques reconnaissant le format SMPTE 
lisent correctement la fréquence 29,97 Non-
Drop s'ils sont configurés pour lire la fréquence 
30 i/s Non-Drop.

Tout lecteur SMPTE utilisant des valeurs de 
timecode pour effectuer des calculs en temps 
réel (à l'instar de Pro Tools en cas de 
déclenchement et de synchronisation à un code 
SMPTE) doit également être informé que la 
fréquence d'image est de 29,97 et non 30 i/s. 
Pro Tools permettant de choisir cette fréquence 
d'image, cela ne pose pas de problème 
particulier. En revanche, le problème réside 
dans l'incapacité de nombreux utilisateurs à 
distinguer ces deux fréquences.

Certaines sociétés de production fournissent des 
bandes de travail vidéo couchées avec un 
timecode à 29,97 i/s mais écrivent sur la boîte 
« 30 i/s NTSC », ce qui signifie en réalité 
29,97 i/s Non-Drop.

Ainsi, lorsque la bande arrive en votre 
possession, vous ne connaissez pas sa fréquence 
d'image réelle. Si vous envoyez un timecode 
29,97 Non-Drop à un système Pro Tools 
configuré pour recevoir un timecode à 30 i/s 
Non-Drop, il en résultera une dérive temporelle 
d'environ 1,8 image par minute, ce qui 
désynchronisera la lecture audio.

Modifiez les fréquences d'image avec 
précaution

Si vous modifiez les fréquences d'image de 
timecode en cours de session, bon nombre de 
convertisseurs SMPTE-MIDI Time Code devront 
être éteints puis rallumés afin de reconnaître la 
nouvelle fréquence d'image. 

Utilisez une source d'horloge constante.

Les fichiers sonores doivent si possible être joués 
en utilisant le même signal de référence que 
celui avec lequel ils ont été enregistrés. Cette 
précaution garantit une étroite correspondance 
entre les fréquences d'échantillonnage 
d'enregistrement et de lecture. 

Désactivation des fonctionnalités de gestion de 
l'alimentation et des économiseurs d'écran.

Ces logiciels peuvent empêcher provisoirement 
l'ordinateur de reconnaître des données MIDI 
(par exemple, le code MIDI Time Code). 
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Chapitre 35 : Utilisation de séquences 
QuickTime

Vous pouvez utiliser Pro Tools pour importer 
des séquences au format QuickTime et des 
données audio (fichiers MP3), accomplir des 
tâches de post-production audio, puis exporter 
le produit fini comme nouvelle séquence 
QuickTime.

A propos de QuickTime
La technologie de vidéo numérique QuickTime 
a pour objet de produire des fichiers vidéo, 
compacts destinés à un usage multimédia.

Utilisation de séquences 
QuickTime dans Pro Tools

Vous pouvez importer des séquences QuickTime 
au sein de sessions Pro Tools.

Une fois importée dans Pro Tools, une séquence 
QuickTime apparaît sur une piste Movie dédiée, 
dans la fenêtre Edit, ainsi que dans une fenêtre 
Movie flottante. Vous pouvez visualiser cette 
dernière sur un second moniteur équipé du 
dispositif vidéo approprié (dont une sortie 
FireWire de QuickTime DV). Lorsqu'une session 
contient une séquence QuickTime, Pro Tools 

s'en sert comme référence visuelle rapide à accès 
aléatoire, ce qui permet d'améliorer la séquence 
par l'ajout d'effets sonores, de musique, de 
bruitages, de dialogues ou d'autres effets audio. 

Pro Tools assure une synchronisation 
audio/vidéo précise à l'image près. Ainsi, vous 
pouvez utiliser votre système Pro Tools comme 
un système de montage audio off-line, ce qui 
libère la salle de montage vidéo. 

Piste Movie de Pro Tools affichée sous forme d'images

Fenêtre Movie de Pro Tools
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Avec Pro Tools vous pouvez :

◆ importer une séquence QuickTime dans une 
session ;

◆ importer des données audio à partir d'une 
séquence QuickTime ;

◆ importer des fichiers audio à partir d'un CD 
ou d'un CD-ROM ;

◆ importer des données audio à partir d'un CD 
audio (Macintosh uniquement) ;

◆ synchroniser des événements audio à une 
séquence QuickTime, en utilisant les fonctions 
d'édition de Pro Tools pour placer et décaler les 
régions par rapport aux images vidéo ;

◆ lire des éléments audio en mode Scrub en 
faisant suivre l'image de la séquence 
QuickTime ;

◆ utiliser la commande Bounce to QuickTime 
Movie de Pro Tools pour compiler un nouveau 
fichier film « aplani » QuickTime, lisible par 
toutes les applications compatibles QuickTime.

Si vous souhaitez éditer une séquence ou, d'une 
quelque autre façon, le modifier, vous devez 
revenir à votre logiciel d'acquisition et de 
montage vidéo (Avid Xpress DV par exemple) 
pour procéder à l'édition, puis importer la 
séquence éditée dans Pro Tools. 

Cartes d'acquisition/de lecture 
vidéo

Pour des applications professionnelles 
nécessitant impérativement une lecture en plein 
écran à 25 ou 30 images par seconde, nous 
conseillons l'achat d'une carte d'acquisition et 
de lecture vidéo de tierce partie agréée par 
Digidesign ou un périphérique DV Firewire 
externe. 

Pour plus d'informations sur les cartes 
d'acquisition vidéo compatibles, visitez le site 
Web de Digidesign.

Si vous êtes novice en post-
production audio

Si vous n'êtes pas familiarisé avec les notions de 
vidéo numérique, de timecode ou de traitement 
audio en post-production, les suggestions ci-
après vous aideront à gérer les impératifs audio 
et vidéo de votre session. Attention, certaines de 
ces notions ne s'appliquent pas à tous les 
projets.

Planifiez vos travaux en amont : définissez avec 
précision l'ensemble de votre projet avant de 
débuter l'acquisition vidéo. Pour obtenir des 
résultats optimaux avec le timecode SMPTE, 
assurez-vous que ce code est incrusté dans une 
fenêtre de la séquence. Efforcez-vous d'anticiper 
les éventuels problèmes de compatibilité et de 
configuration.

Vérifiez que votre séquence est conforme : 

veillez, lors de l'acquisition de la séquence 
QuickTime, à respecter la fréquence d'image 
désirée. Reportez-vous à la documentation de 
votre logiciel d'acquisition vidéo pour en savoir 
plus sur l'acquisition d'images. Nous conseillons 
d'appliquer cette procédure à toutes les 
acquisitions vidéo afin de garantir la précision 
ultérieure de lecture dans Pro Tools. 

Dans Pro Tools 5.2.x et les versions antérieures, 
si votre destination est une session Pro Tools 
ralentie, ce ralentissement a une incidence sur la 
vitesse de lecture de la séquence QuickTime. 
Pour utiliser une séquence dans une session 
ralentie, sa fréquence d'image doit être de 30 i/s.

Dans Pro Tools, il est possible d'acquérir 
des séquences compatibles Avid à l'aide de 
l'option AVoption|V10.
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Destination de la séquence (vidéo ou cinéma) :  
quelle est la destination finale de votre travail ? 
Un DVD, un système HD, la télévision, le 
cinéma, un CD audio ou un CD-ROM ? 
La réponse à cette question détermine 
notamment la fréquence d'échantillonnage la 
plus appropriée, la fréquence de timecode 
adaptée et les fréquences des pull-down ou pull-
up. Vérifiez soigneusement la fréquence d'image 
du timecode. Assurez-vous que vous connaissez 
la fréquence d'image de la source vidéo.

Espace de stockage : assurez-vous que votre 
disque dur contient l'espace nécessaire, et 
défragmentez régulièrement vos disques durs. 

Compatibilité vidéo : si vous ne procédez pas 
vous-même à la numérisation de vos données 
vidéo (c'est-à-dire si ces données se trouvent 
déjà sur le disque dur), identifiez le type de 
système d'acquisition et de lecture vidéo utilisé 
et assurez-vous que l'adaptation à cette méthode 
de compression de format est possible. Vérifiez 
si le timecode est ou non incrusté ou superposé 
sur une petite partie de la vidéo.

Configuration QuickTime 
requise
Pro Tools prend en charge la lecture de 
séquences QuickTime sans dispositif 
supplémentaire. Toutefois, avec des ordinateurs 
Macintosh équipés d'entrées vidéo plus anciens, 
les performances varient en termes de taille 
maximale d'image, de fréquence d'image et de 
fluidité de lecture. L'acquisition de séquences de 
30/25 i/s (images par seconde), soit 
60/50 trames par seconde, nécessite une carte 
d'acquisition vidéo et les logiciels et les 
dispositifs associés.

Séquences QuickTime et durée d'image

Tous les logiciels d'acquisition vidéo ne 
respectent pas précisément les durées des 
séquences. Reportez-vous à la documentation de 
votre logiciel d'acquisition vidéo pour en savoir 
plus sur l'acquisition précise à l'image près et la 
conformation de vos séquences à une durée 
correcte.

Pour tirer parti des fonctionnalités de lecture des 
séquences QuickTime de Pro Tools, les éléments 
suivants sont indispensables :

◆ Une version agréée par Digidesign de 
l'extension système d'Apple. Pour plus 
d'informations, visitez les site Web de 
Digidesign (www.digidesign.com/compato).

◆ Un logiciel de lecture et d'édition de 
séquences QuickTime (Avid XPress DV, par 
exemple) pour éditer et compiler les séquences 
QuickTime.

Vous pouvez également ajouter les éléments ci-
après :

◆ Les dispositifs et logiciels d'acquisition de 
séquences QuickTime, afin de numériser vos 
propres séquences à partir d'une bande vidéo ou 
d'une caméra.

◆ Un lecteur de DVD ou de CD-ROM pour 
profiter des séquences et clips audio QuickTime 
disponibles sur le marché.
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Options de lecture des 
séquences QuickTime
La page Operation Preferences propose trois 
options de priorité de lecture QuickTime : 
Normal, Higher et Highest. L'option Normal 
convient dans la plupart des cas. Si vous 
exécutez des séquences QuickTime en natif, 
c'est-à-dire, sans carte d'acquisition vidéo, vous 
devrez faire appel à une des autres options de 
priorité de lecture. Dans tous les autres cas, 
laissez le niveau de priorité de la lecture sur 
Normal. Il s'agit du paramètre par défaut.

Conseils pour optimiser les 
performances du disque dur

Si possible, connectez le disque dur que vous 
utilisez pour l'acquisition et la lecture de films à 
un bus SCSI, ATA/IDE ou FireWire autre que 
celui du lecteur contenant vos fichiers audio. 
Cela minimise les interférences entre les lecteurs 
lorsque Pro Tools requiert des données audio et 
vidéo. Vous obtiendrez ainsi des performances 
satisfaisantes avec la plupart des cartes 
d'acquisition vidéo et des fréquences 
d'acquisition de données modérées (800 Ko/s ou 
inférieures).

Pour obtenir des informations complètes sur la 
configuration de votre disque dur, visitez le site 
Web de Digidesign.

Importation d'une séquence 
QuickTime
Avant d'importer une séquence, numérisez vos 
séquences vidéo et identifiez les fréquences 
d'image et fréquences d'échantillonnage 
applicables. 

Pour importer une séquence QuickTime dans 
Pro Tools :

1  Lancez Pro Tools, puis créez une session ou 
ouvrez une session existante.

2  Assurez-vous que les paramètres de timecode 
de la session correspondent à ceux de la 
séquence à importer, puis enregistrez la session.

3  Choisissez File > Import > QuickTime Movie. 

Voir également Lecture Firewire de 
séquences QuickTime DV, page 803. 

Si la séquence QuickTime a été créée au 
moyen d'une carte vidéo dotée de fonctions 
de compression vidéo matérielle, Pro Tools 
ne peut pas lire la séquence sans ce 
dispositif de compression. Assurez-vous 
alors que la carte d'acquisition vidéo est 
installée et correctement configurée avant 
de démarrer une session.

Boîte de dialogue d'importation d'une séquence 
QuickTime
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4  Sélectionnez la séquence, puis cliquez sur 
Open. Pro Tools importe alors la séquence, et 
l'affiche sur une piste Movie dédiée dans la 
fenêtre Edit ainsi que dans une fenêtre Movie 
flottante. La première image de la séquence est 
automatiquement placée à l'heure de départ de 
votre session.

A propos de la piste Movie

Une fois importées dans Pro Tools, les séquences 
apparaissent dans la fenêtre Edit et sur une piste 
Movie dédiée. Selon vos paramètres d'affichage 
de piste Movie, la séquence s'affiche sous forme 
de blocs ou d'« imagettes », vues « réduites » des 
images de la séquence. La piste Movie fait 
apparaître plus ou moins de détails, selon le 
niveau de zoom choisi dans la fenêtre Edit : plus 
le zoom avant est important, plus les imagettes 
affichées sur la piste Movie sont nombreuses ; à 
l'inverse, plus le zoom arrière est important, plus 
le nombre d'imagettes affichées est réduit.

Une piste Movie se comporte comme une piste 
Pro Tools audio ou MIDI : il est possible de 
déplacer la région de la séquence avec l'outil 
d'accrochage de temps ou d'autres outils 
d'édition. Vous pouvez ainsi décaler le film à 
n'importe quel point de départ. Toutefois, il 
n'est pas possible de modifier la piste Movie par 
rognage ou acquisition des régions qui en font 
partie.

Vous ne pouvez associer à une session qu'une 
seule séquence QuickTime à la fois. Pour 
importer une autre séquence dans une session, 
répétez les étapes décrites précédemment. 
La nouvelle séquence remplace la séquence 
précédente dans la session. Le nom d'une piste 
Movie est issu du fichier de la séquence associé 
et ne peut pas être modifié indépendamment. 

Performances de l'affichage 
Frames View

Lorsque vous visualisez le contenu d'une piste 
Movie en affichage Frames View, les 
performances de l'ordinateur peuvent être 
réduites ou médiocres. Dans ce cas, faites passer 
l'affichage de la piste Movie en mode Blocks.

Lecture Firewire de 
séquences QuickTime DV
Grâce à l'ajout d'un transcodeur (décodeur) DV 
externe, vous pouvez lire les séquences 
QuickTime DV via le port Firewire de 
l'ordinateur. Il peut s'agir de séquences 
QuickTime exportées au format QuickTime DV 
à partir d'Avid Xpress DV.

Piste Movie au-dessus d'une piste audio dans la 
fenêtre Edit

Il est également possible de masquer la piste 
Movie pour optimiser les performances, si 
nécessaire.

Même si la lecture de séquences DV dans 
Pro Tools est possible sur Macintosh via le 
port Firewire, vous obtiendrez de meilleures 
performances en exécutant la séquence DV 
à partir du disque dur interne ATA du 
Macintosh.
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Pour obtenir les informations les plus récentes 
sur la compatibilité des transcodeurs Firewire, 
visitez le site Web de Digidesign 
(www.digidesign.com).

Les performances de QuickTime DV peuvent 
varier selon les besoins de votre système et de 
vos projets. 

Prise en charge des séquences 
QuickTime

« Referenced » et « Consolidated » : 
les séquences QuickTime DV exportées sont soit 
des fichiers Quicktime complets (contenant 
toutes les données), soit des fichiers de référence 
Quicktime (contenant simplement des renvois 
aux fichiers DV d'origine). 

Conditions requises par le codec : lorsque vous 
exportez un fichier depuis Avid Xpress DV, 
utilisez toujours le codec DV d'Apple. N'activez 
pas l'option « Use Avid Codec » de la boîte de 
dialogue Export. Les fichiers DV exportés avec le 
codec d'Avid ne pourront pas être lus avec 
Pro Tools. 

Films DV Stream : Pro Tools ne prend pas en 
charge les données audio des fichiers 
DV Stream. Les fichiers DV Stream contiennent 
tout le flux de données transmis ou enregistré 
par une caméra via le câble FireWire. Ce type de 
fichier sauvegarde l'image et le son en commun 
(procédé « Interleave »), tandis que les fichiers 
QuickTime mémorisent séparément les données 
audio et vidéo. 

Pour lire les séquences QuickTime DV via le port 
FireWire : 

1  Pour importer une séquence QuickTime DV 
dans une session Pro Tools, choisissez File > 
Import > QuickTime Movie.

2  Choisissez Options > QuickTime DV Out 
Firewire. 

Quand cette option est active, Pro Tools 
transmet les films DV (NTSC ou PAL) via le port 
FireWire à un décodeur DV externe. Cela permet 
d'améliorer les performances du système, car il 
n'est plus nécessaire que les données du film 
soient décompressées par le processeur de 
l'ordinateur, ni affichées à l'écran. 

Si la fenêtre Movie du bureau est ouverte 
pendant la lecture vidéo via le port FireWire, elle 
affichera le message « DV Movie Is Playing Out 
FireWire Port ». 

Retard entre l'image et le son

L'utilisation de cette fonction peut provoquer 
un décalage considérable entre la lecture des 
données vidéo et audio. 

Pour compenser le retard entre la lecture des 
données vidéo et audio :

1  Choisissez Setup > QuickTime Movie Offset. 

2  Entrez la valeur permettant de synchroniser le 
son et l'image. 

En général, il n'est nécessaire de définir cette 
valeur qu'une seule fois pour chaque type de 
décodeur DV utilisé. 

Voir également Exportation de séquences 
QuickTime DV depuis Avid, page 805. Pour obtenir une liste des cartes 

d'acquisition vidéo et transcodeurs agréés 
par Digidesign, reportez-vous au site Web 
de Digidesign :
www.digidesign.com/compato. 
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Exportation de séquences QuickTime 
DV depuis Avid

Vous trouverez ci-dessous les paramètres requis 
pour exporter des séquences à l'aide 
d'Avid XPress DV. Ces paramètres permettent 
de créer des séquences QuickTime DV que 
Pro Tools peut lire via le port Firewire. 

Pour exporter une séquence de référence 
QuickTime DV devant être lue par Pro Tools via le 
port Firewire : 

1  Activez les options d'exportation suivantes :

• Flatten video tracks

• Fill in spaces with black

• Render all video effects

• Use Apple DV Codec

• Enable the Apple DV codec

2  Vérifiez que l'option Use Avid Codec n'est pas 
activée.

Scrubbing de la piste Movie

L'outil de scrubbing permet de lire la piste Movie 
en mode Scrub (lecture avant/arrière à vitesse 
variable) tout en conservant une précision 
d'image parfaite. Si vous « scrubbez » 
directement la piste Movie, seule la piste sera lue 
en mode scrub (les données audio ne seront pas 
lues). Si vous appliquez le scrubbing à une piste 
audio, les données audio et vidéo associées 
seront lues simultanément en mode Scrub.

Pour appliquer le scrubbing à une piste Movie :

1  Sélectionnez l'outil de scrubbing.

2  Cliquez sur la piste Movie et faites glisser 
l'outil de scrubbing.

A propos de la fenêtre Movie

La fenêtre Movie affiche le film lu ou la dernière 
image lue lorsque la lecture est suspendue ou 
arrêtée. Vous pouvez faire glisser la fenêtre 
Movie n'importe où sur votre écran.

Vous pouvez sauvegarder ces paramètres 
d'exportation dans Avid XPress DV3.0 
comme valeurs par défaut, afin de simplifier 
les échanges ultérieurs de médias. Pour plus 
d'informations sur les paramètres 
d'exportation et les paramètres par défaut, 
reportez-vous à la documentation d'Avid 
Xpress.

Outil de scrubbing

Scrubbing d'une piste Movie

Pour affiner la précision du scrubbing, 
appuyez sur la touche Pomme pendant 
l'opération.

Fenêtre Movie

Outil de scrubbing 
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Pour afficher la fenêtre Movie :

■ Choisissez Window > QuickTime Movie. Si un 
film a déjà été importé, la fenêtre Movie 
apparaît.

Lecture sur un moniteur de 14 pouces

Si vous capturez des séquences 320 x 240 pixels 
(NTSC) et disposez d'un autre moniteur de 
résolution 640 x 480 (valeur standard pour un 
moniteur 14 pouces), cliquez sur la fenêtre 
Movie pour envoyer la lecture de la séquence 
vers cet écran. La séquence s'adapte à la taille 
d'image de ce second moniteur et s'affiche en 
double grandeur (à raison de deux pixels pour 
un) pour occuper la totalité de l'écran. 

Conseils pour optimiser la lecture 
d'un film

Etant donné que Pro Tools utilise QuickTime 
pour lire des séquences, la qualité de lecture 
dépend de la vitesse du processeur, des 
performances du disque dur, des dimensions 
d'image (en pixels) de la séquence et de la 
qualité du dispositif vidéo utilisé pour 
l'acquisition et la lecture des données vidéo 
numérisées. Bien que QuickTime ne garantisse 
pas une lecture de qualité Broadcast, le 
placement des sons à l'image est d'une précision 
à l'image près.

Sur les ordinateurs équipés d'une interface PCI, 
Pro Tools resynchronise la séquence en 
permanence. La séquence est référencée sur 
l'horloge d'échantillonnage audio et s'adapte 
ainsi sans problème à la bande son, y compris 
sur des systèmes à vitesse variable.

Pour une lecture vidéo plus cohérente, consultez 
les suggestions ci-après :

◆ Utilisez une carte d'acquisition et de lecture 
vidéo agréée Digidesign si vous souhaitez 
profiter d'une lecture en plein écran des films à 
une fréquence de 25/30 images par seconde.

◆ Affichez le film sur un écran distinct piloté par 
sa propre carte d'acquisition et de lecture vidéo.

◆ Si vous ne disposez pas d'une carte 
d'acquisition et de lecture vidéo, définissez 
l'option QuickTime Playback Priority sur Higher 
ou Highest dans la page Operation Preferences. 
La priorité sera ainsi donnée à la lecture de film 
et non aux autres tâches graphiques de l'écran 
telles que le déplacement de faders.

◆ Choisissez un ordinateur équipé d'un 
processeur extrêmement rapide.

◆ Capturez et lisez les séquences QuickTime sur 
un disque dur autre que les disques audio 
Pro Tools. 

◆ Désactivez la préférence d'automation Faders 
Move During Playback.

◆ Réglez l'option de défilement sur None 
(Options > Scrolling > None).

◆ Réduisez autant que possible la taille de la 
fenêtre Edit.

◆ Fermez les fenêtres inutiles.

◆ Réduisez la longueur totale de la chaîne SCSI 
de votre système pour en optimiser le débit.

◆ Réduisez la résolution en pixels de la séquence 
(par exemple, passez de 640 x 480 pixels à 
320 x 240 pixels).

◆ Cachez la piste vidéo quand vous n'en avez 
pas besoin. 

Voir également Lecture Firewire de 
séquences QuickTime DV, page 803.
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◆ Si vous utilisez des cartes d'acquisition vidéo 
ou transcodeurs pour lire de façon autre qu'à 
l'écran de l'ordinateur, vous risquez de devoir 
maintenir la fenêtre QuickTime ouverte pour la 
sortie de la séquence. Dans ce cas, vous pouvez 
améliorer la gestion de l'écran en minimisant la 
séquence de sorte qu'elle n'apparaisse pas sur le 
moniteur de votre ordinateur.

Pour minimiser la fenêtre de QuickTime Player :

1  Fermez la session. 

2  Ouvrez la séquence dans QuickTime Player et 
minimisez-la. 

3  Sélectionnez Save, puis Quit QuickTime 
Player. 

4  Ouvrez la session et déplacez la fenêtre 
QuickTime hors de toute fenêtre Pro Tools.

Définition de l'heure de début 
de la séquence (décalage de 
la séquence)
Lors de l'importation d'une séquence dans votre 
session, la première image de la séquence se 
synchronise par défaut avec l'heure de début de 
session. Dans certains cas, toutefois, il peut être 
nécessaire de décaler la séquence vers l'avant ou 
vers l'arrière, afin de positionner précisément le 
son sur le film. 

Dans la mesure où il est possible de déplacer une 
séquence dans la piste Movie, il est relativement 
facile de faire correspondre les positions 
temporelles de l'image et du son. En pratique, il 
peut ne pas être nécessaire de déplacer la piste 
Movie. 

Pour affiner le réglage de l'heure de départ d'une 
séquence, vous pouvez décaler la séquence par 
incréments de quarts d'image (demi-trames) à 
l'aide de la commande QuickTime Movie Offset. 

Ce procédé, plus précis que le déplacement de la 
piste Movie, s'avère particulièrement utile 
lorsque la piste Movie débute avec une « image 
partielle », plus difficilement repérable.

Pour définir le décalage (Offset) de la séquence :

1  Vérifiez soigneusement que la fréquence 
d'image SMPTE de la session correspond à celle 
de la séquence.

2  Choisissez Setup > QuickTime Movie Offset, 
saisissez une valeur de décalage, puis cliquez 
sur OK.

3  Verrouillez la séquence « en position » en 
choisissant Region > Lock/Unlock.

Pour placer la séquence sur un point de 
synchronisation :

1  Vérifiez soigneusement que la fréquence 
d'image SMPTE de la session correspond à celle 
de la séquence.

2  Dans la fenêtre Edit, activez le mode Grid.

3  Définissez le format d'affichage temporel de la 
session sur SMPTE.

4  Définissez la valeur de la grille sur Time Code.

5  A l'aide du sélecteur, cliquez sur la piste Movie 
afin de placer le curseur à l'emplacement où 
vous souhaitez créer un point de 
synchronisation. Le repère le plus approprié se 
situe généralement deux secondes ou 48 images 
avant la première image (début de la séquence 
vidéo), emplacement normalisé du « start ». 
Vous pouvez déplacer le curseur et la séquence 
image par image à l'aide des touches plus et 
moins du clavier alphanumérique.

Le décalage de la séquence QuickTime est 
toujours définie en quarts d'image, quel que 
soit le format d'affichage temporel de la 
session.
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6  Choisissez Region > Identify Sync Point pour 
placer un point de synchronisation au point 
d'insertion du curseur.

7  Activez le mode Spot en cliquant sur le bouton 
Spot dans la fenêtre Edit.

8  Cliquez sur la piste Movie avec l'outil 
d'accrochage de temps. La boîte de dialogue 
Spot apparaît.

9  Saisissez la valeur du timecode apparaissant 
dans la fenêtre incrustée dans l'image sur 
laquelle vous désirez vous placer (si une fenêtre 
de timecode SMPTE est incrustée dans la 
séquence), puis cliquez sur OK.

Le point de synchronisation de la séquence se 
déplace vers l'emplacement SMPTE ainsi défini.

Placement de données audio 
sur une séquence QuickTime
Pour un positionnement précis, le mode Grille 
constitue un outil efficace permettant de 
sélectionner rapidement et précisément des 
formes d'ondes et des alignements de régions 
dans les pistes. Lorsque le mode Grid est activé, 
le sélecteur travaille en fonction du pas de grille 
défini ; les régions sélectionnées avec l'outil 
d'accrochage de temps et déplacées vers une 
piste s'alignent aussi sur cette valeur de grille.

Vérifiez que votre séquence est 
conforme

Avant de placer des données audio sur une 
séquence, assurez-vous que le fichier de 
séquence est conforme, afin que chaque image 
débute et finisse sur des emplacements valides. 
Il est conseillé de conformer la séquence à une 
fréquence de timecode reconnue par Pro Tools 
(30 i/s ou 29,97 i/s). 

Consultez la documentation de votre logiciel 
d'acquisition vidéo pour en savoir plus.

Conseils supplémentaires pour le 
placement des données audio

◆ Spécifiez la taille d'image de la séquence. Pour 
le placement de données audio, la résolution 
320 x 240 convient généralement. Si vous 
visualisez la séquence sur un autre moniteur 
d'une résolution de 640 x 480 avec un doublage 
de pixels, elle occupera tout l'écran. 

◆ Lors du traitement de séquence, l'utilisation 
d'une fenêtre avec incrustation de timecode 
facilite le placement des données. Vous pouvez 
incruster vous-même le timecode lors de 
l'acquisition de données à l'aide de l'interface 
SYNC I/O de Digidesign.

◆ Réglez l'option de défilement (dans le menu 
Options) sur Continuous ou Center Playhead.

Placement et déplacement de 
régions à l'image près en mode 
Grid
(Pro Tools HD et Pro Tools LE avec DV Toolkit 
uniquement)

Le mode Grid permet de restreindre le 
déplacement des régions à des valeurs SMPTE 
(minutes, secondes, images ou sous-images).

Pour placer des données audio sur une séquence :

1  Cliquez sur le bouton Grid situé dans l'angle 
supérieur gauche de la fenêtre Edit. De la sorte, 
les données audio correspondront à un début 
d'image.

Les options de défilement Continuous et 
Center Playhead requièrent l'utilisation 
d'une unité centrale plus puissante et 
risquent de dégrader la qualité de lecture de 
votre séquence.
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2  Dans le menu déroulant, réglez la valeur de 
grille (Grid Value) sur Time Code. 

3  Choisissez une unité de grille appropriée. 
Remarque : il est possible de définir les unités de 
grille indépendamment de l'échelle temporelle 
principale.

4  A l'aide du sélecteur, placez le point 
d'insertion à l'emplacement de votre choix sur la 
séquence. Si vous le souhaitez, choisissez l'image 
en tant qu'unité de décalage dans le menu 
déroulant Nudge Value. Vous pouvez alors 
déplacer le point d'insertion image par image à 
l'aide des touches plus et moins du clavier 
alphanumérique.

5  Maintenez la touche Contrôle enfoncée, 
pendant que vous faites glisser la région choisie 
de la liste Regions vers la piste appropriée. 
Pro Tools place alors automatiquement la région 
au point d'insertion du curseur.

Importation de données audio 
QuickTime (et de fichiers 
vidéo compressés)
Pro Tools permet d'importer des données audio 
directement depuis une séquence QuickTime. 
Vous pouvez importer des données audio depuis 
une séquence chargée dans une session ou à 
partir de toute autre séquence. La procédure est 
identique dans les deux cas.

Pro Tools est compatible avec les formats de 
fichiers compressés QuickTime suivants :

• MP3

• QDesign

• uLaw 2:1

• aLaw 2:1

• Intel ADPCM

• Microsoft ADPCM

• IMA 4:1

• 32 bits virgule flottante

• 64 bits virgule flottante

• 16 bits Big Endian

• 16 bits Little Endian

• MACE 6:1

• MACE 3:1

Vous pouvez importer des fichiers QuickTime 
dans des sessions à l'aide de la commande 
Import Audio from Current Movie (si la 
séquence QuickTime est déjà ouverte dans la 
session) ou de la commande Import Audio from 
QuickTime Movie.

Qualité de conversion de 
fréquence d'échantillonnage

Si vous importez des données audio QuickTime 
qui n'ont pas été enregistrées à la fréquence 
d'échantillonnage de la session, la fréquence 
d'échantillonnage est convertie afin de 
correspondre à celle des données audio de la 
session. Pro Tools permet de choisir la qualité de 
la conversion de la fréquence d'échantillonnage 
à l'aide du paramètre Conversion Quality de la 
page Editing Preferences. 

Cinq qualités de conversion sont possibles, 
classées par ordre croissant (de Low à 
TweakHead). Plus cette qualité est élevée, plus la 
conversion du fichier prémixé est longue.

Pour placer des éléments directement dans 
la séquence, utilisez la technique décrite 
précédemment. Dans ce scénario, le mode 
Auto Spot n'est pas conseillé, car il utilise la 
valeur du MTC entrant comme information 
de position.
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Pour définir la qualité de conversion de la 
fréquence d'échantillonnage :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Editing.

2  Cliquez sur le menu déroulant Conversion 
Quality et sélectionnez un paramètre de 
conversion.

Importation de données audio à 
partir d'une séquence QuickTime

Vous pouvez utiliser la commande Import 
Audio from Current Movie pour importer des 
pistes audio depuis une séquence QuickTime 
utilisée dans la session en cours. Pour importer 
de l'audio depuis une autre séquence QuickTime 
vers votre disque dur ou CD (Macintosh 
uniquement), servez-vous de la commande 
Import Audio from QuickTime Movie ou faites 
glisser les pistes de votre choix à partir du 
navigateur DigiBase, de l'Explorateur Windows, 
du Finder Macintosh ou d'un dossier.

Pour importer des pistes audio à partir d'une 
séquence QuickTime (à l'aide des commandes de 
menu) :

1  Effectuez l'une des opérations suivantes :

• Pour importer des données audio à partir 
d'une séquence QuickTime présente dans 
la session, choisissez File > Import > Audio 
From Current Movie.

– ou –

• Pour importer des données audio à partir 
d'une séquence QuickTime non importée 
dans la session, choisissez File > Import > 
Audio from QuickTime Movie. 

2  Sélectionnez la séquence QuickTime à partir 
de laquelle vous souhaitez importer des données 
audio. La boîte de dialogue Track Import 
s'affiche, indiquant les informations relatives 
aux pistes audio. 

3  Sélectionnez les pistes audio que vous 
souhaitez importer en cliquant dessus. Pour 
sélectionner plusieurs pistes contiguës dans 
cette boîte de dialogue, cliquez dessus en 
maintenant la touche Maj enfoncée. Pour 
sélectionner des pistes non contiguës, 
maintenez enfoncée la touche Pomme pendant 
que vous cliquez dessus.

4  Cliquez sur OK. Les données audio sont 
converties à la fréquence d'échantillonnage et à 
la résolution de la session, et une nouvelle 
région s'affiche dans la liste des régions pour 
chaque fichier importé (deux régions 
apparaissent pour chaque fichier stéréo 
importé). La liste des régions affiche le nom de la 
région, le nombre de pistes initiales et le numéro 
de la région sur la piste. 

5  Faites glisser les régions importées de la liste 
des régions vers votre session. 

Pour utiliser DigiBase pour l'importation 
d'audio depuis des CD par glisser-déposer, 
consultez la section Importation de 
fichiers et de régions audio en les faisant 
glisser, page 153.

Pour obtenir des informations détaillées sur 
l'utilisation de DigiBase pour importer de 
l'audio, reportez-vous au Guide DigiBase.

Fenêtre Track Import affichant la piste audio d'une 
séquence QuickTime
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Report du son sur une 
nouvelle séquence
Une fois le mixage final achevé et les 
événements audio synchronisés à la séquence 
vidéo, vous pouvez exécuter la commande 
Bounce to QuickTime Movie de Pro Tools pour 
compiler une nouvelle séquence QuickTime, 
incorporant votre mixage sur sa piste son. En 
tant que fichier QuickTime, la nouvelle 
séquence est reconnue par toutes les 
applications logicielles prenant en charge les 
données vidéo QuickTime.

Pour créer une séquence QuickTime incorporant le 
mixage audio sur sa piste son :

1  Réglez les volumes de sortie de piste et 
finalisez votre mixage. Tous les paramètres 
d'insert et d'effets actifs sur les pistes figureront 
définitivement sur les pistes de mixage.

2  Assurez-vous que le son que vous entendez est 
celui que vous souhaitez reporter et que les 
affectations de sortie « prémixage sur disque » 
correspondent aux sorties que vous entendez.

3  Pour mixer la session tout entière, cliquez sur 
le bouton Return to Zero dans la fenêtre 
Transport afin de retourner au début de la 
session. Le nouveau fichier de séquence 
comprendra toutes les données audio et vidéo 
de la session, même si les fichiers audio sont plus 
longs que les fichiers vidéo et inversement. Pour 
reporter le son sur une partie d'une session 
seulement, ouvrez la fenêtre Edit et sélectionnez 
la section choisie. 

4  Choisissez File > Bounce to > Quicktime 
Movie. 

5  Choisissez le format de fichier des données 
audio de la séquence. Choisissez Stereo pour 
conserver le mixage stéréo de la session sur la 
piste son de la séquence. Choisissez l'option 
Mix-to-Mono pour combiner la sortie des 
canaux gauche et droit de la session vers une 
piste son mono.

6  Choisissez la résolution des données audio de 
séquence. Les CD audio Red Book sont toujours 
enregistrés en 16 bits alors que les présentations 
multimédia et les CD-ROM utilisent une 
résolution 8 bits. Il est impossible de créer une 
séquence QuickTime avec des données audio 
24 bits. Les données audio issues des sessions 
24 bits sont converties au format 16 ou 8 bits 
selon les options choisies.

Boîte de dialogue Bounce to QuickTime Movie

L'option Mix-to-Mono peut provoquer un 
écrêtage si vous ne laissez pas une marge de 
sécurité de 6 dB dans le mixage.
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7  Pour convertir la résolution de la session en 
8 bits en vue d'une utilisation multimédia, 
utilisez l'option Squeezer (cliquez sur l'option 
Convert after Bounce, puis sur le bouton 
Settings pour accéder à cette fonction) afin 
d'optimiser la fidélité des données audio en 
8 bits. Cette option repose sur un algorithme 
DSP propriétaire qui prétraite les données audio 
à l'aide des fonctions de compression, de 
limitation et de gating avant de les convertir en 
8 bits. Cette option est recommandée pour 
optimiser les résultats des données audio 8 bits.

8  Sélectionnez la fréquence d'échantillonnage 
des données audio de la séquence (pour accéder 
à cette option, cliquez sur Convert after Bounce, 
puis sur le bouton Settings). La fréquence 
d'échantillonnage audio par défaut est de 
44 100 (44,1 kHz), fréquence standard des CD 
audio. Les présentations multimédias et les 
CD-ROM peuvent utiliser une fréquence 
d'échantillonnage de 11 025 (11,025 kHz) ou 
22 050 (22,050 kHz). 

9  Cliquez sur Bounce, donnez un nom à la 
nouvelle séquence et choisissez l'emplacement 
d'enregistrement.

10  Les pistes audio sont converties à la 
fréquence d'échantillonnage et la résolution 
sélectionnées ; une nouvelle séquence 
« aplanie » incorporant les données audio est 
créée. Vous pouvez ouvrir et lire cette nouvelle 
séquence dans toute application logicielle 
prenant en charge QuickTime.

Les conversions de fréquence 
d'échantillonnage et de résolution dans 
Pro Tools consomment une puissance de 
calcul importante. Pour gagner du temps, 
choisissez une qualité de conversion de 
fréquence d'échantillonnage plus faible 
dans la page Editing Preferences.
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Glossaire

.AVI : format de fichier film pour le composant 
Video for Windows de Microsoft Media Player, 
reconnu par Pro Tools.

.WAV : format audio standard de Microsoft 
(se prononce comme « wave », qui signifie onde 
en anglais). Ce format est lisible par Pro Tools 
tant sur Macintosh que sous Windows.

9 broches (Sony 9 broches ; DB-9) : norme de 
télécommande, via port série, des fonctions de 
transports de machines professionnelles audio 
et vidéo, définie par Sony et d'autres 
constructeurs. Le chiffre 9 fait référence au 
connecteur de type DB-9 à 9 broches des 
périphériques compatibles. 

A/N (analogique-numérique) : les convertisseurs 
analogiques-numériques fonctionnent à des 
résolutions et des fréquences d'échantillonnage 
diverses. Ils convertissent les signaux audio 
analogiques en signaux numériques.

Acheminement : chemin d'acheminement 
interne. 

transport d'un ou plusieurs signaux vers une ou 
plusieurs destinations (qu'elles soient internes 
ou externes).

ADAT (Alesis Digital Audio Tape) : format 
numérique standard utilisé pour la connexion 
par fibre optique de périphériques audio. Créé 
par Alesis, le format ADAT transporte 
simultanément huit canaux.

Adresse (timecode) : référence ou lecture d'un 
emplacement spécifique, exprimé en timecode 
(code temporel) SMPTE/EBU, au format 
heures:minutes:secondes:images. 

Adresse de timecode : voir Adresse.

AES/EBU (Audio Engineering Society/European 
Broadcasters'Union) : format professionnel pour 
le transfert de données audionumériques entre 
périphériques audio de qualité professionnelle. 
La plupart des connexions AES/EBU transitent 
par un connecteur 3 broches de type XLR, qui 
transporte deux canaux audionumériques.

AIFF(Audio Interchange File Format) : format de 
fichier audio d'Apple Computer.

AMS (Audio MIDI Setup) : système audio et MIDI 
d'Apple Computer, partie intégrante de son 
Mac OS X. Pour les utilisateurs Macintosh, AMS 
remplace l'OMS (Open Music System) d'Opcode 
Systems.

ASIO, pilote : le pilote ASIO Digidesign est un 
pilote audio multicanal client unique qui 
permet à des programmes audio tiers ASIO 
prenant en charge la norme ASIO d'enregistrer 
et de lire des données audio via les interfaces 
audio Digidesign agréées.

ATR (Audio Tape Recorder) : magnétophone à 
bandes applicable à tous les formats, englobe 
également les magnétophones numériques à 
cassette (DAT).
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Audio (interface) : sur la plupart des systèmes 
Pro Tools, l'interface audio est un boîtier séparé 
raccordé à la carte son ou au port USB ou 
FireWire par un câble spécial. Habituellement, 
une interface audio comporte des entrées et des 
sorties analogiques et numériques et peut être 
équipée de vumètres, de commandes de niveau 
et autres fonctions.

Audio (région) : fichier audio défini de manière 
non-destructive au moyen de pointeurs. Voir 
également Région. 

AudioSuite (plug-in) : format de plug-in 
Digidesign exclusif, ne travaillant pas en temps 
réel. Les plug-in AudioSuite sont généralement 
utilisés pour traiter et modifier des fichiers audio 
sur le disque. Ils servent moins à la modification 
en temps réel. Selon sa configuration, un plug-
in AudioSuite non temps réel modifiera le 
fichier source ou créera un fichier audio.

AUX (auxiliaire) : voir Entrées auxiliaires.

Auxiliaire (départ) : voir Départ. 

AVoption|V10 : interface vidéo et logiciel 
intégrant la technologie vidéo Avid dans les 
systèmes Pro Tools|HD.

Base de données : outil pratique de stockage, 
d'organisation, de recherche et d'affichage des 
informations. Un fichier de base de données 
désigne un ensemble d'entrées contenant des 
données. Dans ce guide, une base de données 
désigne toujours un fichier de base de données. 
Pro Tools crée et sauvegarde les fichiers de base 
de données sur les volumes locaux requis.

Black burst : voir Référence vidéo house.

BNC : connecteurs pour câble coaxial utilisés 
pour la transmission des signaux vidéo et de 
synchronisation. 

Bounce to Disk : mixage d'un segment audio 
(ou d'une session entière) en interne sur le 
disque, sans quitter le domaine numérique. 
Pro Tools fournit des options de résolution et de 
dithering, ainsi que différents autres paramètres, 
pour le prémixage sur disque.

Broadcast WAV, fichier (BWF) : variante du 
format de fichier audio .WAV créé par 
Microsoft. Ce type de fichier contient des 
données supplémentaires sur le titre, l'origine, la 
date et l'heure de création des données audio 
absentes du format de fichier standard .WAV. 
Parmi les caractéristiques importantes des 
fichiers BWF figure la compatibilité avec le 
marquage temporel. Le marquage temporel 
permet de déplacer aisément des fichiers d'une 
session à l'autre et de les aligner facilement par 
rapport à leur position temporelle d'origine. 

Châssis d'extension : étend la capacité des 
systèmes Pro Tools|HD en fournissant des 
emplacements PCI externes supplémentaires.

Clip (indicateur d'écrêtage) : voyant situé en 
haut de chaque vumètre de canal, indiquant 
qu'un niveau risque d'avoir dépassé la marge de 
sécurité et approche l'écrêtage. 

Contrôleur continu (données de) : messages 
MIDI applicables aux paramètres des notes 
MIDI, tels que volume, panoramiques, vélocité, 
Pitch Bend (variation de hauteur) et 
modulation. Désigne aussi le type d'instructions 
principales transmises par les surfaces de 
contrôle MIDI.

Control|24 : surface de contrôle Digidesign 
dédiée pour les systèmes Pro Tools. Elle 
comporte 16 préamplificateurs de micro haute 
qualité, une section d'écoute de cabine et un 
prémixeur de ligne. Il s'agit d'un système idéal 
pour les fonctions d'enregistrement, de mixage 
et d'édition de Pro Tools.
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CoreAudio : le pilote CoreAudio de Digidesign 
est un pilote audio multicanal multiclient qui 
permet à des applications compatibles 
CoreAudio d'effectuer des opérations de lecture 
et d'enregistrement via un périphérique 
Digidesign. 

Crossfade : fonction de fondu-enchaîné entre 
deux régions. La durée des crossfade peut être 
sélectionnée par l'utilisateur à partir de la 
fenêtre Edit. De même que les fondus, les parties 
des enregistrements audio auxquels cette 
fonction est appliquée sont enregistrées dans le 
dossier Fade Files de la session.

Curseur d'édition : trait clignotant qui apparaît 
lorsque vous cliquez sur une piste de la fenêtre 
Edit.

DAE (Digidesign Audio Engine) : système 
d'exploitation en temps réel de Digidesign 
fournissant les fonctionnalités essentielles pour 
l'enregistrement sur disque dur, le traitement 
numérique de signal, l'automation du mixage et 
les fonctions MIDI requises par Pro Tools et les 
autres produits de Digidesign. 

DB-9 : voir 9 broches. 

Départ : sortie de piste supplémentaire ajustable 
qui peut être envoyée vers un bus interne pour 
le traitement, le contrôle et le prémixage des 
effets.

Digi 002 studio FireWire de Digidesign pour les 
systèmes Pro Tools LE, avec surface de contrôle 
intégrée. Inclut huit faders tactiles motorisés et 
huit codeurs rotatifs sensibles à la vélocité, huit 
entrées et sorties analogiques, quatre 
préamplificateurs de micro, huit canaux d'E/S 
ADAT optiques, deux canaux d'E/S S/PDIF et des 
convertisseurs A/N et N/A 24 bits/96 kHz.

Digi 002 Rack : version rack de Digi 002 de 
Digidesign. Ce système Pro Tools LE basé sur la 
technologie FireWire inclut huit entrées et des 
sorties analogiques, quatre préamplificateurs 
micro, huit canaux d'E/S ADAT optiques, deux 
canaux d'E/S S/PDIF, et des convertisseurs A/N et 
N/A 24 bits/96 kHz.

Digidesign Audio Engine : voir DAE.

Dithering : « bruit » ajouté à un signal audio lors 
de la réduction de sa résolution numérique. 
Le dithering permet d'obtenir une meilleure 
qualité dans les faibles niveaux.

Drop Frame : variante du timecode SMPTE/EBU 
utilisée pour le standard vidéo couleur NTSC 
(29,97 i/s), qui supprime deux images toutes les 
minutes (images 0 et 1), sauf toutes les dixièmes 
minutes. 

DSP (Traitement numérique du signal) : toute 
manipulation du son numérique, depuis la 
réverbération jusqu'aux modifications de 
niveau.

E/S MIDI : interface MIDI USB de Digidesign. 
Dotée de 10 entrées et sorties MIDI, elle permet 
la communication sur un total de 160 canaux 
MIDI et est compatible avec toutes les normes 
principales de format de marquage temporel 
(améliorant ainsi la précision et la 
synchronisation).

Ecoute : écoute, ou « vérification », d'un ou 
plusieurs fichiers ou pistes audio. Pro Tools offre 
la possibilité d'écouter les fichiers audio avant 
de les charger dans le programme. Il existe 
également plusieurs méthodes pour écouter des 
prises à partir de la liste des régions, du menu 
déroulant Takes List et des navigateurs DigiBase.
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EDL (Edit Decision List) : liste de points de 
montage, indiquant généralement les temps 
d'entrée et de sortie source de chacun de ces 
points, le numéro de la bobine source ainsi que 
les temps d'entrée et de sortie d'enregistrement.

Elément : dans DigiBase, chaque entrée de base 
de données s'affiche dans la liste des éléments 
sous forme d'élément. Ces éléments 
comprennent notamment les volumes, 
catalogues, fichiers de session et fichiers médias, 
ainsi que d'autres types de fichiers.

Emplacement mémoire : Pro Tools gère jusqu'à 
999 emplacements mémoire, qui peuvent être 
des marqueurs, des sélections d'édition, des 
plages d'enregistrement et de lecture, des 
paramètres de piste et autres données. Il est 
possible de les faire apparaître et de les trier dans 
la fenêtre Memory Locations (emplacements 
mémoire), ainsi que d'y accéder à partir de 
celle-ci.

En ligne (média) : caractère d'un média branché 
et directement accessible à l'ordinateur. 

En ligne (synchronisation) : caractère d'un 
appareil piloté par un autre pour la reproduction 
ou l'enregistrement synchronisé.

Entrée : élément d'une base de données. 
Une base de données est un ensemble d'entrées. 
Chaque entrée correspond à un type de fichier 
particulier (tel qu'un fichier média ou un fichier 
de session). L'entrée contient toutes les 
métadonnées décrivant le fichier mais ne 
contient aucun des supports. Par conséquent, 
une entrée est nettement plus petite que le 
fichier en question, ce qui facilite l'analyse des 
informations.

Entrées auxiliaires (pistes d'entrée auxiliaire) : 
dans Pro Tools, ces canaux d'entrées sont utilisés 
pour les départs et les retours bus (entrée 
uniquement). Les départs sont utilisés pour 
l'acheminement de la sortie.

Esclave : périphérique « suivant » le maître 
pendant la synchronisation. 

ExpressPro-Tools : utilitaire signé ATTO 
permettant de préparer les disques durs pour 
Pro Tools. Le système Mac OS X requiert 
ExpressStripe, la nouvelle version de cet 
utilitaire.

Fenêtre Universe : fenêtre donnant un aperçu 
global de toutes les pistes d'une session. Elle 
permet également d'aller rapidement à 
n'importe quel endroit dans une session.

Fibre optique : voir ADAT.

Fichier de session : fichier de travail audio, à 
l'instar d'un document de traitement de texte ou 
un fichier issu d'un programme graphique. Un 
fichier de session Pro Tools contient des 
données spécifiant la manière dont les fichiers 
média sont lus et affichés. Il contient également 
des métadonnées décrivant les fichiers dont il 
dépend (fichiers audio et MIDI, ainsi que les 
données liées telles que les faders, playlists et 
sélections). Chaque projet est enregistré 
séparément dans sa propre session.

Fichier média : ce type de fichier contient des 
données audio, vidéo ou graphiques. Ces 
fichiers comprennent aussi une série de 
métadonnées (telles que le nom et le format de 
fichier).

Fichier MIDI standard : format universel lisible 
par quasiment tout logiciel compatible MIDI. 
Type 0 is a single line sequence, type 1 is 
multitrack.
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FireWire : norme de périphérique rapide 
permettant le transfert de données. La norme 
FireWire est généralement utilisée avec les 
périphériques audio vidéo numériques ainsi 
qu'avec les disques durs externes et autres 
périphériques rapides.

Fondu : partie d'une région où le niveau 
augmente ou diminue, généralement à partir de 
–∞. Voir Crossfade.

Forme d'onde : représentation visuelle d'un son. 
Lorsque des régions audio sont importées dans 
la fenêtre Edit de Pro Tools, il est possible de les 
afficher sous forme d'onde dans la vue prévue à 
cet effet. Les aperçus de formes d'onde peuvent 
également être visualisés dans les navigateurs 
DigiBase.

Fréquence d'échantillonnage : Nombre de fois 
où le signal entrant est échantillonné par 
seconde lors de la conversion du signal 
analogique en signal numérique. Il s'agit de 
l'une des deux principales spécifications de la 
qualité des enregistrements audio numériques 
(l'autre étant la résolution numérique). 

Fréquence Nyquist : fréquence audio la plus 
haute qui peut être échantillonnée avec 
précision. Elle équivaut à la moitié de la 
fréquence d'échantillonnage. Le théorème de 
Nyquist sur l'échantillonnage a démontré que la 
fréquence d'échantillonnage doit être au moins 
égale à deux fois la fréquence la plus élevée 
présente dans l'échantillon pour que le signal 
d'origine puisse être recréé avec précision.

Génération de timecode : processus consistant à 
créer un timecode « tout neuf ». 

Grid (mode) : mode permettant d'aligner les 
régions des pistes sur une grille ou dans les 
limites de la grille. Voir également Grid absolu 
(mode) et Grid relatif (mode).

Grid absolu (mode) : mode d'édition produisant 
un déplacement et un alignement forcé des 
régions sur une échelle précise définie dans une 
grille utilisateur. Voir également Grid relatif 
(mode).

Grid relatif (mode) : mode d'édition produisant 
un déplacement et un alignement forcé des 
régions sur une échelle précise définie dans une 
grille utilisateur, tout en permettant aux régions 
de conserver un décalage relatif par rapport à 
l'emplacement dans la grille. Voir également 
Grid absolu (mode).

Groupes : pistes liées de telle façon que toute 
action dans l'une des pistes est étendue à toutes 
les pistes du groupe. Il est possible de créer les 
groupes séparément ou de les lier entre les 
fenêtres Edit et Mix.

HBA SCSI : type de bus de données permettant 
de transférer rapidement des données entre un 
ordinateur et des périphériques. Acronyme de 
Small Computer System Interface (SCSI) et de 
Host Bus Adapter (HBA) désignant les cartes 
SCSI de Digidesign. Une HBA est la carte 
intermédiaire, au niveau du bus SCSI, entre 
l'ordinateur et les périphériques tels que les 
disques durs.

HD Accel : carte PCI dotée de puces DSP 
supplémentaires pour systèmes Pro Tools|HD.

HD Core : carte PCI qui se connecte à l'interface 
audio et contient les puces DSP d'un système 
Pro Tools|HD.

HD Process : carte PCI dotée de puces DSP 
supplémentaires pour systèmes Pro Tools|HD.

Hors ligne (média) : caractère d'un média qui 
n'est pas branché ou n'est pas directement 
accessible à l'ordinateur. 
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Hors ligne (synchronisation) : caractère d'un 
appareil qui n'est pas soumis au contrôle d'un 
autre pour la reproduction ou l'enregistrement 
synchronisé.

Images par seconde (i/s) : nombre d'images 
défilant par seconde, conformément aux quatre 
formats de codage temporel SMPTE/EBU, à 
savoir :

• 24 i/s (pour le cinéma) ;

• 25 i/s (standard vidéo PAL/SECAM) ;

• 29,97 i/s (standard vidéo NTSC) ; 
voir aussi Drop-frame) ;

• 30 i/s (standard vidéo noir et blanc NTSC).

Inactif : caractère d'un élément désactivé dans 
Pro Tools pour récupérer ou économiser les 
ressources DSP. Quand une piste, un départ ou 
un plug-in est inactif, son nom est affiché en 
italiques et l'élément en question ne produit pas 
de son.

Indexation : les bases de données sont indexées 
pour assurer la disponibilité et la mise à jour des 
données affichées dans les navigateurs. 
L'indexation génère et met à jour une base de 
données contenant les dernières informations 
sur les métadonnées. 

Indicateur de crête : témoin lumineux 
avertissant de la possibilité d'écrêtage lorsque le 
niveau d'entrée d'un appareil ne dispose plus 
d'une marge de sécurité suffisante. 

Interface d'E/S héritée : interface audio 
Digidesign antérieure (telles que E/S 888|24 et 
E/S 882|20) qui peuvent être connectées aux 
interfaces audio Pro Tools|HD (telles que E/S 
192 et E/S 96) pour ajouter des canaux d'entrées 
et de sorties supplémentaires. Les interfaces 
Legacy peuvent être utilisées uniquement avec 
des sessions 44,1 kHz et 48 kHz.

Latence : délais inhérents au traitement interne 
ou à la génération de signaux audio sur un 
ordinateur.

Liste des événements : voir Liste des événements 
MIDI.

Loop Sync : boucle d'horloge dédiée permettant 
de synchroniser plusieurs interfaces audio 
Pro Tools|HD. Elle utilise un signal Word Clock 
basé sur la fréquence d'échantillonnage 
44,1 kHz ou 48 kHz. A mesure que les 
fréquences d'échantillonnage augmentent sur le 
système, la fonction Loop Sync conserve la 
fréquence de base de 44,1 kHz ou 48 kHz, selon 
la fréquence la plus élevée. Utilisez Loop Sync 
uniquement pour connecter plusieurs 
périphériques Pro Tools|HD en chaîne.

Machine Control : fonctions de Pro Tools 
contrôlant les transport d'un appareil externe tel 
qu'un magnétoscope ou un magnétophone, ou 
contrôlées par celui-ci. 

Marge de sécurité : gain restant disponible pour 
un signal donné avant apparition d'un écrêtage 
inacceptable. 

Marqueur : emplacement mémoire repéré par 
rapport à une référence temporelle, qui sert 
habituellement à enregistrer l'emplacement de 
points importants d'une session. Voir également 
Emplacement mémoire.

Master (périphérique) : dispositif ou système 
Pro Tools leader au sein d'une configuration 
dans laquelle plusieurs machines sont 
synchronisées. Les machines esclaves suivent le 
maître. Il ne peut y avoir qu'un maître à la fois. 

Master Fader (piste) : régit la sortie globale 
d'une ou plusieurs pistes.
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Métadonnées : les fichiers média, les fichiers de 
sessions et autres types de fichiers possèdent 
leurs propres ensembles de métadonnées, qui 
incluent des données d'ordre général (comme le 
nom de fichier, sa date de création et sa taille). 
Les métadonnées varient selon le type et le 
format du fichier. 

MIDI (Musical Instrument Digital Interface) : 
protocole conçu pour assurer une la 
communication entre des instruments 
compatibles tels que des synthétiseurs à des fins 
de contrôle et de reproduction. Les données 
transmises sur les canaux MIDI comprennent 
des messages d'enclenchement de note, de 
coupure de note, de toucher, de Pitch Bend et 
d'autres données de jeu. Les connexions 
s'effectuent avec des câbles dotés de fiches DIN à 
cinq broches.

MIDI Event List : fenêtre de Pro Tools montrant 
le contenu d'une piste MIDI dans une colonne, 
ce qui facilite l'édition d'événements MIDI 
individuels.

MIDI Machine Control (MMC) : voir Machine 
Control.

MIDI Time Code : voir MTC.

Modèle de session : fichier de session Pro Tools 
dont les paramètres sont préréglés selon les 
préférences de l'utilisateur. La commande Save 
As permet de sauvegarder facilement toute 
session Pro Tools comme modèle de session.

Modèle Groove : modèle issu d'une sélection 
audio en utilisant Beat Detective. Les modèles 
Groove contiennent des informations sur les 
nuances et dynamiques de synchronisation 
d'une performance audio sélectionnée. Ils 
peuvent être utilisés pour conformer ou imposer 

ces caractéristiques de performance sur du 
matériel audio autre, en utilisant Beat Detective 
ou tout autre matériel MIDI utilisant la 
commande Grid/Groove Quantize.

Modes d'automation : fonction permettant 
d'enregistrer et de relire les modifications 
apportées aux niveaux de volume, aux 
panoramiques et, plus généralement, à 
quasiment tout paramètre réglable (y compris 
ceux des plug-in) de Pro Tools. Pro Tools 
propose différents modes d'écriture de données 
d'automation.

MP3 (MPEG Layer 3) : format de réduction de 
débit de données audio de qualité réglable, mis 
au point par l'Institut Fraunhofer.

MTC (MIDI Time Code) : type de timecode non-
SMPTE utilisé par certains périphériques 
(notamment Pro Tools) pour échanger des 
informations temporelles.

N/A (numérique-analogique) : les convertisseurs 
numériques-analogiques fonctionnent à des 
résolutions et des fréquences d'échantillonnage 
diverses. Ils convertissent les signaux audio 
numériques en signaux analogiques.

Navigateur : fenêtre affichant les informations 
contenues dans une base de données et 
permettant de les manipuler. Dans DigiBase, 
permet également de déplacer des fichiers entre 
différents volumes et de les implanter dans des 
sessions Pro Tools à l'aide de la fonction glisser-
déposer.
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Non-destructive (édition) : l'édition non 
destructive laisse les fichiers audio originaux 
intacts. Lorsque vous éditez des séquences audio 
dans Pro Tools, vous modifiez en fait les régions, 
c'est-à-dire des « pointeurs » désignant les 
fichiers audio stockés sur le disque dur, à moins 
que vous ne sélectionniez clairement les modes 
destructifs (au cours de l'enregistrement ou lors 
de l'utilisation du traitement AudioSuite). 

Non-drop frame : timecode n'utilisant pas la 
compensation de temps réel (drop-frame). En 
Amérique du Nord, le format standard hors de la 
production vidéo couleur ou de la post-
production est habituellement de 29,97 i/s non-
Drop Frame, c'est-à-dire sans compensation du 
temps réel. 

NTSC : standard vidéo défini par le National 
Television Standards Committee. La vidéo 
couleur NTSC possède une fréquence de 
29,97 images par seconde. Celle des vidéos 
NTSC en noir et blanc est de 30 i/s. Ces normes 
sont utilisées principalement en Amérique du 
Nord et en Amérique du Sud, ainsi qu'au Japon.

OMS (Open Music System) : système 
d'exploitation MIDI pour les systèmes 
Macintosh OS 9, développé par Opcode. Il gère 
les échanges de données MIDI entre 
applications, notamment les signaux de 
synchronisation tels que MTC. Sous Mac OS X, 
OMS est remplacé par AMS (utilitaire de 
configuration audio MIDI d'Apple).

Passage par zéro : point au niveau duquel la 
forme d'onde d'un signal coupe la ligne 
horizontale traversant la représentation en 
forme d'onde. Généralement, il est judicieux 
d'éditer un fichier audio en un passage à zéro 
pour éviter les artéfacts indésirables.

Périphérique vidéo Avid DNA : interface Avid 
(tel que Avid Mojo) intégrant la technologie 
vidéo Avid dans les systèmes Pro Tools.

PFL (Pre Fader Listen) : écoute du signal d'une 
voie à son niveau d'origine, avant atténuation 
ou amplification par le fader (parfois appelée 
« Cue »). Dans Pro Tools, les faders principaux 
sont des PFL. Voir aussi pré-fader.

Piste hébergeant les voix : nombre total de 
pistes pouvant héberger les voix, connue 
précédemment sous le nom de voix virtuelle. 
Se réfère au nombre maximal de pistes audio 
pouvant se partager les voix disponibles sur le 
système.

Playlist : groupe de régions organisé sur une 
piste audio ou MIDI.

Plug-in RTAS (Real-Time Audio Suite) : format de 
plug-in s'exécutant sur l'hôte Digidesign, 
travaillant en temps réel.

Plug-in TDM : format de plug-in temps réel 
propriétaire non destructif de Digidesign pour 
systèmes Pro Tools|HD. 

Point d'inflexion : point séparant deux niveaux 
de la courbe d'automation d'une piste.

Point d'insertion : emplacement d'une piste où 
vous cliquez (sans faire glisser le curseur). 
Désigne également l'endroit où le point de 
début, de fin ou de synchronisation d'une 
région sera placé.

Point d'insertion sur la règle temporelle : 
position sur la règle temporelle correspondant 
au point où se trouve le curseur et à partir 
duquel la lecture ou l'enregistrement 
commence.

Post-fader (après fader) : signal de sortie prélevé 
après fader sur une piste (généralement via un 
départ), dont le niveau suit par conséquent les 
évolutions du fader de la voie affectée à la piste.
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Post-roll : durée réglable pendant laquelle la 
lecture se poursuit au-delà de la durée de la 
reproduction ou de l'enregistrement en cours 
d'une sélection.

PRE : préamplificateur de microphone à huit 
canaux de Digidesign, pilotables à distance. 
Comporte huit circuits distincts de 
préamplificateur de micro différentiels à 
transistors et garantit un acheminement du 
signal limpide et sur mesure pour 
l'environnement Pro Tools. Peut également être 
utilisé en tant que préamplificateur de micro 
autonome.

Pré-fader : signal de sortie prélevé avant fader 
sur une piste (généralement via un départ), dont 
le niveau reste par conséquent indépendant des 
évolutions du fader de la voie affectée à la piste.

Pré-roll : durée réglable précédant la lecture ou 
l'enregistrement d'une sélection.

Préamplificateur : dans la terminologie des 
studios d'enregistrement, circuit conçu pour 
renforcer les signaux relativement faibles, tels 
que ceux émis par un microphone, jusqu'à un 
niveau ligne standard de –10 dBV ou +4 dBu. 
Digi 002 et Digi 002 Rack sont équipés de quatre 
préamplificateurs de microphone, tandis que 
Mbox 2 et Mbox en possèdent deux. 
Voir aussi PRE.

Préférences générales : préférences affectant 
toutes les sessions d'un même utilisateur. Elles 
diffèrent des préférences globales, qui sont 
quant à elles identiques pour tous les 
utilisateurs. Voir également Préférences 
utilisateur. 

Préférences utilisateur : état définissable par 
l'utilisateur pour un configuration système ou 
un paramètre spécifique de Pro Tools. 
Macintosh permet de créer des fichiers de 
préférences distincts pour chaque utilisateur. 

Les préférences liées aux fonctions des bases de 
données de Pro Tools incluent les fenêtres de 
navigateur, des paramètres et des fonctions de 
recherche. Voir aussi Préférences générales. 

Prémixage : acheminement de plusieurs sources 
audio vers une entrée auxiliaire pour des 
mixages d'écoute, le contrôle des niveaux 
généraux de bus et le traitement des effets 
partagés.

ProControl : surface de contrôle Digidesign 
dédiée, communiquant avec Pro Tools via un 
réseau Ethernet. ProControl offre des fonctions 
tels que des faders motorisés tactiles et une 
section dédiée à l'édition des paramètres d'effets.

Pull Up/Pull Down : procédure consistant à 
« décalibrer » délibérément le signal 
d'échantillonnage vidéo ou audio des horloges, 
ce qui modifie la hauteur du son lu, afin de 
rattraper un décalage intervenu à un autre 
moment dans la chaîne de production. Le cas le 
plus fréquent est celui où on a transféré des sons 
prévus pour un film (fréquence d'image 24 i/s) 
sur une bande vidéo NTSC (à 29,97 i/s). Cette 
fonction est prise en charge par Pro Tools 
version 5.3.1 ou version ultérieure.

Quantification : modification de la position ou 
de la durée de notes MIDI de façon à les faire 
tomber « juste » par rapport à une subdivision 
rythmique ou un gabarit donné. On obtient 
alors ce feeling rythmique rigoureux si 
particulier.

QuickTime : extension système Apple 
permettant de contrôler des événements basés 
sur le temps, tels que des vidéos numériques et 
le son numérisé. 

RealAudio : procédé de réduction de débit 
numérique de données audio, conçu pour le 
streaming sur Internet.
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Référence d'horloge : signal de référence 
temporelle commune, permettant la 
synchronisation de différents périphériques en 
lecture et en enregistrement. 

Référence de position : référence commune de 
position, à laquelle se réfèrent plusieurs 
appareils exploités ensemble pour assurer une 
synchronisation correcte en lecture comme en 
enregistrement. Le plus souvent, ces 
informations sont fournies sous la forme d'un 
timecode SMPTE/EBU. 

Référence vidéo house (black burst) : type de 
signal de référence d'horloge généralement 
utilisé pour synchroniser des périphériques 
audio ou vidéo au cours de la lecture ou de 
l'enregistrement.

Région : dans Pro Tools, « pointeur » vers une 
piste ou un fichier particulier. Il est possible de 
faire glisser des régions sur une piste depuis la 
liste des régions, un navigateur DigiBase ou une 
autre piste. 

Région audio de fichiers complet : région 
correspondant à la globalité d'un fichier audio, 
créée lors de l'enregistrement ou de 
l'importation de signaux audio, du 
regroupement des régions existantes et lors du 
traitement au moyen d'un plug-in AudioSuite.

Région créée automatiquement : produit dérivé 
de l'édition et de l'enregistrement fractionné 
(par punch-in/out) par-dessus des régions 
existantes.

Région définie par l'utilisateur : région définie 
explicitement, créée lors de l'enregistrement ou 
de l'importation de fichiers audio ou MIDI ; lors 
de la capture, de la séparation ou du 
regroupement d'une sélection ; lors du 
trimming d'une région audio correspondant à 
un fichier entier ; ou lorsque vous renommez 
une région existante.

Règles d'échelle temporelle : l'échelle 
temporelle principale est la règle déterminant le 
format temporel utilisé pour les fonctions de 
transport et les valeurs de grille (Grid) et de 
décalage (Nudge). L'échelle temporelle 
secondaire est une règle temporelle qui fournit 
des références de synchronisation 
supplémentaires.

Règles de chef d'orchestre : règle illustrant les 
données de la session. Il existe trois règles de 
chef d'orchestre : Tempo, Métrique et 
Marqueur.

Règles temporelles : les règles de base de temps 
sont affichées dans la partie supérieure de la 
fenêtre Edit. Il peut en apparaître jusqu'à cinq, 
chacune étant graduée en unités différentes 
(échantillons, pieds.images, minutes:secondes, 
mesures:temps ou timecode).

Résolution : l'une des deux principales 
caractéristiques de la qualité des 
enregistrements audio numériques (l'autre étant 
la fréquence d'échantillonnage). La résolution 
numérique détermine la précision de 
quantification de la plage dynamique d'un 
signal. Egalement appelé Débit binaire.

synchronisation d'un appareil avec une 
référence d'horloge commune.

S/PDIF : version semi-professionnelle du 
standard AES/EBU. Acronyme de Sony/Philips 
Digital Interface Format. Les connexions S/PDIF 
s'effectuent par le biais de prises optiques 
coaxiales (RCA) ou TOSlink. La majorité des 
connexions S/PDIF achemine simultanément 
les deux canaux d'un signal audionumérique. 

Sélection d'édition : dans la fenêtre Edit, la 
région passant en surbrillance dans la playlist.
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Sélection dans la règle temporelle : sélection 
effectuée dans n'importe quelle règle de base de 
temps, déterminant la région qui sera lue ou 
enregistrée.

Signal de référence vidéo : tous les signaux 
vidéo contiennent des informations de 
synchronisation pouvant servir de référence 
d'horloge. 

Slave Clock (ou Super Clock) : signal Word 
Clock de Digidesign à haute vitesse qui s'exécute 
à une fréquence d'échantillonnage de 256x (256 
fois). Il est indispensable aux systèmes 
Pro Tools|24 MIX et Pro Tools|24 pour 
synchroniser les interfaces audio sur une seule 
sortie d'horloge à haute précision depuis 
l'interface audio SYNC I/O, USD ou HD. Voir 
aussi Interface d'E/S Legacy. 

Sound Designer II (SDII) : format de fichier 
audio numérique de haute qualité Digidesign.

Sous-groupe : voir Groupes.

Spot : processus de post-production audio 
consistant à faire coïncider des événements 
audio avec des événements visuels. Dans 
Pro Tools, le mode Spot permet de placer des 
régions en regard d'événements de timecode 
particulier.

Super Clock (256x) : voir Slave Clock.

SYNC I/O : périphérique Digidesign de 
synchronisation multiformat pour 
Pro Tools|HD, compatible avec toutes les 
normes principales de format de sources 
d'horloge et de timecode. L'interface d'E/S SYNC 
offre une précision de synchronisation proche 
de l'échantillon sur les signaux timecode ou bi-
phase/tach, ainsi qu'une source d'horloge de 
haute qualité, compatible 192 kHz et à faible 
variation.

Synchronisation : processus consistant à faire 
fonctionner deux ou plusieurs périphériques 
audio, vidéo ou autres à exactement la même 
vitesse. 

Sysex (System Exclusive) : données MIDI 
spécifiques à un dispositif ou à un instrument 
particulier.

TDM (Time Division Multiplexing) : technologie 
utilisant un bus faisant appel à un réseau de 
puces DSP fournissant la puissance de 
traitement requise par les systèmes 
Pro Tools|HD.

USB (Universal Serial Bus) : norme de 
périphérique rapide permettant le transfert de 
données jusqu'à 12 Mo/sec. Le format USB est 
adopté par de nombreux périphériques audio et 
vidéo.

Vélocité : paramètre de données MIDI décrivant 
la force ou la vitesse à laquelle une touche est 
enfoncée et déterminant le volume des notes 
MIDI.

Voix : dans un système Pro Tools, nombre de 
canaux qu'il est possible de lire simultanément.

Volume Performance : volume d'archivage défini 
pour l'enregistrement ou la lecture de fichiers 
médias dans une session Pro Tools.

Volume Transfer : volume d'archivage désigné 
comme volume de transfert dans un espace de 
travail Digibase qui n'est utilisé ni pour la 
lecture ni pour l'enregistrement de média dans 
une session Pro Tools. Les volumes pour 
lesquels Pro Tools ne permet pas la reproduction 
audio (comme les volumes partagés sur un 
réseau ou les CD-ROM) sont définis comme 
volumes de transfert par défaut.

VTR (Video Tape Recorder) : magnétoscope de 
n'importe quel format.
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WaveDriver : WaveDriver de Digidesign est un 
pilote audio multicanal client unique, qui 
permet à des programmes audio tiers 
compatibles WaveDriver MME (Multimedia 
Extensions) de lire des données via les interfaces 
audio Digidesign agréées.

Word Clock : de nombreux produits 
audionumériques (magnétophones multipistes 
à bobines libres, consoles de mixage numériques 
et multipistes numériques) possèdent des 
connecteurs Word Clock (1x fréquence 
d'échantillonnage). 
Le Word Clock permet aux appareils 
compatibles Wordclock d'envoyer et de recevoir 
des informations d'horloge externe qui 
contrôlent la fréquence d'échantillonnage, qui à 
son tour (si applicable) contrôle la vitesse de 
lecture et d'enregistrement.

Zoom : fonction permettant de mieux 
distinguer les détails des formes d'onde affichées 
dans la fenêtre Edit ou autres informations.
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Symboles
% de centrage (pourcentage) 745

Entrées numériques
16 bits

commande Bounce to Disk 690
1622, interface d'E/S 8
176,4 kHz

valeurs de majoration 782
192 kHz

valeurs de majoration 782
192, interface d'E/S 8

Hardware Setup 57
Soft Limit 57

192, interface d'E/S numérique 8
1x 824
24 bits

commande Bounce to Disk 690
traitement TDM 606

24 i/s 759
25 i/s (EBU) 759
256x 823
29,97 i/s Drop 758
29,97 i/s Non-Drop 758, 796
3 Second, option

gel de crêtes (Peak Hold) 117
indication d'écrêtage 117

3:2 Pulldown 760
30 i/s Drop 758
30 i/s Non-Drop 758
32 bits, virgule flottante 606
3-Second Clip Hold, préférence 75
3-Second Peak Hold, préférence 75
5.1, formats dans Pro Tools 716
8 bits 690
888|20, interface d'E/S 8
888|24, interface d'E/S 8
96, interface d'E/S 8

Hardware Setup 57
96i, interface d'E/S 8

Hardware Setup 57

A
AAF, format 164
Absolute Grid, mode 366
Accrochage, outil 336

édition des points d'inflexion 433
outil de saisie d'objet 336

Actifs
éléments 22
inserts 613
plug-in 24

Activation
automation 652
automation de plug-in 629
dispositifs d'entrée MIDI 232
groupes 146
option AutoSave 78

Activation (panoramique Surround) 742
Activation à l'enregistrement de piste, indicateur 35
Activation de pistes à distance 788
Activation et désactivation

niveau de zoom 310
Actives

pistes 138
ADAT Bridge 24 bits, interface d'E/S 8
Add Marker/Memory Location, bouton 460
Add Meter Change, bouton 449
Add Tempo Change, bouton 426, 445
Add Unique Triggers, option 492
AES/EBU

Hardware Setup 56
Affectation de canaux

édition 98
ordre des chemins par défaut 108
réaffectation 99

Affectation de chemins dans I/O Setup 98
Affichage

informations du fichier pour les régions audio 296
noms des régions 276
Original Time Stamps 792
positions temporelles des régions 276
règle de métrique 448
règle de tempo 426
toutes les règles 284
User Time Stamps 793
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Affichage étendu de la piste 660
Affichage étendu de piste 275
Affichage linéaire, mode 436
Affichage Start, End et Length 32, 223
Affinage d'automation 644, 654
AFL (After Fader Listen) 135
AFL/PFL

sélecteur de chemin 107
AFL/PFL, chemin

définition d'un niveau 108
sélection 107

After Playback, option de défilement 330
After Write Pass, Switch To, préférence 82
Aide

commande Bounce to Disk 692
info-bulles 39, 73

AIFF, format de fichier 685
Ajout

départs 584
nouvelle playlist 291
pistes audio 209
pistes d'instrument 236
pistes MIDI 236

All MIDI Notes Off, commande 521
Amount of memory to reserve for automation recording, 

option 83
Annulation d'un enregistrement audio 212
Annulation des prises d'enregistrement 213, 240
Appellation

chemins 95
inserts et départs 631

Application aux pistes automatiquement désactivées 605
Applications multilingues, prise en charge 182
Apply Real-Time Properties, option 170
Archivage

préparation avec Compact Selected 419
Arrêt, bouton 33
Arrière, divergence 745
Assignation du signal

bases du Surround 723
exemple 20
exemples de Surround 730
ordre des chemins par défaut 108

Assignation dynamique des voix 129
Assignment, vue

départs 586
Attribution d’un nouveau nom

playlists 291
Aucun défilement pendant la lecture 330
Aucune sortie

en supprimant des chemins 98
Audio During Fast Forward/Rewind, option 75, 325
Audio Files, dossier 60
Audio Media, options 156
Audio, fichiers

compactage 420
concepts 18
formats 685
formats mélangés 148
importation 147
noms par défaut 194
types de fichiers mélangés 66

Audio, pistes 17
ajout 209
configuration pour l'enregistrement 209

création d'une table des tempos 444
enregistrement en boucle 218
enregistrement fractionné 217
enregistrement multiple 213
flux de signaux 573
format 5.1 711
format de sortie 722
placement de données audio dans les pistes 

multicanaux 721
prémixage sur disque 683
sessions Surround 720
voies 112

Audio, pull up et pull down 778
AudioSuite

dithering 607
plug-in 607
plug-in Duplicate 385
traitement 385

Auto Input, mode d'écoute 190
Auto Match Pull Factors 779
Auto Regions Fade In/Out Length, option 78, 412
Auto Rename, commande 421
Auto, Bouton 620
AutoGlide Time, préférence 83, 744
AutoGlide, mode 744
AutoJoin 640

indicateur 641
AutoMatch Time, option 83, 644
AutoMatch, indicateurs 645
Automatically Copy Files on Import, option 76
Automatically Find and Relink 175
Automation 635

acquisition et application 677
activation, interruption 652
affinage 644, 654
assignations de sorties multiples 722
au point d’inflexion suivant 670
bouton Safe 620
contrôles commutés 648
couper, copier et coller 380, 661
création 650
delta 641
départs 648
dessin avec le crayon 655
discontinu 658
écriture 646
écriture à l’ensemble, au début ou à la fin de la 

sélection 668
édition 656
édition avec l'outil Smart 317
lissage 644
mode Paste spécial 665
mode Trim 641
On Stop 669
panoramique multicanal 748
pistes 646
pistes masquées 125
pistes multicanaux 660
pistes regroupées 660
playlists 290, 636, 646
plug-in 650
point de passage 639
points d'inflexion 658
précision du plug-in lors du prémixage 692
protection 645
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régions audio 279
règle et vue de piste 376
rognage 667
snapshot 675
suppression 653
taille du buffer 645
valeurs relatives et absolues 641
Write to Current ou All Enabled 677

Automation de contrôle discontinu 658
Automation de coupure 658
Automation de panoramique 658
Automation du volume 658
Automation Enable, fenêtre 646
Automation par Snapshot 675

ajout à des playlists d'automation vides 676
écriture sur une automation existante 676
valeurs de rognage 677

Automation, modes
Latch 640
Latch/Trim 642
Off 638
Read 638
Read/Trim 642
Touch 639
Touch/Trim 642
Trim/Off 641
Write 639
Write/Trim 643

Automation, préférences 81
option AutoMatch Time 83, 644
option Memory for Automation Recording 645
option Mutes Follow Groups 134
option Smooth and Thin Data After Pass 654
option Solos Follow Groups 134
option Touch Timeout 83

Auto-Name Memory Locations When Playing, option 80
Auto-Name Memory Locations While Playing, option 461
Auto-Name Separated Regions, option 80, 352
AutoSave, option 78
Auto-Spot Regions, commande 791
Avance rapide

par incrément 325
recherche 325

Avance rapide, bouton 34
Avid Video Errors Stop Playback, option 77
Avid Xpress DV

conditions requises par le codec pour l'exportation 804
lecture dans Pro Tools 803

B
Back and Play, commande 325
Back, commande 325
Back/Forward Amount 326
Back/Forward, commandes 325

extension de sélections 327
répétition 326

Balayage progressif 781
Bande passante de traitement 70
Bars:Beats, échelle temporelle 285
Basculement

hauteur de piste 275
vue de piste 274

Basculement de vue de la piste 274
Base de données 814

Batch Fades, boîte de dialogue 413
Battement du tempo 206
Beat Detective 469, 470

avec plusieurs pistes 485
beat triggers

déplacement 479
génération 475
insertion 479
promotion 480
suppression 478

commande 471
configuration requise 470
conformation de régions 486
création des marqueurs Bar|Beat 481
définition de la sélection 472
détection des transitoires 475
Edit Smoothing 489
extrapolation 483
fenêtre 471
mode Collection 490
modèles 482
modèles DigiGroove 482
modèles Groove

extraction 482
Scroll Next 480
séparation de régions 484
Trigger Pad 484

Big Counter, fenêtre 323
Bi-Phase/Tach 757
Blocks, vue 272
Boîte à rythme, enregistrement en boucle 243
Boucle

lecture 345
sélections 345

Boucles et réverbération, retard 682
Bounce to Disk, commande 679, 683

Aide 692
chemin source 685
Convert After Bounce 692
Convert During Bounce 692
dithering 680
enregistrement d’un prémixage 693
File Type 685
Format 689
fréquence d'échantillonnage, qualité de la 

conversion 692
marquage temporel 683
option Use Squeezer 692
options Bounce 684
options de conversion de fréquence 

d'échantillonnage 691
Resolution 690

Bounce to QuickTime Movie, commande 811
Bouton de tabulation vers transitoires 343
Bouton de zoom arrière audio 305
Bouton de zoom arrière MIDI 305
Bouton de zoom avant audio 305
Bouton de zoom avant MIDI 305
Bouton du métronome 204
bouton Effect Bypass 619
Bouton Pre/Post Fader 593
Boutons du mode d’édition 301
Boutons Write Automation to Selection/Selection 

Start/Selection End 668
Bring to Front, commande 355
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Bus de mixage 180, 585
redéfinition 97

Bypass, bouton
plug-in en temps réel 619

C
Cadence d'image

pull up et pull down 778
Calibration Mode, commande 186
Calibration Reference Level, préférence 79
Canaux 19
Canaux MIDI 25

affectation 131
Capacité de traitement du disque 70
Capacité de traitement du processeur 70
Capture du timecode 790
Capture Region, commande 351
Cartes d'acquisition/de lecture vidéo 800
Center Playhead Scrolling, option 331
Center% dans la fenêtre Output 746
Champ du décalage défini par l'utilisateur (+/–) 603
Change Duration, commande 523, 539
Change Edit to Match Timeline, commande 348
Change Meter, commande 449, 451, 452
Change Tempo, commande 427
Change Timeline to Match Edit, commande 348
Change Velocity, commande 523, 537
Changement de nom

emplacements mémoire 463
groupes 145
régions 421
régions créées automatiquement 420

Changement de zoom, commande 309, 310
Changements de programmes 25, 513

déplacement 516
écoute 517
édition 516
insertion 516
par défaut, pistes MIDI 514
recherche 519
sélection de banque 513
suppression 517

Chef d'orchestre, bouton 37
Chemin d'entrée, sélecteur 115, 126
Chemin de sortie, sélecteur 115, 127
Chemin source 685
Chemins

actifs et inactifs 100
affectation 98
application 99
attribution d'un nom 95
création de chemins multicanaux 714
création et modification 94
dernière utilisation 104
écoute 106
exemple multicanal 98
exemples de sous-chemins Surround 730
mono ou stéréo 95
ordre par défaut 108
organisation 96
par défaut mono et stéréo 95
présélection pour le mixage stéréo 105
principaux 89
réinitialisation par défaut 97

sélection 96
sortie par défaut 107
superposition 100
suppression 98
Surround 726

Chemins au format 5.0 dans les mixages 5.1 730
Chemins principaux 89
Chemins superposés 100
Cinéma, stéréo 700
Classic, mode du clavier numérique 77
Classic, mode du pavé numérique 43
Clear All Clip Indicators, commande 117, 118
Clear Special, commandes 380, 665

All Automation 380, 665
Pan Automation 380, 665
Plug-In Automation 380, 665

Clear, commande 379
Clear, commande (régions) 422
Click

activation 203
configuration 203

Click, plug-in 202
Clics 229
Clics et autres parasites, annulation 279
Clip Indication, options

3 Second 117
Infinite 117
None 117
préférences d'affichage 75

Clips MIDI et liste des régions 296
Clock Source, menu déroulant 56
Close Session, commande 70
Codage et décodage 707
Collage

automation 665
avec la commande Repeat to Fill Selection 380
entre les playlists d'automation 380
pistes multiples 381
plug-in, paramètres 625
plusieurs types de données 381
sélections et régions 378

Color Palette, fenêtre 141
Command|8 608
Commande Clear All Clip Indicators 587
Commandes d'édition 376

coller 378
copier 377
couper 377
mode d'édition 377
supprimer 379

Commandes de sélection
Play Edit Selection 344
Play Timeline 344

Commandes, focus clavier 42
Compact Selected, commande 419
Compare, bouton 620
Compatibilité

formats Surround 707
informations 4

Compatibilité, préférences 84
Compensation de retard

affichage 119
H/W Insert 109
MIDI Beat Clock 85
MIDI Timecode 85
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mode 73
moteur 53
pendant l'enregistrement 194
ressources DSP 53

Compression/extension temporelle, outil de trimming 508
Compteurs principaux 286
Configuration

MMC 784
options du métronome 203
Pro Tools 50
SMPTE 775

Conformation des séquences QuickTime 808
Connexion

appareils audio externes 632
unités d'effets 632

Connexions d'entrée 19, 185
Consolidate, commande 419
Constant Tempo, commande 438
Continuous Scroll During Playback, option

demi-écran 331
Continuous Scroll with Playhead, option

demi-écran 331
Continus, événements de contrôleur 26
Contrôle local 25, 233
Contrôle séparé des signaux 721
contrôles de plug-in

couplage 627
réglage 628

Contrôles des pistes
fenêtre Edit 31
fenêtre Mix 31

Conversion de session
format de fichier audio 64
fréquence d'échantillonnage 64
résolution 64

Conversion Quality, option 80, 150, 692, 809
paramètre Tweak-head 692, 809

Convert Plug-In, sélecteur 619
Convert WAV files to AES31/BroadcastWave, option 75, 176
Copie

automation de pistes sur les départs 649
notes MIDI avec la commande Split 543
paramètre de plug-in 625
paramètres de contrôle de piste vers les départs 590
sélections et régions 377
toutes les playlists d'automation d'une piste 380

Copy Settings, commande 623
Copy Special, commandes 380, 664

All Automation 380, 664
Pan Automation 380, 664
Plug-In Automation 380, 664

Copy to Send, commande 649
Copy, commande 377
Couplage

contrôles de plug-in 627
panoramique inversé 592
panoramiques stéréo 591
plug-in multimono 725

Coupure
automation 662
notes MIDI avec la commande Split 543
pistes 137
régions 373
sélections et régions 377

Coupure de départ 583

CPU Usage Limit, paramètre 51, 52
Crayon, outil 304, 385, 498

aléatoire 499
carré 499
dessin de l'automation 655
édition des points d'inflexion 657
formes 498, 655
gomme 508
insertion de notes MIDI 500
ligne 499

Edition du tempo 431
main levée 498
réparation des formes d'onde 385
résolution des événements de contrôleurs insérés 512
sélection de la forme du crayon 498
triangle 499

Create Fades, commande 408, 409
Création

crossfades 408
fondus d'entrée et de sortie 410
groupes 144
groupes de régions 387
marqueurs et emplacements mémoire 460
régions 351
sessions 59
sessions compatibles Mac et PC 178
sous-dossiers de paramètres 624

Crête, indicateur 116
Crossfade centré 402
Crossfade Preference for Pre/Post-Roll, option 80, 408
Crossfades 401

avec dithering 406
boîte de dialogue Fades 403
création avec l'outil Smart 316
dithering 607
gain égal 405
groupés 412
linéaires 407
pré/post 409
puissance constante 405, 407
recouvrement 407
rognage 409
suppression 409
types 401

Crossfades à gain égal 405
Crossfades à puissance constante 405, 407
Crossfades avec recouvrement 407
Crossfades linéaires 407
Current Meter, bouton 205
Current Meter, indicateur 38
Current Time, affichage 771
Curseur

emplacement 31
valeur 31

Curseur d'édition 324
déplacement vers les limites d'une région 342
scrubbing 318

Curseur de lecture 323
Curseur de tempo 38
Cut Special, commandes 380, 664

All Automation 380, 664
Pan Automation 380, 664
Plug-In Automation 380, 664

Cut Time, commande 451, 455
Cut, commande 377
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D
DAE 15
DAE Playback Buffer Size, paramètre 54
D-Command 608
D-Control 608
Décalage de la vélocité des notes 507
Décalage Feet.Frames et QuickTime 807
Décalages MIDI 520
Déclenchement externe

définition 629
Déclencheur 630

déclencheur, sélecteur 620
Décompte 204
Décompte, bouton 37
Découplage des contrôles de plug-in 627, 725
Default Note On Velocity, option 84, 501
Default Thru Follows First Selected MIDI Track, préférence 85
Default Thru Instrument, option 85
Default Thru, instrument 233
Défaut

changement de programme 514
chemin d'écoute 106
chemin de sortie 107
chemin du vumètre 106
chemins 95
fréquence d'échantillonnage 53
I/O Setup 103
métrique 204
ordre des chemins 108
tempo 205

Défilement
de Mix et Edit aux pistes 329
vertical ou horizontal dans la fenêtre Pro Tools 328
via la règle 328
vue Notes vers le haut ou vers le bas 281

Défilement continu 331
défilement de l'affichage des notes d'une piste MIDI 281, 310
Défilement de la page 330
Défileur

préférence d'émulation 76, 258
Définition des points d'enregistrement fractionné et de 

boucle 222
Degree of Thinning, option 83
Delay (retard)

propriétés en temps réel 553
Delay After Play Command, préférence 86
Delay Compensation Mode, option 73
Delay Compensation View, option 603
Delay Compensation, paramètre 602, 605

activation 602
affichage 580
Champ du décalage défini par l'utilisateur (+/–) 603
configuration du moteur de compensation de retard 603
dépassement de la limite de compensation 604
désactivation 604
Indicateur de retard de plug-in (dly) 603
informations 603
modification du retard de piste 604
paramètres 602

Delay for External Devices, options 85
Delay, plug-in 609
Delete Current Settings File, commande 623
Delete Fades, commande 409
Delete Group, commande 144
Delete Track, commande 122

Delta
trim des données d'automation 641

Demi-écran 331
Départ, contrôles 583
Départs 583

affichage des contrôles 587
ajout 584
automation 648
bus de mixage 585
copie des automations de pistes 649
étiquetage 631
I/O matériels 585
mixage multicanal 723
modification des paramètres par défaut 585
mono ou stéréo 585
multicanaux 723
niveau par défaut 584
suppression 585
Vue Assignment 586

Départs d'E/S matériels 585
Déplacement

changements de programmes 516
événements sysex 518
inserts 618
marqueurs 464
marqueurs Bar|Beat 447
notes MIDI 504

Déplacement des régions 361
Déplacement par incrément 368

contenu de région 371
définition de la valeur de déplacement par 

incrément 369
plage de sélection 338
points de début/de fin d'une sélection 338
régions multiples 370
sélections et régions 369
valeur d'incrément suivante 370

Dernière utilisation 104
Désignation automatique

fichiers et régions audio 194
playlists 291
prises 194
régions QuickPunch 254
régions séparées 352
Strip Silence 416

Destructive Record, mode 200, 215
Digi 002 11

enregistrement avec la pédale 251
Digi 002 Rack 11
Digidesign Audio Engine 15
DigiGroove, modèles 482
Digital Format 56
DigiTranslator Integrated, option 164
Direct Outputs, mode 105
Disable “Input” When Disarming Track (In “Stop”), option 76
Disk Allocation 196

et volume système 198
fenêtre 195
redimensionnement de la fenêtre 195
sessions multi plates-formes 197

Disk Space, fenêtre 199
options 199

Display Events as Modified by Real-Time Properties, 
option 85, 556
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Disposition de piste
ordre des chemins par défaut 108

Disques durs
compactage de données audio 419
enregistrement sur le volume système 198
Round Robin Allocation 196
séquences QuickTime 802

Dither
AudioSuite 607
commande Bounce to Disk 680
fondus 607
pistes des faders principaux 681
préférences 607
résolution et commande Bounce to Disk 690

Dither AudioSuite, préférences 83
Dither Plug-In, préférence 83
Dithering

fondus 406
Divergence

graphique 746
largeur 706
utilisation 745

Division de pistes stéréo ou multicanaux 384
Dolby Digital 704
Dolby Surround 700
Dolby Surround EX 700
Données de piste 270
Données de session

importation 154
dossier de destination pour paramètres de plug-in 624
Drapeaux de pré/post-roll 227, 333
Draw Grids in Edit Window, option 72, 303
Draw Waveforms Rectified, option 72, 278
DSP

aucune sortie 583
départs inactifs 588
éléments actifs et inactifs 22
ressources globales 22
sorties inactives 583
Vumètres de départ 587

DTS 700, 704
Duplicate Track, commande 122, 637
Duplicate, commande 382
Duplicate, plug-in 385
Duplication

départs 589
inserts 619
playlists 291
sélections de notes MIDI 382
sélections et régions 382

Duration (durée)
propriétés en temps réel 552

Durée, pour les sélections 337
Durées, notes MIDI

édition à l'aide de la commande Change Duration 539
plus de legato 541
plus de staccato 541
rendre aléatoire 541

DV
sync offset 804

DV Stream 804
Dynamics, plug-in 609

E
E/S non disponible

présentation 102
E/S, paramètres d'usine 105
Echelle temporelle 285

Bars:Beats 285
Feet.Frames 285
Minutes:Seconds 285
principale 286, 777
Samples 285
secondaire 286, 778
Time Code 285

Echelle temporelle principale 285, 286, 777
Echelle temporelle secondaire 286, 778
Ecoute

enregistrement MIDI avec MIDI Thru 233
fondus 403
indicateur 35
pendant l'enregistrement fractionné 218
points de début/de fin d'une sélection 345
pré/post-roll 344
prises 220
programmes 517

Ecoute à faible latence
commande Bounce to Disk 193
pendant l'enregistrement 194

Ecoute sur place 107
Ecrêtage 186, 619
Ecriture

automation 646
automation à l'arrêt 669
automation à l’ensemble, au début ou à la fin de la 

sélection 668
automation par Snapshot 675
données d’automation au point d’inflexion suivant 670

Edit Dither Settings, préférence pour Dither plug-in 83
Edit Insertion Follows Scrub/Shuttle, option 75, 318
Edit Selection Follows Region List Selection, option 80, 335
Edit Smoothing avec Beat Detective 489
Edit Window Default Length, option 73
Edit Window Follows Bank Selection, option 72
Edit Window, option 28
Edit, fenêtre 28, 30

All Views, option 578
défilement via la règle 328
demi-écran 331
None Views, option 578
options d'affichage 28

Edit, menu
Clear Special, commandes 380, 665
commande Change Edit to Match Timeline 348
commande Change Timeline to Match Edit 348
commande Clear 379
commande Consolidate 419
commande Copy 377
commande Create Fades 408, 409
commande Cut 377
commande Delete Fades 409
commande Duplicate 382
commande Fade To End 411
commande Fade To Start 411
commande Fades 403
commande Heal Separation 357
commande Identify Sync Point 367
commande Insert Silence 418
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commande Paste 378
commande Play Edit Selection 349
commande Play Timeline Selection 350
commande Redo 293
commande Repeat 383
commande Select All 335
commande Shift 371
commande Strip Silence 415, 416
commande Thin Automation 654
commande Undo 293
Copy Special, commandes 380, 664
Copy to Send, commande 649
Cut Special, commandes 380, 664
Paste Special, commandes 380
Repeat to Fill Selection, commande 380
Separate Region, commandes 352
TCE Edit to Timeline Selection, commande 348
Trim Automation to All Enabled, commande 678
Trim Automation to Current, commande 678
Trim Region End to Fill Selection, commande 356
Trim Region End to Insertion, commande 355
Trim Region Start to Fill Selection, commande 356
Trim Region Start to Insertion, commande 355
Trim Region to Fill Selection, commande 356
Trim Region to Selection, commande 355
Write Automation, commandes 675, 676

Edition
attributs de la note 507
automation 656
changements de programmes 516
dans la liste des événements MIDI 565
durées des notes 539
emplacements mémoire 463
événements de contrôleur 511
événements de métrique 450
événements de tempo 427
formes d'onde 278
Grid, mode 302, 366
marqueurs 463
marqueurs Bar|Beat 447
modes d’édition 301
non destructive pour l'audio 279
non destructive pour MIDI 283
non-destructive 269
notes MIDI 502
pendant la lecture 269
pistes masquées 125
points d'inflexion 658
régions en tant que grille 303
régions MIDI 282
Shuffle, mode 301
Slip, mode 301
Spot, mode 302
sur plusieurs pistes 381
vélocités des notes 506, 537
vue Track 376

Edition destructive
compactage des fichiers audio 420

Edition en temps réel 269
Edition MIDI en miroir 497
Edition non destructive 269

audio 279
MIDI 283

Edition, modes 301
commandes d'édition 377
Grid 302
Grid relatif 302
placement des régions 358
Shuffle 301
Slip 301
Spot 302, 789

Edition, outils 31, 304
accrochage 336
crayon 304, 385
main 304
outil de scrubbing 304, 318
outil Smart 304
sélecteur 304, 323
Trimming 304, 311
zoom 304

Effets, enregistrement sur disque 680
Emplacement du curseur, affichage

 33
Emplacement mémoire de sélection 458

déplacement de la sélection stockée 463
Emplacements mémoire 457, 459

attribution d'un nouveau nom 463
création 460
création à la volée 461
édition 463
emplacements mémoire de sélection 458
extension de sélections 339
marqueurs 458
rappel 462
rappel de sélections d'édition 225
stockage de sélections d'édition 224
suppression 464
suppression totale 464

Emplacements, notes MIDI
déplacement 504
quantification 528
rendre aléatoire 527, 530

En ligne, enregistrement 783
Enable Session File Auto Backup, option 78
Enforce Mac/PC Compatibility, option 67, 178
Enregistrement 209

à partir d'une source numérique 227
annulation d'une prise 212
annulation des prises 213
avec le métronome 202
avec Round Robin Allocation 196
avec un décompte 204
demi-vitesse 229
destructif 215
données System Exclusive 249
en ligne 783
en mode Record Pause 214
indicateur 35
latence d'écoute 192
non destructif 15, 214
non linéaire 15
piste audio mono 209
piste stéréo unique 209
pistes multicanaux 209
plusieurs pistes audio 213
prémixage sur disque 681, 683
prises supplémentaires 214
raccourcis clavier 213
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sur le volume système 198
vers une nouvelle playlist 216
voyant d'état 260

Enregistrement à demi-vitesse 229
Enregistrement à la volée

pistes MIDI 241
QuickPunch 201, 251

Enregistrement d'une copie d'une session 64
enregistrement d'une session 63
Enregistrement des paramètres du plug-in 624

commande Save Plug-In Settings To 623
commande Save Settings As 623
Save Settings, commande 623

Enregistrement destructif 215
Enregistrement du fichier de session sous un nouveau nom 64
Enregistrement en boucle

audio 218
et pré/post-roll 218
MIDI 242

prises multiples 244
type boîte à rythme 243

Enregistrement fractionné
audio 217
et écoute 218
et pré/post-roll 217
MIDI 240
MIDI à la volée 241

Enregistrement MIDI 231
activation des dispositifs d'entrée 232
annulation d'une prise 240
annulation des prises 240
données System Exclusive 249
écoute avec MIDI Thru 233
filtre d'entrée 234
mode Merge/Replace 235
quantification en entrée 545
quantisation en entrée 234
Wait for Note 235

Enregistrement non destructif 214
avec QuickPunch 251
enregistrement vers une nouvelle playlist 216

Enregistreur DAT, enregistrement à partir de 228
Entrée (base de données) 816
Entrée analogique 57
Entrée MIDI, sélecteur 236
Entrée mono/sortie stéréo 610
Entrée numérique

raccourcis 340
Entrées auxiliaires 21, 111

écoute et mixage 595
flux de signaux 573
voies 113

Entrelacé 781
EQ, plug-in 609
Erreurs DAE 229
Etiquettes d'E/S (voir Configuration d'E/S)
Evénements de contrôleur 26, 510

édition 511
édition avec l'outil Smart 317
insertion 511
recherche 519
régions MIDI 283

Evénements de métrique 448
édition 450
insertion 449

Evénements de tempo 426
édition 427
insertion 426
marqueurs Bar|Beat 447

Evénements MIDI, liste 559
édition d'événements 565
insertion d'événements 563
menu Options 568
navigation 562
sélection d'événements 566
suppression d'événements 567
View Filter 561

Event, menu
commande All MIDI Notes Off 521
commande Beat Detective 471
commande Change Meter 449
commande Identify Beat 444
commande MIDI Track Offsets 521
commande Remove Duplicate Notes 522
commande Renumber Bars 457
commande Tempo 437
commande Time 451
commandes MIDI 523
liste des événements MIDI 559

Exemples de chemins LCRS 715
Exit, commande (Windows) 70
Export MIDI Settings, boîte de dialogue

menu déroulant MIDI File Format 169
option Apply Real-Time Properties 170

Export MIDI, commande 169
Export Region Definitions, commande 164
Export Regions as Files, commande 162
Export Selected Tracks as OMF/AAF, commande 164
Export Selected, boîte de dialogue 162
Export Session Info as Text, commande 164
Export Settings, bouton (I/O Setup) 103
Exportation

audio 162
définitions des régions 164, 793
données audio des régions 162
fichiers AAF 164
fichiers OMFI 164
fichiers stéréo entrelacés 163
groupes de régions 171
marqueurs 170
pistes MIDI 169
session sous forme de texte 164

Ext. Clock Output 56
Extension de sélections 339, 434

inclusion de régions adjacentes 339
limites de régions 339, 434
marqueurs et emplacements mémoire 339
pistes adjacentes 341, 342

External Time Code Offsets 773
Extrapolation 483

F
Fade Files, dossier 61
Fade To End, commande 411
Fade To Start, commande 411
Fader de volume MIDI 116
Faders Move During Playback, option 81
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Faders principaux
contrôle maître de niveau de départ 601
flux de signaux 574
inactif 575
inserts 610
inserts post-fader 574
multicanaux 724
voies 113
vumètres avant/après fader 575

Fades, boîte de dialogue 403
forme d'entrée 406
forme de sortie 404
option Link 405
option Use Dither 406

Fades, commande 403
Feet.Frames, échelle temporelle 285
Fermeture de plusieurs fenêtres Plug-In 621
Fichiers de groupe de régions

exportation 394
importation 394

Fichiers de noms de patch MIDI (.midnam) 515
Fichiers de session

concepts 16
Fichiers de transfert 174
fichiers des paramètres d'E/S

importation et exportation 103
Fichiers manquants 174
Fichiers stéréo entrelacés, exportation 163
File d'annulation 294
File, menu

Bounce to QuickTime Movie, commande 811
commande Bounce To Disk 683
commande Close Session 70
commande Exit (Windows) 70
commande Export MIDI 169
commande Export Selected Tracks as OMF/AAF 164
commande Export Session Info as Text 164
commande Import Audio From Current Movie 810
commande Import Audio to Track 151
commande Import MIDI to Region List 169
commande Import MIDI to Track 168
commande Import QuickTime Movie 802
commande New Session 59
commande New Track 209, 236
commande Open Session 62
commande Revert to Saved 63
commande Save 63
commande Save As 64
commande Save Copy In 68, 179
Import Audio From QuickTime Movie, commande 810
Send via DigiDelivery 167

Film 700
Films DV

lecture via le port Firewire 803
Filtrage dans la gestion des graves 709
filtres de déclenchement externe 630
Fin, bouton 34
Find Matching Tracks, option 158
Find, commande 297
FireWire

lecture QuickTime DV 803
Flatten Performance, commande 523, 537
Flux de signaux

entrées auxiliaires 573
faders principaux 574

pistes audio 573
Pistes d’instruments 576

Focus clavier 41
commandes 42
liste des groupes 42
liste des régions 42
Régions, liste 300

Focus clavier sur la liste des régions 300
Fondus 410

avec dithering 406
création 410
création avec l'outil Smart 316
fondus automatiques 411
groupés 412
options de dithering 607
régénération 175

Fondus automatiques 411
Format audio, session 770
Format de fichier BWF (.WAV) 685
Format de fichier de groupe de régions (.rgrp) 170
format de fichier de groupe de régions (.rgrp) 393
Formats

multicanaux pris en charge 700
formats 699
Formats de fichier (audio) 685

AIFF 685
BWF (.WAV) 685
MP3 686
MXF 686
QuickTime 686
ressource SND 686
Sound Designer II 685

formats multicanaux 700
Formes d'onde 277

affichage rectifié 278
clics et autres parasites, annulation 279
instructions pour l'édition 278
passage à zéro 279
réparation avec le crayon 385

Formes du fondu d'entrée 406
Formes du fondu de sortie 404
Forward and Play, commande 325
Forward, commande 325
Fréquence d'échantillonnage 53, 691

fréquence d'image cinéma et fréquence d'image 
vidéo 760

Fréquence d'échantillonnage, options de conversion 158
Fréquence d'échantillonnage, qualité de la 

conversion 150, 691, 809
Fréquence d'image cinéma 760
Fréquence d'image vidéo 761
Frontale ou arrière, divergence 745
Frontale, divergence 745

G
Gestion des régions 420
Glide Automation, commandes 666
Global MIDI Playback Offset, option 84, 520
Graves

extension 709
gestion 705, 708
redirection 709
signal sub 705

Grid absolu, mode 302
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Grid relatif, mode 302
Grid, mode 302, 366

absolu 302, 366
configuration 302
définition de la valeur de la grille 366
interruption 366
option Draw Grids in Edit Window 303
Regions/Markers, option 303
relatif 302, 366

Grid/Groove Quantize, commande 523, 525
Grille

définition pour l'édition MIDI 500
Grilles de panoramique dans les fenêtres Mix et Edit 736
Groove Quantize 530
Groove, modèles 482, 531

affectation 534
application 533

Group Track, commande 144, 145
Groupes

activation 146
attribution d'un nouveau nom 145
changement des membres 145
création 144
dissociation des groupes Edit et Mix 146
édition d'automation 660
groupes d'édition 145
groupes de mixage 145
liaison des groupes Edit et Mix 145
panoramique 748
pistes masquées 125
sélection au clavier 146
sélection de pistes 144
suppression 145

Groupes d'édition 145
sélections 334

Groupes de mixage 145
Groupes de régions 271, 386

annulation du groupement 388
création 387
division 390
édition 391
exportation vers d'autres disques durs 172
fondus et crossfades 393
format temporel 387
format temporel, modification 390
importation 171
importation et exportation 170
mixte 388
multipiste 388
reconstitution de groupe 388
référence temporelle 390
rognage 392

Groupes, liste
commandes 144
focus clavier 42
sélecteur 144

H
H/W Buffer Size 50, 193
H/W Insert Delay 109
Hardware Setup 56

Digital Format 56
entrée analogique 57
Ext. Clock Output 56

initialisation d'une interface d'E/S Legacy 57
menu déroulant Meters pour l'interface 96 I/O 56
sélecteur de canal d'entrée 56
sélecteur de canal de sortie 56
sélection de plusieurs sorties 58
sortie analogique 57
source d'horloge 56
taille du buffer 193

Hauteur de piste 275
Hauteur, notes MIDI

transposition 504
transposition à l'aide de la commande Transpose 541

Hauteurs de pistes
changement de zoom 309

Haut-parleurs
disposition 5.1 suggérée 702
disposition Surround 702
dispositions 700
étalonnage Surround 703

HD Accel 7
HD Core, carte 7
HD Process, carte 8
Heal Separation, commande 357
Higher QuickTime Playback Priority, option 78, 802, 806
Highest QuickTime Playback Priority, option 78, 802, 806
historique (recherche de régions) 298

I
I/O Setup, boîte de dialogue 87, 91

affichage d'E/S non disponible 102
dernière utilisation 104
exemples de mixage Surround 729
fichier de paramètres pour le mixage Surround 105
fichiers des paramètres 103
fichiers des paramètres usine 105
importation pour le Surround 714
initialisation 99
paramètres d'importation et d'exportation 103
paramètres par défaut 103
présélection pour le mixage stéréo 105
redimensionnement 88
réinitialisation des chemins 97
sessions Surround 712

Icône de fichier de session Pro Tools 16
Identify Beat, commande 444, 446
Identify Sync Point, commande 367, 794
Ignore Track Arming, préférence 86
Image de départ pour les sessions 771
Import Audio From Current Movie, commande 810
Import Audio From QuickTime Movie, commande 810
Import Audio to Track, commande 151
Import Audio, boîte de dialogue 151
Import MIDI to Region List, commande 169
Import MIDI to Track, commande 168
Import Movie, commande

boîte de dialogue Import Movie 802
Import QuickTime Movie, commande 802
Import Session Data, boîte de dialogue 156
Import Session Data, commande 154
Import Settings, bouton (I/O Setup) 104
Import Settings, commande (plug-in) 623
Importation

audio 147
conversion des données audio 148
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données audio et qualité de la conversion 150
données audio provenant de séquences QuickTime 810
données audio QuickTime 809
groupes de régions 171
marqueurs 169
paramètres d'E/S multicanaux 714
paramètres PRE 161
pistes MIDI 167
pistes pour d'autres sessions 154
plug-in, paramètres 625
séquences QuickTime 802
table des tempos et mesures 161

Inactif
affectation des chemins d'une piste 100
chemins 100
chemins, globalement 100
départs 588
inserts 613
Pistes de fader principal et affectations 575

Inactifs
éléments 22
plug-in 24

Inactives
pistes 138

Incoming Time, affichage 771
Indexation 818
Indicateur de compensation de retard (cmp) 604
Indicateur de retard de plug-in (dly) 603
Indicateurs d'emplacement 327

recherche 328
Indicateurs de sélection d'édition 32, 339
Infinite Clip Hold, préférence 75
Infinite Peak Hold, préférence 75
Infinite, option

gel de crêtes (Peak Hold) 117
indication d'écrêtage 117

Info-bulles 39, 73
Input Devices, commande 232
Input Filter, commande 234

boîte de dialogue MIDI Event List View Filter 561
boîte de dialogue MIDI Input Filter 234

Input Only, mode d'écoute 190
Input Quantize, commande 234, 523, 545
Insert 609

après fader sur pistes de faders principaux 610
déplacement 618
désactivation (et activation) 613
duplication 619
en tant que bus partagé 610
étiquetage 631
I/O matériels 609
mono 610
partagé dans un prémixage 599
plug-in 609
stéréo 610
sur pistes uniques 610

Insert Silence, commande 418
mode Shuffle 418
mode Slip 418

Insert Time, commande 451, 453
Insertion

changements de programmes 516
dans la liste des événements MIDI 563
événements de contrôleur 511
événements de métrique 449

événements de tempo 426
notes MIDI 500
plug-in pendant la lecture 615
plug-in sur les pistes 614

inserts 577
après fader sur pistes de faders principaux 574

inserts avant/après fader 610
Inserts d'E/S matériels 609
Inserts stéréo 610
Inserts, vue 579
Instrument, pistes 112

écoute et mixage 596
flux de signaux 576
mixage Surround 724
sélecteur d'entrée MIDI 133
sélecteur de sortie MIDI 133
voies 114
vue Notes 272
vue Regions 272

Instruments, vue 579
Interface d'E/S Legacy 57
Interfaces audio 10

canaux d'entrée 19
Internal Mode (option Clock Source) 771
interruption

automation 652
écriture de l'automation 652

Items to Copy 67

J
Jam Sync 774
Join 640

L
Largeur des pistes 118
Latch Record Enable Buttons, option 76
Latch, option 136
Latence d'écoute 192
Latence d'enregistrement et d'écoute 192
LE, systèmes 11

fonctionnalités 12
QuickPunch 253

Lecture
à partir d'un point de la piste 324
aucun défilement 330
demi-vitesse 230
pistes 323
sélections 344
sélections à la volée 336
sélections d'édition avec la tête de lecture 349
sélections de timeline avec la tête de lecture 349

Lecture à demi-vitesse 230
Lecture en solo

pistes 134
pistes dans un prémixage 601

Lecture, bouton 33
Levels of Undo, préférence 81, 295
LFE

activation dans les plug-in 748
exemple de sous-chemin 730
exemples de canal séparé ou de collecte des 

signaux 733
faders 748
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LFE Enable, bouton 621
LFEs Follow Groups, option 82
Librarian, menu 619
Limit To, option 78
Limites de régions

déplacement de la tête de lecture 350
déplacement du curseur d'édition 342
extension de sélections 339, 434

Linear Sample Display, commande 436
Linear Tempo, commande 439
Linear Tick Display, commande 437
Link Edit et Timeline Selection, option 332
Link Enable, boutons 620

plug-in multimono 725
Link Mix and Edit Group Enables, option 76
Link Record and Play Faders, option 192
Link Selection, bouton 332, 333
Link Track and Edit Selection, option 333
Lissage d'automation 644
Liste de groupes 143
Liste de groupes, menu déroulant

commande Delete Group 144
commande Display 144
commande New Group 144
commande Suspend All Groups 144

Liste des pistes 123
Liste des prises, mene déroulant

pistes multiples 221
Liste des prises, menu déroulant 220
Liste des régions, menu

commande Auto Rename 421
commande Clear 422
commande Compact Selected 419
commande Export Region Definitions 164
commande Rename 421
commande Selected Unused 422
option Show Auto-Created 422

Localisateur de curseur de lecture 329
Lock Settings File, commande 623
Lock/Unlock Regions, commande 372
Locked, indicateur 772
Loop Playback, option 345

et mode Touch 647
Loop Record, mode 200, 219
Low Latency Monitoring, option 193
LTC (Linear Time Code) 756

M
Machine Chases Memory Location, option 86, 786
Machine Control, préférences 85
Machine Cues Intelligently, option 86
Machine Follows Edit Insertion/Scrub, option 86, 786
Machine Track Arming, fenêtre 788
Macintosh, sessions

compatibilité sous Windows 178
Main, outil

édition des points d'inflexion 657
outil de séparation 353

Main, outils 304
Make Active, commande 138
Make Inactive, commande 138
Manual Tempo, mode 206
Manually Find and Relink 175
Markers, règle 284

Marquages temporels 792
commande Bounce to Disk 683

Marqueur de début de morceau 425
déplacement 425
modification du tempo 426

Marqueurs 458
création 460
création à la volée 461
déplacement 464
édition 463
exportation 170
extension de sélections 339
importation 169
options d'affichage 465
références aux tics et aux échantillons 459
suppression 464
tri 467

Marqueurs Bar|Beat
à partir de la commande Identify Beat 445
créés avec Beat Detective 481
déplacement 447
données audio avec tempos variables 448
édition 447
événements de tempo 447

Marqueurs d'édition 333
durée de la sélection 338

Marqueurs de lecture 223, 333
durée de la sélection 338
sélections d'édition 334
sélections de timeline 347

Masquage
pistes 124
régions créées automatiquement 422
toutes les pistes 124

Master Link, bouton 620
plug-in multimono 725

Mastering
numériquement 695
sur disque 694

Mastering numérique 695
Matching Start Time Takes List, préférence 81
Matériel

affectation à Pro Tools 93
décalages de retard 109
mise à jour des paramètres d'E/S après modification 97

Matrice 703
Mbox 11
Mbox 2 11
Média 816
Memory for Automation Recording, option 645
Memory Location, boîte de dialogue 458
Memory Locations, fenêtre 462

options d'affichage des marqueurs 465
View Filter 466

Menu Track
Commande Clear All Clip Indicators 587
commande Duplicate 637

Merge Paste Special, commande 380
Merge, mode (voir Mode de fusion MIDI)
Mesures

renumérotation 457
Métadonnées 819
Index 837
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Métrique
actuelle 448
affichages 38
défaut 204

Métrique actuelle 448
Métrique en cours 38
Métronome, bouton 37
Mic Preamps, vue 579
MIDI 24

chemins des signaux 26
Default Thru, instrument 233
définition de la valeur de la grille pour l'édition 500
erreurs courantes 26
noms de patches 515
sélection et répartition des notes 543

MIDI File Format, menu déroulant 169
MIDI Machine Control 784
MIDI Machine Control (MMC) 784

activation de pistes à distance 788
configuration dans Pro Tools 784
contrôle des périphériques externes 784

MIDI Merge 37, 201, 235
MIDI Note Display, options 85
MIDI Operations, commandes 523

commande Change Duration 539
commande Change Velocity 537
commande Flatten Performance 537
commande Grid/Groove Quantize 525
commande Input Quantize 234, 545
commande Restore Performance 535
commande Select/Split Notes 544
commande Step Input 246, 546
commande Transpose 541

MIDI Operations, fenêtre 523, 524
MIDI Replace, mode 37, 201, 235
MIDI standard, fichiers 168

exportation 169
importation 167
type 0 168
type 1 168

MIDI Step Input, commande 246
MIDI Studio Setup, fenêtre 515
MIDI Thru, commande 233
MIDI Track Offsets, commande 521
MIDI, commandes du menu Setup

commande Input Devices 232
commande Input Filter 234
commande MIDI Beat Clock 788

MIDI, fichiers (voir fichiers MIDI standard)
MIDI, générateur de signaux 25
MIDI, générateur sonore 25
MIDI, interface 25
MIDI, notes

attributs 507
déplacement 504
duplication des notes sélectionnées 382
édition 502

durées 539
hauteur 504
vélocités 506, 537

insertion 500
quantification 530
recherche 518
répartition 543
rognage des points de début et de fin 505

sélection 502
suppression 508
transposition 504, 541

MIDI, périphériques 25
MIDI, périphériques de contrôle 25, 231

contrôle local 25, 233
MIDI, pistes

affectation à plusieurs canaux 238
changement de programme par défaut 514
configuration pour l'enregistrement 236
décalages MIDI 520
enregistrement 231
enregistrement à la volée 241
enregistrement en boucle 242
enregistrement fractionné 240
entrée 131
Note Chasing 519
sélection d'une plage de hauteurs 544
sortie 131
voies 114
vue Notes 272, 280
vue Regions 272, 281
vue Sysex 518
vue Vélocité 506

MIDI, préférences 84
option Default Note On Velocity 501
option Global MIDI Playback Offset 520
option Pencil Tool Resolution When Drawing Controller 

Data 84, 512, 656
MIDI, propriétés en temps réel 549

paramètres 551
pistes et régions 554

MIDI, régions 280
et enregistrement fractionné 242
événements de contrôleur 283
instructions pour l'édition 282

MIDI, surfaces de contrôle 25
Minimum Sync Delay, option 787
Minutes:Seconds, échelle temporelle 285
Mise en boucle

régions 395
Mix Window Follows Bank Selection, option 72
Mix Window, option 27
Mix, fenêtre 27, 29

All Views, option 578
contrôles de pistes 27
largeur des pistes 118
None Views, option 578
option All Views 27

Mixage
formats Surround 700

Mixage final 694
Mixage final vers un format stéréo 694
Mixage stéréo

présélection usine des paramètres d'E/S 105
MMC (voir MIDI Machine Control)
Mode calculateur pour la saisie numérique 340
Mode Collection, Beat Detective 490
Mode de fusion MIDI 201
Mode Latch

AutoJoin 640
Join 640

Mode Record Pause 214
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Modèles
Beat Detective 482
DigiGroove 482
session Pro Tools 68

Modèles de sessions personnalisés 68
Modes d'écoute 190

Auto Input 190
Input Only 190

Modes d'enregistrement 199
et MIDI 201
mode Destructive Record 200
mode Loop Record 200
mode Nondestructive Record 199
QuickPunch 201
sélection avec le bouton Record 199

Modes Solo 134
sélection 135

Molette de défilement
affichage des notes d'une piste MIDI 281, 310
défilement dans une fenêtre Pro Tools 328
zoom avant dans la fenêtre Edit 310

Momentary Solo, options Solo Latch 136
Mono

chemins 95
commande Bounce to Disk 689
format 700
inserts 610

Moteur de compensation de retard
configuration 603

Move Song Start, commande 451, 456
Movie, fenêtre 805
Movie, pistes 803

insertion du point de synchronisation 807
scrubbing 805

MP3, format de fichier 686
MP3, option 686
option MP3 148

MPEG-1 Layer 3 686
MTC (MIDI Time Code) 755

émission 773
Multicanaux, plug-in 611, 725
Multimono

plug-in 610, 725
sélecteur de canal de plug-in 725

Multiple mono, format 689
Multitimbralité 25
Mute Audio Inputs in Auto Input, option 264
Mute Frees Assigned Voice, option 137, 138
Mute Overwrite/Extend, commande 672
Mute Record-Armed Tracks While Stopped, option 77, 264
Mute, bouton 137
Mute/Unmute Region, commande 373
Mutes Follow Groups, option 82, 134
Mutiplication de la vélocité des notes 539
MXF, format 148, 686

N
Narrow Mix, option d'affichage 118
Navigateur

définition 819
Navigateur de l'espace de travail 197, 198
Navigateur de projet 174
New Group, commande 144
New Memory Location, boîte de dialogue 224

New Session, commande 59
dernière utilisation 104

New Track, commande 119, 209, 236
boîte de dialogue New Tracks 209

New Tracks, boîte de dialogue 119
Niveau, faders

départs 583
Niveaux d'entrée 185
No Clip Hold, option 75
No Clip Indication 117
No Output, option 583
No Peak Hold, option 75, 117
Noir codé 796
Non linéaire 15
Nondestructive Record, mode 199
Normal QuickTime Playback Priority, option 802
Normal QuickTime Priority Playback, option 78
Normal Zoom, mode 306
Note Chasing, option 518
Notes (voir notes MIDI)
Notes coincées 521
Notes MIDI

défilement 281
durées en tics 287

Notes, rapport 62
Notes, vue 272, 280

défilement vers le haut ou vers le bas 281
mini-clavier 280
Pistes MIDI et pistes d'instrument 280

NTSC
vitesse 760

Number of Voices 52
Numeric Keypad, modes 77

Shuttle 320

O
OMFI, format 164
On Stop 669
Online, bouton 33
Online, option 78
Open Ended Record Allocation, option 78, 198
Open Session, commande 62
Operation/Destination Track, menus déroulants 158
Operations, menu

commande Calibration Mode 186
option Link Timeline and Edit Selection 332
option Link Track and Edit 333
option Low Latency Monitoring 193

Optical
I/O ADAT 56

Optical (S/PDIF)
Hardware Setup 56

Options de codage couleur 139
Options de défilement 330

après la lecture 330
Center Playhead 331
continu 331
None 330
page 324, 330

Options de vue de la fenêtre Edit 578
options de vue de la fenêtre Edit 578
Options de vue de la fenêtre Mix 578
options de vue de la fenêtre Mix 578
Index 839
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Options, menu
commande Auto-Spot Regions 791
commande MIDI Thru 233
commande Mirror MIDI Editing 497
commande Transport Online 782
Delay Compensation, option 602
mode Destructive Record 215
mode Loop Record 219
option Link Track and Edit Selection 333
option Loop Playback 345
option Mute Frees Assigned Voice 137, 138
option Pre/Post-Roll 226
option Pre-Fader Metering 117
options de défilement 330
QuickTime DV Out FireWire Port, commande

 804
Organize Plug-In Menus By, option 73, 616
Original Time Stamp 365, 792
Other Playlists, menu 291
Outil d'accrochage de temps 337
Outil d'accrochage, outil

sélection de notes MIDI 502
Outil de saisie d'objet 336

et groupes d'édition 337
outil de trimming de boucle 398
Outils de trimming 304, 311, 434

outil de compression/extension temporelle 508
outil Time Compression/Expansion Trim 84, 312
Scrub Trim, outil 314

Output Window, bouton 737
Output, fenêtres 582
Output, options

option Conversion Quality 692
paramètre Sample Rate 691

Ouverture de plusieurs fenêtres Plug-In 621

P
Panoramique de départ 583
Panoramique, curseur 116
Panoramique, indicateur 116
Panoramiques couplés en mode inversé 592
Panoramisation

3 boutons 742
activation dans la grille 742
automation et groupes 660
conventions 728
couplage stéréo 591
grilles 736
groupes 748
mode de réglage précis 742
mode X/Y 741
playlists d'automation multicanaux 748
trajectoire 744

Parabolic Tempo, commande 440
Parallèle, mixage 722
Paramètre précédent, bouton 619
Paramètre suivant, bouton 619
Paramètres

collage 625
commande Settings Preferences 623
copie 625
création de sous-dossiers 624
création du défaut de l'utilisateur 625
enregistrement 624

importation 625
sélection d'une destination 624

Paramètres d'E/S 105
paramètres de plug-in, bibliothèque 622
Paramètres de session 66
Paramètres par défaut, pour plug-in TC/E 84
Paramètres utilisateur par défaut, création 625
Parasites 229
Passage à zéro 279
Paste Settings, commande 623
Paste Special, commandes

fusionner 380
Merge 380, 664
Overwrite 664
Repeat to Fill 664
Repeat to Fill Selection 380
To Current Automation Type 380, 664

Paste, commande 378
Patch Select (sélection des patchs), bouton 514
Patch Select, boîte de dialogue 514
Pavé numérique, modes 43

Classic 43
Shuttle 44
Transport 44

Peak Hold, options
3 Second 117
Infinite 117
None 117
préférences d'affichage 75

Pencil Tool Resolution When Drawing Controller Data, 
option 84, 512, 656

PFL (Pre Fader Listen) 135
Phase Invert, bouton 621
Piste, vue

Sysex 518
vélocité 506

Pistes
ajout à une sélection 341, 342
ajout de nouvelles données à la fin des pistes 215
ajouter des commentaires 120
concepts 17
conversion de pistes multicanaux en pistes mono 721
coupure 137
déplacement des sélections 341
désactivation (et activation) 138
disposition de piste au format 5.1 720
duplication 122, 637
hauteur de piste 275
lecture 323
lecture en solo 134
masquage 124
noms 119, 194
options de codage couleur 139
placement des régions 357
préparation en enregistrement 187
priorité de lecture 129
raccourci de défilement 329
recherche avec Avance rapide/Retour arrière 325
regroupement 142
rognage des données indésirables 355
sélection de toutes les régions 335
sélection de toutes les régions de toutes les pistes 335
sélection des données 334
sélection sur plusieurs pistes 341
suppression 122
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suppression d'une sélection 342
Surround 719
transposition 541
vue principale 274, 663
vue Track 271, 273
vumètres 117

Pistes audio
Waveform, vue 277

Pistes masquées
édition de groupes 125
groupes 125
sélections 334

Pistes MIDI
vue Notes 280

Pistes multicanaux 209
acheminement du signal 719
automation 660
déplacement de régions 384
division 384
noms 195
remplacement des régions 376

Pistes multiples
adaptation des régions audio à la sélection 

d'édition 349
Beat Detective 485
collage 381
déplacement de régions par incrément 370
déplacement en mode Shuffle 363
écoute des prises 221
édition 381
extension de sélections 341, 342
sélection 341
séparation des régions 353

Pistes stéréo
déplacement de régions 384
division 384
noms 195
remplacement des régions 376

Placement
placement automatique 791
régions 364, 789, 790
séquences QuickTime 808

Play Edit Selection, commande 344, 349
Play MIDI Notes When Editing, option 85
Play Timeline Selection, commande 344, 350
Playback Engine 769

paramètre RTAS Processors 50
Playlists 18, 290

affectation 291
ajout d'une nouvelle playlist 291
attribution d'un nouveau nom 291
désignation automatique 291
duplication 291
édition MIDI non destructive 283
enregistrement vers de nouvelles playlists 216
groupes 292
modification de règle temporelle 289
pistes multicanaux 660
playlists d'automation 290, 636, 646
playlists d'édition 290
rappel 291
réglage du pré/post-roll 226
sélecteur de playlist 290
suppression 292

Playlists d'édition 290

Plug-in
activation de l'automation 629
automation 650
Category 616
Category and Manufacturer 617
couplage 725
couplage et découplage 627
création de paramètres par défaut 625
désactivation (et activation) 24
désactivation depuis une fenêtre 627
favorites 618
Flat List 616
insertion à la volée 615
insertion dans les pistes 614
insertion pendant la lecture 615
Manufacturer 617
mixage Surround 724
mono à stéréo 610
multicanaux 611
multimono 610, 725
Organize Plug-In Menus By 616
Paramètre précédent, bouton 619
paramètre RTAS Processors 50
Paramètre suivant, bouton 619
précision de l'automation lors du prémixage 692
processeurs multiples 51
sélecteur de canal pour le multimono 725
sélection du paramètre de plug-in, bouton 620
suppression des pistes 614
Surround 725
valeurs de majoration 782

Plug-in RTAS 611
Plug-In Selector

plug-in en temps réel 619
Plug-In Settings, menu 619
Plug-in TDM 611
Plug-in temps réel 609
Plug-In, fenêtre

fermeture de plusieurs fenêtres 621
ouverture de plusieurs fenêtres 621

Plug-in, inserts 609
Point d'insertion d'édition

placement des régions 359
rognage de régions 355

Point de passage 639
Points d'enregistrement de boucle 222

et marqueurs de lecture 223
Points d'enregistrement fractionné 222

et marqueurs de lecture 223
Points d'inflexion 658

incrustations Avid 657
Points de synchronisation 794

Beat Detective 490
identification 367, 794
régions 367
séquence QuickTime 807

Post crossfades 402, 409
Post-roll, bouton 35
Pré crossfades 402, 409
PRE, paramètres

importation 161
Pré/post-roll

écoute 344
et enregistrement en boucle 218
et enregistrement fractionné 217
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sélection 225
Pre/Post-Roll, option 226
Pre-Fader Metering, option 117
Préférence After Write Pass, Switch To 639
Préférences

affichage des info-bulles 39
AudioSuite Dither

option Bit Depth 84
générales 821
option Mute Audio Inputs in Auto Input 264
option Mute Record-Armed Tracks While Stopped 264
TrackInput 191
TrackPunch 257
utilisateur Mac OS X 821

Préférences d'affichage 72
Draw Grids in Edit Window, option 303
Draw Waveforms Rectified, option 278
option Show Meters in Sends View 587

Préférences d'édition
Auto-Name Separated Regions, option 352
option Auto-Name Memory Locations While Playing 461
option Conversion Quality 150
option Crossfade Preference for Pre/Post-Roll 80, 408
option Edit Selection Follows Region List Selection 335
option QuickPunch Crossfade Length 252, 257
option Region List Selection Follows Edit Selection 335
option Separate Region Operates On All Related 

Takes 222
option Take Region Lengths That Match 221
option Take Region Names That Match Track 

Names 221
Region List Selection Follows Edit Selection, option 296
Separate Region Operates On All Related Takes, 

option 353
Préférences de fonctionnement 75

Edit Insertion Follows Scrub/Shuttle, option 318
option Audio During Fast Forward/Rewind 325
option Auto Regions Fade In/Out Length 412
option Link Record and Play Faders 192
option Machine Chases Memory Location 786
option Machine Follows Edit Insertion/Scrub 786
option Open Ended Record Allocation 198
option Record Online 783
Use F11 for Wait for Note 235

Preferences, commande 72
Prémixage

séquences QuickTime 811
Prémixages 90

application d'un insert 599
exemples de Surround 733
lecture en solo de pistes 601
prémixage sur disque 681
report son 693

Préparation des pistes à l'enregistrement 187
Pre-Process using Standard Conform, option 488
Pré-roll, bouton 35
Prises

écoute 220
écoute à partir du menu déroulant de la liste des 

prises 220
enregistrement d'autres prises 214
noms par défaut 194
numérotation de QuickPunch 254

Prises associées 220
et commande Separate Region 222
préférences 221

Pro Tools LE
gestion de fichiers 173
systèmes 11

Pro Tools LE, systèmes 12
Pro Tools M-Powered 13
Pro Tools|HD Accel, systèmes 7
Pro Tools|HD, systèmes 7

fonctionnalités audio 9
fonctionnalités E/S 10
fonctionnalités MIDI 9
gestion de fichiers 173
interfaces audio 10
QuickPunch 252, 253
TrackPunch 255

Procédures 262
ProControl 608
Program Change, boîte de dialogue 514, 515
ProLogic 700
Propriétés en temps réel

activation 551
affichage 549
affichage dans la fenêtre Edit 557
affichage dans la liste des événements MIDI 556
basées sur des pistes 554
basées sur des régions 554
Delay (retard) 553
Duration (durée) 552
écriture sur les pistes 555
écriture sur les régions 555
option Display Events as Modified by Real-Time 

Properties 85
paramètres 551
pistes et régions 554
Quantize (quantification) 551
réinitialisation 555
Transpose (transposition) 554
Velocity (vélocité) 553
vue 549

Protection de l'automation 645
Pull up et Pull down 762

audio 778
plug-in 782
règles 782
vidéo 778

Pull Up/Down
3:2 Pulldown 760

Punch In Frame Offset, préférence 86
Punch Out Frame Offset, préférence 86

Q
Quantification

données MIDI en entrée 545
notes MIDI 530

Quantisation
données MIDI en entrée 234
notes MIDI

attaques et relâchements 526
Quantize (quantification)

propriétés en temps réel 551
Quantize Regions, commande

valeur de la grille 366
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Quantize to Grid, commande 372
Quantize, commande

essais 530
Quantize, fenêtre 527
QuickPunch 201, 251

crossfades 252, 257
numérotation des prises/régions 254
systèmes LE 253
systèmes Pro Tools|HD 252

QuickPunch Crossfade Length, option 81, 252, 257
QuickTime

Avid Xpress DV 803
QuickTime DV Out FireWire Port, commande 804
QuickTime Movie Offset, commande 804, 807
QuickTime Playback Priority, commande de menu

option Higher 78, 802, 806
option Highest 78, 802, 806
option Normal 78, 802

QuickTime, fenêtre 806
QuickTime, formats de fichiers 686, 809
QuickTime, formats de fichiers compressés 809
QuickTime, séquences

configuration requise 801
conformation 800, 808
décalage 807
décalage en Feet.Frames 807
définition de l'heure de début 807
durée 801
importation 802
importation de données audio 810
optimisation de la lecture 806
placement 808
prémixage 811
qualité de lecture 802
sync 804

R
Raccourcis clavier 628

commandes de touches générales 41
enregistrement 213
entrée numérique 340
plug-in 629

Raccourcis de saisie clavier 628
Real-Time Properties, fenêtre 550
Recall Memory Location Selection at Original Track, option 80
Recherche

avec Avance rapide/Retour arrière 325
changements de programmes 519
curseur de lecture 329
événements de contrôleur 519
indicateurs d'emplacement 328
notes MIDI 518

Recherche des régions 297
historique de recherche 298

Recompute Invalid Overviews, option 73
Record Enable, bouton 34, 187, 199, 260
Record Online at Insertion/Selection, préférence 78
Record Online at Time Code (or ADAT) Lock, préférence 78
Record Online, option 783
Record Safe, mode 189
Red Book, CD audio 811
Redo, commande 293
Référence de position 755
Regenerate Missing Fades 175

Region Groups, dossier 61
Region List Selection Follows Edit Selection, 

option 80, 296, 335
Region List Selection Follows Track Selection, option 80
Region List, menu 792

commande Find 297
commande Time Stamp Selected 365
commande Timeline Drop Order 358
Sort By, option 297

Region Name, option d'affichage 276
Region Time, option d'affichage 277
Région, définitions 164, 793
Region, menu

Bring to Front, commande 355
Capture, commande 351
commande Identify Sync Point 794
commande Lock/Unlock Regions 372
commande Mute/Unmute 373
commande Quantize to Grid 372
commande Remove Sync Point 367, 794
commande Rename 420
commande Ungroup Regions 388
commande Unloop Regions 397
Send to Back, commande 355
Ungroup All Regions, commande 388

Régions 18
affichage des noms 276
affichage des noms des régions 276
affichage des positions temporelles 276
alignement sur les points de début de la région 360
attribution d'un nouveau nom 421
capture 351
collage 378
conformation avec Beat Detective 486
consolidation 419
copie 377
coupure 373, 377
création 351
créées automatiquement 270
crossfade 408
décalage 371
définies par l'utilisateur 270, 420, 422
déplacement 361
déplacement à partir de la liste des régions 358
déplacement en mode Grid 366
déplacement en mode Shuffle 362

pistes multiples 363
déplacement en mode Slip 363
déplacement par incrément 369
déplacement vers des pistes multicanaux 384
désignation automatique 421
duplication 382
exportation sous forme de fichiers audio 162
extension des sélections à inclure 339
gestion 420
insertion de silence 418
marquage temporel 792
masquer les régions créées automatiquement 422
mise en boucle 395
multicanaux 271
noms par défaut 194
offline 271
Original Time Stamp 365
placement 364, 790
placement au point d'insertion d'édition 359
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placement automatique 791
placement dans les pistes 357
placement en arrière-plan 355
placement en premier plan 355
placement sur des séquences 808
points de synchronisation 367, 794
quantification 372
recherche 297
régions audio de fichiers complets 270
réinitialisation des propriétés en temps réel 555
remplacement 373
répétition 383
réunion de divisions 357
rognage des données indésirables 355
rognage des points de début et de fin 311
rognage jusqu'au point d'insertion d'édition 355
rognage par la valeur de déplacement par incrément 357
sélection 334
sélection de toutes les régions d'une piste 335
séparation 352
séparation avec Beat Detective 484
séparation avec l'outil de séparation 353
suppression 379
suppression des régions inutilisées 422
suppression du silence 416
tri 297
User Time Stamp 365
verrouillage 372

Régions audio 277
adaptation à la sélection d'édition 349
automation 279
fichiers complets 270
suppression du silence 415

Régions audio de fichiers complets 270
Régions créées automatiquement 270

attribution d'un nouveau nom 420
masquage 422

Régions définies par l'utilisateur 270, 420, 422
Régions mises en boucle 395

annulation de la mise en boucle 397
attribution d'un nouveau nom 396
copier-coller des données d'automation 399
création 396
édition 397
rognage 398
rognage à l'aide de l'outil de trimming de boucle 398
sélection 397

Régions multicanaux 271
Régions offline 271
Régions, liste 295

affichage des informations du fichier pour les régions 
audio 296

clips MIDI 296
commande Export Regions as Files 162
déplacement 358
focus clavier 42
recherche des régions 297
tri 297

Regions, vue 272, 281
Réglages de fondu par défaut 80
Règle de métrique

affichage 448
extension d'une sélection d'édition 450

Règle de tempo
affichage 426

extension d'une sélection d'édition 428, 465
Règle des marqueurs 458
Règle temporelle principale 285
Règles

affichage de toutes les règles 284
défilement 328
modification de l'ordre d'affichage 284
pull up et pull down 782
règles de chef d'orchestre 284
règles temporelles 283
zoom avant 307

Règles de chef d'orchestre 284
Règles du chef d'orchestre

dans les sélections 341
Règles temporelles 283

déplacement des sélections d'édition 343
déplacement des sélections de timeline 347
drapeaux de pré/post-roll 333
marqueurs d'édition 333
marqueurs de lecture 333
sélection sur toutes les pistes 341
sélections de timeline 346

Réinitialisation des chemins 97
Relative Grid, mode 366
Remote Mode, option 86
Remove Duplicate Notes, commande 522
Remove Sync Point, commande 367, 794
Rename Region, commande (menu de la liste des 

régions) 420
Rename, commande (menu de la liste des régions) 421
Renamed Audio Files

commande save copy in 175
Rendre aléatoire

durées des notes 541
emplacements des notes 527

Renumber Bars, commande 457
Répartition (MIDI) 543
Repeat to Fill Selection, commande 380
Repeat, commande 383
Répétition des sélections et des régions 383
Replace Regions, commande 373

pistes multicanaux 376
Replace Regions, boîte de dialogue 373

Replace, mode
Report son

vers un mixage stéréo 694
vers un prémixage 693

Résolution du tempo, sélecteur 432
Résolution pour la session 60, 770
Ressource SND, format de fichier 686
Ressources non disponibles 62
Ressources système 22
Restore Performance, commande 523, 535
Retard

décalages de pistes MIDI 521
indicateur de retard du canal 116

Retard du canal, indicateur 116
Retour à zéro, bouton 33
Retour arrière

par incrément 325
recherche 325

Retour rapide, bouton 33
Revert to Saved, commande 63
Rognage

crossfades 409
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points d'inflexion d'automation 434
points de début et de fin d'une région 311
points de début et de fin des notes 505
régions avec le Scrub Trim 314
régions par la valeur de déplacement par incrément 357

Rognage (trimming)
données de pistes et de régions indésirables 355
jusqu'au point d'insertion d'édition 355

Root Settings, dossier 623
spécification 624

Round Robin Allocation 196
Routage par bus

chemins des signaux 87
départs 583
départs multicanaux 724
exemples de Surround 730
prémixage et traitement des effets 595

RTAS Processors, paramètre 50, 51

S
S/PDIF

Hardware Setup 56
Samples, échelle temporelle 285
Saturation numérique 186
Sauvegarde automatique des sessions 61, 78
Save As, commande 64
Save Copy In, commande 64, 68, 179
Save, commande 63
Scale Tempo, commande 442
Scroll To Track, commande 121, 330
Scrolling, option 324
Scrub Trim, outil 314
Scrubbing 318

avec le sélecteur 319
avec Scrub Trim 314
curseur d'édition 318
deux pistes audio 319
piste audio unique 318
pistes Movie 805
résolution 319
vitesse et sens de la lecture 318

Scrubbing, outil 304, 318
mode Shuttle 319
sélection 342

S-Curve, commande 441
SDDS 700
Sections 470
Select All, commande 335
Select Unused Regions, commande 422
Select/Split Notes, commande 523, 543, 544

action Split Notes 543
Sélecteur 29
Sélecteur d'entrée 126
Sélecteur d'entrée MIDI 131

piste d'instrument 133
Sélecteur d'ordre des chemins par défaut 108
Sélecteur de canal 621

plug-in multimono 725
Sélecteur de canal d'entrée 56
Sélecteur de canal de sortie 56
Sélecteur de chemins d'écoute 106
Sélecteur de la sortie par défaut de la nouvelle piste 107
Sélecteur de mode d'automation 638
Sélecteur de piste 619

Sélecteur de playlist 18, 290
Sélecteur de sortie 127
Sélecteur de sortie MIDI 132

piste d'instrument 133
Sélecteur de valeur de la grille 302, 303
Sélecteur de voix 129
sélecteur de vue de la fenêtre Edit 578
sélecteur de vue de la fenêtre Mix 578
Sélecteur de vumètre de chemin 106
Sélecteur de vumètre de chemin du contrôleur 106
Sélecteur du point d'insertion 619
Sélecteur, entrée MIDI 115
Sélecteur, outil 304, 323

scrubbing 319
sélection de notes MIDI 503

Sélecteur, sortie MIDI 115
Sélecteurs de compteurs principaux 286
Sélecteurs de compteurs secondaires 286
Sélection

avec l'outil de de scrubbing 342
dans la liste des événements MIDI 566
données des pistes 334
indicateurs de sélection d'édition 339
notes dans un accord 545
notes MIDI 502
pendant la lecture 336
plage de hauteurs de note 544
régions 334
régions non contiguës 336
sur plusieurs pistes 341
sur toutes les pistes 341
toutes les régions d'une piste 335
toutes les régions de toutes les pistes 335

Selection Changes Alternate Playlists, option 289
Sélection d'objets 336
Sélection de banque 25, 513
sélection du paramètre de plug-in, bouton 620
Sélections

à la volée 336
avec les règles du chef d'orchestre 341
boucle 345
collage 378
commande Bounce to Disk 683
consolidation 419
copie 377
coupure 377
décalage 371
déplacement par incrément 338, 369
déplacement par incrément des points de début et de 

fin 338
déplacement vers la région suivante/précédente 343
déplacement vers les pistes adjacentes 341
duplication 382
écoute des points de début et de fin 345
et groupes d'édition 334
et marqueurs de lecture 334
extension 339, 434
extension à la règle de métrique 450
extension à la règle de tempo 428, 465
lecture 344
modification de longueur 337
non contiguës 336
objet 336
pistes masquées 334
répétition 383
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stockage avec des emplacements mémoire 458
suppression 379
suppression d'une piste 342
sur plusieurs pistes 334, 341

Sélections d'édition
copiées à partir d'une sélection de timeline 348
copiées vers une sélection de timeline 348
déplacement dans la règle 343
écoute avec la tête de lecture 349

Sélections d'édition et de timeline séparées 332
Sélections de timeline 346

champs de début, de fin et de durée 36
copiées à partir d'une sélection d'édition 348
copiées vers une sélection d'édition 348
déplacement dans la règle 347
écoute avec la tête de lecture 349
et marqueurs de lecture 347
règles temporelles 346

Sélections non contiguës 336
Send Levels Follow Groups, option 82
Send Mutes Follow Groups, option 82
Send to Back, commande 355
Send via DigiDelivery, commande 167
Sends Default to -INF, option 75
Sends, vue 579
Separate Region Operates On All Related Takes, 

option 81, 222, 353
Separate Region, commande

et prises associées 222
Separate Region, commandes 352

At Selection 352
At Transients 352
On Grid 352
pistes multiples 353

Séparation des sélections d'édition et de timeline 332
Séparation, outil 353
Session Data to Import, menu 159
Session File Backups, dossier 61
Session Setup, fenêtre 769

Current TC 795
Sessions 16

création 59
création pour le mixage Surround 712
enregistrement 63
fermeture 70
format audio 770
formats audio mélangés 66
fréquence d'échantillonnage 53, 60, 770
fréquence d'image 771
image de départ 771
modèles 68
ouverture 61
ouverture à partir d'un volume de transfert 62
résolution 60, 770
sauvegardes 61, 78

Set As User Default, commande 623
Set Plug-In Default To, commande 623
Set Record Tracks to Auto Input, commande 191
Set Record Tracks to Input Only, commande 191
Set Root Settings Folder, commande 623
Set Servo Lock Bit at Play (Tamura Support), préférence 86
Setup, menu

boîte de dialogue Click/Countoff Options 203
commande Preferences 72
Disk Allocation 196

fenêtres MIDI 515
I/O Setup 91
QuickTime Movie Offset, commande 804, 807
Session Setup 769

Shift, boîte de dialogue 371
Shift, commande 371
Show Auto-Created, option 422
Show Meters in Sends View, option 72, 587
Show Original Setup, bouton 102
Shuffle, mode 301

déplacement de régions 362
régions verrouillées 372

Shuttle
option de mode fixe 320

Shuttle, mode du clavier numérique 77, 320
Shuttle, mode du pavé numérique 44
Single Zoom, mode 307
SIP (Solo In Place) 135
Site Web 5
Skip All 174
Slip, mode 301

déplacement de régions 363
Smart, outil 304, 316

création de crossfades 316
création de fondus 316
édition d'événements de contrôleur 317
édition de l'automation 317
pistes audio 316
pistes MIDI 317
pistes multicanaux 318

Smooth and Thin Data After Pass, option 81, 654
SMPTE

configuration 775
formats d'image 758
image de départ pour la session 771

SMPTE/ITU 700
Snap Pan to Speaker, icônes 740
Soft Limit 57
Solo Latch, options 136
Solo Safe, mode 137
Solo, bouton 134
Solos Follow Groups, option 82, 134
Sort By, option 297
Sortie analogique 57
Sortie d'horloge externe 768
Sortie MIDI, sélecteur 237
Sorties

chemins et sous-chemins 5.1 par défaut 713
chemins multicanaux 723
format et pistes 722

Sorties multiples
Hardware Setup 58

Sound Designer II, format de fichier 685
Source d'horloge 633
Source d'horloge externe 633
Sous-chemins 89

exemples pour le Surround 727
Sous-dossiers, création pour paramètres 624
Sous-images 790
Speed Cal, indicateur 772
Split into Mono Track, commande 384
Split into Mono, commande 721
Split Notes, action 543
Spot, boîte de dialogue 364, 789

bouton User Time Stamp 792
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option Use Subframes 790
Spot, mode 302, 789

déplacement de régions 363
rognage de régions 792

SRC, options 158
Step Input, commande 246, 523, 546
Stereo 690
Stéréo, format 700
Stop at Shuttle Speed Zero, option 86
Stop Disarms Audio Track Record, bouton 258
Stretch Tempo, commande 444
Strip Silence, commande 415, 416

désignation des régions 416
Strip Silence, fenêtre 415
Suppression

automation 653, 662
changements de programmes 517
chemins d'E/S existants 98
crossfades 409
dans la liste des événements MIDI 567
départs 585
emplacements mémoire 464
événements sysex 518
groupes 145
notes MIDI 508
pistes 122
playlists 292
plug-in des pistes 614
régions inutilisées 422

Suppression de chemin 98
Surfaces de contrôle

Command|8 608
Control|24 608
D-Command 608
D-Control 608
ProControl 608

Surround
assignation du signal élémentaire 723
codage et décodage 707
compatibilité de mixage 707
concepts 699
concepts de mixage 707
configuration de Pro Tools et des sessions 712
départs 723
dispositions des haut-parleurs 700
exemple de chemins au format 5.1 716
exemples d'utilisation de sous-chemins 727
fichiers des paramètres 712
formats de livraison 707
formats de mixage 700
formats Pro Tools 700
gestion des graves 708
grilles de panoramique 736
importation des paramètres d'I/O 714
Lt Rt 704
niveau séparé, Solo, Mute 721
playlists et automation de panoramique 748
pourcentage de centrage (%) 746
principes élémentaires de la divergence 706
terminologie 703
utilisation des chemins 726

SurroundScope 748
Suspend All Groups, commande 144
Swing 527, 529

SYNC I/O 754, 757
génération de timecode 783
options de synchronisation 768
référence 767
VSO

Sync Mode, champ 770
Sync Offset 774
Sync Point View, option 368, 794
Synchronisation 754

3:2 Pulldown 760
Bi-Phase/Tach 757
dépannage 795
film 759
formats d'image SMPTE 758
fréquence d'image cinéma et fréquence d'image 

vidéo 760
LTC 756
MIDI Beat Clock 788
MMC 784
noir codé 796
options 767
pistes témoin 759
pull up et pull down 762
référence de position 755
résolution 796
timecode 755
VITC 757

Synchronisation basée sur les échantillons 287
Synchronisation basée sur une référence temporelle 287
Sysex, vue 518
System Exclusive, données 26, 518

déplacement 518
enregistrement 249
suppression 518

System Memory Allocation 55
System Usage, fenêtre 70, 71

options de vue 71
Système

arrêt 49
démarrage 49
paramètres 50

T
Table des mesures

importation 161
Table des tempos

à partir de la commande Identify Beat 444
importation 161

Taille du buffer
matériel 193

Taille du buffer AudioSuite, préférence 84
Taille du buffer matériel 50
Take Region Lengths That Match, option 81, 221
Take Region Names That Match Track Names, option 81, 221
Target, bouton 620
Tascam DA30 56
Task Manager 153
TC/E Plug-In, préférence 84
TCE Edit to Timeline Selection, commande 348
TCE Edit to Timeline, commande

pistes multicanaux 348
Témoin 619
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Tempo
actuel 426
affichages 38
battement 206
défaut 205
effets sur les marqueurs et les emplacements 

mémoire 459
mode Manual Tempo 206

Tempo actuel 38, 426
Tempo Edit Density, menu déroulant 433
Tempo manuel, mode 38
Tempo Operations, commandes

commande Constant 438
commande Linear 439
commande Parabolic 440
commande Scale 442
commande S-Curve 441
commande Stretch 444

Tempo Operations, fenêtre 437
Tempo Ruler Enable, bouton 37
Tempo Sync 621
Temporisation sur les échantillons 459
Temporisation sur les tics 459
Tête de lecture 331

déplacement vers les limites d'une région 350
sélections d'édition 349
sélections de timeline 349

Thin Automation, commande 654
Time Code Mapping, options 157
Time Code Rate, menu déroulant 771
Time Code, échelle temporelle 285
Time Compression/Expansion, outil de trimming 84, 312
Time Compression/Expansion, plug-in 348
Time Operations, commandes 451

commande Change Meter 452
commande Cut Time 455
commande Insert Time 453
commande Move Song Start 456

Time Operations, fenêtre 448, 451
Time Slot TDM, utilisation 71
Time Stamp Selected, commande 365
Time Stamp, commande 221, 792
Timecode 755

capture 790
génération 773, 783
Jam Sync 774
roue libre 773

Timecode en roue libre 773
Timecode, génération 773, 783
Timeline Drop Order, commande 358
Timeline Insertion Follows Playback, option 75
Touch Timeout, option 83
Toutes les pistes

masquage 124
présentation 124
sélection dans les règles temporelles 341
sélection de toutes les régions 335

Track Name/Comments, boîte de dialogue 120
Track Number, commande 120, 330
Track Offset, options 157
Track Position Numbers Stay with Hidden Tracks, option 72
Track, menu

commande Clear All Clip Indicators 117, 118
commande Delete 122
commande Duplicate 122

commande Group 144, 145
commande Make Active 138
commande Make Inactive 138
commande New Track 119
commande Scroll to Track 121, 330
commande Split into Mono 384, 721
commande Write MIDI Real-Time Properties 555
mode d'écoute Auto Input 190
mode d'écoute Input Only 190
Set Record Tracks to Auto Input 191
Set Record Tracks to Input Only 191

Track, vue 271
affichage étendu de la piste 660
Blocks 272
contenu d'édition 376
modification 273
Notes 272
Regions 272
vue principale 663

TrackInput, bouton d'écoute 191
TrackInput, indicateur d'écoute 35
TrackPunch, mode 255
TrackPunch, préférences 257
Trafic du bus PCI 70
Traitement par déclenchement externe 620, 630
Traitement par déclenchement interne 629
Traitement, préférences 83
Trajectoire, panoramique 744
Transitoires

détection avec Beat Detective 475
tabulation vers 343

Transport
écoute TrackInput 35
indicateur d'activation à l'enregistrement de piste 35

Transport maître 785
Transport maître, bouton 36
Transport Online, option 782
Transport RecordLock, option 76, 258, 263, 264
Transport, fenêtre 33

affichage de l'état de l'enregistrement 260
champs de début, de fin et de durée 36, 223
commandes de transport 33
commandes MIDI 36
pré/post-roll 35, 225

Transport, mode du clavier numérique 77
Transport, mode du pavé numérique 44
Transport, options d'affichage 37, 224, 225, 323
Transpose (transposition)

propriétés en temps réel 554
Transpose, commande 523, 541
Transposition 541

notes MIDI 504
par octave 542
pistes 541
tonalité 542

Tri
marqueurs 467
régions 297

Trim
points d'inflexion d'automation 657, 667

Trim Automation, commandes 678
Trim to All Enabled 678
Trim to Current 678

Trim Region, commandes
End to Fill Selection 356
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End to Insertion 355
Start to Fill Selection 356
Start to Insertion 355
To Fill Selection 356
To Selection 355

trimming, outils de 657
Trois boutons, panoramique 742
Tweak-head, paramètre 692, 809
Types de fichiers mélangés 66, 148

U
Undo History, fenêtre 293
Undo, commande 293
Ungroup All Regions, commande 388
Ungroup Regions, commande 388
Universe, fenêtre 321
Unloop Regions, commande 397
Use All Available Space, option 78
Use AudioSuite Dither, préférence 83, 607
Use F11 for Wait for Note, option 76, 235
Use MIDI to Tap Tempo, option 85
Use Squeezer, option 692
Use Subframes, option 790
User Time Stamp 365, 793

V
Valeur de déplacement par incrément 369

rognage de régions 357
Valeur de la grille 366, 500
Variable Speed Override 772
Vélocité, vue 506
Vélocités, notes MIDI

atténuation 539
décalage avec l'outil de trimming 507
dessin avec le crayon 506
édition 506, 537
édition de la vélocité 506
multiplication 539
paramètres par défaut pour notes insérées 501

Velocity (vélocité)
propriétés en temps réel 553

Verrouillage de régions 372
Vidéo

limites d'enregistrement avec une majoration 781
Video Media, options 157
Vidéo, pull up et pull down 778
View Filter, commande 561

fenêtre Memory Locations 466
View, menu

commande Track Number 120, 330
option d'affichage Narrow Mix 118
option d'affichage Region Name 276
option Edit Window 28
option Mix Window 27
option Sync Point View 794
options d'affichage Region Time 277
options d'affichage Transport 37, 224, 225, 323
options de vue de la fenêtre Edit 578
options de vue de la fenêtre Mix 578
options de vue de la fenêtre System Usage 71
Region Sync Point View, option 368

VITC (Vertical Interval Time Code) 757
Vitesse de Shuttle Lock personnalisée 320

Voies 20
entrées auxiliaires 113
pistes audio 112
pistes d'instrument 114
pistes de faders principaux 113
pistes MIDI 114

Voix
assignation automatique par ordre croissant 130
priorité des pistes 129
TrackPunch 255

Volume
types, définitions 823

Volume Performance
définition 823
enregistrement 823
lecture 823

Volume Transfer
définition 823

Volume, fader 116
Volume, indicateur 116
VSO (voir Variable Speed Override)
Vue de piste

affichage étendu de piste 275
basculement 274
forme d'onde 277
Notes 280
Regions 281

Vue de piste, sélecteur 273
Vue de règles, options

échelle temporelle Bars:Beats 285
échelle temporelle Feet.Frames 285
échelle temporelle Minutes:Seconds 285
échelle temporelle Samples 285
Echelle temporelle Time Code 285

Vue Delay Compensation 119, 580
Vue des commentaires 120, 579
Vue des règles, options 284
Vue des règles, sélecteur 284
Vue I/O 115, 579
Vue large des vumètres 118
Vue principale des pistes 274, 663
Vue Real-Time Properties 580
Vues

affichage I/O 115
compensation de retard 119
vue Inserts 579
vue large des vumètres 118
vue Sends 579

Vumètres
niveaux pré/post-fader 117
pistes audio 117
pistes d'entrée auxiliaire, de fader principal et 

d'instrument 117
pistes MIDI 117
plug-in SurroundScope 748
surfaces de contrôle 106
vue Sends 587

Vumètres de pistes 117

W
Wait for Note 37, 235
WAV file, format 685
WAV, format de fichier 176

conformité AES31/Broadcast 176
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WaveCache.wfm, fichier 61
Waveform, vue 277
Window, menu

Automation Enable, commande 646
Color Palette 141
commande Big Counter 323
commande Disk Space 199
commande Edit 28
commande emplacements mémoire 462
commande Machine Track Arming 788
commande Mix 27
commande Project 174
commande QuickTime 806
commande Task Manager 153
commande Transport 33
commande Undo History 293
commande Workspace 197
System Usage, commande 71
Universe, commande 321

Windows, sessions
compatibilité sous Macintosh 178

Word Clock 56
à propos de 824

Write Automation to Next Breakpoint on Stop, commande 672
Write Automation to Next Breakpoint, commande 670
Write Automation, commande 676
Write Automation, commandes 675, 676
Write MIDI Real-Time Properties, commande 555
Write to All Enabled Automation, commande 677
Write to Current Automation, commande 677

X
XML (Extensible Markup Language) 515
X–OR (Cancels Previous Solos), option Solo Latch 136

Z
Zone d'édition des événements 32

attributs de la note 507
Zoom 304

arrière complet 306
autour d'un point de piste 306
avec une molette de défilement 310
changement de zoom 309
continu 305
dans la règle 307
dans une sélection 306
enregistrer les niveaux de zoom 308
horizontalement pour toutes les pistes 305
rappeler les niveaux de zoom 309
rendre visibles toutes les régions 306
retour au niveau de zoom précédent 306
sur une zone de piste 306
verticalement pour toutes les pistes audio 305
verticalement pour toutes les pistes MIDI 305

Zoom arrière horizontal, bouton 304
Zoom avant horizontal, bouton 304
Zoom continu 305
zoom sans modification des playlists 310
Zoom, boutons 304
Zoom, outil 304, 306
Zoom, présélection 308
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